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Revision History
The following table lists the revisions of this document.

Revision Change Description

Revision 05 Updated the supported platform section in Clarity Synthetic on page 750

Revision 04 Updated the following sections:

l Figure 60 to show all the graphs under the APs section

l Performance details in APs

Revision 03 Updated the following sections:

l The range of Application ID in Defining Custom Application

l Note in Defining Custom Application Category

Revision 02 Updated the following sections:

l Upgrading Application Signatures on page 389

l Defining Custom Application on page 390

l Defining Custom Application Category on page 391

Revision 01 Initial release

Table 1: Revision History
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About this Guide

This User Guide describes the features supported in ArubaOS 8.0 and provides instructions and examples to
configure Mobility Master, managed devices, and access points (APs). This guide is intended for system
administrators responsible for configuring and maintaining wireless networks and assumes administrator
knowledge in Layer 2 and Layer 3 networking technologies.

Throughout this document, branch controller and local controller are termed as a managed device.

This chapter covers the following topics:

l What's New In ArubaOS 8.0 on page 21

l Fundamentals on page 30

l Related Documents on page 32

l Conventions on page 32

l Contacting Support on page 33

What's New In ArubaOS 8.0
This section lists the new features, enhancements, and hardware platforms introduced in ArubaOS 8.0.

Mobility Master Architecture
ArubaOS 8.0 is a brand new centralized, multi-tier architecture that provides a clear separation between
management, control, and forwarding functions. Mobility Master takes the place of a master controller in the
network hierarchy. A single Mobility Master or a cluster of Mobility Masters oversee controllers that are co-
located (on-premise local controllers or off-campus branch office local controllers). Each Mobility Master cluster
is referred to as a Mobility Master domain. All the controllers that connect to Mobility Master act as managed
devices. In a large campus, there may be multiple Mobility Master domains.

The entire configuration for both the Mobility Master and managed devices is set up from a centralized point,
thereby simplifying and streamlining the configuration process. Mobility Master consolidates all-master, single
master-multiple local, and multiple master-local deployments into a single deployment model. In contrast, the
ArubaOS 6.x and earlier release trains run on a flat configuration model containing global and local
configurations. Global configurations are applied to the master controller and can only be propagated to each
local controller through the master. The respective local configurations are applied directly to each master or
local controller.

The goal of Mobility Master is to develop a platform that achieves the following:

l Reduces complexity of configuring and managing WLAN deployments.

l Hosts services that run with a central view of the network.

l Assimilates and provides access to the context and data available in the network infrastructure.

l Provides rich APIs that create an ecosystem to build custom applications (in-house/custom/third party),
connecting the application intelligence with network intelligence.

l Is highly available and can scale elastically using VM and clustering techniques.
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Platform and Server Specifications
Mobility Master runs on a virtual machine that is deployed through an OVF/OVA file. ArubaOS 8.0 only
supports VMware ESXi Hypervisor.

The following items must be in place before Mobility Master can be deployed:

l vSphere Client 5.1 or 5.5 must be installed on a Windows machine.

l vSphere Hypervisor 5.1, 5.5, or 6.0 must be installed on the server.

l An OVF/OVA template must be accessible from the ESXi host.

l VMWare Enterprise Plus license must be installed on the Hypervisor.

Minimum server requirements include:

l Quad Core i5 1.9 GHz processor with hyper-threading

l 8GB RAM

l Two physical Network Interface Controllers (NICs)

l Total CPU, memory, and network throughput utilization must be less than 80% of the host capacity

Minimum Virtual Machine Manager (VMM) requirements include:

l Three vCPUs

l 8GB memory

l 60GB disk space

l Four virtual NICs

Limitations
ArubaOS 8.0 includes the following limitations:

l Mobility Master only supports VMware ESXi Hypervisor.

l Certain VMware features, such as vMotion and DRS, are not supported.

l CPU oversubscription is not supported.

l A maximum of four network adapters are supported.

l Promiscuous mode must be enabled on the vSwitch to avoid address resolution protocol (ARP) issues.



New Features

New Features Description

AirGroup
Dashboard

The AirGroup dashboard provides enhanced visibility into AirGroup, displaying the
following information:

l Traffic trends

l Server distribution

l Server and user bandwidth

NOTE: The combined view of all AirGroup devices and usage in the network is
available under the AirGroup dashboard of every node in the hierarchy,
regardless of deployment type.

AirGroup Features AirGroup allows the ability to define the number of hops, use named VLANs, scale,
and a quickaccess mobile phone application to register for AirGroup services.

AirMatch RF Man-
agement

AirMatch optimizes RF network resource allocation by analyzing the past 24 hours
of RF network statistics, and proactively optimizing the network for the next day.
AirMatch can also react to detrimental RF events such as radar and high noise
levels, to allow the network to manage sudden changes in the RF environment.

The AirMatch channel and EIRP optimization features deprecate the channel
planning and EIRP optimization features in the legacy Adaptive Radio Management
(ARM) feature. AirMatch is supported on Mobility Master only, while legacy ARM
channel optimization and EIRP features continue to be supported by stand-alone
controllers running ArubaOS 8.0.

AP Health Checks The AP Health check feature uses ping probes to check reachablility and latency
levels for the connection between the AP and the managed device. The recorded
latency information appears in the output of the show ap ip health-check
command. If the managed device IP address becomes unreachable from the AP
uplink, this feature records the time that the connection failed, and saves that
information in a log file (tmp/ap_hcm_log) on the AP.

AP Termination on
Mobility Master

Mobility Master cannot be used as an AP Master since APs are not allowed to
terminate on a Mobility Master. If the AP manager on a Mobility Master receives
an AP HELLO message, the message is dropped.

AppRF Features AppRF 2.0 provides the ability to support Protocol Data Definition (PDD) based
application signatures and define custom applications

Auto-complete
User-defined
Variables

ArubaOS 8.0 now supports an auto-completion feature for user-defined variables.

Centralized
Licensing

ArubaOS 8.0 introduces several changes to centralized licensing. ArubaOS
supports new license types used to install Mobility Master on a VM, install a
managed device on a VM, or apply firewall policies to clients using a VPN to
connect to the VM. The xSec license is deprecated in ArubaOS 8.0, as. ArubaOS 8.0
supports xSec features in the base operating system, without any additional
license requirements.

Table 2: New Features in ArubaOS 8.0

ArubaOS 8.0.0.0 | User Guide About this Guide |  23



24 | About this Guide ArubaOS 8.0.0.0  | User Guide

New Features Description

Starting in ArubaOS 8.0, you add licenses to a managed device by adding the
license to Mobility Master, and then associating that license to either a specific
managed device, or a shared pool of licenses. Licenses cannot be added directly to
a managed device. You must enable support for sharable licenses by enabling
each licensing feature type on Mobility Master.

NOTE: For more information, refer to the Aruba Mobility Master Licensing Guide.

Cluster Clustering is based on keeping client processing, that is, signaling and traffic,
anchored to a managed device regardless of which AP the client roams to, as long
as the AP is within the control scope of the cluster. Since, the client is fixed at a
given managed device, a single Basic Service Set (BSS) on an AP can now have
clients that are anchored at multiple managed devices.

l The cluster size can reach up to 12 managed devices to support very large
campus deployments. It supports 7200 Series, 7000 Series, and VM platform.
Cluster supports all the cluster-related GSM channels on 7000 Series and VM
platforms. Cluster supports a heterogeneous managed device mix. Cluster
setup supports RAPs and IPv6 clients.

l The client load is shared by all the managed devices and there is a larger
roaming domain with smaller fault domain which helps with faster recovery.

l Enhanced Multicast Proxy feature is an integral part of the cluster setup.

l Session State Synchronization feature resolves all issues regarding seamless
roaming, service availability, and high availability.

l Cluster supports redundancy for both APs and clients.

l An AP is able to failover between clusters.

l AP-Move feature enables a user to move a specific AP to the target managed
device from a specific managed device.

Cluster Dashboard The Cluster dashboard provides a visual overview of each cluster deployed on the
network, displaying the following information:

l Health information between cluster members

l Total AP load per Cluster (AAC)

l Total User load per Cluster (UAC)

l Connection time

NOTE: The Cluster dashboard can only be accessed from the root (Managed
Network) node of the Mobility Master hierarchy. This information is not displayed
on any stand-alone controllers, managed devices, or other nodes in the hierarchy.

Configuration Auto-
Rollback

Mobility Master supports an auto-rollback mechanism that reverts the managed
device to the last known good configuration prior to any management connectivity
loss. Mobility Master indicates if a device has recovered from a bad configuration
through the show switches command output.

Bulk Edit Mobility Master supports the bulk edit that enables the user to upload multiple
configurations at the same time.



New Features Description

Configuration
Hierarchy

Mobility Master contains a centralized, multi-tier architecture that provides a clear
separation between management, control, and forwarding functions. The entire
configuration for both the Mobility Master and managed devices is set up from a
centralized point, simplifying and streamlining the configuration process. Mobility
Master consolidates all-master, single master-multiple local, and multiple master-
local deployments into a single deployment model.

The following enhancements have been introduced for the Mobility Master
configuration model:

l Multi-tier configuration hierarchy

l Centralized configuration

l Centralized validation

l Efficient configuration distribution

l ZTP and branch support

l Mutli-version support

l Recovery mechanisms for connectivity loss

l Centralized licensing

l New parser and CLI infrastructure

l Improved user interface

l Northbound APIs

Configuration User
Interface

The Mobility Master user interface runs on a flat hierarchy profile design that
provides ease-of-use through a simple navigation model. The Mobility Master
WebUI contains the following enhancements:

l Multi-level navigation menu

l Profile configuration model based off a single-page, flat hierarchy architecture,
in which only a portion of the page is updated based on the action performed

l Primary and secondary tables

l Pending Changes button to deploy or discard modifications

l Help mode to view help information for configuration fields

l Centralized hierarchy management

Device Auto-Parking Users can specify a default node to automatically push configurations to devices
that are not mapped to a specific configuration node using the configuration
device default-node command.

Disable Console
Access

A new command, mgmt-user console-block, is introduced to disable the console-
login. The purpose of this command is to introduce an ability to lock down all
console ports, for example, micro USB, mini USB on the managed device to enable
high-level security. This also ensures that no Secure Shell (SSH) access is allowed
at the remote branch office. The SSH is only allowed from the headquarters
through the IPsec tunnel.

ArubaOS 8.0.0.0 | User Guide About this Guide |  25
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New Features Description

Disaster Recovery If auto-rollback from a bad configuration fails, and connectivity between a
managed device and Mobility Master remains disrupted, users can enable
Disaster Recovery mode on the managed device. Disaster Recovery mode
grants users access to the /mm node of a managed device, while blocking any
further configuration syncs from Mobility Master. This allows users to make local
modifications on a managed device and restore connectivity to Mobility Master.

Support for IKE
Fragmentation

ArubaOS 8.0 supports the functionality where non-Aruba devices can fragment the
large IKE_AUTH packets using the standards described in the RFC 7383 – Internet
Key Exchange Protocol Version 2 (IKEv2) message fragmentation when the
Aruba device acts as a responder and not as an initiator.

IPFIX Support IP Flow Information Export (IPFIX) can now exports data for the following attributes:

l Source IP

l Destination IP

l Protocol

l Source L4 port

l Source L4 port

l Destination L4 port

l Session start time

l Session end time

l Packet received

l Byte received

l Station mac

l Station IP

l AP Ethernet MAC

IPsec Support Starting from ArubaOS 8.0, IPsec support is enhanced to accommodate IPv6 which
includes overlay networks across IPv4 and IPv6 IPsec Tunnels. In this release,
IKEv2/IPsec support is extended to IPv6 for the following topologies:

l Mobility Master

l CPsec (Tunnel Mode only)

l RAP (Tunnel Mode only)

l Site-to-Site Crypto Map (Tunnel Mode only)

LMS Configuration
for AP Groups

ArubaOS 8.0 supports LMS, LMS IPv6, and backup LMS IP address configuration as
part of the AP Group settings available in the WebUI.

Loadable Service
Module

The Loadable Service Module (LSM) provides an infrastructure that allows users to
dynamically upgrade or downgrade individual service modules without requiring
an entire system reboot. Services are delivered as individual service packages
containing the version and instructions for loading and running the service. Service
modules must be upgraded if there is a bug in the existing module or a newer
version of the module has been released.

The following service modules are LSM-capable:



New Features Description

l AirGroup

l AppRF

l ARM

l AirMatch

l NBAPI

l UCM

l WebCC

l WMS

Local WMS
Termination for
Managed Devices

If a managed device is installed at a location with strict bandwidth limitations and
in a network topology where the managed device is geographically away from
another managed device terminating APs, WMS services can be configured to
locally terminate on the managed device instead of terminating on Mobility
Master. Enable this feature with caution, as it may impact WMS device
classification and IDS detection and protection on your network.

MultiZone The MultiZone feature allows AP to terminate to multiple managed devices that
reside in different zones. A zone is a collection of managed devices under a single
administration domain.

Prefix Delegation Starting from ArubaOS 8.0, prefix delegation can be used to assign a network
address prefix to a customer site, as defined in IPv6 prefix delegation protocol (RFC
3769). The hosts at the customer site use this prefix to derive a unique IPv6
address using RA and SLAAC. Prefix delegation client uses DHCPv6 IA_PD to
request and assign prefixes

Remote Telnet or
SSH Session

Starting from ArubaOS 8.0, an administrator can initiate a remote telnet or SSH
session from Mobility Master to a remote host. The host can be a managed device
or a non-Aruba host.

SDN Controller The Software Defined Networking (SDN) Controller provides an improved
networking infrastructure to build, deliver, and manage features through the
following enhancements:

l Separation of control-plane and data-plane functions

l Centralized manageability

l Dynamic programmability of network devices

Uplink Load
Balancing

A managed device supports multiple 3G cellular uplinks in addition to its standard
wired ports, providing redundancy in the event of a connection failure. WAN traffic
can be balanced across two or more active uplinks from a managed device to a
VPN concentrator (VPNC). The uplink load balancing feature supports both active
and standby uplinks, so the traffic load can be balanced across two wired uplinks,
even while the backup cellular uplink remains idle.

Unified
Communication and
Collaboration

ArubaOS 8.0 introduces the following new UCC features:

l Enables VoIP ALGs to run as a service on Mobility Master and managed devices
need not run the same. This results in better scalability.
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New Features Description

l Enables real-time analysis of VoIP calls in upstream direction. This is the real-
time analysis and UCC call quality statistics calculated based on VoIP stream
captured at the managed device.

l Multiple applications running simultaneously on the same client device can be
identified and prioritized.

l Supports Intelligent Call Handling (ICH). ICH monitors the channel utilization of
all radios of the APs on the managed device. If the channel utilization exceeds
beyond a configurable threshold on a radio, new UCC calls are not prioritized.

l Supports Cisco Jabber. Mobility Master provides QoS and visibility for voice,
video calls, and desktop-sharing sessions made using an unencrypted version
of the Cisco Jabber client. UCM can uniquely identify and prioritize Cisco jabber
voice, video calls, and desktop-sharing sessions.

l Supports Loadable Service Module. UCM is a Loadable Service Module. ALGs
are completely decoupled from the managed devices. This enables faster
innovation of VoIP services such as introduction of new ALGs and
enhancements to existing features as they will become independent of the
ArubaOS release version.

l Provides a solution to the fanout problem in Lync/Skype for Business SDN API.
In ArubaOS 6.x, Lyn/Skype for Business SDN Manager sent call information
messages to every local controller in the network, regardless of whether the
local controller is involved in the call or not. This additional processing is an
unnecessary overhead on the local controller. In addition, the bandwidth
utilization between the data center and remote location is not efficient. With the
Mobility Master deployment, Lync/Skype for Business SDN Manager sends the
call information messages to Mobility Master only.

l Provides aggregation of statistical information at a centralized entity.

Interference
Metrics

This enhancement is introduced to resolve issues that occur with distributed
channel/power algorithm, random channel assignment, and reduction in
interference channel.

WAN Interface
Bandwidth Priorities

ArubaOS supports minimum bandwidth guarantees per traffic class, and allows
critical delay-sensitive applications like voice and video to use more bandwidth
and/or be scheduled with higher priority. Each interface can be associated with a
scheduler profile, that supports four queues with different priority levels.

Secondary
Managed Device

The secondary managed device feature in ArubaOS 8.0.0.0 provides seamless
connectivity by allowing an access point to terminate on a secondary managed
device in the event of the primary managed device failing.

Whitelist
Management for
APs and Managed
Devices

Zero touch provisioning (ZTP) automates the deployment of APs and managed
devices plug-n-play. The managed device learns the local configuration, global
configuration, and license limits from Mobility Master and provisions itself
automatically. ZTP offers the following advantages over a standard configuration:

l simple deployment

l reduced operational cost

l limits to provisioning errors

Customized
Response

This feature allows you to add customized messages that will be displayed in case
of an authentication failure.



New Features Description

Enabling PortFast A new parameter is introduced to enable PortFast/PortFast on Trunk to reduce the
time taken for wired clients connected to an AP to detect the link before they send
data traffic.

Seamless Logon The Seamless Logon feature enables you to login from the Mobility Master to a
managed device without entering a password.

OpenFlow Agent OpenFlow agent interacts with a centralized SDN Controller using the OpenFlow
protocol and translates OpenFlow commands into device specific actions.

Port Bounce for AP
with Access
Ethernet Ports

Mobility Master provides support for the port bounce feature for APs with access
ethernet ports. This feature enables a client to re-initiate a DHCP request when
there is a VLAN change.

Protection from
Adhoc Networks
Using Valid SSID

Mobility Master provides support for containing the adhoc networks that use a
valid or protected SSIDs so that clients cannot connect to it.

Role-based Access
and Authorization

A new default role, ap-provisioning is introduced to permit access only to AP
provisioning commands.

Clarity Synthetic Clarity Synthetic enables the controller to select and convert a supported access
point to client mode. The converted AP acts like a Wi-Fi client and starts synthetic
data transaction within the network to monitor and detect the network health.

Support for Self-
Signed Certificate

Mobility Master provides support for generating a new self-signed certificate
(default-self-signed) to demonstrate the authentication of the managed device
for captive portal and WebUI management access while booting.

NOTE: This is the default certificate used by Mobility Master and managed
devices.

Enhancements Description

Blocked Session The Blocked tab in Dashboard Monitoring > Traffic Analysis page displays
WebCC and AppRF sessions which are blocked by ACL through system logging.

Radius Accounting
for IPv6 Clients

Starting from ArubaOS 8.0, customers can monitor bandwidth usage by
clients/hosts with IPv6 addresses, over RADIUS protocol. The Framed-IPv6-
Address attribute is used in accounting start, stop, and interim packets. A host can
have multiple IPv6 addresses and all of them are tracked to check the usage, for
billing purpose.

Routing Traffic
through Web Proxy

When the Mobility Master needs to access data on the cloud or the internet, and if
the internet bound traffic needs to pass through a proxy, execute the web-proxy
server command. Once the command is executed the Mobility Master routes web
(HTTP/HTTPS) traffic through the proxy server.

Table 3: Enhancements in ArubaOS 8.0
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Enhancements Description

Uplink Health
Check
Improvements

If the managed device health check feature is configured to use UDP probe mode,
the health check feature can measure jitter on the connection to the remote host
by sending and measuring packets at fixed intervals.

Whitelist
DB Optimization

ArubaOS 8.0 introduces a pull-based sync mechanism for the whitelist database
(whitelist-DB), in which AP whitelist entries are only synced to the managed devices
that require the entry. The pull-based sync mechanism is used when a RAP/CPsec
AP terminates on a managed device or if a network is down during a whitelist push,
which can prevent messages from going through to the managed devices. Entries
can also be configured directly on a managed device for debugging purposes.

Wi-Fi Calling Mobility Master provides QoS for voice calls made using Wi-Fi Calling. UCM in
Mobility Master can identify and prioritize calls made using Wi-Fi Calling. UCM also
provides visibility for all voice calls made using Wi-Fi Calling.

Fundamentals
Configure your Mobility Master and AP using either the Web User Interface (WebUI) or the Command Line
Interface (CLI).

WebUI
Mobility Master supports up to 320 simultaneous WebUI connections. The WebUI is accessible through a
standard Web browser from a remote management console or workstation. The WebUI includes configuration
tasks. The tasks are:

l Provision New APs— Campus AP or Remote AP configuration.

l Create a New WLAN— Create and configure new WLAN(s) and associate with an AP group.

l Define Wireless Intrusion Protection (WIP) Policy— Define WIP policies and assign to AP groups.

l Bulk Configuration Upload— The Bulk Edit template (in Excel sheet) on the managed device allows you to
specify the static IP assignment for individual managed devices.

l Upgrade Controllers— Upgrade the managed devices.

l Reboot Controllers— Reboot the managed devices.

l Show Upgrade Status— Display the upgrade status of the managed devices.

In addition to the tasks, the WebUI includes a dashboard that provides enhanced visibility into your wireless
network’s performance and usage. This allows you to easily locate and diagnose WLAN issues. For details on
the WebUI Dashboard, see Dashboard Monitoring.

CLI
The CLI is a text-based interface accessible from a local console connected to the serial port on the Mobility
Master or managed device or through a Telnet or Secure Shell (SSH) session.

By default, you access the CLI from the serial port or from an SSH session. You must explicitly enable Telnet on your
Mobility Master in order to access the CLI via a Telnet session.

When entering commands remember that:

l commands are not case sensitive

l the space bar completes your partial keyword

l the backspace key erases your entry one letter at a time



l the question mark ( ? ) lists available commands and options

Remote Telnet or SSH Session from Mobility Master
An administrator can initiate a remote telnet or SSH session from the Mobility Master to a remote host. The
host can be a Mobility Master, managed device, or a non-Aruba host.

This feature is supported from the SSH session of the Mobility Master.

To initiate a telnet session from the Mobility Master to a remote host:

1. Initiate an SSH session to the Mobility Master.

2. In the enable mode, execute the telnet <host> [port <port-num>] command.

host: IPv4 or IPv6 address of the remote host.

port <port-num>: Telnet port number of the remote host. This is an optional parameter.

3. Once successfully connected, the remote host prompts the credentials. Enter the remote host credentials.

To initiate an SSH session from the Mobility Master to a remote host:

1. Initiate an SSH session to the Mobility Master.

2. In the enable mode, execute the ssh <username> <ip_addr> command.

username: Username of the remote host.

<ip-addr>: IPv4 or IPv6 address of the remote host.

Once successfully connected, the remote host prompts the credentials.

3. Enter the remote host credentials.

To end the remote host session, execute the exit command. The remote host displays the following message:
(host) [remote] #exit

Connection closed by foreign host.

(host) [mynode]#

Limitations

This feature has few limitations. They are:

l This feature is supported from the SSH session of the Mobility Master only.

l There is an inactivity timeout for the CLI sessions. When an administrator initiates a remote session (inner)
from the Mobility Master’s SSH session (outer), and the remote session takes more time than the inactivity
timeout session, the outer session times out although the inner session is active. The administrator has to
log back in to the outer session once logged off from the inner session.

l Designated telnet client control keys do not work for remote telnet sessions. When an administrator
initiates a remote telnet session (inner) from the Mobility Master’s SSH session (outer), the designated telnet
client control keys functions for the outer SSH session only. The administrator should designate unique
control keys for each remote telnet sessions.

Seamless Logon
The Seamless Logon feature enables you to login from the Mobility Master to a managed device without
entering a password. The user can remotely login from a centralized location (Mobility Master) to any managed
device and execute the show and action commands. To login to a managed device, execute the logon
<device-ip> command on the Mobility Master CLI:
(host) [mynode] #logon 192.0.2.22

Last login: Tue Jul 12 04:34:37 2016 from 192.0.2.81

(host-md) #
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Related Documents
The following guides are part of the complete documentation for the Aruba user-centric network:

l ArubaOS 8.0.0.0 Release Notes

l ArubaOS 8.0.0.0 Quick Start Guide

l ArubaOS 8.0.0.0 User Guide

l ArubaOS 8.0.0.0 CLI Reference Guide

l ArubaOS 8.0.0.0 API Guide

l Aruba Mobility Master Licensing Guide

l Aruba Mobility Master Installation Guide

l Aruba VMC Installation Guide

l Aruba Wireless Access Point Installation Guide

Conventions
The following conventions are used throughout this document to emphasize important concepts:

Type Style Description

italics This style is used to emphasize important terms and to mark the titles of books.

system items This fixed-width font depicts the following:

l Sample screen output

l System prompts

l File names, software devices, and specific commands when mentioned in the text

commands In the command examples, this bold font depicts text that you must type exactly as
shown.

<arguments> In the command examples, italicized text within angle brackets represents items that
you should replace with information appropriate to your specific situation. For
example:
# send <text message>

In this example, you would type “send” at the system prompt exactly as shown,
followed by the text of the message you wish to send. Do not type the angle brackets.

[optional] Command examples enclosed in brackets are optional. Do not type the brackets.

{Item A |

Item B}

In the command examples, items within curled braces and separated by a vertical bar
represent the available choices. Enter only one choice. Do not type the braces or bars.

Table 4: Typographical Conventions

The following informational icons are used throughout this guide:

Indicates helpful suggestions, pertinent information, and important things to remember.



Indicates a risk of damage to your hardware or loss of data.

Indicates a risk of personal injury or death.

Contacting Support

Main Site arubanetworks.com

Support Site support.arubanetworks.com

Airheads Social Forums and
Knowledge Base

community.arubanetworks.com

North American Telephone 1-800-943-4526 (Toll Free)

1-408-754-1200

International Telephone arubanetworks.com/support-services/contact-support/

Software Licensing Site licensing.arubanetworks.com

End-of-life Information arubanetworks.com/support-services/end-of-life/

Security Incident Response Team
(SIRT)

Site: arubanetworks.com/support-services/security-
bulletins/

Email: sirt@arubanetworks.com

Table 5: Contact Information
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Chapter 1
Mobility Master Configuration Hierarchy

The ArubaOS 6.x and earlier release trains consist of a flat configuration model containing global and local
configurations. Global configurations are applied to the master controller and can only be propagated to each
local controller through the master. The respective local configurations are applied directly to each master or
local controller.

Mobility Master (ArubaOS 8.0) uses a centralized, multi-tier architecture under a brand new UI that provides a
clear separation between management, control, and forwarding functions. The entire configuration for both
the Mobility Master and managed devices is set up from a centralized point, thereby simplifying and
streamlining the configuration process. Mobility Master consolidates all-master, single master-multiple local,
and multiple master-local deployments into a single deployment model.

Mobility Master (mm) takes the place of a master controller in the network hierarchy. A single Mobility Master
or a cluster of Mobility Masters oversees controllers that are colocated (on-premise local controllers or off-
campus branch office local controllers). Each Mobility Master cluster is referred to as a Mobility Master domain.
All the controllers that connect to Mobility Master act as managed devices (md). In a large campus, there may
be multiple Mobility Master domains.

This section provides details on the following topics:

l Enhancements

l Configuration Hierarchy

l Centralized Configuration

l Configuration Validation

l Configuration Distribution

l ZTP and Branch Support

l Redundancy

l Serviceability

l Auditing

l Custom Certificates

l User Interface

Enhancements
The following enhancements have been made for the Mobility Master configuration model:

l Multi-tier configuration hierarchy

l Centralized configuration

l Centralized validation

l ZTP and branch support

l Efficient configuration distribution

l New parser and CLI infrastructure

l Northbound APIs
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Configuration Hierarchy
In the ArubaOS 6.x and earlier release trains, multiple local controllers are forced to share a global configuration
or require users to set up multiple master controllers and duplicate configuration information to apply
different global configurations to different local controllers.

Figure 1 Configuration Heirarchy

The Mobility Master hierarchy simplifies the configuration process by supporting multiple configurations for
multiple deployments using a single master controller. Configuration elements can be mapped to one or more
end devices, such as a managed device or VPN concentrator. Common configurations across devices are
extracted to a shared template, which merges with device-specific configurations to generate the configuration
for an individual device.

Figure 2 Example of the Configuration Hierarchy



Figure 2 provides an example of the configuration hierarchy. The solid lines represent the hierarchy, the dotted
arrows represent the device mapping, and each box represents a node in the hierarchy. When a device is added
to Mobility Master, it must be mapped to a node or node-path in order to inherit configurations from the
hierarchy. An explicit configuration node is also created for each device so that any device-specific
configurations can be added directly to that node. Any device that is managed by Mobility Master is known as a
managed device. For example, device m2 in Figure 2 retrieves all device-specific configurations from the
Device m2 Specific node. Since the Device m2 Specific node is mapped to the domain2, md, and Root
nodes, the device also receives configurations from those nodes.

Each node contains a unique combination of common and device-specific configurations. The root node
appears by default upon logging in to Mobility Master CLI. Additional nodes can be created using the
configuration node command. To access a particular node, execute the change-config-node <node-path>
command.

The configuration hierarchy contains the following nodes and node structure:

Category Node
Name Node Description

Mobility Master / Configurations common to Mobility Master and its managed
devices (the root node).

/md Configurations common to all managed devices. The user can
create additional nodes under this node.

/mm Configurations common to the primary and standby Mobility
Master (VRRP pair).

/mm/mynode Configurations specific to a particular Mobility Master. This can
only be edited on the respective Mobility Master.

Stand-alone Controller /mm Configurations common to the primary and standby stand-alone
controllers (VRRP pair).

/mm/mynode Configurations specific to a particular stand-alone controller.
This can only be edited on the respective stand-alone controller.

Managed device /mm Configurations synced from Mobility Master.

/mm/mynode Configurations made locally on the managed device (remote
override).

Table 6: Nodes and Node Structure

The term "mm" refers to Mobility Master and "md" refers to managed device.

Configurations for a node are obtained by traversing the node-path from the root node to the given node. For
example, the m1 device in Figure 2 receives configurations from all nodes along the Root > md > domain1 >
Device m1 Specific node-path. Configurations that are set lower in the hierarchy (child node) can have more
precedence than the same configurations set higher in the hierarchy (parent node), depending on the
configuration type. In a single-instance configuration, such as the ESSID name, configurations from a child or
device-specific node override common configurations from a parent node. In a multi-instance configuration,
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such as a server in an Auth Server group, configurations from a child node are placed in addition to the parent
node configuration. For example, if a parent node specifies two servers in the Auth Server group, and the child
node specifies three servers in the same group, the device is provisioned with a total of five servers.

The configuration hierarchy is not the same as the physical topology. The hierarchy provides a simple way to
organize configurations so that configuration elements can be shared across multiple devices without being
duplicated. Configurations that are added to the root node, for example, are applied to all nodes within the
hierarchy, while configurations that are only applied to a specific region override configurations for the
corresponding child nodes. Order-dependent configurations, however, cannot be overridden. These
configurations can only be set up once in the network hierarchy. Configuration hierarchies are tailored and
organized to meet the unique needs of each customer.

Mobility Master Configuration
The Mobility Master that provides this configuration service to other devices in the network also contains its
own configuration. The Mobility Master configuration is obtained through nodes in the hierarchy labeled /mm
or /mm/mynode. Configurations under the /mm node, which are shared by the redundant Mobility Master
pair (primary and standby Mobility Masters), are synced to the standby Mobility Master. Configurations under
/mm/mynode are synced to individual Mobility Master devices.

Allowed Node Operations
The following node operations are allowed on Mobility Master:

l Create Node: Creates a new node as the child of an existing node in the configuration hierarchy (system-
generated or user-created)

l Add Device: Associates a device to an existing node in the hierarchy. This device inherits configurations
from all nodes between the root node and the device (node-path).

l Delete Node: Deletes an existing user-created node or node without any child nodes. System-generated
nodes cannot be deleted. Only leaf nodes without any child nodes can be deleted.

l Delete Device: Deletes a currently associated device from the configuration hierarchy. This will cause the
device to reload and erase all configurations received from Mobility Master.

l Clone Node: Copies the configuration of an existing node into a new node. The new node is created as a
child of an existing node in the hierarchy.

Access Permissions
The Mobility Master management domain can be large and widespread across various geographic regions.
Multiple admin users should be authorized to make changes to the configuration in order to simplify the
management process between different regions. The legacy ArubaOS management domain grants access to
admin users to modify any configuration in the system, which can impact both Mobility Master and/or any
managed device managed by the master. Mobility Master limits the editing scope of the admin user to
individual node-paths within the configuration hierarchy.

Each management user is granted editing permissions for a given node, allowing the user to modify the
configuration for that node and any child node within its node-path. The user, however, cannot modify any
parent nodes or nodes on a different path in the hierarchy. Users can view configurations for any node in the
hierarchy to refer to a parent node configuration or verify that the derived configuration for a device matches
the parent node configuration.

l Management users that are configured under the root (/) or Mobility Master (/mm) nodes are granted
editing permissions for Mobility Master.

l Management users that are configured under mynode (/mm/mynode) can modify configurations under
/mm/mynode for the respective Mobility Master, stand-alone controller, or managed device.



l Management users that are configured under a managed device can modify configurations for that
managed device.

l Only the management users that are configured under the root node can modify configurations on both
Mobility Master and managed devices.

Centralized Configuration
Mobility Master uses a centralized configuration application to maintain all configurations under the
management domain, eliminating the use of multiple points of contact to apply global and local configurations
to each managed device. The distinction between global and local configurations is no longer applicable, as any
configuration can be applied anywhere in the system through the centralized configuration application.
Instead, configurations can be organized by placing all common configurations at a higher level of the hierarchy
(for example, mm on Figure 3), and all device or group-specific configurations at the lower levels (for example,
mynode on Figure 3).

Order-dependent configurations, such as roles and ACLs, cannot be overridden. These configurations can only be set
up once in the network hierarchy.

Figure 3 The Configuration Hierarchy Viewed in theWebUI

Example of the configuration hierarchy:
(host)[mynode] #show configuration node-hierarchy

Configuration node hierarchy

----------------------------

Config Node Type

----------- ----

/ System

/md System

/md/00:0c:29:b0:12:93 Device

/md/test User

/md/test/00:0c:29:3c:11:91 Device

/mm System

/mm/mynode System

Validation and Application Processes
When a user enters a configuration into a managed device, the configuration is validated. The validated
configuration is accepted by the system but does not take effect. When the configuration is committed, it
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takes effect and is stored in the persistent memory, allowing users to verify the configuration before making it
operational.

This separation of validation and application processes is applied to both Mobility Master and the managed
devices. Since each node can be managed by a different admin user, the commit operation is executed on a
per-node basis. The commit operation also follows the configuration hierarchy. For example, if a configuration
has a dependency, the dependent configuration must be present on that node or one of the parent nodes in
order for it to succeed.

Configurations are classified as pending config or committed config on each node. A pending config refers
to a configuration that is validated on a node, but not yet committed. A committed config refers to all
configurations entered on the node that are committed by the user. Users can view pending configurations at
any time to commit, purge, or leave the configuration uncommitted. Pending configurations are only allowed
on one node at any given time in a given configuration sub-tree.

Example of a committed configuration:
(host) [mynode] #show configuration committed /md

Thu Jun 09 12:10:56.167 2016

ip access-list mac policy

!

ip access-list eth eth

!

ip access-list session apprf-guestthistime-guest-logon-sacl

!

ip access-list session apprf-server-derived-sacl

!

ip access-list session apprf-newest-sacl

!

ip access-list session newPolicy

!

user-role guestthistime-guest-logon

access-list session logon-control

access-list session captiveportal

!

user-role newest

!

user-role server-derived

!

interface gigabitethernet 0/0/0

Configuration Validation
Mobility Master provides a simple and organized validation process using a centralized validation model that
performs various types of validations for different targets. Configuration validation falls under one of the
following categories:

l Syntax Validation: Basic parser validations (for example, making sure the syntax of a command is correct,
the data type is correct, or a value is within a valid range).

Roles, ACLs, and pools (DHCP, VLAN, tunnel, and NAT) must be written in lower-case. Passwords, crypto keys, and
ESSIDs can be written in both upper-case and lower-case.

l Semantic Validation: Custom application-specific validations (for example, dependency checks across
commands or instance count limits). Dependency checks are limited to the nodes from which the target
device is inheriting the configuration.



l Platform Validation: Platform model-specific validations (for example, determining which features are
supported on a platform or the type and count of ports on a platform)

Validation is not available on the setup dialogue. Users must manually verify the setup dialogue information for each
managed device.

Validation Failures
If a command does not pass validation, it is rejected and will not be included in the pending configuration for
that node. If a new device is added that cannot support an existing configuration, the device add is rejected.

Configuration Distribution
Mobility Master includes two types of configuration distributions to the managed devices:

l Partial Configuration Synchronization

l Full Configuration Sync

Partial Configuration Synchronization
When a user attempts to commit a configuration on a node in the Mobility Master hierarchy, a partial
configuration is generated for that node and all of its child nodes, and the global configuration identifier
(config-id) increases by one. The partial configuration contains the delta of valid configurations made since the
previous (successful) configuration commit. If a configuration has been deleted from a given node but still
appears on a parent node, the configuration is inherited and included in the partial configuration for that node.

Mobility Master distributes the partial configuration to each managed device that is impacted by the
configuration change. When the configuration is applied to the device successfully, the config-id of the
managed device is updated with the latest number sent by Mobility Master. The updated config-id is
communicated back to Mobility Master through the next heartbeat message, completing the partial
configuration process.

Full Configuration Synchronization
When a new device is added to Mobility Master, Mobility Master sends a full effective device configuration to
the managed device on which the device is attached. The resulting configuration and config-id are sent to the
corresponding device.

After the configuration has been applied to the device successfully, the config-id of the managed device is
updated with the latest number sent by Mobility Master. The updated config-id is communicated back to
Mobility Master through the next heartbeat message, thereby completing the configuration process.

Example of a full effective device configuration:
(host) [mynode] #show configuration effective /md

Thu Jun 09 12:12:07.875 2016

crypto-local pki ServerCert default-self-signed default-self-signed

crypto-local pki PublicCert master-ssh-pub-cert master-ssh-pub-cert

ip access-list mac policy

!

ip access-list eth eth

!

ip access-list eth validuserethacl

permit any

!

!

ip access-list route uplink-lb-cfg-racl
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!

aaa tacacs-accounting

!

netservice svc-smb-udp udp 445

netservice vnc tcp 5900 5905

netservice svc-noe udp 32512 ALG noe

netservice svc-cfgm-tcp tcp 8211

netservice svc-netbios-ssn tcp 139

netservice svc-syslog udp 514

Bulk Edit
The bulk edit support feature enables you to do a bulk configuration in the Mobility Master. This option helps
reduce the time taken to perform configuration tasks individually. Follow the steps below to do a bulk edit:

1. In the Managed Network node hierarchy, navigate to Configuration > Tasks > Bulk configuration
upload.

2. Click Download sample template.

3. Enter values in the fields provided in the template.

4. Save the file.

5. Select Browse and navigate to the path where the template is stored.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

When devices are added using the bulk edit feature, each template file can include up to 400 devices.

ZTP and Branch Support

Throughout this section, a branch controller is referred to as a managed device.

Zero Touch Provisioning (ZTP) automates the managed device deployment process, removing the need for
professionals to deploy managed device on remote sites. Factory-default managed device auto-discover
Mobility Master, join the central configuration application, download configurations from Mobility Master, and
become operational without requiring any user intervention. Users deploying these devices are only required
to handle the physical wiring (for example, the power supply or network connectivity).

Branch Support
The branch support solution introduced in ArubaOS 6.4.3 includes the auto-bootstrap of managed device and
configurations downloaded from the master controller. With a centralized configuration platform and flexible
hierarchy model, Mobility Master introduces the following enhancements to the branch solution:

l Mobility Master supports the complete set of commands from a central configuration application, or central
configurator.

l ZTP support is extended to campus and branch deployments. The local role has been eliminated, extending
the branch role to support other deployments as a managed device.

l More deployment scenarios are supported, allowing for flexible location and reachability options for the
central configurator, which can reside within a data center or DMZ.

l A consistent hierarchical configuration model is used for both campus and branch deployments.



l IP Pool carving is integrated into the hierarchy with added flexibility.

l Users can apply device-specific configurations directly to a device-specific node without requiring a separate
configuration group with the new configurations. Support for the bulkedit feature has been extended to
include more configuration types and provide a simple mechanism to specify device-specific configuration
under one location.

l Managed devices authenticate Mobility Master using the self-signed certificate of Mobility Master, which
can be downloaded from Aruba Activate.

l Dynamic pool management is extended to carve addresses for VLAN interfaces that do not run a DHCP
server. The VLAN Pool function has been added to separate user VLANs from controller IP VLANs when the
DHCP server only runs on the user VLANs. DHCP pool carving is also integrated into the existing DHCP
pools, making all static DHCP pool configurations available for dynamically carved DHCP pools.

The Controller IP VLAN for a managed device must be set manually if the managed device is using a DHCP IP.

Managed devices obtain the central configurator’s IP address through Aruba Activate or the Setup Dialog. The
central configurator is authenticated by the managed devices using a factory certificate, custom certificate, or
PSK. For more details on ZTP and branch support, see Managed Devices at Branch Offices.

The following tables summarize the options that are available for various deployment scenarios:

Provisioning Type Auto Manual

ZTP Mode Activate Setup Dialog Box (Mini/Full)

Authentication Method Factory
Certificate

Hybrid
Certificate

Factory
Certificate

Custom
Certificate

Hybrid
Certificate

PSK

Managed
Device

Master

7xxx 7xxx ü x ü ü x ü

7xxx Mobility
Master

x ü* x ü ü** ü

x86 7xxx x x x ü ü*** ü

Table 7: Deployments with a Configuratorin a Demilitarized Zone (DMZ)
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Provisioning Type Auto Manual

x86 Mobility
Master

x x x ü x ü

ü Deployment that contains a configurator in a DMZ
x Deployment that does not contain a configurator in a DMZ

*** Mobility Master authenticates 7xxx using a factory certificate; 7xxx authenticates Mobility Master using a custom/self-
signed certificate downloaded automatically from Activate

*** Mobility Master authenticates 7xxx using a factory certificate; 7xxx authenticates Mobility Master using a manually
uploaded custom/self-signed certificate

*** x86 authenticates 7xxx using a factory certificate; 7xxx authenticates x86 using a manually uploaded custom/self-
signed certificate

A Hybrid certificate implies that Mobility Master authenticates a device using a factory certificate, and a device
authenticates Mobility Master using a custom/self-signed certificate.

Provisioning Type Auto Manual

ZTP Mode Activate Setup Dialog Box (Mini/Full)

Auth Method Factory
Certificate

Hybrid
Certificat

e

Factory
Certificate

Custom
Certificate

Hybrid
Certificat

e

PSK

Managed
Device

VPN Concentrato
r

7xxx 7xxx ü x ü ü x ü

x86 7xxx x x x ü ü* ü

7xxx Non-Aruba x x x ü x ü

x86 Non-Aruba x x x ü x ü

ü Deployment that contains a configurator NOT in a DMZ
x Deployment that does not contain a configurator outside the DMZ

* x86 authenticates 7xxx using a factory certificate; 7xxx authenticates x86 using a manually uploaded custom/self-
signed certificate

Table 8: Deployments with a Configurator NOT in a DMZ

Mobility Master also communicates with the Activate server to obtain a whitelist of managed devices, the
configuration nodes mapping to the devices, the controller model, and (optional) VPN concentrator
information. This information can also be entered manually as part of the configuration device command



that is used to add devices to a configuration hierarchy. Mobility Master validates the end devices with the
whitelist and pushes the configuration based on the device-configuration node mapping.

By default, a device that is not mapped to any configuration node does not receive any configuration. The user
may specify a default node to automatically push configurations to such devices using the configuration
device default-node command.

Redundancy
Mobility Master supports the Virtual Router Redundancy Protocol (VRRP) for master redundancy. The entire
configuration hierarchy is synced from the primary Mobility Master to the redundant Mobility Master, except
any configurations under /mm/mynode. Configurations common to both the primary and redundant
Mobility Masters are placed under the /mm node so that they can be synced to the redundant controller.
Configurations specific to individual Mobility Masters must be placed under /mm/mynode on the respective
Mobility Master. For example, IP address and VRRP configurations are different for each device under Mobility
Master. These configurations can be placed under the respective /mm/mynode for each device, while
configurations for Mobility Master services can be placed under the /mm node.

Initial Redundancy Configuration
When redundancy is configured for the first time or the peer IP is modified, it is considered to be in the initial
redundancy relationship establishment state. After the VRRP exchange determines the role for each Mobility
Master in this state, the standby Mobility Master cleans up its existing configuration state, except mynode, and
rebuilds the configuration hierarchy using the configuration synced from the primary Mobility Master.

Incremental Configuration Changes
After the primary and standby Mobility Masters have performed the initial synchronization and reached a
stable state, any incremental configuration changes committed on the primary Mobility Master results in a
configuration sync with the standby.

Any changes made to mynode on the primary Mobility Master are not synced to the standby Mobility Master.
The standby Mobility Master contains its own version of the mynode configurations, and so these changes
must be made directly to the standby Mobility Master. Configuration changes for other nodes are not
permitted on the standby Mobility Master. When mynode is configured on the standby Mobility Master, the
config-id does not change because the modifications are local.

Serviceability
Managed devices are always serviceable from the centralized management location. When a managed device
boots up for the first time under the factory default state, it auto-provisions and establishes connectivity to
Mobility Master through ZTP. Managed devices can also be provisioned manually through the setup dialog
box. Managed devices can encounter connectivity loss due to bad configurations, network connectivity issues,
and so on. The system attempts to recover from these situations when possible.

Bad Configuration Recovery
Certain configurations, such as those in the following list, can interfere with the connectivity between managed
devices and Mobility Master:

l Uplink port shut

l Partially configured uplink VLAN

l Limiting bandwidth contract policy

ArubaOS 8.0.0.0 | User Guide Mobility Master Configuration Hierarchy |  44



45 | Mobility Master Configuration Hierarchy ArubaOS 8.0.0.0  | User Guide

l Bad ACL

Bad configurations can be caused by simple typo errors. Even if the user discovers the error, the bad
configuration may have already caused connectivity loss, preventing the user from pushing the correct
configuration to the managed device.

Mobility Master supports an auto-rollback mechanism that reverts the managed device to the last known good
configuration prior to the management connectivity loss. Mobility Master also indicates if a device has
recovered from a bad configuration through the show switches command output. The output for this
command labels the Configuration State for the managed device as CONFIG ROLLBACK if the device has
recovered connectivity using the rollback configuration. When the user fixes the bad configuration on Mobility
Master, the managed device recovers automatically, and the state changes to ‘UPDATE SUCCESSFUL’.

Example output for the show switches command:
(host) [mynode] #show switches

Thu Jun 09 12:13:45.735 2016

All Switches

------------

IP Address IPv6 Address Name Location Type Model

Version Status Configuration State Config Sync Time (sec) Config ID

---------- ------------ ---- -------- ---- ----- -----

-- ------ ------------------- ---------------------- ---------

192.192.192.1 None TECHPUB_MASTER Building1.floor1 master ArubaMM

8.0.0.0-svcs-ctrl_55038 up UPDATE SUCCESSFUL 0 27

192.192.192.2 None TECHPUB_STANDBY Building1.floor1 standby ArubaMM

8.0.0.0-svcs-ctrl_55038 up UPDATE SUCCESSFUL 10 27

192.192.189.1 None TECHPUB_LC1_189.1 Building1.floor1 MD Aruba7010

8.0.0.0-svcs-ctrl_55038 up UPDATE SUCCESSFUL 0 27

192.192.192.3 None TECHPUB_x86_LC Building1.floor1 MD VMC-TACTICAL

8.0.0.0-svcs-ctrl_55038 up UPDATE SUCCESSFUL 0 27

192.192.189.2 None TECHPUB_LC2_189.2 Building1.floor1 MD Aruba7005

8.0.0.0-svcs-ctrl_55038 up UPDATE SUCCESSFUL 0 27

Total Switches:5

Disaster Recovery
If auto-rollback from a bad configuration fails, and connectivity between the managed device and Mobility
Master remains disrupted, users can enable Disaster Recovery mode on the managed device using the
disaster-recovery on command. Under the regular mode, the /mm node downloads configurations from
Mobility Master that cannot be modified directly on each managed device. Disaster Recovery mode grants
users access to the /mm node through the managed devices while blocking any further configuration syncs
from Mobility Master. With full control of the /mm node, users can make local modifications on each managed
device to restore connectivity to Mobility Master.

Local configurations are only used for debugging purposes and are not visible on the Mobility Master.

After connectivity is restored and verified, the user must fix the configuration on Mobility Master and exit the
Disaster Recovery mode. When the user exits Disaster Recovery mode from the managed device, a full
configuration sync is triggered between the managed devices and Mobility Master, which now contains the
latest effective configurations.

Enabling Disaster Recovery mode in the CLI:
(host) [mynode] #disaster-recovery on

*******************************

Entering disaster recovery mode

*******************************



(DR-Mode) [mynode] #

Disabling Disaster Recovery mode in the CLI:
(DR-Mode) [mynode] #disaster-recovery off

(host) [mynode] #

Initial Provisioning Recovery
If the managed devices fail to connect to Mobility Master on multiple attempts during the initial provisioning
process (for example, when the Mobility Master IP or fully qualified domain name (FQDN) is entered incorrectly
in Aruba Activate), the managed device deletes all provisioning information and restarts the auto-provisioning
process. The user is expected to correct the provisioning information under Aruba Activate. After the
provisioning information is corrected, the managed device automatically recovers during the next auto-
provisioning attempt.

Auditing
Configurations undergo an exhaustive validation process on Mobility Master before they are pushed to the
managed device (see Configuration Validation for more details). When a configuration is validated successfully
but fails to apply to the managed device, the Mobility Master auditing feature provides visibility into these
configuration failures. Users can understand why the command was not applied to the managed device and
potentially modify the configuration to fix the error. However, there could be instances when configuration
cannot be applied on the managed device. These failures are generally due to runtime state in the network.

When there is a failure event, a red marked sign under ALERT is displayed on the Dashboard. To get details on
the failure navigate to Diagnostic > Logs > Audit.

If a configuration fails to apply to a managed device, the managed device sends an alert to Mobility Master
indicating the command that has failed and the reason for failure. Users can view the first failed command and
a list of failed devices on Mobility Master using the show switches command. Users can also view the
complete list of pending commands using the show configuration failure command.

Commands can be fixed manually (for example, user modification) or automatically (for example, a busy
application starts responding). When a failed command is fixed, the managed device clears the failure alert,
which allows Mobility Master to remove the failure from the list of failed devices. The show switches
command output updates the status of these failed devices to ‘UPDATE SUCCESSFUL’.

Example output for the show configuration failure command:
(host) [mynode] #show configuration failure

Configuration Failure

---------------------

Command: interface vlan 10 ip address dhcp-client

Process: Layer2/3

Message: Vlan 10 no longer exists

Total Failures: 1

Local Configuration on the Managed Device
The entire configuration for a managed device is expected to be set up centrally from Mobility Master.
However, users can make configuration changes locally on each managed device for debugging purposes. Since
this mechanism is only used for debugging purposes, these configuration changes are not visible from Mobility
Master. The local configurations are merged with the configurations from Mobility Master to create an
effective configuration for the managed device. Configurations made directly on the managed device take
precedence over the configurations received from Mobility Master. Users can only view these configurations
on the respective managed device using the show configuration committed command.
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Default Configuration
The factory default configuration appears in the root node of the Mobility Master hierarchy. The root node is
not editable by the user. Any modifications to the default configuration must be made on the lower nodes.

AP Master Considerations
When an existing deployment is migrated to Mobility Master, the device currently serving as the AP master can
continue to serve as the AP master after migration. If a local controller acts as the AP master and converts into
a managed device during migration, the corresponding AP group and system profile configurations must also
be migrated to the new hierarchy so that the controller can continue to inherit those configurations. If a
master controller acts as the AP master and converts into a managed device during migration, the controller
continues to inherit all corresponding configurations to avoid making any changes to the AP boot parameters.
If an AP master device is removed from the network, the corresponding configurations must be moved to
another node in the hierarchy, and the AP’s master_ip must be mapped to the new device. Mobility Master
cannot be used as the AP master since APs are not allowed to terminate on a Mobility Master. If the
AP manager on the Mobility Master receives an AP HELLO message, the message is dropped. Mobility Master
images are no longer bundled with any AP images.

Custom Certificates
Custom certificates can be uploaded to the end devices managed by Mobility Master in one of two ways:

l The certificate is uploaded directly to the end device.

l Certificates are stored on Mobility Master and uploaded to the respective end devices when the devices
connect to the managed device at startup.

Certificates can also be uploaded to the end devices through the CLI:
copy scp: <IPAddr> <username> <FilePath/OriginalFile> flash: <CADestinationName>

crypto pki-import pem trustedCA < CADestinationName> <CAOriginalFile>

copy scp: <IPAddr> <username> <FilePath/OriginalFile> flash: <ServerDestinationName>

crypto pki-import pfx ServerCert <ServerDestinationName > <ServerOriginalFile> password

conf t

crypto-local pki TrustedCA < CADestinationName > <CAOriginalFile>

crypto-local pki ServerCert <<ServerDestinationName > <ServerOriginalFile>

end

Centralized Licensing
Mobility Master contains a centralized licensing server that supports multiple license pools, allowing users to
apply a different set of licenses to each group of devices with common feature requirements.

By default, Mobility Master is configured with only one license pool on the root node, which contains all
Mobility Master licenses. If no additional pools are created, all devices in the hierarchy share the single license
pool. Users can add a new pool to any node in the hierarchy, and all devices within the subsequent node-path
(child nodes) are included in that license pool. Devices that are not assigned to a license pool share the licenses
that have not already been allocated to any user-defined pool.

Refer to the Aruba Mobility Master Licensing Guide for more details on the Mobility Master's centralized
licensing architecture.

User Interface
Mobility Master can be accessed through three different interfaces for maximum visibility and functionality:



l Command Line Interface

l WebUI

l JSON APIs

Command Line Interface
Though the Mobility Master CLI remains largely similar to the CLI used in the ArubaOS 6.x and earlier release
trains, the following changes have been made:

l The Mobility Master architecture spawns a new CLI session every time a user logs in to the CLI through
Telnet, SSH, or Console. Since each CLI session is processed independently, multiple sessions do not block
one another.

l New commands and parameters have been added to support new functions and provide increased
visibility. See the ArubaOS CLI Reference Guide for more details.

l A small set of existing commands has been modified for consistency and concision.

l Configurations must be performed in the context of a node in the configuration hierarchy. Users with the
necessary privileges can change the node context on the CLI prompt.

l Users are required to commit configurations on Mobility Master before the configurations can be pushed
and applied to the device.

WebUI
ArubaOS 8.0 supports a user interface that allows users to configure, manage, upgrade, and debug the system.
The new configuration hierarchy is also managed through the UI. For more details, refer to Configuration User
Interface.

JSON APIs
JSON APIs are exposed for all configuration objects in Mobility Master and client location information from the
Analytics and Location Engine (ALE). Configuration APIs allow users to send configurations to Mobility Master
and view those modifications through their own management system (CLI or WebUI). APIs in an operational
state are also exposed. ALE APIs return client location information through the ALE server. Though most of this
data is structured in the JSON format, some data may be arranged in a pre-formatted string. For more details
on JSON APIs, refer to the ArubaOS 8.0 NBAPI Guide. For more information about ALE APIs, refer to the
Analytics and Location Engine 2.0.0.x API Guide.
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Chapter 2
Configuration User Interface

The Mobility Master user interface runs on a flat hierarchy profile design that provides ease-of-use through a
simple navigation model.

Navigation Model
Each page of the Mobility Master UI is divided into four sections:

l Header-left: Displays the Aruba logo and node-path. The node-path can be expanded to reveal the
network hierarchy.

l Header-right: Contains the Help (?) button, user preference drop-down list, and Pending Changes
button.

l Left Navigation Panel: Displays the main menu.

l Work-screen: Displays the content description for a menu item or tab.

Figure 4 Overview of the User Interface

Menu
The Mobility Master menu is divided into two levels: Level-1 (for example, Configuration, Diagnostics, and
Maintenance) and Level-2 (for example, Authentication, Interfaces, and Services). Each Level-1 item can be
expanded to display the corresponding Level-2 items. Each Level-2 item is further expanded to organize and
group content on the work-screen. Based on the following dependencies, certain menu, tab, or accordion items
may be visible or hidden in the UI:

l Selected node

l License

l Model

l Switch/User Role
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Figure 5 TheWebUI Menu, Tabs, and Accordion Panels

Profile Configuration Interface
The profile configuration model is based off a single-page, flat hierarchy architecture, in which only a portion of
the page is updated based on the action performed. The left-navigation panel, headers, and footer remain
constant throughout all changes and selections, while only the work-screen is updated based on the menu, tab,
and profile selections.

When a user selects a profile from the work-screen, the individual profile is expanded to display the
configuration information. The complete list of profiles remains visible so that the user can display or minimize
a profile at any time.

Figure 6 Profile Configuration in theWebUI

Tables
Mobility Master presents data and configuration information through two types of tables: primary tables and
secondary tables. Primary tables display the main object of the page at the top of the screen (for example, the
Server Groups table under Configuration > Authentication > Auth Servers). By selecting a row from the
table, you can view and/or modify the configuration parameters for that entry in an editing pane that is
displayed at the bottom of the screen.



The secondary table is located within the editing pane of a selected row and provides more in-depth
information on each entry. For example, when you select the default server group entry from the Server
Groups (primary) table, the secondary Server Group > default table is displayed at the bottom of the screen.

Pending Changes
Commands are executed when a user clicks Save or Submit. The Save or Submit buttons are disabled by
default and can only be enabled when the user modifies a configuration on the page. When a user clicks the
Save or Submit button, the configuration change is pushed to the Pending Changes zone of Mobility
Master. Modifications are not applied to the network until all pending changes are deployed. Click Pending
Changes in the header-right section of the UI to view and deploy/discard all pending modifications.

Nodes cannot be edited if any parent or child node contains undeployed pending changes.

Figure 7 Pending Changes Window

Help Mode
The Help (?) button in the header-right section of the UI allows you to switch the system to help mode. All
non-active labels that appear in green italics indicates that help information is available for these labels.
Mouseover or click any green italic label to view the help information for that field in a pop-up window.
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Figure 8 HelpMode in theWebUI

Hierarchy Management
The Mobility Master UI allows users to create, modify, and delete all hierarchical nodes from a central location.
By clicking the node-path at the header-left section of the UI, you can reveal the entire network hierarchy. Click
a node to further expand the hierarchy and display its child nodes.

When a node is selected from the network hierarchy, users are directed to the corresponding configuration
profile. Any configuration changes made across the UI are executed and applied to the selected node.

For more information on the configuration hierarchy, see Mobility Master Configuration Hierarchy on page 34.
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Chapter 3
The Basic User-Centric Networks

This chapter describes how to connect an Aruba controller and an Aruba AP to your wired network. After
completing the tasks described in this chapter, see Access Points on page 489 for information on configuring
APs.

This chapter describes the following topics:

l Understanding Basic Deployment and Configuration Tasks on page 53

l Controller Configuration Workflow on page 56

l Connect the Controller to the Network on page 57

l Using the LCD Screen on page 58

l Configuring a VLAN to Connect to the Network on page 61

l Enabling Wireless Connectivity on page 65

l Configuring Your User-Centric Network on page 65

l Replacing a Controller on page 65

Understanding Basic Deployment and Configuration Tasks
This section describes typical deployment scenarios and the tasks you must perform while connecting to an
Aruba controller and Aruba AP to your wired network. For details on performing the tasks mentioned in these
scenarios, see other procedures within the Basic User-Centric Networks section of this document.

Deployment Scenario #1: Controller and APs on Same Subnet
Figure 9 Controller and APs on SameSubnet

In this deployment scenario, the APs and controller are on the same subnetwork and will use IP addresses
assigned to the subnetwork. The router is the default gateway for the controller and clients.There are no
routers between the APs and the controller. APs can be physically connected directly to the controller. The
uplink port on the controller is connected to a layer-2 switch or router.

For this scenario, you must perform the following tasks:

1. Run the initial setup wizard.

l Set the IP address of VLAN 1.

l Set the default gateway to the IP address of the interface of the upstream router to which you will
connect the controller.
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2. Connect the uplink port on the controller to the switch or router interface. By default, all ports on the
controller are access ports and will carry traffic for a single VLAN.

3. Deploy APs. The APs will use the Aruba Discovery Protocol (ADP) to locate the controller.

4. Configure the SSID(s) with VLAN 1 as the assigned VLAN for all users.

Deployment Scenario #2: APs All on One Subnet Different from Controller Subnet
Figure 10 APs All on One Subnet Different from Controller Subnets

In this deployment scenario, the APs and the controller are on different subnetworks and the APs are on
multiple subnetworks. The controller acts as a router for the wireless subnetworks (the controller is the default
gateway for the wireless clients). The uplink port on the controller is connected to a layer-2 switch or router;
this port is an access port in VLAN 1.

For this scenario, you must perform the following tasks:

1. Run the initial setup wizard.

l Set the IP address for VLAN 1.



l Set the default gateway to the IP address of the interface of the upstream router to which you will
connect the controller.

2. Connect the uplink port on the controller to the switch or router interface.

3. Deploy APs. The APs will use DNS or DHCP to locate the controller.

4. Configure VLANs for the wireless subnetworks on the controller.

5. Configure SSIDs with the VLANs assigned for each wireless subnetwork.

Each wireless client VLAN must be configured on the controller with an IP address. On the uplink switch or router, you
must configure static routes for each client VLAN, with the controller’s VLAN 1 IP address as the next hop.

Deployment Scenario #3: APs on Multiple Different Subnets from Controllers
Figure 11 APs onMultiple Different Subnets from Controllers

In this deployment scenario, the APs and the controller are on different subnetworks and the APs are on
multiple subnetworks. There are routers between the APs and the controller. The controller is connected to a
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layer-2 switch or router through a trunk port that carries traffic for all wireless client VLANs. An upstream
router functions as the default gateway for the wireless users.

This deployment scenario does not use VLAN 1 to connect to the layer-2 switch or router through the trunk port. The
initial setup prompts you for the IP address and default gateway for VLAN 1; use the default values. In later steps, you
configure the appropriate VLAN to connect to the switch or router as well as the default gateway.

For this scenario, you must perform the following tasks:

1. Run the initial setup.

l Use the default IP address for VLAN 1. Since VLAN 1 is not used to connect to the layer-2 switch or router
through the trunk port, you must configure the appropriate VLAN in a later step.

l Do not specify a default gateway (use the default “none”). In a later step, you configure the default
gateway.

2. Create a VLAN that has the same VLAN ID as the VLAN on the switch or router to which you will connect the
controller. Add the uplink port on the controller to this VLAN and configure the port as a trunk port.

3. Add client VLANs to the trunk port.

4. Configure the default gateway on the controller. This gateway is the IP address of the router to which you
will connect the controller.

5. Configure the loopback interface for the controller.

6. Connect the uplink port on the controller to the switch or router interface.

7. Deploy APs. The APs will use DNS or DHCP to locate the controller.

8. Now configure VLANs on the controller for the wireless client subnetworks and configure SSIDs with the
VLANs assigned for each wireless subnetwork.

Controller Configuration Workflow
The tasks in deploying a basic user-centric network fall into two main areas:

l Configuring and connecting the controller to the wired network (described in this section)

l Deploying APs (described later in this section)

The following workflow lists the tasks to configure an Aruba controller. Click any of the links below for details
on the configuration procedures for that task.

1. Connect the Controller to the Network.

2. Setting System Clock.

3. View current licenses and install new licenses.

4. For topologies similar to Deployment Scenario #3: APs on Multiple Different Subnets from Controllers), see
Configuring VLANs to connect the controller to your network. You do not need to perform this step if you
are using VLAN 1 to connect the controller to the wired network.

5. Configuring the Mobility Master IP Address. The Controller IP address is used by the controller to
communicate with external devices such as APs.

6. (Optional) Configuring the Loopback IP Address. You do not need to perform this step if you are using the
VLAN 1 IP address as the controller’s IP address. Disable spanning tree on the controller if necessary.

7. Configuring the Default Gatewayfor this controller if you need to configure a trunk port between the
controller and another layer-2 switch (shown in Deployment Scenario #3: APs on Multiple Different Subnets
from Controllers on page 55).

8. Trusted Vs. Untrusted Ports and VLANs for this controller.



Connect the Controller to the Network
To connect the controller to the wired network, run the initial setup to configure administrative information for
the controller.

Initial setup can be done using the browser-based Setup Wizard or by accessing the initial setup dialog via a
serial port connection. Both methods are described in the ArubaOS 8.0.0.0 Quick Start Guide and are referred
to throughout this chapter as “initial setup.”

This section describes the steps in detail.

Running Initial Setup
When you connect to the controller for the first time using either a serial console or a Web browser, the initial
setup requires you to set the role (master, managed device, or stand-alone) for the controller and passwords
for administrator and configuration access.

Do not connect the controller to your network when running the initial setup. The factory-default controller boots up
with a default IP address and both DHCP server and spanning tree functions are not enabled. Once you have
completed the initial setup, you can use either the CLI or WebUI for further configuration before connecting the
controller to your network.

The initial setup might require that you specify the country code for the country in which the controller will
operate; this sets the regulatory domain for the radio frequencies that the APs use.

You cannot change the country code for controllers designated for certain countries, such as the U.S. Improper
country code assignment can disrupt wireless transmissions. Many countries impose penalties and sanctions for
operators of wireless networks with devices set to improper country codes. If none of the channels supported by the
AP you are provisioning have received regulatory approval by the country whose country code you selected, the AP
will revert to Air Monitor mode.

The initial setup requires that you configure an IP address for the VLAN 1 interface, which you can use to access
and configure the controller remotely via an SSH or WebUI session. Configuring an IP address for the VLAN 1
interface ensures that there is an IP address and default gateway assigned to the controller upon completion
of the initial setup.

Connecting to the Controller after Initial Setup
After you complete the initial setup, the controller reboots using the new configuration. (Refer to the ArubaOS
8.0.0.0 Quick Start Guide for information about using the initial setup.) You can then connect to and configure
the controller in several ways using the administrator password you entered during the initial setup:

l You can continue to use the connection to the serial port on the controller to enter the command line
interface (CLI). (See Management Access on page 741 for information on how to access the CLI and enter
configuration commands.)

l You can connect an Ethernet cable from a PC to an Ethernet port on the controller. You can then use one of
the following access methods:

n Use the VLAN 1 IP address to start an SSH session where you can enter CLI commands.

n Enter the VLAN 1 IP address in a browser window to start the WebUI.

n WebUI Wizards.

This chapter and the user guide in general focus on CLI and standard WebUI configuration examples. However, basic
controller configuration and WLAN/LAN creation can be completed using the alternative tasks (wizards) from within
the WebUI. If you wish to use a configuration task, in the Managed Network node hierarchy, navigate to
Configuration > Tasks, click the desired task, and follow the imbedded help instructions within the task.
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7200 Series Controllers Port Behavior
The first two ports on the 7200 Series controllers, 0/0/0 and 0/0/1, are dual media ports and can be used for
any purpose. Ports 0/0/2 through 0/0/5 are fiber-based ports that can be used for any purpose. If the fiber-
based ports are connected with RJ45 or Small Form-factor Pluggable (SFP) transceivers, these ports can
function as 1 GBps ports. To access the controller, you can use port 0/0/0 to 0/0/5 when 0/0/2 through 0/0/5
are connected with RJ45 or SFP transceivers.

The following table describes the connector and speed supported for each physical interface of the 7200 Series
controllers.

Port Type Ports Connector Type Speed

10/100/1000 BASE-T Dual Media
Ports

0/0/0-0/0/1 RJ45 or SFP 1 GBps

10G BASE-X 0/0/2-0/0/5
SFP+ 10 GBps

RJ45 or SFP 1 GBps

Table 9: 7200 Series Controllers Ports

Using the LCD Screen
Some controllers are equipped with an LCD panel that displays a variety of information about the controller’s
status and provides a menu that allows for basic operations such as initial setup and reboot. The LCD panel
displays two lines of text with a maximum of 16 characters on each line. When using the LCD panel, the active
line is indicated by an arrow next to the first letter.

The LCD panel is operated using the two navigation buttons to the left of the screen.

l Menu: Allows you to navigate through the menus of the LCD panel.

l Enter: Confirms and executes the action currently displayed on the LCD panel.

The LCD has four modes:

l Boot: Displays the boot up status.

l LED Mode: Displays the mode that the STATUS LED is in.

l Status: Displays the status of different components of the controller, including Power Supplies and
ArubaOS version.

l Maintenance: Allows you to execute some basic operations of the controller such as uploading an image or
rebooting the system.

Function/Menu Options Displays

Displays boot status "Booting ArubaOS...

Table 10: LCD Panel Mode: Boot



Function/Menu Options Displays

Administrative LED MODE: ADM - displays whether the port is administratively enabled or dis-
abled.

Duplex LED MODE: DPX - displays the duplex mode of the port.

Speed LED MODE: SPD - displays the speed of the port.

Exit Idle Mode EXIT IDLE MENU

Table 11: LCD Panel Mode: LED Mode

Function/Menu Options Display Output

ArubaOS Version ArubaOS X.X.X.X

PSU Status Displays status of the power supply unit.

PSU 0: [OK | FAILED | MISSING]

PSU 1: [OK | FAILED | MISSING]

Fan Tray Displays fan tray status.

FAN STATUS: [OK | ERROR | MISSING]

FAN TEMP: [OK | HIGH | SHUTDOWN]

Exit Status Menu EXIT STATUS

Table 12: LCD Panel Mode: Status

Function/Menu Options Display Output

Upgrade Image Upgrade the software image on the selected partition from a predefined loc-
ation on the attached USB flash device.

Partition [0 | 1] Upgrade Image [no | yes]

Upload Config Uploads the controller’s current configuration to a predefined location on the
attached USB flash device.

Upload Config [no | yes]

Factory Default Allows you to return the controller to the factory default settings.

Factory Default [no | yes]

Media Eject Completes the reading or writing of the attached USB device.

Media Eject [no | yes]

System Reboot Allows you to reboot the controller.

Table 13: LCD Panel Mode: Maintenance
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Function/Menu Options Display Output

Reboot [no | yes]

System Halt Allows you to halt the controller.

Halt [no | yes]

Exit Maintenance Menu EXIT MAINTENANCE

Using the LCD and USB Drive
You can upgrade your image or upload a saved configuration by using your USB drive and your LCD
commands.

For more information on copying and transferring ArubaOS image and configuration files, see Managing Files on
Managed Device on page 787

Upgrading an Image
1. Copy a new controller image onto your USB drive into a directory named /Arubaimage.

2. Insert your USB drive into the controller’s USB slot. Wait for 30 seconds for the controller to mount the
USB.

3. Navigate to Upgrade Image in the LCD’s Maintenance menu. Select a partition and confirm the upgrade
(Y/N) and then wait for controller to copy the image from the USB drive to the system partition.

4. Execute a system reboot either from the LCD menu or from the command line to complete the upgrade.

Uploading a Saved Configuration
1. Make a copy of a controller configuration (with the .cfg file extension), and save the copied file with the

name Aruba_usb.cfg.

2. Move the saved configuration file onto your USB drive into a directory named /Arubaimage.

3. Insert your USB drive into the controller’s USB slot. Wait for 30 seconds for the controller to mount the
USB.

4. Navigate to Upload Config in the LCD’s Maintenance menu. Confirm the upload (Y/N) and then wait for
the upload to complete.

5. Execute a system reboot either from the LCD menu or from the command line to reload from the uploaded
configuration.

For detailed upgrade and instruction, refer to the Upgrade chapter in the ArubaOS 8.0.0.0 Release Notes.

Disabling LCD Menu Functions
For security purposes, you can disable all LCD menu functions by disabling the entire menu functionality using
the following commands:
(host)[md](config) #lcd-menu

(host)[md](lcd-menu) #disable menu

To prevent inadvertent menu changes, you can disable individual LCD menu functions using the following
commands:
(host)[md](lcd-menu) #disable menu maintenance ?

factory-default Disable factory defaulting via LCD

halt-system Disable system halt from LCD

media-eject Disable media eject via LCD



reload-system Disable system reload from LCD

upgrade-image Disable image upgrade via LCD

upload-config Disable config upload via LCD

To display the current LCD functionality from the command line, use the following command:
(host) [md] #show lcd-menu

Configuring a VLAN to Connect to the Network
You must follow the instructions in this section only if you need to configure a trunk port between the
controller and another layer-2 switch (shown in Deployment Scenario #3: APs on Multiple Different Subnets
from Controllers on page 55).

This section shows how to use both the WebUI and CLI for the following configurations (subsequent steps
show how to use the WebUI only):

l Create a VLAN on the controller and assign it an IP address.

l Optionally, create a VLAN pool. A VLAN pool consists of two more VLAN IDs which are grouped together to
efficiently manage multi-controller networks from a single location. For example, policies and virtual
application configurations map users to different VLANs which may exist at different controllers. This
creates redundancy where one controller has to back up many other controllers. With the VLAN pool
feature you can control your configuration globally.

VLAN pooling should not be used with static IP addresses.

l Assign to the VLAN the ports that you will use to connect the controller to the network. (For example, the
uplink ports connected to a router are usually Gigabit ports.) In the example configurations shown in this
section, a controller is connected to the network through its Gigabit Ethernet port 1/25.

l Configure the port as a trunk port.

l Configure a default gateway for the controller.

Creating, Updating, and Viewing VLANs and Associated IDs
You can create and update a single VLAN or bulk VLANS using the WebUI or the CLI. See Creating and Updating
VLANs on page 84.

In the WebUI configuration windows, clicking the Pending Changes button saves configuration changes so that they
are retained after the controller is rebooted. Clicking the Submit or Apply button saves changes to the running
configuration but the changes are not retained when the controller is rebooted. A good practice is to use the Submit
or Apply button to save changes to the running configuration and, after ensuring that the system operates as
desired, click Pending Changes.

You can view VLAN IDs in the CLI.
(host) #show vlan

Creating, Updating, and Deleting VLAN Pools

VLAN pooling should not be used with static IP addresses.

You can create, update, and delete a VLAN pool using the WebUI or the CLI. See Creating a Named VLAN on
page 85.
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Use the CLI to add existing VLAN IDS to a pool.
(host)[mynode](config) #vlan-name <name>

(host)[mynode](config) #vlan mygroup <vlan-ids>

To confirm the VLAN pool status and mappings assignments, use the show vlan mapping command:
(host) #show vlan mapping

Assigning and Configuring the Trunk Port
The following procedures configures a Gigabit Ethernet port as trunk port.

In the WebUI
To configure a Gigabit Ethernet port:

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > Ports.

2. In the Ports section, click the port that will connect the controller to the network.

3. Select Trunk from the Mode drop-down list.

4. Select a VLAN from the Native VLAN drop-down list.

5. Click Submit.

6. At the top of the window, click Pending Changes.

7. In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
To configure a Gigabit Ethernet port:
(host)[mynode](config) #interface gigabitethernet <slot>/<module>/<port>

(host)[mynode](config-submode) #switchport mode trunk

(host)[mynode](config-submode) #switchport trunk native vlan <id>

To confirm the port assignments, use the show vlan command:
(host) #show vlan

Configuring the Default Gateway
The following configurations assign a default gateway for the controller.

In the WebUI
To configure the default gateway:

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > IP Routes.

2. Click the Static Default Gateway accordion menu.

3. To add a new static gateway, click the Add button below the static IP address list.

a. Select Ipv4 from the IP version drop-down list.

b. In the IP Address field, enter an IP address with dot separators.

c. In the Cost field, enter a value for the path cost.

d. Click Submit.

4. You can define a dynamic gateway with the DHCP, PPPOE, or Cellular option by clicking the Dynamic
Default Gateway accordion menu.

a. In the Dynamic Default Gateway section, select Enabled for the DHCP, PPPoE or Cellular drop-down
list. If you enabled more than one dynamic gateway type, you must also define the cost for each
gateway route. The controller will first attempt to obtain a gateway IP address using the option with the



lowest cost. If the controller is unable to obtain a gateway IP address, it will then attempt to obtain a
gateway IP address using the option with the next-lowest path cost.

b. Click Submit.

5. At the top of the window, click Pending Changes.

6. In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
To configure the default gateway:
(host)[mynode](config) #ip default-gateway <ipaddr>|{import cell|dhcp|pppoe}|{ipsec <name>}

<cost> | mgmt | <nexthop>

Configuring the Loopback IP Address for the Controller
You must configure a loopback address if you are not using a VLAN ID address to connect the controller to the
network (see Deployment Scenario #3: APs on Multiple Different Subnets from Controllers on page 55).

After you configure or modify a loopback address, you must reboot the controller.

If configured, the loopback address is used as the controller’s IP address. If you do not configure a loopback
address for the controller, the IP address assigned to the first configured VLAN interface IP address is
considered. Generally, VLAN 1 is configured first and is used as the controller’s IP address. ArubaOS allows the
loopback address to be part of the IP address space assigned to a VLAN interface. For example, if VLAN 5
interface on the controller was configured with the IP address 10.3.22.20/24, the loopback IP address can be
configured as 10.3.22.220.

You configure the loopback address as a host address with a 32-bit netmask. The loopback address should be
routable from all external networks.

Spanning tree protocol (STP) is enabled by default on the controller. STP ensures a single active path between
any two network nodes, thus avoiding bridge loops. Disable STP on the controller if you are not employing STP
in your network.

In the WebUI
To configure a loopback IP address:

1. In the Managed Network node hierarchy, navigate to Configuration > System > General.
2. Click the Loopback Interface accordion menu.

3. Enter the IPv4 address and/or the IPv6 address in the corresponding text boxes.

4. Click Submit.

5. In the Managed Network node hierarchy, navigate to Configuration > System > More.

6. In Spanning Tree, you can turn off the spanning tree option by selecting Disabled from the Spanning
Tree drop-down list.

7. Click Submit.

8. At the top of the window, click Pending Changes.

9. In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.
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You must reboot the controller for the new IP address to take effect.

10.In the Mobility Master node hierarchy, navigate to Maintenance > Software Management > Reboot.

11.Select Yes for Save Current Configuration Before Reboot.

12.Click Reboot.

In the CLI
To configure a loopback IP address:
(host)[mynode](config) #interface loopback ip address <A.B.C.D>

(host)[mynode](config) #no spanning-tree

(host)[mynode](config) #write memory

(host)[mynode](config) #reload

The controller returns the following messages:
Do you really want to reset the system(y/n):

Enter y to reboot the controller or n to cancel.
System will now restart!

...

Restarting system.

To verify that the controller is accessible on the network, ping the loopback address from a workstation on the
network.

Configuring the System Clock
You can manually set the clock on the controller, or configure the controller to use a Network Time Protocol
(NTP) server to synchronize its system clock with a central time source. For more information about setting the
controller’s clock, see Setting System Clock on page 790.

Installing Licenses
For information on licenses installation, refer to the Aruba Mobility Master Licensing Guide.

Connecting the Controller to the Network
Connect the ports on the controller to the appropriately-configured ports on an L2 switch or router. Make sure
that you have the correct cables and that the port LEDs indicate proper connections. Refer to the Aruba
Mobility Master Installation Guide for details on the controller for port LED and cable descriptions.

In many deployment scenarios, an external firewall is situated between various Aruba devices. External Firewall
Configuration on page 616 describes the network ports that must be configured on the external firewall to allow
proper operation of the network.

To verify that the controller is accessible on the network:

l If you are using VLAN 1 to connect the controller to the network (Deployment Scenario #2: APs All on One
Subnet Different from Controller Subnet on page 54 and Deployment Scenario #3: APs on Multiple
Different Subnets from Controllers on page 55), ping the VLAN 1 IP address from a workstation on the
network.

l If you created and configured a new VLAN (Deployment Scenario #3: APs on Multiple Different Subnets
from Controllers on page 55), ping the IP address of the new VLAN from a workstation on the network.



Enabling Wireless Connectivity
Wireless users can connect to the SSID but because you have not yet configured authentication, policies, or
user roles, they will not have access to the network. Other chapters in the ArubaOS 8.0.0.0 User Guide describe
how to build upon this basic deployment to configure user roles, firewall policies, authentication,
authentication servers, and other wireless features.

Configuring Your User-Centric Network
Configuring your controller and AP is done through either the Web User Interface (WebUI) or the command
line interface (CLI).

l WebUI is accessible through a standard Web browser from a remote management console or workstation.
The WebUI includes configuration tasks that walk you through easy-to-follow configuration steps. Each task
has embedded online help. The tasks are:

n Provision New APs—basic AP configurations including LAN, Remote, LAN Mesh, and Remote Mesh
deployment scenarios.

n Controller—applicable only the first time the controller is brought UP; basic controller configuration
including system settings, Control Plane security, and cluster settings

n Create a New WLAN—creating and configuring new WLANs and LANs associated with the “default” ap-
group. Includes campus-only and remote networking.

Clicking Cancel from the tasks (wizards) return you to where you launched the tasks from. Any configuration
changes you entered are not saved.

l The command line interface (CLI) allows you to configure and manage controllers. The CLI is accessible from
a local console connected to the serial port on the controller or through a Telnet or Secure Shell (SSH)
session from a remote management console or workstation.

By default, you can only access the CLI from the serial port or from an SSH session. To use the CLI in a Telnet
session, you must explicitly enable Telnet on the controller.

Replacing a Controller
The procedures below describe the steps to replace an existing stand-alone controller and/or a redundant
controller. Best practices are to replace the backup controller first, and replace the active controller only after
the new backup controller is operational on the network. When you remove the active controller from the
network to replace it, the new backup controller takes over the active controller role. When you add a second
controller to the network, that second controller automatically assumes the role of a backup controller.

For information on the virtual mobility controller (VMC), refer to the Aruba VMC Installation Guide.

Replacing an RMA Device
If the controller being replaced was returned to Aruba as a Return Merchandize Authorization (RMA) device, the
license keys on the RMA controller cannot be directly transferred to a new device, and must be regenerated. To
generate new keys for a license on an controller returned as an RMA:

1. Navigate to the Aruba Software License Management website: https://licensing.arubanetworks.com/.

2. Select Certificate Management > Transfer Certificates.

3. Click the Transfer link beside the license you want to transfer to the replacement controller.
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4. Enter the serial number of the replacement controller and then click Transfer. The licensing website
displays a new activation key. Use this key to apply the licenses to the new controller.

For Mobility Master, a license passphrase is required along with the serial number to generate licenses. Passphrases
are autogenerated.

Procedure Overview
The procedure to replace a backup or active controller consists of the following tasks:

1. Step 1: (Optional) Change the VRRP Priorities for a Redundant Master Pair on page 66

2. Step 2: Back Up the Flash File System on page 66

3. Step 3: Stage the New Controller on page 67

4. Step 4: Add Licenses to the New Controller on page 67

5. Step 5: Backup Newly Installed Licenses on page 67

6. Step 6: Import and Restore the Flash Backup on page 67

7. Step 7: Restore Licenses on page 68

8. Step 8: Reboot the Controller on page 68

9. Step 9. (Optional) Modify the Host Name on page 68

10.Step 10: Save your Configuration on page 68

11.Step 11: Remove the Existing Controller on page 68

If your controller does not have any manually added licenses, skip steps 3, 4 and 6 of the following procedure.

Step 1: (Optional) Change the VRRP Priorities for a Redundant Master Pair
If your deployment uses VRRP to define the primary Mobility Master in a pair of redundant Mobility Masters,
and you are replacing only the primary Mobility Master, and you must change the VRRP priority levels of the
controllers so that the primary Mobility Master has a lower priority than the backup Mobility Master. This will
allow the configuration from the backup Mobility Master to be copied to the new Mobility Master, and prevent
an old or inaccurate configuration from being pushed to the managed devices.

Step 2: Back Up the Flash File System
To start the migration process, access the backup controller or Mobility Master being replaced and create a
backup of the flash file system. You can create a backup file using the WebUI or command-line interfaces.

To create a flash backup from the command-line interface, access the active controller and issue the backup
flash command. To back up the flash from the WebUI, log in to the current backup controller or active
controller and create a flash backup using the procedure below.

1. In the Mobility Master > host node hierarchy, navigate to Diagnostics > Technical Support > Backup
Flash.

2. Select Create Backup.

3. Select Copy Backup to create a copy of the backup file. By default, the flash backup file is named
flashbackup.tar.gz.

4. Next, to move the backup of the flash file system to an external server, in the Mobility Master > host
node hierarchy, navigate to Diagnostics > Technical Support > Copy Files.

5. In the Source Selection section, select Flash File System.



6. In the Destination Selection section, select one of the server options to move the flash backup off the
controller, and enter the name of the flash backup file to be exported.

7. Click Apply.

8. The status of the copy operation is displayed under the Destination Selection section.

Step 3: Stage the New Controller
The next step in the procedure is to stage the new backup controller or active controller with basic IP
connectivity. Power up the new controller, connect a laptop computer to the controller’s serial port, and follow
the prompts to configure basic settings, such as the controller name, role, VLAN, gateway, country code, and
time zone.

Step 4: Add Licenses to the New Controller
To replace a controller with manually added licenses, you will need to transfer those licenses to the new
controller as part of the replacement process.

Use the license add command in the command-line interface. Alternatively, in the Mobility Master node
hierarchy, navigate to Configuration > System > Licensing > Controller Licenses to add new or
transferred licenses to the new controller.

Do not reboot the controller at the end of this step. Do not save the configuration or write it to memory. Reboot only
after the flash memory and the licenses have been restored.

Step 5: Backup Newly Installed Licenses
Use the license export command in the command-line interface to back up the newly installed licenses to the
backup license database.
(host)[mynode] #license export <filename>

Do not reboot the controller at the end of this step. Do not save the configuration or write it to memory. Reboot only
after the flash memory and the licenses have been restored.

Step 6: Import and Restore the Flash Backup
Import and restore the backup flash file system from the original controller to the new controller,

Do not reboot the controller at the end of this step. Do not save the configuration or write it to memory. Reboot only
after the flash memory and the licenses have been restored.

To import and restore a flash backup using the WebUI:

1. Access the new controller.

2. In the Mobility Master > host node hierarchy, navigate to Diagnostics > Technical Support > Copy
Files.

3. In the Source Selection section, select any of the source options, or select a method for uploading the file.

4. In the Destination Selection section, choose Flash File System.

5. Enter the filename of the flash backup and click Apply. By default, the flash backup file is named
flashbackup.tar.gz.

6. Next, Mobility Master > host node hierarchy, navigate to Diagnostics > Technical Support > Restore
Flash and select Restore.

7. The status of the copy operation is displayed under the Destination Selection section.
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To import and restore a flash backup file using the command-line interface, use the copy and restore flash
commands. The following example copies a backup file from a USB drive.
(host)[mynode] #copy usb: Partition 1 flashbak2_3600.tar.gz flash: flashbackup.tar.gz

....File flashbak2_3600.tar.gz copied to flash successfully.

(host)[mynode] #restore flash

Step 7: Restore Licenses
Execute the license import command in the command-line interface to import licenses from the license
database to the new controller.
(host)[mynode] #license import <filename>

Do not save the configuration or write to memory at the end of this step.

Step 8: Reboot the Controller
When all the licenses have been restored, issue the reload command in the command-line interface.
Alternatively, in the Mobility Master node, navigate to Maintenance > Software Management > Reboot
in the WebUI to reboot the new controller. After rebooting, the controller should not be on the network (or a
reachable subnet) with the controller it will replace. This is to prevent a possible IP address conflict.

Do not save the configuration or write to memory at the end of this step.

(host)[mynode] #reload

Do you want to save the configuration(y/n): n

Do you really want to restart the system(y/n): y

System will now restart!

Step 9. (Optional) Modify the Host Name
Execute the hostname command in the command-line interface to give the new controller a unique host
name. (The flash restoration process gives the new controller the same name as the existing controller.)

Do not save the configuration or write to memory at the end of this step.

Step 10: Save your Configuration
Now, you must save the configuration settings on the new controller. Execute the write memory command in
the command-line interface, or in the Managed Network node, click the Configuration tab and select
Pending Changes at the top of the WebUI page.

Step 11: Remove the Existing Controller
If you are only replacing a backup controller, remove the existing backup controller, then connect the
replacement controller to the network. If you are replacing both an active controller and a backup controller,
replace the backup controller first.

When the active controlleris removed from the network, the backup controller immediately assumes the role
of active controller, and all active APs associate to the new active controller within a few seconds. Therefore,
when you add another controller to the network, it will, by default, assume the role of a backup controller.

If you changed the VRRP priorities of your redundant Mobility Master prior to replacing the primary Mobility
Master, you may wish to change them back once the new primary Mobility Master is active on the network.
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Chapter 4
Control Plane Security

ArubaOS supports secure IPsec communications between a controller and campus or remote APs using public-
key self-signed certificates created by each Mobility Master. The controller certifies its APs by issuing them
certificates.

If the Mobility Master has any associated managed devices, the Mobility Master sends a certificate to each
managed device, which in turn sends certificates to their own associated APs. If a managed device is unable to
contact the Mobility Master to obtain its own certificate, it is not be able to certify its APs, and those APs can
not communicate with their managed device until Mobility Master-managed device communication has been
re-established. You create an initial control plane security configuration when you first configure the controller
using the initial setup wizard. The ArubaOS initial setup wizard enables control plane security by default, so it is
very important that the managed device be able to communicate with the Mobility Master when it is first
provisioned.

Some AP model types have factory-installed digital certificates. These AP models use their factory-installed
certificates for IPsec, and do not need a certificate from the controller. Once a campus or remote AP is certified,
either through a factory-installed certificate or a certificate from the controller, the AP can failover between
managed devices and still stay connected to the secure network, because each AP has the same Mobility
Master as a common trust anchor.

The controller maintains two separate AP whitelists; one for campus APs and one for remote APs. These
whitelists contain records of all campus APs or remote APs connected to the network. You can use a campus or
remote AP whitelist at any time to add a new valid campus or remote AP to the secure network, or revoke
network access to any suspected rogue or unauthorized APs.

When the controller sends a certificate to the AP, that AP must reboot before it can connect to its controller
over a secure channel. If you are enabling control plane security for the first time on a large network, you may
experience several minutes of interrupted connectivity while each AP receives its certificate and establishes its
secure connection.

Topics in this chapter include:

l Control Plane Security Overview on page 69

l Configuring Control Plane Security on page 70

l Managing AP Whitelists on page 71

l Whitelist DB Optimization on page 76

l Configuring Networks with a Backup Mobility Master on page 77

l Replacing a Controller on a Multi-Controller Network on page 77

l Troubleshooting Control Plane Security on page 78

Control Plane Security Overview
Controllers using control plane security send certificates to APs that you have identified as valid APs on the
network. If you want closer control over each AP that is certified, you can manually add individual campus and
remote APs to the secure network by adding each AP's information to the whitelists when you first run the
initial setup wizard. If you are confident that all APs currently on your network are valid APs, then you can use
the initial setup wizard to configure automatic certificate provisioning to send certificates from the controller to
each campus or remote AP, or to all campus and remote APs within specific ranges of IP addresses.
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The default automatic certificate provisioning setting requires that you manually enter each campus AP’s
information into the campus AP whitelist, and each remote AP's information into the remote AP whitelist. If
you change the default automatic certificate provisioning values to let the controller send certificates to all APs
on the network, all valid APs will receive certificate, but this also increases the chance that you will certify a
rogue or unwanted AP. If you configure the controller to send certificates to only those APs within a range of IP
addresses, there is a smaller chance that a rogue AP receives a certificate, but any valid AP with an IP address
outside the specified address ranges will not receive a certificate, and cannot communicate with the controller
(except to obtain a certificate). Consider both options carefully before you complete the control plane security
portion of the initial setup wizard. If your controller has a publicly accessible interface, you should identify the
APs on the network by the IP address range. This prevents the controller from sending certificates to external
or rogue campus APs that may attempt to access your controller through that publicly accessible interface.

Configuring Control Plane Security
When you initially deploy the controller, you create your initial control plane security configuration using the
initial setup wizard. These settings can be changed at any time using the WebUI or the command-line
interfaces.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > CPSEC tab.

2. Select the Control Plane Security accordian.

3. Select the Enable CPSEC check box.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To enable auto cert provisioning:

1. In the Managed Network node hierarchy, navigate to Configuration > System > CPSEC tab.

2. Select the Control Plane Security accordian.

3. Select the Enable Auto Cert Provisioning check box. To allow AP's from specified ranges:

a. Select the Only accept APs from specified ranges check box.

b. Click the + symbol in Address ranges for Auto Cert Provisioning. The New Address Range window
is displayed.

c. Enter the start and end ip4/ipv6 addresses.

d. Click OK.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

The Mobility Master generates its self-signed certificate and begins distributing certificates to campus APs and
any managed devices on the network over a clear channel. After all APs have received a certificate and have
connected to the network using a secure channel, access the Control Plane Security window and turn off
auto certificate provisioning if that feature was enabled. This prevents the controller from issuing a certificate
to any rogue APs that may appear on your network at a later time.

In the CLI
Use the commands below to configure control plane security via the command line interface on a managed
device or Mobility Master.



(host) [mynode] (config) #control-plane-security

(host) [mynode] (Control Plane Security Profile) #auto-cert-allow-all

(host) [mynode] (Control Plane Security Profile) #auto-cert-allowed-addrs <start> <end>

(host) [mynode] (Control Plane Security Profile) #auto-cert-prov

(host) [mynode] (Control Plane Security Profile) #cpsec-enable

View the current control plane security settings using the following command:
(host) [mynode] (config)#show control-plane-security

Managing AP Whitelists
Campus or remote APs appear as valid APs in the campus or remote AP whitelists when you manually enter
their information into the campus or remote AP whitelists through the WebUI or CLI of a controller or after a
controller sends a certificate to an AP as part of automatic certificate provisioning and the AP connects to the
controller over a secure tunnel. APs that are not approved or certified on the network are included in the
campus AP whitelists, but these APs appear in an unapproved state.

Use the AP whitelists to grant valid APs secure access to the network or to revoke access from suspected rogue
APs. When you revoke or remove an AP from the campus or remote AP whitelists on a controller that uses
control plane security, that AP will not able to communicate with the controller again, unless the AP obtains a
new certificate.

Adding an AP to the Campus or Remote AP Whitelists
You can add an AP to the campus AP or remote AP whitelists using the WebUI or CLI.

In the WebUI
To add an AP to the campus AP or remote AP whitelist:

1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points > Whitelist
tab.

2. Click Campus AP Whitelist tab.

3. Click +.

4. Define the following parameters for each AP you want to add to the AP whitelist.

Parameter Description

Campus AP whitelist configuration parameters

MAC address MAC address of campus AP that supports secure communications to and
from its controller.

AP name Name of the campus AP. If you do not specify a name, the AP uses its
MAC address as AP name.

AP group Name of the AP group to which the campus AP is assigned. If you do not
specify an AP group, the AP uses default as its AP group.

Description Brief description of the campus AP.

Table 14: AP Whitelist Parameters
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Parameter Description

Remote AP whitelist configuration parameters

MAC address MAC address of the remote AP, in colon-separated octets.

AP name Name of the Remote AP. If you do not specify a name, the AP uses its
MAC address as AP name.

AP group Name of the AP group to which the Remote AP is assigned.

Description Brief description of the Remote AP.

Table 14: AP Whitelist Parameters

5. Click Submit.

In the CLI
To add an AP to the campus AP whitelist:
(host) [mynode] (config) #whitelist-db cpsec add mac-address <address>

ap-group <ap_group>

ap-name <ap_name>

description <description>

To add an AP to the remote AP whitelist:
(host) [mynode] (config) #whitelist-db rap add mac-address <mac-address>

ap-group <ap-group>

ap-name <ap-name>

description <description>

full-name <name>

remote-ip <inner-ip-adr>

remote-ipv6 <ipv6 address>

Viewing AP Whitelist Entries
The WebUI displays the table of entries in the selected AP whitelist. The table of entries page displays a list of
AP whitelist entries.

The Configuration > Access Points > Whitelist tab displays the list of the campus AP whitelists by default.
To view the list of remote AP whitelists, click Remote AP whitelist.

The remote AP whitelist entries page displays only the information you manually configure. The campus AP
whitelist entries page displays both user-defined settings and additional information that is updated when the
status of a campus AP changes.



Parameter Description

Status Displays the status of the AP whitelist entry.

Revoke Shows if the secure status of the AP is revoked.

Revoke text Brief description for revoking the campus AP.

Updated Time and date of the last AP status update.

Table 15: Campus AP Parameters

To view information about the campus and remote AP whitelists using the CLI, use the following commands:
(host) [mynode] #show whitelist-db cpsec

ap-group <ap_group>

ap-name <ap_name>

cert-type {factory-cert|switch-cert}

mac-address <name>

page <num>

start <offset>

state

{approved-ready-for-cert|certified-factory-cert|unapproved-factory-cert|unapproved-no-

cert}

(host) [mynode] #show whitelist-db cpsec-status

(host) [mynode] #show whitelist-db rap

apgroup <rap-group>

apname <rap-name>

export css <filename

fullname <full-name>

long

mac-address <mac-address>

page <page-number>

start <offset>

(host) #show whitelist-db rap-status

Modifying an AP in the Campus AP Whitelist
Use the following procedures to modify the AP group, AP name, certificate type, state, description, and revoked
status of an AP in the campus AP whitelist.

In the WebUI
To modify an AP in the campus AP whitelist:

1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points > Whitelist
tab.

2. Click Campus AP Whitelist tab.

3. Select the check box of the AP that you want to modify.

4. Modify the settings of the selected AP. Some of the following parameters are available when adding an
AP to the campus AP whitelist.

l AP Group: The name of the AP group to which the campus AP is assigned.
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l AP Name: The name of the campus AP. If you not specify a name, the AP uses its MAC address as a
name.

l Description: Brief description of the campus AP.

l Revoke: Click the Revoke check box to revoke an invalid or rogue AP.

l Revoke Text: Enter a brief comment describing why the AP is being revoked.

5. Click Submit to update the campus AP whitelist entry with its new settings.

In the CLI
To modify an AP in the campus AP whitelist:
(host) #whitelist-db cpsec modify mac-address <name>

ap-group <ap_group>

ap-name <ap_name>

cert-type {switch-cert|factory-cert}

description <description>

mode {disable|enable}

revoke-text <revoke-text>

state {approved-ready-for-cert|certified-factory-cert}

Revoking an AP from the Campus AP Whitelist
You can revoke an invalid or rogue AP either by modifying its revoke status (as described in Modifying an AP in
the Campus AP Whitelist on page 73) or by directly revoking it from the campus AP whitelist without modifying
any other parameter. When revoking an invalid or rogue AP, enter a brief description why the AP is being
revoked. When you revoke an AP from the campus AP whitelist, the campus AP whitelist retains the
information of the AP. To revoke an invalid or rogue AP and permanently remove it from the whitelist, delete
that entry.

In the WebUI
To revoke an AP from the campus AP whitelist:

1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points > Whitelist
tab.

2. Click Campus AP Whitelist tab.

3. Select the check box of the AP that you want to revoke, then click Revoke.

4. Enter a brief description why the AP is being revoked, then click Update.

In the CLI
To revoke an AP via the campus AP whitelist:
(host) [mynode] (config) #whitelist-db cpsec revoke mac-address <name> revoke-text <comment>

Deleting an AP from the Campus AP Whitelist
Before deleting an AP from the campus AP whitelist, verify that auto certificate provisioning is either enabled or
disabled only for IP addresses that do not include the AP being deleted. If you enable automatic certificate
provisioning for an AP that is still connected to the network, you cannot delete it from the campus AP whitelist;
the controller immediately re-certifies the AP and re-creates its whitelist entry.

In the WebUI
To delete an AP from the campus AP whitelist:

1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points > Whitelist
tab.



2. Click Campus AP Whitelist tab.

3. Select the check box of the AP that you want to delete, then click Delete.

4. Click Delete.

In the CLI
To delete an AP from the campus AP whitelist:
(host) [mynode] (config) #whitelist-db cpsec del mac-address <name>

Purging a Campus AP Whitelist
Before adding a new managed device to a network using control plane security, purge the campus AP whitelist
on the new managed device. To purge a campus AP whitelist execute the following command:
(host) [mynode] (config) #whitelist-db cpsec purge

Offloading a Controller Whitelist to ClearPass Policy Manager
This feature allows to externally maintain AP whitelist in a ClearPass Policy Manager server. The controller, if
configured to use an external server, can send a RADIUS access request to a ClearPass Policy Manager server.
The MAC address of the AP is used as a username and password to construct the access request packet. The
ClearPass Policy Manager server validates the RADIUS message and returns the relevant parameters for the
authorized APs.

The following supported parameters are associated with the following Vendor Specific Attributes (VSAs). The
ClearPass Policy Manager server sends them in the RADIUS access accept packet for authorized APs:

l ap-group: Aruba-AP-Group

l ap-name: Aruba-Location-ID

l ap-remote-ip: Aruba-AP-IP-Address

The following defaults are used when any of the supported parameters are not provided by the ClearPass
Policy Manager server in the RADIUS access accept response:

l ap-group: The default ap-group is assigned to the AP.

l ap-name: The MAC address of the AP is used as the AP name.

There is no change in the RAP role assignment. The RAP is assigned the role that is configured in the VPN
default-rap profile.

In the WebUI
To assign a ClearPass Policy Manager server to a RAP:

1. Configure a ClearPass Policy Manager server using the WebUI:

a. In the Mobility Master node hierarchy, navigate to Configuration > Authentication > Auth
Servers tab.

b. Click + in the Server Groups table.

c. In the Add Server Group window, enter the server group name in the Name field.

d. Click Submit.

e. Click + in the All Server table.

f. In the New Server window, enter appropriate values in the following fields and click Submit: 

- Name
- IP address / hostname
- Type
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g. Select the server created.

h. Enter a value for the Shared key and re-enter the value in the Retype key field.

i. Click Submit.

j. Click Pending Changes.

k. In the Pending Changes window, select the check box and click Deploy changes.

l. Select the server group created in the previous steps. The Server Group table is displayed.

m. Click + in the Server Group table. A list of servers is displayed.

n. Select the ClearPass Policy Manager server you wish to map to the server group. Click Submit.

o. Click Pending Changes.

p. In the Pending Changes window, select the check box and click Deploy changes.

2. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

3. From All profiles select Wireless LAN > VPN Authentication > default-rap > Server Group.
4. Select the ClearPass Policy Manager server from the Server Group drop-down list.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

To assign a ClearPass Policy Manager server to a RAP that was initially an Instant AP:

1. Make sure that a ClearPass Policy Manager server is configured on the controller.

2. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

3. From All profiles select Wireless LAN > VPN Authentication > default-iap > Server Group.
4. Select the ClearPass Policy Manager server from the Server Group drop-down list.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To add a ClearPass Policy Manager server to a RAP:

Configure a radius server with ClearPass Policy Manager server as host address. In this example cppm-rad is
the ClearPass Policy Manager server name and cppm-sg is the server group name.
(host) [mynode] (config) #aaa authentication-server radius cppm-rad

(host) [mynode] (RADIUS Server "test") # host 1.1.1.1

Add this server to a server group:
(host) [mynode] (config) #aaa server-group cppm-sg

(host) (Server Group "cppm-sg") #auth-server cppm-rad

Add this server group to the default-rap vpn profile:
(host) [mynode] (config) #aaa authentication vpn default-rap

(host)(VPN Authentication Profile "default-rap") #server-group cppm-sg

Whitelist DB Optimization
In addition to the existing push-based model that syncs whitelist entries to managed devices when they are
updated/deleted/revoked from Mobility Master. The Mobility Master introduces a pull-based sync mechanism
for the whitelist database (whitelist-DB), in which AP whitelist entries are only synced to the managed devices
that require the entry. The pull-based sync mechanism is used when a RAP/CPsec AP terminates on a managed



device or if a network is down during a whitelist push, which can prevent messages from going through to the
managed devices. The managed device can use this as a fallback mechanism to periodically check if it is in sync
with the Mobility Master. If a mismatch is detected, the managed device pulls the new entry from Mobility
Master. All whitelist entries are configured from a centralized location on the Mobility Master and synced to
appropriate managed devices. Entries can also be configured directly on a managed device for debugging
purposes. However, these changes are not synced back to the Mobility Master or any other managed device.

This whitelist-DB optimization provides the following enhancements on Mobility Master:

l Reduced memory footprint.

l Increased performance on the Mobility Master and managed devices.

l Scalability and support for over 1000 managed devices and 10,000 APs on a Mobility Master.

l Scalability and support for managed devices with varying AP capacities.

l Simplified debugging process, as corrupt entries are no longer synced to every managed device on a given
Mobility Master.

Changes made to the whitelist-DB can only be applied to the postgres database (PgSQL DB) and are not backwards-
compatible with ArubaOS versions 6.4.x and earlier.

You can view a controller’s current sequence number using the CLI:
(host) #show whitelist-db seq-pendlist

In a Mobility Master, only a global list of whitelist entries are available. To view the entries specific to a managed
device, login into the particular device to view the whitelist specific to the device.

Configuring Networks with a Backup Mobility Master
This section describes the configuration with a backup Mobility Master .

If your network includes a redundant backup Mobility Master, you must synchronize the database from the
primary Mobility Master to the backup Mobility Master at least once after all APs are communicating with the
controllers over a secure channel. This ensures that all certificates, IPsec keys, and campus AP whitelist entries
are synchronized to the backup controller. You should also synchronize the database any time the campus AP
whitelist changes (APs are added or removed to ensure that the backup controller has the latest settings).

Mobility Master and backup Mobility Masters can be synchronized using either of the following methods:

l Manual Synchronization: Issue the database synchronize command to manually synchronize
databases from your primary Mobility Master to the backup Mobility Master.

l Automatic Synchronization: Schedule automatic database backups using the database synchronize
period command in configuration mode.

If you add a new backup Mobility Master to an existing Mobility Master, you must add the backup Mobility Master as
the lower priority controller. If you do not add the backup Mobility Master as a lower priority controller, your control
plane security keys and certificates may be lost. If you want the new backup Mobility Master to become your primary
controller, increase the priority of that controller to a primary controller after you have synchronized your data.

Replacing a Controller on a Multi-Controller Network
The procedure to replace a controller within a multi-controller network varies, depending upon the role of that
controller, whether the network has a single Mobility Master or a cluster of Mobility Masters, and whether or
not the controller has a backup.
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Replacing Controllers in a Single Mobility Master Network
Use the procedures in this section to replace a Mobility Master or managed device in a network environment
with a single Mobility Master.

Replacing a Managed Device
Follow the steps below to replace a managed device in a single-Mobility Master network:

1. Disconnect the managed device from the network.

2. If you plan on moving the managed device to another location on the network, purge the campus AP
whitelist on the managed device.

Access the command-line interface on the old managed device and issue the whitelist-db cpsec purge
command.

3. Install the new managed device, but do not connect it to the network. If the managed device has been
previously installed on the network, you must ensure that the new managed device has a clean whitelist.

4. Purge the managed device whitelist by executing the whitelist-db cpsec purge command on the new
managed device.

5. Once the managed device has a valid control plane security certificate and configuration, the managed
device receives the campus AP whitelist from the Mobility Master and starts certifying approved APs.

6. APs associated with the new managed device reboots and creates new IPsec tunnels to the controller using
the new certificate keys.

Replacing a Redundant Mobility Master
The control plane security feature requires you to synchronize databases from the primary Mobility Master to
the backup Mobility Master at least once after the network is up and running. This ensures that all certificates,
keys, and whitelist entries are synchronized to the backup Mobility Master. Because the AP whitelist may
change periodically, you should regularly synchronize these settings to the backup Mobility Master. For details,
see Configuring Networks with a Backup Mobility Master on page 77.

When you install a new backup Mobility Master, you must add it as a lower priority controller than the existing
primary Mobility Master. After you install the backup Mobility Master on the network, synchronize the
database from the existing primary Mobility Master to the new backup Mobility Master to ensure that all
certificates, keys, and whitelist entries required for control plane security are added to the new backup Mobility
Master configuration. If you want the new Mobility Master to act as the primary Mobility Master, you can
increase that Mobility Master’s priority after the settings have been synchronized.

The control plane security settings of a controller does not change if you upgrade the controller running ArubaOS 6.x
to ArubaOS 8. If control plane security was already enabled, then it remains enabled after the upgrade, however if
control plane security was not enabled previously and you want to use this feature after upgrading, then you must
manually enable control plane security.

Troubleshooting Control Plane Security

Identifying Certificate Problems
If an AP has a problem with its certificate, check the state of the AP in the campus AP whitelist. If the AP is in
either the certified-hold-factory-cert or certified-hold-switch-cert states, you may need to manually change the
status of that AP before it can be certified.

l certified-hold-factory-cert: An AP is put in this state when the controller thinks the AP has been certified
with a factory certificate, but the AP requests to be certified again. Because this is not a normal condition,
the AP is not approved as a secure AP until you manually change the status of the AP to verify that it is not



compromised. If an AP is in this state due to connectivity problems, then the AP recovers and is taken out of
this hold state as soon as connectivity is restored.

l certified-hold-switch-cert: An AP is put in this state when the controller thinks the AP has been certified
with a controller certificate yet the AP requests to be certified again. Because this is not a normal condition,
the AP is not be approved as a secure AP until a network administrator manually changes the status of the
AP to verify that it is not compromised. If an AP is in this state due to connectivity problems, then the AP
recovers and is taken out of this hold state as soon as connectivity is restored.

Verifying Certificates
If you are unable to configure the control plane security feature, verify that its Trusted Platform Module (TPM)
and factory-installed certificates are present and valid by accessing the controller’s command-line interface and
issuing the show tpm cert-info command. If the controller has a valid certificate, the output of the command
appears similar to the output in the example below.

This command works only on hardware controllers.

(host) #show tpm cert-info

=====================================

TPM manufacturing factory certificate

=====================================

subject= /CN=BA0003137::00:1a:1e:00:89:b8

issuer= /DC=com/DC=arubanetworks/DC=ca/CN=DEVICE-CA1

serial=2E1DF0D10000004C8EE7

notBefore=Aug 6 22:50:04 2013 GMT

notAfter=Sep 14 03:21:14 2032 GMT

=====================================

Generated Factory certificate

=====================================

subject= /CN=BA0003137::00:1a:1e:00:89:b8/L=SW

issuer= /CN=BA0003137::00:1a:1e:00:89:b8

serial=2E1DF0D10000004C8EE7

notBefore=Aug 6 22:50:04 2013 GMT

notAfter=Sep 14 03:21:14 2032 GMT

If the controller displays the following output, it may have a corrupted or missing TPM and factory certificates.
Contact Aruba support.
(host) #show tpm cert-info

Cannot get TPM and Factory Certificate Info.

Disabling Control Plane Security
If you disable control plane security on a Mobility Master or managed device, all APs connected to that
controller reboot then reconnect to the controller over a clear channel.

If you disable control plane security for a managed device, APs directly connected to the managed device
reboot and reconnect to the managed device over a clear channel.

Verifying Whitelist Synchronization
To verify if the campus AP whitelist is downloaded from the Mobility Master to managed devices, check the
sequence numbers on the Mobility Master and managed device whitelists.

The sequence number value on a Mobility Master should be the same as the sequence number on the
managed device.
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Rogue APs
If you enable auto certificate provisioning enabled with the Auto Cert Allow All option, any AP that appears
on the network receives a certificate. If you notice unwanted or rogue APs connecting to your controller via an
IPsec tunnel, verify that automatic certificate provisioning has been disabled, then manually remove the
unwanted APs by deleting their entries from the campus AP whitelist.
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Chapter 5
Network Configuration Parameters

Getting Started with ArubaOS WLANs
This chapter gives an overview of ArubaOS WLANs, and describes the procedures to configure a basic WLAN,
define VLANs and ports, and enable advanced and optional WLAN and VLAN optimization features.

Learn more about ArubaOS WLANs, VLANs and Ports
Click any of the links below for information on the basic steps required to configure a campus WLAN using the
WebUI or command-line interfaces, and an general overview of VLAN assignments.

l Campus WLAN Workflow on page 81

l Configuring VLANs on page 84

l Trusted Vs. Untrusted Ports and VLANs on page 91

Create a Basic Network Configuration
The following sections describe how to configure the basic port, VLAN and Mobility Master settings .

l Assign an IP Address to a VLAN on page 92

l Configuring Trusted/Untrusted Ports and VLANs on page 95

l Configuring the Mobility Master IP Address on page 97

l Configuring the Loopback IP Address on page 97

l Configuring Static IP Routes on page 98

Configure Advanced or Optional Network features
The following sections describe how to configure advanced or optional VLAN and Mobility Master settings .

l Configuring GRE Tunnels on page 99

l GRE Tunnel Groups on page 105

l Jumbo Frame Support on page 106

l PVST+ (Per-VLAN Spanning Tree Plus) on page 107

l Rapid Spanning Tree Protocol (RSTP) on page 108

l PortFast and BPDU Guard for Spanning Tree on page 110

l Link Layer Discovery Protocol on page 112

Campus WLAN Workflow
A WLAN can be creating using the New WLAN Wizard in the WebUI, or manually defined using the WebUI or
command-line interfaces.

Using the New WLAN Wizard in the WebUI
The simplest way to create a new WLAN is to use the New WLAN wizard, available in the Configuration >
WLANs section of the WebUI (Managed Network node hierarchy). The wizard walks you through the steps
to define and configure the SSID, VLAN, authentication and authorization settings, and default user role for the
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WLAN. The configuration options that appear in the WLAN wizard will vary, depending upon the type of WLAN
you choose to create.

Manually Configuring the WLAN in the WebUI
The following workflow lists the tasks to configure a campus WLAN, with a signal SSID, that uses 802.1X
authentication. Click any of the links below for details on the configuration procedures for that task.

1. Configure your authentication servers.

2. Create an authentication server group, and assign the authentication servers you configured in step 1 to
that server group.

3. Configure a firewall access policy for a group of users

4. Create a user role, and assign the firewall access policy you created in step 3 to that user role.

5. Create an AAA profile.

a. Assign the user role defined in step 4 to the AAA profile's 802.1X Authentication Default Role
b. Associate the server group you created in step 2 to the AAA profile.

6. Create a new SSID profile.

7. Create a new virtual AP profile.

8. Associate the virtual AP profile to the AAA profile you created in Step 5.

9. Associate the virtual AP profile to the SSID profile you created in Step 6.

Using the CLI
The example below follows the suggested order of steps to configure a virtual AP using the command-line
interface.
(host) [mynode] (config) #aaa server-group THR-DOT1X-SERVER-GROUP-WPA2

auth-server Internal

(host) [mynode] (config) #ip access-list session THR-POLICY-NAME-WPA2

user any any permit

(host) [mynode] (config) #user-role THR-ROLE-NAME-WPA2

access-list session THR-POLICY-NAME-WPA2

(host) [mynode] (config) #aaa server-group THR-DOT1X-SERVER-GROUP-WPA2

auth-server Internal

(host) [mynode] (config) #aaa profile THR-AAA-PROFILE-WPA2

dot1x-default-role THR-ROLE-NAME-WPA2

dot1x-server-group THR-DOT1X-SERVER-GROUP-WPA2

(host) [mynode] (config) #wlan ssid-profile THR-SSID-PROFILE-WPA2

essid THR-WPA2

opmode wpa2-aes

(host) [mynode] (config) #wlan virtual-ap THR-VIRTUAL-AP-PROFILE-WPA2

ssid-profile THR-SSID-PROFILE-WPA2

aaa-profile THR-AAA-PROFILE-WPA2

vlan 60

(host) [mynode] (config) #ap-group THRHQ1-STANDARD

virtual-ap THR-VIRTUAL-AP-PROFILE-WPA2



Understanding VLAN Assignments
A client is assigned to a VLAN by one of several methods, in order of precedence. The assignment of VLANs are
(from lowest to highest precedence):

1. The default VLAN is the VLAN configured for the WLAN (see WLAN Configuration Profiles on page 405).

2. Before client authentication, the VLAN can be derived from rules based on client attributes (SSID, BSSID,
client MAC, location, and encryption type). A rule that derives a specific VLAN takes precedence over a rule
that derives a user role that may have a VLAN configured for it.

3. After client authentication, the VLAN can be configured for a default role for an authentication method,
such as 802.1X or VPN.

4. After client authentication, the VLAN can be derived from attributes returned by the authentication server
(server-derived rule). A rule that derives a specific VLAN takes precedence over a rule that derives a user role
that may have a VLAN configured for it.

5. After client authentication, the VLAN can be derived from Microsoft Tunnel attributes (Tunnel-Type, Tunnel
Medium Type, and Tunnel Private Group ID). All three attributes must be present as shown below. This does
not require a server-derived rule. For example:
Tunnel-Type="VLAN"(13)

Tunnel-Medium-Type="IEEE-802" (6)

Tunnel-Private-Group-Id="101"

6. After client authentication, the VLAN can be derived from Vendor Specific Attributes (VSA) for RADIUS
server authentication. This does not require a server-derived rule. If a VSA is present, it overrides any
previous VLAN assignment. For example:
Aruba-User-VLAN

Aruba-Named-User-VLAN

VLAN Derivation Priorities for VLAN types
The VLAN derivation priorities for VLAN is defined below in the increasing order:

1. Default or Virtual AP VLAN

2. VLAN from Initial role

3. VLAN from User Derivation Rule (UDR) role

4. VLAN from UDR

5. VLAN from DHCP option 77 UDR role (wired clients)

6. VLAN from DHCP option 77 UDR (wired clients)

7. VLAN from MAC-based Authentication default role

8. VLAN from Server Derivation Rule (SDR) role during MAC-based Authentication

9. VLAN from SDR during MAC-based Authentication

10.VLAN from Vendor Specific Attributes (VSA) role during MAC-based Authentication

11.VLAN from VSA during MAC-based Authentication

12.VLAN from Microsoft Tunnel attributes during MAC-based Authentication

13.VLAN from 802.1X default role

14.VLAN from SDR role during 802.1X

15.VLAN from SDR during 802.1X

16.VLAN from VSA role during 802.1X

17.VLAN from VSA during 802.1X

18.VLAN from Microsoft Tunnel attributes during 802.1X

19.VLAN from DHCP options role
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20.VLAN from DHCP options

A VLAN from DHCP options has highest priority for VLAN derivation. Note, however, that DHCP options are not
considered for derivation if the Aruba VSA ARUBA_NO_DHCP_FINGERPRINT (14) was sent for the user.

Use the following command to display user VLAN derivation debug information:
(host) [mynode] #show aaa debug vlan user [ip|ipv6|mac]

Configuring Multiple Wired Uplink Interfaces (Active-Standby)
You can assign up to four VLAN interfaces to operate in active-standby topology. An active-standby topology
provides redundancy so that when an active interface fails, the user traffic can failover to the standby
interface.

To allow Mobility Master to obtain a dynamic IP address for a VLAN, enable the DHCP or PPPoE client on
Mobility Master for the VLAN. For more information, see Assign an IP Address to a VLAN

Configuring VLANs
Managed Devices operate as layer-2 switches that use a VLAN as a broadcast domain. As a layer-2 switch, the
managed device requires an external router to route traffic between VLANs. The managed device can also
operate as a layer-3 switch that can route traffic between VLANs defined on Mobility Master.

You can configure one or more physical ports on the managed device to be members of a VLAN. Additionally,
each wireless client association constitutes a connection to a virtual port on the managed device, with
membership in a specified VLAN. You can place all authenticated wireless users into a single VLAN or into
different VLANs, depending upon your network. VLANs can remain inside the managed device, or they can
extend outside the managed device through 802.1q VLAN tagging.

You can optionally configure an IP address and netmask for a VLAN. The IP address is up when at least one
physical port in the VLAN is up. The VLAN IP address can be used as a gateway by external devices; packets
directed to a VLAN IP address that are not destined for the managed device are forwarded according to the
managed device’s IP routing table.

This section includes the following topics:

l Creating and Updating VLANs on page 84

l Creating a Named VLAN on page 85

l Creating a Named VLAN on page 85

l Role Derivation for Named VLAN Pools on page 86

l Adding a Bandwidth Contract to the VLAN on page 87

l Optimizing VLAN Broadcast and Multicast Traffic on page 87

l Inter-VLAN Routing on page 88

Creating and Updating VLANs
You can create and update a single VLAN or bulk VLANs.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

2. Click + to create a new VLAN. (To edit an existing VLAN, click the VLAN entry.) See Creating Bulk VLANs In the
WebUI on page 85 to create a range of VLANs.



a. Enter a name for the new VLAN.

b. In the VLAN ID/Range field, enter a valid VLAN ID. (Valid values are from 1 to 4094, inclusive).

c. Click Submit.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

6. To add physical ports to the VLAN, go to the Ports page. To associate the VLAN with specific port-channels,
select Port-Channels.

a. If you selected Port, select the port(s) you want to associate with the VLAN from the Ports table. For
each port, select the new VLAN from the VLAN drop-down list.

b. If you selected Port-Channel, select the specific channel number you want to associate with the VLAN
from the Port Channel table.

c. Click Submit.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [mynode] (config) #vlan <id>

(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

(host) [mynode] (config-if) #switchport access vlan <vlan>

Creating Bulk VLANs In the WebUI
1. To add multiple VLANs at one time, click + on the VLANs page.

a. In the New VLAN pop-up window, enter a range of VLANs in the VLAN ID/Range field that you want to
create at once. For example, to add VLAN IDs numbered 200-300 and 302-350, enter 200-300, 302-
350.

b. Click Submit.

2. To add physical ports to a VLAN, select the VLAN.

a. In the Port Members table, click Edit.

b. Select and move the port(s) from the Available list to the Selected list.

c. Click OK.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [mynode] (config) #vlan <id>

(host) [mynode] (config) #vlan <id> range <range>

Creating a Named VLAN
Refer to the section Address Pool Management on page 225.
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Role Derivation for Named VLAN Pools
You can configure Named VLANs under user rule, server derivation, user derivation, and VSA.

You cannot modify a VLAN name, so choose the name carefully.

Named VLANs (single VLAN IDs or multiple VLAN IDs) can only be assigned to tunnel mode VAP’s and wired
profiles. They can also be assigned to user roles, user rule derivation, server derivation, and VSA for tunnel and
bridge mode.

For tunnel mode, named VLANs that have the assignment type “hash” and “even” are supported.

For bridge mode only, named VLANs with the assignment type “hash” are supported. If a named VLAN with
“even” assignment is assigned to a user rule, user role, server derivation or VSA, than the “hash” assignment is
applied and the following error message displays:

"named VLAN assignment type EVEN not supported for bridge. Applying HASH algorithm to retrieve vlan-id"

L2 roaming is not supported with an even VLAN assignment.

In the CLI
To apply a named VLAN in a user rule, use the following CLI commands:
(host) [mynode] (config) #aaa derivation-rules user <name>

(host) [mynode] (user-rule) #set vlan condition <rule-type> <attribute> <value> set-value

{<role>|<vlan>} [description <rule description>][position <number>]

To apply a named VLAN in a user role, use the following CLI commands:
(host) [mynode] (config) #user-role <name>

(user) [mynode] (config-role) #vlan <string>

To apply a named VLAN in server derivation, use the following CLI commands:
(host) [mynode] (config) #aaa server-group <group>

(user) [mynode] (Server Group) set vlan condition <attribute> contains|ends-with|equals|not-

equals|starts-with <string> set-value <set-value-str> [position <number>]

For a named VLAN derivation using VSA, configure the RADIUS server using these values:
Aruba-Named-UserVLAN 9 String Aruba 14823

In the WebUI
To apply a named VLAN to a user rule:

1. In the Managed Network node hierarchy, navigate to Configuration > Authentication > User Rules.

2. Select a user rule from the User Rules Summary table.

3. Click + to add a new rule.

4. Select VLAN from the Set Type drop-down list.

5. Select a VLAN from the VLAN drop-down list.

6. Configure the remaining profile settings: Rule Type, Condition, Value, and Description. Users are
assigned the selected VLAN when the rule matches.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

To apply a named VLAN to a user role:



1. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies > Roles.

2. Select a role from the Roles table, and then click Show Advanced View.

3. Under More, select a VLAN from the VLAN drop-down list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To apply a named VLAN to a server derivation (server group):

1. In the Mobility Master node hierarchy, navigate to Configuration > Authentication> Auth Servers.

2. Select a server group from the Server Groups table.

3. Under Server Rules, click + to add a new rule.

4. Select set vlan from the Action drop-down list.

5. Select a VLAN from the Vlan drop-down list.

6. Configure the remaining profile settings: Attribute, Operation, and Operand. Users are assigned the
selected VLAN when the rule matches.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

Adding a Bandwidth Contract to the VLAN
Bandwidth contracts on a VLAN can limit broadcast and multicast traffic. ArubaOS includes an internal
exception list to allow broadcast and multicast traffic using the VRRP, LACP, OSPF, PVST, and STP protocols. To
remove per-VLAN bandwidth contract limits on an additional broadcast or multicast protocol, add the MAC
address for that broadcast/multicast protocol to the VLAN Bandwidth Contracts MAC Exception List.

The command in the example below adds the MAC address for CDP (Cisco Discovery Protocol) and VTP (Virtual
Trunking Protocol to the list of protocols that are not limited by VLAN bandwidth contracts.
(host) [mynode] (config) #vlan-bwcontract-explist mac <mac>

To show entries in the VLAN bandwidth contracts MAC exception list execute the following command:
(host) [mynode] (config) #show vlan-bwcontract-explist internal

Optimizing VLAN Broadcast and Multicast Traffic
Broadcast and Multicast (BCMC) traffic from APs, remote APs, or distributions terminating on the same VLAN
floods all VLAN member ports. This causes critical bandwidth wastage, especially when the APs are connected
to an L3 cloud where the available bandwidth is limited or expensive. Suppressing the VLAN BCMC traffic to
prevent flooding can result in loss of client connectivity.

To effectively prevent flooding of BCMC traffic on all VLAN member ports, use the bcmc-optimization

parameter under the interface vlan command. This parameter ensures controlled flooding of BCMC traffic
without compromising the client connectivity. This option is disabled by default. You must enable this
parameter for the controlled flooding of BCMC traffic.

If you enable BCMC Optimization on uplink ports, the managed device-generated Layer-2 packets will be dropped.

The bcmc-optimization parameter has the following exemptions:

l All DHCP traffic will continue to flood VLAN member ports even if you enable the bcmc-optimization
parameter.
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l ARP broadcasts and VRRP (multicast) traffic will still be allowed.

You can configure BCMC optimization using the WebUI or CLI.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Interfaces > VLANs.

2. Select a VLAN from the VLANs table.

3. Under Vlan Ids, select the VLAN ID number.

4. Navigate to the IPv4 tab for the selected VLAN ID.

5. Click Other Option to expand it.

6. Set the BCMC optimization to Enabled for the selected VLAN.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #interface vlan <vlan>

(host) [mynode] (config-subif)#bcmc-optimization

(host) [mynode] (config-subif)#show interface vlan <vlan>

Inter-VLAN Routing
On the managed device, you can map a VLAN to a layer-3 subnetwork by assigning a static IP address and a
netmask, or by configuring a DHCP or PPPoE server to provide a dynamic IP address and netmask to the VLAN
interface. The managed device, acting as a layer-3 switch, routes traffic between VLANs that are mapped to IP
subnetworks; this forwarding is enabled by default.

In Figure 12, VLAN 200 and VLAN 300 are assigned the IP addresses 2.1.1.1/24 and 3.1.1.1/24, respectively.
Client A in VLAN 200 is able to access server B in VLAN 300 and vice-versa, provided that there is no firewall rule
configured on the managed device to prevent the flow of traffic between the VLANs.

Figure 12 Default Inter-VLAN Routing

You can optionally disable layer-3 traffic forwarding to or from a specified VLAN. When you disable layer-3
forwarding on a VLAN, the following restrictions apply:

l Clients on the restricted VLAN can ping each other, but cannot ping the VLAN interface on the managed
device. Forwarding of inter-VLAN traffic is blocked.



l IP mobility does not work when a mobile client roams to the restricted VLAN. You must ensure that a
mobile client on a restricted VLAN is not allowed to roam to a non-restricted VLAN. For example, a mobile
client on a guest VLAN will not be able to roam to a corporate VLAN.

To disable layer-3 forwarding for a VLAN configured on the managed device:

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANspage.

2. Select a VLAN from the VLANs table.

3. Under Vlan Ids, select the VLAN ID number.

4. Navigate to the IPv4 tab for the selected VLAN ID.

5. Click IP Address Assignment to expand it.

6. In the IP assignment field, configure the VLAN to either obtain an IP address dynamically (via DHCP or
PPPoE) or to use a static IP address and netmask.

7. Click Submit.

8. Click Other Option to expand it.

9. Set Inter-VLAN routing to Disabled.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Configuring Source NAT to Dynamic VLAN Address
When a VLAN interface obtains an IP address through DHCP or PPPoE, a NAT pool (dynamic-srcnat) and a
session ACL (dynamic-session-acl) are automatically created which reference the dynamically-assigned IP
addresses. This allows you to configure policies that map private local addresses to the public address(es)
provided to the DHCP or PPPoE client. Whenever the IP address on the VLAN changes, the dynamic NAT pool
address also changes to match the new address.

For example, the following rule for a guest policy denies traffic to any network addresses. .

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > Policies

page. Click + to add the policy guest.

2. Select the new guest policy from the Policies table.

3. To add a rule, click + in the Policies > guest table.

d. Select Deny from the Action drop-down list.

e. Select Any from the MAC address drop-down list.

f. Set Mirror to Disabled.

g. Click Submit.

h. Click Pending Changes.

i. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [mynode] (config) #ip access-list session guest

any network any deny
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Configuring Source NAT for VLAN Interfaces
The example configuration in the previous section illustrates how to configure source NAT using a policy that is
applied to a user role. You can also enable source NAT for a VLAN interface to perform NAT on the source
address for all traffic that exits the VLAN.

All outbound traffic can enable NAT with the IP address of the VLAN interface as the source address; while the
locally routed traffic is sent without any address translation.

Traditionally, ArubaOS supported only IP NAT Inside feature where traffic performs NAT with the desired IP
address of the VLAN interface as the source address which was useful for only traffic going out of uplink VLAN
interface. However, for traffic which needed local routing was also going through unnecessary address
translation. Now, this feature resolves this issue by allowing only outbound traffic to perform NAT.

Do not enable the NAT translation for inbound traffic option for VLAN 1, as this will prevent IPsec connectivity
between Mobility Master and its IPsec peers.

Sample Configuration
In the following example, the managed device operates within an enterprise network. VLAN 1 is the outside
VLAN, and traffic from VLAN 6 is source NATed using the IP address of the managed device. The IP address
assigned to VLAN 1 is used as the managed device’s IP address; thus traffic from VLAN 6 would be source
NATed to 66.1.131.5:

Figure 13 Example: Source NAT using theManaged Device's IP Address

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page. Click

+ to configure VLAN 6 (VLAN 1 is configured through the Initial Setup).

a. Enter 6 for the VLAN ID.

b. Click Submit.

2. Select VLAN 6.

a. Navigate to the IPv4 tab for VLAN 6.

b. Click IP Address Assignment to expand it.

c. Enter 192.168.2.1 for the IP4 address.

d. Click Submit.

e. Click Other Option to expand it.

f. Set Source NAT to Enabled.

g. Click Submit.



h. Click Pending Changes.

i. In the Pending Changes window, select the check box and click Deploy changes.

3. Select VLAN 1.

a. Navigate to the IPv4 tab for VLAN 6.

b. Click IP Address Assignment to expand it.

c. Enter 66.1.131.5 for the IPv4 address.

d. Click Submit.

e. Click Other Option to expand it.

f. Set Source NAT to Enabled.

g. Click Submit.

h. Click Pending Changes.

i. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [mynode] (config) #interface vlan 1

ip address 66.1.131.5 255.255.255.0

ip nat outside

(host) [mynode] (config) #interface vlan 6

ip address 192.168.2.1 255.255.255.0

ip nat inside

Trusted Vs. Untrusted Ports and VLANs
Both Fast Ethernet and Gigabit Ethernet ports can be set to access or trunk mode. A port is in access mode
enabled by default and carries traffic only for the VLAN to which it is assigned. In trunk mode, a port can carry
traffic for multiple VLANs.

For a trunk port, specify whether the port will carry traffic for all VLANs configured on the managed device or
for specific VLANs only. You can also specify the native VLAN for the port. A trunk port uses 802.1q tags to
mark frames for specific VLANs, However, frames on a native VLAN are not tagged.

For more information on configuring trusted and untrusted ports or VLANs, see Configuring Trusted/Untrusted Ports
and VLANs on page 95

Classifying Traffic as Trusted or Untrusted
You can classify wired traffic based not only on the incoming physical port and channel configuration, but also
on the VLAN associated with the port and channel.

About Trusted and Untrusted Physical Ports
Physical ports on the managed device are trusted and usually connected to internal networks by default, while
untrusted ports connect to third-party APs, public areas, or other networks to which you can apply access
controls. When you define a physical port as untrusted, traffic passing through that port needs to go through a
predefined access control list policy.

About Trusted and Untrusted VLANs
You can also classify traffic as trusted or untrusted based on the VLAN interface and port or channel. This
means that wired traffic on the incoming port is trusted only when the port’s associated VLAN is also trusted;
otherwise the traffic is untrusted. When a port and its associated VLANs are untrusted, any incoming and
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outgoing traffic must pass through a predefined ACL. For example, this setup is useful if your company
provides wired user guest access, and you want guest user traffic to pass through an ACL to connect to a
captive portal.

You can set a range of VLANs as trusted or untrusted in trunk mode. The following table lists the port, VLAN
and the trust/untrusted combination to determine if traffic is trusted or untrusted. Both the port and the
VLAN have to be configured as trusted for traffic to be considered as trusted. If the traffic is classified as
untrusted, then traffic must pass through the selected session access control list and firewall policies.

Port VLAN Traffic Status

Trusted Trusted Trusted

Untrusted Untrusted Untrusted

Untrusted Trusted Untrusted

Trusted Untrusted Untrusted

Table 16: Classifying Trusted and Untrusted Traffic

Assign an IP Address to a VLAN
A VLAN on the managed device obtains its IP address in one of the following ways:

l You can manually configure it. This is the default method and is described in Assign an IP Address to a VLAN
on page 92. At least one VLAN on the managed device must be assigned a static IP address.

l Dynamically assigned from a Dynamic Host Configuration Protocol (DHCP) or Point-to-Point Protocol over
Ethernet (PPPoE) server.

Assigning a Static Address to a VLAN
You can manually assign a static IP address to a VLAN on the managed device. At least one VLAN on the
managed device should have a static IP address.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

Select a VLAN from the VLANs table, and then select a VLAN ID under Vlan Ids.

2. Under IPv4, select Static from the IP assignment drop-down list.

3. Enter the IPv4 address of the VLAN interface.

4. Select the type of circuit-specific information to be forwarded to the DHCP server from the Option-82
drop-down list.

5. Enter an MTU value for the VLAN, between 1280 and 1500.

6. Enable or disable Supress ARP. If enabled, the managed device prevents flooding of ARP broadcasts on all
untrusted interfaces. This is disabled by default.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #interface vlan <vlan>



ip address <ipaddr> <ipmask>

Configuring a VLAN to Receive a Dynamic Address
In a branch office, you can connect a managed device to an uplink switch or server that dynamically assigns IP
addresses to connected devices. For example, you can connect the managed device to a DSL or cable modem,
or a broadband remote access server (BRAS). The following figure shows a branch office where a managed
device connects to a cable modem. VLAN 1 has a static IP address, while VLAN 2 has a dynamic IP address
assigned via DHCP or PPPoE from the uplink device.

The following restrictions apply when enabling the DHCP or PPPoE client on the managed device:

l You can enable the DHCP/PPPoE client multiple uplink VLAN interfaces (up to four) on the managed device;
these VLANs cannot be VLAN 1.

l Only one port in the VLAN can be connected to the modem or uplink switch.

l At least one interface in the VLAN must be in the up state before the DHCP/PPPoE client requests an IP
address from the server.

Figure 14 IP Address Assignment to VLAN via DHCP or PPPoE

Enabling the DHCP Client
The DHCP server assigns an IP address for a specified amount of time called a lease. The managed device
automatically renews the lease before it expires. When you shut down the VLAN, the DHCP lease is released.

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

2. Select a VLAN from the VLANs table, and then select a VLAN ID under Vlan Ids.

3. Under IPv4, select DHCP from the IP assignment drop-down list.

4. Enter the Client ID and select a link from the Uplink wired drop-down list.

5. Enter a priority value for the VLAN ID in the UpLink Priority field. All wired uplink interfaces have the same
priority by default. If you want to use an active-standby topology, then prioritize each uplink interface by
entering a different priority value (1– 4) for each uplink interface.

6. Enter the Uplink weight and MTU value for the VLAN, between 1280 and 1500.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

In this example, the DHCP client has the client ID namemyclient, and the interface VLAN 62 has an uplink
priority of 2:
(host) [mynode] (config) #interface vlan 62

(host) [mynode] (config) #uplink wired vlan 62 priority 2
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(host) [mynode] (config) #interface vlan 62 ip address dhcp-client client-id myclient

Enabling the PPPoE Client
To authenticate the BRAS and request a dynamic IP address, the managed device must have the following
configured:

l PPPoE user name and password to connect to the DSL network

l PPPoE service name: either an ISP name or a class of service configured on the PPPoE server

When you shut down the VLAN, the PPPoE session terminates.

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

2. Select the previously-created VLAN.

3. Select a VLAN from the VLANs table, and then select a VLAN ID under Vlan Ids.

4. Under IPv4, select PPPoE from the IP assignment drop-down list.

5. Enter the Service name, User name, and Password for the PPPoE session.

6. Enter a priority value for the VLAN ID in the UpLink Priority field. All wired uplink interfaces have the same
priority by default. If you want to use an active-standby topology, then prioritize each uplink interfaces by
entering a different priority value (1– 4) for each uplink interface.

7. Enter an MTU value for the VLAN, between 1280 and 1500.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

In this example, a PPoE service name, username, and password are assigned, and the interface VLAN 14 has an
uplink priority of 3:
(host) [mynode] (config) #interface vlan 14

ip address pppoe

ip pppoe-service-name <service_name>

pppoe-username <username>

ip pppoe-password <password>

(host) [mynode] (config) #uplink wired vlan 14 priority 3

Default Gateway from DHCP/PPPoE
You can specify that the router IP address obtained from the DHCP or PPPoE server be used as the default
gateway for the managed devices.

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > IP Routes page.

2. Click Dynamic Default Gateway to expand it. Set the following to Enabled:

n DHCP - Use DHCP when available to obtain default gateway.

n PPPoE - Use PPPOE when available to obtain default gateway.

n Cellular - Use Cell interface when available to obtain default gateway.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.



In the CLI
(host) [mynode] (config) #ip default-gateway import {cell|cell-cost <cost>|dhcp|dhcp-cost

<cost>|pppoe|pppoe-cost <cost>}

Configuring DNS/WINS Server from DHPC/PPPoE
The DHCP or PPPoE server can also provide the IP address of a DNS server or NetBIOS name server, which can
be passed to wireless clients through the managed device’s internal DHCP server.

For example, the following configures the DHCP server on the managed device to assign addresses to
authenticated employees; the IP address of the DNS server obtained by the managed device via DHCP/PPPoE
is provided to clients along with their IP address.

In the WebUI

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > DHCP Server
page.

2. Set the DHCP server to Enabled.

3. Under Pool Configuration, click +. The Add New Pool Configuration window appears.

4. For Pool Name, enter employee-pool.

5. For Default Routers, enter 10.1.1.254.

6. For DNS Servers, select Import from DHCP/PPPoE.

7. For WINS Servers, select Import from DHCP/PPPoE.

8. For Network, enter 10.1.1.0 for IP address and 255.255.255.0 for IP mask.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following commands:
(host) [mynode] (config) #ip dhcp pool employee-pool

default-router 10.1.1.254

dns-server import

netbios-name-server import

network 10.1.1.0 255.255.255.0

Configuring Trusted/Untrusted Ports and VLANs
Use the following procedures to define access ports and VLANs as trusted or untrusted.

For more information on trusted vs untrusted ports and VLANs, see Trusted Vs. Untrusted Ports and VLANs on page
91

Configuring An Ethernet port as an Untrusted Access Port
You can configure an Ethernet port as an untrusted access port, assign VLANs and classify them as untrusted,
and designate a policy through which VLAN traffic on this port must pass.

In the WebUI
1. In the Mobility Masternode hierarchy, navigate to the Configuration > Interfaces > Ports page.

2. Select the port you want to configure from the Ports table.

3. In the Trust drop-down list, select Untrusted to make the port untrusted. The default is Trusted.
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4. In the Mode drop-down list, select Access.

5. From the VLAN drop-down list, select the VLAN whose traffic will be carried by this port.

6. In the VLAN trust drop-down list, select Untrusted to make the VLAN untrusted. The default is Trusted.

7. In the VLAN policy drop-down list, select the policy through which VLAN traffic must pass. You can select a
policy for both trusted and untrusted VLANs.

8. Select whether Tunneled node should be Enabled or Disabled.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
In this example,
(host) [mynode] (config) #interface range gigabitethernet <slot>/<module-start>/<port-start>-

<module-end>/<port-end>

(host) [mynode] (config-if)#switchport access

(host) [mynode] (config-if)#no trusted

(host) [mynode] (config-if)#switchport access vlan <vlan>

(host) [mynode] (config-if)#no trusted vlan <vlan>

(host) [mynode] (config-if)#ip access-group ap-acl session vlan <vlan>

(host) [mynode] (config-if)#ip access-group validuserethacl in

(host) [mynode] (config-if)#ip access-group validuserethacl out

(host) [mynode] (config-if)#ip access-group validuser session

Configuring Trusted and Untrusted Ports and VLANs in Trunk Mode
The following procedures configure a range of Ethernet ports as untrusted native trunks ports, assign VLANs
and classify them as untrusted, and designate a policy through which VLAN traffic on the ports must pass.

In the WebUI
1. In the Mobility Masternode hierarchy, navigate to the Configuration > Interfaces > Ports page.

2. Select the port you want to configure from the Ports table.

3. For Mode select Trunk.

4. To specify the native VLAN, select a VLAN from the Native VLAN drop-down list.

5. Choose one of the following options from the Allowed VLANs drop-down list to control the type of traffic
the port carries:

n Allow all: The port carries traffic for all VLANs.

n Allow specified VLANs: The port carries traffic for all VLANs selected. Click + to specify a VLAN. You
can select whether the VLAN is Trusted or Untrusted.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following examples:
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

(host) [mynode] (config-if)#description <string>

(host) [mynode] (config-if)#trusted {vlan <word>}

(host) [mynode] (config-range)#switchport mode trunk

(host) [mynode] (config-if)#switchport trunk native vlan <vlan>

(host) [mynode] (config-range)#ip access-group test session vlan <vlan>



Configuring the Mobility Master IP Address
The Mobility Master or managed device's IP address is used to communicate with external devices such as APs.

IP addresses used by the Mobility Master or managed device are not limited to its own IP address.

You can set the IP address to the loopback interface address or to an existing VLAN ID address. This allows you
to force the IP address to be a specific VLAN interface or loopback address across multiple machine reboots.
Once you configure an interface to be the Mobility Master or managed device's IP address, that interface
address cannot be deleted until you remove it from the IP configuration.

If the IP address is not configured, the Mobility Master or managed device's IP defaults to the current loopback
interface address. If the loopback interface address is not configured then the first configured VLAN interface
address is selected. Generally, VLAN 1 is the factory default setting, and thus, becomes the IP address.

In the WebUI
1. In the Mobility Master or Managed Device node hierarchy, navigate to the Configuration > System >

General page.

2. Expand the Controller IP address section.

3. Select the address you want to set as the Mobility Master or managed device's IP from the IPv4 address or
IPv6 address drop-down lists. This list only contains VLAN IDs with statically assigned IP addresses. If you
have previously configured a loopback interface IP address, then it will also appear in this list. Dynamically
assigned IP addresses, such as DHCP/PPPOE, do not appear.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Any change in the Mobility Master or managed device’s IP address requires a reboot.

7. In the Mobility Master node hierarchy, navigate to the Maintenance > Software Management >
Reboot page to reboot Mobility Master and apply the IP address update.

8. Click Yes to save the configuration.

9. Click Reboot.

10.Mobility Master boots up with the updated IP address of the selected VLAN ID.

In the CLI
(host) [mynode] (config) #controller-ip [loopback|vlan <vlan-id>]

Configuring the Loopback IP Address

The loopback IP address is a logical IP interface that is used to communicate with APs. The loopback address is
used as the Mobility Master or managed device’s IP address for terminating VPN and GRE tunnels, originating
requests to RADIUS servers, and accepting administrative communications. You configure the loopback
address as a host address with a 32-bit netmask. The loopback address is not bound to any specific interface
and is operational at all times. To use this interface, ensure that the IP address is reachable through one of the
VLAN interfaces. It will be routable from all external networks.
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You must configure a loopback address if you are not using VLAN1 to connect the Mobility Master or managed
device to the network. If you do not configure the loopback interface address, then the first configured VLAN
interface address is selected. Generally, VLAN 1 is the factory default setting, and thus, becomes the IP
address.

In the WebUI
1. In the Mobility Masteror Managed Device node hierarchy, navigate to the Configuration > System >

General page.

2. Expand the Loopback Interface section.

3. Enter an address into the IPv4 Address or IPv6 Address field, as required.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

If you are use the loopback IP address to access the WebUI, changing the loopback IP address will result in loss of
connectivity. It is recommended that you use one of the VLAN interface IP addresses to access the WebUI.

7. In the Mobility Master node hierarchy, navigate to the Maintenance > Software Management >
Reboot page to reboot Mobility Master and apply the loopback IP address update.

8. Click Yes to save the configuration.

9. Click Reboot.

10.Mobility Master boots up with the changed loopback IP address.

In the CLI
Use the following commands:
(host) [mynode] (config) #interface loopback ip address <ipaddr>

Configuring Static IP Routes
The following procedures configure a static IP route (such as a default route) on Mobility Master.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > IP Routes page.

2. Expand the IP Routes section.

3. Click + to add a static route to a destination network or host.

4. Select the IP Version.

5. Enter the Destination IP address and Destination network mask (255.255.255.255 for a host route)

6. Select a forwarding setting:

l Using Forwarding Router Address: Enter the nexthop IP address in dotted decimal format (A.B.C.D).
Optionally, enter the distance metric (cost) for this route. The cost prioritizes routing to the destination.
The lower the cost, the higher the priority.

l Using IPSec Name Map: Enter the IPsec map name to use a static IPsec route map.

l Using Null Interface: Designate a null interface.

7. Enter the Next hop IP address and Cost.

8. Click Submit.

9. Click Pending Changes.



10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following example:
(host) [mynode] (config) #ip route <destip> <destmask> {ipsec <name> [<cost>]|null <0-

0>|<nexthop> [<cost>]}

Configuring GRE Tunnels
Mobility Master supports Generic Routing Encapsulation (GRE) tunnels between managed device and other
network devices that support GRE tunnels.

This section contains the following information:

l About Layer-2 GRE Tunnels

l About Layer-3 GRE Tunnels

l Configuring a Layer-2 GRE Tunnel

l Configuring a Layer-3 GRE Tunnel for IPv4 or IPv6

l Directing Traffic into the GRE Tunnel

l Configuring Tunnel Keepalives

About Layer-2 GRE Tunnels
Layer-2 GRE tunnels allow you to have the same VLAN in multiple locations (separated by a Layer-3 network)
and be connected. The forwarding method for a Layer-2 GRE tunnel is bridging.

However, the drawback of using Layer-2 GRE tunnels is that all broadcasts are flooded through the tunnel,
adding traffic load to the network and the managed devices.

Figure 15 Layer-2 GRE Tunnel

The traffic flow illustrated by Figure 15 is as follows:

1. The frame enters the source managed device (Controller-1) on VLAN 101.

The frame is bridged through Controller-1 into the Layer-2 GRE tunnel.

2. The frame is encapsulated in a GRE packet.

3. The GRE packet enters the network on VLAN 10, is routed across the network to the destination managed
device (Controller-2), and then exits the network on VLAN 20.

The source IP address of the GRE packet is the IP address of the interface in VLAN 10 in Controller 1.

4. The frame is de-encapsulated and bridged out of the destination managed device (Controller-2) on VLAN
101.
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About Layer-3 GRE Tunnels
The benefit of Layer-3 GRE tunnels is that broadcasts are not flooded through the tunnel, so there's less
wasted bandwidth and less load on the managed devices. The forwarding method for a Layer-3 GRE tunnel is
routing. By default, GRE tunnels are in IPv4 Layer-3 mode.

Figure 16 IPv4 Layer-3 GRE Tunnel

Figure 17 IPv6 Layer-3 GRE Tunnel

IPv6 encapsulated in IPv4 and IPv4 encapsulated in IPv6 are not supported. The only Layer-3 GRE modes supported
are IPv4 encapsulated in IPv4 and IPv6 encapsulated in IPv6.

Layer-3 Tunnel Traffic FLow
The traffic flow illustrated by Figure 16 and Figure 17 is as follows:

1. The frame enters the source managed device (Controller-1) on VLAN 101.

The IP packet within the frame is routed through Controller-1 into the Layer-3 GRE tunnel.

2. The IP packet is encapsulated in a GRE packet.

3. The GRE packet enters the network on VLAN 10, is routed across the network to destination managed
device (Controller-2), and then exits the network on VLAN 20.

The source IP address of the GRE packet is the IP address of the interface in VLAN 10 in Controller 1.

4. The IP packet is de-encapsulated and routed out of the destination managed device (Controller-2) on VLAN
202.

Limitations for Static IPv6 Layer-3 Tunnels
ArubaOS does not support the following functions for static IPv6 Layer-3 GRE tunnels:

l IPv6 Auto-configuration and IPv6 Neighbor Discovery mechanisms do not apply to IPv6 GRE tunnels.

l The tunnel encapsulation limit and Maximum Transmission Unit (MTU) discovery options are not supported
on IPv6 GRE tunnels.



Configuring a Layer-2 GRE Tunnel

In the WebUI
To configure a Layer-2 GRE tunnel for a source managed device and destination managed device via the
WebUI:

1. In the source Managed Device node hierarchy, navigate to Configuration > Interfaces > GRE Tunnels.

2. Create a new GRE tunnel by clicking + below the GRE Tunnel table, or edit an existing GRE tunnel by
selecting an entry from the GRE Tunnel table.

3. Enter the corresponding GRE tunnel values for this managed device.

4. (Optional) Select Enable from the Enable heartbeats drop-down list to enable tunnel keepalive
heartbeats. For more information on this feature, see Configuring Tunnel Keepalives on page 104

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

8. Next, access the destination managed device and navigate to Configuration > Interfaces > GRE Tunnels.

9. Select the tunnel ID of interest from the GRE Tunnel table.

10.Use the edit screen to configure the destination managed device.

11.(Optional) Select Enable from the Enable heartbeats drop-down list to enable tunnel keepalive
heartbeats.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
The following command example configures a Layer-2 GRE tunnel:

Referring to Figure 15, the following are the required configurations to create the Layer-2 GRE tunnel between
controllers named Controller-1 and Controller-2:

Controller-1 Configuration
(Controller-1) (config) # interface tunnel 102

description “IPv4 Layer-2 GRE 102"

tunnel mode gre 1

tunnel source vlan 10

tunnel destination 20.20.20.249

tunnel keepalive

trusted

tunnel vlan 101

Controller-2 Configuration
(Controller-2) (config) # interface tunnel 202

description “IPv4 Layer-2 GRE 202"

tunnel mode gre 1

tunnel source vlan 20

tunnel destination 10.10.10.249

tunnel keepalive

trusted

tunnel vlan 101
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Configuring a Layer-3 GRE Tunnel for IPv4 or IPv6

In the WebUI
The following steps describe the procedure configure an IPv4 Layer-3 GRE tunnel for Controller-1 and
Controller-2 via the WebUI.

1. Log into Controller-1.

2. Navigate to Configuration > Interfaces > GRE Tunnels. The GRE Tunnels page is displayed.

3. Create a new GRE tunnel by clicking + below the GRE Tunnel table, or edit an existing GRE tunnel by
selecting that entry in the GRE Tunnel table. The GRE Tunnel configuration options appear.

4. Click the IP Version drop-down list and select IPv4 or IPv6.

5. Enter the corresponding GRE tunnel values for the controller.

l To configure an IPv4 GRE tunnel , use values for Controller-1 based on the network shown in Figure 16.

l To configure an IPv6 GRE tunnel , use values for Controller-1 based on the network shown in Figure 17.

If a VLAN interface has IPv6 addresses configured, one of them is used as the tunnel source IPv6 address. If the
selected IPv6 address is deleted from the VLAN interface, then the tunnel source IP address is reconfigured with the
next available IPv6 address.

6. (Optional for IPv4 or IPv6 GRE Tunnels) Select Enable Heartbeats to enable tunnel keepalive heartbeats.
For more information on this feature, see Configuring Tunnel Keepalives on page 104

7. Click Apply.

8. Next, log into Controller-2 and navigate to Configuration > Interfaces > GRE Tunnels.
9. Create a new GRE tunnel by clicking + below the GRE Tunnel table, or edit an existing GRE tunnel by

selecting that entry in the GRE Tunnel table. The GRE Tunnel configuration options appear.

10.Enter the corresponding GRE tunnel values for this controller.

l To create an IPv4 L3 GRE tunnel, use the values for Controller-2 as shown in Figure 16.

l To create an IPv6 L3 GRE tunnel, use the values for Controller-2 as shown in Figure 17.

11.(Optional for IPv4 or IPv6 GRE Tunnels) Select Enable Heartbeats to enable tunnel keepalive heartbeats.

12.Click Apply.

In the CLI
The following command examples configure an IPv4 Layer-3 GRE tunnel for IPv4 between two controllers.

Referring to Figure 16, the following are the required configurations to create the IPv4 Layer-3 GRE tunnel
between controllers named Controller-1 and Controller-2:

IPv4 Controller-1 Configuration
(Controller-1) (config) # interface tunnel 104

description “IPv4 L3 GRE 104"

tunnel mode gre ip

ip address 1.1.1.1 255.255.255.255

tunnel source vlan 10

tunnel destination 20.20.20.249

trusted

IPv4 Controller-2 Configuration
(Controller-2) (config) # interface tunnel 204

description “IPv4 L3 GRE 204"

tunnel mode gre ip

ip address 1.1.1.2 255.255.255.255

tunnel source vlan 20



tunnel destination 10.10.10.249

trusted

The following command example configures a Layer-3 GRE tunnel for IPv6:

IPv6 Controller-1 Configuration
(Controller-1) (config) # interface tunnel 106

description “IPv6 Layer-3 GRE 106"

tunnel mode gre ipv6

ip address 2001:1:2:1::1

tunnel source vlan 10

tunnel destination 2001:1:2:2020::1

trusted

IPv6 Controller-2 Configuration
(Controller-2) (config) # interface tunnel 206

description “IPv6 Layer-3 GRE 206"

tunnel mode gre ipv6

ip address 2001:1:2:1::2

tunnel source vlan 20

tunnel destination 2001:1:2:1010::1

trusted

Directing Traffic into the GRE Tunnel
You can direct traffic into a GRE tunnel by configuring a Static route, which directs traffic to the IP address of
the tunnel, or a Firewall policy (session-based ACL), that redirects traffic to the specified tunnel ID.

About Configuring Static Routes
You can configure a static route that specifies the IP address of a tunnel as the next-hop for traffic for a specific
destination. See Configuring Static IP Routes on page 98 for detailed information on how to configure a static
route.

While redirecting traffic into a Layer-3 GRE tunnel via a static route, be sure to use the controller's tunnel IP address
as the next-hop, instead of providing the destination controller's tunnel IP address.

Referring to Figure 16, the following are examples of the required static route configurations to direct traffic
into the IPv4 Layer-3 GRE tunnel. for Controller-1 and Controller-2:

l For the controller named Controller-1:
(Controller-1) (config) # ip route 20.20.202.0 255.255.255.0 1.1.1.1

l For the controller named Controller-2:
(Controller-2) (config) # ip route 10.10.101.0 255.255.255.0 1.1.1.2

Configuring a Firewall Policy Rule
You can configure a firewall policy rule to redirect selected traffic into a GRE tunnel.

Traffic redirected by a firewall policy rule is not forwarded to a tunnel that is “down” (see the next section,
Configuring Tunnel Keepalives, for more information on how GRE tunnel status is determined).

From the WebUI

To direct traffic into a GRE tunnel via a firewall policy via the WebUI:

1. On the controller, navigate to the Configuration > Roles & Policies > Policies page.

2. Create a new firewall policy by clicking + below the Policies table. The Add Policy popup window appears.

3. Enter the Policy Name.
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4. For Policy Type, specify Session (the default).

5. Click Apply.

6. To create a new policy rule for that policy, select the new policy in the Policies table, then scroll to the Add
table (below the Policies table) section and click +.

a. Select the Rule Type and click OK.

b. Specify the IP Version.

c. For Action, select PermitorDeny.

d. Configure any additional settings.

7. When satisfied with the settings, click Apply.

In the CLI

To direct traffic into a GRE tunnel via a firewall policy (session-based ACL) via the CLI, use the following
command:
(ControllerController-1)(config) #ip access-list session <name>

<source> <destination> <service> redirect tunnel <id>

Configuring Tunnel Keepalives
The controller determines the status of a GRE tunnel by sending periodic keepalive frames on the Layer-2 or
Layer-3 GRE tunnel. When you enable tunnel keepalives, the tunnel is considered “down” when the keepalives
fail repeatedly.

If you configure a firewall policy rule to redirect traffic to the tunnel, traffic is not forwarded to the tunnel until
it is "up." When the tunnel comes up or goes down, an SNMP trap and logging message is generated. The
remote endpoint of the tunnel does not need to support the keepalive mechanism.

The controller sends keepalive frames at 60-second intervals by default and retries keepalives up to three times
before the tunnel is considered down. You can change the default values of the intervals:

l For the interval, specify a value between 1 and 86400 seconds.

l For the retries, specify a value between 0 and 1024.

l To interoperate with Cisco network devices, use the cisco option.

In the WebUI
To configure keepalives (Heartbeats) via the WebUI:

1. On the controller, navigate to the Configuration > Interfaces > GRE Tunnels page.

2. Locate the tunnel ID for which you are enabling keepalives, and select it. The Edit GRE Tunnel screen
appears.

3. To enable tunnel keepalives and display the Heartbeat interval (secs) and Heartbeat Retries fields,
select Enabled.

a. Specify a value for Heartbeat interval (secs).
The default value is 10 seconds.

b. Specify a value for Heartbeat Retries.

The default value is 3 retries.

4. Click Apply.

In the CLI
To configure the keepalive heartbeats, use the following commands:
(host)(config) #interface tunnel id

tunnel keepalive [<interval> <retries>] [cisco]



GRE Tunnel Groups
ArubaOS supports redundancy of Generic Routing Encapsulation (GRE) tunnels for both Layer-2 and Layer-3
GRE tunnels. This feature enables automatic redirection of the user traffic to a standby tunnel when the
primary tunnel goes down.

GRE Tunnel Group Overview
A tunnel group is identified by a name or number. You can add multiple tunnels to a tunnel group. The order of
the tunnels defined in the tunnel-group configuration specifies their standby precedence. The first member of
the tunnel-group is the primary tunnel.

A GRE tunnel group combines two tunnels created on a managed device, where one tunnel is active and the
other tunnel is the standby. Traffic forwarding can occur on the active tunnel, and the standby tunnel can
become active once the active tunnel is down. When the first tunnel fails, the second tunnel carries the traffic.
The third tunnel in the tunnel-group takes over if the second tunnel also fails. In the meantime, if the first
tunnel comes up, it becomes the most eligible standby tunnel.

You can also enable or disable preemption as part of the tunnel-group configuration. Preemption is enabled by
default. This preemptive-failover option automatically redirects the traffic whenever it detects an active
tunnel with a higher precedence in the tunnel group. When preemption is disabled, the traffic gets redirected
to a higher precedence tunnel only when the tunnel carrying the traffic fails.

When creating a tunnel group, keep in mind the following:

l When a tunnel is added to the tunnel group, the tunnel is used for data traffic only if it is the active tunnel in
the group.

l Standby tunnels do not carry any data traffic. However, all tunnels in the group continue to send and
receive keepalive packets.

l Only one type of tunnel can be placed into a tunnel group—either Layer-2 or Layer-3. That is, you can't have
a tunnel group consisting of both Layer-2 and Layer-3 tunnels.

l The default value of tunnel group type is Layer-3.

l All tunnels in a Layer-2 tunnel group must be tunneling the same VLAN.

l A Layer-2 tunnel can only be part of one tunnel group.

l The ArubaOS Layer-2 tunnel-group is not interoperable with other vendors. You must set up Layer-2 tunnel
groups between Aruba devices only.

Configuring Tunnel Groups

In the WebUI
To configure a Layer-2 or Layer-3 tunnel group using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > Interfaces > GRE Tunnels.

2. Click + below the Tunnel Group table.

3. Specify a name for the tunnel-group in the Tunnel Group Name field.

4. In the Tunnel Group Members text box, click + to add one or more tunnel IDs.

5. Select the IDs and click OK.

6. To enable preemption, click the Enable Preemptive-Failover Mode drop-down list and select Enabled.
This option is enabled by default.

7. In the Mode section, identify the the tunnel group type as a layer-2 or layer-3 group.

8. Click Submit.

9. Click Pending Changes.
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10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands to configure a Layer-2 or Layer-3 tunnel group using the CLI:
(host) [mynode] (config) tunnel-group <tungrpname>

(host) [mynode] (config-tunnel-group)#

mode {L2|L3)

preemptive-failover

tunnel <tunnel-id>

Jumbo Frame Support
Jumbo frames are the data frames that are larger than 1500 bytes and includes the Layer 2 header and Frame
Check Sequence (FCS). Jumbo frames functionality can be configured on 7200 Series controllers to support up
to 9216 bytes of payload.

In centralized deployments, frames that are more than 1500 bytes in size are generated from the AP to the
managed device during encryption and enabling AMSDU. Therefore, whenever the AP associates to the
managed device, jumbo frames are used to get the highest network performace. If this functionality is not
supported, the data frames gets fragmented, which reduces the overall throughput of the network and makes
the network slow.

ArubaOS supports jumbo frames between 11ac APs and 7200 Series controllers only.

You can enable the jumbo frame support in the following scenarios:

l Tunnel node: In a tunneled node deployment, the wired clients connected on the tunneled nodes can
send and receive the jumbo frames.

l L2/L3 GRE tunnels: When you establish a GRE tunnel between two managed devices, the clients on one
managed device can send and receive jumbo frames from the clients on the other managed device on
enabling jumbo frames.

l Between wired clients: In a network where clients connect to the managed device with jumbo frames
enabled ports can send and receive the jumbo frames.

l Wi-Fi tunnel: A Wi-Fi tunnel can support an AMSDU jumbo frame for an AP (The maximum MTU supported
is up to 9216 bytes).

Limitations for Jumbo Frame Support
This release of ArubaOS does not support the jumbo frames for the following scenarios:

l IPsec, IPIP, and xSec.

l IPv6 fragmentation/reassembly.

Configuring Jumbo Frame Support
You can use the CLI to configure the jumbo frame support.

To enable the jumbo frame support globally and to configure the MTU value:
(host) [mynode] (config) #firewall jumbo mtu <1789-9216>

You can configure the MTU value between 1789-9216. The default MTU value is 9216.

To enable jumbo frame support on a port channel:



(host) [mynode] (config) #interface port-channel <id> jumbo

To enable jumbo frame support on a port:
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port> jumbo

Viewing the Jumbo Frame Support Status
Execute the following command to view the global status of the jumbo frame support:
(host) [mynode] #show firewall

Execute the following command to view the jumbo frame status on a port:
(host) [mynode] #show interface gigabitethernet <slot>/module>/<port>

Execute the following command to view the jumbo frame status on a port channel:
(host) [mynode] #show interface port-channel <id>

PVST+ (Per-VLAN Spanning Tree Plus)
PVST+ (Per-VLAN Spanning Tree Plus) provides load-balancing of VLANs across multiple ports, resulting in
optimal usage of network resources. PVST+ also ensures interoperability with industry-accepted PVST+
protocols.

PVST+ is disabled by default.

Understanding PVST+ Interoperability and Best Practices
The interoperability between RSTP and PVST+ includes:

l When the access port on the managed device and the trunk port terminate on one Layer 2 switch running
PVST+, PVST+ will send untagged STP BPDUs on the access port; it also transmits untagged STP BPDUs (in
addition to the other PVST+ BPDUs) on the native VLAN trunk port. If the Aruba managed device is the
root, it will detect a loop on the native VLAN.

If PVST+ is not on the managed device, best practices recommend disabling RSTP on the Aruba managed device to
avoid a looping issue.

l For VLAN load balancing when managed devices are connected to armed mode, the VLAN priorities on two
ports and bridge priorities must be configured so that one set of VLANs are active on one link, and the other
set of VLANs are active on the other link.

l Supported instances include: 64 on the 7000 Series and 7200 Seriescontrollers.

Enabling PVST+ in the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Interfaces > VLANs and select a

VLAN with one or more active interfaces in the VLANs table.

2. In the Port Members table, select the More option.

3. Expand the Spanning Tree section, and enable PVST mode.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

ArubaOS 8.0.0.0 | User Guide Network Configuration Parameters |  107



108 | Network Configuration Parameters ArubaOS 8.0.0.0  | User Guide

Enabling PVST+ in the CLI
PVST+ is disabled by default. Enable PVST+, ensure a VLAN instance is configured, and then configure PVST+.

1. Enable PVST+:
(host) [mynode] (config) #spanning-tree mode rapid-pvst

2. Configure PVST+ forward time; the following command sets the time VLAN 2 spends in the listening and
learning state (3 seconds):
(host) [mynode] (config) #spanning-tree vlan 2 forward-time 3

3. Configure PVST+ hello time; the following command sets the time VLAN 2 waits to transmit BPDUs to four
seconds:
(host) [mynode] (config) #spanning-tree vlan 2 hello-time 4

4. Configure PVST+ max age; the following command sets the time VLAN 2 waits to receive a hello packet to
30 seconds:
(host) [mynode] (config) #spanning-tree vlan 2 max-age 30

5. Configure PVST+ priority: the following command sets the VLAN 2 priority to 10, making it more likely to
become the root bridge:
(host) [mynode] (config) #spanning-tree vlan 2 priority 10

6. Configure PVST+ on a range of VLANs using the VLAN IDs (coma separated or hyphen separated):
(host) [mynode] (config) #spanning-tree vlan range 2-6,11

Rapid Spanning Tree Protocol (RSTP)
The ArubaOS implementation of Rapid Spanning Tree Protocol (RSTP) is as specified in 802.1w, with backward
compatibility to legacy Spanning Tree (STP) 802.1D. RSTP takes advantage of point-to-point links and provides
rapid convergence of the spanning tree. RSTP is enabled by default on all Aruba managed devices.

RSTP Overview
The ArubaOS RSTP implementation interoperates with PVST (Per VLAN Spanning Tree 802.1D) and Rapid-PVST
(802.1w) implementation on industry-standard routers/switches. Aruba only supports global instances of STP
and RSTP. Therefore, the ports on industry-standard routers/switches must be on the default or untagged
VLAN for interoperability with Aruba managed devices.

ArubaOS supports RSTP on the following interfaces:

l FastEthernet IEEE 802.3: fastethernet

l Gigabitethernet IEEE 802.3: gigabitethernet

l Port Channel ID: port-channel

Since RSTP is backwards compatible with STP, it is possible to configure both bridges in the same network.
However, such mixed networks may not always provide rapid convergence. RSTP provides rapid convergence
when interfaces are configured as either:

l Edge ports: These are the interfaces/ports connected to hosts. These interfaces are immediately moved to
the forwarding state. In this mode, an interface forwards frames by default until it receives a BPDU (Bridge
Protocol Data Units), indicating that it should behave otherwise. It does not go through the Listening and
Learning states.

l Point-to-Point links: These are the interfaces/ports connected directly to neighboring bridges over a
point-to-point link. RSTP negotiates with the neighbor bridge for rapid convergence/transition only when
the link is point-to-point.



STP (802.1d)
Port State RSTP (802.1w) Port State

Disabled Discarding

Blocking Discarding

Listening Discarding

Learning Learning

Forwarding Forwarding

Table 17: Port State Comparison

In addition to port state, RSTP introduces port roles for all the interfaces (see Table 18).

RSTP (802.1w)
Port Role Description

Root The port that receives the best BPDU on a bridge.

Designated The port can send the best BPDU on the segment to which it is connected.

Alternate The port offers an alternate path, in the direction of root bridge, to that provided by
bridge’s root port.

Backup The port acts as a backup for the path provided by a designated port in the direction
of the spanning tree.

Table 18: Port Role Descriptions

Configuring RSTP
Use either the CLI or the WebUI to configure RSTP.

In the WebUI
The RSTP port interface is designated as point-to-point, by default, in the existing port configuration screen ().

1. In the Mobility Master node hierarchy, navigate to Configuration > Interfaces > Ports.

2. In the Ports table, click the port number for which you want to enable RSTP/STP features.

3. Select the Show Advanced Options link at the bottom of the Ports tab.

4. Scroll down to the Spanning Tree drop-down list and select Enabled.

5. (Optional) Define values for the following Spanning Tree configuration parameters:

l Cost: Defines the RSTP interface path cost. The cost prioritizes routing to the destination. The lower the
cost, the higher the priority.

l Priority: Sets the interface’s RSTP priority. The supported range is 0–255, and the default value is 128.

l Port Fast: Changes from blocking to forwarding mode, enabling forwarding of traffic from the interface.

l Point-to-Point: Sets the interface as a point-to-point link.
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6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Change the default configurations using the following commands in the command-line interface:
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

(host) [mynode] (config-if) #spanning-tree

cost <value>

point-to-point

port-priority <value>

portfast

The following commands can be used to view settings and troubleshoot RSTP issues:

l The show spantree command displays the root and bridge information, verifying that they are correct.
The port/interface information (e.g. state, role, etc.) is also displayed to make sure that the state and role
information correspond with each other. For more details and examples on the show spantree command,
refer to show spantree in the ArubaOS CLI Reference Guide.

l The show spanning-tree interface command (config-if mode) displays Tx/Rx BPDU counters. For
example, if a port’s role is “designated,” it only transmit BPDUs but does not receive any. In this case, the Tx
counter continues to increase in increments while the Rx counter remains the same. This is reversed when a
port's role is “root/alternate/backup”. For more details and examples on the show spanning-tree
interface command, refer to show spaning-tree in the ArubaOS CLI Reference Guide.

PortFast and BPDU Guard for Spanning Tree
The PortFast and Bridge Protocol Data Unit (BPDU) Guard features enhance network reliability, manageability,
and security for Layer-2 Spanning Tree Protocol (STP) .

Some devices and local stacks running on systems/workstations are capable of generating potential STP
BPDUs that cause Denial of Service (DOS) attacks. PortFast and BPDU Guard features provide stability and
security for network topologies to prevent such attacks, and can be applied either independently or together.

PortFast
The PortFast feature is introduced to avoid network connectivity issues. These issues are caused by delays in
STP enabled ports moving from blocking-state to forwarding-state after transitioning from the listening and
learning states. STP enabled ports that are connected to devices such as a single switch, workstation, or a
server can access the network only after passing all these STP states. Some applications need to connect to the
network immediately, else they will timeout.

Enabling the PortFast feature causes a switch or a trunk port to enter the STP forwarding-state immediately or
upon a linkup event, thus bypassing the listening and learning states. The PortFast feature is enabled at a port
level, and this port can either be a physical or a logical port. When PortFast feature is enabled on a switch or a
trunk port, the port immediately transitions to the STP forwarding state.

Though PortFast is enabled the port still participates in STP. If the port happens to be part of topology that
could form a loop, the port eventually transitions into STP blocking mode. PortFast is usually configured on an
edge port, which means the port should not receive any STP BPDUs. If the port receives any STP BPDU, it
moves back to normal/regular mode and will participate in the listening and learning states.



In most deployments, edge ports are access ports. However, in this scenario there are no restrictions in
enabling the PortFast feature. The mode of the port changes from PortFast to non-PortFast when the port
receives a STP BPDU. To re-enable this feature on a port, run the shut command followed by a no-shut
command at the interface/port level.

Configuring PortFast on a non-edge port can cause instability to the STP topology.

BPDU Guard
BPDU Guard feature protects the port from receiving STP BPDUs, however the port can transmit STP BPDUs.
When a STP BPDU is received on a BPDU Guard enabled port, the port is shutdown and the state of the port
changes to ErrDis (Error-Disable) state. The port remains in the ErrDis state until the port status is manually
changed by using the configuration command shut followed by a no-shut applied on the interface. In most
deployments, BPDU Guard feature is configured over the PortFast enabled STP ports, but in this
implementation the BPDU Guard feature can be enabled on any of the STP ports, with or without PortFast
feature being enabled on these ports.

It is recommended not to enable the BPDU Guard feature on a trunk port that forms the STP topology.

Scenarios Supported on PortFast and BPDU Guard
PortFast and BPDU Guard features are applied at the port/interface level. These features can also be applied in
the following scenarios:

l RSTP and PVST modes

l Access and Trunk ports

l Physical and Logical ports

In the global RSTP mode, there is only one RSTP instance running in the entire Mobility Master. If the port that
is enabled with PortFast and BPDU Guard receives any STP BPDU, it affects all ports, as the global RSTP runs
on a port basis.

In the PVST mode, there can be multiple instances of RSTP running, as they are based per VLAN. Though it is
based per VLAN, it will still behave in the same way as it does in the global RSTP mode. For example, if there are
five VLANs and each VLAN has a separate RSTP instance running, then any STP BPDU received on any of these
five ports effects all ports.

If an STP BPDU is received from any one of the five RSTP instances running, the port that is enabled with BPDU
Guard shuts down and goes to ErrDis state. In other words, both PortFast and BPDU Guard features are
applied on a port basis for both global RSTP and PVST modes, even though the PVST runs on a per VLAN basis.

Enabling PortFast and BPDU Guard on a Port
The following section guides you to enable the PortFast and BPDU Guard features on a port. BPDU Guard is
configurable only via the command-line interface.

In the Web UI
Follow the steps below to enable PortFast features on a port using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > Interfaces > Ports.

2. In the Ports table, click the port number for which you want to enable PortFast and BPDU Guard.

3. Select the Show Advanced Options link at the bottom of the Ports tab .

4. Select the PortFast check box.
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5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

It is recommended to enable PortFast only on access port types. However, PortFast can be enabled on the trunk ports
by selecting the Trunk check box in the WebUI.

In the CLI
Execute the following commands at the command prompt to enable PortFast and BPDU Guard:
(host) [mynode] (config) #interface gigabitinternet <slot>/<module>/<port>

(host) [mynode] (config-if)#spanning-tree portfast

(host) [mynode] (config-if)#spanning-tree bpduguard

To disable PortFast
(host) [mynode] (config-if) #no spanning-tree portfast

(host) [mynode] (config-if) #no spanning-tree bpduguard

Execute the following command to enable PortFast on trunk ports:
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

(host) [mynode] (config-if)#spanning-tree portfast trunk

Execute the following show command to display the status of the STP ports ,
(host) [mynode] (config-if) #show spanning-tree interface gigabitethernet

<slot>/<module>/<port>

Link Layer Discovery Protocol
Link Layer Discovery Protocol (LLDP), defined in the IEEE 802.1AB standard, is a Layer 2 protocol that allows
network devices to advertise their identity and capabilities on a LAN. ArubaOS supports a simple one-way
neighbor discovery protocol with periodic transmissions of LLDP PDUs, allowing managed devices to advertise
identity information and capabilities to other nodes on the network and store the information discovered
about the neighbors.

Getting Started with ArubaOS LLDP
This chapter describes ArubaOS LLDP features, and lists the procedures to configure an LLDP solution.

Learn more about LLDP Features
The LLDP Overview on page 112 contains details about the ArubaOS implementation of the LLDP protocol,
including supported TLVs, and known issues and limitations.

Configure and Monitor an LLLDP Solution
Configuring and Monitoring LLDP on page 113 describes the commands to configure LLDP and monitor
existing LLDP neighborhood data.

LLDP Overview
LLDP supported devices use attributes known as TLVs to receive and send information such as configuration
information, device capabilities, and device identity to their neighbors. These TLVs contain contain type, length,
and value descriptions, use the destination MAC address 01:80:c2:00:00:0e, and are constrained to a local link.

Supported TLVs
ArubaOS supports the following basic management TLVs, all of which are enabled by default:



l MAC Phy configuration TLV

l Management address TLV

l Maximum frame size TLV

l Port-description TLV

l Port VLAN ID TLV

l System capabilities TLV

l System description TLV

l System name TLV

l VLAN name TLV

LLDP-MED
LLDP-MED (media endpoint devices) is an extension to LLDP that supports interoperability between VoIP
devices and other networking clients. LLDP-MED network policy discovery lets end-points and network devices
advertise their VLAN IDs (for example, voice VLAN), priority levels, and DSCP values. ArubaOS supports a
maximum of eight LLDP -MED Network Policy profiles.

Creating an LLDP MED network policy profile does not apply the configuration to any AP or AP interface or
interface group. To apply the LLDP-MED network policy profile, you must associate it to an LLDP profile, then
apply that LLDP profile to an AP wired port profile.

You can use the command, ap lldp med-network-policy-profile to define an LLDP MED network policy
profile that defines DSCP values and L2 priority levels for a voice or video application.

When you use the default LLDP configuration, the LLDP RX and LLDP TX parameters are disabled. You must
explicitly enable them for LLDP to work.

Feature Restrictions and Limitations
l Inventory-management and Location TLVs are not currently supported.

l Aggregation-management and Power-management TLVs are not supported.

l SNMP support is currently unavailable for LLDP MIBs.

l Cisco Discovery Protocol (CDP) proprietary is not supported.

l The maximum number of neighbors that can be learned on the managed device (including all the per port
neighbors) is 250.

Configuring and Monitoring LLDP
Configure LLDP using the following commands in the command-line interface. For detailed information on the
LLDP commands, refer to the interface fastethernet | gigabitethernet , show lldp and show ap lldp
command in the ArubaOS CLI Reference Guide.

Configuring LLDP
The following commands configure LLDP on a specific managed device interface.
(host) [mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

(host) [mynode] (config-if) #lldp

fast-transmit-counter <1-8>

fast-transmit-interval <1-3600>

med

receive

transmit

transmit-hold <1-100>

transmit-interval <1-3600>
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If you use the default LLDP configuration, the transmit and Receive parameters are disabled. You must explicitly
enable them for LLDP to work.

Configuring LLDP-MED
When you create an LLDP MED network policy profile, you must associate it to an LLDP profile, then apply that
LLDP profile to an AP wired port profile.

The following commands create a LLDP MED network policy profile for streaming video applications and marks
streaming video as high-priority traffic.

(host) [mynode] (config) #ap lldp med-network-policy-profile vid-stream

(host) [mynode] (AP LLDP-MED Network Policy Profile "vid-stream") #dscp 48

(host) [mynode] (AP LLDP-MED Network Policy Profile "vid-stream") #l2-priority 6

(host) [mynode] (AP LLDP-MED Network Policy Profile "vid-stream") #tagged

(host) [mynode] (AP LLDP-MED Network Policy Profile "vid-stream") #vlan 10

Next, the LLDP MED network policy profile is assigned to an LLDP profile, and the LLDP profile is associated
with an AP wired-port profile.
(host) [mynode] (config) #ap lldp profile video1

(host) [mynode] (AP LLDP Profile "video1") #lldp-med-network-policy-profile vid-stream

(host) [mynode] (config) #ap wired-port-profile corp2

(host) [mynode] (AP wired port profile "corp2") #lldp-profile video1

Monitoring LLDP Data and Configurations
The following show commands display aggregate and per-interface information about LLDP configurations
and neighborhood data.

Command Description

show lldp interface gigabitethernet

<slot>/<module>/<port>
Displays LLDP information for all interfaces, or include the
optional gigabitethernet <slot>/<module>/<port> parameters
to display LLDP information for a specific interface.

show lldp neighbor gigabitethernet

<slot>/<module>/<port> [details]
This command displays information about LLDP peers, including
the neighbor's name, MAC address and the capabilities of the
peer to operate as a router, bridge, access point, phone or other
network device. Include the optional gigabitethernet
<slot>/<module>/<port> parameters to display detailed
information about LLDP neighbors for a specific interface, or
include the details parameter to display additional details about
the device type, and LLDP-MED (Media Endpoint Discovery), if
applicable.

show lldp statistics gigabitethernet

<slot>/<module>/<port>
Displays information about LLDP TLVs sent and received on all
interfaces, or include the optional gigabitethernet
<slot>/<module>/<port> parameters to display LLDP TLV
statistics for a specific interface.

show ap lldp

med-network-policy-profile
Displays a list of LLDP-MED Network Policy profiles, or display the
current configuration settings of an individual profile.

Table 19: LLDP Show Commands



Command Description

show ap lldp counters Shows LLDP counters for a specific AP, or all APs sending or
receiving LLDP Protocol Data Units (PDUs).

show ap lldp [<profile>] Displays a list of LLDP-MED Network Policy profiles, or display the
current configuration settings of an individual profile.
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Chapter 6
IPv6 Support

This chapter describes ArubaOS support for IPv6 features:

l Understanding IPv6 Notation on page 116

l Understanding IPv6 Topology on page 116

l Enabling IPv6 on page 117

l Enabling IPv6 Support for Mobility Master and APs on page 117

l Filtering an IPv6 Extension Header (EH) on page 126

l Configuring a Captive Portal over IPv6 on page 126

l Working with IPv6 Router Advertisements (RAs) on page 126

l RADIUS Over IPv6 on page 139

l TACACS Over IPv6 on page 141

l DHCPv6 Server on page 141

l IPsec Support

l Understanding ArubaOS Supported Network Configuration for IPv6 Clients on page 144

l Understanding IPv6 Exceptions and Best Practices on page 151

Understanding IPv6 Notation
The IPv6 protocol is the next generation of large-scale IP networks, it supports addresses that are 128 bits
long. This allows 2128 possible addresses (versus 232 possible IPv4 addresses).

Typically, the IP address assigned on an IPv6 host consists of a 64-bit subnet identifier and a 64-bit interface
identifier. IPv6 addresses are represented as eight colon-separated fields of up to four hexadecimal digits each.
The following are examples of IPv6 addresses:
2001:0000:0eab:DEAD:0000:00A0:ABCD:004E

The use of the “::” symbol is a special syntax that you can use to compress one or more group of zeros or to
compress leading or trailing zeros in an address. The “::” can appear only once in an address.

For example, the address, 2001:0000:0dea:C1AB:0000:00D0:ABCD:004E can also be represented as:
2001:0:eab:DEAD:0:A0:ABCD:4E – leading zeros can be omitted

2001:0:0eab:dead:0:a0:abcd:4e – not case sensitive

2001:0:0eab:dead::a0:abcd:4e - valid

2001::eab:dead::a0:abcd:4e - Invalid

IPv6 uses a "/" notation which describes the no: of bits in netmask, similar to IPv4.
2001:eab::1/128 – Single Host

2001:eab::/64 – Network

Understanding IPv6 Topology
IPv6 APs connect to the IPv6 Mobility Master over an IPv6 L3 network. The IPv6 Mobility Master can terminate
both IPv4 and IPv6 APs. IPv4 and IPv6 clients can terminate to either IPv4 or IPv6 APs. ArubaOS supports
Router Advertisements (RA). You do not need an external IPv6 router in the subnet to generate RA for IPv6 APs
and clients that depend on stateless autoconfiguration to obtain IPv6 address. The external IPv6 router is the
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default gateway in most deployments. However, the Mobility Master can be the default gateway by using static
routes. The master-local communication occurs in both IPv4 and IPv6.

l The IPv6 Mobility Master (MC2) terminates both V4 AP (IPv4 AP) and V6 AP (IPv6 AP).

l Client 1 (IPv4 client) terminates to V6 AP and Client 2 (IPv6 client) terminates to V4 AP.

l Router is an external IPv6 router in the subnet that acts as the default gateway in this illustration.

l MC1 (master) and MC2 (local) communicates in IPv4.

Enabling IPv6
You must enable the IPv6 option on the Mobility Master before using any of the IPv6 functions. You can use
the ipv6 enable command to enable the IPv6 packet/firewall processing on the Mobility Master. The IPv6
option is disabled by default.

You can also use the WebUI to enable the IPv6 option:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > Firewall page.

2. Select the Global Settings accordion.

3. Select Enabled from IPv6 enable drop-down list to enable the IPv6 option.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Enabling IPv6 Support for Mobility Master and APs
This release of ArubaOS provides IPv6 support for Mobility Master and access points. You can now configure
the Mobility Master with an IPv6 address to manage the managed devices and APs. Both IPv4 and IPv6 APs
can terminate on the IPv6 managed device. You can provision an IPv6 AP in the network only if the managed
device interface is configured with an IPv6 address. An IPv6 AP can serve both IPv4 and IPv6 clients.

You must manually configure an IPv6 address on the managed device interface to enable IPv6 support.

You can perform the following IPv6 operations on the Mobility Master:

l Configuring IPv6 Addresses on page 119

l Configuring IPv6 Static Neighbors on page 120

l Configuring IPv6 Default Gateway and Static IPv6 Routes on page 121

l Configuring Prefix Delegation on page 121

l Managing Mobility Master IP Addresses on page 122

l Configuring Multicast Listener Discovery on page 123

l Debugging an IPv6 Mobility Master on page 125

l Provisioning an IPv6 AP on page 125

You can also view the IPv6 statistics on the Mobility Master using the following commands:

l show datapath ip-reassembly ipv6 — View the IPv6 contents of the IP Reassembly statistics table.

l show datapath route ipv6 — View datapath IPv6 routing table.

l show datapath route-cache ipv6 — View datapath IPv6 route cache.

l show datapath tunnel ipv6 — View the tcp tunnel table filtered on IPv6 entries.



l show datapath user ipv6 — View datapath IPv6 user statistics such as current entries, pending deletes,
high water mark, maximum entries, total entries, allocation failures, invalid users, and maximum link length.

l show datapath session ipv6 — View datapath IPv6 session entries and statistics such as current entries,
pending deletes, high water mark, maximum entries, total entries, allocation failures, invalid users, and
maximum link length.

Additionally, you can view the IPv6 AP information on the Mobility Master using the following show
commands:

l show ap database

l show ap active

l show user

l show ap details ip6-addr

l show ap debug

The following table lists IPv6 features:

Features Supported on IPv6 APs?

Forward Mode - Tunnel Yes

Forward Mode - Decrypt Tunnel No

Forward Mode - Bridge No

Forward Mode - Split Tunnel No

AP Type - CAP Yes

AP Type - RAP Yes

AP Type - Mesh Node No

CPsec Yes

Wired-AP/Secure-Jack Yes

Fragmentation/Reassembly Yes

MTU Discovery Yes

Provisioning through Static IPv6
Addresses

Yes

Provisioning through IPv6 FQDN
Master Name

Yes

Provisioning from WebUI Yes

Table 20: IPv6 APs Support Matrix
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Features Supported on IPv6 APs?

AP boot by Flash Yes

AP boot by TFTP No

WMM QoS No

AP Debug and Syslog Yes

ARM & AM Yes

WIDS Yes (Limited)

CLI support for users & datapath Yes

Configuring IPv6 Addresses
You can configure IPv6 addresses for the management interface, VLAN interface, and the loopback interface of
the Mobility Master. The managed device can have up to three IPv6 addresses for each VLAN interface. The
IPv6 address configured on the loopback interface or the first VLAN interface of the managed device becomes
the default IPv6 address of the managed device.

If only one IPv6 address is configured on the managed device, it becomes the default IPv6 address of the managed
device. With this release of ArubaOS, you can delete this IPv6 address.

You can configure IPv6 interface address using the WebUI or CLI. As per Internet Assigned Numbers Authority
(IANA), Aruba Mobility Master support the following ranges of IPv6 addresses:

l Global unicast—2000::/3

l Unique local unicast—fc00::/7

l Link local unicast—fe80::/10

In the WebUI

To Configure Link Local Address

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs tab.

2. Edit a Name.

3. Edit a VLAN ID and select IPv6 tab.

4. Enter the link local address in the Link Local Address field.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

To Configure Global Unicast Address

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs tab.

2. Edit a Name.

3. Edit a VLAN ID and select IPv6 tab.

4. Enter the IPv6 address and the prefix-length in the Global unicast address field.



5. (Optional) Select the EUI64 Format check box, if applicable.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

To Configure Loopback Interface Address

1. In the Managed Network node hierarchy, navigate to the Configuration > System > General tab.

2. Select Loopback Interface accordion and enter the loopback address in the IPv6 Address field.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

You cannot configure the management interface address using the WebUI.

In the CLI
To configure the link local address:
(host) [mynode] (config)#interface vlan <id>

(host) [mynode] (config-submode)#ipv6 address <ipv6-address> link-local

To configure the global unicast address:
(host) [mynode] (config)#interface vlan <id>

(host) [mynode] (config-submode)#ipv6 address <ipv6-prefix>/<prefix-length>

To configure the global unicast address (EUI 64 format):
(host) [mynode] (config)#interface vlan <id>

(host) [mynode] (config-submode)#ipv6 address <ipv6-prefix/prefix-length> eui-64

To configure the management interface address:
(host) [mynode] (config)#interface mgmt

(host) [mynode] (config-submode)#ipv6 address <ipv6-prefix/prefix-length>

To configure the loopback interface address:
(host) [node] (config)#interface loopback

(host) [node] (config-submode)#ipv6 address <ipv6-prefix>

Configuring IPv6 Static Neighbors
You can configure a static neighbor on a VLAN interface either using the WebUI or the CLI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > IPv6

Neighbors tab.

2. Click + and enter the following details:

l IPV6 Address

l Link-layer Addr

l VLAN Interface

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.
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In the CLI
To configure a static neighbor on a VLAN interface:
(host) [mynode] (config)#ipv6 neighbor <ipv6addr> vlan <vlan#> <mac>

Configuring IPv6 Default Gateway and Static IPv6 Routes
You can configure IPv6 default gateway and static IPv6 routes using the WebUI or CLI.

In the WebUI

To Configure IPv6 Default Gateway

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces and select the
IP Routes tab.

2. Click + under the Static Default Gateway accordion.

3. Select IPv6 as IP Version, and enter the IPv6 address in the IP Address field.

4. Click Submit to add the address to the IPv6 default gateway table.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To Configure Static IPv6 Routes

1. Click + under the IP Routes accordion.

2. Select IPv6 as IP Version.

3. Enter the Destination IP address and the Forwarding settings.

4. Click Submit to add the static route to the IPv6 routes table.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To configure the IPv6 default gateway:
(host) [mynode] (config)#ipv6 default-gateway <ipv6-address> <cost>

To configure static IPv6 routes:
(host) [mynode] (config)#ipv6 route <ipv6-prefix/prefix-length> <ipv6-next-hop> <cost>

<ipv6-next-hop> = X:X:X:X::X

Configuring Prefix Delegation
Prefix delegation can be used to assign a network address prefix to a customer site, as defined in IPv6 prefix
delegation protocol (RFC 3769). The hosts at the customer site use this prefix to derive a unique IPv6 address
using RA and SLAAC. Prefix delegation client uses DHCPv6 IA_PD to request and assign prefixes.

As part of addition of prefix delegation, the following features are supported on the Mobility Master:

l IPv6 address can be assigned using DHCPv6 IA_NA. For DHCPv6 stateful address assignment, DHCP client
process is started for the interface VLAN to retrieve and manage the address.

l PD client is supported to retrieve the prefix from ISP using DHCPv6 IA_PD, PD client process is started for
interface VLAN to retrieve and manage the IA_PD lease.

l A PD-based address, based on the prefix obtained on uplink VLAN using PD client can be configured on
other interface VLANs. When a PD-based address is configured, that prefix is advertised using RA on that
VLAN. This RA helps the host to derive a unique SLAAC address from the prefix advertised.



PD client and DHCPv6 client are not allowed to be configured in different VLANs. PD-based address cannot be
configured on an interface that is configured to run PD/DHCPv6 clients.

In the CLI
Execute the following command in the CLI to automate prefix delegation, and stateful IPv6 address
configuration:

IPv6 address configuration under interface vlan
(host) [mynode] (config)#interface vlan 101

(host) [mynode] (config-submode)#ipv6 address

dhcp6-client

link-local

pd

X:X:X:X::X/<0-128>

(host) [mynode] (config-submode)#ipv6 address dhcp6-client

Prefix delegation configuration under interface vlan
(host) [mynode] (config-submode)#ipv6 dhcp

pdclient

server

(host) [mynode] (config-submode)#ipv6 dhcp pdclient

<pd_name>

IPv6 PD-based address configuration under interface vlan
(host) [mynode] (config)#interface vlan 101

(host) [mynode] (config-submode)#ipv6 address

dhcp6-client

link-local

pd

X:X:X:X::X/<0-128>

(host) [mynode] (config-submode)#ipv6 address pd <pd_name> ::X:X:X:X:X

IPv6 PD status
(host)[mynode] #show ipv6 pd status

DHCPv6 PD Client is enabled

Uplink VLAN : 100

Label : site1

Prefix : 2001:0:3::/48

65536 unique /64 prefixes are derivable from the acquired IA PD lease

Preferred lifetime 604800s, Valid lifetime 2592000s

Last request/renewal for the lease done at Thu Apr 14 04:46:15 2016

Lease expires at Sat May 14 04:46:15 2016

Downlink VLANs

--------------

VlanId Prefix

------ ------

101 2001:0:3:12:1:2:3:4/64

Managing Mobility Master IP Addresses
You can change the default Mobility Master IP address by assigning a different VLAN interface address or the
loop back interface address. You can also turn on Syslog messaging for IPv6 (similar to IPv4 logging) using the
logging <ipv6 address> command. For more information on logging, see Configuring Logging on page
768.You can use the WebUI or CLI to change the default Mobility Master IP address.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > System > General tab.
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2. Select the Controller IP Address accordion, select the VLAN Id or the loopback interface Id from the IPv6
Address drop-down.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To configure an IPv6 address to the Mobility Master:
(host) [mynode] (config)#controller-ipv6 loopback

(host) [mynode] (config)#controller-ipv6 vlan <vlanId>

To enable logging over IPv6:
(host) [node] (config)#logging <ipv6 address>

Configuring Multicast Listener Discovery
You can enable the IPv6 multicast snooping on the Mobility Master by using the WebUI or CLI and configure
Multicast Listener Discovery (MLD) parameters such as query interval, query response interval, robustness
variable, and ssm-range.

The Source Specific Multicast (SSM) supports delivery of multicast packets that originate only from a specific
source address requested by the receiver. You can forward multicast streams to the clients if the source and
group match the client subscribed source group pairs (S,G).

The Mobility Master supports the following IPv6 multicast source filtering modes:

l Include - In Include mode, the reception of packets sent to a specified multicast address is enabled only
from the source addresses listed in the source list. The default IPv6 SSM address range is FF3X::4000:1 –
FF3X::FFFF:FFFF, and the hosts subscribing to SSM groups can only be in the Include mode.

l Exclude - In Exclude mode, the reception of packets sent to a specific multicast address is enabled from all
source addresses. If there is a client in the Exclude mode, the subscription is treated as an MLDv1 join.

For more information on MLD feature, see RFC 3810 and RFC 4604,

MLD snooping does not add IPv6 Solicited-Node multicast address or groups to the multicast table. A Solicited-
Node multicast address is an IPv6 multicast address valid within the local-link (example, an Ethernet segment
or a Frame Relay cloud). Every IPv6 host has at least one such address per interface. Solicited-Node multicast
addresses are used in Neighbor Discovery Protocol for obtaining the layer 2 link-layer addresses of other
nodes.

In the WebUI
To modify IPv6 MLD Snooping:

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs tab.

2. Click Name under VLANs and ID under Vlan Ids.

3. Select IPv6 tab and Multicast Listener Discover (MLD) accordion.

4. Select Enabled from the MLD Snooping drop-down list to enable IPv6 MLD snooping.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

To modify IPv6 MLD parameters execute the following in a managed device:

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > Multicast tab.

2. Under the MLD accordion, enter the required values in the following fields:



l Robustness Variable: default value is 2

l Query Interval (seconds): default value is 125 seconds

l Query Response Interval (in 1/10 second): default value is 100 (1/10 seconds).

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To configure the SSM Range execute the following in a managed device:

1. In the Managed Network node hierarchy, navigate to Configuration>Interfaces page and select the
Multicast tab.

2. In the MLD accordion, use the SSM Range Start-IP and SSM Range Mask-IP fields to configure the
SSM Range.

3. Click Submit to save your changes.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To enable IPv6 MLD snooping:

(host) [mynode] (config) #interface vlan 1

(host) [mynode] (config-submode)#ipv6 mld snooping

To view if IPv6 MLD snooping is enabled:
(host) [mynode] (config-submode)#show ipv6 mld interface

To view the MLD Group information: 
(host) [mynode] (config)#show ipv6 mld group

To modify IPv6 MLD parameters:
(host) [mynode] (config)#ipv6 mld

(host) [mynode] (config-mld) # query-interval <time in seconds (1-65535)>|query-response-

interval <time in 1/10th of seconds (1-65535)|robustness-variable <value (2-10)>

To view MLD configuration:
(host) [mynode](config-submode)#show ipv6 mld config

When you enter the SSM Range ensure that the upstream router has the same range, else the multicast stream
would be dropped.

Dynamic Multicast Optimization
When multiple clients are associated to an AP and when one client is subscribed for a multicast stream, all the
clients associated to the AP receive the stream, as the packets are directed to the multicast MAC address. To
restrict the multicast stream to only the subscribed clients, DMO sends the stream to the unicast MAC address
of the subscribed clients. DMO is currently supported for both IPv4 and IPv6.

To verify the DMO configuration, execute the following command:
(host) #show wlan virtual-ap

Limitations
The following are the MLDv2 limitations:

l Mobility Master cannot route multicast packets.

l For mobility clients mld proxy should be used.
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l VLAN pool scenario stream is forwarded to clients in both the VLANs even if the client from one of the
VLANs is subscribed.

l Dynamic Multicast Optimization is applicable for wired clients in Mobility Master.

Debugging an IPv6 Mobility Master
ArubaOS provides the following debug commands for IPv6:

l show ipv6 global — displays if IPv6 is enabled globally or not

l show ipv6 interface — displays the configured IPv6 address, and any duplicate addresses

l show ipv6 route/show datapath route ipv6 — displays the IPv6 routing information

l show ipv6 ra status — displays the Router Advertisement status

l show Datapath session ipv6 — displays the IPv6 sessions created, and the sessions that are allowed

l show datapath frame — displays the IPv6 specific counters

You can also use the debug options such as ping and tracepath for IPv6 hosts. You can either use the WebUI or
the CLI to use the ping and tracepath options.

In the WebUI
1. To ping an IPv6 host, in the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Ping

tab, enter an IPv6 address, and click Ping.

2. To trace the path of an IPv6 host, in the Mobility Master node hierarchy, navigate to Diagnostics >
Tools > Tracepath tab, enter an IPv6 address, and click Trace.

In the CLI
To ping an IPv6 host:
(host)#ping ipv6 <global-ipv6-address>

(host)#ping ipv6 interface vlan <vlan-id> <linklocal-address>

To trace the path of an IPv6 host:
(host)#tracepath <global-ipv6-address>

Provisioning an IPv6 AP
You can provision an IPv6 AP on an IPv6 Mobility Master. You can either configure a static IP address or obtain
a dynamic IPv6 address via stateless-autoconfig. The Mobility Master can act as the default gateway for the
IPv6 clients, if static IPv6 routes are set on the Mobility Master.

A wired client can now connect to the Ethernet interface of an IPv6 enabled AP.

To provision a static IPv6 address using the CLI:
(host) [mynode](config)# provision-ap

Enhancements to IPv6 Support on AP
ArubaOS provides the following IPv6 enhancements on the AP:

l DNS based ipv6 Mobility Master discovery

l FTP support for image upgrade in an IPv6 network

l DHCPv6 client support



Filtering an IPv6 Extension Header (EH)
ArubaOS firewall is enhanced to process the IPv6 Extension Header (EH) to enable IPv6 packet filtering. You
can now filter the incoming IPv6 packets based on the EH type. You can edit the packet filter options in the
default EH, using the CLI. The default EH alias permits all EH types.

Execute the following commands to permit or deny the IPv6 packets matching an EH type:
(host) [mynode](config) #netexthdr default

(host) [mynode](config-exthdr) #eh <eh-type> permit | deny

To view the EH types denied:
(host) [mynode](config-exthdr) #show netexthdr default

Configuring a Captive Portal over IPv6
IPv6 is now enabled on the captive portal for user authentication on the Aruba Mobility Master. For user
authentication, use the internal captive portal that is initiated from the Mobility Master. A new parameter
captive has been added to the IPv6 captive portal session ACL:

(host) [mynode] (config)#ipv6 user alias controller 6 svc-https captive

This release does not support external captive portal for IPv6. The captive portal authentication, customization of
pages, and other attributes are same as IPv4.

You can configure captive portal over IPv6 (similar to IPv4) using the WebUI or CLI. For more information on
configuration, see Configuring Captive Portal in the Base Operating System on page 287.

Working with IPv6 Router Advertisements (RAs)
ArubaOS enables the Mobility Master to send router advertisements (RA) in an IPv6 network. Each host auto
generates a link local address when you enable ipv6 on the host. The link local address allows the host to
communicate between the nodes attached to the same link.

The IPv6 stateless autoconfiguration mechanism allows the host to generate its own addresses using a
combination of locally available information and information advertised by the routers. The host sends a
router solicitation multicast request for its configuration parameters in the IPv6 network. The source address
of the router solicitation request can be an IP address assigned to the sending interface, or an unspecified
address if no address is assigned to the sending interface.

The routers in the network respond with an RA. The RAs can also be sent at periodic intervals. The RA contains
the network part of the Layer 3 IPv6 address (IPv6 Prefix). The host uses the IPv6 prefix provided by the RA; it
generates the universally unique host part of the address (interface identifier), and combines the two to derive
the complete address. To establish continuous connectivity to the default router, the host starts the neighbor
reachability state machine for the router.

ArubaOS uses Radvd, an open source Linux IPv6 Router Advertisement daemon maintained by Litech Systems
Design.

You can perform the following tasks on the Mobility Master to enable, configure, and view the IPv6 RA status
on a VLAN interface:

l Configure IPv6 RA on a VLAN

l Configure Optional Parameters for RA

n Configure neighbor discovery reachable time

n Configure neighbor discovery retransmit time
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n Configure RA DNS

n Configure RA hop-limit

n Configure RA interval

n Configure RA lifetime

n Configure RA managed configuration flag

n Configure RA MTU

n Configure RA other configuration flag

n Configure RA Preference

n Configure RA prefix

l View IPv6 RA Status

Configuring an IPv6 RA on a VLAN
You must configure the IPv6 RA functionality on a VLAN for it to send solicited/unsolicited router
advertisements on the IPv6 network. You must configure the following for the IPv6 RA to be operational on a
VLAN:

l IPv6 global unicast address

l enable IPv6 RA

l IPv6 RA prefix

l The advertised IPv6 prefix length must be 64 bits for the stateless address autoconfiguration to be operational.
l You can configure up to three IPv6 prefixes per VLAN interface.
l Each IPv6 prefix must have an on-link interface address configured on the VLAN.
l Ensure you configure the upstream routers to route the packets back to Aruba Mobility Master.

You can use the WebUI or CLI to configure the IPv6 RA on a VLAN.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs tab.

2. Select a VLAN ID and click IPv6 tab.

3. To configure an IPv6 global unicast address, follow the steps below:

a. Enter IPv6 address and prefix-length in the Global Unicast Address field.

b. (Optional) Select the EUI64 Format check box, if applicable.

c. Click Submit to add the address to the global address list.

4. To enable an IPv6 RA on a VLAN, select Enabled from the Router Advertisements (RA) drop-down under
Neighbor Discovery.

5. To configure an IPv6 RA prefix for a VLAN, follow the steps below:

a. Under Neighbor Discovery, enter an IPv6 prefix in the RA Prefix field.

b. Click + to configure an IPv6 prefix for the VLAN.

You can add up to three IPv6 prefixes per VLAN interface.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Execute the following commands to configure router advertisements on a VLAN:



(host) [mynode](config) #interface vlan <vlanid>

(host) [mynode](config-subif)#ipv6 address <prefix>/<prefix-length>

(host) [mynode](config-subif)#ipv6 nd ra enable

(host) [mynode](config-subif)#ipv6 nd ra prefix X:X:X:X::X/64

Configuring Optional Parameters for RAs
In addition to enabling the RA functionality, you can configure the following IPv6 neighbor discovery and RA
options on a VLAN:

l Neighbor discovery reachable time – the time, in milliseconds, that a node assumes a neighbor is reachable
after receiving a reachability confirmation.

l Neighbor discovery retransmit time – the time, in milliseconds, between retransmitted Neighbor Solicitation
messages.

l RA DNS – the IPv6 recursive DNS Server for the VLAN.

l On Linux systems, clients must run the open rdnssd daemon to support the DNS server option.
l Windows 7 does not support the DNS server option.

l RA hop-limit – the IPv6 RA hop-limit value. It is the default value to be placed in the Hop Count field of the
IP header for outgoing (unicast) IP packets.

l RA interval – the maximum and minimum time interval between sending unsolicited multicast router
advertisements from the interface, in seconds.

l RA lifetime – the lifetime associated with the default router in seconds. A value of zero indicates that the
router is not a default router and will not appear on the default router list. The router lifetime applies only
to the router's usefulness as a default router; it does not apply to information contained in other message
fields or options.

l RA managed configuration flag (Enable DHCP for address) – a flag that indicates that the hosts can use the
DHCP server for address autoconfiguration besides using RAs.

l RA maximum transmission unit (MTU) – the maximum transmission unit that all the nodes on a link use.

l RA other configuration flag (Enable DHCP for other information – a flag that indicates that the hosts can use
the administered (stateful) protocol for autoconfiguration of other (non-address) information.

l RA preference – the preference associated with the default router.

You can use the WebUI or CLI to configure these options.

It is recommended that you retain the default value of the RA interval to achieve better performance.

If you enable RAs on more than 100 VLAN interfaces, some of the interfaces may not send out the RAs at regular
intervals.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces page and select

the VLANs tab.

2. Select a VLAN ID and click IPv6 tab.

3. Under Neighbor Discovery accordion, configure the following neighbor discovery and RA options for the
VLAN based on your requirements:

a. Enter a value in the Reachable Time (ms) field. The allowed range is 0-3,600,000 msec. The default
value is zero.
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b. Enter a value in the Retransmit Time (ms) field. The allowed range is 0-3,600,000 msec. The default
value is zero.

c. Enter a DNS server name in the Recursive DNS Server field.

d. Enter a hop-limit value in the RA hop-limit field. The allowed range is 1-255. The default value is 64.

e. Enter the maximum interval value in the RA Interval (sec) field. Allowed range is 4-1800 seconds.
Default value is 600 seconds.

f. Enter a value in the RA Minimum Interval (sec) field. Allowed range is 3-0.75 times the maximum RA
interval value in seconds. The default minimum value is 0.33 times the maximum RA interval value

g. Enter a value in the RA Lifetime field. A value of zero indicates that the router is not a default router.
Apart from a zero value, the allowed range for the lifetime value is the RA interval time to 9,000 seconds.
The default and minimum value is three times the RA interval time.

h. Select Enabled from the DHCP for address drop-down list to enable the hosts to use the DHCP server
for address autoconfiguration apart from any addresses auto configured using the RA.

i. Enter a value in the RA MTU Option option. The allowed range is 1,280-maximum MTU allowed for the
link.

j. Select Enabled from the DHCP for Other Info drop-down list to enable the hosts to use the DHCP
server for autoconfiguration of other (non-address) information.

k. Select the router preference as High, Medium, or Low.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Execute the following CLI commands to configure the neighbor discovery and RA options for a VLAN interface:

To configure neighbor discovery reachable time:
(host) [mynode](config) #interface vlan <vlan-id>

(host) [mynode](config-subif)#ipv6 nd reachable-time <value>

To configure neighbor discovery retransmit time:
(host) [mynode](config-subif)#ipv6 nd retransmit-time <value>

To configure IPv6 recursive DNS server:
(host) [mynode](config-subif)#ipv6 nd ra dns X:X:X:X::X

To configure RA hop-limit:
(host) [mynode](config-subif)#ipv6 nd ra hop-limit <value>

To configure RA interval:
(host) [mynode](config-subif)#ipv6 nd ra interval <value> <min-value>

To configure RA lifetime:
(host) [mynode](config-subif)#ipv6 nd ra life-time <value>

To enable hosts to use DHCP server for stateful address autoconfiguration:
(host) [mynode](config-subif)#ipv6 nd ra managed-config-flag

To configure maximum transmission unit for RA:
(host) [mynode](config-subif)#ipv6 nd ra mtu <value>

To enable hosts to use DHCP server for other non-address stateful autoconfiguration:
(host) [mynode](config-subif)#ipv6 nd ra other-config-flag

To specify a router preference:



(host) [mynode](config-subif)#ipv6 nd ra preference [High | Low | Medium]

To view the IPv6 RA status on the VLAN interfaces:

(host) [mynode]#show ipv6 ra status

IPsec Support
IPsec support is enhanced to accommodate IPv6 which includes overlay networks across IPv4 and IPv6 IPsec
Tunnels. IPsec is the base for security features like Site-to-Site VPNs, CPsec, RAP, and Master-Local
deployments. The control plane handles the configuration of these features and translation to IPsec Security
Association. The data plane handles encryption / decryption, encapsulation / decapsulation, tunneling, session
setup, management, and routing of IPsec data.

In this release, IKEv2/IPsec support is extended to IPv6 for the following topologies:

l Mobility Master-Managed Devices

l CPsec (Tunnel Mode and D-Tunnel Mode)

l RAP (Tunnel Mode and D-Tunnel Mode)

l IPsec Support

Mobility Master-Managed Devices
This topology is used to secure all control plane traffic exchanged between Mobility Master and a managed
device. This is specifically used by CFGM process to push configuration from Mobility Master to the managed
device.

While configuring IPv6 local and master addresses, assign and use an IPv4 address to accommodate all the
other applications that are yet to be enhanced to support IPv6 addresses. For example, License Manager still
listens on IPv4 address and this needs to be accommodated by Mobility Master- Managed Devices IPv6
deployment.

Configuring the Mobility Master IPv6 Address
You can configure the master IPv6 address used for pre-shared key authentication on the managed device,
using the WebUI and CLI.

The initial IPv6 Masteripv6 configuration on local needs to be done using the CLI. Once configured, any change in
masteripv6 can be done through WebUI/CLI. This change in masteripv6 should remain in the same IP address family.
Change from masteripv6 to masterip (vice-versa) requires a write erase on the managed device.

In the WebUI

Execute the following steps in the WebUI to configure the master IPv6 address for pre-shared key
authentication:

1. In the Mobility Master node hierarchy, navigate to the Managed Device.

2. Click Configuration > Controllers menu.

3. Select PSK from the Authentication drop-down list.

4. Enter the Mobility Master IPv4 address, Mobility Master IPv6 address and Passphrase.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.
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In the CLI

Execute the following command in the CLI to configure the master IPv6 address for pre-shared key
authentication:
(host) [mynode](config) #masteripv6 <masteripv6>

ipsec <key> [fqdn <local-fqdn>][interface|{vlan <id>}][masteripv4 <masteripv4>]

You can configure the master IPv6 address used for certificate-based authentication on the managed device.

In the WebUI

Execute the following steps in the WebUI to configure the master IPv6 address for certificate-based
authentication:

1. In the Mobility Master node hierarchy, navigate to the Managed Device.

2. Click Configuration > Controllers menu.

3. Select Certificate from the Authentication drop-down list.

4. Select Custom/Factory from the Certificate type drop-down list.

5. Enter the Mobility Master IPv4 address, Mobility Master IPv6 address.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to configure the master IPv6 address for certificate-based
authentication:
(host) [mynode](config) #masteripv6 <masteripv6>

ipsec-custom-cert master-mac-1-c <mac-1-c> ca-cert <ca> server-cert [fqdn-v <local-fqdn-v>]

[interface-c {uplink-v <uplink-v> | vlan-c <id-c>] masteripv4 {fqdn-v|interface-

c|masteripv4|suite-b} siute-b {fqdn-v|interface-c|masteripv4|suite-b}

ipsec-factory-cert master-mac-1 <MAC> [fqdn-c <local-fqdn-c>][interface-v {uplink-v

<uplink-v> | vlan-c <id-c>] [master-mac-2 <MAC>] [masteripv4 <masteripv4>]

Configuring IPv4/IPv6 Address for PSK Authentication
On Mobility Master, you can configure the IPv4/IPv6 address of the managed device, to be used for pre-shared
key authentication:

In the WebUI

Execute the following steps in the WebUI to configure the IPv6 address of the managed device for pre-shared
key authentication:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Controllers menu.

2. Click + under Local Controllers IPSec Keys table.

3. Select IPSec Key from the Authentication drop-down list.

4. Enter the Local Controller IPv4 address, Local Controller IPv6 address, and the IPSec Key in the Add
New IPsec Controller table.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.



In the CLI

Execute the following command in the CLI to configure the IPv6 address of the managed device for pre-shared
key authentication:
(host)[mynode](config)#localipv6 <local-switch-ipv6> ipsec <pre-shared-key> localipv4 <local-

switch-ipv4>

You can configure the certificate-based authentication on the managed device.

Configuring IPv4/IPv6 Address for PSK Authentication
On Mobility Master, you can configure the IPv4/IPv6 address of the managed device, to be used for certificate
based authentication:

In the WebUI

Execute the following steps in the WebUI to configure the IPv6 address of the managed devices for certificate
based authentication:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Controllers menu.

2. Click + under Local Controllers IPSec Keys table.

3. Select Certificate from the Authentication drop-down list.

4. Select Factory from the Certificate type drop-down list.

5. Enter the Local Controller IPv4 address, Local Controller IPv6 address, and the IPSec Key in the Add
New IPsec Controller table.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following steps in the CLI to configure certificate-based authentication on the managed device:
(host) [mynode](config) #local-custom-cert local-mac <MAC> ca-cert <ca-cert-name> server-cert

<server-cert-name> suite-b <gcm128/gcm256> load-balance

Monitoring and Managing Master Local IPv6 Settings
Execute the following command in the CLI, on Mobility Master to check the ipv6 address of the managed
device:
(host) [mynode] (config) #show localipv6

Local Switches configured by Local Switch IPv6

-----------------------------------------------

Switch IPv6 address of the Local Corres IPv4 address of the Local Key

-------------------------------- -------------------------------- ---

2002::1 1.1.1.1 ********

Execute the following command in the CLI to check the IKE security associations:
(host) [node] #show crypto isakmp sa

ISAKMP SA Active Session Information

------------------------------------

Initiator IP Responder IP Flags Start Time Private IP

------------ ------------ ----- --------------- ----------

ISAKMP SA Active Session Information

------------------------------------

Initiator IP Responder IP Flags Start Time Private IP

------------ ------------ ----- --------------- ----------

2002::1 2002::3 r-v2-p Dec 4 15:15:31 -

Flags: i = Initiator; r = Responder

m = Main Mode; a = Agressive Mode; v2 = IKEv2
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p = Pre-shared key; c = Certificate/RSA Signature; e = ECDSA Signature

x = XAuth Enabled; y = Mode-Config Enabled; E = EAP Enabled

3 = 3rd party AP; C = Campus AP; R = RAP; Ru = Custom Certificate RAP;

I = IAP

V = VIA; S = VIA over TCP

Total ISAKMP SAs: 1

Execute the following command in the CLI to check the IPsec security associations:
(host) [node] #show crypto ipsec sa

IPSEC SA (V2) Active Session Information

-----------------------------------

Initiator IP Responder IP SPI(IN/OUT) Flags Start Time Inner IP

------------ ------------ ---------------- ----- --------------- --------

2002::1 2002::3 cdb5f100/d533c500 T2 Dec 4 14:53:42 -

Flags: T = Tunnel Mode; E = Transport Mode; U = UDP Encap

L = L2TP Tunnel; N = Nortel Client; C = Client; 2 = IKEv2

Total IPSEC SAs: 1

Execute the following command in the CLI to retrieve the statistics of communication between Mobility Master
and the managed device:
(host) [node] #show master-local stats 2002::1

Missed -> HB Req from Local(s)

------------------------------

IP Address HB Req HB Resp Cfg Terminate Peer Reset Total Missed

---------- ------ ------- ------------- ---------- ------------

32.2.0.0 35155 35155 0 0 0

Last Sent Missed Last Synced/First Missed

---------------- ------------------------

0 Pending

Execute the following command in the CLI to check the progress of the configuration update:
(host)[node] #show switches state [complete|incomplete|inprogress|required]

(host) [node] (config) #show switches state complete

All Switches

------------

IP Address IPv6 Address Name Location Type Model Version

---------- ------------ ---- -------- ---- ----- -------

1.1.1.1 2002::1 abhi_vmc_61.122 Building1.floor1 LC VMC-TACTICAL 8.0.0.0-svcs-

ctrl_0000

Status Configuration State Config Sync Time (sec) Config ID

---------- -------------------- ---------------------- ---------

up UPDATE SUCCESSFUL 0 22

Total Switches:1

(host) [node] (config) #show switches state incomplete

All Switches

------------

IP Address IPv6 Address Name Location Type Model Version Status Configuration State

---------- ------------ ---- -------- ---- ----- ------- ------ -------------------

Config Sync Time (sec) Config ID

---------------------- ---------

Total Switches:0

(host) [node] (config) #show switches state inprogress

All Switches

------------



IP Address IPv6 Address Name Location Type Model Version Status Configuration State

---------- ------------ ---- -------- ---- ----- ------- ------ -------------------

Config Sync Time (sec) Config ID

---------------------- ---------

Total Switches:0

(host) [node] (config) #show switches state required

All Switches

------------

IP Address IPv6 Address Name Location Type Model Version Status Configuration State

---------- ------------ ---- -------- ---- ----- ------- ------ -------------------

Config Sync Time (sec) Config ID

---------------------- ---------

Total Switches:0

CPsec (Tunnel Mode and D-Tunnel Mode)
Control Plane security feature enables communication between an IPsec enabled AP (in CPsec mode) and a
Mobility Master. The configuration traffic between the Mobility Master and AP (in CPsec mode) is routed
through an IPsec tunnel, whereas the client traffic served by the AP is communicated to the Mobility Master in
clear. Heartbeats go in a GRE tunnel, even though they are locally generated.

Enabling a range of IPv6 addresses
An AP can terminate on a Mobility Master, if Auto Cert Provisioning is enabled in the Control Plane Security
profile or if a range of IPv6 addresses are enabled under Control Plane Security profile, and if Auto Cert
Provisioning is disabled.

In the WebUI

Execute the following steps in the WebUI to enable a range of IPv6 addresses:

1. In the Managed Network node hierarchy, navigate to the Configuration > System > CPSec tab.

2. Click Control Plane Security accordion.

3. Select the Enable CPSec check box.

4. Select the Enable Auto Cert Provisioning check box. This check box is displayed only when the Enable
CPSec check box is selected.

5. Select the Only accept APs from specified ranges check box. This check box is displayed only when the
Enable Auto Cert Provisioning check box is selected.

6. Click + in the Address ranges for Auto Cert Provisioning table.

7. Enter the Start address (IPV4/IPV6) and End address (IPV4/IPV6) in the New Address Range dialogue
box.

8. Click OK.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to enable a range of IPv6 addresses:
(host) [mynode] (config) #control-plane-security

(host) [mynode] (Control Plane Security Profile) #auto-cert-allowed-addrs <startv6> <endv6>

Execute the following command in the CLI to accept cert-provisioning for all the IPv6 addresses:
(host) [mynode] (config) #control-plane-security
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(host) [mynode] (Control Plane Security Profile) #auto-cert-allow-all

You can check if the control plane security is enabled by executing the following command:
(host) [mynode] (Control Plane Security Profile) #show control-plane-security

RAP (Tunnel Mode and D-Tunnel Mode)
An AP terminating with an IPv6 address can be provisioned as a RAP using certs only. IPv6 L2TP pool is
provisioned to assign IPv6 inner-ip address to AP. When a configuration request is initiated, the AP requests for
IPv6 inner IP as the peer switch-ip.

In this release, only certificate-based RAP in forward-mode and decrypt mode tunnel is supported.

Provisioning an inner IPv6 address to a RAP
You can provision an inner IPv6 address to a RAP, by configuring L2TP IPv6 Pool address range.

In the WebUI

Execute the following steps in the WebUI to provision an inner IPv6 address to a RAP, by configuring L2TP IPv6
Pool address range:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > VPN tab.

2. Click General VPN.

3. Click + in the Address Pools table.

4. Enter the Pool Name, Start Address, and End Address in the Add New Address Pool table.

5. Click Submit
6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to provision an inner IPv6 address to a RAP, by configuring L2TP
IPv6 Pool address range:
(host) [mynode] (config) #ipv6 local pool <pool_name_v6> <pool_start_addressv6> <pool_end_

addressv6>

Execute the following command in the CLI to view the total number of IPs in each pool and the IPs assigned
from each pool:
(host) [mynode] (config) #show vpdn l2tp local pool

Execute the following command in the CLI to view the pools configured:
(host) [mynode] (config) #show vpdn l2tp configuration

You can provision an inner IPv6 address to a RAP, by configuring remote IP to the whitelist-db entry.

In the CLI

Execute the following command in the CLI to provision an inner IPv6 address to a RAP, by configuring remote-
ipv6 address in the whitelist DB entry:
(host) [mynode] (config) #whitelist-db rap add mac-address <mac address> ap-group <ap_group>

remote-ipv6 <remote_ipv6>

Site-to-Site Crypto Map (Tunnel Mode and Transport Mode)
A Virtual Private Network (VPN) consists of multiple remote peers transmitting private data securely to one
another over an unsecured network, such as the Internet. Site-to-site VPNs use tunnels to encapsulate data



packets within normal IP packets for forwarding over IP-based networks; encryption ensures that privacy and
authentication to ensure integrity of data. Listed below are the types of deployments supported in this release:

l IPv6 networks over IPv6 IPsec tunnel

l IPv6 networks over IPv4 IPsec tunnel

l IPv4 networks over IPv6 IPsec tunnel

l IPv4 and IPv6 networks over IPv4 IPsec tunnel

l IPv4 and IPv6 networks over IPv6 IPsec tunnel

l Static IPv6 Route to IPsec crypto-map

l IP compression support for IPv6 inner traffic

All IPv6 IPsec crypto maps are supported with IKE version v2 only.

Configuring Site-to-Site VPN
You can configure a Site-to-Site VPN protecting IPv6 networks over an IPv6 IPsec tunnel.

In the WebUI

Execute the following steps in the WebUI to configure a Site-to-Site VPN protecting IPv6 and IPv4 networks
over an IPv6 IPsec tunnel:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > VPN tab.

2. Click Site to Site.

3. Click + symbol in the IPSec Maps table.

4. Enter the IPv6 Source Network, IPv6 Source Prefix, IPv6 Destination Network, IPv6 Destination
Prefix, Peer gateway v4/v6 details in the Create New IPSec table.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to configure a Site-to-Site VPN protecting IPv6 networks over an
IPv6 IPsec tunnel:
(host) [node] (config) #crypto-local ipsec-map <map name> <priority>

version v2

peer-ipv6 <IPv6 address>

vlan 1

src-net-ipv6 <IPv6 address> <Prefix length>

dst-net-ipv6 <IPv6 address> <Prefix length>

src-net <IPv4 address> <mask>

dst-net <IPv4 address> < mask>

Adding a new IPv6 static route
You can add a new IPv6 static route to an existing crypto-map.

In the WebUI

Execute the following steps in the WebUI to add a new IPv6 static route to an existing crypto-map:

1. In the Managed Network node hierarchy, navigate to the Configuration > Interfaces > IP Routes tab.

2. Click IP Routes.

3. Click + symbol in the IP Routes table.
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4. Select IPSec Map from the Forwarding Settings drop-down list.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to add a new IPv6 static route to an existing crypto-map:
(host) [mynode] (config) #ipv6 route <ipv6-network/prefix> ipsec <name>

Associating a Pre-shared Key

You can associate a pre-shared-key to the site-to-site crypto-map.

Hex based pre-shared key is supported.

In the WebUI

Execute the following steps in the WebUI to associate a pre-shared-key to the site-to-site crypto-map:

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > VPN tab.

2. Click Site to Site accordion.

3. Click + symbol in the IPSec Maps table and enter the following details in the Create New IPSec table.

a. Select Text-Based or Hex-based from the Representation type drop-down list.

b. Enter the IKE shared secret and Retype shared secret.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to associate a pre-shared-key to the site-to-site crypto-map:
(host) [node] (config) #crypto-local isakmp key <key> addressv6 <IPv6 address> <prefix length>

(host) [node] (config) #crypto-local isakmp key-hex <key> addressv6 <IPv6 address> <prefix

length>

Hex based pre-shared key is supported.

Associating a Certificate Based Authentication

You can configure certificate based authentication for the site-to-site crypto-map.

In the WebUI

Execute the following steps in the WebUI to associate a pre-shared-key to the site-to-site crypto-map:

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > VPN tab.

2. Click Site to Site accordion.

3. Click + symbol in the IPSec Maps table and enter the following details in the Create New IPSec table.

a. Select Certificate from the Authentication Method drop-down list.

b. Enter the Certificate Details.

4. Click Submit.

5. Click Pending Changes.



6. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI

Execute the following command in the CLI to associate a pre-shared-key to the site-to-site crypto-map:
(host) [node] (config) #crypto-local ipsec-map <map name> <priority>

(host) [node] (config) #set ca-certificate <ca-certificate>

(host) [node] (config) #set server-certificate <server-certificate>

If you configure your Mobility Master to use IKEv2 and custom-installed certificates, you can optionally use Suite-B
cryptographic algorithms for IPsec encryption. Select either gcm-128 Use 128-bit AES-GCM Suite-B encryption or
gcm-256 Use 256-bit AES-GCM Suite-B encryption.

Monitoring and Managing Site-to-Site Settings
Execute the following command in the CLI to view the crypto Internet Security Association and Key
Management Protocol (ISAKMP) for an IPv6 peer:
(host) [mynode] #show crypto isakmp sa peer v6 2002::1

Initiator IP: 2002::1

Responder IP: 2002::3

Initiator: No

Initiator cookie:4ab9d9805eb16f73 Responder cookie:93f1c4dbec0ee92b

SA Creation Date: Fri Dec 4 23:14:33 2015

Life secs: 28800

Initiator Phase1 ID: 2002::1

Responder Phase1 ID: 2002::3

Exchange Type: IKE_SA (IKEV2)

Phase1 Transform:EncrAlg:AES128 HashAlg:HMAC_SHA1_96 DHGroup:2

Authentication Method: Pre Shared Key

IPSEC SA Rekey Number: 1

Ipsec-map name: default-local-master-ipsecmap2002::1

Execute the following command in the CLI to view the IPsec security association for an IPv6 peer:
(host) [mynode] #show crypto ipsec sa peer v6 2002::1

Initiator IP: 2002::1

Responder IP: 2002::3

Initiator: No

SA Creation Date: Sat Dec 5 00:50:01 2015

Life secs: 7200

Exchange Type: IKE_SA (IKEV2)

Phase2 Transform:Encryption Alg: 3DES Authentication Alg: SHA1

Encapsulation Mode Tunnel

IP Compression Disabled

PFS: no

IN SPI: 1C514500, OUT SPI: 14F61800

Ipsec-map name: default-local-master-ipsecmap2002::1

Responder IP: 2002::3

Execute the following command in the CLI to view IKE transports:
(host) [mynode] #show crypto isakmp transports

transport 0x33cfb40 flags 0 refcnt 1

UDP-NATT Transport: fd 11 ikev2-id:0 src 1.1.1.10:4500 dst 1.1.1.4:4500

transport 0x2b3d660 flags 0 refcnt 1

UDP-500 Transport: fd 10 ikev2-id:0 src 1.1.1.10:500 dst 1.1.1.4:4500

transport 0x3292bb0 flags 0 refcnt 1

transport 0x298ea20 flags 1 refcnt 1

UDP-NATT Transport: fd 11 ikev2-id:0 src 0.0.0.0:4500 dst *:0

transport 0x298e940 flags 1 refcnt 1

UDP-500 Transport: fd 10 ikev2-id:0 src 0.0.0.0:500 dst

Execute the following command in the CLI to view IPv6 Switch address:
(host) [mynode] #show crypto isakmp stats
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Switch IP = 1.1.1.10

Main Mode Initiator exchanges started/completed = 0/0

Main Mode Responder exchanges started/completed = 0/0

Aggr Mode Initiator exchanges started/completed = 0/0

Aggr Mode Responder exchanges started/completed = 104034/0

Quick Mode Initiator exchanges started/completed = 0/0

Quick Mode Responder exchanges started/completed = 0/0

XAuth Type1 Responder exchanges started/completed = 0/0

XAuth Type2 Responder exchanges started/completed = 0/0

XAuth Authentication Pass/Fail = 0/0

Mode-Config Responder exchanges started/completed = 0/0

Mode-Config Authentication Pass/Fail = 0/0

XAuth Protocol Errors Bad-Packets/Quick-mode-fail = 0/0

IP Pool Alloc/Free/Free-NoSa Alloc-Error/Free-Error = 0/0/0/0/0

IP External Pool Alloc/Alloc-Error = 0/0

Authentication State Errors No-SA/No-Msg/No-Exch = 0/0/0

Auth Msgs Reqs/Rcvd/AP-Down/Idle-timeout/IP-down = 0/0/0/0/0

Auth Msg Errors Not-Ready/Reqs-Throttled/IP-UP-err/Recv-err/Rcv-NoState = 0/0/0/0/0

IKE->Auth Msgs IP-up/IP-down = 0/0

Cert-Revocation Msgs Reqs/Rcvd/Pass/Revoked = 0/0/0/0

Cert-Revocation Msg Errors Reqs-Throttled/Send-err/Recv-err/Rcv-NoState = 0/0/0/0

UDB Msgs Reqs-Throttled/Req-sent/Req-send-errors/Resp-rcvd/Rcv-NoState = 0/0/0/0/0

ACR License Msgs Request/Delete/Req-errors/Resp-rcvd/Resp-error = 0/0/0/0/0 Allow/Fail 0/0

Limit:1000

...

Execute the following commands in the CLI to clear IPsec and ISAKMP state security associations:
(host) [mynode] (config) #clear crypto isakmp sa peer v6 <>

(host) [mynode] (config) #clear crypto ipsec sa peer v6 <>

IP compression support for IPv6 traffic inside an IPsec tunnel
Support for IP Compression is extended to IPv6 traffic inside an IPsec tunnel to minimize the size of the
packets crossing a public network where ISP charges are calculated based on the number of bytes transferred.

IP Compression is supported for IPv6 traffic in an IPv4 IPsec Tunnel as well as IPv6 IPsec Tunnel.

In the CLI

Execute the following command in the CLI to enable/disable IP compression per crypto-map:
(host) [mynode] (config) #crypto-local ipsec-map test 9988

(host) [mynode] (config-submode)#ip-compression

(host) [mynode] (config-submode)#no ip-compression

Execute the following command in the CLI to verify if IP compression is enabled at the global level:
(host) [mynode] (config) #show crypto-local isakmp disable-ipcomp

IP Compression is Enabled

RADIUS Over IPv6
ArubaOS provides support for RADIUS authentication server over IPv6. You can configure an IPv6 host or
specify an FQDN that can resolve to an IPv6 address for RADIUS authentication. The RADIUS server is in IPv4
mode by default. You must enable the RADIUS server in IPv6 mode to resolve the specified FQDN to IPv6
address.

You can only configure the global IPv6 address as the host for the Radius server in IPv6 mode.

You can configure the IPv6 host for the RADIUS server using the WebUI or CLI.



In the CLI
You must enable the enable-ipv6 parameter to configure the RADIUS server in IPv6 mode.
(host) [mynode](config) #aaa authentication-server radius IPv6

(host) [mynode](RADIUS Server "IPv6") #enable-ipv6

Configure an IPv6 address as the host for RADIUS server using the following command:
(host)(RADIUS Server "IPv6") #host <ipv6-address>

The <host> parameter can also be a fully qualified domain name that can resolve to an IPv6 address.

To resolve FQDN, you must configure the DNS server name using the ip name-server <ip4addr> command.

You can configure an IPv6 address for the NAS-IP parameter using the following CLI command:
(host) [mynode](RADIUS Server "Ipv6") #nas-ip6 <IPv6 address>

You can configure an IPv6 address for the Source Interface parameter using the following CLI command:
(host) [mynode](RADIUS Server "Ipv6") # source-interface vlan <vland-id> ip6addr <ip6addr>

Use the following CLI command to configure an IPv6 address for the global NAS IP which the Mobility Master
uses to communicate with all the RADIUS servers:
(host) [mynode](config) #ipv6 radius nas-ip6 <IPv6 address>

You can also configure an IPv6 global source-interface for all the RADIUS server requests using the following
commands:
(host) [mynode](config) #ipv6 radius source-interface loopback

(host) [mynode](config) #ipv6 radius source-interface vlan <vlan-id> <ip6addr>

In the WebUI
To configure an IPv6 host for a RADIUS server:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth
Servers tab.

2. Select RADIUS Server to display the RADIUS server List.

3. Select the required RADIUS server from the list to go to the Radius server page.

4. To enable the RADIUS server in IPv6 mode select Enabled from the Enable IPv6 drop-down list.

5. To configure an IPv6 host for the selected RADIUS server specify an IPv6 address or an FQDN in the IP
address field.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

To configure an IPv6 address for the NAS-IP:

1. Specify an IPv6 address in the NAS IPv6 field.

2. Click Submit.

3. Click Pending Changes.

4. In the Pending Changes window, select the check box and click Deploy changes.

Radius Accounting for IPv6 Clients
Customers can now monitor bandwidth usage by clients/hosts with IPv6 addresses, over RADIUS protocol. The
Framed-IPv6-Address attribute is used in accounting start, stop, and interim packets. A host can have
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multiple IPv6 addresses and all of them are tracked to check the usage, for billing purpose.

TACACS Over IPv6
ArubaOS provides support for TACACS authentication server over IPv6. You can configure the global IPv6
address as the host for TACACS authentication using CLI or WebUI.

In the CLI
(host) [mynode](config) #aaa authentication-server tacacs IPv6

(host) [mynode](TACACS Server "IPv6") #host <ipv6-address>

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication page and select

Auth Servers tab.

2. Select TACACS Server from All Servers table, to display the Server List.

3. To configure an IPv6 host for the selected server, specify an IPv6 address in the Host field.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

DHCPv6 Server
The DHCPv6 server enables network administrators to configure stateful/stateless options and manage
dynamic IPv6 users connecting to a network. You can also configure domain name server using DHCPv6.

You can configure IPv6 pools with various configurations such as lease duration, DNS server, vendor specific
options, and user defined options using DHCPv6. You can also exclude IPv6 addresses from subnets. Mobility
Master IPv6 addresses, VLAN interface IPv6 addresses, and DNS server addresses are excluded from use by
default.

Similar to DHCPv4, a DHCPv6 server pool is associated with a VLAN only through the IPv6 address configured
in that VLAN interface. A VLAN interface can have a maximum of three global unicast addresses, but only one
DHCPv6 pool.

DHCPv6 server supports stateless configuration of clients with options apart from the network addresses
described in RFC 3736.

Points to Remember
l Similar to IPv4, the default router configuration is not required for IPv6 pools as IPv6 compliant routers will

send RAs. The RA source address will be the default-gateway for the clients.

l ArubaOS does not support DHCPv6 relay and Hospitality feature on DHCPv6.

DHCP Lease Limit
The following table provides the maximum number of DHCP leases (both v4 and v6) supported per platform:

There is a new enforcement to the existing DHCP limit during configuration.



Table 21: DHCP Lease Limits

Platform DHCP Lease Limit

Virtual Mobility
Master

512

7005 512

7010 1024

7024 1024

7030 2048

7205 4096

7210 5120

7220 10240

7240 15360

Configuring DHCPv6 Server
You must enable the global DHCPv6 knob for the DHCPv6 functionality to be operational. You can enable and
configure DHCPv6 server using the WebUI or CLI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > Services > DHCP Server tab.

2. Select Enable from the IPv6 DHCP Server drop-down list to enable DHCPv6 globally.

3. If there are addresses that should not be assigned in the subnetwork:

a. Under IPv6 Excluded Address Range table, click + to create a list of IPv6 excluded address.

b. Enter the excluded IPv6 address range in IPv6 Excluded Range and click Apply. The specified address
range gets added to the IPv6 Excluded Address list box. The starting IP address in the Exclude
Address Range should always contain a unique value, if the IP address is already present, then the
existing IP address is replaced with a new one, and a warning is displayed.

4. Under Pool Configuration, click + to create a new DHCP server pool or click Edit to modify an existing
DHCP server pool.

To enable the DHCPv6 Server functionality on an interface, select the IP Interfaces tab, edit the VLAN interface, and
select a DHCP pool from the drop-down list under the DHCP server section. Ensure that the IP version of the VLAN
interface is IPv6.

5. Select IP Version as IPv6 to create a DHCPv6 pool.

6. Enter a name in Pool Name to configure an IPv6 pool name.

7. Enter an IPv6 address in DNS Servers to configure an IPv6 DNS server.
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To configure multiple DNS servers, enter the IPv6 addresses separated by space.

8. Enter a value in Domain Name to configure the domain name.

9. Enter the number of days, hours, minutes, and seconds in Lease days, Lease hours, Lease minutes,
and Lease seconds to configure the lease time. The default value is 12 hours.

10.Specify an IPv6 prefix in Network IP Address to configure an IPv6 network.

11.Enter the following details under Option to configure client specific DHCPv6 options.

a. Specify the option code in Option.

b. Select IP or text from the IP/Text drop-down list.

c. Enter a value in Value. If you selected IP in step b, then you must enter a valid IPv6 address in this field.

d. Click OK.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To enable the DHCPv6 service you can use the following command:
(host) [mynode] (config)#service dhcpv6

To configure a domain name server, execute the following commands:
(host) [mynode] (config)#ipv6 dhcp pool <pool-name>

(host) [mynode] (config-dhcpv6)#dns-server <ipv6-address>

To configure a domain name, use the following command:
(host) [mynode] (config-dhcpv6)#domain-name <domain>

To configure DHCPv6 lease time, use the following command:
(host) [mynode] (config-dhcpv6)#lease <days> <hours> <minutes> <seconds>

The default value is 12 hours.

To configure a DHCP network, use the following command:
(host) [mynode] (config-dhcpv6)#network <network-prefix>

To configure a client specific option, use the following command:
(host) [mynode] (config-dhcpv6)#option <code> [ip <ipv6-address> | text <string>]

To configure DHCP server preference, use the following command:
(host) [mynode] (config-dhcpv6)#preference <value>

To enable DHCPv6 Server functionality on an interface, use the following command:
(host) [mynode] (config) #interface vlan <vlan-id>

(host) [mynode] (config-subif) #ipv6 dhcp server <pool-name>

The configured DHCPv6 pool subnet must match the interface prefix for DHCPv6 Server to be active.

To configure the IPv6 excluded address range for the DHCPv6 server, use the following command:
(host) [mynode] (config)#ipv6 dhcp excluded-address <low-address> [<high-address>]

You can view the DHCPv6 server settings, statistics, and binding information using the CLI.

To view the DHCPv6 database, use the following command:



(host) [mynode] #show ipv6 dhcp database

You can also view the DHCPv6 database for a specific pool, use the following command:
(host) [mynode] #show ipv6 dhcp database [pool <pool-name>]

(host) [mynode] #show ipv6 dhcp database pool DHCPv6

To view the DHCPv6 binding information, use the following command:
(host) [mynode]# show ipv6 dhcp binding

To clear all the DHCPv6 bindings, use the following command:
(host) [mynode] # clear ipv6 dhcp binding

To view the DHCPv6 server statistics, use the following command:
(host) [mynode](config) #show ip dhcp statistics

To view the DHCPv6 active pools, use the following command:
(host) [mynode] #show ipv6 dhcp active-pools

Understanding ArubaOS Supported Network Configuration for
IPv6 Clients
ArubaOS provides wired or wireless clients using IPv6 addresses with services such as firewall functionality,
layer-2 authentication, and, with the installation of the Policy Enforcement Firewall Next Generation (PEFNG),
identity-based security. The Aruba Mobility Master does not provide routing or Network Address Translation to
IPv6 clients (see Understanding IPv6 Exceptions and Best Practices on page 151).

Supported Network Configuration
Clients can be wired or wireless and use IPv4 and/or IPv6 addresses. An external IPv6 router is recommended
for a complete routing experience (dynamic routing). You can use the WebUI or CLI to display IPv6 client
information.

On the Mobility Master, you can configure both IPv4 and IPv6 client addresses on the same VLAN.

Understanding the Network Connection Sequence for Windows IPv6 Clients
This section describes the network connection sequence for Windows Vista/XP clients that use IPv6 addresses,
and the actions performed by the AP and the Mobility Master.

1. The IPv6 client sends a Router Solicit message through the AP. The AP passes the Router Solicit message
from the IPv6 client through the GRE tunnel to the Mobility Master.

2. The Mobility Master removes the 802.11 frame and creates an 802.3 frame for the Router Solicit message.

a. The Mobility Master authenticates the user, applies firewall policies, and bridges the 802.3 frame to the
IPv6 router.

b. The Mobility Master creates entries in the user and session tables.

3. The IPv6 router responds with a Router Advertisement message.

4. The Mobility Master applies firewall policies, then creates an 802.11 frame for the Router Advertisement
message. The Mobility Master sends the Router Advertisement through the GRE tunnel to the AP.

5. The IPv6 client sends a Neighbor Solicitation message.

6. The IPv6 router responds with a Neighbor Advertisement message.

7. If the DHCP is required to provide IPv6 addresses, the DHCPv6 process is started.

8. The IPv6 client sends data.

9. The Mobility Master removes the 802.11 frame and creates an 802.3 frame for the data.
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The Mobility Master authenticates the user, applies firewall policies and bridges the 802.3 frame to the IPv6
router. The Mobility Master creates entries in the user and session tables.

A client can have an IPv4 address and an IPv6 address, but the Mobility Master does not relate the states of the IPv4
and the IPv6 addresses on the same client. For example, if an IPv6 user session is active on a client, the Mobility
Master will delete an IPv4 user session on the same client if the idle timeout for the IPv4 session is reached.

Understanding ArubaOS Authentication and Firewall Features
that Support IPv6
This section describes ArubaOS features that support IPv6 clients.

Understanding Authentication
This release of ArubaOS only supports 802.1X authentication for IPv6 clients. You cannot configure layer-3
authentications to authenticate IPv6 clients.

Authentication Method Supported for IPv6 Clients?

802.1X Yes

Stateful 802.1X (with non-Aruba
APs)

Yes

Local database Yes

Captive Portal Yes

VPN No

xSec No (not tested)

MAC-based Yes

Table 22: IPv6 Client Authentication

You configure 802.1X authentication for IPv6 clients in the same way as for IPv4 client configurations. For
more information about configuring 802.1X authentication on the Mobility Master, see 802.1X Authentication
on page 233.

This release does not support authentication of management users on IPv6 clients.

Working with Firewall Features
If you installed a Policy Enforcement Firewall Next Generation (PEFNG) license in the Mobility Master, you can
configure firewall functions for IPv6 client traffic. While these firewall functions are identical to firewall
functions for IPv4 clients, you need to explicitly configure them for IPv6 traffic. For more information about
firewall policies, see Understanding Global Firewall Parameters on page 379.

Voice-related and NAT firewall functions are not supported for IPv6 traffic.



Parameter Description

Monitor Ping Attack (per
30 seconds)

Number of ICMP pings per 30 second, which if exceeded, can indicate a denial of
service attack. Valid range is 1-16384 pings per 30 seconds.

Recommended value is 120.

Default: No default

Monitor TCP SYN Attack
rate (per 30 seconds)

Number of TCP SYN messages per 30 second, which if exceeded, can indicate a
denial of service attack. Valid range is 1-16384 pings per 30 seconds.

Recommended value is 960.

Default: No default

Monitor IP Session
Attack (per 30 seconds)

Number of TCP or UDP connection requests per 30 second, which if exceeded,
can indicate a denial of service attack. Valid range is 1-16384 requests per 30
seconds.

Recommended value is 960.

Default: No default

Deny Inter User Bridging Prevents the forwarding of Layer-2 traffic between wired or wireless users. You
can configure user role policies that prevent Layer-3 traffic between users or
networks but this does not block Layer-2 traffic. This option can be used to
prevent traffic, such as Appletalk or IPX, from being forwarded.

Default: Disabled

Deny All IP Fragments Drops all IP fragments.

NOTE: Do not enable this option unless instructed to do so by an Aruba
representative.

Default: Disabled

Enforce TCP Handshake
Before Allowing Data

Prevents data from passing between two clients until the three-way TCP
handshake has been performed. This option should be disabled when you have
mobile clients on the network, as enabling this option will cause mobility to fail.
You can enable this option if there are no mobile clients on the network.

Default: Disabled

Prohibit IP Spoofing Enables detection of IP spoofing (where an intruder sends messages using the IP
address of a trusted client). When you enable this option, IP and MAC addresses
are checked for each ARP request/response. Traffic from a second MAC address
using a specific IP address is denied, and the entry is not added to the user table.
Possible IP spoofing attacks are logged and an SNMP trap is sent.

Default: Disabled

Prohibit RST Replay
Attack

When enabled, closes a TCP connection in both directions if a TCP RST is received
from either direction. You should not enable this option unless instructed to do so
by an Aruba representative.

Default: Disabled

Table 23: IPv6 Firewall Parameters
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Parameter Description

Session Mirror
Destination

Destination (IPv4 address or managed device port) to which mirrored session
packets are sent. You can configure IPv6 flows to be mirrored with the session
ACL “mirror” option. This option is used only for troubleshooting or debugging.

Default: N/A

Session Idle Timeout Set the time, in seconds, that a non-TCP session can be idle before it is removed
from the session table. Specify a value in the range 16–259 seconds. You should
not set this option unless instructed to do so by an Aruba representative.

Default: 30 seconds

Per-packet Logging Enables logging of every packet if logging is enabled for the corresponding
session rule. Normally, one event is logged per session. If you enable this option,
each packet in the session is logged. You should not enable this option unless
instructed to do so by an Aruba representative, as doing so may create
unnecessary overhead on the Mobility Master.

Default: Disabled (per-session logging is performed)

IPv6 Enable Enables IPv6 globally.

Table 23: IPv6 Firewall Parameters

The following examples configure attack rates and the session timeout for IPv6 traffic.

To configure the firewall function via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > Firewall tab.

2. Click Global Setting accordion.

3. Under the IPv6 column, enter the following:

l For Monitor Ping Attack (per 30 sec), enter 15
l For Monitor IP Session Attack (per 30 sec), enter 25
l For Session Idle Timeout (sec), enter 60

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To configure firewall functions using the command line interface, issue the following commands in config
mode:
(host) [mynode] (config)#ipv6 firew all attack-rate ping 15

(host) [mynode] (config)#ipv6 firewall attack-rate session 25

(host) [mynode] (config)#ipv6 firewall session-idle-timeout 60

Understanding Firewall Policies
A user role, which determines a client’s network privileges, is defined by one or more firewall policies. A firewall
policy consists of rules that define the source, destination, and service type for specific traffic, and whether you
want the Mobility Master to permit or deny traffic that matches the rule.

You can configure firewall policies for IPv4 traffic or IPv6 traffic, and apply IPv4 and IPv6 firewall policies to the
same user role. For example, if you have employees that use both IPv4 and IPv6 clients, you can configure
both IPv4 and IPv6 firewall policies and apply them both to the “employee” user role.



The procedure to configure an IPv6 firewall policy rule is similar to configuring a firewall policy rule for IPv4
traffic, but with some differences. Table 18 describes the required and optional parameters for an IPv6 firewall
policy rule.

Field Description

Source
(required)

Source of the traffic:

l any: Acts as a wildcard and applies to any source address.

l user: This refers to traffic from the wireless client.

l host: This refers to traffic from a specific host. When this option is chosen, you must
configure the IPv6 address of the host. For example,
2002:d81f:f9f0:1000:c7e:5d61:585c:3ab.

l network: This refers to a traffic that has a source IP from a subnet of IP addresses.
When you chose this option, you must configure the IPv6 address and network mask of
the subnet. For example, 2002:ac10:fe:: ffff:ffff:ffff::.

l alias: This refers to using an alias for a host or network.

NOTE: This release does not support IPv6 aliases. You cannot configure an alias for an
IPv6 host or network.

Destination
(required)

Destination of the traffic, which you can configure in the same manner as Source.

Service
(required)

NOTE: Voice over IP services are unavailable for IPv6 policies.

Type of traffic:

l any: This option specifies that this rule applies to any type of traffic.

l tcp: Using this option, you configure a range of TCP port(s) to match the rule to be
applied.

l udp: Using this option, you configure a range of UDP port(s) to match the rule to be
applied.

l service: Using this option, you use one of the pre-defined services (common protocols
such as HTTPS, HTTP, and others) as the protocol to match the rule to be applied. You
can also specify a network service that you configure by navigating to the
Configuration > Advanced Services > Stateful Firewall > Network Services page.

l protocol: Using this option, you specify a different layer 4 protocol (other than
TCP/UDP) by configuring the IP protocol value.

Action
(required)

The action that you want the Mobility Master to perform on a packet that matches the
specified criteria.

l permit: Permits traffic matching this rule.

l drop: Drops packets matching this rule without any notification.

NOTE: The only actions for IPv6 policy rules are permit or deny; in this release, the
Mobility Master cannot perform network address translation (NAT) or redirection on IPv6
packets. You can specify options such as logging, mirroring, or blacklisting (described
below).

Log (optional) Logs a match to this rule. This is recommended when a rule indicates a security breach,
such as a data packet on a policy that is meant only to be used for voice calls.

Table 24: IPv6 Firewall Policy Rule Parameters
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Field Description

Mirror
(optional)

Mirrors session packets to a datapath or remote destination specified in the IPv6 firewall
function (see “Session Mirror Destination” in Table 23). If the destination is an IP address,
it must be an IPv4 IP address.

Queue
(optional)

The queue in which a packet matching this rule should be placed. Select High for higher
priority data, such as voice, and Low for lower priority traffic.

Time Range
(optional)

Time range for which this rule is applicable. You configure time ranges in the
Configuration > Security > Access Control > Time Ranges page.

Black List
(optional)

Automatically blacklists a client that is the source or destination of traffic matching this
rule. This option is recommended for rules that indicate a security breach where the
blacklisting option can be used to prevent access to clients that are attempting to breach
the security.

TOS
(optional)

Value of type of service (TOS) bits to be marked in the IP header of a packet matching this
rule when it leaves the Mobility Master.

802.1p
Priority
(optional)

Value of 802.1p priority bits to be marked in the frame of a packet matching this rule
when it leaves the Mobility Master.

Table 24: IPv6 Firewall Policy Rule Parameters

The following example creates a policy "ipv6-web-only" that allows only web (HTTP and HTTPS) access for IPv6
clients and assigns the policy to the user role “web-guest."

The user role “web-guest” can include both IPv6 and IPv4 policies, although this example only shows configuration of
an IPv6 policy.

Creating an IPv6 Firewall Policy
Follow the procedure below to create an IPv6 firewall policy using the WebUI.

1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Policies
tab.

2. Click + to create a new policy.

3. Enter ipv6-web-only for the Policy Name.

4. To configure a firewall policy, select Session for Policy Type.

5. Click Submit.

6. Click + to add a rule that allows HTTP traffic.

a. Select the ipv6-web-only policy.

b. Click +.

c. Select Access Control option in the Rule Type field.

d. Click OK.

a. Under IP Version column, select IPv6.

b. Under Source, select network from the drop-down list.

c. For Host IP, enter 2002:d81f:f9f0:1000::.
d. For Netmask, enter 64 as the prefix-length.



e. Under Service/app, select service from the drop-down list.

f. Under Service alias, select svc-http from the drop-down list.

g. Click Submit.

7. Click + to add a rule that allows HTTPS traffic.

a. Under IP Version column, select IPv6.
b. Under Source, select network from the drop-down list.

c. For Host IP, enter 2002:d81f:f9f0:1000::.
d. For Mask, enter 64 as the prefix-length.

e. Under Service, select service from the drop-down list.

f. Select svc-https from the scrolling list.

g. Click Submit.

Rules can be reordered using the up and down arrow buttons provided for each rule.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

To create an IPv6 firewall policy using the command-line interface, issue the following commands in config
mode:
(host) [mynode] (config)#ip access-list session ipv6-web-only

(host) [mynode] (config-submode)#ipv6 network 2002:d81f:f9f0:1000::/64 any svc-http permit

(host) [mynode] (config-submode)#ipv6 network 2002:d81f:f9f0:1000::/64 any svc-https permit

Assigning an IPv6 Policy to a User Role
To assign an IPv6 policy using the WebUI:

1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Roles
tab.

2. Click + to create a new user role.

3. Enter web-guest for Role Name.

4. Click Submit.

5. Select web-guest role.

6. Click Show Advanced View.

7. Click + in Roles >web-guest table.

8. Select Add existing session policy option, in the Add Policy popup.

9. Select a policy from the Policy name drop-down list.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

To assign an IPv6 policy to a user role via the command-line interface, issue the following command in config
mode:
(host) [mynode] (config)#user-role web-guest

(host) [mynode] (config-submode)#access-list session ipv6-web-only position 1
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Understanding DHCPv6 Passthrough/Relay
The Mobility Master forwards DHCPv6 requests from IPv6 clients to the external IPv6 router. On the external
IPv6 router, you must configure the Mobility Master’s IP address as the DHCP relay. You do not need to
configure an IP helper address on the Mobility Master to forward DHCPv6 requests.

Understanding IPv6 Exceptions and Best Practices
The IPv6 best practices are provided below:

l Ensure that you enable IPv6 globally.

l The uplink port must be trusted. This is the same behavior as IPv4.

l Ensure that the validuser session ACL does not block IPv6 traffic.

l There must not be any ACLs that drop ICMPv6 or DHCPv6 traffic. It is acceptable to drop DHCPv6 traffic if
the deployment uses Stateless Address Auto Configuration (SLAAC) only.

l If an external device provides RA:

n It is not recommended to advertise too many prefixes in RA.

n The Mobility Master supports a maximum of four IPv6 user entries in the user table. If a client uses more
than four IPv6 addresses at a time, the user table is refreshed with the latest four active entries without
disrupting the traffic flow. However, this may have some performance impact.

l Enable BCMC Optimization under interface VLAN to drop any random IPv6 multicast traffic. DHCPv6, ND,
NS, and RA traffic are not dropped when you enable this option.

It is recommended to enable BCMC Optimization only if mDNS traffic is not used in the network, as mDNS traffic
gets dropped if this option is enabled.

l While selecting a source address, the number of common bits between each source address in the list, is
checked from the left most bit. This is followed by selection of the source address that has the maximum
number of matching bits with the destination address. If more than one source addresses has the same
number of matching bits with the destination address, the kernel selects that source address that is most
recently configured on the system. It is essential that the administrator/user configures the network
appropriately, if a particular VLAN interface needs to be selected as the source. For example, in case of
Dot1x authentication the administrator/user can configure the source interface appropriately so that it is
selected for authentication process. For more information on IPv6 source address selection, see RFC 3848.

ArubaOS does not support the following functions for IPv6 clients:

l The Mobility Master offers limited routing services to IPv6 clients, so it is recommended to use an external
IPv6 router for a complete routing experience (dynamic routing).

l VoIP ALG is not supported for IPv6 clients.

l Remote AP supports IPv6 clients in tunnel forwarding mode only. The Remote AP bridge and split-tunnel
forwarding modes do not support IPv6 clients. Secure Thin Remote Access Point (STRAP) cannot support
IPv6 clients.

l IPv6 Auto configuration and IPv6 Neighbor Discovery mechanisms does not apply to IPv6 tunnels.

l Tunnel Encapsulation Limit, Tunnel-group, and MTU discovery options on IPv6 tunnels are not supported.

l IPsec is not supported in this release, so IPv6 GRE cannot be used for master-local setup.
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Chapter 7
Port Channel Link Aggregation Control Protocol

The ArubaOS implementation of Link Aggregation Control Protocol (LACP) is based on the standards specified
in 802.3ad. LACP provides standardized means for exchanging information with partner systems, to form a
Link Aggregation Group (LAG). LACP avoids port channel misconfiguration.

LACP Overview
Two devices (actor and partner) exchange LACP Data Units (DUs) when forming a port-channel group (LAG).
Once multiple ports in the system have the same actor system ID, actor key, partner system ID, and partner
key, they belong to the same LAG.

The maximum number of supported port-channels is eight. With the introduction of LACP, this number
remains the same.

Two LACP configured devices exchange LACPDUs to form a link aggregation group (LAG). A device is
configurable as an active or passive participant. In active mode, the device initiates DUs irrespective of the
partner state; passive mode devices respond only to the incoming DUs sent by the partner device. Hence, to
form a LAG group between two devices, one device must be an active participant. For detailed information on
the LACP commands, see the ArubaOS 8.0 Command-Line Interface Reference Guide.

LACPDUs exchange their corresponding system identifier/priority along with their port’s key/priority. This
information determines the LAG of a given port. The LAG for a port is selected based on its keys. The port is
placed in that LAG only when its system ID/key and partner's system ID/key matches the other ports in the
LAG (if the group has ports).

LACP Best Practices and Exceptions
l LACP is disabled by default.

l LACP depends on periodical Tx/Rx of LACP Data Units (LACPDUs). Any failure detected at a port can be
removed from the LAG. Failure detection period depends on the configured timeout which can either be
short or long.

l The maximum LAG supported per system is eight groups; each group can be created statically or through
LACP.

l Each LAG can have up to eight member ports.

l The LAG group identification (ID) range is 0–7 for both static (port-channel) and LACP groups.

l When a port is added to a LACP LAG, it inherits the port-channel’s properties such as, VLAN membership,
trunk status, and so on.

l When a port is added to a LACP LAG, the port’s property (like speed) is compared to the existing port
property. If there is a mismatch, the command is rejected.

l The LACP commands cannot be configured on a port that is already a member of a static port-channel.
Similarly, if the group assigned in the command lacp group <number> already contains static port
members, the command is rejected.

l The port uses the group number as its actor admin key.

l All ports use the long(90 seconds) timeout value by default.

l The output of the command show interface port-channel <port-channel ID>indicates if sthe LAG is
created by LACP (dynamic) or static configuration. If the LAG is created through LACP, you cannot add or
delete any ports under that port channel. All other commands are allowed.
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Configuring LACP

Configuring LACP

In the CLI
1. Enable LACP and configure the per-port specific LACP.

[mynode] (config) #interface gigabitethernet <slot>/<module>/<port>

2. Configure LACP group and mode.
[mynode] (config-submode)#lacp group <group_number> mode {active | passive}

l Group number range is 0–7.

l Active mode—the interface is in an active negotiating state. LACP runs on any link that is configured to
be in the active state. The port in an active mode also automatically initiates negotiations with other
ports by initiating LACP packets.

l Passive mode—the interface is not in an active negotiating state. LACP runs on any link that is configured
in a passive mode. The port in a passive mode responds to negotiations requests from other ports that
are in an active mode. Ports in passive mode respond to LACP packets.

A port in a passive mode cannot set up a port channel (LAG group) with another port in a passive mode.

3. Set the timeout for the LACP session. The timeout value is the amount of time that a port-channel interface
waits for a LACPDU from the remote system before terminating the LACP session. The default long time-
out value is 90 seconds; short is 3 seconds.
[mynode] (config-submode)#lacp timeout {long | short}

4. Set the port priority.
[mynode] (config-submode)#lacp port-priority <priority_value>

The higher the priority value the lower the priority. The range is 1-65535 and the default is 255.

5. Save configuration.
[mynode] (config-submode)#write memory

6. View your LACP configuration.

The port uses the group number +1 as the “actor admin key”. All the ports use the long timeout value (90
seconds) by default.
[mynode] (config-submode)#show lacp <group_number> neighbor

When a port in a LAG is misconfigured (the partner device is different than the other ports), or the neighbor
timesout or can not exchange LACPDUs with the partner, the port status is displayed as “DOWN” (see the
following example):
[mynode] (config-submode)#show lacp <group_number> internal

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration >Interfaces>Ports page. In the

Port Channel table, click the add (+) button.

2. In the New Port Channel dialog, select an ID from the list, as show in the following figure:



Figure 18 New Port Channet List

3. Click OK.

4. In the dialog for the Port ID added, for Prococol select LACP.

5. For LACP mode, select active.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

For information on configuring LACP on 220 Series and 270 Series access points, see Link Aggregation Support on
page 541

LACP Sample Configuration
The following sample configuration is for FastEthernet (FE) port/slot 0/1:
[mynode] (config) #interface gigabitethernet 0/0/4

[mynode] (config-submode)#lacp group 1 mode active

[mynode] (config-submode)#lacp timeout long

[mynode] (config-submode)#lacp port-priority 2

[mynode] (config-submode)#write memory

Saving Configuration...

Partial configuration for /mm/mynode

------------------------------------

Contents of : /flash/config/partial/0/p=sc=mynode.cfg

interface gigabitethernet 0/0/4

lacp group 1 mode active

lacp port-priority 2

lacp timeout long

!

Configuration Saved
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Chapter 8
OSPFv2

OSPFv2 (Open Shortest Path First) is a dynamic Interior Gateway routing Protocol (IGP) based on IETF RFC
2328. The OSPF uses the shortest or fastest routing path. Aruba’s implementation of OSPFv2 allows Aruba
Mobility Master and managed devices to deploy effectively in a Layer 3 topology. Aruba Mobility Master and
managed devicescan act as default gateway for all clients and forward user packets to the upstream router.
The OSPF on the Mobility Master can be used to redistribute branch routes into corporate OSPF domain. The
information on this chapter is in the following sections:

l Understanding OSPF Deployment Best Practices and Exceptions on page 155

l Understanding OSPFv2 by Example using a WLAN Scenario on page 156

l Understanding OSPFv2 by Example using a Branch Scenario on page 157

l Configuring OSPF on page 159

l Sample Topology and Configuration on page 160

Understanding OSPF Deployment Best Practices and Exceptions
OSPF is a robust routing protocol addressing various link types and deployment scenarios. The Aruba
implementation applies to two main use cases; WLAN Scenarios and Branch Scenario.

l OSPF is disabled by default.

l Aruba Mobility Master supports only one OSPF instance.

l Convergence takes between 5 and 15 seconds.

l All area types are supported.

l Multiple configured areas are supported.

l An Aruba Mobility Master can act as an ABR (Area border router).

l OSPF supports VLAN and GRE tunnel interfaces.

l To run OSPF over IPsec tunnels, a Layer 3 GRE tunnel is configured between two routers with GRE
destination addresses as the inner address of the IPsec tunnel. OSPF is enabled on the Layer 3 GRE tunnel
interface, and all of the OSPF control packets undergo GRE encapsulation before entering the IPsec tunnels.

The default MTU value for a Layer 3 GRE tunnel in an Aruba Mobility Master is 1100. When running OSPF
over a GRE tunnel between an Aruba Mobility Master and another vendor’s router, the MTU values must be
the same on both sides of the GRE tunnel.

The following table provides information on the maximum OSPF routes supported for various platforms:

Platform Branches Routes

7005 4K 4K

7008 4K 4K

7210 8K 8K

Table 25: Maximum OSPF Routes
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Platform Branches Routes

7220 16K 16K

7240 32K 32K

Below are some guidelines regarding deployment and topology for this release of OSPFv2.

l In the WLAN scenario upstream router, configure only the interface connected to the stand-alone controller
or the managed device in the same area. This will minimize the number of local subnet addresses advertised
by the upstream router to the stand-alone controller or the managed device.

l Use the upstream router as the designated router (DR) for the link/interface between the stand-alone
controller or the managed device and the upstream router.

l The default MTU value for a Layer 3 GRE tunnel in an Aruba Mobility Master, managed device or stand-
alone controller is 1100. When running OSPF over a GRE tunnel between an Aruba device and another
vendor’s router, the MTU values must be the same on both sides of the GRE tunnel.

l Do not enable OSPF on any uplink/WAN interfaces on the managed device. Enable OSPF only on the Layer 3
GRE tunnel connecting the Mobility Master.

l Use only one physical port in the uplink VLAN interface that is connecting to the upstream router. This will
prevent broadcasting the protocol PDUs to other ports and hence limit the number of adjacencies on the
uplink interface to only one.

Understanding OSPFv2 by Example using a WLAN Scenario
In the WLAN scenario, the Aruba Mobility Master acts as a default gateway for all the clients, and talks to one or
two upstream routers for redundancy. Mobility Master advertises all the user subnet addresses as stub
addresses to the routers via LSAs.

Totally stub areas see only default route and to the areas themselves.

WLAN Topology
Mobility Master (Figure 19) is configured with VLAN 10 and VLAN 12 as user VLANs. These VLANs have clients
on the subnets, and Mobility Master is the default router for those clients. VLAN 4 and VLAN 5 both have OSPF
enabled. These interfaces are connected to upstream routers (Router 1 and Router 2). The OSPF interface cost
on VLAN 4 is configured lower than VLAN 5. The IDs are:

l Aruba managed device— 40.1.1.1

l Router 1— 50.1.1.1

l Router 2— 60.1.1.1



Figure 19 WLAN OSPF Topology

Based on the cost of the uplink interface, the default route from one of the upstream routers is installed in the
forwarding information base (FIB) by the routing information base/route table manager (RIB/RTM) module.

WLAN Routing Table
View the Mobility Master routing table using the show ip route command:

(host) [mynode] #show ip route

Codes: C - connected, O - OSPF, R - RIP, S - static

M - mgmt, U - route usable, * - candidate default

Below is the routing table for Router 1:
(router1) #show ip route

O 10.1.1.0/24 [1/0] via 4.1.1.1

O 12.1.1.0/24 [1/0] via 4.1.1.1

C 4.1.1.0 is directly connected, VLAN4

Below is the routing table for Router 2:
(router2) #show ip route

O 10.1.1.0/24 [2/0] via 5.1.1.1

O 12.1.1.0/24 [2/0] via 5.1.1.1

C 5.1.1.0 is directly connected, VLAN5

Understanding OSPFv2 by Example using a Branch Scenario
The branch office scenario has a number of remote branch offices with managed devices talking to a central
office via a Mobility Master using site-to-site VPN tunnels or IPsec tunnels. The central office Mobility Master is
in turn talking to the upstream routers (see Figure 20). In this scenario, the default route is normally pointed to
the uplink router, in many cases the ISP. Configure the area as stub so that inter-area routes are also advertised
enabling the managed device in the branch office to reach the corporate subnets.

Branch Topology
All the OSPF control packets exchanged between the managed devices and Mobility Master undergo GRE
encapsulation before entering the IPsec tunnels. The managed devices in the branch offices advertise all the
user subnet addresses to Mobility Master as stub addresses in router LSA. Mobility Master in turn forwards
those router LSAs to the upstream routers.

ArubaOS 8.0.0.0 | User Guide OSPFv2 |  157



158 | OSPFv2 ArubaOS 8.0.0.0  | User Guide

Figure 20 BranchOSPF Topology

All the managed devices in the branch office, Mobility Master in the central office, and the upstream routers are
part of a stub area. Since the OSPF packets follow GRE encapsulation over IPsec tunnels, Mobility Master can
be any vendor’s VPN concentrator. Regardless, the managed devices in the branch office will operate with
other vendors seamlessly.

In Figure 20, the managed device is configured using VLAN 14 and VLAN 15. Layer 3 GRE tunnel is configured
with IP address 20.1.1.1/24 and OSPF is enabled on the tunnel interface.

In the Central office Mobility Master, OSPF is enabled on VLAN interfaces 4, 5, and the Layer 3 GRE tunnel
interface (configured with IP address 20.1.1.2/24). OSPF interface cost on VLAN 4 is configured lower than
VLAN 5.

Branch Routing Table
View the branch office managed device routing table using the show ip route command:
(host) [md] #show ip route

Codes: C - connected, O - OSPF, R - RIP, S - static

M - mgmt, U - route usable, * - candidate default

The routing table forMobility Master is below:
(host) [mynode] #show ip route

Gateway of last resort is 4.1.1.2 to network 0.0.0.0

O* 0.0.0.0/0 [1/0] via 4.1.1.2*

O 14.1.1.0/24 [1/0] via 30.1.1.1*

O 15.1.1.0/24 [1/0] via 30.1.1.1*

C 4.1.1.0 is directly connected, VLAN4

C 5.1.1.0 is directly connected, VLAN5

C 20.1.1.0 is directly connected, Tunnel 1

The routing table for Router 1 is below:
(router1) #show ip route

O 14.1.1.0/24 [1/0] via 4.1.1.1

O 15.1.1.0/24 [1/0] via 4.1.1.1

C 4.1.1.0 is directly connected, VLAN4

The routing table for Router 2 is below:
(router2) #show ip route



O 14.1.1.0/24 [1/0] via 5.1.1.1

O 15.1.1.0/24 [1/0] via 5.1.1.1

C 5.1.1.0 is directly connected, VLAN5

Configuring OSPF
To configure general OSPF settings from the OSPF tab, perform the following steps:

1. In the Mobility Master node hierarchy, navigate to the Configuration >Interfaces > OSPF page.

2. To enable OSPF, Select Enabled in the Enable OSPF field.

3. Configure the other OSPF interface settings in the respective fields.

4. To add an OSPF area, click the + icon in the Area table and specify the appropriate values.

5. To add an excluded subnet in the Excluded Subnet table, click the + icon and specify the appropriate
values.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

OSPF monitoring is available from an IP Routing sub-section (Controllers > Interfaces > IP Routes). Select
the IP Routes accordion to view both Static and OSPF routes .

Exporting VPN Client Addresses to OSPF
You can configure VPN client addresses so that they can be exported to OSPF and be advertised as host routes
(/32). Exporting applies to any VPN client address regardless of how it is assigned.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles > Wireless

LAN > VPN Authentication > default page.

For Instant AP, RAP and CAP, you can edit the respective default profiles (default-iap, default-rap, and default-cap)

2. (Optional) Select the Export VPN IP address as a route check box. Regardless of how an authentication
server is contacted, selecting this option causes any VPN client address to be exported to OSPF using IPC.
Note that the Framed-IP-Address attribute is assigned the IP address as long as any server returns the
attribute. The Framed-IP-Address value always has a higher priority than the local address pool.

3. Click Save.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa authentication vpn default

(host) [mynode] (VPN Authentication Profile "default") #

(host) [mynode] (VPN Authentication Profile "default") # export-route

Use the show ip ospf database command to show LSA types that are generated.
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Sample Topology and Configuration
The figure below displays a sample OSPF topology followed by sample configurations of the Remote Branch 1,
Remote Branch 2, and the Central Office Mobility Master (Active and Backup).

Figure 21 Sample OSPF Topology

Remote Branch 1
controller-ip vlan 30

vlan 16

vlan 30

vlan 31

vlan 32

interface gigabitethernet 0/0/1

description "GE0/0/1"

trusted

switchport access vlan 16

!

interface gigabitethernet 0/0/2

description "GE0/0/2"

trusted

switchport access vlan 30

!

interface gigabitethernet 0/0/3

description "GE0/0/3"

trusted

switchport access vlan 31

!

interface gigabitethernet 0/0/4

description "GE0/0/4"

trusted

switchport access vlan 32

!

interface vlan 16

ip address 192.168.16.251 255.255.255.0

!

interface vlan 30

ip address 192.168.30.1 255.255.255.0

!

interface vlan 31

ip address 192.168.31.1 255.255.255.0



!

interface vlan 32

ip address 192.168.32.1 255.255.255.0

!

uplink wired priority 202

uplink cellular priority 201

uplink wired vlan 16

interface tunnel 2003

description "Tunnel Interface"

ip address 2.0.0.3 255.0.0.0

tunnel source 192.168.30.1

tunnel destination 192.168.68.217

trusted

ip ospf area 10.10.10.10

!

ip default-gateway 192.168.16.254

ip route 192.168.0.0 255.255.0.0 null 0

!

router ospf

router ospf router-id 192.168.30.1

router ospf area 10.10.10.10 stub

router ospf redistribute vlan 30-32

Remote Branch 2
controller-ip vlan 50

!

vlan 20

vlan 50

vlan 51

vlan 52

!

interface gigabitethernet 0/0/1

description "GE0/0/1"

trusted

switchport access vlan 20

!

interface gigabitethernet 0/0/2

description "GE0/0/2"

trusted

switchport access vlan 50

!

interface gigabitethernet 0/0/3

description "GE0/0/3"

trusted

switchport access vlan 51

!

interface gigabitethernet 0/0/4

description "GE10/0/4"

trusted

switchport access vlan 52

!

interface vlan 20

ip address 192.168.20.1 255.255.255.0

!

interface vlan 50

ip address 192.168.50.1 255.255.255.0

!

interface vlan 51

ip address 192.168.51.1 255.255.255.0

!

interface vlan 52
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ip address 192.168.52.1 255.255.255.0

!

uplink wired priority 206

uplink cellular priority 205

uplink wired vlan 20

interface tunnel 2005

description "Tunnel Interface"

ip address 2.0.0.5 255.0.0.0

tunnel source 192.168.50.1

tunnel destination 192.168.68.217

trusted

ip ospf area 10.10.10.10

!

ip default-gateway 192.168.20.254

ip route 192.168.0.0 255.255.0.0 null 0

!

router ospf

router ospf router-id 192.168.50.1

router ospf area 10.10.10.10 stub

router ospf redistribute vlan 50-52

Mobility Master—Active
localip 0.0.0.0 ipsec db947e8d1b383813a4070ab0799fa6246b80fc5cfcc3268f

controller-ip vlan 225

vlan 68

vlan 100

vlan 225

!

interface gigabitethernet 0/0/1

description "GE0/0/1"

trusted

switchport access vlan 225

!

interface gigabitethernet 0/0/2

description "GE0/0/2"

trusted

switchport access vlan 100

!

interface gigabitethernet 10/0/31

description "GE0/0/4"

trusted

switchport access vlan 68

!

interface vlan 68

ip address 192.168.68.220 255.255.255.0

!

interface vlan 100

ip address 192.168.100.1 255.255.255.0

!

interface vlan 225

ip address 192.168.225.2 255.255.255.0

!

interface tunnel 2003

description "Tunnel Interface"

ip address 2.1.0.3 255.0.0.0

tunnel source 192.168.225.2

tunnel destination 192.168.30.1

trusted

ip ospf area 10.10.10.10

!

interface tunnel 2005



description "Tunnel Interface"

ip address 2.1.0.5 255.0.0.0

tunnel source 192.168.225.2

tunnel destination 192.168.50.1

trusted

ip ospf area 10.10.10.10

!

master-redundancy

master-vrrp 2

peer-ip-address 192.168.68.221 ipsec password123

!

vrrp 1

priority 120

authentication password123

ip address 192.168.68.217

vlan 68

preempt

tracking vlan 68 sub 40

tracking vlan 100 sub 40

tracking vlan 225 sub 40

no shutdown

!

vrrp 2

priority 120

ip address 192.168.225.9

vlan 225

preempt

tracking vlan 68 sub 40

tracking vlan 100 sub 40

tracking vlan 225 sub 40

no shutdown

!

ip default-gateway 192.168.68.1

ip route 192.168.0.0 255.255.0.0 null 0

router ospf

router ospf router-id 192.168.225.1

router ospf area 10.10.10.10 stub

router ospf redistribute vlan 100,225

!

Mobility Master—Backup
localip 0.0.0.0 ipsec db947e8d1b383813a4070ab0799fa6246b80fc5cfcc3268f

controller-ip vlan 225

!

interface gigabitethernet 0/0/1

description "GE0/0/1"

trusted

switchport access vlan 225

!

interface gigabitethernet 0/0/2

description "GE0/0/2"

trusted

switchport access vlan 100

!

interface gigabitethernet 0/0/31

description "GE0/0/3"

trusted

switchport access vlan 68

!

interface vlan 68
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ip address 192.168.68.221 255.255.255.224

!

interface vlan 100

ip address 192.168.100.5 255.255.255.0

!

interface vlan 225

ip address 192.168.225.1 255.255.255.0

!

interface tunnel 2003

description "Tunnel Interface"

ip address 2.1.0.3 255.0.0.0

tunnel source 192.168.225.1

tunnel destination 192.168.30.1

trusted

ip ospf area 10.10.10.10

!

interface tunnel 2005

description "Tunnel Interface"

ip address 2.1.0.5 255.0.0.0

tunnel source 192.168.225.1

tunnel destination 192.168.50.1

trusted

ip ospf area 10.10.10.10

!

master-redundancy

master-vrrp 2

peer-ip-address 192.168.68.220 ipsec password123

!

vrrp 1

priority 99

authentication password123

ip address 192.168.68.217

vlan 68

tracking vlan 68 sub 40

tracking vlan 100 sub 40

tracking vlan 225 sub 40

no shutdown

!

vrrp 2

priority 99

ip address 192.168.225.9

vlan 225

tracking vlan 68 sub 40

tracking vlan 100 sub 40

tracking vlan 225 sub 40

no shutdown

!

ip default-gateway 192.168.68.1

ip route 192.168.0.0 255.255.0.0 null 0

!

router ospf

router ospf router-id 192.168.225.1

router ospf area 10.10.10.10 stub

router ospf redistribute vlan 100,225

!

The following figure displays how the managed device is configured for Instant AP VPN for different OSPF
cases.



Figure 22 Managed Device Not-So-Stubby-Area (NSSA) and Normal Area

Topology
l Area-10 is NSSA (Not-So-Stubby Area)

l Area-11 is Normal area.

l RAPNG AP-1 is configured to have a UP managed device as its primary managed device and a DOWN as
secondary managed device.

l RAPNG AP-2 is configured to have a DOWN as its primary managed device and a UP as secondary managed
device.

l RAPNG AP-1 is configured to have a 201.201.203.0/24 L3-distributed network.

l RAPNG AP-2 is configured to have a 202.202.202.0/24 L3-distributed network.

Observation
l UP managed device will send Type-5 LSA (External LSA) of VPN route 201.201.203.0/24 to it’s upstream

router, Cisco-3750.

l DOWN managed device will send Type-7 LSA (NSSA) of VPN route 202.202.202.0/24 to it’s upstream
router, Cisco-2950.

l UP managed device will send a Type-4 asbr-summary LSA.

Configuring UP Managed Device
interface vlan 21

ip address 21.21.21.2 255.255.255.0

ip ospf area 0.0.0.11

!

router ospf

router ospf area 0.0.0.11

router ospf redistribute rapng-vpn

!
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The following commands display the configuration and run time protocol details on the UP managed device:

(host) [mynode]#show ip route

Codes: C - connected, O - OSPF, R - RIP, S - static

M - mgmt, U - route usable, * - candidate default, V - RAPNG VPN

Gateway of last resort is Imported from DHCP to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from CELL to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from PPPOE to network 0.0.0.0 at cost 10

Gateway of last resort is 10.15.231.185 to network 0.0.0.0 at cost 1

S* 0.0.0.0/0 [1/0] via 10.15.231.185*

O 10.15.228.0/27 [333/0] via 21.21.21.1*

O 12.12.12.0/25 [0/0] via 21.21.21.1*

O 22.22.22.0/24 [3/0] via 21.21.21.1*

O 23.23.23.0/24 [2/0] via 21.21.21.1*

O 25.25.25.0/24 [333/0] via 21.21.21.1*

S 192.100.3.0/24 [1/0] via 192.100.2.1*

S 192.100.4.0/24 [1/0] via 192.100.2.1*

S 192.100.5.0/24 [1/0] via 192.100.2.1*

S 192.100.6.0/24 [1/0] via 192.100.2.1*

S 192.100.7.0/24 [1/0] via 192.100.2.1*

S 192.100.8.0/24 [1/0] via 192.100.2.1*

S 192.100.9.0/24 [1/0] via 192.100.2.1*

S 192.100.10.0/24 [1/0] via 192.100.2.1*

S 192.100.11.0/24 [1/0] via 192.100.2.1*

S 192.100.12.0/24 [1/0] via 192.100.2.1*

S 192.100.13.0/24 [1/0] via 192.100.2.1*

S 192.100.14.0/24 [1/0] via 192.100.2.1*

S 192.168.1.0/24 [1/0] via 192.100.2.1*

S 192.169.1.0/24 [1/0] via 192.100.2.1*

S 192.170.1.0/24 [1/0] via 192.100.2.1*

S 192.171.1.0/24 [1/0] via 192.100.2.1*

S 192.172.1.0/24 [1/0] via 192.100.2.1*

S 192.173.1.0/24 [1/0] via 192.100.2.1*

S 192.174.1.0/24 [1/0] via 192.100.2.1*

S 192.175.1.0/24 [1/0] via 192.100.2.1*

S 192.176.1.0/24 [1/0] via 192.100.2.1*

S 192.177.1.0/24 [1/0] via 192.100.2.1*

S 192.178.1.0/24 [1/0] via 192.100.2.1*

S 192.179.1.0/24 [1/0] via 192.100.2.1*

V 201.201.203.0/26 [10/0] ipsec map

O 202.202.202.0/29 [0/0] via 21.21.21.1*

C 192.100.2.0/24 is directly connected, VLAN2

C 10.15.231.184/29 is directly connected, VLAN1

C 172.16.0.0/24 is directly connected, VLAN3

C 21.21.21.0/24 is directly connected, VLAN21

C 5.5.0.2/32 is an ipsec map 10.15.149.30-5.5.0.2

(host) [mynode]#show ip ospf database

OSPF Database Table

-------------------

Area ID LSA Type Link ID Adv Router Age Seq# Checksum

------- -------- ------- ---------- --- ---- --------

0.0.0.11 ROUTER 21.21.21.1 21.21.21.1 178 0x80000017 0xca50

0.0.0.11 ROUTER 192.100.2.3 192.100.2.3 1406 0x80000007 0x2253

0.0.0.11 NETWORK 21.21.21.1 21.21.21.1 178 0x80000003 0xdf6d

0.0.0.11 IPNET_SUMMARY 22.22.22.0 21.21.21.1 178 0x80000003 0x7e38

0.0.0.11 IPNET_SUMMARY 23.23.23.0 21.21.21.1 178 0x80000003 0x5064

0.0.0.11 ASBR_SUMMARY 25.25.25.1 21.21.21.1 178 0x80000003 0xefbc

0.0.0.11 ASBR_SUMMARY 192.100.2.3 192.100.2.3 1412 0x80000002 0xa85d

N/A AS_EXTERNAL 10.15.228.0 25.25.25.1 1014 0x8000000e 0xea43

N/A AS_EXTERNAL 12.12.12.0 25.25.25.1 268 0x80000003 0x433a



N/A AS_EXTERNAL 25.25.25.0 25.25.25.1 1761 0x80000005 0x3d8d

N/A AS_EXTERNAL 201.201.203.0 10.15.231.186 3600 0x80000001 0x6690

N/A AS_EXTERNAL 201.201.203.0 192.100.2.3 1104 0x80000002 0xe4a2

N/A AS_EXTERNAL 202.202.202.0 25.25.25.1 268 0x80000003 0x4385

(host) [mynode]#show ip ospf neighbor

OSPF Neighbor Table

-------------------

Neighbor ID Pri State Address Interface

----------- --- ----- ------- ---------

21.21.21.1 1 FULL/DR 21.21.21.1 Vlan

Configuring DOWN Managed Device
interface vlan 22

ip address 22.22.22.2 255.255.255.0

ip ospf area 0.0.0.10

!

router ospf

router ospf area 0.0.0.10 nssa

router ospf redistribute rapng-vpn

!

The following commands display the configuration and run time protocol details on the DOWN managed
device:

(host) [mynode]#show ip route

Codes: C - connected, O - OSPF, R - RIP, S - static

M - mgmt, U - route usable, * - candidate default, V - RAPNG VPN

Gateway of last resort is Imported from DHCP to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from CELL to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from PPPOE to network 0.0.0.0 at cost 10

O 0.0.0.0/0 [1/0] via 22.22.22.1*

S 10.0.0.0/8 [1/0] via 10.15.231.177*

O 10.15.228.0/27 [333/0] via 22.22.22.1*

V 12.12.12.0/25 [10/0] ipsec map

O 21.21.21.0/24 [3/0] via 22.22.22.1*

O 23.23.23.0/24 [2/0] via 22.22.22.1*

O 25.25.25.0/24 [333/0] via 22.22.22.1*

V 202.202.202.0/29 [10/0] ipsec map

C 192.100.2.0/24 is directly connected, VLAN2

C 10.15.231.176/29 is directly connected, VLAN1

C 22.22.22.0/24 is directly connected, VLAN22

C 4.4.0.2/32 is an ipsec map 10.15.149.35-4.4.0.2

C 4.4.0.1/32 is an ipsec map 10.17.87.126-4.4.0.1

(host) [mynode]#show ip ospf neighbor

OSPF Neighbor Table

-------------------

Neighbor ID Pri State Address Interface

----------- --- ----- ------- ---------

25.25.25.1 1 FULL/BDR 22.22.22.1 Vlan 22

(host) [mynode]#show ip ospf database

OSPF Database Table

-------------------

Area ID LSA Type Link ID Adv Router Age Seq# Checksum

------- -------- ------- ---------- --- ---- --------

0.0.0.10 ROUTER 25.25.25.1 25.25.25.1 1736 0x80000021 0xb732

0.0.0.10 ROUTER 192.100.2.2 192.100.2.2 500 0x80000005 0x9ad9

0.0.0.10 NETWORK 22.22.22.2 192.100.2.2 500 0x80000004 0x8aeb
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0.0.0.10 IPNET_SUMMARY 21.21.21.0 25.25.25.1 1990 0x80000003 0xe7bf

0.0.0.10 IPNET_SUMMARY 23.23.23.0 25.25.25.1 1990 0x80000003 0x950d

0.0.0.10 NSSA 0.0.0.0 25.25.25.1 725 0x80000002 0xaab9

0.0.0.10 NSSA 10.15.228.0 25.25.25.1 1228 0x80000010 0xca5f

0.0.0.10 NSSA 12.12.12.0 192.100.2.2 352 0x80000005 0xe8cb

0.0.0.10 NSSA 25.25.25.0 25.25.25.1 1485 0x80000006 0x1fa8

0.0.0.10 NSSA 202.202.202.0 192.100.2.2 352 0x80000005 0xe817

N/A AS_EXTERNAL 12.12.12.0 192.100.2.2 352 0x80000005 0x28d8

N/A AS_EXTERNAL 202.202.202.0 192.100.2.2 352 0x80000005 0x2824

Viewing the Status of Instant AP VPN

RAPNG AP-1
(host) [mynode]# show vpn status

profile name:default

--------------------------------------------------

current using tunnel :primary tunnel

ipsec is preempt status :disable

ipsec is fast failover status :disable

ipsec hold on period :600

ipsec tunnel monitor frequency (seconds/packet) :5

ipsec tunnel monitor timeout by lost packet cnt :2

ipsec primary tunnel crypto type :Cert

ipsec primary tunnel peer address :10.15.231.186

ipsec primary tunnel peer tunnel ip :192.100.2.3

ipsec primary tunnel ap tunnel ip :5.5.0.2

ipsec primary tunnel current sm status :Up

ipsec primary tunnel tunnel status :Up

ipsec primary tunnel tunnel retry times :2

ipsec primary tunnel tunnel uptime :1 hour 24 minutes 50 seconds

ipsec backup tunnel crypto type :Cert

ipsec backup tunnel peer address :10.15.231.178

ipsec backup tunnel peer tunnel ip :0.0.0.0

ipsec backup tunnel ap tunnel ip :0.0.0.0

ipsec backup tunnel current sm status :Init

ipsec backup tunnel tunnel status :Down

ipsec backup tunnel tunnel retry times :0

ipsec backup tunnel tunnel uptime :0

(host)# show datapath route

Route Table Entries

-------------------

Flags: L - Local, P - Permanent, T - Tunnel, I - IPsec, M - Mobile, A - ARP, D - Drop

IP Mask Gateway Cost VLAN Flags

--------------- --------------- --------------- ---- ---- -----

0.0.0.0 0.0.0.0 10.15.149.25 0 0

0.0.0.0 128.0.0.0 192.100.2.3 0 0 T

128.0.0.0 128.0.0.0 192.100.2.3 0 0 T

192.168.10.0 255.255.254.0 192.168.10.1 0 3333 D

201.201.203.0 255.255.255.192 0.0.0.0 0 103 LP

10.15.149.24 255.255.255.248 10.15.149.30 0 1 L

10.15.231.186 255.255.255.255 10.15.149.25 0 0

Route Cache Entries

-------------------

Flags: L - local, P - Permanent, T - Tunnel, I - IPsec, M - Mobile, A - ARP, D - Drop

IP MAC VLAN Flags

--------------- ----------------- ----------- -----

202.202.202.6 00:00:00:00:00:00 0 T

192.100.2.3 00:00:00:00:00:00 0 PT

192.168.10.51 10:40:F3:98:80:94 1 PA

192.168.10.1 00:24:6C:C9:27:A3 3333 LP

201.201.203.8 00:26:C6:52:6B:14 103



201.201.203.1 00:24:6C:C9:27:A3 103 LP

10.1.1.50 00:00:00:00:00:00 0 T

5.5.0.2 00:24:6C:C9:27:A3 1 LP

10.15.149.30 00:24:6C:C9:27:A3 1 LP

10.15.149.25 00:0B:86:40:93:00 1 A

(host)# show clients

Client List

-----------

Name IP Address MAC Address OS Network Access Point Channel Type Role

Signal Speed (mbps)

---- ---------- ----------- -- ------- ------------ ------- ---- ----

------ ------------

201.201.203.8 00:26:c6:52:6b:14 149.30 00:24:6c:c9:27:a3 48- AN 149.30 43

(good) 6(poor)

Info timestamp :80259

RAPNG AP-3
(host) [mynode]# show vpn status

profile name:default

--------------------------------------------------

current using tunnel :primary tunnel

ipsec is preempt status :disable

ipsec is fast failover status :disable

ipsec hold on period :600

ipsec tunnel monitor frequency (seconds/packet) :5

ipsec tunnel monitor timeout by lost packet cnt :2

ipsec primary tunnel crypto type :Cert

ipsec primary tunnel peer address :10.15.231.178

ipsec primary tunnel peer tunnel ip :192.100.2.2

ipsec primary tunnel ap tunnel ip :4.4.0.2

ipsec primary tunnel current sm status :Up

ipsec primary tunnel tunnel status :Up

ipsec primary tunnel tunnel retry times :13

ipsec primary tunnel tunnel uptime :1 hour 55 minutes 6 seconds

ipsec backup tunnel crypto type :Cert

ipsec backup tunnel peer address :10.15.231.186

ipsec backup tunnel peer tunnel ip :0.0.0.0

ipsec backup tunnel ap tunnel ip :0.0.0.0

ipsec backup tunnel current sm status :Init

ipsec backup tunnel tunnel status :Down

ipsec backup tunnel tunnel retry times :0

ipsec backup tunnel tunnel uptime :0

(host) [mynode]# show datapath route

Route Table Entries

-------------------

Flags: L - Local, P - Permanent, T - Tunnel, I - IPsec, M - Mobile, A - ARP, D - Drop

IP Mask Gateway Cost VLAN Flags

--------------- --------------- --------------- ---- ---- -----

0.0.0.0 0.0.0.0 10.15.149.33 0 0

0.0.0.0 128.0.0.0 192.100.2.2 0 0 T

128.0.0.0 128.0.0.0 192.100.2.2 0 0 T

192.168.10.0 255.255.254.0 192.168.10.1 0 3333 D

10.15.149.32 255.255.255.248 10.15.149.35 0 1 L

202.202.202.0 255.255.255.248 0.0.0.0 0 203 LP

10.15.231.178 255.255.255.255 10.15.149.33 0 0

Route Cache Entries

-------------------

Flags: L - local, P - Permanent, T - Tunnel, I - IPsec, M - Mobile, A - ARP, D - Drop

IP MAC VLAN Flags
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--------------- ----------------- ----------- -----

202.202.202.1 00:24:6C:C0:41:F2 203 LP

202.202.202.6 08:ED:B9:E1:51:7B 203

192.100.2.2 00:00:00:00:00:00 0 PT

192.168.10.1 00:24:6C:C0:41:F2 3333 LP

201.201.203.8 00:00:00:00:00:00 0 T

10.1.1.50 00:00:00:00:00:00 0 T

192.168.11.7 00:26:C6:52:6B:14 1 PA

4.4.0.2 00:24:6C:C0:41:F2 1 LP

10.13.6.110 00:00:00:00:00:00 0 T

10.15.149.38 00:24:6C:C9:27:CC 1 A

10.15.149.35 00:24:6C:C0:41:F2 1 LP

10.15.149.33 00:0B:86:40:93:00 1 A

(host) [mynode]# show clients

Client List

-----------

Name IP Address MAC Address OS Network Access Point Channel Type Role

Signal Speed (mbps)

---- ---------- ----------- -- ------- ------------ ------- ---- ----

------ ------------

202.202.202.6 08:ed:b9:e1:51:7b 149.35 00:24:6c:c0:41:f2 48- AN 149.35 53

(good) 48(poor)

Info timestamp :80748
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Chapter 9
Tunneled Nodes

This chapter describes how to configure an Aruba tunneled node, also known as a wired tunneled node. Aruba
tunneled nodes provide access and security using an overlay architecture.

This chapter describes the following topics:

l Understanding Tunneled Node Configuration on page 171

l Configuring a Wired Tunneled Node Client on page 172

Understanding Tunneled Node Configuration
The Aruba tunneled node connects to one or more client devices at the edge of the network and then
establishes a secure GRE tunnel to the controlling concentrator server. This approach allows the managed
device to support all the centralized security features, such as 802.1X authentication, captive-portal
authentication, and stateful firewall. The Aruba tunneled node is required to handle only the physical
connection to clients and support for its end of the GRE tunnel.

To support the wired concentrator, the managed device must have a license to terminate access points (APs).
No other configuration is required. To configure the Aruba tunneled node, you must specify the IP address of
the managed device and identify the ports that are to be used as active tunneled node ports. Tunnels are
established between the managed device and each active tunneled node port on the tunneled node. All
tunneled node units must be running the same version of software. The tunneled node port can also be
configured as a trunk port. This allows customers to have multiple clients on different VLANs that come
through the trunk port instead of having clients on a single VLAN.

Figure 23 shows how the tunneled node fits into network operations. Traffic moves through GRE tunnels
between the active tunneled node ports and the managed device. Policies are configured on the managed
device and enforced the enforced on the managed device can run on the same or different systems.

On the managed device, you can assign the same policy to tunneled node user traffic as you would to any
untrusted wired traffic. The profile specified by the aaa authentication wired command determines the
initial role, which contains the policy. The VLAN setting on the concentrator port must match the VLAN that will
be used for users at the local controller.
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Figure 23 Tunneled Node Configuration Operation

Configuring a Wired Tunneled Node Client
ArubaOS does not allow a tunneled-node client and tunneled-node server to co-exist on the same managed device at
the same time. The managed device must be configured as either a tunneled-node client or a tunneled-node server.
By default, the managed device behaves as a tunneled-node server. However, once tunneled-node-server
xxx.xxx.xxx.xxx is configured on the managed device, the managed device becomes a tunneled-node client. To
remove the tunneled-node client function, use the command tunneled-node-server 0.0.0.0 to disable the tunneled-
node client on the managed device.

This section describes how to configure a tunneled node client. You can use the WebUI or the CLI to complete
the configuration steps.

1. Access the Wired tunneled node CLI according to the instructions provided in the installation guide that
shipped with your tunneled node. Console access (9600 8N1) and SSH access are supported.

2. Specify the IP address of the managed device and specify tunnel loop prevention.

n CLI:
(mynode)(config) #tunneled-node-address ipaddress

(mynode)(config) #tunnel-loop-prevention

3. Access each interface that you want to use, and assign it as a tunneled node port.



(mynode(config) #

interface fastethernet

n

/m

(mynode(config-if) #

tunneled-node port

4. Verify the configuration.
(mynode) (config-if) #

exit

(mynode) # show tunneled-port config

Configuring an Access Port as a Tunneled Node Port
You can configure any port on any managed device as a tunneled node port using the tunneled-node-port
command. Set the tunneled-nod -address as the managed device to act as the tunneled node termination
point. The tunneled-node-port command tells the physical interface to tunnel that traffic to the managed
device.

1. Enable portfast on the Wired tunneled node.
(mynode)(config) #interface fastethernet <slot/module/<port>

(mynode) (config-if) # spanning-tree portfast

2. Assign a VLAN to the tunneled node port.
(mynode) (config-if) # switchport mode access

(mynode) (config-if) # switchport access vlan <vlanid>

Configuring a Trunk Port as a Tunneled Node Port
To enable portfast on the Wired tunneled node execute the following commands:

l (mynode) (config-if) # switchport mode trunk

l (mynode) (config-if) # switchport trunk allowed vlan <WORD>

To verify the status of the Wired tunneled node execute the following command:

l (mynode) # show tunneled-node state

l (mynode) # show tunneled-node config

To check the current usage on the managed device execute the following command. Each tunneled node client
uses one AP license. Attaching an additional wired client on the tunneled node client does not increment the AP
license usage on the managed device.

l (mynode) # show license-usage ap
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Chapter 10
Authentication Servers

The ArubaOS software allows you to use an external authentication server or the Mobility Master's internal
user database to authenticate clients who need to access the wireless network.

Authentication Server Overviews
The following sections provide a general overview of the Mobility Master authentication server management:

l Understanding Authentication Server Best Practices and Exceptions on page 174

l Understanding Servers and Server Groups on page 174

Configuring Authentication Servers and Server Groups
The following topics describe the procedures to create and manage external and internal authentication
servers and server groups.

l Configuring Authentication Servers on page 175

l Managing the Internal Database on page 184

l Configuring Server Groups on page 185

l Assigning Server Groups on page 191

l Configuring Authentication Timers on page 195

l Authentication Server Load Balancing on page 197

Understanding Authentication Server Best Practices and
Exceptions
l For an external authentication server to process requests from Mobility Master, you must configure the

server to recognize the Mobility Master. Refer to the vendor documentation for information on configuring
the authentication server.

l To configure Microsoft’s IAS and Active Directory, see the following links:

n http://technet2.microsoft.com/windowsserver/en/technologies/ias.mspx

n http://www.microsoft.com/en-us/server-cloud/windows-server/active-directory.aspx

Understanding Servers and Server Groups
Mobility Master supports the following external authentication servers:

l RADIUS (Remote Authentication Dial-In User Service)

l LDAP (Lightweight Directory Access Protocol)

l TACACS+ (Terminal Access Controller Access Control System)

l Windows (For stateful NTLM authentication)

A maximum of 128 LDAP, RADIUS, and TACACS servers, each can be configured on a managed device.

Additionally, you can use the internal database to authenticate users by creating entries for users, their
passwords, and their default role.

http://technet2.microsoft.com/windowsserver/en/technologies/ias.mspx
http://technet2.microsoft.com/windowsserver/en/technologies/ias.mspx
http://www.microsoft.com/en-us/server-cloud/windows-server/active-directory.aspx
http://www.microsoft.com/en-us/server-cloud/windows-server/active-directory.aspx
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You can create groups of servers for specific types of authentication. For example, you can specify one or more
RADIUS servers to be used for 802.1X authentication. The list of servers in a server group is an ordered list.
This means that the first server in the list is always used unless it is unavailable, in which case the next server in
the list is used. You can configure servers of different types in one group. For example, you can include the
internal database as a backup to a RADIUS server.

Figure 24 represents a server group named “Radii” that consists of two RADIUS servers, Radius-1 and Radius-2.
The server group is assigned to the server group for 802.1X authentication.

Figure 24 Server Group

Server names are unique. You can configure the same server in multiple server groups. You must configure the
server before you can add it to a server group.

If you use the internal database for user authentication, use the predefined “Internal” server group.

You can also include conditions for server-derived user roles or VLANs in the server group configuration. The
server derivation rules apply to all servers in the group.

Configuring Authentication Servers
This section describes how to configure RADIUS, LDAP, TACACS+ and Windows external authentication servers
and the internal database.

This section includes the following information:

l Configuring a RADIUS Server on page 176

l RADIUS Service-Type Attribute on page 177

l Enabling Radsec on RADIUS Servers on page 178

l Configuring Username and Password for ClearPass Policy Manager Authentication on page 180

l Configuring an RFC-3576 RADIUS Server on page 180

l Configuring an LDAP Server on page 181

l Configuring a TACACS+ Server on page 182

l Configuring a Windows Server on page 184



Configuring a RADIUS Server
Follow the procedures below to configure a RADIUS server using the WebUI or CLI.

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers tab.

2. In the All Servers table, click + to add a new server.

3. Enter a name for the new server.

4. Enter the IP address for the new server.

5. Select RADIUS from the Type drop-down list.

6. Click Apply.

7. In the All Servers table, select the name of the new RADIUS server to configure server parameters.

8. Enter the parameters as described in Table 26. Set Mode to Enabled to activate the authentication server.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

The configuration does not take effect until you perform this step.

Using the CLI
(host) [mynode] (config) #aaa authentication-server radius <name>

host <ipaddr>

key <psk>

enable

Parameter Description

IP address IP address or fully qualified domain name (FQDN) of the authentication
server. The maximum supported FQDN length is 63 characters.

Default: N/A

Auth Port Authentication port of this server.

Default: 1812

Acct Port Accounting port of this server.

Default: 1813

Shared key Shared secret between the managed device and the authentication server.
The maximum length is 128 characters.

Default: N/A

Timeout Maximum time, in seconds, that the managed device waits before timing out
the request and resending it.

Default: 5 seconds

Table 26: RADIUS Server Configuration Parameters
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Parameter Description

Retransmits Maximum number of retries sent to the server by the managed device
before the server is marked as down.

Default: 3

NAS ID Network Access Server (NAS) identifier to use in RADIUS packets.

NAS IP The NAS IP address to be sent in RADIUS packets from that server.

NOTE: If you define a local NAS IP using the Configuration > Security >
Authentication > Servers page and also define a global NAS IP using the
Configuration > Security > Authentication > Advanced page, the global
NAS IP address takes precedence.

Enable IPv6 Enable or disable IPv6 for this server.

Default: Disabled

NAS IPv6 The NAS IPv6 address to be sent in RADIUS packets.

Use MD5 Use MD5 hash of cleartext password.

Default: Disabled

Mode Enables or disables the server.

Default: Enabled

Lowercase MAC
addresses

Send MAC address with lowercase in the authentication and accounting
requests to this server.

Default: Disabled

Use IP address for calling
station ID

Enables or disables using the IP address for the calling station ID.

Default: Disabled

MAC address delimiter Send MAC address with the following delimiters in the authentication and
accounting requests of this server:

l colon: Send MAC address as XX:XX:XX:XX:XX:XX

l dash: Send MAC address as XX-XX-XX-XX-XX-XX

l none: Send MAC address as XXXXXXXXXXXX

l oui-nic: Send MAC address as XXXXXX-XXXXXX

Default: none

Service-type of FRAMED-
USER

Send the service-type as FRAMED-USER instead of LOGIN-USER. For more
information, see RADIUS Service-Type Attribute on page 177.

Default: Disabled

RADIUS Service-Type Attribute
Managed devices send the following Service-Type attribute values for RADIUS authentication requests.



RADIUS Attribute Authentication Type Attribute Value

Service-Type MAC Call-Check

802.1X Framed

Captive Portal Login

Table 27: RADIUS Service-Type Attributes

The service-type-framed-user configuration of the RADIUS server overwrites all the attribute values to Framed
irrespective of the authentication type. Existing deployments that depend upon this attribute for their third-
party RADIUS integrations should make changes to support these new service types.

Enabling Radsec on RADIUS Servers
Conventional RADIUS protocol offers limited security. This level of limited security is not sufficient for
authentication that takes place across unsecured networks such as the Internet. To address this, the
RADIUS over TLS or Radsec enhancement is introduced to ensure RADIUS authentication and accounting data
is transmitted safely and reliably across insecure networks. The default destination port for RADIUS over TLS is
TCP/2083. Separate ports are not used for authentication, accounting, and dynamic authorization changes.

In a TLS connection, both the managed device (TLS client) and the Radsec server (TLS server) need to
authenticate each other using certificates. For the managed device to authenticate the Radsec server:

l The Certificate Authority (CA) certificate should be uploaded as a Trusted CA if the Radsec server uses a
certificate signed by a CA.

l Self-signed certificates should be uploaded as a PublicCert if the Radsec server uses a self-signed
certificate.

If neither of these certificates are configured, the managed device does not try to establish any connection with the
Radsec server, even if Radsec is enabled.

The managed device must also send a TLS client certificate to the Radsec server by uploading a certificate on
Mobility Master as ServerCert and configuring Radsec to accept and use the certificate. If a certificate is not
configured, Mobility Master uses the device certificate in its Trusted Platform Module (TPM). In this case, the
Aruba device CA that signed the certificate should be configured as a Trusted CA on the Radsec server.

When Radsec support is enabled, the default RADIUS shared key is radsec and remains the same even if the user
configures a different shared key.

In the CLI
(host) [mynode] (config) #aaa authentication-server radius <rad_server_name>

enable-radsec

radsec-client-cert-name <name>

radsec-port <radsec-port>

radsec-trusted-cacert-name <radsec-trusted-ca>

radsec-trusted-servercert-name <name>

To upload certificates through the CLI, see Importing Certificates.

To configure a Radsec server as RFC 3576 server for dynamic authorization (CoA), see Configuring an RFC-3576
RADIUS Server on page 180.
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RADIUS Server VSAs
Vendor-Specific Attributes (VSAs) are a method for communicating vendor-specific information between
Network Access Servers and RADIUS servers, allowing vendors to support their own extended attributes. You
can use Aruba VSAs to derive the user role and VLAN for RADIUS-authenticated clients; however the VSAs must
be present on your RADIUS server. This requires that you update the RADIUS dictionary file with the vendor
name (Aruba) and/or the vendor-specific code (14823), the vendor-assigned attribute number, and the
attribute format (such as string or integer) for each VSA. For more information on VSA-derived user roles, see
Configuring a VSA-Derived Role on page 378

For the current and complete list of all RADIUS VSAs available in the version of ArubaOS currently running on
your Mobility Master, access the command-line interface and issue the command show aaa radius-
attributes.

RADIUS Server Authentication Codes
A configured RADIUS server returns the following standard response codes.

Code Description

0 Authentication OK.

1 Authentication failed : user/password combination not correct.

2 Authentication request timed out : No response from server.

3 Internal authentication error.

4 Bad Response from RADIUS server : verify shared secret is correct.

5 No RADIUS authentication server is configured.

6 Challenge from server. (This does not necessarily indicate an error condition.)

Table 28: RADIUS Authentication Response Codes

RADIUS Server Fully Qualified Domain Names
If you define a RADIUS server using the FQDN of the server rather than its IP address, the managed device
periodically generates a DNS request and caches the IP address returned in the DNS response. To view the IP
address that currently correlates to each RADIUS server FQDN, access the command-line interface in config
mode and issue the show aaa fqdn-server-names command.

DNS Query Intervals
If you define a RADIUS server using the FQDN of the server rather than its IP address, the managed device
periodically generates a DNS request and caches the IP address returned in the DNS response. DNS requests
are sent every 15 minutes by default.

You can use either the WebUI or the CLI to configure how often a DNS request is generated to cache the IP
address for a RADIUS server identified via its fully qualified domain name (FQDN).

Using the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Advanced
page.



2. Under DNS Query Interval, enter a new DNS query interval, from 1-1440 minutes, in the DNS Query
Interval (min) field.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

Using the CLI
(host) [mynode] (config) #aaa dns-query-interval <minutes>

Configuring Username and Password for ClearPass Policy Manager
Authentication
Authentication to ClearPass Policy Manager is enhanced to use configurable usernames and passwords instead
of a support password. The support password is vulnerable to attacks as the server certificate presented by
ClearPass Policy Manager server is not validated.

Configuring an RFC-3576 RADIUS Server
You can configure a RADIUS server to send user disconnect, change-of-authorization (CoA), and session
timeout messages as described in RFC 3576, “Dynamic Authorization Extensions to Remote Dial In User Service
(RADIUS).”

For Remote AP, RADIUS CoA is supported on tunnel and split-tunnel forwarding modes only.

For Campus AP, RADIUS CoA is supported on tunnel and decrypt-tunnel forwarding modes only.

The disconnect, session timeout, and change-of-authorization messages sent from the server to a managed
device contains information to identify the user for which the message is sent. Mobility Master supports the
following attributes for identifying the users who authenticate with an RFC 3576 server:

l user-name: name of the user to be authenticated

l framed-ip-address: user’s IP address

l calling-station-id: phone number of a station that originated a call

l accounting-session-id: unique accounting ID for the user session.

If the authentication server sends both supported and unsupported attributes to a managed device, the
unknown or unsupported attributes are ignored. If no matching user is found, a 503: Session Not Found error
message is sent back to the RFC 3576 server.

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. To define a new RFC 3576 RADIUS server click + under All Servers. Set the Type to RFC and enter the IP
address for the server. Click Apply.

3. Select the server from the All Servers list to configure server parameters.

4. Enter the server authentication key into the Key and Retype keyfields.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.
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The configuration does not take effect until you perform this step.

Using the CLI
(host) [mynode] (config) #aaa rfc-3576-server <ipaddr>

clone <sourse>

key <psk>

no ...

Configuring an RFC-3576 RADIUS Server with Radsec

Using the CLI
(host) [mynode] (config) #aaa rfc-3576-server <ipaddr>

enable-radsec

no ...

Configuring an LDAP Server
Table 29 describes the parameters you configure for an LDAP server.

Parameter Description

Host IP address of the LDAP server.

Default: N/A

Admin-DN Distinguished name for the admin user who has read/search privileges across all
the entries in the LDAP database (the user does need write privileges, but will be
able to search the database, and read attributes of other users in the database).

Admin Password Password for the admin user.

Default: N/A

Allow Clear-Text Allows clear-text (unencrypted) communication with the LDAP server.

Default: disabled

Authentication Port Port number used for authentication.

Default: 389

Base-DN Distinguished Name of the node that contains the entire user database.

Default: N/A

Filter A string searches for users in the LDAP database. The default filter string is:
(objectclass=*).

Default: N/A

Key Attribute A string searches for a LDAP server. For Active Directory, the value is
sAMAccountName.

Table 29: LDAP Server Configuration Parameters



Parameter Description

Default: sAMAccountName

Timeout Timeout period of a LDAP request, in seconds.

Default: 20 seconds

Mode Enables or disables the server.

Default: enabled

Preferred
Connection Type

Preferred type of connection between a managed device and the LDAP server. The
default order of connection type is:

1. ldap-s
2. start-tls
3. clear-text
The managed device first attempts to contact the LDAP server using the preferred
connection type, and only attempts to use a lower-priority connection type if the
first attempt is not successful.

NOTE: If you select clear-text as the preferred connection type, you must also
enable the allow-cleartext option.

Maximum number
of non-admin
connections

Configure the maximum number of non-admin connections to the server.

Default: 4

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. To configure an LDAP server, click + under All Servers. Set the Type to Ldap, enter the Name for the
server, and enter the IP address. Click Apply.

3. Select the name to configure server parameters. Enter parameters as described in Table 29. Set Mode to
Enabled to activate the authentication server.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

The configuration does not take effect until you perform this step.

Using the CLI
(host) [mynode] (config) #aaa authentication-server ldap <name>

host <ipaddr>

(enter parameters as described in Table 29)
enable

Configuring a TACACS+ Server
Table 30 defines the TACACS+ server parameters.
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Parameter Description

Host IP address of the server.

Default: N/A

Key Shared secret to authenticate communication between the TACACS+ client and
server.

Default: N/A

TCP Port TCP port used by server.

Default: 49

Retransmits Maximum number of times a request is retried.

Default: 3

Timeout Timeout period for TACACS+ requests, in seconds.

Default: 20 seconds

Mode Enables or disables the server.

Default: enabled

Session
Authorization

Enables or disables session authorization. Session authorization turns on the
optional authorization session for admin users.

Default: disabled

Table 30: TACACS+ Server Configuration Parameters

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. To configure a TACACS+ server, click + under All Servers. Set the Type to Tacacs, enter the Name for the
server, and enter the IP address. Click Apply.

3. Select the name to configure server parameters. Enter parameters as described in Table 30. Set the Mode
to Enabled to activate the authentication server.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

The configuration does not take effect until you perform this step.

Using the CLI
The following command configures, enables a TACACS+ server and enables session authorization:
(host) [mynode] (config) #aaa authentication-server tacacs <name>

clone default

host <ipaddr>

key <psk>

enable



session-authorization

Configuring a Windows Server
Table 31 defines parameters for a Windows server used for stateful NTLM authentication.

Parameter Description

Host IP address of the server.

Default: N/A

Mode Enables or disables the server.

Default: enabled

Windows Domain Name of the Windows Domain assigned to the server.

Table 31: Windows Server Configuration Parameters

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. To configure a Windows server, click + under All Servers. Set the Type to Windows, enter the Name for
the server, and enter the IP address. Click Apply.

3. Select the name of the server to configure its parameters. Enter the parameters as described in Table 31.

4. Set the Mode to Enabled to activate the authentication server.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

The configuration does not take effect until you perform this step.

Using the CLI
(host) [mynode] (config) #aaa authentication-server windows <windows-server-name>

host <ipaddr>

enable

Managing the Internal Database
You can create entries in the internal database to authenticate clients. The internal database contains a list of
clients, along with the password and default role for each client. When you configure the internal database as
an authentication server, client information is checked in incoming authentication requests against the internal
database.

Configuring the Internal Database
Mobility Master uses the internal database for authentication by default. You can choose to use the internal
database in a managed device by entering the CLI command aaa authentication-server internal use-
local-switch. If you use the internal database in a managed device, you need to add clients on the managed
device.
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Using the CLI
Enter the following command in enable mode:
(host) [mynode] #local-userdb add {generate-username|username <name>}{

generate-password|password <password>}

Managing Internal Database Files
Mobility Master allows you to import and export user information tables to and from the internal database.
These files should not be edited once they are exported. Mobility Master only supports the importing of
database files that were created during the export process. Note that importing a file into the internal database
overwrites and removes all existing entries.

Exporting and Importing Files in the CLI
Enter the following command in enable mode:
(host) [mynode] #local-userdb export <filename>

(host) [mynode] #local-userdb import <filename>

Configuring Server Groups
You can create groups of servers for specific types of authentication – for example, you can specify one or
more RADIUS servers to be used for 802.1X authentication. You can configure servers of different types in one
group. For example, you can include the internal database as a backup to a RADIUS server.

Configuring Server Groups
Server names are unique. You can configure the same server in more than one server group. You must
configure the server before you can include it in a server group.

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. The Server Groups table displays the server group list.

3. Click +. Enter the name of the new server group and click Apply.

4. Select the new server group.

5. Under All Servers, click + to add a server to the group.

a. To add an existing server, select Add existing server and choose a server from the list. Click Apply.

b. To add a new server, select Add new server. Specify a server type from the Type drop-down list, and
enter a name and IP address for the server. Click Apply.

c. Repeat the above step(s) to add other servers to the group.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

Using the CLI
(host) [mynode] (config) #aaa server-group <name>

auth-server <name>



Configuring Server List Order and Fail-Through
The servers in a server group are part of an ordered list. The first server in the list is always used by default,
unless it is unavailable, in which case the next server in the list is used. You can configure the order of servers in
the server group through the WebUI using the up or down arrows (the top server is the first server in the list).
In the CLI, the position parameter specifies the relative order of servers in the list (the lowest value denotes
the first server in the list).

As mentioned previously, the first available server in the list is used for authentication. If the server responds
with an authentication failure, there is no further processing for the user or client for which the authentication
request failed. You can also enable fail-through authentication for the server group so that if the first server in
the list returns an authentication deny, the managed device attempts authentication with the next server in
the ordered list. The managed device attempts to authenticate with each server in the list until there is a
successful authentication or the list of servers in the group is exhausted. This feature is useful in environments
where there are multiple, independent authentication servers; users may fail authentication on one server but
can be authenticated on another server.

Before enabling fail-through authentication, note the following:

l This feature is not supported for 802.1X authentication with a server group that consists of external EAP-
compliant RADIUS servers. You can, however, use fail-through authentication when the 802.1X
authentication is terminated on a managed device (AAA FastConnect).

l Enabling this feature for a large server group list may cause excess processing load on the managed device.
It is recommended that you use server selection based on domain matching whenever possible (see
Configuring Dynamic Server Selection on page 187).

l Certain servers, such as the RSA RADIUS server, lock out the managed device if there are multiple
authentication failures. Therefore, you should not enable fail-through authentication with these servers.

In the following example, you create a server group "corp-serv" with two LDAP servers (ldap-1 and ldap-2), each
containing a subset of the usernames and passwords used in the network. When you enable fail-through
authentication, users that fail authentication with the first server on the list will be authenticated with the
second server.

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. The All Servers table displays the LDAP server list.

3. Click +. Enter ldap-1 for the server name, enter the IP address for the server, and select Ldap from the Type
drop-down list. Click Apply.

4. Click +. Enter ldap-2 for the server name, enter the IP address for the server, and select Ldap from the Type
drop-down list. Click Apply.

5. Under All Servers, select ldap-1 to configure server parameters. Set the Mode to Enabled to activate the
authentication server.

6. Click Submit.

7. Repeat step 5 on page 186 to configure ldap-2.

8. Click + under the Server Groups table to add a new server group. Set the server group name to corp-serv,
and then click Apply.

9. Select corp-serv from the Server Groups table to configure the server group settings.

10.Navigate to the Options tab.

11.Set Fail through to Enabled.

12.Click Submit.
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13.Navigate to the Servers tab.

14.Click + to add a server to the group.

a. Select ldap-1, and then click Apply.

b. Repeat the step above to add ldap-2 to the server group.

15.Click Submit.

16.Click Pending Changes.

17.In the Pending Changes window, select the check box and click Deploy changes.

Using the CLI
(host)[mynode] (config) #aaa authentication-server ldap ldap-1

host 10.1.1.234

(host) [mynode] (config) #aaa authentication-server ldap ldap-2

host 10.2.2.234

(host) [mynode] (config) #aaa server-group corp-serv

auth-server ldap-1 position 1

auth-server ldap-2 position 2

allow-fail-through

Configuring Dynamic Server Selection
Managed devices can dynamically select an authentication server from a server group based on the user
information sent by the client in an authentication request. For example, an authentication request can include
client or user information in one of the following formats:

l <domain>\<user> : for example, corpnet.com\darwin

l <user>@<domain> : for example, darwin@corpnet.com

l host/<pc-name>.<domain> : for example, host/darwin-g.finance.corpnet.com (this format is used with
802.1X machine authentication in Windows environments)

When you configure a server in a server group, you have the option to associate the server with one or more
match rules. A match rule for a server can be one of the following:

l The server is selected if the client/user information contains a specified string.

l The server is selected if the client/user information begins with a specified string.

l The server is selected if the client/user information exactly matches a specified string.

You can configure multiple match rules for the same server. Managed devices compare the client/user
information with the match rules configured for each server, starting with the first server in the server group. If
a match is found, the managed device sends the authentication request to the server with the matching rule. If
no match is found before the end of the server list is reached, an error is returned, and no authentication
request for the client/user is sent.

Figure 25 depicts a network consisting of several subdomains in corpnet.com. The server radius-1 provides
802.1X machine authentication to PC clients in xyz.corpnet.com, sales.corpnet.com, and hq.corpnet.com. The
server radius-2 provides authentication for users in abc.corpnet.com.



Figure 25 Domain-Based Server Selection Example

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. Under the Server Groups table, select a server group.

3. Under the Server Group > [server group name] > Server Rules tab, click +.

a. Select an attribute from the Attribute drop-down list.

b. Select an Operation to apply a condition to the attribute.

c. Set the Operand value to the client or user information.

d. Click Apply.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
(host) [mynode] (config) #aaa server-group <group>

auth-server <name> [match-authstring contains|equals|starts-with <string>] [match-fqdn

<string>] [position <number>] [trim-fqdn]

Configuring Match FQDN Option
You can also use the “match FQDN (domain name)” option for a server rule. With this rule, the server is selected
if the <domain> portion of the user information in the formats <domain>\<user> or <user>@<domain>
matches a specified string exactly. Note the following caveats when using a match FQDN rule:

l This rule does not support client information in the host/<pc-name>.<domain> format, so it is not useful
for 802.1X machine authentication.

l The match FQDN option performs matches on only the <domain> portion of the user information sent in
an authentication request. The match-authstring option (described previously) allows you to match all or a
portion of the user information sent in an authentication request.
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Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. Under the Server Groups table, select a server group.

3. Under the Server Group > [server group name] > Server Rules tab, click +.

a. Select Domain-Name from the Attribute drop-down list.

b. Set the Operation to equals.

c. Set the Operand value to the client or user information.

d. Click Apply.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
(host) [mynode] (config) #aaa server-group <group>

auth-server <name> match-fqdn <string>

Trimming Domain Information from Requests
Before a managed device forwards an authentication request to a specified server, it can truncate the domain-
specific portion of the user information. This is useful when user entries on the authenticating server do not
include domain information. You can specify this option with any server match rule. This option is only
applicable when the user information is sent to the managed device in the following formats:

l <domain>\<user> : the <domain>\ portion is truncated

l <user>@<domain> : the @<domain> portion is truncated

This option does not support client information sent in the format host/<pc-name>.<domain>

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. Under the Server Groups table, select a server group.

3. Under Server Group > [server group name] > Servers, select a server or click + to add a new server to
the group.

a. To add an existing server, select Add existing server and choose a server from the list. Click Apply.

b. To add a new server, select Add new server. Specify a server type from the Type drop-down list, and
enter a name and IP address for the server. Click Apply.

4. Click Server Group Trim FQDN.

5. Set Trim FQDN to Enabled.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
(host) [mynode] (config) #aaa server-group <group>

auth-server <name> trim-fqdn



Configuring Server-Derivation Rules
When you configure a server group, you can set the VLAN or role for clients based on attributes returned for
the client by the server during authentication. The server derivation rules apply to all servers in the group. The
user role or VLAN assigned through server derivation rules takes precedence over the default role and VLAN
configured for the authentication method.

The authentication servers must be configured to return the attributes for the clients during authentication. For
instructions on configuring the authentication attributes in a Windows environment using IAS, refer to the
documentation at http://technet2.microsoft.com/windowsserver/en/technologies/ias.mspx

The server rules are applied based on the first match principle. The first rule that is applicable for the server and
the attribute returned is applied to the client, and would be the only rule applied from the server rules. These
rules are applied uniformly across all servers in the server group.

Table 32 describes the server rule parameters you can configure.

Parameter Description

Attribute This is the attribute returned by the authentication server that is examined for
Operation and Operand match.

Operation This is the match method by which the string in Operand is matched with the
attribute value returned by the authentication server.

l contains : The rule is applied if and only if the attribute value contains the
string in parameter Operand.

l starts-with : The rule is applied if and only if the attribute value returned
starts with the string in parameter Operand.

l ends-with : The rule is applied if and only if the attribute value returned
ends with the string in parameter Operand.

l equals : The rule is applied if and only if the attribute value returned equals
the string in parameter Operand.

l not-equals : The rule is applied if and only if the attribute value returned is
not equal to the string in parameter Operand.

l value-of : This is a special condition. What this implies is that the role or
VLAN is set to the value of the attribute returned. For this to be successful,
the role and the VLAN ID returned as the value of the attribute selected
must already be configured on the managed device when the rule is
applied.

Operand This is the string to which the value of the returned attribute is matched.

Action Defines whether to assign a role or a VLAN to the user when the rule is
matched.

Role or VLAN The server derivation rules apply to either user role or VLAN assignment. With
Role assignment, a client can be assigned a specific role based on the
attributes returned. In VLAN assignment, the client can be placed in a specific
VLAN based on the attributes returned.

Table 32: Server Rule Configuration Parameters
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Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. Under the Server Groups table, select a server group.

3. Under Server Group > [server group name] > Servers, select a server or click + to add a new server to
the group.

a. To add an existing server, select Add existing server and choose a server from the list. Click Apply.

b. To add a new server, select Add new server. Specify a server type from the Type drop-down list, and
enter a name and IP address for the server. Click Apply.

4. Under the Server Rules tab, click + to add server derivation rules for assigning a user role or VLAN.

a. Select the Attribute.

b. Select the Operation from the drop-down list.

c. Enter the Operand.

d. To set a role, select set role from the Action drop-down list. Select the role to be assigned from the
Role drop-down list.

e. To set a vlan, select set vlan from the Action drop-down list. Select the VLAN name or ID from the Vlan
drop-down list.

f. Click Apply.

g. Repeat the above steps to add other rules for the server group.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
(host) [mynode] (config) #aaa server-group <name>

(host) [mynode] (Server Group name) #set {role|vlan} condition <attribute> contains|ends-

with|equals|not-equals|starts-with <operand> set-value <set-value-str> position <number>

Configuring a Role Derivation Rule for the Internal Database
When you add a user entry to the internal database, you can specify a user role (see Managing the Internal
Database on page 184). The role specified in the internal database entry to be assigned to the authenticated
client, you must configure a server derivation rule as shown in the following:

Using the CLI
(host) [mynode] (config) #aaa server-group internal

set role condition Role value-of

Assigning Server Groups
You can create server groups for the following purposes:

l user authentication

l management authentication

l accounting

You can configure all types of servers for user and management authentication (see Table 33). Accounting is
only supported with RADIUS and TACACS+ servers when RADIUS or TACACS+ is used for authentication.



RADIUS TACACS+ LDAP Internal Database

User authentication Yes Yes Yes Yes

Management authentication Yes Yes Yes Yes

Accounting Yes Yes No No

Table 33: Server Types and Purposes

User Authentication
For information about assigning a server group for user authentication, refer to the Roles and Policies chapter
of the ArubaOS User Guide.

Management Authentication
Users who need to access Mobility Master to monitor, manage, or configure the Aruba user-centric network
can be authenticated with RADIUS, TACACS+, or LDAP servers or the internal database.

Only user record attributes are returned upon successful authentication. Therefore, to derive a
management role other than the default mgmt auth role, set the server derivation rule based on the user
attributes.

Using the CLI
(host)[mynode] (config) #aaa authentication mgmt

server-group <group>

enable

Accounting
You can configure accounting for RADIUS and TACACS+ server groups.

RADIUS or TACACS+ accounting is only supported when RADIUS or TACACS+ is used for authentication.

RADIUS Accounting
RADIUS accounting allows user activity and statistics to be reported from managed devices to RADIUS servers:

1. The managed device generates an Accounting Start packet when a user logs in. The code field of transmitted
RADIUS packet is set to 4 (Accounting-Request). Note that sensitive information, such as user passwords,
are not sent to the accounting server. The RADIUS server sends an acknowledgement of the packet.

2. The managed device sends an Accounting Stop packet when a user logs off; the packet information includes
various statistics such as elapsed time, input and output bytes, and packets. The RADIUS server sends an
acknowledgment of the packet.

The following attributes can be sent to a RADIUS accounting server:

l Acct-Status-Type: This attribute marks the beginning or end of accounting record for a user. Current
values are Start, Stop, and Interim Update.

l User-Name: Name of user.

l Acct-Session-Id: A unique identifier to facilitate matching of accounting records for a user. It is derived
from the user name, IP address, and MAC address. This is set in all accounting packets.
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l Acct-Authentic: This indicates how the user was authenticated. Current values are 1 (RADIUS), 2 (Local),
and 3 (LDAP).

l Acct-Session-Time: The elapsed time, in seconds, that the client was logged in to the managed device. This
is only sent in Accounting-Request records, where the Acct-Status-Type is Stop or Interim Update.

l Acct-Terminate-Cause: Indicates how the session was terminated and is sent in Accounting-Request
records where the Acct-Status-Type is Stop. Possible values are:

1: User logged off

4: Idle Timeout

5: Session Timeout. Maximum session length timer expired.

7: Admin Reboot: Administrator is ending service, for example prior to rebooting the Mobility Master.

l NAS-Identifier: This is set in the RADIUS server configuration.

l NAS-IP-Address: IP address of the managed device. You can configure a “global” NAS IP address:

n In the Mobility Master node hierarchy of the WebUI, navigate to the Configuration >
Authentication > Advanced page. Under RADIUS Client, enter the IPv4 or IPv6 address.

n In the CLI, use the, ip radius nas-ip command.

l NAS-Port: Physical or virtual port (tunnel) number through which the user traffic is entering the managed
device.

l NAS-Port-Type: Type of port used in the connection. This is set to one of the following:

n 5: admin login

n 15: wired user type

n 19: wireless user

l Framed-IP-Address: IP address of the user.

l Calling-Station-ID: MAC address of the user.

l Called-station-ID: MAC address of the managed device.

The following attributes are sent in Accounting-Request packets when Acct-Status-Type value is Start:

l Acct-Status-Type

l User-Name

l NAS-IP-Address

l NAS-Port

l NAS-Port-Type

l NAS-Identifier

l Framed-IP-Address

l Calling-Station-ID

l Called-station-ID

l Acct-Session-ID

l Acct-Authentic

The following attributes are sent in Accounting-Request packets when Acct-Status-Type value is Stop:

l Acct-Status-Type

l User-Name

l NAS-IP-Address

l NAS-Port

l NAS-Port-Type

l NAS-Identifier



l Framed-IP-Address

l Calling-Station-ID

l Called-station-ID

l Acct-Session-ID

l Acct-Authentic

l Terminate-Cause

l Acct-Session-Time

The following attributes are sent only in Accounting Stop packets (they are not sent in Accounting Start
packets):

l Acct-Input-Octets

l Acct-Output-Octets

l Acct-Input-Packets

l Acct-Output-Packets

Remote APs in split-tunnel mode now support RADIUS accounting. If you enable RADIUS accounting in a split-
tunnel Remote AP’s AAA profile, the managed device sends a RADIUS accounting start record to the RADIUS
server when a user associates with the remote AP, and sends a stop record when the user logs out or is deleted
from the user database. If interim accounting is enabled, the managed device sends updates at regular
intervals. Each interim record includes cumulative user statistics, including received bytes and packets
counters.

You can use either the WebUI or CLI to assign a server group for RADIUS accounting.

Using the WebUI

1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication > AAA
Profiles page.

2. Under AAA Profiles select the AAA profile instance.

3. (Optional) In the Profile Details pane, select RADIUS Interim Accounting to allow the managed device to
send Interim-Update messages with current user statistics to the server at regular intervals. This option is
disabled by default, allowing the managed device to send only start and stop messages RADIUS accounting
server.

4. Select a AAA profile, and then scroll down to select the Radius Accounting Server Group for the AAA
profile. Select the server group from the drop-down list.

You can add additional servers to the group or configure server rules.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
(host) [mynode] (config) #aaa profile <profile>

radius-accounting <group>

radius-interim-accounting

RADIUS Accounting on Multiple Servers
ArubaOS provides support to send RADIUS accounting to multiple RADIUS servers. Mobility Master notifies all
the RADIUS servers to track the status of authenticated users. Accounting messages are sent to all the servers
configured in the server group in a sequential order.

You can enable multiple server account functionality by using the WebUI and CLI:
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Using the WebUI

1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication > AAA
Profiles page.

2. Under AAA Profiles select the AAA profile instance.

3. Select the Multiple Server Accounting check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI

To enable RADIUS Accounting on Multiple Servers functionality, use the following CLI:
(host) [mynode] (config) # aaa profile <profile_name>

multiple-server-accounting

TACACS+ Accounting
TACACS+ accounting allows commands issued on a Mobility Master or managed device to be reported to
TACACS+ servers. You can specify which types of commands are reported (action, configuration, or show
commands), or report all commands.

You can only configure TACACS+ accounting through the CLI:
(host) [mynode] (config) #aaa tacacs-accounting server-group {enable|disable}

command {action|all|configuration|show}

Configuring Authentication Timers
Table 34 describes the timers you can configure for all clients and servers. These timers can be left at their
default values for most implementations.



Timer Description

User Idle Timeout Maximum period after which a client is considered idle if there is no
wireless traffic from the client.The timeout period is reset if there is
wireless traffic. If there is no wireless traffic in the timeout period, the
client is aged out. Once the timeout period has expired, the user is
removed. If the keyword seconds is not specified, the value defaults
to minutes at the command line.

Range: 1–255 minutes (30–15300 seconds)

Default: 5 minutes (300 seconds)

Authentication Server
Dead Time

Maximum period, in minutes, that the managed device considers an
unresponsive authentication server to be “out of service.”

This timer is only applicable if there are two or more authentication
servers configured on a managed device. If there is only one
authentication server configured, the server is never considered out
of service, and all requests are sent to the server.

If one or more backup servers are configured and a server is
unresponsive, it is marked as out of service for the dead time;
subsequent requests are sent to the next server on the priority list
for the duration of the dead time. If the server is responsive after the
dead time has elapsed, it can take over servicing requests from a
lower-priority server; if the server continues to be unresponsive, it is
marked as down for the dead time.

Range: 0–50 minutes

Default: 10 minutes

Logon User Lifetime Maximum time, in minutes, unauthenticated clients are allowed to
remain logged on.

Range: 0–255 minutes

Default: 5 minutes

User Interim stats
frequency

Sets the timeout value for user stats, reporting in minutes or
seconds.

Range: 300-600 seconds, or 5-10 minutes

Default: 600 seconds

Table 34: Authentication Timers

Setting an Authentication Timer
To set an authentication timer, complete one of the following procedures:

Using the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Advanced

page.

2. Configure the timers as described above.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy Changes.
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Using the CLI
The commands below configure timers you can apply to clients. If the optional seconds keyword is not
specified for the idle-timeout and stats-timeout parameters, the value defaults to minutes.
(host)[mynode] (config) #aaa timers

dead-time <minutes>

idle-timeout <time> [seconds]

logon-lifetime <0-255>

stats-timeout <time> [seconds]

Authentication Server Load Balancing
Load balancing of authentication servers ensures that the authentication load is split across multiple
authentication servers, thus avoiding any one particular authentication server from being overloaded.
Authentication Server Load Balancing functionality enables Mobility Master to perform load balancing of
authentication requests destined for external authentication servers (Radius/LDAP etc). This prevents any one
authentication server from having to handle the full load during heavy authentication periods, such as at the
start of the business day.

Previously, the controller used the first authentication server in the server group list. The remaining servers in
that group would be used in sequential order only when an authentication server was down. Thus, the
controllers performed fail-over instead of load balancing of authentication servers.

The load balancing algorithm computes the expected time taken to authenticate a new client for each
authentication server and chooses that authentication server with the shorted expected authentication time.
The load balancing algorithm maintains re-authentication stickiness, meaning that at the time of re-
authentication, the request is forwarded to the same server where it was originally authenticated.

Enabling Authentication Server Load Balancing Functionality
Use the aaa server-group command to enable authentication server load balancing functionality.
(host) [mynode] (config) #aaa server-group <group>

load-balance

auth-server s1

auth-server s2

You can use the following command to disable load balancing:
(host) [mynode] (config) #aaa server-group <group>

no load-balance

If you configure an internal server in the server group, load balancing is not applicable to the internal server. The
Internal server will be used as a fall-back when all other servers in the group are down.
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Chapter 11
MAC-Based Authentication

This chapter describes how to configure MAC-based authentication on the Aruba controller using the WebUI
and the CLI.

Use MAC-based authentication to authenticate devices based on their physical media access control (MAC)
address. Although this not the most secure and scalable method, MAC-based authentication implicitly provides
an additional layer of security to authenticate devices. MAC-based authentication is often used to authenticate
and allow network access through certain devices while denying access to the rest. For example, if clients are
allowed access to the network through station A, then one method of authenticating station A is MAC-based.
Clients may be required to authenticate themselves using other methods depending on the network privileges
required.

MAC-based authentication can also be used to authenticate Wi-Fi phones as an additional layer of security to
prevent other devices from accessing the voice network using what is normally an insecure SSID.

This chapter describes the following topics:

l Configuring MAC-Based Authentication on page 198

l Configuring Clients on page 200

Configuring MAC-Based Authentication
Before configuring MAC-based authentication, you must configure the following options:

l User role—The user role that will be assigned as the default role for the MAC-based authenticated clients.
(See Roles and Policies on page 363 for information on firewall policies to configure roles.)

Configure the default user role for MAC-based authentication in the AAA profile. If derivation rules exist or if
the client configuration in the internal database has a role assigned, these values take precedence over the
default user role.

l Authentication server group—The authentication server group that the controller uses to validate the
clients. The internal database can be used to configure the clients for MAC-based authentication. See
Configuring Clients on page 200 for information on configuring the clients on the local database. For
information on configuring authentication servers and server groups, see Authentication Servers on page
174.

Configuring the MAC Authentication Profile
Table 35 describes the parameters you can configure for MAC-based authentication.
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Parameter Description

Delimiter Delimiter used in the MAC string:

l colon specifies the format XX:XX:XX:XX:XX:XX

l dash specifies the format XX-XX-XX-XX-XX-XX

l none specifies the format XXXXXXXXXXXX

l oui-nic specifies the format XXXXXX-XXXXXX

Default: none

Case The case (upper or lower) used in the MAC string.

Default: lower

Max Authentication failures Number of times a station can fail to authenticate before it is blacklisted.
A value of zero disables blacklisting.

Default: zero (0)

Reauthentication Interval Time duration between reauthentication attempts. Configure a value in
the range of 60–86,400. Reauthentication timer is configured in terms of
seconds.

Select the Reauthentication check box if you want to enable
Reauthentication; Default: disable.

Select the Use Server provided Reuthentication Interval check box to
use the interval provided by the server; Default: disable.

Table 35: MAC Authentication Profile Configuration Parameters

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > Authentication > L2

Authentication.

2. Click MAC Authentication under L2 Authentication section.

3. In the MAC Authentication Profile: New Profile section, click the plus (+) icon.

4. Enter a profile name in the Profile name text box.

5. Select the profile name to display configurable parameters.

6. Configure the parameters, as described in Table 35.

7. Click Save at the bottom of the page.

8. Click Pending Changes at the top of the page.

9. In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
Execute the following command to configure a MAC authentication profile:
(host)[mynode](config) #aaa authentication mac <profile>

case {lower|upper}

clone {default|<source>}

delimiter {colon|dash|none|oui-nic}

max-authentication-failures <max-authentication-failures-number>

reauthentication

timer <reauth period>



Configuring Clients
You can create entries in the controller’s internal database to authenticate client MAC addresses. The internal
database contains a list of clients along with the password and default role for each client. To configure entries
in the internal database for MAC authentication, you enter the the username and password for each client.

In the WebUI
1. In the Mobility Master node, navigate to Configuration > Authentication > Auth Servers.

2. In the All Servers section, click Internal. The Server >Internal section is displayed below All Servers
section.

3. In the Server >Internal section, click the plus (+) icon.

4. In the Internal Server > Add New User section, for automatic username and password generation, click
Generate beside the corresponding text boxes. Otherwise, enter the username and password in the text
boxes.

5. Select the role from the Role drop-down list.

6. Select Enabled from the drop-down list to activate the user entry on creation.

7. Select the expiration duration mode from the Expiration drop-down list. Expiration represents the
maximum time duration that a guest account is valid for.

a. If you selected time, set the date (mm/dd/yyyyy format) and time (hh:mm format) in the Date and Time
boxes.

b. If you selected duration, set the time for expiration in minutes.

8. Click Submit at the bottom of the page.

9. Click Pending Changes at the top of the page.

10.In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

The configuration does not take effect if you do not submit your changes.

In the CLI
Execute the following command from the Mobility Master node:
(host)[mynode] #local-userdb add username {generate-username|<username>} password {generate-

password|<password>}
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Chapter 12
Managed Devices at Branch Offices

Many distributed enterprises with branch and remote offices and locations use cost-effective hybrid WAN
connectivity solutions that include low-cost DSL, 4G and LTE technologies, rather than relying solely on
traditional E1/T1 or T3/E3 dedicated circuits. 7000 Series Cloud Services Controllers are optimized for these
types of locations, which are more likely to use cloud security architectures instead of dedicated security
appliances, and where clients are likely to access applications in the cloud, rather than on local application
servers.

Provision and Configure Managed Devices
This chapter describes ArubaOS features designed to optimize the configuration and performance of managed
devices in branch and remote offices, and lists the procedures to configure these features

Learn more about Managed Device Optimization
Select any of the links below to view detailed information about ArubaOS features for managed device
configuration and management, and examples of deployment topologies that support these features.

l Managed Device Feature Overview

l Zero-Touch Provisioning Overview

l WAN Authentication Survivability Overview

l Managed Device Redundancy

Provision and Configure a Managed Device
The following sections describe the procedures to configure your network for zero-touch managed device
provisioning, and to define configuration settings for a group of managed devices.

l Provisioning a Managed Device on page 211

l Health Check Services for Managed Devices on page 216

l WAN Optimization through IP Payload Compression on page 217

l WAN Interface Bandwidth Priorities on page 218

l Uplink Monitoring and Load Balancing on page 219

l Policy Based Routing on page 222

l Uplink Routing using Nexthop Lists on page 223

l Address Pool Management on page 225

l Configuring WAN Authentication Survivability on page 228

l Preventing WAN Link Failure on Virtual APs

Managed Device Feature Overview
ArubaOS supports these distributed enterprises through the following features designed specifically for
managed devices in branch and remote offices:

l Authentication survivability allows managed devices to store user access credentials and key reply attributes
whenever clients are authenticated with external RADIUS servers or LDAP authentication servers, providing
authentication and authorization survivability when remote authentication servers are not accessible.
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l Integration with existing Palo Alto Networks Firewalls, like WildFire™ anti-virus and anti-malware detection
services. In deployments with multiple Palo Alto Networks (PAN) firewalls, managed devices can select the
best PAN firewall based on priority and availability.

l Policy-based routing on each uplink interface, which allows you specify the next hop to which packets are
routed. ArubaOS supports multiple next-hop lists, to ensure connectivity in the event that a device on the
list becomes unreachable.

l Uplink and VPN redundancy, and per-interface bandwidth contracts to limit traffic for individual
applications (or categories of applications) either sent from or received by a selected interface.

l Packet compression between Aruba devices (such as devices at the branch and main office), to maximize
the amount of data that can be carried by the network.

l A WAN health-check feature that uses ping-probes to measure WAN availability and latency on each uplink.

The following diagram depicts a managed device topology where a managed device in the branch office learns
the address, routing information, and other provisioning information from the Mobility Master.

Figure 26 Managed Device Topology

Scalable Site-to-Site VPN Tunnels
ArubaOS supports site-to-site IPsec tunnels based on a Fully Qualified Domain Name (FQDN). When you
identify the remote peer for a managed device using an FQDN, that node configuration can be applied across
multiple branch managed devices, as the configured FQDN can resolve to different IP addresses for each local
branch, based on local DNS settings.

Crypto maps for site-to-site VPNs support a VLAN ID as the identifier for the source network. When the VPN
settings are pushed to a managed device, the IKE negotiation process uses the IP address range for the VLAN.
This feature allows multiple managed devices to use a single group of configuration settings defined at a



configuration node, as each managed device negotiates a different source source network IP for its VLAN,
based on the IP pool for the managed devices defined for that configuration node.

WAN Health Check
The health-check feature uses ping-probes to measure WAN availability and latency on selected uplinks. Based
upon the results of this health-check information, the managed device can continue to use its primary uplink,
or failover to a backup link. Latency is calculated based on the round-trip time (RTT) of ping responses. The
results of this health check appear in the WAN section of the Monitoring Dashboard.

Zero-Touch Provisioning Overview
Traditionally, the deployment of controllers was a multiple step process where the master controller
information and local configurations were first pre-provisioned. After the managed device connected to the
network, it established a secure tunnel to the master and downloaded the global configuration. Zero touch
provisioning automates deployment of managed devices plug-n-play. The managed device now learns the
required information from the network and provisions itself automatically. ArubaOS allows a managed device
to automatically gets its local and global configuration and license limits from Mobility Master.

This section includes the following topics:

l Why use ZTP? on page 203

l Managed Device Provisioning Modes on page 204

l Managed Device Address Pools on page 204

l Zero-Touch Provisioning Workflows on page 205

For more information about the procedures to prepare your network for ZTP, see Provisioning a Managed Device on
page 211.

Why use ZTP?
ZTP offers the following advantages over a standard managed device configuration:

l simple deployment

l reduced operational cost

l limits to provisioning errors

A managed device configured using ZTP automatically discovers the Mobility Master, downloads its local
configuration from that Mobility Master, and is provisioned with its device role, and country code.

The local configuration is the configuration that is specific to a managed device. That is, not the global configuration
shared by a network of managed devices. This includes, but is not limited to, IP addresses and VLANs.

Once the manged node is provisioned, it is ready to obtain its global configuration in either of two ways:

l The administrator enters the global configuration via the WebUI or CLI of the Mobility Master.

l The managed device retrieves its global configuration from the Mobility Master.

Device-specific configurations that are common across multiple devices can be modified from a central location
using the bulk edit feature. Users can apply common device configurations to a group of devices without
having to update each device individually. Bulk edit supports, but is not limited to, the following
configurations: 

l Time zone

ArubaOS 8.0.0.0 | User Guide Managed Devices at Branch Offices |  203



204 | Managed Devices at Branch Offices ArubaOS 8.0.0.0  | User Guide

l Daylight savings time setting

l VLANs

l Managed device IP addresses

l DHCP pools

ArubaOS supports a layer-2 or layer-3 redundant Mobility Master for managed devices. Layer-2 redundancy
prevents a scenario where Mobility Master acts as a single point of failure if the link to the Mobility Master goes
down. Layer-3 redundancy supports an additional master and backup Mobility Master pair at a remote site,
giving you an extra layer of protection in the event that a the co-located Master-Standby Mobility Master pair
at the primary site fails due to a network failure or local natural disaster. For more information, see Managed
Device Redundancy on page 210.

Managed Device Provisioning Modes
The administrator has the choice of several provisioning modes that alter how the managed device is supplied
with its own IP address, role, country code, and configuration settings.

Once the managed device learns the IP address of the primary Mobility Master, the managed device contacts
that Mobility Master and retrieves its configuration from its assigned configuration node.

Before you deploy a managed device, use you m ust create a configuration for that device at a configuration node on
Mobility Master. Mobility Master pushes this configuration to the managed device when the device becomes active
on the network.

ArubaOS supports the following provisioning modes for managed devices:

l auto: In this mode, the managed device:

n obtains its IP address from DHCP

n obtains its role, country code, and the IP addresses of the Mobility Master and any defined secondary
Mobility Master from DHCP Options or a provisioning rule in Activate

n retrieves its configuration from a configuration node on Mobility Master

l mini-setup: In this mode, the managed device:

n has its role set to local (local) when mini-setup is initiated

n obtains its IP address from DHCP

n is configured through the console with its country code and the IP address of the primary Mobility
Master and (optionally) the secondary Mobility Master IP

n retrieves its local config group from the primary Mobility Master

l full-setup: In this mode, the managed device:

n is configured with its role set to ocal (local) through the console

n is configured to obtain its IP address through manual configuration of a static IP, DHCP, or PPPoE

n is configured through the console with its country code and the IP address of the primary Mobility
Master and (optionally) the secondary Mobility Master IP

n retrieves its configuration from a configuration node on the primary Mobility Master

Managed Device Address Pools
Each managed device needs a pool of addresses it can dynamically assign to APs or users on each of its VLANs,
and a separate IP address that managed device uses to create a GRE tunnel to Mobility Master. Mobility Master
can assign IP these addresses to managed devices using dynamic address pools. These pools allow network
administrators to create a generic configuration that provisions managed device interfaces with individual
settings that are unique across branch offices. If managed devices are also serving as DHCP servers for other



devices at that location, smaller DHCP pools for those individual branches can be dynamically carved out from
a larger DHCP pool.

ArubaOS 8.0 supports three different types of address pools that can be applied to a hierarchy node

l NAT Pools: A NAT pool is used to assign IP addresses to a VLAN interface on a managed device . The range
of addresses in this pool is available for use for any DHCP-enabled managed device when it is added to that
specific node in the configuration hierarchy. When you add a managed device, a group of IP addresses is
removed from the NAT pool on that hierarchy node and is and leased to the device. The IP addresses in a
NAT pool are dynamic (leased) rather than static (permanently assigned), so addresses no longer in use are
automatically returned to the pool for reallocation.

l Tunnel pools: A tunnel pool defines a range of IP addresses that can be used by the managed devices to
create a GRE tunnel to the Mobility Master. When you add a managed device controller, an IP address is
removed from the tunnel pool on that hierarchy node and is and leased to that device. Addresses no longer
in use are automatically returned to the pool for reallocation.

l VLAN pools: A VLAN pool allocates a block of IP addresses for each managed device. The managed device
acts as a DNS proxy server and dynamically assigns IP addresses from its allocated pool to each AP or client
on the VLAN. A VLAN pool allocates multiple addresses to each managed device VLAN, unlike the tunnel
pool, which assigns a single tunnel IP address to each managed device.

Zero-Touch Provisioning Workflows
The managed device obtains its IP address through DHCP by sending a DHCP discover on the default uplink
port. The default uplink port is configured as an access port in VLAN 4094.

Next it will attempt to retrieve the provisioning parameters from the DHCP options in the DHCP lease it has
obtained. If the provisioning parameters could not be obtained from the DHCP options, the managed device
will attempt to retrieve the provisioning parameters from Activate.

If the managed device is unsuccessful in retrieving the provisioning parameters from Activate, it will retry in 30
seconds. The managed device keeps trying to retrieve the provisioning parameters from Activate every 30
seconds until it is successful or the administrator interrupts Auto-Provisioning by initiating mini-setup or full-
setup.

To interrupt the auto provisioning process, enter the string mini-setup or full-setup at the initial setup dialog
prompt shown below.
Auto-provisioning is in progress. Choose one of the following options to override or debug...

'enable-debug' : Enable auto-provisioning debug logs

'disable-debug': Disable auto-provisioning debug logs

'mini-setup' : Stop auto-provisioning and start mini setup dialog for smart-local role

'full-setup' : Stop auto-provisioning and start full setup dialog for any role

Enter Option (partial string is acceptable):_

When the managed device sends the DHCP discover message to obtain its IP address, it adds a DHCP option
60 Vendor Class Identifier to that DHCP discover message, where DHCP Option 60 is set to “ArubaMC”.

If the DHCP Offer does have DHCP Option 60 = ArubaMC, the managed device will accept the DHCP lease and
send a DHCP request. It will also look for DHCP Option 43 – Vendor Specific Information in the DHCP Lease. If
DHCP Option 43 is present in the Offer, the managed device will parse it to learn the provisioning parameters.

The role is not explicitly specified in DHCP Option 43. However, the controllerwill set its Role to local if the other
provisioning parameters are present in DHCP Option 43.
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WAN Authentication Survivability Overview
Authentication survivability is critical to managed device WLANs since most managed devices use
geographically remote authentication servers to provide authentication and authorization services. When
those authentication servers are not accessible, clients can't access the WLAN because the managed device
can't authenticate them. ArubaOS authentication survivability allows managed devices to provide client
authentication and authorization survivability when remote authentication servers are not accessible. When
this feature is enabled, ArubaOS stores user access credentials and key reply attributes whenever clients are
authenticated with external RADIUS servers or LDAP authentication servers. When external authentication
servers are not accessible, the managed device uses its internal survival server to continue providing
authentication and authorization functions by using the user access credentials and key reply attributes that
were stored earlier.

When authentication survivability is enabled, a internal survival server on the manged node performs
authentication functions, as well as EAP-termination using the RADIUS protocol. The survival server performs
authentication or query requests when authentication survivability is enabled, and one of the following is true:

1. All servers are out of service in the server group if fail-through is disabled

2. All in-service servers failed the authentication and at least one server is out of service when fail-through is
enabled.

All access credentials and key reply attributes saved in the local survival server remain in the system until they
expire. The system-wide lifetime parameter auth-survivability cache-lifetime has a range from 1 to 72
hours, and a default value of 24 hours. Expired user credential attributes and key reply attributes stored in the
survival server cache are purged every 10 minutes.

Best practices is to import a customer server certificate into the managed device and assign it to the local survival
server.

The survival server can store the following types of client data:

l Client username

l Encrypted Passwords. For Password Authentication Protocol (PAP) authentication, the survival server
receives the password provided by the client and then stores the encrypted SHA-1 hashed value of the
password.

l EAP indicator: When employing 802.1X with disabled termination using EAP-TLS, the EAP indicator is stored.

l The CN lookup EXIST indicator

Supported Client and Authentication Types
The the following combination of clients and authentication types are supported with the authentication
survivability feature (see ):



Table 36: Clients and Supported Authentication Types

Clients Authentication Methods

Captive Portal clients Password Authentication Protocol (PAP)

802.1X clients l Termination disabled: Extensible Authentication Protocol-Transport
Layer Security (EAP-TLS) with an external RADIUS server

l Termination enabled: EAP-TLS with Common Name (CN) lookup with
an external authentication server

External Captive Portal clients using
the XML-API

PAP

MAC-based Authentication clients PAP

VPN clients l PAP with an external authentication server

l CN lookup with an external authentication server

VIA and other VPN clients PAP method and CN lookup

Wireless Internet Service Provider
roaming (WISPr) clients

PAP

Supported Key Reply Attributes
The following key reply attributes are supported:

l ARUBA_NAMED_VLAN

l ARUBA_NO_DHCP_FINGERPRINT

l ARUBA_ROLE

l ARUBA_VLAN

l MS_TUNNEL_MEDIUM_TYPE

l MS_TUNNEL_PRIVATE_GROUP_ID

l MS_TUNNEL_TYPE

l PW_SESSION_TIMEOUT

l PW_USER_NAME

Feature Restrictions and Limitations
The authentication survivability feature has the following support restrictions:

l The Survival Server cache database is station-based (thus, the MAC address is the key), so authentication
survivability is not supported for any station with a zero MAC address.

l For a client using EAP-TLS, you must install the issuer certificate of the Survival Server certificate as a
TrustedCA certificate in the client station.

l For an 802.1X client using EAP-TLS that does not terminate at the managed device, the issuer certificate for
the client certificate must be imported as a TrustedCA or an intermediateCA certificate at the managed
device—just as the same certificate must be installed at the terminating External RADIUS server.
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l The Survival Server does not support the Online Certificate Status Protocol (OCSP) nor the Certificate
Revocation List (CRL) for EAP-TLS.

l Authentication survivability will not activate if Authentication Server Dead Time is configured as 0.

To configure Authentication Server Dead Time, on the managed device, navigate to: Configuration >
SECURITY > Authentication > Advanced > Authentication Timers > Authentication
ServerDeadTime (min).

Captive Portal Authentication Workflow
This section describes the authentication procedures for Captive Portal clients, both when the branch's
authentication servers are available and when they are not available. When the authentication servers are not
available, the Survival Server takes over the handling of authentication requests.

Captive Portal Client Authentication Using PAP
Table 37 describes what occurs for Captive Portal clients using PAP as the authentication method.

Table 37: Captive Portal Authentication Using PAP

When Authentication Servers Are
Available When Authentication Servers Are Not Available

l If authentication succeeds, the associated
access credential with an encrypted SHA-1
hash of the password and Key Reply
attributes are stored in the Survival Server
database.

l If authentication fails, the associated
access credential and Key Reply attributes
associated with the PAP method (if they
exist) are deleted from the Survival Server
database.

When no in-service server in the associated server group is
available, the Survival Server is used to authenticate the
Captive portal client using PAP.

The Survival Server uses the previously stored unexpired
access credential to perform authentication and, upon
successful authentication, returns the previously stored Key
Reply attributes.

External Captive Portal Client Authentication Using the XML-API
Table 38 describes the authentication procedures for External Captive Portal clients using the XML-API, both
when the branch's authentication servers are available and when they are not available. When the
authentication servers are not available, the Survival Server takes over the handling of authentication requests.

Table 38: Captive Portal Authentication Using XML-API

When Authentication Servers Are Available When Authentication Servers Are Not
Available

For authentication requests from an External Captive
Portal using the XML-API, PAP is used to authenticate
these requests with an external authentication server.

l If authentication succeeds, the associated access
credential with an encrypted SHA-1 hash of the
password and Key Reply attributes are stored in
the Survival Server database.

l If authentication fails, the associated access
credential and Key Reply attributes associated with
the PAP method (if they exist) are deleted from the
Survival Server database.

When no in-service server in the associated server
group is available, the Survival Server is used to
authenticate the Captive portal client using PAP.

The Survival Server uses the previously stored
unexpired access credential to perform authentication
and, upon successful authentication, returns the
previously stored Key Reply attributes.



802.1X Authentication Workflow
This section describes the authentication procedures for 802.1X clients with termination at an External RADIUS
server, or at the controller.

Table 39: 802.1X Authentication Terminating at an External Server

When Authentication Servers Are Available When Authentication Servers Are Not
Available

For an 802.1X client that terminates at an external RADIUS
server using EAP-TLS:

l If authentication is accepted, the associated access
credential with the EAP-TLS indicator, in addition to the
Key Reply attributes, are stored in the Survival Server
database.

l If authentication is rejected, the associated access
credential and Key Reply attributes associated with the
EAP-TLS method (if they exist) are deleted from the
Survival Server database.

When there is no available in-service server in the
associated server group, the Survival Server
terminates and authenticates 802.1X clients using
EAP-TLS.

The Survival Server uses the previously stored
unexpired access credential to perform
authentication and, upon successful authentication,
returns the previously stored Key Reply attributes.

In this case, the client station must be configured to
accept the server certificate assigned to the
Survival Server.

For an 802.1X client for which termination is enabled at the managed device using EAP-TLS with Common
Name (CN) lookup, a query request about the Common Name is sent to the external authentication server.

The external authentication server can be either a RADIUS server or an LDAP server.

Table 40: 802.1X Client Authentication Using EAP_TLS with CN Lookup

When Authentication Servers Are Available When Authentication Servers Are Not
Available

l If the query succeeds, the associated access credential
with a returned indicator of EXIST, plus the Key Reply
attributes, are stored in the Survival Server database.

l If the query fails, the associated access credential and
Key Reply attributes associated with the Query method
(if they exist) are deleted from the Survival Server
database.

When there is no available in-service server in the
associated server group, the Survival Server
performs CN lookup for 802.1X clients for which
termination is enabled at the managed device
using EAP-TLS.

The Survival Server returns previously stored Key
Reply attributes as long as the client with the EXIST
indicator is in the Survival Server database.

MAC Authentication Workflow
This section describes the authentication procedures for clients.
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Table 41: MAC-Based Client Authentication Using PAP

When Authentication Servers Are Available When Authentication Servers Are Not
Available

l If authentication succeeds, the associated access
credential, along with an encrypted SHA-1 hash of the
password and Key Reply attributes, are stored in the
Survival Server database.

l If authentication fails, the associated access credential
and Key Reply attributes associated with the PAP
method (if they exist) are deleted from the Survival
Server database.

When there is no available in-service server in the
associated server group, the Survival Server
authenticates the MAC-based authentication client
using PAP.

The Survival Server returns previously stored Key
Reply attributes as long as the client with the EXIST
indicator is in the Survival Server database.

WISPr Authentication
This section describes the authentication procedures for Wireless Internet Service Provider roaming (WISPr)
clients, both when the branch's authentication servers are available and when they are not available. When the
authentication servers are not available, the Survival Server takes over the handling of authentication requests.

The external authentication server can be either a RADIUS server or an LDAP server.

Table 42: WISPr Authentication Using PAP

When Authentication Servers Are Available When Authentication Servers Are Not
Available

For a WISPr client authenticated by an external server
using PAP:

l If authentication succeeds, the associated access
credential, along with an encrypted SHA-1 hash of the
password and Key Reply attributes, are stored in the
Survival Server database.

l If authentication fails, the associated access credential
and Key Reply attributes (if they exist) associated with
the PAP method are deleted from the Survival Server
database.

When there is no available in-service server in the
associated server group, the Survival Server
authenticates the WISPr client using PAP.

Upon successful authentication, the Survival Server
uses the previously stored unexpired credential to
perform authentication, and returns the previously
stored Key Reply attributes .

Managed Device Redundancy
ArubaOS supports a redundant Mobility Master for managed devices. This prevents a scenario where Mobility
Master acts as a single point of failure if the link to the master goes down, or a co-located Master-Standby VRRP
Mobility Master pair fails due to a network failure or local natural disaster.

Configuring Layer-3 Redundancy
The IP address of a primary Mobility Master and a secondary, backup Mobility Master can be defined for a
managed device during the Zero-touch provisioning process, and is either defined in a DHCP server, is manually
entered into the managed device during the initial startup dialog, or defined via an Activate server. The primary



and secondary Mobility Masters must be manually kept in synchronization by ensuring all the configuration,
certificates, whitelist and local user database are the same on both Mobility Masters.

Database settings are not automatically synchronized from a primary master to a secondary master with Layer-3
redundancy. All database settings, certificates, whitelist settings and profile configurations must be kept in sync
manually.

Viewing Managed Device Connectivity Status
The status of the managed device's connection to a primary and secondary Mobility Master appears in the
WAN dashboard page of the WebUI. To display the current status of the managed device's connectivity to the
master and secondary master IP addresses, click the Layer3 Redundancy tab on the Status section of the
dashboard.

For more information on the WAN Dashboard, see WAN on page 706

Figure 27 Managed Device Redundancy Status

Failover Behaviors
When a provisioned managed device detects that its primary Mobility Master is unreachable, it attempts to
reconnect to the primary Mobility Master for the time period defined by the Master L3 Redundancy Switchover
Timeout. If the managed device cannot reconnect to the primary Mobility Master during this switchover
timeout period, and the secondary Mobility Master is up and reachable, the managed device reloads and
associates to the Mobility Master as the new master. The manged node then synchronizes its branch and
global configuration settings from the new Mobility Master master, and reloads again to apply those settings.

Provisioning a Managed Device
When a factory-default controller boots, it starts the auto-provisioning process. The following sections describe
the provisioning workflow, and the process to prepare your network for zero-touch provisioning (ZTP)for a
managed device.

Configure your Network for ZTP using DHCP
Before you deploy a managed device using ZTP, configure the DHCP server with the following information:

l The option-60 vendor class identifier ArubaMC
l Option-43 Vendor Specific Information (VSI) with the primary master IP address, the country code, and

optionally, a secondary master IP (for deployments requiring Layer-3 redundancy). This VSI must be in one
of the following formats, where the Mobility Master IP address is in dotted-decimal notation (a.b.c.d)
format or a fully qualified domain name format (master.example.com), and the country code contains a
valid ISO 3166 country codes, such as US, AU, or IN
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n <Master-IP-address>

n <Master-ip-address>,<Country-code>

n <Primary-master-IP-address>, <Country-Code>,<Secondary-master-IP-address>

If the DHCP offer from the server does not include ArubaMC as DHCP option 60, the managed device will still
accept the DHCP Lease and send a DHCP Request. However, once the managed device is bound to an IP
Address, it will query Activate for additional provisioning information. If the node does not receive the
ArubaMC identifier through option-60, or if the received IP address is not valid, option-43 is completely
discarded and ZTP moves to the next discovery method. For details, refer to Configure your Network for ZTP
with Aruba Activate on page 212

Configure your Network for ZTP with Aruba Activate
If the managed device does not receive its provisioning parameters through DHCP options, it will query
Activate for a provisioning rule that assigns that managed device to Mobility Master..

When a managed device establishes an HTTPS connection to the Activate server and requests provisioning
information, the Activate server authenticates the managed device and provides that device with provisioning
information, including the IP address of its Mobility Master and secondary Mobility Master, and its country
code. If the managed device is unsuccessful in retrieving the provisioning parameters from Activate, it will retry
in 30 seconds. The managed device will keep trying to retrieve the provisioning parameters from Activate until
it is successful, or the administrator iniitiates Mini-Setup or Full-Setup provisioning.

Before you can use Activate to associate a managed device to Mobility Master, you must configure Activate
with additional device settings for each managed device and Mobility Master, create a folder for those local
devices, then assign a provisioning rule to that folder that associates the managed devices to a specified master
and configuration node. Use the following procedures to configure device details for the Mobility Masterand
managed devices, create folders, and define the provisioning rule.

Configuring Device details for a Managed Device
When you place an order for a controller, that device appears in the Activate Devices list displaying the
preconfigured settings for its serial number, MAC address, and software image. Before you can add a managed
device to a whitelist, you must use the Activate interface to assign a name to each managed device, and use the
Activate interface to identify the Mobility Masterin a managed device deployment.

Follow the steps below to use Activate to configure managed device or Mobility Master device settings

1. Click the Devices icon at the top of the page to display the Devices page.

2. Select a managed device or Mobility Master from the Devices list. If the list is very large, you can click the
filter icon by any Devices list column heading and choose which entries to display, then select the
managed device from the smaller, filtered list.

3. If the device will be used as the Mobility Master, select the Master Controller check box.

4. In the Device Detail section of the Devices page, enter the following values:

l Device name: (Required) an IP address or fully-qualified domain name for the managed device or
Mobility Master

l Full name: (Optional) a user-friendly name for the device

l Description: (Optional) a short text string describing the device

5. Click Done to save your settings.



Figure 28 Device Details for aManaged Device

Creating a New Managed Device Folder
Associate multiple managed devices to the same Mobility Master by moving those managed devices into a
single Activate folder.

A folder can contain only one model of managed device, using the same country code and mapping to the same
configuration node. Different folders need to be created for managed devices of different model types, or that use a
different country code or local config group.

Follow the steps below to add a new folder to the Folders list:

1. Click the Setup icon to display the Setup page.

2. Click the New link in the title bar of the Folders list. The Create a New Folder window appears.

3. Enter the following information for the folder:

l Name: Name of the new managed device folder. The folder name must be 100 characters or less, and
cannot include the characters ?, # or &.

l Parent: The new folder's parent folder. The new folder will be created under the selected parent.

l Notes: (Optional) Use this field to add any additional notes about the folder.

4. Click Done to save the new folder.

Configuring the Provisioning Rule
A folder can only have one provisioning profile configured within it and the provisioning profile can only
reference one configuration node . Consequently, it is necessary to create a folder and associate the
provisioning rule for each group of managed devices that share a common configuration node.

Follow the steps below to create a new provisioning rule for the new managed device folder

1. Click the Setup icon to display the Setup page.

2. In the folders section of the Setup page, select the new managed device folder.

3. Click the New link in the title bar of the Rules list. The Create a New Rule window appears at the bottom
of the page. Enter a value for each required field, then click Done to save your settings.
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Figure 29 New Provisioning Rule

Provisioning Rule
Setting

Description

Rule Type Click the Rule Type drop-down list, and select Provisioning Rule.

Parent Folder Select the folder to which this provisioning rule applies.

Provision Type Select the Managed Node to Master Controller rule type.

Redundancy Level Select No Redundancy to configure just a single Mobility Master, choose L2 redundancy to
define a local backup at the same site as the Mobility Master or select L3 to define an
additional primary and backup Mobility Master at a different location than the main primary
and backup Mobility Master pair.

NOTE: If you select the L3 option, you must configure a , Master Mobility Master and
Secondary Mobility Master for Site 1 and Site 2.

Primary Controller MAC address of the primary Mobility Master. Activate sends a managed device whitelist with
information about the managed devices in this folder to the Mobility Master with this MAC
address.

Master Controller
IP

Enter the IP address used to access Mobility Master or the primary/backup Mobility Master
pair.

Secondary
Controller

(Optional for Layer-2 or Layer-3 redundancy) MAC address of a backup Mobility Master, for
deployments that require layer-2 or Layer-3 redundancy.

VPN Concentrator
MAC

The MAC address of the managed device (or other device) that terminates VPN tunnels to
the datacenter.

Table 43: Provisioning Rule Configuration Settings



Provisioning Rule
Setting

Description

VPN Concentrator
IP

The IP address of the managed device (or other device) that terminates VPN tunnels to the
datacenter.

Country Code Select a country code to be assigned to the managed devices in this folder.

Local Config Group Enter the name of a local config group to assign that group of local configuration settings to
the managed devices in this folder.

Moving a Managed Device to the New Folder
Follow the steps below to assign one or more managed devices to a folder:

1. Click the Devices icon at the top of the page to display the Devices page.

2. Click the filter icon by any Devices list column heading and choose which entries to display. You can repeat
this step and filter the list by multiple criteria types until the Devices list shows only those devices you want
to move to a new folder.

3. Click the Move to Folder button at the top of the Devices page. A drop-down window appears, displaying
with all folder names.

4. Select the destination folder for the devices.

5. A confirmation window appears, showing the total number of devices that will be moved.

6. Click OK to confirm the change, or click Cancel to cancel the move.

You can also assign an individual device to a new folder by selecting that device from the Devices list and
manually changing its parent folder in the Device Details window.

Retrieval of a Managed Device Whitelist from Activate
Activate may be configured to supply the list of managed devices to the Mobility Master to be added to the
whitelist.

The Mobility Master sends a query to Activate every hour. To initiate an immediate query to Activate, access
the Mobility Master CLI in enable mode and issue the command “activate sync.”

When the Mobility Master sends the query to Activate, Activate searches for all provisioning rules of the type
managed node to master controller that include the MAC address of this Mobility Master in the primary
controller field.

Activate Interface Communication
The managed device and the Mobility Master interact with the Activate server to receive information about
each other. Once the Activate server is properly configured with the appropriate folders and provisioning rules,
Activate automatically manages the relationship between Mobility Master and all the managed devices
associated with that master.

The Mobility Masterregularly contacts the Activate server to get a list of its associated managed devices.
Managed devices interact with the Activate server to learn about their role, Mobility Master information, and
their regulatory domain. The Mobility Master sends its own information and not managed device information.
Activate reuses information in the AP-information field for controller interactions between Mobility Masterand
managed devices.

The following steps describe the how Mobility Master retrieves the whitelist database from the Activate server.

ArubaOS 8.0.0.0 | User Guide Managed Devices at Branch Offices |  215



216 | Managed Devices at Branch Offices ArubaOS 8.0.0.0  | User Guide

1. The Mobility Master sends an initial post with a keepalive connection type that includes the following
information:

l type = Provision update

l mode = controller

l a session ID

l AP information that includes <serial number>, <mac-address>, <model>

2. Activate responds with the following information:

l type = provision update

l an Activate-assigned session ID

l status

l connection = keep alive.

3. The Mobility Master then sends a second POST with ‘close’ connection type with the following information:

l type = provision update,

l the session ID received from Activate,

l Device information that includes <serial number>, <mac-address>, <model>

l certificate length

l signed certificate

l device certificate

4. Activate then responds with the following information:

l type = provision update,

l the same session ID that Activate assigned in the first response

l status = success or failure

l mode = master

l the list of managed devices from the whitelist database, where each list entry contains a <mac-
address>,<serial number>,<model>,<mode>,<hostname>, and <config group>

Health Check Services for Managed Devices
The health-check feature uses ping-probes to measure WAN availability and latency on selected uplinks. Based
upon the results of this health-check information, the managed device can continue to use its primary uplink,
or failover to a backup link. Latency is calculated based on the round-trip time (RTT) of ping responses. You
must define an uplink interface via the uplink manager and enable the health check feature before the results
of this health check appear in the WAN section of the Monitoring Dashboard.

For more information on the WAN Dashboard, see WAN on page 706.

ArubaOS supports policy-based routing on each uplink interface, which allows you specify the next hop to
which packets are routed. ArubaOS supports multiple next-hop lists, to ensure connectivity in the event that a
device on the list becomes unreachable. If you are using Policy Based Routing, you can define global ping
settings for all next-hop list destinations.

The Health Check section of the Configuration > Services > WAN tab allows you to configure probe
measurement settings ping probe settings for the primary WAN uplink on the managed device, as well as for
next hop links used by the policy-based routing (PBR) feature



Parameter Description

Health Check Click this check box to enable the health check features.

Remote Host IP/FQDN IP address or fully qualified domain name (FQDN) of a remote host to which the man-
aged device is connected. The WAN health check feature will check the connectivity to
the managed device uplink to this device.

WAN

Probe Mode Click the Probe Mode drop-down list and select ping or UDP to enable this feature.

Probe Interval (sec) The Probe Interval field specifies the probe interval, in seconds. The WAN health-
check feature sends the number of probes defined by the Pocket Burst per Probe
parameter during each probe interval. To change the default interval of 10 seconds,
enter a new value into this field.

Packet Burst Per Probe The Pocket Burst per Probe field specifies the number of probes to be sent during
the probe interval. To change the default value of 5 probes, enter a new value into this
field.

Probe Retries The number of times the managed device will attempt to resend a probe.

Jitter Measurement If the health check feature is configured to use UDP probe mode, the WAN health-check
feature can measure jitter on the connection to the remote host by sending and meas-
uring packets at fixed intervals.

PBR

Probe Mode Click the Probe Mode drop-down list and select ping to enable this feature.

Probe Interval (sec) The Probe Interval field specifies the probe interval, in seconds. The WAN health-
check feature sends the number of probes defined by the Pocket Burst per Probe
parameter during each probe interval. To change the default interval of 10 seconds,
enter a new value into this field.

Packet Burst Per Probe The Pocket Burst per Probe field specifies the number of probes to be sent during
the probe interval. To change the default value of 5 probes, enter a new value into this
field.

Probe Retries The number of times the managed device will attempt to resend a probe.

Table 44: WANHealth Check Settings

WAN Optimization through IP Payload Compression
Data compression reduces the size of data frames that are transmitted over a network link, thereby reducing
the time required to transmit the frame across the network. IP payload compression is one of the key features
of the WAN bandwidth optimization solution, which is comprised of the following elements:

l IP Payload Compression
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l Traffic Management and QoS

l Caching

WAN optimization through IP payload compression is not supported in a
7205 controller.

The managed device can send traffic to destinations other than the corporate headquarters on the same link,
so payload compression is enabled on the IPsec tunnel between the managed device and Mobility Master.
Dynamic compression is used for the IP payload to achieve a high compression ratio. No compression is
applied to data such as an embedded image file that might already be in a compressed format. Such data does
not compress well, and may even increase in size.

To enable payload compression:

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > WAN tab.

2. Expand the WAN Optimization section.

3. Select the Compression option.

4. Click Submit.
5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

WAN Interface Bandwidth Priorities
ArubaOS supports minimum bandwidth guarantees per traffic class, and allows critical delay-sensitive
applications like voice and video to use more bandwidth and/or be scheduled with higher priority. Each
interface can be associated with a scheduler profile, that supports four queues with different priority levels. If
you use session ACLs to define traffic policies on the managed device, you can use the scheduler profile to
automatically associate these different priority levels assigned by these policies to a scheduler profile queue.

For information on creating a traffic policy that assigns 802.1p priority levels to a specific application or application
type, see Configuring Firewall Policies on page 363

Each scheduler profile queue is assigned a priority level and one of the following scheduler discipline types:

l Strict priority: The queue service is based exclusively on the priority of the queue, where the lower priority
queues are not serviced until the higher priority queue is clear. With this option, the highest level priority is
guaranteed as much bandwidth as possible, but there can be phases where the 2nd, 3rd and 4th priority
queues may receive little or no bandwidth.

l Deficit Round Robin (DRR) Weight: The queue is assigned a percentage of available bandwidth.

You can define both strict priority and DDR Weight discipline types for a single scheduler profile.

Using the WebUI
Use the following procedure to enable WLAN interface bandwidth priorities using the WAN scheduler feature,

1. In the Managed Network node hierarchy, navigate to Configuration > Services > WAN.

2. Expand the WAN Scheduler accordion.

3. Click + below the WAN Scheduler Profiles table to define a new scheduler profile.

a. In the Priority fields, enter one or more 802.1p priority levels (0-7) for each queue type. Each of the
seven priority levels must be supported by one of the four queues.



b. For each queue, click the Scheduler Discipline drop-down list and select the Strict Priority or DDR
Weight discipline type. If you select the DDR weight option, enter the percentage of available
bandwidth that should be made available to traffic in the selected queue. This field appears to the right
of the DDR weight option.

If you configure both of strict priority and DRR weighted queues, the strict priority queues should be specified
together continuously, followed by the DRR weighted queues. For example, if you want to specify two strict priority
queues and two DDR weighted queues, configure queue 0 and 1 with the strict priority type, then configure queues 2
and 3 with a DRR priority type. You cannot alternate between strict priority and DDR weighted queues.

4. To assign the scheduler profile to a cellular or Gigabit Ethernet interface, click + below the Assignments
table.

a. Click the Ports drop-down list to select an interface.

b. In the Transmit Rate field, enter the maximum transmit rate for the selected interface, in Mbps.

5. Create a firewall session policy that assigns a priority level to an application or application group. For details,
see Configuring Firewall Policies on page 363

Using the CLI
(host)[node](config) #scheduler-profile <map-name> {priority-map <q0-q3> <que0-prio-list>} |

{queue-weights <q0-q3> <percentage_weight>}

(host)[node](config) #interface cellular|gigabitethernet <slot/module/port> transmit max-rate

rate mbits <mbps> scheduler-profile <profile>

(host)[node](config) #ip access-list session any any app salesforce permit priority 3

Uplink Monitoring and Load Balancing
The ArubaOS Uplink Manager prioritizes cellular and wired uplinks, and checks and monitors the availability and
quality of the connection to a remote host with specified FQDN or IP address. The status of these monitored
uplinks appears on the WAN section of the WebUI dashboard.

By default, the cellular uplink is a lower priority than the wired uplink; making the wired link the primary link
and the cellular link the secondary or backup link. A  controller supports multiple 3G cellular uplinks in addition
to its standard wired ports, providing redundancy in the event of a connection failure. If wired link cannot
access the internet, the controller can fail over to a secondary cellular link and continue routing traffic.

Uplink Load Balancing
WAN traffic can be balanced across two or more active uplinks from a managed device to a VPN concentrator
(VPNC). The uplink load balancing feature supports both active and standby uplinks, so the traffic load is
balanced across two wired uplinks, while the backup cellular uplink remains idle.

When a managed device has multiple active uplinks, uplink load balancing can modify the Internet Key
Exchange (IKE) parameters for the managed device to create multiple managed device/VPNc IPsec tunnels, one
on each uplink. Once multiple uplinks and IPsec tunnels are up, Layer-3 traffic can be load-balanced across
these uplinks using specially created internal routing ACLs and nexthop lists.

Load Balancing ACLs
When uplink load balancing is enabled, any Layer-3 traffic session that is not associated to a manually defined
routing ACL will be managed by two specially created, internal ACLs placed at the bottom of the routing
ACL table; the editable ACL uplink-lb-cfg-racl,followed by the non-editable ACL uplink-lb-sys-racl.

ArubaOS 8.0.0.0 | User Guide Managed Devices at Branch Offices |  219



220 | Managed Devices at Branch Offices ArubaOS 8.0.0.0  | User Guide

Load Balancing Nexthop Lists
The uplink load balancing feature uses three special internally created nexthop lists:

Load-balance-gateways is used for load-balancing internet-bound traffic, and load-balance-ipsecs for
managing encrypted traffic headed to the corporate headquarters. These nexthop lists include information
about one nexthop gateway and one managed device / VPNC IPsec tunnel for each uplink, which are added to
these lists so all nexthops are considered active and are available for routing.

The third nexthop list created by this feature is traditional-ipsecs, which is created by the load balancing
feature, and used by uplinks in active-standby mode to send control plane traffic from the managed device to
the VPNC.

Configuring the Uplink Manager
Use the following procedure to disable or enable the uplink manager, and manage priorities for the wired and
cellular connections. The uplink managed is enabled by default on managed device uplinks.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration> Services > WAN tab

2. Expand the Uplinks menu.

3. Select Enable uplink to enable the uplink manager.

4. Define a non-default priority for a wired and cellular connections in the Default Wired Priority and
Default Cellular Priority fields. The default priority for a wired connection is 200, and the default priority
for a cellular connection is 100.

5. (Optional) If you are configuring an uplink to a VPN concentrator, select Load Balancing to balance session
traffic across multiple active uplinks. Do not enable this feature if the managed device has uplinks that
connect directly to Mobility Master.

6. Click the Mode drop-down list and choose one of the following load balancing modes:

l Hash based: Hash-based load balancing uses information from the packets being sent, (e.g. the source
IP address, destination IP address, protocol and port numbers to determine how to load balance that
traffic)

l Round Robin: Traffic is equally distributed to all the active uplinks

l Session Count: Traffic is balanced between the uplinks based upon the number of sessions managed
by each link, so that the load for each active uplink stays within 5% of the other active uplinks.

7. In the Max sessions per uplink (%) field, enter the maximum percentage of total sessions that can be
managed by any active uplink. The default value is 25%.

8. (Optional) Check the Media Mode option to reevaluate the selected uplink for the session if it is identified
as a media session. By default, all sessions use the load-balance mode specified in step 6 on page 220 .
When you select this option, any time a session is identified as a media session, the uplink is reassigned to
the optimal uplink for media sessions, based upon a separate media load-balancing algorithm.

9. (Optional) Enter a value into the Latency threshold (ms) field to optimize media sessions by defining the
maximum latency allowed for media sessions in media mode. The supported range is 1 - 400 milliseconds,
and the default is 20 ms.

10.(Optional) Enter a value into the Jitter threshold (ms) field to optimize media sessions by defining the
maximum jitter allowed for media sessions in media mode. The supported range is 1 - 300 milliseconds, and
the default is 5 ms.

11.Click + in the Uplink VLANs table and enter the following values to define a uplink VLAN for an uplink
interface on the managed device.

l Link: Link to which the VLAN is assigned

l VLAN ID: VLAN ID number



l Description: Text string describing the VLAN

l Enabled: Select this drop-down list to disable or reenable the VLAN. New VLANs created on
Configuration > Services > WAN > Uplinks are enabled by default.

l Priority: If load balanced is not enabled, this value defines the priority for the uplink in a active/standby
uplink scenario.

l Weight: If the uplink is using load balancing in session mode, this value defines the weight given to the
uplink in a active/active uplink scenario. An uplink with a higher weight will be assigned more session
traffic than a uplink with a lower weigh. The supported range of values is 1-100.

12.Click Submit.
13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
The following examples configure an uplink load-balancing solution via the Mobility Master command-line
interface.

Step 1: Configure the VPN concentrator

If a managed device terminates a secure tunnel on a VPN concentrator, you can issue the vpn-peer peer-mac
command on the VPN concentrator configuration to enable load balancing on secure uplinks between the VPN
concentrator and a managed device.

The following example enables load balancing on the uplinks between a managed device with the MAC address
01:00:5E:00:00:FF and a VPN concentrator:
(host)[node](config) #vpn-peer peer-mac 01:00:5E:00:00:FF cert-auth factory-cert load-balance

Step 2: Enable the Uplink Manager

Issue the following command to enable the uplink manager:
(host) [node] (config) #uplink enable

Step 3: Enable the Load Balancing

Issue the uplink load-balance command without any additional parameters to enable uplink load balancing:
(host) [node] (config) #uplink load-balance

Step 4: (Optional) Configure Load Balancing Settings

Use the uplink load-balance command with the following parameters to configure additional uplink load-
balancing settings. You cannot define load balancing settings unless the uplink manager and uplink load
balancing features are already enabled.
(host) [node] (config) #uplink load-balance ?

mode load-balancing mode

media-mode load-balancing media mode

vlan uplink vlan

To disable uplink load balancing between a managed device and VPN concentrator, disable the load balancing
feature on the managed device (no uplink load-balance) before you disable load balancing on the
VPN concentrator (no vpn-peer peer-mac).
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Policy Based Routing
A policy-based routing (PBR) rule is an ACL that can forward traffic as normal, or route traffic over a VPN tunnel
specified by an IPsec map, routed to a nexthop router on a nexthop list, or redirected over an L3 GRE tunnel or
tunnel group.

A Policy Based Routing (PBR) rule does not become active until it is applied to a VLAN interface or user role.

To associate a policy based routing rule with a managed device:

1. In the Managed Network node hierarchy, navigate to Configuration> Interfaces > IP Routes.

2. Expand the Policy-Based Routing menu.

3. Click + below the Policies table to create a new policy. When you add a new policy, the Add Policy window
appears and prompts you to name the new policy. The policy type (route) is predefined in this window.

4. Select the policy in the Policies table. The Policies > (policy name) table appears.

5. Click + to add a new policy.

6. The New Rule window opens. Select a rule type

l Access Control: Applies the rule to all traffic, or traffic using a specific service, protocol, or TCP/UDP port
or range of ports.

l Application: Applies a rule to an traffic for an application or application category.

7. Configure the rule parameters.

Field Description

IP version Specifies whether the policy applies to IPv4 or IPv6 traffic.

Source
(required)

Source of the traffic, which can be one of the following:

l any: Acts as a wildcard and applies to any source address.

l user: This refers to traffic from the wireless client.

l host: This refers to traffic from a specific host. When this option is chosen, you must configure
the IP address of the host.

l network: This refers to a traffic that has a source IP from a subnet of IP addresses. When this
option is chosen, you must configure the IP address and network mask of the subnet.

l alias: This refers to using an alias for a host or network. You configure the alias by navigating
to the Configuration > Advanced Services > Stateful Firewall > Destination page.

Destination
(required)

Destination of the traffic, which can be configured in the same manner as Source.

Service/AP
P

If you are creating an access control rule, select a type of traffic, which can be one of the
following:

l protocol: Using this option, you specify a different layer 4 protocol (other than TCP/UDP) by
configuring the IP protocol value.

l any: This option specifies that this rule applies to any type of traffic.

l service: Using this option, you use one of the pre-defined services (common protocols such as
HTTPS, HTTP, and others) as the protocol to match for the rule to be applied. You can also

Table 45: Policy Based Routing ACL Rule Parameters



Field Description

specify a network service that you have manually configured. For details, see Creating a
Network Service Alias on page 368.

l tcp: A range of TCP port(s) that must be used by the traffic in order for the rule to be applied.

l udp: A range of UDP port(s) hat must be used by the traffic in order for the rule to be applied.

Scope If you are creating an application rule, select a type of traffic, which can be one of the following:

l application: Create a rule that applies to a specific application type. Click the Application
drop-down list and select an application type.

l application category:Create a rule that applies to a specific application category. Click the
Application Category drop-down list and select a category type.

Action
(required)

The action that you want the controller to perform on a packet that matches the specified criteria.
This can be one of the following:

l Forward Regularly: Packets are forwarded to their next destination without any changes.

l Forward to ipsec-map: Packets are forwarded through an IPsec tunnel defined by the specified
IPsec map. You must specify the position of the forwarding or routing rule. (1 is first, default is
last)

l Forward to next-hop-list: packets are forwarded to the highest priority active device on the
selected next hop list. You must also specify the position of the forwarding or routing rule (1 is
first, default is last). For more information on next-hop lists, see Uplink Routing using Nexthop
Lists on page 223

l Forward to tunnel: Packets are forwarded through the tunnel with the specified tunnel ID. You
must also specify the position of the forwarding or routing rule (1 is first, default is last). For
more information on GRE tunnels, see Configuring GRE Tunnels on page 99.

l Forward to tunnel group: Packets are forwarded through the active tunnel in a GRE tunnel
group. You must also specify the position of the forwarding or routing rule (1 is first, default is
last). For more information on tunnel groups, see GRE Tunnel Groups on page 105.

Position (Optional) Define a position for the rule in the ACL. Rules processed according to their position num-
bers, and new Rules are added at the end of an ACL by default. A position of 1 puts the rule at the
top of the list.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy Changes.

Targets for PBR Rules

Use the command routing-policy-map to associate a routing ACL with a specific user role on a managed device.

l If you selected the VLAN type, click the Target drop-down list and select a VLAN ID to apply the rule to
the VLAN interface's inbound traffic.

Uplink Routing using Nexthop Lists
If the controller uses policy-based routing to forward packets to a next hop device, a next-hop list ensures that
if the primary next-hop device becomes unreachable, the packets matching the policy can still reach their
destination. For more information on nexthop devices, see Policy Based Routing on page 222.

To define a next-hop list:
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1. In the Managed Network node hierarchy, navigate to Configuration> Interfaces > IP Routes.

2. Expand the Next Hop Configuration menu.

3. (Optional) In the Health check probe interval field, specify the probe interval, in seconds. The WAN
health-check feature sends the number of probes defined by the Packet Burst per Probe parameter
during each probe interval. To change the default interval of 10 seconds, enter a new value into this field.

4. (Optional) In the Pocket Burst per Probe field, specify the number of probes to be sent during the probe
interval. To change the default value of 5 probes, enter a new value into this field.

5. Click + below the Nexthop Table to open a pop-up window that allows you to configure the following next-
hop settings:

Parameter Description

Nexthop-list name Name for the new nexthop list.

Nexthop IP / DHCP IP address of the nexthop device or the VLAN ID of the VLAN used by the nexthop
device. If the VLAN gets an IP address using DHCP, and the default gateway is
determined by the VLAN interface, the gateway IP is used as the nexthop IP address.
When you click + to define a NextHop IP or DHCP value, a pop-up list appears and
field requires you to select either the IP or DHCP option.

l If you selected IP, enter the IP address and priority of the nexthop device In the
Nexthop Value and Priority fields.

l If you selected DHCP, enter the VLAN ID and priority of the nexthop device In
the VLAN IP and Priority fields.

IPsec map A nexthop list may require policy-based redirection of traffic to different VPN
tunnels. Click the IPsec map drop-down list to select an IPsec map to redirect
traffic through IPsec tunnels.

Preemptive-Failover If preemptive failover is disabled and the highest-priority device on the nexthop list
is disabled, the new primary nexthop device remains the primary even when the ori-
ginal device comes back online.

Figure 30 Managed Device Next-Hop Settings

6. Click Submit.
7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Targets for PBR Rules

A Policy Based Routing (PBR) rule does not become active until it is applied to a VLAN interface or user role. To
define a target for a PBR rule:

1. In the Managed Network node hierarchy, navigate to Configuration> Interfaces > IP Routes.

2. Select the PBR sub-tab.

3. Click the Add button below the Target table.

4. Click the PBR Rule Name drop-down list and select the rule to be applied to the target.

5. Select the target type: VLAN or User Role.

l If you selected the VLAN type, click the Target drop-down list and select a VLAN ID to apply the rule to
the VLAN interface's inbound traffic.



l If you selected the User Role type, click the Target drop-down list and select a user role. The rule will be
applied to traffic from clients with the selected user role.

6. Click Done.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

Address Pool Management
Each managed device supports one or more client DHCP pools; a pool of IP addresses that can be assigned to
clients associated to that managed device, or to the node itself. In addition to the DHCP pool, the Mobility
Master also allows you to create separate pools of addresses a managed device can use to dynamically assign
to its uplink VLANs, use for NAT translation, or use to create a GRE tunnel to the Mobility Master. These
address pools are pushed out to each manged node when it comes up on the network. If a manged node is
removed from the master, the IP addresses allocated to that managed device can be reused and reassigned to
a new manged node.

ArubaOS supports the following pool types:

l DHCP pools: When you create DHCP pool for a configuration group, that pool defines a set of IP addresses
that can be assigned to client associated to managed devices in that group.

l VLAN Pools: Mobility Master must have a separate VLAN pool defined for each VLAN used by its managed
device. A VLAN pool allocates a static, continuous block of multiple IP addresses to each managed device.
The managed device acts as a DNS proxy server and dynamically assign IP addresses from its allocated pool
to each AP or client on the VLAN.

l Tunnel Pools: The tunnel pool on a manged node defines a range of IP addresses that the manged node
uses to create a GRE tunnel within the IPsec tunnel back to the Mobility Master. Unlike VLAN pools, which
allocates multiple addresses to each manged node VLAN, the tunnel DHCP pool assigns a single tunnel IP
address to each manged node.

l NAT Pools: Used by the managed device for source NAT translation. You can use a NAT pool to create a
firewall policy rule to perform network address translation (NAT) on packets matching the rule.

l VPN Pools: The VPN pool defines a group of IP addresses assigned to VPN clients.

DHCP Address Pools
Use the Configuration > Services > DHCP Server page to configure a pool of DHCP addresses. The
managed device can use one of the addresses from this pool for its own IP address, and/or assign addresses in
the pool to clients associating to that node. To configure a DHCP address pool:

1. In the Managed Network node hierarchy,avigate to Configuration > Services > DHCP Server.
2. Click + below the Pool Configuration table.

3. Define the following values for the pool, then click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy Changes.
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Parameter Description

IP version Assign IPv4 or IPv6 addresses

Pool Name Give a name to the new addres pool

Default router IP address of the default router for the DHCP client. The client should be on the same
subnetwork as the default router. You can specify up to eight IP addresses.

DNS Server IP address of the DNS server. You can specify up to eight IP addresses. Multiple IP
addresses must be separated by spaces.

Import from
DHCP/PPPoE

Select this option to use the DNS server address obtained through PPPoE or DHCP.

Domain Name Domain name to which the client belongs.

WINS IP address of aNetBIOS Windows Internet Naming Service (WINS) server. You can
specify up to eight IP addresses. Multiple IP addresses must be separated by spaces.

Import from
DHCP/PPPoE

Use the NetBIOS name server address obtained through PPPoE or DHCP.

Lease Days The number of days that the assigned IP address is valid for the client.

Lease Hours The number of hours that the assigned IP address is valid for the client.

Lease Minutes The number of minutes that the assigned IP address is valid for the client.

Network
IP Address Type

Choose Static to add a static IP address and netmask to the pool, or select Dynamic
to define a range of addresses that the DHCP server may assign to clients.

l If you select Static, enter an IP address and netmask.

l If you select Dynamic, enter the starting and ending IP address for the address
range, as well as the maximum number of hosts to be supported by the pool.

Option Click Option to apply a client-specific option code and IP address or text string. See
RFC 2132, “DHCP Options and BOOTP Vendor Extensions”.

Figure 31 DHCP Pool Configuration Parameters

To assign a DHCP address pool to a VLAN:

1. In the Managed Network node hierarchy, navigate to Configuration > interfaces > VLANs.

2. In the VLANs table, select the name of the VLAN to which you want to assign the DHCP pool. A VLANS >
(selcted VLAN) table appears

3. Select the VLAN ID of the VLAN to use the address pool. The Port Members table opens.

4. In the Port Members table, select the IPv4 subtab.

5. Click the IP assignment field, and select DHCP Pool.

6. Click the DHCP pool drop-down list and select a DHCP to associate to the VLAN.

7. Click Submit.



8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

VLAN Pools
To create a VLAN pool for uplink interfaces on a managed device:

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces> Pool
Management.

1. Expand the VLAN Pools section

2. Click + below the VLAN Pools table to create a new VLAN pool

3. In the Pool name field, enter a name to the new pool.

4. In the Start IP address field, enter the IP address at the start of the range of addresses.

5. In the End IP address field, enter the IP address at the end of the range of addresses.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

To assign a VLAN address pool to a VLAN:

1. Navigate to Configuration > interfaces > VLANs.

2. In the VLANs table, select the name of the VLAN to which you want to assign the DHCP pool. A VLANS >
(selected VLAN) table appears

3. Select the VLAN ID of the VLAN to use the address pool. The Port Members table opens.

4. In the Port Members table, select the IPv4 subtab.

5. Click the IP assignment field, and select VLAN Pool.

6. Click the VLAN Pool drop-down list and select a DHCP to associate to the VLAN.

NAT Pools
To create a pool of addresses the managed device can use for Network Address Translation:

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces> Pool
Management.

1. Expand the VLAN Pools section

2. Click + below the VLAN Pools table to create a new VLAN pool

3. In the Pool name field, enter a name to the new pool.

4. In the Start IP address field, enter the IP address at the start of the range of addresses.

5. In the End IP address field, enter the IP address at the end of the range of addresses.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Nat pools can associated to firewall policy rules and VPN configurations.

l For information on creating a firewall policy rule that uses the NAT pool to performs NAT translation on
matching packets. see Configuring Firewall Policies on page 363.

l To apply network address translation to VPN clients , navigate to Configuration > Services > VPN >
General VPN, enable the source-nat option, then click the NAT drop-down list and select the NAT pool
you just created.

ArubaOS 8.0.0.0 | User Guide Managed Devices at Branch Offices |  227



228 | Managed Devices at Branch Offices ArubaOS 8.0.0.0  | User Guide

Tunnel Pools
Use tunnel pools to create a pool of IP addresses used by the managed device to create a GRE tunnel to the
Mobility Master. Each managed device uses a single IP address from this pool.

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces> Pool
Management.

2. Expand the Tunnel Pools section

3. Click + below the Tunnel Pools table to create a new VLAN pool

4. In the Pool name field, enter a name to the new pool.

5. In the Start IP address field, enter the IP address at the start of the range of addresses.

6. In the End IP address field, enter the IP address at the end of the range of addresses.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

To associate a tunnel pool to a GRE tunnel:

1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > GRE Tunnels.
2. Select an entry in the GRE Tunnels table to associate a tunnel pool to that GRE tunnel.

3. In the IPv4 Address Type field, select the Dynamic option.

4. Click the Dynamic IP Address Pool drop-down list and select a tunnel pool.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

VPN Pools
To create a pool of addresses used by VPN clients :

1. In the Managed Network node hierarchy, navigate to Configuration > Services > VPN.

1. Expand the General VPN section

2. Click + below the Address Pools table to create a new VPN address pool

3. In the Pool name field, enter a name to the new pool.

4. In the Start IP address field, enter the IP address at the start of the range of addresses.

5. In the End IP address field, enter the IP address at the end of the range of addresses.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Configuring WAN Authentication Survivability
Enable WAN survivability for managed devices on your network by navigating to the Configuration >
Authentication> Advanced tab, then selecting the Survivability tab.

The survivability settings on this tab are described in Table 46.

For additional iformation on WAN Authentication Survivability, including authentication workflows and supported
client and authentication types see the WAN Authentication Survivability Overview on page 206.



Parameter Description

Enable Auth-
Survivability

This parameter controls whether to use the Survival Server when no other
authentication servers in the server group are in-service.

This parameter also controls whether to store the user access credential in the
Survival Server when it is authenticated by an external RADIUS or LDAP server in the
server group. Authentication Survivability is enabled or disabled at each controller.
This parameter is disabled by default.

NOTE: Authentication Survivability will not activate if Authentication Server Dead Time
is configured as 0. For more information on configuring Authentication Server Dead
Time, see Configuring Authentication Timers on page 195.

Authentication Server
Certificate

This parameter allows you to view the name of the server certificate used by the local
Survival Server. The local Survival Server is provided with a default server certificate
from ArubaOS . The customer server certificate must be imported into the managed
device first, and then you can assign the server certificate to the local Survival Server.

Cache Lifetime (hrs) This parameter specifies the lifetime in hours for the cached access credential in the
local Survival Server. When the specified cache-lifetime expires, the cached access
credential is deleted from the managed device.

Configured authentication servers are put into the out-of-service (OOS) state when
authentication requests time out. The managed device picks the next server from the
server group when the previous server times out or fails.

When there are no more servers available from the server group, the local Survival
Server processes the authentication request. When the client is authenticated with the
local Survival Server, the previously stored Key Reply attributes are included in the
RADIUS response.

The Cache Lifetime range is from 1 to 72 hours. The default is 24 hours.

Certificate Type Select the certificate to be used for client authentication.

Table 46: WAN Authentication Survivability for a Managed Device

Preventing WAN Link Failure on Virtual APs
In managed device deployments, the managed devices are connected across the WAN link from the Mobility
Master to the RADIUS server. A WAN link outage will result in service outage as new users cannot be
authenticated to 802.1X Virtual APs. This feature provides limited connectivity to managed devices even when
the WAN link is down. To provide connectivity when the WAN link is down, open and PSK SSID Virtual APs
(VAPs) are available at all times and the user can connect to these VAPs instead of the main 802.1X Virtual AP.

Currently, this feature is targeted for Campus APs in managed device deployments.

When all the WAN links are down, an AP management module in the controller updates the link state using the
notification it receives from the health check manager. Depending on the link state, the new set of Virtual APs
are made available to the users, ensuring minimum service depending on the deployment. The VAPs for WAN
link failure feature can be configured using the Mobility Master WebUI or command-line interface.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration> System> Profiles page.

2. In the All Profiles pane, expand the Wireless LAN menu.

3. Expand the Virtual AP menu.
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4. Select a existing virtual AP profile.

5. Expand the Advanced section.

6. The WAN Operation Mode drop-down list supports the Primary, Always, and Backup WAN modes. To
enable WAN link failure, set this mode to backup.

7. Click Submit.
8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

Managed Device Integration with a Palo Alto Networks (PAN)
Portal
Managed devices can leverage their networks' existing Palo Alto infrastructure to access more advanced
security services, including antivirus services, malware detection and seamless integration with the Palo Alto
Networks WildFireTM cloud-based threat detection.

Overview
Enable Palo Alto firewall integration on Mobility Master to securely redirect internet inbound traffic from
managed devices into the PAN firewall. Although this configuration setting can be used on a stand-alone
Mobility Master, this feature can only be used in this types of deployments when used in conjunction with the
Uplink VLAN manager feature.

The uplink VLAN manager is enabled by default on managed device uplinks. Stand-alone Mobility Masters
using the PAN portal feature must enable the uplink VLAN manager using the uplink command in the Mobility
Master command-line interface.

Figure 32 Managed Device and PAN Firewall Integration



Integration Workflow
The following steps describes the work flow to integrate a managed device with a Palo Alto Networks (PAN)
Large-Scale VPN (LSVPN) firewall.

1. Palo Alto Portal certificates are installed on Mobility Master, and the managed device is configured with the
Palo Alto portal IP address or FQDN, Palo Alto certificate, and the username and password for device
authentication using the Configuration > Services > External Services > PAN Portal section of the
Mobility Master WebUI.

2. The managed device is provisioned via Aruba Activate and downloads its configuration (including Palo Alto
Networks integration settings).

3. The Palo Alto portal may be configured with the device number (a text string comprised of the device serial
number followed by its MAC address) of the managed device at each remote office site. This allows the
managed device to bypass the username and password challenge to authenticate to the portal.

4. The managed device initiates a secure connection to the Palo Alto portal. Once the managed device is
authenticated, the Palo Alto portal sends the managed device a list of PAN gateways and priority levels.
Once the managed device is authenticated, that device appears in the PAN satellite list, as shown in the
figure below.

Figure 33 Palo Alto Networks Active Satellites List

.

5. The managed device uses the Palo Alto Networks gateway list and credentials from the portal to contact all
PAN gateways. Each PAN gateway sends the managed device information that allows the managed device
to automatically create a secure IPsec tunnel and exchange branch subnet routes with each PAN gateway.

6. The managed device maintains a priority list of IPsec tunnels to each PAN gateway to enable failover in the
event a PAN gateway becomes unreachable.

7. Policy-based routing access control lists (ACLs) on the managed device selectively routes traffic to the PAN
gateways.

8. Traffic redirected from the managed device is inspected via the Palo Alto Networks firewall.

Configuration Prerequisites
The Palo Alto Networks LSVPN framework can integrate with a managed device by establishing an IPsec tunnel
between the firewall and the managed device. Integrating a Palo Alto Networks firewall with a managed device
requires that all user traffic is routed, so it can be managed by a policy-based routing access control list.

The following certificate requirements must be fulfilled before the managed device can integrate with the Palo
Alto Networks Large-Scale VPN (LSVPN) framework:
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l the LSVPN framework must be installed and active on your network. For more information on configuring
Palo Alto Networks products, refer to the Palo Alto Networks Technical Documentation portal.

l The CA certificate used by the Palo Alto portal must be installed on Mobility Master, so that it can be pushed
down to the managed device.

l On the PAN gateway devices, you must enable the accept published routes option, and the devices must
install the server certificates derived from the management portal root CA.

In deployments with multiple PAN firewalls, you must configure the PAN management portal with a list of
gateways and the priorities for each PAN gateway. Even if the PAN management portal uses serial number
registration with preregistered serial numbers or MAC addresses, best practice is to configure LDAP, Radius,
Kerberos or Local Database authentication as well. This allows a managed device to authenticate to the portal
even if the portal does not recognize the managed device's MAC address.

Configuring PAN Portal settings
Pan portal settings must be defined via a managed device (/md) configuration. The Mobility Master
configuration node (/mm) does not support PAN portal settings.

1. From a managed device configuration, navigate to Configuration > Services > External Services.

2. Expand the PAN Portal menu.

3. Define values for the configuration settings described in Table 47.

Parameter Description

Portal IP/FQDN The IP address or fully qualified domain name (FQDN) of the portal.

Trusted Certificate Specify the name of the self-signed or external certification authority (CA) certificate to
establish an SSL connection to the portal.

User Name Username to authenticate to the Palo Alto Networks portal.

Password Password to authenticate to the Palo Alto Networks portal.

Table 47: PAN Portal Settings

https://www.paloaltonetworks.com/documentation.html
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Chapter 13
802.1X Authentication

802.1X is an Institute of Electrical and Electronics Engineers (IEEE) standard that provides an authentication
framework for WLANs. 802.1X uses the Extensible Authentication Protocol (EAP) to exchange messages during
the authentication process. The authentication protocols that operate inside the 802.1X framework that are
suitable for wireless networks include EAP-Transport Layer Security (EAP-TLS), Protected EAP (PEAP), and EAP-
Tunneled TLS (EAP-TTLS). These protocols allow the network to authenticate the client while also allowing the
client to authenticate the network.

This chapter describes the following topics:

l Understanding 802.1X Authentication on page 233

l Configuring 802.1X Authentication on page 236

l Sample Configurations on page 246

l Performing Advanced Configuration Options for 802.1X on page 264

Other types of authentication not discussed in this section can be found in the following sections of this guide:

l Captive portal authentication: Configuring Captive Portal Authentication Profiles on page 300

l VPN authentication: Planning a VPN Configuration on page 335

l MAC authentication: Configuring MAC-Based Authentication on page 198

l Stateful 802.1X, stateful NTLM, and WISPr authentication: Stateful and WISPr Authentication on page 269

Understanding 802.1X Authentication
802.1X authentication consists of three components:

l The supplicant, or client, is the device attempting to gain access to the network. You can configure the Aruba
user-centric network to support 802.1X authentication for wired users and wireless users.

l The authenticator is the gatekeeper to the network and permits or denies access to the supplicants.

l The Aruba managed device acts as the authenticator, relaying information between the authentication
server and supplicant. The EAP type must be consistent between the authentication server and supplicant,
and is transparent to the managed device.

The authentication server provides a database of information required for authentication, and informs the
authenticator to deny or permit access to the supplicant.

The 802.1X authentication server is typically an EAP-compliant Remote Access Dial-In User Service (RADIUS)
server which can authenticate either users (through passwords or certificates) or the client computer.

An example of an 802.1X authentication server is the Internet Authentication Service (IAS) in Windows (see
http://technet.microsoft.com/en-us/library/cc759077(WS.10).aspx).

In Aruba user-centric networks, you can terminate the 802.1X authentication on the managed device. The
managed device passes user authentication to its internal database or to a “backend” non-802.1X server.
This feature, also called AAA FastConnect, is useful for deployments where an 802.1X EAP-compliant RADIUS
server is not available or required for authentication.

Supported EAP Types
Following is the list of supported EAP types:

http://technet.microsoft.com/en-us/library/cc759077(WS.10).aspx
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l PEAP — Protected EAP (PEAP) is an 802.1X authentication method that uses server-side public key
certificates to authenticate clients with the server. The PEAP authentication creates an encrypted SSL / TLS
tunnel between the client and the authentication server. The exchange of information is encrypted and
stored in the tunnel to ensure that the user credentials are kept secure.

l EAP-GTC—The EAP-GTC (Generic Token Card) type uses clear text method to exchange authentication
controls between the client and the server. Since the authentication mechanism uses the one-time tokens
(generated by the card), this method of credential exchange is considered safe. In addition, EAP-GTC is used
in PEAP or TTLS tunnels in wireless environments. The EAP-GTC is described in RFC 2284.

l EAP-AKA—The EAP-AKA (Authentication and Key Agreement) authentication mechanism is typically used in
mobile networks that include Universal Mobile Telecommunication Systems (UMTS) and CDMA 2000. This
method uses the information stored in the Subscriber Identity Module (SIM) for authentication. The EAP-
AKA is described in RFC 4187.

l EAP-FAST—The EAP-FAST (Flexible Authentication via Secure Tunneling) is an alternative authentication
method to PEAP. This method uses the Protected Access Credential (PAC) for verifying clients on the
network. The EAP-FAST is described in RFC 4851.

l EAP-MD5—The EAP-MD5 method verifies MD5 hash of a user password for authentication. This method is
commonly used in a trusted network. The EAP-MD5 is described in RFC 2284.

l EAP-POTP—The EAP type 32 is supported. Complete details are described in RFC 4793.

l EAP-SIM—The EAP-SIM (Subscriber Identity Module) uses Global System for Mobile Communication (GSM)
Subscriber Identity Module (SIM) for authentication and session key distribution. This authentication
mechanism includes network authentication, user anonymity support, result indication, and fast re-
authentication procedure. Complete details about this authentication mechanism is described in RFC 4186.

l EAP-TLS—The EAP-TLS (Transport Layer Security) uses Public key Infrastructure (PKI) to set up
authentication with a RADIUS server or any authentication server. This method requires the use of a client-
side certificate for communicating with the authentication server. The EAP-TLS is described in RFC 5216.

l EAP-TLV—The EAP-TLV (type-length-value) method allows you to add additional information in an EAP
message. Often this method is used to provide more information about an EAP message such as status
information or authorization data. This method is always used after a typical EAP authentication process.

l EAP-TTLS—The EAP-TTLS (Tunneled Transport Layer Security) method uses server-side certificates to set up
authentication between clients and servers. The actual authentication is, however, performed using
passwords. Complete details about EAP-TTLS is described in RFC 5281.

l LEAP—Lightweight Extensible Authentication Protocol (LEAP) uses dynamic WEP keys and mutual
authentication between the client and the RADIUS server.

l ZLXEAP—ZoneLabs EAP is an EAP method that has been allocated EAP Type 44 by IANA. For more
information, visit http://tools.ietf.org/html/draft-bersani-eap-synthesis-sharedkeymethods-00#page-30.

Configuring Authentication with a RADIUS Server
See Table 48 for an overview of the parameters that you need to configure on authentication components
when the authentication server is an 802.1X EAP-compliant RADIUS server.



Figure 34 802.1X Authentication with a RADIUS Server

The supplicant and the authentication server must be configured to use the same EAP type. The managed
device does not need to know the EAP type used between the supplicant and authentication server.

For the managed device to communicate with the authentication server, you must configure the IP address,
authentication port, and accounting port of the server on the managed device. The authentication server must
be configured with the IP address of the RADIUS client, which is the managed device in this case. Both the
managed device and the authentication server must be configured to use the same shared secret.

Additional information on EAP types supported in a Windows environment, Microsoft supplicants, and
authentication servers, is available at http://technet.microsoft.com/en-us/library/cc782851
(WS.10).aspx.

The client communicates with the managed device through a GRE tunnel to form an association with an AP and
to get authenticated in the network. Therefore, the network authentication and encryption configured for an
ESSID must be the same on both the client and the managed device.

Configuring Authentication Terminated on managed device
User authentication is performed either via the managed device’s internal database or a non-802.1X server.
See 802.1X Authentication Profile WebUI Parameters on page 237 for an overview of the parameters that you
need to configure on 802.1X authentication components when 802.1X authentication is terminated on the
managed device (AAA FastConnect).

Figure 35 802.1X Authentication with Termination onManaged device

In this scenario, the supplicant is configured for EAP-Transport Layer Security (TLS) or EAP-Protected EAP
(PEAP).
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l EAP-TLS is used with smart card user authentication. A smart card holds a digital certificate which, with the
user-entered personal identification number (PIN), allows the user to be authenticated on the network. EAP-
TLS relies on digital certificates to verify the identities of both the client and the server.

EAP-TLS requires that you import server and certification authority (CA) certificates onto the managed
device (see Configuring and Using Certificates with AAA FastConnect on page 242). The client certificate is
verified on the managed device (the client certificate must be signed by a known CA) before the username is
checked on the authentication server.

l EAP-PEAP uses TLS to create an encrypted tunnel. Within the tunnel, one of the following “inner EAP”
methods is used:

n EAP-Generic Token Card (GTC): Described in RFC 2284, this EAP method permits the transfer of
unencrypted usernames and passwords from client to server. The main uses for EAP-GTC are one-time
token cards such as SecureID and the use of an LDAP or RADIUS server as the user authentication
server. You can also enable caching of user credentials on the managed device as a backup to an external
authentication server.

n EAP-Microsoft Challenge Handshake Authentication Protocol version 2 (MS-CHAPv2): Described in RFC
2759, this EAP method is widely supported by Microsoft clients. A RADIUS server must be used as the
backend authentication server.

If you use the managed device’s internal database for user authentication, you need to add the names and
passwords of the users to be authenticated. If you use an LDAP server for user authentication, you need to
configure both the LDAP server and the user IDs and passwords on the managed device. If you use a RADIUS
server for user authentication, you need to configure the RADIUS server on the managed device.

Configuring 802.1X Authentication
On the managed device, use the following steps to configure a wireless network that uses 802.1X
authentication:

1. Configure the VLANs to which the authenticated users will be assigned. See Network Configuration
Parameters on page 81.

2. Configure policies and roles. You can specify a default role for users who are successfully authenticated
using 802.1X. You can also configure server derivation rules to assign a user role based on attributes
returned by the authentication server; server-derived user roles take precedence over default roles. For
more information about policies and roles, see Roles and Policies on page 363.

The Policy Enforcement Firewall Virtual Private Network (PEFV) module provides identity-based security for wired and
wireless users and must be installed on the managed device. The stateful firewall allows user classification based on
user identity, device type, location, and time of day to provide differentiated access for different classes of users. For
information about obtaining and installing licenses, refer to the Aruba Mobility Master Licensing Guide.

3. Configure the authentication server(s) and server group. The server can be an 802.1X RADIUS server or, if
you use AAA FastConnect, a non-802.1X server or the managed device’s internal database. If you use EAP-
GTC within a PEAP tunnel, configure an LDAP or RADIUS server as the authentication server (see
Authentication Servers on page 174). If you use EAP-TLS, import server and CA certificates on the managed
device (see Configuring and Using Certificates with AAA FastConnect on page 242).

4. Configure the AAA profile:

n Select the 802.1X default user role.

n Select the server group you previously configured for the 802.1X authentication server group.

5. Configure the 802.1X authentication profile. See In the WebUI on page 259.

6. Configure the virtual AP profile for an AP group or for a specific AP:

n Select the AAA profile you previously configured.



n In the SSID profile, configure the WLAN for 802.1X authentication.

For details on how to complete the above steps, see Sample Configurations on page 246.

In the WebUI
This section describes how to create and configure a new instance of an 802.1X authentication profile in the
WebUI or the CLI.

1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > L2
Authentication tab.

2. In the L2 Authentication table, select 802.1X Authentication Profile.

3. click + in the 802.1X Authentication Profile: New Profile.
4. Change the settings described in Table 48 as desired, then click Save As.
5. Enter a name for the new profile in the Profile Name field.

Parameter Description

Max authentication
failures

Number of times a user can try to log in with wrong credentials

after which the user is blacklisted as a security threat. Set to 0

to disable blacklisting, otherwise enter a non-zero integer to

blacklist the user after the specified number of failures.

Range: 0-5 failures.

Default: 0 failure.

NOTE: This option may require a license.

Enforce Machine
Authentication

Select the Enforce Machine Authentication option to require

machine authentication. This option is also available on the Basic settings tab.

NOTE: This option may require a license.

Machine
Authentication Default
Machine Role

Default role assigned to the user after 802.1X authentication. The default role
for this setting is the “guest” role.

Machine
Authentication Cache
Timeout

The timeout, in hours, for machine authentication. The allowed range of values is
1-1000 hours, and the default value is 24 hours.

Blacklist on Machine
Authentication Failure

Select the Blacklist on Machine Authentication Failure check box to blacklist
a client if machine authentication fails. This setting is disabled by default.

Machine
Authentication Default
User Role

Default role assigned to the user after completing only machine authentication.
The default role for this setting is the “guest” role.

Interval between
Identity Requests

Interval, in seconds, between identity request retries.

Range: 1-65535 seconds.

Default: 30 seconds.

Table 48: 802.1X Authentication Profile WebUI Parameters

ArubaOS 8.0.0.0 | User Guide 802.1X Authentication |  237



238 | 802.1X Authentication ArubaOS 8.0.0.0  | User Guide

Parameter Description

Quiet Period after
Failed Authentication

The enforced quiet period interval, in seconds, following failed authentication.
Range: 1-65535 seconds.

Default: 30 seconds.

Reauthentication
Interval

Interval, in seconds, between reauthentication attempts.

Range: 60-864000 seconds.

Default: 86400 seconds (1 day).

Use Server provided
Reauthentication
Interval

Select this option to override any user-defined reauthentication interval and use
the reauthentication period defined by the authentication server.

Multicast Key Rotation
Time Interval

Interval, in seconds, between multicast key rotation.

Range: 60-864000 seconds.

Default: 1800 seconds.

Unicast Key Rotation
Time Interval

Interval, in seconds, between unicast key rotation.

Range: 60-864000 seconds. Default: 900 seconds.

Authentication Server
Retry Interval

Server group retry interval, in seconds.

Range: 5-65535 seconds.

Default: 30 seconds.

Authentication Server
Retry Count

Maximum number of authentication requests that are sent to server group.

Range: 0-3 requests.

Default: 2 requests.

Framed MTU Sets the framed Maximum Transmission Unit (MTU) attribute sent to the
authentication server.

Range: 500-1500 bytes.

Default: 1100 bytes.

Max number of
requests sent during
an Auth attempt

Maximum number of times ID requests are sent to the client.

Range: 1-10 retries.

Default: 3 retries.

Maximum Number of
Reauthentication
Attempts

Number of times a user can try to log in with wrong credentials after which the
user is blacklisted as a security threat. Set to 0 to disable blacklisting, otherwise
enter a value from 0-5 to blacklist the user after the specified number of failures.

NOTE: If changed from its default value, this option may require a license.

Table 48: 802.1X Authentication Profile WebUI Parameters



Parameter Description

Maximum number of
times Held State can
be bypassed

Number of consecutive authentication failures which, when reached, causes the
managed device to not respond to authentication requests from a client while
the managed device is in a held state after the authentication failure. Before this
number is reached, the managed device responds to authentication requests
from the client even while the managed device is in its held state.

(This parameter is applicable when 802.1X authentication is terminated on the
managed device, also known as AAA FastConnect.) The allowed range of values
for this parameter is 0-3 failures, and the default value is 0.

Dynamic WEP Key
Message Retry Count

Set the Number of times WPA/WPA2 Key Messages are retried.

Range: 1-5 retries.

Default: 3 retries.

Dynamic WEP Key Size The default dynamic WEP key size is 128 bits, If desired, you can change this
parameter to 40 bits.

Interval between
WPA/WPA2 Key
Messages

Interval, in milliseconds, between each WPA key exchanges.

Range: 1000-5000 ms.

Default: 1000 ms.

Delay between EAP-
Success and WPA2
Unicast Key Exchange

Interval, in milliseconds, between EAP-Success and unicast key exchanges.

Range: 0-2000 ms.

Default: 0 ms (no delay).

Delay between
WPA/WPA2 Unicast
Key and Group Key
Exchange

Interval, in milliseconds, between unicast and multicast key exchange. Time
interval in milliseconds.

Range: 0-2000.

Default: 0 (no delay).

Time interval after
which the PMKSA will
be deleted

The time interval after which the PMKSA (Pairwise Master Key Security
Association) cache is deleted. Time interval in Hours.

Range: 1-2000.

Default: 8.

WPA/WPA2 Key
Message Retry Count

Number of times WPA/WPA2 key messages are retried.

Range: 1-5 retries.

Default: 3 retries.

Multicast Key Rotation Select this check box to enable multicast key rotation. This feature is disabled by
default.

Unicast Key Rotation Select this check box to enable unicast key rotation. This feature is disabled by
default.

Table 48: 802.1X Authentication Profile WebUI Parameters
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Parameter Description

Reauthentication Select the Reauthentication check box to force the client to do a 802.1X
reauthentication after the expiration of the default timer for reauthentication.
(The default value of the timer is 24 hours.) If the user fails to reauthenticate
with valid credentials, the state of the user is cleared. If derivation rules are used
to classify 802.1X-authenticated users, then the reauthentication timer per role
overrides this setting.

This option is disabled by default.

Opportunistic Key
Caching

By default, the 802.1X authentication profile enables a cached pairwise master
key (PMK) which is derived through a client and an associated AP. This key is
used when the client roams to a new AP. This allows clients faster roaming
without a full 802.1X authentication. Uncheck this option to disable this feature.

NOTE: Make sure that the wireless client (the 802.1X supplicant) supports this
feature. If the client does not support this feature, the client will attempt to
renegotiate the key whenever it roams to a new AP. As a result, the key cached
on the managed device can be out of sync with the client's key.

Validate PMKID This parameter instructs the managed device to check the pairwise master key
(PMK) ID sent by the client. When you enable this option, the client must send a
PMKID in the associate or reassociate frame to indicate that it supports OKC or
PMK caching; otherwise, full 802.1X authentication takes place.

NOTE: This feature is optional, since most clients that support OKC and PMK
caching do not send the PMKID in their association request.

Termination Select the Termination check box to allow 802.1X authentication to terminate
on the managed device. This option is disabled by default.

Termination EAP-Type If you enable termination, click either EAP-PEAP or EAP-TLS to select a Extensible
Authentication Protocol (EAP) method.

Termination Inner
EAP-Type

If you use EAP-PEAP as the EAP method, specify one of the following

inner EAP types:

l eap-gtc: Described in RFC 2284, this EAP method permits the transfer of
unencrypted usernames and passwords from client to server. The main uses
for EAP-GTC are one-time token cards such as SecureID and the use of LDAP
or RADIUS as the user authentication server. You can also enable caching of
user credentials on the managed device as a backup to an external
authentication server.

l eap-mschapv2: Described in RFC 2759, this EAP method is widely supported
by Microsoft clients.

Enforce Suite-B 128
bit or more security
level Authentication

Configure Suite-B 128 bit or more security level authentication enforcement.

Enforce Suite-B 128
bit or more security
level Authentication

Configure Suite-B 192 bit security level authentication enforcement.

Table 48: 802.1X Authentication Profile WebUI Parameters



Parameter Description

Termination Select the Termination check box to allow 802.1X authentication to terminate
on the managed device. This option is disabled by default.

Termination EAP-Type If you enable termination, click either EAP-PEAP or EAP-TLS to select a Extensible
Authentication Protocol (EAP) method.

Termination Inner
EAP-Type

If you use EAP-PEAP as the EAP method, specify one of the following

inner EAP types:

l eap-gtc: Described in RFC 2284, this EAP method permits the transfer of
unencrypted usernames and passwords from client to server. The main uses
for EAP-GTC are one-time token cards such as SecureID and the use of LDAP
or RADIUS as the user authentication server. You can also enable caching of
user credentials on the managed device as a backup to an external
authentication server.

l eap-mschapv2: Described in RFC 2759, this EAP method is widely supported
by Microsoft clients.

Token Caching If you select EAP-GTC as the inner EAP method, you can select the Token
Caching check box to enable the managed device to cache the username and
password of each authenticated user. The managed device continues to
reauthenticate users with the remote authentication server. However, if the
authentication server is unavailable, the managed device will inspect its cached
credentials to reauthenticate users.

This option is disabled by default.

Token Caching Period If you select EAP-GTC as the inner EAP method, you can specify the timeout
period, in hours, for the cached information. The default value is 24 hours.

CA-Certificate Click the CA-Certificate drop-down list and select a certificate for client
authentication. The CA certificate needs to be loaded in the managed device
before it will appear on this list.

Server-Certificate Click the Server-Certificate drop-down list and select a server certificate the
managed device will use to authenticate itself to the client.

NOTE: By default, the default-self-signed certificate is used as server
certificate. For more details on default-self-signed certificate, see Managing
Certificates on page 758.

TLS Guest Access Select TLS Guest Access to enable guest access for EAP-TLS users with valid

certificates. This option is disabled by default.

TLS Guest Role Click the TLS Guest Role drop-down list and select the default user role for EAP-
TLS guest users. This option may require a license.

Ignore EAPOL-START
after authentication

Select Ignore EAPOL-START after authentication to ignore EAPOL-START
messages after authentication. This option is disabled by default.

Table 48: 802.1X Authentication Profile WebUI Parameters
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Parameter Description

Handle EAPOL-Logoff Select Handle EAPOL-Logoff to enable handling of EAPOL-LOGOFF messages.
This option is disabled by default.

Ignore EAP ID during
negotiation

Select Ignore EAP ID during negotiation to ignore EAP IDs during negotiation.
This option is disabled by default.

WPA-Fast-Handover Select this option to enable WPA-fast-handover on phones that support this
feature. WAP fast-handover is disabled by default.

Check certificate
common name
against AAA server

If you use client certificates for user authentication, enable this option to verify
that the certificate's common name exists in the server. This parameter is
enabled by default in the default-cap and default-rap VPN profiles, and disabled
by default on all other VPN profiles.

Disable rekey and
reauthentication for
clients on call

This feature disables rekey and reauthentication for VoWLAN clients. It is
disabled by default, meaning that rekey and reauthentication is enabled.

NOTE: This option may require a license

Table 48: 802.1X Authentication Profile WebUI Parameters

In the CLI
The following command configures settings for an 802.1X authentication profiles. Individual parameters are
described in the previous table.
(host) [mynode](config)# aaa authentication dot1x {<profile>|countermeasures}

Configuring and Using Certificates with AAA FastConnect
The managed device supports 802.1X authentication using digital certificates for AAA FastConnect.

l Server Certificate—A server certificate installed in the managed device verifies the authenticity of the
managed device for 802.1X authentication. Aruba managed device ship with a demonstration digital
certificate. Until you install a customer-specific server certificate in the managed device, this demonstration
certificate is used by default for all secure HTTP connections (such as the WebUI and captive portal) and AAA
FastConnect. This certificate is included primarily for the purposes of feature demonstration and
convenience, and is not intended for long-term use in production networks. Users in a production
environment are urged to obtain and install a certificate issued for their site or domain by a well-known
certificate authority (CA). You can generate a Certificate Signing Request (CSR) on the managed device to
submit to a CA. For information on how to generate a CSR and how to import the CA-signed certificate into
the managed device, see Managing Certificates on page 758.

l Client Certificates—Client certificates are verified on the managed device (the client certificate must be
signed by a known CA) before the username is checked on the authentication server. To use client certificate
authentication for AAA FastConnect, you need to import the following certificates into the managed device
(see Importing Certificates on page 761):

n managed device’s server certificate

n CA certificate for the CA that signed the client certificates

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > L2

Authentication page.



2. In the L2 Authentication table, select 802.1X Authentication Profile.

3. Select the default 802.1X authentication profile to display configuration parameters.

4. Select the Termination check box.

5. In the Server-Certificate field, select the server certificate imported into the managed device.

6. In the CA-Certificate field, select the CA certificate imported into the managed device.

7. Click Save As Enter a name for the 802.1X authentication profile.

8. Enter a name for the new profile in the Profile Name field.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) # aaa authentication dot1x <profile>

   termination enable

   server-cert <certificate>

   ca-cert <certificate>

Configuring User and Machine Authentication
When a Windows device boots, it logs onto the network domain using a machine account. Within the domain,
the device is authenticated before computer group policies and software settings can be executed; this process
is known asmachine authentication. Machine authentication ensures that only authorized devices are allowed
on the network.

You can configure 802.1X for both user and machine authentication (select the Enforce Machine
Authentication option described in Table 48). This tightens the authentication process further, since both the
device and user need to be authenticated.

Working with Role Assignment with Machine Authentication Enabled
When you enable machine authentication, there are two additional roles you can define in the 802.1X
authentication profile:

l Machine authentication default machine role

l Machine authentication default user role

While you can select the same role for both options, you should define the roles as per the polices that need to
be enforced. Also, these roles can be different from the 802.1X authentication default role configured in the
AAA profile.

With machine authentication enabled, the assigned role depends upon the success or failure of the machine
and user authentications. In certain cases, the role that is ultimately assigned to a client can also depend upon
attributes returned by the authentication server or server derivation rules configured on the managed device.

Table 49 describes role assignment based on the results of the machine and user authentications.
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Machine
Auth
Status

User
Auth
Status

Description Role Assigned

Failed Failed Both machine authentication and
user authentication failed. L2
authentication failed.

No role assigned. No access to the
network allowed.

Failed Passed Machine authentication failed (for
example, the machine information is
not present on the server) and user
authentication succeeded. Server-
derived roles do not apply.

Machine authentication default user
role configured in the 802.1X
authentication profile.

Passed Failed Machine authentication succeeded
and user authentication has not been
initiated. Server-derived roles do not
apply.

Machine authentication default
machine role configured in the
802.1X authentication profile.

Passed Passed Both machine and user are
successfully authenticated. If there
are server-derived roles, the role
assigned via the derivation take
precedence. This is the only case
where server-derived roles are
applied.

A role derived from the
authentication server takes
precedence. Otherwise, the 802.1X
authentication default role
configured in the AAA profile is
assigned.

Table 49: Role Assignment for User and Machine Authentication

For example, if the following roles are configured:

l 802.1X authentication default role (in AAA profile): dot1x_user

l Machine authentication default machine role (in 802.1X authentication profile): dot1x_mc

l Machine authentication default user role (in 802.1X authentication profile): guest

Role assignment is as follows:

l If both machine and user authentication succeed, the role is dot1x_user. If there is a server-derived role, the
server-derived role takes precedence.

l If only machine authentication succeeds, the role is dot1x_mc.

l If only user authentication succeeds, the role is guest.

l On failure of both machine and user authentication, the user does not have access to the network.

With machine authentication enabled, the VLAN to which a client is assigned (and from which the client obtains
its IP address) depends upon the success or failure of the machine and user authentications. The VLAN that is
ultimately assigned to a client can also depend upon attributes returned by the authentication server or server
derivation rules configured on the managed device (see Understanding VLAN Assignments on page 83). If
machine authentication is successful, the client is assigned the VLAN configured in the virtual AP profile.
However, the client can be assigned a derived VLAN upon successful user authentication.

You can optionally assign a VLAN as part of a user role configuration. Do not use VLAN derivation if you
configure user roles with VLAN assignments.

Table 50 describes VLAN assignment based on the results of the machine and user authentications when VLAN
derivation is used.



Machine Auth
Status

User
Auth
Status

Description VLAN Assigned

Failed Failed Both machine authentication and user
authentication failed. L2 authentication
failed.

No VLAN.

Failed Passed Machine authentication failed (for
example, the machine information is not
present on the server) and user
authentication succeeded.

VLAN configured in
the virtual AP profile.

Passed Failed Machine authentication succeeded and
user authentication has not been
initiated.

VLAN configured in
the virtual AP profile.

Passed Passed Both machine and user are successfully
authenticated.

Derived VLAN.
Otherwise, VLAN
configured in the
virtual AP profile.

Table 50: VLAN Assignment for User and Machine Authentication

The administrator can now associate a VLAN ID to a client data based on the authentication credentials in a bridge
mode.

Enabling 802.1X Supplicant Support on an AP
ArubaOS provides 802.1X supplicant support on the Access Point (AP). The AP can be used as a 802.1X
supplicant where access to the wired Ethernet network is restricted to those devices that can authenticate
using 802.1X. You can provision an AP to act as an 802.1X supplicant and authenticate to the infrastructure
using the PEAP protocol.

Both Campus APs (CAPs) and Remote APs (RAPs) can be provisioned to use 802.1X authentication.

Prerequisites
l An AP has to be configured with the credentials for 802.1X authentication. These credentials are stored

securely in the AP flash.

l The AP must complete the 802.1X authentication before it sends or receives IP traffic such as DHCP.

If the AP cannot complete 802.1X authentication (explicit failure or reply timeout) within 1 minute, the AP will proceed
to initiate the IP traffic and attempt to contact the managed device. The infrastructure can be configured to allow this.
If the AP contacts the managed device it will be marked as unprovisioned so that the administrator can take
corrective action.

Provisioning an AP as an 802.1X Supplicant
This section describes how an AP can be provisioned as an 802.1X supplicant using CLI or the WebUI.
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In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Access Points.

2. Click Access Points > Provisioning window. The list of discovered APs are displayed on this page.

3. Select the AP you want to provision.

4. Select the AP to which you want to add new provisioning settings, then click Provision. The AP provisioning
settings divided into two groups. By default, the ArubaOS WebUI displays only the basic, commonly used
configuration settings. The advanced settings are hidden until you click the Show Advanced options link.

5. Select the 802.1X Parameters using PEAP:

a. PEAP username: Enter the username of the AP in the User Name field.

b. PEAP password: Enter the password of the AP in the Password field.

6. Enter the password again in the Retype PEAP password field and reconfirm it.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)# provision-ap

(host) [mynode] (config-submode)# apdot1x-username <username>

(host) [mynode] (config-submode)# apdot1x-passwd <password>

To view the 802.1X authentication details on the managed devices:
(host) [mynode] # show ap active

Sample Configurations
The following examples show basic configurations:

l Configuring Authentication with an 802.1X RADIUS Server on page 246

l Configuring Authentication with the Managed Device’s Internal Database on page 257

In the following examples:

l Wireless clients associate to the ESSID WLAN-01.

l The following roles allow different networks access capabilities:

n student

n faculty

n guest

n system administrators

The examples show how to configure using the WebUI and CLI commands.

Configuring Authentication with an 802.1X RADIUS Server
l An EAP-compliant RADIUS server provides the 802.1X authentication. The RADIUS server administrator

must configure the server to support this authentication. The administrator must also configure the server
to all communications with the Aruba Mobility Master.

l The authentication type is WPA. From the 802.1X authentication exchange, the client and the Mobility
Master derive dynamic keys to encrypt data transmitted on the wireless network.

l 802.1X authentication based on PEAP with MS-CHAPv2 provides both computer and user authentication. If
a user attempts to log in without the computer being authenticated first, the user is placed into a more
limited “guest” user role.



Windows domain credentials are used for computer authentication, and the user’s Windows login and
password are used for user authentication. A single user sign-on facilitates both authentication to the
wireless network and access to the Windows server resources.

802.1X Configuration for IAS and Windows Clients on page 1040 describes how to configure the Microsoft Internet
Authentication Server and Windows XP wireless client to operate with the managed device configuration shown in
this section.

Configuring Roles and Policies
You can create the following policies and user roles for:

l Student

l Faculty

l Guest

l Sysadmin

l Computer

Creating the Student Role and Policy
The student policy prevents students from using telnet, POP3, FTP, SMTP, SNMP, or SSH to the wired portion
of the network. The student policy is mapped to the student user role.

In the WebUI

1. In a Managed Network node hierarchy, navigate to the Configuration > Roles & Policies > Policies
tab.

2. Select + to add the student policy.

3. For Policy Name, enter student,

4. Policy Type, select Session.

5. Click Save.

6. Select the student role from the Policies table.

7. In the Policies > student table, click + to add rules for the policy.

a. For Rule type, select Access Control, then click OK.

b. For Source, select user.

c. For Destination, select alias.

The following step defines an alias representing all internal network addresses. Once defined,
you can use the alias for other rules and policies.

d. Under the Destination alias selection, click +. For Destination Name, enter Internal Network. Click + to
add a rule. For Rule Type, select network. For IP Address, enter 10.0.0.0. For Network Mask/Range,
enter 255.0.0.0. Click Add to add the network range. Repeat these steps to add the network range
172.16.0.0 - 255.255.0.0. Click OK, then click Submit.The alias Internal Network appears in the
Destination menu. This step defines an alias representing all internal network addresses. Once defined,
you can use the alias for other rules and policies.

e. Under Destination, select Internal Network.

f. Under Service, select service. In the Service scrolling list, select svc-telnet.

g. Under Action, select drop.

h. Click Add.

8. Under Rules, click Add.
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a. Under Source, select user.

b. Under Destination, select alias and then select Internal Network.

c. Under Service, select service. In the Service scrolling list, select svc-pop3.

d. Under Action, select drop.

e. Click Add.

9. Repeat steps 4A-E to create rules for the following services: svc-ftp, svc-smtp, svc-snmp, and svc-ssh.

10.Click Save.

11.Click Submit.

12.Click the Roles tab. Click + to create the student role.

13.For Role Name, enter student then click Submit.

14.Select the role you just created from the Roles table.

15.Select Show Advanced View.

16.In the Roles > student table, select the Policies tab.

17.C lick + to add a new policy.

18.Select Add existing session policy and select the student policy you previously created. Click Done.

19.Click Submit.

20.Click Pending Changes.

21.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #ip access-list session student

   user alias “Internal Network” svc-telnet deny

   user alias “Internal Network” svc-pop3 deny

   user alias “Internal Network” svc-ftp deny

   user alias “Internal Network” svc-smtp deny

   user alias “Internal Network” svc-snmp deny

   user alias “Internal Network” svc-ssh deny

(host)[mynode](config) #user-role student

   session-acl student

   session-acl allowall

Creating the Faculty Role and Policy
The faculty policy is similar to the student policy, however faculty members are allowed to use POP3 and
SMTP for VPN remote access from home. (Students are not permitted to use VPN remote access.) The faculty
policy is mapped to the faculty user role.

In the WebUI

1. In a Managed Network node hierarchy, navigate to the Configuration > Roles & Policies > Policies
tab.

2. Click + to add the faculty policy.

3. For Policy Name, enter faculty.

4. For Policy Type, select Session.

5. Click Submit.

6. Select the new faculty policy from the Policies table.

7. Click + in the Policies > Faculty table to add rules for the policy.

a. Click Rule Type, select Access Control, then click OK.

b. Click Source, and select user.



c. Click Destination, select alias, then select Internal Network.

d. Click Service/App and select service.

e. Click the Service Alias drop-down list, and select svc-telnet.

f. Click Action, and select deny.

g. Click Save.

h. Repeat steps A-E to create rules for the following services: svc-ftp, svc-snmp, and svc-ssh.

8. Click Submit.

9. Select the Roles tab. Click + to create the faculty role.

10.in the Name dialog box, enter faculty then click Submit.

11.Select the role you just created from the Roles table.

12.Select Show Advanced View.

13.In the Roles > faculty table, select the Policies tab.

14.C lick + to add a new policy.

15.Select Add existing session policy and select the faculty policy you previously created. Click Done.

16.Click Submit.

17.Click Pending Changes.

18.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #ip access-list session faculty

   user alias “Internal Network” svc-telnet deny

   user alias “Internal Network” svc-ftp deny

   user alias “Internal Network” svc-snmp deny

   user alias “Internal Network” svc-ssh deny

(host)[mynode](config) #user-role faculty

   session-acl faculty

   session-acl allowall

Creating the Guest Role and Policy
The guest policy permits only access to the internet (via HTTP or HTTPS) and only during daytime working
hours. The guest policy is mapped to the guest user role.

In the WebUI

1. In a Managed Network node hierarchy, navigate to the Configuration > Roles & Policies> Roles tab.

2. Select a role name and click + in the Roles > Roles Names table.

1. Click + for the Time range field and enter the following details:

a. For Name, enter working-hours.

b. For Type, select Periodic.

c. For Start day, click Weekday.

d. For Start time(hh:mm), enter 07:30.

e. For End time(hh:mm), enter 17:00.

f. Click OK.

g. Click Submit.

2. Click the Policies tab. Click + to add the guest policy.

3. For Policy Name, enter guest.

4. For Policy Type, select Session.
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5. Click Submit.

6. Select the Policy name under Policies. The Policies > policy Name table is displayed.

7. Click + under the Policies > policy Name table.

8. Select Access Control for the Rule Type and click OK.

9. Add the following New Forwarding Rule information for the policy.

To create rules to permit access to DHCP and DNS servers during working hours:

a. Under Source, select user.

b. Under Destination, select host. In Host IP, enter 10.1.1.25.

c. Under Service, select service. In the Service scrolling list, select svc-dhcp.

d. Under Action, select permit.

e. Under Time Range, select working-hours.

f. Click Add.

g. Repeat steps A-F to create a rule for svc-dns.

To create a rule to deny access to the internal network:

a. Under Source, select user.

b. Under Destination, select alias. Select Internal Network.

c. Under Service, select any.

d. Under Action, select drop.

e. Click Add.

To create rules to permit HTTP and HTTPS access during working hours:

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select service. In the Services scrolling list, select svc-http.

d. Under Action, select permit.

e. Under Time Range, select working-hours.

f. Click Add.

g. Repeat steps A-F for the svc-https service.

To create a rule that denies the user access to all destinations and all services:

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select any.

d. Under Action, select drop.

e. Click Add.

10.Click Save.

11.Click Submit.

12.Click the Roles tab. Click Add to create the guest role.

13.For Role Name, enter guest.
14.Under Firewall Policies, click +. In Choose from Configured Policies, select the guest policy you previously

created. Click Done.

15.Click Pending Changes.

16.In the Pending Changes window, select the check box and click Deploy changes.



In the CLI
time-range working-hours periodic

   weekday 07:30 to 17:00

(host)[mynode](config) #ip access-list session guest

   user host 10.1.1.25 svc-dhcp permit time-range working-hours

   user host 10.1.1.25 svc-dns permit time-range working-hours

   user alias “Internal Network” any deny

   user any svc-http permit time-range working-hours

   user any svc-https permit time-range working-hours

   user any any deny

(host)[mynode](config) #user-role guest

   session-acl guest

Creating Roles and Policies for Sysadmin and Computer
The allowall policy, a predefined policy, allows unrestricted access to the network. The allowall policy is
mapped to both the sysadmin user role and the computer user role.

In the WebUI

1. In a Managed Network node hierarchy, navigate to Configuration > Roles & Policies> Roles tab. Click
+ to create the sysadmin role.

2. For Role Name, enter sysadmin and click Submit.

3. Under the Roles>Sysadmin table, click Show Advanced View.

4. Under Policies, Click +. In Add Policy, select the Add existing session policy and select the predefined
allowall policy from the Policy Name drop-down list.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #user-role sysadmin

   session-acl allowall

Creating a computer role

In the WebUI

1. In a Managed Network node hierarchy, navigate to Configuration > Roles & Policies> Roles tab. Click
+ to create the sysadmin role.

2. For Role Name, enter computer and click Submit.

3. Under the Roles > computer table, click Show Advanced View.

4. Under Policies, Click +. In Add Policy, select the Add existing session policy and select the predefined
allowall policy from the Policy Name drop-down list.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following command to create a computer role:
(host)[mynode](config) #user-role computer

   session-acl allowall
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Creating an Alias for the Internal Network

In the CLI
(host)[MyNode](config) #netdestination “Internal Network”

   network 10.0.0.0 255.0.0.0

   network 172.16.0.0 255.255.0.0

Configuring the RADIUS Authentication Server
Configure the RADIUS server IAS1, with IP address 10.1.1.21 and shared key. The RADIUS server is configured
to sent an attribute called Class to the managed device; the value of this attribute is set to either “student,”
“faculty,” or “sysadmin” to identify the user’s group. The managed device uses the literal value of this attribute
to determine the role name.

On the managed device, you add the configured server (IAS1) into a server group. For the server group, you
configure the server rule that allows the Class attribute returned by the server to set the user role.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. In the All Servers list, click +.

a. In the New Server window, enter IAS1 for the server name

b. Enter 10.1.1.21 for the server IP address.

c. Click the Type drop-down list and select the RADIUS server type.

d. Click Submit.

3. Select the new server from the All Servers list.

4. In the Shared Key field, enter a key, such as |*a^t%183923!. (You must enter the key string twice.)

5. Click Submit.

6. In the Server Group list, click +.

7. Enter the server name IAS and click Submit.
a. Select the server group IAS to display configuration parameters for the server group.

b. In the Server Group > IAS table, click +.

c. Select Add existing server, select IAS1, then click Submit.

8. In the Server Groups table, select the IAS server group. The Server Group > IAS table appears.

9. In the Server Group > IAS table, select Server Rules.

10.Click + to add a new server rule.

a. For Condition, enter Class.
b. For Attribute, select value-of from the drop-down list.

c. For Operand, select set role.

d. Click Add.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
[host][mynode](config) #aaa authentication-server radius IAS1

host 10.1.1.21

key |*a^t%183923!



[host][mynode](config) #aaa server-group IAS

auth-server IAS1

set role condition Class value-of

Configuring 802.1X Authentication
An AAA profile specifies the 802.1X authentication profile and 802.1X server group to be used for
authenticating clients for a WLAN. The AAA profile also specifies the default user roles for 802.1X and MAC
authentication.

In the 802.1X authentication profile, configure enforcement of machine authentication before user
authentication. If a user attempts to log in before machine authentication completes, the user is placed in the
limited guest role.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > L2

Authentication page.

2. Select 802.1X Authentication Profile.

a. Select the Profile name.

b. Select Enforce Machine Authentication.

c. For the Machine Authentication: Default Machine Role, select computer.

d. For the Machine Authentication: Default User Role, select guest.

e. Click Save.

3. In the Configuration > Authentication > AAA Profiles tab.

a. In the AAA Profiles, click + to add a new profile.

b. Enter aaa_dot1x as the Profile Name and then click Save.

a. Select the profile name you just added.

b. For MAC Authentication Default Role, select computer.

c. For 802.1X Authentication Default Role, select faculty.

d. Click Save.

4. In the Profiles list (under the aaa_dot1x profile), select 802.1X Authentication Profile.

a. From the drop-down list, select the dot1x 802.1X authentication profile you configured previously.

b. Click Save.

5. In the Profiles list (under the aaa_dot1x profile), select 802.1X Authentication Server Group.

a. From the drop-down list, select the IAS server group you created previously.

b. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #aaa authentication dot1x dot1x

machine-authentication enable

machine-authentication machine-default-role computer

machine-authentication user-default-role guest

(host)[mynode](config) #aaa profile aaa_dot1x

d>ot1x-default-role faculty

mac-default-role computer

authentication-dot1x dot1x

d>ot1x-server-group IAS
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Configuring VLANs
In this example, wireless clients are assigned to either VLAN 60 or 61 while guest users are assigned to VLAN
63. VLANs 60 and 61 split users into smaller IP subnetworks, improving performance by decreasing broadcast
traffic. The VLANs are internal to the Aruba managed device only and do not extend into other parts of the
wired network. The clients’ default gateway is the Aruba managed device, which routes traffic out to the
10.1.1.0 subnetwork.

You configure the VLANs, assign IP addresses to each VLAN, and establish the “helper address” to which client
DHCP requests are forwarded.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

Click + to add VLAN_60.
a. For VLAN ID, enter 60.

b. Click Submit.
c. Repeat steps A and B to add VLANs 61 and 63.

2. To configure IP parameters for the VLANs, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN 60.

b. Under VLANs > VLAN_60 table, select the VLAN ID, 60. Click IPv4.

c. For IP Address, enter 10.1.60.1.

d. For Net Mask, enter 255.255.255.0.

e. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.

f. Click Submit.

3. Similarly, for VLAN 61, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN_61.

b. Under VLANs > VLAN_61 table, select the VLAN ID, 61. Click IPv4.

c. For IP Address, enter 10.1.61.1.

d. For Net Mask, enter 255.255.255.0.

e. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.
f. Click Submit.

4. Similarly, for VLAN 63, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN_63.

b. Under VLANs > VLAN_63 table, select the VLAN ID, 61. Click IPv4.

a. For IP Address, enter 10.1.63.1.

b. For Net Mask, enter 255.255.255.0.
c. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.

d. Click Submit.

5. Select the IP Routes tab.

a. For Default Gateway, enter 10.1.1.254.

b. Click Submit.

In the CLI
(host)[mynode](config) #vlan 60

(host)[mynode](config) #interface vlan 60

ip address 10.1.60.1 255.255.255.0

ip helper-address 10.1.1.25



(host)[mynode](config) #vlan 61

(host)[mynode](config) #interface vlan 61

ip address 10.1.61.1 255.255.255.0

ip helper-address 10.1.1.25

(host)[mynode](config) #vlan 63

(host)[mynode](config) #interface vlan 63

ip address 10.1.63.1 255.255.255.0

ip helper-address 10.1.1.25

(host)[mynode](config) #ip default-gateway 10.1.1.254

Configuring the WLANs
In this example, default AP parameters for the entire network are: the default ESSID is WLAN-01 and the
encryption mode is TKIP. A second ESSID called “guest” has the encryption mode set to static WEP with a
configured WEP key.

In this example, the non-guest clients that associate to an AP are mapped into one of two different user VLANs.
The initial AP to which the client associates determines the VLAN: clients that associate to APs in the first floor
of the building are mapped to VLAN 60, and clients that associate to APs in the second floor of the building are
mapped to VLAN 61. Therefore, the APs in the network are segregated into two AP groups, named first-floor
and second-floor. (See Creating an AP group on page 493 for information about creating AP groups.) The guest
clients are mapped into VLAN 63.

Configuring the Guest WLAN
You create and configure the virtual AP profile, guest and apply the profile to each AP group. The “guest” virtual
AP profile contains the SSID profile “guest” which configures static WEP with a WEP key.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > System > Profiles page.

2. Under All Profiles, select Wireless LAN and then Virtual AP.

3. To create the guest virtual AP:

a. Click + to add a new Virtual AP Profile under Virtual AP profile: New Profile tab.

a. Enter guest for the profile name field and click Save.
b. Under All Profiles, select Wireless LAN and then SSID.

c. For the name for the SSID profile, enter guest.

d. For the Network Name for the SSID, enter guest.

e. For Network Authentication, select None.

f. For Encryption, select WEP.

g. Enter the WEP Key.

h. Click Save to apply the SSID profile to the Virtual AP.

i. Under Profile Details, click Save.

4. Click on the guest virtual AP name in the Profiles list or in Profile Details to display configuration
parameters.

a. Ensure that you select Virtual AP enable.

b. For VLAN, select 63.

c. Click Submit.

5. In the Configuration > Wireless > AP Configuration page.
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6. In the AP Group list, click Edit for the second-floor.

7. In the Profiles list, select Wireless LAN and then Virtual AP.

8. Select guest from the Add a profile drop-down list. Click Add.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)v(config) #wlan ssid-profile guest

essid guest

wepkey1 aaaaaaaaaa

opmode static-wep

(host)[mynode](config) #wlan virtual-ap guest

vlan 63

ssid-profile guest

(host)[mynode](config) #ap-group first-floor

virtual-ap guest

(host)(config) #ap-group second-floor

virtual-ap guest

Configuring the Non-Guest WLANs
You create and configure the SSID profile “WLAN-01” with the ESSID “WLAN-01” and WPA TKIP encryption. You
need to create and configure two virtual AP profiles: one with VLAN 60 for the first-floor AP group and the
other with VLAN 61 for the second-floor AP group. Each virtual AP profile references the SSID profile “WLAN-
01” and the previously-configured AAA profile aaa_dot1x.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > AP Group.

2. In the AP Group list, select an AP Group first-floor.

3. Click + under WLAN for the AP Group selected.

4. Select WLAN-01 for the Virtual AP.

5. In the Configuration > System > Profiles tab. In the Profiles list, select Wireless LAN and then Virtual
AP.

6. In a Managed Network node hierarchy, navigate to configure the WLAN-01_first-floor virtual AP:

a. Select NEW from the Add a profile drop-down list. Enter WLAN-01_first-floor, and click Add.

b. In the Profile Details entry for the WLAN-01_first-floor virtual AP profile, select the aaa_dot1x AAA
profile you previously configured. A pop-up window displays the configured AAA profile parameters.
Click Save.

c. From the SSID profile drop-down list, select NEW. A pop-up window allows you to configure the SSID
profile.

d. Enter WLAN-01 for the name of the SSID profile.

e. For Network Name, enter WLAN-01.

f. For Network Authentication, select WPA.
g. Click Save.

h. At the bottom of the Profile Details page, click Save.

7. Click on the WLAN-01_first-floor virtual AP name in the Profiles list or in Profile Details to display
configuration parameters.



a. Ensurer that you select Virtual AP enable.

b. For VLAN, select 60.

c. Click Save.

8. In a Managed Network node hierarchy, navigate to the Configuration > AP Group page.

9. In the AP Group list, select an AP Group second-floor.

10.Click + under WLAN for the AP Group selected.

11.Select WLAN-01 for the Virtual AP.

12.To configure the WLAN-01_second-floor virtual AP:

a. Select NEW from the Add a profile drop-down list. Enter WLAN-second-floor, and click Add.

b. In the Profile Details entry for the virtual AP profile, select aaa_dot1x from the AAA profile drop-down
list. A pop-up window displays the configured AAA profile parameters. Click Save.

c. From the SSID profile drop-down list, select WLAN-01. A pop-up window displays the configured SSID
profile parameters. Click Submit .

d. At the bottom of the Profile Details page, click Save.
13.Click on the new virtual AP name in the Profiles list or in Profile Details to display configuration

parameters.

a. Ensure that you select Virtual AP enable.

b. For VLAN, select 61.

c. Click Save.

In the CLI
(host)[mynode](config) #wlan ssid-profile WLAN-01

essid WLAN-01

opmode wpa-tkip

(host)[mynode](config) #wlan virtual-ap WLAN-01_first-floor

vlan 60

aaa-profile aaa_dot1x

ssid-profile WLAN-01

(host)[mynode](config) #wlan virtual-ap WLAN-01_second-floor

vlan 61

aaa-profile aaa_dot1x

ssid-profile WLAN-01

(host)[mynode](config) #ap-group first-floor

virtual-ap WLAN-01_first-floor

ap-group second-floor

virtual-ap WLAN-01_second-floor

Configuring Authentication with the Managed Device’s Internal Database
In the following example:

l The managed device’s internal database provides user authentication.

l The authentication type is WPA. From the 802.1X authentication exchange, the client and the managed
device derive dynamic keys to encrypt data transmitted on the wireless network.

Configuring the Internal Database
Configure the internal database with the username, password, and role (student, faculty, or sysadmin) for each
user. There is a default internal server group that includes the internal database. For the internal server
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group, configure a server derivation rule that assigns the role to the authenticated client.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > Auth

Servers page.

2. In the All Servers list, select Internal.
3. Select a server name under Server>Internal table

4. For each user, enter a username and password.

5. Select a role for each user (if a role is not specified, the default role is guest).

6. Select the expiration time for the user account in the internal database.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the privileged mode in the CLI to configure users in the managed device’s internal database.

(host)[mynode](config) #local-userdb add username <user> password <password>

Configuring a Server Rule

In the WebUI

1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > Auth
Servers page.

2. Select Server Group to display the Server Group list.

3. Select the internal server group from the Server Group table.
4. Click Server Rules tab in the Server Group > Internal table.

5. Click + to add a server derivation rule.

a. For Attribute, enter Role.

b. Select value-of from the Operations drop-down list.

c. Select Set Role from the Action drop-down list.

d. Click Add.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #aaa server-group internal

set role condition Role value-of

Configuring 802.1X Authentication
An AAA profile specifies the 802.1X authentication profile and 802.1X server group to be used for
authenticating clients for a WLAN. The AAA profile also specifies the default user role for 802.1X
authentication.

For this example, you enable both 802.1X authentication and termination on the managed device.



In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication > L2

Authentication page. In the profiles list, select 802.1X Authentication Profile.

a. In the Instance list, enter dot1x, then click Add.

b. Select the dot1x profile you just created.

c. Select Termination.

The defaults for EAP Method and Inner EAP Method are EAP-PEAP and EAP-MSCHAPv2, respectively.

d. Click Submit.

2. Select the AAA Profiles tab.

a. In the AAA Profiles Summary, click Add to add a new profile.

b. Enter aaa_dot1x, then click Add.

c. Select the aaa_dot1x profile you just created.

d. For 802.1X Authentication Default Role, select faculty.

e. Click Save.
3. In the Profiles list (under the aaa_dot1x profile you just created), select 802.1X Authentication Profile.

a. Select the dot1x profile from the 802.1X Authentication Profile drop-down list.

b. Click Save.
4. In the Profiles list (under the aaa_dot1x profile you just created), select 802.1X Authentication Server

Group.

a. Select the internal server group.

b. Click Save.

In the CLI
(host)[mynode](config) #aaa authentication dot1x dot1x

termination enable

(host)[mynode](config) #aaa profile aaa_dot1x

d>ot1x-default-role student

authentication-dot1x dot1x

d>ot1x-server-group internal

Configuring VLANs
In this example, wireless clients are assigned to either VLAN 60 or 61 while guest users are assigned to VLAN
63. VLANs 60 and 61 split users into smaller IP subnetworks, improving performance by decreasing broadcast
traffic. The VLANs are internal to the Aruba managed device only and do not extend into other parts of the
wired network. The clients’ default gateway is the Aruba managed device, which routes traffic out to the
10.1.1.0 subnetwork.

You configure the VLANs, assign IP addresses to each VLAN, and establish the “helper address” to which client
DHCP requests are forwarded.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

Click + to add VLAN_60.

a. For VLAN ID, enter 60.

b. Click Submit.
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c. Repeat steps A and B to add VLANs 61 and 63.

2. To configure IP parameters for the VLANs, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN_60.

b. Under VLANs > VLAN_60 table, select the VLAN ID, 60. Click IPv4.

c. For IP Address, enter 10.1.60.1.

d. For Net Mask, enter 255.255.255.0.

e. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.

f. Click Submit.
3. To configure IP parameters for the VLANs, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN_61.

b. Under VLANs > VLAN_61 table, select the VLAN ID, 61. Click IPv4.

a. For IP Address, enter 10.1.61.1.

b. For Net Mask, enter 255.255.255.0.

c. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.

d. Click Submit.

4. To configure IP parameters for the VLANs, navigate to the Configuration > Interfaces > VLANs page.

a. Select VLAN_63.

b. Under VLANs > VLAN_63 table, select the VLAN ID, 63. Click IPv4.

a. For IP Address, enter 10.1.63.1.

b. For Net Mask, enter 255.255.255.0.

c. Under DHCP Helper Address, click Add. Enter 10.1.1.25 and click Add.

d. Click Submit.

5. Select the IP Routes tab.

a. For Default Gateway, enter 10.1.1.254.

b. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #vlan 60

(host)[mynode](config) #interface vlan 60

ip address 10.1.60.1 255.255.255.0

ip helper-address 10.1.1.25

(host)[mynode](config) #vlan 61

(host)[mynode](config) #interface vlan 61

ip address 10.1.61.1 255.255.255.0

ip helper-address 10.1.1.25

(host)[mynode](config) #vlan 63

(host)[mynode](config) #interface vlan 63

ip address 10.1.63.1 255.255.255.0

ip helper-address 10.1.1.25

(host)[mynode](config) #ip default-gateway 10.1.1.254



Configuring WLANs
In this example, default AP parameters for the entire network are as follows: the default ESSID is WLAN-01 and
the encryption mode is TKIP. A second ESSID called guest has the encryption mode set to static WEP with a
configured WEP key.

In this example, the non-guest clients that associate to an AP are mapped into one of two different user VLANs.
The initial AP to which the client associates determines the VLAN: clients that associate to APs in the first floor
of the building are mapped to VLAN 60, and clients that associate to APs in the second floor of the building are
mapped to VLAN 61. Therefore, the APs in the network are segregated into two AP groups, named first-floor
and second-floor. (See Creating an AP group on page 493 for information about creating AP groups.) The guest
clients are mapped into VLAN 63.

Configuring the Guest WLAN
You create and configure the virtual AP profile, guest and apply the profile to each AP group. The guest virtual
AP profile contains the SSID profile, guest which configures static WEP with a WEP key.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Wireless > AP Configuration

page.

2. In the AP Group list, select first-floor.

3. In the Profiles list, select Wireless LAN and then Virtual AP.

4. To configure the guest virtual AP:

a. Select NEW from the Add a profile drop-down list. Enter guest for the name of the virtual AP profile,
and click Add.

b. In the Profile Details entry for the guest virtual AP profile, select NEW from the SSID profile drop-down
list. A pop-up window allows you to configure the SSID profile.

c. Enter guest for the name of the SSID profile.

d. Enter guest for the Network Name.

e. For Network Authentication, select None.

f. For Encryption, select WEP.

g. Enter the WEP key.

h. Click Save.

i. Under Profile Details, click Save.
5. Click on the guest virtual AP name in the Profiles list or in Profile Details to display configuration

parameters.

a. Ensure that you select Virtual AP enable.

b. For VLAN, select 63.

c. Click Save.
6. In a Managed Network node hierarchy, navigate to the Configuration > Wireless > AP Configuration

page.

7. In the AP Group list, select second-floor.

8. In the Profiles list, select Wireless LAN and then Virtual AP.

9. Select guest from the Add a profile drop-down list. Click Add.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.
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In the CLI
(host)[mynode](config) #wlan ssid-profile guest

essid guest

wepkey1 aaaaaaaaaa

opmode static-wep

(host)[mynode](config) #wlan virtual-ap guest

vlan 63

ssid-profile guest

(host)[mynode](config) #ap-group first-floor

virtual-ap guest

(host)[mynode](config) #ap-group second-floor

virtual-ap guest

Configuring the Non-Guest WLANs
You create and configure the SSID profile “WLAN-01” with the ESSID “WLAN-01” and WPA TKIP encryption. You
need to create and configure two virtual AP profiles: one with VLAN 60 for the first-floor AP group and the
other with VLAN 61 for the second-floor AP group. Each virtual AP profile references the SSID profile “WLAN-
01” and the previously-configured AAA profile “aaa_dot1x”.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Wireless > AP Configuration

page.

2. In the AP Group list, select first-floor.

3. In the Profiles list, select Wireless LAN, then select Virtual AP.

4. To configure the WLAN-01_first-floor virtual AP:

a. Select NEW from the Add a profile drop-down list. Enter WLAN-01_first-floor, and click Add.

b. In the Profile Details entry for the WLAN-01_first-floor virtual AP profile, select aaa_dot1x from the
AAA Profile drop-down list. A pop-up window displays the configured AAA parameters. Click Save.

c. From the SSID profile drop-down list, select NEW. A pop-up window allows you to configure the SSID
profile.

d. Enter WLAN-01 for the name of the SSID profile.

e. Enter WLAN-01 for the Network Name.

f. Select WPA for Network Authentication.

g. Click Save.

h. At the bottom of the Profile Details page, click Save.

5. Click on the WLAN-01_first-floor virtual AP profile name in the Profiles list or in Profile Details to display
configuration parameters.

a. Ensure that you select Virtual AP enable.

b. For VLAN, select 60.

c. Click Save.

6. In a Managed Network node hierarchy, navigate to the Configuration > Wireless > AP Configuration
page.

7. In the AP Group list, select second-floor.

8. In the Profiles list, select Wireless LAN and then Virtual AP.

9. To create the WLAN-01_second-floor virtual AP:

a. Select NEW from the Add a profile drop-down list. Enter WLAN-01_second-floor, and click Add.



b. In the Profile Details entry for the virtual AP profile, select aaa_dot1x from the AAA Profile drop-
down list. A pop-up window displays the configured AAA profile parameters. Click Save.

c. From the SSID profile drop-down list, select WLAN-01. A pop-up window displays the configured SSID
profile parameters. Click Save.

d. At the bottom of the Profile Details page, click Save.

10.Click on the WLAN-01_second-floor virtual AP profile name in the Profiles list or in Profile Details to
display the configuration parameters.

a. Ensure that you select Virtual AP enable.

b. For VLAN, select 61.

c. Click Save.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)[mynode](config) #wlan ssid-profile WLAN-01

essid WLAN-01

opmode wpa-tkip

(host)[mynode](config) #wlan virtual-ap WLAN-01_first-floor

vlan 60

aaa-profile aaa_dot1x

ssid-profile WLAN-01

(host)[mynode](config) #wlan virtual-ap WLAN-01_second-floor

vlan 61

aaa-profile aaa_dot1x

sid-profile WLAN-01

(host)[mynode](config) #ap-group first-floor

virtual-ap WLAN-01_first-floor

(host)[mynode](config) #ap-group second-floor

virtual-ap WLAN-01_second-floor

Configuring Mixed Authentication Modes
Use l2-auth-fail-through command to perform mixed authentication which includes both MAC and 802.1X
authentication. When MAC authentication fails, enable the l2-auth-fail-through command to perform
802.1X authentication.

By default the l2-auth-fail-through command is disabled.
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Authentication 1 2 3 4 5 6

MAC
authentication

Success Success Success Fail Fail Fail

802.1X
authentication

Success Fail — Success Fail —

Association dynamic-
wep

No
Associatio
n

static-
wep

dynamic-
wep

No
Associatio
n

static-
wep

Role Assignment 802.1X — MAC 802.1X — logon

Table 51: Mixed Authentication Modes

Table 51 describes the different authentication possibilities

In the CLI
(host) [mynode] (config) #aaa profile test

l2-auth-fail-through

Performing Advanced Configuration Options for 802.1X
This section describes advanced configuration options for 802.1X authentication.

Configuring Reauthentication with Unicast Key Rotation
When enabled, unicast and multicast keys are updated after each reauthorization. It is a best practice to
configure the time intervals for reauthentication, multicast key rotation, and unicast key rotation to be at least
15 minutes. Ensure that these intervals are mutually prime, and the factor of the unicast key rotation interval
and the multicast key rotation interval is less than the reauthentication interval.

Unicast key rotation depends upon both the AP/managed device and wireless client behavior. It is known that some
wireless NICs have issues with unicast key rotation.

The following is an example of the parameters you can configure for reauthentication with unicast and
multicast key rotation:

l Reauthentication: Enabled

l Reauthentication Time Interval: 6011 Seconds

l Multicast Key Rotation: Enabled

l Multicast Key Rotation Time Interval: 1867 Seconds

l Unicast Key Rotation: Enabled

l Unicast Key Rotation Time Interval: 1021 Seconds

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Authentication. Select the L2

Authentication tab.

2. Select 802.1X Authentication Profile, then select the name of the profile you want to configure.

3. Enter the following values:



n Reauthentication Interval: 6011

n Multicast Key Rotation Time Interval: 1867

n Unicast Key Rotation Time Interval: 1021

n Multicast Key Rotation: (select)

n Unicast Key Rotation: (select)

n Reauthentication: (select)

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa authentication dot1x profile

reauthentication

timer reauth-period 6011

unicast-keyrotation

timer ukey-rotation-period 1021

multicast-keyrotation

timer mkey-rotation-period 1867

Application Single Sign-On Using L2 Authentication
This feature allows single sign-on (SSO) for different web-based applications using Layer 2 authentication
information. Single sign-on for web-based application uses Security Assertion Markup Language (SAML), which
happens between the web service provider and an identity provider (IDP) that the web server trusts. A request
made from the client to a web server is redirected to the IDP for authentication. If the user has already been
authenticated using L2 credentials, the IDP server already knows the authentication details and returns a SAML
response, redirecting the client browser to the web-based application. The user enters the web-based
application without needing to enter the credentials again.

Enabling application SSO using L2 network information requires configuration on the managed device and on
the IDP server. The Aruba ClearPass Policy Manager is the only IDP supported. The managed device has been
optimized to work with ClearPass Policy Manager to provide better functionality as an IDP.

Important Points to Remember
l ClearPass Policy Manager is the only supported IDP.

l SSO occurs after 802.1X authentication. Therefore, SSO after captive portal authentication is not
supported. Roles for captive portal and SSO are mutually exclusive and, therefore, a user in the captive
portal role cannot perform SSO and vice-versa.

l SSO with VIA is not supported.

l There is a limit on the number of concurrent sessions that can be serviced at a given instant. This limit is set
at the webserver level using the web-server profile web-max-clients command. The default value is 320
for 7000 Series and 7200 Series managed device platforms and 25 for other managed device platforms.
The maximum number of concurrent SSO sessions that can be handled is dependent on the other web
services being handled and the same time.

Enabling Application SSO
Enabling application SSO using L2 authentication information requires configuration on the managed device
and ClearPass Policy Manager. This feature is enabled by completing the following steps:
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l ClearPass Policy Manager (refer to the ClearPass Policy Manager for configuration of the following
procedures):

n Add the managed device’s IP address as a network device

n Add the user to the local user DB

n Create an enforcement profile to return the Aruba vendor-specific attribute (VSA) SSO token

n Create an IDP attribute enforcement profile

n Create an enforcement policy binding the Aruba VSA SSO token enforcement profile

n Create an enforcement policy binding the IDP enforcement profile

n Create a service, allowing the respective authentication types and authentication database, and bind the
Aruba VSA SSO token enforcement policy.

n Create a service, allowing the respective authentication types and authentication database, and bind the
IDP enforcement policy.

n Configure SSO for the ClearPass Policy Manager.

l Managed device:

n Configuring an SSO-IDP Profile

n Applying an SSO Profile to a User Role

n Selecting an IDP Certificate

Configuring SSO IDP-Profiles on the Managed devices
Before SSO can be enabled, you must configure an SSO profile by completing the procedure detailed below.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > System. Click the Profiles tab.

2. Expand the Wireless LAN menu.

3. Select SSO.

4. Click + to create a new profile.

5. Enter a name in the Profile Name dialog box.

6. Click + to add a new URL.

7. Enter the name of the URL in the URL Name dialog box.

8. Enter the URL into the URL text box.

9. Click OK.

10.Repeat steps 4 through 8 for each URL you are adding to the SSO profile.

11.Click Save when all URLs have been added.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
sso idp-profile <idp profile name>

idp <urlname> <url>

Applying an SSO Profile to a User Role
The newly created SSO profile must be applied to any applicable user rules that require SSO. Apply the SSO
profile be completing the steps below.



In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Roles & Policies > Roles
2. In the Roles table, select the User Role that the SSO profile will be linked to.

3. Click Show Advanced View.

4. Click the More Tab.

5. Select Authentication.

6. Click the IDP profile drop-down list and select an IDP profile.

7. Click Save.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode](config)# user-role <role name>

(host) [mynode](config)# sso <idp profile name>

Selecting an IDP Certificate
An SSL certificate is needed for SSL negotiation with browser. The certificate can be imported in PKCS12
format, so that it contains the certificate and private key, or the key pair can be generated and a certificate
signing request (CSR) request sent to the enterprise CA server to generate a certificate which can then be
uploaded to the managed device.

For information about uploading or generating a certificate, see Managing Certificates.

After a certificate is uploaded or generated, the IDP certificate must be selected.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > System > More tab.

2. Click General
3. Under IDP Server Certificate, select the IDP certificate from the IDP Server Certificate drop-down list.

By default, the default-self-signed certificate is used as the server certificate. For more details on default-self-
signed certificate, see Managing Certificates on page 758.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode](config)# web-server profile

(host) [mynode](Web Server Configuration) # idp-cert <name of the certificate>

Device Name as User Name for Non-802.1X Authentication
When a client is authenticated by non-802.1X method of authentication, the host name of the host device is
used as the user name (instead of the MAC address) of the host device. When a device tries to obtain an IP
address by using DHCP, the host name of the host device in the option-12 field of DHCP request is used as the
host name of the device.
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A CLI command allows the use of host name or MAC address of a device as the user name of the host device.
By default, the MAC address of the host device is used as the user name. If the CLI command is enabled, the
host name of the host device is used as the user name.

Using Device Name as User Name
In the CLI:
(host) [mm] (config) #aaa profile <profile>

(host) [mm] (AAA Profile “<profile >”) #username-from-dhcp-opt12



ArubaOS 8.0.0.0 | User Guide Stateful and WISPr Authentication | 269

Chapter 14
Stateful and WISPr Authentication

Mobility Master supports stateful 802.1X authentication, stateful NTLM authentication, and authentication for
Wireless Internet Service Provider roaming (WISPr). Stateful authentication differs from 802.1X authentication
in that Mobility Master does not manage the authentication process directly, but instead monitors the
authentication messages between a user and an external authentication server, then assigns a role to that user
based upon the information in those authentication messages. WISPr authentication allows clients to roam
between hotspots using different ISPs.

This chapter describes the following topics:

l Working With Stateful Authentication on page 269

l Working With WISPr Authentication on page 270

l Understanding Stateful Authentication Best Practices on page 270

l Configuring Stateful 802.1X Authentication on page 270

l Configuring Stateful NTLM Authentication on page 272

l Configuring Stateful Kerberos Authentication on page 273

l Configuring WISPr Authentication on page 274

Working With Stateful Authentication
Mobility Master supports three different types of stateful authentication:

l Stateful 802.1X authentication: This feature allows Mobility Master to learn the identity and role of a
user connected to a third-party AP, and is useful for authenticating users to networks with APs from
multiple vendors. When an 802.1X-capable access point sends an authentication request to a RADIUS
server, Mobility Master inspects this request and the associated response to learn the authentication state
of the user. It then applies an identity-based user-role through the Policy Enforcement Firewall.

l Stateful Kerberos authentication: Stateful Kerberos authentication configures Mobility Master to
monitor the Kerberos authentication messages between a client and a Windows authentication server. If
the client successfully authenticates via a Kerberos authentication server, Mobility Master recognizes that
the client has been authenticated and assigns that client a specified user role.

l Stateful NTLM authentication: NT LAN Manager (NTLM) is a suite of Microsoft authentication and
session security protocols. You can configure Mobility Master to monitor the NTLM authentication
messages between a client and a Windows authentication server. If the client successfully authenticates via
an NTLM authentication server, Mobility Master recognizes that the client has been authenticated and
assigns that client a specified user-role.

The default Windows authentication method has changed from the older NTLM protocol to the newer
Kerberos protocol, starting with Windows 2000. Therefore, stateful NTLM authentication is most useful for
networks with legacy, pre-Windows 2000 clients. Also note that unlike other types of authentication, all
users authenticated via stateful NTLM authentication must be assigned to the user-role specified in the
Stateful NTLM Authentication profile. Aruba’s stateful NTLM authentication does not support placing users
in various roles based upon group membership or other role-derivation attributes.
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Working With WISPr Authentication
WISPr authentication allows a “smart client” to authenticate to the network when roaming between Wireless
Internet Service Providers, even if the wireless hotspot uses an ISP, which the client may not have an account
for.

If you are a hotspot operator using WISPr authentication, and a client that has an account with your ISP
attempts to access the Internet at your hotspot, your ISP’s WISPr AAA server authenticates that client directly
and allows the client to access the network. If, however, the client only has an account with a partner ISP, your
ISP’s WISPr AAA server forwards that client’s credentials to the partner ISP’s WISPr AAA server for
authentication. Once the client has been authenticated on the partner ISP, it is authenticated on your hotspot’s
own ISP, as per their service agreements. After your ISP sends an authentication message to Mobility Master,
the default WISPr user-role is assigned to that client.

Mobility Master supports the following smart clients, which enable client authentication and roaming between
hotspots by embedding iPass Generic Interface Specification (GIS) redirect, proxy, authentication, and logoff
messages within HTML messages:

l iPass

l Boingo

l Trustive

l weRoam

l AT&T

Understanding Stateful Authentication Best Practices
Before you can configure a stateful authentication feature, you must define the user-role you want to assign to
the authenticated users and create a server group, which includes a RADIUS authentication server for stateful
802.1X authentication or a Windows server for stateful NTLM authentication. For details on performing these
tasks, refer to the following sections of this User Guide:

l Roles and Policies on page 363

l Configuring a RADIUS Server on page 176

l Configuring a Windows Server on page 184

l Configuring Server Groups on page 185

You can use the default stateful NTLM authentication and WISPr authentication profiles to manage the
settings for these features, or you can create additional profiles as desired. Unlike most other types of
authentication, stateful 802.lx authentication uses only a single Stateful 802.1X profile. This profile can be
enabled or disabled, but you cannot configure more than one Stateful 802.1X profile.

Configuring Stateful 802.1X Authentication
When configuring 802.1X authentication for clients on non-Aruba APs, you must specify the group of RADIUS
servers that performs user authentication and assign roles to users who successfully complete authentication.
When the user logs off or shuts down the client machine, Mobility Master notes the deauthentication message
from the RADIUS server and changes the user’s role from the specified authenticated role back to the login
role. For details on defining a RADIUS server used for stateful 802.1X authentication, see Configuring a RADIUS
Server on page 176.

In the WebUI
To configure the Stateful 802.1X Authentication profile via the WebUI:



1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication page.

2. Under the L2 Authentication tab, select Stateful 802.1X Authentication.

3. Select the role assigned to stateful 802.1X authenticated users from the Default Role drop-down list.

4. Specify the timeout period for authentication requests, between 1 and 20 seconds. The default value is 10
seconds.

5. Select the Mode check box to enable stateful 802.1X authentication.

6. Click Save.

7. Select Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the commands below to configure stateful 802.1X authentication via the command-line interface. The first
set of commands defines the RADIUS server used for 802.1X authentication, and the second set assigns that
server to a server group. The third set associates the server group with the stateful 802.1X authentication
profile, then sets the authentication role and timeout period.
(host) [mynode] (config) #aaa authentication-server radius <rad-server-name>

acctport <acctport>

authport <authport>

clone <source>

enable

enable-ipv6

enable-radsec

host <host>

key <key>

nas-identifier <nas-identifier>

nas-ip <nas-ip>

retransmit <retransmit>

timeout <timeout>

use-ip-for-calling-station

use-md5

(host) [mynode] (config) #aaa server-group <sg_name>

allow-fail-through

auth-server <name> [match-authstring {contains <sub_string>|equals <sub_string>|starts-with

<sub_string>][match-fqdn {all|<fqdn>}][position <prio>][trim-fqdn]

clone <source>

load-balance

set {role|vlan} condition <attribute> [contains <operand>|ends-with <operand>|equals

<operand>|not-equals <operand>|starts-with <operand>][value-of][set-value <set-value-str>]

[position <number>]

(host) [mynode] (config) #aaa authentication stateful-dot1x

default-role <default-role>

enable

server-group <srv-group>

timeout <timeout>

User the commands below to view the servers and profiles configured for stateful 802.1X authentication:
(host) [mynode] #show aaa authentication-server radius

(host) [mynode] #show aaa server-group

(host) [mynode] #show aaa authentication stateful-dot1x
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Configuring Stateful NTLM Authentication
The Stateful NTLM Authentication profile requires that you specify a server group, which includes the servers
performing NTLM authentication and the role to be assigned to users who are successfully authenticated. For
details on defining a windows server used for NTLM authentication, see Configuring a Windows Server on page
184.

When a user logs off or shuts down the client machine, the user remains in the authenticated role until the user
ages out, meaning there is no user traffic for the amount of time specified in the User idle timeout setting
under Configuration > Authentication > Advanced > Authentication Timers.

In the WebUI
To configure a stateful NTLM authentication profile via the WebUI:

1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication page.

2. Select Stateful NTLM Authentication from the L3 Authentication tab.

3. Under Stateful NTLM Authentication Profile: New Profile, click the Add button to add a new profile
entry. To modify an existing stateful NTLM authentication profile, select a profile entry below Stateful
NTLM Authentication in the L3 Authentication list.

4. Enter a profile name.

5. From the Default Role drop-down list, select the role to be assigned to all users after completing stateful
NTLM authentication.

6. Select the Mode check box to enable stateful NTLM authentication.

7. Specify the timeout period for authentication requests, between 1 and 20 seconds. The default value is 10
seconds.

8. Click Save.

9. In the L3 Authentication list, select the Server Group entry below the stateful NTLM authentication
profile.

10.Select the group of Windows servers to be used for stateful NTLM authentication from the Server Group
drop-down list.

11.To enable authentication fail through and load balancing, select the check boxes for Fail Through and
Load Balance.

12.Click Save.

13.Select Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the commands below to configure stateful NTLM authentication via the command-line interface. The first
set of commands defines the Windows server used for NTLM authentication, and the second set adds that
server to a server group. The third set associates that server group with the stateful NTLM authentication
profile, then defines the profile settings.
(host) [mynode] (config) #aaa authentication-server windows <windows_server_name>

clone <source>

domain <domain>

enable

host <host>

(host) [mynode] (config) #aaa server-group <sg_name>

allow-fail-through



auth-server <name> [match-authstring {contains <sub_string>|equals <sub_string>|starts-with

<sub_string>][match-fqdn {all|<fqdn>}][position <prio>][trim-fqdn]

clone <source>

load-balance

set {role|vlan} condition <attribute> [contains <operand>|ends-with <operand>|equals

<operand>|not-equals <operand>|starts-with <operand>][value-of][set-value <set-value-str>]

[position <number>]

(host) [mynode] (config) #aaa authentication stateful-ntlm <profile-name>

clone <source>

default-role <default-role>

enable

server-group <server-group>

timeout <timeout>

Use the commands below to view the servers and profiles configured for stateful NTLM authentication:
(host) [mynode] #show aaa authentication-server window

(host) [mynode] #show aaa server-group

(host) [mynode] #show aaa authentication stateful-ntlm

Configuring Stateful Kerberos Authentication
The Stateful Kerberos Authentication profile requires that you specify a server group, which includes the
Kerberos servers and the role assigned to authenticated users. For details on defining a windows server used
for Kerberos authentication, see Configuring a Windows Server on page 184.

When the user logs off or shuts down the client machine, the user remains in the authenticated role until the
user ages out, meaning there is no user traffic for the amount of time specified in the User idle timeout
setting under Configuration > Authentication > Advanced > Authentication Timers.

In the WebUI
To configure a stateful Kerberos authentication profile via the WebUI:

1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication page.

2. Select Stateful Kerberos Authentication from the L3 Authentication tab.

3. Under Stateful Kerberos Authentication Profile: New Profile, click the Add button to add a new
profile entry. To modify an existing stateful Kerberos authentication profile, select a profile entry below
Stateful Kerberos Authentication in the L3 Authentication list.

4. Enter a profile name.

5. From the Default Role drop-down list, select the role to be assigned to all users after completing stateful
Kerberos authentication.

6. Specify the timeout period for authentication requests, between 1 and 20 seconds. The default value is 10
seconds.

7. Click Save.

8. In the All Profiles list, select the Server Group entry below the stateful Kerberos authentication profile.

9. Select the group of Windows servers to be used for stateful Kerberos authentication from the Server
Group drop-down list.

10.To enable authentication fail through and load balancing, select the check boxes for Fail Through and
Load Balance.

11.Click Save.
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12.Select Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the commands below to configure stateful Kerberos authentication via the command-line interface. The
first set of commands defines the server used for Kerberos authentication, and the second set adds that server
to a server group, and the third set of commands associates that server group with the stateful NTLM
authentication profile then defines the profile settings.
(host) [mynode] (config) #aaa authentication-server windows <windows_server_name>

clone <source>

domain <domain>

enable

host <host>

(host) [mynode] (config) #aaa server-group <sg_name>

allow-fail-through

auth-server <name> [match-authstring {contains <sub_string>|equals <sub_string>|starts-with

<sub_string>][match-fqdn {all|<fqdn>}][position <prio>][trim-fqdn]

clone <source>

load-balance

set {role|vlan} condition <attribute> [contains <operand>|ends-with <operand>|equals

<operand>|not-equals <operand>|starts-with <operand>][value-of][set-value <set-value-str>]

[position <number>]

(host) [mynode] (config) #aaa authentication stateful-kerberos <profile-name>

clone <source>

default-role <default-role>

server-group <server-group>

timeout <timeout>

Use the commands below to view the servers and profiles configured for stateful Kerberos authentication:
(host) [mynode] #show aaa authentication-server windows

(host) [mynode] #show aaa server-group

(host) [mynode] #show aaa authentication stateful-kerberos

Configuring WISPr Authentication
The WISPr authentication profile includes parameters to define RADIUS attributes, default roles for
authenticated WISPr users, the maximum number of authentication failures, and login wait times. The WISPr-
Location-ID, sent from Mobility Master to the WISPr RADIUS server, is the concatenation of the ISO Country
Code, E.164 Country Code, E.164 Area Code, and SSID/Zone parameters configured in this profile.

The parameters used to define WISPr RADIUS attributes are specific to the RADIUS server your ISP uses for
WISPr authentication; contact your ISP to determine these values. You can find a list of ISO and ITU country
and area codes at the ISO and ITU websites (www.iso.org) and http://www.itu.int.)

In the WebUI
To configure a WISPr authentication profile in the WebUI:

1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication page.

http://www.iso.org/
http://www.iso.org/
http://www.itu.int/
http://www.itu.int/


2. Select WISPr Authentication from the L3 Authentication tab.

3. Under WISPr Authentication Profile: New Profile, click the Add button to add a new profile entry. To
modify an existing WISPr authentication profile, select a profile entry below WISPr Authentication in the
All Profiles list.

4. Enter a profile name.

5. Define values for the following parameters:

Parameter Description

Default Role Default role assigned to users that complete WISPr authentication.

Max Authentication failures Maximum number of failed WISPr authentication attempts permitted
for each user.

User Agent String User agent that identifies and provides details on the browser used
during an HTTP request

Logon wait minimum wait If the controller’s CPU utilization has surpassed the Login wait CPU
utilization threshold value, the Logon wait minimum wait
parameter defines the minimum number of seconds a user has to
wait to retry a login attempt. Range: 1–10 seconds. Default: 5
seconds.

Logon wait maximum wait If the controller’s CPU utilization has surpassed the Login wait CPU
utilization threshold value, the Logon wait maximum wait
parameter defines the maximum number of seconds a user has to
wait to retry a login attempt. Range: 1–10 seconds. Default: 10
seconds.

Logon wait CPU utilization
threshold

Percentage of CPU utilization at which the maximum and minimum
login wait times are enforced. Range: 1–100%. Default: 60%.

WISPr Location-ID ISO Country
Code

The ISO Country Code section of the WISPr Location ID.

WISPr Location-ID E.164 Country
Code

The E.164 Country Code section of the WISPr Location ID.

WISPr Location-ID E.164 Area
Code

The E.164 Area Code section of the WISPr Location ID.

WISPr Location-ID SSID/Zone The SSID/Zone section of the WISPr Location ID.

WISPr Operator Name Name identifying the hotspot operator.

WISPr Location Name Name identifying the hotspot location. If no name is defined, the
parameter uses the name of the associated AP.

Table 52: WISPr Authentication Profile Parameters

6. Click Save.

7. In the All Profiles list, select the Server Group entry below the WISPR authentication profile.
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8. Select the group of RADIUS servers to be used for WISPr authentication from the Server Group drop-down
list.

9. To enable authentication fail through and load balancing, select the check boxes for Fail Through and
Load Balance.

10.Click Save.

11.Select Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

A Boingo smart client uses a NAS identifier in the format <CarrierID>_<VenueID> for location identification. To
support Boingo clients, you must also configure the NAS identifier parameter in the Radius server profile for the
WISPr server

In the CLI
Use the CLI commands below to configure WISPr authentication. The first set of commands defines the
RADIUS server used for WISPr authentication, and the second set adds that server to a server group. The third
set of commands associates that server group with the WISPR authentication profile, then defines the profile
settings.
(host) [mynode] (config) #aaa authentication-server radius <rad-server-name>

acctport <acctport>

authport <authport>

clone <source>

enable

enable-ipv6

enable-radsec

host <host>

key <key>

nas-identifier <nas-identifier>

nas-ip <nas-ip>

retransmit <retransmit>

timeout <timeout>

use-ip-for-calling-station

use-md5

(host) [mynode] (config) #aaa server-group <sg_name>

allow-fail-through

auth-server <name> [match-authstring {contains <sub_string>|equals <sub_string>|starts-with

<sub_string>][match-fqdn {all|<fqdn>}][position <prio>][trim-fqdn]

clone <source>

load-balance

set {role|vlan} condition <attribute> [contains <operand>|ends-with <operand>|equals

<operand>|not-equals <operand>|starts-with <operand>][value-of][set-value <set-value-str>]

[position <number>]

(host) [mynode] (config) #aaa authentication wispr <profile-name>

agent_string <agent_string>

clone <source>

default-role <default-role>

logon-wait {cpu-threshold <cpu-threshold>|maximum-delay <maximum-delay>|minimum-delay

<minimum-delay>}

max-authentication-failures <max-authentication-failures>

server-group <server-group>

wispr-location-id-ac <wispr-location-id-ac>

wispr-location-id-cc <wispr-location-id-cc>

wispr-location-id-isocc <wispr-location-id-isocc>

wispr-location-id-network <wispr-location-id-network>

wispr-location-name-location <wispr-location-name-location>



wispr-location-name-operator-name <wispr-location-name-operator-name>

User the commands below to view the servers and profiles configured for WISPr authentication:
(host) [mynode] #show aaa authentication-server radius

(host) [mynode] #show aaa server-group

(host) [mynode] #show aaa authentication wispr
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Chapter 15
Certificate Revocation

The Certificate Revocation feature enables the controller to perform real-time certificate revocation checks
using the Online Certificate Status Protocol (OCSP), or traditional certificate validation using the Certificate
Revocation List (CRL) client.

Topics in this chapter include:

l Understanding OCSP and CRL on page 278

l Configuring the Controller as an OCSP Client on page 279

l Configuring the Controller as a CRL Client on page 281

l Configuring the Controller as an OCSP Responder on page 282

l Certificate Revocation Checking for SSH Pubkey Authentication on page 283

Understanding OCSP and CRL
OCSP (RFC 2560) is a standard protocol that consists of an OCSP client and an OCSP responder. This protocol
determines revocation status of a given digital public-key certificate without downloading the entire CRL.

CRL is the traditional method of checking certificate validity. A CRL provides a list of certificate serial numbers
that have been revoked or are no longer valid. CRLs let the verifier check the revocation status of the
presented certificate while verifying it. CRLs are limited to 512 entries.

Both the Delegated Trust Model and the Direct Trust Model are supported to verify digitally signed OCSP
responses. Unlike the Direct Trust Model, the Delegated Trust Model does not require the OCSP responder
certificates to be explicitly available on the controller.

Configuring a Controller as OCSP and CRL Clients
The controller can act as an OCSP client and issue OCSP queries to remote OCSP responders located on the
intranet or Internet. Since many applications in ArubaOS (such as IKE), use digital certificates, a protocol such as
OCSP needs to be implemented for revocation.

An entity that relies on the content of a certificate (a relying party) needs to check before accepting the
certificate as valid. Once it is verified that the certificate has not been revoked, the OCSP client retrieves
certificate revocation status from an OCSP responder. The responder may be the CA (Certificate Authority) that
has issued the certificate in question, or it may be some other designated entity which provides the service on
behalf of the CA. A revocation checkpoint is a logical profile that is tied to each CA certificate that the controller
has (trusted or intermediate). Also, the user can specify revocation preferences within each profile.

The OCSP request is not signed by the Aruba OCSP client at this time. However, the OCSP response is always
signed by the responder.

Both OCSP and CRL configuration and administration is usually performed by the administrator who manages
the web access policy for an organization.

In small networks where there are is no Internet connection or connection to an OCSP responder, CRL is
preferable to than OCSP.

Configuring an OCSP Controller as a Responder
The controller can be configured to act as an OCSP responder (server) and respond to OCSP queries from
clients that want to obtain revocation status of certificates.
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The OCSP responder on the controller is accessible over HTTP port 8084. You cannot configure this port.
Although the OCSP responder accepts signed OCSP requests, it does not attempt to verify the signature before
processing the request. Therefore, even unsigned OCSP requests are supported.

The controller as an OCSP responder provides revocation status information to Aruba applications that use
CRLs. This is useful in small disconnected networks where clients cannot reach outside OCSP server to validate
certificates. Typical scenarios include client to client or client to other server communication situations where
the certificates of either party need to be validated.

Configuring the Controller as an OCSP Client
When OCSP is used as the revocation method, you need to configure the OCSP responder certificate and the
OCSP URL.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Certificates.

2. Expand the Import Certificates accordion menu.

3. Click the plus (+) icon in the Import Certificates section.

4. Enter the following certificate details in the New Certificate section:

a. Enter a name in the Certificate name text box. This name identifies the certificate you are importing.

b. Enter the certificate filename in the Certificate filename text box. Click the Browse button to enter
the full pathname.

c. Enter a password in the Optional passphrase text box. The password is optional.

d. If you opted to use the optional password (in step c), re-enter the password in the Retype passphrase
text box.

e. Select a certificate format from the Certificate format drop-down list. You can import certificates of
format DER, P12, PEM, PFX, PKCS12, and PKCS7.

f. Select OCSPResponderCert from the Certificate type drop-down list.

A revocation check method (OCSP or CRL) can be chosen independently for every revocation checkpoint. In this
example, we are only describing the OCSP check method.

When this certificate is imported, it is maintained in the certificate store for OCSP responder certificates. These
certificates are used for signature verification.



Figure 36 Import a Certificate

5. Click Submit. The certificate appears in the Import Certificates section.

6. For detailed information about an imported certificate, click the certificate from the certificate list.

Figure 37 View Certificate Details

7. Click the Revocation Checkpoint accordion menu.

8. In the Revocation Checkpoint section, click the record for which you want to configure the revocation
checkpoint. The Revocation Checkpoint section is displayed.

a. In the Revocation Check list, select ocsp from the Method 1 drop-down list as the primary check
method.

b. In the OCSP URL text box, enter the URL of the OCSP responder.

c. Select the OCSP certificate that you want to configure from the OCSP Responder Cert drop-down list.
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9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
This example configures an OCSP client with the revocation check method as OCSP for revocation checkpoint
CAroot.

The OCSP responder certificate is configured as RootCA-Ocsp_responder. The corresponding OCSP responder
service is available at http://10.4.46.202/ocsp. The check method is OCSP for revocation checkpoint CARoot.
(host)[mynode](config) #crypto-local pki rcp CARoot

(host)[mynode](RCP-CARoot) #ocsp-responder-cert RootCA-Ocsp_responder

(host)[mynode](RCP-CARoot) #ocsp-url http://10.4.46.202/ocsp

(host)[mynode](RCP-CARoot) #revocation-check ocsp

The show crypto-local pki OCSP ResponderCert command lists the contents of the OCSP Responder
Certificate store.

The show crypto-local pki revocation checkpoint rcp_name command shows the entire configuration for
a given revocation checkpoint.

Configuring the Controller as a CRL Client
CRL is the traditional method of checking certificate validity. When you want to check certificate validity using a
CRL, import the CRL. You can import CRLs only through the WebUI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Certificates.

2. Expand the Import Certificates accordion menu.

3. Click the plus (+) icon in the Import Certificates section.

4. Enter the following certificate details in the New Certificate section:

a. Enter a name in the Certificate name text box. This name identifies the certificate you are importing.

b. Enter the certificate filename in the Certificate filename text box. Click the Browse button to enter
the full pathname.

c. Enter a password in the Optional passphrase text box. The password is optional.

d. If you opted for using the optional password (in step c), re-enter the password in the Retype
passphrase text box.

e. Select a certificate format from the Certificate format drop-down list. You can import certificates of
format DER, P12, PEM, PFX, PKCS12, and PKCS7.

f. Select CRL from the Certificate type drop-down list.

A revocation check method (OCSP or CRL) can be chosen independently for every revocation checkpoint. In this
example, we are only describing the CRL check method.

When this CRL is imported, it is maintained in the store for CRLs. These CRLs are used for signature
verification.

5. Click Submit. The CRL appears in the Import Certificates section.

6. For detailed information about an imported CRL, click the CRL from the CRL list.

7. Click the Revocation Checkpoint accordion menu.

http://10.4.46.202/ocsp


a. In the Revocation Checkpoint section, click the record for which you want to configure the revocation
checkpoint. The Revocation Checkpoint section is displayed.

b. In the Revocation Check list, select crl from the Method 1 drop-down list.

c. In the CRL Location text box, enter the CRL you want to use for this revocation checkpoint. The CRLs
listed are files that have already been imported onto the controller.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
This example configures an OCSP responder with the check method as CRL for revocation check point ROOTCa-
ssh-webui. The CRL location is crl1 and the revocation check method is crl.
(host)[mynode](config) #crypto-local pki rcp ROOTCa-ssh-webui

(host)[mynode](RCP-CARoot) #crl-location file crl1

(host)[mynode](RCP-CARoot) #revocation-check crl

Configuring the Controller as an OCSP Responder
When configured as an OCSP responder, the controller provides revocation status information to ArubaOS
applications that use CRLs.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Certificates.

2. Expand the Import Certificates accordion menu.

3. Click the plus (+) icon in the Import Certificates section.

4. Enter the following certificate details in the New Certificate section:

a. Enter a name in the Certificate name text box. This name identifies the certificate you are importing.

b. Enter the certificate filename in the Certificate filename text box. Click the Browse button to enter
the full pathname.

c. Enter a password in the Optional passphrase text box. The password is optional.

d. If you opted for using the optional password (in step c), re-enter the password in the Retype
passphrase text box.

e. Select a certificate format from the Certificate format drop-down list. You can import certificates of
format DER, P12, PEM, PFX, PKCS12, and PKCS7.

f. Select OCSPSignerCert from the Certificate type drop-down list.

When this certificate is imported, it is maintained in the certificate store for OCSP signer certificates. These
certificates are used for signature verification.

The OCSP signer cert signs OCSP responses for this revocation checkpoint. The OCSP signer cert can be the
same trusted CA as the checkpoint, a designated OCSP signer certificate issued by the same CA as the
checkpoint or some other local trusted authority.

If you do not specify an OCSP signer cert, OCSP responses are signed using the global OCSP signer
certificate. If that is not present, than an error message is sent out to clients.

The OCSP signer certificate takes precedence over the global OCSP signer certificate as it is checkpoint specific.
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5. Click Submit. The certificate appears in the Import Certificates section.

6. For detailed information about an imported certificate, click the certificate from the certificate list.

7. Click the Revocation Checkpoint accordion menu.

a. Select Enabled from the Enable OCSP Responder drop-down list.

Enable OCSP Responder is a global option that turns the OCSP responder service on or off on the
controller. The default is disabled (off). Enabling this option automatically adds the OCSP responder port
(TCP 8084) to the permit list in the CP firewall so this can be accessed from outside the controller.

b. Select the OCSPSignerCert to be used to sign OCSP responses for this revocation checkpoint from the
OCSP Certificates drop-down list .

c. In the Revocation Checkpoint section, click the record for which you want to configure the revocation
checkpoint. The Revocation Checkpoint section is displayed.

d. In the Revocation Check list, select ocsp from the Method 1 drop-down list as the primary check
method. Optionally, select a backup check method from the Method 2 drop-down list.

e. Select Enabled from the Enable OCSP Responder drop-down list.

f. Select OCSPSignerCert from the OCSP Signer Cert drop-down list.

g. In the CRL Location text box, enter the CRL you want used for this revocation checkpoint. The CRLs
listed are files that have already been imported onto the controller.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
This example configures the controller as an OCSP responder. The OCSP responder service is enabled, the
revocation checkpoint is CAroot, the OCSP signer cert is “oscap_CA1,” and the CRL file location is “Sec1-WIN-
05PRGNGEKAO-CA-unrevoked.crl.”
(host)[mynode](config) #crypto-local pki service-ocsp-responder

(host)[mynode](config) #crypto-local pki rcp CAroot

(host)[mynode](CAroot) #ocsp-signer-cert oscsp_CA1

(host)[mynode](CAroot) #crl-location file Sec1-WIN-05PRGNGEKAO-CA-unrevoked.crl

(host)[mynode](CAroot) #enable-ocsp-responder

Certificate Revocation Checking for SSH Pubkey Authentication
This feature allows the ssh-pubkey management user to be optionally configured with a Revocation
Checkpoint (RCP). This meets the requirement for a two-factor authentication and integration of device
management with PKI for SSH pubkey authentication. The ArubaOS implementation of SSH using Pubkey
authentication is designed for integration with smart cards or other technologies that use X.509 certificates.

The RCP checks the revocation status of the SSH user’s client certificate before permitting access. If the
revocation check fails, the user is denied access using the ssh-pubkey authentication method. However, the
user can still authenticate through a username and password if configured to do so.

For information about configuring a revocation checkpoint, see Certificate Revocation.

Configuring the SSH Pubkey User with RCP
You can configure the SSH pubkey user with RCP to check the validity of the user’s X.509 certificate.



In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Admin.

2. Click the Management User accordion menu.

3. Click the Show users with certificate authentication link. The Management Users with Certificate
Authentication section is displayed.

4. In the Management Users with Certificate Authentication section, click the plus (+) icon. The
Management Users with Certificate Authentication > New User section is displayed.

5. In the Management Users with Certificate Authentication > New User section, perform the
following steps:

a. Enter a username in the Username text box.

b. Select the Webui certificate check box if you want the user to get the Webui authentication.

c. Select a role from the Role drop-down list.

d. Select a certificate from the Trusted CA certificate name drop-down list.

e. Enter the client certificate serial number in the Client certificate serial no. text box.

f. Select the Use external authentication server to authenticate check box, if you want the user to
be authenticated by an external authentication server.

g. Select the SSH public key check box.

h. Select a client certificate from the Client certificate drop-down list.

6. To specify the revocation checkpoint, perform either of the following tasks :

l To enable the RCP check, select a valid configured RCP from Revocation checkpoint drop-down list.

l Select None if you do not want the RCP check enabled for the SSH pubkey user.

7. Click Submit.

8. Click Pending Changes at the top of the window.

9. In the Pending Changes window, select the check box indicating the pending change and click Deploy
Changes.

In the CLI
The CLI allows you to configure an optional RCP for an ssh-pubkey user. Users can still be configured without
the RCP. In this example, the certificate name is
“client1-rg,”, the username is “test1,” the role name is “root,” and the rcp is “ca-rg:”
(host)[mynode](config) #mgmt-user ssh-pubkey client-cert client1-rg test1 root ?

rcp Revocation Checkpoint for ssh user's client certificate

(host)[mynode](config) #mgmt-user ssh-pubkey client-cert client1-rg test1 root rcp ca-rg

In this example, a user is configured without the RCP:
(host)[mynode](config) #mgmt-user ssh-pubkey client-cert client2-rg test2 root

Displaying Revocation Checkpoint for the SSH Pubkey User
The RCP checks the revocation status of the SSH user’s client certificate before permitting access. If the
revocation check fails, the user is denied access using the ssh-pubkey authentication method. However, the
user can still authenticate through a username and password if configured to do so. This feature allows the
ssh-pubkey management user to be optionally configured with a Revocation Checkpoint (RCP). This meets the
requirement for a two-factor authentication and integration of device management with PKI for SSH pubkey
authentication. The ArubaOS implementation of SSH using Pubkey authentication is designed for integration
with smart cards or other technologies that use X.509.
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The column REVOCATION CHECKPOINT displays the configured RCP for the ssh-pubkey user. If no RCP is
configured for the user, the entry none is displayed.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Admin.

2. Click the Management User accordion menu.

3. Click the Show users with certificate authentication link. The Management Users with Certificate
Authentication section is displayed.

4. Click the user name for which you want to know the configured RCP. The Management User >
<username> section is displayed.

5. The Revocation Checkpoint column displays the RCP configured (if any) for the SSH pubkey user.

In the CLI
(host)#show mgmt-user ssh-pubkey

Removing the SSH Pubkey User

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Admin.

2. Click the Management User accordion menu.

3. Click the Show users with certificate authentication link. The Management Users with Certificate
Authentication section is displayed.

4. Click the username which you want to delete.

5. Click the bin box icon beside the management user that you want to delete.

In the CLI
(host)[mynode](config) #no mgmt-user ssh-pubkey client-cert <certname> <username>
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Chapter 16
Captive Portal Authentication

Captive portal is one of the methods of authentication supported by ArubaOS. A captive portal presents a web
page which requires user action before network access is granted. The required action can be simply viewing
and agreeing to an acceptable use policy, or entering a user ID and password which must be validated against a
database of authorized users.

You can also configure captive portal to allow clients to download the Aruba VPN dialer for Microsoft VPN
clients if the VPN is to be terminated on the Mobility Master. For more information about the VPN dialer, see
Virtual Private Networks on page 335.

Topics in this chapter include:

l Understanding Captive Portal on page 286

l Configuring Captive Portal in the Base Operating System on page 287

l Using Captive Portal with a PEFNG License on page 290

l Sample Authentication with Captive Portal on page 292

l Configuring Guest VLANs on page 299

l Configuring Captive Portal Authentication Profiles on page 300

l Enabling Optional Captive Portal Configurations on page 305

l Personalizing the Captive Portal Page on page 309

l Creating Walled Garden Access on page 313

l Enabling Captive Portal Enhancements

Understanding Captive Portal
You can configure captive portal for guest users, where no authentication is required, or for registered users
who must be authenticated against an external server or the Mobility Master’s internal database.

While you can use captive portal to authenticate users, it does not provide for encryption of user data and should not
be used in networks where data security is required. Captive portal is most often used for guest access, access to
open systems (such as public hot spots), or as a way to connect to a VPN.

You can use captive portal for guest and registered users at the same time. The default captive portal web page
provided with ArubaOS displays login prompts for both registered users and guests. (You can customize the
default captive portal page, as described in Personalizing the Captive Portal Page on page 309)

You can also load up to 16 different customized login pages into the Mobility Master. The login page displayed
is based on the SSID to which the client associates.

Policy Enforcement Firewall Next Generation (PEFNG) License
You can use captive portal with or without the PEFNG license installed in the Mobility Master. The PEFNG
license provides identity-based security to wired and wireless clients through user roles and firewall rules. You
must purchase and install the PEFNG license on the Mobility Master to use identity-based security features.

There are differences in how captive portal functions work and how you configure captive portal, depending on
whether the license is installed. Other parts of this chapter describe how to configure captive portal in the base
operating system (without the PEFNG license) and with the license installed.
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Server Certificate
The Aruba Mobility Master is designed to provide secure services through the use of digital certificates. A server
certificate installed in the Mobility Master verifies the authenticity of the Mobility Master for captive portal.

Aruba Mobility Master ship with a demonstration digital certificate. Until you install a customer-specific server
certificate in the Mobility Master, this demonstration certificate is used by default for all secure HTTP
connections such as captive portal. This certificate is included primarily for the purposes of feature
demonstration and convenience and is not intended for long-term use in production networks. Users in a
production environment are urged to obtain and install a certificate issued for their site or domain by a well-
known certificate authority (CA). You can generate a Certificate Signing Request (CSR) on the Mobility Master to
submit to a CA. For information on how to generate a CSR and how to import the CA-signed certificate into the
Mobility Master, see Managing Certificates on page 758 in Management Access on page 741.

The Mobility Master can accept wild card server certificates (CN begins with an asterisk). If a wildcard certificate
is uploaded (for example, CN=*.domain.com), the asterisk in CN is replaced with 'captiveportal-login' in order
to derive the Captive Portal logon page URL (captiveportal-login.domain.com).

Once you have imported a server certificate into the Mobility Master, you can select the certificate to be used
with captive portal as described in the following sections.

To select a certificate for captive portal using the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > More > General
accordion.

2. Under Captive Portal Certificate, select the name of the imported certificate from the drop-down list.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To select a certificate for captive portal using the command-line interface, access the CLI in config mode and
issue the following commands:
(host) [mynode] (config) #web-server profile

(host) [mynode] (Web Server Configuration) #captive-portal-cert <certificate>

To specify a different server certificate for captive portal with the CLI, use the no command to revert back to
the default certificate before you specify the new certificate:
(host) [mynode] (config) #web-server profile

(host) [mynode] (Web Server Configuration) #captive-portal-cert ServerCert1

(host) [mynode] (Web Server Configuration) #no captive-portal-cert

(host) [mynode] (Web Server Configuration) #captive-portal-cert ServerCert2

Configuring Captive Portal in the Base Operating System
The base operating system (ArubaOS without any licenses) allows full network access to all users who connect
to an ESSID, both guest and registered users. In the base operating system, you cannot configure or customize
user roles; this function is only available by installing the PEFNG license. Captive portal allows you to control or
identify who has access to network resources.

When you create a captive portal profile in the base operating system, an implicit user role is automatically
created with same name as the captive portal profile. This implicit user role allows only DNS and DHCP traffic
between the client and network and directs all HTTP or HTTPS requests to the captive portal. You cannot
directly modify the implicit user role or its rules. Upon authentication, captive portal clients are allowed full
access to their assigned VLAN.



The WLAN Wizard within the ArubaOS WebUI allows for basic captive portal configuration for WLANs associated with
the “default” ap-group: Configuration > WLAN Wizard. Follow the steps in the workflow pane within the wizard and
refer to the help tab for assistance.

What follows are the tasks for configuring captive portal in the base ArubaOS. The example server group and
profile names appear inside quotation marks.

l Create the Server Group name. In this example, the server group name is “cp-srv”.

If you are configuring captive portal for registered users, configure the server(s) and create the server
group. For more information about configuring authentication servers and server groups, see
Authentication Servers on page 174.

l Create Captive Portal Authentication Profile. In this example, the profile name is “c-portal”.

Create and configure an instance of the captive portal authentication profile. Creating the captive portal
profile automatically creates an implicit user role and ACL with the same name. Creating the profile “c-
portal” creates an implicit user role called “c-portal”. That user role allows only DNS and DHCP traffic
between the client and network and directs all HTTP or HTTPS requests to the captive portal.

l Create an AAA Profile. In this example, the profile name is “aaa_c-portal”.

Create and configure an instance of the AAA profile. For the initial role, enter the implicit user role that was
created in step on page 288. The initial role in the profile “aaa_c-portal” must be set to “c-portal”.

l Create SSID Profile. In this example, the profile name is “ssid_c-portal”.

Create and configure an instance of the virtual AP profile which you apply to an AP group or AP name.
Specify the AAA profile you created in step on page 288.

l Create a Virtual AP Profile. In this example, the profile name is “vp_c-portal”.

Create and configure an instance of the SSID profile for the virtual AP.

The following sections present the procedure for configuring the captive portal authentication profile, the AAA
profile, and the virtual AP profile using the WebUI or the command line (CLI). Configuring the VLAN and
authentication servers and server groups are described elsewhere in this document.

In ArubaOS 2.5.2 and later 2.5.x releases, captive portal users in the base operating system are placed into the
predefined cpbase initial user role before authentication. The cpbase role is not supported in ArubaOS 3.x. You need
to create new captive portal profiles in the base operating system, as described in this section, which automatically
generates the required policies and roles.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > L3

Authentication page. Select the Captive Portal Authentication profile.

a. Click + to create a new Captive Portal Authentication Profile, enter the name of the profile (for example,
c-portal), then click Save.

b. Select the captive portal authentication profile you just created.

c. You can enable user login and/or guest login, and configure other captive portal profile parameters as
described in Table 53.

d. Click Save.

2. To specify authentication servers, select Server Group under the captive portal authentication profile you
just configured.

a. Select the server group (for example, cp-srv) from the drop-down list.

b. Click Save.
3. Select the AAA Profiles tab.
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a. In the AAA Profiles, click + to add a new profile. Enter the name of the profile (for example, aaa_c-
portal), then click Add.

b. Select the AAA profile you just created.

c. For Initial Role, select the captive portal authentication profile (for example, c-portal) you created
previously.

The Initial Role must be exactly the same as the name of the captive portal authentication profile you created.

d. Click Save.

4. Under Profiles, select Wireless LAN, then select Virtual AP.

5. To create a new virtual AP profile, Click + from the Virtual AP profile: New Profile pane. Enter the name
for the virtual AP profile (for example, vp_c-portal), and click Save.

a. In the Profile Details entry for the new virtual AP profile (guestnet), select the AAA profile you
previously configured from the AAA Profile drop-down list and click Save.

b. From the SSID profile drop-down list, select NEW.

c. Enter the name for the SSID profile (for example, ssid_c-portal).
d. Enter the Network Name for the SSID (for example, c-portal-ap).

e. For Network Authentication, select None.

f. For Encryption, select Open.

g. At the bottom of the Profile Details page, click Save.
6. Navigate to the Configuration > AP Groups page.

7. Select an AP Group and Click WLANs tab in the AP group window.

8. Click + under the WLANs tab and select the newly create virtual AP profile (guestnet) from the Virtual-ap
drop-down list.

9. Click on the new virtual AP name in the Profiles list.

a. Click General accordion and make sure Virtual AP enable is selected.

b. For VLAN, select the ID of the VLAN in which captive portal users are placed (for example, VLAN 20).
c. Click Save.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To configure captive portal in the base operating system via the command-line interface, access the CLI in
config mode and issue the following commands:
(host) [mynode] (config) #aaa authentication captive-portal c-portal

server-group cp-srv

(host) [mynode] (config) #aaa profile aaa_c-portal

initial-role c-portal

(host) [mynode] (config) #wlan ssid-profile ssid_c-portal

essid c-portal-ap

(host) [mynode] (config) #wlan virtual-ap vp_c-portal

aaa-profile aaa_c-portal

ssid-profile ssid_c-portal

vlan 20



Using Captive Portal with a PEFNG License
The PEFNG license provides identity-based security for wired and wireless users. There are two user roles that
are important for captive portal:

l Default user role, which you specify in the captive portal authentication profile, is the role granted to clients
upon captive portal authentication. This can be the predefined guest system role.

l Initial user role, which you specify in the AAA profile, directs clients who associate to the SSID to captive
portal whenever the user initiates a Web browser connection. This can be the predefined logon system role.

The captive portal authentication profile specifies the captive portal login page and other configurable
parameters. The initial user role configuration must include the applicable captive portal authentication
profile instance.

MAC-based authentication, if enabled on the Mobility Master, takes precedence over captive portal authentication.

The following are the basic tasks for configuring captive portal using role-based access provided by the Policy
Enforcement Firewall software module. Note that you must install the PEFNG license before proceeding (see
Aruba Mobility Master Licensing Guide).

l Configure the user role for a default user.

Create and configure user roles and policies for guest or registered captive portal users. (See Roles and
Policies on page 363 for more information about configuring policies and user roles.)

l Create a server group.

If you are configuring captive portal for registered users, configure the server(s) and create the server
group. (See Authentication Servers on page 174for more information about configuring authentication
servers and server groups.)

If you are using the Mobility Master’s internal database for user authentication, use the predefined “Internal” server
group. You need to configure entries in the internal database, as described in Authentication Servers on page 174.

l Create the captive portal authentication profile.

Create and configure an instance of the captive portal authentication profile. Specify the default user role
for captive portal users.

l Configure the initial user role.

Create and configure the initial user role for captive portal. You need to include the predefined
captiveportal policy, which directs clients to the captive portal, in the initial user role configuration.

You also need to specify the captive portal authentication profile instance in the initial user role
configuration. For example, if you are using the predefined logon system role for the initial role, you need
to edit the role to specify the captive portal authentication profile instance.

l Create the AAA Profile.

Create and configure an instance of the AAA profile. Specify the initial user role.

l Create the SSID Profile “ssid_c-portal”.

Create and configure an instance of the virtual AP profile that you apply to an AP group or AP name. Specify
the AAA profile you just created.

l Create the Virtual AP Profile “vp_c-portal”.

Create and configure an instance of the SSID profile for the virtual AP.
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The following sections present the WebUI and Command Line (CLI) procedures for configuring the captive
portal authentication profile, initial user role, the AAA profile, and the virtual AP profile. Other chapters within
this document detail the configuration of the user roles and policies, authentication servers, and server groups.

Configuring Captive Portal in the WebUI
To configure captive portal with PEFNG license via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > L3
Authentication page. In the Profiles list, select Captive Portal Authentication Profile.

a. Click + to create a new Captive Portal Authentication Profile, enter the name of the profile (for
example, c-portal), then click Save.

b. Select the captive portal authentication profile you just created.

c. Select the default role (for example, employee) for captive portal users.

d. Enable guest login and/or user login, as well as other parameters (refer to Table 53).

e. Click Save.

2. To specify the authentication servers, select Server Group under the captive portal authentication profile
you just configured.

a. Select the server group (for example, cp-srv) from the drop-down list.

b. Click Save.
3. Select the AAA Profiles tab.

a. In the AAA Profiles , click + to add a new profile. Enter the name of the profile (for example, aaa_c-
portal), then click Save.

b. Set the Initial role to a role that you will configure with the captive portal authentication profile.

c. Click Save.

4. Navigate to the Configuration > Roles and Policies. Click on a role and click + to add a new rule.

a. To edit the predefined logon role, select the role and click + in the policies page that opens and select
Access Control.

b. To configure a new role, first configure policy rules in the Policies tab, then select the User Roles tab to
add a new user role and assign policies.

c. Select the profile from the Captive Portal Profile drop-down list in Authentication tab under the selected
Role.

d. Click Save.

5. Navigate to the Configuration > AP Group page to configure the virtual AP profile.

6. Select the AP Group . Click + for the applicable AP group name or AP name.

7. Under Profiles, select Wireless LAN, then select Virtual AP.

8. Select NEW from the Add a profile drop-down list to create a new virtual AP profile. Enter the name for the
virtual AP profile (for example, vp_c-portal), then click Save.
a. In the Profile Details entry for the new virtual AP profile, select the AAA profile you previously

configured. A pop-up window displays the configured AAA profile parameters. Click Save.

b. From the SSID profile drop-down list, select NEW. A pop-up window allows you to configure the SSID
profile.

c. Enter the name for the SSID profile (for example, ssid_c-portal).
d. Enter the Network Name for the SSID (for example, c-portal-ap).

e. At the bottom of the Profile Details page, click Save.
9. Click on the new virtual AP name in the Profiles list or in Profile Details to display configuration parameters.

a. Make sure Virtual AP enable is selected.



b. For VLAN, select the VLAN to which users are assigned (for example, 20).

c. Click Save.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

Configuring Captive Portal in the CLI
To configure captive portal with the PEFNG license via the command-line interface, access the CLI in config
mode and issue the following commands:
(host) [mynode] (config) #aaa authentication captive-portal c-portal

default-role employee

server-group cp-srv

(host) [mynode] (config) #user-role logon

captive-portal c-portal

(host) [mynode] (config) #aaa profile aaa_c-portal

initial-role logon

(host) [mynode] (config) #wlan ssid-profile ssid_c-portal

essid c-portal-ap

vlan 20

(host) [mynode] (config) #wlan virtual-ap vp_c-portal

aaa-profile aaa_c-portal

ssid-profile ssid_c-portal

Sample Authentication with Captive Portal
In the following example:

l Guest clients associate to the guestnet SSID which is an open wireless LAN. Guest clients are placed into
VLAN 900 and assigned IP addresses by the Mobility Master’s internal DHCP server. The user has no access
to network resources beyond DHCP and DNS until they open a web browser and log in with a guest account
using captive portal.

l Guest users are given a login and password from guest accounts created in the Mobility Master’s internal
database. The temporary guest accounts are created and administered by the site receptionist.

l Guest users must enter their assigned login and password into the captive portal login before they are given
access to use web browsers (HTTP and HTTPS), POP3 email clients, and VPN clients (IPsec, PPTP, and L2TP)
on the Internet and only during specified working hours. Guest users are prohibited from accessing internal
networks and resources. All traffic to the Internet is source-NATed.

This example assumes a Policy Enforcement Firewall Next Generation (PEFNG) license is installed in the Mobility
Master.

In this example, you create two user roles:

l guest-logon is a user role assigned to any client who associates to the guestnet SSID. Normally, any client
that associates to an SSID will be placed into the logon system role. The guest-logon user role is more
restrictive than the logon role.

l auth-guest is a user role granted to clients who successfully authenticate via the captive portal.

Creating a Guest User Role
The guest-logon user role consists of the following ordered policies:

l captiveportal is a predefined policy that allows captive portal authentication.

l guest-logon-access is a policy that you create with the following rules:

ArubaOS 8.0.0.0 | User Guide Captive Portal Authentication |  292



293 | Captive Portal Authentication ArubaOS 8.0.0.0  | User Guide

n Allows DHCP exchanges between the user and the DHCP server during business hours while blocking
other users from responding to DHCP requests.

n Allows ICMP exchanges between the user and the Mobility Master during business hours.

l block-internal-access is a policy that you create that denies user access to the internal networks.

The guest-logon user role configuration needs to include the name of the captive portal authentication profile
instance. You can modify the user role configuration after you create the captive portal authentication profile
instance.

Creating an Auth-guest User Role
The auth-guest user role consists of the following ordered policies:

l cplogout is a predefined policy that allows captive portal logout.

l guest-logon-access is a policy that you create with the following rules:

n Allows DHCP exchanges between the user and the DHCP server during business hours while blocking
other users from responding to DHCP requests.

n Allows DNS exchanges between the user and the public DNS server during business hours. Traffic is
source-NATed using the IP interface of the Mobility Master for the VLAN.

l block-internal-access is a policy that you create that denies user access to the internal networks.

l auth-guest-access is a policy that you create with the following rules:

n Allows DHCP exchanges between the user and the DHCP server during business hours while blocking
other users from responding to DHCP requests.

n Allows DNS exchanges between the user and the public DNS server during business hours. Traffic is
source-NATed using the IP interface of the Mobility Master for the VLAN.

n Allows HTTP/S traffic from the user during business hours. Traffic is source-NATed using the I interface
of the Mobility Master for the VLAN.

l drop-and-log is a policy that you create that denies all traffic and logs the attempted network access.

Configuring Policies and Roles in the WebUI

Creating a Time Range
To create the guest-logon-access policy via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > Policies
page.

2. Select + to add the guest-logon-access policy.

3. For Policy Name, enter guest-logon-access.
4. For Policy Type, select IPv4 Session.

5. Click Submit.

6. Select the newly created guest-logon-access policy.

7. Click + under the Policies > guest-logon-access table.

8. In the New Rule for guest-logon-access popup, select Access Control option and click OK.

9. Under the Roles > guest-logon-access > New forwarding Rules table, to add a new rule select the
following options:

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select udp. Enter 68.



d. Under Action, select deny.

e. Click Submit.

f. For the time range, select + and enter the following for adding a new time range:

n For Name, enter working-hours.

n For Type, select Periodic and click +.

n For Start Day, click Weekday.

n For Start Time, enter 07:30.
n For End Time, enter 17:00.

n Click Submit.

10.Add another new rule for the guest-logon-access:

a. Under Source, select any.

b. Under Destination, select any.

c. Under Service, select service. Select svc-dhcp.

d. Under Action, select permit.
e. Under Time Range, select working-hours.
f. Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Creating Aliases
The following step defines an alias representing the public DNS server addresses. Once defined, you can use
the alias for other rules and policies.

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & policies> Policies
page.

2. Select + to add the guest-logon-access policy.

3. For Policy Name, enter guest-logon-access.
4. For Policy Type, select IPv4 Session.

5. Click Submit.

6. Select the newly created guest-logon-access policy.

7. Click + under the Policies > guest-logon-access table.

8. In the New Rule for guest-logon-access popup, select Access Control option and click OK.

9. Under the Roles > guest-logon-access > New forwarding Rules table, to add a new rule select the
following options:

a. Under Source, select user.

b. Under Destination, select alias.

c. Under the alias selection, click +.

n IP version is IPv4.

n For Destination name, enter “Public DNS“.

n For Destination description, enter public-dns.

n Under the Rule section, click +:

n For Rule Type, select host.
n For IP Address, enter 64.151.103.120.

n Click OK.
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n Click Submit. The alias “Public DNS” appears in the Destination menu

d. Under Destination, select Public DNS.

e. Under Service, select svc-dns.
f. Under Action, select src-nat.

g. Under Time Range, select working-hours.

h. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

Creating an Auth-Guest-Access Policy
To configure the auth-guest-access policy via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > Policies
page.

2. Select + to create the policy.

3. For Policy Name, enter auth-guest-access.

4. For Policy Type, select IPv4 Session.

5. Click Submit.

6. Select the newly created auth-guest-access policy.

7. Click + under the Policies > auth-guest-access table.

8. In the New Rule for auth-guest-access popup, select Access Control option and click OK.

9. Under the Roles > auth-guest-access > New forwarding Rules table, to add a new rule select the
following options:

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select udp. Enter 68.

d. Under Action, select deny.

e. Click Submit.

10.Under the Roles > auth-guest-access > New forwarding Rules table, select the following options to
add another rule.

a. Under Source, select any.

b. Under Destination, select any.

c. Under Service, select service. Select svc-dhcp.

d. Under Action, select permit.

e. Under Time Range, select working-hours.

f. Click Submit.

11.Under the Roles > auth-guest-access > New forwarding Rules table, select the following options to
add another rule.

a. Under Source, select user.

b. Under Destination, select alias. Select Public DNS from the drop-down list.

c. Under Service, select service. Select svc-dns.

d. Under Action, select src-nat.

e. Under Time Range, select working-hours.

f. Click Submit.



12.Under the Roles > auth-guest-access > New forwarding Rules table, select the following options to
add another rule.

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select service. Select svc-http.

d. Under Action, select src-nat.

e. Under Time Range, select working-hours.

f. Click Submit.

13.Under the Roles > auth-guest-access > New forwarding Rules table, select the following options to
add another rule.

a. Under Source, select user.

b. Under Destination, select any.

c. Under Service, select service. Select svc-https.

d. Under Action, select src-nat.

e. Under Time Range, select working-hours.

f. Click Submit.

14.Click Submit.

15.Click Pending Changes.

16.In the Pending Changes window, select the check box and click Deploy changes.

Creating an Block-Internal-Access Policy
To create the block-internal-access policy via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies> Policies
page.

2. Select + to add a new policy.

3. For Policy Name, enter block-internal-access.

4. For Policy Type, select IPv4 Session.

5. Click Submit.

6. Select the newly created block-internal-access policy.

7. Click + under the Policies > block-internal-access table.

8. In the New Rule for block-internal-access popup, select Access Control option and click OK.

9. Under the Roles > block-internal-access > New forwarding Rules table, to add a new rule select the
following options:

a. Under Source, select user.

b. Under Destination, select alias.

The following step defines an alias representing all internal network addresses. Once defined, you can use the
alias for other rules and policies.

c. Under the alias selection, click +.

n IP version is IPv4.

n For Destination name, enter “Internal Network“.

n For Destination description, enter internal_network.

n Under the Rule section, click +:
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n For Rule Type, select network.
n For IP Address, enter 10.0.0.0.

n For Network Mask/Range, enter 255.0.0.0.

n Click OK.

n Repeat these steps to add the network ranges 172.16.0.0 255.240.0.0 and 192.168.0.0
255.255.0.0.

n Click Submit. The alias “Internal Network” appears in the Destination menu

d. Under Destination, select Internal Network.

e. Under Service, select any.

f. Under Action, select deny.

g. Click Submit.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Creating a Drop-and-Log Policy
To create the drop-and-log policy via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > Policies
page.

2. Select + to add a new policy.

3. For Policy Name, enter drop-and-log.
4. For Policy Type, select IPv4 Session.

5. Click Submit.

6. Select the newly created drop-and-log policy.

7. Click + under the Policies > drop-and-log table.

8. In the New Rule for drop-and-log popup, select Access Control option and click OK.

9. Under the Roles > drop-and-log > New forwarding Rules table, to add a new rule select the following
options:

a. Under Source, select user.
b. Under Destination, select any.

c. Under Service, select any.
d. Under Action, select deny.

e. Select Log.

f. Click Submit.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Creating a Guest Role
To create a guest role via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > Roles page.

2. Click + to add a new role.

3. Enter guest-logon as a New Role.



4. Select the role name you just created and click Show Advanced View.

5. Click + under the Roles > guest-logon role > Policies.

6. In the Add Policy popup, select the Add an existing policy option.

7. Select the policy name as guest-logon-access from the drop-down list

8. Click Submit.

9. Similarly, add block-internal-access policy for the role guest-logon..

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Creating an Auth-Guest Role
To create the guest-logon role via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies > User Roles
page.

2. Click + to add a new role.

3. Enter auth-guest as a New Role.

4. Select the role name you just created and click Show Advanced View.

5. Click + under the Roles > auth-guest role> Policies.

6. In the Add Policy popup, select the Add an existing policy option.

7. Select the policy name as cplogout from the drop-down list

8. Click Submit.

9. Similarly, add guest-logon-access, block-internal-access, auth-guest-access, drop-and-log policies for the role
auth-guest.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

Configuring Policies and Roles in the CLI

Defining a Time Range
To create a time range via the command-line interface, access the CLI in config mode and issue the following
commands:
(host)(config) #time-range working-hours periodic

weekday 07:30 to 17:00

Creating Aliases
To create aliases via the command-line interface, access the CLI in config mode and issue the following
commands:

(host)(config) #netdestination “Internal Network”

network 10.0.0.0 255.0.0.0

network 172.16.0.0 255.255.0.0

network 192.168.0.0 255.255.0.0

(host)(config) #netdestination “Public DNS”

host 64.151.103.120

host 216.87.84.209
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Creating a Guest-Logon-Access Policy
To create a guest-logon-access policy via the command-line interface, access the CLI in config mode and issue
the following commands:
(host)(config) #ip access-list session guest-logon-access

user any udp 68 deny

any any svc-dhcp permit time-range working-hours

user alias “Public DNS” svc-dns src-nat time-range working-hours

Creating an Auth-Guest-Access Policy
To create an auth-guest-access policy via the command-line interface, access the CLI in config mode and issue
the following commands:
(host) [MyNode] (config) #ip access-list session auth-guest-access

user any udp 68 deny

any any svc-dhcp permit time-range working-hours

user alias “Public DNS” svc-dns src-nat time-range working-hours

user any svc-http src-nat time-range working-hours

user any svc-https src-nat time-range working-hours

Creating a Block-Internal-Access Policy
To create a block-internal-access policy via the command-line interface, access the CLI in config mode and issue
the following commands:
(host) [MyNode] (config) #ip access-list session block-internal-access

user alias “Internal Network” any deny

Creating a Drop-and-Log Policy
To create a drop-and-log policy via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)[MyNode] (config) #ip access-list session drop-and-log

user any any deny log

Creating a Guest-Logon Role
To create a guest-logon-role via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)[MyNode] (config) #user-role guest-logon

session-acl captiveportal position 1

session-acl guest-logon-access position 2

session-acl block-internal-access position 3

Creating an Auth-Guest Role
To create an auth-guest role via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)[MyNode] (config) #user-role auth-guest

session-acl cplogout position 1

session-acl guest-logon-access position 2

session-acl block-internal-access position 3

session-acl auth-guest-access position 4

session-acl drop-and-log position 5

Configuring Guest VLANs
Guests using the WLAN are assigned to VLAN 900 and are given IP addresses via DHCP from the Mobility
Master.



In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces window and select

the VLANs tab.

2. Click + to add a new VLAN.

3. Enter the VLAN name as guest_vlan.

4. Enter VLAN ID/Range as 900.

5. Click Submit.

6. Select the VLAN name from the VLANs table and the VLANs > <VLAN name> table is displayed.

7. Click on the VLAN ID, 900 and enter the following:.

a. For IPv4 Address, enter 192.168.200.20.

b. Click Save.

8. Navigate to Configuration > Services > DHCP Server tab.

a. Select Enabled for IPV4 DHCP Server.

b. Click + under Pool Configuration.

c. In the Pool Name field, enter guestpool.
d. In the Default Router field, enter 192.168.200.20.

e. In the DNS Server field, enter 64.151.103.120.

f. In the Lease field, enter 4 hours.

g. In the Network field, enter 192.168.200.0. In the Netmask field, enter 255.255.255.0.

h. Click Submit.
9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #vlan 900

(host) [mynode] (config) #interface vlan 900

(host) [mynode] (config) #ip address 192.168.200.20 255.255.255.0

(host) [mynode] (config) #ip dhcp pool "guestpool"

(host) [mynode] (config) #default-router 192.168.200.20

(host) [mynode] (config) #dns-server 64.151.103.120

(host) [mynode] (config) #lease 0 4 0

(host) [mynode] (config) #network 192.168.200.0 255.255.255.0

Configuring Captive Portal Authentication Profiles
In this section, you create an instance of the captive portal authentication profile and the AAA profile. For the
captive portal authentication profile, you specify the previously-created auth-guest user role as the default
user role for authenticated captive portal clients and the authentication server group (“Internal”).

To configure captive portal authentication via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > L3
Authentication page. In the Profiles list, select Captive Portal Authentication Profile.

a. Click + to create a new Captive Portal Authentication Profile, enter the name of the profile as guestnet
for the name of the profile, then click Save.

b. Select the captive portal authentication profile you just created.

c. For Default Role, select guest.
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d. Select User Login.

e. Deselect (uncheck) Guest Login.

f. Click Save.

2. Select Server Group under the guestnet captive portal authentication profile you just created.

a. Select internal from the Server Group drop-down list.

b. Click Save.

3. Click Pending Changes.

4. In the Pending Changes window, select the check box and click Deploy changes.

To configure captive portal authentication via the command-line interface, access the CLI in config mode and
issue the following commands:
(host) [mynode] (config) #aaa authentication captive-portal guestnet

default-role auth-guest

user-logon

no guest-logon

server-group internal

Modifying the Initial User Role
The captive portal authentication profile specifies the captive portal login page and other configurable
parameters. The initial user role configuration must include the applicable captive portal authentication profile
instance. Therefore, you need to modify the guest-logon user role configuration to include the guestnet
captive portal authentication profile.

To modify the guest-logon role via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Roles & Policies >Roles page.

2. Select the guest-logon role.

3. Select Show Advanced View in the Roles > guest-logon table.

4. Select the More tab.

5. Select Authentication accordion.

6. Select the captive portal authentication profile you just created from the Captive Portal Profile drop-
down list, and click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

To modify the guest-logon role via the command-line interface, access the CLI in config mode and issue the
following commands:
(host) [mynode] (config) #user-role guest-logon

captive-portal guestnet

Configuring the AAA Profile
In this section, you configure the guestnet AAA profile, which specifies the previously-created guest-logon
role as the initial role for clients who associate to the WLAN.

To configure the AAA profile via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > AAA
Profiles page.

2. Expand AAA. In the AAA Profiles:New Profile, click + to add a new profile. Enter guestnet for the name
of the profile, then click Save.

3. Select guest-logon from Initial role drop-down list.



4. Click Save.
5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To configure the AAA profile via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)[mynode](config) #aaa profile guestnet

initial-role guest-logon

Configuring the WLAN
In this section, you create the guestnet virtual AP profile for the WLAN. The guestnet virtual AP profile
contains the SSID profile guestnet (which configures opensystem for the SSID) and the AAA profile guestnet.

To configure the guest WLAN via the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Under Profiles, select Wireless LAN, then select Virtual AP.

3. To create a new virtual AP profile, Click + from the Virtual AP profile: New Profile pane. Enter the name
for the virtual AP profile (for example, guestnet), and click Save.

a. In the Profile Details entry for the new virtual AP profile (guestnet), select the AAA profile you
previously configured from the AAA Profile drop-down list and click Save.

b. From the SSID profile drop-down list, select NEW.

c. Enter the name for the SSID profile (for example, guestnet).

d. Enter the Network Name for the SSID (for example, guestnet).

e. For Network Authentication, select None.

f. For Encryption, select Open.

g. Click Apply in the pop-up window.

h. At the bottom of the Profile Details page, click Save.
4. Navigate to the Configuration > AP Groups page.

5. Select an AP Group and Click WLANs tab in the AP group window.

6. Click + under the WLANs tab and select the newly create virtual AP profile (guestnet) from the Virtual-ap
drop-down list.

7. Click on the new virtual AP name in the Profiles list.

a. Click General accordion and make sure Virtual AP enable is selected.

b. For VLAN, select the ID of the VLAN in which captive portal users are placed (for example, VLAN 900).
c. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

To configure the guest WLAN via the command-line interface, access the CLI in config mode and issue the
following commands:
(host) [mynode] (config) #wlan ssid-profile guestnet

essid guestnet

opmode opensystem

(host) [mynode] (config) #aaa profile guestnet

initial-role guest-logon

(host) [mynode] (config) #wlan virtual-ap guestnet

vlan 900
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aaa-profile guestnet

ssid-profile guestnet

Managing User Accounts
Temporary user accounts are created in the internal database on the Mobility Master. You can create a user
role which will allow a receptionist to create temporary user accounts. Guests can use the accounts to log into a
captive portal login page to gain Internet access.

See Creating Guest Accounts on page 778 for more information about configuring guest provisioning users
and administering guest accounts.

Configuring Captive Portal Configuration Parameters
Table 53 describes configuration parameters on the WebUI Captive Portal Authentication profile page.

In the CLI, you configure these options with the aaa authentication captive-portal commands.

Parameter Description

Default Role Role assigned to the Captive Portal user upon login. When both user and guest logon
are enabled, the default role applies to the user logon; users logging in using the
guest interface are assigned the guest role.

Default: guest

Default Guest Role Role assigned to guest.

Default: guest

Redirect Pause Time, in seconds, that the system remains in the initial welcome page before
redirecting the user to the final web URL. If set to 0, the welcome page displays until
the user clicks on the indicated link.

Default: 10 seconds

Login Page URL of the page that appears for the user logon. This can be set to any URL.

Default: /auth/index.html

User Logon Enables Captive Portal with authentication of user credentials.

Default: Enabled

Guest Login Enables Captive Portal logon without authentication.

Default: Disabled

Logout popout
window

Enables a pop-up window with the Logout link for the user to logout after logon. If
this is disabled, the user remains logged in until the user timeout period has elapsed
or the station reloads.

Default: Enabled

Table 53: Captive Portal Authentication Profile Parameters



Parameter Description

Use HTTP for
authentication

Use HTTP protocol on redirection to the Captive Portal page. If you use this option,
modify the captive portal policy to allow HTTP traffic.

Default: disabled (HTTPS is used)

Logon wait
minimum wait

Minimum time, in seconds, the user will have to wait for the logon page to pop up if
the CPU load is high. This works in conjunction with the Logon wait CPU utilization
threshold parameter.

Default: 5 seconds

Logon wait
maximum wait

Configure parameters for the logon wait interval

Default: 10 seconds

Logon wait CPU
utilization
threshold

CPU utilization percentage above which the Logon wait interval is applied when
presenting the user with the logon page.

Default: 60%

Max
Authentication
failures

Maximum number of authentication failures before the user is blacklisted.

Default: 0

Show FDQN Allows the user to see and select the fully-qualified domain name (FQDN) on the
login page. The FQDNs shown are specified when configuring individual servers for
the server group used with captive portal authentication.

Default: Disabled

Authentication Pro-
tocol

Select the PAP, CHAP or MS-CHAPv2 authentication protocol.

NOTE: Do not use the CHAP = option unless instructed to do so by anAruba
representative.

Logon Page URL of the page that appears before logon. This can be set to any URL.

Default: /auth/index.html

Welcome Page URL of the page that appears after logon and before redirection to the web URL.
This can be set to any URL.

Default: /auth/welcome.html

Show Welcome
Page

Displays the configured welcome page before the user is redirected to their original
URL. If this option is disabled, users are redirected to the web URL immediately after
they log in.

Default: Enabled

Add switch IP
address in
redirection URL

Sends the Mobility Master’s IP address in the redirection URL when external captive
portal servers are used. An external captive portal server can determine the
Mobility Master from which a request originated by parsing the ‘switchip’ variable in
the URL.

Default: Disabled
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Parameter Description

Add User VLAN in
the Redirection
URL

Sends the user’s VLAN ID in the redirection URL when external captive portal servers
are used.

Add a Mobility
Master interface in
the redirection URL

Sends the Mobility Master’s interface IP address in the redirection URL when
external captive portal servers are used. An external captive portal server can
determine the Mobility Master from which a request originated by parsing the
‘switchip’ variable in the URL. This parameter requires the Public Access license.

Allow only one
active user
session

Allows only one active user session at a time.

Default: Disabled

White List To add a netdestination to the captive portal whitelist, enter the destination host or
subnet, then click Add. The netdestination will be added to the whitelist. To remove
a netdestination from the whitelist, select it in the whitelist field, then click Delete.

If you have not yet defined a netdestination, use the CLI command netdestination
to define a destination host or subnet before you add it to the whitelist.

This parameter requires the Public Access license.

Black List To add a netdestination to the captive portal blacklist, enter the destination host or
subnet, then click Add. The netdestination will be added to the blacklist. To remove a
netdestination from the blacklist, select it in the blacklist field, then click Delete.

If you have not yet defined a netdestination, use the CLI command netdestination
to define a destination host or subnet before you add it to the blacklist.

Show Acceptable
Use Policy Page

Show the acceptable use policy page before the logon page.

Default: Disabled

User idle timeout The user idle timeout value for this profile. Specify the idle timeout value for the client
in seconds. Valid range is 30-15300 in multiples of 30 seconds. Enabling this option
overrides the global settings configured in the AAA timers. If this is disabled, the
global settings are used.

Redirect URL URL to which an authenticated user will be directed. This parameter must be an abso-
lute URL that begins with either http:// or https://.

URL Hash Key If a redirection URL is defined, enter a URL Hash Key to hash the redirect URL using
the specified key.

This parameter enhances security for the ClearPass Guest login URL so that
ClearPass Policy Manager can trust and ensure that the client MAC address in the
redirect URL has not been tampered with by anyone. Default: Disabled.

Enabling Optional Captive Portal Configurations
The following are optional captive portal configurations:

l Uploading Captive Portal Pages by SSID Association on page 306

l Changing the Protocol to HTTP on page 306

l Configuring Redirection to a Proxy Server on page 307



l Redirecting Clients on Different VLANs on page 308

l Web Client Configuration with Proxy Script on page 309

Uploading Captive Portal Pages by SSID Association
You can upload custom login pages for captive portal into the Mobility Master through the WebUI. The SSID to
which the client associates determines the captive portal login page displayed.

You specify the captive portal login page in the captive portal authentication profile, along with other
configurable parameters. The initial user role configuration must include the applicable captive portal
authentication profile instance. (In the case of captive portal in the base operating system, the initial user role is
automatically created when you create the captive portal authentication profile instance.) You then specify the
initial user role for captive portal in the AAA profile for the WLAN.

When you have multiple captive portal login pages loaded in the Mobility Master, you must configure a unique
initial user role and user role, and captive portal authentication profile, AAA profile, SSID profile, and virtual AP
profile for each WLAN that will use captive portal. For example, if you want to have different captive portal
login pages for the engineering, business and faculty departments, you need to create and configure according
to Table 54.

Entity Engineering Business Faculty

Captive portal login
page

/auth/eng-login.html /auth/bus-login.html /auth/fac-login.html

Captive portal user
role

eng-user bus-user fac-user

Captive portal
authentication profile

eng-cp

(Specify /auth/eng-
login.html and eng-
user)

bus-cp

(Specify /auth/bus-
login.html and bus-
user)

fac-cp

(Specify /auth/bus-
login.html and fac-
user)

Initial user role eng-logon

(Specify the eng-cp
profile)

bus-logon

(Specify the bus-cp
profile)

fac-logon

(Specify the fac-logon
profile)

AAA profile eng-aaa

(Specify the eng-logon
user role)

bus-aaa

(Specify the bus-logon
user role)

fac-aaa

(Specify the fac-logon
user role)

SSID profile eng-ssid bus-ssid fac-ssid

Virtual AP profile eng-vap bus-vap fac-vap

Table 54: Captive Portal login Pages

Changing the Protocol to HTTP
By default, the HTTPS protocol is used on redirection to the Captive Portal page. If you need to use HTTP
instead, you need to do the following:

l Modify the captive portal authentication profile to enable the HTTP protocol.
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l For captive portal with role-based access only—Modify the captiveportal policy to permit HTTP traffic
instead of HTTPS traffic.

In the base operating system, the implicit ACL captive-portal-profile is automatically modified.

To change the protocol to HTTP via the WebUI:

1. In the Mobility Master node hierarchy, edit the captive portal authentication profile by navigating to the
Configuration > Authentication > L3 Authentication page.

2. Select a captive portal profile, enable the Use HTTP for authentication check box and click Save.

3. (For captive portal with role-based access only) Edit the captiveportal policy by navigating to the
Configuration > Roles & Policies > Policies page.

a. Select the policy for which you want to add/delete a new rule.

b. First, delete the rule for “user mswitch svc-https dst-nat”.

c. Add a new rule with the following values:

l Source is user.

l Destination is the mswitch alias.

l Service is svc-http.

l Action is dst-nat.

d. Click Submit.
4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To change the protocol to HTTP via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)(config) #aaa authentication captive-portal profile

protocol-http

(For captive portal with role-based access only)

(host)(config) #ip access-list session captiveportal

no user alias mswitch svc-https dst-nat

user alias mswitch svc-http dst-nat

user any svc-http dst-nat 8080

user any svc-https dst-nat 8081

Configuring Redirection to a Proxy Server
You can configure captive portal to work with proxy Web servers. When proxy Web servers are used, browser
proxy server settings for end users are configured for the proxy server’s IP address and TCP port. When the
user opens a Web browser, the HTTP/S connection request must be redirected from the proxy server to the
captive portal on the Mobility Master.

To configure captive portal to work with a proxy server:

l (For captive portal with base operating system) Modify the captive portal authentication profile to specify
the proxy server’s IP address and TCP port.

l (For captive portal with role-based access) Modify the captiveportal policy to have traffic for the proxy
server’s port destination NATed to port 8088 on the Mobility Master.

The base operating system automatically modifies the implicit ACL captive-portal-profile.

The following sections describe how use the WebUI and CLI to configure the captive portal with a proxy server.

When HTTPS traffic is redirected from a proxy server to the Mobility Master, the user’s browser will display a warning
that the subject name on the certificate does not match the hostname to which the user is connecting.



To redirect proxy server traffic using the WebUI:

1. For captive portal with Aruba base operating system, in the Mobility Master node hierarchy, edit the
captive portal authentication profile by navigating to the Configuration > Authentication > L3
Authentication page.

a. Select a captive portal profile and enter the IP address and port for the proxy server.

b. Click Save.

2. For captive portal with role-based access, edit the captiveportal policy by navigating to the Configuration
> Roles and Policies > Policies page.

3. Add a new rule with the following values:

a. Source is user.

b. Destination is any.

c. Service is TCP.

d. Port is the TCP port on the proxy server.

e. Action is dst-nat.

f. IP address is the IP address of the proxy port.

g. Port is the port on the proxy server.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To redirect proxy server traffic via the command-line interface, access the CLI in config mode and issue the
following commands.

For captive portal with Aruba base operating system:
(host)(config) #aaa authentication captive-portal profile

proxy host ipaddr port port

For captive portal with role-based access:

(host)(config) #ip access-list session captiveportal

user alias mswitch svc-https permit

user any tcp port dst-nat 8088

user any svc-http dst-nat 8080

user any svc-https dst-nat 8081

Redirecting Clients on Different VLANs
You can redirect wireless clients that are on different VLANs (from the Mobility Master’s IP address) to the
captive portal on the Mobility Master. To do this:

1. Specify the redirect address for the captive portal.

2. For captive portal with the PEFNG license only, you need to modify the captiveportal policy that is
assigned to the user. To do this:

a. Create a network destination alias to the Mobility Master interface.

b. Modify the rule set to allow HTTPS to the new alias instead of the mswitch alias.

In the base operating system, the implicit ACL captive-portal-profile is automatically modified.

This example shows how to use the command-line interface to create a network destination called cp-redirect
and use that in the captiveportal policy:
(host)(config) #ip cp-redirect-address ipaddr
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For captive portal with PEFNG license:
(host)(config) #netdestination cp-redirect ipaddr

(host)(config) #ip access-list session captiveportal

user alias cp-redirect svc-https permit

user any svc-http dst-nat 8080

user any svc-https dst-nat 8081

Web Client Configuration with Proxy Script
If the web client proxy configuration is distributed through a proxy script (a .pac file), you need to configure
the captiveportal policy to allow the client to download the file. Note that in order modify the captiveportal
policy, you must have the PEFNG license installed in the Mobility Master.

To allow clients to download proxy script via the WebUI:

1. Edit the captiveportal policy by navigating to the Configuration > Roles & Policies > Policies page in
the Mobility Master node hierarchy.

2. Select the Policy and add a new rule with the following values:

n Source is user.

n Destination is host.

n Host IP is the IP address of the proxy server.

n Service is svc-https or svc-http.

n Action is permit.

3. Click Submit to add the rule.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To allow clients to download proxy script via the command-line interface, access the CLI in config mode and
issue the following commands:

(host)(config) #ip access-list session captiveportal

user alias mswitch svc-https permit

user any tcp port dst-nat 8088

user host ipaddr svc-https permit

user any svc-http dst-nat 8080

user any svc-https dst-nat 8081

Personalizing the Captive Portal Page
The following can be personalized on the captive portal page:

l Captive portal background

l Welcome text

l Acceptance Use Policy

Starting with ArubaOS 8.0, Reply-Message that is returned by RADIUS server for a Captive Portal
Authentication can be customized using the Standard Radius attribute reply-Message VSA.

The background image and text should be visible to users with a browser window on a 1024 by 768 pixel
screen. The background should not clash if viewed on a much larger monitor. A good option is to have the
background image at 800 by 600 pixels, and set the background color to be compatible. The maximum image
size for the background can be around 960 by 720 pixels, as long as the image can be cropped at the bottom
and right edges. Leave space on the left side for the login box.



Captive Portal profile have few configurations which are confined only to WebUI and there are no command line
interface commands to perform some of the actions like uploading custom login or Welcome page, background
images, logos, AUP texts, and so on.

You can create your own web pages and install them in the Mobility Master for use with captive portal. See
“Internal Captive Portal” on page 265.

1. In the Mobility Master node hierarchy, navigate to the Configuration > WLAN page.

2. Select a virtual AP and click Security tab.

3. In the Security tab, select Internal captive portal with authentication option.

4. To make changes to the template, perform the following steps using templates link in the Captive Portal
Options window:

a. Click on the Welcome text to change the Title, Banner Icon, or Banner Color.

b. Click OK.

c. Following is an example after making the changes to the Title, Banner Icon, or Banner Color.
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d. Click anywhere on the body of the Welcome text window and you can change the color options of the
window.

e. Click OK.

f. You can also change the Acceptable Usage Policy (AUP) text using templates link in the Captive Portal
Options window.

g. Click OK.

h. Before submitting the changes, ensure that the changes are accurate by clicking the Preview option.



5. Click Submit.

6. To upload Login or Welcome page, perform the following steps using Custom HTML link in the Captive
Portal Options window:

a. Click on Custom HTML link.

b. To change the login page, browse for the file through the File for Login Page option.

c. To change the Welcome page, browse for the file through the File for Welcome Page option.

d. Before submitting the changes, ensure that the changes are accurate by clicking the Preview option.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

Customizing the Captive Portal Page for a Role
Captive Portal page can also be customized for a particular user role.

To customize the Captive Portal page for a role, perform the following steps:

1. In the Mobility Master node hierarchy, navigate to Configuration > Roles & Policies and click Roles
tab.

2. Select the role you want to customize the Captive Portal page for.

3. Select Show Advanced View.

4. Click Captive Portal tab in the Roles ><role_name> table.
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5. Click Internal captive portal with email registration option and the Captive Portal Options are
displayed.

6. You can also customize the Captive Portal page while creating the virtual AP with option as Guest in the
Configuration > WLAN options.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

Creating Walled Garden Access
On the Internet, a walled garden typically controls a user’s access to web content and services. The walled
garden directs the user’s navigation within particular areas to allow access to a selection of websites or prevent
access to other websites.

The Walled Garden feature can be used with the PEFNG or PEFV licenses.

Walled garden access is needed when an external or internal captive portal is used. A common example could
be a hotel environment where unauthenticated users are allowed to navigate to a designated login page (for
example, a hotel website) and all its contents.

Users who do not sign up for Internet service can view “allowed” websites (typically hotel property websites).
The website names must be DNS-based (not IP address based) and support the option to define wildcards.

HTTP or HTTPS proxy does not work when walled garden is implemented as a user-role using domain name
ACL. For example, user alias example.com any permit.

When a user attempts to navigate to other websites not configured in the white list walled garden profile, the
user is redirected back to the login page. In addition, the black listed walled garden profile is configured to
explicitly block navigation to websites from unauthenticated users.

In the CLI
This example configures a destination named Mywhite-list and adds the domain names, example.com and
example.net to that destination. It then adds the destination name Mywhite-list (which contains the allowed
domain names example.com and example.net) to the white list.
(host) [mynode] (config)# netdestination "Mywhite-list"

(host) [mynode] (config)#name example.com

(host) [mynode] (config)#name example.net

(host) [mynode] (config) #aaa authentication captive-portal default

(host) [mynode] (Captive Portal Authentication Profile "default")#white-list

Mywhite-list

After you create the netdestination in using the CLI, perform the following steps in the WebUI:

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Roles and Policies.
2. Select Policies tab.

3. Click + to add a new policy.

4. Enter Policy Name and set the Policy Type as Session.

5. Select the newly created policy name and Click + to add a new rule.



6. Select Access Control as the Rule Type and click OK.

7. In the New forwarding Rule window:

a. Select the Mobility Master's IP version, IPv4 or IPv6, from the IP Version drop-down list.

b. Enter the destination as Alias.

c. Click + for Destination Alias and select the destination, Mywhite-list.

8. Click Submit.
9. Navigate to Configuration > Authentication > L3 Authentication.
10.Select Captive Portal Authentication Profile.
11.To allow users to access a domain, enter the destination name that contains the allowed domain names in

the White List field. This stops unauthenticated users from viewing specific domains such as a hotel
website.

A rule in the white list must explicitly permit a traffic session before it is forwarded to the Mobility Master.
The last rule in the white list denies everything else.

12.To deny users access to a domain, enter the destination name that contains prohibited domain names in
the Black List field. This prevents unauthenticated users from viewing specific websites.

13.Click Save.

14.Click Pending Changes.

15.In the Pending Changes window, select the check box and click Deploy changes.

Enabling Captive Portal Enhancements
ArubaOS introduces the following enhancements in Captive Portal:

l Location information such as AP name and AP group name have been included in the Captive Portal redirect
URL. The following example shows a Captive Portal redirect URL that contains the AP name and the AP
group name:

https://securelogin.example.com/cgi-
bin/login?cmd=login&mac=00:24:d7:ed:84:14&ip=10.15.104.13&essid=example-test-
tunnel&apname=ap135&apgroup=example&url=http%3A%2F%2Fwww%2Eespncricinfo%2Ecom%2F

l A new option redirect-url is introduced in the Captive Portal Authentication profile which allows you to
redirect the users to a specific URL after the authentication is complete.

l Captive Portal Login URL length has been increased from 256 characters to 2048 characters.

l Support for “?” (question mark) inside the Captive Portal login URL has been added.

l A new field, description has been introduced in the netdestination and netdestination6 commands to
provide a description about the netdestination up to 128 characters long.

l Support for configuring Whitelist in Captive Portal has been introduced.

l Support for bypassing Captive Portal landing page has been introduced.

The Captive Portal enhancements are available on Tunnel and Split-Tunnel forwarding modes.

Configuring the Redirect-URL
You can configure the Captive Portal redirect URL using the following commands:
(host) [mynode] (config) # aaa authentication captive-portal REDIRECT

(host) [mynode] (Captive Portal Authentication Profile "REDIRECT") #redirect-url <absolute-

URL>

Example:
(host) [mynode] (config) # aaa authentication captive-portal REDIRECT
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(host) [mynode] (Captive Portal Authentication Profile "REDIRECT") #redirect-url https://test-

login.php

Configuring the Login URL
You can configure a Captive Portal login URL up to 2048 characters using the following commands:
(host) [mynode] (config) # aaa authentication captive-portal LOGIN

(host) [mynode] (Captive Portal Authentication Profile "LOGIN")#login-page

"http://10.17.36.100/login.php?isinit=1&mac=00:11:22:33:44:55&loginURL=https://captiveportal-

login.test.aero/auth/index.html&originalURL=&statusURL=&error=&logginIn”

You can configure the login URL with “?” (question mark) character in it provided the URL containing the question
mark is within the double quotes.

Defining Netdestination Descriptions
You can provide a description (up to 128 characters) for the netdestination using the CLI.

Use the following commands to provide description for an IPv4 netdestination:
(host) [mynode] (config) #netdestination Local-Server

(host) [mynode] (config-dest) #description “This is a local server for IPv4 client

registration”

Use the following commands to provide description for an IPv6 netdestination:
(host) [mynode] (config) #netdestination6 Local-Server6

(host) [mynode] (config-dest) #description “This is a local server for IPv6 client

registration”

The following command displays the details of the specified IPv4 netdestination:
(host) [mynode] (config-dest) #show netdestination Local-Server

Local-Server Description: This is a local server for IPv4 client registration

-------------------------------------------------------------------------------

Position Type IP addr Mask-Len/Range

-------- ---- ------- --------------

1 name 0.0.0.1 yahoomail

2 name 0.0.0.2 mycorp

3 name 0.0.0.3 cricinfo

The following command displays the details of the specified IPv6 netdestination:
(host) (config-dest) #show netdestination Local-Server6

Local-Server6 Description: This is a local server for IPv6 client registration

-------------------------------------------------------------------------------

Position Type IP addr Mask-Len/Range

-------- ---- ------- --------------

1 name 0.0.0.1 yahoomail

2 name 0.0.0.2 mycorp

3 name 0.0.0.3 cricinfo

Configuring a Whitelist
You can now configure a Whitelist in Captive Portal using the CLI.

Configuring the Netdestination for a Whitelist:
Use the following commands to configure a netdestination alias for Whitelist:
(host) [mynode] (config) #netdestination whitelist

(host) [mynode] (config-dest) #description guest_whitelist

(host) [mynode] (config-dest) #name mycorp



Associating a Whitelist to Captive Portal Profile
Use the following CLI commands to associate a whitelist to the Captive profile:
(host) [mynode] (config) #aaa authentication captive-portal CP_Profile

(host) [mynode] (Captive Portal Authentication Profile "CP_Profile”) #white-list whitelist

Applying a Captive Portal Profile to a User-Role
Use the following commands to apply the Captive Portal profile to a user-role:
(host) [mynode] (config) # user-role guest_role

(host) [mynode] (config-role) #session-acl logon-control

(host) [mynode] (config-role) #session-acl captiveportal

(host) [mynode] (config-role) #captive-portal CP_Profile

Verifying a Whitelist Configuration
Use the following commands to verify the whitelist alias:
(host)[mynode] (config) #show netdestination whitelist

whitelist Description: guest_whitelist

--------------------------------------

Position Type IP addr Mask-Len/Range

-------- ---- ------- --------------

1 name 0.0.0.6 mycorp

Verifying a Captive Portal Profile Linked to a Whitelist
Use the following commands to verify the Captive Portal profile linked to the whitelist:
(host)[mynode] (config) #show aaa authentication captive-portal CP_Profile

Captive Portal Authentication Profile "CP_Profile"

-----------------------------------------------------------------

Parameter Value

--------- -----

Default Role guest

Default Guest Role guest

Server Group default

Redirect Pause 10 sec

User Login Enabled

Guest Login Disabled

Logout popup window Enabled

Use HTTP for authentication Disabled

Logon wait minimum wait 5 sec

Logon wait maximum wait 10 sec

logon wait CPU utilization threshold 60 %

Max Authentication failures 0

Show FQDN Disabled

Use CHAP (non-standard) Disabled

Login page /auth/index.html

Welcome page /auth/welcome.html

Show Welcome Page Yes

Add switch IP address in the redirection URL Disabled

Adding user vlan in redirection URL Disabled

Add a controller interface in the redirection URL N/A

Allow only one active user session Disabled

White List whitelist

Black List N/A

Show the acceptable use policy page Disabled

Redirect URL N/A

ArubaOS 8.0.0.0 | User Guide Captive Portal Authentication |  316



317 | Captive Portal Authentication ArubaOS 8.0.0.0  | User Guide

Verifying Dynamic ACLs for a Whitelist
Use the following commands to verify the dynamically created ACLs for the whitelist:
(host) [mynode] (config) #show rights guest_role

Derived Role = 'guest_role'

Up BW:No Limit Down BW:No Limit

L2TP Pool = default-l2tp-pool

PPTP Pool = default-pptp-pool

Periodic reauthentication: Disabled

ACL Number = 79/0

Max Sessions = 65535

Captive Portal profile = CP_Profile

access-list List

----------------

Position Name Location

-------- ---- --------

1 CP_Profile_list_operations

2 logon-control

3 captiveportal

CP_Profile_list_operations

-----------------------------------------

Priority Source Destination Service Action TimeRange Log Expired Queue TOS 8021P

Blacklist Mirror DisScan ClassifyMedia IPv4/6

-------- ------ ----------- ------- ------ --------- --- ------- ----- --- -----

--------- ------ ------- ------------- ------

1 user whitelist svc-http permit Low

4

2 user whitelist svc-https permit Low

4

logon-control

-------------

Priority Source Destination Service Action TimeRange Log Expired Queue TOS 8021P

Blacklist Mirror DisScan ClassifyMedia IPv4/6

-------- ------ ----------- ------- ------ --------- --- ------- ----- --- ----- -

-------- ------ ------- ------------- ------

1 user any udp 68 deny Low

4

2 any any svc-icmp permit Low

4

3 any any svc-dns permit Low

4

4 any any svc-dhcp permit Low

4

5 any any svc-natt permit Low

4

captiveportal

-------------

Priority Source Destination Service Action TimeRange Log Expired Queue

TOS 8021P Blacklist Mirror DisScan ClassifyMedia IPv4/6

-------- ------ ----------- ------- ------ --------- --- ------- -----

--- ----- --------- ------ ------- ------------- ------

1 user controller svc-https dst-nat 8081 Low

4

2 user any svc-http dst-nat 8080 Low

4

3 user any svc-https dst-nat 8081 Low

4

4 user any svc-http-proxy1 dst-nat 8088 Low

4

5 user any svc-http-proxy2 dst-nat 8088 Low

4



6 user any svc-http-proxy3 dst-nat 8088 Low

4

Expired Policies (due to time constraints) = 0

Verifying DNS Resolved IP Addresses for Whitelisted URLs
Use the following command to verify the DNS resolved IP addresses for the whitelisted URLs:
(host)[mynode] #show firewall dns-names ap-name <AP-name>

Example:
(host)[mynode] #show firewall dns-names ap-name ap135

Firewall DNS names

------------------

Index Name Id Num-IP List

----- ---- -- ------ ----

0 bugzilla 10 1 0.0.0.0

1 cricinfo 9 0

2 yahoo 1 0

3 mycorp 6 1 1.1.1.1

Bypassing Captive Portal Landing Page
An increasing number of user sessions in Captive Portal pre-authenticated role, repeatedly request the Captive
Portal login page from the Mobility Master. This impacts the number of browser-based user login requests
handled per second by the Mobility Master. This eventually delays the loading of the Captive Portal page and
logging into Captive Portal. Most of the increased activities are from non-browser based applications running
on smart phones and tablets.

When this feature is disabled, the Mobility Master sends 200 OK status code message to the now-browser
based apps so that the apps stop sending repeated requests to the Mobility Master. This reduces the load of
the httpd process on the Mobility Master. This feature is enabled by default.

You can enable this feature from the Mobility Master CLI. On enabling this feature, non-browser apps continue
to request Captive Portal login page from the Mobility Master. This increases the load of the httpd process of
the Mobility Master.
(host) [mynode] (config) #web-server profile

(host) [mynode] (Web Server Configuration) #bypass-cp-landing-page

The landing page contains the meta-refresh tag to reload the page using real browser applications.
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Chapter 17
Controller Clustering

Cluster is a combination of multiple managed devices working together to provide high availability to all the
clients and ensure service continuity when a failover occurs.

ArubaOS 8.0 supports a 12-node cluster. The managed devices need not be identical and can be either L2-
connected or L3-connected, with a mixed configuration. In case of failover, the client single sign-on (SSO) works
for the L2-connected managed devices and the clients are de-authenticated for L3-connected managed devices
in a cluster.

The client load is shared by all the managed devices and there is a larger roaming domain with smaller fault
domain which helps in faster recovery.

All the managed devices that are part of a cluster are collectively known as cluster members. The workload of
serving APs and clients is divided or partitioned among cluster members. All managed devices that are part of
the cluster are managed by the same Mobility Master.

Clustering is based on keeping client processing, that is, signaling and traffic, anchored to a managed device
regardless of which AP the client roams to, as long as the AP is within the control scope of the cluster. Since, the
client is fixed at a given managed device, a single Basic Service Set (BSS) on an AP can now have clients that are
anchored at multiple managed devices. Therefore, it is important to separate the management of AP from the
management of client. Hence, the terms used are:

l AAC – AP Anchor Controller, a role given to a managed device from individual AP perspective.

l UAC – User Anchor Controller, a role given to a managed device from individual User perspective.

The terms AAC and UAC are only roles corresponding either a given AP or a given user respectively.

The cluster architecture uses the all-active and distributed reliability scheme as all cluster members are actively
serving the load. One of the cluster members is elected as the cluster leader. Each cluster contains only one
cluster leader. The cluster leader is elected from an operations perspective, however, all managed devices
participating in the cluster have all the information to take over the leadership role, if required. Each managed
devices in a cluster actively detects if the peer nodes within the cluster are reachable.

The objective of cluster is to provide high availability to all the clients and ensure service continuity when a
failover occurs. It improves scalability, performance, and redundancy.

Supported Platform
In ArubaOS 8.0, the cluster size can reach up to 12 managed devices to support very large campus
deployments. It supports 7200 Series, 7000 Series, and VM platforms. Cluster setup supports a single cluster
with a mix of 7200 Series and 7000 Series controllers. A mix of VM and hardware platforms are not supported.
Remote Access points are supported in ArubaOS 8.0.

Cluster now supports all the cluster-related global shared memory on 7000 Series and VM controllers.

Support for Heterogeneous Cluster
Listed below are some of the points to consider for cluster capacity (APs and clients) when the cluster has a
heterogeneous managed device mix. For example, 7210, 7220, and 7240 managed devices.

l Total capacity of individual managed devices in the cluster, when redundancy is disabled.

l Half of the total capacity of individual managed devices in the cluster, when redundancy is enabled.
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l The number of clusters are restricted to four when it involves a 7000 Series managed device.

l When 7200 Series managed devices are added to a cluster consisting of other 7000 Series managed devices,
then the capacity of the 7200 Series managed devices is reduced to the maximum capacity of the 7000
Series managed devices that is currently part of the cluster.

l When 7000 Series managed devices is added to a cluster consisting of 7200 Series managed devices, then
one of the following scenarios apply:

n If there are more than three 7200 Series managed devices in the cluster, the 7000 Series managed
devices will not be allowed to join the cluster.

n If the current AP or station count on the 7200 Series managed devices is greater than the maximum AP
or station capacity supported on the newly added 7000 Series managed devices, then the 7000 Series
managed devices will not be allowed to join the cluster. To check if the 7000 Series managed devices
were allowed to join the cluster, execute the show lc-cluster group-membership command.

n If the current AP or station count on the 7200 Series managed devices is less than the maximum AP or
station capacity supported on the newly added 7000 Series managed devices, then the capacity of the
7200 Series managed devices in the cluster will drop to the maximum capacity supported on the 7000
Series managed devices and the existing supported APs in the 7200 Series managed devices will not be
impacted.

l 12-node cluster support is applicable only for clusters consisting of 7200 Series managed devices.

Cluster supports VM only in homogenous mode. VM can be clustered only with other VM controllers and not with 7200
Series/7000 Seriescontrollers.

Cluster is not supported in stand-alone controllers.

Even with a 12-node cluster, the maximum supported APs and client counts are limited to 10k and client count to 100k,
respectively.

RAP and IPv6 Support
With RAPs, tunnel mode VPN is configured and each AP is assigned an inner-IP or remote-IP. The same remote-
IP or inner-IP is assigned to the RAPs on every managed device in the cluster. For RAPs, the size of cluster is
restricted to four. Starting with ArubaOS 8.0, cluster setup supports both IPv4 and IPv6 clients and the IPv6
clients' sessions are also synchronized and continued after fail overs.

Only IPv6 clients are supported in a cluster. As we do not support IPv6 managed devices in a cluster, the APs
communicating to managed devices over IPv6 is not supported.

Cluster Load Balancing
To reduce excessive workload among managed devices, the cluster load balancing feature helps balance the
stations among multiple User Anchor Controller (UAC). Thus, the transition of stations from one UAC to
another is efficiently managed and the disruption to the existing station session is reduced.

If the system detects a distorted distribution of load, it load balanced the managed devices by changing the
UAC of these clients. In this case, the load across all the managed devices are balanced in the cluster regardless
of the type of platform.

For example, the threshold to trigger the load balancer is based on the individual platform capacity, and not
the total cluster capacity. For example, if the threshold is 50%, and a cluster without redundancy has two 7240
managed devices, then the load balancer balances the load if any one of the managed devices reaches 16,000
clients. When the redundancy mode is enabled, the capacity of the cluster is reduced to half and only 8000
clients are considered to reach the threshold.



Enhanced Multicast Proxy
Enhanced Multicast Proxy feature is an integral part of the cluster setup.

In traditional topology, if a multicast stream reaches more than one VLAN, a client that is attached to a BSS
which has VLAN pool configured with both VLANs, receives more than one copy of the stream. In cluster,
multicast is configured in only one VLAN and only one stream is seen by the managed devices and clients.

Managed device acts as a multicast proxy for all the wireless clients connected to it and the managed device's
subscription to multicast stream is done through a single VLAN. Hence, only one copy of the multicast stream
will be delivered to a client.

Clustering supports only IGMP proxy.

When IGMP proxy is enabled, client reports reach UAC and then, UAC transfers the subscription information to
AP Anchor Controller (AAC) . Both managed devices (AAC and UAC) will proxy for clients in the uplink multicast
VLAN.

APs are anchored on AAC and users on UAC. When an AP boots, it establishes tunnel with the AAC. The same
tunnel is used for UAC traffic as well. When a client comes up, the AP determines its UAC and establishes a
tunnel to the UAC. When the client roams from one AAC to another, protocol-independent Multicast (PIM)
detects this roaming through STA (station) channel and deletes the client’s multicast subscriptions from the old
AAC and adds them to the new AAC. To perform this, a cluster proxy table that stores per-client subscriptions is
maintained in the UAC.

If a multicast stream is sourced from a wireless station, the managed device forwards the stream to the
multicast router through the VLAN, where the client is located. The downstream is still from the multicast
router to each managed device in the cluster through the configured VLAN for multicast proxy operation. If the
two VLANs are the same, the proxy on the UAC of the sourcing client will not receive the stream from the
multicast router.

Session State Synchronization
This feature resolves all issues regarding seamless roaming, service availability, and high availability.

Session synchronization feature ensures that service continuity is achieved for clients when failover occurs
without the clients realizing that the managed device was down. The objective of the cluster is to provide high
availability to all the clients and ensure service continuity when a failover occurs.

Only sessions which are HIGH value are synchronized, for example, FTP, UCC, and DPI modified sessions. And
the session synchronization is supported only if the cluster nodes are L2 connected.

Synchronization for load balancing (REDUNDANCY OFF) is a necessary feature. In an existing cluster, when new
managed devices are added and the existing managed devices have load more than the threshold, the load
balancer ensures that traffic from UACs that have more load are redirected to the new managed device. In this
scenario, synchronization of the sessions for these users are performed before the load balancer switches the
users from other UACs to ensure reliability.

A maximum of 10 sessions per client is supported. Session sync is now supported for IPv6 clients and dual stack.

Session synchronization is useful in two different scenarios:

l When Redundancy is OFF — When redundancy mode is turned off, standby copy is not created for an AP or
the client for failover protection. As part of load balancing, prior to planned UAC switchover, sessions are
synchronized to new UAC.
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l When Redundancy is ON — When redundancy mode is turned on, the system will assign standby managed
device for all APs and clients. The sessions are synchronized to standby UACs.

Authorization Server Interaction
Cluster supports redundancy for both APs and clients. ACLs or Roles are referred with names instead of IDs. It
will keep ACLs/roles in sync across cluster members and AP datapath as well.

User Anchor Controller (UAC) is the role given to a managed device from individual user perspective. UAC
handles all the wireless client traffic, including association/disassociation notification, authentication, and all
the unicast traffic between managed device and the client. UAC is used to ensure that the managed device
remains the same within the cluster when the wireless clients roam between APs.

Standby Controller (S-UAC) is the role given to the managed device if a user fails over to this managed device
when Active UAC (A-UAC) is down.

The Authorization module authenticates clients on A-UAC and sets the A-UAC IP address as NAS-IP. The
external RADIUS server sets the NAS-IP as the A-UAC IP in the client database. This NAS-IP is used later to
change the client's state or attributes. However, if the client changes its UAC, the authentication server is not
updated and hence can affect the transactions initiated by the authorization server. To resolve this issue,
virtual-IP and VLAN are configured in each node in the cluster.

AP Fail Over to Different Cluster
Starting from ArubaOS 8.0, an AP will be able to fail over between clusters. Redundancy across geographically
separated data centers are supported. An AP terminates to an AAC in a cluster. If a member in the cluster fails,
then AP will fail over to the standby AAC in the same cluster. If the AP is unable to establish communication to
any of the members in the first cluster, then it will terminate at another cluster setup in the backup data center.
It will terminate only if the other cluster member’s IP is provided in the AP system profile as backup-LMS.

For example, a cluster with four managed devices is deployed in the West Coast data center. Similarly, a cluster
with four managed devices is deployed in the East Coast data center. An AP is configured to have a primary
termination to West Coast data center and backup to East Coast data center. If a managed device fails in the
West Coast data center, then the AAC will move to another managed device in the same data center. However,
if the entire West Coast data center is inaccessible to the AP, then it will fail over to the East Coast data center.

AP-Move
This feature enables an end-user to move a specific AP from the current managed device to a target managed
device. The ap-move command reassigns an AP or AP group to any managed device. When an end-user wants
to move some specific APs to other managed device without changing any configuration or if there is no fail
over/rebootstrap configuration between the current managed device and the target managed device, the ap-
move command can be used to move a specific AP to a specific assigned managed device.

ap-move can be executed in the following setups:

l Same cluster group — ap-move can only be executed on a cluster's managed device leader.

l Same High Availability (HA)— this command is executed on the HA-Active node and the AP will fail over to
HA standby.

l Normal topology — In a non-cluster setup, ap-move can be executed on the node to move an AP from the
current managed device.



In the CLI
If cluster is enabled, the System Access Point monitor (SAPM) process will check whether the current node is
the cluster leader. if not, an error is displayed and the cluster leader IP address is provided to the end-user,
then the end-user can execute the command in the correct managed device.

Currently, apmove and ap-move are two different commands. The ap-move command is used for HA while the
apmove is used for same cluster group and non-cluster setup.

ap-move command is executed as follows:
(host) [mynode] (config) #apmove <ap-mac> <target-ip>

(host) [mynode] (config) #apmove <ap-group/all> <source-ip> <target-ip>

Parameter Description

ap-mac Specific AP.

ap-group/all APs in specific group or all APs in the specific managed
device.

source-ip Specific managed device on which the specific APs are.

target-ip Specific managed device to which the APs will be
move.

Cluster Configuration
This section describes the procedure for setting up a cluster using the CLI.

In the CLI
Execute the following commands to set up a cluster in ArubaOS 8.0:

1. To create a managed device:
(host) [mynode] (config) #configuration node /md/cluster

2. To change the configuration node:
(host) [mynode] (config) #change-config-node /md/cluster

3. To ensure that the common profiles such as SSID, VAP , and AAA profiles configured in /managed
device/cluster are consistent:
(host) [mynode] (config) #configuration device 00:1a:1e:02:04:88 device-model A7210

/md/cluster

4. All managed devices in the cluster need to be time synchronized. Hence, it is recommended to have an
NTP server in a cluster setup. To configure an NTP server:
(host) [cluster] (config) #ntp server <ip address> iburst

(host) [cluster] (config) #ntp authentication-key 1 md5 <password>

5. To configure the cluster group profile in Mobility Master:
(host) [cluster] (config) #lc-cluster group-profile 6NodeCluster

6. To add the managed devices to the group profile:
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The switch IP of the managed device is used as the IP address in the following configuration. The APs termination
point should also be set to the switch IP of the managed device. The LMS-IP for the AP in the AP system profile
becomes the active-AAC (A-AAC) for the AP.

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.16.116.3

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.15.116.4

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.15.116.5

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.15.116.8

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.15.116.9

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #controller

10.15.116.10

(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #redundancy

The IP address is a mandatory field and the priority, mcast, VLAN, VRRP IP and VRRP VLAN are optional fields.

7. In Mobility Master, apply the configuration to managed devices:
(host) [cluster] (Classic Controller Cluster Profile "6NodeCluster ") #write memory

Saving Configuration...

Partial configuration for /md/cluster

8. Configure the group-membership on each managed devices. If you have nodes only under a node-path that
forms a cluster, then execute the command on that node-path [00:1a:1e:02:04:88].
(host) [00:1a:1e:02:04:88] (config) #lc-cluster group-membership 6NodeCluster

(host) [00:1a:1e:02:04:88] (config) #write memory

9. On each managed device, check the cluster status:
(host) #show lc-cluster group-membership

10.To ensure the correct working of client SSO upon failover, managed devices in the cluster have to be L2-
connected. The following command shows the status of L2/L3 connectivity in cluster.
(host) #show lc-cluster vlan-probe status

11.Optionally, on the managed devices, exclude certain VLANs for the VLAN probing algorithm.
(host) (config) #lc-cluster exclude-vlan <vlan-number>

12.After removing the VLANs using the previous command, run the VLAN probing algorithm again.
(host) [cluster] (config) #lc-cluster start-vlan-probe

Basic Show Commands
Use the following show commands to ensure that the cluster configuration is working as expected:

1. Check the cluster status on each managed device:
(host) #show lc-cluster group-membership

2. View the status of the VLAN probing algorithm, which runs automatically between every pair of nodes in
cluster:
(host) #show lc-cluster vlan-probe status

3. View the heartbeat status:
(host) # show lc-cluster heartbeat counters

4. View the active/standby AP load distribution within cluster for an AP:
(host) # show lc-cluster load distribution ap

5. View the active/standby client load distribution within cluster for a client:
(host) # show lc-cluster load distribution client



6. View the list of APs in standby mode on managed devices:
(host) # show ap standby

7. View the list of users in standby mode on managed devices:
(host) # show user-table standby

8. View the list of users in datapath in standby mode on managed devices:
(host) # show datapath user standby

9. View the A-UAC and the S-UAC for any given client. This command can be run on any managed device that is
part of the cluster:
(host) # show aaa cluster essid <essid name> mac <client mac address>

10.Collect the cluster-related debug information from managed devices:
(host) #show cluster-tech-support </flash/config/outfile>

11.Collect the cluster-related debug information from an AP:
(host) #show ap cluster-tech-support ap-name <ap-name> </flash/config/ap outfile>

In the WebUI
Configuration of cluster in the WebUI involves two major steps:

a. Create a cluster profile.

b. Attach the created profile to the cluster group membership.

Perform the following steps to add a cluster profile:

1. In a Managed Network node hierarchy, navigate to Configuration > System > Profiles tab.

2. Expand Cluster, and click Classic Controller Cluster. The Classic Controller Cluster Profile: New
Profile pane is displayed.

3. Click + in the Classic Controller Cluster profile.

4. Enter a name in the Profile name text box.

5. In Member IP address, click + and define the following fields, and then click OK.

l Mandatory parameters

n IP address — The IP address should be set to the switch IP of the managed device.

l Optional parameters

n Priority — This is used to influence the cluster leader election.

n mcast VLAN — The VLAN used to subscribe the multicast traffic to the upstream multicast router.

n VRRP IP — The IP used in order to service all requests initiated by external authentication servers
such as CoA.

n VRRP VLAN — The VLAN used in order to service all requests initiated by the external authentication
servers such as CoA.

6. Click Redundancy to enable redundancy in the cluster.

7. Optionally, the Active Client Load Re-Balance Threshold, Standby Client Load Re-Balance
Threshold, Unbalance Threshold, Minimum Heartbeat Threshold in milliseconds can be set.
However, these parameters have default settings and Aruba strongly recommends using the default
settings.

For Minimum Heartbeat Threshold in milliseconds, the default setting is based on the latency determined
between each pair of managed devices and the cluster. It also depends on the connection type between managed
device and distribution switch (single ethernet cable, or port channel, and so on).

8. Click Save.

Perform the following steps to attach the cluster profile to the cluster group membership.
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9. In the Managed Network node hierarchy, navigate to Configuration > Services > Cluster Profile.
10.Select the cluster profile from the Cluster group-membership drop-down list.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

Cluster Dashboard
The Cluster dashboard provides a visual overview on each cluster deployed on the network, displaying the
following information:

l Health information between cluster members

l Total AP load per Cluster (AAC)

l Total User load per Cluster (UAC)

l Connection time

The Cluster dashboard can only be accessed from the root node of the Mobility Master hierarchy. This
information is not displayed on any stand-alone controllers, managed devices, or other nodes in the hierarchy.
To view the Cluster dashboard, navigate to Dashboard > Cluster in the WebUI. By default, the Cluster
dashboard displays an overview for the first cluster under the Cluster drop-down list. The dashboard displays
Total AP load and Total User Load per Cluster. To view information on a different cluster, click the Cluster
drop-down list, and then select the desired cluster name.

Figure 38 TheClusterDashboard

The Cluster dashboard consists of an Overview page and Membership Details page. The Cluster
Overview page contains the following graphs and tables:

l AP Load Chart: Displays the proportional distribution and number of active, standby, and free APs. Hover
your mouse above a section of the pie chart to view the count for that AP type.

l Client Load Chart: Displays the proportional distribution and number of active, standby, and free stations
(clients). Hover your mouse above a section of the pie chart to view the count for that station type.

l Cluster Members Table: Provides the following information on each member in the cluster. The latency
displayed is in microseconds (μs).



Parameter Description

Self IP Address Self IP address of the cluster member

Controller Hostname Host name of the cluster member

Leader IP Address IP address of the cluster leader to which the cluster
member is assigned

Controller Model Controller model of the cluster member

Cluster Membership Type Cluster membership type (leader or member)

Node Reachability from Mobility Master Indicates whether the cluster member is reachable
from Mobility Master

Table 55: Parameters of the Cluster Members Table - Overview Page

To view more in-depth information on a specific cluster member, select the member from the Cluster
Members table to navigate to the Membership Details page. The Membership Details page contains the
following graphs and tables for the selected cluster member:

l AP Load Chart: Displays the proportional distribution of active, standby, and free APs for the selected
cluster member. Hover your mouse above a section of the pie chart to view the count for that AP type.

l Client Load Chart: Displays the proportional distribution of active, standby, and free stations (clients) for
the selected cluster member. Hover your mouse above a section of the pie chart to view the count for that
station type.

l Cluster Members Table: Provides the following peer-to-peer information for the selected cluster
member.

Parameter Description

Self IP Address Self IP address of the cluster member.

Peer IP Address IP address of the peer managed devices.

Connection Status Connection status of the peer managed device.

Connection Type Connection type between the cluster member and
peer managed device (L2/L3).

Mismatch VLAN ID Indicates any VLAN mismatches between the cluster
member and peer managed device.

Disconnect Reason Indicates why the peer managed device has
disconnected from the cluster member.

Incompatible Reason Indicates why the peer managed device is not
compatible with the cluster member.

Table 56: Parameters for the Cluster Members Table - Membership Details Page
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Parameter Description

Minimum Round Trip Delay Minimum latency, in μs.

Maximum Round Trip Delay Maximum latency, in μs.

Average Round Trip Delay Average latency, in μs.

Troubleshooting Cluster
This section provides commands that can be used to troubleshoot different scenarios in a cluster
configuration.

The different control plane processes in the cluster are GSM manager (GSM), cluster manager (CM), Station
Manager (STM), and AUTH. On the AP, the main modules are A-STM and ASAP (datapath).

Common Scenarios
The following is a list of some common troubleshooting scenarios in cluster: 

l Cluster Formation Unsuccessful

l AP Rebootstrap

l Users are Unable to Connect to a Cluster

l Users are Getting De-authenticated

Cluster Formation Unsuccessful
All the managed devices in the cluster are collectively known as cluster members. The cluster formation is
successful when all the managed devices in the cluster are CONNECTED to each other.

The following is a list of some of the reasons due to which a cluster formation is unsuccessful:

1. If the cluster group membership is not executed then the cluster formation fails.

2. If all the managed devices are not listed in cluster then the cluster formation fails.

3. If there is a connectivity issue and managed devices are not able to reach their peer.

4. If IPsec sa is not formed.

To check the status of the cluster formation, execute the show lc-cluster group membership command.
(host) [mynode] #show lc-cluster group-membership

Mon Dec 21 17:30:51.952 2015

Cluster Enabled, Profile Name = "6NodeCluster"

Redundancy Mode On

Active Client Rebalance Threshold = 50%

Standby Client Rebalance Threshold = 75%

Unbalance Threshold = 5%

Cluster Info Table

------------------

Type IPv4 Address Priority Connection-Type STATUS

---- --------------- -------- --------------- ------

self 10.15.116.3 128 N/A ISOLATED (Leader)

peer 10.15.116.4 128 L3-Connected CONNECTED-FROM-SELF-DISCONNECTED-FROM-PEERS

peer 10.15.116.5 128 L3-Connected CONNECTED-FROM-SELF-DISCONNECTED-FROM-PEERS

peer 10.15.116.8 128 L3-Connected CONNECTED-FROM-SELF-DISCONNECTED-FROM-PEERS

peer 10.15.116.9 128 N/A SECURE-TUNNEL-NEGOTIATING

peer 10.15.116.10 128 N/A SECURE-TUNNEL-NEGOTIATING



DISCONNECTED

INCOMPATIBLE

DISCONNECTED-FROM-SELF-CONNECTED-FROM-PEERS",

CONNECTED-FROM-SELF-DISCONNECTED-FROM-PEERS",

SECURE-TUNNEL-NEGOTIATING

SECURE-TUNNEL-ESTABLISHED

CONNECTED

State Reason

INCOMPATIBLE This error can occur in the following scenario:

l If two managed devices are running different ArubaOS versions, then a build
string mismatch is found and the managed devices are not part of the cluster.

l If there are already 4 managed devices including a RAP in a cluster, and if the
user tries to add another managed device, RAP cluster limit reached error is
displayed.

DISCONNECTED This error can occur in the following scenario:

l If none of the managed devices in the cluster are in the CONNECTED state.

l If there is an issue with the physical connectivity between the managed devices
in the cluster.

l If one of the ports is an untrusted node.

SECURE TUNNEL
NEGOTIATION

This status will be displayed for a very short period of time till the IPsec tunnel is set
up. If the status persists, it indicates that there is an issue in the IPsec tunnel setup.

CONNECTED
FROM SELF
DISCONNECTED
FROM PEER

This error can occur in the following scenario:

l MD1 and MD2 are connected. MD3 is later introduced in the cluster. MD1 and
MD3 are connected but MD2 and MD3 are not connected.

Table 57: Cluster state

After the cluster moves to the CONNECTED state, check if it is L2-connected, where every VLAN on the peer is
reachable as determined by vLAN probing. Use the following command to check the VLAN probing status:
(host) [mynode] #show lc-cluster vlan-probe status

Execute the VLAN probing algorithm on the managed device, if you have made some vlan changes to the
distribution switch:
(host) [mynode] (config) #lc-cluster start-vlan-probe

AP Rebootstrap
When the AP does not have a Standby AAC assigned, following could be the reasons for the AP rebootstrap:

1. Platform capacity — If the managed device has reached maximum exhaustion or it already has the
maximum APs it can support.

To resolve this issue:

l Add another managed device or upgrade an existing managed device to support more number of APs.

l Rework on the network configuration.

2. Multiple managed devices are down – If an AAC goes down, the Standby Controller (S-UAC) is made the
Active Controller (A-UAC). However, if the S-UAC also goes down, then the AP rebootstraps.

To resolve this issue:
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l Ensure that you make an appropriate selection of the distribution switch to handle the required scale.

Users are Unable to Connect to a Cluster
The following is a list of some of the reasons due to which a user might be unable to connect to a cluster:

1. The AP and the managed device have different roles for the user.

Every user has an A-UAC and if the AP’s perception of what the UAC for a user is different from the actual
managed device's perception and if the managed device does not have this information regarding the user,
then it rejects the user.

2. IPsec tunnel is not established.

If CPsec is enabled on the APs, then the APs are expected to have the IPsec tunnel established with all the
managed devices in a cluster. If the IPsec tunnel is not established, the user cannot connect to a cluster.

3. There is incomplete AP configuration for an 802.1X client.

For 802.1X clients to connect, multicast key (mkey) has to go from AAC to UAC. If the mkey is not available
in the UAC, the status will not be displayed and the user would be unable to connect. To check for
incomplete AP configurations, execute the show auth trace buff command .

Users are Getting De-authenticated
The following is a list of some of the reasons due to which a user might get de-authenticated:

1. Cluster failover — If a user is de-authenticated in a cluster, check if there was a cluster failover at the same
time. For a managed note that is down, to check when it was last disconnected, use the show lc-cluster
heartbeat counters command.

l In case a failover occurs when the managed devices are down, check if the managed devices are L2-
connected using the show lc-cluster vlan-probe status command.

l If the managed devices are L3-connected, fix the VLAN probe using the lc-cluster exclude-vlan <vlan-
number> command.

2. If the managed devices are L2-connected and if the issue persists, check for AP Rebootstrap.

3. If the AP is not rebootstrapping and if there was no failover, contact support.

Enabling Debug
In a cluster setup, a lightweight tracing mechanism has been added to collect debug information with minimal
performance impact on the cluster.

In a 7200 Series managed device, the debug information gets collected in the flash1 partition of the managed
device and can be used for future troubleshooting. In a 7000 Series managed device, there is no flash1
partition and a USB device is needed to collect this debug information, which can be used for future debugging
or reporting of an issue.

Following traces could be turned on to collect debug information in the cluster:
(host) #gsm trace channel ap application stm

(host) #gsm trace channel ap application dds

(host) #gsm trace channel ap application cluster_mgr

(host) #gsm trace channel radio application stm

(host) #gsm trace channel radio application dds

(host) #gsm trace channel sta application stm

(host) #gsm trace channel sta application auth

(host) #gsm trace channel sta application dds

(host) #gsm trace channel sta application cluster_mgr

(host) #gsm trace channel mac_user application auth

(host) #gsm trace channel mac_user application dds

(host) #gsm trace channel mac_user application cluster_mgr

(host) #gsm trace channel ip_user application auth



(host) #gsm trace channel ip_user application dds

(host) #gsm trace channel user application auth

(host) #gsm trace channel user application dds

(host) #gsm trace channel sectun application dds

(host) #gsm trace channel sectun application cluster_mgr

(host) #gsm trace channel key_cache application auth

(host) #gsm trace channel key_cache application dds

(host) #gsm trace channel pmk_cache application stm

(host) #gsm trace channel pmk_cache application auth

(host) #gsm trace channel pmk_cache application dds

(host) #gsm trace channel rep_key application dds

(host) #gsm trace channel rep_key application cluster_mgr

(host) #gsm trace channel cluster application dds

(host) #gsm trace channel cluster application cluster_mgr

(host) #gsm trace channel bucket_map application stm

(host) #gsm trace channel bucket_map application auth

(host) #gsm trace channel bucket_map application dds

(host) #gsm trace channel bucket_map application cluster_mgr

(host) #gsm trace channel cluster_bss application dds

(host) #gsm trace channel cluster_bss application cluster_mgr

(host) #gsm trace channel cluster_aac application dds

(host) #gsm trace channel cluster_aac application cluster_mgr

(host) #gsm trace channel cluster_ap application dds

(host) #gsm trace channel cluster_ap application cluster_mgr

(host) #gsm trace channel bss application stm

(host) #gsm trace channel bss application auth

(host) #gsm trace channel bss application cluster_mgr

(host) #dds trace receive channel sta peer $peerIP

(host) #dds trace transmit channel sta peer $peerIP

(host) #dds trace receive channel ip_user peer $peerIP

(host) #dds trace transmit channel ip_user peer $peerIP

(host) #dds trace receive channel mac_user peer $peerIP

(host) #dds trace transmit channel mac_user peer $peerIP

(host) #dds trace receive channel key_cache peer $peerIP

(host) #dds trace transmit channel key_cache peer $peerIP

(host) #dds trace receive channel pmk_cache peer $peerIP

(host) #dds trace transmit channel pmk_cache peer $peerIP

(host) #dds trace receive channel bucket_map peer $peerIP

(host) #dds trace transmit channel bucket_map peer $peerIP

(host) #dds trace receive channel cluster_bss peer $peerIP

(host) #dds trace transmit channel cluster_bss peer $peerIP

(host) #dds trace receive channel cluster_sta peer $peerIP

(host) #dds trace transmit channel cluster_sta peer $peerIP

(host) #dds trace receive channel cac_usage peer $peerIP

(host) #dds trace transmit channel cac_usage peer $peerIP

(host) #dds trace receive channel cluster_aac peer $peerIP

(host) #dds trace transmit channel cluster_aac peer $peerIP

(host) #dds trace receive channel cluster_ap peer $peerIP

(host) #dds trace transmit channel cluster_ap peer $peerIP

(host) #ap debug stm-trace category all loglevel debug

(host) #aaa auth-trace loglevel debug
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Chapter 18
MultiZone

The MultiZone feature allows AP to terminate to multiple managed devices that reside in different zones. A
zone is a collection of managed devices under a single administration domain. The zone can have a single
managed device or a cluster setup.

Traditionally, one AP was managed by a single zone where the configuration was generated on a master
controller and synchronized across all other local controllers. Starting from ArubaOS 8.0, MultiZone AP is
supported and an AP can be managed by multiple zones. Different zones can have different configurations.
The managed devices in different zones do not communicate with one another.

Initially, when the AP is booted up, the first zone it contacts is called the Primary Zone. When the AP boots up
on a managed device, and the primary zone managed device configures the AP including the BSS, radio
channel, radio power, and other features. The primary zone can configure MultiZone profiles to enable the
MultiZone feature.

Data zone is the secondary zone that an AP connects to after receiving the MultiZone configuration from the
primary zone. If there are MultiZone profiles configured and associated in the AP group or AP name profile of
the primary zone, then the AP enters MultiZone state and starts connecting with the specified data zones. Only
one MultiZone profile per ap-group or ap-name can be attached. The data zone managed device must be
configured with the same AP group or AP name profile as the primary zone. When the AP connects to the data
zone managed devices, there is a flag in the HELLO message indicating that the AP is connecting to the zone as
a data zone. The data zone managed device then can configure additional BSSs.

The AP virtually connects to each data zone independently. Each data zone’s network change or failure does
not affect the management of an AP from other data zones. The data zone can configure the AP separately
and the AP will apply each configuration. However, if the primary zone goes down, then all the data zones will
be affected including the traffic on the data zone.

For example, the first zone has SSID-1, SSID-2 configured and has stand-alone setup, while the second zone
has SSID-3, SSID-4 configured and has cluster setup. Then, the MultiZone AP receives both configurations and
provides service for all the four SSIDs with no communication between the managed devices.

The MultiZone feature allows the client traffic of different Extended Service Set (ESS) to go to different
managed devices into various zones without cross-contamination. The client traffic of the specific ESS is
encrypted and tunneled directly from AP to the managed devices using the tunnel mode. All devices in the path
including the primary managed device managing the AP are automatically secured. Client wireless frames are
encrypted/decrypted for the corresponding SSID data zone managed device in the secure zone.

AP-134/AP-135 and AP-224/AP-225 are the AP types supported. All the zones can have a maximum of 12
managed devices and 16 VAPs per radio and a maximum of 5 zones are supported including the primary zone.
The only Forward-Mode supported is Tunnel mode.

The primary zone and data zone managed devices do not require to be on the same layer 2 subnet, but, should
be layer 3 reachable.

The data zone managed device cannot change the configuration that can affect other zone's BSSs like radio
configurations.

The functional flow of the MultiZone AP is as follows:

l AP boots up and terminates on primary zone.

l Receives configuration from primary zone and apply.
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l Simultaneously, it connects to each IP address of data zone configured in the MultiZone profile.

l Receives VAP configuration from data zone and apply.

l If common configuration like radio or channel is changed on primary zone, data zone needs to rebootstrap
to update.

l If the CPsec is enabled, each data zone managed device should have the AP appropriately white-listed.

Configuration
The primary zone can configure MultiZone profiles to enable the MultiZone feature. The data zone APs are
referred to as zone APs. In the data zone, the APs cannot be rebooted, provisioned, or upgraded. Only a tunnel
mode virtual AP configuration is allowed.

The AP-SYSTEM profile should not be configured in the data zone Multizone AP
Group.

In the WebUI
To create a MultiZone profile:

1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles > AP.

2. Click AP MultiZone. AP MultiZone profile: New Profile is displayed.

3. Click + in AP MultiZone profile to add a new profile.

4. Enter the name of the profile in the Profile Name field.

The data zone managed device configuration should only include the VAP profile and AAA profile for the
MultiZone AP Group.

5. Click + in the Data zone controller IP table.

a. Enter the name of the zone in the Zone field.

a. Enter the IP address in the IP field.

a. Enter the number of virtual APs in the num_vaps field.

6. Click the Enable/disable MultiZone check box to enable or disable the MultiZone profile.

7. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

To attach or detach the profile to an ap-group:

1. In the Managed Network node hierarchy, navigate to Configuration > AP Groups.

2. Add the MultiZone profile to an AP Group.

In the CLI
Execute the following commands to create a MultiZone profile, and set the data zone index and controller-ip:
(host) [mynode] (config)##ap multizone-profile newMZProfile

(host) [mynode](AP multizone profile "newMZProfile") #datazone 1 controller-ip 10.15.146.3

num-vaps 5

(host) [mynode](AP multizone profile "newMZProfile") #datazone 2 controller-ip 10.15.116.3

num-vaps 3

(host) [mynode] (AP multizone profile "newMZProfile") #datazone 3 controller-ip 10.16.84.11

Info: Zone 3 num-vaps set to default 2

(host) [mynode] (AP multizone profile "newMZProfile") #datazone 4 controller-ip 10.16.84.12

Info: Zone 4 num-vaps set to default 2



(host) [mynode] (AP multizone profile "newMZProfile") #write memory

Execute the following commands to attach the profile to ap-group or ap-name:
(host) [mynode] (config) #ap-group default

(host) [mynode] (AP group "default") #ap-multizone-profile "newMZProfile"

(host) [mynode] (AP group "default") #write memory
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Chapter 19
Virtual Private Networks

Wireless networks can use virtual private network (VPN) connections to further secure wireless data from
attackers. Mobility Master can be used as a VPN concentrator that terminates all VPN connections from both
wired and wireless clients.

This chapter describes the following topics:

l Planning a VPN Configuration on page 335

l Working with VPN Authentication Profiles on page 338

l Configuring a Basic VPN for L2TP/IPsec on page 340

l Configuring a VPN for L2TP/IPsec with IKEv2 on page 345

l Configuring a VPN for Smart Card Clients on page 350

l Configuring a VPN for Clients with User Passwords on page 351

l Configuring Remote Access VPNs for XAuth on page 352

l Working with Remote Access VPNs for PPTP on page 354

l Working with Site-to-Site VPNs on page 354

l Working with VPN Dialer on page 361

Planning a VPN Configuration
The following VPN types can be configured on the Mobility Master or managed devices:

l Remote access VPNs: Remote access VPNs allow hosts, such as telecommuters or traveling employees, to
connect to private networks (for example, a corporate network) over the Internet. Each host must run VPN
client software, which encapsulates and encrypts traffic, then sends it to a VPN gateway at the destination
network. The following remote access VPN protocols are supported by Mobility Master:

n Layer-2 Tunneling Protocol over IPsec (L2TP/IPsec)

n Point-to-Point Tunneling Protocol (PPTP)

n XAUTH IKE/IPsec

n IKEv2 with Certificates

n IKEv2 with EAP

l Site-to-site VPNs: Site-to-site VPNs allow networks to connect to other networks, such as a corporate
network. Unlike a remote access VPN, hosts in a site-to-site VPN do not run VPN client software. All traffic
for the other network is sent and received through a VPN gateway, which encapsulates and encrypts the
traffic.

Before enabling VPN authentication, you must configure the following:

l The default user role for authenticated VPN clients. See Roles and Policies on page 363 for information
about configuring user roles.

l The authentication server group used by the managed device to validate clients. See Authentication Servers
on page 174 for configuration details.

A server-derived role, if present, takes precedence over the default user role.
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You then specify the default user role and authentication server group in the VPN authentication default
profile, as described in the sections below.

ESP Tunnel Mode is the only supported IPsec mode of operation. Mobility Master does not support AH and Transport
modes.

Selecting an IKE protocol
Managed devices running ArubaOS version 8.0 support both IKEv1 and IKEv2 protocols to establish IPsec
tunnels. Though both IKEv1 and IKEv2 support the same suite-B cryptographic algorithms, IKEv2 is a simpler,
faster, and more reliable protocol than IKEv1.

If your IKE policy uses IKEv2, you should be aware of the following caveats when configuring your VPN:

l Separate pre-shared keys cannot be used for each direction of an exchange; both peers must use the same
pre-shared key.

l Mixed authentication between both pre-shared keys and certificates is not supported; each authentication
exchange requires a single authentication type. For example, if a client authenticates with a pre-shared key,
the managed device must also authenticate with a pre-shared key.

l IKEv2 Authentication Headers (AH) and IP Payload Compression Protocol (IPComp) are not supported.

l Non-Aruba devices can fragment the large IKE_AUTH packets using the standards described in the RFC
7383 – Internet Key Exchange Protocol Version 2 (IKEv2) message fragmentation when the Aruba
device acts as a responder and not as an initiator.

Understanding Suite-B Encryption Licensing
Aruba managed devices support Suite-B cryptographic algorithms when the Advanced Cryptography (ACR)
license is installed. Table 58 describes the Suite-B algorithms supported by Mobility Master IKE Policies and
IPsec tunnels. For further details on configuring a VPN to use Suite-B algorithms, see Configuring a VPN for
L2TP/IPsec with IKEv2 on page 345.

IKE Policies Suite-B for IPsec tunnels

hash: SHA-256-128, SHA-384-192 Encryption: AES-128-GCM, AES-256-GCM

Diffie-Hellman (DH) Groups: ECP-256, ECP-384 Perfect Forward Secrecy (PFS): ECP-256, ECP-
384

Pseudo-Random Function (PRF): HMAC_SHA_256,
HMAC_SHA_384

—

Suite-B certificates: ECDSA-256, ECDSA-384 —

Table 58: Suite-B Algorithms Supported by the ACR License

The ArubaOS hardware supports IKE Suite-B AES-128-GCM and AES-256-GCM encryption. The ArubaOS software
performs the IKE Suite-B Diffie-Hellman and Certificate-based signature operations, and hash, PFS, and PRF
algorithm functions.

The following VPN clients support Suite-B algorithms when establishing an L2TP/IPsec VPN:



Client Operating
System

Supported Suite-B
IKE Authentication

Supported Suite-B IPsec
Encryption

l Windows client

NOTE: Windows client
operating system
includes Windows XP and
later versions.

l IKEv1 Clients using ECDSA
Certificates

l IKEv1/IKEv2 Clients using ECDSA
Certificates with L2TP/PPP/EAP-TLS
certificate user-authentication

l AES-128-GCM

l AES-256-GCM

Table 59: Client Support for Suite-B

The Suite-B algorithms described in Table 58 are also supported by Site-to-Site VPNs between Aruba managed
devices, or between an Aruba managed device and a server running Windows 2008 or StrongSwan 4.3.

Working with IKEv2 Clients
Not all clients support both the IKEv1 and IKEv2 protocols. Only the clients in Table 60 support IKEv2 with the
following authentication types:

Windows Client StrongSwan 4.3 Client VIA Client

l Machine authentication
with Certificates

l User name password
authentication using
EAP-MSCHAPv2 or PEAP-
MSCHAPv2

l User smart-card
authentication with EAP-
TLS / IKEv2

NOTE: Windows clients
using IKEv2 do not support
pre-shared key
authentication.

NOTE: Windows client
operating system includes
Windows 7 and later
versions.

l Machine authentication
with Certificates

l User name password
authentication using EAP-
MSCHAPv2

l Suite-B cryptographic
algorithms

l Machine authentication with
Certificates

l User name password
authentication using EAP-
MSCHAPv2

l EAP-TLS using Microsoft cert
repository

NOTE: VIA clients using IKEv2 do not
support pre-shared key authentication.

Table 60: VPN Clients Supporting IKEv2

Understanding Supported VPN AAA Deployments
If you want to simultaneously deploy various combinations of a VPN client, RAP-psk, RAP-certs, and CAP on the
same controller, see Table 61.

Each row in this table specifies the allowed combinations of AAA servers for simultaneous deployment.
Configuration rules include the following:

l RAP-certs can only use LocalDB-AP.

l An RAP-psk and RAP-cert can only terminate on the same controller if the RAP VPN profile’s AAA server uses
Local-db.

l If an RAP-psk is using an external AAA server, the RAP-cert cannot be terminated on the same controller.

l Clients can use any type of AAA server, regardless of the RAP/CAP authentication configuration server.
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VPN Client RAP psk RAP certs CAP

External AAA server 1 LocalDB LocalDB-AP CPsec-whitelist

External AAA server 1 External AAA server 1 Not supported CPsec-whitelist

External AAA server 1 External AAA server 2 Not supported CPsec-whitelist

LocalDB LocalDB LocalDB-AP CPsec-whitelist

LocalDB External AAA server 1 Not supported CPsec-whitelist

Table 61: Supported VPN AAA Deployments

Working with Certificate Groups
The certificate group feature allows you to access multiple types of certificates on the same controller. To
create a certificate group, use the following command:
(host) [node] (config) #crypto-local isakmp certificate-group server-certificate <server_cert-

name> ca-certificate <ca_cert-name>

You can view existing certificate groups using:
(host) [node] #show crypto-local isakmp certificate-group

Working with VPN Authentication Profiles
VPN Authentication profiles identify an authentication server, the server group to which the authentication
server belongs, and a user-role for authenticated VPN clients. There are three predefined VPN authentication
profiles: default, default-rap, and default-cap. These different profiles allow you to use different
authentication servers, user roles, and IP pools for VPN, remote AP, and campus AP clients.

You can configure the default and default-rap profiles, but not the default-cap profile.



Parameter Description default default-rap default-cap

Default Role for
authenticated users

The role that will be
assigned to the
authenticated users.

default-vpn-
role

default-vpn-
role

sys-ap-role

0

Maximum allowed
authentication failures

The number of
contiguous
authentication failures
before the station is
blacklisted.

0 (feature is
disabled)

0 (feature is
disabled)

0 (feature is
disabled)

Check certificate
common name against
AAA server

When enabled, this
feature verifies that the
certificate's common
name exists in the
server.

disabled enabled enabled

Export VPN IP address
as a route

When enabled, this
feature causes any VPN
client address to be
exported to OSPF using
IPC.

NOTE: Note that the
Framed-IP-Address
attribute is assigned the
IP address as long as the
any server returns the
attribute. The Framed-
IP-Address value always
has a higher priority
than the local address
pool.

enabled enabled enabled

User idle timeout The user idle timeout
value for this profile.
Specify the idle timeout
value for the client in
seconds. Valid range is
30-15300 in multiples of
30 seconds. Enabling
this option overrides the
global settings
configured in the AAA
timers. If this is disabled,
the global settings are
used.

disabled N/A N/A

PAN firewalls Integration Requires IP mapping at
Palo Alto Networks
firewalls.

disabled disabled disabled

Table 62: Predefined Authentication Profile settings

In the WebUI
To modify the default VPN authentication profile via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles page.
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2. In the All Profiles list, select the default VPN authentication profile under Wireless LAN >
VPN Authentication.

3. Click the Default Role drop-down list and select the default user role for authenticated VPN users. (For
detailed information on creating and managing user roles and policies, see Roles and Policies on page 363.)

4. (Optional) Set Max Authentication failures to an integer value. The default value is 0, which disables this
feature.

5. (Optional) If you use client certificates for user authentication, select the Check certificate common
name against AAA server check box to verify that the certificate's common name exists in the server.
This parameter is enabled by default in the default-cap and default-rap VPN profiles, and is disabled by
default on all other VPN profiles.

6. (Optional) Regardless of how an authentication server is contacted, the Export VPN IP address as a
route option causes any VPN client address to be exported to OSPF using IPC. Note that the Framed-IP-
Address attribute is assigned the IP address as long as any server returns the attribute. The Framed-IP-
Address value always has a higher priority than the local address pool.

7. Enter a User idle timeout value, in seconds.

8. (Optional) Enabling PAN Firewall Integration requires IP mapping at Palo Alto Networks firewalls. (For
more information about PAN firewall integration, see Palo Alto Networks Firewall Integration on page 619.)

9. Click Save.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy Changes.

12.In the All Profiles list, select the Server Group entry below the Wireless LAN > VPN Authentication >
Default profile.

13.From the Server Group drop-down list, select the server group to be used for VPN authentication.

14.Click Save.

15.Click Pending Changes.

16.In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
To configure VPN authentication via the command-line interface, access the CLI in config mode and issue the
following commands:
(host) [node] (config) #aaa authentication vpn default

cert-cn-lookup

clone <source>

default-role <role>

export-route

max-authentication-failures <number>

pan-integration

radius-accounting <server_group_name>

server-group <group>

user-idle-timeout <seconds>

Configuring a Basic VPN for L2TP/IPsec
The combination of Layer-2 Tunneling Protocol and Internet Protocol Security (L2TP/IPsec) creates a highly-
secure technology that enables VPN connections across public networks such as the Internet. L2TP/IPsec
provides a logical transport mechanism on which to transmit PPP frames, tunneling, or encapsulation, so that
the PPP frames can be sent across an IP network. L2TP/IPsec relies on the PPP connection process to perform
user authentication and protocol configuration. With L2TP/IPsec, the user authentication process is encrypted
using the Data Encryption Standard (DES) or Triple DES (3DES) algorithm.



L2TP/IPsec using IKEv1 requires two levels of authentication:

l Computer-level authentication with a preshared key to create the IPsec security associations (SAs) to
protect the L2TP-encapsulated data.

l User-level authentication through a PPP-based authentication protocol using passwords, SecureID, digital
certificates, or smart cards after successful creation of the SAs.

Note that only Windows 7 (and later versions), StrongSwan 4.3, and VIA clients support IKEv2. For additional
information on the authentication types supported by these clients, see Working with IKEv2 Clients on page 337.

In the WebUI
Use the following procedures in the WebUI to configure a remote access VPN for L2TP IPsec for clients using
pre-shared keys, certificates, or EAP for authentication:

l Defining Authentication Method and Server Addresses on page 346

l Defining Address Pools on page 346

l Enabling Source NAT on page 346

l Selecting Certificates on page 347

l Defining IKEv1 Shared Keys on page 342

l Configuring IKE Policies on page 347

l Setting the IPsec Dynamic Map on page 348

l Finalizing WebUI changes on page 349

Defining Authentication Method and Server Addresses
1. Define the authentication method and server addresses.

2. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.

3. Click IKEv1 to expand it.

4. To enable L2TP, select Enabled from the L2tp drop-down list (this is enabled by default).

5. Select the authentication method for IKEv1 clients. Currently, supported methods include:

n Password Authentication Protocol (PAP)

n Extensible Authentication Protocol (EAP)

n Challenge Handshake Authentication Protocol (CHAP)

n Microsoft Challenge Handshake Authentication Protocol (MSCHAP)

n Microsoft Challenge Handshake Authentication Protocol version 2 (MSCHAPv2)

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

9. Click General Vpn to expand it. Configure the IP addresses of the Primay DNS Server, Secondary
DNS Server, Primary WINS Server, and Secondary WINS Server that are pushed to the VPN client.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy Changes.

Defining Address Pools
Next, define the pool from which the clients are assigned addresses:

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.
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2. Click General Vpn to expand that section.

3. Under the Address Pools table, click + to open the Add New Address Pool section.

4. Specify the Pool Name, Start address(ipv4/v6), and End address(ipv4/v6).
5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

RADIUS Framed-IP-Address for VPN Clients

IP addresses are usually assigned to VPN clients from configured local address pools. However, the Framed-IP-
Address attribute that is returned from a RADIUS server can be used to assign the address.

VPN clients use different mechanisms to establish VPN connections with Mobility Master, such as IKEv1, IKEv2,
EAP, or a user certificate. Regardless of how the RADIUS server is contacted for authentication, the Framed-IP-
Address attribute is assigned the IP address as long as the RADIUS server returns the attribute. The Framed-IP-
Address value always has a higher priority than the local address pool.

Enabling Source NAT
Under Configuration > Services > VPN in the Mobility Master node hierarchy, click General Vpn to
expand that section. From the Source-nat drop-down list, select Enabled if the IP addresses of clients must be
translated to access the network. If you enabled source NAT, click the NAT POOL drop-down list and select an
existing NAT pool.

Selecting Certificates
If you are configuring a VPN to support machine authentication using certificates, define the IKE Server
certificates for VPN clients using IKE. Note that these certificates must be imported into Mobility Master, as
described in Management Access on page 741.

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.

2. Click General Vpn to expand that section.

3. Select the server certificate for client machines from the Server-certificate for VPN clients drop-down
list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

7. If you are configuring a VPN to support clients using certificates, you must also assign one or more trusted
CA certificates to VPN clients.

a. Click Certificates for VPN Clients to expand that section.

b. Click +.

c. Select a CA certificate from the drop-down list of CA certificates imported in Mobility Master.

d. Click Submit.

e. Repeat the above steps to add additional CA certificates.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy Changes.

Defining IKEv1 Shared Keys
If you are configuring a VPN to support IKEv1 and clients using pre-shared keys, you can configure a global IKE
key or IKE key for each subnet. Make sure that this key matches the key on the client.

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.



2. Click Shared Secrets to expand that section.

3. Click + to open the Create IKE Group section.

4. Enter the Subnet and Subnet mask. To make the IKE key global, specify 0.0.0.0 for both values.

5. Select the Representation type.

6. Enter Shared key and repeat it in the Retype shared key field.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

Configuring IKE Policies
ArubaOS contains several predefined default IKE policies, as described in Table 63. If you do not want to use
any of these predefined policies, you can use the procedures below to edit an existing policy or create your
own custom IKE policy instead.

The IKE policy selections, along with any preshared key, must be reflected in the VPN client configuration. When using
a third-party VPN client, set the VPN configuration on clients to match the choices made above. In case the Aruba
dialer is used, these configurations must be made on the dialer prior to downloading the dialer onto the local client.

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.

2. Click IKEv1 to expand that section.

3. Under IKEv1 Policies, click an existing policy to edit it, or click + to create a new policy.

4. Enter a number into the Priority field to set the priority for this policy. Enter a priority of 1 for the
configuration to take priority over the Default setting.

5. Select Enabled (default value) to enable the policy when it is saved.

6. Set the Encryption type. Click the Encryption drop-down list and select one of the following encryption
types:

l DES

l 3DES

l AES128

l AES192

l AES256

7. Set the HASH function. Click the Hash algorithm drop-down list and select one of the following hash
types:

l MD5

l SHA

l SHA1-96

l SHA2-256-128

l SHA2-384-192

8. ArubaOS VPNs support client authentication using pre-shared keys, RSA digital certificates, or Elliptic Curve
Digital Signature Algorithm (ECDSA) certificates. To set the authentication type for the IKE rule, click the
Authentication drop-down list and select one of the following:

l Pre-Share (for IKEv1 clients using pre-shared keys)

l RSA (for clients using certificates)

l ECDSA-256 (for clients using certificates)

l ECDSA-384 (for clients using certificates)
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9. Diffie-Hellman is a key agreement algorithm that allows two parties to agree upon a shared secret, and is
used within IKE to securely establish session keys. To set the Diffie–Hellman Group for the ISAKMP policy,
click the Diffie hellman group drop-down list and select one of the following groups:

l Group 1: 768-bit Diffie–Hellman prime modulus group.

l Group 2: 1024-bit Diffie–Hellman prime modulus group.

l Group 14: 2048-bit Diffie–Hellman prime modulus group.

l Group 19: 256-bit random Diffie–Hellman ECP modulus group.

l Group 20: 384-bit random Diffie–Hellman ECP modulus group.

Configuring Diffie–Hellman Group 1 and Group 2 types are not permitted if FIPS mode is enabled.

10.Set the Lifetime to define the lifetime of the security association in seconds. The default value is 7200
seconds. To change this value, enter a value between 300 and 86400 seconds.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy Changes.

Setting the IPsec Dynamic Map
Dynamic maps enable IPsec SA negotiations from dynamically addressed IPsec peers. ArubaOS has a
predefined IPsec dynamic map for IKEv1. If you do not want to use this predefined map, you can use the
procedures below to edit an existing map or create your own custom IPsec dynamic map instead.

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.

2. Click IKEv1 to expand that section.

3. Scroll down to the IKEv1 IPSec Dynamic Maps section, then click an existing dynamic map to edit it or
click + to create a new map.

4. In the Priority field, enter a priority number for the map. Negotiation requests for security associations try
to match the highest-priority map first. If that map does not match, the negotiation request continues
down the list to the next-highest priority map until a match is made.

5. In the Name field, enter a name for the dynamic map.

6. (Optional) Configure Perfect Forward Secrecy (PFS) settings for the dynamic peer by assigning a Diffie-
Hellman prime modulus group. PFS provides an additional level of security by ensuring that the IPsec SA
key was not derived from any other key, and therefore, cannot be compromised if another key is broken.
Click the PFS group drop-down list and select one of the following groups:

l Group 1: 768-bit Diffie–Hellman prime modulus group.

l Group 2: 1024-bit Diffie–Hellman prime modulus group.

l Group 14: 2048-bit Diffie–Hellman prime modulus group.

l Group 19: 256-bit random Diffie–Hellman ECP modulus group.

l Group 20: 384-bit random Diffie–Hellman ECP modulus group.

7. Select the transform set for the map to define a specific encryption and authentication type used by the
dynamic peer. Select the transform set for the dynamic peer or click + to add a new transform set.

To view current configuration settings for an IPsec transform-set, access the command-line interface and issue the
command crypto ipsec transform-set tag <transform-set-name>.



8. Set the Lifetime to define the lifetime of the security association for the dynamic peer in seconds. The
default value is 7200 seconds. To change this value, enter a value between 300 and 86400 seconds. Also,
set the Lifetime in kilobytes.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy Changes.

Finalizing WebUI changes
Before navigating to other pages, ensure all changes have been submitted and deployed through the Pending
Changes window.

In the CLI
Use the following procedures to use the command-line interface to configure a remote access VPN for L2TP
IPsec:

1. Define the authentication method and server addresses:
(host) [mynode] (config) #vpdn group l2tp

enable

client configuration {dns|wins} <ipaddr1> [<ipaddr2>]

2. Enable authentication methods for IKEv1 clients:
(host) [mynode] (config) vpdn group l2tp ppp authentication {cache-

securid|chap|eap|mschap|mschapv2|pap

3. Create address pools:
(host) [mynode] (config) #ip local pool <pool> <start-ipaddr> <end-ipaddr>

4. Configure source NAT:
(host) [mynode] (config) #ip access-list session srcnatuser any any src-nat pool <pool>

position 1

5. If you are configuring a VPN to support machine authentication using certificates, define server certificates
for VPN clients using IKEv1:
(host) [mynode] (config) #crypto-local isakmp server-certificate <cert>

6. If you are configuring a VPN to support IKEv1 Clients using pre-shared keys, you can configure a global IKE
key by entering 0.0.0.0 for both the address and netmask parameters in the command below, or configure
an IKE key for an individual subnet by specifying the IP address and netmask for that subnet:
(host) [mynode] (config) #crypto isakmp key <key> address <ipaddr|> netmask <mask>

7. Define IKE Policies:
(host) [mynode] (config) #crypto isakmp policy <priority>

encryption {3des|aes128|aes192|aes256|des}

version v1|v2

authentication {pre-share|rsa-sig|ecdsa-256ecdsa-384}

group {1|2|19|20}

hash {md5|sha|sha1-96|sha2-256-128|sha2-384-192}

lifetime <seconds>

Configuring a VPN for L2TP/IPsec with IKEv2
Only clients running Windows 7 (and later versions), StrongSwan 4.3, and Aruba VIA support IKEv2. For
additional information on the authentication types supported by these clients, see “Working with IKEv2 Clients
on page 337."

ArubaOS 8.0.0.0 | User Guide Virtual Private Networks |  345



346 | Virtual Private Networks ArubaOS 8.0.0.0  | User Guide

In the WebUI
Use the following procedures in the WebUI to configure a remote access VPN for IKEv2 clients using
certificates.

l Defining Authentication Method and Server Addresses on page 346

l Defining Address Pools on page 346

l Enabling Source NAT on page 346

l Selecting Certificates on page 347

l Configuring IKE Policies on page 347

l Setting the IPsec Dynamic Map on page 348

l Finalizing WebUI changes on page 349

Defining Authentication Method and Server Addresses
1. Define the authentication method and server addresses.

2. In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN.

3. Click IKEv2 to expand it.

4. Select the EAP passthrough for IKEv2 clients. The currently supported methods include:

n EAP-TLS

n EAP-PEAP

n EAP-MSCHAPv2

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

8. Click General Vpn to expand it. Configure the IP addresses of the Primary DNS Server, Secondary DNS
Server, Primary WINS Server, and Secondary WINS Server that are pushed to the VPN client.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy Changes.

Defining Address Pools
Next, define the pool from which the clients are assigned addresses.

1. In the Mobility Masternode hierarchy, navigate to Configuration > Services > VPN.

2. Click General Vpn to expand that section.

3. Under the Address Pools section, click + to open the Add New Address Pool section.

4. Specify the Pool name, Start address(ipv4/v6), and End address(ipv4/v6).
5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

Enabling Source NAT
Click General Vpn to expand that section. From the Source-nat drop-down list, select Enabled if the IP
addresses of clients must be translated to access the network. If you enabled source NAT, click the NAT POOL
drop-down list and select an existing NAT pool.



Selecting Certificates
To configure the VPN to support machine authentication using certificates, define the IKE Server certificates for
VPN clients using IKEv2. Note that these certificate must be imported into Mobility Master, as described in
Management Access on page 741.

1. In the Mobility Masternode hierarchy, navigate to Configuration > Services > VPN.

2. Click General Vpn to expand that section.

3. Select the server certificate for client machines from the Server-certificate for VPN clients drop-down
list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

7. If you are configuring a VPN to support IKEv2 clients using certificates, you must also assign one or more
trusted CA certificates to VPN clients.

a. Click Certificates for VPN Clients to expand that section.

b. Click + under the CA Certificate Assigned for VPN-Clients table.

c. Select a CA certificate from the drop-down list of CA certificates imported in Mobility Master.

d. Click Submit.

e. Repeat the above steps to add additional CA certificates.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy Changes.

Configuring IKE Policies
ArubaOS contains several predefined default IKE policies, as described in Table 63. If you do not want to use
any of these predefined policies, you can use the procedures below to delete a factory-default policy, edit an
existing policy, or create your own custom IKE policy instead.

The IKE policy selections must be reflected in the VPN client configuration. When using a third-party VPN client, set
the VPN configuration on clients to match the choices made above. In case the Aruba dialer is used, these
configurations must be made on the dialer prior to downloading the dialer onto the local client.

1. In the Mobility Masternode hierarchy, navigate to Configuration > Services > VPN
2. Click IKEv2 to expand that section.

3. Under IKEv2 Policies, click an existing policy to edit it, or click + to create a new policy.

4. Enter a number into the Priority field to set the priority for this policy. Enter a priority of 1 for the
configuration to take priority over the Default setting.

5. Select Enabled (default value) to enable the policy when it is saved.

6. Set the Encryption type. Click the Encryption drop-down list and select one of the following encryption
types:

l DES

l 3DES

l AES128

l AES192

l AES256

7. Set the HASH function. Click the Hash algorithm drop-down list and select one of the following hash
types:

l MD5
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l SHA

l SHA1-96

l SHA2-256-128

l SHA2-384-192

8. ArubaOS VPNs support IKEv2 client authentication using pre-shared keys, RSA digital certificates, or Elliptic
Curve Digital Signature Algorithm (ECDSA) certificates. To set the authentication type for the IKE rule, click
the Authentication drop-down list and select one of the following types:

l Pre-Share (for IKEv2 clients using pre-shared keys)

l RSA

l ECDSA-256

l ECDSA-384

9. Diffie-Hellman is a key agreement algorithm that allows two parties to agree upon a shared secret, and is
used within IKE to securely establish session keys. To set the Diffie–Hellman Group for the ISAKMP policy,
click the Diffie hellman group drop-down list and select one of the following groups:

l Group 1: 768-bit Diffie–Hellman prime modulus group.

l Group 2: 1024-bit Diffie–Hellman prime modulus group.

l Group 14: 2048-bit Diffie–Hellman prime modulus group.

l Group 19: 256-bit random Diffie–Hellman ECP modulus group.

l Group 20: 384-bit random Diffie–Hellman ECP modulus group.

Configuring Diffie–Hellman Group 1 and Group 2 types are not permitted if FIPS mode is enabled.

10.Set the Pseudo-Random Function (PRF) value. This algorithm is an HMAC function used to hash certain
values during the key exchange:

l PRF-HMAC-MD5

l PRF-HMAC-SHA1

l PRF-HMAC-SHA256

l PRF-HMAC-SHA384

11.Set the Lifetime to define the lifetime of the security association in seconds. The default value is 7200
seconds. To change this value, enter a value between 300 and 86400 seconds.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy Changes.

Setting the IPsec Dynamic Map
Dynamic maps enable IPsec SA negotiations from dynamically addressed IPsec peers. ArubaOS has predefined
IPsec dynamic maps for IKEv2. If you do not want to use these predefined maps, you can use the procedures
below to delete a factory-default map, edit an existing map, or create your own custom IPsec dynamic map
instead.

In the WebUI

1. In the Mobility Masternode hierarchy, navigate to Configuration > Services > VPN.

2. Click IKEv2 to expand that section.

3. Scroll down to the IKEv2 IPsec Dynamic Maps section, then click an existing dynamic map to edit it or
click + to create a new map.



You can also delete a predefined factory-default dynamic map by clicking Delete.

4. In the Priority field, enter a priority number for the map. Negotiation requests for security associations try
to match the highest-priority map first. If that map does not match, the negotiation request continues
down the list to the next-highest priority map until a match is made.

5. In the Name field, enter a name for the dynamic map.

6. (Optional) Configure Perfect Forward Secrecy (PFS) settings for the dynamic peer by assigning a Diffie-
Hellman prime modulus group. PFS provides an additional level of security by ensuring that the IPsec SA
key was not derived from any other key, and therefore can not be compromised if another key is broken.
Click the PFS group drop-down list and select one of the following groups:

l Group 1: 768-bit Diffie–Hellman prime modulus group.

l Group 2: 1024-bit Diffie–Hellman prime modulus group.

l Group 14: 2048-bit Diffie–Hellman prime modulus group.

l Group 19: 256-bit random Diffie–Hellman ECP modulus group.

l Group 20: 384-bit random Diffie–Hellman ECP modulus group.

7. Select the transform set for the map to define a specific encryption and authentication type used by the
dynamic peer. Select the transform set for the dynamic peer or click + to add a new transform set.

To view current configuration settings for an IPsec transform-set, access the command-line interface and issue the
crypto ipsec transform-set tag <transform-set-name>.command.

8. Set the Lifetime to define the lifetime of the security association for the dynamic peer in seconds. The
default value is 7200 seconds. To change this value, enter a value between 300 and 86400 seconds. Also,
set the Lifetime in kilobytes.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy Changes.

Finalizing WebUI changes
Before navigating to other pages, ensure all changes have been submitted and deployed through the Pending
Changes window.

In the CLI
Use the following procedures in the CLI to configure a remote access VPN for L2TP IPsec using IKEv2:

1. Define the server addresses:
(host) [mynode] (config) #vpdn group l2tp

enable

client configuration {dns|wins} <ipaddr1> [<ipaddr2>]

2. Enable authentication methods for IKEv2 clients:
(host) [mynode] (config) #crypto isakmp eap-passthrough {eap-mschapv2|eap-peap|eap-tls}

3. Create address pools:
(host) [mynode] (config) #ip local pool <pool> <start-ipaddr> <end-ipaddr>

4. Configure source NAT:
(host) [mynode] (config) #ip access-list session srcnat user any any src-nat pool <pool>

position 1
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5. If you are configuring a VPN to support machine authentication using certificates, define server certificates
for VPN clients using IKEv2:
(host) [mynode] (config) #crypto-local isakmp server-certificate <cert>

The IKE pre-shared key value must be between 6-64 characters. To configure a pre-shared IKE key that contains non-
alphanumeric characters, surround the key with quotation marks.
For example: crypto-local isakmp key "key with spaces" fqdn-any.

6. Define IKEv2 Policies:
(host) [mynode] (config) #crypto isakmp policy <priority>

encryption {3des|aes128|aes192|aes256|des}

version v2

authentication {pre-share|rsa-sig|ecdsa-256ecdsa-384}

group {1|2|19|20}

hash {md5|sha|sha1-96|sha2-256-128|sha2-384-192}

prf PRF-HMAC-MD5|PRF-HMAC-SHA1|PRF-HMAC-SHA256|PRF-HMAC-SHA384

lifetime <seconds>

7. Define IPsec Tunnel parameters:
(host) [mynode] (config) #crypto ipsec

mtu <max-mtu>

transform-set <transform-set-name> esp-3des|esp-aes128|esp-aes128-gcm|esp-aes192|esp-

aes256|esp-aes256-gcm|esp-des esp-md5-hmac|esp-null-mac|esp-sha-hmac

Configuring a VPN for Smart Card Clients
This section describes how to configure a remote access VPN on the controller for Microsoft L2TP/IPsec clients
with smart cards, which contain a digital certificate allowing user-level authentication without the user entering
a username and password. As described earlier in this chapter, L2TP/IPsec requires two levels of
authentication: IKE SA (machine) authentication and user-level authentication with an IKEv2 or PPP-based
authentication protocol.

Microsoft clients running Windows 7 (and later versions) support both IKEv1 and IKEv2. Microsoft clients using
IKEv2 support machine authentication using RSA certificates (but not ECDSA certificates or pre-shared keys)
and smart card user-level authentication with EAP-TLS over IKEv2.

Windows 7 (and later version) clients without smart cards also support user password authentication using EAP-
MSCHAPv2 or PEAP-MSCHAPv2.

Working with Smart Card clients using IKEv2
To configure a VPN for Windows 7 (and later version) clients using smart cards and IKEv2, follow the procedure
described in Configuring a VPN for L2TP/IPsec with IKEv2 on page 345, and ensure that the following settings
are configured:

l L2TP is enabled

l User authentication is set to EAP-TLS
l The IKE policy is configured for ECDSA or RSA certificate authentication

Working with Smart Card Clients using IKEv1
Microsoft clients using IKEv1, including clients running Windows Vista or earlier versions of Windows, only
support machine authentication using a pre-shared key. In this scenario, user-level authentication is performed
by an external RADIUS server using PPP EAP-TLS, and client and server certificates are mutually authenticated



during the EAP-TLS exchange. During the authentication, EAP-TLS messages from the client are encapsulated
into RADIUS messages and forwarded to the server.

You must configure the L2TP/IPsec VPN with EAP as the PPP authentication and IKE policy for preshared key
authentication of the SA.

On the RADIUS server, you must configure a remote access policy to allow EAP authentication for smart card users
and select a server certificate. The user entry in Microsoft Active Directory must be configured for smart cards.

To configure an L2TP/IPsec VPN for clients using smart cards and IKEv1, ensure that the following settings are
configured:

1. On a RADIUS server, a remote access policy must be configured to allow EAP authentication for smart card
users and to select a server certificate. The user entry in Microsoft Active Directory must be configured for
smart cards. (For detailed information on creating and managing user roles and policies, see Roles and
Policies on page 363.)

l Ensure that the RADIUS server is part of the server group used for VPN authentication.

l Configure other VPN settings as described in Configuring a VPN for L2TP/IPsec with IKEv2 on page 345,
while selecting the following options:

n Select Enable L2TP
n Select EAP for the Authentication Protocol.

n Define an IKE Shared Secret to be used for machine authentication. (To make the IKE key global, specify
0.0.0.0 and 0.0.0.0 for both subnet and subnet mask.)

n Configure the IKE policy for Pre-Share authentication.

Configuring a VPN for Clients with User Passwords
This section describes how to configure a remote access VPN on the controller for L2TP/IPsec clients with user
passwords. As described earlier, L2TP/IPsec requires two levels of authentication: IKE SA authentication and
user-level authentication with the PAP authentication protocol. IKE SA is authenticated with a preshared key,
which you must configure as an IKE shared secret. User-level authentication is performed by the managed
device’s internal database.

You must configure the following:

l AAA database entries for username and passwords

l VPN authentication profile, which defines the internal server group and the default role assigned to
authenticated clients

l L2TP/IPsec VPN with PAP as the PPP authentication (IKEv1 only).

l (For IKEv1 clients) An IKE policy for preshared key authentication of the SA.

l (For IKEv2 clients) A server certificate to authenticate the managed device to clients, and a CA certificate to
authenticate VPN clients.

In the WebUI
Use the following procedure to configure L2TP/IPsec VPN for username/password clients via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth
Servers window.

a. Select Internal from the Server Groups table, and then select Internal from the Server Group >
Internal table to display entries for the internal database.

b. Under Server Group > Internal > Internal > Users, click +.
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c. Enter the User Name and Password information for the client.

d. Select Enabled to activate this entry on creation.

e. Click Submit.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy Changes.

2. In the Managed Network node hierarchy, navigate to the Configuration > Authentication > L3
Authentication page.

a. Under the default VPN Authentication Profile, select Server Group.

b. Select the internal server group from the drop-down list.

c. Click Save.

d. Click Pending Changes.

e. In the Pending Changes window, select the check box and click Deploy Changes.

3. Navigate to the Configuration > Services > VPN page.

a. Click IKEv1 to expand that section.

b. Select Enabled for L2tp (this is enabled by default).

c. Select PAP for Auth Protocols.

d. Click Submit.

e. Click Pending Changes.

f. In the Pending Changes window, select the check box and click Deploy Changes.

4. Configure other VPN settings as described in Configuring a VPN for L2TP/IPsec with IKEv2 on page 345,
while ensuring that the following settings are selected:

l In the Configuration > Services > VPN page, enable L2TP.

l In the Configuration > Services > VPN page, select PAP as the authentication protocol.

In the CLI
The following example uses the command-line interface to configure a L2TP/IPsec VPN for
username/password clients using IKEv1:
(host) [mynode] (config) #vpdn group l2tp

enable

ppp authentication pap

client dns 101.1.1.245

(host) [mynode] (config) #ip local pool pw-clients 10.1.1.1 10.1.1.250

(host) [mynode] (config) #crypto isakmp key <key> address 0.0.0.0 netmask 0.0.00

(host) [mynode] (config) #crypto isakmp policy 1

authentication pre-share

Next, issue the following command in enable mode to configure client entries in the internal database:
(host) [mynode] #local-userdb add username <name> password <password>

Configuring Remote Access VPNs for XAuth
Extended Authentication (XAuth) is an Internet Draft that permits user authentication after IKE Phase 1
authentication. This authentication prompts the user for a username and password, in which user credentials
are authenticated with an external RADIUS or LDAP server or the managed device’s internal database.
Alternatively, the user can start client authentication with a smart card, which contains a digital certificate to



verify the client credentials. IKE Phase 1 authentication can be done with either an IKE preshared key or digital
certificates.

Configuring VPNs for XAuth Clients using Smart Cards
This section describes how to configure a remote access VPN on Mobility Master for Cisco VPN XAuth clients
using smart cards. Smart cards contain a digital certificate, allowing user-level authentication without the user
entering a username and password. IKE Phase 1 authentication can be done with either an IKE preshared key
or digital certificates; for XAuth clients using smart cards, the smart card digital certificates must be used for IKE
authentication. The client is authenticated with the internal database.

You must configure the following:

1. Add entries for Cisco VPN XAuth clients to the managed device’s internal database, or to an external RADIUS
or LDAP server. For details on configuring an authentication server, see Authentication Servers on page
174.

For each client, you need to create an entry in the internal database with the entire Principal name (SubjectAltname
in X.509 certificates) or Common Name as it appears on the certificate.

2. Verify that the server with the client data is part of the server group associated with the VPN authentication
profile.

3. In the IKEv1 section of the Configuration > Services > VPN page, set L2tp to Enabled.

4. In the IKEv1 section of the Configuration > Services > VPNpage, set XAuth to Enabled.

5. The Phase 1 IKE exchange for XAuth clients can be either Main Mode or Aggressive Mode. Aggressive
Mode condenses the IKE SA negotiations into three packets (versus six packets for Main Mode). In the
Aggressive group name field of the Configuration > Services > VPN page, General Vpn section, enter
the authentication group name for aggressive mode to associate this setting to multiple clients. Make sure
that the group name matches the aggressive mode group name configured in the VPN client software.

6. Configure other VPN settings as described in Configuring a VPN for L2TP/IPsec with IKEv2 on page 345,
while ensuring that the following settings are selected:

l In the IKEv1 section of the Configuration > Services > VPN page, set L2tp to Enabled.

l In the IKEv1 section of the Configuration > Services > VPN page, set XAuth to Enabled.

l Define an IKE policy to use RSA or ECDSA authentication.

Configuring a VPN for XAuth Clients Using a Username and Password
This section describes how to configure a remote access VPN on Mobility Master for Cisco VPN XAuth clients
using passwords. IKE Phase 1 authentication is done with an IKE preshared key; users are then prompted to
enter their username and password, which is verified with the internal database.

You must configure the following:

1. Add entries for Cisco VPN XAuth clients to the managed device’s internal database. For details on
configuring an authentication server, see Authentication Servers on page 174

For each client, you need to create an entry in the internal database with the entire Principal name (SubjectAltname
in X.509 certificates) or Common Name as it appears on the certificate.

2. Verify that the server with the client data is part of the server group associated with the VPN authentication
profile.

3. Configure other VPN settings as described in Configuring a VPN for L2TP/IPsec with IKEv2 on page 345,
while ensuring that the following settings are selected:
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l In the IKEv1 section of the Configuration > Services > VPN page, set L2tp to Enabled.

l In the IKEv1 section of the Configuration > Services > VPN page, set XAuth to Enabled.

l The IKE policy must have pre-share authentication.

Working with Remote Access VPNs for PPTP
Point-to-Point Tunneling Protocol (PPTP) is an alternative to L2TP/IPsec. Like L2TP/IPsec, PPTP provides a
logical transport mechanism using tunneling or encapsulation to send PPP frames across an IP network. PPTP
relies on the PPP connection process to perform user authentication and protocol configuration.

With PPTP, data encryption begins after PPP authentication and connection process is completed. PPTP
connections are encrypted through Microsoft Point-to-Point Encryption (MPPE), which uses the Rivest-Shamir-
Aldeman (RSA) RC-4 encryption algorithm. PPTP connections require user-level authentication through a PPP-
based authentication protocol (MSCHAPv2 is the currently-supported method).

In the CLI
(host) [mynode] (config) #vpdn group pptp

enable

client configuration {dns|wins} <ipaddr1> [<ipaddr2>]

ppp authentication {mschapv2}

(host) [mynode] (config) #pptp ip local pool <pool_name> <pool_start_address> [<pool_end_

address>]

Working with Site-to-Site VPNs
Site-to-site VPNs allow sites in different locations to securely communicate with each other over a Layer-3
network such as the Internet. You can use Aruba managed device instead of VPN concentrators to connect the
sites. You can also use a VPN concentrator at one site and a managed device at the other site.

Mobility Master supports the following IKE SA authentication methods for site-to-site VPNs:

l Preshared key: Note that the same IKE shared secret must be configured on both the local and remote
sites.

l Suite-B cryptographic algorithms
l Digital certificates: You can configure an RSA or ECDSA server certificate and a CA certificate for each site-

to-site VPN IPsec map configuration. If you use certificate-based authentication, the peer must be identified
by its certificate subject name, distinguished name (for deployments using IKEv2), or by the peer’s IP
address (for IKEv1). For more information about importing server and CA certificates into Mobility Master,
see Management Access on page 741.

Certificate-based authentication is only supported for site-to-site VPN between two managed devices with static IP
addresses. IKEv1 site-to-site tunnels cannot be created between a Mobility Master and managed device.

Enable IP compression in an IPsec map to reduce the size of data frames transmitted over a site-to-site VPN
between 7200 Series or 7000 Series controllers using IKEv2 authentication. IP compression can reduce the
time required to transmit the frame across the network. When this hardware-based compression feature is
enabled, the quality of unencrypted traffic (such as Lync or Voice traffic) is not compromised by increased
latency or decreased throughput. IP compression is disabled by default.

This feature is only supported in an IPv4 network using IKEv2. This feature cannot be enabled on a 7205 controller or
on a site-to-site VPN established using IKEv1.



Working with Third-Party Devices
Aruba managed devices can use IKEv1 or IKEv2 to establish a site-to-site VPN with another Aruba managed
device or third-party remote client devices. Devices running Microsoft® Windows 2008 can use Suite-B
cryptographic algorithms and IKEv1 to support authentication using RSA or ECDSA. StrongSwan® 4.3 devices
can use IKEv2 to support authentication using RSA or ECDSA certificates, Suite-B cryptographic algorithms, and
pre-shared keys. These two remote clients are tested to work with Aruba managed devices using Suite-B
cryptographic algorithm.

Working with Site-to-Site VPNs with Dynamic IP Addresses
ArubaOS supports site-to-site VPNs with two statically addressed managed devices, or with one static and one
dynamically addressed managed device. Two methods are supported to enable dynamically addressed peers:

l Pre-shared Key Authentication with IKE Aggressive Mode: The Aruba managed device with a
dynamic IP address must be configured as the initiator of IKE Aggressive-mode for Site-Site VPNs, while the
managed device with a static IP address must be configured as the responder of IKE Aggressive mode. Note
that when the managed device is operating in FIPS mode, IKE aggressive mode must be disabled.

l X.509 certificates: IPsec peers will identify each other using the subject name of X.509 certificates. IKE
operates in main mode when this option is selected. This method is preferred from a security standpoint.

Understanding VPN Topologies
You must configure VPN settings on the managed devices at both the local and remote sites. In the following
figure, a VPN tunnel connects Network A to Network B across the Internet.

Figure 39 Site-to-Site VPN Configuration Components

To configure the VPN tunnel on managed device A, you must configure the following:

l The source network (Network A)

l The destination network (Network B)

l The VLAN on which managed device A’s interface to the Layer-3 network is located (Interface A in Figure 39)

l The peer gateway, which is the IP address of managed device B’s interface to the Layer-3 network (Interface
B in Figure 39)

Configure VPN settings on the managed device at both the local and remote sites.

Configuring Site-to-Site VPNs
Use the following procedures to create a site-to-site VPN via the WebUI or CLI.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > VPN page, and click

Site to Site to open that section.

2. In the IPsec Maps section, click + to open the Create New Ipsec section.
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3. Enter a name for this VPN connection in the Name field.

4. Select Enabled so this configuration takes effect as soon as it is saved.

5. In the Priority field, enter a priority level for the IPsec map. Negotiation requests for security associations
try to match the highest-priority map first. If that map does not match, the negotiation request continues
down the list to the next-highest priority map until a match is made.

6. Select a Source network type to specify whether the VPN source, the local network connected to the
managed device, is defined by an IP address or a VLAN ID.

l If you selected IP Address, enter the IP address and netmask for the source network. (See managed
device A in Figure 39)

l If you selected VLAN, click the VLAN drop-down list and select the VLAN ID for the source network.

7. In the Destination network and Destination subnet mask fields, enter the IP address and netmask for
the destination, the remote network to which the local network communicates. (See managed device B in
Figure 39)

8. The SA Lifetime parameter defines the lifetime of the security association in seconds and kilobytes. For
seconds, the default value is 7200. To change this value, enter a value between 300 and 86400 seconds.
Range: 1000–1000000000 kilobytes.

9. Click the Version drop-down list and select v1 to configure the VPN for IKEv1, or v2 for IKEv2.

10.(Optional) Click the Policies drop-down list and select a predefined or custom IKE policy to apply to the
IPsec map. For more information on default IKE policies, see Table 63.

11.IKEv2 site-to-site VPNs between Mobility Master and 7000 Series controllers support traffic compression
between those devices. Set IP compression to Enabled to enable compression for traffic in the site-to-site
tunnel.

12.Set Factory certificate authentication to Enabled to enable the authentication.

13.Select the VLAN containing the interface of the managed device that connects to the Layer-3 network. (See
Interface A in Figure 39)

This determines the source IP address used to initiate IKE. If you select 0 or None, the default is the VLAN
of the managed device’s IP address (either the VLAN where the loopback IP is configured, or VLAN 1 if no
loopback IP is configured).

14.If you enable PFS mode, new session keys are not derived from previously used session keys. Therefore, if a
key is compromised, that compromised key does not affect any previous session keys. PFS mode is disabled
by default. To enable this feature, click the PFS drop-down list and select one of the following Perfect
Forward Secrecy modes:

l group1 : 768-bit Diffie–Hellman prime modulus group.

l group2 : 1024-bit Diffie–Hellman prime modulus group.

l group 14 : 2048-bit Diffie–Hellman prime modulus group.

l group19 : 256-bit random Diffie–Hellman ECP modulus group.

l group20 : 384-bit random Diffie–Hellman ECP modulus group.

15.Set Pre-connect to Enabled to establish the VPN connection, even if there is no traffic being sent from the
local network. If you do not select this, the VPN connection is established only when traffic is sent from the
local network to the remote network.

16.Set Trusted tunnel to Enabled if traffic between the networks is trusted. If you do not select this, traffic
between the networks is untrusted.

17.Set Enforce NATT to Enabled to enforce UDP 4500 for IKE and IPsec. This option is disabled by default.

18.Add one or more transform sets to be used by the IPsec map. Click +, and select an existing transform set or
create a new one. Then click Apply to add that transform set to the IPsec map.



19.For site-to-site VPNs with dynamically addressed peers, select Dynamic from the Remote peer
addressing drop-down list.

a. From the Peer gateway drop-down list, select Initiator if the dynamically addressed switch is the
initiator of IKE Aggressive-mode for Site-Site VPNs, or select Responder if the dynamically addressed
switch is the responder for IKE Aggressive-mode.

b. In the FQDN field, enter a fully qualified domain name (FQDN) for the managed device. If the managed
device is defined as a dynamically addressed responder, you can select All Peers to make the managed
device a responder for all VPN peers, or select Per Peer Id and specify the FQDN to make the managed
device a responder for one specific initiator.

20.For Remote peer addressing that is Static, select one of the supported peer gateway types:

l IP Address: Select this option to identify the remote end point of the VPN tunnel using an IP address.

l FQDN : This option allows you to use same FQDN across different branches. The FQDN resolves to
different IP addresses for each branch, based on its local DNS setting.

21.Define the Peer Gateway using an IP address or FQDN.

l If you use IKEv1 to establish a site-to-site VPN for a statically addressed remote peer and selected
IP Address in the previous step, enter the IP address of the interface used by the remote peer to
connect to the L3 network in the Peer Gateway field (See Interface B in Figure 39).

l If you are configuring an IPsec map for a dynamically addressed remote peer, and selected IP Address in
the previous step, leave the peer gateway set to its default value of 0.0.0.0.

l If you selected FQDN as the peer gateway type in the previous step, enter the fully qualified domain
name for the remote peer.

22.Select one of the following authentication types:

a. For pre-shared key authentication, select PSK, select the Representation type, then enter a shared
secret in the IKE shared secret and Retype shared secret fields. This authentication type is generally
required in IPsec maps for a VPN with dynamically addressed peers, but can also be used for a static site-
to-site VPN.

b. For certificate authentication, select Certificate, then click the Server certificate and CA certificate
drop-down lists to select certificates previously imported into the controller. See Management Access on
page 741 for more information. Enter the Peer certificate subject name.

To identify the subject name of a peer certificate, issue the following command in the CLI:
show crypto-local pki servercert <certname> subject

23.Click Submit.

24.Click Pending Changes.

25.In the Pending Changes window, select the check box and click Deploy Changes.

26.Click the IKEv1 or IKEv2 section (match the IKE version that you selected in Step 9) to configure an IKE
policy.

a. Under IKE Policies, click + to open the Add IKE Policy configuration page.

b. Set the Priority to 1 for this configuration to take priority over the Default setting.

c. Set Enable policy to Enabled so the configuration takes effect as soon as it is saved.

d. Set the Encryption from the drop-down list.
e. Set the HASH algorithm from the drop-down list.

f. Set the Authentication to pre-share if you use pre-shared keys. If you use certificate-based IKE, select
rsa or ecdsa.

g. Set the Diffie hellman group from the drop-down list.
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h. Set the Lifetime to define the lifetime of the security association in seconds. The default value is 7200
seconds. To change this value, enter a value between 300 and 86400 seconds.

i. The IKE policy selections, including any pre-shared key, must be reflected in the VPN client configuration.
When using a third-party VPN client, set the VPN configuration on clients to match the choices made
above. If you use the Aruba dialer, you must configure the dialer prior to downloading the dialer onto
the local client.

j. Click Submit.

k. Click Pending Changes.

l. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
To configure a site-to-site VPN with two static IP managed devices using IKEv1, issue the following commands
in the CLI:
(host) [mynode] (config) #crypto-local ipsec-map <ipsec-map-name> <ipsec-map-number>

src-net <ipaddr> <mask>

dst-net <ipsec-map-dst-net> <ipsec-map-dst-mask>

peer-ip <ipaddr>

vlan <ipsec-map-vlan-id>

version {v1|v2}

peer-cert-dn <peer-dn>

pre-connect {enable|disable}

trusted enable

For certificate authentication:
set ca-certificate <cacert-name>

set server-certificate <cert-name>

(host) [mynode] (config) #crypto isakmp policy <priority>

encryption {3DES|AES128|AES192|AES256|DES}

version {v1|v2}

authentication {pre-share|rsa-sig|ecdsa-256|ecdsa-384}}

group {1|2|14|19|20}

hash {md5|sha|sha1-96|sha2-256-128|sha2-384-192}

lifetime <seconds>

For pre-shared key authentication:
(host) [mynode] (config) #crypto-local isakmp {key <keystring>|key-hex <keystring>}

address <peer-address> netmask <mask>

(host) [mynode] (config) #crypto isakmp policy <priority>

encryption {3DES|AES128|AES192|AES256|DES}

version {v1|v2}

authentication {pre-share|rsa-sig|ecdsa-256|ecdsa-384}}

group {1|2|14|19|20}

hash {md5|sha|sha1-96|sha2-256-128|sha2-384-192}

lifetime <seconds>

To configure site-to-site VPN with a static and dynamically addressed managed device that initiates IKE
Aggressive-mode for Site-Site VPN:
(host) [mynode] (config) #crypto-local ipsec-map <ipsec-map-name> <ipsec-map-number>

src-net <ipaddr> <mask>

dst-net <ipsec-map-dst-net> <ipsec-map-dst-mask>

peer-ip <ipaddr>

local-fqdn <local_id_fqdn>

vlan <ipsec-map-vlan-id>

pre-connect {enable|disable}

trusted enable



For the Pre-shared-key:
(host) [mynode] (config) #crypto-local isakmp {key <keystring>|key-hex <keystring>}

address <peer-address> netmask 255.255.255.255

For a static IP managed device that responds to IKE Aggressive-mode for Site-Site VPN:
(host) [mynode] (config) #crypto-local ipsec-map <ipsec-map-name 2> <ipsec-map-number>

src-net <ipaddr> <mask>

dst-net <ipsec-map-dst-net> <ipsec-map-dst-mask>

peer-ip 0.0.0.0

peer-fqdn fqdn-id <peer_id_fqdn>

vlan <ipsec-map-vlan-id>

trusted enable

For the Pre-shared-key:
(host) [mynode] (config) #crypto-local isakmp {key <keystring>|key-hex <keystring>}

fqdn <ike-id-fqdn>

For a static IP managed device that responds to IKE Aggressive-mode for Site-Site VPN with one PSK for All
FQDNs:

(host) [mynode] (config) #crypto-local ipsec-map <ipsec-map-name 2> <ipsec-map-number>

src-net <ipaddr> <mask>

peer-ip 0.0.0.0

peer-fqdn any-fqdn

vlan <ipsec-map-vlan-id>

trusted enable

For the Pre-shared-key for All FQDNs:

(host) [mynode] (config) #crypto-local isakmp {key <keystring>|key-hex <keystring>}

fqdn-any

Detecting Dead Peers
Dead Peer Detection (DPD) is enabled by default on the controller for site-to-site VPNs. DPD, as described in
RFC 3706, “A Traffic-Based Method of Detecting Dead Internet Key Exchange (IKE) Peers,” uses IPsec traffic
patterns to minimize the number of IKE messages required to determine the liveliness of an IKE peer.

After a dead peer is detected, the managed device tears down the IPsec session. Once the network path or
other failure condition has been corrected, a new IPsec session is automatically re-established.

To configure DPD parameters, issue the following commands through the CLI:
(host) [mynode] (config) #crypto-local isakmp dpd idle-timeout <idle_sec> retry-timeout

<retry_sec> retry-attempts <retry_number>

About Default IKE Policies
ArubaOS includes the following default IKE policies. These policies are predefined, but can be edited and
deleted. You can do this in the CLI by using the crypto isakmp policy and crypto dynamic-map commands,
or the WebUI by navigating to Advanced Services > VPN Services > IPSEC and using the Delete button
next to the default IKE policy or IPsec dynamic map you want to delete.
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Policy
Name

Policy
Number

IKE
Version

Encryption
Algorithm

Hash
Algorithm

Authen-
tication
Method

PRF
Method

Diffie-
Hellman
Group

Default
protection
suite

10001 IKEv1 3DES-168 SHA 160 Pre-
Shared
Key

N/A 2 (1024
bit)

Default RAP
Certificate
protection
suite

10002 IKEv1 AES -256 SHA 160 RSA
Signatur
e

N/A 2 (1024
bit)

Default RAP
PSK
protection
suite

10003 AES -256 SHA 160 Pre-
Shared
Key

N/A 2 (1024
bit)

Default RAP
IKEv2 RSA
protection
suite

1004 IKEv2 AES -256 SSHA160 RSA
Signatur
e

hmac-
sha1

2 (1024
bit)

Default
Cluster PSK
protection
suite

10005 IKEv1 AES -256 SHA160 Pre-
Shared
Key

Pre-
Shared
Key

2 (1024
bit)

Default
IKEv2 RSA
protection
suite

1006 IKEv2 AES - 128 SHA 96 RSA
Signatur
e

hmac-
sha1

2 (1024
bit)

Default
IKEv2 PSK
protection
suite

10007 IKEv2 AES - 128 SHA 96 Pre-
shared
key

hmac-
sha1

2 (1024
bit)

Default
Suite-B
128bit
ECDSA
protection
suite

10008 IKEv2 AES - 128 SHA 256-
128

ECDSA-
256
Signatur
e

hmac-
sha2-
256

Random
ECP
Group
(256 bit)

Table 63: Default IKE Policy Settings



Policy
Name

Policy
Number

IKE
Version

Encryption
Algorithm

Hash
Algorithm

Authen-
tication
Method

PRF
Method

Diffie-
Hellman
Group

Default
Suite-B 256
bit ECDSA
protection
suite

10009 IKEv2 AES -256 SHA 384-
192

ECDSA-
384
Signatur
e

hmac-
sha2-
384

Random
ECP
Group
(384 bit)

Default
Suite-B
128bit
IKEv1
ECDSA
protection
suite

10010 IKEv1 AES-GCM-
128

SHA 256-
128

ECDSA-
256
Signatur
e

hmac-
sha2-
256

Random
ECP
Group
(256 bit)

Default
Suite-B
256-bit
IKEv1
ECDSA
protection
suite

10011 IKEv1 AES-GCM-
256

SHA 256-
128

ECDSA-
256
Signatur
e

hmac-
sha2-
256

Random
ECP
Group
(256 bit)

Working with VPN Dialer
For Windows clients, a dialer can be downloaded from Mobility Master to auto-configure tunnel settings on the
client.

Configuring VPN Dialer

In the CLI
Issue the following commands in the CLI to configure the VPN dialer:
(host) [mynode] (config) #vpn-dialer <name>

enable {dnctclear|l2tp|pptp|secureid_newpinmode|wirednowifi}

ike authentication {pre-share <key>|rsa-sig}

ike encryption {3des|des}

ike group {1|2}

ike hash {md5|sha}

ipsec encryption {esp-3des|esp-des}

ipsec hash {esp-md5-hmac|esp-sha-hmac}

ppp authentication {cache-securid|chap|mschap|mschapv2|pap}

Assigning a Dialer to a User Role
The VPN dialer can be downloaded using Captive Portal. For the user role assigned through Captive Portal,
configure the dialer by using the dialer name.

For example, if the Captive Portal client is assigned to the guest role after logging in, and the dialer is called
mydialer, configuremydialer as the dialer to be used in the guest role.
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In the CLI
To configure the Captive Portal dialer for a user-role via the CLI, access the CLI in config mode and issue the
following commands:
(host) [mynode] (config) #user-role <role>

dialer <name>
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Chapter 20
Roles and Policies

The client in an Aruba user-centric network is associated with a user role, which determines the client’s network
privileges, how often it must re-authenticate, and which bandwidth contracts are applicable. A policy is a set of
rules that applies to traffic that passes through the Aruba Managed device. You specify one or more policies for
a user role. Finally, you can assign a user role to clients before or after they authenticate to the system.

This chapter describes assigning and creating roles and policies using the ArubaOS CLI or WebUI. Roles and
policies can also be configured for WLANs associated with the “default” ap-group via the WLAN Wizard in the
Managed device: Configuration > Tasks > Create a new WLAN. Follow the steps in the workflow pane
within the wizard and refer to the help tab for assistance.

Topics in this chapter include:

l Configuring Firewall Policies on page 363

l User Roles on page 372

l Assigning User Roles on page 374

l Understanding Global Firewall Parameters on page 379

l AppRF 2.0 on page 384

This chapter describes configuring firewall policies and parameters that relate to IPv4 traffic. See IPv6 Support on
page 116 for information about configuring IPv6 firewall policies and parameters.

Configuring Firewall Policies
A firewall policy identifies specific characteristics about a data packet passing through the Aruba Mobility
Master and takes some action based on that identification. In an Aruba Mobility Master, that action can be a
firewall-type action such as permitting or denying the packet, an administrative action such as logging the
packet, or a quality of service (QoS) action such as setting 802.1p bits or placing the packet into a priority
queue. You can apply firewall policies to user roles to give differential treatment to different users on the same
network, or to physical ports to apply the same policy to all traffic through the port.

Firewall policies differ from access control lists (ACLs) in the following ways:

l Firewall policies are stateful, meaning that they recognize flows in a network and keep track of the state of
sessions. For example, if a firewall policy permits telnet traffic from a client, the policy also recognizes that
inbound traffic associated with that session should be allowed.

l Firewall policies are bi-directional, meaning that they keep track of data connections traveling into or out of
the network. ACLs are normally applied to either traffic inbound to an interface or outbound from an
interface.

l Firewall policies are dynamic, meaning that address information in the policy rules can change as the policies
are applied to users. For example, the alias user in a policy automatically applies to the IP address assigned
to a particular user. ACLs typically require static IP addresses in the rule.

You can apply IPv4 and IPv6 firewall policies to the same user role. See IPv6 Support on page 116 for
information about configuring IPv6 firewall policies.
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Working With Access Control Lists (ACLs)
Access control lists (ACLs) are a common way of restricting certain types of traffic on a physical port. ArubaOS
provides the following types of ACLs:

l Standard ACLs permit or deny traffic based on the source IP address of the packet. Standard ACLS can be
either named or numbered, with valid numbers in the range of 1-99 and 1300-1399. Standard ACLs use a
bitwise mask to specify the portion of the source IP address to be matched.

l Extended ACLs permit or deny traffic based on source or destination IP address, source or destination port
number, or IP protocol. Extended ACLs can be named or numbered, with valid numbers in the range 100-
199 and 2000-2699.

l MAC ACLs are used to filter traffic on a specific source MAC address or range of MAC addresses. Optionally,
you can mirror packets to a datapath or remote destination for troubleshooting and debugging purposes.
MAC ACLs can be either named or numbered, with valid numbers in the range of 700-799 and 1200-1299.

l Ethertype ACLs are used to filter based on the Ethertype field in the frame header. Optionally, you can
mirror packets to a datapath or remote destination for troubleshooting and debugging purposes. Ethertype
ACLs can be either named or numbered, with valid numbers in the range of 200-299.These ACLs can be
used to permit IP while blocking other non-IP protocols, such as IPX or AppleTalk.

l Service ACLs provide a generic way to restrict how protocols and services from specific hosts and subnets to
the Mobility Master are used. Rules with this ACL are applied to all traffic on the Mobility Master regardless
of the ingress port or VLAN.

l Routing ACLs forward packets to a device defined by an IPsec map, a next-hop list, a tunnel or a tunnel
group.

ArubaOS provides both standard and extended ACLs for compatibility with router software from popular
vendors, however firewall policies provide equivalent and greater function than standard and extended ACLs
and should be used instead.

You can apply MAC and Ethertype ACLs to a user role, however these ACLs only apply to non-IP traffic from the
user.

Creating a Firewall Policy
This section describes how to configure the rules that constitute a firewall policy. A firewall policy can then be
applied to a user role (until the policy is applied to a user role, it does not have any effect). Table 64 describes
required and optional parameters for a rule.



Field Description

IP version Specifies whether the policy applies to IPv4 or IPv6 traffic.

Source
(required)

Source of the traffic, which can be one of the following:

l any: Acts as a wildcard and applies to any source address.

l user: This refers to traffic from the wireless client.

l host: This refers to traffic from a specific host. When this option is chosen, you
must configure the IP address of the host.

l network: This refers to a traffic that has a source IP from a subnet of IP addresses.
When this option is chosen, you must configure the IP address and network mask
of the subnet.

l alias: This refers to using an alias for a host or network. You configure the alias by
navigating to the Configuration > Roles & Policies > Policies tab. Select a
policy created and click + to create a Rule. Select the Access Control option in the
Rule Type. Select Alias from the Destination drop-down list and the alias name
from the Destination alias drop-down list. Select a Source from the traffic
Source drop-down list.

Destination
(required)

Destination of the traffic, which can be configured in the same manner as Source.

Service/app
(required)

Type of traffic, which can be one of the following:

l any: This option specifies that this rule applies to any type of traffic.

l application: For session and route policies on a 7000 Series managed device, you
can create a rule that applies to a specific application type. Click the Application
drop-down list and select an application type.

l web category/ Reputation: For session policies on a 7000 Series managed
device, you can create a rule that applies to a specific web category or application
type. For more information on web category classification, see Traffic Analysis on
page 712

l tcp: Using this option, you configure a range of TCP port(s) to match for the rule to
be applied.

l udp: Using this option, you configure a range of UDP port(s) to match for the rule
to be applied.

l service: Using this option, you use one of the pre-defined services (common
protocols such as HTTPS, HTTP, and others) as the protocol to match for the rule
to be applied. You can also specify a network service that you configure by
navigating to the Configuration > Roles & Policies > Policies tab. Select a
policy created and click + to create a Rule. Select the Access Control option in the
Rule Type. Select the service type from the Service/app drop-down list.

l (other than TCP/UDP) by configuring the IP protocol value.

Action
(required)

The action that you want the managed device to perform on a packet that matches
the specified criteria. This can be one of the following:

l permit: Permits traffic matching this rule.

l drop: Drops packets matching this rule without any notification.

l reject: Drops the packet and sends an ICMP notification to the traffic source.

Table 64: Firewall Policy Rule Parameters
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Field Description

l src-nat: Performs network address translation (NAT) on packets matching the
rule. When this option is selected, you need to select a NAT pool. Source IP
changes to the outgoing interface IP address (implied NAT pool) or from the pool
configured (manual NAT pool). This action functions in tunnel/decrypt-tunnel
forwarding mode.

l dst-nat: This option redirects traffic to the configured IP address and destination
port. An example of this option is to redirect all HTTP packets to the captive portal
port on the Aruba managed device as used in the pre-defined policy called
“captiveportal”. This action functions in tunnel/decrypt-tunnel forwarding mode.
User should configure the NAT pool in the managed device.

l dual-nat: This option performs both source and destination NAT on packets
matching the rule. Forward packets from source network to destination; re-mark
them with destination IP of the target network. This action functions in
tunnel/decrypt-tunnel forwarding mode. User should configure the NAT pool in
the managed device.

l redirect to tunnel: This option redirects traffic into a GRE tunnel. This option is
used primarily to redirect all guest traffic into a GRE tunnel to a DMZ
router/switch.

l redirect to esi: This option redirects traffic to the specified ESI group. You also
specify the direction of traffic to be redirected: forward, reverse, or both
directions. Select a NAT Pool from the NAT Pool drop-down list to add a NAT-
POOL for ESI policy.

l route: Specify the next hop to which packets are routed, which can be one of the
following:

n Forward Regularly: Packets are forwarded to their next destination without
any changes.

n Forward to ipsec-map: Packets are forwarded through an IPsec tunnel
defined by the specified IPsec map.

n Forward to next-hop-list: packets are forwarded to the highest priority active
device on the selected next hop list. For more information on next-hop lists,
see Uplink Routing using Nexthop Lists on page 223.

n Forward to tunnel: Packets are forwarded through the tunnel with the
specified tunnel ID. For more information on GRE tunnels, see Configuring
GRE Tunnels on page 99.

n Forward to tunnel group: Packets are forwarded through the active tunnel in
a GRE tunnel group. For more information on tunnel groups, see GRE Tunnel
Groups on page 105.

TOS
(optional)

Value of type of service (TOS) bits to be marked in the IP header of a packet matching
this rule when it leaves the managed device.

Time Range You can create an absolute time range with a single fixed start and end date and
time, or create a periodic (recurring) time range that starts and ends at a specified
time on a weekday, weekend, or selected day.

Log (optional) Logs a match to this rule. This is recommended when a rule indicates a security
breach, such as a data packet on a policy that is meant only to be used for voice calls.



Field Description

Mirror
(optional)

Mirrors session packets to datapath or remote destination.

Queue
(optional)

The queue in which a packet matching this rule should be placed.
Select High for higher priority data, such as voice, and Low for lower priority traffic.

Time Range
(optional)

Time range for which this rule is applicable.

To configure time range, navigate to Configuration > Roles & Policies > Roles tab.
Select a role and click + in the Global Rules table. Select a Time range form the Time
range drop-down list.

Pause ARM
Scanning
(optional)

Pause ARM scanning while traffic is present. Note that you must enable “VoIP Aware
Scanning” in the ARM profile for this feature to work.

Black List
(optional)

Automatically blacklists a client that is the source or destination of traffic matching
this rule. This option is recommended for rules that indicate a security breach where
the blacklisting option can be used to prevent access to clients that are attempting to
breach the security.

ACL White
List (optional)

A rule must explicitly permit a traffic session before it is forwarded to the managed
device. The last rule in the white list denies everything else.
Configure white list ACLs on the Configuration > Services> Firewall> ACL White
List accordion.

802.1p
Priority
(optional)

When this this parameter is enabled, the value of 802.1p priority bits are marked in
the frame of a packet matching this rule when it leaves the managed device. 0 is the
lowest priority (background traffic) and 7 is the highest (network control).

The following example creates a policy ‘web-only’ that allows web (HTTP and HTTPS) access.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Policies

tab on the WebUI.

2. Click + to create a new policy.

3. Enter the policy name in the Policy name field.

4. Select a the policy type from the Policy type drop-down list. You can select Ethertype, Extended, MAC,
Route, Session , or Standard.

5. Click Submit.

6. Select policy created and click +.
7. Select Access Control option in the Rule Type field.

8. Click OK.

9. To add a rule that allows HTTP traffic.

a. Under Service/app, select service from the drop-down list.

b. Select svc-http from the Service alias drop-down list.

10.Click Submit.

11.Click + to add a rule that allows HTTPS traffic.

a. Under Service/app, select service from the drop-down list.
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b. Select svc-https from the Service alias drop-down list.

Rules can be re-ordered by using the up and down buttons provided for each rule.

12.Click Submit to apply this configuration. The policy is not created until the configuration is applied.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #ip access-list session web-only

Creating a Network Service Alias
A network service alias defines a TCP, UDP or IP protocol and a list or range of ports supported by that service.
When you create a network service alias, you can use that alias when specifying the network service for
multiple session ACLs.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Policies

tab on the WebUI.

2. Click + to create a new policy.

3. Enter the policy name in the Policy name field.

4. Select a the policy type from the Policy type drop-down list. You can select Ethertype, Extended,MAC,
Route, Session , or Standard.

5. Click Submit.

6. Select the policy created and click +.

7. Select Access Control option in the Rule Type field.

8. Click OK.

9. Select Service from the Service/app drop-down list.

10.Click + in the Service alias drop-down list to add a new service.

a. In the Protocol drop-down, select either TCP or UDP, or select a Protocol and enter the IP protocol
number of the protocol for which you want to create an alias.

b. In the Port Type drop-down, specify whether you want to define the port by a contiguous range of
ports, or by a list of non-contiguous port numbers.

l If you select Range, enter the starting and ending port numbers in the Starting Port and End Port
fields.

l If you select list, enter a comma-separated list of port numbers in the Port list field.

c. To limit the service alias to a specific application, select on the of the following service types from the
Application Level Gateway (ALG) drop-down list:

l ftp: Service is FTP

l tftp: Service is TFTP

l dns: Service is DNS

l dhcp: Service is DHCP

l sip: Service is SIP

l sips: Service is Secure SIP

l svp: Service is SVP



l sccp: Service is SCCP

l rtsp:  Service is RTSP

l vocera: Service is VOCERA

l noe: Service is Alcatel NOE

l h323: Service is H323

l jabber: Service is Jabber

l facetime: Service is Facetime

11.Click Submit to add a new service.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To define a service alias via the command-line interface, issue the following command:
(host) [mynode] (config) #netservice <name> <protocol>|tcp|udp {list <port>,<port>}|{<port>

[<port>]}[ALG <service>]

Creating an ACL White List
The ACL White List consists of rules that explicitly permit or deny session traffic from being forwarded to or
blocked from the managed device. The white list protects the managed device during traffic session processing
by prohibiting traffic from being automatically forwarded to the managed device if it was not specifically
denied in a blacklist. The maximum number of entries allowed in the ACL White List is 256. To create an ACL
white list, you must first define a white list bandwidth contract, and then assign it to an ACL.

Creating a Bandwidth Contract

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > Firewall tab.

2. Click White List BW Contracts accordion.

3. Click + to create a new contract.

4. In the White list contract name field, enter the name of a bandwidth contract.

5. Enter a bandwidth rate value in the Bandwidth rate field.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host)(config) #cp-bandwidth-contract

Configuring the ACL White List

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > Firewall tab.

2. Click Acl White List accordion.

3. Click + to create a new protocol.

4. Select Permit or Deny from the Action drop-down list. Permit allows session traffic to be forwarded to
the managed device while Deny blocks session traffic.

ArubaOS 8.0.0.0 | User Guide Roles and Policies |  369



370 | Roles and Policies ArubaOS 8.0.0.0  | User Guide

5. Select IPv4 or IPv6 filter from the IP Version drop-down list .

6. Select one of the following from the Source drop-down list:

n For a specific IPv4 or IPv6 filter, select addr_mask. Enter the IP address and mask of the IPv4 or IPv6
filter in the corresponding fields.

n For a IPv4 or IPv6 host, select any and enter the source address.

7. In the IP Protocol Number (1-255) or IP Protocol field, enter the number for a protocol or select the
protocol from the drop-down list used by session traffic.

8. In the Starting Ports field, enter a starting port. This is the first port, in the port range, on which permitted
or denied session traffic is running. Port range: 1–65535.

9. In the End Ports field, enter an ending port. This is the last port, in the port range, on which permitted or
denied session traffic is running. Port range: 1–65535.

10.(Optional) Select the name of the bandwidth contract to which the session traffic should be applied, from
the White list Bandwidth Contract drop-down list.

11.For further information on creating Bandwidth Contracts, see Configuring Bandwidth Contracts on page
388

12.Click Submit. The ACL displays on the white list section.

13.To delete an entry, click Delete next to the entry you want to delete.

14.Click Submit.

15.Click Pending Changes.

16.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following CLI command to create ACL White Lists.
(host) (config)firewall cp

Override Local Network Destination
This feature provides a scalable solution to create a local net destination override. To implement this feature, a
new sub-command, host vlan – offset under the netdestination configuration command is introduced. An
example and description are as follows:
netdestination store

host vlan 10 offset 5

host vlan 10 offset 8

With the above, select the subnet (for example, 10.1.1.0/24) assigned to vlan 10 for that store and calculate
offsets 5 (10.1.1.5) and 8 (10.1.1.8) from it.

Configure the override local netdestination in the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Roles

tab on the WebUI.

2. Select a role and click + under Rules For This Role Only to create a rule.

3. Click one of the options in the Rule Type filed to select a rule and click OK.

4. Select the rule created.

5. Select Alias from the Destination drop-down list.

6. Select + from the Destination alias drop-down list.

7. Click + in the Rule table.

8. Select Override from the Rule type drop-down list.

9. Select a VLAN offset number which is the Netmask/range, from the Vlan drop-down list.



10.Click OK.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

Configure the override local netdestination in the CLI
l Configure the local override netdestination

l Show the local override netdestination

l Local override netdestination used at AOS

To configure the local override netdestination:
(host) [mynode] (config) #netdestination store

(host) [mynode] (config-submode) #?

description Brief description about this destination (up to 128 characters in

quote)

host Configure a single IPv4 host

invert Use all destinations EXCEPT this destination

name Configure a single host name or domain, Max 63 characters

network Configure a IPv4 subnet

no Delete Command

range Configure a range of IPv4 addresses

(host) [mynode] (config-submode) #host ?

A.B.C.D IPv4 Address of host

vlan IPv4 Address based on VLAN

(host) [mynode] (config-submode) #host vlan ?

<1-4094> VLAN ID

(host) [mynode] (config-submode) #host vlan 55 ?

offset Offset in the VLAN subnet

(host) [mynode] (config-submode) #host vlan 55 offset ?

<1-254> Offset number in the VLAN subnet

(host) [mynode] (config-submode) #host vlan 55 offset 36

To show the local override netdestination
(host) [mynode] #show netdestination store

Name: store

Position Type IP addr Mask-Len/Range

-------- ---- ------- --------------

1 override vlan 55 offset 36

How to use the local-override netdestination alias in the managed device:
(host) [mynode] (config) #ip access-list session store-override

(host) [mynode] (config-sess-store-override) #any alias store any permit

(host) [mynode] (config-sess-store-override) #alias store any any deny

(host) [mynode] (config-sess-store-override) #!

(host) [mynode] #show ip interface brief

Interface IP Address / IP Netmask Admin Protocol

vlan 1 172.72.10.254 / 255.255.255.0 up up

vlan 55 55.55.55.1 / 255.255.255.0 up up

loopback unassigned / unassigned up up

(host) [mynode] #show acl acl-table | include store-override 81 session 744 2 3

store-override 0

(host) [mynode] #show acl ace-table acl 81

744: any 55.55.55.36 255.255.255.255 0 0-0 0-0 f80001:permit

745: 55.55.55.36 255.255.255.255 any 0 0-0 0-0 f80000:deny

746: any any 0 0-0 0-0 f180000:deny
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User Roles
User roles are comprised of user role settings, firewall policies, and bandwidth contracts. This section describes
the procedure to create a new user role, and associate a firewall policy with that role.

This section describes how to create a new user role.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Roles

tab on the WebUI.

2. Click + to create a new role.

3. Select the role created and click + under Rules for this Role Only table.

4. Click one of the options in the Rule Type filed to select a rule and click OK.

5. Click Submit.

6. Select one of the following options to add a policy to the role:

l To create a new policy for a user role, select the Role and click + under the Policies tab. Select Create a
new policy option and enter the Policy name. Click Apply.

l To associate an existing policy to a user role, select the Role and click + under the Policies tab. Select
Add existing session policy or Add existing routing policy option and select a policy from the
Policy name drop-down list. Click Apply.

For more information on creating a firewall policy, see Configuring Firewall Policies on page 363.

7. (Optional) If the user role contains more than one firewall policy, use the up and down arrows to assign
priorities to each role. The higher the policy on the list, the higher its priority.

8. Click Show Advanced View and enter the configuration values as described in Table 65.

9. Click Submit.
10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

12.Next, you must assign the user role to a AAA profile in the Managed device. After assigning the user role
you, execute the show reference user-role <role> command on the managed device to see the profiles
that reference this role. For more information, see Assigning User Roles on page 374



Field Description

Name Name of the user role.

Re-auth interval
(optional)

Time, in minutes, after which the client is required to reauthenticate. Enter a value
between 0-4096. 0 disables reauthentication.

Default: 0 (disabled)

VLAN (optional) By default, a client is assigned a VLAN on the basis of the ingress VLAN for the client to
the managed device. You can override this assignment and configure the VLAN ID that is
to be assigned to the user role. You configure a VLAN by navigating to the Configuration
> Roles & Policies > Roles tab. Select a Role and click Show Advanced View > More
> Network.

Bandwidth
(optional)

You can assign a bandwidth contract to provide an upper limit to upstream or
downstream bandwidth utilized by clients in this role. You can select the Per User option
to apply the bandwidth contracts on a per-user basis instead of to all clients in the role.

For more information, see Configuring Bandwidth Contracts on page 388.

VPN Dialer
(optional)

This assigns a VPN dialer to a user role. For details about VPN dialer, see Virtual Private
Networks on page 335.

Select a dialer from the drop-down list and assign it to the user role. This dialer will be
available for download when a client logs in using captive portal and is assigned this role.

L2TP Pool (optional) This assigns an L2TP pool to the user role. For more details about L2TP pools, see Virtual
Private Networks on page 335.

Select the required L2TP pool from the list to assign to the user role. The inner IP
addresses of VPN tunnels using L2TP will be assigned from this pool of IP addresses for
clients in this user role.

PPTP Pool (optional) This assigns a PPTP pool to the user role. For more details about PPTP pools, see Virtual
Private Networks on page 335.

Select the required PPTP pool from the list to assign to the user role. The inner IP
addresses of VPN tunnels using PPTP will be assigned from this pool of IP addresses for
clients in this user role.

Captive Portal
Profile (optional)

This assigns a Captive Portal profile to this role. For more details about Captive Portal
profiles, see Captive Portal Authentication on page 286.

Captive Portal Check
for Accounting

This setting is enabled by default. If disabled, RADIUS accounting is done for an authen-
ticated users irrespective of the captive-portal profile in the role of an authenticated user.
If enabled, accounting is not done as long as the user's role has a captive portal profile on
it. Accounting will start when Auth/XML-Add/CoA changes the role of an authenticated user
to a role which doesn't have captive portal profile.

Max Sessions This parameter configures the maximum number of sessions per user in this role. If the
sessions reach the maximum value, any additional sessions from this user that are
reaching the threshold are blocked till the session usage count for the user falls back
below the configured limit.

The default is 65535. You can configure any value between 0-65535.

Table 65: User Role Parameters
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To a delete a user role in the WebUI:

1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Roles
tab on the WebUI.

2. Select the Role and click the Delete icon.

You cannot delete a user-role that is referenced to profile or server derived role. Deleting a server referenced role
will result in an error. Remove all references to the role and then perform the delete operation.

In the CLI
The commands to associate an access control list (ACL) to a user role vary, depending upon the type of access
control list being associated to that role. User roles are applied globally across all managed devices, so
ethertype, MAC and session ACLs can be applied to global user roles. However, routing access lists may vary
between locations, so they are mapped to a user role in a local configuration setting.

To associate the user role with an ethertype, MAC or session ACL, use the command user-role <role> access-
list eth|mac|session <acl>. To associate a user role with a routing ACL, use the routing-policy-map
command.

Assigning User Roles
A client is assigned a user role by one of several methods. A role assigned by one method may take precedence
over one assigned by a different method. The methods of assigning user roles are, from lowest to highest
precedence:

1. The initial user role or VLAN for unauthenticated clients is configured in the AAA profile for a virtual AP (see
Access Points on page 489).

2. The user role can be derived from user attributes upon the client’s association with an AP (this is known as a
user-derived role). You can configure rules that assign a user role to clients that match a certain set of
criteria. For example, you can configure a rule to assign the role VoIP-Phone to any client that has a MAC
address that starts with bytes xx:yy:zz.User-derivation rules are executed before client authentication.

3. The user role can be the default user role configured for an authentication method, such as 802.1X or VPN.
For each authentication method, you can configure a default role for clients who are successfully
authenticated using that method.

4. The user role can be derived from attributes returned by the authentication server and certain client
attributes (this is known as a server-derived role). If the client is authenticated via an authentication server,
the user role for the client can be based on one or more attributes returned by the server during
authentication, or on client attributes such as SSID (even if the attribute is not returned by the server).
Server-derivation rules are executed after client authentication.

5. The user role can be derived from Aruba Vendor-Specific Attributes (VSA) for RADIUS server authentication.
A role derived from an Aruba VSA takes precedence over any other user roles.

The following sections describe the methods of assigning user roles.

Assigning User Roles in AAA Profiles
An AAA profile defines the user role for unauthenticated clients (initial role) as well as the default user role for
MAC and 802.1X authentication. For additional information on creating AAA profiles, see WLAN Authentication
on page 431.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Managed Network.



2. Navigate to the Configuration > Authentication > AAA Profiles tab.

3. Select the default profile or a user-defined AAA profile.

4. Select the desired user role for unauthenticated users, from the Initial Role drop-down list.

5. Select the desired user role for users who have completed 802.1X authentication, from the 802.1X
Authentication Default Role drop-down list.

6. Select the desired user role for clients who have completed MAC authentication, from the MAC
Authentication Default Role drop-down list.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa profile <profile-name>

Working with User-Derived VLANs
Attributes derived from the client’s association with an AP can be used to assign the client to a specific role or
VLAN, as user-derivation rules are executed before the client is authenticated.

You configure the user role or VLAN to be assigned to the client by specifying condition rules; when a condition
is met, the specified user role or VLAN is assigned to the client. You can specify more than one condition rule;
the order of rules is important as the first matching condition is applied. You can optionally add a description
of the user rule.

Table 66 describes the conditions for which you can specify a user role or VLAN.

Rule Type Condition Value

BSSID: Assign client to a role or VLAN
based upon the BSSID of AP to which
client is associating.

One of the following:

l contains

l ends with

l equals

l does not equal

l starts with

MAC address (xx:xx:xx:xx:xx:xx)

DHCP-Option: Assign client to a role or
VLAN based upon the DHCP signature ID.

One of the following:

l equals

l starts with

DHCP signature ID.

NOTE: This string is not case
sensitive.

DHCP-Option-77: Assign client to a role or
VLAN based upon the user class identifier
returned by DHCP server.

equals string

Encryption: Assign client to a role or VLAN
based upon the encryption type used by
the client.

One of the following:

l equals

l does not equal

l Open System (no encryption)

l WPA/WPA2 AES (static or
dynamic)

l WPA/WPA2-TKIP (static or

Table 66: Conditions for a User-Derived Role or VLAN
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Rule Type Condition Value

dynamic)

l WEP (static or dynamic)

l xSec

ESSID: Assign client to a role or VLAN
based upon the ESSID to which the client
is associated.

One of the following:

l contains

l ends with

l equals

l does not equal

l starts with

l value of (does
not take string;
attribute value is
used as role)

string

Location: Assign client to a role or VLAN
based upon the ESSID to which the client
is associated.

One of the following:

l equals

l does not equal

string

MAC address of the client One of the following:

l contains

l ends with

l equals

l does not equal

l starts with

MAC address (xx:xx:xx:xx:xx:xx)

Understanding Device Identification
The device identification feature allows you to assign a user role or VLAN to a specific device type by identifying
a DHCP option and signature for that device. If you create a user rule with the DHCP-Option rule type, the first
two characters in the Value field must represent the hexadecimal value of the DHCP option that this rule
should match, while the rest of the characters in the Value field indicate the DHCP signature the rule should
match. To create a rule that matches DHCP option 12 (host name), the first two characters in the Value field
must be the hexadecimal value of 12, which is 0C. To create a rule that matches DHCP option 55, the first two
characters in the Value field must be the hexadecimal value of 55, which is 37.

The following table describes some of the DHCP options that are useful for assigning a user role or VLAN.



DHCP Option Description Hexadecimal Equivalent

12 Host name 0C

55 Parameter Request List 37

60 Vendor Class Identifier 3C

81 Client FQDN 51

DHCP Option values

The device identification features in ArubaOS can also automatically identify different client device types and
operating systems by parsing the User-Agent strings in the client’s HTTP packets. To enable this feature, select
the Device Type Classification option in the AP’s AAA profile. For details, see WLAN Authentication on page
431.

Configuring a User-derived VLAN in the WebUI
1. In the Mobility Master node hierarchy, navigate to the Managed Network.

2. Navigate to the Configuration > Authentication > User Rules tab.

3. Click + to add a new set of derivation rules. Enter a name for the set of rules, and click Apply. The name
appears in the User Rules Summary list.

4. In the User Rules Summary list, select the name of the rule set to configure rules.

5. Click + to add a rule. Select VLAN from the Set Type drop-down list. (You can select VLAN to create
derivation rules for setting the VLAN assigned to a client.)

6. Configure the condition for the rule by setting the Rule Type, Condition, Value parameters and optional
description of the rule. See Table 66 for descriptions of these parameters.

7. Select the role assigned to the client when this condition is met.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

11.You can configure additional rules for this rule set. When you have added rules to the set, use the up or
down arrows in the Actions column to modify the order of the rules. (The first matching rule is applied.)

12.(Optional) If the rule uses the DHCP-Option condition, best practices is to enable the Enforce DHCP
parameter in the AP group’s AAA profile, which requires users to complete a DHCP exchange to obtain an IP
address. For details on configuring this parameter in an AAA profile, see WLAN Authentication on page 431.

Configuring a User-derived Role or VLAN in the CLI
(host) [mynode] (config) #aaa derivation-rules user <name>

RADIUS Override of User-Derived Roles
This feature introduces a new RADIUS vendor specific attribute (VSA) named “Aruba-No-DHCP-Fingerprint,”
value 14. This attribute signals the RADIUS Client (managed device) to ignore the DHCP Fingerprint user role
and VLAN change post L2 authentication. This feature applies to both CAP and RAP in tunnel mode and for the
L2 authenticated role only.
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Configuring a Default Role for Authentication Method
For each authentication method, you can configure a default role for clients who are successfully authenticated
using that method. To configure a default role for an authentication method:

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Managed Network.

2. Navigate to the Configuration > Authentication > AAA Profiles tab.

3. To configure the default user role for MAC or 802.1X authentication, select the AAA Profiles tab. Select the
AAA profile. Enter the user role for MAC Authentication Default Role or 802.1X Authentication
Default Role.

4. To configure the default user role for other authentication methods, select the L2 Authentication or L3
Authentication tab. Select the authentication type (Stateful 802.1X or stateful NTLM for L2
Authentication, Captive Portal or VPN for L3 Authentication), and then select the profile. Enter the user role
for Default Role.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

For additional information on configuring captive portal authentication, see Captive Portal Authentication on
page 286.

In the CLI
To configure the default user role for MAC or 802.1X authentication:
(host) [mynode] (config) #aaa profile <profile>

To configure the default user role for other authentication methods:
(host) [mynode] (config) #aaa authentication captive-portal|stateful-dot1x|stateful-ntlm|vpn

Configuring a Server-Derived Role
If the client is authenticated through an authentication server, the user role for the client can be based on one
or more attributes returned by the server during authentication. You configure the user role to be derived by
specifying condition rules; when a condition is met, the specified user role is assigned to the client. You can
specify more than one condition rule; the order of rules is important as the first matching condition is applied.
You can also define server rules based on client attributes such as ESSID, BSSID, or MAC address, even though
these attributes are not returned by the server.

For information about configuring a server-derived role, see Configuring Server-Derivation Rules on page 190.

Configuring a VSA-Derived Role
Many Network Address Server (NAS) vendors, including Aruba, use VSAs to provide features not supported in
standard RADIUS attributes. For Aruba systems, VSAs can be employed to provide the user role and VLAN for
RADIUS-authenticated clients, however the VSAs must be present on your RADIUS server. This involves
defining the vendor (Aruba) and/or the vendor-specific code (14823), vendor-assigned attribute number,
attribute format (such as string or integer), and attribute value in the RADIUS dictionary file. VSAs supported
on managed devices conform to the format recommended in RFC 2865, “Remote Authentication Dial In User
Service (RADIUS)”.

For more information on Aruba VSAs, see RADIUS Server VSAs on page 179. Dictionary files that contain Aruba
VSAs are available on the Aruba support website for various RADIUS servers. Log into the Aruba support
website to download a dictionary file from the Tools folder.



Understanding Global Firewall Parameters
Table 67 describes optional firewall parameters you can set on the managed devices for IPv4 traffic. To set
these options in the WebUI, in the Mobility Master node hierarchy, navigate to the Configuration >
Services > Firewall > Global Settings accordion and select or enter values in the IPv4 column. To set these
options in the CLI, use the firewall configuration commands.

See IPv6 Support on page 116 for information about configuring firewall parameters for IPv6 traffic.

Parameter Description

Monitor Ping Attack (per 30
seconds)

Number of ICMP pings per 30 second, which if exceeded, can indicate a
denial of service attack. Valid range is 1-16384 pings per 30 seconds.

Recommended value is 120 seconds.

Default: No default

Monitor TCP SYN Attack rate
(per 30 seconds)

Number of TCP SYN messages per 30 second, which if exceeded, can
indicate a denial of service attack. Valid range is 1-16384 pings per 30
seconds.

Recommended value is 960 seconds.

Default: No default

Monitor IP Session Attack (per
30 seconds)

Number of TCP or UDP connection requests per 30 second, which if
exceeded, can indicate a denial of service attack. Valid range is 1-16384
requests per 30 seconds.

Recommended value is 960 seconds.

Default: No default

Monitor/Police ARP Attack (non
Gratuitous ARP) rate (per 30
seconds)

Number of ARP packets (other than Gratuitous ARP packets) per 30
seconds, which if exceeded, can indicate a denial of service attack. Valid
range is 1-16384 packets per 30 seconds.

Recommended value is 960 packets.

Default: No default

NOTE: Blacklisting of wired clients is not supported.

Monitor/Police CP Attack rate
(per 30 seconds)

Rate of misbehaving user’s traffic, which if exceeded, can indicate a
denial or service attack.

Recommended value is 3000 frames per 30 seconds.

Default: No default

Monitor/Police Gratuitous ARP
Attack rate (per 30 seconds)

Number of Gratuitous ARP packets per 30 seconds, which if exceeded,
can indicate denial of service attack. Valid range is 1-16384 packets per
30 seconds.

Recommended value is 50 packets.

Default: 50 packets

NOTE: Blacklisting of wired clients is not supported.

Table 67: IPv4 Firewall Parameters
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Parameter Description

Deny Inter User Bridging Prevents the forwarding of Layer-2 traffic between wired or wireless
users. You can configure user role policies that prevent Layer-3 traffic
between users or networks but this does not block Layer-2 traffic. This
option can be used to prevent traffic, such as Appletalk or IPX, from
being forwarded.

Default: Disabled

Deny Inter User Traffic Denies traffic between untrusted users by disallowing layer-2 and
layer-3 traffic. This parameter does not depend on the deny-inter-user-
bridging parameter being enabled or disabled.

Default: Disabled

Deny Source Routing Permits the firewall to reject and log packets with the specified IP
options loose source routing, strict source routing, and record route.
Note that network packets where the IPv6 source or destination
address of the network packet is defined as an “link-local address
(fe80::/64) are permitted.

Default: Disabled

Deny All IP Fragments Drops all IP fragments.

NOTE: Do not enable this option unless instructed to do so by an Aruba
representative.

Default: Disabled

Enforce TCP Handshake
Before Allowing Data

Prevents data from passing between two clients until the three-way TCP
handshake has been performed. This option should be disabled when
you have mobile clients on the network as enabling this option will
cause mobility to fail. You can enable this option if there are no mobile
clients on the network.

Default: Disabled

Prohibit IP Spoofing Enables detection of IP spoofing (where an intruder sends messages
using the IP address of a trusted client). When this option is enabled,
source and destination IP and MAC addresses are checked for each
ARP request/response. Traffic from a second MAC address using a
specific IP address is denied, and the entry is not added to the user
table. Possible IP spoofing attacks are logged and an SNMP trap is sent.

Default: Enabled

Prohibit RST Replay Attack When enabled, closes a TCP connection in both directions if a TCP RST
is received from either direction. You should not enable this option
unless instructed to do so by an Aruba representative.

Default: Disabled

Log ICMP Errors Enables logging of received ICMP errors. You should not enable this
option unless instructed to do so by an Aruba representative.

Default: Disabled



Parameter Description

Stateful SIP Processing Disables monitoring of exchanges between a voice over IP or voice over
WLAN device and a SIP server. This option should be enabled only when
there is no VoIP or VoWLAN traffic on the network.

Default: Disabled (stateful SIP processing is enabled)

Allow Tri-session with DNAT Allows three-way session when performing destination NAT. This option
should be enabled when the managed device is not the default gateway
for wireless clients and the default gateway is behind the managed
device. This option is typically used for captive portal configuration.

Default: Disabled.

AMSDU Configuration Enables handling AMSDU traffic from clients.

Default: Disabled

Session Mirror Destination Destination (IP address or port) to which mirrored session packets are
sent. This option is used only for troubleshooting or debugging.

Packets can be mirrored in multiple ACLs, so only a single copy is
mirrored if there is a match within more than one ACL.

You can configure the following:

l Ethertype to be mirrored with the Ethertype ACL mirror option.

l IP flows to be mirrored with the session ACL mirror option.

l MAC flows to be mirrored with the MAC ACL mirror option.

l If you configure both an IP address and a port to receive mirrored
packets, the IP address takes precedence.

Default: N/A

Session Idle Timeout (sec) Set the time, in seconds, that a non-TCP session can be idle before it is
removed from the session table. Specify a value in the range 16-259
seconds. You should not set this option unless instructed to do so by an
Aruba representative.

Default: 15 seconds

Disable FTP Server Disables the FTP server on the managed device. Enabling this option
prevents FTP transfers. You should not enable this option unless
instructed to do so by an Aruba representative.

Default: Disabled (FTP server is enabled)

GRE Call ID Processing Creates a unique state for each PPTP tunnel. You should not enable this
option unless instructed to do so by an Aruba representative.

Default: Disabled

Per-packet Logging Enables logging of every packet if logging is enabled for the
corresponding session rule. Normally, one event is logged per session.
If you enable this option, each packet in the session is logged. You
should not enable this option unless instructed to do so by an Aruba
representative, as doing so may create unnecessary overhead on the
managed device.
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Parameter Description

Default: Disabled (per-session logging is performed)

Broadcast-filter ARP Reduces the number of broadcast packets sent to VoIP clients, thereby
improving the battery life of voice handsets. You can enable this option
for voice handsets in conjunction with increasing the DTIM interval on

clients.

Default: Disabled

Prohibit ARP Spoofing Detects and prohibits ARP spoofing. When this option is enabled,
possible arp spoofing attacks are logged and an SNMP trap is sent.

Default: Disabled

Prevent DHCP exhaustion Enable check for DHCP client hardware address against the packet
source MAC address. This command checks the frame's source-MAC
against the DHCPv4 client hardware address and drops the packet if it
does not match. Enabling this feature prevents a client from submitting
multiple DHCP requests with different hardware addresses, thereby
preventing DHCP pool depletion.

Default: Disabled

Session VOIP Timeout (sec) Sets the idle session timeout for sessions that are marked as voice
sessions. If no voice packet exchange occurs over a voice session for
the specified time, the voice session is removed. Range is 16 – 300
seconds.

Default: 300 seconds

Stateful H.323 Processing Disables stateful H.323 processing.

Default: Enabled

Stateful SCCP Processing Disables stateful SCCP processing.

Default: Disabled

Only allow local subnets in user
table

Adds only IP addresses, which belong to a local subnet, to the user-
table.

Default: Disabled

Session mirror IPSEC Configures session mirroring of all frames that are processed by IPsec.
Frames are sent to IP address specified by the session-mirror-
destination option.

NOTE: Use this option for debugging or troubleshooting only.

Default: Disabled

Session-tunnel FIB Enable session-tunnel based forwarding.

NOTE: Best practices is to enable this parameter only during
maintenance window or off-peak production hours.



Parameter Description

Multicast automatic shaping Enables multicast optimization and provides excellent streaming quality
regardless of the amount of VLANs or IP IGMP groups that are used.

Default: Disabled

Stateful VOCERA Processing Disables stateful VOCERA processing.

Default: Disabled

Stateful UA Processing Disables stateful UA processing.

Default: Disabled

Enforce bw contracts for
broadcast traffic

Applies bw contracts to local subnet broadcast traffic.

Enforce TCP Sequence
numbers

Enforces the TCP sequence numbers for all packets.

Default: Disabled

Enforce WMM Voice Priority
Matches Flow Content

If traffic to or from the user is inconsistent with the associated QoS
policy for voice, the traffic is reclassified to best effort and data path
counters incremented.

Default: Disabled

Rate limit CP untrusted ucast
traffic (pps)

Specifies the untrusted unicast traffic rate limit. Range is 1-65535
packets per seconds (pps).

Default: 9765 pps

Rate limit CP untrusted mcast
traffic (pps)

Specifies the untrusted multicast traffic rate limit. Range is 1-65535
packets per seconds (pps).

Default: 1953 pps

Rate limit CP trusted ucast
traffic (pps)

Specifies the trusted unicast traffic rate limit. Range is 1-65535 packets
per seconds (pps).

Default: 65535 pps

Rate limit CP trusted mcast
traffic (pps)

Specifies the trusted multicast traffic rate limit. Range is 1-65535
packets per seconds (pps).

Default: 1953 pps
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Parameter Description

Rate limit CP route traffic (pps) Specifies the traffic rate limit that needs ARP requests. Range is 1-
65535 packets per seconds (pps).

Default: 976 pps

Rate limit CP session mirror
traffic (pps)

Specifies the session mirrored traffic forwarded to the managed
device. Range is 1-65535 packets per seconds (pps).

Default: 976 pps

Rate limit CP auth process
traffic (pps)

Specifies the traffic rate limit that is forwarded to the authentication
process. Range is Range is 1-65535 packets per seconds (pps).

Default: 976 pps

Working in the Presence of Web Proxy
When the Mobility Master needs to access data on the cloud or the internet, and if the internet bound traffic
needs to pass through a proxy, execute the web-proxy server command. Once the command is executed the
Mobility Master routes web (HTTP/HTTPS) traffic through the proxy server.

In the CLI
Execute the following command in the CLI to route web traffic through the proxy server:
(host) [mynode] (config) #web-proxy server arubaproxy.com port 8080

(host) [mynode] (config) #show web-proxy

Server: arubaproxy.com

port: 8080

Support for Desktop Virtualization Protocols
ArubaOS supports desktop virtualization protocols by providing preconfigured ACLs for Citrix and VMware
clients. You can apply these ACLs to the user-role when using the Virtual Desktop Infrastructure (VDI) clients.
This ensures that any enterprise application that uses the VDI client performs optimally with appropriate QoS.

Disable the voice aware ARM when applying the ACLs for the VDI clients as the virtual desktop sessions may prevent
the ARM scanning.

AppRF 2.0
The AppRF 2.0 feature improves application visibility and control by allowing you to configure access control
list (ACL) and bandwidth-control applications and application categories. AppRF 2.0 supports a Deep Packet
Inspection (DPI) engine for application detection for over a thousand applications. All wired and wireless traffic
that traverses the managed device can now be categorized and controlled by application and application
category.

AppRF 2.0 provides the ability to:

l permit or deny an application or application category for a specific role. For example, you can block
bandwidth monopolizing applications on a guest role within an enterprise.

l rate limit an application or application category, such as video streaming applications, globally or for a
specific role.



l mark different L2/L3 Quality of Service (QoS) for an application or application category for a user role. For
example, you can mark video and voice sessions that originate from wireless users with different priorities
so that traffic is prioritized accordingly in your network.

l support for upgrading application signatures.

l define custom applications and custom application categories

To configure AppRF 2.0, see the following topics:

l Enabling Deep Packet Inspection (DPI) on page 385

l Configuring Policies for AppRF 2.0 on page 385

l Configuring Bandwidth Contracts on page 388

l Upgrading Application Signatures on page 389

l Defining Custom Application on page 390

Enabling Deep Packet Inspection (DPI)
For application and application category specific configuration to take affect, you must first enable DPI.

You must reboot (reload) the managed device after you enable or disable DPI for global classification to take effect.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Services > Firewall tab.

2. Click Global Settings accordion.

3. Select Enabled from the Enable Deep Packet Inspection drop-down list. To disable DPI, select Disabled
from the drop-down list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

7. Reload the Mobility Master.

In the CLI
To enable global DPI:
(host) [mynode](config) #firewall dpi

(host) [mynode] #reload

To display the application ID, application name, and the ACL/ACE index information for a given session:
(host) [mynode] #show datapath session dpi

Configuring Policies for AppRF 2.0
Access control lists now contain new application and application category options that let you permit or deny
an application or application category on a given role. See the Dashboard Monitoring Traffic Analysis topic for
details about configuring policies from the Dashboard.

How ACL Works with AppRF
A session entry proceeds through two phases: the application detection phase (phase 1) and the post-
application detection phase (phase 2). A session ACL is applied in phase1 and in phase 2.

In phase1, if the session ACL lookup results in an L3/L4 ACE entry request, the traffic pertaining to the session
is guided by this L3/L4 ACE entry. However, if the session ACL lookup results in an application/application
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category specific ACE entry, the enforcement is postponed until phase 2. Once the application is determined,
the session ACL is re-applied with "application/application category" information to determine the final action
on the traffic.

Global Session ACL
The Global Session ACL is used to configure ACL rules that span across or are common to all roles. They are
applied to all roles. The global-sacl rules take precedence over any other ACLs that may be in the user role.

The global-sacl session ACL by default, is in position one for every user role configured on the managed device.
The global-sacl session ACL has the following properties:

l It cannot be deleted.

l It always remains at position one in every role and its position cannot be modified.

l It contains only application rules.

l It can be modified in the WebUI, CLI, and dashboard on a Mobility Master.

l Any modifications to it results in the regeneration of ACE’s of all roles.

Role Default Session ACL
You can configure role-specific application configuration using the WebUI and dashboard. For example, you
can deny the facebook application on the guest role using the CLI or dashboard without having to change the
firewall configuration. This per-user role configuration from WebUI or Dashboard is placed in the Role Default
Session ACL.

A new role session ACL named apprf-“role-name”-sacl has been added. This session, by default, is in position
two for every user role configured on the managed device.

The string "apprf" is added to the beginning and "sacl" to the end of a role’s name to form a managed device
unique name for role default session ACL. This session ACL is in position two of the given user role after the
global session ACL and takes the next higher priority after global policy rules.

The predefined role session ACL has the following properties:

l It cannot be deleted through the WebUI or CLI. It it is only deleted automatically when the corresponding
role is deleted.

l It always remains at position 2 in every role and its position cannot be modified.

l It contains only application rules.

l It can be modified using the WebUI, CLI, or dashboard on a Mobility Master, however any modification
results in the regeneration of ACE’s for that role.

l It cannot be applied to any other role.

Each application has an implicit set of ports that are used for communication. In phase 1, if an application ACE
entry is hit, the traffic matching this application’s implicit port is allowed (as governed by the application ACE).
The DPI engine can monitor the exchange on these ports and determine the application. Once the application
is determined, phase 2 occurs when an evaluation is done to determine the final outcome for the session.

Example
This example shows a DPI rule along with a L3/L4 rule with forwarding action in the same ACL. Both
ACL policies can be applied to a single user role.

ACL Policy "AppRules", Policy Type: Session

l Rule 1

n source: any

n destination: any



n service/application: application facebook

n action: permit

n TOS value: 45

l Rule 2:

n source: any

n destination: any

n service/application: application YouTube

n action: deny

l Rule 3:

n source: any

n destination: any

n service/application: application category peer-to-peer

n action: deny

l Rule 4:

n source: any

n destination: any

n service/application: TCP 23

n action: permit

l Rule 5:

n source: network 40.1.0.0/16

n destination: any

n service/application: TCP 80

n action: permit

n TOS: 60

l Rule 6:

n source: network 20.1.0.0/16

n destination: any

n service/application: TCP 80

n action: source-nat

ACL Policy "NetRules", Policy Type: Session

l Rule 1

n source: network 80.0.0.0/24

n destination: any

n service/application: TCP 80

n action: deny

l Rule 2:

n source: network 60.0.0.0/24

n destination: any

n service/application: TCP 80

n action: dual-nat <nat_pool>

l Rule 3:

n source: network 10.0.0.0/24
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n destination: any

n service/application: TCP 80

n action: destination nat

In the WebUI

1. In the Managed Networks node hierarchy, navigate to the Configuration > Roles & Policies > Policies
tab on the WebUI.

2. Click + to create a new policy.

3. Select the policy created and click +.

4. Select Access Control option in the Rule Type field.

5. Click OK.

6. Select IPv4 or IPv6 from the IP version drop-down list.

7. Select Service from the Service drop-down list and an alias from the Service alias drop-down list.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To configure the ACL application-specific parameters using the command-line interface, access the command-
line interface in config mode, run the following commands:
(host)[mynode](config)#ip access-list

Configuring Bandwidth Contracts
Bandwidth contract configuration lets you configure bandwidth contracts for both the global or application-
specific levels.

Global Bandwidth Contract Configuration
To configure bandwidth contracts to limit application and application categories on an application or global
level, or to show global bandwidth contract configuration output, access the command-line interface and use
the commands dpi global-bandwidth-contract and show dpi global-bandwidth-contract.
[host] [mynode](config) #dpi global-bandwidth-contract[app|appcategory]

[host] [mynode] #show dpi global-bandwidth-contract

Role-Specific Bandwidth Contracts
Application-specific bandwidth contracts (unlike "generic" bandwidth-contracts) allow you to control or reserve
rates for specific applications only on a per-role basis. An optional exclude list is provided that allows you to
exclude applications or application categories on which a generic user/role bandwidth-contract is not applied.

Using an Exclude List

Use an exclude to give specific enterprise mission-critical applications priority over other user traffic. An
enterprise may have well known applications such as Microsoft Exchange, SAP, Oracle, accounting and finance
applications, and other enterprise resource planning (ERP) or customer relationship management (CRM)
applications.

Instead of enumerating bandwidth limits for each application individually on a per-user/per-role basis, you can
configure a single bandwidth contract on a per-user/per-role to limit all non-mission critical applications. You
can then exclude all mission-critical applications by placing them in an exclude list. This way all mission-critical
applications will not be rate-limited. Important points regarding bandwidth contracts include:



l Application bandwidth contracts are per-role by default.

l When an application bandwidth-contract is configured for both a category and an application within the
category, always apply the most specific bandwidth contract.

In the WebUI

1. In the Managed Networks node hierarchy, navigate to Configuration > Roles & Policies> Roles tab.

2. Click + to create a new user role or select a role from the Roles table to modify an existing role.

3. Click Show Advanced View.

4. Select the Bandwidth tab.

5. Click Pre-Application Limit Exceptions for This Role accordion to exclude an application or application
category.

6. Click the + button below the Exceptions section, select an item from the Name drop-down list and click
Apply.

7. Click + under Pre-Application Limits for This Role accordion to add an application or application
category to a bandwidth contract,

8. Select the application type from the Type drop-down list.

9. Enter the name of the new bandwidth contract, the bandwidth in kpbs or mbps, and if downstream is
enforced.

10.Select an option from the Downstream drop-down list and Per Role, Per User, or Per AP Group from the
adjacent drop-down list.

11.Click Show Advanced View to configure additional parameters.

Make sure that the Enable Deep Packet Inspection option is checked.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To configure the bandwidth application-specific parameters using the CLI, access the command-line interface in
config mode, and issue the following commands:
(host) [mynode] (config)# user-role <string>

(host) [mynode](config-role)# bw-contract exclude

Upgrading Application Signatures
Qosmos provides an upgraded app set library to Aruba. This is integrated in to the ArubaOS image. This is
provided to the user as a Aruba..-certified protobundle file. The user can copy this file to Mobility Master flash
and activate the protobundle file using the command dpi proto-bundle activate <filename>

The protobundle file activation is available only from CLI.

This ensures that managed device is able to recognize the latest app set dynamically.

The protobundle file activation must be done under managed device.

In a typical Mobility Master deployment, if the managed device is running a higher version of the protobundle ,
then upgrade with a lower version will not take effect.
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Protocol Database Image Upgrade
The procedure for protocol database image upgrade is as follows:

1. Qosmos DPI IxEngine provides a new protocol library to Aruba.

2. Aruba uses this to create a Aruba-certified protobundle file, which is provided to the user.

3. User copies this to the Mobility Masterflash.

4. Under the managed device, activate the protobundle file using the dpi proto-bundle activate
<filename> command.

Defining Custom Application
A custom application can be created on the fly. Creating custom applications is supported on the managed
device This facilitates the user to apply roles and policies, and BW contracts to the custom applications. Custom
applications can be associated with custom application categories.

A maximum of 64 custom applications can be created. In each custom application, a maximum of 16 rules can
be applied. A custom application can be deleted only after deleting all the rules applied on it

In the WebUI
To create a custom application, perform the following steps:

1. In the Managed Network node hierarchy, navigate to the Configuration > Roles & Policies >
Applications tab.

2. Click the Custom Application accordion.

3. Click + to create a custom application.

4. For Name, enter the name for the custom application.

5. For Application ID, enter a number between 1 and 64.

6. Select a Category from the drop-down list, if required.

To create a new custom category, see ....

7. For Server name, click +. In the Add Server window:

a. Enter the Server name.

b. Enter the URI.
c. Click OK.

8. For Referer name, click +. In the Add Referer window:

a. Enter the Referer name.

b. Click OK.

9. For Common name, click +. In the Add Common Server window:

a. Enter the Common name.

b. Click OK.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
The following commands are used to create a new custom application on the Mobility Master and pushed to
the managed device:

l http host/server name based application
(mynode) (config)dpi custom-app <appname> <appID>



(mynode) (config-submode)#http <hostname>

l http referrer based application
(mynode) (config)dpi custom-app <appname> <appID>

(mynode) (config-submode)#http referer-param <referer>

Ensure to only enter the domain name of the application for <referer>.

l http server name and uri based application
(mynode) (config)dpi custom-app <appname> <appID>

(mynode) (config-submode)#http <hostname-param> <hostname> uri-param <uri>

l https common name based application
(mynode) (config)dpi custom-app <appname> <appID>

(mynode) (config-submode)#https common-name <common-name>

Enter the common name of the server certificate of the application. <app id> is a number between 1 and 64.

Debugging
The following show commands are introduced as part of the custom application feature:

l Issue the following commands on the Mobility Master:

n show dpi custom-app all: Displays output of custom applications

n show dpi custom-app <appname>: Displays the rules of custom applications.

l Issue the following commands on the managed device:

n show dpi custom-app all : Displays output of custom applications.

n show dpi custom-app <appname>: Displays the rules of custom applications.

n show dpi application custom-app all: Displays the custom application port information and DPI
application id of all the custom applications.

n show dpi application custom-app <appname>: Displays the custom application port information
and DPI application ID of a particular custom application .

Defining Custom Application Category
Creating user-defined custom application categories is supported on the Mobility Master. This will enable to
customers to apply a policy for this category so that multiple custom applications associated with this category
can receive the same policy.

A maximum of 32 custom application categories can be created.

Standard applications cannot be associated with custom application categories. Only custom applications can be
associated with custom application categories. By default, custom applications fall under web category.

In the WebUI
To create a custom application category, perform the following steps:

1. In the Managed Network node hierarchy, navigate to the Configuration > Roles & Policies >
Applications tab.

2. Click the Custom Application accordion.

3. Click + to create a custom application.
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You may leave .all the fields for creating a custom application blank because you are intending to create a new
custom application category.

4. In Category, click +.

5. In the Application Categories window, click + to create a custom application category.

6. In the Application Categories > New Category table:

a. For Name, enter the name for the custom application category.

b. For Application ID, enter a number between 1 and 32.

c. (Optional) For Application, select the check box next to the list of custom applications to associate with
the category. Multiple custom applications can also be selected.

The Application list with check box appears only if custom application are already created.

d. Click Submit.

The new custom category is now available in the Category drop-down list.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

To associate a custom application with a custom application category:

In the CLI
Define the application category using the following command:
(mynode) (config) #dpi appcategory <appcategory> <categoryId>

categoryId is a number between 1 and 32.

Associate the application category to a custom-application using the following commands:
(mynode) (config) #dpi custom-app <appname> <appID>

(mynode) (config-submode)#appcategory <appcategory>

(config-submode)#end

Debugging
The following show commands are introduced as part of the custom application category feature:

l Issue the following command on the Mobility Master:

n show dpi application category user-defined all: Displays custom app categories.

l Issue the following commands on the managed device:

n show dpi application category user-defined all: Displays all custom application categories.

n show dpi application category user-defined <category-name>: Displays the custom applications
which associated to a particular custom application category.



ArubaOS 8.0.0.0 | User Guide ClearPass Policy Manager Integration | 393

Chapter 21
ClearPass Policy Manager Integration

ArubaOS and ClearPass Policy Manager include support for centralized policy definition and distribution.
ArubaOS now supports downloadable roles. By using this feature, when ClearPass Policy Manager successfully
authenticates a user, the user is assigned a role by ClearPass Policy Manager. If the role is not defined on the
Mobility Master, the role attributes can also be downloaded automatically.

This chapter contains the following sections:

n Introduction on page 393

n Important Points to Remember on page 393

n Enabling Downloadable Role on a Managed Device on page 394

n Sample Configuration on page 394

Introduction
In order to provide highly granular per-user level access, user roles can be created when a user has been
successfully authenticated. During the configuration of a policy enforcement profile in ClearPass Policy
Manager, the administrator can define a role that should be assigned to the user after successful
authentication. In RADIUS authentication, when ClearPass Policy Manager successfully authenticates a user,
the user is assigned a role by ClearPass Policy Manager. If the role is not defined on Mobility Master, the role
attributes can also be downloaded automatically. This feature supports roles obtained by the following
authentication methods:

l 802.1X (wireless and wired users)

l MAC authentication

l Captive Portal

Important Points to Remember
l Under Advanced mode, ClearPass Policy Manager does not perform any error checking to confirm

accuracy of the role definition. Therefore, it is recommended that you review the role defined in ClearPass
Policy Manager prior to enabling this feature.

l The attributes that are listed below, herein referred to as whitelist role attributes, can be defined in
ClearPass Policy Manager.:

n netdestination
n netservice
n ip access-list eth
n ip access-list mac
n ip access-list session
n user-role

l The above attributes that are referred to by a role definition must either be defined within the role
definition itself or configured on the Mobility Master before the policy is downloaded.

l In ClearPass Policy Manager, two or more attributes (as listed above) should not have the same name. The
following example is considered invalid, as both the attributes use test as the profile/net destination name:
qos-profile test

netdestination test
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l Instance names (name of a whitelist role attribute) are case-sensitive. Attributes must adhere to the
following rules:

n Should not match any CLI option nested under a command from the whitelist.

n Should not contain a number or a combination of numbers.

n Should not contain any periods '.'.

n Should not contain any spaces.

The example below is considered an invalid configuration and prevents ClearPass Policy Manager role
download on a managed device:
netservice 'tcp' tcp 443

The first instance of tcp is a user-defined field, while the second is an operator of the netservice
command. This violates the first rule.
netdestination 'alias'

The user-defined name alias is also a valid operator of the netdestination command. This violates the
first rule.
netdestination '10.1.5'

This user-defined name uses both numbers and periods. This violates the second and third rule.
ip access-list stateless '100'

This user-defined name uses numbers. This violates the second rule.
qos-profile emp role

This profile name emp role contains spaces. This violates the fourth rule.

It is recommended that some naming convention similar to the CamelCase (mixture of upper and lower case
letters in a single word) be used to avoid collisions with the CLI options in the role description.

Enabling Downloadable Role on a Managed Device
You can enable role download using the CLI or WebUI.

Using the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Authentication page.

2. Select the AAA Profiles tab

3. Expand AAA in the AAA Profiles list, and then select a AAA profile.

4. Select the Download Role from CPPM check box to enable role download.

5. Click Save.

6. Select Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

Using the CLI
(host) [mynode] (config) #aaa profile <profile-name>

(host) [mynode] (AAA profile) #download-role

Sample Configuration
The following example shows the configuration details to integrate ClearPass Policy Manager server with a
managed device to automatically download roles.



ClearPass Policy Manager Server Configuration

Adding a Device
1. Navigate to the Configuration > Network > Devices page in the ClearPass Policy Manager server.

2. Click Add from the Action drop-down list. The Add Device page opens.

3. Under the Device tab, enter the Name, IP or Subnet Address, and RADIUS Shared Secret fields.

Keep the rest of the fields as default.

4. Click Add.

The fields are described in Table 68.

Container Description

Name The name or identity of the device.

IP or Subnet Address The IP address or subnet (example 10.1.1.1/24) of the device.

RADIUS Shared
Secret

Enter and confirm a Shared Secret for each of the two supported request
protocols.

Table 68: Device Tab

Adding an Enforcement Profile
1. Navigate to the Configuration > Enforcement > Profiles page.

2. Click Add from the Action drop-down list. The Enforcement Profiles page opens.

3. Under the Profile tab, select Aruba Downloadable Role Enforcement from the Template drop-down
list.

4. Enter the Name of the enforcement profile.

5. Under Role Configuration Mode, select Advanced.

Keep the rest of the fields as default.

6. Click Next.

For the rest of the configuration, see Advanced Role Configuration Mode.

The fields are described in Table 69.

Container Description

Template Policy Manager comes pre-packaged with several enforcement profile templates.
In this example, select Aruba Downloadable Role Enforcement - RADIUS
template that can be filled with user role definition to create roles that can be
assigned to users after successful authentication.

Name The name of the enforcement profile.

Role Configuration
Mode

Standard: Configures the enforcement profile role using standard mode.

Advanced: Configures the enforcement profile role using advanced mode.

Table 69: Enforcement Profiles Page
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Advanced Role Configuration Mode
1. Under the Attributes tab, select Radius:Aruba from the Type table.

2. From the Name drop-down list, select Aruba-CPPM-Role.

3. In the Value field, enter the attribute for the downloadable-role.

4. Click the Save icon to save the attribute.

5. Click Save to save the enforcement profile.

The fields are described in Table 70.

Container Description

Type Any RADIUS vendor dictionary that is pre-packaged with Policy Manager, or
imported by the Administrator. This field is pre-populated with the dictionary
names.

Name The name of the attribute from the dictionary selected in the Type field. The
attribute names are pre-populated from the dictionary.

Value The attribute for the downloadable role. You can enter free-form text to define
the role and policy.

NOTE: The maximum limit for free form text is 16,000 bytes.

Table 70: Enforcement Profiles Attributes Tab

Adding Enforcement Policy
1. Navigate to the Configuration > Enforcement > Policies page.

2. Click Add from the Action drop-down list. The Enforcement Policies page opens.

3. Under the Enforcement tab, enter the Name of the enforcement policy.

4. From the Default Profile drop-down list, select [Deny Access Profile].
Keep the rest of the fields as default.

5. Click Next.

The fields are described in Table 71.

Container Description

Name The name of the enforcement policy.

Default Profile An Enforcement Policy applies Conditions (roles, health, and time attributes)
against specific values associated with those attributes to determine the
Enforcement Profile. If none of the rules matches, Policy Manager applies the
Default Profile.

See Adding an Enforcement Profile on page 395 to add a new profile.

Table 71: Enforcement Policies Enforcement Tab

6. Under the Rules tab, click Add Rule. The Rules Editor page opens.

7. Select Click to add... from the Conditions section. Select the appropriate values, and then click the Save
icon.



8. In the Enforcement Profiles section, select the RADIUS enforcement profile that you created in Adding an
Enforcement Profile on page 395 from the Profile Names drop-down list.

9. Click Save.

The fields are described in Table 72.

Container Description

Type The rules editor appears throughout the Policy Manager interface. It exposes
different namespace dictionaries depending on Service type. When working with
service rules, you can select Authentication namespace dictionary

Name Drop-down list of attributes present in the selected namespace. In this example,
select Source.

Operator Drop-down list of context-appropriate (with respect to the attribute) operators. In
this example, select EQUALS.

Value Drop-down list of the Authentication source database. In this example, select
[Local User Repository].

Profile Names Name of the RADIUS enforcement profile.

Table 72: Enforcement Policies Rules Editor

Adding Services
1. Navigate to the Configuration > Services page.

2. Click Add from the Action drop-down list.

3. Under the Service tab, select 802.1X Wired from the Type drop-down-list.

4. In the Name field, enter the name of the service.

Keep the rest of the fields as default.

5. Click Next.

The fields are described in Table 73.

Container Description

Type The service type. In this example, select 802.1X Wired.

Name The name of the service.

Table 73: Service Tab

6. Under the Authentication tab, select [Local User Repository] [Local SQL DB] from the
Authentication Sources drop-down list.

Keep the rest of the fields as default.

7. Click Next twice.

8. Under the Enforcement tab, select the enforcement policy that you created in Adding Enforcement Policy
on page 396 from the Enforcement Policy drop-down list.

Keep the rest of the fields as default.

9. Click Save.
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For more configuration details on ClearPass Policy Manager, see the ClearPass Policy Manager User Guide.

Managed Device Configuration
For additional command parameters, see the ArubaOS CLI Reference Guide.

Configuring ClearPass Policy Manager Server on a Managed Device
(host) [mynode] (config) #aaa authentication-server radius cppm_server

(host) [mynode] (RADIUS Server "cppm_server") #host <ip_address_of_

cppm_server>

(host) [mynode] (RADIUS Server "cppm_server") #key <psk>

(host) [mynode] (RADIUS Server "cppm_server") #cppm username <username>

password <password>

Configuring Server Group to include ClearPass Policy Manager Server
(host) [mynode] (config) #aaa server-group cppm_grp

(host) [mynode] (server group "cppm_grp") #auth-server cppm_server

Configuring 802.1X Profile
(host) [mynode] (config) #aaa authentication dot1x cppm_dot1x_prof

Configuring AAA Profile
(host) [mynode] (config) #aaa profile cppm_aaa_prof

(host) [mynode] (AAA Profile "cppm_aaa_prof") #authentication-dot1x cppm_

dot1x_prof

(host) [mynode] (AAA Profile "cppm_aaa_prof") #dot1x-server-group cppm_gr

(AAA Profile "cppm_aaa_prof") #download-role

Show AAA Profile
(host) [mynode] #show aaa profile cppm_aaa_prof

AAA Profile "cppm_aaa_prof"

---------------------

Parameter Value Set

--------- ----- ---

Initial role logon

MAC Authentication Profile N/A

MAC Authentication Default Role guest

MAC Authentication Server Group default

802.1X Authentication Profile N/A

802.1X Authentication Default Role guest

802.1X Authentication Server Group N/A

Download Role from CPPM Disabled

Set username from dhcp option 12 Disabled

L2 Authentication Fail Through Disabled

Multiple Server Accounting Disabled

User idle timeout N/A

Max IPv4 for wireless user 2

RADIUS Accounting Server Group N/A

RADIUS Interim Accounting Disabled

XML API server N/A

RFC 3576 server N/A

User derivation rules N/A

Wired to Wireless Roaming Enabled

Device Type Classification Enabled

Enforce DHCP Disabled

PAN Firewall Integration Disabled

Open SSID radius accounting Disabled
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Chapter 22
Configuring WLANs

APs advertise WLANs to wireless clients by sending out beacons and probe responses that contain the WLAN’s
SSID and supported authentication and data rates. When a wireless client associates to an AP, it sends traffic to
the AP’s Basic Service Set Identifier (BSSID) which is usually the AP’s MAC address.

In the Aruba network, an AP uses a unique BSSID for each WLAN, so each individual AP or AP group can
support multiple WLAN configurations.

This chapter describes the following topics for creating and managing WLANs and Virtual AP profiles:

l Basic WLAN Configuration Workflow on page 399

l WLAN Configuration Profiles on page 405

l Configuring the Virtual AP Profile

l Radio Resource (802.11k) and BSS Transition Management (802.11v) on page 414

l Fast BSS Transition ( 802.11r) on page 423

l WLAN SSID Profiles on page 424

l WLAN Authentication on page 431

Basic WLAN Configuration Workflow
The recommended method for creating a new WLAN configuration is through the new WLAN wizard, although
advanced users may also configure a WLAN manually via the ArubaOS WebUI and command-line interfaces.

Creating a WLAN using the WLAN Wizard
To start the New WLAN wizard, navigate to Configuration > Tasks and select New WLAN. The wizard opens
and prompts you to enter the following information:

Configuration Setting Description

General Settings

Name (SSID) Name you assign to the new WLAN.

Primary Usage Select whether the WLAN will be primarily supporting employees or guest
users.

Broadcast on Choose whether the WLAN SSID should broadcast on all APs associated to the
managed device or Mobility Master configuration, or whether the WLAN should
broadcast on APs in a selected AP group. If you choose the Select AP Groups
option, you are prompted to select one or more AP groups.



400 | Configuring WLANs ArubaOS 8.0.0.0  | User Guide

Configuration Setting Description

Forwarding Mode If the forwarding mode is set to Tunnel, data is tunneled to the managed
device using generic routing encapsulation (GRE). When a WLAN is configured
to use the Decrypt-Tunnel forwarding mode, that AP decrypts and
decapsulates all 802.11 frames from a client and sends the 802.3 frames
through the GRE tunnel to the managed device, which then applies firewall
policies to the user traffic. When the managed device sends traffic to a client,
the managed device sends 802.3 traffic through the GRE tunnel to the AP,
which then converts it to encrypted 802.11 and forwards to the client.

Broadcast SSID By default, selected APs begin broadcasting the new WLAN SSID as soon as
the new WLAN is created. If you do not want APs to broadcast the new WLAN,
click the Broadcast SSID drop-down list and select No.

VLANs

VLAN The VLAN(s) into which users are placed in order to obtain an IP address. If
you are creating a guest WLAN, remember that guest users must be
separated from employee users by VLANs in the network.

Named VLANs Click the Show VLAN Details link to display the list of named VLANs
configured on the managed device or Mobility Master.

To add a new VLAN, click + below the Named VLANs table, then enter a
VLAN name and a VLAN ID or range of IDs for the new VLAN. To edit a named
VLAN, select the VLAN from the table and click the edit (pencil) icon.

NOTE: To create a range of multiple VLAN IDs, by specify the beginning and
ending VLAN IDs separated by a hyphen. For example, 55-58.

All VLAN IDs on This Controller Click the Show VLAN Details link to display the list of VLAN IDs configured on
the managed device or Mobility Master.

To add a VLAN ID, click + below the Al VLAN IDs table. To edit a VLAN ID, select
the VLAN from the table and click the edit (pencil) icon. You can configure or
edit the following settings:

l VLAN IDs: Identification number for the VLAN

l Admin State: Enable or disable the VLAN interface.

l IPv4 Address: The IPv4 and netmask address for this interface

l Enable NAT: Enables source network address translation (NAT) for all
traffic routed from this VLAN. All ports on the managed device are
assigned to VLAN 1 by default. Do not enable the NAT option for VLAN 1,
as this will prevent IPsec connectivity between the managed device and its
IPsec peers.

l Local Link Address: Configures the specified IPv6 address as the link
local address for this interface.

l Global Unicast Address: Specify the IPv6 address prefix to configure the
global unicast address for this interface. For example, 2001:DB8:0:3::/64

Security (for employee WLANs)

Enterprise This option supports the following configuration parameters:



Configuration Setting Description

l Auth servers: Click + to open the Add Existing Server window and select
a preconfigured server from the list of servers. To define a new server,
click + on the Add Existing Server window and define a new LDAP or
RADIUS server. For details, see Configuring Authentication Servers on
page 175

l Reauth Interval: Interval, in seconds, between reauthentication attempts.

l Machine Authentication: Select this option to enforce machine
authentication before user authentication. If selected, either the machine-
default-role or the user-default-role is assigned to the user, depending on
which authentication is successful.

l Blacklisting: Blacklists the client if authentication fails a specified number
of times.

l Max Authentication Failures: If Blacklisting is enabled, this parameter
defines the number of times a user can try to login with wrong credentials
after which the user is blacklisted as a security threat.

Personal This option supports the following configuration parameters:

l Key management: Use this setting to select the layer-2 encryption type to
be used on this WLAN SSID. Select either WPA-2 personal
(recommended) or WPA personal.

l Passphrase: Enter the WPA-2 or WPA password

l Retype: Retype the WPA-2 or WPA password

l MAC authentication: Select this option to enforce machine
authentication before user authentication. If selected, either the machine-
default-role or the user-default-role is assigned to the user, depending on
which authentication is successful.

l Blacklisting: Blacklists the client if authentication fails a specified number
of times.

l Max Authentication Failures: If Blacklisting is enabled, this parameter
defines the number of times a user can try to login with wrong credentials
after which the user is blacklisted as a security threat.

Open This option supports the following configuration parameters:

l MAC authentication: Select this option to enforce machine
authentication.

l Blacklisting: Blacklists the client if authentication fails a specified number
of times.

l Max Authentication Failures: If Blacklisting is enabled, this parameter
defines the number of times a user can try to login with wrong credentials
after which the user is blacklisted as a security threat.

Security (for guest WLANs)

Clearpass or other external cap-
tive portal

This option supports the following configuration parameters:

l Auth servers: Click + to open the Add Existing Server window and select
a preconfigured server from the list of servers. To define a new server,
click + on the Add Existing Server window and define a new LDAP or
RADIUS server. For details, see Configuring Authentication Servers on
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Configuration Setting Description

page 175

l CPPM Host: IPv4 address of the ClearPass Policy Manager host.

l CPPM Page: URL of the page that appears for the user logon. This can be
set to any URL. Default: /auth/index.html

l Redirect URL: URL to which an authenticated user will be directed. This
parameter must be an absolute URL that begins with either http:// or
https://.

Internal captive portal with
authentication

This option supports the following configuration parameters:

l Template: Define the title, text, banner icon and banner color for the
captive portal landing page.

l Custom HTML: Click this link to browse to and select HTML files for the
initial login and welcome pages.

l Redirect URL: URL to which an authenticated user will be directed. This
parameter must be an absolute URL that begins with either http:// or
https://.

Internal captive portal with email
registration

This option supports the following configuration parameters:

l Template: Define the title, text, banner icon and banner color for the
captive portal landing page.

l Custom HTML: Click this link to browse to and select HTML files for the
initial login and welcome pages.

l Redirect URL: URL to which an authenticated user will be directed. This
parameter must be an absolute URL that begins with either http:// or
https://.

Internal captive portal, no auth or
registration

This option supports the following configuration parameters:

l Template: Define the title, text, banner icon and banner color for the
captive portal landing page.

l Custom HTML: Click this link to browse to and select HTML files for the
initial login and welcome pages.

l Redirect URL: URL to which an authenticated user will be directed. This
parameter must be an absolute URL that begins with either http:// or
https://.

No Captive Portal Guests are granted access without a captive portal.

Access

Default Role Select a user role to be assigned to an employee that successfully
authenticates to the WLAN.

If you are creating an employee WLAN, click the default role drop-down list
and select an existing user role, or define a new role for the WLAN, by
selecting Show Roles and clicking + below the Roles table.



Configuration Setting Description

If you are creating a guest WLAN, the WLAN wizard automatically creates a
default role for the guest users that have successfully authenticated to the
WLAN, named is <WLAN-name>-guest-logon. To configure this role, click
Show Roles and click + below the Roles table. As you configure your guest
role, keep in mind the following guidelines for guest WLANs:

l Guests must be limited not only in where they may go, but also by what
network protocols and ports they may use to access resources.

l Guests should be allowed to access only the local resources that are
required for IP connectivity. These resources include DHCP and possibly
DNS if an outside DNS server is not available. In most cases, a public DNS
is always available.

l All other internal resources should be off limits for the guest. This
restriction is achieved usually by denying any internal address space to
the guest user.

l A time-of-day restriction policy should be used to allow guests to access
the network only during normal working hours, because they should be
using the network only while conducting official business. A rate limit can
also be put on each guest user to keep the user from using up the limited
wireless bandwidth. Accounts should be set to expire when their local work
is completed, typically at the end of each business day.

NOTE: For complete information on creating user roles and assigning rules
and policies to a role, see Roles and Policies on page 363.

Server Derived Roles (For employee WLANs using enterprise security) Enable this option to
configure a server derivation rules that can assign a user role for the client
can be based on one or more attributes returned by the server during
authentication, or on client attributes such as SSID (even if the attribute is not
returned by the server). Server-derivation rules are executed after client
authentication.

Derivation Method (For employee WLANs using enterprise security) Select a derivation method.
Select use value returned from ClearPass or other auth server if your
users will authenticate to the WLAN via ClearPass Policy Manager or another
type of authentication server, or select User rules defined in table below
to define a custom role based upon RADIUS Server VSAs. You will be
prompted define the following values:

l Attribute: RADIUS VSA type

l Condition: contains, equals, not-equals, start-with or value-of

l String: Text string compared against VSA condition

l Role: Role assigned if the VSA condition and string match.

NOTE: For the current and complete list of all RADIUS VSAs available in the
version of ArubaOS currently running on your managed device, access the
command-line interface and issue the command show aaa radius
attributes. See also RADIUS Server VSAs on page 179

Manually Creating a WLAN in the WebUI
The following workflow lists the tasks to manually configure a WLAN that uses 802.1X authentication. Click any
of the links below for details on the configuration procedures for that task.
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This method for configuring a WLAN is recommended for advanced users only.

1. Configure your authentication servers.

2. Create an authentication server group, and assign the authentication servers you configured in step 1 to
that server group.

3. Configure a firewall access policy for a group of users

4. Create a user role, and assign the firewall access policy you created in step 3 to that user role.

5. Configure the AAA profile for the configuration node.

a. Assign the user role defined in step 4 to the AAA profile's 802.1X Authentication Default Role
b. Associate the server group you created in step 2 to the AAA profile.

6. Configure the SSID profile for the configuration node

7. Configure the virtual AP profile for the configuration node. the Virtual AP profile for the configuration node
will automatically be associated to the AAA profile configured in Step 5, and the SSID profile configured in
Step 6.

Manually Creating a WLAN in the CLI
The example below follows the suggested order of steps to configure a WLAN using the command-line
interface.

This method for configuring a WLAN is recommended for advanced users only.

(host)[node](config) #aaa server-group "THR-DOT1X-SERVER-GROUP-WPA2"

auth-server Internal

!

ip access-list session THR-POLICY-NAME-WPA2

user any any permit

!

(host)[node](config) #user-role THR-ROLE-NAME-WPA2

session-acl THR-POLICY-NAME-WPA2

!

(host)[node](config) #aaa server-group "THR-DOT1X-SERVER-GROUP-WPA2"

auth-server Internal

!

(host)[node](config) #aaa profile "THR-AAA-PROFILE-WPA2"

dot1x-default-role "THR-ROLE-NAME-WPA2"

dot1x-server-group "THR-DOT1X-SERVER-GROUP-WPA2"

!

(host)[node](config) #wlan ssid-profile "THR-SSID-PROFILE-WPA2"

essid "THR-WPA2"

opmode wpa2-aes

!

(host)[node](config) #wlan virtual-ap "THR-VIRTUAL-AP-PROFILE-WPA2"

ssid-profile "THR-SSID-PROFILE-WPA2"

aaa-profile "THR-AAA-PROFILE-WPA2"

vlan 60

!

(host)[node](config) #ap-group "THRHQ1-STANDARD"

virtual-ap "THR-VIRTUAL-AP-PROFILE-WPA2"



WLAN Configuration Profiles
You can configure your WLANS to provide different network access or services to users on the same physical
network. For example, you can configure a WLAN to provide access to guest users and another WLAN to
provide access to employee users through the same APs. You can also configure a WLAN that offers open
authentication and Captive Portal access with data rates of 1 and 2 Mbps, and another WLAN that requires
WPA authentication with data rates of up to 11 Mbps. You can apply both virtual AP configurations to the
same AP or an AP group.

When you define a WLAN using the New WLAN wizard on the Configuration > Tasks page of the Mobility
Master or stand-alone controller WebUI, the wizard automatically creates a new virtual AP profile, AAA profile,
802.1X, Server group profile and SSID profile with the same name as the WLAN, and with the configuration
settings and values defined via the wizard. These profiles also support additional advanced features that are
not configurable via the WLAN wizard on the Configuration > Tasks page.

The following table describes the profiles that comprise the configuration settings for an ArubaOS WLAN, with
links to the sections of this document that describe these profiles in more detail.

Profile Description

Virtual AP
Profile

This is the top-level WLAN configuration profile. A Virtual AP profile allows you to configure WLAN
settings such as broadcast/multicast settings, forwarding modes and RF bands, but it also
identifies the individual 802.11k, AAA, Anyspot, Hotspot 2.0, SSID and WWM Traffic management
profiles to be used by that WLAN.

Default profile name: <WLAN Name>

When you create a WLAN using the WLAN wizard, ArubaOS automatically creates a new Virtual
AP profile with the same name as the WLAN.

802.11k
profile

The 802.11k protocol provides mechanisms for APs and clients to dynamically measure the
available radio resources. Each 802.11k profile also references one instance of each the
following additional profile types.

l Beacon Report Request profile: Defines beacon report request settings. Beacon report
requests are sent only to 802.11k-compliant clients that advertise Beacon Report Capability in
their RRM Enabled Capabilities IE.

l RRM IE profile: Defines Radio Resource Management Information Elements (RRM IEs) for
WLANs with 802.11k support enabled.

l TSM Report Request profile: Defines Traffic Stream Measurement (TSM) Report Requests.
These report requests are sent only to 802.11k- compliant clients that advertise a traffic
stream report capability

Default profile name: default

AAA profile The AAA profile defines the type of authentication used by clients associating to a WLAN. Each
AAA profile also references one instance of each the following additional profile types:

l 802.1X Authentication profile: Defines 802.1X authentication settings.

l 802.1X Authentication Server Group profile: Defines fail through and load balancing settings
for a group of servers used for 802.1X authentication.

l MAC Authentication profile: Defines MAC authentication settings.

Table 74: WLAN Profiles
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Profile Description

l MAC Authentication Server Group profile: Defines fail through and load balancing settings for
a group of servers used for MAC authentication.

l RADIUS Accounting Server Group profile: Defines fail through and load balancing settings for
a group of servers used for RADIUS accounting.

l RFC 3576 Server profile: Defines a RADIUS server to send user disconnect, change-of-
authorization (CoA), and session timeout messages as described in RFC 3576.

l XML API Server profile: Define an authentication key for an XML API server, to perform
customized external captive portal user management using an XML API interface.

Default profile name: <WLAN Name>

When you create a WLAN using the WLAN wizard, ArubaOS automatically creates a new AAA
profile with the same name as the WLAN.

AnySpot
Profile

The anyspot client probe suppression feature decreases network traffic by suppressing probe
requests from clients attempting to locate and connect to other known networks. By default, a
virtual AP is not associated with an Anyspot profile, so an Anyspot profile must first be defined,
and then manually associated to the virtual AP.

Default profile name: N/A

Hotspot 2.0
Profile

Hotspot 2.0 is a Wi-Fi Alliance Passpoint specification based upon the 802.11u protocol that
provides wireless clients with a streamlined mechanism to discover and authenticate to suitable
networks, and allows mobile users the ability to roam between partner networks without
additional authentication. The Hotspot profile for a WLAN references a hotspot advertisement
profile, which in turn references several other profiles that define settings for individual hotspot
features.

l Hotspot Advertisement Profiles

l ANQP Venue Name Profiles

l ANQP Network Authentication Profiles

l ANQP Domain Name Profile

l ANQP IP Address Availability Profiles

l ANQP NAI Realm Profiles

l ANQP Roaming Consortium Profiles

l ANQP 3GPP Cellular Network Profiles

l H2QP Connection Capability Profiles

l H2QP Operator Friendly Name Profiles

l H2QP Operating Class Indication Profiles

l H2QP WAN Metrics Profiles

Default profile name: <WLAN Name>

When you create a WLAN using the WLAN wizard, ArubaOS automatically creates a new Hotspot
2.0 profile with the same name as the WLAN.



Profile Description

SSID Profile A SSID profile defines the name of the network, authentication type for the network, basic rates,
transmit rates, SSID cloaking, and certain WMM settings for the network. Each SSID profile also
references one instance of each the following additional profile types:

l 80.11r profile: The Fast BSS Transition (802.11r) mechanism minimizes the delay when a
voice client transitions from one BSS to another within the same ESS.

l EDCA Parameters (AP) profile: ArubaOS supports media access prioritization through
Enhanced Distributed Channel Access (EDCA), which defines four access categories (ACs) to
prioritize traffic. This profile defines EDCA settings for APs.

l EDCA Parameters (Station) profile: ArubaOS supports media access prioritization through
Enhanced Distributed Channel Access (EDCA), which defines four access categories (ACs) to
prioritize traffic. This profile defines EDCA settings for clients.

l High-throughput SSID profile: Defines 802.11ac very-high-throughput settings for the 5 GHz
frequency band, and high-throughput (802.11n) settings for both the 5 GHz and 2.4 GHz
frequency bands.

Default profile name: <WLAN Name>

When you create a WLAN using the WLAN wizard, ArubaOS automatically creates a new SSID
profile with the same name as the WLAN.

Configuring the Virtual AP Profile
The recommended method for creating a new WLAN configuration is through the new WLAN wizard, although
advanced users may also configure a WLAN manually via the ArubaOS WebUI and command-line interfaces.

Follow the procedure below to manually configure a Virtual AP profile using the WebUI or command-line
interfaces.

For important information on changing the virtual AP forwarding mode for a WLAN serving active wired or wireless
clients, see Changing a Virtual AP Forwarding Mode on page 414.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles list, expand the Wireless LAN menu, then select Virtual AP.

3. Select the virtual AP profile you want to edit, or click + to create a new profile.
The Virtual AP profile settings are divided into four sections, Broadcast/Multicast, General, RF and
Advanced. The profile parameters in each section are described in Table 75.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.
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Parameter Description

BroadCast/Multicast

Dynamic Multicast
Optimization (DMO)

Enable/Disable dynamic multicast optimization. This parameter is disabled by
default, and cannot be enabled without the PEFNG license.

Dynamic Multicast
Optimization (DMO)
Threshold

Maximum number of high-throughput stations in a multicast group beyond which
dynamic multicast optimization stops.

Range: 2-255 stations

Default: 6 stations.

Drop Broadcast and
Multicast

Select the Drop Broadcast and Multicast check box to filter out broadcast and
multicast traffic in the air.

Do not enable this option for virtual APs configured in bridge forwarding mode.
This configuration parameter is only intended for use for virtual APs in tunnel
mode. In tunnel mode, all packets travel to the controller, so the controller is able
to drop all broadcast traffic. When a virtual AP is configured to use bridge
forwarding mode, most data traffic stays local to the AP, and the controller is not
able to filter out that broadcast traffic.

IMPORTANT: If you enable this option, you must also enable the Convert
Broadcast ARP requests to unicast parameter on the virtual AP profile to
prevent ARP requests from being dropped.

Convert Broadcast
ARP requests to
unicast

If enabled, all broadcast ARP requests are converted to unicast and sent directly to
the client. You can check the status of this option using the show ap active and
the show datapath tunnel command. If enabled, the output will display the letter
a in the flags column.

This configuration parameter is only intended for use for virtual APs in tunnel
mode. In tunnel mode, all packets travel to the controller, so the controller is able
to convert ARP requests directed to the broadcast address into unicast.

When a virtual AP is configured to use bridge forwarding mode, most data traffic
stays local to the AP, and the controller is not able to convert that broadcast traffic.

This parameter is enabled by default. Behaviors associated with these settings are
enabled upon upgrade to ArubaOS 6.1.3.2. If your controller supports clients
behind a wireless bridge or virtual clients on VMware devices, you must disable
this setting to allow those clients to obtain an IP address. In previous releases of
ArubaOS, the virtual AP profile included two unique broadcast filter parameters;
the drop broadcast and multicast parameter, which filtered out all broadcast
and multicast traffic in the air except DHCP response frames (these were
converted to unicast frames and sent to the corresponding client) and the convert
Broadcast ARP requests to unicast parameter, which converted broadcast ARP
requests to unicast messages sent directly to the client.

The Convert Broadcast ARP requests to unicast setting includes the additional
functionality of broadcast-filter all parameter, where DHCP response frames are
sent as unicast to the corresponding client. This can impact DHCP
discover/requested packets for clients behind a wireless bridge and virtual clients
on VMware devices. Disable this option to resolve this issue and allow clients
behind a wireless bridge or VMware devices to receive an IP address.

Default: Enabled

Table 75: Virtual AP Profile Parameters



Parameter Description

General

Virtual AP enable Select the Virtual AP enable check box to enable or disable the virtual AP.

VLAN The VLAN(s) into which users are placed in order to obtain an IP address. Click the
drop-down list to select a configured VLAN, the click the arrow button to associate
that VLAN with the virtual AP profile.

NOTE: You must add an existing VLAN ID to the Virtual AP profile.

Forward mode This parameter controls whether data is tunneled to the controller using generic
routing encapsulation (GRE), bridged into the local Ethernet LAN (for remote APs),
or a combination thereof depending on the destination (corporate traffic goes to
the controller, and Internet access remains local). All forwarding modes support
band steering, TSPEC/TCLAS enforcement, 802.11k and station blacklisting.

Click the drop-down list to select one of the following forward modes:

l Tunnel: The AP handles all 802.11 association requests and responses, but
sends all 802.11 data packets, action frames and EAPOL frames over a GRE
tunnel to the controller for processing. The controller removes or adds the GRE
headers, decrypts or encrypts 802.11 frames and applies firewall rules to the
user traffic as usual. Both remote and campus APs can be configured in tunnel
mode.

l Bridge: 802.11 frames are bridged into the local Ethernet LAN. When a remote
AP or campus AP is in bridge mode, the AP (and not the controller) handles all
802.11 association requests and responses, encryption/decryption processes,
and firewall enforcement. The 802.11e and 802.11k action frames are also
processed by the AP, which then sends out responses as needed.

An AP in bridge mode does not support captive portal authentication. Both
remote and campus APs can be configured in bridge mode. Note that you must
enable the control plane security feature on the controller before you configure
campus APs in bridge mode.

l Split-Tunnel: 802.11 frames are either tunneled or bridged, depending on the
destination (corporate traffic goes to the controller, and Internet access
remains local).

A remote AP in split-tunnel forwarding mode handles all 802.11 association
requests and responses, encryption/decryption, and firewall enforcement. the
802.11e and 802.11k action frames are also processed by the remote AP, which
then sends out responses as needed.

l Decrypt-Tunnel: Both remote and campus APs can be configured in decrypt-
tunnel mode. When an AP uses decrypt-tunnel forwarding mode, that AP
decrypts and decapsulates all 802.11 frames from a client and sends the 802.3
frames through the GRE tunnel to the controller, which then applies firewall
policies to the user traffic.

When the controller sends traffic to a client, the controller sends 802.3 traffic
through the GRE tunnel to the AP, which then converts it to encrypted 802.11 and
forwards to the client. This forwarding mode allows a network to utilize the
encryption/decryption capacity of the AP while reducing the demand for
processing resources on the controller.
APs in decrypt-tunnel forwarding mode also manage all 802.11 association
requests and responses, and process all 802.11e and 802.11k action frames.
APs using decrypt-tunnel mode do have some limitations that not present for
APs in regular tunnel forwarding mode.
You must enable the control plane security feature on the controller before you
configure campus APs in decrypt-tunnel forward mode.
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Parameter Description

NOTE: Virtual APs in bridge or split-tunnel mode using static WEP should use key
slots 2-4 on the controller. Key slot 1 should only be used with Virtual APs in tunnel
mode.

RF

Allowed band The band(s) on which to use the virtual AP:

l a—802.11a band only (5 GHz).

l g—802.11b/g band only (2.4 GHz).

l all—both 802.11a and 802.11b/g bands (5 GHz and 2.4 GHz). This is the default
setting.

Band Steering ARM’s band steering feature encourages dual-band capable clients to stay on the
5GHz band on dual-band APs. This frees up resources on the 2.4GHz band for
single band clients like VoIP phones.

Band steering reduces co-channel interference and increases available bandwidth
for dual-band clients, because there are more channels on the 5GHz band than on
the 2.4GHz band. Dual-band 802.11n-capable clients may see even greater
bandwidth improvements, because the band steering feature will automatically
select between 40MHz or 20MHz channels in 802.11n networks. This feature is
disabled by default, and must be enabled in a Virtual AP profile.

The band steering feature supports both campus APs and remote APs that have a
virtual AP profile set to tunnel, split-tunnel or bridge forwarding mode. Note,
however, that if a campus or remote APs has virtual AP profiles configured in
bridge or split-tunnel forwarding mode but no virtual AP in tunnel mode, those APs
will gather information about 5G-capable clients independently and will not
exchange this information with other APs that also have bridge or split-tunnel
virtual APs only.

Steering Mode Band steering supports the following three different band steering modes.

l Force-5GHz: When the AP is configured in force-5GHz band steering mode, the
AP will try to force 5Ghz-capable APs to use that radio band.

l Prefer-5GHz (Default): If you configure the AP to use prefer-5GHz band
steering mode, the AP will try to steer the client to 5G band (if the client is 5G
capable) but will let the client connect on the 2.4G band if the client persists in
2.4 G association attempts.

l Balance-bands: In this band steering mode, the AP tries to balance the clients
across the two radios in order to best utilize the available 2.4G bandwidth. This
feature takes into account the fact that the 5Ghz band has more channels than
the 2.4 Ghz band, and that the 5 Ghz channels operate in 40MHz while the 2.5
Ghz band operates in 20 MHz.

Advanced

Cellular Handoff
Assist

When both the client match and the cellular handoff assist features are enabled,
the cellular handoff assist feature can help a dual-mode, 3G/4G-capable Wi-Fi
device such as an iPhone, iPad or Android client at the end of a Wi-Fi network
switch from Wi-Fi to an alternate 3G/4G radio that provides better network access.
This feature is supported by iOS and Android devices only.



Parameter Description

Authentication
Failure Blacklist
Time

Time, in seconds, a client is blocked if it fails repeated authentication. The default
setting is 3600 seconds (1 hour). A value of 0 blocks the client indefinitely.

Blacklist Time Number of seconds that a client is quarantined from the network after being
blacklisted. Default: 3600 seconds (1 hour)

Deny inter user
traffic

Select this check box to deny traffic between the clients using this virtual AP profile.

The global firewall shown the Configuration>Advanced Services > Stateful
Firewall > Global window also includes an option to deny all inter-user traffic,
regardless of the Virtual AP profile used by those clients.

If the global setting to deny inter-user traffic is enabled, all inter-user traffic
between clients will be denied, regardless of the settings configured in the virtual
AP profiles. If the setting to deny inter-user traffic is disabled globally but enabled
on an individual virtual ap, only the traffic between un-trusted users and the clients
on that particular virtual AP will be blocked.

Deny time range Click the drop-down list and select a configured time range for which the AP will
deny access. If you have not yet configured a time range, navigate to
Configuration > Security > Access Control > Time Ranges to define a time
range before configuring this setting in the Virtual AP profile.

DoS Prevention If enabled, APs ignore deauthentication frames from clients. This prevents a
successful deauthorization attack from being carried out against the AP. This does
not affect third-party APs. Default: Disabled

HA Discovery
on-association

If enabled, home agent discovery is triggered on client association instead of home
agent discovery based on traffic from client. Mobility on association can speed up
roaming and improve connectivity for clients that do not send many uplink packets
to trigger mobility (VoIP clients). Best practices is to disable this parameter as it
increases IP mobility control traffic between managed devices in the same mobility
domain. Enable this parameter only when voice issues are observed in VoIP clients.

Default: Disabled

NOTE: ha-disc-onassoc parameter works only when IP mobility is enabled and
configured on the managed device. For more information about this parameter,
see HA Discovery on Association on page 599

Mobile IP Enables or disables IP mobility for this virtual AP.

Default: Enabled

Preserve Client VLAN If you select this check box, clients retain their previous VLAN assignment if the
client disassociates from an AP and then immediately re-associates either with
same AP or another AP on the same managed device.

Remote-AP
Operation

Configures when the virtual AP operates on a remote AP:

l always—Permanently enables the virtual AP (Bridge Mode only). This option
can be used for non-802.1X bridge VAPs.

l backup—Enables the virtual AP if the remote AP cannot connect to the
managed device (Bridge Mode only). This option can be used for non-802.1X
bridge VAPs.
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Parameter Description

l persistent—Permanently enables the virtual AP after the remote AP initially
connects to the managed device (Bridge Mode only). This option can be used
for any (Open/PSK/802.1X) bridge VAPs.

l standard—Enables the virtual AP when the remote AP connects to the
managed device. This option can be used for any (bridge/split-tunnel/tunnel/d-
tunnel) VAPs.

Station Blacklisting Select the Station Blacklisting check box to enable detection of denial of service
(DoS) attacks, such as ping or SYN floods, that are not spoofed deauthorization
attacks.

Default: Enabled

Strict Compliance If enabled, the AP denies client association requests if the AP and client station
have no common rates defined. Some legacy client stations which are not fully
802.11-compliant may not include their configured rates in their association
requests. Such non-compliant stations may have difficulty associating with APs
unless strict compliance is disabled. This parameter is disabled by default.

VLAN Mobility Enable or disable VLAN (Layer-2) mobility.

Default: Disabled

WAN operation
mode

This feature works in conjunction with the WAN Health Check Manager and Uplink
Manager. When all uplinks are be down, the uplink manager makes the needed
changes based on configuration and pushes these changes to APs.

l If the operation mode is set to primary, the VAP will be disabled.

l If the operation mode is set to backup, the VAP will be enabled.

l If the operation mode is set to Always, the VAP will not change.

FDB Update on Assoc This parameter enables seamless failover for silent clients, allowing them to re-
associate. If you select this option, the controller will generate a Layer 2 update on
behalf of client to update forwarding tables in bridge devices.

Default: Disabled

A Virtual AP profile directly references one of each of the following profiles types.

l 802.11k

l AAA

l AnySpot

l HotSpot 2.0

l SSID

l WWM Traffic Management

To change the profiles associated to a Virtual AP profile:

1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles list, expand the Wireless LAN menu, then select Virtual AP.

3. Select the Virtual AP profile you want to edit. The All Profiles window displays the list of associated profiles
for that Virtual AP.

4. Select any of the associated profiles in the list.



5. A drop-down list appears at the top of the right window pane which allows you to select another profile of
that type.

6. Click Save.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Figure 40 Associating Profiles to a Virtual AP

In the CLI
(host)[node](config) #wlan virtual-ap <profile>

(host)[node] (Virtual AP profile "profile")aaa-profile <profile>

(host)[node] (Virtual AP profile "profile")anyspot-profile <profile>

(host)[node] (Virtual AP profile "profile")dot11k-profile <profile>

(host)[node] (Virtual AP profile "profile")hs2-profile <profile>

(host)[node] (Virtual AP profile "profile")ssid-profile <profile>

(host)[node] (Virtual AP profile "profile")wmm-traffic-management-profile <profile>

Selective Multicast Streams
The selective multicast group is based only on the packets learned through the Internet Group Management
Protocol (IGMP).

l When the Drop Broadcast and Multicast setting is enabled in the virtual AP profile, the managed device
allows multicast packets to be forwarded only if the following conditions are met:

n packets originating from the wired side have a destination address range of 225.0.0.0 -
239.255.255.255

n a station has subscribed to a multicast group.
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l If the Dynamic Multicast Optimization (DMO) setting is enabled in the virtual AP profile , the packets
are sent with 802.11 unicast header.

l When IGMP snooping/proxy is disabled, the managed device is not aware of the IGMP membership and
drops the multicast flow.

l If AirGroup is enabled, mDNS (SSDP) packets are sent to the AirGroup application. The common address for
mDNS is 224.0.0.251 and SSDP is 239.255.255.250.

Changing a Virtual AP Forwarding Mode
When you change the forwarding mode for a Virtual AP actively serving clients, the user table will NOT reflect
accurate client information unless the entries for those users are manually cleared. Use the following
procedure to change the forwarding mode on a Virtual AP serving wired or wireless clients.

Changing the Forwarding Mode for Wired Users
To change the forwarding mode for wired users connected to the wired port on an AP:

1. Disable the port by issuing the CLI command ap wired-port-profile <ap-wired-port-profile> shutdown.
This will disconnect any wired clients using that port.

2. Issue the command aaa user delete {<ipaddr>|all|mac <macaddr>|name <username>|role
<role>} to remove from the user table the wired users associated with AP wired ports using the <ap-wired-
port-profile>.

3. Issue the command ap wired-ap-profile <profile> forward-mode <mode> where <mode> is the new
forwarding mode for the wired port

4. Reenable the port using the command ap wired-port-profile <ap-wired-port-profile> no shutdown.

Changing the Forwarding Mode for Wirelsss Users
To change the forwarding mode for wireless users associated with an AP radio:

1. Issue the command ap-name <group> no virtual-ap <vap-profile> or ap-group <group> no virtual-ap
<vap-profile> to disassociate the AP or group of APs from the virtual AP profile.

2. Issue the command aaa user delete {<ipaddr>|all|mac <macaddr>|name <username>|role <role>}
to remove from the user table the users associated to the virtual-ap specified in the previous step.

3. Issue the command wlan virtual-AP <vap-profile> forward-mode <mode> where <mode> is the new
forwarding mode for the virtual AP.

4. Issue the command ap-name <group> virtual-ap <vap-profile> or ap-group <group> virtual-ap <vap-
profile> to reassociate the AP or group of APs with the virtual AP profile.

Radio Resource (802.11k) and BSS Transition Management
(802.11v)
The 802.11k protocol provides mechanisms for APs and clients to dynamically measure the available radio
resources. In an 802.11k enabled network, APs and clients can send neighbor reports, beacon reports, and link
measurement reports to each other. This allows the APs and clients to take appropriate connection actions.

The 802.11v BSS Transition capability can improve throughput, data rates and QoS for the voice clients in a
network by shifting (via transition) the individual voice traffic loads to more appropriate points of association
within the ESS.

This topic includes the following procedures:

l Configuring the 802.11k Profile on page 415

l Configuring Radio Resource Management Information Elements on page 417



l Configuring Beacon Report Requests on page 418

l Configuring Traffic Stream Measurement Report Requests on page 420

l BSS Transition Management (802.11v) on page 422

Configuring the 802.11k Profile
The following procedures outline the steps to configure 802.11k parameters for a configuration node.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles window.

2. In the Profiles list, expand the Wireless LAN menu, then select 802.11k
3. To edit an existing 802.11k profile, select the 802.1X profile you want to edit. To create a new 802.11k

profile, click + and enter a name for the new 802.11k profile name in the profile name field.

4. Configure your 802.11k radio settings. Table 76 outlines the parameters you can configure in the 802.11k
profile.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

Parameter Description

Advertise
802.11k
Capability

Select this option to allow Virtual APs using this profile to advertise 802.11k
capability. Enabling this option also enables support for the 802.11v BSS transition
management feature described in BSS Transition Management (802.11v) on page
422.

Default: Disabled

Forcefully
disassociate
on-hook voice
clients

Select this option to allow the AP to forcefully disassociate on-hook voice clients
(clients that are not on a call) after period of inactivity. Without the forced
disassociation feature, if an AP has reached its call admission control limits and an
on-hook voice client wants to start a new call, that client may be denied. If forced
disassociation is enabled, those clients can associate to a neighboring AP that can
fulfill their QoS requirements.

Default: Disabled

Measurement
Mode for
Beacon
Reports

Click the Measurement Mode for Beacon Reports drop-down list and specify
one of the following measurement modes:

l active-all-ch—Enables active beacon measurement mode. In this mode, the
client sends a probe request to the broadcast destination address on all
supported channels, sets a measurement duration timer, and, at the end of the
measurement duration, compiles all received beacons or probe response with
the requested SSID and BSSID into a measurement report.

l active-ch-rpt—In this mode, the client and returns a report that contains a list
of channels in a regulatory class where a client is likely to find an AP, including
the AP transmitting the AP channel report.

l beacon-table—Enables beacon-table beacon measurement mode. In this
mode, the client measures beacons and returns a report with stored beacon
information for any supported channel with the requested SSID and BSSID. The
client does not perform any additional measurements.

Table 76: 802.11k Profile Parameters
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Parameter Description

l passive—Enables passive beacon measurement mode. In this mode, the client
sets a measurement duration timer, and, at the end of the measurement
duration, compiles all received beacons or probe response with the requested
SSID and BSSID into a measurement report.

NOTE: If a station doesn't support the selected measurement mode, it returns a
Beacon Measurement Report with the Incapable bit set in the Measurement
Report Mode field.

Default Mode: beacon-table

Channel for
Beacon
Requests in 'A'
band

This value is sent in the 'Channel' field of the beacon requests on the 'A' radio. You
can specify values in the range 34 to 165. The default value is 36.

Channel for
Beacon
Requests in 'BG'
band

This value is sent in the 'Channel' field of the Beacon Requests on the 'BG' radio.
You can specify values in the range 1 to 14. The default value is 1.

Channel for AP
Channel
Reports in 'A'
band

This value is sent in the 'Channel' field of the AP channel reports on the 'A' radio.
You can specify values in the range 34 to 165. The default value is 36.

Channel for AP
Channel
Reports in 'BG'
band

This value is sent in the 'Channel' field of the AP channel reports on the 'BG' radio.
You can specify values in the range 1 to 14. The default value is 1.

Time duration
between
consecutive
Beacon
Requests

This option configures the time duration between two consecutive beacon
requests sent to a dot11K client. By default, the beacon requests are sent to a
dot11K client every 60 seconds. However, if a different value is required, the bcn-

req-time option can be used.

This permits values in the range from 10 seconds to 200 seconds. A value of 0 is
used to indicate that the generation of Beacon Request frames is turned off.

Time duration
between
consecutive
Link
Measurement
Requests

This option configures the time duration between two consecutive link
measurement requests sent to an dot11K client. By default, link measurement
requests are sent to a dot11K client every 61 seconds.

This parameter permits values in the range from 10 seconds to 200 seconds. A
value of 0 is used to indicate that the generation of Link Measurement Request
frames is turned off.

Time duration
between
consecutive
Transmit
Stream
Measurement
Request

This option configures the time duration between two consecutive transmit stream
measurement requests sent to a dot11K client. By default, the transmit stream
measurement requests are sent to a dot11K client every 90 seconds.

This permits values in the range from 10 seconds to 200 seconds. A value of 0 is
used to indicate that the generation of Transmit Stream Measurement Request
frames is turned off.



In the CLI
Use the following command to configure 802.11k profiles. The available parameters for this profile are
described in Table 76.
(host)[node](config)#wlan dotllk-profile <profile-name>

Configuring Radio Resource Management Information Elements
ArubaOS supports the following radio resource management information elements (RRM IEs) for APs with
802.11k support enabled. These settings can be enabled through the WebUI or CLI.

In the WebUI
To select the RRM IEs to be sent in beacons and probe responses using the WebUI:

1. Navigate to Configuration>System>Profiles.

2. Expand the Wireless LAN menu and select RRM IE.

3. Select the RRM IE profile you want to configure, or create a new profile by clicking + and entering a name for
the new profile in the Profile Name field.

4. Select any of the following IE types to enable that information element in beacons and probe responses. (All
IE types are sent by default.)

Parameter Description

Advertise Enabled
Capabilities IE

This value is used to determine if the RRM Enabled Capabilities IE
should be advertised in the beacon frames. A value of "Enabled"
allows the RRM Enabled Capabilities IE to be present in the beacon
frames when 802.11K capability is enabled. A value of "Disabled"
prevents the advertisement of the RRM Enabled Capabilities IE in the
beacon frames when 802.11K capability is enabled.

Advertise Country IE This value is used to determine if the Country IE should be advertised
in the beacon frames. A value of "Enabled" allows the Country IE to be
present in the beacon frames when 802.11K capability is enabled. A
value of "Disabled" prevents the advertisement of the Country IE in
the beacon frames when 802.11K capability is enabled.

Advertise Power Constraint IE This value is used to determine if the Power Constraint IE should be
advertised in the beacon frames. A value of "Enabled" allows the
Power Constraint IE to be present in the beacon frames when 802.11K
capability is enabled. A value of "Disabled" prevents the
advertisement of the Power Constraint IE in the beacon frames when
802.11K capability is enabled.

Advertise TPC Report IE This value is used to determine if the TPC Report IE should be
advertised in the beacon frames. A value of "Enabled" allows the TPC
Report IE to be present in the beacon frames when 802.11K capability
is enabled. A value of "Disabled" prevents the advertisement of the
TPC Report IE in the beacon frames when 802.11K capability is
enabled.

Table 77: RRM IE Parameters
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Parameter Description

Advertise QBSS Load IE This value is used to determine if the QBSS Load IE should be
advertised in the beacon frames. A value of "Enabled" allows the
QBSS Load IE to be present in the beacon frames when 802.11K
capability is enabled. A value of "Disabled" prevents the
advertisement of the QBSS Load IE in the beacon frames when
802.11K capability is enabled. The default value is "Enabled".

Advertise BSS AAC IE This value is used to determine if the BSS Available Admission
Capacity IE should be advertised in the beacon frames. A value of
"Enabled" allows the BSS Available Admission Capacity IE to be
present in the beacon frames when 802.11K capability is enabled. A
value of "Disabled" prevents the advertisement of the BSS Available
Admission Capacity IE in the beacon frames when 802.11K capability
is enabled.

Advertise Quiet IE This value is used to determine if the Quiet IE should be advertised in
the beacon frames. A value of "Enabled" allows the Quiet IE to be
present in the beacon frames when 802.11K capability is enabled. A
value of "Disabled" prevents the advertisement of the Quiet IE in the
beacon frames when 802.11K capability is enabled.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
To use the CLI to configure radio resource management information elements in the RRM IE profile, access the
CLI in config mode and issue the following command:

(host)[node] (config)#wlan rrm-ie-profile <profile>

Configuring Beacon Report Requests
The beacon report requests are sent only to 802.11k-compliant clients that advertise Beacon Report Capability
in their RRM Enabled Capabilities IE. The beacon request frames are sent every 60 seconds.

The content of the report requests can be defined in the Beacon Report Request profile using the WebUI or
CLI.

In the WebUI
To select the information to be sent in beacon report requests using the WebUI:

1. Navigate to Navigate to Configuration>System>Profiles.

2. Expand the Wireless LAN menu and select Beacon Report Request.

3. Select the Beacon Report Request profile you want to configure or create a new profile by clicking + and
entering a name for the new profile in the Profile Name field.

4. Define the settings described in the table below.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.



Table 78: Beacon Report Request Settings

Parameter Description

Interface This field is used to specify the Radio interface for transmitting the Beacon Report
Request frame. It can have a value of either 0 or 1. The default value is 1.

Regulatory Class This option is used to specify the Regulatory Class field in the Beacon Report
Request frame. It can be set to one of the following: -

l 1 (for 5 GHz band)

l 12 (for 2.4 GHz band)

Channel This option is used to set the Channel field in the Beacon Report Request frame.
The Channel value can be set to one of the following: - the channel of the AP (when
Measurement Mode is set to either 'Passive' or 'Active-All channels') - 0 (when
Measurement Mode is set to 'Beacon Table') - 255 (when Measurement Mode is
set to 'Active-Channel Report')

Randomization
Interval

This value is used to set the Randomization Interval field in the Beacon Report
Request frame. The Randomization Interval is used to specify the desired
maximum random delay in the measurement start time. It is expressed in units of
TUs (Time Units). A Randomization Interval of 0 in a measurement request
indicates that no random delay is to be used. This field can be given a value in the
range (0, 65535). The default value is 0.

Measurement
Duration

This value is used to set the Measurement Duration field in the Beacon Report
Request frame. The Measurement Duration is set to the duration of the requested
measurement. It is expressed in units of TUs. This field can be given a value in the
range (0, 65535). The default value is 0.

Measurement
Mode for Beacon
Reports

Click the Measurement Mode for Beacon Reports drop-down list and specify
one of the following measurement modes:

l active-all-ch-—Enables active beacon measurement mode. In this mode, the
client sends a probe request to the broadcast destination address on all
supported channels, sets a measurement duration timer, and, at the end of the
measurement duration, compiles all received beacons or probe response with
the requested SSID and BSSID into a measurement report.

l active-ch-rpt—In this mode, the client and returns a report that contains a list
of channels in a regulatory class where a client is likely to find an AP, including
the AP transmitting the AP channel report.

l beacon-table—Enables beacon-table beacon measurement mode. In this
mode, the client measures beacons and returns a report with stored beacon
information for any supported channel with the requested SSID and BSSID. The
client does not perform any additional measurements.

l passive—Enables passive beacon measurement mode. In this mode, the client
sets a measurement duration timer, and, at the end of the measurement
duration, compiles all received beacons or probe response with the requested
SSID and BSSID into a measurement report.

NOTE: If a station doesn't support the selected measurement mode, it returns a
Beacon Measurement Report with the Incapable bit set in the Measurement
Report Mode field. Default Mode: beacon-table

Reporting Condi-
tion

This option is used to indicate the value for the "Reporting Condition" field in the
Beacon Reporting Information sub-element present in the Beacon Report Request
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Parameter Description

frame. It can have a range from 0 to 255. The default value is 0.

ESSID name This option is used to indicate the value for the "SSID" field in the Beacon Report
Request frame. It corresponds to the SSID Name for which the Beacon Report
Request frame needs to be generated. It is a string with a minimum length of 1 and
a maximum length of 32.

Reporting Detail This option is used to indicate the value for the "Detail" field in the Reporting Detail
sub-element present in the Beacon Report Request frame. It is set to "Disabled" by
default.

Measurement
Duration
Mandatory

This value is used to set the "Duration Mandatory" bit of the Measurement
Request Mode field of the Beacon Report Request frame. The default value is
"Disabled".

Request
Information
values

This option is used to indicate the contents of the Request Information IE that could
be present in the Beacon Report Request frame. The Request Information IE is
present for all Measurement Modes except the 'Beacon Table' mode. It consists of
a list of Element IDs that should be included by the client in the response frame.

In the CLI
To select the information to be sent in beacon report requests using the command-line interface, access the
CLI in config mode and issue the following commands.
(host)[node] (config)wlan bcn-rpt-req-profile <profile>

Configuring Traffic Stream Measurement Report Requests
The Traffic Stream Measurement (TSM) report requests are sent only to 802.11k- compliant clients that
advertise a traffic stream report capability. The TSM report request frames are sent every 60 seconds. The
content of the report requests can be defined in the TSM Report Request profile using the WebUI or CLI.

In the WebUI
To select the information to be sent in TSM report requests using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration>System>Profiles.

2. Expand the Wireless LAN menu and select TSM Report Request.

3. Select the TSM Report Request profile you want to configure or create a new profile by clicking + and
entering a name for the new profile in the Profile Name field.

4. Define the settings described in the table below.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.



Table 79: TSM Report Request Settings

Parameter Description

Request Mode for TSM
Report Request

Select one of the following request modes:

l normal

l triggered

This value is used to determine the request mode for the Transmit
Stream/Category Measurement Request frame. A Transmit
Stream/Category Measurement Request frame can be sent in either
normal mode or triggered mode. There are two options for this parameter
normal and triggered. When the triggered option is selected, the Transmit
Stream/Category Measurement Request frame is sent only when the
trigger condition occurs. The default value for this field is normal.

Number of repetitions This value is used to set the "Number of Repetitions" field in the Transmit
Stream/Category Measurement Request frame. The Number of
Repetitions field contains the requested number of repetitions for all the
Measurement Request elements in this frame. A value of zero in this field
indicates Measurement Request elements are executed once without
repetition. A value of 65535 in the Number of Repetitions field indicates
Measurement Request elements are repeated until the measurement is
cancelled or superseded. This field has values in the range (0, 65535). The
default value is 65535.

Duration Mandatory This value is used to set the "Duration Mandatory" bit of the Measurement
Request Mode field of the Transmit Stream/Category Measurement
Request frame. The default value is enabled.

Randomization Interval This value is used to set the Randomization Interval field in the Transmit
Stream/Category Measurement Request frame. The Randomization
Interval is used to specify the desired maximum random delay in the
measurement start time. It is expressed in units of TUs (Time Units). When
the request mode for the Transmit Stream/Category Measurement
Request frame is set to "triggered", the Randomization Interval is not used
and is set to 0. A Randomization Interval of 0 in a measurement request
indicates that no random delay is to be used. This field can be given a value
in the range (0, 65535). The default value is 0.
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Parameter Description

Measurement Duration This value is used to set the Measurement Duration field in the Transmit
Stream/Category Measurement Request frame. The Measurement Duration
is set to the duration of the requested measurement. It is expressed in units
of TUs. When the request mode for the Transmit Stream/Category Meas-
urement Request frame is set to triggered, the Measurement Duration field
should be set to 0. This field can be given a value in the range (0, 65535). The
default value is 9776.

Traffic ID The value is used to set the Traffic Identifier field in the Transmit Stream/Cat-
egory Measurement Request frame. The Traffic Identifier field contains the
TID subfield. The TID subfield indicates the TC or TS for which traffic is to be
measured. This field can be given a value in the range (0, 255). The default
value is 96

Bin 0 Range This value is used to set the 'Bin 0 Range' field in the Transmit Stream/Cat-
egory Measurement Request frame. Bin 0 Range indicates the delay range of
the first bin (Bin 0) of the Transmit Delay Histogram, expressed in units of
TUs. This field can be given a value in the range (0, 255). The default value is
6.

In the CLI
To select the information to be sent in TSM report requests using the command-line interface, access the CLI in
config mode and issue the following command.

(host)[node](config) #wlan tsm-req-profile <profile>

BSS Transition Management (802.11v)
BSS Transition Management enables an AP to request a voice client to transition to a specific AP, or suggest a
set of preferred APs to a voice client, due to network load balancing or BSS termination. This helps the voice
client identify the best AP to which that client should transition to as that client roams. ArubaOS supports BSS
Transition Management features defined by the 802.11v standard.

Both the 802.11v BSS transition management features and the 802.11k radio resource manatement features are
disabled by default. To enable both of these features, select the Advertise 802.11k Capability option in an 802.11k
profile.

Frame Types
BSS Transition Management uses the following frame types:

l Query: A Query frame is sent by the voice client that supports BSS transition management requesting a
BSS transition candidate list to its associated AP, if the associated AP indicates that it supports the BSS
transition capability.

l Request: An AP that supports BSS Transition Management responds to a BSS Transition Management
Query frame with a BSS Transition Management Request frame. The AP may also send an unsolicited BSS
Transition Management Request frame to a voice client at any time, if the client supports the BSS Transition
Management capability. The Request frame also contains a Disassociation flag. If the flag is set, then the AP
forcefully disassociates the client after 10 beacon intervals.

l Response: A Response frame is sent by the voice client back to the AP, informing whether it accepts or
denies the transition.



802.11k and 802.11v clients
For 802.11k capable clients, the client management framework uses the actual beacon report generated by the
client in response to a beacon report request sent by the AP. This beacon report replaces the virtual beacon
report for that client. For 802.11v capable clients, the controller uses the 802.11v BSS Transition message to
steer clients to the desired AP upon receiving a client steer trigger from the AP.

Fast BSS Transition ( 802.11r)
ArubaOS provides support for Fast BSS Transition as part of the 802.11r implementation. Fast BSS Transition
mechanism minimizes the delay when a voice client transitions from one BSS to another within the same ESS.
Fast BSS Transition establishes security and QoS states at the target AP before or during a re-association. This
minimizes the time required to resume data connectivity when a BSS transition happens.

The following table provides the modes in which Fast BSS Transition is supported:

VAP Forwarding Mode Support for 802.11r

Tunnel Mode Yes

Decrypt-Tunnel Mode Yes

Split-Tunnel Mode No

Bridge Mode Beta quality

Table 80: Supported VAP Forwarding Modes

Important Points to Remember
l Fast BSS Transition is operational only if the wireless client has support for 802.11r standard. If the client

does not have support for 802.11r standard, it falls back to normal WPA2 authentication method.

l If dot11r is enabled, iOS clients such as iPad/iPhone gen1 (limitation on iOS) and all MAC-OS clients
(limitation on MAC) fail to connect to the network.

Configuring Fast BSS Transition
To enable and configure Fast BSS Transition on a configuration node, you must can create and configure an
802.11r profile using the WebUI or CLI.

Fast BSS transition is operational only with WPA2-Enterprise or WPA2-Personal.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles window.

2. In the All Profiles list, expand the Wireless LAN menu, then select 802.11r.

3. To edit an existing 802.11r profile, c select the 802.11r profile you want to edit. To create a new 802.11r
Profile, click + and enter a name for the new 802.11r profile name in the profile name field.

4. Configure the following 802.11r radio settings.

a. Select the Advertise 802.11r Capability option to allow Virtual APs using this profile to advertise
802.11r capability.
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b. Enter the mobility domain ID value (1-65535) in the 802.11r Mobility Domain ID field. The default
value is 1.

c. Enter the R1 Key timeout value in seconds (60-86400) for decrypt-tunnel or bridge mode in the 802.11r
R1 Key Duration field. The default value is 3600.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
Create an 802.11r profile using the following command:

(host)[node](config) #wlan dot11r-profile <profile> dot11r

Troubleshooting Fast BSS Transition
ArubaOS provides various troubleshooting options to verify the Fast BSS Transition functionalities.

In decrypt-tunnel mode and bridge mode, each r0 key generates up to four r1 keys and the managed device
pushes each r1 key to the corresponding AP. The following commands help verifying the pushing functionality:

Execute the following command to view all the r1 keys that are stored in an AP:
(host)[node](config) #show ap debug dot11r state

You can use the following command to remove an r1 key from an AP when the AP does not have a cached r1
key during Fast BSS Transition roaming:
(host)[node] #ap debug dot11r remove-key

Execute the following command to view the hit/miss rate of r1 keys cached on an AP before a Fast BSS
Transition roaming. This counter helps to verify if enough r1 keys are pushed to the neighboring APs.
(host)(config) #show ap debug dot11r efficiency <client-mac>

WLAN SSID Profiles
A Service Set Identifier (SSID) is the network or WLAN that any client sees. A SSID profile defines the name of
the network, authentication type for the network, basic rates, transmit rates, SSID cloaking, and certain WMM
settings for the network.

SSID Profile Overview
ArubaOS supports different types of the Advanced Encryption Standard (AES), Temporal Key Integrity Protocol
(TKIP), and wired equivalent privacy (WEP) encryption. AES is the most secure and recommended encryption
method. Most modern devices are AES capable and AES should be the default encryption method. Use TKIP
only when the network includes devices that do not support AES. In these situations, use a separate SSID for
devices that are only capable of TKIP.

Suite-B Cryptography
The Suite-B (bSec) protocol is a pre-standard protocol that has been proposed to the IEEE 802.11 committee as
an alternative to 802.11i. The main difference between bSec and standard 802.11i is that bSec implements
Suite-B algorithms wherever possible. Notably, AES-CCM is replaced by AES-GCM, and the Key Derivation
Function (KDF) of 802.11i is upgraded to support SHA-256 and SHA-384. In order to provide interoperability
with standard Wi-Fi software drivers, bSec is implemented as a shim layer between standard 802.11 Wi-Fi and a
Layer 3 protocol such as IP. A managed device configured to advertise a bSec SSID will advertise an open
network, however only bSec frames will be permitted on the network.



This feature requires the ACR license.

The bSec protocol requires that you use VIA 2.1.1 or greater on the client device. Consult VIA documentation
for more information on configuring and installing VIA.

The bSec protocol is available in 128-bit mode and 256-bit mode. The number of bits specifies the length of the
AES-GCM encryption key. Using United States Department of Defense classification terminology, bSec-128 is
suitable for protection of information up to the SECRET level, while bSec-256 is suitable for protection of
information up to the TOP SECRET level.

Suite-B AES-128-GCM and AES-256-GCM encryption is supported by the ArubaOS hardware.

Wi-Fi Multimedia Protection
Wi-Fi Multimedia™ (WMM®) is a Wi-Fi Alliance® certification program that is based on the IEEE 802.11e
amendment. WMM ensures QoS for latency-sensitive traffic in the air. WMM divides the traffic into four
queues or access categories:

l voice

l video

l best effort

l background

Management Frame Protection
ArubaOS supports the IEEE 802.11w standard, also known as Management Frame Protection (MFP). MFP
makes it difficult for an attacker to deny service by spoofing Deauth and Disassoc management frames.
MFP uses 802.11i (Robust Security Network) framework that establishes encryption keys between the client
and AP.

MFP is configured on a virtual AP (VAP) as part of the wlan ssid-profile. There are two parameters that can be
configured, mfp-capable and mfp-required. Both are disabled by default.

MFP can only be enabled on SSIDs that support WPA2. MFP is not supported on virtual APs using tunnel forwarding
mode.

Configuring the SSID Profile
Follow the procedures below to create a new SSID profile and associate that profile to your Virtual AP.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > All Profiles.

2. In the Profiles list, expand the Wireless LAN menu, then select SSID.

3. Select the existing SSID profile from the Profile Details pane, or create a new profile by clicking + and
entering a name for the new profile in the Profile Name field.

4. Configure the SSID profile parameters described in Table 81.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.
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Parameter Description

SSID Enable Click this check box to enable or disable the SSID. The SSID is enabled by
default.

ESSID Name that uniquely identifies a wireless network. The network name, or ESSID
can be up to 31 characters. If the ESSID includes spaces, you must enclose it
in quotation marks.

Encryption Select one of the following encryption types:

    xSec Encryption and tunneling of Layer-2 traffic between the controller and wired
or wireless clients, or between controllers. To use xSec encryption, you must
use a RADIUS authentication server. For clients, you must install the Funk
Odyssey client software.

Requires installation of the xSec license. For xSec between managed devices,
you must install an xSec license in each managed device.

    opensystem No authentication and encryption.

    static-wep WEP with static keys.

    dynamic-wep WEP with dynamic keys.

    wpa-tkip WPA with TKIP encryption and dynamic keys using 802.1X.

    wpa-aes WPA with AES encryption and dynamic keys using 802.1X.

    wpa-psk-tkip WPA with TKIP encryption using a preshared key.

    wpa-psk-aes WPA with AES encryption using a preshared key.

    wpa2-aes WPA2 with AES encryption and dynamic keys using 802.1X.

    wpa2-psk-aes WPA2 with AES encryption using a preshared key.

    wpa2-psk-tkip WPA2 with TKIP encryption using a preshared key.

    wpa2-tkip WPA2 with TKIP encryption and dynamic keys using 802.1X.

    wpa2-aes-gcm-128 WPA2 with AES GCM-128 (Suite-b) encryption and dynamic keys using 802.1X.

NOTE: This parameter requires the ACR license. For further information on
Suite-B encryption, see Suite-B Cryptography on page 424.

    wpa2-aes-gcm-256 WPA2 with AES GCM-256 (Suite-b) encryption and dynamic keys

using 802.1X.

Table 81: SSID Profile Parameters



Parameter Description

NOTE: This parameter requires the ACR license. For further information on
Suite-B encryption, see Suite-B Cryptography on page 424.

Enable Management
Frame Protection

When selected, the SSID supports MFP-capable and traditional clients.

NOTE: MFP can only be enabled on SSIDs that support WPA2.

Require Management
Frame Protection

When selected, the SSID supports MFP-capable clients only.

NOTE: MFP can only be enabled on SSIDs that support WPA2.

DTIM Interval Specifies the interval, in milliseconds, between the sending of Delivery Traffic
Indication Messages (DTIMs) in the beacon. This is the maximum number of
beacon cycles before unacknowledged network broadcasts are flushed. When
using wireless clients that employ power management features to sleep, the
client must revive at least once during the DTIM period to receive broadcasts

802.11a Basic Rates Select the set of supported 802.11a rates, in Mbps, that are advertised in
beacon frames and probe responses.

802.11a Transmit Rates Select the set of 802.11a rates at which the AP is allowed to send data. The
actual transmit rate depends on what the client is able to handle, based on
information sent at the time of association and on the current error/loss rate
of the client.

802.11g Basic Rates Select the set of supported 802.11b/g rates that are advertised in beacon
frames and probe responses.

802.11g Transmit Rates Select the set of 802.11b/g rates at which the AP is allowed to send data. The
actual transmit rate depends on what the client is able to handle, based on
information sent at the time of association and on the current error/loss rate
of the client.

Station Ageout Time Time, in seconds, that a client is allowed to remain idle before being aged out.

Max Transmit Attempts Maximum number of retries allowed for the AP to send a frame.

RTS Threshold Wireless clients transmitting frames larger than this threshold must issue
Request to Send (RTS) and wait for the AP to respond with Clear to Send (CTS).
This helps prevent mid-air collisions for wireless clients that are not within
wireless peer range and cannot detect when other wireless clients are
transmitting.

The default value is 2333 bytes.

Table 81: SSID Profile Parameters
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Parameter Description

Short Preamble Click this check box to enable or disable a short preamble for 802.11b/g
radios. Network performance may be higher when short preamble is enabled.
In mixed radio environments, some 802.11b wireless client stations may
experience difficulty associating with the AP using short preamble. To use
only long preamble, disable short preamble. Legacy client devices that use
only long preamble generally can be updated to support short preamble.

Max Associations Maximum number of wireless clients per radio for the SSID (subject to an AP
limit of 255 clients per radio).

The supported range is 0-255 clients. Default value is 64.

Wireless Multimedia
(WMM)

Enables or disables WMM, also known as IEEE 802.11e Enhanced Distribution
Coordination Function (EDCF). WMM provides prioritization of specific traffic
relative to other traffic in the network.

Wireless Multimedia U-
APSD (WMM-UAPSD)
Powersave

Enable Wireless Multimedia (WMM) UAPSD powersave.

WMM TSPEC Min
Inactivity Interval

Specify the minimum inactivity time-out threshold of WMM traffic. This setting
is useful in environments where low inactivity interval time-outs are
advertised, which may cause unwanted timeouts.

The supported range is 0-3,600,000 milliseconds, and the default value is 0
milliseconds.

Override DSCP
mappings for WMM
clients

Override the default DSCP mappings in the SSID profile with the ToS value.
This setting is useful when you want to set a non-default ToS value for a
specific traffic.

DSCP mapping for WMM
voice AC

DSCP used to map WMM voice traffic.

The supported range is 0-63.

DSCP mapping for WMM
video AC

Select the DSCP used to map WMM video traffic.

The supported range is 0-63.

DSCP mapping for WMM
best-effort AC

Select the DSCP value used to map WMM best-effort traffic.

The supported range is 0-63.

DSCP mapping for WMM
background AC

Select the DSCP used to map WMM background traffic.

The supported range is 0-63.

Hide SSID Select this check box to enable or disable the hiding of the SSID name in
beacon frames. Note that hiding the SSID does very little to increase security.

Table 81: SSID Profile Parameters
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Deny_Broadcast Probes When a client sends a broadcast probe request frame to search for all
available SSIDs, this option controls whether or not the system responds for
this SSID. When enabled, no response is sent and clients have to know the
SSID in order to associate to the SSID. When disabled, a probe response
frame is sent for this SSID.

Local Probe Request
Threshold (dB)

Enter the SNR threshold below which incoming probe requests will get
ignored. The supported range of values is 0-100 dB. A value of 0 disables this
feature.

Disable Probe Retry Click this check box to enable or disable battery MAC level retries for probe
response frames. By default this parameter is enabled, which mean that MAC
level retries for probe response frames is disabled.

NOTE: This parameter is not supported for 200 Series access points.

Battery Boost Converts multicast traffic to unicast before delivery to the client, thus allowing
you to set a longer DTIM interval. The longer interval keeps associated
wireless clients from activating their radios for multicast indication and
delivery, leaving them in power-save mode longer and thus lengthening
battery life.

This parameter requires the PEFNG license.

WEP Key 1 First static WEP key associated with the key index. Can be 10 or 26 hex
characters in length.

WEP Key 2 Second static WEP key associated with the key index. Can be 10 or 26 hex
characters in length.

WEP Key 3 Third Static WEP key associated with the key index. Can be 10 or 26 hex
characters in length.

WEP Key 4 Fourth Static WEP key associated with the key index. Can be 10 or 26 hex
characters in length.

WEP Transmit Key Index Key index that specifies which static WEP key is to be used. Can be 1, 2, 3, or 4.

WPA Hexkey WPA pre-shared key (PSK).

WPA Passphrase WPA passphrase with which to generate a pre-shared key (PSK).

Maximum Transmit
Failures

The AP assumes the client has left and should be deauthorized when the AP
detects this number of consecutive frames were not delivered because the
maximum retry threshold as been exceeded.

Table 81: SSID Profile Parameters
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BC/MC Rate
Optimization

Click this check box to enable or disable scanning of all active stations
currently associated to an AP to select the lowest transmission rate for
broadcast and multicast frames. This option only applies to broadcast and
multicast data frames; 802.11 management frames are transmitted at the
lowest configured rate.

NOTE: Do not enable this parameter unless instructed to do so by your Aruba
technical support representative.

Rate Optimization for
delivering EAPOL frames

Click this check box to use a more conservative rate for more reliable delivery
of EAPOL frames.

Strict Spectralink Voice
Protocol (SVP)

Click this check box to enable Strict Spectralink Voice Protocol (SVP)

802.11g Beacon Rate Click this drop-down list to select the beacon rate for 802.11g (use for
Distributed Antenna System (DAS) only). Using this parameter in normal
operation may cause connectivity problems.

802.11a Beacon Rate Click this drop-down list to select the beacon rate for 802.11a (use for
Distributed Antenna System (DAS) only). Using this parameter in normal
operation may cause connectivity problems.

Video Multicast Rate
Optimization

When configured, the controller chooses the rate for video multicast frames.
You can configure Modulation Coding Scheme (MCS) rates as well. MCS is an
important setting because it provides for potentially greater throughput.

NOTE: The following information displays the MCS rate if the Short guard
interval in 20 MHz mode setting in High-throughput SSID profile is either
enabled or disabled:

MCS Streams 20 MHz 20 MHz SGI

--- ------- ------ ----------

0 1 6.5 7.2

1 1 13.0 14.4

2 1 19.5 21.7

3 1 26.0 28.9

4 1 39.0 43.3

5 1 52.0 57.8

6 1 58.5 65.0

7 1 65.0 72.2

8 2 13.0 14.4

9 2 26.0 28.9

10 2 39.0 43.3

11 2 52.0 57.8

12 2 78.0 86.7

13 2 104.0 115.6

14 2 117.0 130.0

15 2 130.0 144.4

NOTE: The MCS rates for video multicast are supported in all 802.11n -
capable APs. This is not supported in 320 Series AP.
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Advertise QBSS Load IE Click this check box to enable the AP to advertise the QBSS load element. The
element includes the following parameters that provide information on the
traffic situation:

l Station count: The total number of stations associated to the QBSS.

l Channel utilization: The percentage of time (normalized to 255) the
channel is sensed to be busy. The access point uses either the physical or
the virtual carrier sense mechanism to sense a busy channel.

l Available admission capacity: The remaining amount of medium time
(measured as number of 32us/s) available for a station via explicit
admission control.

The QAP uses these parameters to decide whether to accept an admission
control request. A wireless station uses these parameters to choose the
appropriate access points.

NOTE: Ensure that WMM is enabled for legacy APs to advertise the QBSS
load element. For 802.11n APs, ensure that either WMM or high throughput is
enabled.

Advertise Location
Information

When this option is enabled, APs broadcast their location within a IE carried in
Beacon frames and Probe Response frames. The AP’s latitude, longitude and
altitude can be configured on the Configuration > Wireless> AP
Installation page of the controller WebUI, or using the provision-ap
command in the controller command-line interface.

Advertise AP Name If this parameter is enabled, APs will broadcast the AP name configured by
the ap-name command. This option is disabled by default.

Enforce User VLAN for
Open Stations

Select this option to restrict data traffic from open stations to the user's
assigned VLAN. This option is disabled by default.

Enable OKC Opportunistic Key Caching (OKC) is a similar technique, not defined by
802.11i, available for authentication between multiple APs in a network where
those APs are under common administrative control. AnAruba deployment
with multiple APs under the control of a single controller is one such example.
Using OKC, a station roaming to any AP in the network will not have to
complete a full authentication exchange, but will instead just perform the 4-
way handshake to establish transient encryption keys.

Table 81: SSID Profile Parameters

In the CLI
(host)[node](config) #wlan ssid-profile <profile>

WLAN Authentication
The WLAN Wizard allows you to define the type of authentication used by clients associating to a WLAN. The
WLAN wizard is the recommend method for defining WLAN settings, but advanced users can also define
authentication settings manually via the AAA profile in the WebUI or command-line interfaces.

Configuring an AAA Profile in the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > Authentication > AAA Profiles.

2. Click + to define AAA profile settings for the selected configuration node.
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3. Enter a name for the profile in the Profile name field, then configure the AAA profile parameters described
in Table 82.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

Parameter Description

Initial role Click the Initial Role drop-down list and select a role for
unauthenticated users. The default role for unauthenticated users
is logon.

MAC Authentication Default
Role

Click the MAC Authentication Default Role drop-down list and
select the role assigned to the user when the device is MAC
authenticated. The default role for MAC authentication is the guest
user role. If derivation rules are present, the role assigned to the
client through these rules take precedence over the default role.

NOTE: This feature requires the PEFNG license.

802.1X Authentication Default
Role

Click the 802.1X Authentication Default Role drop-down list and
select the role assigned to the client after 802.1X authentication.
The default role for 802.1X authentication is the guest user role. If
derivation rules are present, the role assigned to the client through
these rules take precedence over the default role.

NOTE: This feature requires the PEFNG license.

User idle timeout Select the Enable check box to configure user idle timeout value
for this profile. Specify the idle timeout value for the client in
seconds. A value of 0, deletes the user immediately after
disassociation from the wireless network. Valid range is 30-15300
in multiples of 30 seconds. Enabling this option overrides the global
settings configured in the AAA timers. If this is disabled, the global
settings are used.

RADIUS Interim Accounting When this option is enabled, the RADIUS accounting feature allows
the managed device to send Interim-Update messages with
current user statistics to the server at regular intervals. This option
is disabled by default, allowing the managed device to send only
start and stop messages to the RADIUS accounting server.

User derivation rules Click the User derivation rules drop-down list and specify a user
attribute profile from which the user role or VLAN is derived.

Wired to Wireless Roaming Enable this feature to keep users authenticated when they roam
from the wired side of the network. This feature is enabled by
default.

SIP authentication role Click the SIP authentication role drop-down list and specify the
role assigned to a session initiation protocol (SIP) client upon
registration.

NOTE: This feature requires the PEFNG license.

Table 82: AAA Profile Parameters



Parameter Description

Device Type Classification When you select this option, the managed device will parse user-
agent strings and attempt to identify the type of device connecting
to the AP. When the device type classification is enabled, the Global
client table shown in the Monitoring>Network > All WLAN
Clients window shows each client’s device type, if that client device
can be identified.

Enforce DHCP When you select this option, clients must obtain an IP using DHCP
before they are allowed to associate to an AP. Enable this option
when you create a user rule that assigns a specific role or VLAN
based upon the client device’s type. For details, see Working with
User-Derived VLANs on page 375.

NOTE: If a client is removed from the user table by the “Logon user
lifetime” AAA timer, then that client will not be able to send traffic
until it renews it’s DHCP.

NOTE: Enforce DHCP is available on the managed device for APs
configured for tunnel or decrypt-tunnel forwarding mode only.

PAN firewalls Integration Requires IP mapping at Palo Alto Networks firewalls. For details, see
Palo Alto Networks Firewall Integration on page 619.

Open SSID RADIUS Accounting Initiates RADIUS accounting as soon as the user associates to an
Open SSID without any authentication.

NOTE: Do not enable this parameter for wired users. If enabled,
the managed device sends RADIUS accounting packets for
unauthenticated wired users.

Configuring an AAA Profile in the CLI
(host)[node](config) #aaa authentication dot1x <profile>

(host)[node](config) #aaa profile <profile>
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Chapter 23
RF Planning and Channel Management

AirMatch is the next generation radio resource management service introduced in ArubaOS 8.0. AirMatch
provides RF network resource allocation with unprecedented quality. It analyzes the past 24 hours of RF
network statistics and proactively optimizes the network for the next day. Any RF plan change is applied in the
early morning to minimize client disruption and maximize the user experience. AirMatch can react to
detrimental RF events, such as radar and high noise levels, to allow the network to manage sudden changes in
the RF environment.

Stand-alone controllers support only the Adaptive Radio Management (ARM) and ClientMatch features, which
use automatic, infrastructure-based controls to maximize client performance and enhance the stability and
predictability of the W-Fi network.

AirMatch and ARM cannot be used together. Stand-alone controllers do not support AirMatch RF planning. A Mobility
Master deployment that includes managed devices does not support Adaptive Radio Management.

RF Management for Mobility Master Deployments with Managed Devices
The following sections provide a general overview of the RF management used by a multi-
controller deployment managed by Mobility Master.

l AirMatch RF Management Overview on page 434

l ClientMatch Overview on page 436

The sections below describe the procedures to configure AirMatch and ClientMatch:

l Configuring AirMatch on page 438

l Configuring ClientMatch on page 440

RF Management for Deployments with a Stand-alone Controller
The following sections provide a general overview of the RF management used by stand-alone controllers:

l RF Management for Stand-alone Controller Deployments on page 441

l ClientMatch Overview on page 436

The sections below describe the steps to configure advanced ARM settings and troubleshoot common
ARM issues:

l ARM Coverage and Interference Metrics on page 446

l Configuring ARM Profiles on page 447

l Troubleshooting ARM on page 453

AirMatch RF Management Overview
The AirMatch channel and EIRP optimization features deprecate the channel planning and EIRP optimization
features in the legacy Adaptive Radio Management (ARM) feature. AirMatch is supported on Mobility Master
only, while legacy ARM channel optimization and EIRP features continue to be supported by stand-alone
controllers running ArubaOS 8.0.

AirMatch channel planning evens out channel distributions in any size of network, and in any subset of the
contiguous network (as much as allowed by the network configuration, regulatory domain, and AP hardware
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capability). AirMatch also minimizes channel coupling, where adjacent radios are assigned to the same channel.
The computing power of Mobility Master impacts channel distribution calculations, so channel coupling may
occasionally be allowed in complex networks to keep the computing time practical. The more powerful the
processing power of the Mobility Master server, the less channel coupling will be allowed by AirMatch.

AirMatch EIRP planning automatically considers the local density of the network to manage the APs' coverage
and modulation and coding scheme (MCS) operation, and optimizes EIRP changes across neighboring AP radios
in order to offer users the best roaming experience.

Table 83 describes some of the differences between the channel and EIRP optimization features supported by
ArubaOS AirMatch and ArubaOS ARM.

Features AirMatch ARM

Initial Release ArubaOS 8.0 ArubaOS 2.x

Supported Topology Mobility Master / Managed
device

Stand-alone controller

Run Period 24 hours As little as 5 minutes

RF information used Past 24 hours of RF data Instantaneous snapshot of the RF
environment

Deployment Time 5 AM (by default) , or any time
necessary

Any time necessary

Computing Time 10 seconds to 1 hour,
depending upon network size

Less than 1 second

Optimization Scope The entire RF network Each individual AP

Table 83: AirMatch and ARM in ArubaOS

The AirMatch Database and Initial RF Calculations
Each AP in a Mobility Master deployment measures its RF environment for a five minute period, every 30
minutes. The AP then sends AMON messages about the radio feasibility to the managed device based on that
AP's hardware capability, radio and regulatory domain, and RF neighbors. The managed device forwards these
messages to the Mobility Master. The Mobility Master adds this information to a database, computes an
optimal solution, and deploys the latest RF plan by sending updated settings to the APs every 24 hours. By
default, this configuration update is sent at 5 AM (as per the Mobility Master system clock), but time of this
configuration update can be modified via the AirMatch profile.

An exception to this daily update is an automatic channel change due to a radar detection event or high noise
interference. If an AP detects a radar event on its current operating channel, that AP automatically changes to
another supported channel to avoid radar interference, and does not wait for the daily RF configuration update from
the Mobility Master. An AP may also automatically change channels if a very high noise level is detected on the
current channel, if at least one other channel is free of noise.

The database for the AirMatch service is empty when Mobility Master first boots up. When Mobility Master first
detects APs on the network, it enters its initial optimization phase, collects data from all the APs, and generates
an incremental solution every 30 minutes for the next eight hours. When this initial eight-hour period has
elapsed, the AirMatch service calculates a new RF configuration for these devices every 24 hours.



When a new AP is deployed on a network with an active Mobility Master during the initial 8-hour AirMatch
optimization phase, that AP joins the network with its preassigned channel and transmission power values. The
AirMatch service detects the newly deployed AP on the network, restarts its RF computations, and sends an
incremental RF configuration update to the new AP 30 minutes later. APs added to the network after the initial
8-hour optimization period will not receive an additional RF configuration update until the next scheduled
update period.

ClientMatch Overview
ClientMatch continually monitors a client's RF neighborhood to provide ongoing client bandsteering and load
balancing, and enhanced AP reassignment for roaming mobile clients.

Legacy 802.11a/b/g devices do not support ClientMatch. When you enable ClientMatch on 802.11n-capable devices,
ClientMatch overrides any settings configured for the legacy bandsteering or load balancing features. 802.11ac-
capable devices do not support the legacy bandsteering, station hand off or load balancing settings, so these APs
must be managed on using ClientMatch.

The managed device aggregates information it receives from all APs using ClientMatch, and maintains
information for all associated clients in a database. The managed device shares this database with the APs (for
their associated clients), and the APs use the information to compute the client-based RF neighborhood and
determine which APs should be considered candidate APs for each client. When the managed device receives a
client steer request from an AP, the managed device identifies the optimal AP candidate and manages the
client’s relocation to the desired radio. This is an improvement from previous releases, where ARM was
managed exclusively by APs, without the larger perspective of the client's RF neighborhood.

In Mobility Master/managed device deployments where APs are connected to a managed device that is
associated to Mobility Master, the AP sends RF neighborhood information to the managed device, which then
forwards that information to the Mobility Master. The Mobility Master receives probe reports from all
managed devices and generates a Virtual Beacon Report (VBR) for each client. These VBRs are sent from the
Mobility Master to the managed device, and then to the AP to which the client is associated. APs associated to a
stand-alone controller receive and collect information about clients in their neighborhood, and periodically
send this information to the controller, which in turn generates VBRs and sends them directly back to the APs.

The following client/AP mismatch conditions are managed by ClientMatch:

l Load Balancing: ClientMatch balances clients across APs on different channels, based upon the client load
on the APs and the SNR levels that the client detects from an underused AP. If an AP radio can support
additional clients, the AP will participate in ClientMatch load balancing, and clients can be directed to that AP
radio, subject to predefined SNR thresholds.

l Sticky Clients: ClientMatch also helps mobile clients that tend to stay associated to an AP despite low
signal levels. APs using ClientMatch continually monitor the client's RSSI as it roams between APs, and
moves the client to an AP when a better radio match is found. This prevents mobile clients from remaining
associated to an APs with a less than ideal RSSI, which can cause poor connectivity and reduce performance
for other clients associated with that AP.

l Band Steering/Band Balancing: APs using the ClientMatch feature monitor the RSSI for clients that
advertise dual-band capability. If a client is currently associated to a 2.4 GHz radio, and the AP detects that
the client has a good RSSI from the 5 Ghz radio, the managed device attempts to steer the client to the 5
GHz radio, as long as the 5 GHz RSSI is not significantly worse than the 2.4 GHz RSSI, and the AP retains a
suitable distribution of clients on each of its radios.
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Incremental Rules-Based ClientMatch Updates
The ClientMatch rules that manage client associations are based primarily upon the client's RF environment
and apply uniformly to all client types, regardless of device type or operating system. ArubaOS 8.0 supports
incremental updates to ClientMatch rules to support network devices running newer operating systems that
may be incompatible with the existing ClientMatch client association rules. This feature allows the managed
device to use a newer set of ClientMatch rules without updating the entire operating system, reducing network
downtime.

BSS Transition Management Support
The BSS Transition Management Support feature allows ClientMatch to steer devices using 802.11v BSS
transition management standards for continuous wireless connectivity. This feature provides a seamless
standards-compatible method of device steering in wireless networks, as 802.11v BSS transition management
support has become increasingly common in wireless devices.

When ClientMatch attempts to steer the client to a more optimal AP, it sends out an 802.11v BSS transition
management request to the 11v capable station and waits for a response.

1. ClientMatch begins a timeout session for the BSS transition management response or new association
request to the desired AP.

2. If the request is rejected or the timeout session expires, ClientMatch is notified of the failed attempt and
reinitiates the steer using the 802.11v BSS transition management request.

n If the client steer fails the maximum number of timeout attempts (default: 5), ClientMatch marks the
client as 11v unsupported and falls back to using deauths to steer.

n If the client steer fails due to request rejection, ClientMatch does not mark the client as 11v unsupported
and continues to attempt to steer using the 802.11v BSS transition management request.

Multi-Media Sync-Up
ClientMatch offers a tighter integration with multiple media-aware ALGs to provide better call quality for
programs like Skype for Business (Skype4b) and Facetime. With ClientMatch’s ability to understand various
media protocols, clients are not steered to different APs in the middle of an active media session.

When a client participates in a call, the managed device learns about the media session and sends this
information to the AP to which the client is currently associated, as part of the variable bitrate (VBR) update.
When the AP learns that the client is in a call, it will not attempt to steer the client to another AP until the
managed device indicates that the call has ended, allowing calls to run more smoothly without any disruptions
to the ongoing media flow.

Multi-User MIMO Steering
Multi-user MIMO, or MU-MIMO Steering, groups multi-user-capable (MU-capable) clients to maximize the
likelihood of MIMO transmissions, which increases downstream throughput performance in 802.11ac Wave 2
(gen 2) APs. MU-MIMO runs on MU-capable clients with traffic flows and PHY channels compatible for multi-
user transmissions. ClientMatch steers and aligns MU-MIMO-capable clients with MU-MIMO-capable radios
using SNR values. Multiple MU-MIMO-capable clients can be grouped together on a MU-MIMO-capable radio.

Successful MU-MIMO transmissions depend on the following:

l Traffic streams that can be multiplexed for MIMO transmissions. This is dependent on packet length and
traffic flow rates (packet arrival rates) from APs to the devices.

l MU-MIMO-capable clients associated to the same radio, whose PHY channel matrices are compatible for
simultaneous multi-user transmissions



In an 802.11ac AP deployment, clients indicate VHT capabilities for probe requests and association requests,
including MU-MIMO support. The APs and managed devices use this information to determine whether the
client is MU-MIMO-capable.

After the MU-MIMO-capable clients are located, they are steered to an appropriate MU-MIMO-capable radio.
MU-MIMO Steering ensures that steers are compatible with existing trigger thresholds, such as sticky clients
and load-balancing. The multi-user SNR threshold of the target radio must be greater than the sticky client SNR
threshold, and radios that exceed the client threshold are avoided to prevent the need for load-balancing.

Removing VBR Dependency on Probe Requests
ClientMatch has shifted its dependency on probe requests to the Air Monitor (AM) data feeds for virtual
beacon report (VBR) data. Instead of relying solely on client background scans during probe requests, which
can cause limitations due to low scanning frequency, ClientMatch uses AM data feeds to gain more continuous,
comprehensive client RSSI feeds. Along with probe requests, Air Monitor data feeds collect client information
during AP scanning using the following frames:

l Block ACK

l Management frames

l NULL data frames

l Data frames with rates no higher than 36Mbps

l Control frames

Configuring AirMatch
The range of RF settings that can be assigned to an the AP via the AirMatch feature is defined in the 2.4 GHz
and 5 GHz radio profiles on the managed device. You can access these settings on the Mobility Master WebUI
by selecting the configuration for the managed device from the configuration hierarchy, then navigating to the
Configuration > AP Groups > Radio and Configuration > Access Points > Radio pages. Use these pages
to specify the radio mode and range of channels and maximum channel bandwidth that can be assigned to an
AP or AP group via an AirMatch solution. The AirMatch feature will not assign an AP a channel that does not fall
within the group of valid channels or channel bandwidth ranges allowed by that AP's 2.4 GHz and 5 GHz radio
profile.

The AirMatch feature performs automatic daily updates by default, but you can use the Mobility Master WebUI
or command-line interface to disable daily updates for APs at one or more configuration nodes, allowing those
APs and retain their existing RF configuration. If the AirMatch updates are changed from the default enabled
setting to disabled, the Mobility Master continues to receive RF updates from the APs and calculate an
optimized RF solution. However,these changes are not pushed to the APs.

The AirMatch disabled setting is different from the ARM disable or maintain setting. The ARM disable setting
changes the AP radio's channel and EIRP values back to the default values specified in the AP radio's 802.11a and
802.11g radio profiles. The ARM maintain setting freezes the radio's current channel and EIRP settings. In contrast,
AirMatch's enabled option simply means the centralized algorithm will stop selecting a new channel, bandwidth, or
EIRP setting; the network operator still can override the previous settings assigned by AirMatch with static channel or
EIRP values, and the AP radio can continue to voluntarily change channels to avoid radar interference or high noise
levels.

You can use the WebUI or command-line interface to define the most commonly used AirMatch configuration
settings, but some advanced AirMatch settings are only available via the command-line interface.

In the WebUI
To hold the existing AirMatch RF configuration and disable future updates:
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1. In the Mobility Master node hierarchy, navigate to Configuration > Services > More > AirMatch.

2. Select Disabled from the AirMatch drop-down list.

3. Click Submit.

4. Select Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To change the time of the daily AirMatch RF updates:

1. In the Mobility Master node hierarchy, navigate to Configuration > Services > More > AirMatch.

2. In the Activation Time field, enter a number from 0-23 to specify an update hour (in 24-hour format).

3. Click Submit.

4. Select Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To hold the existing AirMatch RF configuration :
(host) [mynode] (config) #airmatch profile schedule disable

To change the time of the daily AirMatch RF updates from the default 5 AM to 2 AM:
(host) [mynode] (config) #airmatch profile deploy-hour 2

Use the Mobility Master command-line interface to manually initiate AirMatch RF computations and solution
deployment instead of waiting for the next scheduled update period. Access the command-line interface in
enable mode and issue the following command:
(host) [mynode] #airmatch runnow full

The airmatch ap freeze command deploys the specified channel and EIRP values to a radio immediately,
then freezes those values, regardless of whether the AirMatch RF planning feature is set to enable or disable
mode. A radio set with the airmatch ap freeze command uses a static radio configuration until those settings
get explicitly canceled with the airmatch ap unfreeze command. This command can be used to freeze either
the channel or the EIRP value, or both values. For example, you can freeze the channel on an AP radio, while
allowing the EIRP values to be updated by AirMatch.
(host) [mynode] (config) #airmatch ap freeze {ip-addr <ip-addr>}|{ip6-addr <ip6-addr>}|{ap-

name <ap-name>}|{ap-group <ap-group>}|{all-aps} [band <band>] [all-params] [channel <channel>]

[eirp <eirp>]

Unfreezing a radio configuration with the airmatch ap unfreeze command does not mean that there will
automatically be an immediate change in the radio's channel and EIRP values. It does, however, mean that the
AirMatch algorithm can assign a new set of values at the next update.
(host) [mynode] (config) #airmatch ap unfreeze {ip-addr <ip-addr>}|{ip6-addr <ip6-addr>}|{ap-

name <ap-name>}|{ap-group <ap-group>}|{all-aps} band <band> [all-params] [channel] [eirp]

By default, each AP in a Mobility Master deployment measures its RF environment for a five minute duration,
every 30 minutes.  Mobility Master uses this information to compute an optimal solution, then deploys the
latest RF plan by sending updated settings to the APs every 24 hours. Use the ap system profile command to
modify these default report intervals, or to disable AirMatch reports to the APs.
(host) [mynode] (config) #ap system-profile <profile>

airmatch-measure-duration <airmatch-measure-duration>

airmatch-report-enabled

airmatch-report-period <airmatch-report-period>



Configuring ClientMatch
Use the following procedures to disable or reenable ClientMatch, and upload a Rules-Based ClientMatch
(RCBM) update package.

Enabling and Disabling ClientMatch
ClientMatch is enabled by default. The procedure to disable and reenable ClientMatch varies, depending upon
whether your deployment consists of multiple managed devices managed by a Mobility Master, or whether
your APs are all associated to a stand-alone controller.

Mobility Master Deployments
ClientMatch is enabled and disabled in the AP group's 2.4 GHz and 5 GHz radio settings.

1. In the Managed Network node hierarchy, navigate to the Configuration > AP Groups page.

2. Select the name of an AP group from the AP Groups table.

3. Click the Radio tab below the AP Groups table to display the AP radio settings.

4. Expand the Client Control section.

5. Click the Client-Match drop-down lists for the 2.4 GHz and 5 GHz radios to enable or disable ClientMatch
for these radios.

6. Modify the desired settings, and then click Submit.
7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

For more information on managing 2.4 GHz and 5 Ghz radio settings, see 2.4 Ghz and 5 Ghz Radio RF
Management on page 523.

Stand-alone Controller Deployments
For stand-alone controllers that do not have any associated managed devices, the ClientMatch feature is
enabled and disabled in the AP's Adaptive Radio Management (ARM) profile, as described in Configuring ARM
Profiles on page 447. Although default ClientMatch settings are recommended for most users, advanced
ClientMatch settings can be configured using rf arm-profile commands in the command-line interface.

Uploading a Custom Client-Match Rule Update Package
Use the WebUI or command line interface to upload a custom update file of ClientMatch rules to the
/flash/config folder on Mobility Master. This feature is not available for stand-alone controller deployments.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Services > More.

2. Expand the Client-Match Rules section.

3. Click Upload Custom Rules Files, and then select a file to upload.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
(host) [mynode] (config) #copy tftp: <tftphost> <filename> flash: <destname>

(host) [mynode] (config) #copy ftp: <ftphost> <user> <password> flash: <destname>

(host) [mynode] (config) #copy scp: <scphost> <username> <password> flash: <destname>
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RF Management for Stand-alone Controller Deployments
Aruba's Adaptive Radio Management (ARM) technology maximizes WLAN performance even in the highest
traffic networks by dynamically and intelligently choosing the best 802.11 channel and transmit power for
each Aruba AP in its current RF environment.

Aruba’s ARM technology solves wireless networking challenges for stand-alone controllers in a large network
deployment, dense deployment, or a network that must support VoIP or mobile users. Deployments with
dozens of users per access point can cause network contention and interference, but ARM dynamically
monitors and adjusts the network to ensure that all users are allowed ready access.

ARM continually monitors and adjusts radio resources to provide optimal network performance for APs
associated to a stand-alone controller. Automatic power control can adjust AP power settings if adjacent APs
are added, removed, or moved to a new location within the network, minimizing interference with other WLAN
networks. ARM adjusts only the affected APs, so the entire network does not require systemic changes.

This section describes the following features:

l Adaptive Radio Management (ARM) Monitoring and Management on page 441

l Traffic Shaping on page 444

Adaptive Radio Management (ARM) Monitoring and Management
When ARM is enabled, the Aruba AP dynamically scans all 802.11 channels in its regulatory domain at regular
intervals and will report everything it sees to the controller on each channel it scans (by default,
802.11n-capable APs scan channels in all regulatory domains). This includes, but is not limited to, data
regarding WLAN coverage, interference, and intrusion detection. You can retrieve this information from the
controller to get a quick health check of your WLAN deployment without having to walk around every part of a
building with a network analyzer. For additional information on the individual matrix gathered on the AP’s
current assigned RF channel, see ARM Coverage and Interference Metrics on page 443.

Maintaining Channel Quality
Hybrid APs and Spectrum Monitors determine channel quality by measuring channel noise, non-Wi-Fi
(interferer) utilization and duty-cycles, and certain types of retries. Regular APs using ARM derive channel
quality values by measuring the noise floor for both 802.11 and non-802.11 noise on that channel.

The ARM algorithm is based on what the individual AP hears, so each AP on your WLAN can effectively “self
heal” by compensating for changing scenarios like a broken antenna or blocked signals from neighboring APs.
Additionally, ARM periodically collects information about neighboring APs to help each AP better adapt to its
own changing environment.

Configuring ARM Scanning
The default ARM scanning interval is determined by the scan-interval parameter in the ARM profile. If the AP
does not have any associated clients (or if most of its clients are inactive), ARM will dynamically readjust this
default scan interval, allowing the AP to obtain better information about its RF neighborhood by scanning non-
home channels more frequently. If an AP attempts to scan a non-home channel but is unsuccessful, the AP will
make additional attempts to rescan that channel before skipping it and continuing on to other channels.

The Over the Air Updates feature allows an AP to get information about its RF environment from its
neighbors, even if the AP cannot scan. If you enable this feature, when an AP on the network scans a foreign
(non-home) channel, it sends an Over-the-Air (OTA) update in an 802.11 management frame that contains
information about that AP's home channel, the current transmission EIRP value of the home channel, and one-
hop neighbors seen by that AP.

If ARM reports a high noise floor on a channel within a 40 MHz channel pair or 80 MHz channel set, ARM
performs an additional 20 MHz scan on each channel within that channel pair or set, to determine the actual



noise floor of each affected channel. This allows ARM to avoid assigning the overused channel, while still
allowing channel assignments to the other unaffected channels in that channel pair or set.

Understanding ARM Application Awareness
Aruba APs keep a count of the number of data bytes transmitted and received by their radios to calculate the
traffic load. When a WLAN gets very busy and traffic exceeds a predefined threshold, load-aware ARM
dynamically adjusts scanning behavior to maintain uninterrupted data transfer on heavily loaded systems.
ARM-enabled APs will resume their complete monitoring scans when the traffic has dropped to normal levels.
You can also define a firewall policy that pauses ARM scanning when the AP detects critically important or
latency-sensitive traffic from a specified host or network.

ARM’s band steering feature encourages dual-band capable clients to stay on the 5 GHz band on dual-band
APs. This frees up resources on the 2.4 GHz band for single-band clients like VoIP phones.

The ARM “Mode Aware” option is a useful feature for single radio, dual-band WLAN networks with high density
AP deployments. If there is too much AP coverage, those APs can cause interference and negatively impact
your network. Mode aware ARM can turn APs into Air Monitors if necessary, then turn those Air Monitors back
into APs when they detect gaps in coverage. Note that an Air Monitor will not turn back into an AP if it detects
client traffic (or client traffic increases), but will change to an AP only if it detects coverage holes.

Using Multi-Band ARM for 802.11a/802.11g Traffic
It is recommended that you use the multi-band ARM assignment and Mode Aware ARM feature for single-
radio APs in networks with traffic in the 802.11a and 802.11g bands. This feature allows a single-radio AP to
dynamically change its radio bands based on current coverage on the configured band. This feature is enabled
via the AP's ARM profile.

When you first provision a single-radio AP, it initially operates in the radio band specified in its AP system
profile. If the AP finds adequate coverage on multiple channels in its current band of operation, the mode-
aware feature allows the AP to temporarily turn itself off and become an AP Air Monitor (APM). In AP Monitor
mode, the AP scans all channels across both bands to verify that each channel meets or exceeds its required
level of acceptable radio coverage (as defined by the in the ARM profile).

If the AP Monitor detects that a channel on the 802.11g band does not have adequate radio coverage, it will
convert back to an AP on that 802.11 channel. If the 802.11g band is adequately covered, the AP Monitor will
next check the 802.11a band. If a channel on the 802.11a band lacks coverage, the AP Monitor will convert
back to an AP on that 802.11a channel.

80MHz Dynamic Bandwidth Switch
If an AP radio uses an 80 MHz channel, the radio only sends out frames when the entire 80 MHz channel is
clear, even if the AP is sending only a 20 MHz management frame or 40 MHz data frame. As a result,
throughput on the selected 80 MHz channel can be negatively impacted if interference occurs on both 20 MHz
channels of the secondary 40 MHz channel.

The ARM dynamic bandwidth switch feature allows ARM to detect the 20 MHz interferers in this situation and
potentially move the AP radio to another 80 MHz channel, or change the AP transmissions to 40 MHz and use
the primary 40 MHz channel instead.

When this feature is enabled, ARM starts a dynamic bandwidth switch observation window if load-aware scan
rejects increase, and the clear channel assignment IBSS percentage (the percentage of channel traffic sent from
that AP radio) drops below the value defined by the dynamic-bw-cca-ibss-thresh parameter.

If an observation window opens, and the clear channel assignment interference threshold exceeds the value
defined by the dynamic-bw-cca- intf-thresh parameter, and the number of failed beacons from the radio
exceeds the threshold defined by the dynamic-bw-beacon- failed-thresh parameter during that observation
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period, ARM will move the AP to another available 80 MHz channel with the minimum interference index. If no
other 80 MHz channel si available, ARM downgrades the radio bandwidth to 40 MHz.

This feature is configured using the rf arm-profile command in the command-line interface. For more information
refer to the ArubaOS CLI Reference Guide.

ARM Coverage and Interference Metrics
ARM computes coverage and interference metrics for each valid channel and chooses the best performing
channel and transmit power settings for each AP’s RF environment. Each AP gathers other metrics on their
ARM-assigned channel to provide a snapshot of the current RF health state.

The following two metrics help the AP decide which channel and transmit power setting is best.

l Coverage Index: The AP uses this metric to measure RF coverage. The coverage index is calculated as x/y,
where “x” is the AP’s weighted calculation of the Signal-to-Noise Ratio (SNR) on all valid APs on a specified
802.11 channel, and “y” is the weighted calculation of the Aruba AP's SNR the neighboring APs see on that
channel.

To view these values for an AP in your current WLAN environment, issue the CLI command show ap arm
rf-summary ap-name <ap-name>, where <ap-name> is the name of an AP for which you want to view
information.

l Interference Index: The AP uses this metric to measure co-channel and adjacent channel interference. The
Interference Index is calculated as a/b/c/d, where:

l Metric value “a” is the channel interference the AP sees on its selected channel.

l Metric value “b” is the interference the AP sees on the adjacent channel.

l Metric value “c” is the channel interference the AP’s neighbors see on the selected channel.

l Metric value “d” is the interference the AP’s neighbors see on the adjacent channel.

To manually calculate the total Interference Index for a channel, issue the CLI command show ap arm rf-
summary ap-name <ap-name>, then add the values a+b+c+d.

Each AP also gathers the following additional metrics, which can provide a snapshot of the current RF health
state. View these values for each AP using the CLI command show ap arm rf-summary ip-addr <ap ip
address>.

l Amount of Retry frames (measured in %)

l Amount of Low-speed frames (measured in %)

l Amount of Non-unicast frames (measured in %)

l Amount of Fragmented frames (measured in %)

l Amount of Bandwidth seen on the channel (measured in kbps)

l Amount of PHY errors seen on the channel (measured in %)

l Amount of MAC errors seen on the channel (measured in %)

l Noise floor value for the specified AP

Cellular Handoff Assist
Some dual-network-capable devices, such as mobile phones, prefer to connect to Wi-Fi networks and may
remain associated to a Wi-Fi network even when they experience poor performance at the edge of the Wi-Fi
coverage area. When both the ClientMatch and the cellular handoff assist features are enabled, the cellular
handoff assist feature can help a dual-mode, 3G/4G-capable Wi-Fi device, such as an iPhone, iPad, or Android
client at the end of a Wi-Fi network, switch from Wi-Fi to an alternate 3G/4G radio that provides better network
access. This feature is supported by iOS and Android devices only.



This feature is enabled via the Virtual AP profile for an AP or AP group. For more information on Virtual AP
profiles and other WLAN configuration settings, see Basic WLAN Configuration Workflow on page 399

Traffic Shaping
In a mixed-client network, it is possible for slower clients to bring down the performance of the whole network.
To solve this problem and ensure fair access to all clients independent of their WLAN or IP stack capabilities, an
AP can implement the traffic shaping feature. This feature has the following three options:

l default-access: Traffic shaping is disabled, and client performance is dependent on MAC contention
resolution. This is the default traffic shaping setting.

l fair-access: Each client gets the same airtime, regardless of client capability and capacity. This option is
useful in environments like a training facility or exam hall, where a mix of 802.11a/g, 802.11g and 802.11n
clients need equal to network resources, regardless of their capabilities.

l preferred-access: High-throughput (802.11n) clients do not get penalized because of slower 802.11a/g or
802.11b transmissions that take more air time due to lower rates. Similarly, faster 802.11a/g clients get
more access than 802.11b clients.

With this feature, an AP keeps track of all BSSIDs active on a radio, all clients connected to the BSSID, and
802.11a/g, 802.11b, or 802.11n capabilities of each client. During every sampling period, airtime is allocated to
each client, giving it the opportunity to receive traffic. The specific amount of airtime given to an individual
client is determined by the following factors:

l Client capabilities (802.11a/g, 802.11b or 802.11n).

l Amount of time the client spent receiving data during the last sampling period.

l Number of active clients in the last sampling period.

l Activity of the current client in the last sampling period.

The bw-alloc parameter of a traffic management profile allows you to set a minimum bandwidth to be
allocated to a virtual AP profile when there is congestion on the wireless network. You must set traffic shaping
to fair-access to use this bandwidth allocation value for an individual virtual AP.

Traffic shaping is configured in an traffic management profile. You can use the CLI or WebUI to enable and
configure traffic shaping.

In the WebUI
To configure traffic shaping via the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Select QoS from the All Profiles list to expand the QoS section.

3. Select the Traffic management profile.

4. In the Profiles Details window, select the name of the traffic management profile for which you want to
configure traffic shaping. If you do not have any traffic management profiles configured, click + and enter a
name for a new profile.

The following table describes configuration settings available in the General and Advanced sections of the
traffic management profile.
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Parameter Description

General Settings

Station Shaping
Policy

Define Station Shaping Policy This feature has the following three options:

l default-access: Traffic shaping is disabled, and client performance is dependent on
MAC contention resolution. This is the default traffic shaping setting.

l fair-access: Each client gets the same airtime, regardless of client capability and
capacity. This option is useful in environments like a training facility or exam hall,
where a mix of 802.11a/g, 802.11g, and 802.11n clients need equal to network
resources, regardless of their capabilities. The bw-alloc parameter of a traffic
management profile allows you to set a minimum bandwidth to be allocated to a
virtual AP profile when there is congestion on the wireless network. You must set
traffic shaping to fair-access to use this bandwidth allocation value for an individual
virtual AP.

l preferred-access: High-throughput (802.11n) clients do not get penalized because
of slower 802.11a/g or 802.11b transmissions that take more air time due to lower
rates. Similarly, faster 802.11a/g clients get more access than 802.11b clients.

Advanced Settings

Proportional
BW Allocation

You can allocate a maximum bandwidth, as a percentage of available bandwidth to a
virtual AP (VAP).

To assign a percentage of bandwidth to a virtual AP:
1. Click + in the Proportional BW Allocation table.
2. Select the VAP profile to which you would like to allocate a bandwidth share from the

virtual_ap drop-down list.
3. Specify the percentage of bandwidth to be allocated to the VAP in the share field.
4. Click the hard_limit drop-down list and select the mode for restricting the bandwidth

for the VAP. Select the soft limit check box if you want to restrict the bandwidth for
this VAP when there is a congestion on the wireless network. If you do want to restrict
the bandwith even when here there is congestion, select the hard limit option.

5. Click OK.
6. Repeat steps 1-5 to assign any remaining bandwidth to additional VAPs, if desired.
To remove a VAP from the list of VAPs with allocated bandwidth, select the VAP from
the Proportional BW Allocation table and click Delete.

Report Interval Number of minutes between bandwidth usage reports.

Range: 1-99 minutes

Default value is 5 minutes.

Table 84: Traffic Management Profile Parameters

7. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
To enable and configure traffic shaping via the command-line interface, access the CLI in config mode and issue
the following commands:
(host) [mynose] (config) #wlan traffic-management-profile <profile> shaping-policy default-

access|fair-access|preferred-access



Use the following commands to apply an 802.11a or 802.11g traffic management profile to an AP group or an
individual AP.
(host) [mynode] (config) #ap-group <name> dot11a-traffic-mgmt-profile|dot11g-traffic-mgmt-

profile <profile>

ARM Coverage and Interference Metrics
ARM computes coverage and interference metrics for each valid channel, and chooses the best performing
channel and transmit power settings for each AP’s RF environment. Each AP gathers other metrics on their
ARM-assigned channel to provide a snapshot of the current RF health state.

The following two metrics help the AP decide which channel and transmit power setting is best:

l Coverage Index: The AP uses this metric to measure RF coverage. The coverage index is calculated as x/y,
where “x” is the AP’s weighted calculation of the Signal-to-Noise Ratio (SNR) on all valid APs on a specified
802.11 channel, and “y” is the weighted calculation of the Aruba AP's SNR the neighboring APs see on that
channel.

To view these values for an AP in your current WLAN environment, issue the CLI command show ap arm
rf-summary ap-name <ap-name>, where <ap-name> is the name of an AP for which you want to view
information.

l Interference Index: The AP uses this metric to measure co-channel and adjacent channel interference. The
Interference Index is calculated as a/b/c/d, where:

l Metric value “a” is the channel interference the AP sees on its selected channel.

l Metric value “b” is the interference the AP sees on the adjacent channel.

l Metric value “c” is the channel interference the AP’s neighbors see on the selected channel.

l Metric value “d” is the interference the AP’s neighbors see on the adjacent channel.

To manually calculate the total Interference Index for a channel, issue the CLI command show ap arm rf-
summary ap-name <ap-name>, then add the values a+b+c+d.

Each AP also gathers the following additional metrics, which can provide a snapshot of the current RF health
state. View these values for each AP using the CLI command show ap arm rf-summary ip-addr <ap ip
address>.

l Amount of Retry frames (measured in %)

l Amount of Low-speed frames (measured in %)

l Amount of Non-unicast frames (measured in %)

l Amount of Fragmented frames (measured in %)

l Amount of Bandwidth seen on the channel (measured in kbps)

l Amount of PHY errors seen on the channel (measured in %)

l Amount of MAC errors seen on the channel (measured in %)

l Noise floor value for the specified AP

The following enhancements are introduced in ArubaOS 8.0 to resolve issues that occur with the distributed
channel/power algorithm:

l Push random channel assignments to APs: To support the random channel assignment feature, set
the Assignment parameter in the ARM profile to maintain. Once this is done, random channels are
pushed from the managed device STM/SAPM to APs that belong to a specific ap-group. This helps in
replacing the dynamic channel change solution in a high density environment, thereby overcoming the issue
with convergence. Random channel assignment helps in certain customer deployments where
administrators want to control channels assigned and also for initial channel assignment to seed ARM
channel computation.
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l Reduce interference channel change: To reduce the number of interference channel changes and to
configure the weight of interfering APs when calculating the interference index, the interfering-ap-weight
parameter is introduced in the rf-arm-profile command. Before this enhancement was introduced, the
value of the interfering AP (uncontrollable AP) was similar to the valid AP (controllable AP).

Configuring ARM Profiles
ARM profile settings are divided into two categories: General, Scanning and Advanced. The general ARM
settings include general configuration parameters such as channel and power assignments and minimum and
maximum allowed EIRP values.

Most network environments do not require any changes to the Scanning or Advanced categories of ARM
configuration settings. If, however, your network supports a large amount of VoIP or Video traffic, or if you have
unusually high security requirements you may want to manually adjust the basic ARM thresholds.

Default Profiles
When you create a new AP group and modify any of the ARM settings for that group, ArubaOS creates a unique
profile for that AP group. The settings in these default profiles may vary, depending upon the radio type. The
default ARM profile for a 2.4 Ghz radio is Default-g, and the default profile for a5 Ghz radio is Default-a.

Manually Configuring an ARM Profile
The range of RF settings that can be assigned to an the AP is defined in the 2.4 GHz and 5 GHz radio profiles.
You can access these settings on the Mobility Master WebUI by selecting the configuration for the managed
device from the configuration hierarchy, then navigating to the Configuration > AP Groups > Radio page.
However, advanced ARM settings can be edited using the WebUI or command-line interface.

The ARM profile also includes advanced ClientMatch settings that can be configured through the command-line
interface only. The default values for these settings are recommended for most users, and caution should be used
when changing them to a non-default value. For complete details on all ClientMatch configuration settings, refer to
the ArubaOS CLI Reference Guide.

In the WebUI
To edit an ARM profile via the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Select RF Management from the All Profiles list, and then click Adaptive Radio Management (ARM).
3. Select the ARM profile you want to edit, or create a new profile by clicking + and entering a name for the

new profile in the Profile Name field. The ARM profile settings are divided into three sections, General,
Scanning and Advanced. The profile parameters in each section are described in Table 85.



Parameter Description Default

Basic

Assignment Activates one of four ARM channel/power assignment
modes.

l disable: Disables ARM calibration and reverts APs back
to default channel and power settings specified by the
AP’s radio profile.

l maintain: APs maintain their current channel and power
settings. This setting can be used to maintain AP channel
and power levels after ARM has initially selected the best
settings.

l multi-band: For single-radio APs, this value computes
ARM assignments for both 5 GHZ (802.11a) and 2.4 GHZ
(802.11b/g) frequency bands.

l single-band: For dual-radio APs, this value enables APs
to change transmit power and channels within their same
frequency band, and to adapt to changing channel
conditions.

single-band

Allowed
bands for
40MHz
channels

The specified setting allows ARM to determine if 40 MHz
mode of operation is allowed on the 5 GHz or 2.4 GHz
frequency band only, on both frequency bands, or on neither
frequency band.

a-only

80MHz
support

If enabled, this feature allows ARM to assign 80 MHz
channels on APs that support VHT.

enabled

Max Tx EIRP Maximum effective isotropic radiated power (EIRP) from 3 to
33 dBm in 3 dBm increments. You may also specify a special
value of 127 dBm for regulatory maximum. Higher power
level settings may be constrained by local regulatory
requirements and AP capabilities. In the event that an AP is
configured for a Max Tx EIRP setting it cannot support, this
value will be reduced to the highest supported power setting.

NOTE: Power settings will not change if the Assignment
option is set to disabled or maintain.

l default-a: 18 dBm

l default-g: 9 dBm

Min Tx EIRP Minimum effective isotropic radiated power (EIRP) from 3 to
33 dBm in 3 dBm increments. You may also specify a special
value of 127 dBm for regulatory maximum to disable power
adjustments for environments such as outdoor mesh links.
Note that power settings will not change if the Assignment
option is set to disabled or maintain. Higher power level
settings may be constrained by local regulatory
requirements and AP capabilities. In the event that an AP is
configured for a Min Tx EIRP setting it cannot support, this
value will be reduced to the highest supported power setting.

l default-a: 12 dBm

l default-g: 6 dBm

Table 85: ARM Profile Configuration Parameters
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Parameter Description Default

Consider configuring a Min Tx Power setting higher than the
default value if most of your APs are placed on the ceiling.
APs on a ceiling often have good line of sight between them,
which will cause ARM to decrease their power to prevent
interference. However, if the wireless clients down on the
floor do not have such a clear line back to the AP, you could
end up with coverage gaps.

ClientMatch The ClientMatch feature helps optimize network resources
by balancing clients across channels, regardless of whether
the AP or the managed device is responding to the wireless
clients' probe requests.

If enabled, the managed device compares whether an AP has
more clients than its neighboring APs on other channels. If an
AP’s client load is at or over a predetermined threshold as
compared to its immediate neighbors, or if a neighboring
Aruba AP on another channel does not have any clients, load
balancing will be enabled on that AP. This feature is enabled
by default. For details, see ClientMatch Overview on page
436.

Enabled

Scanning

Scanning The Scanning check box enables or disables AP scanning
across multiple channels. This check box is selected by
default. Do not disable scanning unless you want to disable
ARM and manually configure AP channel and transmission
power. Disabling this option also disables the following
scanning features:

l Multi Band Scan

l Rogue AP Aware

l Voip Aware Scan

l Power Save Scan

Enabled

Multi Band
Scan

If enabled, single radio channel APs scan for rogue APs
across multiple channels. This option requires that Scanning
is also enabled.

(The Multi Band Scan option does not apply to APs that
have two radios, as these devices already scan across
multiple channels. If one of these dual-radio devices are
assigned an ARM profile with Multi Band enabled, that device
will ignore this setting.)

Enabled

VoIP Aware
Scan

Aruba’s VoIP Call Admission Control (CAC) prevents any
single AP from becoming congested with voice calls. When
you enable CAC, you should also enable VoIP Aware Scan in
the ARM profile, so the AP will not attempt to scan a different
channel if one of its clients has an active VoIP call. This option
requires that Scanning is also enabled.

Enabled

Table 85: ARM Profile Configuration Parameters



Parameter Description Default

Power Save
Aware Scan

If enabled, the AP will not scan a different channel if it has
one or more clients that is in power save mode.

Disabled

Video Aware
Scan

As long as there is at least one video frame every 100 mSec
the AP will reject an ARM scanning request. Note that for
each radio interface, video frames must be defined in one of
two ways:

l Classify the frame as video traffic via a session ACL.

l Enable WMM on the WLAN’s SSID profile and define a
specific DSCP value as a video stream. Next, create a
session ACL to tag the video traffic with the that DSCP
value.

Enabled

Scan Mode By default, 802.11n-capable APs scan channels within all
regulatory domains. To limit the AP scans to just the
regulatory domain for that AP, click the Scan Mode drop-
down list and select reg-domain.

NOTE: This setting does not apply to APs that do not support
802.11n; these APs will scan their regulatory domain only.

all-reg-domain

Advanced

Client Aware If the Client Aware option is enabled, the AP does not
change channels if there is an active client associated to that
AP. (Activity is defined by the sta-inactivity-time parameter
in the IDS general profile. By default, a client is considered
active if it has sent or received traffic within the last 60
seconds.)

If you disable Client Aware , the AP may change to a more
optimal channel, but this change may also disrupt current
client traffic.

Enabled

Rogue AP
Aware

If you have enabled both the Scanning and Rogue AP
options, Aruba APs may change channels to contain off-
channel rogue APs with active clients. This security features
allows APs to change channels even if the Client Aware
setting is disabled.

This setting is disabled by default, and should only be
enabled in high-security environments where security
requirements are allowed to consume higher levels of
network resources. You may prefer to receive Rogue AP
alerts via SNMP traps or syslog events.

Disabled

Active Scan When you enable Active Scan, an AP initiates active
scanning via probe request. This option elicits more
information from nearby APs, but also creates additional
management traffic on the network. Active Scan is disabled
by default, and should not be enabled except under the direct
supervision of Aruba Support.

Disabled

Table 85: ARM Profile Configuration Parameters
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Parameter Description Default

ARM Over
the Air
Updates

The ARM Over the Air Updates option allows an AP to get
information about its RF environment from its neighbors,
even the AP cannot scan. If this feature is enabled, when an
AP on the network scans a foreign (non-home) channel, it
sends other APs an Over-the-Air (OTA) update in an 802.11
management frame that contains information about the
scanning AP's home channel, the current transmission EIRP
value of its home channel, and one-hop neighbors seen by
that AP.

Default: enabled

Enabled

Ideal
Coverage
Index

The Aruba coverage index metric is a weighted calculation
based on the RF coverage for all Aruba APs and neighboring
APs on a specified channel. The Ideal Coverage Index
specifies the ideal coverage that an AP should try to achieve
on its channel. The denser the AP deployment, the lower this
value should be.

Range: 2–20

For additional information on how this the Coverage Index is
calculated, see ARM Coverage and Interference Metrics on
page 443

l default-a: 6

l default-g: 6

Acceptable
Coverage
Index

For multi-band implementations, the Acceptable Coverage
Index specifies the minimal coverage an AP it should
achieve on its channel. The denser the AP deployment, the
lower this value should be.

Range: 1–6

4

Free
Channel
Index

The Aruba Interference index metric measures interference
for a specified channel and its surrounding channels. This
value is calculated and weighted for all APs on those
channels (including 3rd-party APs).

An AP will only move to a new channel if the new channel has
a lower interference index value than the current channel.
Free Channel Index specifies the required difference
between the two interference index values before the AP
moves to the new channel. The lower this value, the more
likely it is that the AP will move to the new channel. The range
of possible values is 10–40.

For additional information on how this the Channel Index is
calculated, see ARM Coverage and Interference Metrics on
page 443

l default-a: 40

l default-g: 25

Interfering
AP weight

Weight of interfering APs in the interference index calculation.

Range: 0-100

25

Backoff Time After an AP changes channel or power settings, it waits for
the backoff time interval before it asks for a new
channel/power setting.

Range: 120–3600 seconds.

240 sec

Table 85: ARM Profile Configuration Parameters
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Error Rate
Threshold

The minimum percentage of PHY errors and MAC errors in
the channel that will trigger a channel change.

l default-a: 70%

l default-g: 70%

Error Rate
Wait Time

Minimum time in seconds the error rate has to exceed the
Error Rate Threshold before it triggers a channel change.

l default-a: 90 sec

l default-g: 90 sec

Channel
Quality
Aware Arm

If this feature is enabled, ARM changes are based upon an
internally calculated channel quality metric. When this
feature is disabled, ARM initiates channel changes based on
thresholds defined in this profile, and chooses the channel
based on the calculated interference index value. Default:
Disabled

Disabled

Channel
Quality
Threshold

Channel quality percentage below which ARM initiates a
channel change.

Range: 0-100%

70%

Channel
Quality Wait
Time

If channel quality is below the specified channel quality
threshold for this wait time period, ARM initiates a channel
change.

Range:1-3600 seconds

120 seconds

Minimum
Scan Time

Minimum number of times a channel must be scanned
before it is considered for assignment. Range: 0–
2,147,483,647 scans. It is recommended to use a Minimum
Scan Time between 1–20 scans.

8 scans

Load Aware
Scan
Threshold

Load aware ARM preserves network resources during
periods of high traffic by temporarily halting ARM scanning if
the load for the AP gets too high.

The Load Aware Scan Threshold is the traffic throughput
level an AP must reach before it stops scanning.

Range: 0–20,000,000 bytes/second. (Specify 0 to disable this
feature.)

1250000 Bps

Mode Aware
ARM

If enabled, ARM will turn APs into Air Monitors (AMs) if it
detects higher coverage levels than necessary. This helps
avoid higher levels of interference on the WLAN. Although
this setting is disabled by default, you may want to enable
this feature if your APs are deployed in close proximity (less
than 60 feet apart).

Mode aware ARM turns Air Monitors back into APs when they
detect gaps in coverage. Note that an Air Monitor will not
turn back into an AP if it detects client traffic (or client traffic
increases), but will change to an AP only if it detects
coverage holes.

Disabled

Table 85: ARM Profile Configuration Parameters
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In the CLI
To create a new ARM profile or modify an existing profile via the command-line interface, access the CLI in
config mode and issue the following command:
(host) [mynode] (config) #rf arm-profile <profile>

Dynamic Bandwidth Switch
ARM’s dynamic bandwidth switch feature provides capability for ARM to detect the 20 MHz interferer by
reading the Clear Channel Assessment (CCA) statistics and other radio statistics. Once the signatures are
detected, ARM moves to another 80 MHz channel or downgrades to 40 MHz. This feature only works when
dynamic-bw parameter is enabled and ARM is set to use 80 MHz assignment.

If ARM decides to downgrade the bandwidth to 40 MHz, then it will upgrade back to 80 MHz after the clear time
based on the volume of the traffic.

Enabling Dynamic Bandwidth Switch
Use the following procedures to enable or disable dynamic bandwidth switch using command-line interfaces.

In the CLI
Use the following commands to enable and set dynamic bandwidth switch:
(host) [mynode] (config) #rf arm-profile default

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw-beacon-failed-

thresh

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw-cca-ibss-

thresh

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw-cca-intf-

thresh

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw-clear-time

(host) [mynode] (Adaptive Radio Management (ARM) profile "default") #dynamic-bw-wait-time

Troubleshooting ARM
If ARM is enabled but does not seem to be working properly, try some of the troubleshooting tips below.

Too many APs on the Same Channel
If many APs are selecting the same RF channel, there may be excessive interference on the other valid 802.11
channels. Issue the CLI commands show ap arm rf-summary ap-name <ap-name> or show ap arm rf-
summary ip-addr <ap ip address>and calculate the Interference index (intf_idx) for all the valid channels.

An AP will only move to a new channel if the new channel has a lower interference index value than the current
channel. The ARM Free Channel Index parameter specifies the required difference between two interference
index values. If this value is set too high, the AP will not switch channels, even if the interference is slightly lower
on another channel. Lower the Free Channel Index to improve the likelihood that the AP will switch to a better
channel.

Wireless Clients Report a Low Signal Level
If APs detect strong signals from other APs on the same channel, they may decrease their power levels
accordingly. Issue the CLI commands show ap arm rf-summary ap-name <ap-name> or show ap arm rf-
summary ip-addr <ap ip address>.



for all APs and check their current coverage index (cov-idx). If the AP’s coverage index is at or higher than the
configured coverage index value, then the APs have correctly chosen the transmit power setting. To manually
increase the minimum power level for the APs using a specific ARM profile, define a higher minimum value with
the command rf arm-profile <profile> min-tx-power <dBm>.

If wireless clients still report that they see low signal levels for the APs, check that the AP’s antennas are
correctly connected to the AP and correctly placed according to the manufacturer’s installation guide.

Transmission Power Levels Change Too Often
Frequent changes in transmission power levels can indicate an unstable RF environment, but can also reflect
incorrect ARM or AP settings. To slow down the frequency at which the APs change their transmit power, set
the ARM backoff time to a higher value.

APs Detect Errors but Do Not Change Channels
First, ensure that ARM error checking is enabled. The ARM Error Rate Threshold should be set to a percentage
higher than zero. The suggested configuration value for the ARM Error Rate Threshold is 30–50%.

APs Don’t Change Channels Due to Channel Noise
APs will only change channels due to interference if you enable ARM noise checking. Check to verify that the
ARM Noise Threshold is set to a value higher than 0 dBm. The suggested setting for this threshold is 75 dBm.
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Chapter 24
Wireless Intrusion Prevention

The ArubaOS Wireless Intrusion Prevention (WIP) features and configurations are discussed in this chapter.
WIP offers a wide selection of intrusion detection and protection features to protect the network against
wireless threats. The WIP configuration is done on Mobility Master in the network.

These features do not require an RFprotect license:

l Rogue AP classification techniques other than AP classification rules

l Rogue containment

l Wired containment

l Wireless containment without Tarpit

For details on commands see the Aruba Networks, Inc. CLI Reference Guide.

This chapter contains the following sections:

l Working with the Reusable Wizard on page 455

l Monitoring the Security Dashboard on page 456

l Detecting Rogue APs on page 457

l Working with Intrusion Detection on page 460

l Configuring Intrusion Protection on page 472

l Configuring the WLAN Management System (WMS) on page 475

l Understanding Client Blacklisting on page 481

l Working with WIP Advanced Features on page 484

l Configuring TotalWatch on page 484

l Administering TotalWatch on page 486

l Tarpit Shielding Overview on page 487

l Configuring Tarpit Shielding on page 487

Working with the Reusable Wizard
The WebUI’s reusable, intuitive, user-friendly Wizard provides steps to enable, define, or change

l Integrated vs Overlay WLAN/WIP options

l Detection features for attacks against infrastructure

l Detection features for attacks against WLAN clients

l Protection features for attacks against infrastructure

l Protection features for WLAN clients

Understanding Wizard Intrusion Detection
Apply the intrusion detection mechanisms for detecting attacks against your infrastructure and clients. You can
either set the detection level to automatically enable the appropriate detection mechanisms or customize the
settings for infrastructure and client attacks. Use the slider to select one of the detection levels for the
infrastructure and clients:

l High—Enables all the detection mechanisms applicable to your infrastructure, including all the options of
low and medium level settings.
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l Medium (Default)—Enables some important detection mechanisms for your infrastructure. This includes all
the options of the low level settings.

l Low—Enables only the most critical detection mechanisms for your infrastructure.

l Off—Disables all the detection mechanisms.

To enable custom settings, click Custom Settings for Infrastructure or Custom Settings for Client to
manually enable or disable the detection mechanisms for your infrastructure and clients. To revert to the
standard settings from the custom settings mode, click Revert to Standard Settings.

Understanding Wizard Intrusion Protection
Apply the intrusion protection mechanisms for your infrastructure and clients . You can set the protection level
to automatically enable the appropriate protection mechanisms or customize the settings for your
infrastructure and clients.

Protecting Your Infrastructure
Select the required protection settings for the infrastructure from the Settings for Infrastructure table. The
following protections options are available to choose:

l Protect misconfigured AP

l Protect from adhoc networks

l Protect from adhoc networks - enhanced

l Protect from adhoc networks using valid SSID

l Protect SSID

l Protect 802.11n high throughput devices

l Protect 40mhz 802.11n high throughput devices

l Protect from AP impersonation

l Protect from wireless hosted networks

l Rogue containment

l Suspected rogue containment

l Suspected rogue confidence level > 90

l Suspected rogue confidence level > 80

Protecting Your Clients
Select the required protection settings for the clients from the Settings for Client table. The following
protections options are available to choose:

l Protect valid stations

l Protect windows bridge

Monitoring the Security Dashboard
The Security page of Dashboard in the WebUI, allows you to monitor the detection and protection of wireless
intrusions in your network.

The dashboard’s two top tables— Discovered APs & Clients and Events—contain data as links. When these
links are clicked, they arrange, filter, and display the appropriate information in the lower table. For example, if
you click a number under the Active APs column , the bottom table will filter and arrange information about
those classified Rogue APs. Use the scroll bar at the right to view all the Rogue APs.



The term events in this document is meant to include security threats, vulnerabilities, attacks (intrusion or Denial of
Service) and other similarly related events.

The Event table contains data links. You can click on these data links to view information, in the bottom table,
related to the event you selected. You can use the scroll bar at the right to view all the events.

Detecting Rogue APs
The most important WIP functionality is the ability to classify an AP as a potential security threat. An AP is
considered to be rogue if it is both unauthorized and plugged in to the wired side of the network. An AP is
considered to be interfering if it is seen in the RF environment but is not connected to the wired network.

While the interfering AP can potentially cause RF interference, it is not considered a direct security threat since
it is not connected to the wired network. However, an interfering AP may be reclassified as a rogue AP.

Understanding Classification Terminology
APs and clients are discovered during scanning of the wireless medium, and they are classified into various
groups. The AP and client classification definitions are in Table 86 and Table 87.

Classification Description

Valid AP An AP that is part of the enterprise providing WLAN service.

Interfering AP An AP that is seen in the RF environment but is not connected to the wired
network. An interfering AP is not considered a direct security threat since it is not
connected to the wired network. For example, an interfering AP can be an AP that
belongs to a neighboring office’s WLAN but is not part of your WLAN network.

Neighbor AP A neighboring AP is when the BSSIDs are known. Once classified, a neighboring
AP does not change its state.

Rogue AP An unauthorized AP that is plugged into the wired side of the network.

Suspected-Rogue AP A suspected rogue AP is an unauthorized AP that may be plugged into the wired
side of the network.

Manually-contained
AP

An AP for which DoS is enabled manually.

Table 86: AP Classification Definition
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Classification Description

Valid Client Any client that successfully authenticates with a valid AP and passes encrypted
traffic is classified as a valid client.

Manually-contained
Client

Any clients for which DoS is enabled manually.

Interfering Client A client associated to any AP and is not valid.

Table 87: Client Classification Definitions

Understanding Classification Methodology
A discovered AP is classified as a rogue or a suspected rogue by the following methods:

l Internal heuristics

l AP classification rules

l Manually by the user

The internal heuristics works by checking if the discovered AP is communicating with a wired device on the
customer network. This is done by matching the MAC address of devices that are on the discovered AP’s
network with that of the user’s wired network. The MAC of the device on the discovered AP’s network is known
as theMatch MAC. The ways in which the matching of wired MACs occurs is detailed in the sections
Understanding Match Methods on page 458 and Understanding Match Types on page 458.

Understanding Match Methods
The match methods are:

l Plus One—The match MAC matches a device whose MAC address’ last bit was one more than that of the
Match MAC.

l Minus One—The match MAC matches a device whose MAC address’ last bit was one less than that of the
Match MAC.

l Equal—The match was against the same MAC address.

l OUI—The match was against the manufacturer’s OUI of the wired device.

The classification details are available in the ‘Discovered AP table’ section of the ‘Security Summary’ page of the
WebUI. The information can be obtained by clicking on the details icon for a selected discovered AP. The
information is also available in the command show wms rogue-ap.

Understanding Match Types
l Eth-Wired-MAC: The MAC addresses of wired devices learned by an AP on its Ethernet interface.

l GW-Wired-MAC: The collection of Gateway MACs of all APs across Mobility Master and managed devices.

l AP-Wired-MAC: The MAC addresses of wired devices learned by monitoring traffic out of other valid and
rogue APs.

l Config-Wired-MAC: The MAC addresses that are configured by the user, typically that of well-known
servers in the network.

l Manual: User-triggered classification.

l External-Wired-MAC: The MAC address matched a set of known wired devices that are maintained in an
external database.

l Mobility-Manager: The classification was determined by the mobility manager, AMP.



l Classification-off: AP is classified as rogue because classification has been disabled, causing all non-
authorized APs to be classified as rogue.

l Propagated-Wired-MAC: The MAC addresses of wired devices learned by a different AP than the one that
uses it for classifying a rogue.

l Base-BSSID-Override: The classification was derived from another BSSID, which belongs to the same AP
that supports multiple BSSIDs on the radio interface.

l AP-Rule: A user-defined AP classification rule has matched.

l System-Wired-MAC: The MAC addresses of wired devices learned on the managed device.

l System-Gateway-MAC: The Gateway MAC addresses learned on the managed device.

Understanding Suspected Rogue Confidence Level
A suspected rogue AP is a potential threat to the WLAN infrastructure. A suspected rogue AP has a confidence
level associated with it. An AP can be marked as a suspected rogue if it is determined to be a potential threat on
the wired network, or if it matches a user-defined classification rule.

The suspected-rogue classification mechanisms are:

l Each mechanism that causes a suspected-rogue classification is assigned a confidence level increment of
20%.

l AP classification rules have a configured confidence level.

l When a mechanism matches a previously unmatched mechanism, the confidence level increment
associated with that mechanism is added to the current confidence level (the confidence level starts at
zero).

l The confidence level is capped at 100%.

l If your managed device reboots, your suspected-rogue APs are not checked against any new rules that were
configured after the reboot. Without this restriction, all the mechanisms that classified your APs as
suspected-rogues may trigger again, causing the confidence level to surpass its cap of 100%. You can
explicitly mark an AP as “interfering” to trigger all new rules to match against it.

Understanding AP Classification Rules
AP classification rule configuration is performed only on Mobility Master. If AMP is enabled via the mobility-
manager command, then processing of the AP classification rules is disabled on Mobility Master. A rule is
identified by its ASCII character string name (32 characters maximum). The AP classification rules have one of
the following specifications:

l SSID of the AP

l SNR of the AP

l Discovered-AP-Count or the number of APs that can see the AP

Understanding SSID specification
Each rule can have up to 6 SSID parameters. If one or more SSIDs are specified in a rule, an option of whether
to match any of the SSIDs or not match all of the SSIDs can be specified. The default is to check for a match
operation.

Understanding SNR specification
Each rule can have only one specification of the SNR. A minimum and/or maximum can be specified in each
rule, and the specification is in SNR (db).
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Understanding Discovered-AP-Count specification
Each rule can have only one specification of the Discovered-AP-Count. Each rule can specify a minimum or
maximum of the Discovered-AP-count. The minimum or maximum operation must be specified if the
Discovered-AP-count is specified. The default setting is to check for the minimum discovered-AP-count.

Sample Rules
If SSID equals xyz AND SNR > 40 then classify AP as suspected-rogue with conf-level-increment of 20

If SNR > 60 and DISCOVERING_APS > 2, then classify AP as suspected-rogue with conf-level increment of 35

If SSID equals ‘XYZ’, then classify AP as known-neighbor

Understanding Rule Matching
A rule must be enabled before it is matched. A maximum of 32 rules can be created with a maximum of 16
rules simultaneously active. If a rule matches, an AP is classified as:

l Suspected-Rogue: An associated confidence-level is provided (minimum is 5%)

l Neighbor

The following mechanism is used for rule matching:

l When all the conditions specified in the rule evaluate to true, the rule matches.

l If multiple rules match, causing the AP to be classified as a Suspected-Rogue, the confidence level of each
rule is aggregated to determine the confidence level of the classification.

l When multiple rules match and any one of those matching rules cause the AP to be classified as a Neighbor,
then the AP is classified as Neighbor.

l APs classified as either Neighbor or Suspected-Rogue will attempt to match any configured AP rule.

l Once a rule matches an AP, the same rule will not be checked for the AP.

l When the managed device reboots, no attempt to match a previously matched AP is made.

l If a rule is disabled or modified, all APs that were previously classified based on that rule will continue to be
in the newly classified state.

Working with Intrusion Detection
This section covers Infrastructure and Client Intrusion Detections.

Understanding Infrastructure Intrusion Detection
Detecting attacks against the infrastructure is critical in avoiding attacks that may lead to a large-scale Denial of
Service (DoS) attack or a security breach. This group of features detects attacks against the WLAN
infrastructure, which consists of authorized APs, the RF medium, and the wired network. An authorized or
valid-AP is defined as an AP that belongs to the WLAN infrastructure. The AP is either an Aruba AP or a third
party AP. ArubaOS automatically learns authorized Aruba APs.

Table 88 presents a summary of the Intrusion infrastructure detection features with their related commands,
traps, and syslog identification. Feature details follow the table.



Feature Command Trap Syslog
ID

Detecting an
802.11n
40MHz
Intolerance
Setting on
page 464

ids dos-profile

detect-ht-40mhz-intolerance

client-ht-40mhz-intol-quiet-time

wlsxHT40MHzIntoleranceAP

wlsxHT40MHzIntoleranceSta

1260
52,
1260
53,
1270
52,
1270
53

Detecting
Active 802.11n
Greenfield
Mode on page
465

ids unauthorized-device-profile

detect-ht-greenfield
wlsxHtGreenfieldSupported 1260

54,
1270
54

Detecting Ad
hoc Networks
on page 465

ids unauthorized-device-profile

detect-adhoc-network
wlsxNAdhocNetwork 1260

33,
1270
33

Detecting an
Ad hoc
Network Using
a Valid SSID on
page 465

ids unauthorized-device-profile

detect-adhoc-using-valid-ssid

adhoc-using-valid-ssid-quiet-time

wlsxAdhocUsingValidSSID 1260
68,
1270
68

Detecting an
AP Flood
Attack on page
465

ids dos-profile

detect-ap-flood

ap-flood-threshold

ap-flood-inc-time

ap-flood-quiet-time

wlsxApFloodAttack 1260
34,
1270
34

Detecting AP
Impersonation
on page 465

ids impersonation-profile

detect-ap-impersonation

beacon-diff-threshold

beacon-inc-wait-time

wlsxAPImpersonation 1260
06,
1270
06

Detecting AP
Spoofing on
page 465

ids impersonation-profile

detect-ap-spoofing

ap-spoofing-quiet-time

wlsxAPSpoofingDetected

wlsxClientAssociatingOn

WrongChannel

1260
69,
1260
70,
1270
69,
1270
70

Table 88: Infrastructure Detection Summary
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Feature Command Trap Syslog
ID

Detecting Bad
WEP
Initialization on
page 465

ids unauthorized-device-profile

detect-bad-wep
wlsxRepeatWEPIVViolation

wlsxStaRepeatWEPIVViolation

wlsxWeakWEPIVViolation

wlsxStaWeakWEPIVViolation

1260
14,
1260
15,
1260
16,
1260
17,
1270
14,
1270
15,
1270
16,
1270
17

Detecting a
Beacon Frame
Spoofing
Attack on page
465

ids impersonation-profile

detect-beacon-wrong-channel

beacon-wrong-channel-quiet-time

wlsxMalformedFrameWrongChan
nel
Detected

1260
86,
1270
86

Detecting a
Client Flood
Attack on page
465

ids dos-profile

detect-client-flood

client-flood-threshold

client-flood-inc-time

client-flood-quiet-time

wlsxClientFloodAttack 1260
64,
1270
64

Detecting a CTS
Rate Anomaly

ids dos-profile

detect-cts-rate-anomaly

cts-rate-threshold

cts-rate-time-interval

cts-rate-quiet-time

wlsxCtsRateAnomaly 1260
73,
1270
73

Detecting
Devices with
an Invalid MAC
OUI on page
466

ids unauthorized-device-profile

detect-invalid-mac-oui

mac-oui-quiet-time

wlsxInvalidMacOUIAP

wlsxInvalidMacOUISta

1260
29,
1260
30,
1270
29,
1270
30

Detecting an
Invalid
Address
Combination
on page 466

ids dos-profile

detect-invalid-address-combination

invalid-address-combination-quiet-

time

wlsxInvalidAddressCombination 1260
79,
1270
79

Detecting an
Overflow
EAPOL Key on
page 466

ids dos-profile

detect-overflow-eapol-key

overflow-eapol-key-quiet-time

wlsxMalformedOverflowEAPOLKe
y
Detected

1260
82,
1270
82



Feature Command Trap Syslog
ID

Detecting
Overflow IE
Tags on page
466

ids dos-profile

detect-overflow-ie

overflow-ie-quiet-time

wlsxOverflowIEDetected 1260
84,
1270
84

Detecting a
Malformed
Frame-Assoc
Request on
page 466

ids dos-profile

detect-malformed-assoc-req

malformed-assoc-req-quiet-time

wlsxMalformedAssocReqDetecte
d

1260
80,
1270
80

Detecting
Malformed
Frame-Auth on
page 466

ids dos-profile

detect-malformed-frame-auth

malformed-auth-frame-quiet-time

wlsxMalformedAuthFrameDetect
ed

1260
83,
1270
83

Detecting a
Malformed
Frame-HT IE
on page 467

ids dos-profile

detect-malformed-htie

malformed-htie-quiet-time

wlsxMalformedHTIEDetected 1260
81,
1270
81

Detecting a
Malformed
Frame-Large
Duration on
page 467

ids-dos-profile

detect-malformed-large-duration

malformed-large-duration-quiet-time

wlsxMalformedFrameLargeDurat
ion

Detected

1260
85,
1270
85

Detecting a
Misconfigured
AP on page
467

(WEP, WPA,
SSID, Channel,
OUI)

ids unauthorized-device-profile

detect-misconfigured-ap

privacy

require-wpa

valid-and-protected-ssid

cfg-valid-11g-channel

cfg-valid-11a-channel

valid-oui

wlsxWEPMisconfiguration

wlsxWPAMisconfiguration

wlsxSSIDMisconfiguration

wlsxChannelMisconfiguration

wlsxOUIMisconfiguration

1260
11,
1260
28,
1260
10,
1260
08,
1260
09,
1270
11,
1270
28,
1270
10,
1270
08,
1270
09

Detecting a
CTS Rate
Anomaly on
page 466

ids dos-profile

detect-rts-rate-anomaly

rts-rate-threshold

rts-rate-time-interval

rts-rate-quiet-time

wlsxRtsRateAnomaly 1260
74,
1270
74
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Feature Command Trap Syslog
ID

Detecting a
Windows
Bridge on
page 467

ids unauthorized-device-profile

detect-windows-bridge
wlsxWindowsBridgeDetectedAP

wlsxWindowsBridgeDetectedSta

wlsxNAdhocNetworkBridgeDetec
ted

AP

wlsxNAdhocNetworkBridgeDetec
ted
Sta

1260
39,
1260
40,
1260
41,
1260
42,
1270
39,
1270
40,
1270
41,
1270
42

Detecting a
Wireless
Bridge on
page 467

ids unauthorized-device-profile

detect-wireless-bridge

wireless-bridge-quiet-time

wlsxWirelessBridge 1260
36,
1270
36

Detecting
Broadcast
Deauthenticati
on on page
467

ids signature-matching-profile

signature deauth-Broadcast

ids general-profile

signature-quiet-time

wlsxNSignatureMatchDeauthBca
st

1260
47,
1270
47

Detecting
Broadcast
Disassociation
on page 467

ids signature-matching-profile

signature disassoc-Broadcast

ids general-profile

signature-quiet-time

wlsxNSignatureMatchDisassocBc
ast

1260
66,
1270
66

Detecting
Netstumbler
on page 467

ids signature-matching-profile

signature ‘Netstumbler Generic’

signature ‘Netstumbler Version

3.3.0.x’

ids general-profile

signature-quiet-time

wlsxNSignatureMatchNetstumble
r

1260
43,
1270
43

Detecting Valid
SSID Misuse
on page 467

ids-unauthorized-device-profile

detect-valid-ssid-misuse

valid-and-protected-ssid

wlsxValidSSIDViolation 1260
07,
1270
07

Detecting
Wellenreiter
on page 467

ids signature-matching-profile

signature Wellenreiter

ids general-profile

signature-quiet-time

wlsxNSignatureMatchWellenreite
r

1260
67,
1270
67

Detecting an 802.11n 40MHz Intolerance Setting
When a client sets the HT capability “intolerant bit” to indicate that it is unable to participate in a 40MHz BSS,
the AP must use lower data rates with all of its clients. Network administrators often want to know if there are



devices that are advertising 40MHz intolerance, as this can impact the performance of the network.

Detecting Active 802.11n Greenfield Mode
When 802.11 devices use the HT operating mode, they can not share the same channel as 802.11a/b/g
stations. Not only can they not communicate with legacy devices, the way they use the transmission medium is
different, which would cause collisions, errors, and retransmissions.

Detecting Ad hoc Networks
An adhoc network is a collection of wireless clients that form a network amongst themselves without the use of
an AP. As far as network administrators are concerned, adhoc wireless networks are uncontrolled. If they do
not use encryption, they may expose sensitive data to outside eavesdroppers. If a device is connected to a
wired network and has bridging enabled, an adhoc network may also function like a rogue AP. Additionally,
adhoc networks can expose client devices to viruses and other security vulnerabilities. For these reasons, many
administrators choose to prohibit adhoc networks.

Detecting an Ad hoc Network Using a Valid SSID
If an unauthorized adhoc network is using the same SSID as an authorized network, a valid client may be
tricked into connecting to the wrong network. If a client connects to a malicious adhoc network, security
breaches or attacks can occur.

Detecting an AP Flood Attack
Fake AP is a tool that was originally created to thwart wardrivers by flooding beacon frames containing
hundreds of different addresses. This would appear to a wardriver as though there were hundreds of APs in
the area, thus concealing the real AP. An attacker can use this tool to flood an enterprise or public hotspots
with fake AP beacons to confuse legitimate users and to increase the amount of processing need on client
operating systems.

Detecting AP Impersonation
In AP impersonation attacks, the attacker sets up an AP that assumes the BSSID and ESSID of a valid AP. AP
impersonation attacks can be done for man-in-the-middle attacks, a rogue AP attempting to bypass detection,
or a honeypot attack.

Detecting AP Spoofing
An AP Spoofing attack involves an intruder sending forged frames that are made to look like they are from a
legitimate AP. It is trivial for an attacker to do this, since tools are readily available to inject wireless frames with
any MAC address that the user desires. Spoofing frames from a legitimate AP is the foundation of many
wireless attacks.

Detecting Bad WEP Initialization
This is the detection of WEP initialization vectors that are known to be weak. A primary means of cracking WEP
keys is to capture 802.11 frames over an extended period of time and searching for such weak
implementations that are still used by many legacy devices.

Detecting a Beacon Frame Spoofing Attack
In this type of attack, an intruder spoofs a beacon packet on a channel that is different from that advertised in
the beacon frame of the AP.

Detecting a Client Flood Attack
There are fake AP tools that can be used to attack wireless intrusion detection itself by generating a large
number of fake clients that fill internal tables with fake information. If successful, it overwhelms the wireless
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intrusion system, resulting in a DoS.

Detecting a CTS Rate Anomaly
The RF medium can be reserved via Virtual Carrier Sensing using a Clear To Send (CTS) transaction. The
transmitter station sends a Ready To Send (RTS) frame to the receiver station. The receiver station responds
with a CTS frame. All other stations that receive these CTS frames will refrain from transmitting over the
wireless medium for an amount of time specified in the duration fields of these frames.

Attackers can exploit the Virtual Carrier Sensing mechanism to launch a DoS attack on the WLAN by
transmitting numerous RTS and/or CTS frames. This causes other stations in the WLAN to defer transmission
to the wireless medium. The attacker can essentially block the authorized stations in the WLAN with this attack.

Detecting an RTS Rate Anomaly
The RF medium can be reserved via Virtual Carrier Sensing using an RTS transaction. The transmitter station
sends a RTS frame to the receiver station. The receiver station responds with a CTS frame. All other stations
that receive these RTS frames will refrain from transmitting over the wireless medium for an amount of time
specified in the duration fields of these frames.

Attackers can exploit the Virtual Carrier Sensing mechanism to launch a DoS attack on the WLAN by
transmitting numerous RTS and/or CTS frames. This causes other stations in the WLAN to defer transmission
to the wireless medium. The attacker can essentially block the authorized stations in the WLAN with this attack.

Detecting Devices with an Invalid MAC OUI
The first three bytes of a MAC address, known as the MAC organizationally unique identifier (OUI), is assigned
by the IEEE to known manufacturers. Often, clients using a spoofed MAC address do not use a valid OUI and
instead use a randomly generated MAC address.

Detecting an Invalid Address Combination
In this attack, an intruder can cause an AP to transmit deauthentication and disassociation frames to all of its
clients. Triggers that can cause this condition include the use of broadcast or multicast MAC address in the
source address field.

Detecting an Overflow EAPOL Key
Some wireless drivers used in access points do not correctly validate the EAPOL key fields. A malicious EAPOL-
Key packet with an invalid advertised length can trigger a DoS or possible code execution. This can only be
achieved after a successful 802.11 association exchange.

Detecting Overflow IE Tags
Some wireless drivers used in access points do not correctly parse the vendor-specific IE tags. A malicious
association request sent to the AP containing an IE with an inappropriate length (too long) can cause a DoS and
potentially lead to code execution. The association request must be sent after a successful 802.11
authentication exchange.

Detecting a Malformed Frame-Assoc Request
Some wireless drivers used in access points do not correctly parse the SSID information element tag contained
in association request frames. A malicious association request with a null SSID (that is, zero length SSID) can
trigger a DoS or potential code execution condition on the targeted device.

Detecting Malformed Frame-Auth
Malformed 802.11 authentication frames that do not conform to the specification can expose vulnerabilities
in some drivers that have not implemented proper error checking. This feature checks for unexpected values in



an Authentication frame.

Detecting a Malformed Frame-HT IE
The IEEE 802.11n HT (High Throughput) IE is used to convey information about the 802.11n network. An
802.11 management frame containing a malformed HT IE can crash some client implementations, potentially
representing an exploitable condition when transmitted by a malicious attacker.

Detecting a Malformed Frame-Large Duration
The virtual carrier-sense attack is implemented by modifying the 802.11 MAC layer implementation to allow
random duration values to be sent periodically. This attack can be carried out on the ACK, data, RTS, and CTS
frame types by using large duration values. This attack can prevent channel access to legitimate users.

Detecting a Misconfigured AP
A list of parameters can be configured to define the characteristics of a valid AP. This feature is primarily used
when non-Aruba APs are used in the network, since the Aruba devices cannot configure the third-party APs.
These parameters include WEP, WPA, OUI of valid MAC addresses, valid channels, and valid SSIDs.

Detecting a Windows Bridge
A Windows Bridge occurs when a client that is associated to an AP is also connected to the wired network, and
has enabled bridging between these two interfaces.

Detecting a Wireless Bridge
Wireless bridges are normally used to connect multiple buildings together. However, an attacker could place (or
have an authorized person place) a wireless bridge inside the network that would extend the corporate
network somewhere outside the building. Wireless bridges are somewhat different from rogue APs, in that
they do not use beacons and have no concept of association. Most networks do not use bridges – in these
networks, the presence of a bridge is a signal that a security problem exists.

Detecting Broadcast Deauthentication
A deauthentication broadcast attempts to disconnect all stations in range. Rather than sending a spoofed
deauth to a specific MAC address, this attack sends the frame to a broadcast address.

Detecting Broadcast Disassociation
By sending disassociation frames to the broadcast address (FF:FF:FF:FF:FF:FF), an attacker can disconnect all
stations on a network for a widespread DoS.

Detecting Netstumbler
NetStumbler is a popular wardriving application used to locate 802.11 networks. When used with certain NICs,
NetStumbler generates a characteristic frame that can be detected. Version 3.3.0 of NetStumbler changed the
characteristic frame slightly.

Detecting Valid SSID Misuse
If an unauthorized AP (neighbor or interfering) is using the same SSID as an authorized network, a valid client
may be tricked into connecting to the wrong network. If a client connects to a malicious network, security
breaches or attacks can occur.

Detecting Wellenreiter
Wellenreiter is a passive wireless network discovery tool used to compile a list of APs along with their MAC
address, SSID, channel, and security setting in the vicinity. It passively sniffs wireless traffic, and with certain
version (versions 1.4, 1.5, and 1.6), sends active probes that target known default SSIDs.

ArubaOS 8.0.0.0 | User Guide Wireless Intrusion Prevention |  467



468 | Wireless Intrusion Prevention ArubaOS 8.0.0.0  | User Guide

Understanding Client Intrusion Detection
Generally, clients are more vulnerable to attacks than APs. Clients are more apt to associate with a malignant
AP due to the client’s driver behavior or a misconfigured client. It is important to monitor authorized clients to
track their associations and to track any attacks raised against the client.Client attack detection is categorized
as:

l Detecting attacks against Aruba APs clients: An attacker can perform an active DOS attack against an
associated client, or perform a replay attack to obtain the keys of transmission which could lead to more
serious attacks.

l Monitoring Authorized clients: Since clients are easily tricked into associating with unauthorized APs,
tracking all misassociations of authorized clients is very important.

An authorized client is a client authorized to use the WLAN network. In ArubaOS, an authorized client is called a
valid-client. ArubaOS automatically learns a valid client. A client is determined to be valid if it is associated to an
authorized or valid AP using encryption; either Layer 2 or IPsec.

Detection of attacks is limited to valid clients and clients associated to valid APs. Clients that are associated as guests
using unencrypted association are included in the attack detection. However, clients on neighboring (interfering) APs
are not tracked for attack detection unless they are specified as valid.

Table 89 presents a summary of the client intrusion detection features with their related commands, traps, and
syslog identification. Details of each feature follow the table.

Feature Command Trap Syslog
ID

Detecting a
Block ACK
DoS on page
470

ids-dos-profile

detect-block-ack-attack

block-ack-quiet-time

wlsxBlockAckAttackDetected 12608
7,
127087

Detecting a
ChopChop
Attack on
page 470

ids-dos-profile

detect-chopchop-attack

chopchop-quiet-time

wlsxChopChopAttackDetected 12607
8,
127078

Detecting a
Disconnect
Station Attack
on page 470

ids dos-profile <name>

detect-disconnect-sta

disconnect-sta-quiet-time

disconnect-sta-assoc-resp-threshold

disconnect-deauth-disassoc-threshold

wlsxNDisconnectStationAttack 12603
5,
127035

Detecting an
EAP Rate
Anomaly on
page 470

ids-dos-profile

detect-eap-rate-anomaly

eap-rate-threshold

eap-rate-time-interval

eap-rate-quiet-time

wlsxEAPRateAnomaly 12603
2,
127032

Detecting a
FATA-Jack
Attack
Structure on
page 470

ids dos-profile

detect-fatajack-attack

fatajack-attack-quiet-time

wlsxFataJackAttackDetected 12607
2,
127072

Table 89: Client Detection Summary



Feature Command Trap Syslog
ID

Detecting a
Hotspotter
Attack on
page 471

ids impersonation-profile

detect-hotspotter-attack

hotspotter-quiet-time

wlsxHotspotterAttackDetected 12608
8,
127088

Detecting a
Meiners
Power Save
DoS Attack on
page 471

ids dos-profile

detect-power-save-dos-attack

power-save-dos-min-frames

power-save-dos-quiet-time

power-save-dos-threshold

wlsxPowerSaveDoSAttack 12610
9,
127109

Detecting an
Omerta
Attack on
page 471

ids dos-profile

detect-omerta-attack

omerta-attack-threshold

omerta-attack-quiet-time

wlsxOmertaAttack 12607
1,
127071

Detecting
Rate
Anomalies on
page 471

ids dos-profile

detect-rate-anomalies

assoc-rate-thresholds

disassoc-rate-thresholds

deauth-rate-thresholds

probe-request-rate-thresholds

probe-response-rate-thresholds

auth-rate-thresholds

wlsxChannelRateAnomaly

wlsxNodeRateAnomalyAP

wlsxNodeRateAnomalySta

12606
1,
12606
2,
12606
3,
12706
1,
12706
2,
127063

Detecting a
TKIP Replay
Attack on
page 471

ids dos-profile

detect-tkip-replay-attack

tkip-replay-quiet-time

wlsxTkipReplayAttackDetected 12607
7,
127077

Detecting
Unencrypted
Valid Clients
on page 471

ids unauthorized-device-profile

detect-unencrypted-valid-client

unencrypted-valid-client-quiet-time

wlsxValidClientNotUsingEncryption 12606
5,
127065

Detecting a
Valid Client
Misassociatio
n on page 471

ids unauthorized-device-profile

detect-valid-client-misassociation
wlsxValidClientMisassociation 12607

5,
127075
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Feature Command Trap Syslog
ID

Detecting an
AirJack Attack
on page 472

ids signature-matching-profile

signature AirJack

ids general-profile

signature-quiet-time

wlsxNSignatureMatchAirjack 12604
6,
127046

Detecting
ASLEAP on
page 472

ids signature-matching-profile

signature ASLEAP

ids general-profile

signature-quiet-time

wlsxNSignatureMatchAsleap 12604
4,
127044

Detecting a
Null Probe
Response on
page 472

ids signature-matching-profile

signature Null Probe Response

ids general-profile

signature-quiet-time

wlsxNSignatureMatchNullProbeRe
sp

12604
5,
127045

Detecting a Block ACK DoS
The Block ACK mechanism that was introduced in 802.11e, and enhanced in 802.11nD3.0, has a built-in DoS
vulnerability. The Block ACK mechanism allows for a sender to use the ADDBA request frame to specify the
sequence number window that the receiver should expect. The receiver will only accept frames in this window.

An attacker can spoof the ADDBA request frame causing the receiver to reset its sequence number window
and thereby drop frames that do not fall in that range.

Detecting a ChopChop Attack
ChopChop is a plaintext recovery attack against WEP encrypted networks. It works by forcing the plaintext, one
byte at a time, by truncating a captured frame and then trying all 256 possible values for the last byte with a
corrected CRC. The correct guess causes the AP to retransmit the frame. When that happens, the frame is
truncated again.

Detecting a Disconnect Station Attack
A disconnect attack can be launched in many ways; the end result is that the client is effectively and repeatedly
disconnected from the AP.

Detecting an EAP Rate Anomaly
To authenticate wireless clients, WLANs may use 802.1X, which is based on a framework called Extensible
Authentication Protocol (EAP). After an EAP packet exchange, and the user is successfully authenticated, the
EAP-Success is sent from the AP to the client. If the user fails to authenticate, an EAP-Failure is sent. In this
attack, EAP-Failure or EAP-Success frames are spoofed from the access point to the client to disrupting the
authentication state on the client. This confuses the client’s state, causing it to drop the AP connection. By
continuously sending EAP Success or Failure messages, an attacker can effectively prevent the client from
authenticating with the APs in the WLAN.

Detecting a FATA-Jack Attack Structure
FATA-Jack is an 802.11 client DoS tool that tries to disconnect targeted stations using spoofed authentication
frames that contain an invalid authentication algorithm number.



Detecting a Hotspotter Attack
The Hotspotter attack is an evil-twin attack which attempts to lure a client to a malicious AP. Many enterprise
employees use their laptop in Wi-Fi area hotspots at airports, cafes, malls etc. They have SSIDs of their hotspot
service providers configured on their laptops. The SSIDs used by different hotspot service providers are well
known. This enables the attackers to set up APs with hotspot SSIDs in close proximity of the enterprise
premises. When the enterprise laptop Client probes for hotspot SSIDs, these malicious APs respond and invite
the client to connect to them. When the client connects to a malicious AP, a number of security attacks can be
launched on the client. Airsnarf is a popular hacking tool used to launch these attacks.

Detecting a Meiners Power Save DoS Attack
To save on power, wireless clients will "sleep" periodically, during which they cannot transmit or receive. A client
indicates its intention to sleep by sending frames to the AP with the Power Management bit ON. The AP then
begins buffering traffic bound for that client until it indicates that it is awake. An intruder could exploit this
mechanism by sending (spoofed) frames to the AP on behalf of the client to trick the AP into believing the
client is asleep. This will cause the AP to buffer most, if not all, frames destined for the client.

Detecting an Omerta Attack
Omerta is an 802.11 DoS tool that sends disassociation frames to all stations on a channel in response to data
frames. The Omerta attack is characterized by disassociation frames with a reason code of 0x01. This reason
code is “unspecified” and is not used under normal circumstances.

Detecting Rate Anomalies
Many DoS attacks flood an AP or multiple APs with 802.11 management frames. These can include
authenticate/associate frames, which are designed to fill up the association table of an AP. Other management
frame floods, such as probe request floods, can consume excess processing power on the AP.

Detecting a TKIP Replay Attack
TKIP is vulnerable to replay (via WMM/QoS) and plaintext discovery (via ChopChop). This affects all WPA-TKIP
usage. By replaying a captured TKIP data frame on other QoS queues, an attacker can manipulate the RC4 data
and checksum to derive the plaintext at a rate of one byte per minute.

By targeting an ARP frame and guessing the known payload, an attacker can extract the complete plaintext and
MIC checksum. With the extracted MIC checksum, an attacker can reverse the MIC AP to Station key and sign
future messages as MIC compliant, opening the door for more advanced attacks.

Detecting Unencrypted Valid Clients
An authorized (valid) client that is passing traffic in unencrypted mode is a security risk. An intruder can sniff
unencrypted traffic (also known as packet capture) with software tools known as sniffers. These packets are
then reassembled to produce the original message.

Detecting a Valid Client Misassociation
This feature does not detect attacks, but rather it monitors authorized (valid) wireless clients and their
association within the network. Valid client misassociation is potentially dangerous to network security. The
four types of misassociation that we monitor are:

l Authorized Client associated to Rogue: A valid client that is associated to a rogue AP.

l Authorized Client associated to External AP: An external AP, in this context, is any AP that is not valid
and not a rogue.

l Authorized Client associated to Honeypot AP: A honeypot is an AP that is not valid but is using an
SSID that has been designated as valid/protected.

l Authorized Client in ad hoc connection mode: A valid client that has joined an ad hoc network.
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Detecting an AirJack Attack
AirJack is a suite of device drivers for 802.11(a/b/g) raw frame injection and reception. It was intended to be
used as a development tool for all 802.11 applications that need to access the raw protocol. However, one of
the tools included allowing users to force all users off an AP.

Detecting ASLEAP
ASLEAP is a tool created for Linux systems used to attack Cisco LEAP authentication protocol.

Detecting a Null Probe Response
A null probe response attack has the potential to crash or lock up the firmware of many 802.11 NICs. In this
attack, a client probe-request frame will be answered by a probe response containing a null SSID. A number of
popular NIC cards will lock up upon receiving such a probe response.

Configuring Intrusion Protection
Intrusion protection features support containment of an AP or a client. In the case of an AP, we will attempt to
disconnect all clients that are connected or attempting to connect to the AP. In the case of a client, the client's
association to an AP is targeted. The following containment mechanisms are supported:

l Deauthentication containment: An AP or client is contained by disrupting its association on the wireless
interface.

l Tarpit containment: An AP is contained by luring clients that are attempting to associate with it to a
tarpit. The tarpit can be on the same channel as the AP being contained, or on a different channel (see Tarpit
Shielding Overview on page 487).

l Wired containment: An AP or client is contained by disrupting its connection on the wired interface.

The WIP feature supports separate enforcement policies that use the underlying containment mechanisms to
contain an AP or a client that do not conform to the policy. These policies are discussed in the sections that
follow.

Understanding Infrastructure Intrusion Protection
Table 90 presents a summary of the infrastructure intrusion protection features with their related commands,
traps, and syslog identifications. Details of each feature follow the table.

Feature Command

Protecting 40MHz 802.11 High Throughput Devices on
page 473

ids unauthorized-device-profile

protect-ht-40mhz

Protecting 802.11n High Throughput Devices on page
473

ids unauthorized-device-profile

protect-high-throughput

Protecting Against Adhoc Networks on page 473 ids unauthorized-device-profile

protect-adhoc-enhanced

protect-adhoc-network

Protecting Against Adhoc Networks Using Valid SSID on
page 473

ids unauthorized-device-profile

protect-adhoc-using-valid-ssid

Table 90: Infrastructure Protection Summary



Feature Command

Protecting Against AP Impersonation on page 473 ids impersonation-profile

protect-ap-impersonation

Protecting Against Misconfigured APs on page 473 ids unauthorized-device-profile

protect-misconfigured-ap

Protecting SSIDs on page 474 ids unauthorized-device-profile

protect-ssid

Protecting Against Wireless Hosted Networks on page
474

ids unauthorized-device-profile detect-wireless-hosted-
network protect-wireless-hosted-network

Protecting Against Rogue Containment on page 474 ids unauthorized-device-profile

rogue-containment

Protecting Against Suspected Rogue Containment on
page 474

ids unauthorized-device-profile

suspect-rogue-containment

suspect-rogue-conf-level

Protection against Wired Rogue APs on page 474 ids general-profile

wired-containment

wired-containment-ap-adj-mac

wired-containment-susp-l3-rogue

Protecting 40MHz 802.11 High Throughput Devices
Protection from AP(s) that support 40MHz HT involves containing the AP such that clients can not connect.

Protecting 802.11n High Throughput Devices
Protection from AP(s) that support HT involves containing the AP such that clients can not connect.

Protecting Against Adhoc Networks
Protection from an adhoc network involves containing the adhoc network so that clients cannot connect to it.
The basic adhoc protection feature protects against adhoc networks using WPA/WPA2 security. The enhanced
adhoc network protection feature protects against open/WEP adhoc networks. Both features can be used
together for maximum protection, or enabled or disabled separately.

This feature requires that you enable the wireless-containment setting in the IDS general profile.

Protecting Against Adhoc Networks Using Valid SSID
Protection from adhoc networks using valid SSID involves containing the adhoc networks that use a valid or
protected SSIDs so that clients cannot connect to it. This feature provides protection against
WPA/WPA2/WEP/open adhoc networks.

Protecting Against AP Impersonation
Protection from AP impersonation involves containing both the legitimate and impersonating AP so that clients
can not connect to either AP.

Protecting Against Misconfigured APs
Protect Misconfigured AP enforces that valid APs are configured properly. An offending AP is contained by
preventing clients from associating to it.
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Protecting Against Wireless Hosted Networks
Clients using the Windows wireless hosted network feature can act as an access point to which other wireless
clients can connect, effectively becoming a Wi-Fi HotSpot. This creates a security issue for enterprises, because
unauthorized users can use a hosted network to gain access to the corporate network, and valid users that
connect to a hosted network are vulnerable to attacks or security breaches. This feature detects a wireless
hosted network, and contains the client hosting this network.

Protecting SSIDs
Protect SSID enforces that valid/protected SSIDs are used only by valid APs. An offending AP is contained by
preventing clients from associating to it.

Protecting Against Rogue Containment
By default, rogue APs are not automatically disabled. Rogue containment automatically disables a rogue AP by
preventing clients from associating to it.

Protecting Against Suspected Rogue Containment
By default, suspected rogue APs are not automatically contained. In combination with the suspected rogue
containment confidence level, suspected rogue containment automatically disables a suspect rogue by
preventing clients from associating to it.

Protection against Wired Rogue APs
This feature enables containment from the wired side of the network. The basic wired containment feature in
the IDS general profile isolates layer-3 APs whose wired interface MAC addresses are the same as (or one
character off from) their BSSIDs. The enhanced wired containment feature introduced in ArubaOS 6.3 can also
identify and contain an AP with a preset wired MAC address that is completely different from the AP’s BSSID. In
many non-Aruba APs, the MAC address the AP provides to wireless clients as a ‘gateway MAC’ is offset by one
character from its wired MAC address. This enhanced feature allows ArubaOS to check to see if a suspected
Layer-3 rogue AP’s MAC address follows this common pattern.

Understanding Client Intrusion Protection
Table 91 list the client intrusion protection features with their related commands, traps, and syslog
identifications. Details of each feature follow the table.

Feature Command

Protecting Valid Stations on page 474 ids unauthorized-device-profile

protect-valid-sta

Protecting Windows Bridge on page 474 ids unauthorized-device-profile

protect-windows-bridge

Table 91: Client Protection Summary

Protecting Valid Stations
Protecting a valid client involves disconnecting that client if it is associated to a non-valid AP.

Protecting Windows Bridge
Protecting from a Windows Bridge involves containing the client that is forming the bridge so that it can not
connect to the AP.



Warning Message for Containment Features
The feature for enabling wireless containment under the IDS Unauthorized Device profile and IDS
Impersonation profile may be in violation of certain Federal Communications Commission (FCC) regulatory
statutes. To address this, a warning message will be issued each time the command is enabled:

l If enabled through the WebUI, the warning message will appear before the command is executed.

l If enabled through the CLI, the warning message will appear after the command is executed

Configuring the WLAN Management System (WMS)
The WLAN management system (WMS) on Mobility Master monitors wireless traffic to detect any new AP or
wireless client station in the RF environment. When an AP or wireless client is detected, it is classified, and its
classification is used to determine the security policies that should be enforced on the AP or client. By default,
the WMS service is terminated at Mobility Master, which requires every AP across the network to communicate
with the WMS service on Mobility Master.

Configuring General WMS settings
Use the IDS WMS General profile to configure general WMS settings such as AP ageout times and update
intervals, and enable the collection of statistics for monitored APs and clients.

In the WebUI
To configure the IDS WMS General profile

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Expand the IDS menu and select IDS WMS General.
3. Configure the parameters as described in Table 92 and then click Save.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

AP poll interval Interval, in milliseconds, for communication between the
managed device and Aruba APs. The managed device contacts
the AP at this interval to download AP to station associations,
update policy configuration changes, and download AP and
station statistics.

Default: 60000 milliseconds (1 minute)

AP poll retries Maximum number of failed polling attempts before the polled
AP is considered to be down.

Default: 3

AP ageout interval The amount of time, in minutes, that an AP is unseen by any
probes before it is deleted from the database. Enter 0 to
disable ageout.

Default: 30 minutes

Table 92: WMS Configuration Parameters
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Parameter Description

Adhoc AP ageout interval The amount of time, in minutes, that an adhoc (IBSS) AP unseen
by any problems before it is deleted from the database. Enter 0
to disable ageout.

Default: 5 minutes

Station ageout Interval The amount of time, in minutes, that a client is unseen by any
probes before it is deleted from the database. Enter 0 to
disable ageout.

Default: 30 minutes

Statistics update Enables or disables statistics update in the database.

Default: disabled

Persistent Neighbor APs When enabled, this feature prevents APs that are marked as
neighbor APs from being aged out.

Default: disabled

Persistent Valid STAs When enabled, this feature prevents valid stations from being
aged out.

Default: disabled

AP learning Enables or disables AP learning. Learning affects the way APs
are classified.

Default: disabled

Propagate Wired Macs Enables the propagation of the gateway wired MAC
information.

Default: enabled

Collect Stats for Monitored APs and Cli-
ents

Enables collection of statistics (up to 25,000 entries) on Mobility
Master for monitored APs and clients.

Default: disabled

Learn System Wired Macs: Enable or disable “learning” of wired MACs on the managed
device.

Default: disabled

In the CLI
Use the following command to configure WMS via the CLI. The parameters in this command are described in
detail in Table 92.
(host)[mynode]config# ids wms-general-profile

Configuring Local WMS Settings
The configuration parameters in IDS WMS local system profile allow the user to change the default behavior
and table sizes of the WMS on specific managed devices.



Configuring Local WMS Settings In the WebUI
To configure the IDS WMS Local System profile

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Expand the IDS menu and select IDS WMS Local System.

3. Configure the parameters as described in Table 93 and then click Save.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Max AP Threshold Set the max threshold for the total number of APs

Max RBTree Entries Set the max threshold for the total number of AP and
station RBTree entries.

Max STA Threshold Set the max threshold for the total number of stations.

Max System Wired MACs Set the max number of system wired MAC table entries
learned by the managed device.

Override Service Termination Override the system-determined termination mode, and
terminate WMS service at the managed device to which the
AP is associated. Do not use this option if you have multiple
managed devices in one location, as WMS will not operate
correctly. For more information, see Mobility Master WMS
Termination vs. Managed Device WMS Termination on
page 478.

Periodic AP Snapshot Interval Set the interval in minutes at which to generate a periodic
snapshot of monitored APs. The (AMON) messages
comprising the snapshot will be spread over this interval.

Periodic Rogue AP Snapshot Interval Set the interval in minutes at which to generate a periodic
snapshot of monitored Rogue APs. The (AMON) messages
comprising the snapshot will be spread over this interval.

Periodic STA Snapshot Interval Set the interval in minutes at which to generate a periodic
snapshot of monitored clients. The (AMON) messages
comprising the snapshot will be spread over this interval.

System Wired MAC Update Interval Set the interval, in minutes, for repopulating the system
wired MAC table at the managed device.

Table 93: IDS WMS Local System Profile Settings

Configuring Local WMS Settings In the CLI
Use the following command to configure local WMS settings via the ids wms-local-system-profile. The
parameters in this command are described in detail in Table 93.
(host) [mynode] (config) #ids wms-local-system-profile
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Mobility Master WMS Termination vs. Managed Device WMS Termination
By default, the devices and events detected by a managed device are sent to Mobility Master, allowing Mobility
Master to update its database with AP, client, and event information from that managed device. This is the
recommended mode for terminating WMS services.

If a managed device is installed at a location with strict bandwidth limitations, the WMS services can optionally
be configured to terminate at the managed device. Local managed device termination of WMS services must
be enabled with caution. Enabling this feature reduces the bandwidth used by messages between the managed
device and Mobility Master,but does introduce some serious limitations. Optimal device classification and IDS
detection/protection requires a centralized network-wide view that is best provided by WMS termination on
Mobility Master.

Enable local (managed device) termination of the WMS service with caution, as enabling this feature may impact
WMS device classification and IDS detection and protection on your network. This feature is only supported on a
network topology where the managed device is geographically away from another managed device
terminating APs.

AMON Messaging between WMS on a Managed Device and WMS on Mobility Master
If you enable local termination of the WMS service on a managed device, the default behavior for this feature
prevents Mobility Master from monitoring devices seen by APs on that managed device. As a result, network
administrators must view these devices via the managed device WebUI and command-line interfaces. This is
the recommended method for monitoring devices at locations where a managed device locally terminates the
WMS service.

However, a managed device can optionally be configured to send AMON messages with information about
monitored devices and events to the WMS service on Mobility Master.The managed device does not send
AMON messages to Mobility Master unless AMON messaging is enabled via Mobility Master WebUI.

Do not enable WMS AMON messages from a managed device to Mobility Master if the WMS service does
not terminate on the managed device, as this will disrupt WMS functionality for the APs associated to
that managed device. AMON messages sent from a managed device to Mobility Master are likely to consume a
substantial amount of bandwidth, potentially eliminating and bandwidth savings provided by local termination of
WMS on a managed device.

To allow a managed device that is locally terminating the WMS service to send AMON messages to Mobility
Master:

1. Configure the Mobility Master as management server for the managed device using the Configuration >
System > More > General page of the Mobility Master WebUI.

2. Enable AMON messaging from the managed device to Mobility Master using the Mgmt Config profile on
the Configuration > System > Profiles page of the Mobility Master WebUI.

Supported AMON Message Types
A managed device terminating the WMS service can send the following AMON message types to Mobility
Master:

l Monitored AP Info Messages: This message is sent when a monitored AP is newly added to the WMS, or a
monitored AP's classification, confidence level, SSID, or encryption type has changed. To enable this
message type, select the Monitored Info - Add/Update option in the Mgmt Config profile.

l Monitored AP Delete Messages: This message is not used by WMS. Although this message type can be
enabled via the Monitored Info - Deletion option in the Mgmt Config profile, best practices is to keep
this option disabled.



l Monitored Station Info Messages: This message is sent when a monitored client is newly added to the
WMS, or a monitored client's BSSID or rogue station type has changed. To enable this message type, select
the Monitored Info - Add/Update option in the Mgmt Config profile.

l Monitored Station Delete Messages: This message is not used by WMS. Although this message type can
be enabled via the Monitored Info - Deletion option in the Mgmt Config profile, best practices is to keep
this option disabled.

l Rogue AP Info Messages: This message is sent when an AP is newly classified as a rogue or suspected
Rogue, or when the AP confidence level changes. To enable this message type, select the Monitored Info -
Add/Update option in the Mgmt Config profile.

l Wireless IDS Event Info Message: (new): This message type sends information about Intrusion
Detection System events as they are seen. To enable this message type, select the Wireless IDS Event Info
option in the Mgmt Config profile.

l Periodic AP Snapshots: This message type sends a snapshot of all monitored APs in WMS every update
period. To enable this message type, select the Monitored Info - Periodic Snapshot option in the Mgmt
Config profile. Use the Periodic STA Snapshot Interval parameter in the IDS WMS Local System profile
to set the interval during which the AP snapshot messages are sent.

l Periodic Station Snapshots: This message type sends a snapshot of all monitored clients in WMS every
update period. To enable this message type, select the Monitored Info - Periodic Snapshot option in the
Mgmt Config profile. Use the Periodic Rogue AP Snapshot Interval parameter in the IDS WMS Local
System profile to set the interval during which the client snapshot messages are sent.

l Periodic Rogue AP Snapshots: This message type sends a snapshot of all rogue APs in WMS every update
period. To enable this message type, select the Monitored Info - Periodic Snapshot option in the Mgmt
Config profile. Use the Periodic AP Snapshot Interval parameter in the IDS WMS Local System profile to
set the interval during which the rogue AP snapshot messages are sent.

Managing the WMS Database
The WMS process interacts with all the air monitor (AM) processes in the network. When WMS receives an
event message from an AM, the WMS process will save the event information along with the BSSID of the AP
that generated the event in the WMS database. Use the following commands in Enable mode to manage the
WMS database.

The wms export-db command exports the specified file as an ASCII text file into the WMS database.
(host)[mynode]#wms export-db <filename>

The wms import-db command imports the specified file into the WMS database:
(host)[mynode]#wms import-db <filename>

The wms reint-db command reinitializes the WMS database. Note that this command does not make an
automatic backup of the current database.

(host)[mynode] #wms reint-db

Optimizing Classification Behavior
APs can be configured to periodically send WMS a list of monitored devices that are still unclassified. Once the
WMS receives this list, a classification message is sent from the WMS to the AP, to classify each unclassified
device.

In the WebUI

1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. Expand the IDS menu and select IDS General.
3. Expand the Advanced accordion.
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4. Configure the parameters as described in Table 94 then click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Unclassified AP Update Enables or disables classification updates for monitored APs. If
this option is enabled, it helps decrease the delay in the speed
at which the devices are classified.

Default: Disabled

Unclassified STA Update Enables or disables classification updates for monitored clients.
If this option is enabled, it helps decrease the delay in the speed
at which the devices are classified.

Default: Disabled

Table 94: IDS General Profile Parameters

In the CLI

Use the following command to configure IDS General Profile parameters using the CLI.
(host) [md](config)# ids general-profile <profile-name>

(host) [md] (IDS General Profile "<profile-name>") #unclass-ap-update

(host) [md] (IDS General Profile "<profile-name>")unclass-device-update-interval

(host) [md] (IDS General Profile "<profile-name>")unclass-sta-update

Managing the List of Valid Exempt Clients
The network administrator can configure clients to be exempted from valid station protection and valid station
misassociation detection by adding the mac-address of those devices to the valid-exempt-list.

Once a client MAC address is added to the valid-exempt list:

l If the client exists in the WMS, the classification is set to valid.

l If the client does not exist in the WMS, a client entry is created and then the classification is set to valid.

l After the classification is done, APs that are seeing the client are notified that the client is added to the valid-
exempt list.

A maximum of 200 MAC addresses can be added to a valid-exempt list. The valid-exempt list is not retained after the
managed device reboots or a process is restarted.

In the CLI

Use the following commands to add or remove MAC addresses from the valid-exempt list:
(host)[md](config) #wms client <macaddr> valid-exempt insert

(host)[md](config) #wms client <macaddr> valid-exempt remove

Use the following command to display a list of configured valid-exempt clients:
(host)[md] #show wms client valid-exempt

Use the following command to display a list of clients that are viewed by the AP and marked as valid-exempt:
(host)[md] #show ap monitor client-list ap-name <> valid-exempt

Use the following command to view the number of MAC addresses added to the valid-exempt client list:
(host)[md] #show wms counters

Counters



--------

Name Value

---- -----

DB Reads 288268

DB Writes 350870

Probe Table DB Reads 2477

Probe Table DB Writes 952

AP Table DB Reads 143992

AP Table DB Writes 138867

STA Table DB Reads 40404

STA Table DB Writes 99687

Probe STA Table DB Reads 101352

Probe STA Table DB Writes 117566

Probe Register 2476

Probe State Update 37077

Set RAP Type 42552

Set RAP Type Conf Level 152

Valid Exempt Station Macs 10

Understanding Client Blacklisting
When a client is blacklisted in the Aruba system, the client is not allowed to associate with any AP in the
network for a specified amount of time. If a client is connected to the network when it is blacklisted, a
deauthentication message is sent to force the client to disconnect. While blacklisted, the client cannot associate
with another SSID in the network.

The managed device retains the client blacklist in the user database, so the information is not lost if the
managed device reboots. When you import or export the managed device’s user database, the client blacklist
will be exported or imported as well.

Methods of Blacklisting
There are several ways in which a client can be blacklisted in the Aruba system:

l You can manually blacklist a specific client. See Blacklisting Manually on page 481 for more information.

l A client fails to successfully authenticate for a configured number of times for a specified authentication
method. The client is automatically blacklisted. See Blacklisting by Authentication Failure on page 482 for
more information.

l A DoS or man in the middle (MITM) attack has been launched in the network. Detection of these attacks can
cause the immediate blacklisting of a client. See Enabling Attack Blacklisting on page 482 for more
information.

l An external application or appliance that provides network services, such as virus protection or intrusion
detection, can blacklist a client and send the blacklisting information to the Mobility Master via an XML API
server. When the managed device receives the client blacklist request from the server, it blacklists the client,
logs an event, and sends an SNMP trap.

See External Services Interface on page 973 for more information.

The External Services Interface feature require the Policy Enforcement Firewall Next Generation (PEFNG) license
installed in the managed device.

Blacklisting Manually
There are several reasons why you may choose to blacklist a client. For example, you can enable different
Aruba intrusion detection system (IDS) features that detect suspicious activities, such as MAC address spoofing
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or DoS attacks. When these activities are detected, an event is logged and an SNMP trap is sent with the client
information. To blacklist a client, you need to know its MAC address.

To manually blacklist a client, issue the following command in enable mode of the CLI:
(host) [md] #stm add-blacklist-client

To clear the entire client blacklist, issue the following command in enable mode of the CLI:
(host) [md] #stm purge-blacklist-clients

Blacklisting by Authentication Failure
You can configure a maximum authentication failure threshold for each of the following authentication
methods:

l 802.1X

l MAC

l Captive portal

l VPN

When a client exceeds the configured threshold for one of the above methods, the client is automatically
blacklisted by the managed device, an event is logged, and an SNMP trap is sent. By default, the maximum
authentication failure threshold is set to 0 for the above authentication methods, which means that there is no
limit to the number of times a client can attempt to authenticate.

With 802.1X authentication, you can also configure blacklisting of clients who fail machine authentication.

When clients are blacklisted because they exceed the authentication failure threshold, they are blacklisted
indefinitely by default. You can configure the duration of the blacklisting; see Setting Blacklist Duration on page 483.

To set the authentication failure threshold via the WebUI:

1. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles expand the Wireless LAN list, select the appropriate authentication profile, then select the
profile instance.

3. Enter a value in the Max Authentication failures field.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To set the authentication failure threshold via the command-line interface, access the CLI in config mode and
issue the following commands:

(host) [md] (config) #aaa authentication {captive-portal|dot1x|mac|vpn} <profile>

(host) [md] (<Auth-Profile> <profile-name>) # max-authentication-failures <number>

Enabling Attack Blacklisting
There are two types of automatic client blacklisting that can be enabled: blacklisting due to spoofed
deauthentication, or blacklisting due to other types of DoS attacks.

Automatic blacklisting for DoS attacks other than spoofed deauthentication is enabled by default. You can
disable this blacklisting on a per-SSID basis in the virtual AP profile.

Man in the middle (MITM) attacks begin with an intruder impersonating a valid enterprise AP. If an AP needs to
reboot, it sends deauthentication packets to connected clients to enable them to disconnect and reassociate
with another AP. An intruder or attacker can spoof deauthentication packets, forcing clients to disconnect from
the network and reassociate with the attacker’s AP. A valid enterprise client associates to the intruder’s AP,



while the intruder then associates to the enterprise AP. Communication between the network and the client
flows through the intruder (the man in the middle), thus allowing the intruder the ability to add, delete, or
modify data. When this type of attack is identified by the Aruba system, the client can be blacklisted, blocking
the MITM attack. You can enable this blacklisting ability in the IDS DoSprofile (this is disabled by default).

To enable spoofed deauth detection and blacklisting via the WebUI:

1. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles , expand the IDS menu, then select a profile from the IDS DOS profile list.

3. Select the Spoofed Deauth Blacklist check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

To enabled spoofed deauth detection and blacklisting via the command-line interface, access the CLI in config
mode, and issue the following commands:
(host) [md] (config) #ids dos-profile defaultids dos-profile <profile>

(host) [md] (IDS Denial Of Service Profile "default") #spoofed-deauth-blacklist

Setting Blacklist Duration
You can configure the duration that clients are blacklisted on a per-SSID basis via the virtual AP profile. There
are two different blacklist duration settings:

l For clients that are blacklisted due to authentication failure. By default, this is set to 0 (the client is
blacklisted indefinitely).

l For clients that are blacklisted due to other reasons, including manual blacklisting. By default, this is set to
3600 seconds (one hour). You can set this to 0 to blacklist clients indefinitely.

To configure the blacklist duration via the WebUI:

1. In the Managed Networks node hierarchy, navigate to the Configuration >System > Profiles page.

2. In All Profiles, select Wireless LAN, then Virtual AP. Select the virtual AP instance.

a. To set a blacklist duration for authentication failure, expand the Advanced accordion and enter a value
for Authentication Failure Blacklist Time.

b. To set a blacklist duration for other reasons, expand the Advanced accordion and enter a value for
Blacklist Time.

3. Click Save.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

To configure the blacklist duration via the command-line interface, access the CLI in config mode and issue the
following commands:
(host) [md] (config) #wlan virtual-ap default

(host) [md] (Virtual AP profile "default") #auth-failure-blacklist-time <seconds>

(host) [md] (Virtual AP profile "default") #blacklist-time <seconds>

Removing a Client from Blacklisting
To remove a client from blacklisting via the command-line interface, access the CLI in enable mode and issue
the following command:
(host) [md] #stm remove-blacklist-client <macaddr>

ArubaOS 8.0.0.0 | User Guide Wireless Intrusion Prevention |  483



484 | Wireless Intrusion Prevention ArubaOS 8.0.0.0  | User Guide

Working with WIP Advanced Features
Device Classification is the first step in securing the corporate environment from unauthorized wireless access.
Adequate measures that quickly shut down intrusions are critical in protecting sensitive information and
network resources. APs and stations must be accurately classified to determine whether they are valid, rogue,
or a neighboring AP. Then, an automated response can be implemented to prevent possible intrusion
attempts.

TotalWatch™ allows for detecting devices that are running on typical operational channels. Tarpit Shielding
provides a better way of containing devices that are deemed unauthorized. Both of these features are
discussed in the sections that follow.

l Configuring TotalWatch on page 484

l Administering TotalWatch on page 486

l Tarpit Shielding Overview on page 487

l Configuring Tarpit Shielding on page 487

Configuring TotalWatch
Aruba 802.11n APs and non-11n APs in AM-mode support for TotalWatch is the ability to scan all channels of
the RF spectrum, including 2.4-and 5-GHz bands as well as the 4.9-GHz public safety band. TotalWatch also
provides 5-MHz granular channel scanning of bands for rogue devices and dynamic scanning dwell times to
focus on those channels with traffic. TotalWatch provides an advanced set of features to detect unauthorized
wireless devices and a set of customized rules are used to highlight devices that truly pose a threat to the
network.

TotalWatch is supported on APs deployed in the AM-mode only.

TotalWatch provides monitoring support for the entire WLAN spectrum. Aruba APs in the AM-mode can
monitor the following frequencies:

l 2412MHz to 2472MHz in the 2.5GHz band

l 5100Mhz to 5895MHz in the 5GHz band.

Aruba APs in AM-mode can scan the following additional frequencies:

l 2484 MHz and 4900Mhz to 5000MHz (J-channels)

l 5000 to 5100Mhz

If the AP is HT-capable (High Throughput), these frequencies are scanned in the 40MHz mode.

Understanding TotalWatch Channel Types and Qualifiers
Based on the regulatory characteristics, channels are categorized into the following types:

l Reg-domain Channels : A channel that belongs to the regulatory domain of the country in which the AP is
deployed. The set of channels that belong to this group is a subset of the channels in the all-reg-domain
channel group.

l All-reg-domain Channels : A valid non-overlapping channel that is in the regulatory domain of at least one
country. The channels in this category belong in the frequency ranges of:

n 2412MHz to 2472MHz in the g-band

n 5100Mhz to 5895MHz in the a-band.



l Rare Channel : Channels that fall into a frequency range outside of the regulatory domain; 2484 MHz and
4900MHz-4995MHz (J-channels), and 5000-5100Mhz. The channels in this group do not belong to any
other group.

Each of these channel types can have an associated qualifier:

l Active Channel : This qualifier indicates that wireless activity is detected on this channel by the presence of
an AP or other 802.11 activity such as a probe request.

l DOS Channel : A channel where wireless containment is active. This channel should belong to the country-
code channel (regulatory domain).

Understanding TotalWatch Monitoring Features
TotalWatch enables monitoring of all channels including regulatory domain and rare channels. You can select
one of the following scanning modes for each radio AP:

l scan only the channels that belong to the AP’s regulatory domain

l scan channels that belong to all regulatory domains

l scan all channels

Understanding TotalWatch Scanning Spectrum Features
TotalWatch scans the following frequencies.

l G-band—2412MHz to 2472MHz

l J-band—2484 MHz and 4900-4995MHz

l A-band—5000-5100Mhz to 5895MHz

Table 95 list the frequency-to-channel mapping used by TotalWatch.

Frequency Channel

2412 – 2472MHz (in increments of
5MHz)

1 - 13

2484MHz 14

5100 – 5895MHz (in increments of
5MHz)

20 - 179

4900 – 4995MHz (in increments of
5MHz)

180 - 199

5000 – 5100MHz 200 - 219

Table 95: Frequency to Channel Mapping

Understanding TotalWatch Channel Dwell Time
When an AP (in am-mode) visits a channel, the amount of time the AP stays on that channel is known as the
dwell time. The channel dwell time is a variable value based on the following channel types.

l dwell-time-active-channel : For channels where there is wireless activity. Default setting is 500 ms.

l dwell-time-reg-domain channel : For channels that belong to the AP’s regulatory domain group (reg-
domain) with nowireless activity. The default setting is 250 ms.
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l dwell-time-other-reg-domain-channel : For channels that belong to the all regulatory domain group (all-
reg-domain) with nowireless activity The default setting is 250 ms.

l dwell-time-rare-channel : For channels in the rare group where nowireless activity is detected. The
default value is 100 ms.

Use the rf am-scan-profile command to set the dwell time and scan mode.

Understanding TotalWatch Channel Visiting
The Active and DOS channels are visited more frequently than the other channels. The order of preference in
selecting the next channel is:

1. DOS

2. Active

3. reg-domain

4. All-reg-domain

5. Rare

Once a channel is selected, the dwell time for that channel is determined based on the channel type. At the end
of the dwell time, a new channel is picked.

Understanding TotalWatch Age out of Devices
ArubaOS uses a combination of inactivity time and unseen time to age out a device. This ensures that the
channel is scanned a sufficient number of times before a device ages out. AM module maintains the following
parameters:

l Discovered Time : The absolute time, in seconds, since the device was discovered.

l Monitored Time : The number of times the channel was scanned since discovery.

l Inactivity Time : The number of times the device was not “seen” when the channel is scanned.

l Unseen Time : The absolute time, in seconds, since the device was last “seen.”

Administering TotalWatch
The AM module will initialize the channel list for each of the AP’s radio based on the scan mode setting for the
radio. For example, if scan mode is set to rare, then the channel list will contain all possible channels. You can
view these channels by using the show ap arm scan-times command.

Configuring Per Radio Settings
For each radio, you can configure the following settings (for detailed information on commands, refer to the
ArubaOS 8.0.0.0 Command Line Reference Guide):

l the dwell times for the various channel types

l the channel list that should be used for scanning

These settings are configured via the command rfam-scan-profile, which can be attached to the two profiles,
dot11a-radio-profile and dot11g-radio-profile.

The am-scan-profile includes the following parameters that can be configured:
rf am-scan-profile <name>

scan-mode [reg-domain | all-reg-domain | rare]

The default setting is the all-reg-domain. This is consistent with the default functioning of the AM scanning
where the radio scans channels belonging to all regulatory domains.



Configuring Per AP Setting
If the AP is a dual-band single radio AP, an option is available to specify which band should be used for scanning
in AM-mode. This setting is available in the ap system-profile, via the am-scan-rf-band command.

ap system-profile <name>

am-scan-rf-band [a | g | all]

The default value is “all”, which is consistent with the prior behavior. This setting is ignored in the case of a dual
radio AP.

There are four parameters that will control the age out of devices in the AM module.
ids general-profile <name>

ap-inactivity-timeout

sta-inactivity-timeout

ap-max-unseen-timeout

sta-max-unseen-timeout

The inactivity timeout is the number of times the device was not “seen” when the channel was scanned. The
unseen timeout is the time, in seconds, since the device was last “seen.”

The show ap monitor scan-info/channel commands provide details of the channel types, dwell times, and
the channel visit sequence.

(host) # show ap monitor scan-info ap-name rb-121

Licensing
The ability to perform rare scanning is available only with the RFprotect license. However, the AP can scan ‘reg-
domain’ or ‘all-reg-domain’ channels without the RFprotect license.

Tarpit Shielding Overview
The Tarpit Shielding feature is a type of wireless containment. Detected devices that are classified as rogues are
contained by forcing client association to a fake channel or BSSID. This method of tarpitting is more efficient
than rogue containment via repeated de-authorization requests. Tarpit Sheilding works by spoofing frames
from an AP to confuse a client about its association. The confused client assumes it is associated to the AP on a
different (fake) channel than the channel that the AP is actually operating on, and will attempt to communicate
with the AP in the fake channel.

Tarpit Shielding works in conjunction with the deauth wireless containment mechanism. The deauth
mechanism triggers the client to generate probe request and subsequent association request frames. The AP
then responds with probe response and association response frames. Once the monitoring AP sees these
frames, it will spoof the probe-response and association response frames, and manipulates the content of the
frames to confuse the client.

A station is determined to be in the Tarpit when we see it sending data frames in the fake channel. With some
clients, the station remains in tarpit state until the user manually disables and re-enables the wireless interface.

Configuring Tarpit Shielding
Tarpit shielding is configured on an AP using one of two methods:

l Disable all clients : In this method, any client that attempts to associate with an AP marked for
containment is sent spoofed frames.

l Disable non-valid clients : In this method, only non-authorized clients that attempt to associate with an
AP are sent to the tarpit.

The choices for disabling Tarpit Shielding on an AP are:
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l Deauth-wireless-containment

l Deauth-wireless-containment with tarpit-shielding (excluding-valid-clients)

l Deauth-wireless-containment with tarpit-shielding

Enabling Tarpit Shielding
Use the ids-general-profile command to configure Tarpit Shielding (for detailed information on commands
refer to the ArubaOS Command Line Reference Guide).
ids general-profile default

wireless-containment [deauth-only | none | tarpit-all-sta | tarpit-non-valid-sta]

Use the following show commands to view updated Tarpit Shielding status and the spoofed frames generated
for an AP:
show ap monitor stats …

show ap monitor containment-info

Understanding Tarpit Shielding Licensing CLI Commands
Under the ids general-profile default wireless-containment command, the ‘tarpit-non-valid-sta’ and
‘tarpit-all-sta’ options are available only with a RFprotect license. The ‘deauth-only’ and ‘none’ options are
available with the Base OS license.
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Chapter 25
Access Points

When an AP is first installed on the network and powered on, the AP locates its host managed device and the
AP’s designated configuration is “pushed” from the Mobility Master to the AP. This chapter gives an overview of
the basic functions of each AP, and describes the process to install and configure the APs on your network.

The following topics are included in this chapter:

l Basic Functions and Features on page 489

l AP Settings Triggering a Radio Restart on page 490

l Naming and Grouping APs

l Understanding AP Configuration Profiles on page 495

l Before you Deploy an AP on page 497

l Enable Controller Discovery on page 497

l Enable DHCP to Provide APs with IP Addresses

l Enable Controller Discovery on page 497

l Configuring Installed APs on page 502

l Optional AP Configuration Settings on page 509

l Configuring AP Image Preload on page 507

l 2.4 Ghz and 5 Ghz Radio RF Management on page 523

l Validating and Optimizing AP Connectivity on page 534

l AP Chanel Scanning on page 535

l Managing AP Console Settings on page 537

l Link Aggregation Support on page 541

l Support for Port Bounce on page 544

Basic Functions and Features
Use the Mobility Master WebUI and command-line interface to configure APs. Table 96 lists the basic AP
configuration functions and features.
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Features
and
Function

Description

Wireless
LANs

A wireless LAN (WLAN) permits wireless clients to connect to the network. An AP
broadcasts the SSID (which corresponds to a WLAN configured on the Mobility Master) to
wireless clients. APs support multiple SSIDs. WLAN configuration includes the
authentication method and the authentication servers by which wireless users are
validated for access.

The WebUI includes a WLAN Wizard that provides easy-to-follow steps to configure a new
WLAN.

NOTE: All new WLANs are associated with the ap-group named “default”.

AP operation An AP can function as an AP that serves clients, as an air monitor (AM) performing
network and radio frequency (RF) monitoring, or as a hybrid AP that serves both clients
and performs spectrum analysis a single radio channel. You can also specify the
regulatory domain (the country) which determines the 802.11 transmission spectrum in
which the AP will operate. Within the regulated transmission spectrum, you can configure
802.11a, 802.11b/g, or 802.11n (high-throughput) radio settings.

NOTE: The 802.11n features, such as high-throughput and 40 MHz configuration
settings, are supported on APs that are 802.11n standard compliant.

Quality of
Service (QoS)

Configure Voice over IP call admission control options and bandwidth allocation for 5 GHz
(802.11a) or 2.4 GHz (802.11b/g) frequency bands of traffic.

RF
Management

Configure settings for balancing wireless traffic across APs, detect holes in radio
coverage, or other metrics that can indicate interference and potential problems on the
wireless network.

Adaptive Radio Management (ARM) is an RF spectrum management technology that
allows each AP to determine the best 802.11 channel and transmit power settings. ARM
provides several configurable settings.

Intrusion
Detection
System

Configure settings to detect and disable rogue APs, adhoc networks, and unauthorized
devices, and prevent attacks on the network. You can also configure signatures to detect
and prevent intrusions and attacks.

Mesh Configure Aruba APs as mesh nodes to bridge multiple Ethernet LANs or extend wireless
coverage. A mesh node is either

l a mesh portal: an AP that uses its wired interface to reach the managed device

l a mesh point: an AP that establishes a path to the managed device via the mesh
portal

Mesh environments use a wireless backhaul to carry traffic between mesh nodes. This
allows one 802.11 radio to carry traditional WLAN services to clients and one 802.11
radio to carry mesh traffic and WLAN services. Secure Enterprise Mesh on page 545
contains more specific information on the Mesh feature.

Table 96: AP Configuration Function Overview

AP Settings Triggering a Radio Restart
Changing the following settings triggers the radio to restart on the 200 Series, AP-205H, 210 Series, 220 Series,
270 Series and 320 Series access points. When the radio restarts, wireless services will be briefly interrupted.
Clients will automatically reconnect to the network when the radio is again up and running.



Profile Settings

802.11a/802.11g Radio Profile l Channel

l Enable Channel Switch Announcement (CSA)

l CSA Count

l High throughput enable (radio)

l Very high throughput enable (radio)

l TurboQAM enable

l Maximum distance (outdoor mesh setting)

l Transmit EIRP

l Advertise 802.11h Capabilities

l Beacon Period/Beacon Regulate

l Advertise 802.11d Capabilities

Virtual AP Profile l Virtual AP enable

l Forward Mode

l Remote-AP operation

SSID Profile l ESSID

l Encryption

l Enable Management Frame Protection

l Require Management Frame Protection

l Multiple Tx Replay Counters

l Strict Spectralink Voice Protocol (SVP)

l Wireless Multimedia (WMM) settings
n Wireless Multimedia (WMM)
n Wireless Multimedia U-APSD (WMM-UAPSD) Powersave
n WMM TSPEC Min Inactivity Interval
n Override DSCP mappings for WMM clients
n DSCP mapping for WMM voice AC
n DSCP mapping for WMM video AC
n DSCP mapping for WMM best-effort AC
n DSCP mapping for WMM background AC

Table 97: Profile Settings that restart an AP radio
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Profile Settings

High-throughput SSID Profile l High throughput enable (SSID)

l 40 MHz channel usage

l Very High throughput enable (SSID)

l 80 MHz channel usage (VHT)

802.11r Profile l Advertise 802.11r Capability

l 802.11r Mobility Domain ID

l 802.11r R1 Key Duration

l key-assignment (CLI only)

Hotspot 2.0 Profile l Advertise Hotspot 2.0 Capability

l RADIUS Chargeable User Identity (RFC4372)

l RADIUS Location Data (RFC5580)

Table 97: Profile Settings that restart an AP radio

Naming and Grouping APs
In the Aruba user-centric network, each AP has a unique name and belongs to an AP group.

Each AP is identified with an automatically-derived name. The default name depends on if the AP has been
previously configured.

l The AP has not been configured—the name is the AP’s Ethernet MAC address in colon-separated
hexadecimal digits.

l Configured with a previous ArubaOS release—the name is in the format building.floor.location

You can assign a new name (up to 63 characters) to an AP; the new name must be unique within your network.
For example, you can rename an AP to reflect its physical location within your network, such as “building3-
lobby”.

An AP group is a set of APs to which the same configuration is applied. There is an AP group called “default” to
which all APs discovered by the managed device are assigned. By using the “default” AP group, you can
configure features that are applied globally to all APs.

You can create additional AP groups and assign APs to that new group. However, an AP can belong to only one
AP group at a time. For example, you can create an AP group “Victoria” that consists of the APs that are
installed in a company’s location in British Columbia. You can create another AP group “Toronto” that consists
of the APs in Ontario. You can configure the “Toronto” AP group with different information from the APs in the
“Victoria” AP group.

While you can use an AP group to apply a feature to a set of APs, you can also configure a feature or option for
a specific AP by referencing the AP’s name. Any options or values that you configure for a specific AP will
override the same options or values configured for the AP group to which the AP belongs.

The following procedures describes how to create an AP group.

Reassigning an AP from an AP group requires a reboot of the AP for the new group assignment to take effect.
Therefore, wait until there is little or no client traffic passing through the AP before reassigning it.



Creating an AP group
You can use the WebUI or the CLI to create a new AP group.

In the WebUI
1. In the Managed Network node hierarchy, select the managed device where the AP group are to be added.

2. Navigate to the Configuration > AP Groups menu.

3. Click Add below the AP Groups table.

4. In the New AP Groups window, enter the AP group name in the New AP groups field.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
Use the following command to create an AP group:

(host) [mynode](config) #ap-group <group>

When you create an AP group with the CLI, you can specify the virtual AP definitions and configuration profiles
you want applied to the APs in the group.

Assigning an AP to an AP Group
Although you will assign an AP to an AP group when you first deploy the device, you can assign an AP to a
different AP group at any time.

Once the ap-regroup command is executed, the AP automatically reboots. If the AP is powered off or otherwise not
connected to the network or managed device, the executed command is queued until the AP is powered on or
reconnected.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points menu.

2. Select the check box next to the AP and click Provision.

3. From the list of provisioning settings, click the AP group drop-down list and choose a new the AP group for
the selected AP.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

In the CLI
Use the following command to assign a single AP to an existing AP group.

(host) [mynode](config) #ap-regroup {ap-name <name>|serial-num <number>|wired-mac

<macaddr>} <group>

Assigning Channels to an AP Group
The country code in the AP Regulatory Domain profile determines supported channel and channel pairs for
that specific AP. Any changes to the country code causes the valid channel lists to be reset to the defaults for
the country.

This section illustrates how to perform the following tasks for an AP group:
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l Configure the “default” regulatory domain profile to use a valid country code. This will determine the
available channels.

l Configure a 40 MHz channel (bonded pair) for the AP group’s 802.11a (5 GHz) radio profile.

l Configure a 20 MHz channel for the AP group’s 802.11g (2.4 GHz) radio profile.

Using the WebUI
1. In the Managed Network node hierarchy, select the managed device containing the AP group.

2. Navigate to the Configuration > AP Groups page.

3. Select the AP group to be configured.

4. Select the Radio tab from the AP group menu and click Basic accordion.

5. Select 2.4 GHz or 5 GHz radio to be configured and click Edit in the Valid Channels field.

6. In the Valid Channels window, select the channels that will be supported by the AP group.

7. Click OK.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy Changes.

Using the CLI
The following commands may be used to configure channels for an AP group.

(host) [mynode](config) #ap regulatory-domain-profile default

   country-code US

(host) [mynode](config) #rf dot11a-radio-profile ht-corpnet-a

   channel 36+

(host) [mynode](config) #rf dot11g-radio-profile ht-corpnet-g

   channel 1

Country codes are generally specified in ISO 3166 format. To see what channels are available for a given country
code, use the show ap allowed-channels country-code <country-code> command.

Channel Switch Announcement (CSA)
When an AP changes its channel, an existing wireless clients may “time out” while waiting to receive a new
beacon from the AP; the client must begin scanning to discover the new channel on which the AP is operating.
If the disruption is long enough, the client may need to reassociate, reauthenticate, and request an IP address.
Channel Switch Announcement (CSA), as defined by IEEE 802.11h, enables an AP to announce that it is
switching to a new channel before it begins transmitting on that channel. This allows the clients, who support
CSA, to transition to the new channel with minimal downtime.

When CSA is enabled, the AP does not change to a new channel immediately. Instead, it sends a number of
beacons (the default is 4) which contain the CSA announcement before it switches to the new channel. You can
configure the number of announcements sent before the change.

Clients must support CSA in order to track the channel change without experiencing disruption.

Using the WebUI
1. In the Managed Network node hierarchy, select the managed device containing the AP group.

2. Navigate to the Configuration > AP Groups page.

3. Select the AP group to be configured.

4. Select Radio tab from the AP group menu and click Advanced accordion.



5. Select Enabled from the CSA drop-down list. This option can be enabled/disabled separately for 2.4 GHz
and 5 GHz radios.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy Changes.

Automatic Channel and Transmit Power Selection
To allow automatic channel and transmit power selection based on the radio environment, enable Adaptive
Radio Management (ARM). Note that ARM assignments will override the static channel and power
configurations done using the radio profile. For complete information on the Adaptive Radio Management
feature, refer to RF Planning and Channel Management on page 434.

Understanding AP Configuration Profiles
An AP configuration profile is a general name to describe any of the different groups of settings that can
defined, saved, and applied to an Access Point. ArubaOS has many different types of profiles that each allow
you to configure a different aspect of an AP’s overall configuration. ArubaOS also contains a predefined
“default” profile for each profile type. You can use the predefined settings in these default profiles, or create
entirely new profiles that you can edit as required.

Each different AP configuration profile type can be managed using the CLI or the WebUI. To see a full list of
available configuration profiles using the command-line interface, access the CLI and issue the command show
profile-hierarchy. To view available configuration profiles using the WebUI, navigate to Configuration >
System, then select the Profiles tab.

The profile types that appear in the All Profiles list may vary, depending upon the controller configuration and
available licenses.

AP Profiles
The AP profiles configure AP operation parameters, radio settings, port operations, regulatory domain, and
SNMP information.

l AM Filter: Clients may assign APs/AP groups to Air Monitor (AM) filter profiles. These profiles collect data
that is used to identify and monitor APs, wireless clients, and mesh nodes within the network.

l AP Authorization: Allows you to assign an to a provisioned but unauthorized AP to a AP group with a
restricted configuration profile. For details see Configuring Remote AP Authorization Profiles on page 653.

l AP Ethernet Link: Sets the duplex mode and speed of the AP’s Ethernet link. The configurable speed is
dependent on the port type, and you can define a separate Ethernet Interface profile for each Ethernet link.
For details on configuring this profile, see Ethernet Interface Link Profile Parameters on page 512

l AP LACP LMS map information: maps a LMS IP address to a GRE striping IP address. If the AP fails over
to a standby or backup Mobility Master, the AP LACP LMS map information profile on the new LC defines
the striping IP address that the AP uses for link aggregation. For details, see Configuring LACP.

l AP LLDP and AP LLDP-MED Network Policy: Link Layer Discovery Protocol (LLDP), is a Layer-2 protocol
that allows network devices to advertise their identity and capabilities on a LAN. The LLDP-MED Network
Policy profile defines the VLAN, priority levels, and DSCP values used by a voice or video application. Wired
interfaces on Aruba APs support LLDP by periodically transmitting LLDP Protocol Data Units (PDUs)
comprised of selected type-length-value (TLV) elements. The AP LLDP profile identifies which TLVs will be
sent by the AP. For details, see Understanding Extended Voice and Video Features on page 911.
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l AP multizone: The MultiZone feature allows AP to terminate to multiple managed devices that reside in
different zones. A zone is a collection of managed devices under a single administration domain. For details,
see MultiZone

l AP system: defines administrative options for the controller, including the IP addresses of the local,
backup, and master controllers, Real-time Locating Systems (RTLS) server values and the number of
consecutive missed heartbeats on a GRE tunnel before an AP reboots. For details on configuring this profile,
see Optional AP Configuration Settings.

l AP Wired Port: specifies a AAA profile for users connected to the wired port on an AP.

l EDCA Parameters (AP): AP to client traffic prioritization, including EDCA parameters for background, best-
effort, voice and video queues. For additional information on configuring this profile, see Configure EDCA
parameters on page 871.

l EDCA Parameters (Station): client to AP traffic prioritization parameters, including Enhanced Distributed
Channel Access (EDCA) parameters for background, best-effort, voice and video queues. For additional
information on configuring this profile, see Configure EDCA parameters on page 871.

l Regulatory Domain: defines the AP’s country code and valid channels for both legacy and high-
throughput 802.11a and 802.11b/g radios.

l Spectrum Local Override: configure an individual AP radio as a spectrum monitor, For details, see
Converting AP to Spectrum Monitor on page 680.

l Wired AP: determines if 802.11 frames are tunneled to the controller using Generic Routing Encapsulation
(GRE) tunnels, bridged into the local Ethernet LAN, or configured for a combination of the two (split-mode).
In tunnel forwarding mode, the AP handles all 802.11 association requests and responses, but sends all
802.11 data packets, action frames and EAPOL frames over a GRE tunnel to the controller for processing.
When a remote AP or campus AP is in bridge mode, the AP handles all 802.11 association requests and
responses, encryption/decryption processes, and firewall enforcement. In split-tunnel mode, 802.11 frames
are either tunneled or bridged, depending on the destination (corporate traffic goes to the controller, and
Internet access remains local). For details, see Configuring Ethernet Ports for Mesh on page 573

RF Management Profiles
The profiles configure radio tuning and calibration, AP load balancing, and RSSI metrics.

l 802.11a: defines AP radio settings for the 5 GHz frequency band, including the Adaptive Radio
Management (ARM) profile and the high-throughput (802.11n) radio profile. For additional information on
configuring this profile, see 2.4 Ghz and 5 Ghz Radio RF Management on page 523.

l 802.11g: defines AP radio settings for the 2.4 GHz frequency band, including the Adaptive Radio
Management (ARM) profile and the high-throughput (802.11n) radio profile. Each 802.11a and 802.11b
radio profile includes a reference to an Adaptive Radio Management (ARM) profile.

If you want ARM to dynamically select the best channel and transmission power for the radio, verify that
the 802.11a/802.11g radio profile references an active and enabled ARM profile. If you want to manually
select a channel for each AP group, create separate 802.11a and 802.11g profiles for each AP group and
assign a different transmission channel for each profile. For additional information on configuring this
profile, see 2.4 Ghz and 5 Ghz Radio RF Management on page 523.

l Adaptive Radio Management (ARM): defines the Adaptive Radio Management (ARM) settings for
scanning, acceptable coverage levels, transmission power and noise thresholds. In most network
environments, ARM does not need any adjustments from its factory-configured settings. However, if you
are using VoIP or have unusually high security requirements you may want to manually adjust the ARM
thresholds. For complete details on Adaptive Radio Management, refer to Configuring ARM Profiles on page
447.

l AM Scanning: Aruba 802.11n APs and non-11n APs in AM-mode support the TotalWatch scanning feature
giving them the ability to scan all channels of the RF spectrum, including 2.4-and 5-GHz bands as well as the



4.9-GHz public safety band. The AM Scanning profile enables this feature, and defines the dwell types for
different channel types.

l High-throughput radio: manages high-throughput (802.11n) radio settings for 802.11n-capable APs. A
high-throughput profile determines 40 Mhz tolerance settings, and controls whether or not the APs using
this profile will advertise intolerance of 40 MHz operation. (This option is disabled by default, allowing 40
MHz operation.) For additional information on configuring this profile, see High-Throughput APs on page
528.

l RF Event Thresholds: defines error event conditions, based on a customizable percentage of low-speed
frames, non-unicast frames, or fragmented, retry or error frames. For additional information on configuring
this profile, see RF Event Configuration on page 527.

l RF Optimization: enables or disables load balancing based on a user-defined number of clients or degree
of AP utilization on an AP. Use this profile to detect coverage holes, radio interference and STA association
failures and configure Received signal strength indication (RSSI) metrics.

Before you Deploy an AP
Before you install APs in a network environment, you must ensure that the APs are able to locate and connect
to the managed device. Specifically, you must configure firewall settings to allow APs to obtain software images
and configuration settings from the controller, verify APs are able to locate the Mobility Master, and verify each
AP is assigned a valid IP address when connected to the network. If you want to provision APs with more than
one interface, you can also configure the USB settings and interface priority levels using an AP provisioning
profile.

Mobility Master cannot be used as an AP master since APs are not allowed to terminate on a Mobility Master. If the
AP manager on Mobility Master receives an AP HELLO message, the message is dropped.

The following steps describe the basic pre-deployment tasks. Click any of the links for more information on
these procedures.

1. Configure Firewall Settings

2. Enable Controller Discovery

3. Enable DHCP

4. (Optional) Define the AP Provisioning Profile

5. Define a virtual AP profile, and assign that profile to an AP group

Mesh AP Preconfiguration
Mesh APs require the following additional steps to define the mesh networking environment.

l Define and configure the mesh cluster profile.

l Define and configure the mesh radio profile

Remote AP Preconfiguration
Remote APs require the following additional step to identify valid APs in the remote AP whitelist.

l Create a Remote AP whitelist

Enable Controller Discovery
An AP can discover the IP address of the controller from a DNS server, from a DHCP server, or using the
Aruba Discovery Protocol (ADP).
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At boot time, the AP builds a list of managed device IP addresses and then tries these addresses in order until it
successfully reaches a managed device . This list of IP addresses provides an enhanced redundancy scheme for
managed device that are located in multiple data centers separated across Layer-3 networks. The AP constructs
its list of managed device addresses as follows:

l If the provisioning parameter is set to a DNS name, that name is resolved and all resulting addresses are put
on the list. If is set to an IP address, that address is put on the list.

l If the provisioning parameter is not set and a managed device address was received in DHCP Option 43,
that address is put on the list.

l If the provisioning parameter is not set and no address was received via DHCP option 43, ADP is used to
discover a managed device address and that address is put on the list.

l Managed device addresses derived from the server-name and server-ip provisioning parameters and the
default managed device name aruba-master are added to the list. Note that if a DNS name resolves to
multiple addresses, all addresses are added to the list.

Controller Discovery using DNS
When using DNS, AP learns multiple IP addresses to associate with a managed device. If the primary node is
unavailable or does not respond, the AP continues through the list of learned IP addresses until it establishes a
connection with an available managed device. This takes approximately 3.5 minutes per managed device.

It is recommended you use a DNS server to provide APs with the IP address of the managed device because it
involves minimal changes to the network and provides the greatest flexibility in the placement of APs.

APs are factory-configured to use the host name aruba-master for the Mobility Master. For the DNS server to
resolve this host name to the IP address of the Mobility Master, you must configure an entry on the DNS
server for the name aruba-master.

Controller Discovery using ADP
ADP is enabled by default on all Aruba APs and managed devices. With ADP, APs send out periodic multicast
and broadcast queries to locate the Mobility Master. ADP requires that all APs and managed devices are
connected to the same Layer-2 network. If the devices are on different networks, you must use a Layer-3
compatible discovery mechanism, such as DNS, DHCP, or IGMP forwarding.

To use ADP discovery:

1. Issue the command show adp config to verify that ADP and IGMP join options are enabled on the
managed device, If ADP is not enabled, you can reenable ADP using the command adp discovery enable
and adp igmp-join enable.

2. If the APs are not in the same broadcast domain as the Mobility Master, you enable multicast on the
network (ADP multicast queries are sent to the IP multicast group address 239.0.82.11) for the Mobility
Master to respond to the APs’ queries. You also must make sure that all routers are configured to listen for
Internet Group Management Protocol (IGMP) join requests from the controller and can route these
multicast packets.

Controller discovery using a DHCP Server
You can configure a DHCP server to provide the Mobility Master’s IP address. You must configure the DHCP
server to send the managed device’s IP address using the DHCP vendor-specific attribute option 43. The APs
identify themselves with a vendor class identifier set to ArubaAP in their DHCP requests. When the DHCP
server responds to a request, it will send the managed device’s IP address as the value of option 43.

When using DHCP option 43, the AP accepts only one IP address. If the IP address of the managed
deviceprovided by DHCP is not available, the AP can use the other IP addresses provisioned or learned by DNS



to establish a connection. For more information on how to configure vendor-specific information on a DHCP
server, see DHCP with Vendor-Specific Options on page 1036 or refer to the documentation included with your
server.

Enable DHCP to Provide APs with IP Addresses
Each AP requires a unique IP address on a subnetwork that has connectivity to a managed device. It is
recommended you use the Dynamic Host Configuration Protocol (DHCP) to provide IP addresses for APs; the
DHCP server can be an existing network server or a managed device configured as a DHCP server.

If you do not enable DHCP, each AP must be manually configured with an IP address through the AP provisioning
profile.

You can use an existing DHCP server in the same subnetwork as the AP to provide the AP with its IP
information. You can also configure a device in the same subnetwork to act as a relay agent for a DHCP server
on a different subnetwork. (Refer to the vendor documentation for the DHCP Server or relay agent for
information.)

The Mobility Master can configure the managed device as a DHCP server to assign an IP address to the AP. The
managed device must be the only DHCP server for this subnetwork.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services window.

2. Open the DHCP Server tab
3. Select Enable from either IPv4 or IPv6 DHCP server drop-down list.

4. In the Pool Configuration table, click Add.

5. Enter information about the subnetwork for which IP addresses are to be assigned.

6. Click Submit.

Table 98: DHCP Configuration Parameters

Parameter Description

IP Version Select the IP version used by the DHCP pool configuration

Pool name Enter the name of the DHCP pool.

Default routers Enter an IP address to assign the DHCP default router for the managed device

DNS Servers Enter an IP address to assign the DHCP DNS server for the managed device

Import from DHCP/PPPoE Enables/disables importing of DNS server configurations.

WINS Enter IP address to assign WINS servers. When enterning multiple servers,
each server must be separated by a space.

Import from DHCP/PPPoE Enables/disables importing WINS server configurations.
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Parameter Description

Lease days Length of time a device may lease the DHCP in days. Entering 0 indicates no
time limit.

Lease hours Length of time a device may lease the DHCP in hours.

Lease minutes Length of time a device may lease the DHCP in minutes.

Lease seconds Length of time a device may lease the DHCP in seconds.

Network IP mask Enter an IP address to assign the netmask for the DHCP pool

Excluding IP Addresses
If there are addresses that should not be assigned in the subnetwork:

1. Click Add in the Excluded Address Range table that corresponds with the IP version used.

2. Enter the address range in the Add Excluded Address section.

3. Click Apply.

In the CLI
The following commands can be used to configure the DHCP services.
(host)[node](config)# ap system-profile <profile>

rap-dhcp-default-router <ip-addr>

rap-dhcp-dns-server <ip-addr>

rap-dhcp-lease

rap-dhcp-pool-end

rap-dhcp-pool-start

rap-dhcp-pool-netmask

rap-dhcp-server-id

rap-dhcp-server-vlan

(host)[node](config)# ip dhcp

adaptive

default-pool

excluded-address

load-balance

ping-check

pool

(host)[node](config)# service

dhcp

dhcpv6

AP Provisioning
AP provisioning settings allow you to define a set of additional provisioning information for an AP, such as USB
modem settings, PPPoE values, or configuration settings to provision an AP as a remote AP.

Make sure that any provisioning changes you make are complete and accurate before save those settings. If an
AP is misconfigured with erroneous parameters, that AP may lost.

1. Navigate to the Configuration > Access Points window.

2. Select the AP to which you want to add new provisioning settings, then click Provision. The AP provisioning
settings divided into two groups. By default, the ArubaOS WebUI displays configuration settings described
in Table 99.



Parameter Description

Name Name assigned to an AP

NOTE: An AP requires a reboot before a new AP name takes effect.
Therefore, wait until there is little or no client traffic passing through the
AP before renaming it.

AP Group AP group to which the AP is assigned.

Remote-AP Select this check box to provision the APs as a remote APs. If you are
provisioning remote APs, you must also add the remote APs to the RAP
whitelist. For details, see Remote Access Points on page 626.

Controller Discovery Select DHCP if you have configured a DHCP server to provide the AP with
the master controller’s IP address, or select Static to manually define the
AP's managed device IP.

l If you select the Static option, you are prompted to enter the
managed device's DNS name or IP address.

l If you select the DHCP option, You must configure the DHCP server to
send the controller’s IP address using the DHCP vendor-specific
attribute option 43.

When using DHCP discovery, the APs identify themselves with a vendor
class identifier set to ArubaAP in their DHCP requests. When the DHCP
server responds to a request, it will send the controller’s IP address as
the value of option 43.

When using DHCP option 43, the AP accepts only one IP address. If the IP
address of the controller provided by DHCP is not available, the AP can
use the other IP addresses provisioned or learned by DNS to establish a
connection. For more information on how to configure vendor-specific
information on a DHCP server, see Enable DHCP to Provide APs with IP
Addresses on page 499 or refer to the documentation included with your
server.

IP Select DHCP if you have configured a DHCP server to provide the AP with
the the AP IP address, or select Static to manually define the AP's IP
address.

If you select the Static option, you are prompted to enter the following
information for the selected AP:

l IPv4 address, netmask and DNS server

l IPv6 address and DNS server

l IP address of the internet gateway used by the AP.

TFTP Server IP address of the TFTP server from which the AP can download its boot
image.

Coverage Area This setting defines the type of installation (indoor or outdoor). The
default option indicates that the installation mode is determined by the
AP model type.

Table 99: AP Provisioning Profile parameters

ArubaOS 8.0.0.0 | User Guide Access Points |  501



502 | Access Points ArubaOS 8.0.0.0  | User Guide

Parameter Description

Single Chain Mode If this option is enabled for an 802.11n-capable radio, the radio will
operate in single-chain mode, and will transmit and receive data using
only legacy rates and single-stream HT rates up to MCS 7. This
parameter is disabled by default.

PEAP username Username of AP so that AP can authenticate to 802.1X using PEAP.

PEAP password Password of AP so that AP can authenticate to 802.1X using PEAP.

Configuring Installed APs
APs and AMs are designed to require only minimal setup to make them operational in an user-centric network.
Once APs have established communication with the managed device, you can apply advanced configuration to
individual APs or groups of APs in the network using the WebUI on the managed device.

You can either connect the AP directly to a port on the managed device, or connect the AP to another switch or
router that has layer-2 or layer-3 connectivity to the managed device. If the Ethernet port on the managed
device is an 802.3af Power over Ethernet (PoE) port, the AP automatically uses it to power up. If a PoE port is
not available, you must get an AC adapter for the AP. For more information, see the Installation Guide for the
specific AP.

If you are configuring a new AP that has never been provisioned before, you must first connect the AP to the
managed device according the instructions included with that AP. If you are reprovisioning or reconfiguring
existing active APs, this step is not necessary, as the APs are already communicating with the managed device.

This section describes the procedure to configure a installed AP with the basic settings it requires to become
operational on the network. You can configure an AP using the AP wizard, the provisioning profile in the
WebUI, or the managed device command-line interface. using The individual configuration steps vary,
depending upon whether the AP is deployed as a campus AP, remote AP (RAP) or a mesh AP.

Configuring an AP using the web UI
The easiest way to provision any AP is to use the AP Wizard in the managed device WebUI. This wizard will walk
you through the specific steps required to provision a campus, remote or Mesh AP. The Wizard includes a help
tab that further describes each of the configuration tasks for that deployment type.

To access the AP wizard to provision a AP:

1. Select the managed device to which the AP will be provisioned.

2. Navigate to the Configuration > Access Points page.

3. Select the new AP from the Campus APs list, then click Provision.
4. In the General section, click the AP Group drop-down list and select the AP group to which this AP should

be assigned. The AP group must have at least one virtual AP.

5. (Optional) Some AP models support an external antenna in addition to their internal antenna. If the AP you
are provisioning supports an external antenna, the Provisioning window displays an additional Antenna
Parameters section.

6. If your AP will use Point-to-Point Protocol over Ethernet (PPPoE) to authenticate itself to a service provider,
open the Uplink tab to enter the parameters in the PPPoE section:

l PPPoE User Name: Set the PPPoE User Name for this remote AP.

l PPPoE Password: Enter and then confirm the PPPoE password for this remote AP.

l PPPoE Service Name: Either an ISP name or a class of service configured on the PPPoE server.



7. (Optional) To allow the remote AP to use PEAP to authenticate to 802.1X networks, select Show Advanced
Options under the General tab, then enter a user name and password in the 802.1X Parameter using
PEAP section.

8. (Optional) Define the uplink VLAN. If you configure an uplink VLAN on an AP connected to a port in trunk
mode, the AP sends and receives frames tagged with this VLAN on its Ethernet uplink. To define the uplink
VLAN, entering a VLAN ID from 1-4095 (inclusive) in the IP Settings section of the Provisioning window,

9. In the IP Settings section, define how the AP should obtain its IP address. If you have configured an DHCP
server to allow APs to get addresses using DHCP, select Obtain IP address using DHCP. For more
information on configuring a DHCP server, see Enable DHCP to Provide APs with IP Addresses on page 499.
Otherwise, select Use the Following IP address and enter the appropriate values in the following fields:

l IP address: IP address for the AP, in dotted-decimal format

l Subnet mask: Subnet mask for the IP, in dotted-decimal format.

l Gateway IP address: The IP address the AP uses to reach other networks.

l DNS IP address: The IP address of the Domain Name Server.

l Domain name: (optional) The default domain name.

10.(Optional) Access points can be configured in single-chain mode, allowing the radios of those APs to
transmit and receive data using only legacy rates and single-stream HT and VHT rates on a single radio chain
and single antenna or antenna interface. On APs with external antennas, this feature uses the external
antenna interface labeled A0 or ANT0 (radio chain 0); the other (one or two) antenna interfaces are left
unused. If you are provisioning an 802.11n-capable AP, select the Enable for Radio-0 or Enable for
Radio-1 check boxes in the Single-Chain Mode section to enable single-chain mode for the selected radio.
AP radios in single-chain mode will transmit and receive data using only legacy rates and single-stream HT
rates up to MCS 7. This feature is disabled by default.

11.(Optional) If you are provisioning a campus AP model that support USB modems, you must complete the
fields in the USB Settings section. USB settings will not appear in the Provisioning tab unless you are
provisioning an AP that support these features. Check the USB Parameters check box and configure the
additional cellular USB settings described in Table 100.

12.(Optional) Define the AP name or SNMP location. The AP list section displays current information for an AP,
and allows you to define additional parameters for your AP, such as AP Name, SNMP System Location.

13.Click Submit (Reprovisioning the AP causes it to automatically reboot).

Parameter Description

Device Select the USB modem model from the drop-down list. If the model is not
listed, select Other (Any).

TTY Device Data Path The TTY device path for the USB modem. This parameter only needs to
be specified if the default path is incorrect.

TTY Device Control Path The TTY device control path for the USB modem. This parameter only
needs to be specified if the default path is incorrect.

Initialization String The initialization string for the USB modem. This string configures the
Access Point Name (APN) setting of the USB modem. For the USB
modem to understand this string, the value entered should adhere to the
following formats:

l Prefix double-quotes with a backslash character. See example below:

Table 100: USB Settings
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Parameter Description

"AT+CGDCONT=1,\"IP\",\"vendor\""
l Use single-quote instead of double-quotes. AP translates single-quote

into double-quotes. See example below:
"AT+CGDCONT=1,’IP’,’vendor’"

l Do not use double-quotes as a string begin-end pair. This is
supported by AP. See example below:

AT+CGDCONT=1,’IP’,’vendor’
This parameter only needs to be specified if the default string is
incorrect.

Device Identifier The USB device identifier, if the device is not already supported.

Device Type Specify the USB driver type from the following list:

l acm: Use ACM driver

l airprime: Use Airprime driver

l beceem-wimax: Use Beceem driver for 4G-WiMAX

l ether: Use CDC Ether driver for direct IP 4G device

l hso: Use HSO driver for newer Option

l none: Disable 3G or 2G network on USB

l option: Use Option driver

l pantech-3g: Same as "pantech-uml290" - to support upgrade

l pantech-uml290: Use Pantech USB driver for UML290 device

l ptumlusbnet: Use Pantech USB driver for 4G device

l rndis: Use a RNDIS driver for a 4G device

l sierra-evdo: Use EVDO Sierra Wireless driver

l sierra-gsm: Use GSM Sierra Wireless driver

l sierrausbnet:Use SIERRA Direct IP driver for 4G device

l storage: Use USB flash as storage device for storing RAP certificates

Dial String The dial string for the USB modem. This parameter only needs to be
specified if the default string is incorrect.

PPP Username Enter the PPP username provided by the cellular service provider.

PPP Password Enter the optional PPP password provided by the cellular service
provider.

Confirm PPP Password Re-enter the optional PPP password provided by the cellular service
provider.

Modeswitch USB cellular devices on remote APs typically register as modems, but
may occasionally register as a mass-storage device. If a remote AP
cannot recognize its USB cellular modem, use setting to specify the
parameters for the hardware model of the USB cellular data-card.



Parameter Description

NOTE: You must enclose the entire modeswitch parameter string in
quotation marks. Example follows:

"-v <default_vendor> -p <default_product> -V <target_vendor> -P
<target_product> -M <message_content>"

Cellular NW Preference The cellular modem network preference setting allows you to select how
the modem should operate.

l auto (default): In this mode, the modem firmware will control the
cellular network service selection; so the cellular network service
failover and fallback is not interrupted by the remote AP (RAP).

l 3g_only: Locks the modem to operate only in 3G.

l 4g_only: Locks the modem to operate only in 4G.

l advanced: The RAP controls the cellular network service selection
based on the Received Signal Strength Indication (RSSI) threshold-
based approach. Initially the modem is set to the default auto mode.
This allows the modem firmware to select the available network. The
RAP determines the RSSI value for the available network type (for
example 4G), checks whether the RSSI is within required range, and if
so, connects to that network. If the RSSI for the modem’s selected
network is not within the required range, the RAP will then check the
RSSI limit of an alternate network (for example, 3G), and reconnect to
that alternate network. The RAP will repeat the above steps each time
it tries to connect using a 4G multi-mode modem in this mode.

Link Priority Ethernet Set the priority of the wired uplink. Each uplink type has an associated
priority; wired ports having the highest priority by default.

Link Priority Cellular Set the priority of the cellular uplink. By default, the cellular uplink is a
lower priority than the wired uplink; making the wired link the primary
link and the cellular link the secondary or backup link.

Configuring the cellular link with a higher priority than your wired link
priority will set your cellular link as the primary managed device link.

USB storage for CSR/Key Check this box if you want the USB to store CSR and private key files.

Configuring a Remote AP
A remote AP (RAP) is recommended when the network between the AP and managed device is an un-
trusted/non-routable network, such as the Internet. Furthermore, a RAP supports an internal DHCP server,
while a campus AP does not.

Remote Authentication
The two most common ways to provision an AP for remote authentication are certificate-based AP
provisioning and provisioning using a pre-shared key. Although both options allow for a simple secure setup of
your remote network, you should make sure that the procedure you select is supported by your managed
device, the AP model type and the end user’s client software. If you must provision your APs using a pre-shared
key, you need to know which managed device models you have that do not support certificate-based
provisioning.

l Certificate based authentication allows a managed device to authenticate a AP using its certificates
instead of a PSK. You can manually provision an individual AP with a full set of provisioning parameters, or
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simultaneously provision an entire group of APs by defining a provisioning profile which contains a smaller
set of provisioning parameters that can be applied the entire AP group. When you manually provision an
individual AP to use certificated-based authentication, you must connect that AP to the managed device
before you can define its provisioning settings.

l Use Pre-Shared Key (PSK) authentication to provision an individual remote AP or a group of remote
APs using an Internet Key Exchange Pre-Shared Key (IKE PSK).

RAP Configuration
The steps to configure a remote AP using the WebUI are similar to the steps described in Configuring an AP
using the web UI , although some additional steps are required.

1. Select the managed device to which the AP will be provisioned.

2. Navigate to the Configuration > Access Points page.

3. Open the Remote APs tab

4. Select the new RAP from the Remote AP list, then click Provision.

5. In the General section, click the AP Group drop-down list and select the AP group to which this AP should
be assigned. The AP group must have at least one virtual AP.

6. (Optional) Some AP models support an external antenna in addition to their internal antenna. If the AP you
are provisioning supports an external antenna, the Provisioning window displays an additional Antenna
Parameters section.

7. If your AP will use Point-to-Point Protocol over Ethernet (PPPoE) to authenticate itself to a service provider,
open the Uplink tab to enter the parameters in the PPPoE section:

l PPPoE User Name: Set the PPPoE User Name for this remote AP.

l PPPoE Password: Enter and then confirm the PPPoE password for this remote AP.

l PPPoE Service Name: Either an ISP name or a class of service configured on the PPPoE server.

8. (Optional) To allow the remote AP to use PEAP to authenticate to 802.1X networks, select Show Advanced
Options under the General tab, then enter a user name and password in the 802.1X Parameter using
PEAP section.

9. If you are provisioning a remote AP model that support USB modems, you must complete the fields in the
USB Settings section. USB settings will not appear in the Provisioning tab unless you are provisioning an
AP that support these features. Check the USB Parameters check box and configure the additional cellular
USB settings described in Table 100.

Verifying the Configuration
After the AP has been configured, navigate to Dashboard page and verify that the AP has an up status. The AP
on your network does not appear in this table, it may have been classified as an inactive AP for any of the
following reasons:

l The AP is configured with a missing or incorrect VLAN. (For example, the AP is configured to use a tunneled
SSID of VLAN 2 but the controller doesn't have a VLAN 2.)

l The AP has an unknown AP group.

l The AP has a duplicate AP name.

l An AP with an external antenna is not provisioned with external antenna gain settings.

l Both radios on the AP are disabled.

l No virtual APs are defined on the AP.

l The AP has profile errors. For details, access the command-line interface and issue the command “show
profile errors”.



l The GRE tunnel between the AP and the managed device was blocked by a firewall after the AP became
active.

l The AP is temporarily down while it is upgrading its software. The AP will become active again after
upgrading.

Configuring AP Image Preload
The AP image preload feature minimizes the downtime required for a managed device upgrade by allowing the
APs associated to that managed device to download the new images before the managed device actually starts
running the new version.

This feature allows you to select the maximum number of APs that are allowed to preload the new software
image at any one time, thereby reducing the possibility that the managed device may get overloaded or that
network traffic may be impacted by all APs on the managed device attempting to download a new image at
once.

APs can continue normal operation while they are downloading their new software version. When the
download completes, the AP sends a message to the managed device, informing it that the AP has either
successfully downloaded the new software version, or that the preload has failed for some reason. If the
download fails, the AP will retry the download after a brief waiting period.

You can allow every AP on a managed device to preload a new software version, or also create a custom list of
AP groups or individual APs that can use this feature. If a new AP associates to the managed device while the
AP image download feature is active, the managed device will check that AP’s name and group to see if it
appears in the preload list. If an AP is on the list, (and does not already have the specified image in its Flash
memory) that AP will start preloading its image.

Once a software version has been downloaded, another version cannot be downloaded until the AP reboots.

Enable and Configure AP Image Preload

To configure the AP image preload feature using the command-line interface, enter the following commands in
enable mode.
ap image-preload

activate all-aps|specific-aps

add {ap-group <ap-group> | ap-name <ap-name>}

cancel

clear-all

delete {ap-group <ap-group> | ap-name <ap-name>}

[partition <part-num>]

[max-downloads <max-downloads>]

The parameters for this command are described in Table 101.
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Parameter Description

activate Issue the ap image-preload activate command to activate this
feature, allowing APs in the preload list to start downloading their
new image from the managed device.

all-aps All APs will be allowed to pre download the image.

specific-aps Only APs in the preload list will be allowed to preload the image.

add Add individual APs or AP groups to the list of APs allowed to preload
the image.

ap-group <group> Add a group of APs to the preload list.

ap-name <name> Add an individual AP to the preload list.

cancel Cancel the AP preload and clear the preload list. Any APs
downloading a new image at the time this command is issued will
continue to download the file.

clear-all Clear all APs from the preload list.

delete Delete an individual AP or AP group from the preload list.

NOTE: This command may be issued before or after preloading is
activated. If it is executed after preloading has already been
activated, any APs downloading a new image at the time this
command is issued will continue to download the file. APs that are
still waiting to preload will be removed from the preload list.

ap-group <group> Remove the specified group of APs from the preload list

ap-name <name> Remove an individual AP from the preload list

partition <partition-num> Specify the partition from which the APs should download their
images. By default, the APs will preload images from the managed
device’s default boot partition.

max-downloads <max-downloads> Specify the maximum number of APs that can simultaneously
download their image from the managed device. The default value
is ten APs.

Table 101: AP Image Preload Configuration Parameters

View AP Preload Status
You can monitor the current preload status of APs using the image preload feature using the show ap image-
preload status summary command in the command-line interface.The output of this command contains
the following information:



Column Description

AP Image Preload
State/Count

These two columns list the different possible preload states for APs eligible to
preload a new software image, and the total number of APs in each state.

l Preloaded: Number of APs that have finished preloaded a new software
image.

l Preloading: Number of APs that are currently downloading the new image.

l Waiting: Number of APs that are waiting to start preloading the new image
from the managed device.

Count This column lists the number of eligible APs currently in each preload state.

AP Name Name of an AP eligible to preload a new software image.

AP Group AP group of an AP eligible to preload a new software image.

AP IP IP address of the AP.

AP Type AP model type.

Preload State Current preload state for the AP

l Preloaded: The AP is finished preloading a new software image.

l Preloading: The AP is currently downloading the new image.

l Waiting: The AP is waiting to start preloading the new image from the
managed device.

Start Time Time the AP starting preloading an image.

End Time Time the AP completed the image preload.

Failure Count Number of times that the AP failed to preload the new image.

Failure Reason In the event of an image preload failure, this column will display the reason that
the image download failed.

Table 102: AP Image Preload Status Settings

Optional AP Configuration Settings
Once the AP has been installed and provisioned, you can use the WebUI or CLI to configure the optional AP
settings described in the following sections:

l Spanning Tree on page 510

l PortFast on page 510

l Enabling PortFast On a Trunk Port on page 510

l AP Console Access Using a Backup ESSID on page 510

l Defining an RTLS Server on page 511

l AP Redundancy on page 511

l AP Maintenance Mode on page 511

ArubaOS 8.0.0.0 | User Guide Access Points |  509



510 | Access Points ArubaOS 8.0.0.0  | User Guide

l Energy Efficient Ethernet on page 511

l AP LEDs on page 512

l Suppressing Client Probe Requests on page 513

l BLE Operation Mode on page 514

l Configuring the AP System Profile on page 514

l Configuring the AP Wired Port Profile on page 522

Spanning Tree
The Spanning Tree Protocol (STP) can prevent loops in bridged Ethernet local area networks. Spanning tree
settings can be configured via the WebUI and command-line interface.

To enable this feature, enable both the Spanning Tree parameter in the AP system profile and the Spanning
Tree parameter in the AP wired port profile. For details, see Configuring the AP System Profile on page 514.

PortFast
The PortFast feature is introduced to avoid network connectivity issues. These issues are caused by delays in
STP enabled ports moving from blocking-state to forwarding-state after transitioning from the listening and
learning states. STP enabled ports that are connected to devices such as a single switch, workstation, or a
server can access the network only after passing all these STP states. Some applications need to connect to the
network immediately, else they will timeout.

Spanning Tree should be enabled on the access point before enabling PortFast. If PortFast is configured, it is
enabled only on access mode ports and if PortFast-Trunk is configured, it is enabled on trunk-mode ports only.
Only one of them can be set based on the port’s switchport mode.

Enabling PortFast on an Access Port
Before enabling PortFast ensure that the switchport mode is set to access:
(host)[mynode] #show ap wired-port-profile <profile>

Execute the following commands in config mode to enable PortFast on an access port:
(host)[mynode] (config) #ap wired-port-profile "default"

(host)[mynode] (AP wired port profile "default") #portfast

Enabling PortFast On a Trunk Port
Before enabling PortFast ensure that the switchport mode is set to trunk:
(host)[mynode] #show ap wired-port-profile <profile>

Execute the following commands in config mode to enable PortFast on a trunk port:
(host)[mynode] (config) #ap wired-port-profile "default"

(host)[mynode] (AP wired port profile "default") #portfast-trunk

AP Console Access Using a Backup ESSID
This failover system allows users to access an AP console after the AP has disconnected from the managed
device. By advertising backup ESSID in either static or dynamic mode, the user is still able to access and debug
the AP remotely through a virtual AP. Settings for this feature are configured using the Password for Backup,
RF Band for Backup, and Operation for backup parameters in the AP system profile. For details, see
Configuring the AP System Profile on page 514.



Defining an RTLS Server
The RTLS server configuration enables the AP to send RFID tag information to an RTLS server. Currently, when
configuring the RTLS server under ap system-profile, you can set the station-message-frequency
parameter in the 1-3600 seconds range. Setting the frequency to 1 means a report is sent for every station
every second. A value of 5 means that a report for a ny particular station would be sent at 5 second intervals.

l Sending more frequent reports to the server can improve the accuracy of the location calculation.

l Configuring an AP to send reports more frequently adds additional load in terms of CPU usage.

Settings for this feature are configured using the RTLS Server configuration parameters in the Advanced
section the AP system profile. For details, see Configuring the AP System Profile on page 514.

AP Redundancy
In conjunction with the managed device redundancy features described in Increasing Network Uptime Through
Redundancy and VRRP on page 581 the information in this section describes redundancy for APs. Remote APs
also offer redundancy solutions via a backup configuration, backup managed device list, and remote AP
failback. For more information relevant to remote APs, see Remote Access Points on page 626.

The AP failback feature allows an AP associated with the backup managed device (backup LMS) to fail back to
the primary managed device (primary LMS) if it becomes available.

If configured, the AP monitors the primary managed device by sending probes every 600 seconds by default. If
the AP successfully contacts the primary managed device for the entire hold-down period, it will fail back to the
primary managed device. If the AP is unsuccessful, the AP maintains its connection to the backup managed
device, restarts the LMS hold-down timer, and continues monitoring the primary managed device.

Settings for this feature are configured using the LMS IP parameters in the LMS settings section of the AP
system profile. For details, see Configuring the AP System Profile on page 514.

AP Maintenance Mode
You can configure APs to suppress traps and syslog messages related to those APs. Known as AP maintenance
mode, this setting in the AP system profile is particularly useful when deploying, maintaining, or upgrading the
network. If enabled, APs stop flooding unnecessary traps and syslog messages to network management
systems or network operations centers during a deployment or scheduled maintenance. The managed device
still generates debug syslog messages if debug logging is enabled. After completing the network maintenance,
disable AP maintenance mode to ensure all traps and syslog messages are sent. AP maintenance mode is
disabled by default.

The AP maintenance mode is configured by enabling Maintenance Mode parameter in the Advanced
section of the AP system profile. For details, see Configuring the AP System Profile on page 514.

To view the maintenance mode status of APs, use the following commands in the Mobility Master command-
line interface:

show ap config {ap-group <name>|ap-name <name>|essid <name>}

show ap debug system-status {ap-name <name>|bssid <name>| ip-addr <ipaddr>}

Energy Efficient Ethernet
Most newer models of Aruba APs support the 803.az Energy Efficient Ethernet (EEE) standard, which allows the
APs to consume less power during periods of low data activity. This setting can be enabled for provisioned APs
or AP groups through the Ethernet Link profile. If this feature is enabled for an AP group, any APs in the group
that do not support 803.az will ignore this setting.

Energy Efficient Ethernet is configured using the AP Ethernet Link profile.
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In the WebUI
1. Navigate to the Configuration > System > Profiles page.

2. Select AP > AP Ethernet Link, and select the Ethernet link profile you want to modify. The parameters for
the profile are described in Table 103.

Parameter Description

Speed The speed of the Ethernet interface, either 10 Mbps, 100 Mbps, 1000
Mbps (1 Gbps), or auto-negotiated.

Duplex The duplex mode of the Ethernet interface, either full, half, or auto-
negotiated.

802.3az (EEE) Select this check box to enable support for 802.1az Energy Efficient
Ethernet. (for 130 Series only).

Power Over Ethernet Enable Power over Ethernet (PoE) for APs that support PoE.

Table 103: Ethernet Interface Link Profile Parameters

By default, AP wired port profiles reference the Default Ethernet interface link profile. If you created a new
Ethernet interface link profile to support 803.az, use the procedure below to associate a AP wired port profile
or Ethernet interface port configuration with the new Ethernet Interface link profile.

To associate a new Ethernet interface link profile with a wired port profile:

1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles page.

2. Navigate to AP > AP Wired Port Profile on the Profile pane, then select the AP Wired Port profile you
want to modify.

3. Click the Ethernet interface link profile currently associated with the AP wired port profile you want to
modify. This profile appears below the AP Wired Port Profile in the All Profiles list.

4. Click the Ethernet interface link profile drop-down list at the top of the Profile Details window, and
select a new Ethernet interface link profile.

5. Click Apply to save your changes.

In the CLI
To enable support for 803.az EEE, access the command-line interface in config mode and issue the following
command:
(host)[node] (config) #ap enet-link-profile <profile>

dot3az

Associate a new Ethernet Interface link profile with an AP wired port profile using the following command:
(host)[node] (config) #ap wired-port-profile <profile>

enet-link-profile <profile>

AP LEDs
AP LEDs on 802.11n and 802.11ac APs can be configured in two modes: normal and off. In normal mode, the
AP LEDs will light as expected. When the mode is set to off, all of the LEDs on the affected APs are disabled. The
AP LED mode is configured by enabling the LED Operating Mode parameter in the General section of the
AP system profile. For details, see Configuring the AP System Profile on page 514.



Suppressing Client Probe Requests
The anyspot client probe suppression feature decreases network traffic by suppressing probe requests from
clients attempting to locate and connect to other known networks. By reducing the frequency at which these
messages are sent, this feature frees up network resources and improves network performance.

When an AP is configured to use this feature, the anyspot AP radio hides its configured ESSID in beacons, and
compiles a list of other ESSIDs from detected neighboring APs. If the client sends a probe request without a
specified ESSID, the anyspot AP will respond with a preconfigured ESSID.

When a client searches for a preferred network, that client sends the SSID of the preferred network in the
probe request. The anyspot AP checks to see if there is a neighboring AP using that ESSID that can respond the
client's request. If no matching network is found, the anyspot AP sends a response to the client using the SSID
from the client request. If the client is authorized to connect to the anyspot AP, that client associates to AP.
Once connected to the anyspot AP, the client recognizes the ESSID to which it is connected as one associated
with its preferred network, and does not send out any further probe requests.

An AP radio can only use this feature when encryption is disabled. (That is, when the operation mode parameter in
the AP radio's WLAN SSSID profile is set to opensystem.)

You can define a list of excluded ESSIDs to which the anyspot AP will not respond. If a client sends probe
request with an ESSID on the excluded ESSID list, the anyspot AP will not respond to the request, even if there
is no neighboring AP using that ESSID. Excluded ESSIDs can be identified by exact name or a matching string.

In the WebUI
Use the following procedure to suppress client probe requests by enabling the anyspot feature.

1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles page.

2. Navigate to Wireless LAN> Anyspot on the Profile pane, then select the Anyspot profile you want to
modify.

3. Configure the anyspot parameters described in Table 104.

Parameter Description

Enable Anyspot Select this check box to enable the anyspot feature. Note that you must associate the any-
spot profile with a virtual AP profile for the settings to take effect.

Exclude ESSID(s)
(exact match)

An anyspot-enabled radio will not respond to client probe requests using an ESSID in the
Exclude ESSID lists. To add an ESSID to the list, enter the full name of the ESSID, then
click Add. To remove an ESSID from the list, select it and click Delete. ESSIDs from neigh-
boring APs will automatically appear in this list as long as the anyspot-enabled AP can
detect that ESSID.

Exclude ESSID(s) (con-
taining string(s)

An anyspot-enabled radio will not respond to client probe requests using an ESSID in the
Exclude ESSID list. To exclude ESSIDs that partially match a text string, enter that string
then click Add. To remove a matching string from the list, select it and click Delete.

Preset ESSID(s) The anyspot-enabled AP will not send an ESSID in beacons, but if a client sends a probe
requests without ESSIDs (that is, the probe request is not looking for a specific network)
then the anyspot-enabled AP will respond to the probe request with an ESSID from this list.

Table 104: Anyspot Client Probe Suppression Configuration Parameters
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If you create a new Anyspot profile, use the procedure below to associate the anyspot profile with a selected
WLAN via the virtual AP profile.

To associate a new Ethernet interface link profile with a wired port profile:

1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles page.

2. Select AP > Virtual AP on the Profile pane, then select the Virtual AP profile for the WLAN you want to
modify.

3. Click the Anyspot profile currently associated with the Virtual AP profile. This profile appears below the
Virtual AP Profile in the All Profiles list.

4. Click the Anyspot profile drop-down list and select the new Anyspot profile.

In the CLI
Use the following commands to configure the anyspot profile, and associate an anyspot profile with a virtual
AP.
(host)[node] (config) #wlan anyspot-profile <anyspot-profile>

(host)[node] (config) #wlan virtual-ap profile <profile>

anyspot <profile>

BLE Operation Mode
The BLE Operation Mode setting determines how the built-in Bluetooth Low Energy (BLE) chip in the AP
functions. You can configure this setting using the Mobility Master WebUI or CLI.

BLE is disabled on the ArubaOS FIPS build. The BLE Operation Mode setting is currently supported in 320 Series
access points only.

This feature supports the following modes:

l Beaconing: The AP's built-in BLE chip functions as an iBeacon combined with beacon management
functionality.

l Disabled: The AP's built-in BLE chip is turned off. This is the default setting.

l DynamicConsole: The AP's built-in chip functions as a regular iBeacon combined with beacon
management functionality. However, when the link to the managed device is lost, the built-in chip
temporarily enables access to the AP console over BLE. This state of the BLE device may be rolled back to
any of the other modes if the AP receives a different configuration setting for the ble-op-mode parameter
from the new LMS.

l PersistentConsole: The AP's built-in chip provides access to the AP console over BLE using a mobile
application. This functionality is the superset of the Beaconing mode.

Settings for this feature are configured using the BLE Operation Mode parameter in the Advanced section
the AP system profile. For details, see Configuring the AP System Profile on page 514.

Configuring the AP System Profile
The AP system profile configuration settings are divided into four groups, General, LMS Settings, Remote
AP and Advanced. The General, LMS Settings, and Remote AP sections of this profile include configuration
settings that often need to be adjusted to suit a specific network. The Advanced tab includes settings that do
not need frequent adjustment or should be kept at their default values.

In the WebUI:
To configure AP settings via the AP system profile:



1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles and expand
the AP profiles menu.

2. Expand the AP system profile menu and select the name of an existing profile or click Add to create a new
profile.

3. Configure the profile parameters described in Table 105, then click Save.

Parameter Description

General AP System Profile Settings

RF Band For APs that support both 802.11a and 802.11b/g RF bands, specify
the RF band in which the AP should operate:

l g = 2.4 GHz

l a = 5 GHz

RF Band for AM Mode scanning For Air Monitors that support both 802.11a and 802.11b/g RF bands,
specify the RF band which the AM should scan:

l a = 5 GHz

l all = both radio bands

l g = 2.4 GHz

Native VLAN ID Native VLAN for bridge mode virtual APs (frames on the native
VLAN are not tagged with 802.1q tags).

Session ACL Session ACL configured with the ip access-list session command.

NOTE: This parameter requires the PEFNG license.

Corporate DNS Domain Name of domain that is resolved by corporate DNS servers. Use
this parameter when configuring split-tunnel forwarding.

SNMP sysContact SNMP system contact information.

LED operating mode The operating mode for the LEDs on 802.11n-capable indoor AP.
supported options are normal mode, and off, which disables all
LEDs.

LED Override Override the LED action for single-LED APs in normal LED operating
mode. If enabled, this feature disables the LED auto-turn-off function.

Driver Log Level Level of AP driver logs sent to the syslog server. Supported options
are:

l alerts: Immediate action needed

l critical: Critical Conditions

l debugging: Debugging Messages

l emergencies: System is unusable

l errors: Error Conditions

Table 105: AP System Profile Configuration
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Parameter Description

l informational: Informational Messages

l notifications: Normal but significant conditions

l warnings: Warning conditions

SAP MTU Maximum Transmission Unit, in bytes, on the wired link for the AP.

RAP MTU Configures the maximum size of the GRE packets exchanged
between a RAP and the managed device.

Secondary Master IP/FQDN The secondary Mobility Master is configured to be used when a
RAP is not able to reach the primaryMobility Master.

Spanning Tree Enables the spanning-tree protocol.

AP Multicast Aggregation Enable multicast aggregation at AP

AP ARP attack protection Drop ARP packets coming from wired or wireless clients with AP
gateway IP address. In other words, disallow ARP attack from un-
trusted ports.

AP multicast aggregation allowed
VLANs

Enable a list of VLANs where AP multicast aggregation is allowed.

LMS AP System Profile Settings

LMS IP This parameter specifies the IP address of the local management
switch (LMS)—the managed device—which is responsible for
terminating user traffic from the APs, and processing and
forwarding the traffic to the wired network. This can be the IP
address of the managed device or Mobility Master.

When using redundant managed devices as the LMS, set this
parameter to be the VRRP IP address to ensure that APs always
have an active IP address with which to terminate sessions.

NOTE: If the LMS-IP is blank, the access point will remain on the
managed device that it finds using methods like DNS or DHCP. If an
IP address is configured for the LMS IP parameter, the AP will be
immediately redirected to the managed device at that address.

Backup LMS IP This parameter specifies the IP address of a backup to the IP
address specified with the lms-ip parameter.

LMS IPv6 This parameter specifies the IPv6 address of the local management
switch (LMS)—the managed device—which is responsible for
terminating user traffic from the APs, and processing and
forwarding the traffic to the wired network. This can be the IP
address of the managed device or Mobility Master.

When using redundant managed devices as the LMS, set this
parameter to be the VRRP IP address to ensure that APs always
have an active IP address with which to terminate sessions.



Parameter Description

Backup LMS IPv6 This parameter specifies the IPv6 address of a backup to the IPv6
address specified with the lms-ipv6 parameter.

LMS Preemption When this parameter is enabled, the AP automatically reverts to the
primary LMS IP address when it becomes available.

LMS Hold-down Period Time, in seconds, that the primary LMS must be available before an
AP returns to that LMS after failover.

Remote AP AP System Profile Settings

Remote-AP DHCP Server VLAN VLAN ID of the remote AP DHCP server used if the managed device
is unavailable. This VLAN enables the DHCP server on the AP (also
known as the remote AP DHCP server VLAN). If you enter the native
VLAN ID, the DHCP server is unavailable.

Remote-AP DHCP Server ID IP address used as the DHCP server identifier.

Remote-AP DHCP Default Router IP address for the default DHCP router.

Remote-AP DHCP DNS Server IP address of the DNS server.

Remote-AP DHCP Pool Start Configures a DHCP pool for remote APs. This is the first IP address
of the DHCP pool.

Remote-AP DHCP Pool End Configures a DHCP pool for remote APs. This is the last IP address
of the DHCP pool.

Remote-AP DHCP Pool Netmask Configures a DHCP pool for remote APs. This is the netmask used
for the DHCP pool.

Remote-AP DHCP Lease Time The amount of days that the assigned IP address is valid for the
client. Specify the lease in <days>. A value of 0 indicates the IP
address is always valid; the lease does not expire.

Remote-AP uplink total bandwidth This is the total reserved uplink bandwidth (in Kilobits per second).

Remote-AP bw reservation 1

Remote-AP bw reservation 2

Remote-AP bw reservation 3

Session ACLs with uplink bandwidth reservation in kilobits per
second. You can specify up to three session ACLs to reserve uplink
bandwidth. The sum of the three uplink bandwidths should not
exceed the Remote-AP uplink total bandwidth .

Remote-AP Local Network Access Enable or disable local network access across VLANs in a Remote-
AP.

Advanced AP System Profile Settings
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Parameter Description

Tunnel heartbeat interval Set the interval between heartbeat messages between a remote or
campus AP and its associated managed device. An increase in the
heartbeat interval increases the time it will take for an AP to detect
the loss in connectivity to the managed device, but can reduce
internet bandwidth consumed by a remote AP. The supported range
is 1-60 seconds, and the default value is 1 second.

LMS ping interval Specifies the interval at which application level ping needs to be
sent to primary managed device to check the reachability.
Applicable only for RAP.

NOTE: If this parameter is changed, UDP session timeout on an
intermediate router which performs NATing should be set
accordingly. The preferred timeout value is (lms-ping-interval +
30sec). The supported range is 10-60 seconds, and the default
value is 20 seconds.

Bootstrap threshold Number of consecutive missed heartbeats on a GRE tunnel
(heartbeats are sent once per second on each tunnel) before an AP
rebootstraps. On the managed device, the GRE tunnel timeout is 1.5
x bootstrap-threshold; the tunnel is torn down after this number of
seconds of inactivity on the tunnel. The supported range is 1-65535,
and the default value is 8.

Double Encrypt This parameter applies only to remote APs. Use double encryption
for traffic to and from a wireless client that is connected to a
tunneled SSID.

When enabled, all traffic is re-encrypted in the IPsec tunnel. When
disabled, the wireless frame is only encapsulated inside the IPsec
tunnel.

All other types of data traffic between the managed device and the
AP (wired traffic and traffic from a split-tunneled SSID) are always
encrypted in the IPsec tunnel.

Dump Server (For debugging purposes.) Specifies the server to receive a core
dump generated when an AP process crashes.

NOTE: To allow the core dump files to be sent to the managed
device instead of a dump server, access the managed device
command-line interface and issue the command ap-crash-
transfer.

Heartbeat DSCP Assign a DSCP value to AP heartbeats to prioritize heartbeats
traveling over low-speed links. The supported range is 0-63, and the
default value is 0. For more information, see Optional AP
Configuration Settings on page 509.

Maintenance Mode Enable or disable AP maintenance mode.

This setting is useful when deploying, maintaining, or upgrading the
network.



Parameter Description

If enabled, APs stop flooding unnecessary traps and syslog
messages to network management systems or network operations
centers when deploying, maintaining, or upgrading the network.
The controller still generates debug syslog messages if debug
logging is enabled.

Maximum Request Retries Maximum number of times to retry AP-generated requests,
including keepalive messages. After the maximum number of
retries, the AP either tries the IP address specified by the bkup-lms-
ip (if configured) or reboots.

Request Retry Interval Interval, in seconds, between the first and second retries of AP-
generated requests. If the configured interval is less than 30
seconds, the interval for subsequent retries is increased up to 30
seconds.

Number of IPSEC retries Number of times the AP will try to create an IPsec tunnel with the
master controller before the AP will reboot. If you specify a value of
0, and AP will not reboot if it cannot create the IPsec tunnel. The
supported range of values is 0-1000 retries, and the default value is
85 retries.

AeroScout RTLS Server Enables the AP to send AeroScout tag information to an RTLS
server. You must specify the IP address or DNS server and port
number of the server to which location reports are sent.

RTLS station reporting includes information for APs and the clients
that the AP has detected. If you select the Include Unassociated
Stations option, the station reports will also include information
about clients not associated to any AP. By default, unassociated
clients are not included in station reports.

IPorDNS IP address or the DNS of the AeroScout server to which location
reports are sent.

     Port Port number on the AeroScout server to which location reports are
sent.

     includeUnassocSta If you select the Include Unassociated Stations option, the station
reports will also include information about clients not associated to
any AP. By default, unassociated clients are not included in station
reports.

RTLS Server configuration Enables the AP to send RFID tag information to an RTLS server. You
must specify the IP address or DNS server and port number of the
server to which location reports are sent, a shared secret key, and
the frequency at which packets are sent to the server.

RTLS station reporting includes information for APs and the clients
that the AP has detected. For more information on configuring RTLS
server configuration, see Defining an RTLS Server on page 511.

    IPorDNS IP address or the DNS of the RTLS server to which location reports
are sent.
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Parameter Description

     Port RTLS server port number

     frequency Specifiy how often to send station RSSI update messages to the
server.. The supported range is 1-3600 seconds, and the default set-
ting is 30 seconds.

     key Shared secret key for the RTLS server.

     Include Unassociated Stations If you select the Include Unassociated Stations option for an RTLS
server, the station reports will also include information about clients
not associated to any AP. By default, unassociated clients are not
included in station reports.

RTLS Server Compatibility Mode The compatibility mode controls the format of tag frames forwarded
to the RTLS server. Enabling this mode will enable legacy format
(includes a 2 byte padding), and disabling this mode will remove the
padding. The tag frame format will be the same across all AP models.
This feature is enabled by default

Slow Timer Recovery by rebooting
itself

If you enable this option, ArubaOS checks for a slow CPU timer, and if
it detecst an issue, restarts the AP without logging a reason for the
reboot. This feature is supported on AP-103H, and RAP-108/ RAP-109
access points.

Telnet Select this check box to enable telnet to the AP.

Console Enable Enable console port on the AP.

AP Console Protection Enable the AP console protection by requiring a password to get AP
console access.

AP Console Password Sets the AP console password on the controller. If configured, you
must enter this password to get AP console access. If not
configured, the controller generates a default random password
which can be viewed by executing the encrypt disable command
followed by the show ap system-profile <profile-name>
command. To disable the AP console password, execute the shell-
passwd passworddisabled command.

NOTE: The passworddisabled is a special character string. On
entering this string, the controller disables the AP console
password.

Password for Backup Allows client access to adjust the band and mode settings for the
backup ESSID.

AP USB Power override Enabling override enables the USB port of the AP with POE AT
power.

NOTE: This parameter is applicable for AP-205H access point only.



Parameter Description

RF Band for Backup Band on which the controller broadcasts the backup ESSID. Sup-
ported values are as follows:

l a: 802.11a

l all: all bands. This is the default setting.

l g: 802.11g

Operation for Backup This parameter allows AP console access using a backup ESSID,
allowing users to access an AP console after the AP has
disconnected from the controller. When the AP advertises a backup
ESSID in either static or dynamic mode, a user is able to access and
debug the AP remotely through a virtual AP.

The default setting for this feature is off. Select dynamic or static
to enable this feature and select the mode by which the controller
broadcasts the backup ESSID.

BLE Endpoint URL URL of the Meridian server to which the BLE sends monitoring data.

BLE Auth Token The Bluetooth Low Energy (BLE) endpoint authorization token is a
text string of 1-255 characters used by the BLE to authorize to and
securely communicate with the Beacon Management Console. This
token is unique for each deployment.

BLE Operation Mode Determines how the built-in Bluetooth Low Energy (BLE) chip in the
AP functions. BLE chip can be in one of the following four modes:

l Beaconing: The AP's built-in BLE chip functions as an iBeacon
combined with beacon management functionality.

l Disabled: The AP's built-in BLE chip is turned off. This is the
default setting.

l Dynamic Console: The AP's built-in chip functions as a regular
iBeacon combined with beacon management functionality.
However, when the link to the controller is lost, the built-in chip
temporarily enables access to the AP console over BLE. This
state of the BLE device may be rolled back to any of the other
modes if the AP receives a different configuration setting for the
ble-op-mode parameter from the new LMS.

l Persistent Console: The AP's built-in chip provides access to
the AP console over BLE using a mobile application. This
functionality is the superset of the Beaconing mode.

NOTE: BLE is disabled for ArubaOS FIPS.

Health Check The AP Health check feature uses ping probes to check reachablility
and latency levels for the connection between the AP and the
controller.

     mode Ping probe mode is the only mode currently supported by this
feature.
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Parameter Description

     packetsize The size, in bytes, of a ping datagram. The supported range of
values is 10-2000.

     burstcnt Number of probes to be sent during the probe frequency interval
defined by the frequency health-check parameter. The supported
range of values is 1-16.

     freq Probe interval, in seconds. The WAN health-check feature sends the
number of probes defined by the burst-size parameter during each
frequency interval defined by this frequency parameter. The
supported range of values is 10-300.

     report Number of seconds between health check reports sent from the AP
to the controller. The supported range of values is 60-3600.

     retrycnt Number of times the attempts to resend a probe. The supported
range of values is 1-10 retry attempts.

AirMatch Report Period Change the frequency period which AirMatch starts measuring the
RF environment. The default value is 30 minutes, and the supported
range of values is 5-180 minutes.

AirMatch Measurement Duration Change the AirMatch RF measurement duration from the default
value of five minutes to any value from 5-60 minutes. A value of 0
disables AirMatch RF environment measurements.

AirMatch Report Enabled Enable or disable AirMatch reports. Each AP in a Mobility Master
deployment measures its RF environment for a five minute
duration, every 30 minutes.Mobility Master uses this information to
compute an optimal solution, then deploys the latest RF plan by
sending updated settings to the APs every 24 hours. This feature is
enabled by default.

In the CLI
The following command configures the AP system profile in the command-line interface.
(host)[node](config)#ap system-profile <profile>

Configuring the AP Wired Port Profile
This profile is only applicable to APs with Ethernet ports. Use this profile to enable or disable the wired port,
define an AAA profile for wired port devices, and associate the port with an Ethernet link profile that defines its
speed and duplex values. Basic AP wired port settings can be configured via the WebUI, while some additional
advanced settings are available in the command-line interface.

In the WebUI
1. Navigate to the Configuration > System > Profiles page.

2. Select AP > AP Wired Port , and select the AP wired port profile you want to modify. The parameters for
the profile are described in Table 103.



Parameter Description

Shut down Disable the wired AP port.

Remote AP Backup Enable this otion to use the wired port on a Remote AP for local
connectivity and troubleshooting when the AP cannot reach the managed
device. If the AP is not connected to the managed device, no firewall
policies will be applied when this option is enabled. (The AAA profile will
be applied when the AP is connected to managed device).

Bridge Role Role that is assigned to a user if split-tunnel authentication fails.

Time to wait for
authentication to succeed

Authentication timeout value, in seconds, for devices connecting the AP’s
wired port. The supported range is 1-65535 seconds, and the default
value is 20 seconds.

Spanning Tree: Enables the spanning-tree protocol.

Portfast: Enables portfast for AP wired access ports. Spanning tree must be enabled
before this command can be used.

Portfast on trunk: Enables portfast for AP wired trunk ports. Spanning tree must be enabled
before this command can be used.

Table 106: AP Wired Port Profile Parameters

In the CLI
The following command configures the AP wired port profile in the command-line interface.
(host)[node] (config) #ap wired-port-profile <profile>

2.4 Ghz and 5 Ghz Radio RF Management
The two 802.11a and 802.11g RF management profiles for an AP configure its 802.11a (5 Ghz) and 802.11b/g
(2.4 GHz) radio settings. You can either use the “default” version of each profile, or create a new 802.11a or
802.11g profile using the procedures below. Each RF management radio profile includes a reference to an
Adaptive Radio Management (ARM) profile. If you would like ARM to dynamically select the best channel and
transmission power for the radio, verify that the RF management profile references an active and enabled ARM
profile. It can be useful to set the Max Tx EIRP parameter in the ARM profile to 127 (the maximum power level
permissible) until it determines the signal-to-noise radio on the links. If ARM is active, the Max Tx EIRP can also
be set to 127 to allow maximum power levels.

If you want to manually select a channel for each AP group, create separate 802.11a and 802.11g profiles for
each AP group and assign a different transmission channel for each profile. For example, one AP group could
have an 802.11a profile that uses channel 36 and an 802.11g profile that uses channel 11, and another AP
group could have an 802.11a profile that uses channel 40 and an 802.11g profile that uses channel 9.

With the implementation of the high-throughput 802.11n standard, 40 MHz channels were added in addition
to the existing 20 MHz channel options. Available 20 MHz and 40 MHz channels are dependent on the country
code entered in the regulatory domain profile. The newer very high-throughput (VHT) 802.11ac standard
introduces 80 Mhz channel options.
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Changing the country code causes the valid channel lists to be reset to the defaults for the country.

Managing 2.4 GHz and 5 Ghz Radio Settings
Use the following procedures to define and manage 802.11a and 802.11g RF management profiles Using the
WebUI.

In the WebUI
1. Navigate to the Configuration > Access Points tab or the Configuration > AP Groups tab.

2. Select the name of an AP or AP group from the access points or AP groups tables.

3. Click the Radio tab below the access points or AP groups tables to display the AP radio settings. The AP
radio settings are divided into three sections, Basic, Advanced and Client Control. The profile
parameters in each section are described in Table 107.

4. Modify the desired settings, then click Submit.
5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy Changes.

Parameter Description

Basic

Radio Mode Access Point operating mode. Available options are:

l am-mode: Air Monitor mode

l ap-mode: Access Point mode

l spectrum-mode: Spectrum Monitor mode

The default settings is ap-mode.

Spectrum
Monitoring

Select this option to convert APs using this radio profile to a hybrid APs that will
continue to serve clients as an Access Point, but will also scan and analyze
spectrum analysis data for a single radio channel. For more details on hybrid APs,
see Spectrum Analysis on page 674.

Tx Power Select the maximum and minimum transmission power levels for the radio in dBm.
You can also set the maximum level to 127 for the regulatory maximum for taht
radio. Transmit power may be further limited by regulatory domain constraints and
AP capabilities.

Channel Width The following channel width configurations are available in ArubaOS:

l 20 Mhz: A 20 MHz channel assignment consists of a single 20 MHz channel.
This20 channel assignment is valid for 802.11a/b/g and for 802.11n 20 MHz
mode of operation.

l 40 Mhz: A 40 MHz channel assignment consists of two 20 MHz channels
bonded together (a bonded pair). This channel assignment is valid for 802.11n
40 MHz mode of operation and is most often utilized on the 5 GHz frequency
band.

l 80 Mhz: If you select this option, the AP radio supports channels assignments

Table 107: 2.4 Ghz and 5 Ghz Radio Configuration Parameters



Parameter Description

within the 20 Mhz, 40 Mhz and 80 Mhz bands.

Valid 2.4 Ghz
Channels

Valid 5 Ghz
Channels

Click Edit to select a group of supported transmit channels for the 2.4 Ghz and 5
Ghz radios. The available channels depend on the regulatory domain (country).
The available channels may be limited by the Channel Width setting.

Advanced

Interference
Immunity

Set a value for non-Wi-Fi Interference Immunity.

The default setting for this parameter is level 2. When performance drops due to
interference from non-802.11 interferers (such as DECT or Bluetooth devices), the
level can be increased up to level 5 for improved performance. However,
increasing the level makes the AP slightly “deaf” to its surroundings, causing the AP
to lose a small amount of range.

The levels for this parameter are:

l Level 0: no ANI adaptation.

l Level 1: noise immunity only.

l Level 2: noise and spur immunity.

l Level 3: level 2 and weak OFDM immunity.

l Level 4: level 3 and FIR immunity.

l Level 5: disable PHY reporting.

Beacon Interval Beacon Interval for the AP in msec. The supported range is 60-30000)msec, and
the default value is 100 msec.

Enable CSA Channel Switch Announcements (CSAs), as defined by IEEE 802.11h, enable an AP
to announce that it is switching to a new channel before it begins transmitting on
that channel. Enable this option to allow clients that support CSA to transition to the
new channel with minimal downtime.

CSA Count Number of channel switch announcements that must be sent prior to switching to a
new channel. The default CSA count is 4 announcements.

Advertise 802.11d
and 802.11h

Enable the radio to advertise its 802.11d (Country Information) and 802.11h
(Transmit Power Control) capabilities. This option is disabled by default.

Client Control

Client Match Enable client match client bandsteering, load balancing and enhanced AP
reassignment for roaming mobile clients. For more information on this feature, see
ClientMatch Overview on page 436

In the CLI
[mynode](config) #rf dot11a-radio-profile|dot11g-radio-profile <profile-name>

To view a complete list of 802.11a or 802.11g RF management profiles and their status:
[mynode]# show rf dot11a-radio-profile|dot11g-radio-profile
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To view a complete list of 802.11a or 802.11g RF management profiles and their status:
[mynode]# show rf dot11a-radio-profile|dot11g-radio-profile

To view the settings of a specific RF management profile:
[mynode]# show rf dot11a-radio-profile|dot11g-radio-profile <profile-name>

Managing High Throughput Radio Settings
Each radio references a high-throughput profile that manages that AP’s 40Mhz tolerance settings. By default, a
5 Ghz radio uses a high-throughput profile named default-a and a 2.4 Ghz radio uses a high-throughput
profile named default-g. If you do not want to use these default profiles, use the procedure below to
reference a different high-throughput profile for your 802.11a or 802.11g RF management profiles. For more
information on configuring these settings, see High-Throughput APs on page 528.

RF Optimization
Each AP includes an RF Optimization profile that allows you to configure settings for detecting interference.
The controller can detect interference near a wireless client station or AP is based on an increase in the frame
retry rate or frame receive error rate.

Using the WebUI
1. Navigate to the Configuration > System > Profiles tab.

2. Select RF Management menu, then click RF Optimization.

3. Select the RF Optimization profile you want to edit or click Add and enter a name into the Profile Name
dialog box to create a new profile.

4. Configure your RF Optimization radio settings then click Submit. Table 108 describes the parameters

Parameter Description

Station Handoff Assist Allows the controller to force a client off an AP when the RSSI drops
below a defined minimum threshold.

Default: Disabled

RSSI Falloff Wait Time Time, in seconds, to wait with decreasing RSSI before a de-authorization
message is sent to the client.

Maximum value: 8 seconds

Default : 4 seconds

Low RSSI Threshold Minimum RSSI above which de-authorization messages should never be
sent.

Default: 10

RSSI Check Frequency Interval, in seconds, to sample RSSI.

Default: 3 seconds

Table 108: RF Optimization Profile Parameters

Using the CLI
Use the following command to configure RF Optimization profiles using the command-line interface

rf optimization-profile <profile>



RF Event Configuration
An AP’s event threshold profile configures Received Signal Strength Indication (RSSI) metrics, including high and
low watermarks for frame error rates and frame retry rates. When certain RF parameters are exceeded, these
events can signal excessive load on the network, excessive interference, or faulty equipment.

This profile and many of the detection parameters are disabled (value is 0) by default.

The following procedure details the steps to configure RF Event parameters.

Using the WebUI
1. Navigate to the Configuration > Controller> Profiles tab.

2. Select RF Management menu, then click RF Event Thresholds.

3. Select the RF Event Thresholds profile you want to edit or click + and enter a name into the Profile Name
dialog box to create a new profile.

4. (Optional) Click General then select Detect Frame Rate Anomalies to enable or disables detection of
frame rate anomalies. This feature is disabled by default.

5. (Optional) Click Advanced to configure the parameters described detailed in Table 109.

6. Click Save.

Parameter Description

Bandwidth Rate High
Watermark

If bandwidth in an AP exceeds this value, a bandwidth exceeded
condition exists. The value represents the percentage of maximum for
a given radio. (For 802.11b, the maximum bandwidth is 7 Mbps. For
802.11 a and g, the maximum is 30 Mbps.) The recommended value is
85%.

Bandwidth Rate Low
Watermark

After a bandwidth exceeded condition exists, the condition persists until
bandwidth drops below this value. The recommended value is 70%.

Frame Error Rate High
Watermark

If the frame error rate (as a percentage of total frames in an AP)
exceeds this value, a frame error rate exceeded condition exists. The
recommended value is 16%.

Frame Error Rate Low
Watermark

After a frame error rate exceeded condition exists, the condition
persists until the frame error rate drops below this value. The
recommended value is 8%.

Frame Fragmentation Rate
High Watermark

If the frame fragmentation rate (as a percentage of total frames in an
AP) exceeds this value, a frame fragmentation rate exceeded condition
exists. The recommended value is 16%.

Frame Fragmentation Rate
Low Watermark

After a frame fragmentation rate exceeded condition exists, the
condition persists until the frame fragmentation rate drops below this
value. The recommended value is 8%

Table 109: RF Event Thresholds Profile Parameters
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Parameter Description

Frame Low Speed Rate
High Watermark

If the rate of low-speed frames (as a percentage of total frames in an
AP) exceeds this value, a low-speed rate exceeded condition exists. This
could indicate a coverage hole. The recommended value is 16%.

Frame Low Speed Rate Low
Watermark

After a low-speed rate exceeded condition exists, the condition persists
until the percentage of low-speed frames drops below this value. The
recommended value is 8%.

Frame Non Unicast Rate
High Watermark

If the non-unicast rate (as a percentage of total frames in an AP)
exceeds this value, a non-unicast rate exceeded condition exists. This
value depends upon the applications used on the network.

Frame Non Unicast Rate
Low Watermark

After a non-unicast rate exceeded condition exists, the condition
persists until the non-unicast rate drops below this value.

Frame Receive Error Rate
High Watermark

If the frame receive error rate (as a percentage of total frames in an
AP) exceeds this value, a frame receive error rate exceeded condition
exists. The recommended value is 16%

Frame Receive Error Rate
Low Watermark

After a frame receive error rate exceeded condition exists, the
condition persists until the frame receive error rate drops below this
value. The recommended value is 8%.

Frame Retry Rate High
Watermark

If the frame retry rate (as a percentage of total frames in an AP)
exceeds this value, a frame retry rate exceeded condition exists. The
recommended value is 16%.

Frame Retry Rate Low
Watermark

After a frame retry rate exceeded condition exists, the condition
persists until the frame retry rate drops below this value. The
recommended value is 8%.

Using the CLI
Use the following command to configure RF event profiles. The available parameters for this profile are
detailed in Table 109.

rf event-thresholds-profile <profile>

High-Throughput APs
With the implementation of the IEEE 802.11ac standard, very-high-throughput can be configured to operate
on the 5 GHz frequency band. High-throughput (802.11n) can be configured on both the 5 GHz and 2.4 GHz
frequency bands. High-throughput is enabled by default, and can be enabled or disabled in the 802.11a and
802.11g radio profiles. For details, see 2.4 Ghz and 5 Ghz Radio RF Management on page 523

Two different profiles advanced define settings specific to high-throughput APs, the high-throughput radio
profile and the high-throughput SSID profile. Use the High-throughput radio profile to configure your APs
to advertise intolerance of 40 MHz operation. ( By default, this option is disabled, and 40 MHz operation is
allowed.) This profile also allows you to enable the CSD Override feature. When you turn on CSD override,
CSD is disabled and only one antenna transmits data, even if they are being sent to high-throughput stations.
The High-throughput SSID profile configures the high-throughput SSID settings for 802.11n.



You must create and modify a high-throughput radio or high-throughput SSID profile to change default values
for an AP radio, such as activating features not enabled by default, disabling features that are enabled by
default, or modifying default values for configuration settings.

Stations are not allowed to use high-throughput with TKIP stand-alone encryption, although TKIP can be provided in
mixed-mode BSSIDs that support high-throughput. High-throughput is disabled on a BSSID if the encryption mode is
stand-alone TKIP or WEP.

Configuring Advanced High-Throughput Radio Settings
Most deployments do not require manual configuration of the high-throughput radio profile, however, you
can configure advanced high-throughput radio profile settings using the WebUI or CLI interfaces

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles tab.

2. From the All Profiles window, expand the RF Management menu, then click High-Throughput Radio.

3. Select the High-Throughput Radio profile you want to edit or click + and enter a name into the Profile
Name dialog box to create a new profile.

4. Configure the throughput settings described in Table 110.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy Changes.

Parameter Description

honor 40MHz
intolerance

When enabled, the radio will stop using the 40 MHz channels if the 40 MHz
intolerance indication is received from another AP or station. Uncheck the
Honor 40 Mhz intolerance check box to disable this feature.

Default: Enabled

CSD override Most transmissions to high throughput (HT) stations are sent through
multiple antennas using cyclic shift diversity (CSD). When you enable the
CSD Override parameter, CSD is disabled and only one antenna transmits
data, even if they are being sent to high-throughput stations. This enables
interoperability for legacy or high-throughput stations that cannot decode
802.11n CDD data. This option is disabled by default, and should only be
enabled under the supervision of Aruba technical support.

Use this feature to turn off antenna diversity when the AP must support
legacy clients such as Cisco 7921g VoIP phones, or older 802.11g clients
(e.g. Intel Centrino clients). Note, however, that enabling this feature can
reduce overall throughput rates.

Table 110: High-Throughput Radio Profile Configuration Parameters

In the CLI
(host)(config) #rf ht-radio-profile <profile>

(host)(config) #rf dot11a-radio-profile|dot11g-radio-profile <profile> high-throughput-enable

Configuring Advanced High-Throughput SSID settings
Most deployments do not require manual configuration of the high-throughput SSID profile, however, you can
configured advanced high-throughput SSID profile settings or modify default SSID profile values using the
WebUI or CLI interfaces.
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De-aggregation of MAC Service Data Units (A-MSDUs) is supported with a maximum frame transmission size of 4k
bytes; however, this feature is always enabled and is not configurable. Aggregation is not currently supported.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Expand the Wireless LAN profiles menu.

3. Select High-Throughput SSID.

4. Select the High-Throughput SSID profile you want to edit or click + and enter a name into the Profile Name
dialog box to create a new profile.

5. Configure the high-throughput SSID profile settings described in Table 111 .

Parameter Description

General

High throughput enable (SSID) Determines if this high-throughput SSID allows high-
throughput (802.11n) stations to associate.

Enabling high-throughput in an WLAN high-throughput SSID
profile enables Wi-Fi Multimedia (WMM) base features for
the associated SSID.

Default: Enabled.

40 MHz channel usage Enable or disable the use of 40 MHz channels. This
parameter is enabled by default.

Default: Enabled.

Very High throughput enable (SSID) Enable or disable support for Very High Throughput
(802.11ac) on the SSID.

Default: Enabled.

80 MHz channel usage (VHT) Enable or disable the use of 80 MHz channels on Very High
Throughput (VHT) APs.

Default: Enabled.

Multi User Transmit Beamforming

VHT - Multi User Transmit Beamforming Enable or disable VHT Multi-User Transmit Beamforming. If
this parameter is disabled, all other Multi-User Transmit
Beamforming configuration parameters have no effect.

Default: Enabled.

Transmit Beamforming

Table 111: High-Throughput SSID Profile Parameters



Parameter Description

VHT - Explicit Transmit Beamforming Enable or disable VHT Explicit Transmit Beamforming for
the 802.11ac-capable APs. When this parameter is enabled,
the AP requests information about the Multiple-Input and
Multiple-Output (MIMO) channel and uses that information
to transmit data over multiple transmit streams using a
calculated steering matrix. The result is higher throughput
due to improved signal at the beamforming (the receiving
client). If this parameter is disabled, all other transmit
beamforming settings will not take effect.

Default: Enabled.

Advanced

BA AMSDU Enable Enable or disable Receive AMSDU in Block ACK (BA)
negotiation. If enabled, AP denies clients from sending
AMSDU using BA agreement.

Default: Enabled.

Temporal Diversity Enable When this setting is enabled and the client is not
responding to 802.11 packets, the AP will launch two
hardware retries; if the hardware retries are not successful
then it attempts software retries.

Default: Disabled.

Legacy stations Control whether or not legacy (non-HT) stations are allowed
to associate with this SSID. By default, legacy stations are
allowed to associate. This setting has no effect on a BSS in
which HT support is not available.

Default: Enabled.

Low-density Parity Check If enabled, the AP will advertise Low-density Parity Check
(LDPC) support. LDPC improves data transmission over
radio channels with high levels of background noise.

Default: Enabled.

Maximum number of spatial streams usable for
STBC reception

Control the maximum number of spatial streams usable for
Space-Time Block Code (STBC) reception. 0 disables STBC
reception, 1 uses STBC for MCS 0-7. Higher MCS values are
not supported. (Supported on the AP-105, 130 Series, and
AP-175 only. The configured value will be adjusted based on
AP capabilities.)

Default: 1.

NOTE: If transmit beamforming is enabled, STBC will be
disabled for beamformed frames.

Maximum number of spatial streams usable for
STBC transmission.

Control the maximum number of spatial streams usable for
STBC transmission. 0 disables STBC transmission, 1 uses
STBC for MCS 0-7. Higher MCS values are not supported.
(Supported on AP-105, 130 Series, and AP-175 only. The
configured value will be adjusted based on AP capabilities.)
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Parameter Description

Default: 1.

NOTE: If transmit beamforming is enabled, STBC will be
disabled for beamformed frames.

MPDU Aggregation Enable or disable MAC Protocol Data Unit (MPDU)
aggregation.

High-throughput APs are able to send aggregated MAC
protocol data units (MDPUs), which allow an AP to receive a
single block acknowledgment instead of multiple ACK
signals. This option, which is enabled by default, reduces
network traffic overhead by effectively eliminating the need
to initiate a new transfer for every MPDU.

Default: Enabled.

Max received A-MPDU size Control the maximum size, in bytes, of an Aggregated-MAC
Packet Data Unit (A-MPDU) that can be received on this
high-throughput SSID.

Default: 65535 bytes.

Max transmitted A-MPDU size Control the maximum size, in bytes, of an A-MPDU that can
be sent on this high-throughput SSID.

Range: 1576–65535 bytes.

Min MPDU start spacing Minimum time between the start of adjacent MPDUs within
an aggregate MPDU, in microseconds.

Range: 0 (No restriction on MDPU start spacing), .25 µsec,
.5 µsec, 1 µsec, 2 µsec, 4 µsec.

Default: 0.

Short guard interval in 20 MHz mode Enable or disable use of short (400 ns) guard interval in 20
MHz mode.

A guard interval is a period of time between transmissions
that allows reflections from the previous data transmission
to settle before an AP transmits data again. An AP identifies
any signal content received inside this interval as unwanted
inter-symbol interference, and rejects that data. The
802.11n standard specifies two guard intervals: 400 ns
(short) and 800 ns (long). Enabling a short guard interval
can decrease network overhead by reducing unnecessary
idle time on each AP. Some outdoor deployments, may,
however require a longer guard interval. If the short guard
interval does not allow enough time for reflections to settle
in your mesh deployment, inter-symbol interference values
may increase and degrade throughput.

Default: Enabled.

Short guard interval in 40 MHz mode Enable or disable use of short guard interval (400 ns) in 40
MHz mode of operation.

Default: Enabled.



Parameter Description

Short guard interval in 80 MHz mode Enable or disable use of short guard interval (400 ns) in 80
MHz mode of operation.

Default: Enabled.

Supported MCS set A list of Modulation Coding Scheme (MCS) values or ranges
of values to be supported on this SSID. The MCS you choose
determines the channel width (20 MHz vs. 40 MHz vs. 80
MHz) and the number of spatial streams used by the mesh
node.

Range: 0–31.

Default: 0–31.

To specify a smaller range of values, enter a hyphen
between the lower and upper values. To specify a series of
different values, separate each value with a comma.

Examples:
2–10
1,3,6,9,12

MCS value of 16-23 are supported on 130 Series/RAP-
155/11ac APs only.

MCS value of 24-31 are supported on 320 Series APs only.

VHT - Supported MCS Map Comma separated list of maximum supported MCS for
spatial streams 1 through 4. Valid values for maximum MCS
are 7, 8, 9, and '-' (if spatial stream is not supported).
Maximum MCS of a spatial stream cannot be higher than
the previous streams. If an MCS is not valid for a particular
combination of bandwidth and number of spatial streams, it
will not be used for Tx and Rx.

Default: 9,9,9,9.

VHT - Transmit Beamforming Sounding Interval Time interval in milliseconds between channel information
updates between the AP and the beamformee client.

Default: 25 msec.

NOTE: This is applicable for 802.11ac-capable APs only.

Maximum VHT MPDU size Maximum size of a VHT MPDU.

Default: 11454 bytes.

Maximum number of MSDUs in an A-MSDU on
best-effort AC

Set the maximum number of MSDUs in a TX A-MSDU on
best effort AC.

Default: 2.

NOTE: In tunnel and decrypt-tunnel forwarding mode, TX A-
MSDU is disabled if the value is set to 0. If the value is set to
non-zero, TX A-MSDU is enabled and set to this value.

Maximum number of MSDUs in an A-MSDU on
background AC

Set the maximum number of MSDUs in a TX A-MSDU on
background AC.
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Parameter Description

Default: 2.

NOTE: TX A-MSDU is disabled if the value is set to 0. In
decrypt-tunnel forwarding mode, TX A-MSDU on
background AC is disabled and assigning any value has no
effect.

Maximum number of MSDUs in an A-MSDU on
video AC

Set the maximum number of MSDUs in a TX A-MSDU on
video AC.

Default: 2.

NOTE: TX A-MSDU is disabled if the value is set to 0. In
decrypt-tunnel forwarding mode, TX A-MSDU on video AC is
disabled and assigning any value has no effect.

Maximum number of MSDUs in an A-MSDU on
voice AC

Set the maximum number of MSDUs in a TX A-MSDU on
voice AC.

Default: 0.

NOTE: TX A-MSDU is disabled if the value is set to 0. In
decrypt-tunnel forwarding mode, TX A-MSDU on voice AC is
disabled and assigning any value has no effect.

In the CLI
(host)(config) #wlan ht-ssid-profile <profile-name>

Validating and Optimizing AP Connectivity
The ArubaOS AP system profile contains multiple configuration settings to help you validate and optimize your
AP connections to a controller.

This section includes the following information about these features:

l AP Health Checks on page 534

l Optimizing AP Connections over Low-Speed Links on page 534

AP Health Checks
The AP Health check feature uses ping probes to check reachablility and latency levels for the connection
between the AP and the managed device. The recorded latency information appears in the output of the show
ap ip health-check command. If the managed device IP address becomes unreachable from the AP uplink,
this feature records the time that the connection failed, and saves that information in a log file (tmp/ap_hcm_
log) on the AP.

This feature is disabled by default, and is enabled by selecting the Health Check option in the AP system profile. For
details see Configuring the AP System Profile on page 514

Optimizing AP Connections over Low-Speed Links
Depending on your deployment scenario, you may have APs or remote APs that connect to a managed device
located across low-speed (less than 1 Mbps capacity) or high-latency (greater than 100 ms) links.

With low-speed links, if heartbeat or keep alive packets are not received between the AP and managed device
during the defined interval, APs may reboot causing clients to re-associate. You can adjust the bootstrap



threshold and prioritize AP heartbeats to optimize these types of links. In addition, high bandwidth
applications may saturate low-speed links. For example, if you have tunnel-mode SSIDs, use them with low-
bandwidth applications such as barcode scanning, small database lookups, and Telnet to avoid saturating the
link. If you have traffic that will remain local, deploying remote APs and configuring SSIDs as bridge-mode
SSIDs can also prevent link saturation.

With high-latency links, consider the amount and type of client devices accessing the links. Aruba APs locally
process 802.11 probe-requests and probe-responses, but the 802.11 association process requires interaction
with the managed device.

When deploying APs across low-speed or high-latency links, The following best practices are recommended:

l Connect APs and managed devices over a link with a capacity of 1 Mbps or greater.

l Maintain a minimum link speed of 64 Kbps per AP and per bridge-mode SSID. This is the minimum speed
required for downloading software images.

l Adjust the bootstrap threshold to 30 if the network experiences packet loss. This makes the AP recover
more slowly in the event of a failure, but it will be more tolerant to heartbeat packet loss.

l Prioritize AP heartbeats to prevent losing connectivity with the managed device.

l If possible, reduce the number of tunnel-mode SSIDs. Each SSID creates a tunnel to the managed device
with its own tunnel keep alive traffic.

l If most of the data traffic will remain local to the site, deploy remote APs in bridging mode. For more
information about remote APs, see Access Points on page 489.

l If high-latency links such as transoceanic or satellite links are used in the network, deploy a managed device
geographically close to the APs.

l If high-latency causes association issues with certain handheld devices or barcode scanners, check the
manufacturer of the device for recent firmware and driver updates.

Configuring the Bootstrap Threshold
To configure the bootstrap threshold via the WebUI, enter a value into the bootstrap threshold field in the
advanced AP system profile settings. ( For details see Configuring the AP System Profile on page 514) To
configure this setting via the command-line interface, issue the command ap system-profile <profile>
bootstrap-threshold <bootstrap-threshold>.

Prioritizing AP heartbeats
To configure the AP heartbeat priority via the WebUI, enter a value greater than zero into the Heartbeat DSCP
field in the advanced AP system profile settings. ( For details see Configuring the AP System Profile on page
514) To configure this setting via the command-line interface, issue the command ap system-profile
<profile> heartbeat-dscp <number>.

AP Chanel Scanning
The scanning algorithm is enhanced to reduce the delay between visits to some channel types, by changing
their scan priority.

Channel Types and Priority
A channel can belong to one or more channel types, depending on regulatory information and the activity that
is detected on the channel. The frequency of visits to a channel depends on the priority of the channel type(s)
to which it belongs. The following table describes the priority of channel types.
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Channel Priority Channel Type Description

One DOS Channels Channels where the AP is actively containing one more
rogue devices in AM mode are marked with an O flag in
the ARM CLI output (show ap arm scan-times).

Two Active Channels Channels where AP or Station activity has already been
detected are marked with an A flag in the ARM CLI output
and are visited in all scan-modes.

Three Reg-Domain Channels Channels that are in the AP’s regulatory domain are
marked with a C flag in the ARM CLI output and are visited
in all scan modes.

Four All Reg-Domain Channels Channels that belong to any country’s regulatory domain
are marked with a D flag in the ARM CLI output and are
visited only if the scan-mode is set to All-Reg or Rare.

Five Unconventional Scan
Channels

This new channel type category contains channels that
belong to any country’s regulatory domain, but with an
unconventional scan direction. These channels are
marked with a J or M flag in the ARM CLI output and are
visited only if scan-mode is set to All-Reg or Rare.

Six Rare Channels Channels that do not belong to any country’s regulatory
domain are marked with a Z flag in the ARM CLI output.
Rare channel scanning is done in the AM mode only if the
rare scan mode is selected in the AM Scanning profile.

Table 112: Channel Types and Priority

The country code in the AP Regulatory Domain profile determines supported channel and channel pairs for
that specific AP. If there is a change in the country code, the valid channel list is reset to the default value for
that country.

Use the show ap arm scan-times ap-name <ap_name> command to show scan state and flags for each channel.

Scanning Optimizations
The following optimizations enable the AP to achieve optimum RF monitoring. Unconventional Scans and
Relative Priority of Channel Type Categories optimization apply to all AP types, but Channel Group Scanning
optimization applies only to 200 Series models. All optimizations apply to AP and AM mode scanning.

Unconventional (direction) Scans
l Unconventional scans are 40MHz scans of a channel in the direction away from the channel pair. For

example, in the 44-48 channel pair:

n Conventional scans will be 44+ and 48-

n Unconventional scans will be 44- and 48+

l Unconventional scans are no longer interspersed with conventional scans. Unconventional scans operate
with a lower frequency, because they belong to a new low priority channel type.



l Unconventional scans are performed in all-regulatory and rare scan modes. But these scans will not be
performed if the scan mode is set to regulatory domain. This modification enables the AP to scan through
active channels, regulatory channels, and all-regulatory channels faster.

Currently, 200 Series access points do not support unconventional or rare channel scanning.

Modifications in Scan Frequency
A modification is introduced to increase the frequency of visits to active and regulatory domain channels.
Channel type categories are:

l DOS

l Active

l Regulatory domain

l All-regulatory domain

l Unconventional or rare

Unconventional or rare channels are merged for scanning.

Channel Group Scanning
Since a 11ac AP radio can hear frames sub-channels when it performs an 80MHz wide scan, scanning can be
optimized by categorizing channels into scan groups, which are visited sequentially when a new primary
channel is selected. This allows the AP scan through the list of channels faster, so that the delay between visits
to channels in a group is reduced.

For more information on Channel Group Scanning, see Channel Group Scanning on page 537

Channel Group Scanning
The following section describes channel group scanning:

l Channel groups can be 80MHz (4 channels), 40MHz (2 channels), or 20MHz wide (1 channel).

l Each channel is mapped to a group depending on the maximum width supported by that channel and the
radio’s capability. The maximum width supported by a channel is determined by the channel’s membership
in regulatory domain channel pairs or groups.

n Channel 36, 40, 44, and 48 belong to 80MHz group

n Channel 165 belongs to 20MHz group

l Channel groups are visited sequentially and the primary channel is rotated after each visit.

l Group scanning behavior is performed for 200 Series access points on A-band channels.

Scanning only once in each 80MHz wide group allows the AP to scan through the channel list faster and also hear
frames on sub-channels.

Managing AP Console Settings
An AP’s provisioning parameters are unique to each AP. These parameters are initially configured on the
Mobility Master and then pushed out to the AP and stored on the AP itself. Best practices are to configure an
AP’s provisioning settings using the Mobility Master WebUI. If you find it necessary to alter an AP’s provisioning
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settings for troubleshooting purposes, you can do so using the WebUI and CLI, or alternatively, through a
console connection to the AP itself.

To create a console connection to the AP:

1. Connect a local console to the serial port on the AP. You can connect the AP’s serial port to a terminal or
terminal server using an Ethernet cable, or connect the serial console port to a DB-9 adapter, then connect
the adapter to a laptop using an RS-232 cable. For details on connecting to an AP’s serial console port, refer
to the installation guide included with the AP.

2. Establish a console communication to the AP, then power-cycle the AP to reboot it.

3. To access the AP console command prompt, press Enter when the AP displays the message “Hit <Enter> to
stop autoboot.” If the autoboot countdown expires before you can interrupt it, turn the device off and then
back on.

4. Once the AP boot prompt appears, enter the AP console password. You can issue any of the AP provisioning
commands described in the Table 113. Remember, though these commands may be useful for
troubleshooting, they are all optional and are not necessary for normal AP provisioning.

Command Description

boot Boot the ArubaOS image from flash or USB, using currently saved
environment variables. Any unsaved changes to the variables will be lost.
This command has the following sub-parameters:

l ap - Boot the ArubaOS image from flash.

l usb:<path> - Boot the ArubaOS image from USB.

clear Clear the ArubaOS image or other information. This command has the
following sub-parameters:

l all - Clear the cache and ArubaOS.

l cache - Clear the cache sectors (mesh, RAP, CAP).

l os <n> - Clear the image from the specified partition (default: 0).

l prov - Clear provisioning image from the flash.

dhcp Invoke DHCP client to obtain IP/boot parameters.

factory_reset Reset the AP to factory default.

flash Upgrade the boot image.

NOTE: Exercise caution when using this command.

help Help text for the AP boot commands.

mfginfo Shows manufacturing information of the AP.

Table 113: AP Boot Commands

The list of AP boot commands may vary based on the APBoot image version.



Command Description

osinfo Shows the ArubaOS image information on the AP.

ping Check network connectivity.

printenv List the environment variables and their current settings. AP boot
environment variables are configured using the AP boot setenv
command,

purgeenv Reinstate AP boot configuration to factory default. This includes restoring
the default environment variables.

reset Perform RESET of the AP CPU.

saveenv Save environment variables to persistent storage.

setenv ipaddr <ipaddr> IP address to be assigned to the AP.

setenv netmask <netmaskip> Netmask to be assigned to the AP.

setenv gatewayip <ipaddr> IP address of the internet gateway used by the AP.

setenv name <ap name> Name of the AP.

setenv group <group name> Name of the AP group to which the AP should belong.

setenv master <ipaddr> IP address of the AP’s master controller.

setenv serverip <ipaddr> IP address of the TFTP server from which the AP can download its boot
image.

setenv dnsip <ipaddr> IP address of the DNS server used by the AP.

setenv domainname
<domain>

Domain name used by the AP.

tftpboot Boot ArubaOS image over the network using TFTP protocol.

upgrade Upgrade the APBoot or ArubaOS image. This command has the following
sub-parameters:

l boot <file> - Upgrade the APBoot image from <file>.

l os [<n>] <file> - Upgrade the ArubaOS image in partition <n> from
<file>.

l prov - Upgrade provisioning image from <file>.

NOTE: <file> can be a <TFTP-server-IP>:<path> or usb:<path>.

version Displays the APBoot image version.
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5. When you are finished, type saveenv and then press enter to save your settings

Other AP console commands may be available when accessing an AP directly through its console port, but these
commands can cause configuration errors if used improperly and should only be issued under the direct supervision
of Aruba technical support.

The example below configures an AP location and domain name using an AP console connection:
Hit <Enter> to stop autoboot: 0

apboot> <INTERRUPT>

apboot> setenv group corporate-2

apboot> setenv domainname mycompany.com

apboot> saveenv

apboot>boot

To view current AP settings using the AP console, issue the command printenv <name> where <name> is
one of the variable names listed in Table 113, such as ipaddr, dnsip or gatewayip.
apboot> printenv domainname

domainname=mycompany.com

AP Console Password Protection
The ArubaOS AP console password feature helps protect systems that manage highly sensitive information, like
financial and banking institutions, by requiring users to log in to the AP network with a password. The AP
console password is enabled by default. Passwords must be 6 to 32 characters in length, and can include
alphanumeric and special characters. If configured, you must enter this password to get AP console access. If
not configured, the Mobility Master generates a default random password which can be viewed by executing
the encrypt disable command followed by the show ap system-profile <profile-name> command.

The timeout feature is also supported as an added level of security. If there is no user input or activity during
one timeout interval (default of 30 minutes), the user is logged out of the system. The timeout interval cannot
be modified.

Setting an AP Console Password
You can configure an AP console password using the managed device WebUI or CLI.

In the WebUI

To set a password in the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > System page.

2. Select the Profiles tab.

3. Expand the AP profile in the All Profiles list, then select AP System.

4. Select the AP system profile you want to modify.

5. Open the Advanced tab, check the Console Enable check box.

6. In the AP Console Password field, enter the desired AP console password. Retype the password to
confirm.

7. In the Password for Backup field, enter the password backup password for the console. Retype the
password to confirm.

8. Click Submit.

Once the console is enabled, you do not need to enable it again. The console access is password protected.



In the CLI

To set the AP console password in the CLI:
(host)[node] (config) #ap system-profile <profile>

(host)[node] (AP system-profile “<profile>") #console-enable

(host)[node] (AP system-profile “<profile>”) #slow_timer_recovery

If the password is lost, and the AP is not connected to a managed device, the console can be reset using the
reset button on the AP or the factory_reset AP boot command. If it is already connected to a managed device,
the AP password can be changed under the AP Console Password field of the AP System profile in the
WebUI, or using the ap-console-password parameter of the ap system-profile command in the CLI.

Disabling Access to the AP Console
Another way to protect your AP system is to completely disable access to the AP console under enabled mode.

In the WebUI

To disable access to the console in the WebUI:

1. In the Managed Network node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand the AP profile in the All Profiles list, then select AP System.

4. Select the AP system profile you want to modify.

5. Open the Advanced tab, check the Console Enable check box.

6. Click Save.

In the CLI

To disable access to the console in the CLI:
(host)[node] (config) #ap system-profile default

(host)[node] (AP system profile “default”) #no console-enable

Link Aggregation Support

Link aggregation is only supported by 220 Series, 270 Series and 320 Series access points.

All 220 Series , 270 Series, and 320 Series access points support link aggregation using either static port channel
(configuration based) or Link Aggregation Control Protocol (protocol signaling based). These access points can
optionally be deployed with LACP configuration to benefit from higher (greater than 1 Gbps) aggregate
throughput capabilities.

The Mobility Master uses two different IP addresses for forwarding traffic to wireless clients associated to
tunnel mode or decrypt-tunnel mode VAPs. One IP address is Mobility Master's IP address and the other is an
unassigned IP address called GRE striping IP. Select the GRE striping IP address to ensure that a different
physical interface is used by the load-balancing algorithm on the Ethernet switch. This enables the 220 Series ,
270 Series, and 320 Series access points achieve greater than 1 Gbps throughput in both upstream and
downstream directions.

On 200 Series and 270 Series access points, different IP addresses are used for different GRE tunnels between
the AP and the LC. One LC IP address is used for tunnels corresponding to virtual APs using a 5G radio and the
other LC IP address is used for tunnels corresponding to virtual APs using a 2.4G radio. By associating clients
on both bands you can achieve more than 1 Gbps throughput.
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On 320 Series access points, both IP addresses are used for GRE tunnels of virtual APs on 5G radio. By
associating one 4x4 802.11ac client or multiple clients on you can achieve more than 1 Gbps throughput.

A local AP LACP LMS map information profile that maps a LMS IP address to a GRE striping IP address. If the AP
fails over to a standby or backup Mobility Master, the AP LACP LMS map information profile on the new LC
defines the striping IP address that the AP uses for link aggregation. This feature allows 220 Series , 270 Series,
and 320 Series access points to continue to support link aggregation to a backup Mobility Master in the event
of a Mobility Master failover, even if the backup Mobility Master is in a different L3 network.

In previous releases, the GRE striping IP address was defined in the global AP system profile, which did not
allow APs to maintain GRE striping tunnels if the AP failed over to a backup Mobility Master in a different L3
network.

If your topology includes a backup Mobility Master you must define GRE striping IP settings in the active and the
backup Mobility Master For more information on LACP features in ArubaOS, see Configuring LACP on page 153.

Configuring LACP 
To enable and configure LACP on 220 Series , 270 Series, and 320 Series access points, configure the LMS IP
address and the GRE Striping IP address. In ArubaOS 6.4.2 and later, the GRE striping parameter is configured
in the AP LACP Striping profile. In ArubaOS 6.3.1.0 to 6.4.1.x, GRE striping is configured in the AP System
profile. The GRE Striping IP value must be an IPv4 address owned by the Mobility Master that has the
specified LMS IP. The GRE Striping IP does not belong to any physical or virtual interface on the Mobility
Master, but the Mobility Master can transmit or receive packets using this IP.

You can configure LACP features using the WebUI or the CLI.

Using the WebUI
Follow the procedure to configure the LACP parameters in the AP System profile and AP LACP LMS map
information profile:

1. In the Managed Network node hierarchy, navigate to the Configuration > AP Groups page.

1. Select an AP group then click the More tab.

2. Enter a unique IPv4 address in the LMS IP address field

3. Enter a backup IPv4 address in the Backup LMS IP address field.

4. Enter a unique IPv6 address in the LMS IPv6 address field

5. Enter a backup IPv6 address in the Backup LMS IPv6 address field.

6. Click Submit.

Use the following steps to enable LACP.

1. In the Managed Network node hierarchy, navigate to Configuration > System
2. Profiles and expand the AP profiles menu.

3. Select the AP LACP LMS map information profile.

4. Select the AP LACP Striping IP check box to enable the AP LACP striping IP feature.

5. Enter a GRE striping IP address in the ip field.

6. Enter a LMS IP address in the lms field.

7. Click OK.

8. Click Save.

Using the CLI,
Execute the following commands to configure AP LACP and striping IP on HA standby or backup LMS:



(host)[node] (config) #ap system-profile LACP

(host)[node] (AP system-profile "LACP") #lms-ip 192.0.2.1

(host)[node] (AP system-profile "LACP") #bkup-lms-ip 192.0.77.1

(host)[node] (AP system-profile "LACP") #exit

(host)[node] (config) #ap-lacp-striping-ip

(host)[node] (AP LACP LMS map information) #striping-ip 192.0.2.2 lms 192.0.2.1

(host)[node] (AP LACP LMS map information) #aplacp-enable

Execute the following commands to configure AP LACP LMS on HA standby or backup LMS.
(bkup-host)[node] (config) #ap-lacp-striping-ip

(bkup-host)[node] (config) (AP LACP LMS map information) #striping-ip

192.0.77.2 lms 192.0.2.1

(bkup-host) [node] (config)(AP LACP LMS map information) #aplacp-enable

If the lms-ip is not specified in the AP system profile, you can create an entry in ap-lacp-striping-ip profile with just
the striping-ip.

Important Points to Remember
l In the upstream direction when the AP transmits GRE frames to the Mobility Master the bonding driver

must be in active-active mode and not in the default active-standby mode to allow link aggregation.

l If an AP’s uplink access switch ports are configured in static port-channel mode, then the AP will set the
Ethernet bonding mode to static port-channel (xor mode) only if gre-striping-ip is configured. If gre-
striping-ip is not configured, then the AP goes back to active-standby mode. In this scenario, the AP may
go down depending on the behavior of the upstream switch.

l If an AP’s uplink access switch ports are configured in dynamic LACP mode, the AP detects LACP-PDUs and
automatically sets the Ethernet bonding mode to LACP. If gre-striping-ip is not configured, then the AP’s
Ethernet bonding mode will continue to be in LACP mode, but the AP will send GRE traffic only through one
Ethernet port.

l In AP-324/AP-325 access points, if AP uplink packet capture is taken, the downstream traffic will have
sequence number in GRE header. Wireshark Aruba wlan decoder will not be able to decode these packets
correctly since it looks for known Aruba GRE tunnel IDs.

l Ensure that the gre-striping-ip is unique and not used by any other host on the subnet.

l LACP support is limited to a use case where Enet 0 and Enet 1 ports of the AP are connected to a switch, and
LACP is enabled on the two corresponding switch ports.

l The port priority is not applicable to the AP as both ports need to be used. This value is always set to the
maximum numerical priority (0xFF), which is the lowest priority.

l The system priority is not configurable. It is set to the maximum numerical value (0xFFFF), which is the
lowest priority. This leaves control of the aggregate to the upstream switch.

l The timeout value is not configurable.

l The key is not configurable and the default key value is 1.

l LACP cannot be enabled if wired AP functionality is enabled on the second port. You cannot enable LACP if
the Enet 1 port is shutdown.

Troubleshooting Link Aggregation
The following show commands in the CLI can be used to troubleshoot Link Aggregation on 220 Series , 270
Series, and 320 Series access points:

l show ap debug lacp ap-name <ap-name>—Using this command, you can view if LACP is active on an
AP. It displays the number of GRE packets sent and received on the two Ethernet ports. Using this
command with verbose option on AP-324/AP-325 access points displays packet re-ordering statistics of
each wlan client.
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l show ap database—Starting with ArubaOS 6.4.2, the output of this command includes an LACP Striping
flag (s) to indicate of the AP is configured with a LACP striping IP address,

l show datapath tunnel—Using this command on 220 Series/270 Series access points, you can verify if the
2.4GHz tunnels are anchored on the gre-striping-ip (The GRE IDs for these tunnels are in a range between
0x8300 and 0x83F0) . On AP-324/AP-325 access points, use the verbose option to verify that 5GHz tunnels
have striping IP set in the column StripIP (The GRE IDs for these tunnels are in a range between 0x8200 and
0x82F0).

l show datapath station—On AP-324/AP-325 access points, using this command displays the LACP
sequence number sent in the GRE header of the last packet to the client. This information is displayed
under Seq column.

l show ap remote debug anul-sta-entries—On AP-324/AP-325 access points, using this command
displays LAG enabled/disabled per station and data drops due to LAG packet reordering.

l show datapath user—Using this command, you can verify if the gre-striping-ip has an entry with the ‘L’
(local) flag

l show datapath route-cache—Using this command, you can verify if the gre-striping-ip has an entry
with the LC MAC.

Support for Port Bounce
Mobility Master provides support for the port bounce feature which enables a client to re-initiate a DHCP
request when there is a VLAN change. This is achieved when a RADIUS server such as ClearPass Policy Manager
sends Disconnect-Request with a Vendor Specific Attribute (VSA 40) to Mobility Master. Then, Mobility Master
forwards the request to the device to trigger an interface shut down for a specified period. This allows the
device to re-initiate a DHCP request for obtaining an IP address in the changed subnet.

The Disconnect-Request must include the following information:

l Calling Station-Id—MAC address of the user

l VSA—40

l Integer—0-60

VSA 40 represents Aruba-Port-Bounce-Host. The integer value indicates the time in seconds for which
Mobility Master must shut the interface down. If the integer value received is 0 or a number greater than 60,
Mobility Master does not shut the interface down.

During a port bounce, the client connected to the interface is removed from the user table and is added back after the
port is up.

Execute the following command to view the security logs during and after a port bounce:
[mynode] #show log security all | include bounce

The following sample shows the output during a port bounce:
Sep 14 22:22:46 authmgr[539]: <124004> <DBUG> |authmgr| Sending port bounce request for User

mac 34:e6:d7:24:c8:3b

Sep 14 22:23:22 authmgr[539]: <124004> <DBUG> |authmgr| Port Bounce succeeded for User Mac

34:e6:d7:24:c8:3b
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Chapter 26
Secure Enterprise Mesh

The Aruba secure enterprise mesh solution is an effective way to expand network coverage for outdoor and
indoor enterprise environments without any wires. Using mesh, you can bridge multiple Ethernet LANs or you
can extend your wireless coverage. As traffic traverses across mesh APs, the mesh network automatically
reconfigures around broken or blocked paths. This self-healing feature provides increased reliability and
redundancy: the network continues to operate if an AP stops functioning or a connection fails. Aruba managed
devices provide centralized configuration and management for APs in a mesh environment; local mesh APs
provide encryption and traffic forwarding for mesh links.

Mesh Overview Information
The following topics in this chapter describes the components of the Aruba secure enterprise mesh
architecture and profiles, as well as factors that should be taken into consideration when planning your mesh
deployment.

l Understanding Mesh Access Points on page 545

l Understanding Mesh Links on page 547

l Understanding Mesh Profiles on page 549

l Understanding Remote Mesh Portals (RMPs) on page 553

l Mesh Deployment Planning on page 557

l Mesh Deployment Solutions on page 555

l Mesh Deployment Planning on page 557

Mesh Configuration Procedures
The following topics describe the procedures required to configure your secure enterprise mesh solution:

1. Creating and Editing Mesh Radio Profiles on page 562

2. Creating and Editing Mesh Radio Profiles on page 562

3. Creating and Editing Mesh High-Throughput SSID Profiles on page 568

4. Configuring Ethernet Ports for Mesh on page 573

5. Provisioning Mesh Nodes on page 576

6. Verifying Your Mesh Network on page 577

Aruba strongly recommends staging mesh APs before deploying them. Identify the physical location of the APs,
configure them for mesh, provision the APs and verify connectivity before physically deploying them in a live network.

If you are configuring an AP as both a remote access point and a mesh portal, see also Configuring Remote
Mesh Portals (RMPs) on page 579

Understanding Mesh Access Points
Mesh APs learn about their environment when they boot up. Mesh APs are either configured as a mesh portal
(MPP), an AP that uses its wired interface to reach the managed device, or a mesh point (MP), an AP that
establishes an all-wireless path to the mesh portal. Mesh APs locate and associate with their nearest neighbor,
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which provides the best path to the mesh portal. Mesh portals and mesh points are also known as mesh
nodes, a generic term used to describe APs configured for mesh.

A mesh radio’s bandwidth can be shared between mesh-backhaul traffic and client traffic. You can, however,
configure a radio for mesh services only. If you have a dual-radio AP, a mesh node can be configured to deliver
client services on one radio, and both mesh and WLAN services to clients on the other. If you configure a single-
radio AP to deliver mesh services only (by disabling the mesh radio in its 802.11a or 802.11g radio profile) that
mesh node can not deliver WLAN services to its clients.

For mesh and traditional thin AP deployments, the Aruba Mobility Master provides centralized provisioning,
configuration, policy definition, ongoing network management, and wireless and security services. However,
unlike the traditional thin AP case, mesh nodes also perform network traffic encryption and decryption, and
packet forwarding over wired and wireless links.

You configure the AP for mesh on the Mobility Master using either the WebUI or the CLI. All mesh related
configuration parameters are grouped into mesh profiles that you can apply as needed to an AP group or to
individual APs.

APs operate as thin APs by default; their primary function is to receive and transmit electromagnetic signals;
other WLAN processing is left to the managed device. When planning a mesh network, you manually configure
APs to operate in mesh portal or mesh point roles. Unlike a traditional WLAN environment, local mesh nodes
provide encryption and traffic forwarding for mesh links in a mesh environment. Virtual APs are still applied to
non-mesh radios.

Provisioning mesh APs is similar to thin APs; however, there are some key differences. Thin APs establish a
channel to the managed device from which they receive the configuration for each radio interface. Mesh
nodes, in contrast, get their radio interfaces up and running before making contact with the managed device.
This requires a minimum set of parameters from the AP group and mesh cluster so the mesh node discovers a
neighbor, and creates a mesh link and subsequent channel with the managed device. To do this, you must first
define and configure the mesh cluster profile before configuring an AP to operate as a mesh node. This chapter
first describes how to configure the mesh profile, then describes how to configure APs to operate in mesh
mode. If you have already configured a complete mesh profile, continue to “Ethernet Ports for Mesh” or
“Provisioning Mesh Nodes”.

Mesh Portals
The mesh portal (MP) is the gateway between the wireless mesh network and the enterprise wired LAN. You
configure an Aruba AP to perform the mesh portal role, which uses its wired interface to establish a link to the
wired LAN. You can deploy multiple mesh portals to support redundant mesh paths (mesh links between
neighboring mesh points that establish the best path to the mesh portal) from the wireless mesh network to
the wired LAN.

The mesh portal broadcasts the configured mesh service set identifier (MSSID/mesh cluster name), and
advertises the mesh network service to available mesh points. Neighboring mesh points that have been
provisioned with the same MSSID authenticate to the portal and establish a secure mesh link over which traffic
is forwarded. The authentication process requires secure key negotiation, common to all APs, and the mesh
link is established and secured using Advanced Encryption Standard (AES) encryption. Mesh portals also
propagate channel information, including CSAs.

Mesh Points
The mesh point (MP) is an Aruba AP configured for mesh and assigned the mesh point role. Depending on the
AP model, configuration parameters, and how it was provisioned, the mesh point can perform multiple tasks.
The mesh point provides traditional Aruba WLAN services (such as client connectivity, intrusion detection
system (IDS) capabilities, user role association, LAN-to-LAN bridging, and Quality of Service (QoS) for LAN-to-
mesh communication) to clients and performs mesh backhaul/network connectivity. A mesh radio can be



configured to carry mesh-backhaul traffic only. Additionally, a mesh point can provide LAN-to-LAN Ethernet
bridging by sending tagged/untagged VLAN traffic across a mesh backhaul/network to a mesh portal.

Mesh points use one of their wireless interfaces to carry traffic and reach the managed device. Mesh points are
also aware of potential neighbors, and can form new mesh links if the current mesh link is no longer preferred
or available.

Mesh Clusters
Mesh clusters are similar to an Extended-Service Set (ESS) in a WLAN infrastructure. A mesh cluster is a logical
set of mesh nodes that share the common connection and security parameters required to create mesh links.
Mesh clusters are grouped and defined by a mesh cluster profile, as described in “Mesh Cluster Profile”.

Mesh clusters may enforce predictability in mesh networking by limiting the amount of concurrent mesh
points, hop counts, and bandwidth used in the mesh network. A mesh cluster can have multiple mesh portals
and mesh points that facilitate wireless communication between wired LANs. Mesh portals in a mesh cluster do
not need to be on the same VLAN. Figure 41 shows two mesh clusters and their relationship to the managed
device.

Figure 41 SampleMesh Clusters

Understanding Mesh Links
The mesh link is the data link between a mesh point and its parent. A mesh point uses the parameters defined
in the mesh cluster profile, to establish a mesh link with a neighboring mesh point. The mesh link uses a series
of metrics to establish the best path to the mesh portal.

Throughout the rest of this chapter, the term “uplink” is used to distinguish the active association between a mesh
point and its parent.

The following list describes how mesh links are created:

l Creating the initial mesh link

When creating the initial mesh link, mesh points look for others advertising the same MSSID as the one
contained in its mesh cluster profile. The mesh point scans the channels in its provisioned band of
operation to identify a list of neighbors that match its mesh cluster profile. The mesh point then selects the
from highest priority neighbors based on the least expected path cost.
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If no provisioned mesh cluster profile is available, mesh points use the recovery profile to establish an
uplink. If multiple cluster profiles are configured, mesh points search, in order of priority, their list of
provisioned backup mesh cluster profiles to establish an uplink. If the configured profiles are unavailable
after searching for 5 minutes, the recovery profile is used.

l Moving to a better mesh link

If the existing uplink quality degrades below the configured threshold, and a lower cost or more preferable
uplink is available on the same channel and cluster, the mesh point reselects that link without re-scanning.
In some cases, this invalidates all of the entries that have this mesh point as a next hop to the destination
and triggers new learning of the bridge tables.

l Using a new mesh link if the current mesh link goes down

If an uplink goes down, the affected mesh nodes reestablish a connection with the mesh portal by re-
scanning to choose a new path to the mesh portal. If a mesh portal goes down, and a redundant mesh
portal is available, the affected mesh nodes update their forwarding tables to reflect the path to the new
mesh portal.

Link Metrics
Mesh points use the configured algorithm to compute a metric value, or “path cost,” for each potential uplink
and select the one with the lowest value as the optimal path to the mesh portal. Table 114 describes the
components that make up the metric value: node cost, hop count, link cost and 802.11 capacity.

The link metrics indicate the relative cost of a path to the mesh portal. The best path (lowest metric value) is
used to create the uplink.

Component Description

Node cost Indicates the amount of traffic expected to traverse the mesh node. The more traffic, the
higher the node cost. When establishing a mesh link, nodes with less traffic take
precedence. The node cost is dependent on the number of children a mesh node supports.
It can change as the mesh network topology changes, for example if new children are
added to the network or old children disconnect from the network.

Hop count Indicates the number of hops it takes the mesh node to get to the mesh portal. The mesh
portal advertises a hop count of 0, while all other mesh nodes advertise a cumulative count
based on the parent mesh node.

Link cost Represents the quality of the link to an active neighbor. The higher the Received Signal
Strength Indication (RSSI), the better the path to the neighbor and the mesh portal. If the
RSSI value is below the configured threshold, the link cost is penalized to filter marginal
links. A less direct, higher quality link may be preferred over the marginal link.

The following factors also affect mesh link metrics:

l High-throughput APs add a high cost penalty for links to non-high-throughput APs.

l Multi-stream high-through APs add proportional cost penalties for links to high-
throughput APs that support fewer streams.

Table 114: Mesh Link Metric Computation



Component Description

802.11
capacity

High-throughput APs can send 802.11 information elements (IEs) in their management
frames, allowing high-throughput mesh nodes to identify other mesh nodes with a high-
throughput capacity. High-throughput mesh points prefer to select other 802.11-capable
mesh points in their path to the mesh portal, but can use a legacy path if no high-
throughput path is available.

Path Cost Path cost is calculated by analyzing the other components in this table, and adding the link
cost, the mesh parent's path cost, and the parent's node cost.

Mesh portals typically advertise a path-cost of zero, but high-throughput portals add an
offset penalty if they are connected to a 10/100mbps port that is too slow for the high-
throughput link capacity.

Optimizing Links
You can configure and optimize operation of the link metric algorithm via the mesh radio profile. These
configurable mesh link trigger thresholds can determine when the uplink or mesh path is dropped and another
is chosen, provide enhanced network reliability, and contain flapping links. Although you can modify the
behavior of the link metric algorithm, It is recommended to follow the default values for most deployments.
For information, see Metric algorithm on page 565.

Understanding Mesh Profiles
Mesh profiles help define and bring-up the mesh network. The following sections describe the mesh cluster,
mesh radio, and mesh recovery profiles in more detail.

The complete mesh profile consists of a mesh radio profile, RF management (802.11a and 802.11g) radio
profiles, a high-throughput SSID profile (if your deployment includes 802.11n-capable APs), a mesh cluster
profile, and a read-only recovery profile. The recovery profile is dynamically generated by the Mobility Master;
you do not explicitly configure the recovery profile.

Aruba provides a “default” version of the mesh radio, RF management, high-throughput SSID and cluster
profiles with default values for most parameters. You can use the “default” version of a profile or create a new
instance of a profile which you can then edit as you need. You can change the values of any parameter in a
profile. You have the flexibility of applying the “default” versions of profiles in addition to customizing profiles
that are necessary for the AP or AP group to function.

If you assign a profile to an individual AP, the values in the profile override the profile assigned to the AP group
to which the AP belongs. The exception is the mesh cluster profile: you can apply multiple mesh cluster profiles
to individual APs, as well as to AP groups.

Mesh Cluster Profiles
Mesh clusters are grouped and defined by a mesh cluster profile, which provides the framework of the mesh
network. Similar to virtual AP profiles, the mesh cluster profile contains the MSSID (mesh cluster name),
authentication methods, security credentials, and cluster priority required for mesh nodes to associate with
their neighbors and join the cluster. Associated mesh nodes store this information in flash memory. Although
most mesh deployments require only a single mesh cluster profile, you can configure and apply multiple mesh
cluster profiles to an AP group or an individual AP. If you have multiple cluster profiles, the mesh portal uses
the profile with the highest priority to bring up the mesh network. Mesh points, in contrast, go through the list
of mesh cluster profiles in order of priority to decide which profile to use to associate themselves with the
network. The mesh cluster priority determines the order by which the mesh cluster profiles are used. This
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allows you, rather than the link metric algorithm, to explicitly segment the network by defining multiple cluster
profiles.

Since the mesh cluster profile provides the framework of the mesh network, you must define and configure
the mesh cluster profile before configuring an AP to operate as a mesh node. You can use either the default
cluster profile or create your own. If you find it necessary to define more than one mesh cluster profile, you
must assign priorities to each profile to allow the Mesh AP group to identify the primary and backup mesh
cluster profile(s). The primary mesh cluster profile and each backup mesh cluster profile must be configured to
use the same RF channel. The APs may not provision correctly if they are assigned to a backup mesh cluster
profile with a different RF channel than the primary mesh cluster profile.

If the mesh cluster profile is unavailable, the mesh node can revert to the recovery profile to bring-up the mesh
network until the cluster profile is available. You can also exclude one or more mesh cluster profiles from an
individual access point, this prevents a mesh cluster profile defined at the AP group level from being applied to
a specific AP.

Do not delete or modify mesh cluster profiles once you use them to provision mesh nodes. You can recover
the mesh point if the original cluster profile is still available. It is recommended to create a new mesh cluster
profile if needed. If you modify any mesh cluster setting, you must reprovision your AP for the changes to take
effect (this also causes the AP to automatically reboot). See “Provisioning Mesh Nodes” for more information.

If you configure multiple cluster profiles with different cluster priorities, you manually override the link metric
algorithm because the priority takes precedence over the path cost. In this scenario, the mesh portal uses the
profile with the highest priority to bring-up the mesh network. The mesh portal stores and advertises that one
profile to neighboring mesh nodes to build the mesh network. This profile is known as the “primary” cluster
profile. Mesh points, in contrast, go through the list of configured mesh cluster profiles in order of priority to
find the profile being advertised by the mesh portal. Once the primary profile has been identified, the other
profiles are considered “backup” cluster profiles. Use this deployment if you want to enforce a particular mesh
topology rather than allowing the link metric algorithm to determine the topology.

For this scenario, do the following:

l Configure multiple mesh cluster profiles with different priorities. The primary cluster profile has a lower
priority number, which gives it a higher priority.

l Configure the mesh radio profile.

l Create an AP group for 802.11a radios and 802.11g radios

l Configure the 802.11a or 802.11g RF management profiles for each AP group.

l If your deployment includes high-throughput APs, configure the mesh high-throughput SSID profile. The
mesh radio profile uses the default high-throughput SSID profile unless you specifically configure the mesh
radio profile to use a different high-throughput SSID profile

l Create an AP group for each 802.11a channel.

If a mesh link breaks or the primary cluster profile is unavailable, mesh nodes use the highest priority backup
cluster profile to re-establish the uplink or check for parents in the backup profiles. If these profiles are
unavailable, the mesh node can revert to the recovery profile to bring up the mesh network until a cluster
profile is available. For information about the procedure to configure a mesh cluster profile, see Configuring
Mesh Cluster Profiles on page 559

Mesh Radio Profiles
The mesh radio profile allows you to specify the set of rates used to transmit data on the mesh link. This profile
also allows you to define a reselection-mode setting to optimize the operation of the link metric algorithm.
The reselection mode specifies the method a mesh node uses to find a better uplink to create a path to the
mesh portal. Only neighbors on the same channel in the same mesh cluster are considered.

The mesh radio profile includes the following reselection mode options:



l reselect- anytime: mesh points using the reselect-anytime reselection mode perform a single topology
readjustment scan within 9 minutes of startup and 4 minutes after a link is formed. If no better parent is
found, the mesh point returns to its original parent. This initial scan evaluates more distant mesh points
before closer mesh points, and incurs a dropout of 5–8 seconds for each mesh point. After the initial
startup scan is completed, connected mesh nodes evaluate mesh links every 30 seconds. If a mesh node
finds a better uplink, the mesh node connects to the new parent to create an improved path to the mesh
portal.

l reselect-never: connected mesh nodes do not evaluate other mesh links to create an improved path to
the mesh portal.

l startup-subthreshold: mesh points using the startup-subthreshold reselection mode perform a single
topology readjustment scan within 9 minutes of startup and 4 minutes after a link is formed. If no better
parent is found, the mesh point returns to its original parent. This initial startup scan evaluates more distant
mesh points before closer mesh points, and incurs a dropout of 5–8 seconds for each mesh point. After
that time, each mesh node evaluates alternative links if the existing uplink falls below the configured
threshold level (the link becomes a sub-threshold link). It is recommended to use this default startup-
subthreshold value.

l subthreshold-only: connected mesh nodes evaluate alternative links only if the existing uplink becomes a
sub-threshold link.

If a mesh point using the startup-subthreshold or subthreshold-only mode reselects a more distant parent
because its original, closer parent falls below the acceptable threshold, then as long as that mesh point is
connected to that more distant parent, it seeks to reselect a parent at the earlier, shorter distance (or less) with
good link quality. For example, if a mesh point disconnects from a mesh parent 2 hops away and subsequently
reconnects to a mesh parent 3 hops away, then the mesh point continues to seek a connection to a mesh
parent with both an acceptable link quality and a distance of two hops or less, even if the more distant parent
also has an acceptable link quality.

For information about the procedure to configure mesh radio profiles, see Creating and Editing Mesh Radio
Profiles on page 562.

RF Management (802.11a and 802.11g) Profiles
The two 802.11a and 802.11g RF management profiles for an AP configure its 802.11a (5 Ghz) and 802.11b/g
(2.4 GHz) radio settings. Use these profile settings to determine the channel, beacon period, transmit power,
and ARM profile for a mesh AP’s 5 GHz and 2.4 Ghz frequency bands. You can either use the “default” version
of each profile, or create a new 802.11a or 802.11g profile which you can then configure as necessary. Each RF
management profile also has a radio-enable parameter that allows you to enable or disable the AP’s ability to
simultaneously carry WLAN client traffic and mesh-backhaul traffic on that radio. This value is enabled by
default. For information about configuring RF Management Radio profiles, see 2.4 Ghz and 5 Ghz Radio RF
Management on page 523.

If you do not want the mesh radios carrying mesh-backhaul traffic to support client traffic, consider using a dedicated
802.11a/80211/g radio profile with the mesh radio disabled. In this scenario, the radio carries mesh backhaul traffic
but does not support client Virtual APs.

Mesh nodes operating in different cluster profiles can share the same radio profile. Conversely, mesh portals
using the same cluster profile can be assigned different RF Management Radio profiles to achieve frequency
separation (for more information, see “Deployments with Multiple Mesh Cluster Profiles”).

High-Throughput Radio Profiles
Each 802.11a and 802.11g radio profile also references a high-throughput profile that manages an AP or AP
group’s 40Mhz tolerance settings. For information about referencing a high-throughput profile, see Managing
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High Throughput Radio Settings on page 526.

Mesh High-Throughput SSID Profiles
High-throughput APs support additional settings not available in legacy APs. A mesh high-throughput SSID
profile can enable or disable high-throughput (802.11n) features and 40 MHz channel usage, and define values
for aggregated MAC protocol data units (MDPUs), and Modulation and Coding Scheme (MCS) ranges.

Aruba provides a “default” version of the mesh high-throughput SSID profile. You can use the “default” version
or create a new instance of a profile which you can then edit as you need. High-throughput mesh nodes
operating in different cluster profiles can share the same high-throughput SSID radio profile. For information
about configuring mesh high-throughput SSID profiles, see Creating and Editing Mesh High-Throughput SSID
Profiles .

Wired AP Profiles
The wired AP profile controls the configuration of the Ethernet port(s) on your AP. You can use the wired AP
profile to configure Ethernet ports for bridging or secure jack operation using the wired AP profile. For details,
see Configuring Ethernet Ports for Mesh on page 573

Mesh Recovery Profiles
In addition to the “default” and user-defined mesh cluster profiles, mesh nodes also have a recovery profile.
The Mobility Masterdynamically generates a recovery profile, and each mesh node provisioned by the same
Mobility Masterhas the same recovery profile. The recovery profile is based on a pre-shared key (PSK), and
mesh nodes use the recovery profile to establish a link to the managed device if the mesh link is broken and no
other mesh cluster profiles are available.

The mesh portal advertises the provisioned cluster profile. If a mesh point is unaware of the active mesh
cluster profile, but is aware of and has the same recovery profile as the mesh portal, the mesh point can use
the recovery profile to connect to the mesh portal.

The mesh point must have the same recovery profile as the parent to which it connects. If you provision the mesh
points with the same Mobility Master, the recovery profiles should match.

To verify that the recovery profile names match, use the following command:
show ap mesh debug provisioned-clusters {ap-name <name> | bssid <bssid> | ip-addr <ipaddr>}.

To view the recovery profile on the managed device, use the following command:
show running-config | include recovery.

If a mesh point connects to a parent using the recovery profile, it may immediately exit recovery if the parent is
actively using one of its provisioned mesh cluster profiles. Once in recovery, a mesh point periodically exits
recovery to see if it can connect using an available provisioned mesh cluster profile. The recovery profile is
read-only; it cannot be modified or deleted.

The recovery profile is stored in the Mobility Master’s configuration file and is unique to that Mobility Master. If
necessary, you can transfer your configuration to another managed device. If you do so, make sure your new
mesh cluster is running and you have re-provisioned the mesh nodes before deleting your previous
configuration. The APs learn the new recovery profile after they are provisioned with the new managed device.
This is also true if you provision a mesh node with one Mobility Master and use it with a different Mobility
Master. In this case, the recovery profile does not work on the mesh node until you re-provision it with the new
Mobility Master.



Understanding Remote Mesh Portals (RMPs)
You can deploy mesh portals to create a hybrid mesh/remote AP environment to extend network coverage to
remote locations; this feature is called remote mesh portal, or RMP. The RMP feature integrates the functions
of a remote AP (RAP) and the Mesh portal. As a RAP, it sets up a VPN tunnel back to the corporate switch that
secures control traffic between the RAP and the switch.

The Remote Mesh Portal feature allows you to configure a remote AP at a branch office to operate as a mesh
portal for a mesh cluster. Other mesh points belonging to that cluster get their IP address and configuration
settings from the main office via an IPsec tunnel between the remote mesh portal and the Mobility Master.
This feature is useful for deploying an all-wireless branch office or creating a complete wireless network in
locations where there is no wired infrastructure in place.

When the client at the branch office associates to a virtual AP in split-tunnel forwarding mode, the client’s
DHCP requests are forwarded over a GRE tunnel (split tunnel) to the corporate network. This communication is
done over a secure VPN tunnel. The IPs are assigned from the corporate pool based on the VLAN tag
information, which helps to determine the corresponding VLAN. The VLAN tag also determines the subnet
from which the DHCP address has assigned.

A mesh point sends the DHCP request with the mesh private VLAN (MPV) parameter. The mesh point learns
the MPV value from the response during the mesh association. When the split tunnel is setup for the RMP on
the Mobility Master, the VLAN of the tunnel should be the MPV.A DHCP pool for the MPV should be setup on
the switch. The use of MPV makes it easy for the RMP to decide which requests to forward over the split
tunnel. All requests tagged with the MPV are sent over the split tunnel. Hence the MPV should be different
from any user VLAN that is bridged using the mesh network.

The RMP configuration requires an AP license. For complete information on the licenses, refer to the Aruba Mobility
Master Licensing Guide.

Figure 42 Working of RMP

By default, the data frames the mesh portal receives on its mesh link are forwarded according to the bridge
table entries on the portal. However, frames received on mesh private VLAN (MPV) are treated differently by
the remote mesh portal. These frames are treated the same as frames received on a split SSID and are routed
rather than bridged. Mesh points obtain DHCP addresses from the corporate network, then register with the
managed device using these IP addresses. When these mesh points send and receive PAPI control traffic from
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the Mobility Master, it controls these mesh points just as if they were on a local VLAN. PAPI traffic containing
keys and other secret information receives IPsec encryption and decryption when it is forwarded to the
managed device through the VPN tunnel.

Not all traffic from a mesh point is sent on the mesh private VLAN. When a mesh point bridges data received
via its Ethernet interface or from clients connected to an access radio VAP, the mesh point does not tag the
frame with the mesh private VLAN tag when it sends the data through mesh link to the remote mesh portal.
Note that the mesh point may still tag the frame depending on the VLAN of the virtual AP and the native VLAN
specified in the system profile. Care must be taken to assign the MPV value so that it does not clash with any
local tags assigned in the mesh network. In this scenario, the portal performs the default operation and bridges
the frame based on its bridge table. Traffic destined to the Internet is recognized as such by the remote mesh
portal based on ACL rules. This traffic is NATed on the remote mesh portal’s Ethernet interface.

For information on the procedure to configure remote mesh portals, see Configuring Remote Mesh Portals
(RMPs) on page 579

Understanding the AP Boot Sequence
The section describes the boot sequence for mesh APs in detail. Depending on its configured role, the AP
performs a slightly different boot sequence.

Booting the Mesh Portal
When the mesh portal boots, it recognizes that one radio is configured to operate as a mesh portal. It then
obtains an IP address from a DHCP server on its Ethernet interface, discovers the Mobility Master on that
interface, registers the mesh radio with the managed device, and obtains regulatory domain and mesh radio
profiles for each mesh point interface. A mesh virtual AP is created on the mesh portal radio interface, the
regulatory domain and radio profiles are used to bring up the radio on the correct channel, and the provisioned
mesh cluster profile is used to setup the mesh virtual AP with the correct announcements on beacons and
probe responses. On the non-mesh radio provisioned for access mode, that radio is a thin AP and everything
on that interface works as a thin AP radio interface.

If the 802.11a/802.11g radio profile assigned to the mesh radio is enabled, the radio supports both mesh
backhaul and client access Virtual APs. If the mesh radio is to be used exclusively for mesh backhaul traffic,
associate that radio to a dedicated 802.11a/802.11g radio profile with the radio disabled so the mesh radios
carry backhaul traffic only.

Booting the Mesh Point
When the mesh point boots, it scans for neighboring mesh nodes to establish a link to the mesh portal. All of
the mesh nodes that establish the link are in the same mesh cluster. After the link is up, the mesh point uses
the DHCP to obtain an IP address and uses the same Mobility Master as their parent. The remaining boot
sequence, if applicable, is similar to that of a thin AP. Remember, the priority of the mesh point is establishing a
link with neighboring mesh nodes, not establishing a control link to a managed device.

In a single hop environment, the mesh point establishes a direct link with the mesh portal.

Air Monitoring and Mesh
Each mesh node has an air monitor (AM) process that registers the BSSID and the MAC address of the mesh
node to distinguish it from a thin AP. This allows the WLAN management system (WMS) on the managed node



and AMs deployed in your network to distinguish between APs, wireless clients, and mesh nodes. The WMS
tables also identify the mesh nodes.

For all thin APs and mesh nodes, the AM identifies a mesh node from other packets monitored on the air, and
the AM does not trigger wireless-bridging events for packets transmitted between mesh nodes.

Mesh Deployment Solutions
You can configure the following single-hop and multi-hop solutions:

l Thin AP services with wireless backhaul deployment

l Point-to-point deployment

l Point-to-multipoint deployment

l High-availability deployment

With a thin AP wireless backhaul deployment, mesh provides services and security to remote wireless clients
and sends all control and user traffic to the Mobility Master over a wireless backhaul mesh link.

The remaining deployments allow you to extend your existing wired network by providing a wireless bridge to
connect Ethernet LAN segments. You can use these deployments to bridge Ethernet LANs between floors,
office buildings, campuses, factories, warehouses, and other environments where you do not have access to
physical ports, or cable to extend the wired network. In these scenarios, a wireless backhaul carries traffic
between the Aruba APs configured as the mesh portal and the mesh point, to the Ethernet LAN.

Thin AP Services with Wireless Backhaul Deployment
To expand your wireless coverage without bridging Ethernet LAN segments, you can use thin AP services with a
wireless backhaul. In this scenario, the mesh point provides network access for wireless clients and establishes
a mesh path to the mesh portal, which uses its wired interface to connect to the managed device. Use the
802.11g radio for WLAN and managed device services and the 802.11a radio for mesh services. Figure 43
shows the wireless backhaul between the mesh portal to the mesh point that services the wireless clients.

Figure 43 SampleWireless Backhaul Deployment

Point-to-Point Deployment
In this point-to-point scenario, two Ethernet LAN segments are bridged via a wireless connection that carries
both client services traffic and mesh-backhaul traffic between the mesh portal and the mesh point. This
provides communication from one LAN to another. Figure 44 shows a single-hop point-to-point deployment.
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Figure 44 Sample Point-to-Point Deployment

Point-to-Multipoint Deployment
In a point-to-multipoint scenario, multiple Ethernet LAN segments are bridged via multiple wireless/mesh
backhauls that carry traffic between the mesh portal and the mesh points. This provides communication from
the local LAN to multiple remote LANs. Figure 45 shows a single-hop point-to-multipoint deployment.

Figure 45 Sample Point-to-Multipoint Deployment

High-Availability Deployment
In this high-availability scenario, multiple Ethernet LAN segments are bridged via multiple wireless backhauls
that carry traffic between the mesh portal and the mesh points. You configure one mesh portal for each
remote LAN that you are bridging with the host LAN. This provides communication from the host LAN to
multiple remote LANs. In the event of a link failure between a mesh point and its mesh portal, the affected
mesh point could create a link to the other mesh portal. Figure 46 shows a sample single-hop high-availability
deployment. The dashed lines represent the current mesh link between the mesh points and their mesh
portals. The diagonal dotted lines represent possible links that could be formed in the event of a mesh link or
mesh portal failure.



Figure 46 Sample High-Availability Deployment

Mesh Deployment Planning
Following considerations are recommended when planning and deploying a mesh solution:

Pre-Deployment Considerations
l Stage the APs before deployment. Identify the location of the APs, configure them for mesh, provision

them, and verify connectivity before physically deploying the mesh APs in a live network.

l Ensure the Mobility Master has Layer-2/3 network connectivity to the network segment where you plan to
install the mesh portal.

l Keep the AP packaging materials and reuse them to send the APs to the installation location.

l Verify the layout of the physical location to determine the appropriate configuration and placement of the
APs. Use this information to avoid problems that would necessitate a physical recovery.

l Label the AP before sending it to the physical location for installation.

Outdoor-Specific Deployment Considerations
l Provision the AP with the latitude and longitude coordinates of the installation location. This allows you to

more easily identify the AP for inventory and troubleshooting purposes.

l Identify a “radio line of sight” between the antennas for optimum performance. The radio line of sight
involves the area along a link through which the bulk of the radio signal power travels.

l Identify the minimum antenna height required to ensure a reliable mesh link.

l Scan your proposed site to avoid radio interference caused by other radio transmissions using the same or
an adjacent frequency.

l Consider extreme weather conditions known to affect your location, including: temperature, wind velocity,
lightning, rain, snow, and ice.

l Allow for seasonal variations, such as growth of foliage.

For more detailed outdoor deployment information, refer to the installation guide that came with your
outdoor AP.
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Configuration Considerations
l On dual-radio APs, you can configure only one of the radio for mesh. If you want a dual-radio AP to carry

mesh backhaul traffic and client services traffic on separate radios, it is recommended to use 802.11a
radios for mesh-backhaul traffic and 802.11g radios for traditional WLAN access.

l If you configure more than one mesh node in the same VLAN, prevent network loops by enabling STP on
the Layer-2 switch used to connect the mesh nodes.

l Mesh nodes learn a maximum of 1,024 source MAC addresses; this cannot be changed.

l Place all APs for a specific mesh cluster in the same AP group.

l Create and keep separate mesh cluster profiles for specific mesh clusters. Do not overwrite or delete the
cluster profiles.

l Enable bridging on mesh point Ethernet ports when deploying LAN bridging solutions.

l APs configured as mesh points support secure jack operation on Enet0. APs with multiple Ethernet ports
configured as mesh portals support secure jack operation on Enet1. If an AP with multiple Ethernet ports is
configured as a mesh point, it supports secure jack operation on Enet1 and Enet0.

l Mesh networks forward tagged/untagged VLAN traffic, but do not tag traffic. The allowed VLANS are
controlled by the wired ap profile.

l Mesh APs provisioned on different managed device can interoperate if those APs are configured with the
same country code, cluster name and cluster key. However, the mesh recovery profile created on one
managed device is not able to recover settings for mesh APs provisioned on another managed device unless
the recovery profile is on Mobility Master and the other mesh nodes were provisioned by a managed device
connected to that master.

Post-Deployment Considerations
l Do not connect mesh point Ethernet ports in such a way that causes a network loop.

l Have a trained professional install the AP. After installation, check to ensure the AP receives power and
boots up, enabling RSSI outputs.

Although the AP is up and operational, it is not connected to the network.

l Align the AP antenna for optimal RSSI.

l Do not delete or modify mesh cluster profiles once you use them to provision mesh nodes. You can recover
the mesh point if the original cluster profile is still available. It is recommended to create a new mesh cluster
profile if needed.

l If you create a new mesh cluster profile for an existing deployment, you must re-provision the AP for the
new profile to take effect. If you re-provision mesh nodes that are already operating, re-provision the most
distant (highest hop count) mesh points first, followed by the mesh portals. If you re-provision the mesh
portal first, the mesh points may be unable to form a mesh link. Note that re-provisioning the AP causes it
to automatically reboot, which may cause a disruption of service to the network.

Dual-Port AP Considerations
A dual-port AP has two 10/100 Mbps Ethernet ports (Enet0 and Enet1, respectively). When using these APs in a
mesh environment, note the following Ethernet port requirements:

l If configured as a mesh portal:

n Connect Enet0 to the managed device to obtain an IP address. The wired AP profile controls Enet1.

n Only Enet1 supports secure jack operation.

l If configured as a mesh point, Enet0 and Enet1 can be configured using separate wired-port-profiles



Configuring Mesh Cluster Profiles
The mesh cluster configuration gets pushed from the controller to the mesh portal and the other mesh points,
which allows them to inherit the characteristics of the mesh cluster of which they are a member. Mesh nodes
are grouped according to a mesh cluster profile that contains the MSSID, authentication methods, security
credentials, and cluster priority. Cluster profiles (including the default cluster profile) are not applied until you
provision your APs for mesh. For more information on mesh cluster profiles, see Mesh Cluster Profiles on page
549

Managing Mesh Cluster Profiles in the WebUI
Use the following procedures to define and manage mesh cluster profiles using the WebUI.

Creating a Profile
1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile

window.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Cluster profile and select Add profile
.

3. Enter a name for the new profile

4. Configure the mesh cluster settings described in Table 115, then click Save.

Parameter Description

Profile Name Name of the mesh cluster profile. The name must be 1–63 characters.

Default: Mesh cluster profile named “default.”

Cluster Name Indicates the mesh cluster name. The name can have a maximum of 32 characters, and
is used as the MSSID for the mesh cluster. When you first create a new mesh cluster
profile, the profile uses the default cluster name “Aruba-mesh”. Use the Cluster Name
parameter to define a new, unique MSSID before you assign APs or AP groups to the
mesh cluster profile.

NOTE: If you want a mesh cluster to use WPA2-PSK-AES encryption, do not use spaces in
the mesh cluster name, as this may cause errors in mesh points associated with that
mesh cluster.

To view existing mesh cluster profiles, use the CLI command: show ap mesh-cluster-
profile.

A mesh portal chooses the best cluster profile and provisions it for use. A mesh point can
have a maximum of 16 cluster profiles.

Default: Mesh cluster named “Aruba-mesh.”

RF Band Indicates the band for mesh operation for multiband radios. Select a or g.

Important: If you create more than one mesh cluster profile for an AP or AP group, each
mesh cluster profile must use the same band.

Table 115: Mesh Cluster Profile Configuration Parameters
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Parameter Description

WPA Hexkey Configures a WPA pre-shared key. This key must be 64 hexadecimal characters

WPA
Passphrase

Sets the WPA password that generates the PSK. The passphrase must be between 8–63
characters, inclusive.

Encryption Configures the data encryption, which can be either opensystem (no authentication or
encryption) or wpa2-psk-aes (WPA2 with AES encryption using a preshared key). It is
recommended to select wpa2-psk-aes and using the wpa-passphrase parameter to
select a passphrase.

Default: opensystem.

Associating a Mesh Cluster Profile to Mesh APs
Use the following procedure to associate a mesh cluster profile to a group of mesh APs or an individual mesh
AP using the WebUI. If you configure multiple cluster profiles with different cluster priorities, you manually
override the link metric algorithm because the priority takes precedence over the path cost. In this scenario,
the mesh portal uses the profile with the highest priority to bring-up the mesh network.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the AP tab in the All Profiles menu, and select the AP.

3. Under the Profiles list, expand the Mesh menu, then select Mesh Cluster profile.

4. In the Profile Details window pane, click the Mesh Cluster profile drop-down list select New.

l To add an existing mesh cluster profile to the selected AP group, click the Add a profile drop-down list
and select a new profile name from the list.

l To create a new mesh cluster profile to the selected AP group, click the Add a profile drop-down list and
select NEW. Enter a name for the new mesh cluster profile.

5. Click the using priority drop-down list to select a priority for the mesh cluster profile. The lower the
number, the higher the priority.

6. Click Save. The profile name appears in the mesh cluster profile list with your configured settings. If you
configure this for the AP group, this profile also becomes the mesh cluster profile used by the mesh portal
for your mesh network.

Editing a Mesh Cluster Profile
If you modify any mesh cluster profile setting, you must reprovision your AP. For example, if you change the
priority of a cluster profile from 5 to 2, you must reprovision the AP before you can assign priority 5 to another
cluster profile. Reprovisioning the AP causes it to automatically reboot. For more information, see Provisioning
Mesh Nodes.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Cluster profile and select the profile
you want to edit.

3. Change the mesh cluster settings as desired. Table 115 describes the parameters you can configure for new
and existing mesh clusters.



A mesh cluster profile configured with wpa2-psk-aes encryption must have a defined WPA hexkey or a WPA
passphrase (or both). If you have configured one encryption type but not the other, and want switch from a hexkey to
a passphrase or vice versa, you must add the new encryption type, click Save, then remove the encryption type you
no longer want and click Save again. You cannot delete one encryption type and add a different type in a single step.

4. Click Save to save your changes.

Deleting a Mesh Cluster Profile
You can delete a mesh cluster profile only if no APs or AP groups are associated with that profile.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Cluster profile.

3. Click the Delete icon next to the name of the profile you want to delete.

Managing Mesh Cluster Profiles in the CLI
You must be in config mode to create, modify or delete a mesh cluster profile using the CLI. Specify an existing
mesh cluster profile with the <profile-name> parameter to modify an existing profile, or enter a new name to
create an entirely new profile.

Configuration details and any default values for each of these parameters are described in Table 115. If you do
not specify a parameter for a new profile, that profile uses the default value for that parameter.

Use the no option before any parameter to remove the current value for that parameter and return it to its
default setting. Enter exit to leave the mesh cluster profile mode.
(host)[node] (config) #ap mesh-cluster-profile <profile>

clone <profile>

cluster <name>

no ...

opmode [opensystem | wpa2-psk-aes]

rf-band {a | g}

wpa-hexkey <wpa-hexkey>

wpa-passphrase <wpa-passphrase>

The following examples create and configure the mesh cluster profiles cluster1 and cluster2.
(host)[node] (config) #ap mesh-cluster-profile cluster1

cluster corporate

opmode wpa2-psk-aes

wpa-passphrase mesh_123

rf-band a

(host)[node] (config) #ap mesh-cluster-profile cluster2

cluster corporate

opmode wpa2-psk-aes

wpa-passphrase mesh_123

rf-band a

You can also create a new mesh radio profile by copying the settings of an existing profile using the clone
parameter. Using the clone command to create a new profile makes it easier to keep constant attributes in
common within multiple profiles.
(host)[node] (config) #ap mesh-cluster-profile <profile-name> clone

<source-profile-name>

Viewing Mesh Cluster Profile Settings
To view a complete list of mesh cluster profiles and their status:
(host)[node] (config) #show ap mesh-cluster-profile
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To view the settings of a specific mesh cluster profile:
(host)[node] (config) #show ap mesh-cluster-profile <profile-name>

Associating Mesh Cluster Profiles
The following commands associate a mesh cluster profile to an AP group or an individual AP. For deployments
with multiple mesh clusters, you must also configure the profile’s priority. Remember, the lower the priority
number, the high the priority. The mesh cluster priority determines the order by which the mesh cluster
profiles are used. This allows you, rather than the link metric algorithm, to control the network topology by
defining the cluster profiles to use if one becomes unavailable.

To associate a mesh cluster profile to an AP group in a single-cluster deployment:
(host)[node](config) #ap-group <group> mesh-cluster-profile <profile-

name>

To associate a mesh cluster profile to an individual AP in a single-cluster deployment:
(host)[node](config) #ap-name <name> mesh-cluster-profile <profile-name>

To associate a mesh cluster profile to an AP group in a multiple-cluster deployment:
(host)[node] (config) #ap-group <group> mesh-cluster-profile <profile-

name> priority <priority>

To associate a mesh cluster profile to an individual AP in a multiple-cluster deployment, use the command
(host)[node] (config) #ap-name <name> 

mesh-cluster-profile <profile-name> priority <priority>

Example:
(host)[node] (config) #ap-group group1

mesh-cluster-profile cluster1 priority 5

mesh-cluster-profile cluster2 priority 10

(host)[node] (config) #ap-group2

mesh-cluster-profile cluster1 priority 10

mesh-cluster-profile cluster2 priority 5

mesh-radio-profile channel2

Excluding a Mesh Cluster Profile from a Mesh Node
To exclude a specific mesh cluster profile from an AP:
(host)[node] (config) #ap-name <name> exclude-mesh-cluster-profile-ap

<profile-name>

Deleting a Mesh Cluster Profile
If no APs are using a mesh cluster profile, you can delete that profile using the no parameter:
(host)[node] (config) #no ap mesh-cluster-profile <profile-name>

Creating and Editing Mesh Radio Profiles
The mesh radio profile determines many of the settings used by mesh nodes to establish mesh links and the
path to the mesh portal, including the maximum number of children a mesh node can accept, and transmit
rates for the 802.11a and 802.11g radios. The attributes of the mesh radio profile are applied to a mesh point
upon receiving its configuration from the managed node. You can configure multiple radio profiles; however,
you select and deploy only one radio profile per AP group. Radio profiles, including the “default” profile, are not
active until you provision your APs for mesh.

If you modify a currently provisioned and running radio profile, your changes take effect immediately. You do
not need to reboot the managed device or the AP to apply the changes.



Managing Mesh Radio Profiles in the WebUI
Use the following procedures to define and manage mesh radio profiles using the WebUI.

Creating or Editing a Mesh Radio Profile
To create or edit an existing mesh radio profile, refer to the following steps.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Radio profile.

3. The procedure to create a new mesh profile varies slightly from the procedure to edit an existing profile.

l To create a new mesh profile: select Add Profile. Enter a new mesh radio profile name in the field to the
right of the drop-down list.

l To edit an existing mesh profile: select the profile that you want to edit from the All Profiles pane.

4. Configure your desired mesh radio settings.

Mesh Radio profile configuration settings are divided into two tabs, General and Advanced. The General
tab displays only those configuration settings that often need to be adjusted to suit a specific network. The
Advanced tab shows all configuration settings, including settings that do not need frequent adjustment or
should be kept at their default values. If you change a setting on one tab, then click and display the other
tab without saving your configuration, that setting reverts to its previous value. The basic and advanced
profile settings are described in Table 116.

Parameter Description

Basic Mesh Radio Settings

Link
Threshold

Use this setting to optimize operation of the link metric algorithm.

Indicates the minimal RSSI value. If the RSSI value is below this threshold, the link may be
considered a sub-threshold link. A sub-threshold link is one whose average RSSI value
falls below the configured link threshold.

If this occurs, the mesh node may try to find a better link on the same channel and
cluster (only neighbors on the same channel are considered).

Default: 12. The supported threshold is hardware dependent, with a practical range of
10–90.

Advanced Mesh Radio Settings

802.11a
Transmit
Rates

Indicates the transmit rates for the 802.11a radio.

The AP attempts to use the highest transmission rate to establish a mesh link. If a rate is
unavailable, the AP goes through the list and uses the next highest rate.

To modify transmit rates, do one of the following:

l In the WebUI, deselect (uncheck) a specific rate box to use fewer rates when
establishing a mesh link.

l In the CLI, enter the specific rates to use.

Default: All transmission rates are selected and used. If you do not select 802.11a or
802.11g transmit rates, all rates are selected by default when you click Save.

Table 116: Mesh Radio Profile Configuration Parameters
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Parameter Description

802.11g
Transmit
Rates

Indicates the transmit rates for the 802.11g radio.

The AP attempts to use the highest transmission rate to establish a mesh link. If a rate is
unavailable, the AP goes through the list and uses the next highest rate.

To modify transmit rates, do one of the following:

l In the WebUI, deselect (uncheck) a specific rate box to use fewer rates when
establishing a mesh link.

l In the CLI, enter the specific rates to use.

Default: All transmission rates are selected and used. If you do not select 802.11a or
802.11g transmit rates, all rates are selected by default when you click Save.

Allowed
VLANs on
Mesh Link

List the VLAN ID numbers of VLANs allowed on the mesh link.

BC/MC Rate
Optimization

Broadcast/Multicast Rate Optimization dynamically selects the rate for sending
broadcast/multicast frames on any BSS. This feature determines the optimal rate for
sending broadcast and multicast frames based on the lowest of the unicast rates across
all associated clients.

When you enable the Multicast Rate Optimization feature, the managed node scans the
list of all associated stations in that BSS and finds the lowest transmission rate as
indicated by the rate adaptation state for each station. If there are no associated stations
in the BSS, it selects the lowest configured rate as the transmission rate for broadcast
and multicast frames.

This feature is enabled by default. Multicast Rate Optimization applies to broadcast and
multicast frames only. 802.11 management frames are not affected by this feature and
are transmitted at the lowest configured rate. When enabled, this setting dynamically
adjusts the multicast rate to that of the slowest connected mesh child. Multicast frames
are not sent if there are no mesh children.

NOTE: This feature should only be enabled on a BSS where all associated stations are
sending or receiving unicast data. If there is no unicast data to or from a particular
station, then the rate adaptation state may not accurately reflect the current sustainable
transmission rate for that station. This could result in a higher packet error rate for
broadcast/multicast packets at that station. Configuring the Video Multicast Rate
Optimization parameter overrides the configuration of BC/MC Rate Optimization
parameter for VI-tagged multicast traffic. Multicast traffic that is not VI-tagged behaves
the same with BC/MC as before. If multicast rate is not set, all traffic behaves the same.

Default: Enabled.

Heartbeat
threshold

Indicates the maximum number of heartbeat messages that can be lost between
neighboring mesh nodes.

Default: 10 missed heartbeats.

Range: 1–255.

Maximum
Children

Indicates the maximum number of children a mesh node can accept.

Default: 64 children.

Range: 1–64



Parameter Description

Maximum
Hop Count

Indicates the maximum hop count from the mesh portal.

Default: 8 hops.

Range: 1–32

Mesh Private
VLAN

A VLAN ID for control traffic between an remote mesh portal and mesh nodes. This VLAN
ID must not be used for user traffic.

Range: 0–4094. Default: 0 (disabled).

For further information on configuring a remote mesh portal, see Configuring Remote
Mesh Portals (RMPs) on page 579

Metric
algorithm

This parameter specifies the algorithm used by a mesh node to select its parent. Use
this setting to optimize operation of the link metric algorithm.

Available options are:

l best-link-rssi: Selects the parent with the strongest RSSI, regardless of the number of
children a potential parent has.

l distributed-tree-rssi: selects the parent based on link-RSSI and node cost based on
the number of children. This option evenly distributes the mesh points over high
quality uplinks. Low quality uplinks are selected as a last resort.

Default: distributed-tree-rssi. It is recommended to use the default value.

Rate
Optimization
for delivering
EAPOL frames
and mesh
echoes

When you enable this parameter, EAPOL frames, mesh echo requests and echo
responses are sent at a lower rate.
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Parameter Description

Reselection
mode

Use this setting to optimize operation of the link metric algorithm.

Available options are:

l reselect-anytime

l reselect-never

l startup-subthreshold

l subthreshold-only

For complete information on reselection mode options, see Mesh Radio Profiles on page
550

Retry Limit Indicates the number of times a mesh node can re-send a packet.

Default: 4 times.

Range: 1–15

RTS Threshold Defines the packet size sent by mesh nodes. Mesh nodes transmitting frames larger
than this threshold must issue request to send (RTS) and wait for other mesh nodes to
respond with clear to send (CTS) to begin transmission. This helps prevent mid-air
collisions.

Default: 2,333 bytes.

Range: 256– 2,346.

5. Click Save. The profile name appears in the Mesh Radio Profile list with your configured settings.

If you configure this for the AP group, this profile also becomes the selected radio profile used by the mesh
portal for your mesh network.

Assigning a Mesh Radio Profile to a Mesh AP or AP Group
To associate a mesh radio profile to a mesh AP or AP group, refer to the following steps.

1. In the Managed Network node hierarchy, navigate to the Configuration > Systemand open the
Profilewindow.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Radio profile.

3. Select the desired mesh radio profile from the list.

4. Open the Mesh High-throughput SSID configuration for the radio profile and select an SSID profile from
the Mesh High-throughput SSID profile drop-down list.

5. Click Save. The profile name appears in the Mesh Radio Profile list with your configured settings. If you
configure this for the AP group, this profile also becomes the selected radio profile used by the mesh portal
for your mesh network.

6. Click the Delete button by the name of the profile you want to delete.

Managing Mesh Radio Profiles in the CLI
You must be in config mode to create, modify, or delete a mesh radio profile using the CLI. Specify an existing
mesh profile with the <profile-name> parameter to modify an existing profile, or enter a new name to create
an entirely new profile.



Creating or Modifying a Mesh Radio Profile
Configuration details and any default values for each of these parameters are described in Table 116. If you do
not specify a parameter for a new profile, that profile uses the default value for that parameter. Put the no
option before any parameter to remove the current value for that parameter and return it to its default
setting. Enter exit to leave the mesh radio profile mode.
(host)[node] (config) #ap mesh-radio-profile <profile-name>

a-tx-rates

allowed-vlans

children <children>

clone <source-profile-name>

eapol-rate-opt

g-tx-rates [1|2|5|6|9|11|12|18|24|36|48|54]

heartbeat-threshold <count>

hop-count <hop-count>

link-threshold <count>

max-retries <max-retries>

mesh-ht-ssid-profile

mesh-mcast-opt

mesh-survivability

metric-algorithm {best-link-rssi|distributed-tree-rssi}

mpv <vlan-id>

no

reselection-mode

rts-threshold <rts-threshold>

You can also create a new mesh radio profile by copying the settings of an existing profile using the clone
parameter. Using the clone command to create a new profile makes it easier to keep constant attributes in
common within multiple profiles.
(host)[node] (config) #ap mesh-radio-profile <profile-name> clone <source-profile-name>

Assigning a Mesh Radio Profile to a Mesh AP or AP Group
To associate a mesh radio profile with an AP group, use the following commands. When you add the mesh
cluster profile to the AP group, you must also define the cluster priority.
(host)[node] (config) #ap-group <group>

mesh-radio-profile <profile-name> priority <priority>

To associate a mesh radio profile with an individual AP:
(host)[node](config) #ap-name <name>

mesh-radio-profile <profile-name> priority <priority>

The following examples assign the mesh cluster profiles cluster1 and cluster2 to two different AP groups. In
the AP group group1, cluster1 has a priority of 5, and cluster2 has a priority of 10, so cluster1 has the
higher priority. In the AP group group2, cluster1 has a priority of 10, and cluster2 has a priority of 5, so
cluster5 has the higher priority.
(host)[node] (config) #ap-group group1

   mesh-cluster-profile cluster1 priority 5

   mesh-cluster-profile cluster2 priority 10

(host)[node] (config) #ap-group group2

mesh-cluster-profile cluster1 priority 10

mesh-cluster-profile cluster2 priority 5

Deleting Mesh Radio Profiles
You can delete a mesh radio profile only if no other APs or AP groups use that profile.

To delete a mesh radio profile using the WebUI:

ArubaOS 8.0.0.0 | User Guide Secure Enterprise Mesh |  567



568 | Secure Enterprise Mesh ArubaOS 8.0.0.0  | User Guide

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the Mesh tab in the All Profiles pane, then open the Mesh Radio profile.

3. Select the mesh radio profile from the list

4. Click Delete icon by the name of the profile you want to delete.

The following CLI command deletes a radio profile via the command-line interface.
(host)[node] (config)no ap mesh-radio-profile <profile-name>

Creating and Editing Mesh High-Throughput SSID Profiles
The mesh high-throughput SSID profile defines settings unique to 802.11n and 802.11ac-capable, high-
throughput APs. If none of the APs in your mesh deployment are 802.11n or 802.11ac-capable APs, you do
not need to configure a high-throughput SSID profile. If you modify a currently provisioned and running high-
throughput SSID profile, your changes take effect immediately. You do not need to reboot the managed device
or the AP.

Managing Mesh High-Throughput SSID Profiles in the WebUI
Use the following procedures to manage your high-throughput SSID profiles using the WebUI.

Creating a Profile
To create a high-throughput SSID profile:

1. Navigate to the Configuration > System and open the Profile window.

2. Expand the Mesh tab in the All Profiles menu, and select the Mesh High-throughput SSID profile.

3. Select Add Mesh High-throughput SSID profile.

4. Enter a name for the new profile.

5. Configure the mesh high-throughput SSID parameters described in Table 117. The Mesh High-Throughput
SSID Profile configuration settings are divided into two tabs, General and Advanced. The General tab
displays only those configuration settings that often need to be adjusted to suit a specific network. The
Advanced tab shows all configuration settings, including settings that do not need frequent adjustment or
should be kept at their default values. If you change a setting on one tab then click and display the other
tab without saving your configuration, that setting reverts to its previous value.

6. Click Save. The profile name appears in the Mesh High-throughput SSID Profile list with your configured
settings.

Parameter Description

40 MHz channel usage Enable or disable the use of 40 MHz channels.

Default: enabled

80 MHz channel usage Enable or disable the use of 80 MHz channels.

Default: enabled

High-throughput Enable
(SSID)

Enable or disable high-throughput (802.11n) features on the SSID.

Default: enabled

Table 117: Mesh High-Throughput SSID Profile Configuration Parameters



Parameter Description

VHT- Explicit Transmit
Beamforming

Enable/Disable use of Very High Through-put Explicit Transmit
Beamforming.

If this parameter is disabled, the other transmit beamforming configuration
settings have no effect.

Very High throughput
enable (VHT)

Enable or disable very high-throughput (802.11av) features on the SSID.

Default: enabled

Temporal Diversity
Enable

When a client is not responding to 802.11 packets, the AP will launch two
hardware retries. If you enable this option and hardware retries are not
successful, then the AP will launch and the software retries.

BA AMSDU Enable Enable/Disable Receive AMSDU in BA negotiation.

Legacy stations Allow or disallow associations from legacy (non-HT) stations. By default, this
parameter is enabled (legacy stations are allowed).

Low-density Parity Check If enabled, the AP advertises Low-density Parity Check (LDPC) support LDPC
improves data transmission over radio channels with high levels of
background noise. (For 130 Series only)

Maximum number of
spatial streams usable for
STBC reception

Controls the maximum number of spatial streams usable for STBC
reception. 0 disables STBC reception, 1 uses STBC for MCS 0-7. Higher MCS
values are not supported. (Supported on the Series, 130 Series, AP-175 and
AP-105 only. The configured value adjusts based on AP capabilities.)

If transmit beamforming is enabled, STBC is disabled for disabled for
beamformed frames.

Maximum number of
spatial streams usable for
STBC transmission.

Controls the maximum number of spatial streams usable for STBC
transmission. 0 disables STBC transmission, 1 uses STBC for MCS 0-7.
Higher MCS values are not supported. (Supported on Series, AP-175, 130
Series and AP-105 only. The configured value adjusts based on AP
capabilities.)

If you enable transmit beamforming, STBC is disabled for disabled for
beamformed frames.

MPDU Aggregation Enable or disable MAC protocol data unit (MPDU) aggregation.

High-throughput APs are able to send aggregated MAC protocol data units
(MDPUs), which allow an AP to receive a single block acknowledgment
instead of multiple ACK signals. This option, which is enabled by default,
reduces network traffic overhead by effectively eliminating the need to
initiate a new transfer for every MPDU.

Max received A-MPDU
size

Maximum size of a received aggregate MPDU, in bytes. Allowed values:
8191, 16383, 32767, 65535.

Max transmitted A-MPDU
size

Maximum size of a transmitted aggregate MPDU, in bytes.

Range: 1576–65535
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Parameter Description

Maximum number of
MSDUs in an A-MSDU on
best-effort AC

Maximum number of MSDUs in a TX A-MSDU on best-effort AC. TX-AMSDU
disabled if 0.

Range: 0-15

Default: 2

Maximum number of
MSDUs in an A-MSDU on
background AC

Maximum number of MSDUs in a TX A-MSDU on background. TX-AMSDU
disabled if 0.

Range: 0-15

Default: 2

Maximum number of
MSDUs in an A-MSDU on
video AC

Maximum number of MSDUs in a TX A-MSDU on video AC. TX-AMSDU
disabled if 0.

Range: 0-15

Default: 2

Maximum number of
MSDUs in an A-MSDU on
voice AC

Maximum number of MSDUs in a TX A-MSDU on voice AC. TX-AMSDU dis-
abled if 0.

Range: 0-15

Default: 0

Maximum VHT MPDU size Maximum size of a VHT MPDU, in bytes.

Range: 3895, 7991, 11454

Min MPDU start spacing Minimum time between the start of adjacent MPDUs within an aggregate
MPDU, in microseconds. Allowed values: 0 (No restriction on MDPU start
spacing), .25 µsec, .5 µsec, 1 µsec, 2 µsec, 4 µsec.

Short guard interval in 20
MHz mode

Enable or disable use of short (400ns) guard interval in 20 MHz mode. This
parameter is enabled by default.

A guard interval is a period of time between transmissions that allows
reflections from the previous data transmission to settle before an AP
transmits data again. An AP identifies any signal content received inside this
interval as unwanted inter-symbol interference, and rejects that data. The
802.11n standard specifies two guard intervals: 400ns (short) and 800ns
(long). Enabling a short guard interval can decrease network overhead by
reducing unnecessary idle time on each AP. Some outdoor deployments,
may, however require a longer guard interval. If the short guard interval
does not allow enough time for reflections to settle in your mesh
deployment, inter-symbol interference values may increase and degrade
throughput.

Short guard interval in 40
MHz mode

Enable or disable use of short (400ns) guard interval in 40 MHz mode. This
parameter is enabled by default.



Parameter Description

A guard interval is a period of time between transmissions that allows
reflections from the previous data transmission to settle before an AP
transmits data again. An AP identifies any signal content received inside this
interval as unwanted inter-symbol interference, and rejects that data. The
802.11n standard specifies two guard intervals: 400ns (short) and 800ns
(long). Enabling a short guard interval can decrease network overhead by
reducing unnecessary idle time on each AP. Some outdoor deployments,
may, however require a longer guard interval. If the short guard interval
does not allow enough time for reflections to settle in your mesh
deployment, inter-symbol interference values may increase and degrade
throughput.

Short guard interval in 80
MHz mode

Enable or disable use of short (400ns) guard interval in 80 MHz mode.

A guard interval is a period of time between transmissions that allows
reflections from the previous data transmission to settle before an AP
transmits data again. An AP identifies any signal content received inside this
interval as unwanted inter-symbol interference, and rejects that data.

The 802.11n standard specifies two guard intervals: 400ns (short) and 800ns
(long). Enabling a short guard interval can decrease network overhead by
reducing unnecessary idle time on each AP. Some outdoor deployments,
may, however require a longer guard interval. If the short guard interval
does not allow enough time for reflections to settle in your mesh
deployment, inter-symbol interference values may increase and degrade
throughput.

This parameter is enabled by default.

Supported MCS set A list of Modulation Coding Scheme (MCS) values or ranges of values to be
supported on this SSID. The MCS you choose determines the channel width
(20MHz vs. 40MHz) and the number of spatial streams used by the mesh
node.

The default value is 1–23; the complete set of supported values. To specify a
smaller range of values, enter a hyphen between the lower and upper
values. To specify a series of different values, separate each value with a
comma.

Examples:

2–10

1,3,6,9,12

Range: 0–23.

VHT - Support MCS Map A list of Modulation Coding Scheme (MCS) values or ranges of values to be
supported on this SSID. The MCS you choose determines the channel width
(20MHz vs. 40MHz vs 80MHz) and the number of spatial streams used by
the mesh node.

The default value is 1–23; the complete set of supported values. To specify a
smaller range of values, enter a hyphen between the lower and upper
values. To specify a series of different values, separate each value with a
comma.

Examples:

2–10

1,3,6,9,12
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Parameter Description

Range: 0–23.

vht-txbf-explicit-enable Enable/Disable use of VHT Explicit Transmit Beamforming.

Assigning a Profile to an AP Group
1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile

window.

2. Expand the Mesh tab in the All Profiles menu, and select the Mesh High-throughput SSID profile.

3. In the Profile Details window pane, click the Mesh High-throughput SSID profile drop-down list and
select the desired profile from the list.

4. Click Save. The profile name appears in the Mesh High-throughput SSID Profile list with your configured
settings. If you configure this for the AP group, this profile also becomes the selected high-throughput SSID
profile used by the mesh portal for your mesh network.

Editing a Profile
1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile

window.

2. Expand the Mesh tab in the All Profiles menu, and select the Mesh High-throughput SSID profile.

3. Select the Mesh high-throughput profile you want to edit.

4. Change the settings as desired. Table 117 describes the parameters you can configure in this profile.

5. Click Save.

Deleting a Profile
You can delete a mesh high-throughput SSID profile only if no APs or AP groups are associated with that
profile.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the Mesh tab in the All Profiles menu, and select Mesh High-throughput SSID.

3. Select the Mesh High-throughput SSID profile you want to delete and click the delete icon.

Managing Mesh High-Throughput SSID Profiles in the CLI
You must be in config mode to create, modify or delete a mesh high-throughput SSID radio profile using the
CLI. Specify an existing high-throughput SSID profile with the <profile-name> parameter to modify an existing
profile, or enter a new name to create an entirely new profile.

Creating or Modifying a Profile
Configuration details and any default values for each of these parameters are described in Table 117. If you do
not specify a parameter for a new profile, that profile uses the default value for that parameter. Put the no
option before any parameter to remove the current value for that parameter and return it to its default
setting. Enter exit to leave the high-throughput radio profile mode
(host)[node](config) #ap mesh-ht-ssid-profile <profile-name>

40mhz-enable

80mhz-enable

ba-amsdu-enable

clone

high-throughput-enable



ldpc

legacy-stations

max-rx-a-mpdu-size

max-tx-a-mpdu-size

max-tx-a-msdu-count-be

max-tx-a-msdu-count-bk

max-tx-a-msdu-count-vi

max-tx-a-msdu-count-vo

max-vht-mpdu-size

min-mpdu-start-spacing

mpdu-agg

no

short-guard-intvl-20mhz

short-guard-intvl-40mhz

short-guard-intvl-80mhz

stbc-rx-streams

stbc-tx-streams

supported-mcs-set

temporal-diversity

vht-supported-mcs-map

You can also create a new mesh high-throughput SSID profile by copying the settings of an existing profile
using the clone parameter. Using the clone command to create a new profile makes it easier to keep constant
attributes in common within multiple profiles.
(host)[node] (config) #ap mesh-ht-ssid-profile <profile-name> clone <source-profile-name>

Assigning a Profile to an AP Group
To associate a mesh high-throughput SSID profile with an AP group:
(host)[node] (config) #ap-group <group> mesh-ht-ssid-profile <profile-name>

To associate a mesh radio profile with an individual AP:
(host)[node] (config) #ap-name <name> mesh-ht-ssid-profile <profile-name>

Viewing High-throughput SSID Settings
To view a complete list of high-throughput profiles and their status:
(host)[node] (config) #show ap mesh-ht-ssid-profile

To view the settings of a specific high-throughput profile:
(host)[node] (config) #show ap mesh-ht-ssid-profile <profile-name>

Deleting a Profile
If no AP or AP group is using a mesh high-throughput SSID profile, you can delete that profile using the no
parameter:
(host)[node] (config) #no ap mesh-ht-ssid-profile <profile-name>

Configuring Ethernet Ports for Mesh
If you use mesh to join multiple Ethernet LANs, configure and enable bridging on the mesh point Ethernet port
This section describes how to configure Ethernet ports for bridging or secure jack operation using the wired AP
profile. The wired AP profile controls the configuration of the Ethernet port(s) on your AP.

Mesh nodes only support bridge mode and tunnel mode on their wired ports (Enet0 or Enet1). Split tunnel mode is
not supported. Use bridge mode to configure bridging on the mesh point Ethernet port. Use tunnel mode to configure
secure jack operation on the mesh node Ethernet port.
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When configuring the Ethernet ports on dual-port APs, note the following requirements for the AP configures
as a mesh portal:

l Connect Enet0 to the managed deviceto obtain an IP address. The wired AP profile controls Enet1.

l Only Enet1 supports secure jack operation.

Configuring Bridging on the Ethernet Port
Use the following procedure to configure bridging on the Ethernet port via the WebUI.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the AP tab in the All Profiles menu, then open the Wired AP profile and select the profile.

3. Under General settings, do the following:

a. Select the Wired AP enable check box. This option is not selected by default.

b. From the Forward mode drop-down list, select bridge.

c. Optionally, from the Switchport mode drop-down list, select access or trunk. These options only
apply to bridge mode configurations.

l Access mode forwards untagged packets received on the port to the managed device and they
appear on the configured access mode VLAN. Tagged packets are dropped. All packets received from
the managed device and sent via this port are untagged. Define the access mode VLAN in the Access
mode VLAN field.

l Trunk mode contains a list of allowed VLANs. Any packet received on the port that is tagged with an
allowed VLAN is forwarded to the managed device. Untagged packets are forwarded to the managed
device on the configured Native VLAN. Packets received from the managed device and sent out the
port remain tagged unless the tag value in the packet is the Native VLAN, in which case the tag is
removed. Define the Native VLAN in the Trunk mode native VLAN field and the other allowed
VLANs in the Trunk mode allowed VLANs field.

d. Optionally, select Trusted to configure this as a trusted port.

4. Click Save.

Use the following commands to configure Ethernet port bridging via the CLI.
(host)[node] (config) #ap wired-ap-profile <profile>

broadcast

clone

forward-mode {bridge | split-tunnel | tunnel}

wired-ap-enable

Optionally, you can configure the following wired AP profile settings:
(host)[node](config) #ap wired-ap-profile <profile>

switchport mode {access | mode | trunk}

switchport access vlan <vlan>

switchport trunk native vlan <vlan>

switchport trunk allowed vlan <vlan>

trusted

Configuring Ethernet Ports for Secure Jack Operation
You can configure the Ethernet port(s) on mesh nodes to operate in tunnel mode. Known as secure jack
operation for mesh, this configuration allows Ethernet frames coming into the specified wired interface to be
generic routing encapsulation (GRE) tunneled to the managed device. Likewise, Ethernet frames coming from
the tunnel are bridged to the corresponding wired interface. This allows an Ethernet port on the mesh node to
appear as an Ethernet port on the managed deviceseparated by one or more Layer-3 domains. You can also
enable VLAN tagging.



Unlike secure jack on non-mesh APs, any mesh node configured for secure jack uses the mesh link, rather than
Enet0, to tunnel the frame to the managed device.

When configuring mesh Ethernet ports for secure jack operation, note the following guidelines:

l Mesh points support secure jack on Enet0 and Enet1.

l Mesh portals only support secure jack on Enet1. This function is only applicable to Aruba APs that support a
second Ethernet port and mesh, such as the 130 Series.

You configure secure jack operation in the wired AP profile.

The parameters in the wired AP profile only apply to the wired AP interface to which they are assigned. Two wired
interfaces can have different parameter values.

In the WebUI
Use the following procedure to configure secure jack operation using the WebUI.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the AP tab in the All Profiles menu then select the Wired AP profle from the drop-down list. The
settings for the currently selected wired AP profile appear.

3. Under General settings, do the following:

a. Select the Wired AP enable check box. This option is not selected by default.

b. From the Forward mode drop-down list, select tunnel.
c. Optionally, select Trusted to configure this as a trusted port.

4. Click Save.

In the CLI
To configure secure jack operation using the command-line interface, access the CLI in config mode and issue
the following commands:
(host)[node] (config) #ap wired-ap-profile <profile>

forward-mode tunnel

wired-ap-enable

Optionally, you can configure the following wired AP profile settings:
(host)[node](config) #ap wired-ap-profile <profile>

trusted

Extending the Life of a Mesh Network
To prevent your mesh network from going down in the event of a managed device failure, modify the following
settings in the AP system profile(s) used by mesh nodes to maintain the mesh network until the managed
device is available:

It is recommended to use the default maximum request retries and bootstrap threshold settings for most mesh
networks; however, if you must keep your mesh network alive, you can modify the settings as described in this
section. The modified settings are not applicable if mesh portals are directly connected to the managed device.

l Maximum request retries: maximum number of times to retry AP-generated requests. The default is 10
times. If you must modify this setting, it is recommended to set a value of 10,000.

l Bootstrap threshold: number of consecutive missed heartbeats before the AP rebootstraps. (Heartbeats
are sent once per second.) The default is 9 missed heartbeats. If you must modify this setting, it is
recommended to set a value of 5,000.
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When the managed device comes back online, the affected mesh nodes (mesh portals and mesh points)
rebootstrap; however, the mesh link is not affected and continues to be up.

In the WebUI
Use the following procedure to modify the AP system profile via the WebUI.

1. In the Managed Network node hierarchy, navigate to the Configuration > System and open the Profile
window.

2. Expand the AP tab in the All Profiles menu, and select AP System profile.

3. Click the AP system profile you want to edit

4. Open the Advanced settings in the AP system profile window and make the following changes:

a. Change the Maximum Request Retries to 10000.

b. Change the Bootstrap threshold to 5000.

5. Click Save.

In the CLI
To modify the AP system profile via the command-line interface, access the CLI in config mode and issue the
following commands:
(host)[node] (config) #ap system-profile <profile>

max-request-retries 10000

bootstrap-threshold 5000

Provisioning Mesh Nodes
Provisioning mesh nodes is similar to thin APs; however, there are some key differences. Thin APs establish a
channel to the managed device from which they receive the configuration for each radio interface. Mesh
nodes, in contrast, get their radio interfaces up and running before making contact with the managed device.
This requires a minimum set of parameters from the AP group and mesh cluster that enables the mesh node to
discover a neighbor to create a mesh link and subsequent channel with the managed device. To do this, you
must first configure mesh cluster profiles for each mesh node prior to deployment. See Creating and Editing
Mesh Radio Profiles for more information.

On each radio interface, you provision a mode of operation: mesh node or thin AP (access) mode. If you do not
specify mesh, the AP operates in thin AP (access) mode. If you configure mesh, the AP is provisioned with a
minimum of two mesh cluster profiles: the “default” mesh cluster profile and an emergency read-only recovery
profile, as described in the section Configuring Mesh Cluster Profiles. If you create and select multiple mesh
cluster profiles, the AP is provisioned with those as well. If you have a dual-radio AP and configure one radio for
mesh and the other as a thin AP, each radio is provisioned as configured.

Each radio provisioned in mesh mode can operate in one of two roles: mesh portal or mesh point. You
explicitly configure the role, as described in this section. This allows the AP to know whether it uses the mesh
link (via the mesh point/mesh portal) or an Ethernet link to establish a connection to the managed device.

During the provisioning process, mesh nodes look for a mesh profile that the AP group and AP name is a
member of and stores that information in flash. If you have multiple cluster profiles, the mesh portal uses the
best profile to bring-up the mesh network. Mesh points in contrast go through the list of mesh cluster profiles
in order of priority to decide which profile to use to associate themselves with the network. In addition, when a
mesh point is provisioned, the country code is sent to the AP from its AP name or AP group along with the
mesh cluster profiles. Mesh nodes also learn the recovery profile, which is automatically generated by the
Mobility Master. If the other mesh cluster profiles are unavailable, mesh nodes use the recovery profile to
establish a link to the Mobility Master; data forwarding does not take place.



If you create a new mesh cluster profile for an existing deployment, you must re-provision the AP for the new profile
to take effect. If you re-provision mesh nodes that are already operating, re-provision the most distant (highest hop
count) mesh points first followed by the mesh portals. If you re-provision the mesh portal first, the mesh points may
be unable to form a mesh link. Re-provisioning the AP causes it to automatically reboot. This may cause a disruption
of service to the network.

Provisioning Caveats
Remember the following when provisioning APs for mesh:

l You must provision the AP before you install it as a mesh node in a mesh deployment. To provision the AP,
it must be physically connected to the local network or directly connected to the Mobility Master. When
connected and powered on, the AP must also be able to obtain an IP address from a DHCP server on the
managed device or from the Mobility Master.

l Make sure that the provisioned mesh nodes form a connected mesh network before physically deploying
the APs. For more information, seeVerifying Your Mesh Network.

l In multi-node networks, save your mesh cluster configuration before provisioning the mesh nodes. To save
your configuration in the WebUI, at the top of any window, click Pending Changes > Deploy changes. To
save your configuration in the CLI, use the command write memory.

Provisioning Mesh Nodes
Reprovisioning the AP causes it to automatically reboot. The following procedures describe the process to
provision a mesh portal or mesh node via the WebUI or CLI. (The easiest way to provision a mesh node is to
use the Provisioning window in the WebUI.) To provision a remote mesh portal, see Configuring Remote Mesh
Portals (RMPs).

Verifying Your Mesh Network
To view a list of your Mesh APs via the WebUI, navigate to the one of the following windows:

l Monitoring > Network > All Mesh Nodes
l Monitoring > Controller > Mesh Nodes

To view mesh APs and the mesh topology tree using the command line interface, access the command-line
interface in enable mode and issue the following commands:

l #show ap mesh active

l #show ap mesh topology

Verification Checklist
After provisioning the mesh APs, follow the steps below to ensure that the mesh network is up and operating
correctly.

l Issue the command show ap mesh topology to verify all the mesh APs are up and the topology is as
expected. (Wait 10 minutes after startup for the topology to stabilize.)

l Verify each mesh node has the expected RSSI to its neighboring mesh nodes. The mesh topology is updated
periodically, so access the command-line interface and issue the command show ap mesh neighbors
for the current status. If the RSSI is low, verify that the tx-power settings in the mesh node’s
802.11a/802.11g radio profiles are correct, or, if ARM is used, verify the correct minimum tx-power setting.

l Issue the command show ap mesh debug provisioned-clusters to verify that the mesh clusters are
correctly defined and provisioned (with encryption if desired). Issue the show running-config | include

ArubaOS 8.0.0.0 | User Guide Secure Enterprise Mesh |  577



578 | Secure Enterprise Mesh ArubaOS 8.0.0.0  | User Guide

recovery command to verify that the cluster’s recovery profile matches the managed device's recovery
profile.

l Verify antenna provisioning by issuing the show ap provisioning command and verify installation
parameters for non-default installations (that is, standard indoor APs deployed outside, or outdoor APs
deployed inside). Ensure all APs use the same channel list by issuing the show ap allowed-channels
command.

l If the mesh-radio is to be reserved exclusively for mesh backhaul traffic, issue the command show ap
profile-usage to identify the radio’s 802.11a or 802.11g radio profile, then issue the command show rf
dot11a-radio-profile <profile> or show rf dot11g-radio-profile <profile> to verify the radio is disabled
in the profile. Next, use the show ap bss-table command to that verify no access Virtual APs are up on the
mesh radio.

CLI Examples
Use the show ap mesh active command to verify all nodes are present and that EIRP is correct:
[mynode] #show ap mesh active

Mesh Cluster Name: meshprofile1

------------------------------

Name Group IP Address BSSID Band/Ch/EIRP/MaxEIRP MTU Enet 0/1 Mesh Role

---- ----- ------------ ----- -------------------- --- -------- ---------

mp1 mp1 10.3.148.245 00:1a:1e:85:c0:30  802.11a/157/19/36 Off/Off Point

mp2 mp2 10.3.148.250 00:1a:1e:88:11:f0  802.11a/157/19/36 Bridge/Bridge Point

mp3 mp3 10.3.148.253 00:1a:1e:88:01:f0  802.11a/157/19/36 Bridge/Bridge Point

mpp mpp125 10.3.148.252 00:1a:1e:88:05:50  802.11a/157/19/36 1578 -/Bridge Portal

Parent #Children AP Type Uptime

------ --------- ------- ------

mp3 0 125 13d:2h:25m:19s

mpp 1 125 14d:21h:23m:49s

mp2 1 125 14d:21h:14m:55s

- 1 125 14d:19h:5m:3s

Use the show ap mesh topology command to verify the cluster topology, RSSI in presence of network traffic,
and Tx and Rx rates.
[mynode] #show ap mesh topology

Mesh Cluster Name: sw-ad-GB32

-----------------------------

Name Mesh Role Parent Path Cost Node Cost Link Cost Hop Count RSSI Rate Tx/Rx

---- --------- ------ --------- --------- --------- --------- ---- ---------- Last

Update Uplink Age #Children

---------- ---------- ---------

ad-ap Point (N) mp3 2 0 0 1 61 300/270 6m:12s

3h:8m:7s 0

msc-1 Point mp3 2 0 0 1 64 54/54 6m:36s

2h:48m:12s 0

Total APs :2

(R): Recovery AP. (N): 11N Enabled. For Portals 'Uplink Age' equals uptime.

Issue the command show ap mesh neighbors ap-name <name> to verify visibility of other mesh nodes is
as expected:(host) #show ap mesh neighbors ap-name portal

Neighbor list

-------------

MAC Portal Channel Age Hops Cost Relation Flags RSSI

Rate Tx/Rx



--- ------ ------- --- ---- ---- -------- ----- ---- --

--------

00:0b:86:e8:09:d1 00:1a:1e:88:01:f0 157 0 1 11.00 C 3h:15m:42s - 65

54/54

00:1a:1e:88:02:91 00:1a:1e:88:01:f0 157 0 1 4.00 C 3h:35m:30s HL 59

300/300

00:0b:86:9b:27:78 Yes 157 0 0 12.00 N 3h:22m:46s - 26 -

00:0b:86:e8:09:d0 00:1a:1e:88:01:f0 157 0 1 11.00 N 3h:15m:36s - 65 -

00:1a:1e:88:02:90 00:1a:1e:88:01:f0 157+ 0 1 2.00 N 3h:35m:6s HL 59 -

A-Req A-Resp A-Fail HT-Details Cluster ID

----- ------ ------ ---------- ----------

1 1 0 Unsupported sw-ad-GB32

1 1 0 HT-40MHzsgi-2ss sw-ad-GB322

0 0 0 Unsupported mc1

0 0 0 Unsupported sw-ad-GB32

0 0 0 HT-40MHzsgi-2ss sw-ad-GB32

Total count: 5, Children: 2

Configuring Remote Mesh Portals (RMPs)
The following steps describe the procedure to configure a Remote Mesh portal using the WebUI and CLI
interfaces.

Creating a Remote Mesh Portal In the WebUI
A remote mesh portal must be provisioned as both a remote access point and a mesh portal. For instructions
on provisioning the remote mesh portal as a remote access point, see Configuring the Secure Remote Access
Point Service on page 627.

Wired ports on remote mesh portals can be configured in either bridge or split-tunnel forwarding mode.
However, there are limitations to the forwarding modes that can be used by other mesh node types. Do not
use bridge or split-tunnel forwarding mode for wired ports on mesh points. Virtual APs on remote mesh portals
and remote mesh points also do not support bridge or split-tunnel forwarding mode.

A remote mesh portal does not support bridge mode Virtual APs or offline Virtual APs.

Provision the AP
1. In the Managed Network node hierarchy, navigate to the Configuration > Access Points window.

2. Open the Remote APs tab

3. Select the AP to provision as a remote mesh portal and click Provision.

4. In the Authentication section, select the Remote AP option.

5. In the Remote AP Authentication Method section of this window, select either Pre-shared Key or
Certificate. If you selected Pre-Shared Key, enter and confirm the Internet Key Exchange Pre-Shared Key
(IKE PSK).

6. In the Master Discovery section, set the Master IP address as the controller IP address.

7. In the IP settings section, select Obtain IP Address Using DHCP.

8. In the AP List section at the bottom of the window, click the Mesh Role drop-down list and select Remote
Mesh Portal.
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Step 2: Define the Mesh Private VLAN in the Mesh Radio Profile
Follow the procedure below to choose a new, non-zero tag value for the mesh private VLAN. Make sure that
the mesh private VLAN so that it does not conflict with any local tags assigned in the mesh network. Once
configured, all mesh points come up in that Mesh Private VLAN. This mesh private VLAN must not be used as a
VLAN for any other virtual AP.

1. Edit the Mesh Radio profile for the remote mesh portal according to the procedure described in Creating or
Editing a Mesh Radio Profile on page 563 .

2. Set the Mesh Private VLAN parameter to define a VLAN ID (0–4094) for control traffic between an
remote mesh point and mesh nodes.

3. Click Apply to save your changes.

Next, assign the remote mesh points with the same mesh cluster profile, 802.11a and 802.11g RF
management profiles, and mesh radio profile as the remote mesh portal. If you have defined an AP group for
all your remote mesh points, you can just assign the required profiles to the remote mesh point AP group.
Otherwise, you must assign the required profiles to each individual remote AP.

Step 3: Assign the Mesh Radio Profile to a Remote Mesh AP
Follow the procedures described in Assigning a Mesh Radio Profile to a Mesh AP or AP Group on page 566

Step 4: Assign an RF Management Profile to a Remote Mesh AP
Follow the procedures described in In the CLI on page 525 to assign an 802.11a or 802.1g RF management
profile to the remote mesh AP.

Step 5: Assign a Mesh Cluster Profile
Follow the procedures described in Configuring Mesh Cluster Profiles on page 559 to assign a mesh cluster
profile to the remote mesh AP.

If you configure multiple cluster profiles with different cluster priorities, you manually override the link metric
algorithm because the priority takes precedence over the path cost. In this scenario, the mesh portal uses the profile
with the highest priority to bring-up the mesh network.

Step 6: Configuring a DHCP Pool
In this next step, you must configure a DHCP pool where the DHCP server is on the subnet associated with
mesh private VLAN. Mesh points get their IP address from this subnet pool. To complete this task, refer to the
procedure described in Enabling Remote AP Advanced Configuration Options.

Step 7: Configuring the VLAN ID of the Virtual AP Profile
Follow the procedure described in WLAN SSID Profiles on page 424 to configure the VLAN ID of the remote
mesh AP's SSID profile. The VLAN of this Virtual AP must have the same VLAN ID as the mesh private VLAN.

Provisioning a Remote Mesh Portal In the CLI
Reprovisioning the AP causes it to automatically reboot. When you use the CLI to reprovision a mesh node, you
may also provision other AP settings.
(host)[node](config) #provision-ap

read-bootinfo ap-name <name>

mesh-role remote-mesh-portal

reprovision ap-name <name>
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Chapter 27
Increasing Network Uptime Through Redundancy and VRRP

ArubaOS high availability and Virtual Router Redundancy Protocol (VRRP) redundancy features allow network
administrators to significantly reduce network downtime and client traffic disruption during network upgrades
or unexpected failures.

Getting Started with High Availability and VRRP Solutions
This chapter describes ArubaOS high availability and VRRP redundancy solutions, and lists the procedures to
configure these features.

Learn more about High-Availability and VRRP Redundancy
For information to help you plan your redundancy solution, refer to the following sections of this document:

l High Availability Overview on page 581

l High Availability with Extended Capacity on page 584

l Client State Synchronization on page 585

l High Availability Inter-Controller Heartbeats on page 586

l Configuring High Availability on page 586

Configure a VRRP Solution
For more information on VRRP redundancy on Multi-Master topologies, see VRRP Redundancy for Multi-
Master Topologies on page 588.

High Availability Overview

This section is applicable only for a stand-alone controller or a managed device on the Mobility Master.

When you enable the High Availability WLAN redundancy solution, campus APs that lose contact with their
active controller do not need to re-bootstrap when they failover to the standby controller, significantly
reducing AP downtime. APs using the High Availability features regularly communicate with the standby
controller so the controller has a light workload to process in the event of an AP failover. This results in very
rapid failover times and a shorter client reconnect period. Therefore, High Availability is usually preferable to
other redundancy solutions (like a backup-LMS) that can put a heavy load on the backup controller during
failover, which results in slower failover performance.

High Availability supports failover for campus APs using tunnel, or decrypt-tunnel, or bridge forwarding modes. It
does not support failover for remote APs.

Controller Role Types
A controller using this feature can have one of three high availability roles: active, standby, or dual. An active
controller serves APs, but cannot act as a failover standby controller for any AP except those that it serves as
an active controller. A standby controller acts as a failover backup controller, but cannot be configured as the
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primary controller for any AP. A dual controller can support both roles, acting as the active controller for one
set of APs, and a standby controller for another set of APs.

A controller is assigned the dual role if no other role is specified

AP Communication with Controllers
The High Availability features work across Layer-3 networks, so there is no need for a direct Layer-2 connection
between controllers in a high-availability group.

When the AP first connects to its active controller, the active controller provides the IP address of a standby
controller, and the AP attempts to establish a tunnel to the standby controller. If an AP fails to connect to the
first standby controller, the active controller will select a new standby controller for that AP, and the AP will
attempt to connect to that standby controller.

An AP will failover to its backup controller if it fails to contact its active controller through regular heartbeats
and keepalive messages, or if the user manually triggers a failover using the WebUI or CLI. If inter-controller
heartbeat is enabled, APs can failover even when the standby controller misses its heartbeats with the active
controller.

High Availability for bridge mode is supported on Campus APs. In this mode, the controller sends ACL Names
to the APs instead of the ACL IDs. These APs generate and maintain the mapping between the ACL Name and
ACL Id . In the event of a failover the ACL Name is sent to the AP from the stand-by controller. Since AP
maintains the mapping, the ACL Ids remain intact during a failover.

Redundancy and High Availability Requirements and Limitations
A backup controller can use the High Availability feature. However, a backup controller can only accept standby
connections from APs, and will not serve active APs as long as its master redundancy role is backup.

This type of High Availability deployment has the following requirements and limitations:

l A backup-master controller can only form an active-standby pair with the master controller.

l The backup master cannot terminate active APs.

l Both the backup-master and master controllers must be configured with the dual controller role.

l The controller IP address defined in the high availability group profile must be the IP address of the VRRP
interface.

l The inter-controller heartbeat feature is not recommended for backup-master and master
controller pairs using the High Availability feature. If the inter-controller heartbeat feature is
enabled in a high availability group profile for redundant masters, the inter-controller failover time must be
greater than the VRRP failover time. That is, the (heartbeat interval * heartbeat threshold threshold) value
should be greater than the (advertisement time * 3 + preemption delay + skew time [which is based on
priority]).

High Availability Deployment Models
High availability supports the following deployment models.

l Active/Active Deployment Model on page 583

l 1:1 Active/Standby Deployment Model on page 583

l N:1 Active/Standby Deployment Model



Active/Active Deployment Model
In this model, two controllers are deployed in dual mode. Controller one acts as a standby for the APs served
by controller two, and vice-versa. To ensure that each AP gets a standby, Aruba recommends not to have AP
count more than 50% of the platform limit; if one controller fails, all the APs served by that controller would
failover to the other controller, providing high availability redundancy to all APs in the cluster.

Figure 47 Active-Active HA Deployment

1:1 Active/Standby Deployment Model
In this model, the active controller supports up to 100% of its rated capacity of APs, while the other controller
is idle in standby mode. If the active controller fails, all APs served by the active controller will failover to the
standby controller.

Figure 48 1:1 Active/Standby Deployment

N:1 Active/Standby Deployment Model
In this model, the active controller supports up to 100% of its rated AP capacity, while the other controller is
idle in standby mode. If an active controller fails, all APs served by the active controller will failover to the
standby controller. This model requires that the AP capacity of the standby controller is able to support the
total number of APs distributed across all active controllers in the cluster.

In the cluster shown in the example below, the standby controller has enough AP capacity to support the total
number of APs terminating at the active controllers ( Controller 1 and Controller 2).
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Figure 49 1:1 Active/Standby Deployment

High Availability with Extended Capacity
The standby controller over-subscription feature allows a standby controller to support connections to
standby APs beyond the controller's original rated AP capacity. The following section of this document gives
and lists requirements and capacity limitations for this feature. For more details on enabling the extended
standby controller capacity, see Configuring High Availability on page 586.

A controller that acts as a standby controller can oversubscribe to standby APs by up to four times that
controller's rated AP capacity, as long as the tunnels consumed by the standby APs do not exceed the
maximum tunnel capacity for that standby controller.

Feature Requirements
This feature can be enabled on managed devices where centralized licensing is enabled on the active and
standby Mobility Master, or on stand-alone controllers that are not using VRRP-based redundancy. If
centralized licensing is disabled, the standby AP over-subscription feature is also disabled. Standby controller
over-subscription and the high availability state synchronization features are mutually exclusive and cannot be
enabled simultaneously. If your deployment uses the state synchronization feature, you must disable it before
you enable standby controller over-subscription.

Standby Controller Capacity
The following table describes the AP over-subscription capacity maximum supported tunnels and the
controllers that support this feature. This feature is not applicable for 70xx controllers.

Controller Model
Standby AP
Capacity

Maximum Tun-
nels Sup-
ported

7205 4x rated AP capacity 8192 tunnels

7210 4x rated AP capacity 16384 tunnels

7220 4x rated AP capacity 32768 tunnels

Table 118: Controller Support for Standby Oversubscription



Controller Model
Standby AP
Capacity

Maximum Tun-
nels Sup-
ported

7240 4x rated AP capacity 65536 tunnels

To determine the number of standby tunnels consumed by APs on each active controller, multiply the number
of APs on the active controllers by the number of BSSIDs per AP. For example, consider a deployment with
four active 7210 controllers that each have 512 APs with 8 BSSIDs. The APs on each active controller consume
(512 * 8) tunnels, for a combined total of 16,384 tunnels. A single 7210 controller using the standby controller
over-subscription feature can act as the standby controller for all four active controllers in this example
because this topology is within the 4x rated AP capacity limit and maximum tunnel limit for the 7210 controller
model.

If the network administrator later changed all the APs in this deployment to support 10 BSSIDs, each active
controller would use (512 * 10) tunnels, for a combined total of 20,480 tunnels on the four active controllers.
The tunnels required by the APs on the active controllers would then exceed the maximum tunnel limit for the
standby controller, so the standby controller can no longer support all APs on the active controllers. Dynamic
changes to configuration (such as the addition of BSSIDs to any AP group) causes all the standby APs to
disconnect and reconnect back to the standby controller defined by their updated configuration

To view information about the numbers of currently associated APs and supported BSS tunnels, and the
remaining capacity for additional APs and BSS tunnels, issue the CLI command show ha oversubscription
statistics.

AP Failover
If a standby controller reaches its AP over-subscription capacity or exceeds its maximum BSSID limit, the
standby controller drops any subsequent standby AP connections. A dropped AP attempts to reconnect to the
standby controller, but after it exceeds the maximum number of request retries, the AP informs the active
controller that it is unable to connect to the standby controller. The active controller then prompts the AP to
create a standby tunnel to another standby controller, if one is configured.

If an active controller fails, the APs on the active controller failover to the standby controller. Once the standby
controller has reached its capacity for active APs, it terminates tunnels to any standby APs that the controller
can no longer serve. When these APs detect that there is no longer a heartbeat between the AP and the
standby controller, they notify their active controller that they can no longer connect to the standby. The
active controller then prompts the APs to establish standby tunnels to another standby controller, if one is
configured.

Client State Synchronization
Client state synchronization allows faster client reauthentication in the event of a controller failure by
synchronizing PMK and Key cache entries between active and standby controllers. When you enable this
feature, clients only need to perform a four-way key exchange to reconnect to the network (instead of
performing a full authentication to the RADIUS server), dramatically shortening the time required for the client
to reconnect.

The following section of this document describes topologies, guidelines, and limitations for this feature. To view the
procedure for enabling the client state synchronization feature, see Configuring High Availability.

Feature Guidelines and Limitations
Note the following guidelines and limitations before enabling this feature in your high availability deployment:
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l Only APs that support 802.11n and 802.11ac support client state synchronization.

l The client state synchronization and standby controller over-subscription features are mutually exclusive
and cannot be enabled simultaneously. If your deployment uses the standby controller over-subscription
feature, the feature must be disabled before enabling state synchronization.

High Availability Inter-Controller Heartbeats
The high availability inter-controller heartbeat feature allows for faster AP failover from an active controller to a
standby controller, especially in situations where the active controller reboots or loses connectivity to the
network.

The inter-controller heartbeat feature works independently from the AP mechanism that sends heartbeats
from the AP to the controller. If enabled, the inter-controller heartbeat feature supersedes the AP's heartbeat
to its controller. As a result, if a standby controller detects missed inter-controller heartbeats from the active
controller, it triggers its standby APs to failover to the standby controller, even if those APs have not detected
any missed heartbeats between the APs and their active controller. Use this feature with caution in deployments
where the active and standby controllers are separated over high-latency WAN links.

When this feature is enabled, the standby controller starts sending regular heartbeats to an AP's active
controller as soon as the AP has an UP status on the standby controller. The standby controller initially flags
the active controller as unreachable, but changes its status to reachable as soon as the active controller
sends a heartbeat response. If the active controller later becomes unreachable for the number of heartbeats
defined by the heartbeat threshold (default of 5 missed heartbeats), the standby controller immediately
detects this error and informs the APs using the standby controller to failover from the active controller to the
standby controller. If, however, the standby controller never receives an initial heartbeat response from the
active controller, and therefore never marks the active controller as initially reachable, the standby controller
will not initiate a failover.

This feature is disabled by default. It can be used in conjunction with the high availability state synchronization
feature only in topologies that use a single active and standby controller, or a pair of dual-mode active
controllers that act as standby controllers for each other. High availability inter-controller heartbeats can be
enabled and configured in the high-availability group profile using the WebUI or Command-Line interface.

For more details on how to enable and configure inter-controller heartbeats, see Configuring High Availability
on page 586.

Configuring High Availability
The high availability feature supports redundancy models with an active controller pair, or an active/standby
deployment model with one backup controller supporting one or more active controllers. Each of these
clusters of active and backup controllers comprises a high-availability group. All active and standby controllers
within a single high-availability group must be deployed in independent masters topology. An independent
masters topology requires all independent master controllers to have the same WLAN configuration.

Configuring High Availability
Configure the high availability feature in the WebUI or CLI using the high-availability and high-availability group
profiles.

In the WebUI
To configure High Availability using the WebUI:

1. In Mobility Master > standalone, navigate to Configuration > Services > Redundancy.

2. Click the HA Groups accordion and click the + icon. A pop-up window appears.



3. In the Name field, enter a name for the new HA group.

4. Configure an IPv4 or IPv6 address for the controller.

a. Click the + icon in the HA Controller IPv4 or HA Controller IPv6 fields. The Add HA Controller IP
window opens. Enter an IP address.

IPv4 and IPv6 controllers can be part of the same HA group profile. However, HA works only between controllers of
same IP format.

b. Click the Role drop-down list to assign a role to the controller. The IP address of each controller must be
reachable by APs and must be the IP address that appears in the Configuration > Controller >
System settings tab of the controller WebUI, or in the output of the show controller-ip CLI
command. The role can be one of the following options:

l Active: Controller is active and serving APs.

l Dual: Controller serves some APs and acts as a standby controller for other APs.

l Standby: Controller does not serve APs and only acts as a standby in case of failover.

c. Click OK to add the controller to the group.

5. (Optional) Select Enabled from the Pre-emption drop-down list to enable the failed over APs to attempt to
connect back to its original active controller once the controller is reachable again. When you enable this
setting, the AP waits for the time specified by the lms-hold-down-period parameter defined in the ap
system profile before the AP attempts to switch back from the standby controller to the orginal controller.

6. (Optional) The standby controller over-subscription feature allows a standby controller to support
connections to standby APs beyond the controller's original rated AP capacity. To enable this feature, click
the Over subscription check box.

7. (Optional) Click the State synchronization drop-down list and select Enable to enable this feature. State
synchronization improves failover performance by synchronizing client authentication state information
from the active controller to the standby controller. (For more information about state synchronization, see 
Client State Synchronization on page 585).

State synchronization is not applicable for IPv6 controllers.

8. (Optional) Click the Heartbeat drop-down list and select Enabled to enable the high availability inter-
controller heartbeat features, which enable faster AP failover from an active controller to a standby
controller, especially in situations where the active controller reboots or loses connectivity to the network.
To edit the default heartbeat threshold and interval values:

l Enter a heartbeat threshold in the Heartbeat threshold field to define the number of heartbeats that
must be missed before the APs are forced to failover to the standby controller. This value must be
between 3 and 10, inclusive.

l Enter a heartbeat interval in the Heartbeat interval (ms) field to define how often inter-controller
heartbeats are sent. This value must be between 100 and 1000 ms, inclusive.

9. (Optional) If you enabled the state synchronization feature in Step 7, enter a pre-shared key into the Pre-
shared key and Retype pre-shared key fields.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.
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In the CLI
To configure a High Availability group using the command-line interface, access the CLI in config mode and
issue the following commands. The high availability group profile should be configured with a pair of IPv4
controller addresses and pair of IPv6 controller addresses to allow an IPv4 or IPv6 access point to establish a
connection to a standby controller.
(host) [mynode] (config) #ha group-profile <profile>

(host) [mynode] (HA group information "default") #controller <ip> role [active/dual/standby]

A controller using the high availability features must be defined as a member of a high availability group. To
add a controller to the new high availability group, issue following CLI command:
(host)[mynode] (config)#ha group-membership <ha-group>

VRRP Redundancy for Multi-Master Topologies

The term controller in this section refers to stand-alone controllers running ArubaOS 8.0.

The master controller in the Aruba user-centric network acts as a single point of configuration for global policies
such as firewall policies, authentication parameters, and RF configuration to ease the configuration and
maintenance of a wireless network. It also maintains a database related to the wireless network that you can
use to make adjustments (automated or manual) in reaction to events that cause a change in the environment
(such as an AP becoming unavailable).

The master controller is also responsible for providing the configuration for an AP to complete its boot process.
If the master controller becomes unavailable, the network continues to run without any interruption. However,
any change in the network topology or configuration will require the availability of the master controller.

To maintain a highly redundant network, the administrator can use a controller to act as a hot standby for the
master controller. The underlying protocol used is the same as in master-local redundancy.

ArubaOS supports VRRP-based LMS redundancy in a deployment with master-master redundancy. In the
topology below, when an AP connects to the master controller (M1), the AP receives a standby IP, which it uses
to establish a standby connection to the backup master (M2). If the active master becomes unreachable or
reboots, the backup master changes its VRRP role to master and accepts active AP connections.

When M1 comes back up, it initially acts as a backup master, and APs associated to M2 establish a standby
connection to M1. When the controllers change roles and M1 becomes the active master once again, M2 forces
the APs to use M1 as their active master. If an AP has not established a connection to M1 before it
disassociates from M2, the AP rebootstraps before it reconnects back to M1.



Figure 50 Redundancy with a Active-BackupMaster Controller Pair

When a VRRP instance is configured on the controller VLAN, there would be no change in the VRRP state if the failover
scenario was tested by shutting down the port or bringing down the vlan. The controller remains in the Master state
and sends VRRP advertisements, which do not reach the peer controller. When the port is down, the peer controller
becomes the Master. However, when the port on the previous master is enabled, it takes over the Master state. The
peer controller moves out of the master state when the original master sends a higher priority advertisement, even
when preemption is not enabled. The peer controller will not be preempted if the master controller crashes or
reboots.

Configuring a Primary and Backup Master for Failover Redundancy
You can use either the WebUI or CLI to configure VRRP on the primary and backup master controllers.

In the WebUI
1. In Mobility Master > standalone, navigate to Configuration > Services > Redundancy.

2. Expand the Virtual Router Table, section.

3. Click the + icon to add a new virtual router. The New Virtual Router fields appear.

4. Select the IP version from the IP Version drop-down list.

5. Select the VLAN on which you want to configure VRRP from the VLAN drop-down list.

6. Set Admin State to UP.

7. Specify the priority value in the Priority field. For a backup controller, use the default priority value of 100.
For the primary controller, use the a priority value higher than the default, such as 110.

8. Configure other VRRP parameters as described in Table 119 .

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes
12.Repeat steps 1-11 to configure VRRP on the other controller in the primary and backup redundant pair.
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Parameter Description

ID The ID uniquely identifies this VRRP instance. For ease in administration, you should
configure this with the same value as the VLAN ID.

Description This is an optional text description to describe the VRRP instance.

IP version Select IPv4 \ IPv6 from the drop-down list box.

Authentication
Password

This is an optional password of up to eight characters that can authenticate VRRP
peers in their advertisements. If this is not configured, there is no authentication
password.

Retype authentication
password

Reconfirm the password, if configured.

IP address Based on the selection made in the IP version field, either IP Address \ IPv6 Address is
displayed. This is the virtual IP address that will be owned by the elected VRRP master.
Ensure that the same IP address and VRRP ID is used on each member of the
redundant pair.

Note: The IP address must be unique and cannot be the loopback address of the
controller. A maximum of only two virtual IPv6 addresses can be configured on each
VRRP instance. Only IPv6 address format is supported for the v6 instance.

Priority Priority level of the VRRP instance for the controller. This value is used in the election
mechanism for the master. When configuring VRRP on a local controller, use the
default priority value of 100. For a master controller, use a higher priority value, such
as 110.

Advertisement interval
(secs)

This is the interval, in seconds, between successive VRRP advertisements sent by the
current master. The default interval time is recommended.

Default: 1 second

Enable router Pre-
emption

Selecting this option means that a controller can take over the role of master if it
detects a lower priority controller currently acting as master.

Pre-emption delay
(secs)

Specifying a value enables the delay timer. The timer is triggered when the VRRP
state moves out of backup or init state to become a master. This is applicable only if
you enable router pre-emption.

When the timer is triggered, it forces VRRP to wait for a specified period of time, so
that all the applications are ready before coming up. This prevents the APs from
connecting to the controller before it can receive them. In the meantime, if there is an
advertisement from another VRRP, the VRRP stops the timer and does not transition
to master.

Admin state Administrative state of the VRRP instance. To start the VRRP instance, change the
admin state to UP in the WebUI.

VLAN VLAN on which the VRRP protocol runs.

Table 119: VRRP Configuration Parameters



Parameter Description

Tracking master up-
time

(Optional) Perform VRRP priority tracking based on how long the controller has been
the master. This feature iis designed to ensure that a master will only be allowed to
take and maintain control of the VRRP if it has been up for a certain amount of
minutes (0-1440). This prevents an issue where a device that is periodically going up
and down assumes the role of primary master.

NOTE: For more information on VRRP master tracking, see VRRP Redundancy for
Multi-Master Topologies on page 588 .

Tracking master up-time
priority

(Optional) The additional priority given to the master once it has been up for the time
interval defined by the Tracking Master Up-time parameter.

Tracking VRRP master
state ID

(Optional) Perform tracking based on the UP or DOWN state of another VRRP master
by specifing the the VRRP ID of the master to be tracked.

Tracking VRRP master
state priority

(Optional) The priority taken away from a VRRP master if it is in a DOWN state. The
priority levels are returned to their previous state when the VRRP master comes back
up.

NOTE: For more information on VRRP master tracking, see VRRP Redundancy for
Multi-Master Topologies on page 588 .

Tracking VLAN (Optional) Perform VRRP priority tracking based on the UP or DOWN state of a VLAN.
Click the + icon below the Tracking VLAN table and specify the following values:

l VLAN Id: ID of the VLAN to be tracked.

l Subtract: Priority level to be subtracted from the controller's VRRP priority if the
tracked VLAN goes down.

NOTE: For more information on VRRP interface tracking, see VRRP Redundancy for
Multi-Master Topologies on page 588 .

Tracking interface (Optional) Perform VRRP priority tracking based on the UP or DOWN state of a
specific interface . Click the + icon below the Tracking Interface table and specify the
following values:

l Interface: Interface Port to be tracked.

l Subtract: Priority level to be subtracted from the controller's VRRP priority if the
tracked interface goes down.

NOTE: For more information on VRRP interface tracking, seeVRRP Redundancy for
Multi-Master Topologies on page 588 .

Table 119: VRRP Configuration Parameters

In the CLI
Execute the following commands to configure a new virtual router:
(host) [mynode] (config) #vrrp <id>

(host) [mynode] (config-submode)#ip address <ip-address>

(host) [mynode] (config-submode)#vlan <vlanID>

(host) [mynode] (config-submode)#priority <0-255>

Configuring APs to use the VRRP IP
Configure the APs associated with the master controller to terminate their tunnels on the VRRP virtual-IP
address . To specify the controller to which an AP or AP group tunnels client traffic, you configure the LMS IP in
the AP system profile on the master controller.
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This configuration must be executed on the master controller; the APs obtain their configuration from the master
controller.

In the WebUI
Follow the procedure below to configure VRRP on an AP system profile:

1. In Mobility Master > standalone, navigate to Configuration > System > Profiles.

2. In All Profiles > AP, expand AP system.

3. Select the AP system profile for which you want to configure VRRP.

4. Click the LMS Settings accordion and enter the virtual IP address into the LMS IP field.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

Follow the procedure below to configure VRRP for an AP group:

1. In Mobility Master > standalone, navigate to Configuration > AP Groups.

2. Select the More tab from the selected AP group table.

3. Enter the virtual IP address into the LMS IP address field. For IPv6 address, enter the value in the LMS
IPv6 address field.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Execute the following commands to configure VRRP on an AP system profile and apply it to an AP profile and
an AP group:
(host) [mynode] (config) #ap system-profile <profile-name>

(host) [mynode] (AP system profile "<profile-name>") #lms-ip <ip-address>

(host) [mynode] (AP system profile "<profile-name>") #ap-name <ap-profile-name>

(host) [mynode] (AP name "<ap-profile-name>") #ap-system-profile <profile-name>

(host) [mynode] (AP name "<ap-profile-name>") #exit

(host) [mynode] (config) #ap-group <ap-group-name>

(host) [mynode] (AP group "<ap-group-name>") #ap-system-profile <profile-name>

If DNS resolution is the chosen mechanism for the APs to discover their master controller, ensure that the
name “aruba-master” resolves to the same virtual IP address configured as a part of the master redundancy.

Configuring Database Synchronization
In a redundant master controller scenario, you can configure a redundant pair to synchronize their WMS and
local user databases. You can either manually or automatically synchronize the databases.

When manually synchronizing the database, the active VRRP master synchronizes its database with the
standby. The command takes effect immediately.

When configuring automatic synchronization, you set how often the two controllers synchronize their
databases. To ensure successful synchronization of database events, you should set periodic synchronization
to a minimum period of 20 minutes.

In the WebUI
1. In Mobility Master > standalone, navigate to the Configuration > Services > Redundancy page.

2. Under Master Redundancy, do the following:



a. Select Enabled in the Database synchronization drop-down list. This enables database
synchronization.

b. Enter the frequency of synchronizing the databases in the Sync period field. A minimum value of 20
minutes is recommended.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands to configure database synchronization.
(host) [mynode] (config) #database synchronize period

To view the database synchronization settings on the controller, use the following command:
(host) [mynode] #show database synchronize

Migrating from VRRP or Backup-LMS Redundancy
High Availability: Fast Failover provides redundancy for APs, but not for controllers. Deployments that require
master controller redundancy should continue to use an existing VRRP redundancy solution. If your
deployment currently uses a backup-LMS or VRRP redundancy solution, use the following procedures to
migrate to a High-Availability-based solution. For more information on this topology, see High Availability
Overview on page 581.

Migrating from VRRP Redundancy
Perform the following steps to migrate from VRRP to High-Availability redundancy:

1. Remove the VRRP IP address as the LMS IP address of the AP.
(host)[mynode](AP system profile) #no lms-ip

2. Configure the AP to use the active controller’s IP address (not VRRP the IP address) as the LMS-IP for the AP.
(host)[mynode](AP system profile) #lms-ip <ipaddress>

3. Configure the AP to use the standby controller IP address (not VRRP the IP address) as the backup LMS-IP
for the AP.
(host)[mynode](AP system profile) #bkup-lms-ip <ipaddress>

4. Configure the master controller with a dual role in the high-availability group profile.
(host)[mynode](config) #ha group-profile grp1

(host)[mynode](HA group information "grp1"): controller <ipaddress> role dual

5. Configure the standby controller with a dual role in the high-availability group profile.
(host)[mynode](HA group information "grp1"): controller <ipaddress> role dual

Migrating from Backup-LMS Redundancy
Perform the following steps to migrate from Backup-LMS to High-Availability redundancy and maintain the
existing configuration as defined by the lms-ip and bkup-lms-ip parameters in the AP system profile.

1. Configure the controller serving the AP with a dual role in the high-availability group profile.
(host)[mynode](config) #ha group-profile grp1

(host) (HA group information "grp1"): controller <ipaddress> role dual

2. Configure the AP’s standby controller with a dual role in the high-availability group profile.
(host)[mynode](HA group information "grp1"): controller <ipaddress> role dual
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Chapter 28
IP Mobility

Amobility domain is a group of Aruba managed devices among which wireless users can roam without losing
their IP address. Mobility domains are not tied with the Mobility Master; thus, it is possible for a user to roam
between managed devices as long as all the managed devices belong to the same Mobility Master.

You enable and configure mobility domains only on Aruba managed devices. No additional software or
configuration is required on wireless clients to allow roaming within the domain.

Topics in this chapter include:

l Understanding Aruba Mobility Architecture on page 594

l Configuring Mobility Domains on page 595

l Tracking Mobile Users on page 597

l Configuring Advanced Mobility Functions on page 599

l Understanding Bridge Mode Mobility Deployments on page 608

l Monitoring Network Traffic Using IPFIX on page 609

l Enabling Mobility Multicast on page 612

Understanding Aruba Mobility Architecture
Aruba’s layer-3 mobility solution is based on the Mobile IP protocol standard, as described in RFC 3344, IP
Mobility Support for IPv4. This standard addresses users who need both network connectivity and mobility
within the work environment.

Unlike other layer-3 mobility solutions, an Aruba mobility solution does not require that you install mobility
software or perform additional configuration on wireless clients. The Aruba managed devices perform all
functions that enable clients to roam within the mobility domain.

In a mobility domain, amobile client is a wireless client that can change its point of attachment from one
network to another within the domain. A mobile client receives an IP address (a home address) on a home
network.

A mobile client can detach at any time from its home network and reconnect to a foreign network (any network
other than the mobile client’s home network) within the mobility domain. When a mobile client is connected to
a foreign network, it is bound to a care-of address that reflects its current point of attachment. A care-of
address is the IP address of the Aruba managed device in the foreign network with which the mobile client is
associated.

The home agent for the client is the managed device at which the client appears for the first time upon joining
the mobility domain. The home agent is the single point of contact for the client when the client roams. The
foreign agent for the client is the managed device which handles all Mobile IP communication with the home
agent on behalf of the client. Traffic sent to a client’s home address is intercepted by the home agent and
tunneled for delivery to the client on the foreign network. On the foreign network, the foreign agent delivers
the tunneled data to the mobile client.

Figure 51 shows the routing of traffic from Host A to Mobile Client B when the client is away from its home
network. The client’s care-of address is the IP address of the Aruba managed device in the foreign network.

The numbers in the Figure 51 correspond to the following descriptions:

1. Traffic to Mobile Client B arrives at the client’s home network via standard IP routing mechanisms.
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2. The traffic is intercepted by the home agent in the client’s home network and tunneled to the care-of
address in the foreign network.

3. The foreign agent delivers traffic to the mobile client.

4. Traffic sent by Mobile Client B is also tunneled back to the home agent.

Figure 51 Routing of Traffic to Mobile Client within Mobility Domain

Configuring Mobility Domains
Before configuring a mobility domain, you should determine the user VLAN(s) for which mobility is required.
For example, you may want to allow employees to be able to roam from one subnetwork to another. All
Managed devices that support the VLANs into which employee users can be placed should be part of the same
mobility domain.

Aruba mobility domains are supported only on Aruba managed devices.

A managed device can be part of multiple mobility domains, although it is recommended that a managed
device belong to only one domain. The managed device in a mobility domain do not need to be managed by
the same Mobility Master.

You configure a mobility domain on a Mobility Master; the mobility domain information is pushed to all
managed device that are managed by the Mobility Master. On each managed device, you must specify the
active domain (the domain to which the managed device belongs). If you do not specify the active domain, the
managed device will be assigned to a predefined “default” domain.

The basic tasks you need to perform to configure a mobility domain are listed below. The sections following
describe each task in further detail. A sample mobility domain configuration is provided in on page 597.

On a Mobility Master: On all managed device in the mobility domain:

l Configure the mobility domain,
including the entries in the home agent
table (HAT)

l Enable mobility (disabled by default)

l Join a specified mobility domain (not required for “default”
mobility domain)

Table 120: Tasks to Configure a Mobility Domain

You can enable or disable IP mobility in a virtual AP profile (IP mobility is enabled by default). When you enable
IP mobility in a virtual AP profile, the ESSID that is configured for the virtual AP supports layer-3 mobility. If you
disable IP mobility for a virtual AP, any clients that associate to the virtual AP will not have mobility service.



Configuring a Mobility Domain
You configure mobility domains on Mobility Master. All managed devices managed by the Mobility Master
share the list of mobility domains configured on the Mobility Master. Mobility is disabled by default and must
be explicitly enabled on all managed devices that will support client mobility. Disabling mobility does not delete
any mobility related configuration.

The home agent table (HAT) maps a user VLAN IP subnet to potential home agent addresses. When you enable
mobility the managed device to which the client connects for the first time becomes its home agent. The
mobility feature uses the HAT table to locate a potential home agent for each mobile client, and then uses this
information to perform home agent discovery. To configure a mobility domain, you must assign a home agent
address to at least one managed device with direct access to the user VLAN IP subnet. (Some network
topologies may require multiple home agents.)

It is recommended that you configure the switch IP address to match the AP’s managed device, or define the
Virtual Router Redundancy Protocol (VRRP) IP address to match the VRRP IP used for managed device
redundancy. Do not configure both a switch IP address and a VRRP IP address as a home agent address, or
multiple home agent discoveries may be sent to the managed device.

All user VLANs that are part of a mobility domain must have an IP address that can correctly forward layer-3
broadcast multicast traffic to clients when they are away from the home network.

The mobility domain named “default” is the default active domain for all managed devices. If you need only
one mobility domain, you can use this default domain. However, you also have the flexibility to create one or
more user-defined domains to meet the unique needs of your network topology. Once you assign a managed
device to a user-defined domain, it automatically leaves the “default” mobility domain. If you want a managed
device to belong to both the “default” and a user-defined mobility domain at the same time, you must explicitly
configure the “default” domain as an active domain for the managed device.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services page. Select the IP

Mobility tab.

2. Click Mobility Domain accordion. Select Enabled for the Enable IP Mobility drop-down list.

3. To configure the default mobility domain, select the default domain in the IP Mobility Configuration
table.

4. To create a new mobility domain, click + in the IP Mobility Configuration table. Enter the Name and
Description in the Create IP Mobility table. Click Submit.

5. Select the newly-created domain name and click +in the IP Mobility Configuration table. The Home
Agent table is displayed.

6. Click + in the Home Agent table. A Create Home Agent table is displayed.

7. Enter the IP and the Description in the Create Home Agent table.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#router mobile

(host) [mynode] (config)#ip mobile domain <name>

(host) [mynode] (config-submode)#hat <home-agent> description <dscr>

To view currently-configured mobility domains in the CLI, use the show ip mobile domain command.
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Ensure that the ESSID to which the mobile client will connect supports IP mobility. You can disable IP mobility
for an ESSID in the virtual AP profile (IP mobility is enabled by default). If you disable IP mobility for a virtual
AP, any client that associates to the virtual AP will not have mobility service.

Joining a Mobility Domain
Assigning a managed device to a specific mobility domain is the key to defining the roaming area for mobile
clients. You should take extra care in planning your mobility domains and survey the user VLANs and managed
device to which clients can roam, to ensure that there are no roaming holes.

All managed device are initially part of the “default” mobility domain. If you use the default mobility domain,
you do not need to specify this domain as the active domain on a managed device. However, once you assign a
managed device to a user-defined domain, the default mobility domain is no longer an active domain on the
managed device.

In the WebUI
1. In a Managed Network node hierarchy, navigate to the Managed Networks > Configuration >

Services page. Select the IP Mobility tab.

2. Click Mobility Domain accordion. Select a Domain Name from the IP Mobility Configuration table.

3. Select Enabled for the Active drop-down list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following command to activate a mobility domain:
(host) [mynode] (config)#ip mobile active-domain <name>

To view the active domains in the CLI, use the show ip mobile active-domains command on the managed
device.

Tracking Mobile Users
This section describes how you can view information about the status of mobile clients in the mobility domain.

Location-related information for users, such as roaming status, AP name, ESSID, BSSID, and physical type are
consistent in both the home agent and foreign agent. The username, role, and authentication can be different
on the home agent and foreign agent, as explained by the following:

L2 GRE tunnels are automatically established between managed devices in mobility domain at the time of boot
up. Whenever a client connects to a managed device in a mobility domain, layer-2 authentication is performed
and the station obtains the layer-2 (logon) role. When the client roams to other networks, layer-2
authentication is performed and the client obtains the layer-2 role. If layer-3 authentication is required, this
authentication is performed on the client’s home agent only. The home agent obtains a new role for the client
after layer-3 authentication; this new role appears in the user status on the home agent only. Even if
reauthentication occurs after the station moves to a foreign agent, the display on the foreign agent still shows
the layer-2 role for the user.

Mobile Client Roaming Status
You can view the list of mobile clients and their roaming status on any managed device in the mobility domain:



In the CLI
#show ip mobile host

Roaming status can be one of the following:

Roaming
Status Type Description

Home Switch/Home
VLAN

This managed device is the home agent for a station, and the client is on the VLAN
on which it has an IP address.

Mobile IP Visitor This managed device is not the home agent for a client.

Mobile IP Binding
(away)

This managed device is the home agent for a client that is currently away.

Home
Switch/Foreign VLAN

This managed device is the home agent for a client, but the client is currently on a
different VLAN than its home VLAN (the VLAN from which it acquired its IP
address).

Stale The client does not have connectivity in the mobility domain. Either the managed
device has received a disassociation message for a client, but has not received an
association or registration request for the client from another managed device, or
a home agent binding for the station has expired before being refreshed by a
foreign agent.

No Mobility Service The managed device cannot provide mobility service to this client. The mobile
client may lose its IP address if it obtains the address via DHCP and has limited
connectivity. The mobile client may be using an IP address that cannot be served,
or there may be a roaming hole due to improper configuration.

Table 121: Client Roaming Status

Viewing User Roaming Status using the CLI
You can view the roaming status of users on any managed device in the mobility domain:
#show user

Roaming status can be one of the following:

Status Type Description

Wireless This client is on its home agent managed device and the client is on the VLAN on
which it has an IP address.

Visitor This client is visiting this managed device and the managed device is not its home
agent.

Away This client is currently away from its home agent managed device.

Table 122: User Roaming status
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Status Type Description

Foreign VLAN This client is on its home agent managed device but the client is currently on a
different VLAN than the one on which it has an IP address.

Stale This should be a temporary state as the client will either recover connectivity or
the client’s entry is deleted when the stale timer expires.

In the CLI
#show ip mobile trace <ip-address>|<mac-address>

Mobile Client Roaming Locations
You can view information about where a mobile user has been in the mobility domain. This information can
only be viewed on the client’s home agent using the following comamnd:
show ip mobile trail <ip-address>|<mac-address>

HA Discovery on Association
In normal circumstances, a managed device performs an HA discovery only when it is aware of the client’s IP
address which it learns through the ARP or any L3 packet from the client. This limitation of learning the client’s
IP and then performing the HA discovery is not effective when the client performs an inter switch move silently
(does not send any data packet when in power save mode). This behavior is commonly seen with various
handheld devices, Wi-Fi phones and so on. This delays HA discovery and eventually results in any loss of
downstream traffic that is meant for the mobile client.

When HA discovery on association is triggered, the foreign agent managed device to which the client is
associated, sends a unicast request to all managed device within the mobility domain to find if any one of the
managed device has the IP mobility state information of the client.

With HA discovery on association, a managed device can perform a HA discovery as soon as the client is
associated. This feature is enabled by default. This option will also poll for all potential HAs.

In the CLI
To configure the mobility association:
wlan virtual-ap default ha-disc-onassoc

Configuring Advanced Mobility Functions
You can configure various parameters that pertain to mobility functions on a managed device in a mobility
domain using either the WebUI or the CLI.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services and select the IP Mobility

tab.

2. Click Global Parameters accordion and configure the IP mobility settings.



Parameter Description

General

Encapsulation
supported

This parameter shows the type of encapsulation currently supported on the
Managed device.

Clear trail entries Clear the station location trail table. You can view entries in this table using the
show ip mobile trail command.

Clear mobility
counters

Clear counters for IP mobility statistics.

Foreign Agent

Lifetime Requested lifetime, in seconds, as per RFC 3344, IP Mobility Support for IPv4.

Range: 10-65534 seconds

Default: 180 seconds

Max. visitors allowed Set a maximum allowed number of active visitors.

Range: 0-5000 visitors

Default: 5000 visitors

Registration requests
retransmits

Maximum number of times the foreign agent attempts mobile IP registration
message exchanges before giving up.

Range: 0-5 attempts

Default: 3 attempts

Registration requests
interval

Retransmission interval, in milliseconds.

Range: 100-10000 milliseconds

Default: 1000 milliseconds

Home Agent

Replay Time difference, in seconds, for timestamp-based replay protection, as
described by RFC 3344, IP Mobility Support for IPv4. 0 disables replay.

Range: 0-5000 seconds

Default: 5000 seconds.

Max. binding allowed Maximum number of mobile IP bindings. Note that there is a license-based limit
on the number of users and a one user per binding limit in addition to unrelated
users. This option is an additional limitation to control the maximum number of
roaming users. When the limit is reached, registration requests from the foreign
agent fail which causes a mobile client to set a new session on the visited
managed device, which will become its home managed device.

Table 123: IP Mobility - Global Parameters
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Parameter Description

Range: 0-300 seconds

Default: 7 seconds

Proxy Mobile IP

Mobility trail logging Enables logging at the notification level for mobile client moves.

Max. station mobility
events per second

Maximum number of mobility events (events that can trigger mobility) handled
per second. Mobility events above this threshold are ignored. This helps to
control frequent mobility state changes when the client bounces back and forth
on APs before settling down.

Range: 1-65535 events

Default: 25 events

Station trail timeout Specifies the maximum interval, in seconds, an inactive mobility trail is held.

Range: 120-86400 seconds

Default: 3600 seconds

Station trail max.
entries

Specifies the maximum number of entries (client moves) stored in the user
mobility trail.

Range: 1-100 entries

Default: 30 entries.

Mobility host entry
hold time

Number of seconds the mobility state is retained after the loss of connectivity.
This allows authentication state and mobility information to be preserved on the
home agent managed device. The default is 60 seconds but can be safely
increased. In many case a station state is deleted without waiting for the stale
timeout; user delete from management, foreign agent to foreign agent handoff,
and so on. (This is different from the no-service-timeout; no-service-timeout
occurs up front, while the stale-timeout begins when mobility service is provided
but the connection is disrupted for some reason.)

Mobility host entry
lifetime

Time, in seconds, after which mobility service expires. If nothing has changed
from the previous state, the client is given another bridge entry but it will have
limited connectivity.

Revocation

Retransmits Maximum number of times the home agent or foreign agent attempts mobile IP
registration/revocation message exchanges before giving up.

Range: 0-5 retransmissions

Default: 3 retransmissions.

Interval Retransmission interval, in milliseconds.

Range: 100-10000 milliseconds

Default: 1000 milliseconds



3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To configure foreign agent functionality, use the following command:
(host) [mynode] (config)#ip mobile foreign-agent {lifetime <seconds> | max-visitors <number> |

registrations {interval <msecs> | retransmits <number>}}

To configure home agent functionality, use the following command:
(host) [mynode] (config)#ip mobile home-agent {max-bindings <number>|replay <seconds>}

To configure proxy mobile IP and DHCP functionality, use the following command:
(host) [mynode] (config)#ip mobile proxy auth-sta-roam-only | block-dhcp-release | event-

threshold <number> | log-trail | no-service-timeout <seconds> | on-association | refresh-

stale-ip | stale-timeout <seconds> | stand-alone-AP | trail-length <number> |trail-timeout

<seconds>

To configure revocation functionality, use the following command:
(host) [mynode] (config)#ip mobile revocation {interval <msec>|retransmits <number>

To enable packet trace for a given MAC address, use the following command:
(host) [mynode] (config)#ip mobile packet-trace <host MAC address>

Proxy Mobile IP
The proxy mobile IP module in a mobility-enabled managed device detects when a mobile client has moved to a
foreign network and determines the home agent for a roaming client. The proxy mobile IP module performs
the following functions:

l Derives the address of the home agent for a mobile client from the HAT using the mobile client’s IP address.
If there is more than one possible home agent for a mobile client in the HAT, the proxy mobile IP module
uses a discovery mechanism to find the current home agent for the client.

l Detects when a mobile client has moved. Client moves are detected based on ingress port and VLAN
changes, and mobility is triggered accordingly. For faster roaming convergence between AP(s) on the same
managed device, it is recommended that you keep the on-association option enabled. This helps trigger
mobility as soon as 802.11 association packets are received from the mobile client.

Revocations
A home agent or foreign agent can send a registration revocation message, which revokes registration service
for the mobile client. For example, when a mobile client roams from one foreign agent to another, the home
agent can send a registration revocation message to the first foreign agent so that the foreign agent can free
any resources held for the client.

IPv6 L3 Mobility
ArubaOS supports IPv6 L3 Mobility functionality. The existing L3 mobility solution has been enhanced to
support dual stacked (IPv4 and IPv6) and pure IPv6 mobile clients. The IPv6 L3 mobility allows the wireless
clients to retain their IPv4 or IPv6 addresses across different VLANs within a managed device and between
different managed devices. In the previous release, the Aruba Managed devices supported L3 mobility only for
single stacked IPv4 clients.
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The following changes in the existing behavior is observed in the Aruba managed device when you enable IPv6
L3 Mobility support :

l The managed device throttles and proxies Router Advertisements (RAs) if the router mobile command is
enabled.

The following command configures the maximum time allowed between sending unsolicited multicast router
advertisements from each interface when RA proxy is enabled:
(host) [mynode] (config)# ipv6 proxy-ra interval <180-1800>

The default value for proxy-ra interval is 600 seconds. If RA is configured on an external router, but not within
the managed device, the managed device stores the RA in cache and replays the RA from the external server
and replays them every proxy-ra interval. If RA is configured in both an external router and in the managed
device, clients serviced by the managed device receive RA only from the managed device and not from the
external router.

l L3 mobility support for wired and third-party APs are deprecated.

l The HA discovery on association parameter is turned on by default and is not configurable.

By enabling L3 mobility feature, both the solicited RAs and the unsolicited periodic RAs will be converted to L2 unicast
and sent to the wireless clients.

It is recommended to reboot the managed device when you issue the no router mobile command so that mutlicast
RAs do not continue to get converted to unicast RAs.

Multicast Mobility
Multicast mobility ensures a client gets an uninterrupted multicast stream while roaming. ArubaOS provides
support for a MLD proxy to enable IPv6 multicast mobility. To achieve multicast mobility, the Home Agent (HA)
and the Foreign Agent (FA) must be capable of MLD proxying by exchanging the MLD membership information
and process MLD messages. ArubaOS managed device supports MLD versions v1 and v2.

Important Points to Remember
l ArubaOS does not support the source-based forwarding functionality of MLDv2.

l The multicast traffic flow stops for few seconds for roaming clients after enabling or disabling the Dynamic
Multicast Optimization (DMO) option.

In the CLI
Use the following command to enable MLD proxy in the VLAN:
(host)[mynode](config)# interface vlan <vlan-id>

(host)[mynode](config-subif)# ipv6 mld proxy <gigabitethernet/fastethernet> <slot/module/port>

Use the following command to display the interface-specific MLD proxy group information:
(host) [mynode] #show ipv6 mld proxy-group

Use the following command to display the MLD proxy mobility database group information for tracking:
(host) [mynode] #show ipv6 mld proxy-mobility-group

Use the following command to display the statistics of the MLD proxy:
(host) [mynode] #show ipv6 mld proxy-stats

Use the following command to display the MLD proxy mobility multicast statistics:
(host) [mynode]# show ipv6 mld proxy-mobility-stats

The following command displays the discovery count table that keeps track of per client home agent discovery:



(host) [mynode] #show datapath mobility discovery-table

The following command displays the datapath HA table information:
(host) [mynode] #show datapath mobility home-agent-table

The following command displays the mobility multicast-group table that floods the multicast RA traffic to the
roaming clients:
(host) [mynode] #show datapath mobility mcast-table

The following commands displays the statistics of the datapath mobility:
(host) [mynode] #show datapath mobility stats

The following command displays the mobility multicast VLAN table information:
(host) [mynode] #show ip mobile multicast-vlan-table

The outputs of the following commands are enhanced to support IPv6 L3 mobility:

l how ip mobile host

l show ip mobile trace

l show ip mobile remote

l show ip mobile binding

l show ip mobile visitor

l show ip mobile trail

l show ip mobile packet-trace

l clear ip mobile trail <IPv6_addr>

l show ip mobile traffic

l show ip mobile global

l show ip mobile hat

l show ip mobile domain

l ip mobile domain <name> hat <home-agent> description <dscr>

Sample Configuration

The following figure provides information on how a client moves from one managed device to another, when
you enable IPv6 L3 mobility feature:
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Figure 52 Sample IPv6 L3Mobility Configuration

The following commands displays the initial configuration on HA and FA:
(host-HA) #show ip mobile domain

Mobility Domains:, 2 domain(s)

------------------------------

Domain name default

Home Agent Table

Domain name 6.3mobility

Home Agent Table

Home Agent Description

--------------- ----------------

10.15.45.10

10.15.44.60

(host-FA) #show ip mobile domain

Mobility Domains:, 2 domain(s)

------------------------------

Domain name default

Home Agent Table

Domain name 6.3mobility

Home Agent Table

Home Agent Description

--------------- ----------------

10.15.45.10

10.15.44.60

The following commands displays information on the client association to HA:



(host-HA) #show user

Users

-----

IP MAC Name Role Age(d:h:m) Auth VPN l

ink AP name Roaming Essid/Bssid/Phy Profile Forward mode

Type Host Name

---------- ------------ ------ ---- ---------- ---- -

------- ------- ------- --------------- ------- --------

---- ---- -

50.50.50.11 24:77:03:9e:dc:4c authenticated 00:00:00

AP124-B11550-Jibin Wireless mobility-test/00:1a:1e:82:b3:10/a-HT default tunnel

2001:5000::2677:3ff:fe9e:dc4c 24:77:03:9e:dc:4c authenticated 00:00:00

AP124-B11550-Jibin Wireless mobility-test/00:1a:1e:82:b3:10/a-HT default tunnel

fe80::2677:3ff:fe9e:dc4c 24:77:03:9e:dc:4c authenticated 00:00:00

AP124-B11550-Jibin Wireless mobility-test/00:1a:1e:82:b3:10/a-HT default tunnel

(host-HA) #show ip mobile host

Mobile Host List, 1 host(s)

---------------------------

24:77:03:9e:dc:4c

IPv4: 50.50.50.11

IPv6: fe80::2677:3ff:fe9e:dc4c, 2001:5000::2677:3ff:fe9e:dc4c

Roaming Status: Home Switch/Home VLAN, Service time 0 days 00:00:57

Home VLAN 50

(host-HA) #show datapath bridge table 24:77:03:9e:dc:4c

Datapath Bridge Table Entries

-----------------------------

Flags: P - Permanent, D - Deny, R - Roamed Client, M - Mobile, X - Xsec, A - Auth, O - Outer V

LAN, T - Trusted

MAC VLAN Assigned VLAN QinQ VLAN Destination Flags

----------------- ---- ------------- --------- ----------- -----

24:77:03:9E:DC:4C 50 50 0 tunnel 17 PM

(host-HA) #show datapath station

Datapath Station Table Entries

------------------------------

Flags: W - WEP, T - TKIP, A - AESCCM, M - WMM N - .11n client

S - AMSDU, G - AESGCM, R - DATA READY, I - INACTIVE, r - ROAMED

MAC BSSID VLAN Bad Decrypts Bad Encrypts Cpu Qsz RSN cap Aid HomeVlan

Flags

----------------- ----------------- ---- ------------ ------------ --- -------- ------- ---- -

------- -----

24:77:03:9E:DC:4C 00:1A:1E:82:B3:10 50 0 0 8 0 0 0 0 0000 0001

50 MN

The following commands displays status of the client roaming to FA:
(host-FA) #show ap association

Association Table

-----------------

Name bssid mac auth assoc aid l-int essid vlan-i

d tunnel-id phy assoc. time num assoc Flags Band steer moves (T/S)

---- ----- --- ---- ----- --- ----- ----- ------

- --------- --- ----------- --------- ----- ----------------------

Ap_local 6c:f3:7f:3a:ba:d8 24:77:03:9e:dc:4c y y 1 100 mobility-test 60

0x1000f a-HT-40sgi-2ss 3m:20s 1 WA 0/0
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(host-FA) #show user

Users

-----

IP MAC Name Role Age(d:h:m) Aut

h VPN link AP name Roaming Essid/Bssid/Phy Profile Forward mode T

ype Host Name

---------- ------------ ------ ---- ----------

---- -------- ------- ------- --------------- ------- ------------

---- --

50.50.50.11 24:77:03:9e:dc:4c sys_mip_role_649130_9 00:00:03

Ap_local Visitor mobility-test/6c:f3:7f:3a:ba:d8/a-HT default tunnel

Win 7

2001:5000::2677:3ff:fe9e:dc4c 24:77:03:9e:dc:4c sys_mip_role_649130_9 00:00:03

Ap_local Visitor mobility-test/6c:f3:7f:3a:ba:d8/a-HT default tunnel

Win 7

User Entries: 2/2

Curr/Cum Alloc:1/7 Free:1/6 Dyn:2 AllocErr:0 FreeErr:0

(host-FA) #show ip mobile host

Mobile Host List, 1 host(s)

---------------------------

24:77:03:9e:dc:4c

IPv4: 50.50.50.11

IPv6: 2001:5000::2677:3ff:fe9e:dc4c

Roaming Status: Mobile IP Visitor, Service time 0 days 00:03:33

Home VLAN 50, visiting local VLAN 60

(host-FA) #show datapath bridge table 24:77:03:9e:dc:4c

Datapath Bridge Table Entries

-----------------------------

Flags: P - Permanent, D - Deny, R - Roamed Client, M - Mobile, X - Xsec, A - Auth, O - Outer V

LAN, T - Trusted

MAC VLAN Assigned VLAN QinQ VLAN Destination Flags

----------------- ---- ------------- --------- ----------- -----

24:77:03:9E:DC:4C 4095 60 0 tunnel 15 PMR

24:77:03:9E:DC:4C 60 60 0 tunnel 15 PM

(host-FA) #show datapath station

Datapath Station Table Entries

------------------------------

Flags: W - WEP, T - TKIP, A - AESCCM, M - WMM N - .11n client

S - AMSDU, G - AESGCM, R - DATA READY, I - INACTIVE, r - ROAMED

MAC BSSID VLAN Bad Decrypts Bad Encrypts Cpu Qsz RSN cap Aid HomeVlan

Flags

----------------- ----------------- ---- ------------ ------------ --- -------- ------- ---- -

------- -----

24:77:03:9E:DC:4C 6C:F3:7F:3A:BA:D8 60 0 0 7 0 0 0 0 0000 0001

50 MNr

(host-FA) #show ip mobile visitor

Foreign Agent Visitor list, 1 host(s)

-------------------------------------

24:77:03:9e:dc:4c

IPv4: 50.50.50.11

IPv6: 2001:5000::2677:3ff:fe9e:dc4c

HA Addr 10.15.44.60, Registration id D51BA8BC:856865FC

Lifetime granted 00:00:40 (40), remaining 00:00:36

Tunnel id 9, src 10.15.44.10 dest 10.15.44.60, reverse-allowed

The following command displays the status of the client on HA after roaming:



(host-HA) #show user

Users

-----

IP MAC Name Role Age(d:h:m) Auth VPN l

ink AP name Roaming Essid/Bssid/Phy Profile Forward mode Type Hos

t Name

---------- ------------ ------ ---- ---------- ---- -

------- ------- ------- --------------- ------- ------------ ----

---------

50.50.50.11 24:77:03:9e:dc:4c authenticated 00:00:08

Ap_local Away mobility-test/6c:f3:7f:3a:ba:d8/a-HT default tunnel

2001:5000::2677:3ff:fe9e:dc4c 24:77:03:9e:dc:4c authenticated 00:00:08

Ap_local Away mobility-test/6c:f3:7f:3a:ba:d8/a-HT default tunnel

User Entries: 2/2

Curr/Cum Alloc:1/16 Free:1/15 Dyn:2 AllocErr:0 FreeErr:0

(host-HA) #show ip mobile host

Mobile Host List, 1 host(s)

---------------------------

24:77:03:9e:dc:4c

IPv4: 50.50.50.11

IPv6: 2001:5000::2677:3ff:fe9e:dc4c

Roaming Status: Mobile IP Binding (Away), Service time 0 days 00:08:20

Home VLAN 50

(host-HA) #show datapath bridge table 24:77:03:9e:dc:4c

Datapath Bridge Table Entries

-----------------------------

Flags: P - Permanent, D - Deny, R - Roamed Client, M - Mobile, X - Xsec, A - Auth, O - Outer V

LAN, T - Trusted

MAC VLAN Assigned VLAN QinQ VLAN Destination Flags

----------------- ---- ------------- --------- ----------- -----

24:77:03:9E:DC:4C 4095 50 0 tunnel 9 PMT

24:77:03:9E:DC:4C 50 50 0 tunnel 9 PMTR

(host-HA) #show ip mobile binding

Home Agent Binding list, 1 host(s)

----------------------------------

24:77:03:9e:dc:4c

IPv6: 2001:5000::2677:3ff:fe9e:dc4c

FA Care-of Addr 10.15.44.10, Src Addr 10.15.44.10, HAT HA Addr 10.15.44.60

FA Visiting VLAN 60

Lifetime granted 00:00:40 (40), remaining 00:00:23

Flags T, Registration id D51BA8BC:856865FC

Tunnel id 9, src 10.15.44.60 dest 10.15.44.10, reverse-allowed

Understanding Bridge Mode Mobility Deployments
In bridge mode deployments, it is possible to deploy more than one AP in a single location. Therefore, APs in
bridge forwarding mode support firewall session synchronization, which allows clients to retain their current
session and IP address as they roam between different bridge mode APs on the same layer-2 network.

The bridge mode mobility feature facilitates client mobility on up to 32 layer-2 connected APs by allowing the
APs to communicate and share the user state as the user roams from AP to AP. This mechanism is always
enabled when an AP is set to bridge mode, and it requires that all APs be on the same Layer 2 segment where
roaming will occur.
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Figure 53 BridgeModeMobility

The roaming process occurs as follows:

1. A client begins to roam from AP1 and starts an association with AP2.

2. AP2 sends a broadcast message to all APs on the local layer-2 network, asking if any other AP has a current
session state for the roaming client.

3. Only AP1 responds to the broadcast, and sends the current session table of the client.

4. AP2 acknowledges receipt of the session table.

5. AP1 deletes the session state of the client.

6. Roaming is complete.

Monitoring Network Traffic Using IPFIX
IP Flow Information Export (IPFIX) allows clients to easily monitor network traffic to and from the node. This
information is cached on the managed device, then exported to an assigned collector server within the node
once the table is full or the timer has expired. This information is then logged and stored by the collector server
for viewing.

Enabling IPFIX
Before enabling IPFIX, the device must be configured for local management within the node. If the device is
not locally managed, the IPFIX tab will not display in the WebUI.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Click Submit.

4. Click Pending Changes.



5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode] (ip flow collector profile)#enable

Assigning the Collector Device
When a device belonging to a node exports a cache, it is sent to the designated Collector Device in that node.
The Collector Device receives, logs and stores the data from the other devices in the node.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Enter the IP address of the device into the Collector IP address field.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode] (ip flow collector profile)#collector-ip <collector ip address>

Selecting a Transfer Mode
IPFIX supports UDP and TCP transfer protocols when sending a cache from a device to the Collector Device.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Select a transfer protocol from the Transport Mode drop-down list.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode] (ip flow collector profile)# transport-protocol<protocol>

Assigning a Destination Port
Clients can assign a destination port on the Collector Device to direct incoming data caches from other devices
in the node.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Enter the port number into the Port field.
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4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode] (ip flow collector profile)#port <port number>

Modifying the Flow Cache Size and Interval Settings
The Flow Cache limits when the cache is exported to the Collector Device and can be determined by the size of
the cache or the duration of time in the session. When any one of these values is met, the cache is exported
and a new one begins.

l Flow cache size: The maximum number of entries in a cache before it is exported.

l Upload interval (all): The interval (time in minutes) to export active sessions.

l Upload interval (inactive): The interval (time in minutes) to export inactive flows.

l Upload interval template: The interval (time in minutes) to export templates.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Enter the maximum number of entries in the Flow cache size field.

4. Enter the time interval for an active session in the Upload interval (all) field.

5. Enter the time interval for an inactive session in the Upload interval (inactive) field.

6. Enter the time interval to export templates in the Upload interval template field.

7. Click Apply.

In the CLI
The following CLI commands can be used to adjust the Flow cache size and interval export settings.
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode](ip flow collector profile)#flow-cache-size<interger>

(host) [mynode](ip flow collector profile)#upload-all-interval<interger>

(host) [mynode](ip flow collector profile)#upload-inactive-interval<interger>

(host) [mynode](ip flow collector profile)#upload-template-interval<interger>

Selecting the Observation Domain
The Observation Domain is a value used by the Collector Device to group devices when receiving data sessions.

In the WebUI
1. In a Managed Network node hierarchy, navigate to Configuration > Services > External Services and

click on the IPFIX tab to expand the pane.

2. Select Enabled from the Enable IPFIX drop-down list.

3. Enter the value in the Observation Domain field.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.



In the CLI
(host) [mynode] (config)#ip-flow-export-profile

(host) [mynode] (ip flow collector profile)#observation-domain

Enabling Mobility Multicast
Internet Protocol (IP) multicast is a network addressing method used to simultaneously deliver a single stream
of information from one sender to multiple clients on a network. Unlike broadcast traffic, which is meant for all
hosts in a single domain, multicast traffic is sent only to those specific hosts who are configured to receive such
traffic. Clients who want to receive multicast traffic can join a multicast group via IGMP messages. Upstream
routers use IGMP message information to compute multicast routing tables and determine the outgoing
interfaces for each multicast group stream.

When a mobile client moved away from its local network and associated with a VLAN on a foreign managed
device (or a foreign VLAN on its own managed device), the client’s multicast membership information would
not be available at its new destination, and multicast traffic from the client could be interrupted. However,
ArubaOS supports mobility multicast enhancements that provide uninterrupted streaming of multicast traffic,
regardless of a client's location.

Working with Proxy IGMP and Proxy Remote Subscription
The managed device is always aware of the client's location, so the managed device can join multicast group(s)
on behalf of that mobile client. This feature, called Proxy IGMP, allows the managed device to join a multicast
group and suppresses the client’s IGMP control messages to the upstream multicast router. (The client's IGMP
control messages will, however, still be used by managed device to maintain a multicast forwarding table.) The
multicast IGMP traffic originating from the client will instead be sent from the managed device’s incoming
VLAN interface IP.

The IGMP proxy feature includes both a host implementation and a router implementation. An upstream
router sees a managed device running IGMP proxy as a host; a client attached to the managed device sees the
managed device as router. When you enable Proxy IGMP, all multicast clients associated with the managed
device are hidden from the upstream multicast device or router.

The newer IGMP proxy feature and the older IGMP snooping feature cannot be enabled at the same time, as both
features add membership information to multicast group table. For most multicast deployments, you should enable
the IGMP Proxy feature on all VLAN interfaces to manage all the multicast membership requirements on the
managed device. If IGMP snooping is configured on some interfaces, there is a greater chance that multicast
information transfers may be interrupted.

IGMP proxy must be enabled or disabled on each individual interface. To use the IGMP proxy, ensure that the
VLANs on the managed device are extended to the upstream router. Enabling IGMP proxy enables IGMP on
the interface and sets the querier to the managed device itself. You must identify the managed device port
from which the managed device sends proxy join information to the upstream router, and identify the
upstream router by upstream port so the managed device can dynamically update the upstream multicast
router information.

IGMPv3 Support
ArubaOS supports IGMPv3 functionality that makes Aruba managed devices aware of the Source Specific
Multicast (SSM) and is used to optimize bandwidth of the network. The SSM functionality is an extension of IP
multicast where the datagram traffic is forwarded to receivers from only those multicast sources to which the
receivers have explicitly joined. By default, the multicast group range of 232.0.0.0 through 232.255.255.255
(232/8) is reserved for SSM by IANA (Internet Assigned Numbers Authority).
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The IGMPv3 snooping functionality is configured at the edge of the network. The devices that support IGMP
snooping listen for the IGMP messages that the host sent to join an IP multicast group. These devices record
details of all the hosts and also about the IP multicast group in which a particular host has joined. These devices
forward IP multicast traffic to the hosts that have joined the specific multicast group.

The IGMP proxy and IGMP snooping functionalities cannot be enabled on the same VLAN simultaneously.

Configuring SSM Range
You can configure the SSM range by using the CLI and WebUI.

In the WebUI

1. In a Managed Network node hierarchy, navigate to the Configuration > Interfaces page and select the
Multicast tab.

2. In the IGMP accordion , enter values for SSM Range in the SSM range start-ip and SSM range mask-iP
fields.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

The proxy operation will be downgraded to IGMPv2 if any lower version clients are present and reverts back to v3
mode if the managed device finds no lower version client joins (reports) for a specified interval of time. In the
downgraded proxy operation the SSM semantics is not applicable for the particular VLAN.

In the CLI
(host) [mynode] (config) # ip igmp

(host) [mynode] (config-ip)# ssm-range <startip> <maskip>

Working with Inter managed device Mobility
When a client moves from one managed device to another, multicast traffic migrates as follows:



Figure 54 Inter-managed deviceMobility

1. The managed device uses its VLAN 10 IP address to join multicast group1 on behalf of a mobile client.

2. The mobile client leaves its managed device and roams to VLAN 50 remote managed device A.

Remote managed device A locates the mobile client's managed device and learns about the client's multicast
groups. Remote managed device A then joins group1 on behalf the mobile client, using its VLAN 50 source
IP. Upstream multicast traffic from the roaming client is sent to the managed device over an L2 GRE tunnel.
The remote managed device will receive downstream multicast traffic and send it to the mobile client.

The L2-GRE Tunnel implementation of the IP mobility functionality is supported only on ArubaOS versions 6.2 or later,
and is not backward compatible with the earlier implementation. ArubaOS supports only v4 mobility and does not
support IPv6 L3 mobility.

Meanwhile, the managed device checks to see if other local clients require group1 traffic. If no other clients
are interested in group1, then the managed device will leave that group. If there are other clients using that
group, the managed device will continue its group1 membership.

3. Now the mobile client leaves remote managed device A and roams to VLAN 100 on remote managed device
B. Remote managed device B locates the mobile client's managed device and learns about the client's
multicast groups. Remote managed device B then joins group1 on behalf the roaming mobile client 1, using
its VLAN 100 IP address.

Both the managed deviceand remote managed device A will verify if any of their other clients require
group1 traffic. If none of their other clients require group1, then that managed device will leave the group.
(If the managed deviceleaves the group, it will also notify remote managed device A.) If either managed
device has other clients using that group, that managed device will continue its group1 membership.

Configuring Mobility Multicast
To enable IGMP and/or IGMP snooping on this interface, or configure a VLAN interface for uninterrupted
streaming of multicast traffic:
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In the WebUI
1. In a Managed Network node hierarchy, navigate to the Configuration > Interfaces page and select the

VLANs tab.

2. Select the VLAN name from the VLANs table and the VLANs > <VLAN name> table is displayed.

3. Select a VLAN ID you want to configure mobility multicast.

4. Select IPV4 from the table and click IGMP accordion.

5. Select Enabled from the Enable IGMP drop-down list to enable the router to discover the presence of
multicast listeners on directly-attached links

6. Select Enabled from the Enable IGMP Snooping drop-down list to save bandwidth and limit the sending
of multicast frames to only those nodes that need to receive them.

7. Select Enabled from the Enable IGMP Proxy drop-down list

8. In the Proxy Interface field, select the Interface Gigabitethernet or Port Channel option and select
the value from the drop-down list.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

12.(Optional) Repeat steps 1-8 above to configure mobility multicast for another VLAN interface.

In the CLI
(host) [mynode] (config)#interface vlan <vlan>

(host) [mynode] (config-submode)#ip igmp proxy [{port-channel|gigabitethernet}

<slot/module/port>]|[snooping]

Multicast Group Limit
The following table describes the maximum multicast group limit per managed device platform.

Maximum multicast group is the sum of IPv4 IGMP and IPv6 MLD groups.

Platform Multicast Group Limit

7005 128

7010 256

7024 256

7030 512

7200 Series 4096

Table 124: Multicast Group Limits
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Chapter 29
External Firewall Configuration

In many deployment scenarios, an external firewall is situated between Aruba devices. This chapter describes
the network ports that need to be configured on the external firewall to allow proper operation of the Aruba
network. You can also use this information to configure session ACLs to apply to physical ports on the
controller for enhanced security. However, this chapter does not describe requirements for allowing specific
types of user traffic on the network.

A controller uses both its loopback address and VLAN addresses for communications with other network elements. If
the firewall uses host-specific ACLS, those ACLs must specify all IP addresses used on the controller.

Topics in this chapter include:

l Understanding Firewall Port Configuration Among Aruba Devices on page 616

l Enabling Network Access on page 617

l Ports Used for Virtual Intranet Access (VIA) on page 617

l Configuring Ports to Allow Other Traffic Types on page 617

Understanding Firewall Port Configuration Among Aruba Devices
This section describes the network ports that need to be configured on the firewall to allow proper operation
of the network.

Communication Between Controllers
Configure the following ports to enable communication between any two controllers:

l IPsec (UDP ports 500 and 4500) and ESP (protocol 50). PAPI between Mobility Master and a managed
device is encapsulated in IPsec.

l IP-IP (protocol 94) and UDP port 443 if Layer-3 mobility is enabled

l GRE (protocol 47) if tunneling guest traffic over GRE to DMZ controller

l IKE (UDP 500)

l ESP (protocol 50)

l NAT-T (UDP 4500)

Communication Between APs and the Controller
APs use Trivial File Transfer Protocol (TFTP) during their initial boot to grab their software image and
configuration from the controller. After the initial boot, the APs use FTP to retrieve their software images and
configurations from the controller. In many deployment scenarios, an external firewall is situated between
various Aruba devices.

Configure the following ports to enable communication between an AP and the controller:

l PAPI (UDP port 8211). If the AP uses DNS to discover the LMS controller, the AP first attempts to connect
to Mobility Master. (Also allow DNS (UDP port 53) traffic from the AP to the DNS server.)

l PAPI (UDP port 8211). All APs running as Air Monitors (AMs) require a permanent PAPI connection to
Mobility Master.

l FTP (TCP port 21)
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l TFTP (UDP port 69). All campus APs; If there is no local image on the AP or if the image needs to be
upgraded (for example, a new AP), the AP will use TFTP to retrieve the initial image. For remote APs, upgrade
the image only by FTP and not TFTP.

l SYSLOG (UDP port 514)

l PAPI (UDP port 8211)

l GRE (protocol 47)

l Control Plane Security (CPsec) uses UDP port 4500

Communication Between Remote APs and the Controller
Configure the following ports to enable communication between a Remote AP (IPsec) and a controller:

l NAT-T (UDP port 4500)

l TFTP (UDP port 69)

TFTP is not needed for normal operation. If the remote AP loses its local image for any reason, it will use TFTP to
download the latest image.

Enabling Network Access
This section describes the network ports that need to be configured on the firewall to manage the Aruba
network.

For WebUI access between the network administrator’s computer (running a web browser) and a controller:

l HTTP (TCP ports 80 and 8888) or HTTPS (TCP ports 443 and 4343).

l SSH (TCP port 22) or TELNET (TCP port 23).

Ports Used for Virtual Intranet Access (VIA)
The following ports are used with Aruba VIA.

l For the reachability/trusted network check, use port 443.

l For the IPsec connection, use port 4500.

l To allow ISAKMP, use port 500.

l To enable NAT-T, use port 4500

Configuring Ports to Allow Other Traffic Types
This section describes the network ports that need to be configured on the firewall to allow other types of
traffic in the Aruba network. You should only allow traffic as needed from these ports.

l For logging: SYSLOG (UDP port 514) between the controller and syslog servers.

l For software upgrade or retrieving system logs: TFTP (UDP port 69) or FTP (TCP ports 21 and 22) between
the controller and a software distribution server.

l If the controller is a PPTP VPN server, allow PPTP (UDP port 1723) and GRE (protocol 47) to the controller.

l If the controller is an L2TP VPN server, allow NAT-T (UDP port 4500), ISAKMP (UDP port 500) and ESP
(protocol 50) to the controller.

l If a third-party network management system is used, allow SNMP (UDP ports 161 and 162) between the
network management system and all controllers.



l For authentication with a RADIUS server: RADIUS (typically, UDP ports 1812 and 1813, or 1645 and 1646)
between the controller and the RADIUS server.

l For authentication with an LDAP server: LDAP (UDP port 389) or LDAPS (UDP port 636) between the
controller and the LDAP server.

l For authentication with a Radsec Server—RADIUS over TLS): TCP port 443 between the controller and the
RADIUS/Radsec Proxy server.

l For authentication with a TACACS+ server: TACACS (TCP port 49) between the controller and the TACACS+
server.

l For NTP clock setting: NTP (UDP port 123) between all controllers and NTP server.

l For packet captures: UDP port 5555 from an AP to an Ethereal packet-capture station; UDP port 5000 from
an AP to a Wildpackets packet-capture station.

l For telnet access: Telnet (TCP port 23) from the network administrator's computer to any AP, if “telnet
enable” is present in the “ap location 0.0.0" section of the controller configuration.

l For External Services Interface (ESI): ICMP (protocol 1) and syslog (UDP port 514) between a controller and
any ESI servers.

l For XML API: HTTP (TCP port 80) or HTTPS (TCP port 443) between a controller and an XML-API client.
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Chapter 30
Palo Alto Networks Firewall Integration

The User-Identification (User-ID) feature of the Palo Alto Networks (PAN) firewall allows network
administrators to configure and enforce firewall policies based on users and user groups. The User-ID identifies
the user on the network based on the IP address of the device to which the user is logged in. Additionally, a
firewall policy can be applied based on the type of device the user is using to connect to the network. Since the
Mobility Master maintains the network and user information of clients in the network, it is the best source to
provide information for the User-ID feature of the PAN firewall.

The procedures in this chapter describe the steps to integrate a Palo Alto Networks firewall with a Mobility Master or
managed device. For additional details on configuring PAN firewall integration, see Managed Device Feature
Overview on page 201

This feature introduces the following interactions with PAN firewall servers running PAN-OS 5.0 or later:

l Send login events for the client to the PAN firewall with its IP address, username, and device type, when
classified.

l Send logout events for the client to PAN firewalls with its IP address.

The following must be configured on the PAN Firewall:

l An admin account must be created on the PAN firewall to allow the managed device to send data to the
PAN firewall. This account must match the account added in the PAN profile on the managed device. The
built-in admin account can be used for this purpose, but that is not recommended. It is better to create a
new admin account used solely for the purpose of communications between the managed device and
PAN firewall.

l Preconfiguration of PAN Host Information Profile (HIP) objects and HIP-profiles on the PAN Firewall to
support a device-type based policy.

To enable these features, the following must be configured on the managed device:

l The system-wide PAN profile must be properly configured and made active on the managed device.

l The pan-integration parameter in the AAA profile to which the client is associated must be enabled.

l For VPN clients, enable the pan-integration parameter in the VPN authentication profile to which the
client is associated.

l For VIA clients, enable the pan-integration parameter in the VIA authentication profile to which the client
is associated.

Limitations
Keep the following limitations in mind when configuring PAN Firewall Integration:

PAN Firewall Integration does not support bridge forwarding mode.

Preconfiguration on the PAN Firewall
Before PAN Firewall configuration can be completed on the managed device, some configurations must be
completed on the PAN Firewall.
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Certificate Management
The issuer certificate of the x509 server certificate used by the PAN firewall must be imported by Mobility
Master as a trusted CA in order to establish a secure HTTPS connection between the firewall and the managed
device.

User-ID Support
The administrator must configure firewall policies based on the username and/or user group. Additionally,
correct configuration of the connection to directory servers is required for user group based policies on the
PAN firewall.

Device-Type Based Policy Support
Managed devices support a limited number of device types. The identified device type associated with each IP
user is sent to the PAN through the client-version field, with the host-info category of the HIP report.
PAN administrators must create these HIP objects, which filter the HIP reports sent from the managed device
to support device-based firewall policies.

Table 125 lists the HIP objects with a specified Is Value in the Client Version field, which must be
preconfigured on the PAN firewall.

Table 125: HIP Objects

Client Version Is Value

Android

Apple

AppleTV

BlackBerry

Chrome OS

iPad

iPhone

iPod

Kindle

Linux

Nintendo

Nintendo 3DS

Nintento Wii



Client Version Is Value

Nook

OS X

PlayStation

PS Vita

PS3

PSP

RIM Tablet

Roku

Symbian

webOS

Win 7

Win 8

Win 95

Win 98

Win 2000

Win CE

Win ME

Win NT

Win Server

Win Vista

Win XP
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Client Version Is Value

Windows

Windows Mobile

Windows Phone 7

Configuring PAN Firewall Integration
A PAN profile must be created on the managed device. Multiple PAN profiles can be configured and saved on
the managed device, but only one profile can be active at a time. These profiles can be configured and applied
using the Mobility Master WebUI or CLI.

The following procedures describe the steps to integrate a Palo Alto Networks firewall policy using Mobility Master.
For additional details on configuring PAN firewall integration, see Managed Device Feature Overview on page 201

Creating PAN Profiles
The first step in configuring PAN firewall integration is to create PAN profiles. This profile provides the managed
device with the information required for connecting to and interacting with the specified PAN firewall. The PAN
profile can be created using the WebUI or CLI.

This configuration is only performed and available on theMobility Master. The configuration is pushed to all
connected to the managed devices.

In the WebUI
To add a new PAN profile, complete the following steps:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand Other Profiles in the All Profiles list, and then select Palo Alto Network Servers.

4. Click Add.

5. Type the profile name into the Profile Name field, then click Add.

6. Enter the Host (IP address or hostname) of the PAN firewall

7. Enter the Port (1 – 65535) of the PAN firewall.

8. Enter the Username of the PAN firewall. The username must be between 1 and 255 bytes in length. The
username must match the Admin account previously created on the PAN firewall.

9. Enter the Password of the username in PAN firewall. The password is between 6 and 100 bytes in length.
The password must match the Admin account previously created on the PAN firewall.

10.Re-enter the Password entered in the previous step.

11.Click OK.

12.Click Save.

13.Select Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

To add PAN firewalls to the PAN profile:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Systems page.



2. Select the Profiles tab.

3. Expand Other Profiles in the All Profiles list, and then select the new PAN profile under Palo Alto
Networks Servers.

4. Click + to add a PAN firewall to the PAN profile.

5. Enter the host (IP address or hostname) of the PAN firewall

6. Enter the portnum (port number between 1–65535) of the PAN firewall.

7. Enter the username of the PAN firewall. The username must be between 1 and 255 bytes in length. The
username must match the admin account previously created on the PAN firewall.

8. Enter the passwd of the username in PAN firewall. The password must be between 6 and 100 bytes in
length. The password must match the admin account previously created on the PAN firewall.

9. Re-enter the password.

10.Click OK.

11.Click Save.

12.Select Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #pan profile <profile-name>

firewall host <host> port <port> username <username> passwd <password>

Activating a PAN Profile
To activate a PAN Firewall profile, complete the following steps:

This configuration must be completed on each managed device.

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page

2. Select the Profiles tab.

3. Expand Other Profiles in the All Profiles list, and then select the Palo Alto Networks Active > Active
Palo Alto Networks profile.

4. Select the profile from the Palo Alto Networks Servers Profile drop-down list, and then click +.
5. Enter the host (IP address or hostname) of the PAN firewall

6. Enter the portnum (port number between 1 – 65535) of the PAN firewall.

7. Enter the username of the PAN firewall. The username must be between 1 and 255 bytes in length. The
username must match the admin account previously created on the PAN firewall.

8. Enter the passwd for the PAN firewall. The password must be between 6 and 100 bytes in length. The
password must match the admin account previously created on the PAN firewall.

9. Re-enter the password.

10.Click OK.

11.Click Save.

12.Select Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #pan active-profile

profile <profile-name>
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PAN Firewall Portal Configuration
To configure the PAN firewall portal, complete the following steps:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand Other Profiles in the All Profiles list, and then select the Configure Palo Alto Network options
profile.

4. Enter the host (IP address or hostname) of the PAN firewall

5. Enter the name of the trusted CA certificate under cacert_name.

6. Enter the username of the PAN firewall in the uname field. The username must be between 1 and 255
bytes in length. The username must match the admin account previously created on the PAN firewall.

7. Enter the passwd for the PAN firewall. The password must be between 6 and 100 bytes in length. The
password must match the admin account previously created on the PAN firewall.

8. Re-enter the password.

9. Click Save.

10.Select Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

Enabling PAN Firewall Integration
PAN firewall integration must be enabled on the AAA profile to which the client is associated.

In the WebUI
To enable PAN firewall integration in the AAA profile:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand Wireless LAN in the All Profiles list, and then select AAA.

4. Select a AAA profile.

5. Select the PAN Firewalls Integration check box.

6. Click Save.

7. Select Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa profile <aaa profile-name>

pan-integration

Enabling PAN Firewall Integration for VIA Clients
For VIA clients, PAN firewall integration must be enabled on the VIA authentication profile that is associated
with the client.

In the WebUI
To enable PAN firewall integration for VIA clients, complete the following steps:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand Other Profiles in the All Profiles list, and then select VIA Authentication.

4. Select a VIA Authentication profile.



5. Select the PAN Firewalls Integration check box.

6. Click Save.

7. Select Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa authentication via auth-profile <profile-name>

pan-integration

Enabling PAN Firewall Integration for VPN Clients
For VPN clients, PAN firewall integration must be enabled on the VPN authentication profile that the client is
associated with.

In the WebUI
To enable PAN firewall integration for VPN clients:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System page.

2. Select the Profiles tab.

3. Expand Wireless LAN in the All Profiles list, and then select VPN Authentication.

4. Select a VPN Authentication profile.

5. Select the PAN Firewalls Integration check box.

6. Click Save.

7. Select Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa authentication vpn default

pan-integration

Related Commands
Use the following CLI commands to view details for your PAN firewall configuration:
(host) [mynode] #show pan activate-profile

(host) [mynode] #show pan debug [uid-table slot-num <slot-num> [starting-rec <starting-rec>]]

(host) [mynode] #show pan-gp gateway-info

(host) [mynode] #show pan-gp portal-info

(host) [mynode] #show pan-options

(host) [mynode] #show pan profile

(host) [mynode] #show pan profile <profile-name>

(host) [mynode] #show pan state

(host) [mynode] #show pan statistics

(host) [mynode] #show profile-list pan profile [start <start>] [page <page>]

(host) [mynode] #show references pan active-profile [start <start>] [page

<page>]

(host) [mynode] #show references pan profile <profile-name> [start <start>]

[page <page>]
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Chapter 31
Remote Access Points

The Secure Remote Access Point Service allows AP users, at remote locations, to connect to an Aruba Mobility
Master over the Internet. Because the Internet is involved, data traffic between the Mobility Master and the
remote AP is VPN encapsulated. That is, the traffic between the Mobility Master and AP is encrypted. Remote
AP operations are supported on all of Aruba’s APs.

Topics in this chapter include:

l About Remote Access Points on page 626

l Configuring the Secure Remote Access Point Service on page 627

l Deploying a Branch/Home Office Solution on page 633

l Enabling Remote AP Advanced Configuration Options on page 639

l Understanding Split Tunneling on page 654

l Understanding Bridge on page 660

l Provisioning Wi-Fi Multimedia on page 664

l Reserving Uplink Bandwidth on page 665

l Provisioning 4G USB Modems on Remote Access Points on page 666

l Configuring RAP-3WN and RAP-3WNP Access Points on page 668

l Converting an IAP to RAP or CAP on page 668

l Enabling Bandwidth Contract Support for RAPs on page 669

About Remote Access Points
Remote APs connect to a Mobility Master using Extended Authentication and Internet Protocol Security
(XAuth/IPsec). AP control and 802.11 data traffic are carried through this tunnel. Secure Remote Access Point
Service extends the corporate office to the remote site. Remote users can use the same features as corporate
office users. For example, voice over IP (VoIP) applications can be extended to remote sites while the servers
and the PBX remain secure in the corporate office.

For both RAPs and CAPs, tunneled SSIDs will be brought down eight seconds after the AP detects that there is
no connectivity to the Mobility Master. However, RAP bridge-mode SSIDs are configurable to stay up
indefinitely (always-on / persistent). For CAP bridge-mode SSIDs, the CAP will be brought down after the
keepalive times out (default 3.5 minutes).

Secure Remote Access Point Service can also be used to secure control traffic between an AP and the Mobility
Master in a corporate environment. In this case, both the AP and Mobility Master are in the company’s private
address space.

The remote AP must be configured with the IPsec VPN tunnel termination point. Once the VPN tunnel is
established, the AP bootstraps and becomes operational. The tunnel termination point used by the remote AP
depends upon the AP deployment, as shown in the following scenarios:

l Deployment Scenario 1: The remote AP and Mobility Master reside in a private network which secures AP-
to-Mobility Master communication. (This deployment is recommended when AP-to-Mobility Master
communications on a private network need to be secured.) In this scenario, the remote AP uses the Mobility
Master’s IP address on the private network to establish the IPsec VPN tunnel.

l Deployment Scenario 2: The remote AP is on the public network or behind a NAT device and the Mobility
Master is on the public network. The remote AP must be configured with the tunnel termination point,
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which must be a publicly-routable IP address. In this scenario, a routable interface is configured on the
Mobility Master in the DMZ. The remote AP uses the Mobility Master’s IP address on the public network to
establish the IPsec VPN tunnel.

l Deployment Scenario 3: The remote AP is on the public network or behind a NAT device and the Mobility
Master is also behind a NAT device. (This deployment is recommended for remote access.) The remote AP
must be configured with the tunnel termination point, which must be a publicly-routable IP address. In this
scenario, the remote AP uses the public IP address of the corporate firewall. The firewall forwards traffic to
an existing interface on the Mobility Master. (The firewall must be configured to pass NAT-T traffic (UDP
port 4500) to the Mobility Master.)

In any of the described deployment scenarios, the IPsec VPN tunnel can be terminated on a managed device,
with a Mobility Master located elsewhere in the corporate network. The remote AP must be able to
communicate with the Mobility Master after the IPsec tunnel is established. Make sure that the L2TP IP pool
configured on the managed device (from which the remote AP obtains its address) is reachable in the managed
device network by the Mobility Master.

Configuring the Secure Remote Access Point Service
The tasks for configuring an Aruba Access Point as a Secure Remote Access Point Service are:

l Configure a public IP address for the Mobility Master.

You must install one or more AP licenses in the Mobility Master. There are several AP licenses available that
support different maximum numbers of APs. The licenses are cumulative; each additional license installed
increases the maximum number of APs supported by the Mobility Master.

l Configure the VPN server on the Mobility Master. The remote AP will be a VPN client to the server.

l Provision the AP with IPsec settings, including the username and password for the AP, before you install it at
the remote location. You can also provision the RAP using the zero touch provisioning method. For more
information, see Provisioning 4G USB Modems on Remote Access Points on page 666.

Configure a Public IP Address for the Mobility Master
The remote AP requires an IP address to which it can connect to establish a VPN tunnel to the Mobility Master.
This can be either a routable IP address you configure on the Mobility Master, or the address of an external
router or firewall that forwards traffic to the Mobility Master. The following procedure describes how to create
a DMZ address on the Mobility Master.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Interfaces > VLANs page.

2. Click + to add a VLAN.

3. Enter the VLAN ID.

4. Click Submit.

5. Click the VLAN ID created.

6. Click Edit on Port Members.

7. Click < to select the port that belongs to this VLAN .

8. Click OK.

9. Click Submit.

10.Click IPv4 tab.

11.Enter the IP Address and Net Mask fields.

12.Click Submit.



13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #vlan <id>

(host) [mynode] (config) #interface vlan <id>

(host) [mynode] (config-submode) #ip address <ipaddr> <mask>

Configure the NAT Device
Communication between the AP and the secure Mobility Master uses the UDP 4500 port. When both the
Mobility Master and the AP are behind NAT devices, configure the AP to use the NAT device’s public address as
its master address. On the NAT device, you must enable NAT-T (UDP port 4500 only) and forward all packets to
the public address of the NAT device on UDP port 4500 to the Mobility Master to ensure that the remote AP
boots successfully.

Configure the VPN Server
This section describes how to configure the IPsec VPN server on the Mobility Master. For more details, see
Virtual Private Networks on page 335. The remote AP will be a VPN client that connects to the VPN server on
the Mobility Master.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Services > VPN tab.

2. Click IKEv1 table.

3. Select Enabled from L2TP drop-down list.

4. Select PAP (Password Authentication Protocol) check box for Auth Protocols.

5. To configure the L2TP IP pool, click General VPN option.

6. Click + in the Address Pools table.

7. Enter the Pool name to configure the L2TP pool from which the APs will be assigned addresses.

8. Click Submit.

The size of the pool should correspond to the maximum number of APs that the Mobility Master is licensed to
manage.

9. To configure an Internet Security Association and Key Management Protocol (ISAKMP) encrypted subnet
and preshared key, navigate to the Configuration > Services > VPN tab.

10.Click Shared Secrets option.

11.Click + in the IKE Shared Secrets table and enter the Shared Key in the Create IKE Group table.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #vpdn group l2tp

(host) [mynode] (config-submode) #ppp authentication PAP

(host) [mynode] (config) #ip local pool <pool_name> <start-ipaddr> <end-ipaddr>

(host) [mynode] (config) #crypto isakmp key <key> address <ipaddr> netmask <mask>
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CHAP Authentication Support over PPPoE
RAPs can now establish a PPPoE session with a PPPoE server at the ISP side and get authenticated using the
Challenge Handshake Authentication Protocol (CHAP). The PPPoE client running on a RAP is capable of
handling the CHAP authentication requests from the PPPoE server.

The PPPoE client selects either the PAP or the CHAP credentials for the RAP authentication depending upon the
request from the PPPoE server.

You can use the WebUI or the CLI to configure CHAP.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Access Points > Remote APs

tab. The list of discovered APs are displayed on this page.

2. Select the AP you want to configure using CHAP and click Provision.

3. In the popup window click Continue and Reboot.

4. Click Uplink tab and enter the CHAP Secret .

You can use all the special characters except question mark (?) and the space can be used within double quotes (“ “).

5. Enter the CHAP Secret again in the Retype text box for confirmation.

6. Click Submit and Reboot.
7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #provision-ap pppoe-chap-secret <KEY>

(host) [mynode] (config-submode) #reprovision ap-name <name>

Configuring Certificate RAP
You can configure the remote AP to use the internal certificate for authentication. You can use the WebUI or
CLI to configure the certificate RAP.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Access Points > Remote APs tab.

2. Select the required Remote AP and click Provision.

3. In the popup window click Continue and Reboot.

4. Select the Remote AP check box.

5. Select Certificate from the Authentication methods drop-down list.

6. Click Submit to apply the configuration and reboot the AP as certificate RAP.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #whitelist-db rap add <mac-address>



Creating a Remote AP Whitelist
If you use the Zero Touch provisioning method to provision the certificate RAP, then you must create a remote
AP whitelist. For more information on Zero Touch Provisioning of the RAP, see Provisioning 4G USB Modems
on Remote Access Points on page 666.

Remote AP whitelist is the list of approved APs that can be provisioned on your Mobility Master.

In the WebUI

1. In the Mobility Master node hierarchy, navigate to Configuration > Access Points > Whitelist tab.

2. Click Remote AP Whitelist tab.

3. Click + and provide the following details:

l MAC Address—mandatory parameter. Enter the MAC address of the AP.

l AP Group—select a group to add the AP.

l AP Name—enter a name for the AP. If you do not enter an AP name, the MAC address will be used
instead.

l Description—enter a text description for the AP

4. Click Submit to add the remote AP to the whitelist.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Configuring PSK RAP
You can use Pre-Shared Key (PSK) authentication to provision an individual remote AP or a group of remote
APs using an Internet Key Exchange Pre-Shared Key (IKE PSK).

In the WebUI
1. In the Mobility Master node hierarchy, navigate to Configuration > Access Points > Remote APs tab.

2. Select the required Remote AP and click Provision.

3. In the popup window click Continue and Reboot.

4. In the General tab, select Pre-shared Key from the Authentication methods drop-down list.

5. Enter and confirm the pre-shared key (IKE PSK).

6. Select Global User Name/password or a Per AP User Name/Password from User credential
assignment drop-down list.

a. If you use the Per AP User Names/Passwords option, each RAP is given its own username and
password.

b. If you use the Global User Name/Password option, all selected RAPs are given the same (shared)
username and password.

7. Enter the user name, and enter and confirm the password. If you want the managed device to automatically
generate a user name and password, select Use Automatic Generation. If this option is not selected, the
user has to enter it manually.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.

Add the User to the Internal Database
You can add the user to the internal database using the WebUI or CLI.
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In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth
Servers tab.

2. From the All Servers table, select Internal under the Name field.

3. Click + in the Users tab. The Internal Server > Add New User page is displayed.

4. Enter the User Name and Password.

5. Select Enabled from the Enabled drop-down list to activate this entry on creation.

6. Click Submit. Note that the configuration does not take effect until you perform this step.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Issue the following command in enable mode.
(host) [mynode] (config) #local-userdb add username rapuser1 password <password>

RAP Static Inner IP Address
The RAP static inner IP address feature assigns a static inner IP address to a remote access point (RAP). A new
remote-IP address parameter is added to the existing configuration commands.

In the WebUI
To view IP address parameter in the local database:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Authentication > Auth
Servers tab.

2. Select All Servers table.

3. Select Internal under the Name field.

4. A list of Static IP for RAPs is displayed under Server > Internal table.

To view the IP-address parameter in the RAP Whitelist: 

1. In the Mobility Master node hierarchy, navigate to the Configuration > Access Points > Remote APs
tab.

In the CLI
Issue the following command in enable mode:
(host) [mynode] (config) #local-userdb add {generate-username|username <name>} {generate-

password|password <password>} {remote-ip <remote-ip>}

(host) [mynode] (config) #local-userdb modify {username < name>} {remote-ip <remote-ip>}

Issue the following command in config mode:
(host) [mynode] (config) #whitelist-db rap add {mac-address <address>}{ap-group <ap_group>}

{remote-ip <remote-ip>}

(host) [mynode] (config) #whitelist-db rap modify {mac-address <address>} {remote-ip<remote-

ip>}

You cannot configure the IP-Address parameter using the WebUI.



Provision the AP
You need to configure the VPN client settings on the AP to instruct the AP to use IPsec to connect to the
Mobility Master. You can provision the remote AP and give it to users and allow remote users to provision AP at
their home. This method of provisioning is referred as Zero Touch Provisioning. See Provisioning 4G USB
Modems on Remote Access Points on page 666 for more information about Zero Touch Provisioning of
remote AP.

You must provision the AP before you install it at its remote location. To provision the AP, the AP must be
physically connected to the local network or directly connected to the Mobility Master. When connected and
powered on, the AP must also be able to obtain an IP address from a DHCP server on the local network or from
the Mobility Master.

If your configuration has an internal LMS IP address, remote APs may attempt to switch over to the LMS IP
address, which is not reachable from the Internet. For remote APs, ensure that the LMS IP address in the AP
system profile for the AP group has an externally routable IP address.

Reprovisioning the AP causes it to automatically reboot. The easiest way to provision an AP is to use the
Provisioning page in the WebUI, as described in the following steps:

1. In the Mobility Master node hierarchy, navigate to the Configuration > Access Points > Remote APs
tab.

2. Select the remote AP and click Provision.

3. Select the Pre-shared Key from the Authentication Methods drop-down list.

4. Enter the User name, Password, and Confirm password.

The username and password you enter must match the username and password configured on the authentication
server for the remote AP.

5. Select Static option in the Controller Discovery field.

6. Set the Controller IP/DNS name as shown below:

Deployment Scenario Master IP Address Value

Deployment 1 Managed device IP address.

Deployment 2 Managed device public IP address.

Deployment 3 Public address of the NAT device to which the Managed device is
connected.

Table 126: Configuring a Managed device IP Address

The username and password you enter must match the username and password configured on the authentication
server for the remote AP.

7. Select DHCP option in the IP field.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the check box and click Deploy changes.
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Secondary Managed Device
The secondary managed device provides reliability and redundancy; however the functionality of a secondary
managed device is initiated only after an AP terminates on a managed device successfully and retrieves the
configuration. If the AP boots up and fails to connect to the managed device the AP cannot be managed. To
address this, ArubaOS 8.0 introduces the secondary managed device feature.

In a scenario where the managed device is not reachable, the AP will try to reach the secondary managed device
and if successful will terminate on the secondary managed device. The secondary managed device details are
not stored in the system flash when the AP is deployed for the first time, but only after a successful
configuration. An AP can use the secondary managed device feature after the AP reboots.

If an AP has not been configured to a managed device after deployment, the secondary managed device feature will
not be applicable.

In the WebUI
To enable the secondary managed device feature:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. Select AP > AP System under All Profiles.
3. Select the AP profile for which the secondary managed device feature is to be enabled. The AP system

profile section is displayed.

4. Enter an IP or FQDN value for the secondary managed device in the Secondary Master IP/FQDN field.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

The secondary managed device feature can be enabled on the secondary managed device.

In the CLI
Execute the following command to enable the secondary managed device feature.
(host) [mynode] (config) #ap system-profile <profile name>

(host) [mynode] (AP system profile "profile name")#secondary-master <value>

Deploying a Branch/Home Office Solution
In a branch office, the AP is deployed in a separate IP network from the corporate network. Typically, there are
one or two NAT devices between the two networks. Branch office users need access to corporate resources
such as printers and servers, but traffic to and from these resources must not impact the corporate head
office.

Figure 55 is a graphic representation of a remote AP in a branch or home office, with a single Mobility Master
providing access to both a corporate WLAN and a branch office WLAN.



Figure 55 Remote AP with Single Managed device

Branch office users want continued operation of the branch office WLAN, even if the link to the corporate
network goes down. The branch office AP solves these requirements by providing the following capabilities on
the branch office WLAN:

l Local termination of 802.11 management frames which provides survivability of the branch office WLAN.

l All 802.1X authenticator functionality is implemented in the AP. The Mobility Master is used as a RADIUS
pass-through when the authenticator has to communicate with a RADIUS server (which also supports
survivability).

l 802.11 encryption/decryption is in the AP to provide access to local resources.

l Local bridging of client traffic connected to the WLAN or to an AP 70 enet1 port to provide access to local
resources.

Provisioning the Branch AP
You can provision the remote AP either using the Mobility Master or using the Zero Touch Provisioning
method. For more information on Mobility Master provisioning, see Configuring Installed APs on page 502. For
more information on Zero Touch Provisioning, see Provisioning 4G USB Modems on Remote Access Points on
page 666.

Configuring the Branch AP
l Specify forward mode for the Extended Service Set Identifier (ESSID) in the virtual AP profile

l Specify remote AP operation in the virtual AP profile (The remote AP operates in standard mode by default.)

l Set how long the AP stays up after connectivity to Mobility Master has gone down in the SSID profile

l Set the VLAN ID in the virtual AP profile

l Set the native VLAN ID in the AP system profile

l Set forward mode for enet1 port

Remote APs support 802.1q VLAN tagging. Data from the remote AP will be tagged on the wired side.

Troubleshooting Remote AP
The following WebUI options are available to troubleshoot issues with remote AP:

l Using local debugging feature

l Viewing the remote AP summary report
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l Viewing remote AP connectivity report

l Using remote AP diagnostic options

Local Debugging
Local debugging is a WebUI feature that allows end users to perform diagnostics and view the status of their
remote AP through a wired or wireless client. This feature is useful for troubleshooting connectivity problems
on remote APs and performing throughput tests. There are three tabs in the Local Debugging WebUI
window; Summary, Connectivity, and Diagnostics. Each tab displays different information for the AP, but
all three tabs include a Generate & save support file link that, when clicked, will automatically generate a
support.tgz file that can be sent to a corporate IT department for additional analysis and debugging.

A snapshot of the bridge, acl, session, user, and arp tables, current processes, memory, and kernel debug messages
are captured in a single rap_debug.txt file which is bundled along with support.tgz file.

Remote AP Summary
The Summary tab has two views; basic and advanced. Click the basic or advanced links at the top of this tab
to toggle between the two views. The table below shows the information displayed for both the basic and
advanced views of the Summary tab.



Summary
Table Name Basic View Information Advanced View Information

Wired Ports
Status

l Port: port numbers of the wired
ports on the AP

l Status: current status of each port
(Connected, LinkDown or Disabled).

The advanced view of the Wired Access
Ports table displays the following data:

l Port: port numbers of the wired ports
on the AP

l Status: current status of each port
(Connected, LinkDown or Disabled)

l MAC Address: MAC address of the
wired port

l Speed: speed of the link

l Duplex Type: duplex mode of the link,
full or half

l Forwarding mode: forwarding mode
for the port: Bridge, Tunnel or Split
Tunnel

l Users: fumber of users accessing each
port

l Rx Packets: number of packets
received on the port

l Tx packets: number of packets
transmitted via the port

Wireless SSIDs l SSID: Name of the SSID.

l Status: SSID Status (up, down, or
disabled).

l Band: Radio band available on the
SSID.

l SSID: name of the SSID

l Status: SSID Status (up, down, or
disabled).

l Band: radio band available on the SSID

l Channel: channel used on the radio
band

l BSSID: BSSID of the wireless SSID

l Forwarding Mode: forwarding mode
used by the Wireless SSID (Bridge,
Tunnel or Split-Tunnel)

l EIRP: equivalent Isotropic Radiated
Power, in dBm

l Noise floor: residual background noise
detected by an AP. Noise seen by an AP
is reported as -dBm Therefore, a noise
floor of -100 dBm is smaller (lower)
than a noise floor of -50 dBm.

l Users: number of users on the radio
band

l Rx Packets: number of packets
received on the BSSID

l Tx packets: number of packets
transmitted via the BSSID

Table 127: RAP Console Summary Tab Information
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Summary
Table Name Basic View Information Advanced View Information

Wired Users l MAC Address: MAC address of the
wired user.

l IP address: IP address of the wired
user.

l MAC Address: MAC address of the
wired user.

l IP address: IP address of the wired
user.

l Port: AP port used by the wired user.

Wireless User l MAC Address: MAC address of the
wireless user.

l IP address: IP address of the
wireless user.

l MAC Address: MAC address of the
wired user

l IP address: IP address of the wired
user

l SSID: name of the SSID

l BSSID: BSSID of the wireless user

l Assoc State: shows if the user is
associated or just authorized

l Auth: Type of authentication: WPA,
802.1X, none, open, or shared

l Encryption: encryption type used by
the wireless user

l Band: radio band used by the wireless
client

l RSSI: Receive Signal Strength Indicator
(RSSI) value displayed in the output of
this command represents signal
strength as a signal to noise ratio.

Device Info l Type: AP device/model type.

l Name: Name assigned to the AP.

l Wired MAC address: MAC address
of the wired port.

l Serial #: AP serial number.

l Tunnel IP address: IP address of
the tunnel between the AP and
managed device.

l Software Version: Software version
currently running on the AP.

l Uptime: Amount of time the AP has
been active since it was last reset.

l Master: IP address of the Mobility
Master.

l lms: IP address of the managed
device.

N/A



Summary
Table Name Basic View Information Advanced View Information

Uplink Info The Uplink Info table can display some
or all of the following information for
your remote AP, depending upon
whether a link is active and the number
of links supported by the AP.

Active uplink information, including:

l Interface name

l Port speed

l IP address

Standby link information, including:

l Name (3G)

l Device connected (yes/no)

l Provisioned (yes/no)

l IP address

l Device

l User

l Password

N/A

Multihoming on remote AP (RAP)
You can uplink a RAP as an Ethernet or a USB based modem. These uplinks can be used as a backup link if the
primary link fails. The uplink becomes active based on the order of priority configured on the RAP. The RAP
switches back to the primary link when the primary connection is restored.

For information on provisioning the RAP using the USB based modem, see Provisioning 4G USB Modems on
Remote Access Points on page 666.

Seamless failover from backup link to primary link on RAP
RAPs can failover from a backup link to a primary link without much disruption to traffic. Also the failover is
performed only if the Mobility Master is reachable via the primary link.

Remote AP Connectivity
The information shown on the Connectivity tab will vary, depending upon the current status of the remote
AP. If a remote AP has been successfully provisioned and connected, it should display some or all of the
information in Table 128.
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Data Description

Uplink status Shows if the link connected failed. If the link is connected, the Uplink
status also displays the name of the interface.

IP Information If the AP has successfully received an IP address, this data row will show
the AP’s IP address, subnet mask, and gateway IP address.

Gateway Connectivity If successful, this item also shows the percentage of packet loss for data
received from the gateway.

TPM Certificates If successful, the AP has a Trusted Platform Module (TPM) certificate.

Master Connectivity Shows if the AP was able to connect to the Mobility Master. This item
also shows the IP address to which the AP attempted to connect, and, if
the AP did connect successfully, the link used to connect to that Mobility
Master.

LMS Connectivity Shows if the AP was able to connect to a managed device. This item also
shows the IP address to which the AP attempted to connect, and, if the
AP did connect successfully, the link used to connect to that Mobility
Master.

Table 128: RAP Console Connectivity Tab Information

The top of the Connectivity tab has a Refresh link that allows users to refresh the data on their screen.
Additional information at the bottom of this tab shows the date, time, and reason the remote AP last
rebooted. The Reboot RAP Now button reboots the remote AP.

Remote AP Diagnostics
Use the Diagnostics tab to view log files, or run diagnostic tests that can help the IT department troubleshoot
errors.

To run a diagnostic test on a remote AP:

1. In the Mobility Master node hierarchy, navigate to the Diagnostics > Tools menu.

2. Select Ping, Traceroute, or Throughput tab.

The ping and traceroute tests require that you enter a network destination in the form of an IP address or
fully-qualified domain name, and select either bridge or tunnel mode for the test. The NSLookup
diagnostic test requires that you enter a destination only. The throughput test checks the throughput of the
link between the AP and the Mobility Master, and does not require any additional test configuration
settings.

3. Click Trace to start the test. The results of the test will appear in the Diagnostics window.

4. To view log files in a separate browser window: 

a. Click Diagnostics > Logs menu.

b. Select a log file name from the Logs drop-down list. The type of log files available will vary, depending
upon your remote AP configuration.

c. Click Display.

Enabling Remote AP Advanced Configuration Options
This section describes the following features designed to enhance your remote AP configuration:



l Understanding Remote AP Modes of Operation on page 640

l Working in Fallback Mode on page 642

l Specifying the DNS Mobility Master Setting on page 650

l Backup Managed device List on page 651

l Configuring Remote AP Failback on page 652

l Working with Access Control Lists and Firewall Policies on page 654

l Understanding Split Tunneling on page 654

l Provisioning Wi-Fi Multimedia on page 664

The information in this section assumes you have already configured the remote AP functionality, as described in
Configuring the Secure Remote Access Point Service on page 627.

Understanding Remote AP Modes of Operation
Table 129 summarizes the different remote AP modes of operation. You specify both the forward mode
setting (which controls whether 802.11 frames are tunneled to the Mobility Master using GRE, bridged to the
local Ethernet LAN, or a combination thereof) and the remote AP mode of operation (when the virtual AP
operates on a remote AP) in the virtual AP profile.

The column on the left of the table lists the remote AP operation settings. The row across the top of the table
lists the forward mode settings. To understand how these settings work in concert, scan the desired remote AP
operation with the forward mode setting, and read the information in the appropriate table cell.

The all column and row lists features that all remote AP operation and forward mode settings have in common
regardless of other settings. For example, at the intersection of all and bridge, the description outlines what
happens in bridge mode regardless of the remote AP mode of operation.
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Remote AP
Operation
Setting

Forward Mode Setting

all bridge split-tunnel tunnel decrypt-tunnel

all Management
frames on the
AP.

Frames are
bridged
between wired
and wireless
interfaces.

No frames are
tunneled to the
Mobility Master.

Station acquires
its IP address
locally from an
external DHCP
server.

Management
frames on the
AP.

Frames are
either GRE
tunneled to the
Mobility Master
to a trusted
tunnel or NATed
and bridged on
the wired
interface
according to
user role and
session ACL.

Typically, the
station obtains
an IP address
from a VLAN on
the Mobility
Master.

Typically, the AP
has ACLs that
forward
corporate traffic
through the
tunnel and
source NAT the
non-corporate
traffic to the
Internet.

Frames are GRE
tunneled to the
Mobility Master
to an untrusted
tunnel.

100% of station
frames are
tunneled to the
Mobility Master.

Management
frames on the
AP.

Frames are
always GRE
tunneled to
Mobility
Master.

always ESSID is
always up
when the AP
is up
regardless of
whether the
Mobility
Master is
reachable.

Supports PSK
ESSID only.

SSID
configuration
stored in flash
on AP.

Provides an
SSID that is
always available
for local access.

Not supported Not supported Not supported

Table 129: Remote AP Modes of Operation and Behavior



Remote AP
Operation
Setting

Forward Mode Setting

all bridge split-tunnel tunnel

backup ESSID is only
up when the
Mobility
Master is
unreachable.

Supports PSK
ESSID only.

SSID
configuration
stored in flash
on AP.

Provides a
backup SSID for
local access
only when the
Mobility Master
is unreachable.

Not supported Not supported Not supported

persistent ESSID is up
when the AP
contacts the
Mobility
Master and
stays up if
connectivity is
disrupted with
the Mobility
Master.

SSID
configuration
obtained from
the Mobility
Master.

Designed for
802.1X SSIDs.

Same behavior
as standard,
described
below, except
the ESSID is up
if connectivity to
the Mobility
Master is lost.

Not supported Not supported Not supported

standard ESSID is up
only when
there is
connectivity
with the
Mobility
Master.

SSID
configuration
obtained from
the Mobility
Master.

Behaves like a
classic Aruba
branch office
AP.

Provides a
bridged ESSID
that is
configured from
the Mobility
Master and
stays up if there
is Mobility
Master
connectivity.

Split tunneling
mode

Classic Aruba
thin AP
operation

Decrypt tunnel
mode

Working in Fallback Mode
The fallback mode (also known as backup configuration) operates the remote AP if the master Mobility Master
or the configured primary and backup LMS are unreachable. The remote AP saves configuration information
that allows it to operate autonomously using one or more SSIDs in local bridging mode, while supporting open
association or encryption with PSKs. You can also use the backup configuration if you experience network
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connectivity issues, such as the WAN link or the central data center becoming unavailable. With the backup
configuration, the remote site does not go down if the WAN link fails or the data center is unavailable.

You define the backup configuration in the virtual AP profile on the Mobility Master. The remote AP checks for
configuration updates each time it establishes a connection with the Mobility Master. If the remote AP detects
a change, it downloads the configuration changes.

The following remote AP backup configuration options define when the SSID is advertised (refer to Table 129
for more information):

l Always - Permanently enables the virtual AP. Recommended for bridge SSIDs.

l Backup - Enables the virtual AP if the remote AP cannot connect to the Mobility Master. This SSID is
advertised until the Mobility Master is reachable. Recommended for bridge SSIDs.

l Persistent - Permanently enables the virtual AP after the remote AP initially connects to the Mobility Master.
Recommended for 802.1X SSIDs.

l Standard - Enables the virtual AP when the remote AP connects to the Mobility Master. Recommended for
802.1X, tunneled, and split-tunneled SSIDs. This is the default behavior.

While using the backup configuration, the remote AP periodically retries its IPsec tunnel to the Mobility Master.
If you configure the remote AP in backup mode, and a connection to the Mobility Master is re-established, the
remote AP stops using the backup configuration and immediately brings up the standard remote AP
configuration. If you configure the remote AP in always or persistent mode, the backup configuration remains
active after the IPsec tunnel to the Mobility Master has been re-established.

Backup Configuration Behavior for Wired Ports
If the connection between the remote AP and the Mobility Master is disconnected, the remote AP will be
exhibit the following behavior:

l All access ports on the remote AP will be moved to bridge forwarding mode ,irrespective of their original
forwarding mode.

l Clients will receive an IP address from the remote AP's DHCP server.

l Clients will have complete access to Remote AP's uplink network. You cannot enforce or modify any access
control policies on the clients connected in this mode.

This section describes the following topics:

l Configuring Fallback Mode on page 643

l Configuring the DHCP Server on the Remote AP on page 644

l Configuring Advanced Backup Options on page 646

Configuring Fallback Mode
To configure the fallback mode, you must:

l Configure the AAA profile

l Configure the virtual AP profile

Configuring the AAA Profile for Fallback Mode

In the WebUI

The AAA profile defines the authentication method and the default user role for unauthenticated users:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select Wireless LAN > AAA under All Profiles.
3. Click + in AAA Profile.



4. Enter the Profile name, and click Save.

5. Select the AAA profile that you just created:

a. For Initial role, select the appropriate role (for example, logon) from the drop-down list.

b. For 802.1X Authentication Default Role, select the appropriate role (for example, default) from the
drop-down list.

c. Click Save.

d. Locate the 802.1X Authentication Server Group, and select the Server Group to be used (for
example, default) from the drop-down list.

e. Click Save.

If you need to create an 802.1X Authentication Server Group, select new from the 802.1X Authentication Server
Group drop-down list, and enter the appropriate parameters.

f. Locate 802.1X Authentication, and select the 802.1X Authentication Profile to be used (for
example, “default”) from the drop-down list.

g. Click Save.

h. Click Pending Changes.

i. In the Pending Changes window, select the check box and click Deploy changes.

If you need to create an 802.1X authentication profile, select new from the 802.1X Authentication Profile drop-
down list, and enter the appropriate parameters.

In the CLI
(host) [mynode] (config) #aaa profile default

(host) [mynode] (AAA Profile "default") #initial-role <role>

(host) [mynode] (AAA Profile "default") #authentication-dot1x <dot1x-profile>

(host) [mynode] (AAA Profile "default") #dot1x-default-role <role>

(host) [mynode] (AAA Profile "default") #dot1x-server-group <group>

Configuring the DHCP Server on the Remote AP
You can configure the internal DHCP server on the remote AP to provide an IP address for the backup SSID if
the Mobility Master is unreachable. If configured, the remote AP DHCP server intercepts all DHCP requests and
assigns an IP address from the configured DHCP pool.

To configure the remote AP DHCP server:

l Enter the VLAN ID for the remote AP DHCP VLAN in the AP system profile. This VLAN enables the DHCP
server on the AP (also known as the remote AP DHCP server VLAN). If you enter the native VLAN ID, the
DHCP server is not configured and is unavailable.

l Specify the DHCP IP address pool and netmask. The AP assigns IP addresses from the DHCP pool
192.168.11.0/24 by default, with an IP address range from 192.168.11.2 through 192.168.11.254. You
can manually define the DHCP IP address pool and netmask based on your network design and IP address
scheme.

l Specify the IP address of the DHCP server, DHCP router, and the DHCP DNS server. The AP uses IP address
192.168.11.1 for the DHCP server, the DHCP router, and the DHCP DNS server by default.

l Enter the amount of days the assigned IP address is valid (also known as the remote AP DHCP lease). The
lease does not expire by default, which means the IP address is always valid.

ArubaOS 8.0.0.0 | User Guide Remote Access Points |  644



645 | Remote Access Points ArubaOS 8.0.0.0  | User Guide

l Assign the VLAN ID for the remote AP DHCP VLAN to a virtual AP profile. When a client connects to that
virtual AP profile, the AP assigns the IP address from the DHCP pool.

The following is a high-level description of the steps required to configure the DHCP server on the remote AP. The
steps assume you have already created the virtual AP profile, AAA profile, SSID profile, and other settings for your
remote AP operation (for information about the backup configuration, see Configuring Fallback Mode on page 643).

In the WebUI

1. In the Managed Networks node hierarchy, navigate to the Configuration > AP Groups menu option.

2. Select an AP Group. Click More tab.

3. Under Profile Details:

a. Enter the LMS IP address in the LMS IP address field and the Bakcup LMS IP address in the Backup
LMS IP address field.

b. Enter the LMS IPv6 address in the LMS IPv6 address field and the Bakcup LMS IPv6 address in the
Backup LMS IPv6 address field.

c. Click Submit.

d. Click Pending Changes.

e. In the Pending Changes window, click Deploy Changes.

4. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles tab.

a. Select AP > AP System under All Profiles, and select an AP system profile.

b. Click Remote AP accordion.

c. Enter the VLAN ID of the backup configuration virtual AP VLAN in the Remote-AP DHCP Server VLAN
field .

d. Enter the IP address of the DHCP server in the Remote-AP DHCP Server ID field.

e. Enter the IP address of the default DHCP router in the Remote-AP DHCP Default Router field.

f. Specify the DHCP IP address pool. This configures the pool of IP addresses from which the remote AP
uses to assign IP addresses.

- Enter the first IP address of the pool, in the Remote-AP DHCP Pool Start field.

- Enter the last IP address of the pool, in the Remote-AP-DHCP Pool End field.

- Enter the netmask, in the Remote-AP-DHCP Pool Netmask field.

g. Specify the number of days for which the IP address is valid, in the Remote-AP DHCP Lease Time field.

h. Click Save.

i. Select Wireless LAN > Virtual AP under All Profiles, and the virtual AP profile you want to configure.

j. Under General tab, enter the Native VLAN ID of the remote AP DHCP VLAN.

k. Click Save.

l. Click Pending Changes.

m. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following commands:
(host) [mynode] (config) #ap system-profile default

(host) [mynode] (AP system profile "default") #lms-ip <ipaddr>

(host) [mynode] (AP system profile "default") #master-ip <ipaddr>

(host) [mynode] (AP system profile "default") #rap-dhcp-default-router <ipaddr>

(host) [mynode] (AP system profile "default") #rap-dhcp-dns-server <ipaddr>

(host) [mynode] (AP system profile "default") #rap-dhcp-lease <days>

(host) [mynode] (AP system profile "default") #rap-dhcp-pool-end <ipaddr>



(host) [mynode] (AP system profile "default") #rap-dhacp-pool-netmask <netmask>

(host) [mynode] (AP system profile "default") #rap-dhcp-pool-start <ipaddr>

(host) [mynode] (AP system profile "default") #rap-dhcp-server-id <ipaddr>

(host) [mynode] (AP system profile "default") #rap-dhcp-server-vlan <vlan>

(host) [mynode] (config) #wlan virtual-ap default

(host) [mynode] (Virtual AP profile "default") #ssid-profile <profile>

(host) [mynode] (Virtual AP profile "default") #vlan <vlan>

(host) [mynode] (Virtual AP profile "default") #forward-mode bridge

(host) [mynode] (Virtual AP profile "default") #aaa-profile <name>

(host) [mynode] (Virtual AP profile "default") #rap-operation {always|backup|persistent}

(host) [mynode] (config) #ap-group default

(host) [mynode] (AP group "default") #virtual-ap <name>

or
(host) [mynode] (config) #ap-name default

(host) [mynode] (AP name "default") #virtual-ap <name>

Configuring Advanced Backup Options
You can also use the backup configuration (fallback mode) to allow the remote AP to pass through a captive
portal, such as network access in a hotel, airport, or other public network, to access the corporate network. For
this scenario:

l Define a session ACL for the bridge SSID to source NAT all user traffic, except DHCP. For example, use any
any svc-dhcp permit followed by any any any route src-nat. Apply the session ACL to a remote AP
user role.

l Configure the AAA profile. Make sure the initial role contains the session ACL previously configured.

The AAA profile defines the authentication method and the default user role.

802.1X and PSK authentication is supported when configuring bridge or split tunnel modes.

l Configure the virtual AP profile for the backup configuration:

n Set the remote AP operation to always or backup.

n Create and apply the applicable SSID profile.

n Configure a bridge SSID for the backup configuration. In the virtual AP profile, specify forward mode as
bridge.

For more information about the backup configuration, see Configuring Fallback Mode on page 643.

l Enter the remote AP DHCP server parameters in the AP system profile. For more information about the
parameters, see Configuring the DHCP Server on the Remote AP on page 644.

If you use a local DHCP server to obtain IP addresses, you must define one additional ACL to permit traffic
between clients without source NATing the traffic. Using the previously configured ACL, add user alias
internal-network any permit before any any any route src-nat.

l Connect the remote AP to the available public network (for example, a hotel or airport network).

The remote AP advertises the backup SSID so the wireless client can connect and obtain an IP address from
the available DHCP server.

The client can obtain an IP address from the public network, for example a hotel or airport, or from the DHCP server
on the remote AP.

After obtaining an IP address, the wireless client can connect and access the corporate network and bring up
the configured corporate SSIDs.
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The following is a high-level description of what is needed to configure the remote AP to pass through a captive
portal and access the corporate Mobility Master. This information assumes you are familiar with configuring
session ACLs, AAA profiles, virtual APs, and AP system profiles and highlights the modified parameters.

Configuring the Session ACL

In the WebUI

1. In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies >
Policies tab.

2. Click + to create a new policy.

3. Enter the policy name in the Policy Name field.

4. From the Policy Type drop-down list, select Session.

5. Click Submit.

6. To create the first rule:

a. Select the policy created.

b. Click +.

c. Select Access Control option in the Rule Type field.

d. Click OK.

e. Select Any from the Source drop-down list.

f. Select Any from the Destination drop-down list.

g. Select Service from the Service/app drop-down list.

h. Select svc-dhcp from the Service alias drop-down list.

i. Select Permit from the Action drop-down list.

j. Click Submit.

7. To create the next rule:

a. Click the policy created.

b. Click +.

c. Select Access Control option in the Rule Type field.

d. Click OK.

e. Select Any from the Source drop-down list.

f. Select Any from the Destination drop-down list.

g. Select Service from the Service/app drop-down list.

h. Select Any from the Service alias drop-down list.

i. Select Route Source NAT from the Action drop-down list.

8. Click Submit.

If you use a local DHCP server to obtain IP addresses, you must define one additional ACL to permit traffic between
clients without source NATing the traffic. Add user alias internal-network any permit before any any any

route src-nat.

9. In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies >Roles
tab.

Roles can be created only in the Managed device.

10.Click + to create a new role.



11.Enter the role name in the Name field.

12.Click Submit.

13.Select the new role created.

14.Click Show Advanced View.

15.Click +.

16.Select Add existing policy option and select the policy created from the Policy name drop-down list.

17.Click Submit.

18.Click Pending Changes.

19.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following commands:
(host) [mynode] (config) #ip access-list session <policy>

any any svc-dhcp permit

any any any route src-nat

If you use a local DHCP server to obtain IP addresses, you must define one additional ACL to permit traffic
between clients without source NATing the traffic. Add user alias internal-network any permit before any
any any route src-nat:
(host) (config) #user-role <role>

session-acl <policy>

Configuring the AAA Profile

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select Wireless LAN > AAA under All Profiles.
3. Click + in AAA Profile.

4. Enter the Profile name, then click Save.

5. Select the AAA profile that you just created:

a. For Initial role, select the user role you just created.

b. For 802.1X Authentication Default Role, select the appropriate role (for example, “default”) from the
drop-down list.

c. Click Save.

d. Under the AAA profile that you created, locate 802.1X Authentication Server Group, and select the
Server Group to be used (for example “default”) from the drop-down list.

e. Click Save.

If you need to create an 802.1X authentication server group, select new from the 802.1X Authentication Server
Group drop-down list, and enter the appropriate parameters.

f. Under the AAA profile that you created, locate 802.1X Authentication Server Group, and select the
Server Group to be used (for example “default”) from the drop-down list.

g. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #aaa profile default
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(host) [mynode] (AAA Profile "default") #initial-role <role>

You can define other parameters as needed.

Defining the Backup Configuration

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select Wireless LAN > Virtual AP under All Profiles.
3. Click + in Virtual AP Profile and enter the profile name.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Whenever you create a new virtual AP profile in the WebUI, the profile automatically contains the default SSID profile
with the default ESSID. You must configure a new ESSID and SSID profile for the virtual AP profile before you apply
the profile.

a. Click + below the profile created and select AAA.

b. Select the previously configured AAA profile from the AAA Profile drop-down list.

c. Click Save.
d. Click + below the profile created and select SSID.

e. Select the previously configured SSID profile from the SSID Profile drop-down list.

f. Click Save.
7. Select the new virtual AP name in the Profiles list or the Profile Details to display the configuration

parameters.

8. Under Profile Details, execute the following:

a. Ensure that the Virtual AP enable is selected.

b. Select the VLAN ID to be used for the Virtual AP profile, from the VLAN drop-down list.

c. Select bridge from the Forward mode drop-down list.

d. Select always or backup from the Remote-AP Operation drop-down list.

e. Click Save.

9. Under All Profiles, select AP > AP system profile.

10.Under Profile Details, execute the following:

a. Select the AP system profile that you want to edit.

b. Under the LMS Settings accordion, enter the LMS IP address in the LMS IP field.

c. Under the Remote AP accordion, enter the Remote -AP DHCP server name in the Remote-AP DHCP
Server field.

d. Click Save.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Use the following commands:
(host) [mynode] (config) #wlan ssid-profile <profile>

essid <name>

opmode <method>

wpa-passphrase <string> (if necessary)



(host) [mynode] (config) #wlan virtual-ap <name>

ssid-profile <profile>

vlan <vlan>

forward-mode bridge

aaa-profile <name>

rap-operation {always|backup}

(host) [mynode] (config) #ap system-profile <name>

lms-ip <ipaddr>

master-ip <ipaddr>

rap-dhcp-default-router <ipaddr>

rap-dhcp-dns-server <ipaddr>

rap-dhcp-lease <days>

rap-dhcp-pool-end <ipaddr>

rap-dhacp-pool-netmask <netmask>

rap-dhcp-pool-start <ipaddr>

rap-dhcp-server-id <ipaddr>

rap-dhcp-server-vlan <vlan>

(host) [mynode] (config) #ap-group <name>

virtual-ap <name>

ap-system-profile <name>

or
(host) (config) #ap-name <name>

virtual-ap <name>

ap-system-profile <name>

Specifying the DNS Mobility Master Setting
In addition to specifying IP addresses for Mobility Master, you can also specify the master DNS name for the
Mobility Master when provisioning the remote AP. The name must be resolved to an IP address when
attempting to set up the IPsec tunnel. For information on how to configure a host name entry on the DNS
server, refer to the vendor documentation for your server. It is recommended to use a maximum of 8 IP
addresses to resolve a Mobility Master name.

If the remote AP gets multiple IP addresses responding to a host name lookup, the remote AP can use one of
them to establish a connection to the Mobility Master. For more detailed information, see the next section
Backup Managed device List on page 651.

Specifying the name also lets you move or change remote AP concentrators without reprovisioning your APs.
For example, in a DNS load-balancing model, the host name resolves to a different IP address depending on
the location of the user. This allows the remote AP to contact the Mobility Master to which it is geographically
closest.

The DNS setting is part of provisioning the AP. The easiest way to provision an AP is to use the Provisioning
page in the WebUI. These instructions assume you are only modifying the Mobility Master information in the
Master Discovery section of the Provision page.

Reprovisioning the AP causes it to automatically reboot.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Access Points > Remote APs

tab.

2. Select the remote AP and click Provision.
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3. In the General tab, enter master DNS name in the Controller IP/DNS name field.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

For more information, see Provision the AP on page 632.

Backup Managed device List
Using DNS, the remote AP receives multiple IP addresses in response to a host name lookup. Known as the
backup managed device list, remote APs go through this list to associate with a managed device. If the primary
managed device is unavailable or does not respond, the remote AP continues through the list until it finds an
available managed device. This provides redundancy and failover protection.

The remote AP loses the IP address information received through DNS when it terminates and receives the
system profile configuration from the managed device. If the remote AP loses connectivity on the IPsec tunnel
to the managed device, the RAP fails over from the primary managed device to the backup managed device.
For this scenario, add the IP address of the backup managed device in the backup LMS and the IP address of
the primary managed device in the LMS field of the ap-system profile. Network connectivity is lost during this
time. As described in the section Configuring Remote AP Failback on page 652, you can also configure a remote
AP to revert back to the primary managed device when it becomes available. To complete this scenario, you
must also configure the LMS IP address and the backup LMS IP address.

For example, assume you have two data centers, data center 1 and data center 2, and each data center has one
master managed device in the DMZ. You can provision the remote APs to use the managed device in data
center 1 as the primary managed device, and the managed device in data center 2 as the backup managed
device. If the remote AP loses connectivity to the primary, it will attempt to establish connectivity to the
backup. You define the LMS parameters in the AP system profile.

Figure 56 Sample Backup Scenario

Configuring the LMS and backup LMS IP addresses

In the WebUI

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select AP > AP System under All Profiles.
3. Select the AP system profile you want to modify.

4. Enter the following details in the LMS Settings accordion:



a. Enter the primary managed device IP address, in the LMS IP field.

b. Enter the backup managed device IP address, in the Backup LMS IP field.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #ap system-profile <profile>

lms-ip <ipaddr>

bkup-lms-ip <ipaddr>

(host) [mynode] (config) #ap-group <group>

ap-system-profile <profile>

(host) [mynode] (config) #ap-name <name>

ap-system-profile <profile>

Configuring Remote AP Failback
In conjunction with the backup managed device list, you can configure remote APs to revert back (failback) to
the primary managed device if it becomes available. If you do not explicitly configure this behavior, the remote
AP will keep its connection with the backup managed device until the remote AP, managed device, or both have
rebooted or some type of network failure occurs. If any of these events occur, the remote AP will go through
the backup managed device list and attempt to connect with the primary managed device.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select AP > AP System under All Profiles.
3. Select the AP system profile you want to modify.

4. Enter the following details in the LMS Settings accordion:

a. Select the LMS Preemption check box. This is disabled by default.

b. Enter the duration (in seconds) for which the remote AP must wait before moving back to the primary
managed device, in the LMS Hold-down period field.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [mynode] (config) #ap system-profile <profile>

lms-preemption

lms-hold-down period <seconds>

Enabling RAP Local Network Access
You can enable local network access between the clients (from same or different subnets and VLANs)
connected to a RAP through wired or wireless interfaces in split-tunnel/bridge forwarding modes. This allows
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the clients to effectively communicate with each other without routing the traffic via the managed device. You
can use WebUI or CLI to enable the local network access.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select AP > AP System under All Profiles.
3. Select the AP system profile you want to modify.

4. To enable remote network access, select the Remote-AP Local Network Access check box under the
Remote AP accordion.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
l To enable, enter the following command:

(host) [mynode] (config) #ap system-profile <ap-profile> rap-local-network-access

l To disable, enter the following command:
(host) [mynode] (config) #ap system-profile <ap-profile> no rap-local-network-access

See the ArubaOS CLI Reference Guide for detailed information on the command options.

Configuring Remote AP Authorization Profiles
Remote AP configurations include an authorization profile that specifies which profile settings should be
assigned to a remote AP that has been provisioned but not yet authenticated at the remote site. These yet-
unauthorized APs are put into the temporary AP group authorization-group by default and assigned the
predefined profile NoAuthApGroup. This configuration allows the user to connect to an unauthorized remote
AP via a wired port, then enter a corporate username and password. Once a valid user has authorized the AP,
and it will be marked as authorized on the network. The remote AP will then download the configuration
assigned to that AP by its permanent AP group.

In the WebUI

Adding or Editing a Remote AP Authorization Profile

To create a new authorization profile or edit an existing authorization profile via the WebUI:

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select AP > AP Authorization under All Profiles.
a. To edit an existing profile, select a profile listed under AP Authorization profile and select a new

AP authorization group from the AP authorization group drop-down list.

b. To create a new authorization profile, click + next to the AP Authorization profile field.

3. Click Save.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
To create a new authorization profile or edit an existing authorization profile via the command-line interface,
access the command-line interface in enable mode, and issue the following commands.
(host) [mynode] (config) #ap authorization-profile <profile>

authorization-group <ap-group>



Working with Access Control Lists and Firewall Policies
Remote APs support the following access control lists (ACLs); unless otherwise noted, you apply these ACLS to
user roles:

l Standard ACLs—Permit or deny traffic based on the source IP address of the packet.

l Ethertype ACLs—Filter traffic based on the Ethertype field in the frame header.

l MAC ACLs—Filter traffic on a specific source MAC address or range of MAC addresses.

l Firewall policies (session ACLs)—Identifies specific characteristics about a data packet passing through the
Aruba Mobility Master and takes some action based on that identification. You apply these ACLs to user
roles or uplink ports.

To configure firewall policies, you must install the PEFNG license.

For more information about ACLs and firewall policies, see Configuring Fallback Mode on page 643.

Understanding Split Tunneling
The split tunneling feature allows you to optimize traffic flow by directing only corporate traffic back to the
Mobility Master, while local application traffic remains local. This ensures that local traffic does not incur the
overhead of the round trip to the Mobility Master, which decreases traffic on the WAN link and minimizes
latency for local application traffic. This is useful for sites that have local servers and printers. With split
tunneling, a remote user associates with a single SSID, not multiple SSIDs, to access corporate resources (for
example, a mail server) and local resources (for example, a local printer). The remote AP examines session ACLs
to distinguish between corporate traffic destined for the Mobility Master and local traffic.

Figure 57 Sample Split Tunnel Environment

Figure 57 displays corporate traffic is GRE tunneled to the Mobility Master through a trusted tunnel and local
traffic is source NATed and bridged on the wired interface based on the configured user role and session ACL.

Configuring Split Tunneling
The procedure to configure split tunneling requires the following steps. Each step is described in detail later in
this chapter.
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The split tunneling feature requires the PEFNG license. If you do not have the PEFNG license on your Mobility Master,
you must install it before you configure split tunneling. For details on installing licenses, refer to the Aruba Mobility
Master Licensing Guide.

1. Define a session ACL that forwards only corporate traffic to the Mobility Master.

a. Configure a net destination for the corporate subnets.

b. Create rules to permit DHCP and corporate traffic to the corporate Mobility Master.

c. Apply the session ACL to a user role.

2. (Optional) Configure an ACL that restricts remote AP users from accessing the remote AP local debugging
homepage.

3. Configure the remote AP’s AAA profile.

a. Specify the authentication method (802.1X or PSK) and the default user role for authenticated users.
The user role specified in the AAA profile must contain the session ACL defined in the previous step.

b. (Optional) Use the remote AP’s AAA profile to enable RADIUS accounting.

4. Configure the virtual AP profile:

a. Specify which AP group or AP to which the virtual AP profile applies.

b. set the VLAN used for split tunneling. Only one VLAN can be configured for split tunneling; VLAN pooling
is not allowed.

c. When specifying the use of a split tunnel configuration, use “split-tunnel” forward mode.

d. Create and apply the applicable SSID profile.

When creating a new virtual AP profile In the WebUI, you can also configure the SSID at the same time. For
information about AP profiles, see Understanding AP Configuration Profiles on page 495.

5. (Optional) Create a list of network names resolved by corporate DNS servers.

Configuring the Session ACL Allowing Tunneling
First you need to configure a session ACL that “permits” corporate traffic to be forwarded (tunneled) to the
Mobility Master, and that routes, or locally bridges, local traffic.

Roles can be created only in the Managed device.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies

>Policies tab.

2. Click + to create a new policy.

3. Enter the policy name in the Policy Name field.

4. From the Policy Type drop-down list, select Session.

5. From the IP Version drop-down list, select IPv4 or IPv6.

6. Click Apply.

7. To create the first rule:

a. Click the policy created.

b. Click +.

c. Select the Rule Type in the New Rule for <policy name> dialog box and click OK.

d. Select Any from the Source drop-down list.



e. Select Any from the Destination drop-down list.

f. Select Service from the Service/app drop-down list.

g. Select svc-dhcp from the Service alias drop-down list.

h. Select Permit from the Action drop-down list.

i. Click Apply.

8. To create the next rule:

a. Click the policy created.

b. Click +.

c. Select the Rule Type in the New Rule for <policy name> dialog box and click OK.

d. Select Any from the Source drop-down list.

e. Select Alias from the Destination drop-down list.

The following steps define an alias representing the corporate network. Once defined, you can use the
alias for other rules and policies. You can also create multiple destinations the same way.

9. Select + from the Destination alias drop-down list.

a. Enter a name in the Destination name field.

b. Click + under Rule and select Network from the Rule type drop-down list.

c. Enter the public IP address of the Mobility Master in the IP address field.

d. Enter the Network mask/range in the Network mask/range field.

e. Click OK.

The new alias appears in the Destination alias drop-down list.

10.Under Destination alias, select the alias you just created.

11.Select Permit from the Action drop-down list.

12.Click Submit.

13.In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies >Roles
tab.

Roles can be created only in the Managed device.

14.Click + to create a new role.

15.Enter the role name in the Name field.

16.Click Submit.

17.Click the new role created.

18.Click Show Advanced View.

19.Click +.

20.Select Add existing session policy option and select the policy created from the Policy name drop-down
list.

21.Click Submit.

22.Click Pending Changes.

23.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #ap system-profile <profile>

lms-preemption

lms-hold-down period <seconds>netdestination <policy>
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network <ipaddr> <netmask>

(host) [mynode] (config) #ip access-list session <policy>

any any svc-dhcp permit

any alias <name> any permit

user any any route src-nat

(host) [mynode] (config) #user-role <role>

session-acl <policy>

When defining the alias, there are a number of other session ACLs that you can create to define the handling of
local traffic, such as:

(host) [mynode] (config) #ip access-list session <policy>

user alias <name> any redirect 0

user alias <name> any route

user alias <name> any route src-nat

Configuring an ACL to Restrict Local Debug Homepage Access
A user in split or bridge role using a remote AP (RAP) can log on to the local debug (LD) homepage (for example,
(http://rapconsole.arubanetworks.com) and perform a reboot or reset operations. The LD homepage provides
various information about the RAP and also has a button to reboot the RAP. You can now restrict a RAP user
from resetting or rebooting a RAP by using the localip keyword in the in the user role ACL.

You will require the PEFNG license to use this feature. For complete information on the centralized licensing
requirements, refer to the Aruba Mobility Master Licensing Guide.

Any user associated to that role can be allowed or denied access to the LD homepage. You can use the localip

keyword in the ACL rule to identify the local IP address on the RAP. The localip keyword identifies the set of
all local IP addresses on the system to which the ACL is applied. The existing keywords Mobility Master and
mswitch indicate only the primary IP address on the Mobility Master.

This release of ArubaOS provides localip keyword support only for RAP and not for Mobility Master.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies

>Policies tab.

2. Click + to create a new policy.

3. Enter the policy name in the Policy Name field.

4. From the Policy Type drop-down list, select Session.

5. From the IP Version drop-down list, select IPv4 or IPv6.

6. To create the first rule:

a. Click the policy created.

b. Click +.

c. Select the Rule Type in the New Rule for <policy name> dialog box and click OK.

d. Select Any from the Source drop-down list.

e. Select Any from the Destination drop-down list.

f. Select Service from the Service/app drop-down list.

g. Select svc-dhcp from the Service alias drop-down list.

h. Select Permit from the Action drop-down list.



i. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the localip keyword in the user role ACL.

All users have an ACL entry of type any any deny by default. This rule restricts access to all users. When the
ACL is configured for a user role, if a user any permit ACL rule is configured, add a deny ACL before that for
localip for restricting the user from accessing the LD homepage.

Example:
(host) [mynode] (config) #ip access-list session logon-control

user localip svc-http deny

user any permit

Configuring the AAA Profile for Tunneling
After you configure the session ACL, you define the AAA profile used for split tunneling. When defining the AAA
parameters, specify the previously configured user role that contains the session ACL used for split tunneling.

If you enable RADIUS accounting in the AAA profile, the Mobility Master sends a RADIUS accounting start
record to the RADIUS server when a user associates with the remote AP, and sends a stop record when the user
logs out or is deleted from the user database. If you enable interim accounting, the Mobility Master sends
updates at regular intervals. Each interim record includes cumulative user statistics, including received bytes
and packets counters. For more information on RADIUS accounting, see RADIUS Accounting on page 192

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Click Wireless LAN and select All Profiles> AAA.

3. Click + in AAA Profile.

4. Enter the Profile name, then click Save.

5. Select the AAA profile that you just created:

a. For Initial role, select the appropriate role (for example, “logon”) from the drop-down list.

b. For 802.1X Authentication Default Role, select the appropriate role (for example, “default”) from the
drop-down list.

c. Click Save.

d. Under the AAA profile that you created, locate 802.1X Authentication Server Group, and select the
Server Group to be used (for example “default”) from the drop-down list.

e. Click Save.

6. (Optional) To enable RADIUS accounting:

a. Select the AAA profile from the profile list to display the list of authentication and accounting profiles
associated with the AAA profile.

b. Select the Radius Accounting Server Group profile associated with the AAA profile. Click the Server
Group drop-down list to select a RADIUS server group. (For more information on configuring a RADIUS
server or server group, see Configuring a RADIUS Server on page 176.)

7. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.
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If you need to create an authentication server group, select new and enter the appropriate parameters.

In the CLI
(host) [mynode] (config) #aaa profile <name>

authentication-dot1x <dot1x-profile>

dot1x-default-role <role>

dot1x-server-group <group>

radius-accounting <group>

radius-interim-accounting

Configuring the Virtual AP Profile

In the WebUI
1. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles tab.

2. Select Wireless LAN > Virtual AP under All Profiles.
3. To create a new virtual AP profile, click + in the Virtual AP Profile. Enter the name for the virtual AP profile,

and click Save.

Whenever you create a new virtual AP profile in the WebUI, the profile automatically contains the “default” SSID
profile with the default ESSID. You must configure a new ESSID and SSID profile for the virtual AP profile before you
apply the profile.

a. Select Wireless LAN > AAA under All Profiles.
b. Click + in AAA Profile and select a previously configured AAA profile.

c. Click Save.

d. Select Wireless LAN > SSID under All Profiles.
e. Click + in SSID Profile and enter the following details:

- Enter the name of the profile in the Profile Name field.

- To enable SSID, select the SSID enable check box.

- Select the appropriate check box under the Encryption field, to choose the network authentication
and encryption method.

f. Click Save.

4. Click the new virtual AP name listed under All Profiles list, to view the configuration parameters.

5. Under Profile Details:

a. Ensure Virtual AP enable is selected.

b. Select the VLAN ID for the VLAN to be used for split tunneling from the VLAN drop-down list.

c. Select split-tunnel from the Forward mode drop-down list.

d. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #wlan ssid-profile <profile>

essid <name>

opmode <method>

(host) [mynode] (config) #wlan virtual-ap <profile>

ssid-profile <name>

forward-mode <mode>



(host) [mynode] (config) # vlan <vlan id>

aaa-profile <profile>

(host) [mynode] (config) #ap-group <name>

virtual-ap <profile>

or
(host) [mynode] (config) #ap-name <name>

virtual-ap <profile>

Defining Corporate DNS Servers
Clients send DNS requests to the corporate DNS server address that it learned from DHCP. If configured for
split tunneling, corporate domains and traffic destined for corporate use the corporate DNS server. For non-
corporate domains and local traffic, other DNS servers can be used.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles tab.

2. Select AP > AP System under All Profiles.
3. Select an AP System Profile.

4. Click + under Corporate DNS Domain table and enter the Corporate DNS Domain.

5. Click OK. The DNS name appears in Corporate DNS Domain table. You can add multiple names the same
way.

6. Click Save.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config) #ap system-profile <profile>

dns-domain <domain name>

Understanding Bridge
The bridge feature allows you to route the traffic flow only to the internet and not to the corporate network.
Only the 802.1X authentication request is sent to the corporate network. This feature is useful for guest users.

ArubaOS does not support Wired 802.1X authentication in bridge mode for RAP and CAP. 802.1X authentication is
supported only in tunnel and split modes.

Figure 58 Sample Bridge Environment
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Figure 58 displays the local traffic being routed to the internet and the 802.1X authentication request sent to
the corporate network.

Configuring Bridge
To configure a bridge, perform the following steps. Each step is described in detail later in this chapter.

The bridge feature requires the PEFNG license. If you do not have the PEFNG license on your managed device, you
must install it before you configure bridge. For details on installing licenses, refer to the Aruba Mobility Master
Licensing Guide.

1. Define a session ACL that routes the traffic. 

a. Create rules to permit DHCP and local data traffic.

b. Apply the session ACL to a user role. For information about user roles and policies, see Roles and Policies
on page 363.

2. Configure the remote AP’s AAA profile.

a. Specify the authentication method (802.1X or PSK) and the default user role for authenticated users.
The user role specified in the AAA profile must contain the session ACL defined in the previous step.

b. (Optional) Use the remote AP’s AAA profile to enable RADIUS accounting.

3. Configure the virtual AP profile:

a. Specify the AP group or ap-name to which the virtual AP profile applies.

b. Set the VLAN in the virtual AP.

c. When specifying the use of a bridge configuration, use bridge forward mode.

d. Create and apply the applicable SSID profile.

e. (Optional) Under AP system profile, configure the RAP DHCP pool. RAP DHCP VLAN must be same as
VAP's VLAN. If the client needs to obtain from the RAP DHCP Server.

When creating a new virtual AP profile In the WebUI, you can simultaneously configure the SSID. For information
about AP profiles, see Understanding AP Configuration Profiles on page 495.

Configuring the Session ACL
First you need to configure a session ACL that “permits” corporate traffic to be forwarded to the managed
device and that routes, or locally bridges, local traffic.

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration >Roles and Policies

>Policies tab.

2. Click + to create a new policy.

3. Enter the policy name in the Policy name field.

4. Select Session from the Policy type drop-down list.

5. Click Submit.

6. Select the policy created and click + under Policies table.

7. Select Access Control option in the Rule Type field.

8. Click OK.

9. To complete creation of a rule:

a. Select IPv4 or IPv6, from the IP Version drop-down list.

b. Select any from the Source drop-down list.



c. Select any from the Destination drop-down list.

d. Select Service from the Service/app drop-down list.

e. Select svc-dhcp from the Service alias drop-down list.

f. Select permit for IPv4 or captive for IPv6 from the Action drop-down list.

g. Click Submit.

10.To create another rule:

a. Select policy created and click +.
b. Select Access Control option in the Rule Type field.

c. Click OK.

d. Select any from the Source drop-down list.

e. Select alias from the Destination drop-down list.

f. Click + in the Destination alias drop-down list.

g. In the Add New Destination window, click + in the Rule table.

h. Select Network from the Rule type drop-down list.

i. Enter the public IP address of the managed device in the IP address field.

j. Enter the Netmask/range in the Netmask/range field.

k. Click OK. The new alias appears in the Destination alias drop-down list.

l. Click Submit.

11.Navigate to the Configuration >Roles and Policies >Roles tab.

Roles can be created only in the Managed device.

a. Click + to create a new role.

b. Enter the role name in the Name field.

c. Click Submit.

d. Click the new role created.

e. Click Show Advanced View.

f. Click +.

g. Select Add an existing policy option and select the policy created from the Policy name drop-down
list.

h. Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
If dhcp server in ap system profile is enabled:
(host) [mynode] (config) #ip access-list session <policy> any any svc-dhcp permit

(host) [mynode] (config) #user any any route src-nat

If dhcp server in ap system profile is disabled:
(host) [mynode] (config) #ip access-list session <policy>

(host) [mynode] (config) #any any any permit

(host) [mynode] (config) #user-role <role>

session-acl <policy>
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To configure an ACL to Restrict Local Debug Homepage Access, see Configuring an ACL to Restrict Local Debug
Homepage Access on page 657.

Configuring the AAA Profile for Bridge
After you configure the session ACL, you define the AAA profile used for bridge. When defining the AAA
parameters, specify the previously configured user role that contains the session ACL used for bridge.

If you enable RADIUS accounting in the AAA profile, the Mobility Master sends a RADIUS accounting start
record to the RADIUS server when a user associates with the remote AP, and sends a stop record when the user
logs out or is deleted from the user database. If you enable interim accounting, the Mobility Master sends
updates at regular intervals. Each interim record includes cumulative user statistics, including received bytes
and packets counters. For more information on RADIUS accounting, see RADIUS Accounting on page 192.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Select Wireless LAN > AAA under All Profiles.
3. Click + in AAA Profile.

4. Enter the Profile name, and click Save.

5. Select the AAA profile that you just created:

a. For Initial role, select the appropriate role (for example, “logon”) from the drop-down list.

b. For 802.1X Authentication Default Role, select the user role you previously configured for split
tunneling or bridge.

c. Click Save.

d. Locate the 802.1X Authentication Server Group, and select the Server Group to be used (for
example “default”) from the drop-down list.

e. Click Save.

If you need to create an 802.1X Authentication Server Group, select new from the 802.1X Authentication Server
Group drop-down list, and enter the appropriate parameters.

6. Click Save.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following command:
(host) [mynode] (config) #aaa profile <name>

(host) [mynode] (config) #authentication-dot1x <dot1x-profile>

(host) [mynode] (config) #dot1x-default-role <role>

(host) [mynode] (config) #dot1x-server-group <group>

(host) [mynode] (config) #radius-accounting <group>

(host) [mynode] (config) #radius-interim-accounting

Configuring Virtual AP Profile

In the WebUI
1. In the Managed Networks node hierarchy, navigate to the Configuration > AP Groups menu option.

2. Select an AP Group.



3. To create a new virtual AP profile, select + and enter the name of the virtual AP profile in the New AP
groups field.

4. Click Submit.

Whenever you create a new virtual AP profile in the WebUI, the profile automatically contains the “default” SSID
profile with the default ESSID. You must configure a new ESSID and SSID profile for the virtual AP profile before you
apply the profile.

5. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

6. Select Wireless LAN > AAA under All Profiles.
7. Select the previously configured AAA profile from the AAA Profile drop-down list.

8. Click Save.

9. Select the previously configured SSID profile from the SSID Profile drop-down list.

10.Click Save.

11.Click the new virtual AP name in the Profiles list or the Profile Details to display configuration parameters.

12.Under Profile Details:

a. Ensure Virtual AP enable is selected.

b. Select the VLAN ID for the VLAN to be used for bridge, from the VLAN drop-down list.

c. Select Bridge from the Forward mode drop-down list.

d. Click Save.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following command:
(host) [mynode] (config) #wlan ssid-profile <profile> essid <name>

(host) [mynode] (config) #opmode <method>

(host) [mynode] (config) #wlan virtual-ap <profile>

(host) [mynode] (config) #ssid-profile <name>

(host) [mynode] (config) #forward-mode bridge

(host) [mynode] (config) #vlan <vlan id>

(host) [mynode] (config) #aaa-profile <profile>

(host) [mynode] (config) #ap-group <name>

(host) [mynode] (config) #virtual-ap <profile>

or
(host) [mynode] (config) #ap-name <name>

(host) [mynode] (config) #virtual-ap <profile>

Provisioning Wi-Fi Multimedia
Wi-Fi Multimedia (WMM) is a Wi-Fi Alliance specification based on the IEEE 802.11e wireless Quality of Service
(QoS) standard. WMM works with 802.11a, b, g, and n physical layer standards. The IEEE 802.11e standard
also defines the mapping between WMM access categories (ACs) and Differentiated Services Codepoint (DSCP)
tags. Remote APs support WMM.

WMM supports four ACs: voice, video, best effort, and background. You apply and configure WMM in the SSID
profile.
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When planning your configuration, make sure that immediate switches or routers do not have conflicting
802.1p or DSCP configurations/mappings. If this occurs, your traffic may not be prioritized correctly.

Reserving Uplink Bandwidth
You can reserve and prioritize uplink bandwidth traffic to provide higher QoS for specific applications, traffic, or
ports. This is done by applying bandwidth reservation on existing session ACLs. Typically, the bandwidth
reservation is applied for uplink voice traffic.

Note the following before you configure bandwidth reservation:

l You must know the total bandwidth available.

l The bandwidth reservation are applicable only on session ACLs.

l Bandwidth reservation on voice traffic ACLs receives higher priority over other reserved traffic.

l You can configure up to three unique priority for bandwidth reservation.

l The bandwidth reservation must be specified in absolute value (kbps).

l Priorities for bandwidth reservation are optional, and bandwidth reservations without priorities are treated
equal.

Understanding Bandwidth Reservation for Uplink Voice Traffic
The voice ACLs are applicable on the voice signaling traffic used to establish voice call through a firewall. When
a voice ACL is executed, a dynamic session is introduced to allow voice traffic through the firewall. This
prevents the re-use of voice ACLs for bandwidth reservation. However, you can create bandwidth reservation
rules that can be applied on voice signaling traffic and ports used for voice data traffic. This mechanism filters
traffic as per the security requirements.

Configuring Bandwidth Reservation
You can configure bandwidth reservation ACLs using the WebUI or the CLI.

In the WebUI
To configure bandwidth reservation

1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Click AP and select AP System.

3. Click + in AAA Profile.

4. Click Remote AP accordion. You can create a new AP system profile to configure bandwidth reservation or
edit an existing AP system profile. In Remote-AP bw reservation 1, Remote-AP bw reservation 2 and
Remote-AP bw reservation 3 fields, specify bandwidth reservation values.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [mynode] (config)#ap system-profile remotebw

(host) [mynode] (AP system profile "remotebw") #rap-bw-total 1024

(host) [mynode] (AP system profile "remotebw") #rap-bw-resv-1 acl voice 128 priority 1

To view bandwidth reservations:
(host) [mynode] #show datapath rap-bw-resv ap-name remote-ap-1



Provisioning 4G USB Modems on Remote Access Points
ArubaOS provides support for 4G networks by allowing you to provision 4G USB modems on the RAP. You can
also provision the RAP to support both 4G and 3G USB modems. This enables the RAP to choose the available
network automatically. 4G takes precedence over 3G when the RAP tries to auto select the network. You can
also configure the RAP to work exclusively on a 3G or 4G network. It is recommended that you provision the
USB modems for the RAP based on your network requirements.

4G USB Modem Provisioning Best Practices and Exceptions
l RAP does not support dynamic plug-and-play for the 4G USB modems. You must provision a RAP with the

4G USB parameters on the Mobility Master manually based on its type and family (4G-WiMAX/4G-LTE).

l When a RAP connects to a 4G network, it appears as a Remote AP (R) and Cellular (C) on the Mobility Master.

l For a 3G/4G network switch, using the UML290 modem with the firmware version L0290VWB522F.242 or
later is recommended. Using a lower version of the firmware auto-selects the network mode based on the
network availability. The latest version allows the RAP to lock the modem in a particular network mode (for
example, 3G only).

The 4G-WiMAX family of modems do not support the 3G-4G network switch-over functionality.

A new method of provisioning multimode USB modems (such as a Verizon UML290, Verizon MC551L, or AT&T
313u) for a remote AP has been introduced. These changes simplify modem provisioning for both 3G and 4G
networks. Earlier the modem configuration procedure required that you define a driver for a 3G modem in the
USB modem field under the AP provisioning profile, or define a driver for a 4G modem in the 4G USB type
field. You can now configure drivers for both a 3G or a 4G modem using the USB field, and the 4G USB Type
field is deprecated.

Provisioning RAP for USB Modems
To enable 3G/4G network support, you must provision the RAP with the USB parameters on the Mobility
Master. You can use the WebUI or CLI to provision the USB parameters.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > Access Points > Remote APs

tab.

2. Select the remote AP and click Provision.

3. Select Uplink tab. This tab is displayed only when one RAP is selected.

4. Select a profile from the USB Profile drop-down list. This field is displayed only when the device is
USB enabled.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.
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Parameter Description

auto (default) In this mode, the modem firmware will control the cellular network service selection; so
the cellular network service failover and fallback is not interrupted by the remote AP (RAP).

3g_only Locks the modem to operate only in 3G .

4g_only Locks the modem to operate only in 4G .

advanced The RAP controls the cellular network service selection based on an Received Signal
Strength Indication (RSSI) threshold-based approach.

l Initially the modem is set to the default auto mode. This allows the modem firmware to
select the available network.

l The RAP determines the RSSI value for the available network type (for example 4G),
checks whether the RSSI is within required range, and if so, connects to that network.

l If the RSSI for the modem’s selected network is not within the required range, the RAP
will then check the RSSI limit of an alternate network (for example, 3G), and reconnect
to that alternate network. The RAP will repeat the above steps each time it tries to
connect using a 4G multimode modem in this mode.

Table 130: Cellular Network Preference Parameters

In the CLI
To enable 4G-exclusive network support on the RAP, execute the following commands:
(host) [mynode] (config) #ap provisioning-profile <profile-name>

(host) [mynode] (Provisioning profile "<profile-name>") usb-type <USB modem type>

(host) [mynode] (Provisioning profile "<profile-name>") #usb-type none

(host) [mynode] (Provisioning profile "<profile-name>") #cellular_nw_preference 4g_only

To enable 3G-exclusive network support on the RAP, execute the following commands:
(host) [mynode] (config) #ap provisioning-profile <profile-name>

(host) [mynode] (Provisioning profile "<profile-name>") usb-type <USB modem type>

(host) [mynode] (Provisioning profile "<profile-name>") #usb-type none

(host) [mynode] (Provisioning profile "<profile-name>") #cellular_nw_preference 3g_only

To enable 3G/4G network switch support, execute the following commands:
(host) [mynode] (config) #ap provisioning-profile <profile-name>

(host) [mynode] (Provisioning profile "<profile-name>") usb-type <USB modem type>

(host) [mynode] (Provisioning profile "<profile-name>") #usb-type none

(host) [mynode] (Provisioning profile "<profile-name>") #cellular_nw_preference auto

RAP 3G/4G Backhaul Link Quality Monitoring
The RAP is enhanced to support link monitoring on 2G, 3G, and 4G modems to provide information about the
state of USB modem and cellular network.

The USB modem has the following four states:

l Active - The USB modem is used as the primary path for connecting VPN to the Mobility Master

l Standby or Backup - The network is available but the USB modem is not used for connecting VPN to the
Mobility Master

l Error - The USB modem is available but the modem is faulty

l Not Plugged - The USB modem is unavailable



To view the USB modem details on the RAP, execute the following command:
(host) [mynode] #show ap debug usb ap-name <ap-name>

Configuring RAP-3WN and RAP-3WNP Access Points
The ArubaRAP-3WN and RAP-3WNP are single-radio, single-band wireless APs that support the IEEE 802.11n
standard for high-performance WLAN. These APs use MIMO (Multiple-In, Multiple-Out) technology and other
high-throughput mode techniques to deliver high-performance, 802.11n 2.4 GHz functionality while
simultaneously supporting existing 802.11 b/g wireless services.

The Power Sourcing Equipment (PSE) functionality is available only for RAP-3WNP APs, as the PoE itself
provides the PSE functionality for RAP-3WN APs. You can use the WebUI or CLI to enable or disable the PSE
functionality on the RAP-3WNP APs.

In the WebUI
1. In the Mobility Master node hierarchy, navigate to the Configuration > System > Profiles tab.

2. Click AP and select AP Ethernet Link.

3. Select the default option.

4. Click Power over Ethernet check box.

5. Click Save. Support for RAP-3WN and RAP-3WNP access points (APs) is enabled.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
l To enable, enter:
(host) [mynode] (config) #ap enet-link-profile <name>

poe

l To disable, enter:
(host)[mynode] (config) #ap enet-link-profile <name>

no poe

Use the following command to view the PoE port status on an AP:
(host) [mynode] #show ap enet-link-profile default

Converting an IAP to RAP or CAP
For IAP to RAP or CAP conversion, the virtual controller sends the convert command to all the other IAPs. The
virtual controller along with the other slave IAPs then set up a VPN tunnel to the remote controller, and
download the firmware by FTP. The Virtual Controller uses IPsec to communicate to the controller over the
internet.

A mesh point cannot be converted to RAP because mesh does not support VPN connection.

The following table describes the supported IAP platforms and minimal AOS version for IAP to CAP/RAP
conversion.

Converting IAP to RAP
To convert an IAP to RAP, follow the instructions below:

1. Navigate to the Maintenance tab in the top right corner of the Instant UI.
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2. Click the Convert tab.

3. Select Remote APs managed by a Mobility Controller from the drop-down list.

4. Enter the hostname (fully qualified domain name) or the IP address of the managed device in the
Hostname or IP Address of Mobility Controller text box. This information is provided by your network
administrator.

Ensure the controller IP Address is reachable by the IAPs.

5. Click Convert Now to complete the conversion.

6. The IAP reboots and begins operating in RAP mode.

7. After conversion, the IAP is managed by the Aruba controller which has been specified in the Instant UI.

In order for the RAP conversion to work, ensure that you configure the Instant AP in the RAP white-list and enable the
FTP service on the controller.

If the VPN setup fails and an error message pops up, please click OK, copy the error logs and share them with your
Aruba support engineer.

Converting an IAP to CAP
To convert an IAP to a Campus AP, do the following:

1. Navigate to the Maintenance tab in the top right corner of the Instant UI.

2. Click the Convert tab.

3. Select Campus APs managed by a Mobility Controller from the drop-down list.

4. Enter the hostname (fully qualified domain name) or the IP address of the controller in the Hostname or
IP Address of Mobility Controller text box. This is provided by your network administrator.

Ensure that the controller IP Address is reachable by the APs.

5. Click Convert Now to complete the conversion.

Enabling Bandwidth Contract Support for RAPs
This release of ArubaOS provides Bandwidth Contract support on remote APs. This is achieved by extending
the Bandwidth Contract support on split-tunnel and bridge modes.

You can apply Bandwidth Contract for a RAP on a per-user or per-role basis. Bandwidth Contract is applied on a
per-role basis by default. This implies that all the users belonging to the same role will share the bandwidth
pool. When Bandwidth Contract configured on the managed device is attached to a user-role, it automatically
gets pushed to the RAPs terminating on it.

The following show commands have been enhanced in this release to retrieve the Bandwidth Contract
information from the RAP:
(host) [mynode] #show datapath user ap-name <ap-name>

(host) [mynode] #show datapath bwm ap-name <ap-name>

Configuring Bandwidth Contracts for RAP
You can configure bandwidth contracts for RAP on a per-role or per-user basis. The following examples
illustrate how to configure, apply, and verify the Bandwidth Contracts on the RAPs.



Defining Bandwidth Contracts
Use the following command to define a 256 Kbps contract:
(host) [mynode] (config) #aaa bandwidth-contract 256k kbits 256

Use the following command to define a 512 Kbps contract
(host) [mynode] (config) #aaa bandwidth-contract 512k kbits 512

Applying Contracts
You can apply the contract on a per-role or per-user basis.

Applying Contracts Per-Role

Use the following commands to apply the contracts on a per-role basis for upstream and downstream:

For upstream contract of 512 Kbps:
(host) [mynode] (config) #user-role authenticated bw-contract 512k upstream

For downstream contract of 256 Kbps:
(host) [mynode] (config) #user-role authenticated bw-contract 256k downstream

Applying Contracts Per-User

Use the following commands to apply the contracts on a per-user basis for upstream and downstream:

For upstream contract of 512 Kbps:
(host) [mynode] (config) #user-role authenticated bw-contract 512k per-user upstream

For downstream contract of 256 Kbps:
(host) [mynode] (config) #user-role authenticated bw-contract 256k per-user downstream

Verifying Contracts on AP
The following example displays the bandwidth contracts on AP for per-role configuration:
(host) [mynode] #show datapath bwm ap-name rap5-2

Datapath Bandwidth Management Table Entries

-------------------------------------------

Contract Types :

0 - CP Dos 1 - Configured contracts 2 - Internal contracts

-----------------------------------------------

Flags: Q - No drop, P - No shape(Only Policed),

T - Auto tuned

--- -------- --------- ---------- ----------- -----------------

Cont Avail Queued/Pkts

Type Id Bits/sec Policed Bytes Bytes Flags

---- ---- --------- ---------- ------- ------------ -----

1 1 512000 0 16000 0/0 P

1 2 256000 0 8000 0/0 P

The following example displays the bandwidth contracts on AP for per-user configuration (contract IDs 3 and 4
are per-user contracts):
(host) [mynode] #show datapath bwm ap-name rap5-2

Datapath Bandwidth Management Table Entries

-------------------------------------------

Contract Types :

0 - CP Dos 1 - Configured contracts 2 - Internal contracts

-----------------------------------------------

Flags: Q - No drop, P - No shape(Only Policed),

T - Auto tuned

--- -------- --------- ---------- ----------- -----------------

Cont Avail Queued/Pkts
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Type Id Bits/sec Policed Bytes Bytes Flags

---- ---- --------- ---------- ------- ------------ -----

1 1 512000 300 16000 0/0 P

1 2 256000 277 8000 0/0 P

1 3 512000 0 16000 0/0 P

1 4 256000 0 8000 0/0 P

Verifying Contracts Applied to Users
You can verify if the contracts are applied to the user after the user connects to the AP using CLI.

The following is a sample output for a per-role configuration:
(host) [mynode] #show datapath user ap-name rap5-2

Datapath User Table Entries

---------------------------

Flags: P - Permanent, W - WEP, T- TKIP, A - AESCCM, G - AESGCM, V - ProxyArp to/for MN

(Visitor),

N - VPN, L - local, Y - Any IP user, R - Routed user, M - Media Capable,

S - Src NAT with VLAN IP, E - L2 Enforced, F - IPIP Force Delete, O - VOIP user

FM(Forward Mode): S - Split, B - Bridge, N - N/A

IP MAC ACLs Contract Location Age Sessions Flags Vlan FM

--------------- ----------------- ------- --------- -------- --- --------- ----- ----

--

10.15.72.50 00:0B:86:61:12:AC 2703/0 0/0 0 16 1/65535 P 0

N

10.15.72.253 00:18:8B:A9:A8:DF 52/0 1/2 0 1 0/65535 1

S

192.168.11.1 00:0B:86:66:03:3F 2700/0 0/0 0 20024 0/65535 P 177

N

10.15.196.249 00:0B:86:66:03:3F 2700/0 0/0 0 3 1/65535 P 1

N

The following is a sample output for a per-user configuration:
(host) [mynode] #show datapath user ap-name rap5-2

Datapath User Table Entries

---------------------------

Flags: P - Permanent, W - WEP, T- TKIP, A - AESCCM, G - AESGCM, V - ProxyArp to/for MN

(Visitor),

N - VPN, L - local, Y - Any IP user, R - Routed user, M - Media Capable,

S - Src NAT with VLAN IP, E - L2 Enforced, F - IPIP Force Delete, O - VOIP user

FM(Forward Mode): S - Split, B - Bridge, N - N/A

IP MAC ACLs Contract Location Age Sessions Flags Vlan FM

--------------- ----------------- ------- --------- -------- --- --------- ----- ----

--

10.15.72.50 00:0B:86:61:12:AC 2703/0 0/0 0 11 0/65535 P 0

N

10.15.72.253 00:18:8B:A9:A8:DF 52/0 3/4 0 46 0/65535 1

S

192.168.11.1 00:0B:86:66:03:3F 2700/0 0/0 0 20883 0/65535 P 177

N

10.15.196.249 00:0B:86:66:03:3F 2700/0 0/0 0 15 1/65535 P 1

N

Verifying Bandwidth Contracts During Data Transfer
You can verify the Bandwidth Contracts that are in use during data transfer using CLI.

The following is a sample output for a per-role configuration:
(host) [mynode] #show datapath session ap-name rap5-2 table 10.15.72.99

Datapath Session Table Entries

------------------------------

Flags: F - fast age, S - src NAT, N - dest NAT

D - deny, R - redirect, Y - no syn



H - high prio, P - set prio, T - set ToS

C - client, M - mirror, V - VOIP

Q - Real-Time Quality analysis

I - Deep inspect, U - Locally destined

E - Media Deep Inspect, G - media signal

RAP Flags: 1 - Class 1, 2 - Class 2, 3 - Class 3

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age Destination TAge Flags

-------------- -------------- ---- ----- ----- ---- ---- --- --- ----------- ---- -----

10.15.72.253 10.15.72.99 6 5001 36092 1/1 0 0 0 dev12 6

10.15.72.253 10.15.72.99 6 3488 5001 1/1 0 0 0 dev5 6 C

10.15.72.99 10.15.72.253 6 5001 3488 1/2 0 0 0 dev5 6

10.15.72.99 10.15.72.253 6 36092 5001 1/2 0 0 0 dev12 6 C

The following is a sample output for a per-user configuration:
(host) [mynode] #show datapath session ap-name rap5-2 table 10.15.72.99

Datapath Session Table Entries

------------------------------

Flags: F - fast age, S - src NAT, N - dest NAT

D - deny, R - redirect, Y - no syn

H - high prio, P - set prio, T - set ToS

C - client, M - mirror, V - VOIP

Q - Real-Time Quality analysis

I - Deep inspect, U - Locally destined

E - Media Deep Inspect, G - media signal

RAP Flags: 1 - Class 1, 2 - Class 2, 3 - Class 3

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age Destination TAge Flags

-------------- -------------- ---- ----- ----- ---- ---- --- --- ----------- ---- -----

10.15.72.253 10.15.72.99 6 3489 5001 1/3 0 0 0 dev5 37 FC

10.15.72.99 10.15.72.253 6 5001 3489 1/4 0 0 0 dev5 37 F

10.15.72.99 10.15.72.253 6 36096 5001 1/4 0 0 0 dev12 37 C

10.15.72.253 10.15.72.99 6 5001 36096 1/3 0 0 0 dev12 37
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Chapter 32
Virtual Intranet Access

Virtual Intranet Access (VIA) is part of the Aruba remote networks solution intended for teleworkers and mobile
users. VIA detects the network environment (trusted and untrusted) of the user and connects the users to the
enterprise network. Trusted networks refers to a protected office network that allows users to directly access
the corporate intranet. Untrusted networks are public Wi-Fi hotspots such as airports, cafes, or home network.

The VIA solution includes the VIA client, Mobility Master with managed device configuration.

l VIA client— Remote workers and mobile users can install VIA on their computers and smart devices (iOS and
Android) to connect to their enterprise network from remote locations.

l Mobility Master and managed device configuration— To setup VIA for remote users, configure the VPN for
VIA in the Mobility Master and configure the authentication profile, and connection profile in the managed
network.

In the WebUI, VIA options are in the following navigations:

n In the Mobility Master node hierarchy, navigate to Configuration > Services > VPN > VIA.

n In the Managed Network node hierarchy, navigate to Configuration > Authentication > L3
Authentication.

VIA requires the PEFV license.

Figure 59 VIA Topology
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Chapter 33
Spectrum Analysis

Wireless networks operate in environments with electrical and radio frequency devices that can interfere with
network communications. Microwave ovens, cordless phones, and even adjacent Wi-Fi networks are all
potential sources of continuous or intermittent interference. The spectrum analysis software modules on APs
that support this feature examine the radio frequency (RF) environment in which the Wi-Fi network is
operating, identify interference and classify its sources. An analysis of the results quickly isolate issues with
packet transmission, channel quality, and traffic congestion caused by contention with other devices operating
in the same band or channel.

AP radios that gather spectrum data but do not service clients are called spectrum monitors, or SMs. Each SM
scans and analyzes the spectrum band used by the SM's radio (2.4Ghz or 5Ghz). An AP radio in hybrid AP mode
continues to serve clients as an access point while analyzing spectrum analysis data for the channel the radio
uses to serve clients. You can record data for both types of spectrum analysis devices, save that data, and then
play it back for later analysis.

Topics in this chapter include:

l Understanding Spectrum Analysis on page 674

l Creating Spectrum Monitors and Hybrid APs on page 679

l Connecting Spectrum Devices to Spectrum Analysis Client on page 681

l Configuring Spectrum Analysis Dashboards on page 683

l Customizing Spectrum Analysis Graphs on page 685

l Working with Non-Wi-Fi Interferers on page 699

l Understanding Spectrum Analysis Session Log on page 700

l Viewing Spectrum Analysis Data on page 700

l Recording Spectrum Analysis Data on page 701

l Troubleshooting Spectrum Analysis on page 703

Understanding Spectrum Analysis
The table below lists the AP models that support the spectrum analysis feature. Single-radio mesh APs do not
support the spectrum analysis feature; if an AP radio has a virtual AP carrying mesh backhaul traffic, no other
virtual AP on that radio can be configured as a spectrum monitor. However, dual-radio mesh APs can have the
client access radio configured as a Spectrum monitor or hybrid AP while the other radio supports mesh
backhaul traffic.
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Device
Configurable as a
Spectrum
Monitor?

Configurable as a
Hybrid AP?

320 Series Yes Yes

210 Series Yes Yes

200 Series Yes Yes

220 Series Yes Yes

270 Series Yes Yes

AP-114 Yes Yes

AP-115 Yes Yes

AP-104 Yes Yes

AP-105 Yes Yes

130 Series Yes Yes

AP-175 Yes No

RAP-3WN Series Yes No

Table 131: Device Support for Spectrum Analysis

The radios on groups of APs can be converted to dedicated spectrum monitors or hybrid APs via the AP group’s
dot11a and dot11g radio profiles. Individual APs can also be converted to spectrum monitors through the AP’s
spectrum override profile.

The spectrum analysis feature requires the RF Protect license. To convert an AP to a spectrum monitor or hybrid AP,
you must have an AP license and an RFProtect license for each AP on that managed device.

The Spectrum Analysis tab of the Diagnostics > Tools in the WebUI includes the Spectrum Dashboards ,
Spectrum Monitors, and Session Log windows.

l Spectrum Monitors: this window displays a list of active spectrum monitors and hybrid APs streaming
data to your client, the radio band the device is monitoring, and the date and time the SM or hybrid AP was
connected to your client. This window allows you to select the spectrum monitors or hybrid APs for which
you want to view information, and release the connection between your client and any device you no longer
want to view.

l Session Log: this tab displays activity for spectrum monitors and hybrid APs during the current browser
session, including timestamps showing when the devices were connected to and disconnected from the
client, and any changes to a hybrid APs monitored channel.

l Spectrum Dashboards: this window shows different user-customizable data charts for 2.4 Ghz and 5 GHz
spectrum monitor or hybrid AP radios. Table 132 below gives a basic description of each of the spectrum
analysis graphs that can appear on the spectrum dashboard.



For more detailed information on these graphs, refer to Customizing Spectrum Analysis Graphs on page 685.

Graph Title Description Update
Interval

Active
Devices

A pie chart showing the percentages and total numbers of each
device type for all active devices. This graph has no set update
interval; the graph automatically updates when values change.
For details, see Active Devices on page 685.

N/A

Active
Devices
Trend

A line chart showing the numbers of up to five different types of
Wi-Fi and non-Wi-Fi devices seen on selected channels during a
specified time interval. This chart can show devices on multiple
channels for a spectrum monitor, or the single monitored
channel for a hybrid AP. For details, see Active Devices Trend
on page 686.

5 seconds

Channel
Metrics

This stacked bar chart shows the current relative quality,
availability or utilization of selected channels in the 2.4 GHz or 5
GHz radio bands. This chart can show multiple channels for a
spectrum monitor, or the single monitored channel for a hybrid
AP. For details, see Channel Metrics on page 687.

5 seconds

Channel
Metrics Trend

A line chart showing the relative quality or availability of
selected channels in the 2.4 GHz or 5 GHz radio bands over a
specified time interval. Spectrum monitors can show channel
data for multiple channels, while a hybrid AP shows information
only for its one monitored channel. For details, see Channel
Metrics Trend on page 688.

5 seconds

Channel
Utilization
Trend

A line chart that shows the channel utilization for one or more
radio channels, as measured over a defined time interval.
Spectrum monitors can show data for multiple channels, while a
hybrid AP shows utilization levels for its one monitored channel
only. For details, see Channel Utilization Trend on page 689.

5 seconds

Device Duty
Cycle

A stacked bar chart showing the percent of each channel in the
spectrum monitor radio’s frequency band used by a Wi-Fi AP or
any other device type detected by the spectrum monitor. The
Device Duty Cycle chart for a hybrid AP only shows data for the
one channel monitored by the hybrid AP. For details, see Device
Duty Cycle on page 690.

5 seconds

Devices vs
Channel

A stacked bar chart showing the total numbers of each device
type detected on each channel in the spectrum monitor radio’s
frequency band. The Devices vs Channel chart for a hybrid AP
only shows data for the one channel monitored by the hybrid
AP. For details, see Devices vs Channel on page 691.

5 seconds

Table 132: Spectrum Analysis Graphs
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Graph Title Description Update
Interval

FFT Duty
Cycle

Fast Fourier Transform, or FFT, is an algorithm for computing
the frequency spectrum of a time-varying input signal. This line
chart shows the FFT duty cycle, which represents the percent of
time a signal is broadcast on the specified channel or
frequency. Spectrum monitors can show data for multiple
channels, while a hybrid AP shows information only for its one
monitored channel.

For details, see FFT Duty Cycle on page 692.

1 second

Interference
Power

This chart shows information about Wi-Fi interference, including
the Wi-Fi noise floor, and the amount of adjacent channel
interference from cordless phones, bluetooth devices and
microwaves. Spectrum monitors can show interference power
data for multiple channels, while a hybrid AP shows information
only for its one monitored channel. For details, see Interference
Power on page 693.

5 seconds

Quality
Spectrogram

This plot shows quality statistics for selected range of channels
or frequencies as determined by the current noise floor, non-
Wi-Fi (interferer) utilization and duty-cycles and certain types of
retries. This chart can also be configured to show channel
availability, the percentage of each channel that is unused and
available for additional traffic. Spectrum monitors can show
data for multiple channels, while a hybrid AP shows information
only for its one monitored channel. For details, see Quality
Spectrogram on page 694.

5 seconds

Real-Time FFT Fast Fourier Transform, or FFT, is an algorithm for computing
the frequency spectrum of a time-varying input signal. This line
chart shows the power level of a signal on the channels or
frequencies monitored by a spectrum monitor radio. Spectrum
monitors can show data for multiple channels, while a hybrid AP
shows information only for its one monitored channel. For
details, see Real-Time FFT on page 695.

1 second

Swept
Spectrogram

This plot displays FFT power levels For details, see or the FFT
duty cycle for a selected channel or frequency, as measured
during each time tick. Spectrum monitors can show data for
multiple channels, while a hybrid AP shows information only for
its one monitored channel. For details, see Swept Spectrogram
on page 697.

1 second

Spectrum Analysis Clients
The maximum number of spectrum monitor radios and hybrid AP radios on a stand-alone controller is limited
only by the number of APs on that stand-alone controller. If desired, you can configure every radio on an AP
that supports the Spectrum Analysis feature as a spectrum device. A dual-radio AP can operate as two
spectrum devices, because each radio can be individually configured as a spectrum monitor (SM) or hybrid AP.

A spectrum analysis client can simultaneously access data from up to four individual spectrum device radios.
Each spectrum device radio, however, can only be connected to a single client WebUI.

When you select a specific spectrum monitor or hybrid AP radio to stream data to your client, the stand-alone
controller first verifies the device is not subscribed to some other client. Once the SM or hybrid AP radio has
been verified as available, the SM or hybrid AP establishes a connection to the client and begins sending



spectrum analysis data either every second or every five seconds, depending on the type of data being
requested. Each client may select up to twelve different spectrum analysis charts and graphs to appear in the
spectrum dashboard.

A stand-alone controller can support up to 22 active WebUI connections. If spectrum analysis clients are
simultaneously viewing data for than 22 WebUI connections, any additional WebUI requests are refused until
some clients close their WebUI browser sessions.

When you finish reviewing data from an SM or hybrid AP, you should disconnect the device from your
spectrum client. Do not forget this important step—no other user can access data from that spectrum monitor
or hybrid AP until you release your subscription. Note, however, that when you disconnect a spectrum monitor
from your client, the AP continues to operate as a spectrum monitor until you return it to AP mode by removing
the local spectrum override, or by changing the mode parameter in the AP’s 802.11a or 802.11g radio profile
from spectrum-mode back to AP-mode.

A spectrum monitor or hybrid AP automatically disconnects from a client when you close the browser window you
used to connect the spectrum monitor to your client. However, if you use Internet Explorer and have multiple
instances of an Internet Explorer browser open, the data-streaming connection to the spectrum monitor or hybrid
AP is not released until 60 seconds after you close the spectrum client browser window. During this 60-second
period, the spectrum monitor is still connected to the client.

When a spectrum monitor or hybrid AP is not subscribed to any client, it still performs all classification tasks
and collect all necessary channel lists and device information. You can view classification, device, and channel
information for any active spectrum monitor or hybrid AP via the stand-alone controller's command-line
interface, regardless of whether or not that device is sending real-time spectrum data to another client WebUI.

Individual spectrum analysis graphs and charts are explained in detail in Customizing Spectrum Analysis Graphs
on page 685.

Hybrid AP Channel Changes
By default, a hybrid AP only monitors the channel specified in its 802.11a or 802.11g radio profile for
spectrum interference. If you want to change the channel monitored by a hybrid AP, you must edit the channel
setting in those profiles. However, there are other ArubaOS features that may automatically change the
channels on hybrid APs. APs using Dynamic Frequency Selection (DFS) perform off-channel scanning to detect
the presence of satellite and radar transmissions, and switch to a different channel if it detects that satellite or
radar transmissions are present. APs using the Adaptive Radio Response (ARM) feature constantly monitor the
network and automatically select the best channel and transmission power settings for that AP. If you
manually change a channel monitored by a hybrid AP, best practices are to temporarily disable ARM, as ARM
may automatically return the channel to its previous setting.

If a hybrid AP is using ARM or DFS, that hybrid AP may automatically move to a different channel in response
to changes in the network environment. If a hybrid AP changes channels while it is connected to a spectrum
analysis client, the hybrid AP updates the graphs in the spectrum dashboard to start displaying spectrum data
for the new channel, and sends a log message to the session log. For details on changing the channel
monitored by a hybrid AP, see 2.4 Ghz and 5 Ghz Radio RF Management on page 523.

Hybrid APs Using Mode-Aware ARM
If a radio is configured as a hybrid AP and that AP is enabled with mode-aware ARM, the hybrid AP can change
to an Air Monitor (or AM) if too many APs are detected in the area. If ARM changes a hybrid AP to an Air
Monitor, that AM does not provide spectrum data after the mode change. The AM unsubscribes from any
connected spectrum analysis client, and sends a log message warning about the change. If mode-aware ARM
changes the AM back to an AP, the hybrid AP does not automatically resubscribe back to the spectrum analysis
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client. The hybrid AP must manually resubscribed before it can appear in the client’s spectrum monitors
page.

Creating Spectrum Monitors and Hybrid APs
Each stand-alone controller can support up to 22 active WebUI connections to spectrum monitor or hybrid AP
radios. If you plan on using spectrum monitors or hybrid APs as a permanent overlay to constantly monitor
your network, you should create a separate AP group for these devices. If you plan on temporarily converting
campus APs to spectrum monitors, best practices are to use the spectrum local override profile to convert an
AP to a spectrum monitor.

This section describes the following tasks for converting regular APs into hybrid APs or spectrum monitors.

l Converting APs to Hybrid APs on page 679

l Converting AP to Spectrum Monitor on page 680

l Converting Group of APs to Spectrum Monitors on page 680

Converting APs to Hybrid APs
You can convert a group of regular APs into a group of hybrid APs by selecting the spectrum monitor option
in the AP group’s 802.11a and 802.11g radio profiles. Once you have enabled the spectrum monitoring option,
all APs in the group that support the spectrum monitoring feature start to function as hybrid APs. If any AP in
the group does not support the spectrum monitoring feature, that AP continues to function as a standard AP,
rather than a hybrid AP.

The spectrum monitoring option in the 802.11a and 802.11g radio profiles only affects APs in ap-mode. Devices in
am-mode (Air Monitors) or sm-mode (Spectrum Monitors) are not affected by enabling this option.

If you want to convert a individual AP (and not an entire AP group) to a hybrid AP, you must create a new
802.11a or 802.11g radio profile, enable the spectrum monitor option, then reassign that AP to the new
profile. For additional information see Creating and Editing Mesh High-Throughput SSID Profiles on page 568
for details on how to create a new 802.11a/g radio profile, then assign an individual AP to that profile.

If the spectrum local-override profile on the stand-alone controller that terminates the AP contains an entry for a
hybrid AP radio, that entry overrides the mode selection in the 802.11a or 802.11g radio profile, and the AP operates
as a spectrum monitor, not as a hybrid AP. You must remove any spectrum local override for an AP to allow the
device to operate as a hybrid AP. For further details on editing a spectrum local override, see Converting AP to
Spectrum Monitor on page 680.

In the WebUI
Follow the procedure below to convert a group of APs to hybrid mode via the WebUI.

1. In the Mobility Master node hierarchy, navigate to Configuration > AP Groups.

2. Select an AP Group.

3. Click Radio tab for the selected AP group.

4. Under Basic > Radio mode, select spectrum-mode under either 2.4 GHz or 5 GHz.

5. Click Submit.

In the CLI
To convert a group of APs via the command-line interface, access the CLI in config mode and issue the
following commands, where profile is the name of the 802.11a or 802.11g radio profile used by the group of
APs you want to convert to hybrid APs:



rf dot11a-radio-profile <profile> spectrum-monitoring

rf dot11g-radio-profile <profile> spectrum-monitoring

Converting AP to Spectrum Monitor
There are two ways to change a radio on an individual AP or AM into a spectrum monitor. You can assign that
AP to a different 802.11a and 802.11g radio profile that is already set to spectrum mode, or you can
temporarily change the AP into a spectrum monitor using a local spectrum override profile. When you use a
local spectrum override profile to override an AP’s mode setting, that AP begins to operate as a spectrum
monitor, but remains associated with its previous 802.11a and 802.11g radio profiles. If you change any
parameter (other than the overridden mode parameter) in the spectrum monitor’s 802.11a or 802.11 radio
profiles, the spectrum monitor immediately updates with the change. When you remove the local spectrum
override, the spectrum monitor reverts back to its previous mode, and remains assigned to the same 802.11a
and 802.11 radio profiles as before.

The spectrum local override profile overrides the mode parameter in the 802.11a or 802.11g radio profile,
changing it from ap-mode or am-mode to spectrum-mode, while allowing the spectrum monitor to continue to
inherit all other settings from its 802.11a/802.11g radio profiles. When the spectrum local override is
removed, the AP automatically reverts to its previous mode as defined it its 802.11a or 802.11g radio profile
settings. If you use the local override profile to change an AP radio to a spectrum monitor, you must do so by
accessing the WebUI or CLI of the stand-alone controller that terminates the AP.

In the WebUI
To convert an individual AP using the local spectrum override profile in the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System.

2. Select Profiles tab.

3. Select Spectrum Local Override.

4. In the Spectrum Local Override Profile, click +.

5. In the ap_name, enter the name of an AP whose radio you want to configure as a spectrum monitor. The
AP names are case-sensitive. Any extra spaces before or after the AP name prevents the AP from being
correctly added to the override list.

6. If your AP has multiple radios or a single dual-band radio, click the spectrum_band drop-down list and
select the spectrum band you want that radio to monitor: 2.4GHz or 5GHz.

7. Click OK to add that radio to the Override Entry list.

8. Repeat steps 4 through 7 to convert other AP radios to spectrum monitors, if required.

9. To remove spectrum monitor from the override entry list, select that radio name in the override entry list,
then click Delete.

10.Click Save.

In the CLI
To convert an individual AP spectrum monitor using the spectrum local override profile in the command-line
interface, access the CLI in config mode and issue the following command:
ap spectrum local-override override ap-name <ap-name> spectrum-band 2ghz|5ghz

Converting Group of APs to Spectrum Monitors
When you convert a group of APs to spectrum monitors using their 802.11a/802.11g radio profiles, all AP
radios associated with that profile stop serving clients and act as spectrum monitors only. Therefore, before
you convert an entire group of APs to spectrum monitors, be sure that none of the APs are currently serving
clients, as that may temporarily interrupt service to those clients.
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If you use an 802.11a or 802.11g radio profile to create a group of spectrum monitors, all APs in any AP group
referencing that radio profile are set to spectrum mode. Therefore, best practices are to create a new 802.11a or
802.11g radio profile just for spectrum monitors, using the following CLI commands:
ap-name <ap name> dot11a-radio-profile <profile-name>ap-name <ap name> dot11g-radio-profile

<profile-name>

If you want to set an existing 802.11a or 802.11g radio profile to spectrum mode, verify that no other AP group
references that radio profile, using the following CLI commands:
show references rf dot11a-radio-profile <profile-name>show references rf dot11g-radio-

profile <profile-name>

In the WebUI
Follow the procedure below to convert a group of APs to Spectrum mode via the WebUI.

1. In the Mobility Master node hierarchy, navigate to Configuration > AP Groups.

2. Select an AP Group.

3. Click Radio tab for the selected AP group.

4. Under Basic > Radio mode, select spectrum-mode under either 2.4 GHz or 5 GHz.

5. Click Submit.

In the CLI
To convert a group of APs via the command-line interface, access the CLI in config mode and issue the
following commands, where <profile> is the 80211a or 80211g radio profile used by the AP group.
rf dot11a-radio-profile <profile> mode spectrum-mode

rf dot11g-radio-profile <profile> mode spectrum-mode

Connecting Spectrum Devices to Spectrum Analysis Client
A spectrum analysis client is any laptop or desktop computer that can access a stand-alone controller WebUI
and receive streaming data from individual spectrum monitors or hybrid APs. Once you have configured one or
more APs to operate as a spectrum monitor or hybrid AP, use the Spectrum Monitors window to identify the
spectrum devices you want to actively connect to the spectrum analysis client.

The Spectrum Analysis option is not available if the license is not enabled or present.

To connect one or more spectrum devices to your client:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Monitors tab in the new window.

4. Click the Spectrum Monitors tab.

5. Click Add. A table appears, displaying a list of spectrum analysis devices, sorted by name. Single-radio
spectrum devices have a single entry in this table, and dual-radio spectrum devices have two entries: one for
each radio. This table displays the following data for each radio.



Table
Column Description

AP Name of the AP whose radio you want to convert to a spectrum monitor. AP names are
case sensitive.

This column includes the following icons:
  Radio is operating as a spectrum monitor.

Radio is operating as a hybrid AP with spectrum enabled.

Band The frequency band currently used by the radio. This value can be either 2.4 GHz or 5
GHz.

Model AP model type.

AP Group Name of the AP group to which the spectrum monitor is currently associated.

Mode This column indicates the type of spectrum analysis device:

l Spectrum Monitor: AP is in spectrum monitor mode.

l Access Point: AP is configured as an access point but with spectrum monitoring
enabled (Hybrid AP).

Availability for
Connection

Indicates if the AP is available to send spectrum analysis data to the client. Possible
options ares:

l Available, 2.4GHz: the radio is available to send spectrum analysis data on the
2.4GHz frequency band.

l Available, 5GHz: the radio is available to send spectrum analysis data on the 5GHz
frequency band.

l Available, Dual Band: the radio is available and is capable of sending spectrum
analysis data on either the 2.4 GHz or the 5 GHz frequency bands.

l Available, current channel - <channel>: the AP radio is in hybrid mode and can
display spectrum analysis data for the single specified channel only.

l Not available: an AP may not be available because it is currently sending spectrum
analysis data to another client.

Table 133: Spectrum Device Selection Information

6. Click the table entry for a spectrum monitor radio, then click Connect.

7. Repeat steps 3-4 to connect additional devices, if desired.

View Connected Spectrum Analysis Devices
Once you have connected one or more spectrum monitors or hybrid APs to your Spectrum Analysis client, the
Diagnostics > Tools > Spectrum Analysis > Spectrum Monitors window displays a table of currently
connected spectrum devices. This table includes the name of each spectrum monitor or hybrid AP and its
current radio band (2 GHz or 5 GHz):

To view a list of connected spectrum devices via the command-line interface, issue the show ap spectrum
monitors command:
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Disconnecting Spectrum Device
A spectrum monitor or hybrid AP can send spectrum analysis data to only one client at a time. When you are
done viewing data for a spectrum device, you should release your client’s subscription to that spectrum device
and allow other clients to view data from that device. A spectrum monitor or hybrid AP automatically
disconnects from your client when you close the browser window used to connect the spectrum device your
client.

To manually disconnect a spectrum monitor or hybrid APs:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Monitors tab in the new window.

4. Click the Spectrum Monitors tab.

5. Each table entry in the Currently Connected table includes a Disconnect link to release the client’s
connection to that spectrum monitor. Identify the table entry for the spectrum monitor you want to
release then click Disconnect.

6. A popup window asks you to confirm that you want to disconnect the spectrum monitor from the
spectrum analysis client. Click OK. The spectrum monitor disconnects from the client and the device’s entry
is removed from the Currently Connected table.

When you disconnect a spectrum device from your client, the AP continues to operate as a spectrum monitor
or hybrid AP until you return the device to AP mode by removing the local spectrum override, or by changing
the mode parameter in the AP’s 802.11a or 802.11g radio profile from spectrum-mode to AP-mode.

If you are use Internet Explorer with multiple instances of the Internet Explorer browser open, and you close the
spectrum browser window without manually disconnecting the spectrum device, the stand-alone controller does not
release the data streaming connection to a spectrum monitor until 60 seconds after you close the spectrum client
browser window. During this 60-second period, the spectrum monitor is still connected to the client.

Configuring Spectrum Analysis Dashboards
Once you have connected spectrum monitors to your spectrum analysis client, you can begin to monitor
spectrum data in the spectrum analysis dashboards. There are three predefined sets of dashboard views, View
1, View 2 and View 3. View 1 displays the Real-Time FFT, FFT Duty-Cycle and Swept Spectrogram graphs by
default, and Views 2 and 3 display the Swept Spectrogram and Quality Spectrogram charts, and the Channel
Summary and Active Devices tables.

Spectrum Analysis dashboards are available only on stand-alone controllers.

Each chart in the dashboard can be replaced with other chart types, or reconfigured to show data for a
different spectrum monitor. Once you have configured a dashboard view with different settings, you can
rename that dashboard view to better reflect its new content.

The following sections explain how to customize your Spectrum Analysis dashboard to best suit the needs of
your individual network:

l Selecting Spectrum Monitor on page 684

l Changing Graphs within Spectrum View on page 684

l Renaming Spectrum Analysis Dashboard View on page 684

l Saving Dashboard View on page 684

l Resizing Individual Graph on page 685



Selecting Spectrum Monitor
When you first log into the Spectrum Analysis dashboard, it displays blank charts. You must identify the
spectrum monitor whose information you want to view before the graphs display any data.

To identify the spectrum monitor radio whose data you want to appear in the Spectrum Analysis dashboard:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Monitors tab in the new window.

4. Click Add.

5. Select a spectrum monitor from the list and click Connect.

After you have selected the initial spectrum monitor or hybrid AP for a graph, you can display data for a
different spectrum device at any time by clicking the down arrow by the device name in the chart titlebar and
selecting a different connected spectrum monitor or hybrid AP.

Changing Graphs within Spectrum View
To replace an existing graph with any other type of graph or chart:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Dashboards tab.

4. From Spectrum Dashboards window, click one of the view names at the top of the window to select the
dashboard layout with the graph you want to change.

5. Click the down arrow at the far right end of the graph title bar to display a drop-down list of chart options.

6. Click Replace With to display a list of available graphs.

7. Click the name of the new graph you want to display.

Renaming Spectrum Analysis Dashboard View
You can rename any of the three spectrum analysis dashboard views at any time. However, renaming a view
does not save its settings. (For details on saving a spectrum dashboard view, refer to Saving Dashboard View
on page 684.)

To rename a Spectrum Analysis Dashboard view:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Dashboards tab.

4. Click the down arrow to the right of the dashboard view you want to rename.

5. Select Rename.

6. The Dashboard Name popup window appears. Enter a new name for the dashboard view, then click OK.

Saving Dashboard View
You can select different graphs to display in a dashboard view, but these changes are not saved unless you
save that view. Dashboard views, (like the spectrum analysis profile and spectrum local-override profile) are all
local configurations that must be configured on each stand-alone controller.

To save a dashboard view:

1. After selecting the graphs you want to appear in the view, click Save Spectrum Views at the top of the
window.
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2. The Spectrum View saved successfully confirmation window appears when the spectrum view has been
saved.

If you change graphs in a spectrum view but do not save your settings, you are prompted to save or cancel your
changes when you close the spectrum dashboard browser window

Resizing Individual Graph
The left side of the title bar for each graph includes a resizing button on that allows you to expand a graph for
easier viewing. Click this button as shown in to expand the selected graph to the size of the full window and
display the Options pane, which allows you to change the current display options for that graph.
(Configuration options are described in Spectrum Analysis Graph Configuration Options on page 685). To close
the options pane if you have not made any changes to the graph, click Close at the bottom of the Options
pane or click the resize button again to return the graph to its original size. To save any changes to the graph,
click OK to save your settings and close the Options pane.

Customizing Spectrum Analysis Graphs
Each Spectrum Analysis graph can be customized to display or hide selected data types. To view the available
options for a graph type:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Dashboards tab in the new window.

4. Click the down arrow at the end of the title bar for the graph you want to configure.

5. Select Options. The Options window appears to the right of the graph.

6. From the Options window, configure graph settings described in Spectrum Analysis Graph Configuration
Options on page 685.

7. When you are done, click Close at the bottom of the Options window to hide the options window.

8. Click Save Spectrum Views at the top of the window to save your new settings.

Spectrum Analysis Graph Configuration Options
The following sections describe the customizable parameters and the default settings for each spectrum
analysis graph.

Active Devices
This graph appears as a pie chart showing the percentages and total numbers of each device type for all active
devices seen by the spectrum monitor or hybrid AP radio. This chart is useful for determining which types of
devices are sending signals on the specified radio band or channel. The Active Devices graphs for spectrum
monitors can be configured to show data for several different device types on a single radio channel or range
of channels. Active Devices graphs for hybrid APs can show data for the single monitored channel only.

When you hover your mouse over any section of the pie chart, a tooltip displays the percentage and number of
active devices classified into that device type.

Click the down arrow in the upper right corner of this chart then click the Options menu to access the
configuration settings for the Active Devices graph. Once you have configured the desired parameters, click OK
at the bottom of the Options menu to save your settings and return to the spectrum dashboards.



Parameter Description

Band Radio band displayed in this graph (2.4 GHz or 5 GHz)

Channel num-
bering

This parameter is not configurable for graphs created by hybrid APs or spectrum mon-
itor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel sees 40
MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz radio band,
click the Channel Numbering drop-down list and select either 20 MHz or 40 MHz
channel numbering to identify a channel numbering scheme for the graph. Graphs for
AP radios that support 802.11ac include an additional 80MHz option for very-high-
throughput channels.

Channel Range For graphs created by spectrum monitors, specify a channel range to determine
which channels appears in this graph. Click the first drop-down list to select the
lowest channel in the range, then click the second drop-down list to select the highest
channel to appear in the graph.

This graph displays all channels within the spectrum monitor’s radio band by default.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Table 134: Active Devices Graph Options

Active Devices Trend
The Active Devices Trend chart is a line chart that shows the numbers of Wi-Fi and non-Wi-Fi devices seen on
each radio channel during the displayed time interval. When you hover your mouse over any line in the chart, a
tooltip displays the number of active devices for the selected device type.

An Active Devices Trend chart created by a hybrid AP displays data for the single channel monitored by that
device. For spectrum monitors, the Active Devices Trend chart can display values for up to five different
channels and device types. These graphs show the following data by default:

l For SMs on the 2.4 GHz radio band, Wi-Fi APs on channel 1, 6, and 11.

l For SMs on the 5 GHz band, Wi-Fi APs on channel 36, 40, and 44.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access the Active
Devices Trend configuration settings. Once you have configured the desired parameters, click OK at the
bottom of the Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph (2.4 GHz or 5 GHz).

Show Trend for Last Amount of elapsed time for which this chart should display data.

Channel Numbering This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5
GHz radio band, click the Channel Numbering drop-down list and select either 20
MHz or 40 MHz channel numbering to identify a channel numbering scheme for
the graph. Graphs for AP radios that support 802.11ac include an additional
80MHz option for very-high-throughput channels.

Table 135: Active Devices Trend Options
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Parameter Description

Show lines for these
channels

The Active Devices Trend chart can display values for up to five different device
types on different channels for a spectrum monitor, or a single device type for a
hybrid AP.

To choose which type of data each line should represent, click the channel
number drop-down list and select a channel within the radio band, then click the
device type drop-down list and select one of the following device types.

l WiFi (AP)

l Microwave (This option is only available for 2.4 GHz radios)

l Bluetooth (This option is only available for 2.4 GHz radios)

l Fixed Freq (Others)

l Fixed Freq (Cordless Phones)

l Fixed Freq (Video)

l Fixed Freq (Audio)

l Freq Hopper (Others)

l Freq Hopper (Cordless Network)

l Freq Hopper (Cordless Base)

l Freq Hopper Xbox (This option is only available for 2.4 GHz radios)

l Microwave (Inverter) (This option is only available for 2.4 GHz radios)

l Generic Interferer

Select the check box beside each channel and device entry to show that
information on the chart, or deselect the check box to hide that information. For
more information on non-Wi-Fi device types detected by a spectrum monitor, see
Working with Non-Wi-Fi Interferers on page 699.

Channel Metrics
This stacked bar chart can show one of three different types of channel metrics; channel utilization,
channel availability, or channel quality.

This chart displays channel utilization data by default, showing both the percentage of each monitored channel
that is currently being used by Wi-Fi devices, and the percentage of each channel being used by non-Wi-Fi
devices and 802.11 adjacent channel interference (ACI).

ACI refers to the interference on a channel created by a transmitter operating in an adjacent channel. A transmitter
on a nonadjacent or partially overlapping channel may also cause interference, depending on the transmit power of
the interfering transmitter and the distance between the devices. In general, ACI may be caused by a Wi-Fi
transmitter or a non-Wi-Fi interferer. However, whenever the term ACI appears in Spectrum Analysis graphs, it
refers to the ACI caused by Wi-Fi transmitters. The channel utilization option in the Channel Metrics Chart shows the
percentage of the channel utilization due to both ACI and non-Wi-Fi interfering devices. Unlike the ACI shown in the
Interference Power chart, the ACI shown in this graph indicates the percentage of channel time that is occupied by
ACI or unavailable for Wi-Fi communication due to ACI.

The Channel Metrics graph can also show channel availability, the percentage of each channel that is available
for use, or display the current relative quality of selected channels in the 2.4 GHz or 5 GHz radio bands.
Spectrum monitors can display data for all channels in their selected band. Hybrid APs display data for their
one monitored channel only.



In the spectrum analysis feature, channel quality is a relative measure that indicates the ability of the channel
to support reliable Wi-Fi communication. Channel quality, which is represented as a percentage in this chart, is a
weighted metric derived from key parameters that can affect the communication quality of a wireless channel,
including noise, non-Wi-Fi (interferer) utilization and duty-cycles, and certain types of retries. Note that channel
quality is not directly related to Wi-Fi channel utilization, as a higher quality channel may or may not be highly
used.

When you hover your mouse over any bar in the chart, a tooltip displays the metric value for that individual
channel. The example below shows that 61% of channel 3 is being consumed by non-Wi-Fi devices and 802.11
adjacent channel interference.

Click the down arrow in the upper right corner of this chart then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down
list and select 5 GHz upper, 5GHz middle or 5Ghz lowerto display data for that
portion of the 5 Ghz radio band. This parameter is not configurable for graphs
created by hybrid APs or spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz
radio band, click the Channel Numbering drop-down list and select either 20 MHz
or 40 MHz channel numbering to identify a channel numbering scheme for the
graph. Graphs for AP radios that support 802.11ac include an additional 80MHz
option for very-high-throughput channels.

Channel Range For graphs created by spectrum monitors, specify a channel range to determine
which channels appear in this graph. Click the first drop-down list to select the lowest
channel in the range, then click the second drop-down list to select the highest
channel to appear in the graph.

This graph displays all channels within the spectrum monitor’s radio band by default.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Display Mode Select Channel Quality to show the relative quality of the channel. Channel Quality
is a weighted metric derived from key parameters which include noise, non-Wi-Fi
(interferer) utilization and duty-cycles, and certain types of retries.

Select Channel Availability to show the percentage of the channel that is unused
and available for additional Wi-Fi traffic.

Select Channel Utilization to show both the percentage of the channel that is
currently used by Wi-Fi devices, and the percentage of each channel that is being
used by non-802.11 devices or 802.11 adjacent channel interference (ACI).

Table 136: Channel Metrics Options

Channel Metrics Trend
By default, this line chart shows the current relative quality of selected channels in the 2.4 GHz or 5 GHz radio
bands over a period of time. The Channel Metrics Trend chart can also be configured to display trends for the
current availability of selected channels, or the percentage of availability for those channels.Spectrum monitors
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can display data for up to five different channels. Hybrid APs display data for their one monitored channel
only.

For more information on how the spectrum analysis feature determines the quality of a channel, see Channel
Metrics on page 687.

When you hover your mouse over any line in the chart, a tooltip displays channel quality or availability data for
that individual channel at the selected time.

Click the down arrow in the upper right corner of this chart then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboard.

Parameter Description

Band Radio band displayed in this graph (2.4 GHz or 5 GHz).

Show Trend for Last The Channel Quality Trend chart shows channel quality or channel availability
for the past 10 minutes by default. To view data for a different time range, click
the Show Trend for Last drop-down list and select one of the following options:

l 10 minutes

l 30 minutes

l 1 hour

Channel numbering This parameter is not configurable for graphs created by hybrid APs or
spectrum monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20
MHz channel sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors
using the 5 GHz radio band, click the Channel Numbering drop-down list and
select either 20 MHz or 40 MHz channel numbering to identify a channel
numbering scheme for the graph. Graphs for AP radios that support 802.11ac
include an additional 80MHz option for very-high-throughput channels.

Show Lines for These
Channels

The Channel Quality Trend chart for a spectrum monitor can display channel
quality, channel availability, or channel utilization values for up to five different
channels on the selected radio band. Charts for hybrid APs can display data for
the one channel monitored by that hybrid AP radio.

To choose which type of data each line should represent on a chart for a
spectrum monitor, click the channel number drop-down list and select a
channel within the radio band, then click the second drop-down list and select
either Channel Quality, or Channel Availability.

Select the check box beside each channel entry to show that information on the
chart, or deselect the check box to hide that information.

Table 137: Channel Metrics Trend Options

Channel Utilization Trend
The Channel Utilization Trend chart is a line chart that shows the percentage of total utilization on each channel
over a time interval. The channel utilization includes the utilization due to Wi-Fi as well as utilization due to non-
Wi-Fi interferers and Adjacent Channel Interference (ACI).

For additional information on how the spectrum analysis feature measures ACI, see Channel Metrics on page 687.



This graph can show data recorded for the last ten, thirty, or sixty minutes. Spectrum monitors display
spectrum analysis data seen on all channels in the selected band, and hybrid APs display data from the one
channel they are monitoring. When you hover your mouse over any line in the chart, a tooltip shows the
percentage of the channel being utilized at the specified time.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Intervals The Channel Utilization Trend chart shows channel quality or channel availability
for the past 10 minutes by default. To view data for a different time range, click the
Intervals drop-down list and select one of the following options:

l 10 minutes

l 30 minutes

l 1 hour

Band Radio band displayed in this graph (2.4 GHz or 5 GHz).

Channel Numbering This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz
radio band, click the Channel Numbering drop-down list and select either 20
MHz or 40 MHz channel numbering to identify a channel numbering scheme for
the graph. Graphs for AP radios that support 802.11ac include an additional
80MHz option for very-high-throughput channels.

Show To select individual channels you want to display on this chart, click the check box
by a channel entry, then click the channel drop-down list to select the channel to
display. To hide a channel, uncheck the check box by that channel number.

Table 138: Channel Utilization Trend Options

Device Duty Cycle
The Device Duty Cycle Chart is a stacked bar chart that shows the duty cycle of each device type on a channel.
The duty cycle is the percentage of time each device type operates or transmits on that channel. Though Wi-Fi
devices do not transmit if there is another Wi-Fi or non-Wi-Fi device active at that time, most non-Wi-Fi devices
do not follow such a protocol for transmissions. Because these devices operate independently without regard
to any other devices operating on the same channel, the total duty cycle of all device types may add up to
more than 100% on a channel. For example, one or more video bridges may be active on a channel, each with a
100% duty cycle. The same channel may have a cordless transmitter with a 10% duty cycle and a microwave
oven with a 50% duty cycle. In this example, the Device Duty Cycle chart shows all three device types with their
respective duty cycle percentages.

A hybrid AP on a 20 MHz channel will see 40 MHz Wi-Fi data as non-Wi-Fi data.

Spectrum monitors display spectrum analysis data seen on all channels in the selected band, and hybrid APs
display data from the one channel they are monitoring. The example below shows data from a spectrum
monitor monitoring all channels in the 2.4 Ghz band.
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Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down list and
select 5 GHz upper, 5 GHz middle or 5 Ghz lower to display data for that portion of the
5 Ghz radio band. This parameter is not configurable for graphs created by hybrid APs or
spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum monitor
radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel sees 40 MHz Wi-
Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz radio band, click the
Channel Numbering drop-down list and select either 20 MHz or 40 MHz channel
numbering to identify a channel numbering scheme for the graph. Graphs for AP radios
that support 802.11ac include an additional 80 MHz option for very-high-throughput
channels.

Channel
Range

For graphs created by spectrum monitors, specify a channel range to determine which
channels appear in this graph. Click the first drop-down list to select the lowest channel in
the range, then click the second drop-down list to select the highest channel to appear in
the graph.

This graph displays all channels within the spectrum monitor’s radio band by default.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Table 139: Device Duty Cycle Options

Devices vs Channel
This stacked bar chart shows the current number of devices using each channel in the radio’s frequency band.
This chart can show separate per-channel statistics for the numbers of Wi-Fi devices, cordless phones,
bluetooth devices, microwaves, and other non-Wi-Fi devices.

If a device affects more than one channel, it is recorded as a device on all channels it affects. For example, if a
20Mhz Wi-Fi AP has a center frequency of 2437 Mhz (channel 6) it is counted as a device on channels 3-9
because it affects all those channels. Similarly, if a channel-hopping device uses all channels within a frequency
band, it is counted as a device on all channels in that band.

When you hover the mouse over any part of the chart, a tooltip shows the numbers of the device type
currently using that channel.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.



Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down
list and select 5 GHz upper, 5GHz middle or 5Ghz lower to display data for that
portion of the 5 Ghz radio band. This parameter is not configurable for graphs
created by hybrid APs or spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz
radio band, click the Channel Numbering drop-down list and select either 20 MHz or
40 MHz channel numbering to identify a channel numbering scheme for the graph.
Graphs for AP radios that support 802.11ac include an additional 80MHz option for
very-high-throughput channels.

Channel Range For graphs created by spectrum monitors, specify a channel range to determine
which channels appear in this graph. Click the first drop-down list to select the lowest
channel in the range, then click the second drop-down list to select the highest
channel to appear in the graph.

This graph displays all channels within the spectrum monitor’s radio band by default.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Table 140: Devices vs Channel Options

FFT Duty Cycle
The FFT Duty Cycle chart is a line chart that shows the duty cycle for each frequency bin. The width of the each
frequency bin depends on the resolution bandwidth of the spectrum monitor. The spectrum analysis feature
considers a frequency bin to be used if the detected power in that bin is at least 20 dB higher than the nominal
noise floor on that channel. The FFT Duty Cycle provides a more granular view of the duty cycle per bin as
opposed to the aggregated channel utilization reported in the Channel Metrics chart.

A hybrid AP on a 20 MHz channel will see 40 MHz Wi-Fi data as non-Wi-Fi data.

This chart can show the duty cycle over the last second, the maximum FFT duty cycle measured for all samples
taken over the last N sweeps, and the greatest FFT duty cycle recorded since the chart was last reset.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.
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Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-
down list and select 5 GHz upper, 5GHz middle or 5Ghz lower to display data
for that portion of the 5 Ghz radio band. This parameter is not configurable for
graphs created by hybrid APs or spectrum monitor radios that use the 2.4 GHz
radio band.

Channel Numbering This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz
radio band, click the Channel Numbering drop-down list and select either 20
MHz or 40 MHz channel numbering to identify a channel numbering scheme for
the graph. Graphs for AP radios that support 802.11ac include an additional
80MHz option for very-high-throughput channels.

X-Axis Select either Channel or Frequency to show the duty cycle for a range of
channels or frequencies.

Channel Range If you selected Channel in the X-Axis parameter, you must also specify a channel
range to determine which channels appear in the x-axis of this chart. Click the first
drop-down list to select the lowest channel in the range, then click the second
drop-down list to select the highest channel to appear in the chart.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Y-Axis Select either Frequency or Channel to show the duty cycle for a range of
frequencies or channels.

Show Select a check box to display that information on the FFT Duty Cycle chart.

l Duty Cycle: The percentage of duty cycle the channel or frequency was
actively used.

l Max Hold: The maximum recorded percentage of active duty cycles for the
channel frequency since the chart was last reset. To clear this setting, click the
down arrow at the end of the title bar for this graph and select Reset
MaxHold.

l Max of last sweeps: This chart shows the maximum percentage of active duty
cycles for the channel of frequency recorded during the last 10 sweeps, by
default. To change the number of sweeps used to determine this value, enter a
number from 2 to 20, inclusive. To clear this setting, click the down arrow at the
end of the title bar for this graph and select Reset MaxNSweep.

Table 141: FFT Duty Cycle Options

Interference Power
The Interference Power chart displays various power levels of interest, including the Wi-Fi AP with maximum
signal strength, noise, and interferer types with maximum signal strength. The ACI displayed in the Interference
Power Chart is the ACI power level based on the signal strength(s) of the Wi-Fi APs on adjacent channels. A
higher ACI value in Interference Power Chart does not necessarily mean higher interference, because the AP
that is contributing to the maximum ACI may or may not be very actively transmitting data to other clients at
all times. The ACI power levels are derived from the signal strength of the beacons.



This chart displays the noise floor of each selected channel in dBm. The noise floor of a channel depends on
the noise figure of the RF components used in the radio, temperature, presence of certain types of interferers
or noise, and the width of the channel. For example, in a clean RF environment, a 20 MHz channel has a noise
floor around -95 dBm and a 40 MHz channel has a noise floor around -92 dBm. Certain types of fixed-
frequency continuous transmitters such as video bridges, fixed-frequency phones, and wireless cameras
typically elevate the noise floor seen by the spectrum monitor. Other interferers such as frequency-hopping
phones, Bluetooth, and Xbox may not affect the noise floor of the radio. A Wi-Fi radio can only reliably decode
Wi-Fi signals that are a certain dB above the noise floor. Therefore estimating and understanding the actual
noise floor of the radio is critical to understanding the reliability of the RF environment.

The chart also includes information about the AP on each channel with the highest power level. You can hover
your mouse over an AP on the chart to view the AP’s name, SSID, and current power level. The example below
shows that the AP with the maximum power on channel 157 has the SSID qa-ss, and a power level of -55dBm.

Click the down arrow in the upper right corner of this chart then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down
list and select 5 GHz upper, 5GHz middle or 5Ghz lower to display data for that
portion of the 5 Ghz radio band. This parameter is not configurable for graphs created
by hybrid APs or spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel sees
40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz radio
band, click the Channel Numbering drop-down list and select either 20 MHz or 40
MHz channel numbering to identify a channel numbering scheme for the graph.
Graphs for AP radios that support 802.11ac include an additional 80MHz option for
very-high-throughput channels.

Channel Range For graphs created by spectrum monitors, specify a channel range to determine which
channels appear in this graph. Click the first drop-down list to select the lowest
channel in the range, then click the second drop-down list to select the highest channel
to appear in the graph.

This graph displays all channels within the spectrum monitor’s radio band by default.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Table 142: Interference Power Options

Quality Spectrogram
This plot shows the channel quality statistics for selected range of channels or frequencies. This chart can also
be configured to show channel availability, the percentage of each channel that is unused and available for
additional traffic.

Channel Quality is a weighted metric derived from key parameters which include noise, non-Wi-Fi (interferer)
utilization and duty-cycles and certain types of retries. Quality levels are indicated by a range of colors between
dark blue, which represents a higher channel quality, and red, which represents a lower channel quality.
Channel availability is indicated by a range of colors between dark blue, which represents 100% channel
availability, and red, which represents 0% availability.
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For additional information on interpreting an Aruba Spectrogram plot, see Swept Spectrogram on page 697.

The Spectrum Analysis Quality Spectrogram chart measures channel data each second, so after every 5-second
sweep, the newest data appears as a thin colored line on the bottom of the chart. Older data is pushed up
higher on the chart until it reaches the top of the spectrogram and ages out. The example below shows the
Aruba Quality Spectrogram chart after it has recorded over 1,500 seconds of FFT data.

When you hover your mouse over any part of the spectrogram, a tooltip shows the devices the spectrum
monitor detected on that frequency, the BSSID of the device (if applicable), the power level of the device in
dBm, the time the device was last seen by the spectrum monitor, and the channels affected by the device.

The following table describes the other optional parameters you can use to customize the Quality
Spectrogram. Click the down arrow in the upper right corner of this chart, then click the Options menu to
access these configuration settings. Once you have configured the desired parameters, click OK at the bottom
of the Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down list
and select 5 GHz upper, 5GHz middle or 5Ghz lower to display data for that portion of
the 5 Ghz radio band. This parameter is not configurable for graphs created by hybrid APs
or spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum monitor
radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel sees 40 MHz Wi-
Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz radio band, click the
Channel Numbering drop-down list and select either 20 MHz or 40 MHz channel
numbering to identify a channel numbering scheme for the graph. Graphs for AP radios
that support 802.11ac include an additional 80MHz option for very-high-throughput
channels.

X-Axis Select either Channel or Frequency to show the quality spectrogram for a range of
channels or frequencies.

Channel
Range

Specify a channel range to determine which channels appear in the x-axis of this chart.
Click the first drop-down list to select the lowest channel in the range, then click the
second drop-down list to select the highest channel to appear in the chart.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Color-Map
Range

If this chart is configured to show quality spectrogram, the default color range on this chart
represents values from 0 to 100.

Table 143: Quality Spectrogram Options

Real-Time FFT
The Real-time FFT chart displays the instantaneous Fast Fourier Transform (FFT) signature of the RF signal seen
by the radio. The Fast Fourier Transform (FFT) converts an RF signal from time domain to frequency domain.
The frequency domain representation divides RF signals into discrete frequency bins; small frequency ranges
whose width depends on the resolution bandwidth of the spectrum monitor (that is, how many Hz are
represented by a single signal strength value). Each frequency bin has a corresponding signal strength value.



Because there may be a large number of FFT signatures received by the radio every second, an algorithm
selects one FFT sample to display in the Real-time FFT chart every second.

A hybrid AP on a 20 MHz channel will see 40 MHz Wi-Fi data as non-Wi-Fi data.

This chart can show an average for all samples taken over the last second, the maximum FFT power measured
for all samples taken over ten channel sweeps, and the greatest FFT power recorded since the chart was last
reset. When you hover your mouse over any line, a tooltip shows the power level and channel or frequency
level represented by that point in the graph. When you hover your mouse over a frequency level (within the
blue brackets on the graph), a tooltip shows the types of devices seen on that frequency, and each device’s
BSSID, power level, channels affected and the time the device was last seen by the spectrum monitor.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.

Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-down list and
select 5 GHz upper, 5GHz middle or 5Ghz lowerto display data for that portion of the
5 Ghz radio band. This parameter is not configurable for graphs created by hybrid APs or
spectrum monitor radios that use the 2.4 GHz radio band.

Channel
Numbering

This parameter is not configurable for graphs created by hybrid APs or spectrum monitor
radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel sees 40 MHz Wi-Fi
data as non-Wi-Fi data. For spectrum monitors using the 5 GHz radio band, click the
Channel Numbering drop-down list and select either 20 MHz or 40 MHz channel
numbering to identify a channel numbering scheme for the graph. Graphs for AP radios
that support 802.11ac include an additional 80MHz option for very-high-throughput
channels.

X-Axis Select either Channel or Frequency to show FFT power for a range of channels or
frequencies. If you select Frequency, you must select the radio frequency on which this
chart should center, and determine the span of frequencies for the graph.

Table 144: Real-Time FFT Options
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Parameter Description

Channel
Range

If you selected Channel in the X-Axis parameter, you must also specify a channel range to
determine which channels appear in the X-axis of this chart. Click the first drop-down list to
select the lowest channel in the range, then click the second drop-down list to select the
highest channel to appear in the chart.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Y-axis Select the range of power levels, in -dBm, to appear in the y-axis of this chart. Enter the
lower value in the right field, and the higher value in the left field.

Show Select the check box by the following items to display that information on the FFT Power
chart.

l Average: the average power level of all samples recorded during the last 10 sweeps.

l Maxthe The highest power recorded during the last 10 channel sweeps.

l Max Hold: the highest maximum power level recorded since the chart data was reset.
To clear this setting, click the down arrow at the end of the title bar for this graph and
select Clear Max Hold.

Swept Spectrogram
A spectrogram is a chart that shows how the density of the quantity being plotted varies with time. The
spectrum analysis Swept Spectrogram chart plots real-time FFT Maximums, real-time FFT Averages, or the FFT
Duty Cycle. In this swept spectrogram, the x-axis represents frequency or channel and the y-axis represents
time. Each line in the swept spectrogram corresponds to the data displayed in the Real-Time FFT or FFT Duty
Cycle chart.

A hybrid AP on a 20 MHz channel will see 40 MHz Wi-Fi data as non-Wi-Fi data.

The power or duty cycle values recorded in each sweep are mapped to a range of colors. In the average or
maximum FFT power Swept Spectrogram charts, the signal strength levels are indicated by a range of colors
between dark blue, which represents -90 dBm, and red, which represents a higher -50 dBm. The duty cycle
Swept Spectrogram chart shows the percentage of the time tick interval that the selected channel or frequency
was broadcasting a signal. These percentages are indicated by a range of colors between dark blue, which
represents a duty cycle of 0% percent, and red, which represents a duty cycle of 100%.
A spectrogram plot is a complex chart that can display a lot of information. If you are not familiar with these
types of charts, they may be difficult to interpret.

The spectrum analysis Swept Spectrogram measures FFT power levels or duty cycle data each second, so after
every 1-second sweep, the newest data appears as a thin colored line on the bottom of the chart. Older data is
pushed up higher on the chart until it reaches the top of the spectrogram and ages out.

Click the down arrow in the upper right corner of this chart, then click the Options menu to access these
configuration settings. Once you have configured the desired parameters, click OK at the bottom of the
Options menu to save your settings and return to the spectrum dashboards.



Parameter Description

Band Radio band displayed in this graph.

For spectrum monitor radios using the 5 GHz radio band, click the Band drop-
down list and select 5 GHz upper, 5GHz middle, or 5Ghz lower to display data
for that portion of the 5 Ghz radio band. This parameter is not configurable for
graphs created by hybrid APs or spectrum monitor radios that use the 2.4 GHz
radio band.

Channel Numbering This parameter is not configurable for graphs created by hybrid APs or spectrum
monitor radios that use the 2.4 GHz radio band. A hybrid AP on a 20 MHz channel
sees 40 MHz Wi-Fi data as non-Wi-Fi data. For spectrum monitors using the 5 GHz
radio band, click the Channel Numbering drop-down list and select either 20
MHz or 40 MHz channel numbering to identify a channel numbering scheme for
the graph. Graphs for AP radios that support 802.11ac include an additional
80MHz option for very-high-throughput channels.

X-Axis Select either Channel or Frequency to show FFT power or duty cycles for a range
of channels or frequencies. If you select Frequency, you must select the radio
frequency on which this chart should center, and determine the span of
frequencies for the graph.

Channel Range If you selected Channel in the X-Axis parameter, you must also specify a channel
range to determine which channels appear in the x-axis of this chart. Click the first
drop-down list to select the lowest channel in the range, then click the second
drop-down list to select the highest channel to appear in the chart.

NOTE: This parameter is not configurable for graphs created by hybrid APs.

Color-Map Range If this chart is configured to show average or maximum FFT values, the default color
range on this chart represents values from -50dBm (red) to -90dBm (blue). If you
would like the color range on this chart to represent a different range of FFT power
levels, enter this range in the from and to entry blanks.

For example, if you defined a color-map range from -60 to -80, then any FFT power
level at or above -60 dBm appears as red, and any FFT power level at or below -80
appears blue. Only the channel or frequency qualities between -60 dBm and -80
dBm would be represented by gradiented colors within the color range.

If this chart is configured to show the FFT duty cycle, the default color range on this
chart represents duty cycles from 0% (red) to 100% (blue). If you would like the
color range on this chart to represent a different range of FFT duty cycle
percentages, enter this range in the from and to entry blanks.

For example, if you defined a color-map range from 25 to 75, then any FFT duty
cycle at or below 25% appears as red, and any FFT duty cycle at or below 75%
appears blue. Only the duty cycle levels between 25% and 75% would be
represented by gradiented colors within the color range.

NOTE: If your swept spectrogram is showing a single color only, you may need to
increase the color map range to display a greater range of values.

Show Select FFT Avg, FFT Max or FFT Duty Cycle to select the type of data you want to
appear in this chart.

Table 145: Swept Spectrogram Options
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Working with Non-Wi-Fi Interferers
The following table describes each type of non-Wi-Fi interferer detected by the spectrum analysis feature.
These devices appear in the following charts:

l Active Devices

l Active Devices Table

l Active Devices Trend

l Device Duty Cycle

l Device vs Channel

l Interference Power

Non-Wi-Fi
Interferer Description

Bluetooth Any device that uses the Bluetooth protocol to communicate in the 2.4 GHz band is
classified as a Bluetooth device. Bluetooth uses a frequency hopping protocol.

Fixed
Frequency
(Audio)

Some audio devices such as wireless speakers and microphones also use fixed
frequency to continuously transmit audio. These devices are classified as Fixed
Frequency (Audio).

Fixed
Frequency
(Cordless
Phones)

Some cordless phones use a fixed frequency to transmit data (much like the fixed
frequency video devices). These devices are classified as Fixed Frequency (Cordless
Phones).

Fixed
Frequency
(Video)

Video transmitters that continuously transmit video on a single frequency are classified
as Fixed Frequency (Video). These devices typically have close to a 100% duty cycle. These
types of devices may be used for video surveillance, TV or other video distribution, and
similar applications.

Fixed
Frequency
(Other)

All other fixed frequency devices that do not fall into one of the above categories are
classified as Fixed Frequency (Other). Note that the RF signatures of the fixed frequency
audio, video and cordless phone devices are very similar, and that some of these devices
may be occasionally classified as Fixed Frequency (Other).

Frequency
Hopper
(Cordless
Base)

Frequency hopping cordless phone base units transmit periodic beacon-like frames at all
times. When the handsets are not transmitting (i.e., no active phone calls), the cordless
base is classified as Frequency Hopper (Cordless Base).

Frequency
Hopper
(Cordless
Network)

When there is an active phone call and one or more handsets are part of the phone
conversation, the device is classified as Frequency Hopper (Cordless Network). Cordless
phones may operate in 2.4 GHz or 5 GHz bands. Some phones use both 2.4 GHz and 5
GHz bands (for example, 5 GHz for Base-to-handset and 2.4 GHz for Handset-to-base).
These phones may be classified as unique Frequency Hopper devices on both bands.

Frequency
Hopper (Xbox)

The Microsoft Xbox device uses a frequency hopping protocol in the 2.4 GHz band. These
devices are classified as Frequency Hopper (Xbox).

Table 146: Non-Wi-Fi Interferer Types



Non-Wi-Fi
Interferer Description

Frequency
Hopper
(Other)

When the classifier detects a frequency hopper that does not fall into one of the above
categories, it is classified as Frequency Hopper (Other). Some examples include IEEE
802.11 FHSS devices, game consoles, and cordless/hands-free devices that do not use
one of the known cordless phone protocols.

Microwave Common residential microwave ovens with a single magnetron are classified as a
Microwave. These types of microwave ovens may be used in cafeterias, break rooms,
dormitories and similar environments. Some industrial, healthcare or manufacturing
environments may also have other equipment that behave like a microwave and may
also be classified as a Microwave device.

Microwave
(Inverter)

Some newer-model microwave ovens have inverter technology to control the power
output and may have a duty cycle close to 100%. These microwave ovens are classified
as Microwave (Inverter). Dual-magnetron industrial microwave ovens with higher duty
cycle may also be classified as Microwave (Inverter). As in the Microwave category
described above, there may be other equipment that behave like inverter microwaves in
some industrial, healthcare or manufacturing environments. Those devices may also be
classified as Microwave (Inverter).

Generic
Interferer

Any non-frequency hopping device that does not fall into one of the other categories
described in this table is classified as a Generic Interferer. For example, a Microwave-like
device that does not operate in the known operating frequencies used by the Microwave
ovens may be classified as a Generic Interferer. Similarly, wide-band interfering devices
may be classified as Generic Interferers.

Understanding Spectrum Analysis Session Log
The spectrum analysis Session Log tab displays times the spectrum monitors and hybrid APs connected to or
disconnected from the spectrum client during the current browser session. This tab also shows changes in a
hybrid AP’s scanning channel caused by changes to the hybrid AP’s 802.11a or 802.11g radio profile or
automatic channel changes by the DFS or ARM features. The latest entry in the session log is also displayed in a
footer at the bottom of the Spectrum Monitors and Spectrum Dashboard window. When you close the
browser and end your spectrum analysis session, the session log is cleared.

Viewing Spectrum Analysis Data
You can use the command-line interface to view spectrum analysis data from any spectrum monitor, even if
that spectrum monitor is currently sending data to another spectrum monitor client’s WebUI.

Table 147 shows the commands that display spectrum analysis data in the CLI interface.
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Command Description

show ap spectrum ap-list Shows spectrum data seen by an access point that has been
converted to a spectrum monitor.

show ap spectrum channel-metrics Shows channel utilization information for a 802.11a or
802.11g radio band, as seen by a spectrum monitor

show ap spectrum channel-summary Displays a summary of the 802.11a or 802.11g channels
seen by a spectrum monitor.

show ap spectrum client-list Shows details for Wi-Fi clients seen by a specified spectrum
monitor.

show ap spectrum debug Sub-commands under this command save spectrum
analysis channel information to a file on the stand-alone
controller.

show ap spectrum device-duty-cycle Shows the current duty cycle for devices on all channels
being monitored by the spectrum monitor radio.

show ap spectrum device-history Displays spectrum analysis history for non-interfering
devices.

show ap spectrum device-list Shows summary table and channel information for non-Wi-
Fi devices currently seen by the spectrum monitor.

show ap spectrum device-log Shows a time log of add and delete events for non-Wi-Fi
devices.

show ap spectrum device-summary Shows the numbers of Wi-Fi and non-Wi-Fi device types on
each channel monitored by a spectrum monitor.

show ap spectrum interference-power Shows the interference power detected by a 802.11a or
80211g radio on a spectrum monitor.

show ap spectrum monitors Shows a list of APs currently configured as spectrum
monitors.

show ap spectrum technical-support Saves spectrum data for later analysis by your Aruba
technical support representative.

Table 147: Spectrum Analysis CLI Commands

Recording Spectrum Analysis Data
The spectrum analysis tool allows you to record up to 60 continuous minutes (or up to 10 Mb) of spectrum
analysis data. By default, each spectrum analysis recording displays data for the Real-Time FFT, FFT Duty Cycle,
Interference Power and Swept Spectrogram charts, however, you can view recorded device data for any the
spectrum analysis charts supported by that spectrum monitor radio. Configurable recording settings allow you
to start a recording session immediately, or schedule a recording to begin at a later date and time. Each
recording can be scheduled to end after a selected amount of time has passed, or continue on until the



recorded data file reaches a specified size. You can save the file to your spectrum monitor client, then play back
that data at a later time.

Creating a Spectrum Analysis Record
To record spectrum analysis data for later analysis:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Monitors tab in the new window.

4. Click Record at the top of the window. The New Recording popup window appears.

5. Click the Record From link, and select the spectrum monitor whose data you want to record.

6. Next, decide whether you want the recording to start immediately, or at a later scheduled time. If you want
the recording to start immediately, select When the OK button is clicked. To schedule a different
starting time for the recording, click the date and time drop-down lists to select a starting month, day, year
and time.

7. The recording continues until either the specified amount of time has passed, or until the recording files
reaches a selected size. Click the Length of recording reaches drop-down list and select the amount of
time the recording should last, or click the Data file reaches drop-down list and select the maximum file
size for the recording.

8. Click OK to save your settings. If you selected the When the OK button is clicked in step 5, the recording
begins.

While the recording is in progress, a round, red recording icon and recording status information appears at the
top of the spectrum dashboard. You can view data for other spectrum monitors and charts while the recording
is in progress. If you want to stop the recording before recording period has finished, click Stop by the
recording status information. When you the Stop, a popup window appears and allows you to stop and delete
the current recording, stop and save the recording in its current state (before it has completed), or continue
recording again.

Saving Recording
After the recording has ended, either because the recording period has elapsed, the recording maximum file
size has been reached, the Spectrum Monitor Recording Complete window appears and displays
information for the current recording.

To save the recording file:

1. From the Spectrum Monitor Recording Complete window, click Continue.

2. A Save As window appears and prompts you to select a file name for the recording and a location to save
the file.

3. Click Save.

Playing Spectrum Analysis Recording
There are two ways to play back a spectrum recording. You can use the playback feature in the spectrum
dashboard, or view recordings using the Aruba RFPlayback tool downloaded from the Aruba website.

Playing Recording in Spectrum Dashboard
The spectrum monitor does not have to be subscribed to your spectrum analysis client in order to play back a
recording in the spectrum dashboard. However, you cannot play back an existing recording in the spectrum
dashboard while another recording session is currently in progress.

To play a spectrum analysis recording in the spectrum dashboard:
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1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > Spectrum Analysis.

2. Click Launch to launch the Spectrum Analysis tool.

3. Click the Spectrum Dashboards tab.

4. Click Load File for Playback.

5. An Open dialog box appears and prompts you to browse to and select the file you want to open.

6. Click Open.

7. Click the triangular play icon at the top of the window to start playing back the recording.

Recorded data for the selected spectrum monitor and dashboard view appears in the spectrum analysis
dashboard. You can replace any of the graphs in the playback window with a different graph type while
replaying the recording. A playback progress bar at the top of the window shows what part of the recording
currently appears on the dashboard. If you pause the recording, you can click and drag the red slider on this
progress bar to advance to or replay any part of the current record.

Playing Recording Using RFPlayback Tool
The Aruba RFPlayback tool can play spectrum recordings created in this and earlier versions of ArubaOS. Aruba
uses the Adobe AIR application to display spectrum recording information. If you have not done so already,
follow the steps below to download and install the free Adobe AIR application and the Aruba spectrum
playback tool.

1. Download the Adobe Air application from http://get.adobe.com/air/ and install it on the client on which you
want to play spectrum recordings.

2. Next, download the spectrum playback installation file from the Aruba website.

3. Open the folder containing the spectrum installation file, and double-click the spectrum.air icon to install
the spectrum playback tool. You will be prompted to select the folder in which you want to install this tool.

Once you have installed the Aruba RFPlayback tool, follow the steps below to load and view a spectrum
recording.

1. Start the Spectrum playback application.

2. Click Load File for Playback. An Open dialog box appears and prompts you to browse to and select the
file you want to open.

3. Click the triangular play icon at the top of the window play the recording.

The RFPlayback tool also allows you to select and display different graph types while the recording playback is
in progress. A playback progress bar at the top of the window shows what part of the recording is displayed in
the playback tool. If you pause the recording, you can click and drag the red slider on this progress bar to
advance to or replay any part of the current record.

Troubleshooting Spectrum Analysis

Verifying Spectrum Monitors Support for One Client per Radio
Each spectrum monitor radio can only send information to one client at a time. If you log into a stand-alone
controller and the spectrum monitor dashboard does not display any data for the selected radio, another user
may be logged in to the stand-alone controller at that time. Note that dual-radio spectrum monitors may be
accessed by two clients; one client for each radio.

Converting a Spectrum Monitor Back to an AP or Air Monitor
If want to convert a spectrum monitor radio back to AP or AM mode but the radio still comes up as a spectrum
monitor, access the command-line interface and see if that spectrum monitor appears in the output of the



show ap spectrum local-override command. If the spectrum monitor does appear in the local override
profile table, issue the command ap spectrum local-override no override ap-name <apame> spectrum-
band <spectrum-band> to remove the local override for that spectrum monitor and return the radio to AP or
AM mode.

Troubleshooting Browser Issues
If you access the spectrum analysis dashboard using the Safari 5.0 browser, clicking the backspace button may
return you to the previous browser screen. Avoid using the backspace button when changing dashboard view
names or chart options.

If you are recording spectrum analysis data or playing back a spectrum analysis recording using a Mac client, do
not minimize the browser window while the recording is in progress, as that may cause the Adobe Flash player
to pause.

Loading a Spectrum View
Saved spectrum view preferences may not be backwards compatible with the spectrum analysis dashboard in
earlier versions of ArubaOS. If you downgrade to an earlier version of ArubaOS and your client is unable to load
a saved spectrum view in the spectrum dashboard, access the CLI in enable mode and issue the command ap
spectrum clear-webui-view-settings to delete the saved spectrum views and display default view settings
in the spectrum dashboard.

Troubleshooting Issues with Adobe Flash Player 10.1 or Later
Removing focus from the browser window displaying the spectrum analysis dashboard may cause Adobe Flash
10.1 or later to stop updating the spectrum charts to reduce CPU usage. When you restore focus to the
spectrum analysis dashboard, you may see the spectrum charts update rapidly as the display catches up.
Recorded data may be inaccurate if you navigate away from the spectrum window during a recording. Flash
10.0 does not have this issue.

Understanding Spectrum Analysis Syslog Messages
The spectrum analysis feature can send four different types of syslog messages: wifi add, wifi delete, non-wifi
add, and non-wifi delete. All messages are in the wireless category at the syslog severity level NOTICE.

The four syslog message types appear in the following formats:

l AM: Spectrum: new wifi device found = [addr:%s] SSID = [ssid:%s] BSSID [bssid_str:%s] DEVICE ID [did:%d]

l AM: Spectrum: deleting wifi device = [addr:%s] SSID = [ssid:%s] BSSID [bssid_str:%s] DEVICE ID [did:%d]

l AM: Spectrum: new non-wifi device found = DEVICE ID [did:%u] Type [dytpe:%s] Signal [sig:%u] Freq
[freq:%u]KHz Bandwidth [bw:%u]KHz

l AM: Spectrum: deleting non-wifi device = DEVICE ID [did:%d] Type [dtype:%s]

Playing a Recording in the RFPlayback Tool
The Aruba RFPlayback tool is periodically updated to support improvements to the ArubaOS Spectrum Analysis
feature. The RFPlayback tool can play spectrum recordings created in the same version of ArubaOS or earlier
releases. If the RFPlayback tool cannot load a newer recording, you may need to download a more recent
version of the tool from the Aruba website.

ArubaOS 8.0.0.0 | User Guide Spectrum Analysis |  704



ArubaOS 8.0.0.0 | User Guide Dashboard Monitoring | 705

Chapter 34
Dashboard Monitoring

The ArubaOS dashboard monitoring functionality provides an enhanced visibility into your wireless network
and individual managed device in the network.

The following pages in the Dashboard page allows you to view various information:

l WAN

l Performance

l Network

l Cluster

l Usage

l Potential Issues

l Traffic Analysis

l AirGroup

l Security

l UCC

l Controller

l WLANs

l Access Points

l Clients

Additionally, you can view the context sensitive help for each field in the Dashboard UI by clicking the help
link at the top-right corner of the UI. The field for which the help has been defined appears as green. You can
turn off the help by clicking Done.

You can use the Search functionality to find the matched results for clients, APs, and WLANs. Click the count on the
search results of clients, APs, and WLANs to navigate the related summary page with the filters applied.

The following figure shows the Dashboard page:



706 | Dashboard Monitoring ArubaOS 8.0.0.0  | User Guide

Figure 60 Dashboard Page

WAN
The WAN (Wide Area Network) dashboard, in the Monitoring section of the WebUI, is the default landing
page for a managed device with uplinks defined via the uplink manager. The WAN dashboard does not appear
in the Mobility Master WebUI.

For more information on defining a WAN uplink, see Uplink Monitoring and Load Balancing on page 219 . For
information on enabling and the uplink health check features, see Health Check Services for Managed Devices on
page 216.

The WAN dashboard provides the WAN summary details for uplink VLANs, and contains the following tables:

l Uplinks: This section displays the link status and WAN status for VLANs monitored using the uplink
manager utility. For each VLAN, the green check mark icon indicates an up status and red down arrow
represents a down status for the link and WAN. The uplink health-check feature is disabled by default on
managed devices. If it is enabled , the WAN status link will appear with a yellow icon, indicating that this
feature is in an error state.

l Layer3 Redundancy: For deployments using Layer-3 Mobility Master redundancy, this section displays
the status of the managed device's connectivity to the primary and secondary Mobility Master defined
during the managed device's provisioning process.

l Health: This table displays statistics showing the general health of the uplink. Jitter statistics will not be
measured if jitter measurement is not enabled in the uplink manager settings. For details on enabling and
disabling uplink jitter measurements, see Uplink Monitoring and Load Balancing on page 219.

n Score: The health score rates the health of the uplink on a scale of 1-5, with score of 1 being lower
quality and a score of 5 being the highest quality. These scores are based upon the latency and Jitter
rates.

n Latency & Jitter: Jitter is a variation in the delay times of received packets. If the jitter measurement
option is enabled in the uplink manger, the uplink manger uses UDP packets on UDP port 4500 to
measure jitter on the WAN links, and includes jitter statistics in the uplink quality calculations.

l Throughput: Displays the inbound and outbound traffic rates for the selected uplink.

l Alerts: Lists the last five alerts with time stamp and description.



l Usage: Displays relative proportions of traffic types based on Application Category or Application.

l Compression: Displays the aggregate percentage compression on all VLANs with the compression feature
enabled.

Figure 61 WAN Monitoring Dashboard

Performance
The Performance page displays the performance details of the wireless clients and APs connected to the
network or managed device.

The three views available in this page are the following:

l All Radios— Displays the performance of all clients and APs

l 5 GHz— Displays the performance of 5 GHz supported client and APs

l 2.5 GHz— Displays the performance of 2.5 GHz supported client and APs

Clients
This section displays the total number of wireless clients connected in the network. The administrator can see a
top level view of the wireless clients, and further drill down into a specific managed device to view the wireless
client connected to it. You can view the distribution of clients in different client health ranges, SNR ranges,
associated data rate ranges, and data transfer speed ranges using the histograms and distributed charts. You
can click on the hyperlinked number to view the data in different screens with histograms.

An AP’s client health is the efficiency at which that AP transmits downstream traffic to a particular client. This
value is determined by comparing the amount of time the AP spends transmitting data to a client to the
amount of time that would be required under ideal conditions, that is, at the maximum Rx rate supported by
client, with no data retries.

A client health metric of 100% means the actual airtime the AP spends transmitting data is equal to the ideal
amount of time required to send data to the client. A client health metric of 50% means the AP is taking twice
as long as is ideal, or is sending one extra transmission to that client for every packet. A metric of 25% means
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the AP is taking four times longer than the ideal transmission time, or sending 3 extra transmissions to that
client for every packet.

To understand histogram information, see Using Dashboard Histograms on page 708.

APs
This section displays the following performance details of the APs on the Mobility Master:

l Overall goodput (bps)— Displays the ratio of the total bytes transmitted or received in the network to the
total air time required for transmitting or receiving the bytes.

l Goodput (bps)— Displays the ratio of total bytes transmitted to client or received from client to the total air
time required for transmitting or receiving

l Frames dropped— Displays the percentage of frames dropped when transmitted to client and received
from client

l Frame types— Displays the type of frame (broadcast, multicast, unicast) transmitted to client or received
from client

l Frame rates— Displays the range of frame rates transmitted to Client or received from Clients in Mbps

l Channel Quality (%)— Displays the total number of radios per channel quality in percentage

l Noise Floor (dBm)— Displays the total number of radios per noise floor (dBm) range

l Channel Busy (%)— Displays the total number of radios per channel busy in percentage

l Interference (%)— Displays the total number of radios per Interference in percentage

l 2.4 GHz Channels— Displays the number of radios using each channel of the 2.4 GHz spectrum

l 5 GHz Channels— Displays the number of radios using each channel of the 5 GHz spectrum

l EIRP (dBm)— Displays the number of radios per EIRP level

You can click the hyperlinked text and histograms to view the AP specific performance information as a trend
chart. Additionally, you can view the distribution of the APs in different noise floor ranges, channel utilization
ranges, and non-Wi-Fi interference ranges using the histograms. To understand histogram information, see
Using Dashboard Histograms on page 708.

Using Dashboard Histograms
Dashboard histograms are a visual representation of the distribution of the wireless clients, access points, and
radios across different performance parameters in the Mobility Master. Histograms help you to quickly identify
any performance issues in the network from the color of the distribution. For example, critical ranges of the
distribution are highlighted in red and normal ranges are highlighted in green.

You can view the number of clients or APs falling in each range of the distribution with a hyperlink. You can also
perform the following tasks on the histograms to get additional information on the clients and APs in the
distribution:

l View Client or AP details—Click the hyperlinked number to view the details of the clients or APs in a pop-
up window.

l Sort—Click a column header of the clients or APs table to sort the complete list based on the entries on the
active column. You can also use the sort icon that appears when you click on a column for sorting.

l Filter—Click the filter icon and select the filter criterion on any column to filter the entries.

l Close pop-up window—Click on the close icon to close the client or AP details pop-up window.



Network
This page contains the world map. The map displays the location of the managed devices in the network. If a
managed device is not positions, it is listed in a red balloon in the top-right corner of the map as shown in the
following figure:

Figure 62 Network Page

Cluster
The Cluster dashboard provides a visual overview on each cluster deployed on the network, displaying the
following information:

l Health information between cluster members

l Total AP load per Cluster (AAC)

l Total User load per Cluster (UAC)

l Connection time

The Cluster dashboard can only be accessed from the root (Managed Network) node of the Mobility Master
hierarchy. This information is not displayed on any stand-alone controllers, managed devices, or other nodes in
the hierarchy. To view the Cluster dashboard, navigate to Dashboard > Cluster in the WebUI. By default, the
Cluster dashboard displays an overview for the first cluster under the Cluster drop-down list. The dashboard
displays Total AP load and Total User Load per Cluster. To view information on a different cluster, click the
Cluster drop-down list, and then select the desired cluster name.

ArubaOS 8.0.0.0 | User Guide Dashboard Monitoring |  709



710 | Dashboard Monitoring ArubaOS 8.0.0.0  | User Guide

Figure 63 The Cluster Dashboard

The Cluster dashboard consists of an Overview page and Membership Details page. The Cluster
Overview page contains the following graphs and tables:

l AP Load Pie Chart: Displays the proportional distribution and number of active, standby, and free APs.
Hover your mouse above a section of the pie chart to view the count for that AP type.

l Client Load Pie Chart: Displays the proportional distribution and number of active, standby, and free
stations (clients). Hover your mouse above a section of the pie chart to view the count for that station type.

l Cluster Members Table: Provides the following information on each member in the cluster. The latency
displayed is in microseconds (μs).

Parameter Description

Self IP Address Self IP address of the cluster member

Controller Hostname Host name of the cluster member

Leader IP Address IP address of the cluster leader to which the cluster
member is assigned

Controller Model Controller model of the cluster member

Cluster Membership Type Cluster membership type (leader or member)

Node Reachability from SC Indicates whether the Cluster Member is reachable
from Mobility Master

Table 148: Parameters of the Cluster Members Table - Overview Page

To view more in-depth information on a specific cluster member, select the member from the Cluster
Members table to navigate to the Membership Details page. The Membership Details page contains the
following graphs and tables for the selected cluster member:

l AP Load Pie Chart: Displays the proportional distribution of active, standby, and free APs for the selected
cluster member. Hover your mouse above a section of the pie chart to view the count for that AP type.

l Client Load Pie Chart: Displays the proportional distribution of active, standby, and free stations (clients)
for the selected cluster member. Hover your mouse above a section of the pie chart to view the count for
that station type.



l Cluster Members Table: Provides the following peer-to-peer information for the selected cluster
member.

Parameter Description

Self IP Address Self IP address of the cluster member

Peer IP Address IP address of the peer managed devices

Connection Status Connection status of the peer managed device

Connection Type Connection type between the cluster member and
peer managed device (L2/L3)

Mismatch VLAN ID Indicates any VLAN mismatches between the cluster
member and peer managed device

Disconnect Reason Indicates why the peer managed device has
disconnected from the cluster member

Incompatible Reason Indicates why the peer managed device is not
compatible with the cluster member

Minimum Round Trip Delay Minimum latency, in μs

Maximum Round Trip Delay Maximum latency, in μs

Average Round Trip Delay Average latency, in μs

Table 149: Parameters for the Cluster Members Table - Membership Details Page

Usage
The Usage page displays the usage summary of the following on the managed devicesin the network:

l Clients & APs: The active wireless clients, status of APs, and its usage.

l Top APs: The list of APs with the number of clients on the managed device. The list of APs is in the
descending order based on the number of clients associated with an AP. You can filter the APs for the 2.4
GHz and 5 GHz radio band options.

l Radios: The radios and clients connected to an AP, usage, and frame types transmitted and received by the
radio.

l Devices: The pie chart of the clients based on the device type. Clicking on the pie chart segment opens the
client details page filtered on the device type.

l AirGroup: All the AirGroup services available and number of servers offering the service. It is aggregated by
the total number of AirGroup servers sorted by the services they advertise. For more information, see
AirGroup on page 724.

l Overall Usage: The total number of clients and APs that have the low usage and throughput data in the
last 15 minutes.

l Usage by WLANs: The total number of clients per WLAN and throughput data in the last 15 minutes. You
can view only three WLANs in a graph and the remaining WLANs are displayed in other graph. Click the
graph to view the blown up chart and information on the Clients page.
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l Apps by Usage: The charts with the list of application based on the usage. You can click on the specific
chart to view the application details in the Traffic Analysis page.

l Apps by Sessions: The list of top five applications with the session information in descending order.

l Call Quality vs. Client Health: This graph displays the co-relation between the VoIP call quality and the
VoIP client health of every Unified Communication and Collaboration (UCC) call. For more information, see
UCC Dashboard on page 904.

l Collaboration Apps: The list of applications with sessions and usage details.

You can click the hyperlinked text in the sections above to view the lists and trend chart in the last 15 minutes
and summary of the APs and clients in the new windows. For more information on the columns, you can view
the context sensitive help for each field in the Dashboard UI by clicking the help link at the top right corner of
the UI.

Potential Issues
The Potential Issues page displays the total number of radios and wireless clients that may have potential
issues in the network. You can click on the total number to view the trend of the clients and radios with
potential issues in the last 15 minutes. You can also view the number of clients or radios that have a specific
potential issue in each radio band.

The potential issues that a client may have are:

l Low SNR: clients that have signal to noise ratio of 30 dBm or lower.

l Low speed: clients that have a connection speed of 36 Mbps or lower.

l Low goodput: clients that have an average data rate of 24 Mbps or lower.

The potential issues that a radio may have are:

l High noise floor: radios that have a noise floor of -85 dB or greater.

l Busy channel: radios that have a channel utilization of 80% or greater.

l High interference: radios that have an interference of 20% or greater.

l High client association: radios that have 15 or more clients connected.

You can click on the hyperlinked number to view the details of the respective clients or radios in the bottom
pane of the page in the Radios with potential issues section. This section has two views, Listing and
Trend.

The Listing view displays clients with potential issues as a list in a table format. You can sort by clicking a
column header of the table based on the entries on the active column.

The Trend view displays the radios with potential issues in a chart.

Traffic Analysis
The information in the Traffic Analysis page is by AppRF, an application visibility and control feature. AppRF
performs deep packet inspection (DPI) of local traffic and detects over 1500 applications on the network.
AppRF allows you to configure both application and application category policies within a given user role.

The Traffic Analysis dashboard application visibility feature is supported only in 7000 Series and 7200 Series
controllers, and requires WebCC the PEF-NG license.

In the WebUI, the Traffic Analysis dashboard contains the following tabs:

l All Traffic—This tab displays the summary of all traffic in the managed device This is the default page. For
more details, see All Traffic on page 713.



l Web Content—This tab displays the summary of only the web traffic in the managed device. For more
details, see Web Content on page 716.

Figure 64 All Traffic andWebContent PageOptions

All Traffic
To view the All Traffic page, in the Managed Network node hierarchy, navigate to Dashboard > Traffic
Analysis . Click on All Traffic tab. The All Traffic page displays the PEF summary of all the sessions in the
managed device aggregated by users, devices, destinations, applications, WLANs, and roles.The applications,
application categories, and other containers are represented in box charts.

Enable DPI to enhance the benefit of the existing visualization or dashboard, To enable DPI, see the Enabling
Deep Packet Inspection (DPI) section.

Filters
You can click on any rectangle tile in a container and that filter is applied across all the containers.

For example: If you click on the Web rectangle in the Application Categories container, Application
Categories == Web filter is applied to all other containers (Roles, WLANs, Application, Destination and Devices).
See the following figure.

Figure 65 Single Filter Applied
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You can apply multiple filters from different containers by clicking on muliple rectangle tiles in various
containers.

For example: If you click on the Web rectangle in the Application Categories container and the https
rectangle under Application, the remaining containers (Roles, WLANs, Destination and Devices) will be filtered
on Application categories == web and Application == https. See the following figure.

Figure 66 Multiple Filters Applied

The action bar reflects the total traffic based on the filter applied. For example, see Figure 67 and Figure 68.

Figure 67 Total traffic withWeb Filter

Figure 68 Total traffic withWeb and https Filter

To remove filters, click on Remove filter in the container that filter is removed across all the containers.

Details
Clicking on Details navigates you to the corresponding details page with data filtered by all selected rectangle
when a filter is applied, The Details link changes to User filtered by <filter> in that container. See Figure 69
and Figure 70

In the WLANs rectangle tile, wired indicates the traffic initiated by wired users and traffic from uplink ports.



Figure 69 Details

Figure 70 User filtered by <filter>

Clicking on Details or User filtered by <filter> shows the user table, See Figure 71 and Figure 72.
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Figure 71 Details View

Figure 72 User filtered by <filter>- Details View

Web Content
The implementation of Web Content Classification (WebCC) feature can be viewed in this tab. WebCC uses a
cloud-based service to dynamically determine the types of websites being visited, and their safety.

The WebCC feature requires the WebCC subscription license.

When the WebCC feature is enabled, all web traffic (http and https) is classified. The classification is done in
data path as the traffic flows through the managed device and updates dynamically.

Aruba has partnered with Webroot®, a Web classification service to provide this WebCC feature in the Mobility
Master. Arubauses the Webroot's URL database and the cloud look-up service to classify the web traffic. Aruba
uses Webroot classified categories and score for web categories and reputation for WebCC.

The current policy enforcement model in Aruba relies on L3/L4 information of the packet or L7 information
with Deep Packet Inspection (DPI) support to apply rules. WebCC complements this as the user is allowed to
apply firewall policies based on web content category and reputation.

Benefits of WebCC:

1. Prevention of malicious malware, spyware, or adware by blocking known dangerous websites

2. Visibility into web content category-level

3. Visibility into web sites accessed by the user

To view the web content page from the WebUI, in the Managed Network node hierarchy, navigate to
Dashboard > Traffic Analysis . Click on Web Content tab. The following figure shows the Web Content
page.



Figure 73 WebContent Page

The web content page includes the following containers:

l Web Categories: This chart shows traffic for web categories in tree chart presentation. All boxes in this
chart is click-able. Clicking on a box filters rest of page data with the clicked web category as filter, and this
chart is locked until the filter is removed by clicking on Remove filter on <web category>. For example,
see the following figure.

Figure 74 Filter by WebCategory

l Roles: This chart shows the for Roles using the web traffic in tree chart presentation. All role boxes are In
this chart is click-able. Clicking on box filters rest of page data with the clicked Role as filter, and this chart is
locked until the filter is removed by clicking on Remove filter on <role name>. For example, see the
following figure.
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Figure 75 Filter by Role

l All traffic by Reputation: The reputation traffic light chart shows the percentage of traffic based on
reputation or score of web traffic in the managed device. The reputation levels are Trustworthy, Low-Risk,
Moderate-Risk, Suspicious, and High-Risk. If there is no traffic on a specific reputation, then the
corresponding reputation does not appear in the chart. The circles in this chart are click-able. Clicking on
circle filters rest of page data with the selected reputation as filter and this chart is locked until the filter is
removed by clicking on Remove filter on <reputation>. For example, see the following figure.

Figure 76 Filter by Reputation

l Category Views: A drop-down at the extreme right of reputation traffic lights allows selecting the category
view. The view options are Top 9 and Top 6. Top 9 is the default view and displays predefined set of
categories that need to be listed in categories by reputation chart. This also list the top 6 or top 9 categories
based on traffic usage. The list updates automatically when filters are applied. The following figure shows an
for Top 9 category view with reputation chart.

Figure 77 Category View- Top 9

l Details Table: Click on the web category link above the Category view chart to display the details table as
shown in the following figure.



Figure 78 Category Views and Details

The details table of the selected web category includes the following four columns:

n Website: Lists the website

n Risk: Reputation score of the website with image presentation

n Traffic: Traffic of the website in total traffic of the selected category

n User: The number of users using that website

l User Table: Click on the number in the User column in the details table as shown in the following figure:

Figure 79 User Table

The user table includes the following columns:

n User: Lists the users of the website

n Traffic: Traffic of the user on the website
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Web Content Filters
Web content tree chart filter behaves in the same way described in Filters on page 713. Filters can be applied to
Web Categories, Roles, and Reputation containers.

Following are the properties of container filters:

l Clicking on any box in the tree chart or reputation traffic light chart will update whole page with the selected
box as filter.

l On clicking, the tree chart will freeze that chart and update rest of the page.

l Filter will be applied only to non-freeze chart.

l Reputation chart color won’t change upon selection.

The following figure shows an example with multiple filters:

Figure 80 Multiple Filters

WebCC Configuration in the CLI

Enabling WebCC

Use the following command to enable WebCC using the CLI:
(host) (mynode)(config) #firewall web-cc

Use the following command to configure WebCC per-role using the CLI:
(host) (mynode)(config-role) #web-cc

New policy configuration

The new CLI extends the existing policy configuration to take web category or reputation or both. Use the
following command to configure a new policy to create ACL rule with web category and reputation:
(host) (mynode)(config-sess-acl) #source destination proto-port/service/app/app-group <name>

webcc-category <ctgry> webcc-reputation <score> action [log | mirror | time-range]

The following actions are supported when web category/reputation is selected:

l Deny

l Permit

l Blacklist

l Classify-media

l Disable-scanning

l Dot1q-priority

l Log



l Mirror

l Queue

l Time-range

l TOS

Example for WebCC policy configuration is as follows:
ip access-list session url-filter

any any web-cc-category educational-institutions permit

any any web-cc-reputation suspicious deny

any any any deny

Assuming that webcc categorization was done only for http traffic running on TCP 80, the above ACL is
converted as follows in datapath for pre-classification ACL scan:

ip access-list session url-filter

any any tcp {80} permit

any any tcp {80} deny

any any any deny

Post-classification, ACL look-up will have the ACL as follows:
ip access-list session url-filter

any any tcp {80} WebCCCtgID 40 WebCCRep 1-100 permit

any any tcp {80} WebCCRep 1-100 deny

any any any deny

In case there exists an ACL rule to deny/permit a specific web category but is required to make an exception to
allow/deny a specific URL or website, then this can be accomplished by configuring in the following manner:

1. First define a netdestination with one or more URLs to whitelist or blacklist
(config) #netdestination search

(config-dest) #name www.google.com

(config-dest) #name www.bing.com

(config-dest) #exit

2. Apply this netdestination to an ACL
(config) #ip access-list session whitelist

(config-sess-whitelist)#any alias search tcp 80 permit

(config-sess-whitelist)#any alias search tcp 443 permit

3. Apply this ACL to an user-role. The position of this ACL should be at the top. However, with global or role-
specific default ACLs this wouldn’t be possible.
(config) #user-role guest2

(config-role) #access-list session whitelist

If there a web-cc/app rule that is applicable globally across user-roles, then there is no way to override such
behavior. This is a limitation.

WebCC Bandwidth Contract Configuration

With this feature, ArubaOS supports configuring WebCC category and reputation based bandwidth contract
configuration/enforcement. This can be enforced globally for all user-roles, or can be enforced per user-role.

Use the following command to apply global WebCC based bandwidth contracts using the CLI:
(host) (mynode) (config) #web-cc global-bandwidth-contract webcc-category/webcc-reputation

<name> upstream/downstream mbits/kbits <value>

Use the following command to apply AAA bandwidth contracts using the CLI:
(host) (mynode) (config) #aaa bandwidth-contract webcc mbits <value>

Use the following command to apply role-specific web-cc based bandwidth contracts using the CLI:
(host) (mynode) (config) #user-role webcc
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(host) (mynode) (config-role) #bw-contract webcc-category/webcc-reputation <name> <contract>

upstream/downstream

Debugging— The following show commands are introduced as part of this feature:

l show web-cc category all: Displays all WebCC categories

l show web-cc reputation: Displays WebCC reputation

l show web-cc stats: Displays the statistics of WebCC module in CP

l show web-cc status: Display the status of Web-CC module in CP

l show web-cc global-bandwidth-contract: Displays configured WebCC bandwidth contract

l show datapath web-cc: Displays md5, web category, reputation, and age for each URL

l show datapath web-cc counters: Displays the number of URLs in cache, Classified and Unclassified
sessions.

l show datapath session web-cc: Displays Internal Flags, Pre Classification ACE Index, and Post
Classification ACE Index

l show gsm debug channel web_cc_info: Lists md5, Category, and Reputation for each URL. GSM entries
are populated as and when URL cache entry is learned, and it is used for reporting the actual URLs being
associated with user session entries.

The following clear command are introduced as part of this feature:

l clear web-cc cache <md5_1> <md5_2> : Clears the WebCC cache entry from both data plane and GSM.

l clear web-cc stats: Clears all WebCC statistics.

l clear datapath web-cc counters: Clears configuration values and statistics in the WebCC datapath
module.

Blocked
The system administrator has the ability to look at blocked sessions for AppRF and WebCC when logged in to
the managed device. System administrators can see blocked sessions belonging to a specific web-category (like
news / sports / gambling), session belonging to specific app category, as shown in the following figure.

Figure 81 Blocked Tab

This tab displays WebCC and AppRF sessions which are blocked by ACL through system logging or on the
WebUI interface.

Blocked session feature support in Firewall-Visibility process is enabled by default .Once the management
server is configured, AMON feed generation is enabled by default. Only for system logging , enable blk-session
option of firewall visibility CLI command.



Log in to the managed device directly, navigate to Dashboard > Traffic Analysis > Blocked to view blocked
sessions. You can view this page for the following information in the Trend & Distribution section:

l Blocked by App Category: Blocked session data is seen in the managed device for AppRF ACLs. You can
filter by clicking on any box in this container tree chart and the information in other containers update
accordingly.

l Blocked by Web Category: Blocked session data is seen in the managed device for WebCC ACLs. You can
filter by clicking on any box in this container tree chart and the information in other containers update
accordingly.

l Blocked by Role: Blocked session data is seen in the managed device for role ACLs. You can filter by
clicking on any box in this container tree chart and the information in other containers update accordingly.

l Blocked Sessions table with filters: Displays data in the managed device based on ACLs applied in
WebCC, AppRF, and role . However, you can filter the data in this table to list only Application Rules, Web
Content Rules, or Forwarding Rules.

You can view the list of all blocked web category and app category in table format in the Blocked Sessions
section. This section has the following three views:

l All—displays all the blocked sessions

l Application Rules—displays sessions that are blocked by application rules

l Web Content Rules—displays sessions that are blocked by web content rules

This table also has column filters and column sorting.

PhoneHome-Lite
PhoneHome-Lite is an HTTPS-based tracking tool used to monitor WebCC feature usage on each managed
device. Aruba managed devices communicate with Activate servers over a secure HTTPS SSL layer through the
PhoneHome infrastructure to send information about which users have enabled WebCC. This usage data can
then be analyzed to determine the scope of future WebCC feature licensing.

You can enable this feature using the managed device's WebUI or CLI.

In the WebUI

To enable PhoneHome-Lite in the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Services > Firewall >Global
Setting.

2. In the Global Setting accordian, select the Enable Web Content Classification check box.

On enabling, WebCC, the WebCC usage information will be sent to Aruba at every 7 days interval.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To enable PhoneHome-Lite using the CLI:
(host) (mynode) #firewall web-cc

You can also view the WebCC configuration using the following command:
(host) (config) #show firewall

Global firewall policies

------------------------

Policy Action Rate Port

------ ------ ---- ----

Enforce TCP handshake before allowing data Disabled
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Prohibit RST replay attack Disabled

.....

Web Content Classification Enabled

....

AirGroup
The AirGroup dashboard provides enhanced visibility into AirGroup, which is a unique enterprise-class solution
that leverages zero configuration networking to enable Bonjour® services like Apple® AirPrint and AirPlay from
mobile devices in an efficient manner. AirGroup supports both wired and wireless devices and Aruba ClearPass
Policy Manager. The combined view of all AirGroup devices and usage in the network is available under the
AirGroup dashboard of every node in the hierarchy, regardless of deployment type.

Figure 82 The AirGroup Dashboard

AirGroup Summary
The Monitoring > AirGroup Summary page provides visual overviews on the AirGroup traffic trends, server
distribution, server bandwidth, and user bandwidth.

Traffic Trend

AirGroup devices generate query and response packets to discover and publish services. The Traffic Trend
graph allows users to monitor packet rate by displaying the number of packets transmitted and received by
AirGroup per minute, over the last 15 minutes. The toggle buttons at the top of the graph allow you to switch
between Total number of packets per minute and number of packets per minute By Protocol.

l The Total graph displays the total number of packets transmitted and received by AirGroup per minute.

l The By Protocol graph displays the number of packets transmitted and received based on the protocol
type (mDNS and DLNA). This graph also indicates which protocol is generating more traffic.

Server Distribution

The Server Distribution box chart represents the distribution of protocols and the top 20 services across all
AirGroup servers. The toggle buttons at the top of the graph allow you to switch views between distribution By
Service and distribution By Protocol.

l By Service represents the distribution of the top 20 services across all AirGroup servers. Services are
labeled using the respective service IDs.

l By Protocol represents the distribution of protocols, such as mDNS and DLNA, across all AirGroup servers.



By clicking a specific box from the Server Distribution chart, you can navigate to the Servers page in which
the servers are organized by service/protocol type and server count.

Servers Bandwidth

AirGroup servers and users generate control traffic and data traffic, based on total bytes transmitted and
received. Control traffic is generated from the query and response packets that discover and publish services.
When the user discovers and attempts to use a service, data traffic, which comprises of User Datagram
Protocol (UDP) and Transmission Control Protocol (TCP) sessions, is established between the server and user.

The Servers Bandwidth box chart represents usage of the top 20 servers based on bandwidth or data traffic
within the last 2 minutes. Devices are marked as ‘server’ when the device’s mDNS response is cached by
AirGroup. This information can be used to determine which server’s aggregated active sessions have consumed
the most data. Click a server to navigate to the Server Activity tab, where you can view more information on
the aggregated data sessions between the selected server and its users.

Users Bandwidth

The Users Bandwidth box chart represents the top 20 users based on bandwidth, or data traffic, within the
last 2 minutes. Devices are marked as ‘user’ when the device receives a response for an mDNS query from
AirGroup. This information can be used to determine which user’s aggregated active sessions have consumed
the most data. Click a user to navigate to the Server Activity tab, where you can view more information on
the aggregated data sessions between the servers and the selected user.

The user bandwidth shown is not life long bandwidth usage. User Bandwidth usage is only for the last 2 minutes of
bandwidth consumption.

AirGroup Servers
The Monitoring > AirGroup Servers page provides more in-depth information on each AirGroup server.

Figure 83 AirGroup Servers Page

The AirGroup Servers table includes the following parameters:
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Parameter Description

Station MAC MAC address of the AirGroup server.

Service Service used by the AirGroup server (for example, AirPrint or AirPlay).

Server Host
Name

Host name of the AirGroup server.

IP Address IP address of the AirGroup server.

Role Role assigned to the AirGroup server (for example, guest).

Wired/Wirele
ss

Connection type.

AP Name Name of the AP to which the wireless server is associated.

VLAN ID ID of the VLAN to which the server is associated.

Group(s) Server group.

AirGroup
Type

Protocol type (mDNS or DLNA).

Table 150: AirGroup Servers Parameters

The Servers Usage table provides the control and data traffic trends for each server. Control traffic appears
upon clicking any PPM data field for a server. Data traffic displays the total bandwidth consumed by active
sessions between the server and user.

The Servers Usage table includes the following parameters:

Parameter Description

Station MAC MAC address of the AirGroup server.

Server Host
Name

Host name of the AirGroup server.

Bandwidth Total active bandwidth between the server and one or more users per minute. This field displays
bandwidth from up to the last 15 minutes.

mDNS PPM The current amount of mDNS control traffic generated per minute. By clicking this field, you can
view mDNS PPM data from the last 15 minutes.

DLNA PPM The current amount of DLNA control traffic generated per minute. By clicking this field, you can
view DLNA PPM data from the last 15 minutes.

Total PPM The sum of mDNS and DLNA control traffic generated per minute. By clicking this field, you can
view the combined data from the last 15 minutes.

Table 151: Servers Usage Parameters



AirGroup Users
The Monitoring > AirGroup Users page provides more in-depth information on each AirGroup user.

Figure 84 AirGroup Users Page

The AirGroup Users table includes the following parameters:

Parameter Description

Station MAC MAC address of the AirGroup user.

Client User
Name

Name of the AirGroup user.

IP Address IP Address of the AirGroup user.

Host Name Host name of the AirGroup user.

Role User role (employee or guest).

AP Name Name of the AP to which the user is associated.

VLAN ID ID of the VLAN to which the user is associated.

Group(s) Group to which the user belongs.

AirGroup
Type

Type of AirGroup protocol assigned to the user (mDNS or DLNA).

Wired/Wirele
ss

Connection type.

Table 152: AirGroup Users Parameters
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The Users Usage table provides the control and data traffic trends for each user. Control traffic appears upon
clicking any PPM data field for a user. Data traffic displays the total bandwidth consumed by the user, and the
total number of servers accessed by the user.

The Users Usage table includes the following oarameters:

Parameter Description

Station
MAC

MAC address of the AirGroup server.

Client User
Name

Username of the client.

Bandwidth Total active bandwidth between the server and one or more users within the last 15 minutes.

mDNS
PPM

The current amount of mDNS control traffic generated per minute. By clicking this field, you can
view mDNS PPM data from the last 15 minutes.

DLNA PPM The current amount of DLNA control traffic generated per minute. By clicking this field, you can
view DLNA PPM data from the last 15 minutes.

Total PPM The sum of mDNS and DLNA control traffic generated per minute. By clicking this field, you can
view the combined data from the last 15 minutes.

Table 153: Users Usage Parameters

AirGroup Server Activity
The Monitoring > AirGroup Server Activity page contains a list of server and user traffic data from active
sessions, and includes the following parameters:

Parameter Description

Session Id ID to identify the AirGroup session.

Server
Host Name

Host name of the AirGroup server.

Client User
Name

Username of the client.

Bandwidth Total bandwidth between the server and user within the last 15 minutes.

Source IP IP address of the AirGroup server.

Destinatio
n IP

IP address of the AirGroup user.

Table 154: Server Activity Parameters

For more information on the AirGroup feature, see AirGroup on page 919



Security
The Security page allows you to monitor the detection and protection of wireless intrusions in your network.

The two top tables—Discovered APs & Clients and Events—contain data as links. When these links are
selected, they arrange, filter, and display the appropriate information in the lower table, Discovered Access
Points.

The term events in this document refers to security threats, vulnerabilities, attacks (intrusion or Denial of Service),
and other related events.

UCC
The Unified Communication and Collaboration (UCC) Dashboard Aggregated Display shows an aggregated view
of the UCC calls made in the managed devices. The administrator can see a top level view of the call quality
assessment, and further drill down into a specific view based on the analysis required.

The UCC feature requires the PEFNG license.

Call Quality is encapsulated into an Aruba-proprietary metric called UCC Score. The UCC Score for voice and
video calls is measured by taking into account the following metrics:

l Delay

l Jitter

l Packet Loss

Chart View
A new UCC tab is introduced under the Dashboard tab. Navigate to the Dashboard > UCC page to view UCC
dashboard. Clicking the UCC hyperlink displays the following characteristics (in graphical format) of the UCC
deployment.

Figure 85 UCC Dashboard

l Call Volume – This graph displays the total number of calls made based on the UCC application type. For
example, SIP, Skype4B, SCCP, H.323, NOE, SVP, Vocera, FaceTime, Jabber, and WiFi-Calling.
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l Call Quality – This graph displays the AP-to-Client call quality under the WLAN tab and the end-to-end
quality including wired and wireless legs of the call under the End-to-End tab. The number of UCC calls are
categorized by the following call quality:

n Good
n Fair
n Poor
n Not Available – In the WLAN tab, short duration voice calls (less than 60 seconds), video calls, and file-

transfer session are categorized as Not Available. In the End-to-End tab, short duration voice calls (less
than 60 seconds), video calls, file-transfer, and app-sharing sessions are categorized as Not Available.

l Call Quality vs. Client Health – This graph displays the correlation between the VoIP call quality and the
VoIP client health of every UCC call. This graph displays the UCC score under the WLAN tab and MOS under
the End-to-End tab.

When VoIP calls are prioritized using media classification like Lync/Skype for Business, Apple Facetime and Wi-Fi
Calling, the End-to-End call quality is not available. In addition, WLAN-based quality metrics including Call Quality vs.
Client Health scatter plot are not available.

l Calls Per Device Type – This graph displays the calls made per device type. For example, Windows 7, Mac
OS X, iPhone, or Android.

l Roaming – Roaming status of UCC clients. The status can be:

n No – Number of calls where the client did not roam to a new AP during an active call.

n Yes – Number of calls where the client has roamed to a new AP during an active call.

l QoS Correction – If the DSCP value of the Real-time Transport Protocol (RTP) packets sent by the client
differs from corresponding priority value configured for the application, Mobility Master corrects this value
as per the SSID profile definition and classifies the call as QoS corrected. This graph displays the number of
UCC calls where Mobility Master has corrected the WMM-DSCP value for such calls. The QoS correction is
categorized as:

n No – No WMM-DSCP value correction.

n Yes – WMM-DSCP value corrected by Mobility Master.

n Not Available – WLAN short duration calls (less than 60 seconds) is categorized as Not Available.

Details View
Navigate to the Dashboard > UCC page. To display an aggregated list of all the UCC call data metrics in
Mobility Master, click any of the following hyperlinks:

n Call Volume Details

n Call Quality Details

n Client Health Details

n Device Details

n Roaming Details

n QoS Details

Figure 86 displays an aggregated list of all the UCC call data metrics in Mobility Master.



Figure 86 Wireless Call List

VoIP calls made to/from clients outside the managed device are displayed in the External Call List pane. This
pane lists all the external and wired client call CDRs. See Figure 87.

External call list is available only when Lync/Skype for Business SDN API is configured on Mobility Master.

Figure 87 External Call List

Controller
The Controller page lists all the managed devices in the network and provides its health related information as
shown in the following figure:
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Figure 88 Controller Page

Upon selecting a managed device from the list, more details are displayed, as shown in the following figure:

Figure 89 Managed Device Information Page

The Information section displays detailed information about the managed device.

The Ports section displays the status of all the ports in the managed device.

WLANs
The WLANs page displays the WLAN details such as the number of associated APs, radios, wireless clients, and
the WLAN usage in managed devices. You can also view the details of the associated APs and clients as tables.

The following sections are available in the WLANs page:

l WLANs: The unique SSID of the WLAN, clients connected in the network, APs connected to the WLAN,
Radios that are enabled on the AP, Goodput, usage, and the frames transmitted and received by the AP.

l All WLANs: The clients, usage, and device distribution information in graphs.

Click the hyperlinked text in the WLANs page to view the following menus with the summary:

l Info: The summary of the WLAN details, frames transmitted and received from and to the client, air quality,
and Tx/Rx statistics.

l Clients: The summary of WLANs and clients.

l Radios: The summary of APs and clients, channel, and its utilization.



l Charts: The summary of WLAN details in graphs.

l Traffic Analysis: The summary of users, destination, applications, devices and its roles.

You can perform the following tasks on this page:

l Sort: Click a column header of the WLAN table to sort the complete list based on the entries on the active
column. You can also use the sort icon that appears when you click on a column for sorting.

l Filter: Click the filter icon and select the filter criterion on any column of the details table to filter the
entries.

l Customize column view: Click the drop-down list on the top right corner of the table header and select
Custom Columns; choose the Edit Current View option to select the columns that you want to view. You
can also choose one of the following system defined views that have the appropriate pre-selected columns.

n Default Columns: you cannot edit this view.

n To/From Client Stats: you can customize this view using the Edit Current View option.

l View WLAN trends: Click on the hyperlinked client name, the trends of the clients connected in the WLAN
and the WLAN usage in the last 15 minutes can be viewed.

l View client summary: Click on the hyperlinked client name on the client details table to view the Client
Summary page. In this page, you can view the client details summary (air quality metrics and from and to
clients statistics), bandwidth of the client usage, trend of the client frame loss in the last 15 minutes, and the
frame rate distribution of the client.

l View AP or radio summary: Click on the hyperlinked AP name or the radio band on the AP details table to
view the Access Points page. In this page you can view the summary of the AP details such as air quality
metrics, from and to clients statistics, and the number of clients associated with the AP under different SNR
ranges. Additionally, you can view the details of the associated clients and WLANs.

Access Points
The Access Points page displays the details of all the radios and APs associated with the managed device in
the network. By selecting the specific section, you can also view the trends of the connected wireless clients
and the client usage under the 2.4 Ghz and 5 Ghz radio bands in the last 15 minutes.

The Access Points page has the following three sections:

l Access Points—Displays the AP name, status, uptime, mode, and model details.

l Radios—Displays the AP name, band, radio mode, goodput, usage, and the frames transmitted and
received by the AP.

l All Clients—Displays the clients and usage trend in charts for the last 15 minutes.

You can click the hyperlinked text on the Access Points page to view the following menus with the summary:

l Info—Displays the summary of the AP details, frames transmitted and received from and to the client, air
quality, and Tx/Rx statistics.

l WLANs & Clients—Displays the summary of WLANs and clients.

l Charts—Displays the summary of clients and its usage in graphs for different bands.

l History—Displays the history of channel utilization, frame drops, and frame rates for every minute with
histograms for the last 15 minutes.

You can perform the following tasks on this page:

l Sort: Click a column header of the AP table to sort the complete list based on the entries on the active
column. You can also use the sort icon that appears when you click on a column for sorting.

l Filter: Click the filter icon and select the filter criterion on any column of the details table to filter the
entries.
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l Customize column view: Click the drop-down list on the top right corner of the table header and select
Custom Columns; choose the Edit Current View option to select the columns that you want to view. You
can also choose one of the following system defined views that have the appropriate pre-selected columns.

n Default Columns—You cannot edit this view.

n Air Quality Metrics—You can customize this view using the Edit Current View option.

n To/From Client Stats—You can customize this view using the Edit Current View option.

l View client details: Click on the number of clients associated with the AP to view the details of the clients
on the Clients page.

l View AP or radio summary: Click on the hyperlinked AP name or the radio band on the AP details table to
view the summary of the AP details such as air quality metrics, from and to clients statistics, and the number
of clients associated with the AP under different SNR ranges. Additionally, you can view the details of the
associated clients and WLANs.

Clients
The Clients page displays the details of all the wireless clients on the managed device. You can also view the
trends of the connected clients and the client usage under the 2.4 Ghz and 5 Ghz radio bands in the last 15
minutes.

The Clients page displays the following sections:

l Clients: The connectivity type, radios, client health, goodput, channel, and the frames transmitted and
received.

l All Clients: The clients and its usage for 2.4 GHz and 5 GHz bands.

Click the hyperlinked text on the Clients page to view the following menus with the summary:

l Info: The summary of the client details, frames transmitted and received from and to the client, air quality,
and Tx/Rx statistics.

l Charts: The summary of the client details in graphs.

l AirGroup: A list of all the far and near end devices that are either accessible or not accessible by the specific
client. For more information, see AirGroup on page 724.

l Firewall: The summary of traffic in the clients, applications and its roles, and protocols.

l UCC: This tab displays an aggregated list of UCC call data metrics of a client. For more information, see UCC
Dashboard on page 904.

You can perform the following tasks on this page:

l Sort: Click a column header of the AP table to sort the complete list based on the entries on the active
column. You can also use the sort icon that appears when you click on a column for sorting.

l Filter: Click the filter icon and select the filter criterion on any column of the details table to filter the
entries.

l Customize column view: Click the drop-down list on the top right corner of the table header and select
Custom Columns; choose the Edit Current View option to select the columns that you want to view. You
can also choose one of the following system defined views that have the appropriate pre-selected columns.

n Default Columns: you cannot edit this view.

n Air Quality Metrics: you can customize this view using the Edit Current View option.

n To/From Client Stats: you can customize this view using the Edit Current View option.

l View client summary: Click on the hyperlinked client name on the client details table to view the Client
Summary page. In this page, you can view the client details summary (air quality metrics and from or to



clients statistics), bandwidth of the client usage, trend of the client frame loss in the last 15 minutes, and the
frame rate distribution of the client.

l View AP details: Click on the hyperlinked AP name to view the Access Points page.

l View WLAN details: Click on the hyperlinked SSID of the WLAN to view the WLANs page.
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Chapter 35
Automatic Reporting (PhoneHome)

The automatic reporting feature, also known as PhoneHome, allows a Mobility Master to send report events
such as hardware failures, software malfunctions, and other critical events. The PhoneHome automatic
reporting is disabled by default. When you enable the PhoneHome automatic reporting feature, the Mobility
Master sends Aruba support weekly reports about the Mobility Master’s configuration, licenses, software and
hardware status, and any software malfunctions via Aruba Activate or a secure email. In the event that you
need to contact Aruba support with a question about your Mobility Master, you can use this feature to
generate and immediately send a status report, so that Aruba support can diagnose the issue with the most
current Mobility Master data.

The PhoneHome feature can send reports to Aruba support through the Aruba Activate server using the HTTPS
protocol (recommended for most deployments), or send reports to a local SMTP server in email messages.

Pre-Deployment Information
For information to help you determine whether you should send PhoneHome reports to Aruba support via the
Activate server or an SMTP server, see Registering with Activate on page 736

Configuration Procedures
For procedures to configure this feature to send an reports or to view your Mobility Master's report history,
refer to the following topics.

l Configuring PhoneHome Automatic Reporting on page 737

l Viewing Report Status on page 739

Registering with Activate
Before sending Phonehome reports using Activate, the managed device should be registered with the Activate
server using the username/passowrd authentication method. Execute the following steps at the command
prompt to register with Activate:
(host) [mynode] (config) #activate

(host) [mynode] (activate) #username ztp

(host) [mynode] (activate) #password ztpadmin

(host) [mynode] (activate) #write memory

Saving Configuration...

Partial configuration for /mm/mynode

------------------------------------

Contents of : /flash/config/partial/25/p=sc=mynode.cfg

activate

username "ztp"

password b8698637f6bc63bf5a851a16a2020b816907d92ba8b85a62

!

Configuration Saved.

(host) [mynode] (activate) #exit

(host) [mynode] (config) #exit

(host) [mynode] #show activate

(host)[node](config)# show activate

activate

--------

Parameter Value Set
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--------- ----- ---

Activate Whitelist Service Enabled

Activate URL https://activate.arubanetworks.com

Provision Activate URL https://device.arubanetworks.com

Activate Login Username ztp

Activate Login Password ********

Periodic Interval for WhiteList Download 1

Add-Only Operation Enabled

Custom cert to upload to Activate N/A

Server cert to be used for IPSEC N/A

The Periodic Interval for WhiteList Download parameter indicates the whitelist download period in days.

Configuring PhoneHome Automatic Reporting
Use the WebUI or the command-line interface to configure the Mobility Master to send weekly status reports.
When you enable this feature, the Mobility Master sends report every week by default.

The procedure to configure PhoneHome automatic reporting varies, depending upon whether you want to
send reports via Aruba Activate or an SMTP email server. The following procedures describe the tasks to
configure automatic reporting using Activate or SMTP.

Configuring PhoneHome Using Activate
To use the WebUI to configure PhoneHome automatic reporting using Aruba Activate:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Technical Support > TAC server tab.

2. Select Enable option in the PhoneHome to enable this feature.

3. Select HTTPS check box in the HTTPS Configuration field.

4. In the Email-ID field, enter a valid email address with a domain name associated with your Mobility Master.
This field is used in the SMTP header and used to validate ownership with PhoneHome data.

5. Use the Report Type check boxes to specify whether you want automatic reporting to send regular weekly
reports, or a single individual report.

l Click Auto Report to schedule weekly status reports to be sent to Aruba.

l Click Report Now to immediately send a single status report to Aruba.

6. Click Apply. If you selected the Report Now option in the Report Type field, the Report Now check box
clears, indicating that no additional reports are scheduled to be sent.

Configuring PhoneHome Using SMTP
To use the WebUI to configure PhoneHome automatic reporting to send reports through an SMTP email
server:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Technical Support > TAC server tab.

2. Select Enable option in the PhoneHome to enable this feature.

3. Select SMTP option in the Protocol field.

4. In the Server IP Address field, enter the IP address of your SMTP server.

5. (Optional) In the Server Port field, enter the port the Mobility Master should use to access the server.

6. In the User Name field, enter the user name of the user from whose email account the reports should be
sent.

7. (Optional) If your SMTP server requires the sender to be authenticated, enter a valid sender’s user name and
password in the User Name and Password fields.



8. In the Email ID field, enter the email address from which the reports should be sent.

9. (Optional) If your SMTP server has limits on email attachment sizes, enter this attachment size in the Max
size of attachment field. Any status reports larger than this size is divided into multiple emails.

10.Use the Report Type check boxes to specify whether you want automatic reporting to send regular weekly
reports, or a single individual report.

l Click Auto Report to schedule weekly status reports to be sent to Aruba.

l Click Report Now to immediately send a single status report to Aruba.

11.Click Apply.

You can disable automatic reporting at any time by returning to the Diagnostics > Technical Support > TAC
server tab and either unchecking the Auto Report check box, or clicking disable.

Configuring PhoneHome Using the CLI
Issue the following commands to enable or disable automatic reporting, or to identify the Aruba Activate or
SMTP server you want to use to send these messages:

(host) [mynode] (config) #phonehome

auto-report

enable|disable

smtp <server ip> email <from_addy> [user <username> password <password>]

[<server port>] [size <max attachment size>]

https <from-addr>

Your SMTP and Activate server settings are preserved even when automatic reporting is disabled.

Sending Reports to Activate vs. SMTP Servers
By default, Mobility Master sends PhoneHome reports to the Activate server using HTTPS.

Most deployments should retain the default behavior introduced in this release and send PhoneHome reports
using Activate. However, if the Mobility Master is behind proxy server and does not have direct access to
Internet, PhoneHome should be configured to send reports using SMTP. The following section of this
document describes the benefits of each of these configurations options.

Sending Phonehome Reports using Activate
PhoneHome integration with Activate offers following benefits:

l Simpler configuration: Phonehome only requires you to configure the email ID of the network
administrator managing the device, as Activate already has information to accurately identify your Mobility
Master. If a DNS server is not configured on the Mobility Master, PhoneHome will query the public DNS
service (8.8.8.8) to resolve the Activate server IP address.

l Smaller bandwidth requirements: When the PhoneHome feature sends the report to the Activate
server, the PhoneHome report is zipped into a smaller package, then divided into smaller 1MB pieces before
being sent to the server using secure HTTPS. Only reports sent to Activate are zipped before they are sent,
so reports sent to Activate use less bandwidth than a report sent to a SMTP server.

l Enhanced error management: If any individual portion of the report is not successfully received by the
Activate server, PhoneHome makes up to three attempts to resend just that portion of the file rather than
resending the entire report. Reports sent via SMTP must be resent in their entirety if any portion is not
received by the SMTP server.
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l Automatic removal of old reports: Once the entire report has been sent to the Activate server, Activate
sends an acknowledgment to the Mobility Master, prompting the Mobility Master to delete its local copy of
the report.

l The PhoneHome feature can be enabled or disabled using the Diagnostics > Technical Support > TAC
server tab in the WebUI. The same can also be done through phonehome [enable | disable] option in
the CLI.

Sending Reports using SMTP
If you configure the PhoneHome feature to use SMTP, the PhoneHome status reports are sent via email. When
the Mobility Master generates the report email with the PhoneHome data file attachment, it forwards the email
to the local SMTP server configured on your local network, which then relays the message to Aruba technical
support. If your email server requires the sender to be authenticated before message delivery, the Mobility
Master can connect to the SMTP server by supplying the sender’s user name and password.

When PhoneHome reports are sent using SMTP, the PhoneHome report attachment is encrypted before it is
transmitted to the SMTP server. It is then decrypted by Aruba support when it is received. If the PhoneHome
status report email is larger than the maximum email size supported by your SMTP server, the Mobility Master
divides the PhoneHome attachment into smaller attachments and sends the report to Aruba in multiple
emails. If any individual portion of the report is not successfully received by the SMTP server, PhoneHome
resends the entire report.

Sending an Individual Report
If you are currently experiencing a problem and have contacted Aruba about the issue, Aruba technical support
may ask you to generate and send an individual report which describes the Mobility Master’s current status,
and reports any software or hardware errors. Once this report has been successfully uploaded, you may
receive an email that contains a unique reference number you can use to track your recently opened ticket.

If you have not yet enabled automatic reporting feature or defined an SMTP server for this feature, follow steps 1-9
of the WebUI procedure described in Configuring PhoneHome Automatic Reporting on page 737

In the WebUI
To generate and send a PhoneHome status report using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Technical Support > TAC server tab.

2. Click Report Now check box.

3. Click Apply.

In the CLI
To generate and send a PhoneHome status report using the command-line interface, access the CLI in enable
mode and issue the command phonehome now.

Viewing Report Status
Both the WebUI and CLI can show the status of the automatic reporting feature since the Mobility Master was
last reset, including whether this feature is enabled, and the number of report messages that were sent
successfully or failed to reach Activate or the SMTP server.

In the WebUI
To view report status using the WebUI:



1. In the Mobility Master node hierarchy, navigate to Diagnostics > Technical Support > TAC server tab.

2. In the Protocol field, select HTTPS option and click the View PhoneHome Report Status check box to
view statistics for sent reports in this window.

3. The Statistics and Transaction tables appear. These tables contain the following information:

Report Statistic Description

Manual Phonehome Number of reports generated by the Mobility Master because the Report
Now setting was enabled.

Auto-Report Number of weekly reports generated by the Mobility Master because the
Auto Report setting was enabled.

Success Number of reports successfully sent to Activate or the SMTP server.

Failed Number of reports that failed to reach Activate or the SMTP server after
one or more retry attempts.

Retry Number of times the Mobility Master attempted to retry sending a report
to Activate or the SMTP server.

Table 155: Automatic Reporting Statistics

Report Statistic Description

Transaction ID An ID number for a specific report transaction. This transaction
ID includes a timestamp showing when the transaction was first
attempted.

Status This field indicates whether or not a report transaction was successfully
sent. If the report failed, this table describes the reason for the failure.

Table 156: Transaction History

In the CLI
Use the following commands to display statistics for Automatic Reporting settings and report status:

(host) [mynode] #show phonehome

global Display Phonehome global settings

history Display a history of phonehome transactions

report-status Display status of reports uploaded to Aruba TAC Server

stats PhoneHome Statistics

ArubaOS 8.0.0.0 | User Guide Automatic Reporting (PhoneHome) |  740



ArubaOS 8.0.0.0 | User Guide Management Access | 741

Chapter 36
Management Access

This chapter describes management access and tasks for a user-centric network and includes the following
topics:

l Configuring Certificate Authentication for WebUI Access on page 741

l Secure Shell (SSH) on page 742

l WebUI Session Timer on page 744

l Enabling RADIUS Server Authentication on page 745

l Connecting to AirWave Server on page 750

l Custom Certificate Support for RAP on page 751

l Implementing Specific Management Password Policy on page 753

l Configuring Centralized Image Upgrades

l Managing Certificates on page 758

l Configuring SNMP on page 765

l Enabling Capacity Alerts on page 767

l Configuring Logging on page 768

l Enabling Guest Provisioning on page 771

l Managing Files on Managed Device on page 787

l Setting System Clock on page 790

l ClearPass Policy Manager Profiling with IF-MAP on page 792

l Whitelist Synchronization on page 793

l Downloadable Regulatory Table on page 794

Configuring Certificate Authentication for WebUI Access
The managed device supports client certificate authentication for users accessing the WebUI. (The default is for
username/password authentication.) You can use client certificate authentication only, or client certificate
authentication with username/password (if certificate authentication fails, the user can log in with a configured
username and password).

Each managed device can support a maximum of ten management users.

To use client certificate authentication, you must do the following:

1. Obtain a client certificate and import the certificate into the managed device. Obtaining and importing a
client certificate is described in Managing Certificates on page 758.

2. Configure certificate authentication for WebUI management. You can optionally also select
username/password authentication.

3. Configure a user with a management role. Specify the client certificate for authentication of the user.
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In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Admin page and click

the Admin Authentication Options section.

2. Under WebUI Authentication, set Client Certificate to Enabled. You can select Username/Password
as well; in this case, the user is prompted to manually enter the username and password only if the client
certificate is invalid.

3. Select the Server Certificate to be used for this service.

By default, the default-self-signed certificate is used as the server certificate. For more details on default-self-
signed certificate, see Managing Certificates on page 758.

4. Click Apply.

5. To configure the management user, navigate to the Configuration > System > Admin page and click the
Management User section.

a. Select Enable Local Authentication as needed.

b. Click Show users with certificate authentication and click +.

c. Select WebUI certificate.

d. Enter the username.

e. Select the user role assigned to the user upon validation of the client certificate.

f. Enter the serial number for the client certificate.

g. Select the name of the CA that issued the client certificate.

h. Click Apply.

In the CLI
(host)(config) #web-server profile

(host)(Web Server Configuration) #mgmt-auth certificate

(host)(Web Server Configuration) #switch-cert <certificate>

(host)(Web Server Configuration) #!

(host)(config) #mgmt-user webui-cacert <certificate-name> serial <number> <username>

<rolename>

Secure Shell (SSH)
SSH is enabled by default in ArubaOS, and thus lets you log in using a username and password. You can enable
SSH login by using public key authentication while leaving username/password authentication enabled, or you
may disable the username/password authentication and leave only the public key authentication enabled. In
the FIPS mode of operation, SSH is pre-configured to only use Diffie-Hellman Group 14 with AES-CBC-128 and
AES-CBC-256 and HMAC-SHA1/HMAC-SHA1-96. These settings are not configurable.

When you import an X.509 client certificate into the managed device, the certificate is converted to SSH-RSA
keys. When you enable public key authentication for SSH, the managed device validates the client’s credentials
with the imported public keys. You can specify public key authentication only, or public key authentication with
username/password (if the public key authentication fails, the user can login with a configured username and
password).

Enabling Public Key Authentication
The managed device allows public key authentication of users accessing the managed device using SSH. (The
default is for username/password authentication.)

To use public key authentication, you must do the following:



1. Import the X.509 client certificate into the managed device using the WebUI, as described in Importing
Certificates on page 761

2. Configure SSH for client public key authentication. You can optionally also select username/password
authentication.

3. Configure the username, role and client certificate.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Admin page and select

the Admin Authentication Options section.

2. Under SSH (Secure Shell) Authentication Method, set Client Public Key to Enabled. You can
optionally select Username/Password to use both username/password and public key authentication for
SSH access.

3. Click Apply.

4. To configure the user, navigate to the Configuration > System > Admin page.

a. Click Management User.

b. Click Show users with certificate authentication.

c. Click +.

d. Select SSH Public Key.

ArubaOS recommends that the username and role for SSH be the same as for the WebUI Certificate. You can
optionally use the check box to copy the username and role from the Web Certificate section to the SSH Public Key
section.

e. Select the management role assigned to the user upon validation of the client certificate.

f. Select the client certificate.

g. Click Apply.

In the CLI
ssh mgmt-auth public-key [username/password]

mgmt-user ssh-pubkey client-cert <certificate> <username> <role>

Disabling Console Access
A new command is introduced to disable the console-login. The purpose of this command is to introduce an
ability to lock down all console ports, for example, micro USB, mini USB on the managed device to enable high
level security.

With this command, only console access over serial port, USB, and mini USB will be blocked. SSH/ telnet are still
allowed.

In the CLI
To disable the console:
(host) [MyNode] (config) #mgmt-user console-block

PLEASE SAVE THE CONFIGURATION. CONSOLE WILL BE BLOCKED ONCE USER LOGS OUT FROM SERIALCONSOLE.

To re-enable the console:
(host) [MyNode] (config) #no mgmt-user console-block
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WebUI Session Timer
The managed device supports two types of WebUI session timers. They are:

l Idle Session Timeout: This setting specifies the time of inactivity after which the WebUI session times out
and requires login for continued access.

l Absolute Session Timeout: This setting specifies the absolute time after which the WebUI session times
out post a successful authentication.

You can configure these settings from either the managed device WebUI or CLI.

In the WebUI
To configure the WebUI session timer using the WebUI, follow the procedure below.

1. In the Managed Device node hierarchy, navigate to the Configuration > System > General page.

2. Under WebUI Session Timer, configure the settings described in Table 157.

Parameter Description

Idle session
timeout

This setting specifies the time of inactivity after which the WebUI session times out and
requires login for continued access.

Default: 900 seconds

Range: 30-3600 seconds

Absolute session
timeout

This setting specifies the absolute time after which the WebUI session times out post a
successful authentication.

Default: Disabled

Range: 30-3600 seconds

Table 157: WebUI Session Timer Settings

In the CLI
To configure the WebUI session timer using the CLI, execute the following commands.
(host) (config) #web-server profile

(host) (Web Server Configuration) #session-timeout 900

(host) (Web Server Configuration) #absolute-session-timeout 300

To view the configuration using the CLI, execute the following command.
(host) #show web-server profile

Web Server Configuration

------------------------

Parameter Value

--------- -----

Cipher Suite Strength medium

SSL/TLS Protocol Config tlsv1 tlsv1.1 tlsv1.2

Switch Certificate default

Captive Portal Certificate default

IDP Certificate default

Management user's WebUI access method username/password

User absolute session timeout <30-3600> (seconds) 300

User session timeout <30-3600> (seconds) 900

Maximum supported concurrent clients <25-320> 75

Enable WebUI access on HTTPS port (443) false

Web Skype4B Listen Protocol/Port Config N/A

Enable bypass captive portal landing page true



Enabling RADIUS Server Authentication
This section include many different types of RADIUS server configuration and related procedures.

Configuring RADIUS Server Username and Password Authentication
In this example, an external RADIUS server is used to authenticate management users. Upon authentication,
users are assigned the default role root.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > Authentication > Auth Servers

page.

2. Configure the RADIUS Server.

a. In the All Servers section, click +.

b. Enter the Name for the server (for example, rad1).

c. Enter the IP address.

d. Select Radius as the Type.

e. Click Apply.

3. Select Server Groups to display the Server Group list.

a. Click + and enter the name of the new server group (for example, corp_rad).

b. Click Apply.

4. Navigate to the Configuration > System > Admin page.

a. Under Admin Authentication Options, select a management role (for example, root) for the Default
Role.

b. Set Enable to Enabled.

c. For Server Group, select the server group that you just configured.

d. Click Apply.

In the CLI
aaa authentication-server radius rad1

  host <ipaddr>

  enable

aaa server-group corp_rad

  auth-server rad1

aaa authentication mgmt

  default-role root

  enable

  server-group corp_rad

Configuring RADIUS Server Authentication with VSA
In this scenario, an external RADIUS server authenticates management users and returns to the managed
device the Aruba vendor-specific attribute (VSA) called Aruba-Admin-Role that contains the name of the
management role for the user. The authenticated user is placed into the management role specified by the
VSA.

The managed device configuration is identical to the Configuring RADIUS Server Username and Password
Authentication on page 745. The only difference is the configuration of the VSA on the RADIUS server. Ensure
that the value of the VSA returned by the RADIUS server is one of the predefined management roles.
Otherwise, the user will have no access to the managed device.
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Configuring RADIUS Server Authentication with Server Derivation Rule

Aruba managed device does not make use of any returned attributes from a TACACS+ server.

A RADIUS server can return to the managed device a standard RADIUS attribute that contains one of the
following values:

l The name of the management role for the user

l A value from which a management role can be derived

For either situation, configure a server-derivation rule for the server group.

In the following example, the RADIUS server returns the attribute Class to the managed device. The value of
the attribute can be either “root” or “network-operations” depending upon the user; the returned value is the
role granted to the user.

Ensure that the value of the attribute returned by the RADIUS server is one of the predefined management roles.
Otherwise, the management user will not be granted access to the managed device.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > Authentication > Auth Servers

page.

2. Configure the RADIUS Server.

a. In the All Servers section, click +.

b. Enter the Name for the server (for example, rad1).

c. Enter the IP address.

d. Select Radius as the Type.

e. Click Apply.

3. Select Server Group to display the Server Group list.

a. Enter the name of the new server group (for example, corp_rad) and click Add.

b. Select the name to configure the server group.

c. Under Servers, click New to add a server to the group.

d. Select a server from the drop-down list and click Add Server.

e. Under Server Rules, click New to add a server rule.

f. For Condition, select Class from the scrolling list. Select value-of from the drop-down list. Select Set
Role from the drop-down list.

g. Click Add.

h. Click Apply.

4. Navigate to the Configuration > System > Administration page.

a. Under Admin Authentication Options, select a management role (for example, root) for the Default
Role.

b. Set Enable to Enabled.

c. For Server Group, select the server group that you just configured.

d. Click Apply.

In the CLI
aaa authentication-server radius rad1

  host <ipaddr>



  enable

aaa server-group corp_rad

  auth-server rad1

  set role condition Class value-of

aaa authentication mgmt

  default-role read-only

  enable

  server-group corp_rad

In the following example, the RADIUS server returns the attribute Class to the managed device; the value of
this attribute can be “it”, in which case, the user is granted the root role. If the value of the Class attribute is
anything else, the user is granted the default read-only role.

Configuring Set-value Server-derivation Rule

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > Security > Authentication >

Servers page.

2. Select RADIUS Server to display the Radius Server List.

a. To configure a RADIUS server, enter the name for the server (for example, rad1) and click Add.

b. Select the name to configure server parameters, such as IP address. Select the Mode check box to
activate the server.

c. Click Apply.

3. Select Server Group to display the Server Group list.

a. Enter the name of the new server group (for example, corp_rad) and click Add.

b. Select the name to configure the server group.

c. Under Servers, click New to add a server to the group.

d. Select a server from the drop-down list and click Add Server.

e. Under Server Rules, click New to add a server rule.

f. For Condition, select Class from the scrolling list. Select equals from the drop-down list. Enter it. Select
Set Role from the drop-down list. For Value, select root from the drop-down list.

g. Click Add.

h. Click Apply.

4. Navigate to the Configuration > Management > Administration page.

a. Under Management Authentication Servers, select a management role (for example, read-only) for the
Default Role.

b. Select (check) Mode.

c. For Server Group, select the server group that you just configured.

d. Click Apply.

In the CLI
aaa authentication-server radius rad1

  host <ipaddr>

  enable

aaa server-group corp_rad

  auth-server rad1

  set role condition Class equals it set-value root
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aaa authentication mgmt

  default-role read-only

  enable

  server-group corp_rad

For more information about configuring server-derivation rules, see Configuring Server-Derivation Rules on
page 190.

Disabling Authentication of Local Management User Accounts
You can disable authentication of management user accounts in local switches if the configured authentication
server(s) (RADIUS or TACACS+) are not available.

You can disable authentication of management users based on the results returned by the authentication
server. When configured, locally-defined management accounts (for example, admin) are not allowed to log in
if the server(s) are reachable and the user entry is not found in the authentication server. In this situation, if the
RADIUS or TACACS+ server is unreachable, meaning it does not receive a response during authentication, or
fails to authenticate a user because of a timeout, local authentication is used and you can log in with a locally-
defined management account.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Administration page.

2. Under Management Authentication Servers, uncheck the Local Authentication Mode check box.

3. Click Apply.

In the CLI
mgmt-user localauth-disable

Verifying Configuration
To verify if authentication of local management user accounts is enabled or disabled, use the following
command:

show mgmt-user local-authentication-mode

Resetting Admin or Enable Password
This section describes how to reset the password for the default administrator user account (admin) on the
managed device. Use this procedure if the administrator user account password is lost or forgotten.

1. Connect a local console to the serial port on the managed device.

2. From the console, login in the managed device using the username password and the password
forgetme!.

3. Enter enable mode by typing in enable, followed by the password enable.

4. Enter configuration mode by typing in configure terminal.
5. To configure the administrator user account, enter mgmt-user admin root. Enter a new password for this

account. Retype the same password to confirm.

6. Exit from the configuration mode, enable mode, and user mode.

This procedure also resets the enable mode password to enable. If you have defined a management user
password policy, make sure that the new password conforms to this policy. For details, see Implementing
Specific Management Password Policy on page 753.

Figure 90 is an example of how to reset the password. The commands in bold type are what you enter.



(host)

User: password

Password: forgetme!

(host) >enable

Password: enable

(host) #configure terminal

Enter Configuration commands, one per line. End with CNTL/Z

(host) (config) #mgmt-user admin root

Password: ******

Re-Type password: ******

(host) (config) #exit

(host) #exit

(host) >exit

Figure 90 Resetting the Password

After you reset the administrator user account and password, you can login to the managed device and
reconfigure the enable mode password. To do this, enter configuration mode and type the enable secret
command. You are prompted to enter a new password and retype it to confirm. Save the configuration by
entering write memory.

Figure 91 details an example reconfigure the enable mode password. Again, the command you enter displays
in bold type.

User: admin

Password: ******

(host) >enable

Password: ******

(host) #configure terminal

Enter Configuration commands, one per line. End with CNTL/Z

(host) (config) #enable secret

Password: ******

Re-Type password: ******

(host) (config) #write memory

Figure 91 Reconfigure the enablemode password

Bypassing Enable Password Prompt
The bypass enable feature lets you bypass the enable password prompt and go directly to the privileged
commands (config mode) after logging on to the managed device. This is useful if you want to avoid changing
the enable password due to company policy.

Use the enable bypass CLI command to bypass the enable prompt an go directly to the privileged commands
(config mode). Use the no enable bypass CLI command to restore the enable password prompt.

Setting Administrator Session Timeout
You can configure the number of seconds after which an administrator’s WebUI or CLI session times out.

For WebUI
To define a timeout interval for a WebUI session, use the command:
(host)(config) #web-server profile

(host)(Web Server Configuration) #session-timeout <session-timeout>
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In the above command, <session-timeout> can be any number of seconds from 30 to 3600, inclusive.

For CLI
To define a timeout interval for a CLI session, use the command:
(host)(config) #loginsession timeout <value>

In the above command, <val> can be any number of minutes from 5 to 60 or seconds from 1 to 3600,
inclusive. You can also specify a timeout value of 0 to disable CLI session timeouts.

Connecting to AirWave Server
AirWave is a powerful and easy-to-use network operations system that manages wireless, wired and remote
access networks, as well as wireless and wired infrastructures and a wide range of third-party manufacturers.

Managed devices can use the Configuration > System > AirWave section of WebUI to quickly and easily
connect the managed device to an AirWave server. The following table lists the information you will need to
connect a managed device to an AirWave server.

Information Description

AirWave IP address IP address of the AirWave server.

SNMP version Specify if the managed device and AirWave server should communicate using
SNMP v2 or SNMP v3. SNMPv3 communication between a managed device and an
AirWave server use SHA authentication and AES encryption.

Table 158: AirWave Wizard Checklist

AMON Message Size Changes
Data communication between managed devices and AirWave servers has shifted from the SNMP model to the
faster, more reliable, and scalable AMON model. Though the SNMP model can still be used to communicate
data, users generally encounter delayed AirWave updates and high CPU usage.

The AMON packet size has been capped at a default value of 1400 bytes to reduce the amount of
fragmentation and message loss that typically occurs in larger packet sizes, which can force customers to fall
back to the SNMP model. Message size has been capped at 1400 bytes to allow for the addition of AMON
headers and PAPI/UDP/IP headers. Each packet only contains one message to further reduce the amount of
overall message loss, as the loss of even a single fragment can render an entire message invalid.

The AMON packet size can be modified using the following CLI command:
(host)(config) #amon msg-buffer-size <msg-buffer-size>

With the additional message load due to the smaller packet size and 1:1 message to packet ratio, output has
also been increased from 10 second intervals to 1 second intervals to distribute packets more evenly, helping
maintain a more stable and less congested traffic flow.

Clarity Synthetic
Mobility Master provides support for Clarity Synthetic, which helps in detecting network health by using
synthetic transaction from a Wi-Fi client. This feature converts the radios of a supported access point to switch
from AP mode to station mode. The managed device converts one or both of the radios of the AP to station
mode based on the instruction from a network management server. When the radio of the AP is in station
mode, it starts synthetic data transaction within the network.



The following table provides a list of AP platforms that support Clarity Synthetic:

Supported AP-Platforms

200 Series access points

210 Series access points

220 Series access points

Table 159: Supported AP-Platforms for Clarity Synthetic

The network health is determined based on the response from the network and the time taken for the
synthetic data transaction. The results captured as part of these transactions are used for the following
purposes:

l Troubleshoot a live network

l Provide whole network overview (WLAN and Wired)

l Support Wi-Fi and Internet protocol service level agreement (IP SLA)

l Troubleshoot Remote network using client traffic (Synthetic)

Custom Certificate Support for RAP
As Suite-B mandates using the AES-GCM encryption and ECDSA certificates for security, this feature allows you
to upload custom RSA and ECDSA certificates to a RAP. This allows custom certificates to be used for IKEv2
negotiation which establishes a tunnel between the RAP and the managed device. Feature support includes the
ability to:

l Upload a single CA certificate and RAP certificate which have either elliptical crypto key parameters with
ECDSA or RSA parameters for signing and verification.

l Store the certificate in the flash of the RAP

l Store CSR and private key files in a USB

l Delete certificates

l Generate a CSR paired with a private key generation for the RAP. The private key is stored in the flash and
the CSR can be exported out of the RAP to get it signed by the CA.

If there is a custom certificate present in the flash when rebooting, this feature creates a suite B tunnel with the
managed device if the certificates uploaded are using EC algorithms. Otherwise it creates a tunnel using
standard RAP IPsec parameters.

Suite-B Support for ECDSA Certificate
If a custom ECDSA certificate is present in the flash of a certificate-based RAP, it is automatically designated as a
Suite-B RAP. On the managed device side, tunnel creation uses the server certificate as a default VPN server
certificate.

Administering Suite-B support for a RAP includes these steps which are described in the following sections:

1. Setting the Default Server Certificate

2. Import a custom certificate

3. Generate a Certificate Signing Request (CSR)

4. Upload the certificate
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Setting Default Server Certificate

In the CLI

To set the default server certificate that is presented to the RAP as the default VPN server certificate:
(host) (config) #crypto-local isakmp server-certificate

<server_certificate_name>

To add the CA certificate to verify the RAP certificate:
(host) (config) #crypto-local isakmp ca-certificate <trusted CA>

Importing a Custom Certificate

Certificates can only be imported to the managed device using the WebUI.

In the WebUI

1. In the Managed Device node hierarchy, navigate to Configuration > System > Certificates and upload
the certificate.

2. To use imported certificates to create a tunnel, in the Managed Device node hierarchy, navigate to
Configuration > Services > VPN > Certificates for VPN Clients.

Generating CSR
The RAP console page allows you to generate a CSR. This is done through a private key which can be generated
and saved to the RAP flash. A corresponding CSR is exported so it can be signed by the required CA to use as
the RAP certificate. This RAP certificate can then be uploaded using the Upload button on the RAP Console
page.

The subject of the RAP certificate needs to be the MAC address of the RAP, and nothing more. Note that this is
case insensitive.

If you create a CSR on the RAP and then have a certificate issued by a CA, you must have the certificate in PEM
format before uploading it to the RAP.

Uploading Certificate

When using the “rapconsole.arubanetworks.com” page on a bridge/split-tunnel RAP to manage certificates on the
RAP, a blank page or a page that does not have the Certificates tabs on it may display. The RAP provisioning page
that is standard on the RAP may conflict with the “rapconsole” page and thus confuse the browser. If this occurs, clear
your browser cache first or use two different browsers.

The Upload button on the RAP console page that lets you upload the certificates to the RAP flash. The
certificate needs to be in PEM format and uploading the RAP certificate requires that the corresponding private
key is present in the RAP flash. Or, use the PKCS12 bundle where the chain includes the RAP private key with
the RAP and CA certificates are optionally password protected.

Storing CSR and Private Key Files in USB
To provision a RAP to store the CSR and private key in a USB, use one of the following options:

AP Boot Prompt
At the AP boot prompt, issue the setenv usb_csr 1 and setenv usb_type 100 commands.

If this option is used to provision the RAP to store the files in the USB device, after the files are saved in the USB, enter
the AP boot prompt to issue the setenv usb_csr 0 command. This is mandatory.



In the WebUI
1. In the Managed Device node hierarchy, navigate to Configuration > Wireless > AP Installation >

Provisioning.

2. Select the RAP, click Provision.

3. Under USB Settings, select the USB Parameters check box.

4. Select the USB storage for CSR/Key check box.

5. Select Device Type as storage.

6. Click Apply and Reboot.

In the CLI
(host) (config) #provision-ap

(host) (AP provisioning) #read-bootinfo ap-name <ap name>

(host) (AP provisioning) #usb-csr

(host) (AP provisioning) #usb-type storage

RAP Console
1. In the Managed Device node hierarchy, navigate to Configuration > Management > Certificates.

2. For Store CSR and key in USB/Flash, select USB from the drop-down list.

After the RAP is provisioned to store the CSR and private key in a USB, log in to the RAP console, export the CSR
and private key files to the USB. A .p12 certificate file format must be manually created as the RAP certificate in
the USB to bring up the IKE/IPsec connection.

Implementing Specific Management Password Policy
By default, the password for a new management user has no requirements other than a minimum length of 6
alphanumeric or special characters. However, if your company enforces a best practices password policy for
management users with root access to network equipment, you may want to configure a password policy that
sets requirements for management user passwords.

Defining Management Password Policy
To define specific management password policy settings through the WebUI or the CLI, complete the following
steps:

In the WebUI
1. In the Managed Device node hierarchy, navigate to Configuration > System > Profiles.

2. Expand Other Profiles.

3. Select Mgmt Password Policy.

4. Configure the settings described in Table 160.
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Parameter Description

Enable Password Policy Select this check box to enable the password management policy. The
password policy will not be enforced until this check box is selected.

Minimum password length
required

The minimum number of characters required for a management user
password

Range: 6-64 characters. Default: 6.

Minimum number of Upper
Case characters

The minimum number of uppercase characters required in a
management user password.

Range: 0-10 characters. By default, there is no requirement for
uppercase letters in a password, and the parameter has a default value
of 0.

Minimum number of Lower
Case characters

The minimum number of lowercase characters required in a
management user password.

Range: 0-10 characters. By default, there is no requirement for
lowercase letters in a password, and the parameter has a default value
of 0.

Minimum number of Digits The minimum number of numeric digits required in a management user
password.

Range: 0-10 digits. By default, there is no requirement for numerical
digits in a password, and the parameter has a default value of 0.

Minimum number of Special
characters (!, @, #, $, %, ^, &,
*, <, >, {, }, [, ], :, ., comma, |,
+, ~, `)

The minimum number of special characters.

Range: 0-10 characters.

Username or Reverse of
username NOT in Password

When you select this check box, the password cannot be the
management users’ current username or the username spelled
backwards.

Maximum consecutive
character repeats

The maximum number of consecutive repeating characters allowed in a
management user password.

Range: 0-10 characters. By default, there is no limitation on the numbers
of character that can repeat within a password, and the parameter has a
default value of 0 characters.

Maximum Number of failed
attempts in 3 minute window
to lockout user

The number of failed attempts within a 3 minute window that causes the
user to be locked out for the period of time specified by the Time
duration to lockout the user upon crossing the "lock-out"
threshold parameter.

Range: 0-10 attempts. By default, the password lockout feature is
disabled, and the default value of this parameter is 0 attempts.

Time duration to lock out the
user upon crossing the "lock-
out" threshold

The duration in time that locks out the user upon crossing the lock out
threshold.

Range: 0-60 in minutes.

Table 160: Management Password Policy Settings



5. Click Apply to save your settings.

In the CLI
aaa password-policy mgmt

Management Authentication Profile Parameters
Table 161 describes configuration parameters on the Management Authentication profile page.

In the CLI, you configure these options with the aaa authentication mgmt and aaa-server-group commands.

Parameter Description

Enable Enables authentication for administrative users.

Default Role Select a predefined management role to assign to authenticated administrative users:

Root Default superuser role

guest-
provisioning

Guest provisioning role

location-api-
mgmt

Location API role

network-
operations

Network operations role

no-access No commands are accessible for this role

read-only Read-only role

no access Negates any configured parameter.

Server
Group

Name of the group of servers used to authenticate administrative users. See the CLI
command aaa-server-group, in the CLI Command Reference Guide for more information.

Table 161: Management Authentication Profile Parameters

Configuring Centralized Image Upgrades
The centralized image upgrade feature allows the Mobility Master to upgrade itself and its associated managed
devices by sending an image from the image server to one or more managed devices.

The Mobility Master connects to an image server, downloads the image file for each managed device, and
verifies the validity of the image files. After the Mobility Master verifies the validity of the image files, the
managed devices connect to the image server, download the appropriate image file, and upgrade to the
downloaded image file.

Configuring Centralized Image Upgrades
This feature can be configured on a Mobility Master only and supports up to 100 simultaneous downloads.
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In the WebUI
1. In the Mobility Master node hierarchy, navigate to Maintenance > Software Management > Upgrade.

2. Under Master Configuration, configure the parameters listed in the following table.

Parameter Description

Upgrade
using

Select the protocol used to download the image file from the image server to the managed
devices.

l TFTP

l FTP

l SCP

l Local File

NOTE: For the FTP or SCP protocol, specify the username and password.

Server IP
address

Specify the IP address of the image server.

NOTE: For the FTP protocol, specify the name or the IP address of the image server.

Image File
Name

Specify the name of the image file.

Partition to
Upgrade

Specify the partition to upgrade.

l Partition 0

l Partition 1

Reboot
Controller
After
Upgrade

Select if the managed device should reboot after the upgrade.

Save
Current
Configurati
on Before
Reboot

Select if the existing configuration on the managed device should be saved before
rebooting.

NOTE: The existing configuration on a managed device is saved before rebooting only if
the managed device is configured to reboot after upgrade.

Table 162: Centralized Image Upgrade Configuration Parameters

3. Click Upgrade.

Configuring Upgrade Profile on Managed Device
Configure the upgrade profile on the managed devices.

In the WebUI
1. In the required managed device node hierarchy, navigate to Configuration > System > Profiles.

2. Under All Profiles, select Controller Profile > Upgrade.

3. Under Upgrade Profile, configure the parameters listed in the following table.



Parameter Description

Server
IP address

Specify the IP address of the image server.

NOTE: For the FTP or SCP protocol, specify the username and password.

Username Specify the username of the image server.

Password Specify the password of the image server.

Retype Repeat the password of the image server.

Protocol Select the protocol used to download the image file from the image server to the managed
devices.

l None

l tftp

l ftp

l scp

NOTE: Select none for local file.

File path Specify the path of the image file on the image server.

Table 163: Upgrade Profile Parameters

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.

Upgrading Managed Device
Use the following procedure to upgrade the required managed devices.

In the WebUI
1. In the required managed device node hierarchy, navigate to Configuration > Tasks.

2. Under Tasks, click Upgrade controllers.

3. Under Controllers in Group /md/managed device, select the managed devices to upgrade.

4. Click Next.

5. Select how to upgrade the selected managed devices.

n Use upgrade profile in group hierarchy - Uses the image server configured in the upgrade profile of the
managed device.

n Use specified image server - Uses the specified image server configuration. Configure the parameters
listed in the following table.
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Parameter Description

IP address Specify the IP address of the image server.

NOTE: For the FTP or SCP protocol, specify the username and password.

Image path Specify the path of the image file on the image server.

NOTE: To specify default path, use .

Protocol Select the protocol used to download the image file from the image server to the managed
devices.

l TFTP

l FTP

l SCP

NOTE: For the FTP or SCP protocol, specify the username and password.

Table 164: Image Server Access Parameters

6. Click Next.

7. Select how to upgrade the selected managed devices and specify a value against Upgrade to.

n version

n file

n force-version

n force-file

8. Select the Auto-reboot check box to reboot the selected managed devices after the upgrade.

9. Select the partition on the selected managed devices to upgrade against Partition.

n auto - Upgrades the default boot partition on the selected managed devices.

n partition 0 - Upgrades partition 0 on the selected managed devices.

n partition 1 - Upgrades partition 1 on the selected managed devices.

10.Click Finish.

Managing Certificates
The Mobility Master is designed to provide secure services through the use of digital certificates. Certificates
provide security when authenticating users and computers and eliminate the need for less secure password-
based authentication.

Starting from ArubaOS 8.0, Mobility Master and managed devices generate a self signed certificate (default-
self-signed) to demonstrate the authentication of the managed device for captive portal and WebUI
management access while booting. The default-self-signed certificate is used as the default certificate for
WebUI authentication, 802.1X termination, and Single Sign-On (SSO).

You can navigate to Configuration > System > Certificates page in the WebUI to view the details of the
default-self-signed certificate. You can also use the following command to view the details in the CLI:
(host) [mynode] # show crypto-local pki servercert default-self-signed

Certificate:

Data:

Version: 3 (0x2)

Serial Number: 1 (0x1)



Signature Algorithm: sha384WithRSAEncryption

Issuer: CN=ArubaMM-DC1234567.arubanetworks.com, O=Aruba Networks, C=US

Validity

Not Before: Apr 25 18:27:34 2016 GMT

Not After : Apr 18 18:27:34 2046 GMT

Subject: CN=ArubaMM-DC1234567.arubanetworks.com, O=Aruba Networks, C=US

Subject Public Key Info:

Public Key Algorithm: rsaEncryption

Public-Key: (2048 bit)

Modulus:

00:98:49:30:ae:6b:11:da:19:45:ff:85:97:1c:03:

83:3a:d3:0c:42:5d:58:c9:f4:ed:fb:25:32:4e:91:

33:0d:0f:29:12:e7:30:32:64:b4:9c:ca:59:65:f3:

...

...

You may see a server certificate error while using the WebUI or 802.1X termination because the default certificate is
a self signed certificate. You can view and verify the certificate to proceed further.

Additionally, to view the fingerprint details of the default-self-signed certificate, execute the following
command:
(host) [mynode] #show crypto-local pki serverCert default-self-signed fingerprint

SHA1 Fingerprint=F7:A3:01:50:BC:AA:5E:2E:8F:62:24:6F:24:B2:B5:ED:AD:D4:25:4F

There is also another server certificate, default available in ArubaOS 8.0 for demonstration purposes.
However, this certificate does not guarantee security in production networks. Aruba strongly recommends that
you replace the default certificate with a custom certificate issued for your site or domain by a trusted
Certificate Authority (CA). This section describes how to generate a Certificate Signing Request (CSR) to submit
to a CA and how to import the signed certificate received from the CA into the managed device.

The managed device supports client authentication using digital certificates for specific user-centric network
services, such as AAA FastConnect, VPN (see Virtual Private Networks on page 335), and WebUI and SSH
management access. Each service can employ different sets of client and server certificates.

During certificate-based authentication, the managed device provides its server certificate to the client for
authentication. After validating the managed device’s server certificate, the client presents its own certificate to
the managed device for authentication. To validate the client certificate, the managed device checks the
certificate revocation list (CRL) maintained by the CA that issued the client certificate. After validating the
client’s certificate, the managed device can check the user name in the certificate with the configured
authentication server (this action is optional and configurable).

When using X.509 certificates for authentication, if a banner message has been configured on the managed device, it
displays before the user can login. Click on the Login button after viewing the banner message to complete the login
process.

About Digital Certificates
Clients and the servers to which they connect may hold authentication certificates that validate their identities.
When a client connects to a server for the first time, or the first time since its previous certificate has expired or
been revoked, the server requests that the client transmit its authentication certificate. The client’s certificate is
then verified against the CA which issued it. Clients can also request and verify the server’s authentication
certificate. For some applications, such as 802.1X authentication, clients do not need to validate the server
certificate for the authentication to function.

Digital certificates are issued by a CA which can be either a commercial, third-party company or a private CA
controlled by your organization. The CA is trusted to authenticate the owner of the certificate before issuing a
certificate. A CA-signed certificate guarantees the identity of the certificate holder. This is done by comparing
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the digital signature on a client or server certificate to the signature on the certificate for the CA. When CA-
signed certificates are used to authenticate clients, the managed device checks the validity of client certificates
using certificate revocation lists (CRLs) maintained by the CA that issued the certificate.

Digital certificates employ public key infrastructure (PKI), which requires a private-public key pair. A digital
certificate is associated with a private key, known only to the certificate owner, and a public key. A certificate
encrypted with a private key is decrypted with its public key. For example, party A encrypts its certificate with
its private key and sends it to party B. Party B decrypts the certificate with party A’s public key.

Obtaining Server Certificate
Best practices is to replace the default server certificate in the managed device with a custom certificate issued
for your site or domain by a trusted CA. To obtain a security certificate for the managed device from a CA:

1. Generate a Certificate Signing Request (CSR) on the managed device using either the WebUI or CLI.

2. Submit the CSR to a CA. Copy and paste the output of the CSR into an email and send it to the CA of your
choice.

3. The CA returns a signed server certificate and the CA’s certificate and public key.

4. Install the server certificate, as described in Importing Certificates on page 761.

There can be only one outstanding CSR at a time in the managed device. Once you generate a CSR, you need to
import the CA-signed certificate into the managed device before you can generate another CSR.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Certificates page and

click the CSR section.

2. Enter the following information:

Parameter Description Range

CSR Type Type of the CSR.

You can generate a certificate signing request
either with an Elliptic curve (EC) key, or with a
Rivest-Shamir-Aldeman (RSA) key.

ec/rsa

Curve name Length of the private/public key for ECDSA. This is
applicable only if CSR Type is ec.

secp256r1/secp384
r1

Key Length Length of the private/public key for RSA.

This is applicable only if CSR Type is rsa.

NOTE: RSA-1024 is not permitted if the managed
device is operating in the FIPS mode.

1024/2048/4096

Common Name Typically, this is the host and domain name, as in
www.example.com.

—

Country Two-letter ISO country code for the country in which
your organization is located.

Table 165: CSR Parameters



Parameter Description Range

State/Province State, province, region, or territory in which your
organization is located.

City City in which your organization is located.

Organization Name of your organization.

Unit Optional field to distinguish a department or other
unit within your organization.

Email Address Email address referenced in the CSR.

3. Click Generate New.

4. Click View Current to display the generated CSR. Select and copy the CSR output between the BEGIN
CERTIFICATE REQUEST and END CERTIFICATE REQUEST lines, paste it into an email and send it to the CA of
your choice.

In the CLI
1. Run the following command:

crypto pki csr {rsa key_len <key_val> |{ec curve-name <key_val>} common_name <common_val>

country <country_val> state_or_province <state> city <city_val> organization <organization_

val> unit <unit_val> email <email_val>

RSA-1024 is not permitted if the managed device is operating in the FIPS mode.

2. Display the CSR output with the following command:
show crypto pki csr

3. Copy the CSR output between the BEGIN CERTIFICATE REQUEST and END CERTIFICATE REQUEST lines,
paste it into an email and send it to the CA of your choice.

Obtaining Client Certificate
You can use the CSR generated on the managed device to obtain a certificate for a client. However, since there
may be a large number of clients in a network, you typically obtain client certificates from a corporate CA
server. For example, in a browser window, enter http://<ipaddr>/crtserv, where <ipaddr> is the IP address of
the CA server.

Importing Certificates
Use the WebUI or the CLI to import certificates into the managed device.

You cannot export certificates from the managed device.

You can import the following types of certificates into the managed device:

l Server certificate signed by a trusted CA. This includes a public and private key pair.

l CA certificate used to validate other server or client certificates. This includes only the public key for the
certificate.
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l Client certificate and client’s public key. (The public key is used for applications such as SSH which does not
support X509 certificates and requires the public key to verify an allowed certificate.)

Certificates can be in the following formats:

l X509 PEM unencrypted

l X509 PEM encrypted with a key

l DER

l PKCS7 encrypted

l PKCS12 encrypted

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Certificates page.

2. In the Import Certificates table click +.

3. For Certificate Name, enter a user-defined name.

4. For Certificate Filename, click Browse to navigate to the appropriate file on your computer.

5. If the certificate is encrypted, enter and repeat the passphrase.

6. Select the Certificate Format from the drop-down list.

7. Select the Certificate Type from the drop-down list.

8. Click Submit.

9. Click Pending Changes.

10.In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
Use the following command to import CSR certificates:

crypto pki-import {der|pem|pfx|pkcs12|pkcs7} {PublicCert|ServerCert|TrustedCA} <name>

The following example imports a server certificate named cert_20 in DER format:
crypto pki-import der ServerCert cert_20

Viewing Certificate Information
In the WebUI, the Certificate Lists section of the page lists the certificates that are currently installed in the
managed device. Click View to display the contents of a certificate.

To view the contents of a certificate with the CLI, use the following commands:



Command Description

show crypto-local pki

trustedCAs [<name>]

[<attribute>]

Displays the contents of a trusted CA certificate. If a name is not
specified, all CA certificates imported into the managed device are
displayed. If name and attribute are specified, then only the attribute in
the certificate are displayed. Attributes can be CN, validity, serial-
number, issuer, subject, public-key.

show crypto-local pki

serverCerts [<name>]

[<attribute>]

Displays the contents of a server certificate. If a name is not specified,
all server certificates imported into the managed device are displayed.

show crypto-local pki

publiccert [<name>]

[<attribute>]

Displays the contents of a public certificate. If a name is not specified,
all public certificates imported into the managed device are displayed.

Table 166: Certificate Show Commands

Imported Certificate Locations
Imported certificates and keys are stored in the following locations in flash on the managed device:

Location Description

/flash/certmgr/trustedCAs Trusted CA certificates, either for root or intermediate CAs. Best
practices is to import the certificate for an intermediate CA, you also
import the certificate for the signing CA.

/flash/certmgr/serverCerts Server certificates. These certificates must contain both a public and
private key (the public and private key must match). You can import
certificates in PKCS12 and X509 PEM formats, but they are stored in
X509 PEM DES encrypted format.

/flash/certmgr/CSR Temporary certificate signing requests (CSRs) that have been
generated on the managed device and are awaiting a CA to sign them.

/flash/certmgr/publiccert Public key of certificates. This allows a service on the managed device
to identify a certificate as an allowed certificate.

Table 167: Imported Certificate Locations

Checking CRLs
A CA maintains a CRL that contains a list of certificates that have been revoked before their expiration date.
Expired client certificates are not accepted for any user-centric network service. Certificates may be revoked
because certificate key has been compromised or the user specified in the certificate is no longer authorized to
use the key.

When a client certificate is being authenticated for a user-centric network service, the managed device checks
with the appropriate CA to make sure that the certificate has not been revoked.

The managed device does not support download of CRLs.
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Certificate Expiration Alert
The certificate expiration alert sends alerts when installed certificates, which correspond to trust chains, OCSP
responder certificates, and any other certificates installed on the device. By default, the system sends this alert
60 days before the expiration of the installed credentials. This alert is then repeated periodically on a weekly or
biweekly basis. This alerts consist of two SNMP traps:

l wlsxCertExpiringSoon

l wlsxCertExpired

Chained Certificates on the RAP
Chained certificates on the RAP (that is, certificates from a multi-level PKI) need to be in a particular order inside
the file. The RAP’s certificate must be first, followed by the certificate chain in order, and then followed by the
private key for the certificate. For example, with a root CA, a single intermediate CA, and a root CA, the PEM or
PKCS12 file must contain the following parts, in this order:

1. RAP Certificate

2. Intermediate CA

3. Root CA

4. Private key

If this order is not followed, certificate validation errors occur. This order also applies to server certificates.

Support for Certificates on USB Flash Drives
This release now supports storing RAP certificates in a USB device. This ensures that the RAP certificate is
activated only when the USB with the corresponding certificate is connected to the RAP. If the USB is removed
from the RAP, the RAP certificate is deactivated and when the USB is connected to the RAP it acts a storage
device and not as a 3G/4G RAP.

The RAP supports only PKCS12-encoded certificates that are present in the USB. This certificate contains all the
information that is required for creating the tunnel including the private key, RAP certificate with the chain of
certificates, and the trusted CA certificate. There is a limit of three supported intermediate CAs.

Ensure you adhere to the following file naming guidelines when you are saving the certificate:

l The first twelve characters of the certificate file name should be the RAP's MAC address. For example, if
RAP’s eth0 MAC address is 00:0b:86:c2:00:6c, then the file name will be 000B86C2006C.P12 or
000B86C2006C_rap155.p12

l All alphabets of the MAC address in the file name should be in upper case.

l The file name can have additional characters after the MAC address separated by "_" for the purpose of
identification.

If this naming convention is not followed a error will occur during certificate validation.

Follow the steps below to configure the USB certificate store:

1. Copy the PKCS12 certificate bundle to a USB device.

2. Enter a name for the certificate using the correct naming convention as mentioned above.

In the USB connected to the RAP, delete any duplicate <mac-address>.p12 certificate file. Only one such file must be
present in the USB.

If you unplug the USB device the RAP will become unresponsive. Reboot the RAP to bring it up with a custom
certificate, if the USB device was unplugged.



Marking the USB Device Connected as a Storage Device
If the AP provisioning parameter “usb-type” contains the value “storage,” this indicates that the RAP will
retrieve certificates from the connected USB flash drive.

RAP Configuration Requirements
The RAP needs to have one additional provisioning parameter, the pkcs12_passphrase, which can be left
untouched or can store an ACSII string. The string assigned to this parameter is used as the passphrase for
decoding the private key stored.

If you have an activated RAP that is using USB storage for the certificate, and you remove the USB storage, the RAP
drops the tunnel. This is by design. However, for the RAP to re-establish the tunnel it has to be power cycled. It does
not matter if you reinsert the USB storage before or after the power cycle as long as you power cycle it.

When the RAP successfully extracts all the information including the CA certificate, the RAP certificate and the
RAP private key using the passphrase from the provisioning parameter, it successfully establishes the tunnel.

Configuring SNMP
Managed devices support versions 1, 2c, and 3 of Simple Network Management Protocol (SNMP) for reporting
purposes only. In other words, SNMP cannot be used for setting values in a system in the current ArubaOS
version.

Aruba-specific management information bases (MIBs) describe the objects that can be managed using SNMP.

SNMP Parameters
You can configure the following SNMP parameters.

Field Description

Host Name Host name of the managed device.

System Contact Name of the person who acts as the System Contact or administrator for
the managed device.

System Location String to describe the location of the managed device.

Read Community Strings Community strings used to authenticate requests for SNMP versions
before version 3.

NOTE: This is needed only if using SNMP v2c and is not needed if using
version 3.

Enable Trap Generation Enables generation of SNMP traps to configured SNMP trap receivers.
Refer to the list of traps in the “SNMP traps” section below for a list of
traps that are generated by the managed device.

Table 168: SNMP Parameters
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Field Description

Trap receivers Host information about a trap receiver. This host needs to be running a
trap receiver to receive and interpret the traps sent by the managed
device. Configure the following for each host/trap receiver:

l IP address

l SNMP version: can be 1, 2c, or 3.

l Type: Trap or Inform (SNMPv2c or SNMPv3 only)

l Engine ID: (SNMPv3 only)

l Security string

l UDP port on which the trap receiver is listening for traps. The default is
the UDP port number 162. This is optional, and will use the default port
number if not modified by the user.

If you are using SNMPv3 to obtain values from the managed device, you can configure the following
parameters:

User name A string representing the name of the user.

Authentication protocol An indication of whether messages sent on behalf of this user can be
authenticated, and if so, the type of authentication protocol used. This can
take one of the two values:

l MD5: HMAC-MD5-96 Digest Authentication Protocol

l SHA: HMAC-SHA-96 Digest Authentication Protocol

Authentication protocol
password

If messages sent on behalf of this user can be authenticated, the (private)
authentication key for use with the authentication protocol. This is a string
password for MD5 or SHA depending on the choice above.

Privacy protocol An indication of whether messages sent on behalf of this user can be
protected from disclosure, and if so, the type of privacy protocol which is
used. This takes the value DES (CBC-DES Symmetric Encryption Protocol).

Privacy protocol password If messages sent on behalf of this user can be encrypted/decrypted with
DES, the (private) privacy key for use with the privacy protocol.

Follow the steps below to configure basic SNMP parameters.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > SNMP page.

2. If the managed device will be sending SNMP traps, click + in the Trap Receivers section to add a trap
receiver.

3. If you are using SNMPv3 to obtain values from the managed device, click + in the Users for SNMPv3 section
to add a new SNMPv3 user.

4. Click Apply.

In the CLI
hostname name

syscontact name

syslocation string



snmp-server community string

snmp-server enable trap

snmp-server engine-id engine-id

snmp-server host ipaddr version {1|2c|3} string [udp-port number]

snmp-server trap source ipaddr

snmp-server user name [auth-prot {md5|sha} password priv-prot DES password

Earlier versions of ArubaOS supported SNMP on individual APs. This feature is not supported by this version of
ArubaOS.

Enabling Capacity Alerts
Use the capacity alert feature to set managed device capacity thresholds which, when exceeded, will trigger
alerts. The managed device will send awlsxThresholdExceeded SNMP trap and a syslog error message when the
managed device has exceeded a set percentage of the total capacity for that resource. A
wlsxThresholdCleared SNMP trap and error message will be triggered if the resource usage drops below the
threshold once again.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > More page.

2. Select Capacity Threshold.

3. Modify the capacity percentages for any of the thresholds described in Table 169.

4. Click Apply to save your settings.

The following table describes the thresholds that can be configured with this feature.

Threshold Description

Controlpath CPU Set an alert threshold for controlpath CPU capacity. The <percentage> parameter
is the percentage of the total controlpath CPU capacity that must be exceeded
before the alert is sent. The default threshold for this parameter is 80%.

Controlpath
memory

Set an alert threshold for controlpath memory consumption. The <percentage>
parameter is the percentage of the total memory capacity that must be exceeded
before the alert is sent. The default threshold for this parameter is 80%.

Datapath CPU Set an alert threshold for datapath CPU capacity. The <percentage> parameter is
the percentage of the total datapath CPU capacity that must be exceeded before
the alert is sent. The default threshold for this parameter is 30%.

Total APs The maximum number of APs that can be connected to a managed device is
determined by that managed device’s model type and installed licenses. Use this
command to trigger an alert when the number of APs currently connected to the
managed device exceeds a specific percentage of its total AP capacity. The default
threshold for this parameter is 80%.

Table 169: Capacity Alert Thresholds
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Threshold Description

Total locals Set an alert threshold for the master managed device’s capacity to support branch
and local managed device. A master managed device can support a combined
total of 256 branch and local managed device. The <percentage> parameter is the
percentage of the total master managed device capacity that must be exceeded
before the alert is sent. The default threshold for this parameter is 80%.

Total tunnels Set an alert threshold for the managed device’s tunnel capacity. The <percentage>
parameter is the percentage of the managed device’s total tunnel capacity that
must be exceeded before the alert is sent. The default threshold for this parameter
is 80%

Total users Set an alert threshold for the managed device’s user capacity. The <percentage>
parameter is the percentage of the total resource capacity that must be exceeded
before the alert is sent. The default threshold for this parameter is 80%.

In the CLI
To configure this feature, access the command-line interface in config mode and issue the following
commands:
threshold

Sample Configuration

The following command configures a new alert threshold for datapath memory consumption:
(host) [mynode] (config) #threshold datapath-cpu 90

If this threshold is exceeded then subsequently drops below the 90% threshold, the managed device would
send the following two syslog error messages.
May 14 13:13:58 nanny[1393]: <399816> <ERRS> |nanny| Resource 'Control-Path Memory' has gone

above 90% threshold, value : 93

May 14 13:16:58 nanny[1393]: <399816> <ERRS> |nanny| Resource 'Control-Path Memory' has come

below 90% threshold, value : 87

Configuring Logging
This section outlines the steps required to configure logging on a managed device.

For each category or subcategory of message, you can set the logging level or severity level of the messages to
be logged. Table 170 summarizes these categories:

Category/Subcategory Description

Network Network messages

all All network messages

packet-dump Protocol packet dump messages

Table 170: Software Modules



Category/Subcategory Description

mobility Mobility messages

dhcp DHCP messages

System System messages

all All system messages

configuration Configuration messages

messages Messages

snmp SNMP messages

webserver Web server messages

security Security messages

all All security messages

aaa AAA messages

firewall Firewall messages

packet-trace Packet trace messages

mobility Mobility messages

vpn VPN messages

dot1x 802.1X messages

ike IKE messages

webserver Web server messages

Wireless Wireless messages

all All wireless messages

User User messages

all All user messages
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Category/Subcategory Description

captive-portal Captive portal user messages

vpn VPN messages

dot1x 802.1X messages

radius RADIUS user messages

For each category or subcategory, you can configure a logging level. Table 171 describes the logging levels in
order of severity, from most to least severe.

Logging Level Description

Emergency Panic conditions that occur when the system becomes unusable.

Alert Any condition requiring immediate attention and correction.

Critical Any critical conditions such as a hard drive error.

Errors Error conditions.

Warning Warning messages.

Notice Significant events of a non-critical and normal nature.

Informational Messages of general interest to system users.

Debug Messages containing information useful for debugging.

Table 171: Logging Levels

The default logging level for all categories is Warning. You can also configure IP address of a syslog server to
which the managed device can direct these logs.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > Logging > Syslog

Servers page.

2. To add a logging server, click + in the Syslog Servers section.

3. Add the logging server to the list of logging servers. Ensure that the syslog server is enabled and configured
on this host. Click Apply.

4. To select the types of messages you want to log, select Logging Levels .

5. Select the category or subcategory to be logged.

6. To select the severity level for the category or subcategory, select the level from the Logging Level drop-
down list.

7. Click Apply to apply the configuration.



In the CLI
logging <ipaddr>

logging level <level> <category> [subcat <subcategory>]

Syslog operates over UDP and is connectionless. Therefore, it is not possible for the managed device to
recognize a failure of the syslog server or the network path to the syslog server. By establishing an IPsec tunnel
between the managed device and the syslog server, (see Planning a VPN Configuration) it is possible to
indirectly track the status of the syslog server link.

After a failure occurs, the network administrator has to manually re-synchronize log files by copying them from
the managed device to the syslog server. Use the tar logs CLI command to create an archive of all local logs,
then use the copy CLI command to copy this archive to an external server. Log space is limited on the
managed device, and depending on how long the outage lasted some local logs may be overwritten.

Enabling Guest Provisioning
The Guest Provisioning feature lets you manage guests who need access to your company’s wireless network.
This section describes how to:

l Design and configure the Guest Provisioning page – Using the WebUI, the network administrator designs
and configures the Guest Provisioning page that is used to create a guest account.

l Configure a guest provisioning user – The network administrator configures one or more guest provisioning
users. A guest provisioning user, such as a front desk receptionist, signs in guests at your company.

l Using the Guest Provisioning page – The Guest Provisioning page is used by the guest provisioning user to
create guest accounts for people who are visiting your company.

Configuring Guest Provisioning Page
Use the Guest Provisioning Configuration page to create the Guest Provisioning page. This configuration page
consists of three tabs: Guest Fields, Page Design and Email. You configure the information on all three tabs to
create a Guest Provisioning page.

l Guest Fields tab—lets you select the fields that appear on the Guest Provisioning page.

l Page Design tab—lets you specify the company banner, heading, and text and background colors that
appear on the Guest Provisioning page.

l Email tab—lets you specify an email to be sent to the guest or sponsor (or both). Email messages can be
sent automatically at account creation time and also may be sent manually by the administrator from the
Guest Provisioning page.

In the WebUI

You can only create and design the Guest Provisioning page in the WebUI.

This section describes how to design a Guest Provisioning page using all three tabs.

Configuring Guest Fields

1. In the Managed Device node hierarchy, navigate to the Configuration > Services > Guest Provisioning
page. The Guest Provisioning configuration page displays with the Guest Fields section on top. This section
contains the following columns:

n Internal Name—The unique identifier that is mapped to the label in the UI.

n Label in UI—A customizable string that displays in both the main listing pane and details sheet on the
Guest Provisioning page.
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n Display in Details—Fields with selected check boxes appear in the Show Details popup-window.

If the guest_category, account_category, sponsor_category and optional_category fields are not checked, their
respective sections do not appear on the Guest Provisioning page.

n Display in Listing—Fields with selected check boxes appear as columns in the management user
summary page.

Figure 92 Guest Provisioning Configuration Page—Guest Fields Section

2. Select the check box next to each field, described in Table 172, that you want to appear on the Guest
Provisioning page. Optionally, you can customize the label that displays in the UI.

3. Click Preview Current Settings in the Guest Access section to view what the Guest Provisioning page
looks like while you are designing it.

4. To save changes, click Apply.

Best practices is to check the Display in Listing field for only the most essential fields, so that the Guest
Provisioning user does not have to scroll the guest listing horizontally to see all the columns.

Guest Field Description

guest_category A guest is the person who needs guest access to the company’s wireless
network. This is the label on the Guest Provisioning page for the guest
information.

guest_username Username for the guest.

guest_password Password for the guest. (Must contain at least 1-6 characters and at
least one digit.)

guest_fullname Full name of the guest.

guest_company Name of the guest's company.

Table 172: Guest Provisioning—Guest Field Descriptions



Guest Field Description

guest_email Guest's Email address.

guest_phone Guest's phone number

comments Optional comments about the guest's account status, meeting schedule
and so on.

account_category This is the label on the Guest Provisioning page for the account
information.

creation-date Date the account is created.

start_date Date the guest account begins.

end_date Date the guest account ends.

grantor The username of the person of who created the guest account.

grantor_role The authentication role of the grantor.

sponsor_category A sponsor is the guest's primary contact for the visit. This is the label in
the Guest Provisioning page for the sponsor information.

sponsor_username

Sponsor's work department

sponsor_email Sponsor's Email address.

optional_category This is the label in the Guest Provisioning page for the information in the
optional fields that follow.

NOTE: The optional_category field can be used for another person, for
example a “Supervisor.” You can enter username, full name,
department and Email information into the optional fields. Or, you can
use this category for some other purpose.

optional_field_1 optional_field_1 description

optional_field_2 optional_field_2 description

optional_field_3 optional_field_2 description

optional_field_4 optional_field_2 description

Configuring Page Design

The Page Design section lets you specify the company banner, heading, and text and background colors that
appear on the Guest Provisioning page.
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1. In the Managed Device node hierarchy, navigate to the Configuration > Services > Guest Provisioning
page and select the Page Design section.

Figure 93 Guest Provisioning Configuration Page—PageDesign Section

2. Enter the filename which contains the company banner in the Banner field. Or, click Browse to search for
the filename.

Best practices is to use a logo or banner image that is 600 x 100 pixels (width x height). The WebUI does not apply
the size restrictions when you upload an image file, but the image is resized to 600 x 100 pixels when it displays or is
printed.

3. Enter the label for the guest listing (the one you used in the Guest Fields tab) in the Text field.

4. Enter the hex value for the color of the text in the Text Color field. The text in the header of the guest
listing displays in this color.

5. Enter the hex value for the color of the background in the Background color field. This determines the
color of the header of the guest listing.

6. Click Preview Current Settings in the Guest Access section to view what the Guest Provisioning page
looks like while you are designing it.

7. To save changes, click Apply.

Configuring Email Messages

You can specify an email to be sent to the guest or sponsor (or both). Email messages can be sent automatically
at account creation time or sent manually by the network administrator or guest provisioning user from the
Guest Provisioning page at any time.

1. Specify the SMTP server and port that processes the guest provisioning (also known as guest access) email.
You can complete this step using the WebUI or CLI commands:

n Configuring SMTP Server and Port in WebUI on page 775

n Configuring SMTP server and port in CLI on page 775

2. Create the email messages. Complete this step using the WebUI:

Creating Email Messages in the WebUI on page 775



Configuring SMTP Server and Port in WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > More page.
2. Click the SMTP section in the bottom of the page.

3. Enter the IP address of the SMTP server to which the managed device sends the guest provisioning email in
the IP Address of SMTP server field.

4. Enter the number of the port through which the guest provisioning email passes in the Port field.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

Configuring SMTP server and port in CLI
The following command creates a guest-access email and sends guest user email through SMTP server IP
address 1.1.1.1 on port 25.
(host) (config) #guest-access-email

(host) (Guest-access Email) #smtp-port 25

(host) (Guest-access Email) #smtp-server 1.1.1.1

Creating Email Messages in the WebUI
After you configured the SMTP server and port, follow these steps:

1. Navigate to the Configuration > Services > Guest Provisioning page and select the Guest Email or
Sponsor Email section.

Figure 94 Guest Provisioning Configuration Page—Email Section

2. To create a message for a guest or sponsor, customize the text in the Subject, From, and Body fields as
needed for both the Guest message and Sponsor message.
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3. Optionally, select the Send automatically at account creation time check box when you want an email
message to be sent to the guest and/or sponsor alerting them that a guest account has just been created.

Regardless of whether you select this option, the person responsible for managing the Guest Provisioning page
may choose to send this email message manually at any time.

Figure 95 shows a sample email message that is sent to the guest after the guest account is created.

Figure 95 Sample Guest Account Email – Sent to Sponsor

4. To save changes, click Apply.

Configuring Guest Provisioning User
The guest provisioning user has access to the Guest Provisioning Page (GPP) to create guest accounts within
your company. The guest provisioning user is usually a person at the front desk who greets guests and creates
guest accounts. Depending upon your needs, there are three ways to configure and authenticate a guest
provisioning user:

l Username and Password authentication — Allows you to configure a user in a guest provisioning role.

l Smart Card authentication

n Static authentication —Uses a configured certificate name and serial number to derive the user role. This
authentication process uses a previously configured certificate name and serial number to derive the
user role. This method does not use and external authentication server.

n Authentication server — Uses an external authentication server to derive the management role. This is
helpful if there is a large number of users who need to be deployed as guest provisioning users.

You can use the WebUI or CLI to create a Guest Provisioning user.

In the WebUI
This section describes how to configure a guest provisioning user. All three methods are described.

Username and Password Authentication Method

1. In the Managed Device node hierarchy, navigate to the Configuration > System > Admin page.

2. Select Enable Local Authentication as needed.

3. In the Management Users section, click +.

4. In the Username field, enter the name of the user who you want to configure as a guest provisioning user.

5. In the Password and Confirm Password fields, enter the user’s password and reconfirm it.



6. From the Role drop-down list, select guest-provisioning.

7. Click Apply.

Static Authentication Method

Before using this method, make sure that the correct CA certificate is uploaded to the managed device.

1. In the Managed Device node hierarchy, navigate to the Configuration > System > Administration page.

2. In the Management Users section, click +.

3. In the New User section, select show users with certificate authentication.

4. Click +.

5. Make sure that the Use external authentication server to authenticate check box is unchecked.

6. In the Username field, enter the name of the user who you want to configure as a guest provisioning user.

7. In the Rolefield, select guest-provisioning from the drop-down list.

8. Select the CA certificate you want to use from the Trusted CA Certificate Name drop-down list.

9. Enter client certificate serial number in the Client Certificate Serial No. field.

10.Click Apply.

Smart Card Authentication Method

1. In the Managed Device node hierarchy, navigate to the Configuration > System > Admin page.

2. Expand Admin Authentication Options.

3. Under Admin Authentication Options, select guest-provisioning from the Default role drop-down
list.

4. Select the Enabled from the Enable drop-down list.

5. Select the server group from the Server Group drop-down list.

6. Click Submit.

7. Under WebUI Authentication, select Enabled for Client Certificate.

8. Click Submit.

9. Under Management Users, click Show users with certificate authentication.

10.Click +.

11.Select WebUI Certificate and Use external authentication server to authenticate.
12.Select the trusted CA certificate from the Trusted CA Certificated Name drop-down list.

13.Click Submit.

14.Click Pending Changes.

15.In the Pending Changes window, select the required check boxes and click Deploy changes.

In the CLI

Username and Password Method

This example creates a user named Alex and assigns her the role of guest provisioning.
(host) (config)# mgmt-user Alex guest-provisioning

Static Authentication Method

This example uses the CA certificate mycertificate with the serial number 1234 to authenticate user Laura in
the guest provisioning role.
(host) (config)# mgmt-user webui-cacert mycertificate serial 1234 Laura guest-provisioning

ArubaOS 8.0.0.0 | User Guide Management Access |  777



778 | Management Access ArubaOS 8.0.0.0  | User Guide

Smart Card Authentication Method

This example shows that using previously configured certificate (1234), authentication and authorization are
automatically configured using an authentication server.
(host) (config) #web-server profile

(host)(Web Server Configuration) #mgmt-auth username/password certificate

(host)(Web Server Configuration) #!

(host) (config) #mgmt-user webui-cacert <certificate_name>

(host) (config) #aaa authentication mgmt

(host) (config) #server-group "internal"

(host) (config) #mgmt-user webui-cacert default

(host) (config) #mgmt-user webui-cacert 1234

Customizing Guest Access Pass
In the WebUI, you can customize the pop-up window that displays the guest account information. You may
want to do this before the Guest Provisioning user creates guest accounts.

1. In the Managed Device node hierarchy, navigate to the Configuration > Services > Guest Provisioning
page and click the Guest Access section.

2. Click Browse to insert a logo or other banner information on the window.

Best practices is to use a logo or banner image that is 600 x 100 pixels (width x height). The WebUI does not apply
the size restrictions when you upload an image file, but the image is resized to 600 x 100 pixels when it displays or is
printed.

3. You can enter text for the Policy portion of the window.

4. Click Submit to save your changes. Click Preview Pass to preview the window. (See Figure 96.)

Figure 96 CustomizedGuest Account InformationWindow

Creating Guest Accounts
After the Guest Provisioning user is created, that person can log in to the managed device using the
preconfigured username and password. The Guest Provisioning page displays. (See Figure 98.) This is a sample
page as the fields may differ based on how the network administrator designed the page.



Figure 97 Creating aGuest Account—Guest Provisioning Page

If you do not want multiple guest users to share the same guest account concurrently, navigate to the Captive Portal
Authentication and select the “Allow only one active user session” option. If a guest user authenticates successfully
but the managed device detects there is already a guest session with the same guest username, the second login is
rejected.

Guest Provisioning User Tasks
The Guest Provisioning user creates guest accounts by filling in information on the Guest Provisioning page.
Tasks include creating, editing, manually sending email, enabling, printing, disabling and deleting guest
accounts. The Guest Provisioning user can also manually send emails to either the guest or sponsor.

To create a new guest account, the Guest Provisioning user clicks New to display the New Guest window. (See
Figure 98.) After filling in information into the fields, click Create. The guest account now displays on the Guest
Provisioning page.

If you manually configure the user name and password, note the following:

l User name entries support alphanumeric characters, however the percent sign (%) and trailing the back
slash are not allowed.

l Passwords must have a minimum of six characters. You can use special characters for the password.

l Click on the Account Start and End fields to change the account start and end times. The default account
start to end time setting is eight hours.
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Figure 98 Creating aGuest Account—New Guest Window

To see details about an existing user account, highlight an existing account and select the Show Details check
box. The Show Details popup-window displays. (See Figure 99.) The Guest Provisioning user can send out Email
from this window to either the guest or the sponsor. When you send an email from the Details pop-up window,
a pop-up message confirming that the email was successfully processed displays



Figure 99 Creating aGuest Account—Show Details Pop-upWindow

Importing Multiple Guest Entries
The Guest Provisioning user can manually create individual guest entries, as previously described, or import
multiple guest entries into the database from a CSV file. This is useful and more efficient if you want to enter
multiple guest entries at once. To import multiple guest entries, you need to:

1. Create a CSV file that contains the guest entries

2. Import the CSV file into the database

Creating Multiple Guest Entries in CSV File

Create a CSV file that contains multiple guest entries. Each field in an entry needs to be separated by a comma
and each entry needs to end with a carriage return. The order of the fields is:

l Guest’s first name (required)

l Guest’s last name (required)

l Guest’s email address (optional)

l Guest’s phone number (optional)

l Guest’s user ID (optional)

l Guest’s password (optional)

l Sponsor’s first name (optional)

l Sponsor’s last name (optional)

l Sponsor’s email address (optional)

See Figure 100 for an example of how guest entries need to be formatted in a CSV file.
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Figure 100 CVS File Format—Guest Entries Information

Note the following limitations when creating guest entries in a CVS file:

l None of the field values can have a comma

l There is no format checking on field. Only the local-userdb-guest CLI command will validate proper
format.

l Any extra columns, beyond the 9th column, are discarded.

l The WebUI only supports characters that the CLI supports.

l If a guest’s user ID is not provided, then it is automatically generated based on the numeric suffix in the
Import Guest List window. See Figure 101.

l We recommend a maximum of 250 entries per CSV file.

Importing CSV File into Database

To import a CSV file that contains multiple guest entries, the Guest Provisioning user must follow these steps:

1. Log in to the WebUI using the username and password assigned to the Guest Provisioning user.

2. Click on Import. The Import Guest List pop-up window displays. See Figure 101.



Figure 101 Importing a CSV file that contains Guest Entries

3. Click Browse to locate for the CSV file you want to import.

4. Click Import. A window displays that lets you open CSV file in text format. (See Figure 102.) Open the text
file to see a summary of the number of users and error messages if users are not imported.
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Figure 102 Displaying the Guest Entries Log File

5. Click Import. A window displays that lets you open CSV file in text format. (See Figure 102.)

6. Open the text file. (See Figure 103.) Note that because no user ID is entered in the CSV file, a guest ID
(username) is automatically generated based on the default value in the Suffix for auto-generated field.
Make changes or corrections to the guest entry information in text file. A user can also change the start time
and end time from this window. Save and exit the file.



Figure 103 Viewing and Editing Guest Entries in the Log File

7. Click Cancel to close the Import Guest List window. Guest entries are now displayed in the Guest
Provisioning page.

Figure 104 ViewingMultiple Imported Guest Entries—Guest Provisioning Page

Printing Guest Account Information

To print guest account information:

1. Highlight the guest account you want to print and click Print. The Print info for guest window displays.

2. Click Print password if you want to print the guest password on the badge. Then enter or generate a new
password for the guest. This modifies the existing guest password. (See Figure 105.)

3. Optionally, click Print policy text if you want your company policy text to appear on the print out.

4. Click Show preview to view the information before it is printed.

5. Click Print to print the guest account information.
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Figure 105 Printing Guest Account Information

Optional Configurations
This section describes guest provisioning options that the administrator can configure.

These options are not configurable by the guest provisioning user.

Restricting one Captive Portal Session for each Guest
You can restrict one captive portal session for each guest. When a new captive portal request is received and
passes authentication, all users are checked and compared with user names. If a user with the same name
already exists and this option is enabled, the second login is denied.

If a guest logs in from one system (and does not log out) and tries to log in again from another system, that guest has
to wait for the initial session to expire.

1. Navigate to the Configuration > System > Profiles page.

2. Select Wireless LAN.

3. Under Wireless LAN, select and open Captive Portal Authentication.

4. Add a new or select and existing profile.

5. Select the Allow only one active user session check box.

6. Click Apply.

Using the CLI to restrict one Captive Portal session for each guest
(host)(config)# aaa authentication captive-portal <> single-session

Setting Maximum Time for Guest Accounts
You can set the maximum expiration time (in minutes) for guest accounts. If the guest-provisioning user
attempt to add a guest account that expires beyond this time period, an error message is displayed and the



guest account is created with the maximum time you configured.

If you set the maximum expiration time, it applies to all users in the internal database whether they are guests or not.

Using WebUI to set maximum time for guest accounts

1. Navigate to the Configuration > Security > Authentication page.

2. Select Internal DB.

3. Under Internal DB Maintenance, enter a value in Maximum Expiration.

4. Click Apply.

Using CLI to set maximum time for guest accounts
(host)# local-userdb maximum-expiration <minutes>

Managing Files on Managed Device
You can transfer the following types of files between the managed device and an external server or host:

l ArubaOS image file

l A specified file in the managed device’s flash file system, or a compressed archive file that contains the
entire content of the flash file system.

You back up the entire content of the flash file system to a compressed archive file, which you can then copy from the
flash system to another destination.

l Configuration file, either the active running configuration or a startup configuration.

l Log files.

You can use the following protocols to copy files to or from a managed device:

l File Transfer Protocol (FTP): Standard TCP/IP protocol for exchanging files between computers.

l Trivial File Transfer Protocol (TFTP): Software protocol that does not require user authentication and is
simpler to implement and use than FTP.

l Secure Copy (SCP): Protocol for secure transfer of files between computers that relies on the underlying
Secure Shell (SSH) protocol to provide authentication and security.

You can use SCP only for transferring image files to or from the managed device, or transferring files between the
flash file system on the managed device and a remote host. The SCP server or remote host must support SSH
version 2 protocol.

The following table lists the parameters that you configure to copy files to or from a managed device.
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Server Type Configuration

Trivial File Transfer Protocol (TFTP) l tftphost - tftp host IPv4 / IPv6 address

l filename - absolute path of filename 

l flash: - copy to the flash file system

l destination: - destination file name

l system: - system partition

l partition - partition 0 / partition 1

File Transfer Protocol (FTP) l ftphost - ftp server host name or IPv4/IPv6 address

l username - user name to log into server

l filename - absolute path of filename

l system: - system partition

l partition - partition 0 / partition 1

Secure Copy (SCP)

You must use the CLI to transfer files
with SCP.

l scphost - scp host of IPv4 / IPv6 address

l username - user name to secur to log into the server

l filename - absolute path of filename (otherwise, SCP
searches for the file relative to the user’s home directory)

l flash: - copy to the flash file system

l destfilename: - destination file name

l system: - system partition

l partition - partition 0 / partition 1

Table 173: File Transfer Configuration Parameters

For example, you can copy an ArubaOS image file from an SCP server to a system partition on a managed
device or copy the startup configuration on a managed device to a file on a TFTP server, You can also store the
contents of a managed device’s flash file system to an archive file which you can then copy to an FTP server.
You can use SCP to securely download system image files from a remote host to the managed device or
securely transfer a configuration file from flash to a remote host.

Transferring ArubaOS Image Files
You can download an ArubaOS image file onto a managed device from a TFTP, FTP, or SCP server. In addition,
the WebUI allows you to upload an ArubaOS image file from the local PC on which you are running the
browser.

When you transfer an ArubaOS image file to a managed device, you must specify the system partition to which
the file is copied. The WebUI shows the current content of the system partitions on the managed device. You
have the option of rebooting the managed device with the transferred image file.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > Upgrade > Image Management

page.

2. Select TFTP, FTP, SCP, or Upload Local File.

3. Enter or select the appropriate values for the file transfer method.

4. Select the system partition to which the image file is copied.



5. Specify whether the managed device is to be rebooted after the image file is transferred, and whether the
current configuration is saved before the managed device is rebooted.

6. Click Upgrade.

In the CLI
copy tftp: <tftphost> <filename> system: partition [0|1]}

copy ftp: <ftphost> <user> <filename> system: partition {0|1}

copy scp: <scphost> <username> <filename> system: partition [0|1]

Backing Up and Restoring Flash File System
You can store the entire content of the flash file system on a managed device to a compressed archive file. You
can then copy the archive file to an external server for backup purposes. If necessary, you can restore the
backup file from the server to the flash file system.

Backup Flash File System in the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > File > Backup Flash page.

2. Click Create Backup to back up the contents of the flash system to the flashbackup.tar.gz file.

3. Click Copy Backup to enter the Copy Files page where you can select the destination server for the file.

4. Click Apply.

Backup Flash File System in the CLI
backup flash

copy flash: flashbackup.tar.gz tftp: <tftphost> <destfilename>

copy flash: flashbackup.tar.gz scp: <scphost> <username> <destfilename>

Restore Flash File System in the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > File > Copy Files page.

a. For Source Selection, specify the server to which the flashbackup.tar.gz file was previously copied.

b. For Destination Selection, select Flash File System.

c. Click Apply.

2. In the Managed Device node hierarchy, navigate to the Maintenance > File > Restore Flash page.

3. Click Restore to restore the flashbackup.tar.gz file to the flash file system.

4. In the Managed Device node hierarchy, navigate to the Maintenance > Upgrade > Reboot page.

5. Click Continue to reboot.

Restore Flash File System in the CLI
copy tftp: <tftphost> <srcfilename> flash: flashbackup.tar.gz

copy scp: <scphost> <username> <srcfilename> flash: flashbackup.tar.gz

restore flash

Copying Log Files
You can store log files into a compressed archive file which you can then copy to an external TFTP or SCP
server. The WebUI allows you to copy the log files to a WinZip folder which you can display or save on your
local PC.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > File > Copy Logs page.

2. For Destination, specify the TFTP or FTP server to which log files are copied.

3. Select Download Logs to download the log files into a WinZip file on your local PC,
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4. Click Apply.

In the CLI
tar logs

copy flash: logs.tar tftp: <tftphost> <destfilename>

copy flash: logs.tar scp: <scphost> <username> <destfilename>

Copying Other Files
The flash file system contains the following configuration files:

l startup-config: Contains the configuration options that are used the next time the managed device is
rebooted. It contains all options saved by clicking the Submit button in the WebUI or by entering the write
memory CLI command. You can copy this file to a different file in the flash file system or to a TFTP server.

l running-config: Contains the current configuration, including changes which have yet to be saved. You can
copy this file to a different file in the flash file system, to the startup-config file, or to a TFTP or FTP server.

You can copy a file in the flash file system or a configuration file between the managed device and an external
server.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > File > Copy Files page.

2. Select the source where the file or image exists.

3. Select the destination to where the file or image is to be copied.

4. Click Apply.

In the CLI
copy startup-config flash: <filename>

copy startup-config tftp: <tftphost> <filename>

copy running-config flash: <filename>

copy running-config ftp: <ftphost> <user> <filename> [<remote-dir>]

copy running-config startup-config

copy running-config tftp: <tftphost> <filename>

Setting System Clock
You can set the clock on a managed device manually or by configuring the managed device to use a Network
Time Protocol (NTP) server to synchronize its system clock with a central time source.

Manually Setting Clock
You can use either the WebUI or CLI to manually set the time on the managed device’s clock.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > General page and click

the Clock section.

2. For the Time, select whether to Get time from NTP server or Use current system time.

3. For Time Zone, select the offset from Greenwich Mean Time (GMT) and select the name of the time zone.

4. To adjust the clock for daylight savings time, click Enabled under Summer Time. Additional fields appear
that allow you to set the offset from UTC, and the start and end recurrences.

5. Click Apply.



In the CLI
To set the date and time, enter the following command in privileged mode:

clock set <year> <month> <date> <hour> <minutes> <seconds>

To set the time zone and daylight savings time adjustment, enter the following commands in configure mode:
clock timezone <WORD> <-23 - 23>

clock summer-time <zone> [recurring]

   <1-4> <start day> <start month> <hh:mm>

   first <start day> <start month> <hh:mm>

   last <start day> <start month> <hh:mm>

   <1-4> <end day> <end month> <hh:mm>

   first <end day> <end month> <hh:mm>

   last <end day> <end month> <hh:mm>

[<-23 - 23>]

Clock Synchronization
You can use NTP to synchronize the managed device to a central time source. Configure the managed device to
set its system clock using NTP by configuring one or more NTP servers.

For each NTP server, you can optionally specify the NTP iburst mode for faster clock synchronization. The
iburst mode sends up ten queries within the first minute to the NTP server. (When iburst mode is not enabled,
only one query is sent within the first minute to the NTP server.) After the first minute, the iburst mode
typically synchronizes the clock so that queries need to be sent at intervals of 64 seconds or more.

The iburst mode is a configurable option and not the default behavior for the managed device, as this option is
considered “aggressive” by some public NTP servers. If an NTP server is unresponsive, the iburst mode continues to
send frequent queries until the server responds and time synchronization starts.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > General > Clock page.

2. Under NTP Servers, click Add.

3. Enter the IP address of the NTP server.

4. Select (check) the iburst mode, if desired.

5. Click Add.

In the CLI
ntp server ipaddr [iburst]

Configuring NTP Authentication
The Network Time Protocol adds security to an NTP client by authenticating the server before synchronizing
the local clock. NTP authentication works by using a symmetric key which is configured by the user. The secret
key is shared by both the managed device and an external NTP server. This helps identify secure servers from
fraudulent servers.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Configuration > System > General > Clock page.

2. Under NTP Authentication, make sure Enable is selected. Enable is the default option.

3. Under NTP Servers, enter the NTP server IP address (IPv4/IPv6) in the Server IP field.

4. Under NTP Identification Keys, enter an identification key (a number between 1 and 65535) in the
Identification Key field. Then add a secret string in the MD5 Secret field. The MD5 ID key must be an
ASCII string up to 31 characters.
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5. Click Add.

6. The identification key along with its corresponding MD5 secret string is displayed in the Identification
Keys section.

7. Under NTP Trusted Keys, enter a string in the Trusted Key field. This is a subset of keys which are
trusted. The trusted key value must be numeric values between 1 to 65535.

8. Click Apply.

In the CLI
This example enables NTP authentication, add authentication secret keys into the database, and specifies a
subset of keys which are trusted. It also enables the iburst option.
(host) (config) #ntp authenticate

(host) (config) #ntp authentication-key <key-id> md5 <key-secret>

(host) (config) #ntp trusted-key <key-id>

(host) (config) #ntp server <ipaddr> <iburst> <key>

(host) (config) #ntp server <server IP> <iburst key> <key>

Timestamps in CLI Output
The timestamp feature can include a timestamp in the output of each show command issued in the command-
line interface, indicating the date and time the command was issued. Note that the output of show clock and
show log do not include timestamps, even when this feature is enabled.

To enable this feature, access the command-line interface in config mode and issue the command clock
append.

(host) (config) #clock append

ClearPass Policy Manager Profiling with IF-MAP
This feature is used in conjunction with ClearPass Policy Manager. It sends HTTP User Agent Strings and mDNS
broadcast information to ClearPass Policy Manager so that it can make more accurate decisions about what
types of devices are connecting to the network.

In the WebUI
To enable and configure this feature:

1. In the Managed Device node hierarchy, navigate to Configuration > System > Profiles > All Profiles >
Other Profiles.

2. Click the CPPM IF-MAP profile.

3. Configure this profile according to the following parameters:



Parameter Description

CPPM IF-Map Interface Enables the feature

Host IP address IP address or hostname of the ClearPass Policy Manager IF-MAP
server

Username Username for the user who performs actions on the ClearPass
Policy Manager IF-MAP server. Range must be between 1-255 bytes
in length.

Password Password of the user who performs actions on the ClearPass Policy
Manager IF-MAP server. Range between 6-100 bytes in length.

Table 174: ClearPass Policy Manager IF-Map Configuration Parameters

In the CLI
To configure this feature using the CLI:
(host) (config) #ifmap

(host) (config) #ifmap cppm

(host) (CPPM IF-MAP Profile) #server host <host>

(host) (CPPM IF-MAP Profile) #port <port>

(host) (CPPM IF-MAP Profile) #passwd <psswd>

(host) (CPPM IF-MAP Profile) #enable

This show ifmap cppm command shows if the CCPM interface is enable and the ClearPass Policy Manager
server IP address, username and password.
(host) (CPPM IF-MAP Profile) #show ifmap cppm

CPPM IF-MAP Profile

-------------------

Parameter Value

--------- -----

CPPM IF-MAP Interface Enabled

CPPM IF-MAP Server 10.4.191.32:443 admin/********

This show command shows if state of all enabled ClearPass Policy Manager servers.
(host) (CPPM IF-MAP Profile) #show ifmap state cppm

CPPM IF-MAP Connection State [Interface: Enabled]

-------------------------------------------------

Server State

------ -----

10.4.191.32:443 UP

Whitelist Synchronization
ArubaOS allows managed devices to synchronize their remote AP whitelists with the Aruba Activate cloud-
based services. When you configure Activate whitelist synchronization, the managed device will securely
contact the Activate server and download the contents of the whitelist on the Activate server to the whitelist
on the managed device. The managed device and the Activate server must have layer-3 connectivity to
communicate.

By default, this feature will both add new remote AP entries to the managed device whitelist and delete any
obsolete entries on the managed device whitelist that were not on the Activate server whitelist. Select the add-
only option to allow this feature to add or modify entries, but not delete any existing entries.
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In the WebUI
To enable this feature using the WebUI,

1. In the Managed Device node hierarchy, navigate to Configuration > System > CPSEC and click the Sync
Whitelist with Activate section.

2. Set Enable sync service to Enabled.

3. In the Activate user field, enter the user name for your Activate account.

4. In the Activate Password field, enter the password for your Activate account.

5. (Optional) Click the Frequency drop-down list and configure how frequently the managed device should
synchronize its remote AP whitelist with the whitelist on the Activate server.

6. Click Apply to save your settings.

In the CLI
The following example enables the Activate whitelist service on the managed device. The add-only parameter
allows only the addition of entries to the Activate remote AP whitelist database. This parameter is enabled by
default. If this setting is disabled, the activate-whitelist-download command can both add and remove entries
from the Activate database.
(host)(config)# activate-service-whitelist

(host)(activate-service-whitelist) #username user2 password pA$$w0rd whitelist-enable

(host)(activate-service-whitelist)add-only

The following command is available in enable mode, and prompts the managed device to synchronize its
remote AP whitelist with the associated whitelist on the Activate server:
(host)# activate whitelist download

Downloadable Regulatory Table
The downloadable regulatory table feature allows for the update of country domain options without
upgrading the ArubaOS software version. A separate file, called the Regulatory-Cert, containing AP regulatory
information will be released periodically on the customer support site. The Regulatory-Cert file can then be
uploaded to a managed device and pushed to deployed APs.

The Regulatory-Cert includes the following information for each AP:

l All countries supported in the current release of ArubaOS (not just United States or Rest of World or any
subset of countries)

l Allowed channels for each country

l Max EIRP for each channel and each country in the allowed list. The max values are specified for each PHY-
type at which the AP is allowed to transmit on. The classified PHY-types are

n 802.11 OFDM rates (802.11a/g mode)

n 802.11b rates (CCK rates)

n 802.11n HT20 and 802.11ac VHT20 rates (MCS0-7)

n 802.11n HT20 and 802.11ac VHT40(MCS0-7)

n 802.11ac VHT80 rates

l DFS functionality for each channel and each country in the allowed list

Important Points to Remember
l When a Regulatory-Cert is activated, the new file is checked against the default file built into ArubaOS. If the

file is of a newer version, the activation is allowed. If the file is of a lower version, then the activation is not



completed. The managed device's CLI displays the following message upon failure:
(host0) #ap regulatory activate reg-data-1.0_00002.txt

Failed to activate regulatory file reg-data-1.0_00002.txt. File Version should be greater

than 1.0_43859

l APs do not rebootstrap or reboot on activation.

l If there is change in channel list or power level, APs will change the channel/power level. Impact is same as
that of ARM channel/power change in that case.

l Clients are not disconnected upon regulatory file activation. Max latency impact during activation (with no
channel changes) is less than 1s (applies to power change too).

l With channel change, the impact is similar to ARM channel change (depends on client behavior and if CSA is
enabled or not).

l If support for the AP (Country) is added, the AP will move from AM to AP mode (if the AP is configured in AP
mode of operation).

Copying the Regulatory-Cert
You can use the following protocols to copy the regulatory file to a managed device:

l FTP

l TFTP

l SCP

Additionally, regulatory files saved to a USB drive can be uploaded to a managed device equipped with a USB
port.

You can copy the Regulatory-Cert to the managed device using the WebUI or CLI.

In the WebUI
1. In the Managed Device node hierarchy, navigate to the Maintenance > File > Copy Files page.

2. Select the source (TFTP, FTP, SCP, or USB) where the file exists.

3. The managed device WebUI will automatically select Flash File System under the Destination Selection
menu.

4. Click Apply.

In the CLI
Use one of the following copy commands to download the regulatory file to the managed device:
copy

ftp: <ftphost> <user> <filename>

scp: <scphost> <username> <filename> flash: <destfilename>

tftp: <tftphost> <filename> flash: <destfilename>

usb: partition <partition-number> <filename> flash: <destfilename>

To view the current regulatory and the content of the file, use the following commands:
show ap regulatory

show ap allowed-channels country-code <country-code> ap-type <ap-type

show ap allowed-max-eirp ap-name <ap-name> country-code <country-code>

show ap debug received-reg-table ap-name <ap-name>

Activating the Regulatory-Cert
Once the Regulatory-Cert has been added to the managed device, the new regulatory information must be
activated and pushed to the APs.
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In the WebUI
To activate a specific regulatory file using the WebUI:

1. In the Managed Device node hierarchy, navigate to Maintenance > File > Regulatory Files.

2. Select a regulatory file from the File List.

3. Click Activate.

In the CLI
To activate a specific regulatory file loaded on the managed device, use the following command:
ap regulatory activate <filename>

To return to the factory default regulatory-cert, use the following command:
ap regulatory reset

In a master-local-standby deployment, the file syncing profile can be enabled to ensure that the regulatory-cert
that is stored on the master is shared with its subordinate managed devices. File syncing is enabled by default,
with a default sync time of 30 minutes. The sync time can be set between 30 to 180 minutes, To configure the
file syncing profile, use the following commands
(host) (config) #file syncing profile

(host) (File syncing profile) #file-syncing-enable

(host) (File syncing profile) #sync-time 30

Related Show Commands
To view the version of Regulatory Cert currently active on all managed devices, execute the following
command:
(host) #show switches regulatory

To view the file synching profile settings, execute the following command:
(host) #show file syncing profile
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Chapter 37
Hotspot 2.0

ArubaOS incorporates Passpoint technology from the Wi-Fi Alliance HotSpot 2.0 (Release 1) Technical
Specification Version 1.0.0 to simplify and automate access to public Wi-Fi networks. Follow the procedures in
this chapter to help mobile devices identify which access points in your hotspot network are suitable for their
needs, and authenticate to a remote service provider using suitable credentials.

Throughout this document, all references to Hotspot 2.0 refer to HotSpot 2.0 (Release 1) Technical Specification
Version 1.0.0. Recent versions of this technical specifications exist, but they are not supported in this version of
ArubaOS.

Hotspot 2.0 Pre-Deployment Information
Hotspot 2.0 is a Wi-Fi Alliance Technical Specification for the Wi-Fi Alliance Wi-Fi CERTIFIED PassPoint program
based upon IEEE P802.11u-2011 that provides wireless clients with a streamlined mechanism to discover and
authenticate to suitable networks, and allows mobile users the ability to roam between partner networks
without additional authentication. For an overview Hotspot 2.0 enhanced network discovery and selection
technology, and a description of each of the hotspot profile types, see Hotspot 2.0 Overview on page 797

Hotspot Profile Configuration Tasks
The following sections describe the procedure to configure the profiles for the hotspot feature.

l Configuring Hotspot 2.0 Profiles on page 800

l Configuring Hotspot Advertisement Profiles on page 805

l Configuring ANQP Venue Name Profiles on page 807

l Configuring ANQP Network Authentication Profiles on page 809

l Configuring ANQP Domain Name Profiles on page 810

l Configuring ANQP IP Address Availability Profiles on page 811

l Configuring ANQP NAI Realm Profiles on page 812

l Configuring ANQP Roaming Consortium Profiles on page 816

l Configuring ANQP 3GPP Cellular Network Profiles on page 817

l Configuring H2QP Connection Capability Profiles on page 818

l Configuring H2QP Operator Friendly Name Profiles on page 820

l Configuring H2QP Operating Class Indication Profiles on page 821

l Configuring H2QP WAN Metrics Profiles on page 821

Hotspot 2.0 Overview
ArubaOS supports Hotspot 2.0 with enhanced network discovery and selection. Clients can receive general
information about the network identity, venue, and type via management frames from the AP. Clients can also
query APs for information about the network’s available IP address type (IPv4 or IPv6), roaming partners, and
supported authentication methods, and receive that information in ANQP Information Elements from the AP.
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Access Network Query Protocol
Access Network Query Protocol (ANQP) is an Advertisement Protocol implemented using the GAS frames
allowing any STA to query another STA about ANQP elements even before the association event.

ANQP Information Element
ANQP Information Elements are additional data that can be sent from the AP to any STA (including other APs)
to provide identify of the AP’s network and service provider. The STA can query for which ANQP elements are
available for being query using the Query List element within a query, in which case the AP will reply with the
Capability List elements indicating what other ANQP elements can be queried. Here are the ANQP elements
that can be returned in the capabilities List element

l Venue Name: the this information element defines the venue group and venue type.

l Domain Name: this information element specifies the AP’s domain name.

l Network Authentication Type: if the network has Additional Steps required for Access (ASRA), this
information element defines the authentication type being used by the hotspot network.

l Roaming Consortium List: this information element contains information identifying the network and
service provider, whose security credentials can be used to authenticate with the AP transmitting this
element.

l IP address Availability: this information element provides clients with information about the availability of
IP address versions and types which could be allocated to those clients after they associate to the hotspot
AP.

l NAI Realm: this information element identifies and describes a NAI realm accessible using the AP and the
method that this NAI realm uses for authentication.

l 3GPP Cellular Network Data: this information element defines information for a 3rd Generation
Partnership Project (3GPP) Cellular Network for hotspots that have roaming relationships with cellular
operators.

l Connection Capability: this information element defines hotspot protocol and port capabilities to be sent in
an ANQP information element.

l Operating Class: this information element defines the channels on which the hotspot is capable of
operating.

l Operator Friendly Name: this information element allows the definition of a free-form text field that can
identify the operator and additional information about the location.

l WAN Metrics: this information element provides hotspot clients information about access network
characteristics such as link status, capacity and speed of the WAN link to the Internet.

Hotspot Profile Types
ArubaOS supports several different Hotspot 2.0 configuration profile types for defining ANQP information
elements. The term H2QP is used to define profile that define Hotspot 2.0 specific Information Elements.



Profile Description

Hotspot Advertisement
profile

An advertisement profile defines a collection of ANQP and H2QP
profiles. Each hotspot 2.0 profile is associated with one
advertisement profile, which in turn references one of each type
of ANQP and H2QP profile.

For more information on configuring this profile, refer to
Configuring Hotspot Advertisement Profiles on page 805

ANQP 3GPP Cellular Network
profile

Use this profile to define priority information for a 3rd Generation
Partnership Project (3GPP) Cellular Network used by hotspots that
have roaming relationships with cellular operators.

For more information on configuring this profile, refer to
Configuring ANQP 3GPP Cellular Network Profiles on page 817

ANQP Domain Name profile Use this profile to specify the hotspot operator domain name.

For more information on configuring this profile, refer to
Configuring Hotspot Advertisement Profiles on page 805

ANQP IP Address Availability
profile

Use this profile to specify the types of IPv4 and IPv6 IP addresses
available in the hotspot network.

For more information on configuring this profile, refer to
Configuring ANQP IP Address Availability Profiles on page 811

ANQP NAI Realm profile An AP’s NAI Realm profile identifies and describes a Network
Access Identifier (NAI) realm accessible using the AP, and the
method that this NAI realm uses for authentication.

For more information on configuring this profile, refer to
Configuring ANQP NAI Realm Profiles on page 812

ANQP Network Authentication
profile

Use the ANQP Network Authentication profile to define the
authentication type used by the hotspot network.

For more information on configuring this profile, refer to
Configuring ANQP Network Authentication Profiles on page 809.

ANQP Roaming Consortium
profile

Name of the ANQP Roaming Consortium profile to be associated
with this WLAN advertisement profile.

For more information on configuring this profile, refer to
Configuring ANQP Roaming Consortium Profiles on page 816

ANQP Venue Name profile Use this profile to specify the venue group and venue type
information be sent in an Access network Query Protocol (ANQP)
information element in a Generic Advertisement Service (GAS)
query response.

For more information on configuring this profile, refer to
Configuring ANQP Venue Name Profiles on page 807.

H2QP Connection Capability
profile

Use this profile to specify hotspot protocol and port capabilities.

Table 175: ANQP and H2QP Profiles referenced by an Advertisement Profile
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Profile Description

For more information on configuring this profile, refer to
Configuring H2QP Connection Capability Profiles on page 818

H2QP Operating Class
Indication profile

Use this profile to specify the channels on which the hotspot is
capable of operating

For more information on configuring this profile, refer to
Configuring H2QP Operating Class Indication Profiles on page 821

H2QP Operator Friendly
Name profile

Use this profile to define the operator-friendly name sent by
devices using this profile.

For more information on configuring this profile, refer to
Configuring H2QP Operator Friendly Name Profiles on page 820

H2QP WAN Metrics profile Use this profile to specify the WAN status and link metrics for
your hotspot.

For more information on configuring this profile, refer to
Configuring H2QP WAN Metrics Profiles on page 821

Configuring Hotspot 2.0 Profiles
Use this profile to enable the hotspot 2.0 feature and define venue and OI settings for roaming partners. Each
hotspot 2.0 profile also references an advertisement profile, which defines a set of ANQP or H2QP profiles
which define other values for the hotspot feature. By default, hotspot 2.0 profiles reference the default
advertisement profile. For information on associating a different advertisement profile with a hotspot 2.0
profile, see Associating Advertisement Profile to Hotspot 2.0 Profile on page 806.

In the WebUI
To configure a hotspot 2.0 profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand Hotspot 2.0. The list of available hotspot 2.0 profiles appears in the All Profiles table.

4. Select an existing Hotspot 2.0 profile from the list of profiles or create a new profile by clicking +.

5. Select Advertise Hotspot 2.0 Capability.

6. Configure the following parameters as desired, then click Save to save your settings.



Parameter Description

Advertise Hotspot
2.0 Capability

This check box enables or disables the Hotspot 2.0 capability. When this
feature is enabled, the Information Elements (IEs) for this hotspot are included
in beacons and probe responses from the AP and the ANQP Queries are
answered to.

This setting is disabled by default.

Use GAS Comeback
Request/Response

By default, ANQP Information is obtained directly from a GAS Initial Response
frame when size allows for it. If this parameter is enabled, advertisement
information will not be included in the GAS Initial Response and will always
force the usage of Comeback-Request and Comeback-Response frames.

This option is disabled by default.

Additional Steps
required for Access
Enabled

This check box enables/disables the advertisement of Additional Steps
Required for Access (ASRA) in the Internetworking information element.

NOTE: If this parameter is enabled, the advertisement profile for this hotspot
must reference a network authentication type profile.

Network Internet
Access

This check box enables/disables the advertisement of Internet access in the
Internetworking information element.

Length of Query
Response

The maximum number of 256 bytes that can be used for a GAS Initial-
Response or GAS Comeback-Response frames. If the data exceeds this
number, multiple Comeback-Response fragment will be used.

The supported range is 1-256

Access Network Type Specify the 802.11u network type. The default setting is public-chargeable.

l emergency-services: emergency services only network

l personal-device: personal device network

l private: private network

l private-guest: private network with guest access

l public-chargeable: public chargeable network

l public-free: free public network

l test: test network

l wildcard: wildcard network

Roaming
Consortium Len
Entry 1

Length of the OI. The value of the Roaming Consortium Len Entry 1 parameter
is based upon the number of octets of the Roaming Consortium OI Entry 1
field.

l 0: Zero Octets in the OI (Null)

l 3: OI length is 24-bit (3 Octets)

l 5: OI length is 36-bit (5 Octets)

Table 176: Hotspot 2.0 Profile Settings
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Parameter Description

Roaming
Consortium OI Entry
1

Roaming consortium OI assigned to one of the service provider’s top three
roaming partners.This additional OI will only be sent to a client if the Additional
Roaming Consortium OI's parameter is set to1 or higher.

NOTE: The service provider’s own roaming consortium OI is configured using
the ANQP Roaming Consortium profile.

Roaming
Consortium Len
Entry 2

Length of the OI. The value of the Roaming Consortium Len Entry 2 parameter
is based upon the number of octets of the Roaming Consortium OI Entry 2
field.

l 0: Zero Octets in the OI (Null)

l 3: OI length is 24-bit (3 Octets)

l 5: OI length is 36-bit (5 Octets)

Roaming
Consortium OI Entry
2

Roaming consortium OI assigned to one of the service provider’s top three
roaming partners. This additional OI will only be sent to a client if the
Additional Roaming Consortium OI's parameter is set to 2 or higher.

NOTE: The service provider’s own roaming consortium OI is configured using
the ANQP Roaming Consortium profile.

Roaming
Consortium Len
Entry 3

Length of the OI. The value of the Roaming Consortium Len Entry -3 parameter
is based upon the number of octets of the Roaming Consortium OI Entry 3
field.

l 0: Zero Octets in the OI (Null)

l 3: OI length is 24-bit (3 Octets)

l 5: OI length is 36-bit (5 Octets)

Roaming
Consortium OI Entry
3

Roaming consortium OI assigned to one of the service provider’s top three
roaming partners. This additional OI will only be sent to a client if the
Additional Roaming Consortium OI's parameter is set to 3.

NOTE: The service provider’s own roaming consortium OI is configured using
the ANQP Roaming Consortium profile.

Additional
Roaming
Consortium OI's
(displayed in
Advertisement
Profile)

The number of additional ANQP Roaming Consortium profiles referenced by
the Advertisement profile associated with this profile. The number must not
include the OI defined within this Hotspot 2.0 profile.

HESSID This optional parameter devices an AP’s homogenous ESS identifier
(HESSSID), which is that device’s MAC address in colon-separated
hexadecimal format.

Venue Group Type Specify one of the following venue groups to be advertised in the IEs from APs
associated with this hotspot profile. The default setting is unspecified.

l assembly

l business



Parameter Description

l educational

l factory-or-industrial

l institutional

l mercantile

l outdoor

l reserved

l residential

l storage

l unspecified

l Utility-Misc

l Vehicular

NOTE: This parameter only defines the venue group advertised in the IEs
from hotspot APs.

Venue Type Specify a venue type to be advertised in the IEs from APs associated with this
hotspot profile. The complete list of supported venue types is described in
Venue Types on page 808.

This parameter only defines the venue type advertised in the IEs from hotspot
APs.

PAME BI This option enables the Pre-Association Message Exchange BSSID
Independent (PAME-BI) bit, which is used by an AP to indicate whether the the
AP indicates that the Advertisement Server can return a query response that
is independent of the BSSID used for the GAS Frame exchange.

Downstream Group
Frames Forwarding
Blocked

This option configures the Downstream Group Addressed Forwarding (DGAF)
Disabled Mode. If this feature is enabled, it ensures that the AP does not
forward downstream group-addressed frames. It is disabled by default,
allowing the AP to forward downstram group-addressed frames.

Time Zone Format The time zone in which the AP is operating, in the format
<std><offset>[dst[offset][,start[/time],end[/time]]

Where the <std> string specifies the abbreviation of the time zone, <dst> is
the abbreviation of the timezone in daylight savings time, and the <offset>
string specifies the time value you must add to the local time to arrive at UTC.

NOTE: For complete details on configuring the timezone format, refer to
section 8.3 of IEEE Std 1003.1, 2004 Edition.

Time Advertisement
Capability

This parameter specifies the AP’s source of external time, and the current
condition of its timing estimator.

l no-std-ext-time-src: The AP using this profile has no standardized
external time source.

l timestamp-offset-utc: The AP has a timestamp offset based on UTC.

l reserved: This setting is reserved for future use, and should not be used.
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Parameter Description

Time Error Value The standard deviation of error in the time value estimate, in milliseconds.
The default value is 0 milliseconds, and the supported range is 0-
2,147,483,647 milliseconds.

P2P Device
Management

Issue this command to advertise support for P2P device management. This
setting is disabled by default.

P2P Cross Connect Issue this command to advertise support for P2P Cross Connections. This
setting is disabled by default.

Hotspot 2.0 Advert-
isement Protocol
Type

The Access Network Query Protocol (ANQP) is used as the Hotspot 2.0
advertisement protocol types by default.

GAS comeback
delay in
milliseconds

At the end of the GAS comeback delay interval, the client may attempt to
retrieve the query response using a Comeback Request Action frame. The
supported range is 100-2000 milliseconds, and the default value is 500
milliseconds.

RADIUS Chargeable
User Identity
(RFC4372)

Include this parameter to enable the Chargeable-User-Identity RADIUS attribute
defined by RFC 4372. Home networks can use this attribute to identify a user for
the roaming transactions that take place outside of that home network.

RADIUS Location
Data (RFC5580)

Include this parameter to enable the Location Data and Operator-Name
RADIUS attributes defined by RFC 5580. The first ANQP Domain Name profile
will be used as the Operator-Name value. Enabling this parameter allows the
RADIUS server to use user location data.

In the CLI
To configure a hotspot 2.0 profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot h2-profile <profile-name>

access-network-type emergency-services|personal-device|private|private-guest|public-

chargeable|public-free|test|wildcard

addtl-roam-cons-ois <addtl-roam-cons-ois>

advertisement-profile <profile-name>

advertisement-protocol anqp|eas|mih-cmd-event|mih-info|rsvd

asra

clone <profile-name>

comeback-mode

gas-comeback-delay

grp-frame-block

hessid <id>

hotspot-enable

internet

no ..

p2p-cross-connect

p2p-dev-mgmt

pame-bi

query-response-length-limit <query-response-length-limit>

radius_cui

radius_loc_data



roam-cons-len-1 0|3|5

roam-cons-len-2 0|3|5

roam-cons-len-3 0|3|5

roam-cons-oi-1 <roam-cons-oi-1>

roam-cons-oi-2 <roam-cons-oi-1>

roam-cons-oi-3 <roam-cons-oi-1>

time-advt-cap no-std-ext-timesrc|timestamp-offset-utc |reserved

time-error <milliseconds>

time-zone <time-zone>

venue-group <venue-group>

venue-type <venue-type>

Configuring Hotspot Advertisement Profiles
An advertisement profile defines a set of ANQP and H2QP profiles for the hotspot feature. Advertisement
profiles can reference multiple instances of some ANQP and H2QP profile types, but only a single instance of
other ANQP and H2QP profiles. The table below shows how the different ANQP and H2QP profile types can be
associated to a single advertisement profile.

One Instance per Advert-
isement Profile

Multiple Instances per Advertisement Profile

l ANQP IP address availability
profile

l H2QP WAN metrics profile

l H2QP connection capability
profile

l ANQP venue name profile

l ANQP network authentication profile

l ANQP foaming consortium profile

l ANQP NAI realm profile

l ANQP 3GPP cellular network profile

l H2QP operator friendly name profile

l H2QP operating class indication profile

l ANQP domain Name profile

Table 177: Hotspot Advertisement Profile Associations

For additional information on each of these profile types, see Hotspot Profile Types on page 798

Configuring Advertisement Profile
The steps below describe the procedure to associate an advertisement profile to a set of ANQP and H2QP
profiles.

The procedure to associate an ANQP or H2QP profile to an advertisement profile varies, depending upon whether
the advertisement profile can reference just one instance or many instances of that profile type.

In the WebUI
To configure an advertisement profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. n the All Profiles table, expand Wireless LAN.

3. Expand Advertisement. The ANQP and H2QP profiles associated with the selected advertisement profile
appear below the advertisement profile in the All Profiles table.
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4. Select an existing advertisement profile from the list of profiles or create a new profile by clicking +.

5. For an ANQP or H2QP profile type that can have only one instance associated with the advertisement
profile:

a. In the All Profiles table, select the ANQP or H2QP profile type.

b. Click the drop-down list in the Network Profile pane and select a profile name.

6. For an ANQP or H2QP profile type that can have multiple instances associated with the advertisement
profile:

a. In the All Profiles table, select the ANQP or H2QP profile type.

b. In the Network Profile pane, click the profile drop-down list.

c. Select the name of the profile to associate with the advertisement profile.

d. Click Save.

In the CLI
To configure a advertisement profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot advertisement profile <profile-name>

anqp-3gpp-nwk-profile <profile-name>

anqp-domain-name-profile <profile-name>

anqp-ip-addr-avail-profile <profile-name>

anqp-nai-realm-profile <profile-name>

anqp-nwk-auth-profile <profile-name>

anqp-roam-cons-profile <profile-name>

anqp-venue-name-profile <profile-name>

clone <profile-name>

h2qp-conn-cap-profile <profile-name>

h2qp-op-cl-profile <profile-name>

h2qp-operator-friendly-profile <profile-name>

h2qp-wan-metrics-profile <profile-name>

no ...

Associating Advertisement Profile to Hotspot 2.0 Profile
The settings in the ANQP and H2QP profiles referenced by the Advertisement profile will not be sent to clients
until you associate the advertisement profile with an active hotspot 2.0 profile. By default, all hotspot 2.0
profiles reference the default advertisement profile.

In the WebUI
To associate a different advertisement profile to a hotspot 2.0 profile:

1. In the Mobility Master node hierarchy, navigate to Configuration> System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand Hotspot 2.0. The list of available hotspot 2.0 profiles appears in the All Profiles table.

4. Select an existing Hotspot 2.0 profile from the list of Hotspot 2.0 profiles.

5. Click Advertisement for the selected Hotspot 2.0 profile.

6. In the All Profiles table, click the Advertisement Profile drop-down list and select a different
advertisement profile name.

7. Click Save.

In the CLI
To associate a different advertisement profile to a hotspot 2.0 profile from the CLI, access the CLI in config
mode and issue the following commands:



wlan hotspot hs2-profile <hotspot-profile-name>

advertisement-profile <advertisement-profile-name>

Configuring ANQP Venue Name Profiles
Use this profile to define the venue group and venue type information which is sent in an Access network
Query Protocol (ANQP) information element in a Generic Advertisement Service (GAS) query response.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a Hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP venue name profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand ANQP Venue Name. The list of available ANQP venue name profiles appears in the All Profiles
table.

4. Select an existing ANQP venue name profile from the list of profiles or create a new ANQP venue name
profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.
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Parameter Description

Venue Group Specify one of the following venue groups to be advertised in the ANQP Information
Elements (IEs) from APs associated with this profile. The default setting is
unspecified.

l assembly

l business

l educational

l factory-or-industrial

l institutional

l mercantile

l outdoor

l reserved

l residential

l storage

l unspecified

l Utility-Misc

l Vehicular

Venue Language
Code

An ISO 639 language code that identifies the language used in the Venue Name
field.

Venue Name Venue name to be advertised in the ANQP IEs from APs associated with this profile.
If the venue name includes spaces, the name must be enclosed in quotation marks,
e.g. “Midtown Shopping Center”.

Venue Type Specify a venue type to be advertised in the IEs from APs associated with this
hotspot profile. The complete list of supported venue types is described the table
below

Table 178: ANQP Venue Name Profile Parameters

Venue Types
The following list describes the different venue types that may be configured in a Hotspot 2.0 or ANQP Venue
Name profile:



l assembly-amphitheater

l assembly-amusement-
park

l assembly-arena

l assembly-bar

l assembly-coffee-shop

l assembly-convention-
center

l assembly-emer-coord-
center

l assembly-library

l assembly-museum

l assembly-passenger-
terminal

l assembly-restaurant

l assembly-stadium

l assembly-theater

l assembly-worship-place

l assembly-zoo

l business-attorney

l business-bank

l business-doctor

l business-fire-station

l business-police-station

l business-post-office

l business-professional-office

l business-research-and-
development

l educational-primary-school

l educational-secondary-school

l educational-university

l industrial-factory

l institutional-alcohol-or-drug-
rehab

l institutional-group-home

l institutional-hospital

l institutional-prison

l institutional-terminal-care

l mercantile-automotive-service-
station

l mercantile-gas-station

l mercantile-grocery

l mercantile-retail

l mercantile-shopping-mall

l outdoor-bus-stop

l outdoor-city-park

l outdoor-kiosk

l outdoor-muni-mesh-nwk

l outdoor-rest-area

l outdoor-traffic-control

l residential-boarding-
house

l residential-dormitory

l residential-hotel

l residential-private-
residence

l unspecified

l vehicular-airplane

l vehicular-automobile

l vehicular-bus

l vehicular-ferry

l vehicular-motor-bike

l vehicular-ship

l vehicular-train

In the CLI
To configure an ANQP venue name profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot anqp-venue-name-profile <profile-name>

clone <profile-name>

no ...

venue-group outdoor|reserved|utility-misc|vehicular|assembly|business  educational|factory-

or-industrial|institutional|mercantile|residential|   storage|unspecified

venue-language <language>

venue-name <venue-name>

venue-type <venue-type>

Configuring ANQP Network Authentication Profiles
Use the ANQP Network Authentication profile to define the authentication type used by the Hotspot network.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a Hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP network authentication profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.
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3. Expand ANQP Network Authentication. The list of available ANQP network authentication profiles
appears in the All Profiles table.

4. Select an existing ANQP network authentication profile from the list of profiles or create a new profile by
clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.

Parameter Description

Type of Network Authentication Network Authentication Type being used by the hotspot network.

l acceptance: Network requires the user to accept terms and
conditions. This option requires you to specify a redirection URL string
as an IP address, FQDN or URL.

l dns-redirection: Additional information on the network is provided
through DNS redirection. This option requires you to specify a
redirection URL string as an IP address, FQDN or URL.

l http-https-redirection: Additional information on the network is
provided through HTTP/HTTPS redirection.

l online-enroll: Network supports online enrollment.

Network Authentication URL URL, IP address, or FQDN used by the hotspot network for the
acceptance, dns-redirection, or online-enroll network authentication
types.

Table 179: ANQP Network Authentication Profile Parameters

In the CLI
To configure an ANQP network authentication profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot anqp-nwk-auth-profile <profile-name>

clone <profile-name>

no ...

nwk-auth-type acceptance|dns-redirection|http-https-redirection|online-enroll

url <url>

Configuring ANQP Domain Name Profiles
This profile defines the hotspot operator domain name to be sent in an Access Network Query Protocol (ANQP)
information element in a Generic Advertisement Service (GAS) query response.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP domain name profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand ANQP Domain Name.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.



5. In the Domain Name field, enter the domain name of the hotspot operator. Ensure that the alphanumeric
text string is 32 characters or less.

6. Click Save.

In the CLI
To configure an ANQP domain name profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot anqp-domain-name-profile <profile-name>

clone <profile-name>

domain-name <domain-name>

no ...

Configuring ANQP IP Address Availability Profiles
Use this profile to specify the types of IPv4 and IPv6 IP addresses available in the hotspot network. This
information is sent in an Access network Query Protocol (ANQP) information element in a Generic
Advertisement Service (GAS) query response.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a Hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP IP address availability profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand ANQP IP Address Availability
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.
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Parameter Description

IPv4 Address
Availability
Type

Indicate the availability of an IPv4 network by clicking the IPv4 Address Availability Type drop-
down list and selecting one of the following options:

l availability-unknown: Network availability cannot be determined.

l not-available: Network is not available.

l port-restricted: Some ports are restricted (e.g., the network blocks port 110 to restrict POP
mail).

l port-restricted-double-nated: Some ports are restricted and multiple routers perform
network address translation.

l port-restricted-single-nated: Some ports are restricted and a single router performs network
address translation.

l private-double-nated: Network is a private network with multiple routers doing network
address translation.

l private-single-nated: Network is a private network a single router doing network address
translation.

l public: Network is a public network.

IPv6 Address
Availability
Type

Indicate the availability of an IPv6 network by clicking the IPv6 Address Availability Type drop-
down list and selecting one of the following options:

l available: An IPv6 network is available.

l availability-unknown: Network availability cannot be determined.

l not-available: Network is not available.

Table 180: ANQP IP Address Availability Profile Parameters

In the CLI
To configure an ANQP IP address availability profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot anqp-ip-addr-avail-profile <profile-name>

clone <profile-name>

ipv4-addr-avail availability-unknown|not-available|port-restricted|port-restricted-double-

nated|port-restricted-single-nated|private-double-nated|private-single-nated

ipv6-addr-avail available|availability-unknown|not-available

no ...

Configuring ANQP NAI Realm Profiles
An AP’s NAI Realm profile identifies and describes a Network Access Identifier (NAI) realm accessible using the
AP, and the method that this NAI realm uses for authentication. These settings configured in this profile
determine the NAI realm elements that are included as part of a GAS Response frame.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP NAI Realm profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.



2. In the All Profiles table, expand Wireless LAN.

3. Expand  ANQP NAI Realm
4. Select an existing profile from the list of profiles or create a new profile by clicking + in the +.

5. Configure the following parameters as desired, then click Save to save your settings.

Parameter Description

NAI Realm name Name of the NAI realm. The realm name is often the domain name of the
service provider.

NAI Realm Encoding Issue this command if the NAI realm name is a UTF-8 formatted character
string that is not formatted in accordance with IETF RFC 4282.

NAI Realm EAP Method Select one of the options below to identify the EAP authentication method
supported by the hotspot realm.

l crypto-card: Crypto card authentication

l eap-aka: EAP for Universal Mobile Telecommunications System
(UMTS) Authentication and Key Agreement

l eap-sim: EAP for GSM Subscriber Identity Modules

l eap-tls: EAP-Transport Layer Security

l eap-ttls: EAP-Tunneled Transport Layer Security

l generic-token-card: EAP Generic Token Card (EAP-GTC)

l identity: EAP Identity type

l notification: The hotspot realm uses EAP Notification messages for
authentication.

l one-time-password: Authentication with a single-use password

l peap: Protected Extensible Authentication Protocol

l peap-mschapv2: Protected Extensible Authentication Protocol with
Microsoft Challenge Handshake Authentication Protocol version 2

NAI Realm Authentication
Param ID 1

Use the NAI Realm Authentication Param ID 1 parameter to send
the one of the following authentication methods for the primary NAI
realm ID.

l credential-type: The specified authentication ID uses credential
authentication.

l expanded-eap: The specified authentication ID uses the expanded
EAP authentication method.

l expanded-inner-eap: The specified authentication ID uses the
expanded inner EAP authentication method.

l inner-auth-eap: The specified authentication ID uses inner EAP
authentication type.

l non-eap-inner-auth: The specified authentication ID uses non-EAP
inner authentication type.

Table 181: ANQP NAI Realm Profile Parameters
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Parameter Description

NAI Realm Authentication
Param Value 1

Use the NAI Realm Authentication Param Value 1 parameter select
an authentication value for the authentication method specified by the
NAI Realm Authentication Param ID 1 parameter.

l cred-cert: Credential - Certificate

l cred-hw-token: Credential - Hardware Token

l cred-nfc: Credential - NFC

l cred-none: Credential - None

l cred-rsvd: Credential - Reserved

l cred-sim: Credential - SIM

l cred-soft-token: Credential - Soft Token

l cred-user-pass: Credential - Username/password

l cred-usim: Credential - USIM

l cred-vendor-spec: Credential - Vendor-specific

l eap-crypto-card: EAP Method - Crypto-card

l eap-generic-token-card: EAP Method - Generic-Token-Card

l eap-identity: EAP Method - Identity

l eap-method-aka: EAP Method - AKA

l eap-method-sim: EAP Method - SIM - GSM Subscriber Iden

l eap-method-tls: EAP Method - TLS - Transport Layer Sec

l eap-method-ttls: EAP Method - TTLS - Tunneled Transport Security

l eap-notification: EAP Method - Notification

l eap-one-time-password: EAP Method - One-Time-Password

l eap-peap: EAP Method - PEAP

l eap-peap-mschapv2: EAP Method - PEAP MSCHAP V2

l non-eap-chap: Non-EAP Method - CHAP

l non-eap-mschap: Non-EAP Method - MSCHAP

l non-eap-mschapv2: Non-EAP Method - MSCHAPv2

l non-eap-pap: Non-EAP Method - PAP

l non-eap-rsvd: Non-EAP Method - Reserved for future use

l reserved: Reserved for Future use

NAI Realm Authentication
Param ID 2

Use the NAI Realm Authentication ID Value 2 parameter to send
the one of the following authentication methods for the secondary NAI
realm ID.

l credential-type: The specified authentication ID uses credential
authentication.

l expanded-eap: The specified authentication ID uses the expanded
EAP authentication method.

l expanded-inner-eap: The specified authentication ID uses the



Parameter Description

expanded inner EAP authentication method.

l inner-auth-eap: The specified authentication ID uses inner EAP
authentication type.

l non-eap-inner-auth: The specified authentication ID uses non-EAP
inner authentication type.

NAI Realm Authentication
Param Value 2

Use the NAI Realm Authentication Param Value 2 parameter select
an authentication value for the authentication method specified by the NAI
Realm Authentication Param ID 2 parameter.

l cred-cert: Credential - Certificate

l cred-hw-token: Credential - Hardware Token

l cred-nfc: Credential - NFC

l cred-none: Credential - None

l cred-rsvd: Credential - Reserved

l cred-sim: Credential - SIM

l cred-soft-token: Credential - Soft Token

l cred-user-pass: Credential - Username/password

l cred-usim: Credential - USIM

l cred-vendor-spec: Credential - Vendor-specific

l eap-crypto-card: EAP Method - Crypto-card

l eap-generic-token-card: EAP Method - Generic-Token-Card

l eap-identity: EAP Method - Identity

l eap-method-aka: EAP Method - AKA

l eap-method-sim: EAP Method - SIM - GSM Subscriber Iden

l eap-method-tls: EAP Method - TLS - Transport Layer Sec

l eap-method-ttls: EAP Method - TTLS - Tunneled Transport Security

l eap-notification: EAP Method - Notification

l eap-one-time-password: EAP Method - One-Time-Password

l eap-peap: EAP Method - PEAP

l eap-peap-mschapv2: EAP Method - PEAP MSCHAP V2

l non-eap-chap: Non-EAP Method - CHAP

l non-eap-mschap: Non-EAP Method - MSCHAP

l non-eap-mschapv2: Non-EAP Method - MSCHAPv2

l non-eap-pap: Non-EAP Method - PAP

l non-eap-rsvd: Non-EAP Method - Reserved for future use

l reserved: Reserved for Future use

NAI Home Realm Mark the realm in this profile as the NAI Home Realm
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In the CLI
To configure an ANQP NAI realm profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot anqp-nai-realm-profile <profile-name>

clone <profile-name>

nai-home-realm

nai-realm-auth-id-1|nai-realm-auth-id-2 {credential-type|expanded-eap|expanded-inner-

eap|inner-auth-eap|non-eap-inner-auth|tunneled-eap-credential-type}

nai-realm-auth-value-1|nai-realm-auth-value-2 {cred-cert|cred-hw-token|cred-nfc|cred-

none|cred-rsvd|cred-sim|cred-soft-token|cred-user-pass|cred-usim|cred-vendor-spec|eap-

crypto-card|eap-generic-token-card|eap-identity|eap-method-aka|eap-method-sim|eap-method-

tls|eap-method-ttls|eap-notification|eap-one-time-password|eap-peap|eap-peap-mschapv2|non-

eap-chap|non-eap-mschap|non-eap-mschapv2|non-eap-pap|non-eap-rsvd|reserved}

nai-realm-eap-method crypto-card|eap-aka|eap-sim|eap-tls|eap-ttls|generic-token-

  card|identity|notification|one-time-password|peap|peap-mschapv2

nai-realm-encoding

nai-realm-name <nai-realm-name>

no ...

Configuring ANQP Roaming Consortium Profiles
Organization Identifiers (OIs) are assigned to service providers when they register with the IEEE registration
authority. You can specify the OI for the hotspot’s service provider in the ANQP Roaming Consortium profile
using the ANQP Roaming Consortium Profile. The Hotspot 2.0 profile also allows you to define and send up to
three additional roaming consortium OIs for the service provider’s top three roaming partners.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

Ensure that the Hotspot 2.0 profile Additional Roaming OI Consortium number is re-visited each time you add or
remove one of those profile.

In the WebUI
To configure an ANQP roaming consortium profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand ANQP Roaming Consortium.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.



Parameter Description

Roaming consortium OI
Len

Length of the OI. The value of the Roaming consortium OI Len parameter must
equal upon the number of octets of the Roaming Consortium OI field.

l 0: 0 Octets in the OI (Null)

l 3: OI length is 24-bit (3 Octets)

l 5: OI length is 36-bit (5 Octets)

Roaming Consortium OI Send the specified roaming consortium OI in a GAS query response. The OI must be
a hexadecimal number 3-5 octets in length.

Table 182: ANQP Roaming Consortium Profile Parameters

In the CLI
To configure an ANQP roaming consortium profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot anqp-roam-cons-profile <profile-name>

clone <profile-name>

no ...

roam-cons-oi <roam-cons-oi>

roam-cons-oi-len <roam-cons-oi-len>

Configuring ANQP 3GPP Cellular Network Profiles
Use this profile to define priority information for a 3rd Generation Partnership Project (3GPP) Cellular Network
used by hotspots that have roaming relationships with cellular operators.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP 3GPP cellular network profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand ANQP 3GPP Cellular Network.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.
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Parameter Description

3GPP PLMN1 The Public Land Mobile Networks (PLMN) value of the highest-priority network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

3GPP PLMN2 The Public Land Mobile Networks (PLMN) value of the second-highest priority
network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

3GPP PLMN3 The Public Land Mobile Networks (PLMN) value of the third-highest priority network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

3GPP PLMN4 The Public Land Mobile Networks (PLMN) value of the fourth-highest priority
network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

3GPP PLMN5 The Public Land Mobile Networks (PLMN) value of the fifth-highest priority network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

3GPP PLMN6 The Public Land Mobile Networks (PLMN) value of the sixth-highest priority network.

The PLMN is comprised of a 12-bit Mobile Country Code (MCC) and the 12-bit Mobile
Network Code (MNC).

Table 183: ANQP 3GPP Cellular Network Profile Parameters

In the CLI
To configure an ANQP 3GPP network profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot anqp-3gpp-nwk-profile <profile-name>

3gpp_plmn1 <3GPP PLMN1 data>

3gpp_plmn2 <3GPP PLMN2 data>

3gpp_plmn3 <3GPP PLMN3 data>

3gpp_plmn4 <3GPP PLMN4 data>

3gpp_plmn5 <3GPP PLMN5 data>

3gpp_plmn6 <3GPP PLMN6 data>

clone <profile-name>

enable

no ...

Configuring H2QP Connection Capability Profiles
Use this profile to specify hotspot protocol and port capabilities. This information is sent in a Access Network
Query Protocol (ANQP) information element in a Generic Advertisement Service (GAS) query response.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.



In the WebUI
To configure a H2QP connection capability profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All profiles table, expand Wireless LAN.

3. Expand H2QP Connection Capability.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.

Parameter Description

H2QP Connection Capability
ICMP Port

Select this option to enable the ICMP port. (port 0)

H2QP Connection Capability FTP
port (TCP Protocol)

Select this option to enable the FTP port. (port 20)

H2QP Connection Capability SSH
port (TCP Protocol)

Select this option to enable the SSH port. (port 22)

H2QP Connection Capability
HTTP port (TCP Protocol)

Select this option to enable the HTTP port. (port 80)

H2QP Connection Capability TLS
VPN port (TCP Protocol)

H2QP Connection Capability TLS VPN port(TCP Protocol)

H2QP Connection Capability PPTP
VPN port (TCP Protocol)

Select this option to enable the PPTP port used by IPsec VPNs. (port
1723)

H2QP Connection Capability VOIP
port (TCP Protocol)

Select this option to enable the TCP VoIP port. (port 5060)

H2QP Connection Capability VOIP
port (UDP Protocol)

Select this option to enable the UDP VoIP port. (port 5060)

H2QP Connection Capability
IKEv2 port for IPSec VPN

Select this option to enable the IPsec VPN port. (ports 500, 4500 and 0)

H2QP Connection Capability May
be used by IKEv2 port for IPSec
VPN

Select this option to enable the IKEv2 port 4500.

H2QP Connection Capability
IKEv2 port for IPSec VPN

Select this option to enable the IKEv2 port 500.

H2QP Connection Capability ESP
port(Used by IPSec VPN)

Include this parameter to enable the Encapsulating Security Payload
(ESP) port used by IPsec VPNs. (port 0)

Table 184: ANQP Connection Capability Profile Parameters
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In the CLI
To configure a H2QP connection capability profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot h2qp-conn-capability-profile <profile>

clone <profile-name>

esp

icmp

no ...

tcp-ftp

tcp-http

tcp-pptp-vpn

tcp-ssh

tcp-tls-vpn

tcp-voip

udp-ike2-4500

udp-ike2-500

udp-ipsec-vpn

udp-voip

Configuring H2QP Operator Friendly Name Profiles
This profile defines an operator-friendly name sent by devices using this profile.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure a H2QP operating class profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand H2QP Operator Friendly Name.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. Configure the following parameters as desired, then click Save to save your settings.

Parameter Description

Operator Friendly Name Lan-
guage Code

An ISO 639 language code that identifies the language used in the Oper-
ator Friendly Name field

Operator Friendly Name An operator-friendly name sent by devices using this profile. The name
can be up to 64 alphanumeric characters, and can include special
characters and spaces. If the name includes quotation marks (“),
include a backslash character (\) before each quotation mark. (e.g.
\"example\")

Table 185: H2QP Operator Friendly Name Profile Parameters

In the CLI
To configure a H2QP operator friendly name profile from the CLI, access the CLI in config mode and issue the
following commands:
wlan hotspot h2qp-operator-friendly-name-profile <profile>

clone <profile-name>



no ...

op-fr-name <op-fr-name>

op-lang-code <op-lang-code>

Configuring H2QP Operating Class Indication Profiles
The values configured in this H2QP Operating Class Indication profile list the channels on which the hotspot is
capable of operating. It may be useful where, for instance, a mobile device discovers a hotspot in the 2.4 GHz
band but finds it is dual-band and prefers the 5 GHz band.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure a H2QP operating class indication profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand H2QP Operating Class Indication.
4. Select an existing profile from the list of profiles or create a new profile by clicking +.

5. In the H2QP Operating Class field, enter a valid operating class value. (For a definition of these global
operating classes refer to Table E-4 of IEEE Std 802.11-2012, Annex E.)

6. Click Save.

In the CLI
To configure a H2QP operating class profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot h2qp-op-cl-profile <profile>

clone <profile-name>

op-cl <1-255>

Configuring H2QP WAN Metrics Profiles
Use this profile to specify the WAN status and link metrics for your hotspot.

To send the values configured in this profile to clients, associate this profile with an advertisement profile, then
associate the advertisement profile with a hotspot 2.0 profile. For additional details, see Configuring Hotspot
Advertisement Profiles on page 805.

In the WebUI
To configure an ANQP venue name profile from the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In the All Profiles table, expand Wireless LAN.

3. Expand H2QP WAN Metrics.
4. Select an existing profile from the list of profiles or create a new profile by clicking + in the New Profile

table.

5. Configure the following parameters as desired, then click Save to save your settings.
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Parameter Description

H2QP WAN metrics link
status

Define the status of the WAN Link by clicking the H2QP WAN metrics link status
drop-down list, and selecting one of the following values. The default link status is
reserved, which indicates that the link status is unknown or unspecified

l link down: WAN link is down.

l link test: WAN link is currently in a test state.

l link up: WAN link is up.

l reserved: This parameter is reserved by the Hotspot 2.0 specification, and
cannot be configured.

Default: reserved

H2QP WAN metrics sym-
metric WAN link

Select this check box to indicate that the WAN Link has same speed in both the
uplink and downlink directions.

H2QP WAN metrics link
at capacity

Select this check box to indicate that the WAN Link has reached its maximum
capacity. If this parameter is enabled, no additional mobile devices will be permitted
to associate to the hotspot AP.

WAN Metrics uplink
speed

This parameter defines the current WAN uplink speed in Kbps. If no value is set, this
parameter will show a default value of 0 to indicate that the uplink speed is unknown
or unspecified.

Range: 0 - 2147483647, Default: 0

WAN Metrics downlink
speed

This parameter defines the current WAN backhaul downlink speed in Kbps. If no
value is set, this parameter will show a default value of 0 to indicate that the
downlink speed is unknown or unspecified.

Range: 0 - 2147483647, Default: 0

WAN Metrics uplink
load

This parameter defines the percentage of the WAN uplink that is currently utilized. If
no value is set, this parameter will show a default value of 0 to indicate that the down-
link speed is unknown or unspecified.

Range: 0-100; Default: 0

WAN Metrics downlink
load

This parameter defines the percentage of the WAN downlink that is currently in use.
If no value is set, this parameter will show a default value of 0 to indicate that the
downlink speed is unknown or unspecified.

Range: 0-100; Default: 0

WAN Metrics load meas-
urement duration

Duration over which the downlink load is measured, in tenths of a second.

Range: 0-65535; Default: 0

Table 186: H2QP WANMetrics Profile Parameters

In the CLI
To configure a H2QP WAN metrics profile from the CLI, access the CLI in config mode and issue the following
commands:
wlan hotspot h2qp-wan-metrics-profile <profile-name>

at-capacity

clone <profile-name>



downlink-load

downlink-speed

load-dur

no ...

symm-link

uplink-load

uplink-speed

wan-metrics-link-status link_down|link_test|link_up|reserved
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Chapter 38
SDN Controller

The Software Defined Networking (SDN) Controller provides an improved networking infrastructure through
the following enhancements:

l Separation of control-plane and data-plane functions

l Centralized manageability

l Dynamic programmability of network devices

Traditional networks can experience high latency and inflexibility, as the number of new applications and
features continues to grow. All control and forwarding functions take place on the same device, and features
can only be provisioned statically through manual intervention. The SDN Controller provides a more efficient
and simple way to build, deliver, and manage features throughout the network.

This section describes the following modules that make up the SDN Controller:

l Southbound Interface on page 824

l SDN Platform Services on page 825

l Northbound API on page 835

Figure 106 SDN Controller Architecture

Southbound Interface
The Southbound Interface is a collection of drivers that handles communication to all data-plane elements
(DPE) in the network.
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OpenFlow Driver
The OpenFlow Driver supports the dynamic manipulation of network devices and the separation of fast-packet
forwarding (data-plane) from high-level routing (control-plane). Data-plane functions reside on the DPE
(switch), while control-plane functions have migrated to a separate controller. The OpenFlow switch and
controller communicate through the OpenFlow protocol to provide functions such as host discovery and
packet handling. OpenFlow allows users to run and manage multiple instances of the control-plane and data-
plane from a centralized location.

The SDN Controller supports OpenFlow versions 1.0 and 1.3.

Auxiliary Channel Driver
The Auxiliary Channel Driver carries all non-control data from the DPEs to the Mobility Master through UDP-
based auxiliary channel connections. The auxiliary channel reduces bandwidth consumption and latency on the
main channel, which must be used for critical functions such as flow programming or network state changes.
All received data is sent to the subscribed Northbound APIs, which process and share the information with
northbound applications.

The following items must be in place before an auxiliary channel connection can be used on the SDN
Controller:

l Global OpenFlow configuration must be enabled on Mobility Master.

l The main channel must be UP.

l The listening port for the auxiliary connection must be configured (default connection is 6633).

l The source IP of the incoming UDP packets from the switch must be the same source IP used by the main
channel connection.

For more information on configuring auxiliary channel ports, see Enabling SDN Controller on Mobility Master
on page 849

SDN Controller Configuration on Mobility Master
OpenFlow is an open communications interface between control plane and the forwarding layers of a network.
OpenFlow allows dynamic manipulation of the forwarding plane for switches and routers. SDN architecture
uses OpenFlow to enable software programs to manipulate the flow of packets in the network and to manage
traffic based on the application's requirement.

OpenFlow Protocol v1.3 is used to achieve SDN with ArubaOS 8.0. An SDN controller runs on Mobility Master
while an OpenFlow agent runs on the managed devices. For more information on OpenFlow agent, see
OpenFlow Agent on page 849. Mobility Master and the managed devices communicate over OpenFlow
channels. The applications running in Mobility Master get all mDNS/SSDP packets seen by control plane on the
managed devices. All outgoing mDNS/SSDP packets are originated by the application on Mobility Master.

For more information on SDN Controller configuration on Mobility Master, see Enabling SDN Controller on
Mobility Master on page 849

SDN Platform Services
SDN Platform Services gather and build the information required for core controller functions, including the
following:

l Discovery of OpenFlow-capable devices and ports

l Discovery of all hosts and clients



l Discovery of the network topology

l Basic switching and routing

l Flow/policy programming

l Functionality to provide network paths between hosts

l Packet transmission

l Asynchronous event/state updates to Northbound applications

SDN Controller functions are achieved through the following services:

l Switch Discovery

l Topology discovery

l Host discovery

l Flow Management

l Packet Handling

The SDN Controller supports IPv6 flows and hosts. IPv6 host addresses can be learned in addition to IPv4 addresses.

Switch Discovery
DPEs connect to the SDN Controller using the Transmission Control Protocol (TCP). Each TCP connection is
terminated by a switch manager and initiates OpenFlow messages between the DPE and the SDN Controller.
When a new switch is discovered, the OpenFlow driver sends a message to the topology manager, which
creates a new switch entry in the Switch Database. Applications can subscribe to this message type to receive a
notification each time a switch is discovered.

Topology Discovery
The network topology displays the arrangement of switches and inter-switch links within the network. The
complete topology view allows applications to:

l Make forwarding decisions

l Establish the shortest paths for flows

l Find alternate paths when links are congested or down

l Send low-latency flows on fast links and low-priority flows on slow links

The SDN Controller uses L3 LLDP to discover links between switches. The LLDP frame is encapsulated in an IP
packet with a unique source and destination IP address, creating a clear separation between standard LLDP
packets and LLDP packets generated by the SDN Controller.

The SDN Controller generates the network topology through the following steps:

1. For every link with an UP status, the controller sends an OpenFlow ‘packet-out’ message with an LLDP frame
to the source switch (switch-1).

2. Switch-1 sends the LLDP frame to switch-2 through the specified link.

3. Switch-2 sends the LLDP frame back to the SDN controller through a ‘packet-in’ message.

4. Upon receiving the ‘packet-in’ message, the controller creates a link between the port number (port) and
datapath ID (dpid) combination on switch-1 and port/dpid on switch-2.

This process only creates a link in one direction. Steps 1-4 must be repeated to create a link from the opposite
direction.
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Figure 107 Topology Discovery

Host Discovery
The network topology can only be completed when all hosts are discovered by the controller. Hosts are
defined by the port/dpid of the DPE to which they are connected. DPEs can run under hybrid mode (passive
mode) or true OpenFlow mode (active mode).

When a host connects to a DPE, the host generates Address Resolution Protocol (ARP) packets that contain
important mapping and identification information. When the DPE registers to the controller, the DPE mirrors
these ARP packets from the host to the controller through a ‘packet-in’ message, in which the controller learns
the IP-MAC binding, attachment point (port/dpid), and classification of the host.

Hosts can be classified as wireless or non-wireless, depending on the point of attachment. For example, if the
port on the DPE is wireless, the host is marked as wireless.

Hosts can only be discovered by packets received through leaf links. Packets that are received through inter-switch
links do not trigger host discovery on the controller.

Hosts can only be classified as wireless if all wireless tunnels contain a "bss" keyword.



Figure 108 Host Discovery

For example, in Figure 108, the ARP packet generated by Host-1 triggers a 'packet-in' message from Switch-1 to
the controller. Switch-2 also generates a 'packet-in' message when the ARP packet is forwarded from Port 2 of
Switch-1. However, the controller ignores the message from Switch-2 since the ARP packet is received through
an inter-switch link (see Topology Discovery for more details on inter-switch links). The controller learns that
Host-1 is connected to Port-1 of DPID Switch-1.

IPv6 hosts are also discovered similarly using Internet Control Message Protocol version 6 (ICMPv6) neighbor
discovery and solicitiation packets.

Host information is maintained in the Host Database, which is available to all SDN Controller applications and
certain Northbound APIs. Host entries are aged out and deleted from the Host Database if no ARP packets for
that host are received within the specified timeout period (default of 300 seconds).

Flow Management
The flow manager programs and maintains flows that are pushed by applications on the controller. APIs from
the SDN-SDK library interact with the flow manager to setup, update, or delete flows between applications and
DPEs. A collection of flows that achieves a specific end-to-end policy or traffic forwarding process is referred to
as a flow-group.
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Figure 109 Flow Push

The flow manager includes the following functions:

Flow Installation
Flow installation is initiated when an application sends a flow setup message to the flow manager. The setup
message contains the flow definition and allows the flow manager to check for any conflicting entries in the
Flow Database. The flow is assigned a unique flow ID and flow-group ID by the application. The flow manager
completes the installation process by sending a flow modification message to the switch manager that handles
the target DPE.

Flow Match and Actions
The SDN Controller presents a uniform interface for flow installation, regardless of the OpenFlow version.
Fields from incoming packets are matched against flow entries (match fields) to perform a specific set of
actions. Refer to Table 187 to view the complete list of supported match fields and Table 188 to view the
complete lists of supported actions.



Table 187: Flow Match Fields

Match Field Description Mand-
atory

Mask-
able Type Example

switch DIPID of the switch. Yes No String 00:00:00:1a:

1e:00:3b:40

priority Priority of the flow. Yes No Integer 32768

idle-timeout Idle-timeout, after which a flow
is deleted based on the time
period since activity was last
detected.

No No Integer 30 seconds

hard-timeout Hard-timeout, after which a
flow is deleted based on the
time period since the flow was
created.

No No Integer 30 seconds

ingress-port Ingress port of the packet. No No Integer 1

src-mac Source MAC address on the
ether header.

No No String 00:1a:1e:00:

3b:40

dst-mac Destination MAC address on
the ether header.

No No String 00:1a:1e:00:

3b:40

ether-type Type of ether header. No No Integer 2048 (IPv4)

vlan VLAN ID. No No Integer 20

vlan-priority VLAN priority. No No Integer 6

src-ip Source IP address on the
IP header.

No Yes String 10.10.10.10

src-ip-mask Number of bits to mask from
the LSB.

No — Integer 8 (/24 mask)

dst-ip Destination IP address on the
IP header.

No Yes String 10.10.10.11

dst-ip-mask Number of bits to mask from
the LSB.

No — Integer 24 (/8 mask)

test
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Match Field Description Mand-
atory

Mask-
able Type Example

src-ipv6 Source IPv6 address on the
IP header.

No Yes String fe80::1a:1e0f:
ff00:3b41/64

src-ipv6-mask Number of bits to mask from
the LSB.

No — Integer 64

dst-ipv6 Destination IPv6 address on
the IP header.

No Yes String fe80::1a:1e0f:
ff00:3b41/64

dst-ipv6-mask Number of bits to mask from
the LSB.

No — Integer 32

icmpv6-type Internet Control Message
Protocol version 6 (ICMPv6)
type.

No No Integer 135

(neighbor

solicitation)

icmpv6-code ICMPv6 code. No No Integer 0

ip-tos Type of Service (ToS) bits on
the IP header.

No No Integer 34

protocol Protocol on the IP header. No No Integer 6 (TCP)

src-port Source port on the IP header. No No Integer 5353 (MDNS)

dst-port Destination port on the
IP header.

No No Integer 5353 (MDNS)

app-name Name of the application
installing the flow.

No No String airgroup

src-port-start Start of the source port range. No No Integer 5000

src-port-end End of the source port range. No No Integer 5010

dst-port-start Start of the destination port
range.

No No Integer 6000

dst-port-end End of the destination port
range.

No No Integer 6010



Table 188: Flow Actions

Action Field Description Example

output Port on which the packet is sent out. l Controller

l Flood

l All

l Normal

set-vlan-id Configures the VLAN ID on the VLAN header. 20

set-vlan-priority Configures the VLAN priority on the VLAN header. 7

set-src-mac Configures the source MAC address on the ether
header.

00:1a:1e:00:3b:40

set-dst-mac Configures the destination MAC address on the ether
header.

00:1a:1e:00:3b:40

set-src-ip Configures the source IP address on the IP header. 20.20.20.20

set-dst-ip Configures the destination IP address on the IP header. 20.20.20.20

set-tos-bits Configures Type of Service (ToS) bits on the IP header. 42

set-flag Updates session flags in the datapath to further
process traffic.

NOTE: This action is only available on Aruba OpenFlow
switches.

VH

write-flag Overwrites datapath session flags.

NOTE: This action is only available on Aruba OpenFlow
switches.

VH

aruba-output Sets a maximum packet number for the specified flow
output. Only the specified number of packets is
mirrored to the output for the flow.

NOTE: This action is only available on Aruba OpenFlow
switches.

controller:10 (indicates
that only the first 10
packets are forwarded to
the controller)

set-appid Sets an application ID on a datapath session after
deep packet inspection (DPI) has been performed.

NOTE: This action is only available on Aruba OpenFlow
switches.

Netflix

Flow Update
Applications can use this function to update the action list associated with an existing flow. The application
must obtain the new action list and the ID of the existing flow/flow-group to create a flow update request.
After the request is accepted, the flow manager locates and updates the existing flow in the Flow Database.
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Flow Deletion
The SDN Controller supports the following methods to delete a flow:

l Applications can explicitly call for a flow delete to remove a flow from the switch.

l Flows can be removed asynchronously through an idle-timeout or hard-timeout. Idle-timeout specifies the
time period since activity was last detected for a flow. Hard-timeout specifies the time period since the flow
was created.

After a flow is deleted, the controller removes all references to the flow and notifies northbound applications
about the deletion.

Individual flows within a flow-group cannot be deleted; the entire flow-group must be deleted.

Flow Statistics
The flow manager sends statistics request messages to the DPEs to update statistics in the Flow Database
every 30 seconds. Separate request messages are sent for each flow bucket, based on the corresponding
cookie ID and cookie mask value. This bucket-based statistics collection improves the overall performance of
the flow manager and DPEs since flow statistics can be processed through multiple (smaller) requests.

Databases
A copy of every network flow is maintained and readily accessible in the Flow Database. The storage of flows in
a database prevents data or state loss during process crashes and provides information to read-only
applications without requiring communication with any infrastructure processes.

Packet Handling
One of the major functions of the SDN Controller is to facilitate packet processing throughout the network.
Packets that are sent from switches are called ‘packet-in’. Packets that are sent to switches are called ‘packet-
out’. The following figure displays the packet-in and packet-out flow within the network.



Figure 110 Packet Handling

When a northbound application, routing switch, or topology manager sends a ‘packet-out’ message, the packet
is sent to the packetin-dispatcher, which handles all packet-related functionality, such as the port number and
datapath ID (dpid) to which the packet must be sent. The packet is then sent to the switch manager, which
processes and sends the packet to the respective DPE (based on the designated port/dpid), where additional
forwarding processes can be handled.

When a switch sends a ‘packet-in’ message, the packet is sent to the packetin-dispatcher through the switch
manager. The packetin-dispatcher classifies and delivers the packet to the routing switch, topology manager, or
Northbound APIs.

OpenFlow Version Support
The SDN Controller supports OpenFlow versions 1.0 and 1.3. The controller dynamically negotiates with the
DPEs to select the highest common version.

IPv6 Support
The SDN Controller supports IPv6 flows and hosts. Flow match conditions can include the following:

l IPv6 as an ether type value

l IPv6 address as an src-ip or dst-ip value

l ICMPv6 type and code

The controller can learn IPv6 addresses in addition to IPv4 addresses.
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High Availability
With the centralization of features and management functions on the SDN Controller, a single instance of the
controller creates a single point of failure. The SDN Controller supports the Virtual Router Redundancy
Protocol (VRRP) to reduce downtime and client traffic disruptions during network upgrades or unexpected
failures. See Increasing Network Uptime Through Redundancy and VRRP for more details on high availability
and VRRP.

VRRP
VRRP provides a redundancy solution, in which two or more systems, such as a primary and backup controller,
share a virtual IP address. When the primary SDN Controller fails, the agents (DPEs) that are connected to the
primary controller time out and reconnect to the backup controller associated with the same virtual IP.

Under the SDN Controller, the primary and backup controllers do not undergo a state sync. The following must
be rebuilt on the backup controller:

l The backup controller must learn and compute the network topology.

l Previous hosts may not be available immediately on the system. The Host Database must be rebuilt.

l Upon switch discovery, applications must re-push all flows to the switches.

VRRP failovers are transparent for northbound applications that use REST APIs, as REST APIs continue to
provide services despite any system failures. However, applications must re-subscribe to the ZMQ APIs.

Northbound API
The Northbound API makes the information built from the SDN Controller available for applications. The
Northbound API consists of the following API types:

l Synchronous: Synchronous APIs are initiated by the client, and the information is presented through the
server in response to the API. Synchronous APIs can be classified into two categories:

n Get/Fetch: These APIs obtain information about the network without affecting the state of the
network.

n Push/Post/Modify: These APIs modify the state of the network.

l Asynchronous: Asynchronous APIs notify northbound applications about changes in the network through
server-to-client communication.

Synchronous APIs
Synchronous APIs are implemented through the REST API (Representational State Transfer) using standard
HTTP GET, POST, and DELETE methods. REST provides a uniform interface between clients and servers, while
allowing them to exist independently without any state transfers. A new request must be made by the client
through a fetch mechanism or a single API each time the information is desired. Refer to the sections below to
view the REST APIs that are available on the SDN Controller.

The SDN Controller provides multi-version support and backwards compatibility for REST APIs

Switch API
The Switch API returns information about switches in the network, using the HTTP GET method.



Table 189: Switch API Query Parameters

Query Parameter Definition

switch Lists all switches in the network.

switch?dpid Lists all switches associated with a specific DPID.

The output for this message type displays the following information:

Table 190: Switch API Output Parameters

Output Parameter Definition

add-time Time that the switch is added to the network.

auxiliary-id ID number identifying the auxiliary channel.

auxiliary-status Indicates if the auxiliary channel is Up or Down.

auxiliary-update-time Time that the auxiliary channel is updated.

capabilities Switch capabilities, such as flow statistics or port statistics.

description Information about the switch, including the model and version of the switch.

disconnect-time Time that the switch disconnects from the network.

ip IP address of the switch.

port Remote TCP port of the switch.

ports Displays the list of ports on the switch.

name Name of the port.

port-mac MAC address of the port.

port-no Port number.

rx-packets Total number of packets received on the port.

status Status of the port.

tx-packets Total number of 802.11 packets transmitted by the port.

reconnect-time Time that the switch reconnects to the network.
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Output Parameter Definition

secure-connection Indicates if a secure connection is Enabled or Disabled on the switch.

status Indicates if the switch is Up or Down.

switch MAC address of the switch.

version OpenFlow version of the switch:

l v1.0

l v1.3

The Switch API displays output similar to the example below:
#curl --insecure -b aruba-cookie https://10.4.251.105:4343/sdn/v1/switch

[

{

"add-time": "Mon Jun 29 07:54:10 2015\n",

"auxiliary-id": 1,

"auxiliary-status": "Up",

"auxiliary-update-time": "Wed May 18 02:54:49 2016\n",

"capabilities": [

"Flow statistics",

"Table statistics",

"Port statistics",

"Queue statistics"

],

"description": "Aruba Networks, Inc. Aruba7210 VERSION 6.4 None None",

"disconnect-time": "Mon Jun 29 09:48:21 2015\n",

"ip": "10.4.251.79",

"port": 51898,

"ports": [

{

"name": "GE0/0/2",

"port-mac": "00:1a:1e:00:3b:43",

"port-no": 1,

"rx-packets": 0,

"status": 0,

"tx-packets": 0

},

{

"name": "GE0/0/3",

"port-mac": "00:1a:1e:00:3b:44",

"port-no": 2,

"rx-packets": 0,

"status": 0,

"tx-packets": 0

}

],

"reconnect-time": "Mon Jun 29 09:48:24 2015\n",

"secure-connection": "Disabled",

"status": "Up",

"switch": "00:00:00:1a:1e:00:3b:40",

"version": "v1.3"

}

]



Host API
The Host API returns information about the hosts that are connected to the network, using the
GET HTTP method.

Table 191: Host API Query Parameters

Query Parameter Definition

host Lists all hosts in the network.

host?mac Lists all hosts associated with a specific MAC address.

host?ip Lists all hosts associated with a specific IP address.

host?ip & timeout Lists all hosts associated with a specific IP address and timeout period.

host?start Controls paging of results by pointing to the starting object.

host?limit Controls paging of results by limiting the number of objects to be returned.

host?direction Controls paging of results by setting the direction to "next" or "prev".

The output for this message type displays the following information:

Table 192: Host API Output Parameters

Output Parameter Definition

attachment-point Information on the host's attachment point.

port Number of the port to which the host is connected.

port-mac MAC address of the port to which the host is connected.

switch MAC address of the switch to which the host is connected.

created-at Time that the host entry is created.

host-mac MAC address of the host.

idle-for Amount of time that host is idle, in seconds.

ip-addrs IP address of the host.

up-time Amount of time that the host is up, in seconds.

wireless Indicates if the host is wireless.
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Output Parameter Definition

object-count Number of objects to be returned.

page-info Information about result pages.

next-id ID number of the next page.

previous-id ID number of the previous page.

response-time Query response time, in microseconds.

The Host API displays output similar to the example below:
#curl --insecure -b aruba-cookie https://10.4.251.105:4343/sdn/v1/host

[

{

"attachment-point": {

"port": 3,

"port-mac": "00:1a:1e:00:3b:46",

"switch": "00:00:00:1a:1e:00:3b:40"

},

"created-at": "Mon Jun 29 01:36:51 2015\n",

"host-mac": "00:00:5e:00:01:01",

"idle-for": 39464,

"ip-addrs": [

"63.82.214.201"

],

"up-time": 40037,

"wireless": false

}

]

"Meta-Info": { 

"object-count": 4,

"page-info": {

"next-id": "573b0fd3cf42dcb5ab9c7c40"

“previous-id”: “573b0fd3cf42dcb5ab9c7c20”

},

"reponse-time (micros)": 607

}

}

Flows API
The Flows API returns information about the flows between applications and DPEs, using the
HTTP GET  method.



Table 193: Flows API Query Parameters

Query Parameter Definition

flows Lists all flows between applications and DPEs.

flows?flow-group-id Lists all flows associated with a specific flow-group.

flows?flow-id Lists all flows associated with a specific flow ID.

flows?dpid Lists all flows associated with a specific dpid.

flows?start Controls paging of results by pointing to the starting object.

flows?limit Controls paging of results by limiting the number of objects to be returned.

flows?direction Controls paging of results by setting the direction to "next" or "prev".

The output for this message type displays the following information:

Table 194: Flows API Output Parameters

Output Parameter Definition

actions Action(s) used by the flow. See Table 193 for the complete list of flow actions.

byte-count Total byte count of the flow.

cookie Cookie ID to which the flow is assigned.

created-at Time that the flow entry is created.

dst-ip Destination IP address of the flow.

ether-type Ethertype used by the ether header.

flow-group-id Flow-group ID.

flow-id Flow ID.

hard-timeout Hard-timeout, after which a flow is deleted based on the time period since the flow
was created.

idle-timeout Idle-timeout, after which a flow is deleted based on the time period since activity was
last detected.

packet-count Number of packets transmitted by the flow.

ArubaOS 8.0.0.0 | User Guide SDN Controller |  840



841 | SDN Controller ArubaOS 8.0.0.0  | User Guide

Output Parameter Definition

priority Priority of the flow.

protocol Protocol used by the flow (for example, TCP).

src-ip Source IP address of the flow.

status Status of the flow (for example, "install-confirmed").

switch MAC address of the switch to which the flow is connected.

object-count Number of objects to be returned.

page-info Information about result pages.

next-id ID number of the next page.

previous-id ID number of the previous page.

response-time Query response time, in microseconds.

The Flows API displays output similar to the example below:
#curl --insecure -b aruba-cookie https://10.4.251.105:4343/sdn/v1/flows

[

{

"actions": "output=controller",

"byte-count": 0,

"cookie": 281474976710660,

"created-at": "Mon Jun 29 07:54:10 2015\n",

"dst-ip": "2.2.2.2",

"ether-type": 2048,

"flow-group-id": 1007117466670727170,

"flow-id": 1007117466670791846,

"hard-timeout": 0,

"idle-timeout": 0,

"packet-count": 0,

"priority": 65535,

"protocol": 97,

"src-ip": "1.1.1.1",

"status": "Install-Confirmed",

"switch": "00:00:00:1a:1e:00:3b:40"

}

]

"Meta-Info": { 

"object-count": 4,

"page-info": {

"next-id": "573b0fd3cf42dcb5ab9c7c40"

“previous-id”: “573b0fd3cf42dcb5ab9c7c20”

},

"reponse-time (micros)": 607

}

}



Links API
The Links API returns information about the inter-switch links that create the network topology, using the
HTTP GET method.

Table 195: Links API Query Parameters

Query Parameter Definition

links Lists all links that make up the network topology.

The output for this message type displays the following information:

Table 196: Links API Output Parameters

Output Parameter Definition

from-port Port number of the source switch.

from-switch MAC address of the source switch.

status Status of the inter-switch link.

to-port Port number of the destination switch.

to-switch MAC address of the destination switch.

The Links API displays output similar to the example below:
#curl --insecure -b aruba-cookie https://10.4.251.201:4343/sdn/v1/links

[

{

"from-port": 2,

"from-switch": "00:00:00:00:00:00:00:03",

"status": 1,

"to-port": 1,

"to-switch": "00:00:00:00:00:00:00:04"

}

]

Path API
The Path API returns information on the path between two ports (hosts) in the network, using the
HTTP GET method. Query the Host API to find the attachment point for each host, and then query the Path
API to locate the path between the two attachment points.

Table 197: Path API Query Parameters

Query Parameter Definition

path?src-spid&src-port&dst-dpid&dst-port Lists a series of dpid's and ports, which constitute the path
between the source dpid/port and destination dpid/port.

The output for this message type displays the following information:
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Table 198: Path API Output Parameters

Output Parameter Definition

inPort Ingress port of a switch in the path.

outPort Egress port of a switch in the path.

switchDPID Datapath ID of a switch in the path.

The Path API displays output similar to the example below:
#curl --insecure -b aruba-cookie

https://10.4.251.105:4343/sdn/v1/path?00:00:00:1a:1e:00:3b:40/1/00:00:00:1a:1e:00:3b:90/2

[

{

"inPort": 1,

"outPort": 2,

"switchDPID": "00:00:00:1a:1e:00:3b:40"

},

{

"inPort": 3,

"outPort": 2,

"switchDPID": "00:00:00:1a:1e:00:3b:90"

}

]

Flows API
The Flows API installs flows between applications and DPEs, using the HTTP POST method. Refer to Flows API
(HTTP GET) to view the list of parameters that can be specified to install a new flow.

The output for this message type displays the following information:

Table 199: Flows API Output Parameters

Output Parameter Definition

flow-group-id Flow-group in which the new flows are installed.

flows List of new flows installed on the controller.

flow-id ID of the new flow.

status Status of flow installation.

The Flows API displays output similar to the example below:
#Install a single flow.

# curl --insecure -b "aruba-cookie" -d '{"flows": [{"switch": "00:00:00:1a:1e:00:3b:40",

"name":"sdn-1", "priority":32768, "ether-type":2048, "src-ip":"20.20.20.4", "dst-

ip":"20.20.20.5", "src-port":5000, "dst-port":8000, "protocol":17,

"actions":"output=controller,output=normal"}]}' https://10.4.251.105:4343/sdn/v1/flows |python

-mjson.tool

[

{

"Flow-Group-Id": 6269292156276441089,



"Flows": [

{

"Flow-Id": 6269292156276441860

}

],

"Status": "Install-In-Progress"

}

]

Flow Update API
The Flow Update API updates the list of actions that are installed on an existing flow, using the
HTTP POST method. See Flow Match and Actions for more information about match fields and actions.

Table 200: Flow Update API Query Parameters

Query Parameter Definition

flow-group-id Updates all flows associated with a specific flow-group ID.

flow-id (Optional) Updates all flows associated with a specific flow ID. If this field is specified,
only the flows that match both the flow-group ID and flow ID are updated.

The output for this message type displays the following information:

Table 201: Flow Update API Output Parameters

Output Parameter Definition

flow-group-id ID of the flow-group that is being updated.

flow-id ID of the flow that is being updated.

status Status of the flow update.

The Flow Update API displays output similar to the example below:
#curl --insecure -b "aruba-cookie" -d '{"flow-group-id":6269292156276441089, "flow-

id":6269292156276441860, "actions":"output=controller"}'

https://10.4.251.105:4343/sdn/v1/flowupdate

{

"flow-group-id": 6269292156276441089,

"flow-id": 6269292156276441860,

"status": "Install-In-Progress"

}

Flow Delete API
The Flow Delete API deletes flows from the controller, using the HTTP POST method.
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Table 202: Flow Delete API Query Parameters

Query Parameter Definition

flow-group-id Deletes all flows associated with a specific flow-group ID.

flow-group-id all Deletes all flows in the network.

The output for this message type displays the following information:

Table 203: Flow Delete API Output Parameters

Output Parameter Definition

status Indicates if the flows for the given flow-group have been deleted.

The Flow Delete API displays output similar to the example below:
#curl --insecure -b "aruba-cookie" -d '{"flow-group-id":"6269292156276441090"}'

https://10.4.251.105:4343/sdn/v1/flowdelete |python -mjson.tool

{

"Status": "Deleted"

}

Error Messages
Error messages are returned if any SDN REST API experiences the following errors:

Error Message Description

API-Timeout The API times out.

Switch-Not-Reachable The switch/DPE cannot be reached.

Switch-No-Reply The switch/DPE does not reply to the request.

Db-Connect-Failed The controller fails to connect to a database.

Out-of-Memory The system runs out of memory.

Host-Not-Found The host cannot be located.

Switch-Not-Found The switch/DPE cannot be located.

Link-Not-Found The link cannot be located.

Invalid-Input The input is invalid.



Error Message Description

Send-Failed Northbound applications are unable to send data to internal applications.

Recv-Failed Northbound applications are unable to receive data from internal applications.

Connect-Failed Northbound applications are unable to connect to internal applications.

Bind-Failed Northbound applications are unable to bind to the local address.

Socket-Failed The socket connection fails.

Listen-Failed Northbound applications are unable to listen for data from internal
applications.

Accept-Failed Northbound applications are unable to accept connections from internal
applications.

Duplicate-Flow The system encounters a duplicate flow.

Flow-Group-Not-Found The flow-group cannot be located.

JSON-Parse-Error The system experiences a JSON parsing error.

Flow-Conflict The flow manager locates a conflicting entry in the Flow Database.

Switch-Internal-Error The switch/DPE experiences an internal error.

Flow-Logical-Error The system experiences an error in the flow logic.

Too-Many-Flows Too many flows are being pushed in a single flow setup request.

Object-Id-Not-Found The object ID cannot be located.

Object-Id-Invalid The object ID is invalid.

Invalid-Group-Owner The group owner is invalid.

Invalid-Action The desired action is invalid.

System-Max-Flow-Limit-
Reached

The system reaches the maximum flow limit.

Asynchronous APIs
Asynchronous APIs are implemented through the ZeroMQ (ZMQ), which is a TCP-based open-source library
that offers publish/subscribe services for server-to-client communication. Northbound applications subscribe
to the desired topics based on the type of information that is required by the client. The controller publishes
this information as events or packets. All ZMQ events, except ‘packet-out’ events, are published by the
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Northbound API and sent to the respective northbound applications. The ‘packet-out’ events are published by
the northbound applications and sent to the packetin-dispatcher on the controller. See Packet Handling for
more information on packet processing.

The following ZMQ APIs are available on the SDN Controller:

Table 204: SDN ZMQ APIs

Event Type Possible Values Data Structure

Switch State
Change

(EVENT_SwITCH)

l STATE_UP

l STATE_DOWN

l STATE_UPDATE

typedef struct {

uint16_t event;

uint16_t len;

} event_header_t;

typedef struct {

uint64_t datapath_id;

uint8_t state;

uint8_t pad[7];

} switch_event_t;

Port State Change

(EVENT_PORT)

l PORT_LINK_UP

l PORT_LINK_DOWN

typedef struct {

uint16_t event;

uint16_t len;

} event_header_t;

typedef struct {

uint64_t datapath_id;

uint32_t port_no;

uint8_t port_mac[ETH_ADDR_LEN];

uint8_t reason;

uint8_t state;

uint8_t pad[MAX_PORT_NAME_LEN];

} port_event_t;

Packet In N/A typedef struct {

uint64_t flow_id;

uint64_t datapath_id;

uint32_t port_no;

uint16_t vlan_vid;

uint16_t len;

} zmq_pkt_in_t;

Followed by packet data

Packet Out N/A typedef struct {

uint64_t datapath_id;

uint32_t port_no;

uint16_t len;

} zmq_pkt_out_t;

Followed by packet data

User Event l USER_EVENT_ADD

l USER_EVENT_DELETE

l USER_EVENT_UPDATE

l USER_EVENT_IP_AGEOUT

#define MAX_IP_ADDRS 4

typedef struct { 

union { 

uint32_t ipv4_addr;

struct in6_addr ipv6_addr;

};



Event Type Possible Values Data Structure

bool is_ipv6;

} ip_addr;

typedef struct sdn_host_t_ { 

unsigned char mac[6];

uint64_t dpid;

uint32_t port;

bool wireless;

unsigned char port_mac[6];

ip_addr addrs[MAX_IP_ADDRS];

time_t updated_at; time_t

created_at; } sdn_host_t;

typedef struct user_event_ {

uint8_t event_type;

sdn_host_t host;

} user_event_t;

Link Event l LINK_EVENT_ADD

l LINK_EVENT_DELETE

l LINK_EVENT_UPDATE

typedef struct sdn_link_status_t_ { 

uint64_t from_dpid;

uint64_t to_dpid;

uint32_t from_port;

uint32_t to_port;

uint8_t status;

} sdn_link_status_t;

typedef struct link_event_ {

uint8_t event_type;

sdn_link_status_t link_status;

} link_event_t;

Flow Event l FLOW_EVENT_DELETE

l FLOW_EVENT_ERROR

l FLOW_EVENT_ADD

l FLOW_EVENT_UPDATE

typedef struct flow_event_ {

uint64_t flow_group_id;

uint64_t flow_id;

uint8_t event_type;

} flow_event_t;

Northbound Authentication
To secure communication between users and APIs, the Northbound API supports basic authentication using
HTTPS. During HTTPS authentication, the client is required to provide a username and password for each
HTTPS request. The server can only carry out the request after the user is authenticated.
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Chapter 39
OpenFlow Agent

OpenFlow agent runs on network devices such as switches, routers, wireless controllers and APs. This interacts
with a centralized SDN Controller using the OpenFlow protocol. The OpenFlow agent translates OpenFlow
commands into device specific actions.

The three main functions of the OpenFlow agent are:

1. Discover the Hosts—Help the SDN Controller to discover all the hosts (endpoints) attached to Mobility
Master.

2. Discover the Network—Help the SDN Controller to learn about the Mobility Master’s interface and its
connectivity to other devices in the network.

3. Program the Network—Accept OpenFlow commands and take appropriate actions for those commands.

4. Provides Statistics—Provide visibility to SDN Controller to export flow/port statistics.

For OpenFlow to be functional in a network, you must enable SDN Controller on the Mobility Master and
OpenFlow agent on the required Managed devices. By default, OpenFlow is disabled on Mobility Master as well
as the managed devices.

Enabling SDN Controller on Mobility Master
You can configure the SDN Controller using the WebUI or CLI.

In the WebUI
The following procedure configures SDN Controller on Mobility Master using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile. Select openflow-controller.

3. In openflow-controller, select the ofc-state check box.

You can also configure an auxiliary channel port to reduce bandwidth consumption and latency on the main channel.
To view the current status of the auxiliary channel, execute the show openflow-controller switches command. The
default port is 6633. For more information on auxiliary channels, see Auxiliary Channel Driver on page 825.

4. (Optional) To configure an auxiliary channel port, enter the listening port in the ofc auxiliary-channel-
port field.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Execute the following commands to enable SDN Controller on Mobility Master:
(host) [mm] (config) #openflow-controller

(host) [mm] (openflow-controller) #openflow-controller-enable

(host) [mm] (openflow-controller) #write memory

You can also configure an auxiliary channel port to reduce bandwidth consumption and latency on the main channel.
To view the current status of the auxiliary channel, execute the show openflow-controller switches command. The
default port is 6633. For more information on auxiliary channels, see Auxiliary Channel Driver on page 825.
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Execute the following command to configure and auxiliary channel port on the SDN Controller:
(host) [mm] (openflow-controller) #auxiliary-channel-port <port-num>

Configuring OpenFlow Agent on Managed devices
To enable OpenFlow agent, you must perform the following tasks on the managed device:

1. Enable OpenFlow profile on the managed device.

a. Configure the SDN Controller IP address and listening port.

b. Bind the user VLAN.

2. Enable OpenFlow for the required user roles and Virtual APs.

Enabling OpenFlow and Binding User VLAN
You can enable OpenFlow on the managed device and bind user VLAN using the WebUI or CLI:

In the WebUI
Follow the procedure below to configure the OpenFlow profile using the WebUI:

1. In the Managed Networks node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile. Select Openflow-profile.

3. In Openflow-profile, select the State check box.

4. (Optional) Select the Auxiliary State check box and enter the auxiliary port number in the Auxiliary
Channel Port field to enable OpenFlow auxiliary channel port.

Ensure that the auxiliary channel port configured on the managed device matches with the one configured on
Mobility Master. The default port is 6633.

5. In controller-ip, enter the Mobility Master IP address and port number.

6. In bind-vlan, enter the OpenFlow VLAN to the current list.

7. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Execute the following commands to configure and enable the OpenFlow profile:
(host) [md] (config) #openflow-profile

(host) [md] (Openflow-profile) #openflow-enable

(host) [md] (Openflow-profile) #controller-ip <master-ip> <port>

Execute the following commands to configure an auxiliary channel port:
(host) [md] (Openflow-profile) #openflow-auxiliary-enable

(host) [md] (Openflow-profile) #auxiliary-channel-port <port>

Ensure that the auxiliary channel port configured on the managed device matches with the one configured on
Mobility Master. The default port is 6633.

Execute the following command to bind user VLANs:
(host) [md] (Openflow-profile) #bind-vlan <list of vlan ids separated by comma>

(host) [md] (Openflow-profile) #write memory



Enabling OpenFlow in User Role and Virtual AP
You can enable OpenFlow in user role and Virtual AP using the WebUI or CLI.

In the WebUI
Follow the procedure below to enable OpenFlow in the user-role and virtual AP using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies.

2. In the Roles tab, select an existing role.

3. In the Roles > <custom-role> section, click Show Advanced View.

4. Under More, expand Network.

5. In the Open flow drop-down list, select Enabled.

6. Click Submit.

7. Navigate to Configuration > System > Profiles.

8. In All Profiles, expand Wireless LAN > Virtual AP. Select the default profile.
This procedure uses the default profile.

9. In Virtual AP profile, expand Advanced.

10.Select the Openflow Enable check box.

11.Click Save.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes

In the CLI
Execute the following commands to enable OpenFlow for a user role:
(host) [md] (config) #user-role <user-role>

(host) [md] (config-submode)#openflow-enable

(host) [md] (config-submode)#write memory

Execute the following commands to enable OpenFlow for a VAP:
(host) [md] (config) #wlan virtual-ap <virtual-ap>

(host) [md] (Virtual AP profile "<virtual-ap>") #openflow-enable

(host) [md] (Virtual AP profile "<virtual-ap>") #write memory

Verifying OpenFlow Configuration on Managed Device
Execute the following commands to verify the OpenFlow profile configuration on the managed device:
(host) [md] #show openflow-profile

Openflow-profile "default"

--------------------------

Parameter Value

--------- -----

State Enabled

Openflow mode passive

Openflow version v1.3

controller-ip 10.16.125.115:6633

VLAN ID or range(s) of VLAN IDs 1,124,400,600

openflow tls Disabled

certificate-file none

key-file none

ca-certificate-file none

Verifying OpenFlow Configuration on Mobility Master
Execute the following command to verify the OpenFlow configuration on Mobility Master.
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(host) [mynode] #show openflow-controller

openflow-controller

-------------------

Parameter Value Set

--------- ----- ---

ofc state Enabled

ofc host-ageout-time 300

ofc mode passive

ofc tls Disabled

ofc certificate-file none

ofc key-file none

ofc ca-certificate-file none

ofc port 6633

ofc topology-discovery Enabled

ofc auxiliary-channel-port 6633

Viewing OpenFlow Information
The following show commands are used to view the OpenFlow related information:

l show openflow debug—Displays the OpenFlow debug information

l show openflow flows—Displays all the flows that are plumbed

l show openflow ports—Lists all the OpenFlow ports

l show openflow controller— Displays the OpenFlow Controller information

l show openflow capabilities —Displays the system capabilities

l show openflow flow-table— Displays the OpenFlow table

l show openflow statistics—Displays the OpenFlow statistics information

l show datapath openflow session/acl— Displays the session/ACL actions

l show datapath acl— Displays ACLs with OpenFlow index

l show ip access-list— Displays ACLs with action as OpenFlow
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Chapter 40
Loadable Service Module

The Loadable Service Module (LSM) provides an infrastructure that allows users to dynamically upgrade or
downgrade individual service modules without requiring an entire system reboot. Services are delivered as
individual service packages containing the version and instructions for loading and running the service. LSM is
introduced in ArubaOS 8.0.

This section includes the following topics:

l Service Modules

l Service Packages

l Upgrading a Service Module

l Troubleshooting

Service Modules
The following service modules are LSM-capable, and the default service packages are bundled with the
ArubaOS image:

l AirGroup

l AppRF

l ARM

l AirMatch

l NBAPI

l UCM

l WebCC

l WMS

Service Packages
Every service module has a corresponding service package, which can be downloaded from the Aruba support
site and installed on Mobility Master.

Upgrading a Service Module
Service modules must be upgraded if there is a bug in the existing module or a newer version of the module
has been released. Patches are posted to the Aruba Support site, where users can view and download packages
to upgrade a service.

After an ArubaOS image upgrades or downgrades, the non-default service packages are deleted.

In the WebUI
The following procedures upgrade a service module on Mobility Master using the WebUI.

Downloading a Service Package
To download a service package through the WebUI:

http://support.arubanetworks.com/
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1. Obtain the required service package from the Aruba Support site.

2. In the Mobility Master node-hierarchy, navigate to Maintenance > Software Management > Service
Module Packages in the WebUI.

3. Click the Add button at the bottom of the Service Module Packages table to add a new service package.

4. Under Load New Package, select the Access method used to fetch the package. Configure the settings
described in Table 205.

Parameter Description

Access method Select the protocol to send the service package from the image server to Mobility Master:

l TFTP

l FTP

l SCP

l Local file

Host IP address Enter the IP address of the image server where the service package resides.

Image file name Enter the exact service package name as residing on the image server.

NOTE: On selecting the Local file option from the Access method field, upload the
service package from your local file explorer.

Destination file
name

Enter the destination service package name. As a best practice, keep the image name
same as destination file name.

Username Enter the username of the image server.

NOTE: This option is only available if you select the FTP or SCP protocol in the Access
method field.

Password Enter the password of the image server.

NOTE: This option is only available if you select the FTP or SCP protocol in the Access
method field.

Table 205: Load New Package Configuration Parameters

5. Click Submit to validate the package.

Activating the Service Package
To activate the service package through the WebUI:

1. In the Mobility Master node hierarchy, navigate to Maintenance > Software Management > Service
Module Packages.

2. Select the new package from the Service Module Packages table. The Service Module Packages >
[name] window appears at the bottom of the workscreen.

3. Set the Status to Active to activate the new service package.

4. Click Submit.

Removing a Service Package
To remove a service package through the WebUI:



1. In the Mobility Master node hierarchy, navigate to Maintenance > Software Management > Service
Module Packages.

2. Select a package from the Service Module Packages table. The trash icon for the highlighted package
appears.

3. Click the trash icon. When the package delete window opens, click Delete.

4. Click Submit.

In the CLI
Execute the following commands to upgrade a service module on Mobility Master using the CLI.

Downloading a Service Package
Use one of the following CLI commands to download a service package through an FTP, SCP, or TFTP server:
(host) [mynode] #upgrade-pkg copy ftp: <ftphost> <username> <filename> flash: <destfilename>

(host) [mynode] #upgrade-pkg copy scp: <scphost> <username> <filename> flash: <destfilename>

(host) [mynode] #upgrade-pkg copy tftp: <tftphost> <filename> flash: <destfilename>

Upon download, the LSM performs the following compatibility checks to determine if the package is
compatible with the running version of ArubaOS. If validation is successful, the installation process can
continue. If validation is unsuccessful, the package is removed, and an error message appears.

l Platform Check: Determines if the package must run on a specific platform.

l Version Check: Determines if the package version matches the verion of ArubaOS running on the system.

Activating the Service Package
Use the following command to install and activate the service package through the CLI:
(host) [mynode] #upgrade-pkg activate <packagename>

The service is halted and upgraded with the new service package, during which time the service is unavailable to
all users. After the new package is installed and activated, the service restarts.

Viewing Service Packages
Execute the following command to display the downloaded and active LSM service packages on Mobility
Master using the CLI:
(host) [mynode] #show packages

Packages that are not active can be removed using the upgrade-pkg remove <packagename> command.

Removing a Service Package
Execute the following command to delete a service package from Mobility Master:
(host) [mynode] #upgrade-pkg remove <packagename>

Troubleshooting
Execute the show packages upgrade-history command to view package installation logs:
(host) [mynode] #show packages upgrade-history

May 04 21:50:29 Copying files to airgroup dir

May 04 21:50:29 Creating symbolic link to mdns binary

May 04 21:50:29 Package default_airgroup_pkg installation was successfully

May 04 21:50:29 Copying files to ucm dir

May 04 21:50:29 Creating symbolic link to ucm binary

May 04 21:50:29 Package default_ucm_pkg installation was successfully
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May 04 21:50:30 Copying files to wms dir

May 04 21:50:30 Creating symbolic link to wms binary

May 04 21:50:30 Package default_wms_pkg installation was successfully

May 04 21:50:30 Copying files to arm_cm dir

May 04 21:50:30 Creating symbolic link to arm binary

May 04 21:50:30 Package default_arm_cm_pkg installation was successfully

May 04 21:50:30 Copying files to web_cc dir

May 04 21:50:30 Creating symbolic link to web_cc binary

May 04 21:50:30 Package default_web_cc_pkg installation was successfully

May 04 21:50:30 Copying files to nbapi_helper dir

May 04 21:50:30 Creating symbolic link to nbapi_helper binary

May 04 21:50:30 Package default_nbapi_helper_pkg installation was successfully

May 04 21:50:31 Copying files to mcell dir

May 04 21:50:31 Copying mcell binary

May 04 21:50:31 Package default_mcell_pkg installation was successfully

May 04 21:50:31 Copying files to appRF dir

May 04 21:50:31 Creating symbolic link to appRF binary

Execute the show packages supported command to view the packages supported on Mobility Master:
(host) [mynode] #show packages supported

Packages Supported

------------------

Package Name Version

------------ -------

airgroup 1

ucm 1

wms 1

arm_cm 1

web_cc 1

nbapi_helper 1

mcell 1

appRF 1
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Chapter 41
Voice and Video

This chapter outlines the steps required to configure voice and video services on the Mobility Master for Voice
over IP (VoIP) devices, including Apple FaceTime, Alcatel-Lucent New Office Environment (NOE), Microsoft®
Lync/Skype for Business, Cisco Jabber, Cisco Skinny Call Control Protocol (SCCP), Spectralink SVP, SIP, H.323,
Vocera, and Wi-Fi Calling. As video and voice applications are more vulnerable to delay and jitter, the network
infrastructure must be able to prioritize video and voice traffic over data traffic.

This chapter includes the following topics:

l Voice and Video License Requirements on page 857

l Configuring Voice and Video on page 857

l Working with QoS for Voice and Video on page 867

l Unified Communication and Collaboration on page 873

l Understanding Extended Voice and Video Features on page 911

Voice and Video License Requirements
The voice and video services require PEFNG licenses on the Mobility Master. For complete details on the
required licenses, refer to the Aruba Mobility Master Licensing Guide.

Configuring Voice and Video
This section describes the steps required to set up and configure voice features on the Mobility Master:

1. Set up net services

2. Configure roles

3. Configure firewall settings for voice and video ALGs

4. Configure other parameters depending on the need and environment

Assigning voice traffic to the high priority queue is recommended when deploying voice over WLAN networks.

Voice ALG and Network Address Translation
Voice ALGs in Aruba Mobility Master do not support Network Address Translation (NAT). This is due to the way
NAT functions and the way IP addresses are embedded in the signaling messages. In a typical customer
deployment, a call server is deployed within an internal network which eliminates the need for NAT.

In short, voice ALGs should not be enabled when voice clients are behind a NAT.

Setting up Net Services
You can either use the default net services and ports or you can create or modify net services.

Using Default Net Services
The following table lists the default net services and their ports:
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Net Service
Name Protocol Port ALG

svc-h323-tcp TCP 1720 H.323

svc-h323-udp UDP 1718, 1719 H.323

svc-noe UDP 32512 NOE

svc-noe-oxo UDP 5000 NOE

svc-sccp TCP 2000 SCCP

svc-sips TCP 5061 SIPS

svc-sip-tcp TCP 5060 SIP

svc-sip-udp UDP 5060 SIP

svc-svp 119 0 SVP

svc-vocera UDP 5002 VOCE
RA

Table 206: Default Voice Net Services and Ports

Creating Custom Net Services
You can use CLI to create or modify net services.

(host) [mynode] (config) #netservice

[service name] [protocol] [port] [alg]

To create an svc-noe service on UDP port 32522, enter:

(host) [mynode] (config) #netservice svc-noe udp 32522 alg noe

Configuring User Roles
In the user-centric network, the user role of a wireless client determines its privileges and the type of traffic that
it can send or receive in the wireless network. You can configure roles for clients that use mostly data traffic,
such as laptops, and roles for clients that use mostly voice traffic, such as VoIP phones. Although there are
different ways for a client to derive a user role, in most cases the clients using data traffic are assigned a role
after they are authenticated through a method such as 802.1X, VPN, or captive portal. The user role for VoIP
phones may also be derived from the Organizational Unit Identifier (OUI) of their MAC addresses or the SSID to
which they associate. Refer to Roles and Policies on page 363 for details on how to create and configure a user
role.

This section describes how to configure voice user roles with the required privileges and priorities. Mobility
Master provides default user roles for all voice services. You can do one of the following:

l Use default user roles

l Create or modify user roles



l Use user-derivation roles

Using the Default User Role
Mobility Master is configured with the default voice role. This role has the following settings:

l No limit on upload or download bandwidth

l Default L2TP and PPTP pool

l Maximum sessions: 65535

The following ACLs are associated with the default voice role:

l global-sacl

l apprf-voice-sacl

l ra-guard

l sip-acl

l noe-acl

l svp-acl

l vocera-acl

l skinny-acl

l h323-acl

l dhcp-acl

l tftp-acl

l dns-acl

l icmp-acl

l http-acl

l https-acl

l skype4b-acl

l jabber-acl

l wificalling-acl

l voip-applications-acl

For more details on the default voice role, enter the following command in the Mobility Master:

(host) [mynode] #show rights voice

Creating or Modifying Voice User Roles
You can create roles for Facetime, H.323, Jabber, NOE, SCCP, Skype for Business, SIP, SVP, Vocera, and Wi-Fi
calling ALGs. Use the WebUI or CLI to configure user roles for any of the ALGs.

In the WebUI

To configure user roles for ALGs:

1. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies.

2. In the Policies tab, click the + icon to add a policy.

3. For Policy Name, enter a name.

4. For Policy Type, select Session.

5. Click Submit.

6. Select the newly added policy.

7. In Policies > <custom-policy>, click the + icon to add a new rule.
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8. Select Access Control option as the rule type.

9. Click OK.

10.Under Roles, configure the following settings:

a. For IP version, select IPv4.

b. For Source, select any.

c. For Destination, select any.

d. For Service, select service, then the correct voice or video ALG service. See Table 207 and Table 208 for
service names for all ALGs:

ALG Service Name

NOE l svc-noe

l sip-noe-oxo

SIP l svc-sip-tcp

l svc-sip-udp

SIPS svc-sips

SVP svc-svp

VOCERA svc-vocera

SCCP svc-sccp

H.323 l svc-h323-tcp

l svc-h323-udp

Table 207: Services for ALGs

ACL Service Name

DHCP svc-dhcp

TFTP svc-tftp

ICMP svc-icmp

DNS svc-dns

Table 208: Other Services for the ALGs

e. For Action, select permit.

f. For 802.1p priority, select a value. -- denotes lowest priority. 7 denotes highest priority.

g. Click Submit. Repeat steps 1 to 5 to add ACLs for more VoIP protocols.

11.Select the Roles tab. Click the + icon to add a user role.

12.In the New Role window, for Name, enter a name for the user role.



13.Click Submit.

14.Select the newly added role.

15.In the Roles > <custom-role> section, click Show Advanced View. Configure the following settings:

a. Under Policies, click the + icon.

b. In the Add Policy window, select the Add an existing policy option.

c. In the Policy name drop-down list, select the previously-configured policy name.

d. Click Submit.

e. Under Policies, click the + icon.

f. In the Add Policy window, select the Add an existing policy option.

g. In the Policy name drop-down list, select control.
h. Click Submit.

16.Click Pending Changes.

17.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To configure user roles for ALGs:
(host) [md] (config) #ip access-list session <policy-name>

(host) ^[md] (config-submode) #any any <service-name> permit queue high

To map the policy name to the user role:
(host) [md] (config) #user-role <role-name>

(host) ^[md] (config-submode) #access-list session <policy-name>

Replace the following strings:

l policy-name with a string that you want to identify the roles policy

l role-name with the name you want to identify the voice user role

l service-name with any of the service names from Table 206

Using the User-Derivation Rules
The user role can be derived from attributes from the client’s association with an AP. For VoIP phones, you can
configure the devices to be placed in their user role based on the SSID or the OUI of the client’s MAC address.

User-derivation rules are executed before the client is authenticated.

In the WebUI

To derive a role based on SSID:

1. In the Managed Network node hierarchy, navigate to Configuration > Authentication > User Rules.

2. In User Rules Summary, click the + icon.

3. In the Add New User Rule window, enter a name for the user rule and click Submit.

4. In User Rules Summary, select the name of the user rule to configure the rule set.

5. In Rules-set, click the + icon and configure the following settings:

a. For Set type, select Role from the drop-down list.

b. For Rule type, select ESSID.

c. For Condition, select equals.

d. For Value, enter the SSID used for the phones.

e. For Roles, select the user role previously created.
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6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To derive a role based on SSID:
(host) [md] (config) #aaa derivation-rules user <name of rule-set>

(host) ^[md] (config-submode) #set role condition essid equals <ssid-name> set-value <The

value that the role/VLAN should be set to>

In the WebUI

To derive a role based on MAC OUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Authentication > User Rules.

2. In User Rules Summary, click the + icon.

3. In the Add New User Rule window, enter a name for the user rule and click Submit.

4. In User Rules Summary, select the name of the user rule to configure the rule set.

5. In Rules-set, click the + icon and configure the following settings:

a. For Set type, select Role from the drop-down list.

b. For Rule type, select MAC Address.

c. For Condition, select contains.

d. For Value, enter the first three octets (the OUI) of the MAC address of the phones (for example, the
Spectralink OUI is 00:09:7a)

e. For Roles, select the user role previously created.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To derive a role based on MAC OUI:
(host) [md] (config) #aaa derivation-rules user <name of rule-set>

(host) ^[md] (config-submode) #set role condition macaddr contains <xx:xx:xx:xx:xx:xx> set-

value <The value that the role/VLAN should be set to>

Additional Video Configurations
You can configure ArubaOS to reliably and efficiently stream video traffic over WLAN. This new method allows
you to stream video traffic reliably without much distortion. To ensure that video data is transmitted reliably,
dynamic multicast optimization techniques are used.

Although the dynamic multicast optimization conversion generates more traffic, that traffic is buffered by the
AP and delivered to the client when the client emerges from power-save mode.

Configuring Video over WLAN enhancements
To configure video over WLAN enhancements:

l Enable WMM in the WLAN SSID profile.

l Enable IGMP proxy or IGMP snooping in the interface VLAN.

l Configure an ACL to set a DSCP value same as the wmm-vi-dscp value in the WLAN SSID profile for
prioritizing the multicast video traffic.

l Enable dynamic multicast optimization in the virtual AP profile.



l Configure the dynamic multicast optimization threshold in the virtual AP profile. The maximum
number of high throughput stations in a multicast group. The optimization will stop if the number exceeds
the threshold value.

l Enable multicast rate optimization in the WLAN SSID profile to support higher data rate for multicast
traffic in the absence of dynamic multicast optimization. Dynamic multicast optimization takes precedence
over multicast rate optimization up to the configured threshold value.

Configuring the Video Multicast Rate Optimization parameter overrides the configuration of BC/MC Rate
Optimization parameter for VI-tagged multicast traffic. Multicast traffic that is not VI-tagged behaves the same with
BC/MC as before. If multicast rate is not set, all traffic behaves the same.

l Enable video aware scan in the ARM profile. This ensures that AP does not scan when a video stream is
active.

l Optionally, you can configure and apply the WMM bandwidth management profile in the virtual AP
profile. The total bandwidth share should not exceed 100 percent.

l Enable multicast shaping in the WMM bandwidth management profile to shape the sudden traffic from
the source.

Prerequisites
l You will need the Policy Enforcement Firewall Next Generation (PEFNG) license to enable dynamic multicast

optimization.

In the WebUI
To configure video over WLAN enhancements:

1. Enable IGMP proxy or IGMP snooping on the managed device. To enable IGMP proxy:

a. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > VLANs.

b. In VLANs, select an existing VLAN.

c. In VLANs > <vlan-name>, select an existing VLAN ID.

d. In the IPv4 tab, expand IGMP and select Enabled from the Enable IGMP drop-down list.

e. In the Enable IGMP proxy drop-down list, select Enabled.

f. In the Proxy interface option, select Interface Gigabitethernet and the appropriate interface from
the drop-down list.

g. Click Submit.

h. Click Pending Changes.

i. In the Pending Changes window, select the check box and click Deploy changes.

To enable IGMP snooping:

a. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > VLANs.

b. In VLANs, select an existing VLAN.

c. In VLANs > <vlan-name>, select an existing VLAN ID.

d. In the IPv4 tab, expand IGMP and select Enabled from the Enable IGMP drop-down list.

e. In the Enable IGMP snooping drop-down list, select Enabled.

f. Click Submit.

g. Click Pending Changes.

h. In the Pending Changes window, select the check box and click Deploy changes.

2. Enable wireless multimedia and set a DSCP value for video traffic:

a. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.
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b. In All Profiles, expand Wireless LAN > SSID. Select the default profile.
This example uses the default profile.

c. In SSID Profile, select the Wireless Multimedia (WMM) check box.

d. In the DSCP mapping for WMM video AC (0-63) field, enter the DSCP value (integer number).

e. Click Save.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy changes.

3. Create an ACL on the managed device with the values equivalent to the DSCP mappings to prioritize the
video traffic:

a. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies.

b. In the Policies tab, click the + icon to add a policy.

c. Enter the appropriate values in Policies > <custom-policy> to match the DSCP mapping values.

d. Click Pending Changes.

e. In the Pending Changes window, select the check box and click Deploy changes.

You can also add this ACL to any user role or port. To apply the ACL to a user role:

a. In the Managed Network node hierarchy, select the Roles tab and click the + icon to add a user role.

b. In the New Role window, for Name, enter a name for the user role.

c. Click Submit.

d. Select the newly added role.

e. In the Roles > <custom-role> section, click Show Advanced View. Configure the following settings:

f. Under Policies, click the + icon.

g. In the Add Policy window, select the Add an existing policy option.

h. In the Policy name drop-down list, select the previously-configured policy name.

i. Click Submit.

j. Click Pending Changes.

k. In the Pending Changes window, select the check box and click Deploy changes.

To apply the ACL to a port:

a. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > Ports.

b. In Ports, select an upstream port.

c. Under the VLAN Policy drop-down list, select the ACL.

d. Click Submit.

e. Click Pending Changes.

f. In the Pending Changes window, select the check box and click Deploy changes.

4. Configure dynamic multicast optimization for video traffic on a virtual AP profile:

a. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

b. In All Profiles, expand Wireless LAN > Virtual AP. Select the default profile.
This example uses the default profile.

c. In Virtual AP profile, expand Broadcast/Multicast.

d. Select the Dynamic Multicast Optimization (DMO) check box.

e. Click Save.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy changes.

5. Configure multicast rate optimization for the video traffic:



a. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

b. In All Profiles, expand Wireless LAN > SSID. Select the default profile.
This example uses the default profile.

c. In SSID Profile, select the BC/MC Rate Optimization check box.

d. Select an option from the Video Multicast Rate Optimization drop-down list.

e. Click Save.

f. Click Pending Changes.

g. In the Pending Changes window, select the check box and click Deploy changes.

Configuring the Video Multicast Rate Optimization parameter overrides the configuration of BC/MC Rate
Optimization parameter for VI-tagged multicast traffic. Multicast traffic that is not VI-tagged behaves the same with
BC/MC as before. If multicast rate is not set, all traffic behaves the same.

6. Configure ARM scanning for video traffic:

a. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

b. In All Profiles, expand RF Management > Adaptive Radio Management (ARM). Select the
default-a profile.
This example uses the default-a profile.

c. In Adaptive Radio Management (ARM) profile, expand Scanning and select the VoIP Aware Scan
check box.

d. Click Save.

e. Click Pending Changes.

f. In the Pending Changes window, select the check box and click Deploy changes.

7. Configure and apply bandwidth management profile:

a. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

b. In All Profiles, expand QOS > WMM Traffic management.

c. In WMM Traffic management profile: New Profile, enter the profile name, select the Enable
Shaping Policy check box, and enter the bandwidth share values.

d. Click Save.

e. Click Pending Changes.

f. In the Pending Changes window, select the check box and click Deploy changes.

This step is optional.

Ensure that you configure the WMM traffic management profile to the virtual AP profile, if you have configured the
virtual AP traffic management profile.

After you configure the WMM bandwidth management profile, apply it to the virtual AP profile.

8. Enable multicast shaping on the firewall:

a. In the Managed Network node hierarchy, navigate to Configuration > Services > Firewall.
b. In Global Settings, select Enabled from the Multicast automatic shaping drop-down list.

c. Click Submit.

d. Click Pending Changes.

e. In the Pending Changes window, select the check box and click Deploy changes.
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In the CLI
To configure the video over WLAN enhancements:

1. Enable IGMP proxy or IGMP snooping on the managed device.

To enable IGMP proxy:
(host) [md] (config) #interface vlan <id>

(host) ^[md] (config-submode)#ip igmp proxy gigabitethernet <slot/module/port>

To enable IGMP snooping:
(host) [md] (config) #interface vlan <id>

(host) ^[md] (config-submode)#ip igmp snooping

2. Enable wireless multimedia and set a DSCP value for video traffic:
(host) [md] (config)#wlan ssid-profile default

(host) ^[md] (SSID Profile “default”)#wmm

(host) ^[md] (SSID Profile “default”)#wmm-vi-dscp <value>

Setting the DSCP value tags the content as video stream that the APs can recognize.

3. Create an ACL on the managed device with the values equivalent to the DSCP mappings to prioritizes video
traffic. The following ACL prioritizes the multicast traffic from the specified multicast group on the managed
device. You can also add this ACL to any user role or port:

(host) [md] (config) #ip access-list session mcast_video_acl

(host) ^[md] (config-submode

)#any network 224.0.0.0 255.0.0.0 any permit tos 40 queue high dot1p-priority 5

a. To apply the ACL to a user role:

This example uses the user role authenticated.
(host) [md] (config) #user-role authenticated access-list session mcast_video_acl

b. To apply the ACL to a port:
(host) [md] (config) #interface gigabitethernet <slot/module/port>

(host) ^[md] (config-submode)#ip access-group mcast_video_acl session

4. Configure dynamic multicast optimization for video traffic on a virtual AP profile:
(host) [md] (config)#wlan virtual-ap default

(host) ^[md] (Virtual AP Profile “default”)#dynamic-mcast-optimization

5. Configure the dynamic multicast optimization threshold value:
(host) ^[md] (Virtual AP Profile “default”)#dynamic-mcast-optimization-thresh 6

6. Configure multicast rate optimization for video traffic:
(host) [md] (config) #wlan ssid-profile default

(host) ^[md] (SSID Profile "default") #mcast-rate-opt

7. Configure ARM scanning for video traffic:

In the rf arm-profile, enable the video-aware-scan option. This prevents APs from scanning when a video
traffic is active:
(host) [md] (config) #rf arm-profile default-a

(host) ^[md] (Adaptive Radio Management (ARM) profile "default-a") #video-aware-scan

8. Configure and apply a bandwidth management profile:

Ensure that you configure the WMM traffic management profile to the virtual AP profile, if you have configured the
virtual AP traffic management profile.

a. Enable a bandwidth shaping policy so that the allocated bandwidth share is appropriately used:
(host) [md] (config) #wlan wmm-traffic-management-profile default

(host) ^[md] (WMM Traffic management profile "default") # enable-shaping

b. Set a bandwidth percentage for the following categories:



(host) ^[md] (WMM Traffic management profile "default") # background 10

(host) ^[md] (WMM Traffic management profile "default") # best-effort 20

(host) ^[md] (WMM Traffic management profile "default") # video 50

(host) ^[md] (WMM Traffic management profile "default") # voice 20

After you configure the WMM bandwidth management profile, apply it to the virtual AP profile:
(host) [md] (config) #wlan virtual-ap default

(host) ^[md] (Virtual AP profile "default") #wmm-traffic-management-profile default

9. Enable multicast shaping on the firewall:
(host) [md] (config) #firewall

(host) ^[md] (config-submode) #shape-mcast

Working with QoS for Voice and Video
Quality of Service (QoS) settings for voice and video applications are configured when you configure firewall
roles and policies.

Understanding Wi-Fi Multimedia
Wi-Fi Multimedia (WMM), is a Wi-Fi Alliance specification based on the IEEE 802.11e wireless QoS standard.
WMM works with 802.11a, b, g, n, and ac physical layer standards.

WMM supports four access categories (ACs); voice, video, best effort, and background. Table 209 shows the
mapping of the WMM access categories to 802.1p priority values. The 802.1p priority value is contained in a
two-byte QoS control field in the WMM data frame.

Priority 802.1p Priority WMM Access Category

Lowest 1 Background

2

0 Best effort

3

4 Video

5

6 Voice

Highest 7

Table 209: WMM Access Category to 802.1p Priority Mapping

In non-WMM, or hybrid environments where some clients are not WMM-capable, ArubaOS uses voice and best
effort to prioritize traffic from these clients. Unscheduled Automatic Power Save Delivery (U-APSD) is a
component of the IEEE 802.11e standard that extends the battery life on voice over WLAN devices. When
enabled, clients trigger the delivery of buffered data from the AP by sending a QoS data or Qos null data frame.
For the environments in which the wireless clients support WMM, you can enable both WMM and U-APSD in
the SSID profile.
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Enabling WMM
You can use the WebUI or CLI to enable WMM for wireless clients.

In the WebUI

To enable WMM for wireless clients:

1. In the Managed Network node hierarchy, navigate to Configuration > System> Profiles.

2. In All Profiles, expand Wireless LAN > Virtual AP > default > SSID.
This example uses the default profile.

3. In SSID Profile, select the Wireless Multimedia (WMM) check box. Or, select the Wireless Multimedia
U-APSD (WMM-UAPSD) Powersave check box if you want to enable WMM in power save mode.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To enable WMM for wireless clients:
(host) [md] (config) #wlan ssid-profile default

(host) ^[md] (SSID Profile "default") #wmm

(host) ^[md] (SSID Profile "default") #wmm-uapsd

Configuring WMM AC Mapping
The IEEE 802.11e standard defines the mapping between WMM ACs and Differentiated Services Code Point
(DSCP) tags. The WMM AC mapping commands allow you to customize the mapping between WMM ACs and
DSCP tags to prioritize various traffic types. You apply and configure WMM AC mappings to a WMM-enabled
SSID profile.

DSCP classifies packets based on network policies and rules, not priority. The configured DSCP value defines
per hop behaviors (PHBs). The PHB is a 6-bit value added to the 8-bit Differentiated Services (DS) field of the IP
packet header. The PHB defines the policy and service applied to a packet when traversing the network. You
configure these services in accordance with your network policies. Table 210 shows the default WMM AC to
DSCP decimal mappings and the recommended WMM AC to DSCP mappings.

DSCP Decimal Value WMM Access Category

8 Background

16

0 Best effort

24

32 Video

Table 210: WMM Access Category to DSCP Mappings



DSCP Decimal Value WMM Access Category

40

48 Voice

56

By customizing WMM AC mappings, both the managed device and AP maintain a customized WMM AC
mapping table for each configured SSID profile. All packets received are matched against the entries in the
mapping table and prioritized accordingly. The mapping table contains information for both upstream (client
to AP) and downstream (AP to client) traffic.

When planning your mappings, make sure that any immediate switch or router does not have conflicting
802.1p or DSCP configuration or mapping. If this occurs, your traffic may not be prioritized correctly.

To view the mapping settings, execute the following command:
(host) [mynode] #show wlan ssid-profile <profile>

In the WebUI

To map WMM AC with DSCP:

1. In the Managed Network node hierarchy, navigate to Configuration > System> Profiles.

2. In All Profiles, expand Wireless LAN > Virtual AP > default > SSID.
This example uses the default profile.

3. In SSID Profile, select the Wireless Multimedia (WMM) check box.

4. Modify the DSCP mapping settings, as needed:

n DSCP mapping for WMM voice AC (0-63)—DSCP map for voice traffic

n DSCP mapping for WMM video AC (0-63)—DSCP map for video traffic

n DSCP mapping for WMM best-effort AC (0-63)—DSCP map for best-effort traffic

n DSCP mapping for WMM background AC (0-63)—DSCP map for background traffic

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

To map WMM AC with DSCP:
(host) [md] (config) #wlan ssid-profile <profile>

(host) ^[md] (SSID Profile "default") #wmm-be-dscp <wmm-be-dscp>

(host) ^[md] (SSID Profile "default") #wmm-bk-dscp <wmm-bk-dscp>

(host) ^[md] (SSID Profile "default") #wmm-vi-dscp <wmm-vi-dscp>

(host) ^[md] (SSID Profile "default") #wmm-vo-dscp <wmm-vo-dscp>

The WMM-DSCP mapping functionality has the following features:

l Default mappings are not there for a newly created SSID profile and for a factory default managed device
running an ArubaOS 8.0 image.

l If the mapping has no value, the original DSCP for upstream traffic is retained.

l The maximum number of values that can be configured for WMM-DSCP is 8.

l For the upstream traffic, if the mapping exists and incoming DSCP value matches one of the mapped
values, then the DSCP value is retained.
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l For the upstream traffic, if the mapping exists and incoming DSCP value does not match any of the mapped
values, then the DSCP value is overwritten with the first value in the WMM-DSCP list

l For wireless-to-wireless traffic, if the AC of the incoming packet has no mapping and the incoming DSCP
value is mapped to a different AC, then the DSCP value is retained and WMM priority is changed to the
corresponding AC where incoming DSCP is mapped.

Configuring DSCP Priorities
You can configure DSCP priorities for WMM packets in the following ways:

l Configure the DSCP mappings in the SSID profile

l Set a ToS value in the ACL

l Set the ToS value and the 802.1p priority in the ACL

Setting a ToS value in the ACL overrides the default DSCP mappings configured in the SSID profile. Configuring
a DSCP priority in both the L2 and L3 header prioritizes the WMM packets with the higher value. For example,
you can have different ToS values set for different voice traffic in a network. To prioritize all of them in the
voice queue, we can set the 802.1p priority to voice.

Consider a deployment where Cisco Softphone, Microsoft Skype for Business, and Avaya Scopia are configured
with the following DSCP :

l Cisco Softphone - DSCP 46

l Microsoft Skype for Business - DSCP 44

l Avaya Scopia - DSCP 42

In the absence of doing anything, all of the DSCP above would map into the video queue. To map all the traffic
into voice queue, you can use the following ACL configuration:
(host) [md] (config) #wlan ssid-profile VOICE

(host) ^[md] (SSID Profile "VOICE") #wmm-vo-dscp 46

(host) ^[md] (SSID Profile "VOICE") #!

(host) ^[md] (config) #ip access-list session VOICE

(host) ^[md] (config-submode)#any destination <SKYPE4B_SERVER> <SKYPE4B_PORTS> permit tos 44

dot1p-priority 6

(host) ^[md] (config-submode)#any destination [SCOPIA_SERVER] [SCOPIA _PORTS] permit tos 42

dot1p-priority 6

You must know the ports on which each traffic is sent so that the correct traffic is identified.

Configuring Dynamic WMM Queue Management
Traditional wireless networks provide all clients with equal bandwidth access. However, delays or reductions in
throughput can adversely affect voice and video applications, resulting in disrupted VoIP conversations or
dropped frames in a streamed video. Thus, data streams that require strict latency and throughput need to be
assigned higher traffic priority than other traffic types.

The Wi-Fi Alliance defined the Wi-Fi Multimedia (WMM) standard in response to industry requirements for QoS
support for multimedia applications for wireless networks. This is defined as per the IEEE 802.11e standards.

WMM requires:

l the access point be Wi-Fi Certified and has WMM enabled

l the client device be Wi-Fi Certified

l the application support WMM



Enhanced Distributed Channel Access

WMM provides media access prioritization through Enhanced Distributed Channel Access (EDCA). EDCA defines
four ACs to prioritize traffic; voice, video, best effort, and background. These ACs correspond to 802.1p priority
tags, as shown in Table 211.

WMM Access Category Description 802.1p Tag

Voice Highest priority 7, 6

Video Prioritize video traffic above other data traffic 5, 4

Best Effort Traffic from legacy devices or traffic from applications or
devices that do not support QoS

0, 3

Background Low priority traffic (file downloads, print jobs) 2, 1

Table 211: WMM Access Categories and 802.1p Tags

While the WMM ACs designate specific types of traffic, you can determine the priority of the ACs. For example,
you can choose to give video traffic the highest priority. With WMM, applications assign data packets to an AC.
In the client, the data packets are then added to one of the transmit queues for voice, video, best effort, or
background.

WMM is an extension to the Carrier Sense Multiple Access with Collision Avoidance (CSMA/CA) protocol’s
Distributed Coordination Function (DCF). The collision resolution algorithm responsible for traffic prioritization
depends on the following configurable parameters for each AC:

l arbitrary inter-frame space number (AIFSN)

l minimum and maximum contention window (CW) size

For each AC, the backoff time is the sum of the AIFSN and a random value between 0 and the CW value. The AC
with the lowest backoff time is granted the opportunity to transmit (TXOP). Frames with the highest-priority AC
are more likely to get TXOP, because they tend to have the lowest backoff times (a result of having smaller
AIFSN and CW parameter values). The value of the CW varies through time as the CW doubles after each
collision up to the maximum CW. The CW is reset to the minimum value after successful transmission. In
addition, you can configure the TXOP duration for each AC.

On the managed device, you configure the AC priorities in the WLAN EDCA parameters profile. There are two
sets of EDCA profiles you can configure:

l AP parameters affecting traffic from the AP to the client.

l STA parameters affecting traffic from the client to the AP.

Configure EDCA parameters

Use the following procedure to define an Enhanced Distributed Channel Access (EDCA) profile for APs or for
clients (stations).

1. In the Managed Network node hierarchy, navigate to Configuration > System> Profiles.

2. In All Profiles, expand Wireless LAN > SSID > default.
This example uses the default profile.

3. Select the EDCA Parameters Station or EDCA Parameters AP profile. Configure the EDCA profile based
on the parameters described in Table 212.

4. Click Save.
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5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Best Effort Set the following parameters to define the best effort queue:

l aifsn: arbitrary inter-frame space number. Range: 1-15.

l ecw-max: the exponential (n) value of the maximum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 1-15.

l ecw-min: the exponential (n) value of the minimum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 0-15.

l txop: transmission opportunity, in units of 32 microseconds. Divide the desired
transmission duration by 32 to determine the value to configure. For example, for
a transmission duration of 3008 microseconds, enter 94 (3008/32). Range: 0-
2047.

l acm: this parameter specifies mandatory admission control. With a value of 1, the
client reserves the access category through traffic specification (TSPEC) signaling.
A value of 0 disables this option.

Background Set the following parameters to define the background queue:

l aifsn: arbitrary inter-frame space number. Range: 1-15.

l ecw-max: the exponential (n) value of the maximum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 1-15.

l ecw-min: the exponential (n) value of the minimum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 0-15.

l txop: transmission opportunity, in units of 32 microseconds. Divide the desired
transmission duration by 32 to determine the value to configure. For example, for
a transmission duration of 3008 microseconds, enter 94 (3008/32). Range: 0-
2047.

l acm: this parameter specifies mandatory admission control. With a value of 1, the
client reserves the access category through traffic specification (TSPEC) signaling.
A value of 0 disables this option.

Video Set the following parameters to define the background queue:

l aifsn: trbitrary inter-frame space number. Range: 1-15.

l ecw-max: The exponential (n) value of the maximum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 1-15.

l ecw-min: the exponential (n) value of the minimum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 0-15.

l txop: transmission opportunity, in units of 32 microseconds. Divide the desired
transmission duration by 32 to determine the value to configure. For example, for
a transmission duration of 3008 microseconds, enter 94 (3008/32). Range: 0-
2047.

l acm: this parameter specifies mandatory admission control. With a value of 1, the
client reserves the access category through traffic specification (TSPEC) signaling.
A value of 0 disables this option.

Voice Set the following parameters to define the background queue:

Table 212: EDCA Parameters Station and EDCA Parameters AP Profile Settings



Parameter Description

l aifsn: trbitrary inter-frame space number. Range: 1-15.

l ecw-max: the exponential (n) value of the maximum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 1-15.

l ecw-min: the exponential (n) value of the minimum contention window size, as
expressed by 2n-1. A value of 4 computes to 24-1 = 15. Range: 0-15.

l txop: transmission opportunity, in units of 32 microseconds. Divide the desired
transmission duration by 32 to determine the value to configure. For example, for
a transmission duration of 3008 microseconds, enter 94 (3008/32). Range: 0-
2047.

l acm: this parameter specifies mandatory admission control. With a value of 1, the
client reserves the access category through traffic specification (TSPEC) signaling.
A value of 0 disables this option.

Configure EDCA Profile

Use the following procedure to define an Enhanced Distributed Channel Access (EDCA) profile for APs or for
clients (stations).
(host) [md] (config) #wlan edca-parameters-profile {ap|station} <profile>

(host) ^[md] (EDCA Parameters profile (AP) "default") #{background|best-effort|video|voice}

[acm][aifsn <number>] [ecw-max <exponent> [ecw-min <exponent>] [txop <number>]

To associate the EDCA profile instance to a SSID profile:
(host) [md] (config) #wlan ssid-profile <profile>

(host) ^[md] (SSID Profile "<profile>") #edca-parameters-profile {ap|sta} <profile>

Unified Communication and Collaboration
This section describes the Unified Communication and Collaboration (UCC) feature. The Unified
Communications Manager (UCM) is the core solution component of this feature. UCC addresses the onslaught
of mobile devices that use voice, video, and collaboration applications. UCC solution reduces the cost of
infrastructure for enterprise communication and collaboration.

UCC continues to support most of the existing functionality offered by ArubaOS 6.x. This section includes the
following topics:

l UCC Application in ArubaOS 8.0 on page 874

l UCC Value Additions in Mobility Master on page 874

l UCC Changes from ArubaOS 6.x on page 874

l UCC Features Deprecated in ArubaOS 8.0 on page 875

l Prerequisites to Enable UCC on page 875

l Multi-ALG Support on page 878

l UCC ALG Configuration

l View UCC Information on page 880

l Intelligent Call Handling on page 881

l RTP Analysis on page 882

l AppRF Integration with ALGs and User Role on page 883

l Microsoft® Lync/Skype for Business on page 886

l Cisco Jabber on page 896

l Wi-Fi Calling on page 901
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l UCC Dashboard on page 904

l UCC-AirWave Integration on page 909

l UCC Limitations on page 911

l Upgrade UCM Loadable Service Module on page 911

UCC Application in ArubaOS 8.0
Starting from ArubaOS 8.0, UCM runs as a loadable service module on Mobility Master. UCC supports various
applications like Apple FaceTime, Alcatel-Lucent New Office Environment (NOE), Microsoft® Lync/Skype for
Business, Cisco Jabber, Cisco Skinny Call Control Protocol (SCCP), SpectraLink Voice Priority (SVP), SIP, H.323,
Vocera, and Wi-Fi Calling. UCC application on Mobility Master implements the VoIP Application Layer Gateway
(ALG) to support both encrypted and non-encrypted VoIP protocols. UCC application uses the OpenFlow
infrastructure to receive the signaling messages from the managed devices and also install and delete flows on
the managed devices for calls made.

In addition, UCC is supported on a stand-alone controller.

UCC Value Additions in Mobility Master
The following is a list of UCC value additions in Mobility Master:

l Enables VoIP ALGs to run as a service on Mobility Master and managed devices need not run the same. This
results in better scalability.

l Enables real-time analysis of VoIP calls in upstream direction. This is the real-time analysis and UCC call
quality statistics calculated based on VoIP stream captured at the managed device.

l Supports Loadable Service Module. UCM is a Loadable Service Module. ALGs are completely decoupled
from the managed devices. This enables faster innovation of VoIP services such as introduction of new
ALGs and enhancements to existing features as they will become independent of the ArubaOS release
version.

l Provides a solution to the fanout problem in Lync/Skype for Business SDN API. In ArubaOS 6.x, Lyn/Skype
for Business SDN Manager sent call information messages to every local controller in the network,
regardless of whether the local controller is involved in the call or not. This additional processing is an
unnecessary overhead on the local controller. In addition, the bandwidth utilization between the data
center and remote location is not efficient. With the Mobility Master deployment, Lync/Skype for Business
SDN Manager sends the call information messages to Mobility Master only.

l Provides aggregation of statistical information of call-related data at a centralized entity.

UCC Changes from ArubaOS 6.x
The following is a list of UCC changes from ArubaOS 6.x to ArubaOS 8.0:

l In ArubaOS 6.x, VoIP ALGs run on the respective local controllers that parse the signaling messages,
dynamically opens sessions in firewall, prioritizes traffic, and provide visibility. In ArubaOS 8.0, VoIP ALGs do
not run from the managed devices. They run as an application on Mobility Master. In a stand-alone
controller deployment, the VoIP ALGs run on the stand-alone controller itself.

l UCC running on Mobility Master uses OpenFlow infrastructure to receive signaling packets on Mobility
Master, parse them, open sessions in the firewall, and prioritizes them.

l Visibility for all supported UCC applications are provided from the centralized Mobility Master dashboard.

l ArubaOS 8.0 supports Cisco Jabber and Wi-Fi Calling.

l Unlike ArubaOS 6.X, where ALGs use Wi-Fi Multimedia-Differentiated Services Code Point (WMM-DSCP)
mappings in the WLAN SSID profile to set the Type of Service (ToS) for Real-time Transport Protocol (RTP)
and Real-time Transport Control Protocol (RTCP), Mobility Master has ALG-specific Quality of Service (QoS)
configurations.



UCC Features Deprecated in ArubaOS 8.0
The following are the features deprecated in ArubaOS 8.0:

l Basic Service Set (BSS) transition and force BSS transition.

l Call count, bandwidth, and Traffic Specification (TSPEC)-based call admission control.

l Classify media action in ACL for media classification – Microsoft® Lync/Skype for Business calls will
automatically get prioritized without the need for classify media ACLs.

l SIP session timer.

l SIP dial plans.

l WMM-DSCP override setting in the SSID profile.

l Stateful ALG settings in global firewall options. These settings are now available in Mobility Master under
the Configuration > System > Profiles > All Profiles > UCC profile.

l Lync/Skype for Business traffic control profile.

l Web Server port configuration for Lync/Skype for Business SDN API. The Mobility Master uses 32000 as the
default port now.

l The Monitoring tab in the WebUI.

l The show voice commands.

l sip-authentication-role parameter in AAA profile.

l voice-aware parameter in AAA authentication 802.1X profile.

Prerequisites to Enable UCC

OpenFlow Controller Configuration
Enable OpenFlow on Mobility Master and managed devices. You must enable this in the /mm node hierarchy.

In the WebUI

The following procedure configures OpenFlow on Mobility Master using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile. Select openflow-controller.

3. In openflow-controller, select the ofc-state check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands configure OpenFlow on Mobility Master using the CLI:
(host) [mm] (config) #openflow-controller

(host) ^[mm] (openflow-controller) #openflow-controller-enable

(host) ^[mm] (openflow-controller) #write memory

OpenFlow Profile Configuration on Managed Devices
Bind the user VLANs to the OpenFlow profile on the managed devices. You must bind this in the /md node
hierarchy.

In the WebUI

The following procedure binds the user VLANs to the OpenFlow profile on the managed devices using the
WebUI:
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1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile. Select Openflow-profile.

3. In Openflow-profile, select the State check box.

4. In controller-ip, enter the Mobility Master IP address and port number.

5. In bind-vlan, enter the user VLAN to the current list.

6. Click Save.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands bind the user VLANs to the OpenFlow profile on the managed devices using the CLI:
(host) [md](config) #openflow-profile

(host) ^[md](Openflow-profile) #openflow-enable

(host) ^[md](Openflow-profile) #controller-ip <MM-ip> <port>

(host) ^[md](Openflow-profile) #bind-vlan <list of user vlans>

(host) ^[md](Openflow-profile) #write memory

OpenFlow in User Role and Virtual AP Configuration
Enable OpenFlow in the user-role and the virtual AP profile. You must this in /md node hierarchy.

In the WebUI

The following procedure enables OpenFlow in the user-role and virtual AP using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies.

2. In the Roles tab, select an existing role.

3. In the Roles > <custom-role> section, click Show Advanced View.

4. Under More, expand Network.

5. In the Open flow drop-down list, select Enabled.

6. Click Submit.

7. Navigate to Configuration > System > Profiles.

8. In All Profiles, expand Wireless LAN > Virtual AP. Select the default profile.
This example uses the default profile.

9. In Virtual AP profile, expand Advanced.

10.Select the Openflow Enable check box.

11.Click Save.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands enable OpenFlow in the user-role and virtual AP using the CLI:
(host) [md] (config) #user-role <user-role>

(host) ^[md] (config-submode)#openflow-enable

(host) ^[md] (config-submode)#!

(host) ^[md] (config) #wlan virtual-ap <virtual-ap>

(host) ^[md] (Virtual AP profile "<virtual-ap>") #openflow-enable

(host) ^[md] (Virtual AP profile "<virtual-ap>") #write memory



Management Server Profile Configuration
Configure the management server profile. This enables AMON feeds to be sent to Mobility Master for various
statistics. You must configure this in the /md node hierarchy or the sub-nodes of /md.

In the WebUI

The following procedure configures management server profile using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile. Select Mgmt Config.

3. In Mgmt Config profile, click the + icon.

4. In the Profile name field, enter the name of the management server profile.

5. Select the following check boxes:

n Stats
n Sessions
n Monitored Info - Add/Update
n Monitored Info - Deletion
n Monitored Info - Periodic Snapshot

6. Click Save.

7. Navigate to Configuration > System > More.

8. In MON Receivers, click the + icon.

9. In New MON Receivers, enter the following details:

a. In the Server field, enter the Mobility Master IP address.

b. In the Profile list drop-down list, select the newly created management server profile.

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands configure management server profile using the CLI:
(host) [md] (config) #mgmt-server profile <profile-name>

(host) ^[md] (Mgmt Config profile "<profile-name>") #stats-enable

(host) ^[md] (Mgmt Config profile "<profile-name>") #sessions-enable

(host) ^[md] (Mgmt Config profile "<profile-name>") #monitored-info-enable

(host) ^[md] (Mgmt Config profile "<profile-name>") #monitored-info-del-enable

(host) ^[md] (Mgmt Config profile "<profile-name>") #monitored-info-snapshot-enable

(host) ^[md] (Mgmt Config profile "<profile-name>") #!

(host) ^[md] (config) #mgmt-server primary-server <MM-IP> profile <profile-name>

(host) ^[md] (config) #write memory

Deep Packet Inspection Configuration
Enable Deep Packet Inspection (DPI) on the managed devices if your deployment has Cisco Jabber clients. You
must enable this in the /md node hierarchy.

In the WebUI

The following procedure enables DPI on the managed devices using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Services > Firewall.
2. Expand Global Settings.

3. In the Enable deep packet inspection drop-down list, select Enabled.
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4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands enable DPI on the managed devices using the CLI:
(host) [md] (config) #firewall

(host) ^[md] (config-submode)#dpi

(host) ^[md] (config) #write memory

If DPI is enabled, either there should be an explicit ACL to permit RTP/RTCP traffic or an app-based ACL to permit
media traffic. For more information, see AppRF Integration with ALGs and User Role on page 883.

Firewall Visibility Configuration
Enable firewall visibility on the managed devices. This is an optional setting. Enable this setting to view traffic
analysis on the Mobility Master dashboard. You must enable this in the /md node hierarchy.

In the WebUI

The following procedure enables firewall visibility on the managed devices using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Services > Firewall.
2. Expand Global Settings.

3. In the Enable firewall visibility drop-down list, select Enabled.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following command enables firewall visibility on the managed devices using the CLI:
(host) [md] (config) #firewall-visibility

(host) ^[md] (config) #write memory

Multi-ALG Support
In ArubaOS 8.0, multiple applications running simultaneously on the same client device can be identified and
prioritized. A maximum of 10 applications running simultaneously on client device is supported. The multi-ALG
feature is enabled by default in Mobility Master.

UCC ALG Configuration
The UCC ALGs must be configured from the /mm node hierarchy of Mobility Master. All the ALGs are enabled
by default.

SpectraLink Voice Priority (SVP) ALG is enabled by default. ArubaOS does not have a separate configuration setting for
this ALG.

In the WebUI
The following procedure configures the ALGs using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC to configure various ALGs as described in Table 213.

3. Click Save.



4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

ALG Description

FaceTime ALG
Configuration

Configures the Apple FaceTime ALG. The ALG is enabled by default. The range is 0-63. The
DSCP value for the video session is 34 by default.

H323 ALG
Configuration

Configures the H.323 ALG. The ALG is enabled by default. The range is 0-63. The DSCP
value for the voice session is 46 by default.

Intelligent Call
Handling
Configuration

Configures the Intelligent Call Handling. The setting is enabled by default. The range is 50-
95. The Channel Utilization Threshold is 90 by default.

Jabber ALG
Configuration

Configures the Cisco Jabber ALG. The ALG is enabled by default. Enter the Cisco Unified
Communication Manager IM & Presence server IP. The range is 0-63. The DSCP values for
the voice, video, and app-sharing sessions are 46, 34, and 34, respectively, by default.

NOE ALG
Configuration

Configures the Alcatel-Lucent NOE ALG. The ALG is enabled by default. The range is 0-63.
The DSCP value for the voice session is 46 by default.

Real-Time Analysis
Configuration

Configures the real-time analysis of VoIP calls including upstream real-time analysis. The
setting is enabled by default.

SCCP ALG
Configuration

Configures the Cisco SCCP ALG. The ALG is enabled by default. The range is 0-63. The
DSCP value for the voice session is 46 by default.

SIP ALG
Configuration

Configures the SIP ALG. The ALG is enabled by default. You can enable the SIP Midcall
request timeout and RTCP inactivity settings. The range is 0-63. The DSCP values for
the voice and video sessions are 46 and 34, respectively, by default.

Skybe4B ALG
Configuration

Configures the Microsoft® Lync/Skype for Business ALG. The ALG is enabled by default.
You can set the Lync/Skype for Business SDN listen protocol over HTTP or HTTPS. The
default Lync/Skype for Business SDN API listen port is 32000. Based on the SDN listen
protocol configuration, Mobility Master accepts either HTTP or HTTPS messages from the
Lync/Skype for Business SDN Manager. The DSCP values for the voice, video, and app-
sharing sessions are 46, 34, and 34, respectively, by default. The range is 0-63.

Table 213: ALG Configurations
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ALG Description

UCC Session Idle
Timeout
Configuration

Configures the UCC session idle timeout. On configuring this parameter, if the voice
session is idle for the configured period, UCM aborts the session on the managed device
due to inactivity. The range is 35-250. The default value is 35.

Vocera ALG
Configuration

Configure the Vocera ALG. The ALG is enabled by default. The range is 0-63. The DSCP
value for the voice session is 46 by default.

Wi-Fi Calling
Configuration

Configures the Wi-Fi Calling. Wi-Fi Calling is enabled by default. The range is 0-62. The
DSCP value for the voice session is 46 by default.

dns-pattern–Configure the DNS pattern for the carrier. A maximum of 10 DNS patterns
can be configured.

DNS patterns for known carriers are configured by default. Default built-in patterns are:

l 3 HK - wlan.three.com.hk

l ATT - epdg.epc.att.net

l Rogers - epdg.epc.mnc720.mcc302.pub.3gppnetwork.org

l SmarTone - epdg.epc.mnc006.mcc454.pub.3gppnetwork.org

l Sprint - primgw.vowifi2.spcsdns.net

l T-Mobile - ss.epdg.epc.mnc260.mcc310.pub.3gppnetwork.org

l Verizon - wo.vzwwo.com

If the ePDG FQDN of the carrier does not match with the default patterns, use this option
to configure the DNS pattern for the carrier.

NOTE: The DNS IP address that Mobility Master learns for Wi-Fi Calling age out
automatically, if there was no DNS query or response matching that IP for more than
seven days.

service-provider–Add the service provider name for enhanced visibility.

Table 213: ALG Configurations

In the CLI
The following command configures the ALGs using the CLI:
(host) [mm] (config) #ucc ?

facetime Configure the FaceTime ALG Configuration

h323 Configure the H323 ALG Configuration

ich Configure the Intelligent Call Handling Configuration

jabber Configure the Jabber ALG Configuration

noe Configure the NOE ALG Configuration

rtpa-config Configure the Real-Time Analysis Configuration

sccp Configure the SCCP ALG Configuration

session-idle-timeout Configure the UCC Session Idle Timeout Configuration

sip Configure the SIP ALG Configuration

skype4b Configure the Skype4B ALG Configuration

vocera Configure the Vocera ALG Configuration

wificalling Configure the WiFiCalling Configuration

For more information, see the ucc command in the ArubaOS Command-Line Interface Reference Guide.

View UCC Information
The following commands are available to view UCC client and call information using the CLI:
(host) [mm] #show ucc ?

call-info Show ucc call detailed records (CDRs)



client-info Show ucc client status and record

dns-ip-learning DNS ip learning

facetime Show the FaceTime ALG Configuration

h323 Show the H323 ALG Configuration

ich Show the Intelligent Call Handling Configuration

internal-state UCC internal-state information

jabber Show the Jabber ALG Configuration

noe Show the NOE ALG Configuration

rtpa-config Show the Real-Time Analysis Configuration

rtpa-report Show Real-Time Analysis report

sccp Show the SCCP ALG Configuration

session-idle-timeout Show the UCC Session Idle Timeout Configuration

sip Show the SIP ALG Configuration

skype4b Show the Skype4B ALG Configuration

statistics UCC statistics

trace-buffer Show call trace buffer

vocera Show the Vocera ALG Configuration

wificalling Show the WiFiCalling Configuration

For more information, see the show ucc commands in the ArubaOS Command-Line Interface Reference Guide.

Intelligent Call Handling
ArubaOS 8.0 replaces Call Admission Control with Intelligent Call Handling (ICH). ICH monitors the channel
utilization of all radios of the APs on the managed device. If the channel utilization exceeds beyond a
configurable threshold on a radio, new UCC calls are not prioritized. This is to ensure that existing calls on the
radio are not penalized due to a new call when channel utilization is very high. ICH is enabled by default and
applies to all ALGs supported by UCM.

In the WebUI
The following procedure configures ICH using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC and click Intelligent Call Handling Configuration.

3. In the Intelligent Call Handling Configuration section, configure the following settings:

a. Select the Intelligent Call Handling check box.

b. In the Channel Utilization Threshold text-box, enter the channel utilization value.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands configure ICH using the CLI:
(host) [mm] (config) #ucc ich

(host) ^[mm] (Intelligent Call Handling Configuration) #enable

(host) ^[mm] (Intelligent Call Handling Configuration) #channel-utilization-threshold 90
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RTP Analysis
Mobility Master performs RTP analysis for most VoIP ALG calls in both downstream (at AP) and upstream
direction (at managed device) and captures the quality metrics. The downstream UCC score measures call
quality between the AP and the wireless client in the downstream direction. The upstream UCC score measures
call quality over the wired network between the AP and the managed device in the upstream direction. The
quality metrics captured is applicable for all the active sessions belonging to the same or different ALG running
on that client.

In the WebUI

The following procedure configures RTP analysis using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC and click Real-Time Analysis Configuration.

3. In the Real-Time Analysis Configuration section, configure the settings described in Table 214.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Real-Time Analysis
of VoIP calls

Enables real-time analysis of VoIP calls.
This is the real-time analysis and UCC statistics calculated based on VoIP stream at the
access point.

Upstream Real-
Time Analysis of
VoIP calls

Enables real-time analysis of upstream VoIP calls.
This is the real-time analysis and UCC statistics calculated based on VoIP stream at the
managed device.

Table 214: Real-Time Analysis Configuration Parameters

In the CLI

The following commands configure real-time analysis using the CLI:
(host) [mm] (config) #ucc rtpa-config

(host) ^[mm] (Real-Time Analysis Configuration) #enable

(host) ^[mm] (Real-Time Analysis Configuration) #upstream

(host) ^[mm] (Real-Time Analysis Configuration) #write memory

The upstream and downstream RTP analysis of VoIP calls are enabled by default.

The following command displays the real-time analysis configuration using the CLI:
(host) [mm] #show ucc rtpa-config

Real-Time Analysis Configuration

--------------------------------

Parameter Value Set

--------- ----- ---

Real-Time Analysis of VoIP calls Enabled

Upstream Real-Time Analysis of VoIP calls Enabled

The following command displays the real-time analysis report using the CLI:
(host) [mm] #show ucc rtpa-report

Help: [C] - Metric calculated at the Controller



[A] - Metric calculated at the AP

[E] - Metric calculated End-to-End

Real-Time Analysis Call Quality Report

--------------------------------------

Client(IP) Client(MAC) Client(Name) ALG Jitter(usec)[C] Pkt-loss(%)[C] Delay

(usec)[C]

---------- ----------- ------------ --- --------------- -------------- ------

--------

192.168.201.240 f0:7b:cb:3b:65:5c 1002 SIP 23.700 0.000

101.800

192.168.201.246 00:24:d7:40:a8:58 1003 SIP 30.912 0.000

257.140

UCC Score[C] Jitter(usec)[A] Pkt-loss(%)[A] Delay(usec)[A] UCC Score[A] Forward mode

------------ --------------- -------------- -------------- ------------ ------------

68.366 0.000 0.499 316.400 84.119 decrypt-tunnel

82.551 0.000 0.000 327.478 85.999 decrypt-tunnel

Num Records:2

The following command displays real-time analysis for VoIP clients using the CLI. A session with the Q flag
indicates downstream real-time analysis and that with the u flag indicates upstream real-time analysis:
(host) [mm] #show datapath session table 10.16.4.71 | include 10.16.4.80

Datapath Session Table Entries

------------------------------

Flags: F - fast age, S - src NAT, N - dest NAT

D - deny, R - redirect, Y - no syn

H - high prio, P - set prio, T - set ToS

C - client, M - mirror, V - VOIP

Q - Real-Time Quality analysis

u - Upstream Real-Time Quality analysis

I - Deep inspect, U - Locally destined

E - Media Deep Inspect, G - media signal

r - Route Nexthop, h - High Value

B - Permanent, O - Openflow

L - Log

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age Destination TAge

--------------- --------------- ---- ----- ----- -------- ---- --- --- ----------- ----

10.16.4.80 10.16.4.71 17 20008 20038 0/0 6 46 0 local 24

Packets Bytes Flags

--------- --------- ----------

909 115732 HPTCIQuVBO

RTP Analysis Limitations

l In case of split-tunnel forwarding mode, UCC score is not calculated if the calling and called party are behind
the same remote AP.

l UCC score, jitter, delay, and packet loss is calculated for voice RTP streams only. These metrics are not
available for video streams.

l Upstream UCC score is not supported for desktop sharing , file transfer, Apple Facetime, Spectralink SVP,
Vocera, and Wi-Fi Calling ALGs.

AppRF Integration with ALGs and User Role
The QOSMOS engine does not recognize many of the UCC applications. For the ones it recognizes, it does not
maintain the state of the application. Due to this limitation, it cannot provide granular visibility into the UCC
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applications. To resolve this limitation, in ArubaOS 8.0, voice ALGs identify the application type for supported
UCC applications, so that the administrator can now use AppRF rules to deny, permit, apply QoS, or rate limit
UCC application traffic. The UCC application identifies all the supported applications listed below. The UCC
application identifies the application type corresponding to a media session and programs the datapath with
the application ID and the priority values. It is mandatory to add the ACLs to permit specific application traffics
if an ACL rule is not present in the user-role to permit RTP/RTCP traffic. Following is a list of UCC applications
that can be used to create application ACLs.

UCC Application ACL

alg-facetime

alg-ftp

alg-h323

alg-jabber-audio

alg-jabber-desktop-sharing

alg-jabber-video

alg-noe

alg-rtp

alg-sccp

alg-sip

alg-sip-audio

alg-sip-video

alg-skype4b-app-sharing

alg-skype4b-audio

alg-skype4b-desktop-sharing

alg-skype4b-file-transfer

alg-skype4b-secure

alg-skype4b-video

Table 215: UCC Application
ACLs



UCC Application ACL

alg-svp

alg-vocera

alg-wifi-calling

Table 215: UCC Application
ACLs

The following pre-defined ACL are available by default. The administrator can either add the entire ACL to the
appropriate user-role or selectively use the application IDs in another ACL and add that to the appropriate
user-role.
ip access-list session voip-applications-acl

any any app alg-skype4b-audio permit

any any app alg-skype4b-video permit

any any app alg-skype4b-desktop-sharing permit

any any app alg-skype4b-app-sharing permit

any any app alg-sip-audio permit

any any app alg-sip-video permit

any any app alg-sccp permit

any any app alg-vocera permit

any any app alg-noe permit

any any app alg-h323 permit

any any app alg-jabber-audio permit

any any app alg-jabber-video permit

any any app alg-facetime permit

any any app alg-wifi-calling permit

any any app alg-rtp permit

The ordering of the UCC application Access Control Entry (ACE) is not important except for the last ACE – any
any app alg-rtp permit. The use of this ACE is to permit RTP traffic. This is important in a deployment having
media application that is not identified by the UCC application. In such a case, the UCC application falls back to
the alg-rtp ACE as the default application ID. If permitting random RTP traffic is a requirement, this ACE should
be included in the ACL. In addition, this ACE should always be the last entry in the ACL.

An example of the ACE entries of voip-applications-acl follows:
(host) [mynode] #show ip access-list voip-applications-acl

ip access-list session voip-applications-acl

voip-applications-acl

---------------------

Priority Source Destination Service Application Action TimeRange

-------- ------ ----------- ------- ----------- ------ ---------

1 any any app alg-skype4b-audio permit

2 any any app alg-skype4b-video permit

3 any any app alg-skype4b-desktop-sharing permit

4 any any app alg-skype4b-app-sharing permit

5 any any app alg-sip-audio permit

6 any any app alg-sip-video permit

7 any any app alg-sccp permit

8 any any app alg-vocera permit

9 any any app alg-noe permit

10 any any app alg-h323 permit

11 any any app alg-jabber-audio permit

12 any any app alg-facetime permit

13 any any app alg-wifi-calling permit
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14 any any app alg-rtp permit

Log Expired Queue TOS 8021P Blacklist Mirror DisScan IPv4/6 Contract

--- ------- ----- --- ----- --------- ------ ------- ------ --------

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

Low 4

The following example adds an ACL to permit Lync/Skype for Business audio and video traffic and reference it
to the user-role:
(host) [mynode] (config) #ip access-list session apprf-skype4b-sacl

(host) ^[mynode] (config-submode)#any any app alg-skype4b-audio permit

(host) ^[mynode] (config-submode)#any any app alg-skype4b-video permit

Other ACL rules like bandwidth contract, deny, 802.1p priority, and Type of Service (ToS) can be used along
with the ACL application IDs.

Microsoft® Lync/Skype for Business
ArubaOS provides a seamless user experience for Microsoft® Lync/Skype for Business users using voice or
video calls, app-sharing, and file-transfer in a wireless environment. Microsoft® Lync/Skype for Business is an
enterprise solution for UCC. It provides support for voice, video, app-sharing, and file-transfer. The Lync/Skype
for Business SDN API provides an interface to Mobility Master to access Lync/Skype for Business network
diagnostic information about voice, video, app-sharing, and file-transfer without having to see into the traffic.

Lync/Skype for Business Media Classification Support in Mobility Master
By default, all the VoIP traffic undergo Media Classification on the managed device whenever RTP Traffic
reaches the managed device. UCM in Mobility Master can identify and prioritize calls made using Lync/Skype
for Business ALG. UCM also provides visibility for all voice calls made using the Lync/Skype for Business ALG.
UCM on Mobility Master dynamically opens firewall ports for voice and video traffic. The user does not have to
explicitly define a firewall policy to permit such traffic.

UCC Score for Lync/Skype for Business Media Classification

ArubaOS supports UCC score for Lync/Skype for Business calls prioritized using media classification. As part of
this feature, UCM supports the following:

l Real-time quality analysis for Lync/Skype for Business voice and video calls (voice RTP streams only)

l Real-time computation of UCC score (delay, jitter, and packet loss) for Lync/Skype for Business VoIP calls
prioritized using media classification. The UCC score is computed by the AP in the downstream direction and
also at the managed device in the upstream direction.

l Call Quality vs. Client Health chart in the UCC dashboard of Mobility Master.

When VoIP calls are prioritized using media classification, end-to-end call quality metrics such as Mean Opinion
Score (MOS), delay, jitter, and packet loss are not available.



UCC score computes the quality of voice calls. It takes delay, jitter, and packet loss of Real-time Transport
Protocol (RTP) packets into account. UCC score is computed on a scale of 0 to 100. To compute the UCC score,
you must enable RTP Analysis on Mobility Master. For more information, see RTP Analysis on page 882.

Available Call Quality Metrics

Following call quality metrics are available for Lync/Skype for Business calls prioritized by media classification:

Client IP, Client Mac, ALG, Duration(approximate), Orig time(approximate), Status, Reason, Call Type
(voice/video), Client Health, UCC Score, UCC Band, Source port, Destination port, Originated and modified
DSCP & WMM values, delay, jitter, and packet loss.

As the RTP packets are encrypted, following call quality metrics are not available for Lync/Skype for Business
calls prioritized by media classification:

Client Name, Direction, Called to, MOS, MOS band, End-to-end Delay, jitter and packet loss.

File transfer and desktop sharing sessions are not prioritized by media classification. Upstream and downstream
delay, jitter, and packet loss are not available for video sessions.

The show ucc commands displays statistics for media classification based Lync/Skype for Business ALG. For
more information on the list of commands, see the ArubaOS Command-Line Interface Reference Guide. The
UCC dashboard is displays statistics for media classification based Lync/Skype for Business ALG. For more
information on UCC dashboard, see UCC Dashboard on page 904.

Lync/Skype for Business Media Classification Limitations

l The media classification logic is applicable only for UDP-based RTP traffic, which applies to real-time voice
and video calls.

l Lync/Skype for Business app-sharing and file-transfer sessions are not identified and prioritized by media
classification.

l When using media classification, UCC score, jitter, delay, and packet loss is calculated only for voice RTP
streams. These metrics are not available for video streams.

l Media classification does not work in split-tunnel forwarding mode.

l When VoIP calls are prioritized using media classification, end-to-end call quality metrics such as Mean
Opinion Score (MOS), delay, jitter, and packet loss are not available.

l Media classification does not work when the managed device is performing a network address translation
for media traffic. Media classification continues to work if the media traffic is subjected to Network Address
Translation (NAT) beyond the managed device.

Lync/Skype for Business SDN API Support in Mobility Master
To take advantage of UCC Lync/Skype for Business ALG, it is recommended to use the Lync/Skype for Business
SDN API. ArubaOS 8.0 supports Lync/Skype for Business SDN API 2.0, 2.1.1, 2.2, and 2.4.1. Lync/Skype for
Business SDN API works with Microsoft Lync/Skype for Business server to export details about voice or video
calls, app-sharing, and file-transfer to Mobility Master. The communication between the Lync/Skype for
Business SDN API and Mobility Master occurs over HTTP or HTTPS.

In ArubaOS 6.x, Lync/Skype for Business SDN Manager sends the call information messages like start of call,
interim update, and end of call to all the preconfigured local controllers though the clients are not present on
the respective local controller. In ArubaOS 8.0, Lync/Skype for Business SDN Manager sends this information
to Mobility Master only and not the managed devices. This reduces the network traffic originating from the
Lync/Skype for Business SDN Manager and also relieves the managed devices of processing unwanted call
information originating from the Lync/Skype for Business SDN Manager.
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Lync/Skype for Business SDN API Configuration
The Lync/Skype for Business ALG should be configured from the /mm node hierarchy of Mobility Master. The
ALG is enabled by default.

In the WebUI

The following procedure configures the Lync/Skype for Business ALG using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC and click Skype4B ALG Configuration.

3. In the Skype4B ALG Configuration section, configure the settings described in Table 216.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Skype4B ALG
Support

Enables the Microsoft® Lync/Skype for Business ALG. The ALG is enabled by default.

Skype4B SDN Over
http/https

You can set the Lync/Skype for Business SDN listen protocol over HTTP or HTTPS. On
configuring this, the Lync diagnostic information will be received over HTTP or HTTPS.
The default value is HTTP.

Voice Priority Configures the DSCP value for the voice session. The default value is 46.

Video Priority Configures the DSCP value for the video session. The default value is 34.

App-sharing Priority Configures the DSCP value for the app-sharing session. The default value is 34.

Table 216: Lync/Skype for Business ALG Configuration Parameters

In the CLI

The following commands configure the Lync/Skype for Business ALG using the CLI:
(host) [mm] (config) #ucc skype4b

(host) ^[mm] (Skype4B ALG Configuration) #enable

(host) ^[mm] (Skype4B ALG Configuration) #priority {app-sharing <app-sharing>| video

<video>|voice <voice>}

(host) ^[mm] (Skype4B ALG Configuration) #sdn {http|https}

(host) ^[mm] (Skype4B ALG Configuration) #write memory

The following commands display the Lync/Skype for Business ALG configuration using the CLI:
(host) [mynode] #show ucc skype4b

Sat Jun 25 03:25:43.429 2016

Skype4B ALG Configuration

-------------------------

Parameter Value Set

--------- ----- ---

Skype4B ALG Support Enabled

Skype4B SDN Over http/https https

voice priority 46

video priority 34

app-sharing priority 34



Lync/Skpe for Business SDN Manager Configuration
Lync Dialog Listener must be installed and configured on the Lync front-end server. Lync/Skype for Business
SDN Manager must be installed on a separate Windows 2008/2012 server (not on the Lync front-end server).
If there are multiple front-end servers, Lync Dialog Listener should be installed on each server and configured
to point at the Lync/Skype for Business SDN Manager. On Lync SDN Manager, the Mobility Master information
needs to be configured.

Depending on the transport mode configured in the Lync/Skype for Business SDN Manager, the same
transport mode (HTTP or HTTPS) should be configured in the Configuration > System > Profiles > All
Profiles > UCC > Skype4B ALG Configuration page of WebUI. The following configuration is a snippet of
the Lync/Skype for Business SDN Manager configuration:

Lync/Skype for Business SDN Manager is a third-party product. The following configuration is an example and
provided for illustration purposes only. If you plan to use this sample in your environment, ensure that the sample
meets your IT guidelines. By running this sample configuration, you acknowledge that Aruba is in no way liable for any
loss, damage, or problems arising from running this sample configuration.

Read and follow the installation instruction PDF that comes with the SDN API software to install Lync/Skype for
Business Dialog Listener and Lync/Skype for Business SDN Manager.

<Configuration Version="2.0" culture="en-US" Kind="Subscriber" Identifier="Aruba"

LastModified="2015-10-27T13:06:59.7745572Z">

<parameter key="submituri">http://10.15.16.123:32000</parameter>

<parameter key="outputschema">D</parameter>

<parameter key="clientcertificateid"></parameter>

<parameter key="domainfilters"></parameter>

<parameter key="subnetfilters"></parameter>

As displayed in the above configuration, the Mobility Master IP address is added to the Lync/Skype for
Business SDN Manager instead of the managed device IP address and the port number has to be 32000 which
is a fixed port and not a configurable parameter on Mobility Master. The general format of the submit Uniform
Resource Identifier (URI) is as follows:
http[s]://<Mobility Master-IP or fqdn>:32000

IP Session ACL and User Role Configuration
The following procedure configures a user-role for Lync/Skype for Business clients. In addition, the procedure
provides steps to add an ACL to permit TCP traffic for app-sharing and file-transfer sessions.

In the WebUI

The following procedure configures the IP session ACL to permit TCP traffic for app-sharing and file-transfer
sessions using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Roles & Policies.

2. In the Roles tab, select an existing role.

3. In the Roles > <custom-role> section, click Show Advanced View.

4. In the Policies tab, click the + icon. The Add Policy pop-up window opens.

5. In the Add Policy window, select the Add existing session policy option.

6. In the Policy Name drop-down list, select the skype4b-acl policy.

7. In the Policy type drop-down list, select Session.

8. Click Submit.

9. Repeat steps 4 and 5.

10.In the Policy Name drop-down list, select the voip-application-acl policy.
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11.In the Policy type drop-down list, select Session.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

The following commands configure the IP session ACL to permit TCP traffic for app-sharing and file-transfer
sessions using the CLI:
(host) [md] (config) #user-role S4B-role

(host) ^[md] (config-submode) #session-acl skype4b-acl

(host) ^[md] (config-submode) #session-acl voip-applications-acl

(host) ^[md] (config-submode) #write memory

Lync/Skype for Business Troubleshooting
The following section describes the step-by-step procedure to troubleshoot Lync/Skype for Business ALG:

1. Ensure that the global prerequisites to enable UCC in ArubaOS 8.0 is configured. For more information, see
Prerequisites to Enable UCC on page 875.

2. Connect clients to the SSID; launch the Lync 2010/2013 or Skype for Business application; and make audio
and video calls between them.

3. Make a few calls between clients. Execute the show ucc client-info and show ucc call-info cdrs
commands and also access the UCC dashboard on the WebUI to view Lync/Skype for Business call statistics
and prioritization.
(host) [mm] #show ucc client-info

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State

--------- ---------- ----------- --- ---------- ------------------

10.16.4.76 00:24:d7:40:c0:a0 Derek Skype4B REGISTERED

10.16.4.71 00:21:6b:9d:f2:74 Allen Skype4B REGISTERED

Call Status AP Name Flags Device Type Home_Agent Foreign_Agent

----------- ------- ----- ----------- ---------- -------------

In-Call 2_205 Win 7 10.16.4.9 NA

In-Call 2_205 Win 7 10.16.4.9 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

(host) [mm] #show ucc call-info cdrs

Help: [C] - Metric calculated at the Controller

[A] - Metric calculated at the AP

CDR:

----

CDR ID UCC Call ID Client IP Client MAC Client Name ALG

------ ----------- --------- ---------- ----------- ---

4 2 10.16.4.71 00:21:6b:9d:f2:74 Derek Skype4B

3 2 10.16.4.76 00:24:d7:40:c0:a0 Allen Skype4B

Dir Called to Dur(sec) Orig Time Status Reason Call Type

--- --------- -------- --------- ------ ------ ---------

OG Scott 6 Nov 27 08:44:45 ACTIVE NA Voice

IC Scott 6 Nov 27 08:44:45 ACTIVE NA Voice

Client Health UCC Score[C] UCC Score[A] MOS



------------- ------------ ------------ ---

80 70.80/Good 38.50/Fair 4.10/Good

85 77.88/Good 41.53/Fair 4.32/Good

Total Entries: 2

4. Execute the show datapath session table command to verify if the calls are prioritized. A client with the
Q flag indicates real-time analysis and a client with u flag indicates RTP analysis of upstream VoIP calls.
(host) [mm] #show datapath session table 10.16.4.67

Datapath Session Table Entries

------------------------------

Flags: F - fast age, S - src NAT, N - dest NAT

D - deny, R - redirect, Y - no syn

H - high prio, P - set prio, T - set ToS

C - client, M - mirror, V - VOIP

Q - Real-Time Quality analysis

u - Upstream Real-Time Quality analysis

I - Deep inspect, U - Locally destined

E - Media Deep Inspect, G - media signal

r - Route Nexthop, h - High Value

B - Permanent, O - Openflow

L - Log

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age

--------------- --------------- ---- ----- ----- -------- ---- --- ---

10.16.4.72 10.16.4.67 17 20002 20008 0/0 5 40 0

10.16.4.72 10.16.4.67 17 20003 20008 0/0 0 0 1

10.16.4.67 10.16.4.72 17 20012 20039 0/0 6 46 0

Destination TAge Packets Bytes Flags

----------- ---- --------- --------- -----------

tunnel 22 24 398 151870 FHPTVQuI

tunnel 10 23 2 252 FCIE

local f2 0 0 FYHPTMCVBO

5. Execute the show ucc client-info command to verify if the Lync/Skype for Business clients are in In-Call
state.
(host) [mm] #show ucc client-info

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State

--------- ---------- ----------- --- ---------- ------------------

10.16.4.76 00:24:d7:40:c0:a0 Derek Skype4B REGISTERED

10.16.4.71 00:21:6b:9d:f2:74 Allen Skype4B REGISTERED

Call Status AP Name Flags Device Type Home_Agent Foreign_Agent

----------- ------- ----- ----------- ---------- -------------

In-Call 2_205 Win 7 10.16.4.9 NA

In-Call 2_205 Win 7 10.16.4.9 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

6. If Mobility Master uses Lync/Skype for Business SDN API, you can view the client name, called party, and
end to end call quality for every Lync/Skype for Business calls on Mobility Master.

7. Execute the show ucc trace-buffer skype4b command to verify if Mobility Master is receiving and
processing call information from the Lync/Skype for Business SDN manager.
(host) [mm] #show ucc trace-buffer skype4B
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Skype4b Voice Client(s) Message Trace

----------------------------------

Client IP Client MAC Client Name Direction Event Time BSSID

--------- ---------- ----------- --------- ---------- -----

192.0.2.22 00:23:33:41:c8:b8 Alex OG Jan 3 11:24:34 9c:1c:12:8a:b5:50

192.0.2.26 24:77:03:9a:6c:dc John OG Jan 3 11:24:34 9c:1c:12:8a:b5:50

192.0.2.29 00:22:90:ea:9e:f1 Steve OG Jan 3 11:24:08 9c:1c:12:8a:b5:50

Called To Media Type AP Name Src Port Dest Port Call Status

--------- ---------- ------- -------- --------- -----------

Joe Voice/Video AP-225 50030/58008 50032/58006 Start of call

Mike Voice/Video AP-225 50032/58006 50030/58008 InCallQuality Update

Ken Voice AP-225 50026 50038 Call Quality Update

Num of Rows:3

8. Execute the show datapath session table command and look for the O flag indicating if the RTP/RTCP-
related flows is installed on the managed device using OpenFlow protocol.
(host) [mm] #show datapath session table 10.16.4.67

Datapath Session Table Entries

------------------------------

Flags: F - fast age, S - src NAT, N - dest NAT

D - deny, R - redirect, Y - no syn

H - high prio, P - set prio, T - set ToS

C - client, M - mirror, V - VOIP

Q - Real-Time Quality analysis

u - Upstream Real-Time Quality analysis

I - Deep inspect, U - Locally destined

E - Media Deep Inspect, G - media signal

r - Route Nexthop, h - High Value

B - Permanent, O - Openflow

L - Log

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age

--------------- --------------- ---- ----- ----- -------- ---- --- ---

10.15.17.207 10.15.17.202 17 20004 20005 0/0 6 46 0

10.15.17.202 10.15.17.207 17 20005 20004 0/0 6 46 0

Destination TAge Packets Bytes Flags

----------- ---- --------- --------- -----------

local 1b 325 46131 FHPTCIVBO

local 3 347 41474 FHPTCIVBO

9. Execute the show ucc call-info cdrs to display the Call Detail Record (CDR) information or access the
Dashboard > UCC page on the WebUI to verify if the calls are identified and prioritized.
(host) [mm] #show ucc call-info cdrs

Help: [C] - Metric calculated at the Controller

[A] - Metric calculated at the AP

CDR:

----

CDR ID UCC Call ID Client IP Client MAC Client Name ALG

------ ----------- --------- ---------- ----------- ---

4 2 10.16.4.71 00:21:6b:9d:f2:74 Derek Skype4B

3 2 10.16.4.76 00:24:d7:40:c0:a0 Allen Skype4B

Dir Called to Dur(sec) Orig Time Status Reason Call Type

--- --------- -------- --------- ------ ------ ---------

OG Ian 6 Nov 27 08:44:45 ACTIVE NA Voice

IC Ian 6 Nov 27 08:44:45 ACTIVE NA Voice



Client Health UCC Score[C] UCC Score[A] MOS

------------- ------------ ------------ ---

NA NA NA NA

NA NA

Total Entries: 2

10.Execute the show ucc statistics counter call client and show ucc statistics counter call global
commands to view the different call metrics.
(host) [mm] #show ucc statistics counter call client

Per Client Call Counters:

-------------------------

Client IP Client MAC Call Originated Call Terminated Active Success

--------- ---------- --------------- --------------- ------ -------

10.16.4.76 00:24:d7:40:c0:a0 0 1 1 0

10.16.4.71 00:21:6b:9d:f2:74 0 1 1 0

10.16.4.79 00:24:d7:40:ff:a0 0 0 0 0

Failed Blocked Aborted Forwarded WMM AC-VI WMM AC-VO WMM-BK WMM-BE

------ ------- ------- --------- --------- --------- ------ ------

0 0 0 0 0 0 0 1

0 0 0 0 0 0 0 1

0 0 0 0 0 0 0 0

WMM (VI, VO, BK, BE):total calls with received priority

(host) [mynode] #show ucc statistics counter call global

System-wide Call Counters:

--------------------------

Call Originated Call Terminated Active Success Failed Blocked Aborted

--------------- --------------- ------ ------- ------ ------- -------

0 2 2 0 0 0 0

Forwarded WMM AC-VI WMM AC-VO WMM-BK WMM-BE

--------- --------- --------- ------ ------

0 0 0 0 2

Device Type Allocations:

------------------------

Device Type WMM AC-VI WMM AC-VO WMM-BK WMM-BE

----------- --------- --------- ------ ------

Win 7 0 0 0 2

WMM (VI, VO, BK, BE):total calls with received priority)

11.If the clients are not seen after executing the show ucc client-info command, verify the output by
executing the show gsm debug channel ucc_client, show gsm debug channel ucc_session, and
show gsm debug channel ip_user.
(host) [mm] #show gsm debug channel ucc_client

ucc_client Channel Table

------------------------

state uc_client_mac uc_client_ip uc_contact_name uc_server_name uc_client_flags

----- ------------- ------------ --------------- -------------- ---------------

ACTV 80:86:f2:40:b3:d4 10.15.88.247 1008 10.15.16.30 1

ACTV 80:86:f2:40:14:9c 10.15.88.245 1007 10.15.16.30 1

uc_reg_state uc_alg uc_entry_type uc_role uc_active_call uc_replicatorip

------------ ------ ------------- ------- -------------- ---------------
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4 14 1 0 0 10.15.88.100

4 14 1 0 0 10.15.88.100

Total Num of Objects :2

Total Num of Active Objects :2

Total Num of Replicated Objects :0

(host) [mm] #show gsm debug channel ucc_session

ucc_session Channel Table

-------------------------

state uc_client_mac uc_client_ip uc_active_call

----- ------------- ------------ --------------

ACTV 80:86:f2:40:b3:d4 10.15.88.247 0

ACTV 80:86:f2:40:14:9c 10.15.88.245 0

Total Num of Objects :2

Total Num of Active Objects :2

Total Num of Replicated Objects :0

(host) [mm] #show gsm debug channel ip_user

ip_user Channel Table

---------------------

state v_repkey user_ip_address user_uuid ip_user_flags ip_user_

timestamp

----- -------- --------------- --------- ------------- ----------------

-

REPL 3 10.15.88.245 001a1e01b2280000002f0064 0 181193397240

REPL 3 10.15.88.247 001a1e01b2280000002f0065 0 181193397370

Total Num of Objects :2

Total Num of Active Objects :0

Total Num of Replicated Objects :2

Total number of hosts: 3

12.Execute the show ucc rtpa-report command to view the Real-Time analysis report.
(host) [mm] #show ucc rtpa-report

Help: [C] - Metric calculated at the Controller

[A] - Metric calculated at the AP

[E] - Metric calculated End-to-End

Real-Time Analysis Call Quality Report

--------------------------------------

Client(IP) Client(MAC) Client(Name) ALG Jitter(usec)[C]

---------- ----------- ------------ --- ---------------

10.16.4.76 00:24:d7:40:c0:a0 Derek Skype4B 308.200

10.16.4.71 00:21:6b:9d:f2:74 Allen Skype4B 1119.080

Pkt-loss(%)[C] Delay(usec)[C] UCC Score[C] Jitter(usec)[A] Pkt-loss(%)[A]

-------------- -------------- ------------ --------------- --------------

0.000 118.000 92.346 36.840 0.000

0.000 35.400 76.210 101.679 0.000

Delay(usec)[A] UCC Score[A] Forward mode

-------------- ------------ ------------

344.610 40.116 tunnel

581.034 48.956 tunnel

Num Records:2



13.Execute the show openflow-controller hosts command to verify if the users are learned as OpenFlow
hosts. If a host entry is not present for a user then flow will not be installed and the call will not be
prioritized.
(host) [mm] #show openflow-controller hosts

Hosts

-----

IP MAC Wireless Dpid

-- --- -------- ----

10.15.88.245 80:86:f2:40:14:9c True 00:00:00:1a:1e:01:b2:28

10.15.88.235 ac:bc:32:78:33:a1 True 00:00:00:1a:1e:01:b2:28

10.15.19.39 00:0c:29:e4:88:93 false 00:00:00:0c:29:e8:b8:b9

Port No Port MAC

------- --------

21 ac:a3:1e:ca:7d:c0

19 d8:c7:c8:c9:23:8b

1 00:0c:29:e8:b8:ba

Total number of hosts: 3

14.Execute the show openflow-controller flow-table command to verify if the flows are installed accurately.
(host) [mm] #show openflow-controller flow-table

Flow-table

----------

Dpid In Port Src Mac Dst Mac Ether Src IP

---- ------- ------- ------- ----- ------

00:00:00:0c:29:a1:de:01 * * * 0x800 222.173.190.239

00:00:00:0b:86:9a:16:77 * * * 0x800 222.173.190.239

Dst IP Proto Src Port Dst Port App Name Actions

------ ----- -------- -------- -------- -------

186.173.202.254 17 60000 60000 ucm output=controller

186.173.202.254 17 60000 60000 ucm output=controller

Total number of flows: 2

15.Execute the show openflow flow-table command on the managed device to check if the OpenFlows are
getting programmed in the managed device.
(host-mn) #show openflow flow-table

Openflow Flow Table

-------------------

In Port Src Mac Dst Mac Ether Src IP Dst IP Proto

------- ------- ------- ----- ------ ------ -----

* * * 0x800 1.1.1.1 2.2.2.2 97

* * * 0x800 192.168.201.251 192.168.201.250 6

* * * 0x800 222.173.190.239 186.173.202.254 17

* * * 0x800 192.168.201.250 192.168.201.251 6

Src Port Dst Port Packets Bytes Actions

-------- -------- ------- ----- -------

* * 0 0 (Output:controller)

42017 42008 0 0 ,(Set IP ToS:34),(Set Vlan pcp:5),(Set AppID:2565)

(Output:normal),(Write Flag:VH)

60000 60000 0 0 (Output:controller)

42008 42017 0 0 ,(Set IP ToS:34),(Set Vlan pcp:5),(Set AppID:2565)

(Output:normal),(Write Flag:VH)

Total number of flows: 4
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Cisco Jabber
Cisco Jabber is an enterprise collaboration application that supports the following protocols:

l Voice call based on SIP signaling and media on RTP protocol

l Video call based on SIP signaling and media on RTP protocol

l Desktop-sharing based on SIP signaling and Binary Floor Control Protocol (BFCP) and media on RTP
protocol

l File-transfer based on TCP protocol

Cisco Jabber is an all-in-one application and significant number of customers deploy this application in open SIP
mode without encryption. As Cisco Jabber deployment continues to gain a larger foothold in the collaboration
space, it is important to ensure QoS for its delay-sensitive applications such that there is no perceptible
difference in the user experience between wireless and wired networks.

Cisco Jabber Support in Mobility Master
Mobility Master provides QoS and visibility for voice, video calls, and desktop-sharing sessions made using an
unencrypted version of the Cisco Jabber client. UCM can uniquely identify and prioritize Cisco jabber voice,
video calls, and desktop-sharing sessions.

Open SIP ALG Enhancements
Cisco Jabber is an all-in-one application, enabling a user to perform functions in addition to audio and video
calls. The existing SIP ALG is enhanced to support Cisco Jabber.

Parser Logic Enhancement

The current SIP ALG parser is capable of handling audio calls. The same is extended to handle video calls, app-
sharing, hold/resume calls, conference calls, and call transfer.

Two additional ports, namely TCP 5222 and TCP 8443 are added to the default jabber-acl IP access list. These
ports are required for the clients to register to the server.
(host) [md] (config) #ip access-list session jabber-acl

(host) [md] (config-submode) #any any tcp 5222 permit

(host) [md] (config-submode) #any any tcp 8443 permit

The jabber-acl IP access list is included in the voice user-role by default. If the administrator chooses to use
any other custom user-role, the ACL should be added manually to the custom user-role.

Identification of Cisco Jabber Clients

A new configuration setting Jabber Server IP is introduced where an administrator can configure the Cisco
Jabber server (Cisco Unified Communication Manager and Cisco Unified Presence Manager) IP address for
client identification. You can configure up to 16 such IP addresses.

Cisco Jabber Configuration
You should enable DPI on Mobility Master for Cisco Jabber to work. For more information on enabling DPI, see
Deep Packet Inspection Configuration on page 877.

The Cisco Jabber ALG should be configured from the /mm node hierarchy of Mobility Master. The ALG is
enabled by default.

In the WebUI

The following procedure configures the Cisco Jabber ALG using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC and click Jabber ALG Configuration.

3. In the Jabber ALG Configuration section, configure the settings described in Table 217.



4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

Parameter Description

Jabber ALG Support Enables the Cisco Jabber ALG. The ALG is enabled by default.

Jabber Server IP Configures the Cisco Jabber server (Cisco Unified Communication Manager and Cisco
Unified Presence Server) IP address to uniquely identify Cisco Jabber clients.

NOTE: This is a mandatory configuration setting.

Voice Priority Configures the DSCP value for the voice session. The default value is 46.

Video Priority Configures the DSCP value for the video session. The default value is 34.

App-sharing Priority Configures the DSCP value for the app-sharing session. The default value is 34.

Table 217: Cisco Jabber ALG Configuration Parameters

In the CLI

The following commands configure the Cisco Jabber ALG using the CLI:
(host) [mm] (config) #ucc jabber

(host) ^[mm] (Jabber ALG Configuration) #enable

(host) ^[mm] (Jabber ALG Configuration) #priority {app-sharing <app-sharing>| video

<video>|voice <voice>}

(host) ^[mm] (Jabber ALG Configuration) #server-ip <server-ip>

(host) ^[mm] (Jabber ALG Configuration) #write memory

The following commands display the Cisco Jabber ALG configuration using the CLI:
(host) [mynode] #show ucc jabber

Jabber ALG Configuration

------------------------

Parameter Value Set

--------- ----- ---

Jabber ALG Support Enabled

Jabber server ip 10.15.16.30

Jabber server ip 10.15.16.31

voice priority 46

video priority 34

app-sharing priority 34

Cisco Jabber Troubleshooting
The following section describes the step-by-step procedure to troubleshoot Cisco Jabber ALG:

1. Ensure that the global prerequisites to enable UCC in ArubaOS 8.0 is configured. For more information, see
Prerequisites to Enable UCC on page 875.

2. Ensure that the Cisco Jabber server (Cisco Unified Communication Manager and Cisco Unified Presence
Manager) IP addresses are configured under the Cisco Jabber ALG configuration.

3. Connect clients to the SSID.

4. Launch the Cisco Jabber application in the client and log in with the credentials to register with the Cisco
Unified Communication Manager and Cisco Unified Presence Manager servers.
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5. Execute the show ucc client-info command to verify if the ALG type is Jabber and the registration status
is REGISTERED.
(host) [mm] #show ucc client-info

Thu Dec 03 08:48:09.077 2015

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State

--------- ---------- ----------- --- ---------- ------------------

10.15.88.235 ac:bc:32:78:33:a1 1019 Jabber 10.15.16.30 REGISTERED

10.15.88.247 80:86:f2:40:b3:d4 1008 Jabber 10.15.16.30 REGISTERED

Call Status AP Name Flags Device Type Home_Agent Foreign_Agent

----------- ------- ----- ----------- ---------- -------------

Idle AP-105 OS X 10.15.88.100 NA

In-Call AP-115 Win 7 10.15.88.100 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

6. Start audio, video calls, and app-sharing sessions between Cisco Jabber clients.

7. Execute the show ucc client-info and show ucc call-info cdrs commands or access the Dashboard >
UCC page on the WebUI to view Cisco Jabber call statistics and prioritization.
(host) [mm] #show ucc client-info

Thu Dec 03 08:48:09.077 2015

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State

--------- ---------- ----------- --- ---------- ------------------

10.15.88.235 ac:bc:32:78:33:a1 1019 Jabber 10.15.16.30 REGISTERED

10.15.88.247 80:86:f2:40:b3:d4 1008 Jabber 10.15.16.30 REGISTERED

Call Status AP Name Flags Device Type Home_Agent Foreign_Agent

----------- ------- ----- ----------- ---------- -------------

Idle AP-105 OS X 10.15.88.100 NA

In-Call AP-115 Win 7 10.15.88.100 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

(host) [mm] #show ucc call-info cdrs

Thu Dec 03 08:48:23.827 2015

Help: [C] - Metric calculated at the Controller

[A] - Metric calculated at the AP

CDR:

----

CDR ID UCC Call ID Client IP Client MAC Client Name ALG Dir Called to

------ ----------- --------- ---------- ----------- --- --- ---------

140 53 10.15.88.247 80:86:f2:40:b3:d4 1008 Jabber OG 1019

138 53 10.15.88.247 80:86:f2:40:b3:d4 1008 Jabber OG 1019

Dur(sec) Orig Time Status Reason Call Type Client Health

-------- --------- ------ ------ --------- -------------

21164 Dec 3 02:55:39 ACTIVE NA Voice 0

21164 Dec 3 02:55:39 ACTIVE NA Voice 0



UCC Score[C] UCC Score[A] MOS

------------ ------------ ---

70.80/Good 38.50/Fair 4.10/Good

77.88/Good 41.53/Fair 4.32/Good

Total Entries:2

8. Execute the show ucc client-info command. If the ALG column displays SIP instead of Jabber, ensure
that the Cisco Unified Communication Manager and Cisco Unified Presence Server IP addresses are added
as part of the Cisco Jabber configuration in Mobility Master. In addition, verify if DPI is enabled on Mobility
Master.

9. Execute the show ucc trace-buffer jabber command to verify if call signaling events such as establishing
voice, video, desktop sharing, and file transfer are recorded.
(host) [mm] #show ucc trace-buffer jabber

Jabber Voice Client(s) Message Trace

------------------------------------

Client IP Client MAC Client Name Direction Event Time BSSID

Msg

--------- ---------- ----------- --------- ---------- -----

---

10.15.88.234 68:17:29:9f:b6:77 3002 Server-To-Client Jul 4 22:48:28

ac:a3:1e:27:dc:00 200_OK

10.15.88.234 68:17:29:9f:b6:77 3002 Server-To-Client Jul 4 22:48:27

ac:a3:1e:27:dc:00 100_TRYING

10.15.88.234 68:17:29:9f:b6:77 3002 Client-To-Server Jul 4 22:48:27

ac:a3:1e:27:dc:00 REGISTER

10.15.88.234 68:17:29:9f:b6:77 3002 Server-To-Client Jul 4 22:46:32

ac:a3:1e:27:dc:00 200_OK

10.If the clients are not seen after executing the show ucc client-info command, verify the output by
executing the show gsm debug channel ucc_client, show gsm debug channel ucc_session, show
gsm debug channel ip_user, and show openflow-controller hosts.
(host) [mm] #show gsm debug channel ucc_client

ucc_client Channel Table

------------------------

state uc_client_mac uc_client_ip uc_contact_name uc_server_name uc_client_flags

----- ------------- ------------ --------------- -------------- ---------------

ACTV 80:86:f2:40:b3:d4 10.15.88.247 1008 10.15.16.30 1

ACTV 80:86:f2:40:14:9c 10.15.88.245 1007 10.15.16.30 1

uc_reg_state uc_alg uc_entry_type uc_role uc_active_call uc_replicatorip

------------ ------ ------------- ------- -------------- ---------------

4 14 1 0 0 10.15.88.100

4 14 1 0 0 10.15.88.100

Total Num of Objects :2

Total Num of Active Objects :2

Total Num of Replicated Objects :0

(host) [mm] #show gsm debug channel ucc_session

ucc_session Channel Table

-------------------------

state uc_client_mac uc_client_ip uc_active_call

----- ------------- ------------ --------------

ACTV 80:86:f2:40:b3:d4 10.15.88.247 0

ACTV 80:86:f2:40:14:9c 10.15.88.245 0

Total Num of Objects :2

Total Num of Active Objects :2
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Total Num of Replicated Objects :0

(host) [mm] #show gsm debug channel ip_user

ip_user Channel Table

---------------------

state v_repkey user_ip_address user_uuid ip_user_flags ip_user_

timestamp

----- -------- --------------- --------- ------------- ----------------

-

REPL 3 10.15.88.245 001a1e01b2280000002f0064 0 181193397240

REPL 3 10.15.88.247 001a1e01b2280000002f0065 0 181193397370

Total Num of Objects :2

Total Num of Active Objects :0

Total Num of Replicated Objects :2

(host) [mm] #show openflow-controller hosts

Hosts

-----

IP MAC Wireless

-- --- --------

10.15.88.245 80:86:f2:40:14:9c True

10.15.88.235 ac:bc:32:78:33:a1 True

10.15.19.39 00:0c:29:e4:88:93 false

Dpid Port No Port MAC

---- ------- --------

00:00:00:1a:1e:01:b2:28 21 ac:a3:1e:ca:7d:c0

00:00:00:1a:1e:01:b2:28 19 d8:c7:c8:c9:23:8b

00:00:00:0c:29:e8:b8:b9 1 00:0c:29:e8:b8:ba

Total number of hosts: 3

11.Execute the show datapath session table command to verify if the calls are prioritized. The ToS values
should be set for this session, along with other flags like V, H, P, T, O.
(host-mn) #show datapath session dpi table | include V,Age

C - client, M - mirror, V - VOIP

r - Route Nexthop, h - High Value

Source IP Destination IP Prot SPort DPort Cntr Prio ToS Age Destination TAge

Packets

------------ -------------- ---- ----- ----- ---- ---- --- --- ----------- ---- ---

----

10.15.89.250 10.15.89.231 17 26344 26112 0/0 5 34 0 local 31 173

10.15.89.250 10.15.89.231 17 26345 26113 0/0 5 34 0 local 31 76

10.15.89.250 10.15.89.231 17 23843 16767 0/0 6 46 0 local 31 2

10.15.89.231 10.15.89.250 17 16767 23843 0/0 6 46 0 local 31 5

Bytes SIDX AclVer Int-Flag PktsDpi UplnkVlan AppID

------ ----- ------ -------- ------- --------- -----------------------

185458 39b56 1632 2101 0 none alg-jabber-video (2570)

4420 4b952 1632 2101 0 none alg-jabber-video (2570)

220 87e7f 1632 2101 0 none alg-jabber-audio (2569)

624 a5a70 1632 2125 0 none alg-jabber-audio (2569)

AceIdx Flags User-MAC DpiTIdx



------ --------- ----------------- -------

0/561 FHPTCVBO 00:00:00:00:00:00 5e

0/561 FHPTMCVBO 00:00:00:00:00:00 84

0/560 FHPTMCVBO 00:00:00:00:00:00 8d

0/560 FHPTMCVBO 00:00:00:00:00:00 c5

Cisco Jabber Limitations
The following are the list of limitations in Cisco Jabber:

l Visibility is not available for file transfer and a pure desktop-sharing sessions. In a pure desktop-sharing
session, there is no simultaneous voice/video session going on. In a stand-alone controller deployment,
visibility is not available for file transfer and desktop -sharing with or without simultaneous voice/video
session.

l If eXtensible Messaging and Presence Protocol (XMPP) signaling is not received for any reason before the
SIP signaling from the Jabber client, the client will be identified as SIP and not Jabber.

Wi-Fi Calling
Wi-Fi calling service allows cellular users to make or receive calls using a Wi-Fi network instead of using the
carrier’s cellular network. Wi-Fi calling allows users to place, receive calls, and text messages even when they are
beyond a cellular coverage but having a Wi-Fi network coverage. Major carriers around the world support Wi-Fi
calling service.

Wi-Fi Calling Support in Mobility Master
Mobility Master provides QoS for voice calls made using Wi-Fi calling. UCM in Mobility Master can identify and
prioritize calls made using Wi-Fi calling. UCM also provides visibility for all voice calls made using Wi-Fi calling.

Wi-Fi Calling Operation
At a high level, this is how Wi-Fi calling operates:

1. Wi-Fi Calling-capable handset initiates a DNS query to locate the carrier’s evolved Packet Data Gateway
(ePDG).

2. The handset establishes a persistent IPsec tunnel with ePDG.

3. Calls, text, and traffic for other services offered by the carrier are then carried over in this IPsec tunnel.

Some carriers use a standard FQDN format for ePDG that includes their Mobile Network Code (MNC) and
Mobile Country Code (MCC). For example, T-Mobile uses ss.epdg.epc.mnc260.mcc310.pub.3gppnetwork.org.
Others follow a different standard format. For example, AT&T uses epdg.epc.att.net. For a list of well known
carrier DNS patterns, see Table 218.

Wi-Fi Calling Configuration
The Wi-Fi Calling ALG should be configured from the /mm node hierarchy of Mobility Master. This ALG is
enabled by default.

In the WebUI

The following procedure configures the Wi-Fi Calling ALG using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles > All Profiles.

2. Expand UCC and click Wi-Fi Calling ALG Configuration.

3. In the Wi-Fi Calling ALG Configuration section, configure the settings described in Table 218.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.
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Parameter Description

Wi-Fi Calling
Support

Enables the Wi-Fi Calling ALG. The ALG is enabled by default.

Voice Priority Configures the DSCP value for the voice session. The default value is 46.

DNS Pattern dns-pattern–Configure the DNS pattern for the carrier. A maximum of 10 DNS patterns
can be configured.

DNS patterns for known carriers are configured by default. Default built-in patterns are:

l 3 HK - wlan.three.com.hk

l ATT - epdg.epc.att.net

l Rogers - epdg.epc.mnc720.mcc302.pub.3gppnetwork.org

l SmarTone - epdg.epc.mnc006.mcc454.pub.3gppnetwork.org

l Sprint - primgw.vowifi2.spcsdns.net

l T-Mobile - ss.epdg.epc.mnc260.mcc310.pub.3gppnetwork.org

l Verizon - wo.vzwwo.com

If the ePDG FQDN of the carrier does not match with the default patterns, use this option to
configure the DNS pattern for the carrier.

NOTE: The DNS IP address that Mobility Master learns for Wi-Fi Calling age out
automatically, if there was no DNS query or response matching that IP for more than
seven days.

service-provider–Add the service provider name for enhanced visibility.

Table 218: Wi-Fi Calling ALG Configuration Parameters

In the CLI

The following commands configure the Wi-Fi Calling ALG using the CLI:
(host) [mm] (config) #ucc wificalling

(host) ^[mm] (WiFiCalling Configuration) #enable

(host) ^[mm] (WiFiCalling Configuration) #priority voice <voice>

(host) ^[mm] (WiFiCalling Configuration) #dns-pattern <dns-pattern> service-provider <service-

provider>

(host) ^[mm] (WiFiCalling Configuration) #write memory

The following command displays the Wi-Fi Calling ALG configuration using the CLI:
(host) [mm] #show ucc wificalling

WiFiCalling Configuration

-------------------------

Parameter Value Set

--------- ----- ---

WiFiCalling Support Enabled

voice priority 46

dns pattern att.net ATT

Wi-Fi Calling Troubleshooting
The following section describes the step-by-step procedure to troubleshoot Wi-Fi Calling ALG:

1. Ensure that the global prerequisites to enable UCC in ArubaOS 8.0 is configured. For more information, see
Prerequisites to Enable UCC on page 875.

2. Connect the 'Wi-Fi Calling'-capable handset to the SSID.



3. Add the default wificalling-acl and voip-applications-acl ACLs to the user-role. By default, these ACLs are
included in the voice user-role.

4. When the handset establishes a persistent IPsec tunnel with ePDG, it displays the Wi-Fi Calling icon.

5. Execute the show ucc dns-ip-learning command to verify if the ePDG IP address is learned.
(host) [mynode] #show ucc dns-ip-learning

DNS IP Learning:

----------------

IP Address Service Provider

---------- ----------------

208.54.85.108 T-Mobile

208.54.73.77 T-Mobile

208.54.70.110 T-Mobile

208.54.77.253 T-Mobile

208.54.75.2 T-Mobile

208.54.85.64 T-Mobile

208.54.73.76 T-Mobile

208.54.83.96 T-Mobile

208.54.85.111 T-Mobile

Total Entries:9

6. If the ePDG IP address is not learned, identify the FQDN of ePDG and add the DNS pattern of the carrier.
FQDN may not be matching with any of the default, built-in DNS patterns.

7. Place a few calls and execute the show ucc client-info and show ucc call-info cdrs commands or access
the Dashboard > UCC page on the WebUI to view Wi-Fi call statistics and prioritization.
(host) [mynode] #show ucc client-info

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State

--------- ---------- ----------- --- ---------- ------------------

10.15.17.208 fc:c2:de:6c:01:9c Client WiFi-Calling T-Mobile REGISTERED

10.15.17.206 d8:bb:2c:51:16:b2 Client WiFi-Calling T-Mobile REGISTERED

Call Status AP Name Flags Device Type Home_Agent Foreign_Agent

----------- ------- ----- ----------- ---------- -------------

In-Call 4-105-2 Android 10.15.16.168 NA

In-Call 2-105-1 Apple 10.15.16.168 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

(host) [mynode] #show ucc call-info cdrs

Help: [C] - Metric calculated at the Controller

[A] - Metric calculated at the AP

CDR:

----

CDR ID UCC Call ID Client IP Client MAC Client Name ALG Dir

Called to

------ ----------- --------- ---------- ----------- --- --- -----

----

20 NA 10.15.17.206 d8:bb:2c:51:16:b2 NA WiFi-Calling NA NA

19 NA 10.15.17.208 fc:c2:de:6c:01:9c NA WiFi-Calling NA NA

18 NA 10.15.17.208 fc:c2:de:6c:01:9c NA WiFi-Calling NA NA
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17 NA 10.15.17.206 d8:bb:2c:51:16:b2 NA WiFi-Calling NA NA

Dur(sec) Orig Time Status Reason Call Type Client Health

-------- --------- ------ ------ --------- -------------

82 Nov 24 23:21:31 ACTIVE NA Voice 44

88 Nov 24 23:21:25 ACTIVE NA Voice 78

93 Nov 24 23:16:19 SUCC Terminated Voice 71

228 Nov 24 23:14:32 SUCC Terminated Voice 51

UCC Score[C] UCC Score[A] MOS

------------ ------------ ---

NA NA NA

NA NA NA

NA NA NA

NA NA NA

Total Entries:4

UCC Score and MOS value are not available for Wi-Fi Calling calls.

8. Execute the show datapath session table command on the managed device to ensure that media
classification flags (I & E) are set for IPsec session destined to the ePDG IP address.

9. When a Wi-Fi Calling call is identified, the I and E flags are removed from the IPsec session and appropriate
ToS and 802.1p values are set for this session, along with other flags like V, H, P, T, O.

10.When the call ends, ToS and 802.1p values are removed for the IPsec session along with the V, H, P, T, O
flags, and the I and E flags are set. For a list of flags, execute the show datapath session table command.

Wi-Fi Calling Limitations
The following is a list of limitations in Wi-Fi Calling:

l Wi-Fi Calling is not supported for clients in split-tunnel and bride-forwarding mode.

l WLAN and end to end quality metrics are not available for Wi-Fi Calling calls.

l Wi-Fi Calling calls may get dropped in the event of a cluster failover.

l Wi-Fi Calling calls do not get prioritized when Mobility Master is not reachable.

l If a Wi-Fi Calling client roams from one managed device to another, subsequent calls may not get prioritized
until the client does a DNS query for carrier ePDG.

l Wi-Fi Calling is not identified and prioritized if NAT is enabled on the user VLAN. Wi-Fi Calling is not identified
and prioritized if the corresponding sessions undergo NATting by the managed device.

UCC Dashboard
The UCC dashboard gives a complete view of the UCC deployment in Mobility Master. The UCC dashboard has
two levels of displaying statistics:

l UCC Dashboard Aggregated Display

l UCC Dashboard Per Client Display



UCC Dashboard Aggregated Display
The UCC Dashboard Aggregated Display shows an aggregated view of the UCC calls made in Mobility Master.
The administrator can see a top-level view of the call quality assessment, and further drill-down into a specific
view based on the analysis required.

Chart View

Navigate to Dashboard > UCC. The UCC page displays the overall health (in graphical format) of the UCC
deployment in Mobility Master as shown in Figure 111.

Figure 111 UCC Dashboard

Each graphical section of the UCC dashboard is explained as follows:

l Call Volume – This graph displays the total number of calls made based on the UCC application type. For
example, SIP, Skype4B, SCCP, H.323, NOE, SVP, Vocera, FaceTime, Jabber, and WiFi-Calling.

l Call Quality – This graph displays the AP-to-Client call quality under the WLAN tab and the end-to-end
quality including wired and wireless legs of the call under the End-to-End tab. The number of UCC calls are
categorized by the following call quality:

n Good
n Fair
n Poor
n Not Available – In the WLAN tab, short duration voice calls (less than 60 seconds), video calls, and file-

transfer session are categorized as Not Available. In the End-to-End tab, short duration voice calls (less
than 60 seconds), video calls, file-transfer, and app-sharing sessions are categorized as Not Available.

l Call Quality vs. Client Health – This graph displays the correlation between the VoIP call quality and the
VoIP client health of every UCC call. This graph displays the UCC score under the WLAN tab and MOS under
the End-to-End tab.

When VoIP calls are prioritized using media classification like Lync/Skype for Business, Apple Facetime and Wi-Fi
Calling, the End-to-End call quality is not available. In addition, WLAN-based quality metrics including Call Quality vs.
Client Health scatter plot are not available.

l Calls Per Device Type – This graph displays the calls made per device type. For example, Windows 7, Mac
OS X, iPhone, or Android.

l Roaming – Roaming status of UCC clients. The status can be:

n No – Number of calls where the client did not roam to a new AP during an active call.
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n Yes – Number of calls where the client has roamed to a new AP during an active call.

l QoS Correction – If the DSCP value of the Real-time Transport Protocol (RTP) packets sent by the client
differs from corresponding priority value configured for the application, Mobility Master corrects this value
as per the SSID profile definition and classifies the call as QoS corrected. This graph displays the number of
UCC calls where Mobility Master has corrected the WMM-DSCP value for such calls. The QoS correction is
categorized as:

n No – No WMM-DSCP value correction.

n Yes – WMM-DSCP value corrected by Mobility Master.

n Not Available – WLAN short duration calls (less than 60 seconds) is categorized as Not Available.

Call Details View

To display an aggregated list of all the UCC call data metrics in Mobility Master, navigate to the Dashboard >
UCC page of the WebUI and click any of the following hyperlinks of the Web page:

l Call Volume Details

l Call Quality Details

l Client Health Details

l Device Details

l Roaming Details

l QoS Details

Figure 112 displays an aggregated list of all the UCC call data metrics on the managed devices.

Figure 112 Wireless Call List

VoIP calls made to/from clients outside Mobility Master are displayed in the External Call List pane. This pane
lists all the external and wired client call CDRs. See Figure 113.

External call list is available only when Lync/Skype for Business SDN API is configured on Mobility Master.



Figure 113 External Call List

UCC Dashboard Per Client Display
On the Dashboard > Clients page of the WebUI, clicking the client IP hyperlink displays the details page of the
client. Click the UCC tab. This tab displays an aggregated list of UCC call data metrics of a client. See Figure 114.

Figure 114 UCC Client Page
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Figure 115 displays the statistics of all the VoIP calls made by a particular client. This graph displays the AP-to-
Client metrics under the WLAN tab and the end-to-end quality including wired and wireless legs of the call
under the End-to-End tab.

When VoIP calls are prioritized using media classification like Apple Facetime and Wi-Fi Calling, the End-to-End call
quality is not available. In addition, WLAN-based quality metrics including Call Quality vs. Client Health scatter plot
are not available.

Figure 115 All Calls

Figure 116 displays the VoIP call summary for a selected call of a client.

Figure 116 Selected Call Summary

Figure 117 displays the VoIP call details for a selected call of a client.

Figure 117 Selected Call Details



On the Dashboard > Usage page of the WebUI, the Call Quality vs. Client Health graph displays the
correlation between the VoIP call quality (UCC-Band) and the VoIP client health of every UCC call. Figure 118
displays the Call Quality vs Client Health graph.

Figure 118 Call Quality vs. Client Health

UCC-AirWave Integration
The UCC-AirWave integration provides a multi-managed device visibility into the UCC solution across
deployments. The Mobility Master sends raw UCC data using Application MONitoring (AMON) periodically.
AirWave Management Platform (AMP) receives these AMON messages and uses this data to display user-
friendly aggregated and per-client UCC statistics in AirWave. This helps the administrator to assess the overall
health and troubleshoot UCC deployments in a multi-managed device environment. The UCC dashboard is
supported in AirWave 8.0 onwards.

Follow these steps to get UCC data in AirWave from Mobility Master:

Enabling UCC Data Collection in AirWave
To enable UCC data collection in the AirWave WebUI:

1. Navigate to the AMP Setup > General tab of the AirWave WebUI.

2. In the Additional AMP Services section, change the Enable UCC Data Collection option to Yes.

Add AirWave as a Management Server in Mobility Master
You can add the default AirWave management server profile using the WebUI or CLI.

In the WebUI

To add AMP as a management server in Mobility Master:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Airwave.
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2. In the Connect to airwave drop-down list, select Yes.

3. In the Airwave IP address text-box, enter the AirWave server IP.

4. In the SNMP version drop-down list, select the appropriate version.

5. Click Submit.

6. Navigate to Configuration > System > More > General.
7. In MON Receivers, click the newly added AirWave server.

8. In Edit MON Receiver, enter the following detail:

a. In the Profile list drop-down list, select the default-amp profile.

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Execute the following command in the CLI to add AMP as a management server in Mobility Master:
(host)[mm] (config) #mgmt-server primary-server <primary-server-ip> profile default-amp

Enable UCC Monitoring in Mobility Master
By default, UCC monitoring is disabled in Mobility Master. You can enable this setting using the WebUI or CLI.

In the WebUI

To enable UCC monitoring in Mobility Master:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile > Mgmt Config. Select the default-amp profile.
This example uses the default-amp profile.

3. In the Mgmt Config profile, select the UCC Monitoring check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI

Execute the following command in the CLI to enable UCC monitoring:
(host) [mm] (config) #mgmt-server profile default-amp

(host) ^[mm] (Mgmt Config profile “default-amp”)#uccmonitoring-enable

Verify the Configuration
Execute the following command in the CLI to view the management server configuration profile:
(host) [mm] #show mgmt-server profile default-amp

Mgmt Config profile "default-amp" (Predefined (changed))

--------------------------------------------------------

Parameter Value

--------- -----

Stats Enabled

Tag Enabled

Sessions Enabled

Monitored Info - Add/Update Disabled

Monitored Info - Deletion Disabled

Monitored Info - Periodic Snapshot Disabled

Wireless IDS Event Info Disabled



Misc Enabled

Location Enabled

UCC Monitoring Enabled

AirGroup Info Disabled

Inline DHCP stats Enabled

Inline AP stats Enabled

Inline Auth stats Enabled

Inline DNS stats Enabled

Execute the following command in the CLI to view the current Mobility Master configuration with respect to
the management server configuration profile:
(host) [mm] #show running-config | include mgmt-server

Building Configuration...

mgmt-server primary-server 192.0.2.1 profile default-amp

mgmt-server profile "default-ale"

mgmt-server profile "default-amp"

mgmt-server profile "default-controller"

The UCC-AirWave integration is complete.

UCC Limitations
l Voice ALGs are not supported when voice clients are behind a NAT device.

l Media classification does not work when user VLAN has IP NAT configured.

l When using media classification or signaling protocols, UCC score, jitter, delay, and packet loss is calculated
only for voice RTP streams. These metrics are not available for video streams.

l Media classification does not work in split-tunnel forwarding mode.

l When VoIP calls are prioritized using media classification, end-to-end call quality metrics such as Mean
Opinion Score (MOS), delay, jitter, and packet loss are not available.

l UCC score is calculated for voice calls and desktop-sharing sessions only.

l For Lync/Skype for Business calls, MOS is generated only for voice streams. Lync/Skype for Business server
does not generate MOS for video streams, desktop-sharing, and file-transfer sessions.

Upgrade UCM Loadable Service Module
Starting from ArubaOS 8.0, UCM runs as a loadable service module on Mobility Master. You can upgrade the
UCM service module without rebooting Mobility Master. For more information, see Loadable Service Module
on page 853.

Understanding Extended Voice and Video Features
This section describes the other voice and video-related functionalities that are available on Mobility Master.

Enabling WPA Fast Handover
In the 802.1X authentication profile, the Wi-Fi Protected Access (WPA) fast handover feature allows certain
WPA clients to use a pre-authorized PMK, significantly reducing handover interruption. Check with the
manufacturer of your handset to see if this feature is supported. This feature is disabled by default.

This feature supports WPA clients, while opportunistic key caching (also configured in the 802.1X Authentication
profile) supports WPA2 clients.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.
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2. In All Profiles, expand Wireless LAN > 802.1X Authentication. Select the default profile.
This example uses the default profile.

3. In 802.1X Authentication Profile, select the WPA-Fast-Handover check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [md] (config) #aaa authentication dot1x default

(host) ^[md] (802.1X Authentication Profile "default") #wpa-fast-handover

For deployments where there are expected to be considerable delays between the managed device and APs
(for example, in a remote location where an AP is not in range of another AP) you can increase the value for the
bootstrap threshold in the AP System profile to minimize the chance of the AP rebooting due to temporary loss
of connectivity with the managed device.

Scanning VoIP-aware ARM
ARM scanning on an AP during a call affects the voice quality. You can pause the ARM scanning on the AP when
a call is active by turning on the VoIP-aware ARM scanning support to avoid voice quality issues. You can use
the WebUI or CLI to enable VoIP-aware ARM scanning in the ARM profile.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand RF Management > Adaptive Radio Management (ARM). Select the default-a
profile.
This example uses the default-a profile.

3. In Adaptive Radio Management (ARM) profile, select the VoIP Aware Scan check box.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

For additional information on configuring an Adaptive Radio Management profile, see Configuring ARM Profiles
on page 447.

In the CLI
(host) [md] (config) #rf arm-profile default-a

(host) ^[md] (Adaptive Radio Management (ARM) profile "default-a") #voip-aware-scan

Working with Voice over Remote Access Point
Voice traffic support is enhanced on the split-tunnel forwarding mode over a Remote Access Point (RAP). The
voice traffic management for remote and local users are done on Mobility Master. However, the sessions are
created differently for both users. For remote users, the sessions are created on the RAP and for local users,
the sessions are created on Mobility Master. This enhancement provides the following support for the voice
traffic in the split tunnel over remote access point:

l Voice traffic QoS is consistent for both local and remote users.

l All voice ALGs work reliably in split-tunnel forwarding mode when the PBX traffic is destined to flow through
the corporate network.

l Provides voice statistics and counters for remote voice clients in the split-tunnel forwarding mode.

The Flags parameter in the show ucc client-info command is updated to indicate remote users:



(host) [mynode] #show ucc client-info

Client Status:

--------------

Client IP Client MAC Client Name ALG Server(IP) Registration State Call

Status

--------- ---------- ----------- ----- ---------- ------------------ -------

----

192.0.2.22 00:23:33:41:c8:b8 Alex SIP 192.0.2.1 REGISTERED Idle

192.0.2.26 24:77:03:9a:6c:dc John Jabber 192.0.2.3 REGISTERED Idle

AP Name Flags Device Type Home Agent Foreign Agent

------- ----- ----------- ---------- -------------

AP-105 R OS X 192.0.2.25 NA

AP-135 Win 7 192.0.2.25 NA

Total Client Entries:2

Flags: V - Visitor, A - Away, W - Wired, R - Remote, E - External

Understanding Battery Boost
Battery boost is an optional feature that can be enabled for any SSIDs that support voice traffic. This feature
converts all broadcast and multicast traffic to unicast before delivery to the client. Enabling battery boost on
an SSID allows you to set the Delivery Traffic Indication Map (DTIM) interval from 10 to 100 (the previous
allowed values were 1 or 2), equating to 1,000 to 10,000 milliseconds. This longer interval keeps associated
wireless clients from activating their radios for multicast indication and delivery, leaving them in power-save
mode longer, and thus lengthening battery life. The DTIM configuration is performed on the WLAN, so no
configuration is necessary on the client.

An associated parameter available on some clients is the Listening Interval (LI). This defines the interval (in
number of beacons) after which the client must wake to read the Traffic Indication Map (TIM). The TIM
indicates whether there is buffered unicast traffic for each sleeping client. With battery boost enabled, the
DTIM is increased but multicast traffic is buffered and delivered as unicast. Increasing the LI can further
increase battery life, but can also decrease client responsiveness.

Do not enable battery boost if your network includes Polycom SpectraLink devices that use the Push-to-Talk feature.

You can use the WebUI or CLI to enable the battery boost feature and set the DTIM interval in the SSID profile.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Wireless LAN > SSID. Select the default profile.
This example uses the default profile.

3. In SSID Profile, change the DTIM Interval to a longer interval time.

4. Select the Battery Boost check box.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the following commands:
(host) [md] (config) #wlan ssid-profile defaultwlan ssid-profile <profile>
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(host) ^[md] (SSID Profile "default") #battery-boost

(host) ^[md] (SSID Profile "default") #dtim-period <dtim-period>

Enabling LLDP
Link Layer Discovery Protocol (LLDP), is a Layer-2 protocol that allows network devices to advertise their
identity and capabilities on a LAN. Wired interfaces on Aruba APs support LLDP by periodically transmitting
LLDP Protocol Data Units (PDUs) comprised of selected Type-Length-Value (TLV) elements. For a complete list
of supported, see Table 219 and Table 220.

LLDP-MED (Media Endpoint Devices) is an extension to LLDP that supports interoperability between VoIP and
video streaming devices and other networking clients. LLDP-MED network policy discovery lets end-points and
network devices advertise the VLAN, priority levels, and DSCP values used by a voice or video application.

You can use the WebUI or CLI to configure the LLDP profile and select the TLVs to be sent by the AP.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand AP > AP LLDP. Select the default profile.
This example uses the default profile.

3. The AP LLDP profile is divided into two tabs, General and Advanced. The General tab displays only those
configuration settings that often need to be adjusted to suit a specific network. The Advanced tab shows
all configuration settings, including settings that do not need frequent adjustment or should be kept at their
default values. Both basic and advanced settings are described in Table 219.

Parameter Description

General

PDU Transmission Select this check box to enable LLDP PDU Transmission. PDU
Transmission is enabled by default.

Reception of LLDP PDUs Select this check box to enable LLDP PDU Reception. PDU Reception is
enabled by default.

Advanced

Transmit Interval (seconds) The interval between LLDP TLV transmission seconds. Range: 1-3600,
seconds and Default: 30 seconds.

Transmit hold multiplier The Transmit hold multiplier is a value that is multiplied by the transmit
interval to determine the number of seconds to cache learned LLDP
information before that information is cleared.

If the Transmit hold multiplier value is set at its default value of 4, and the
Transmit interval is at its default value of 30 seconds, then learned LLDP
information will be cached for 4x30 seconds, or 120 seconds.

Optional TLVs Select the check boxes in this section to select the optional TLVs the AP
interface sends in LLDP PDUs. The AP will send all optional TLVs by
default.

l port-description: transmit a TLV that gives a description of the AP’s

Table 219: LLDP Profile Configuration Parameters



Parameter Description

wired port in an alphanumeric format.

l system-description: transmit a TLV that describes the AP’s model
number and software version.

l system-name: transmit a TLV that sends the AP name or wired MAC
address.

l capabilities: transmit the system capabilities TLV to indicate which
capabilities are supported by the AP.

l management-address: transmit a TLV that indicates the AP’s
management IP address, in either IPv4 or IPV6 format.

802.1 TLVs Select the check boxes in this section to select the 802.1 TLVs the AP
interface sends in LLDP PDUs. The AP will send all 802.1 TLVs by default:

l port-vlan: transmit the LLDP 802.1 port VLAN TLV. If the native VLAN
is configured on the port, the port-vlan TLV will send that value,
otherwise it will send a value of “0”.

l vlan-name: transmit the LLDP 802.1 VLAN name TLV. The AP sends a
value of "Unknown" for VLAN 0, or "VLAN <number>" for all non-zero
VLAN numbers.

802.3 TLVs Select the check boxes in this section to select the 802.3 TLVs the AP
interface sends in LLDP PDUs. The AP will send all 803.2 TLVs by default:

l mac: transmit the 802.3 MAC/PHY Configuration/Status TLV to
indicate the AP interface’s duplex and bit rate capacity and current
duplex and bit rate settings.

l link-aggregation: transmit the 802.3 link aggregation TLV to indicate
that link aggregation is not supported.

l mfs: transmit the 802.3 Maximum Frame Size (MFS) TLV to show the
AP’s maximum frame size capability.

l power:transmit the 802.3 Power Via media dependent interface (MDI)
TLV to show the power support capabilities of the AP interface.

This parameter is supported by the RAP-3WNP and 130 Series only.

LLDP-MED TLVs Once you have associated an LLDP-MED Network policy profile with this
LLDP profile, you can click the check boxes in this section to select the
LLDP-MED TLVs the AP interface sends in LLDP PDUs. The AP does not
send any LLDP-MED TLVs by default:

l capabilities: transmit the LLDP-MED capabilities TLV. The AP will
automatically send this TLV if it sends any other LLDP-MED TLVs.

l inventory: transmit the LLDP-MED inventory TLV.

l network-policy: transmit the LLDP-MED network-policy TLV.

NOTE: The TLVs in this section cannot be enabled unless you have
associated an LLDP-MED Network policy profile

4. To associate an LLDP-MED network policy profile with the LLDP profile and the LLDP-MED TLVs to be sent
by the AP interface, click the LLDP-MED network policy that appears under the AP LLDP > default
profile in the profile list.

5. If the LLDP profile does not currently reference an LLDP-MED Network Policy profile, you must associate an
LLDP-MED Network Policy profile with the LLDP profile before you can configure any LLDP-MED settings.
In AP LLDP-MED Network Policy Profile, click the + icon to link an LLDP-MED Network Policy profile.
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6. Click Save.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [md] (config) #ap lldp profile <profile>

(host) ^[md] (AP LLDP Profile "<profile>") #clone <profile>

(host) ^[md] (AP LLDP Profile "<profile>") #dot1-tlvs [port-vlan|vlan-name]

(host) ^[md] (AP LLDP Profile "<profile>") #dot3-tlvs [link-

aggregation|mac|mfs|power]

(host) ^[md] (AP LLDP Profile "<profile>") #lldp-med-network-policy-profile <profile>

(host) ^[md] (AP LLDP Profile "<profile>") #lldp-med-tlvs

[capabilities|inventory|network-policy]

(host) ^[md] (AP LLDP Profile "<profile>") #no ...

(host) ^[md] (AP LLDP Profile "<profile>") #optional-tlvs

[capabilities|management-address|port-description|system-description|system-name]

(host) ^[md] (AP LLDP Profile "<profile>") #receive

(host) ^[md] (AP LLDP Profile "<profile>") #transmit

(host) ^[md] (AP LLDP Profile "<profile>") #transmit-hold <transmit-hold>

(host) ^[md] (AP LLDP Profile "<profile>") #transmit-interval <transmit-interval>

You can use the WebUI or CLI to configure the LLDP-MED profile.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand AP > AP LLDP-MED Network Policy. Select the default profile.
This example uses the default profile.

3. The LLDP-MED Network Policy profile is divided into two tabs, General and Advanced. The General tab
displays only those configuration settings that often need to be adjusted to suit a specific network. The
Advanced tab shows all configuration settings, including settings that do not need frequent adjustment or
should be kept at their default values. Both basic and advanced settings are described in Table 220.



Parameter Description

General

LLDP-MED application type Click the LLDP-MED application type drop-down list and select the
application type managed by this profile.

l guest-voice: if the AP services a separate voice network for guest
users and visitors.

l guest-voice-signaling: if the AP is part of a network that requires a
different policy for guest voice signaling than for guest voice media.
Do not use this application type if both the same network policies
apply to both guest voice and guest voice signaling traffic.

l softphone-voice: if the AP supports voice services using softphone
software applications on devices such as PCs or laptops.

l streaming-video: if the AP supports broadcast or multicast video or
other streaming video services that require specific network policy
treatment. This application type is not recommended for video
applications that rely on TCP with buffering.

l video-conferencing: of the AP supports video conferencing
equipment that provides real-time, interactive video/audio services.

l video-signaling: if the AP is part of a network that requires a
different policy for video signaling than for the video media. Do not
use this application type if both the same network policies apply to
both video and video signaling traffic.

l voice: if the AP services IP telephones and other appliances that
support interactive voice services. This is the default application type.

l voice-signaling: Select this application type if the AP is part of a
network that requires a different policy for voice signaling than for the
voice media. Do not use this application type if both the same network
policies apply to both voice and voice signaling traffic.

LLDP-MED application VLAN Specify a VLAN by VLAN ID (0-4094) or VLAN name.

LLDP-MED application VLAN
tagging

Select this check box if the LLDP-MED policy applies to a to a VLAN that is
tagged with a VLAN ID or untagged. The default value is untagged.

NOTE: When an LLDP-MED network policy is defined for use with an
untagged VLAN, then the L2 priority field is ignored and only the DSCP
value is used.

Advanced

LLDP-MED application Layer-
2 priority

Specify a 802.1p priority level for the specified application type, by
entering a value from 0 to 7, where 0 is the lowest priority level and 7 is
the highest priority.

LLDP-MED application
Differentiated Services Code
Point

Select a DSCP priority value for the specified application type by
specifying a value from 0 to 63, where 0 is the lowest priority level and 63
is the highest priority.

Table 220: LLDP-MED Network Policy Profile Configuration Parameters

4. Click Save.

5. Click Pending Changes.
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6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
(host) [md] (config) #ap lldp med-network-policy-profile <profile>

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #application-type

{guest-voice|guest-voice-signaling|softphone-voice|streaming-video|video-conferencing|video-

signaling|voice|voice-signaling}

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #clone <profile>

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #dscp <dscp>

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #l2-priority <l2-priority>

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #no ...

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #tagged

(host) ^[md] (AP LLDP-MED Network Policy Profile "default") #vlan <vlan>

The following commands create a LLDP MED network policy profile for streaming video applications and marks
streaming video as high-priority traffic:
(host) [md] (config) #ap lldp med-network-policy-profile vid-stream

(host) ^[md] (AP LLDP-MED Network Policy Profile "vid-stream") #dscp 48

(host) ^[md] (AP LLDP-MED Network Policy Profile "vid-stream") #l2-priority 6

(host) ^[md] (AP LLDP-MED Network Policy Profile "vid-stream") #tagged

(host) ^[md] (AP LLDP-MED Network Policy Profile "vid-stream") #vlan 10

Next, the LLDP MED network policy profile is assigned to an LLDP profile, and the LLDP profile is associated
with an AP wired-port profile:
(host) [md] (config) #ap lldp profile video1

(host) ^[md] (AP LLDP Profile "video1") #lldp-med-network-policy-profile vid-stream

(host) ^[md] (AP LLDP Profile "video1") #!

(host) ^[md] (config)ap wired-port-profile corp2

(host) ^[md] (AP wired port profile "corp2")lldp-profile video1
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Chapter 42
AirGroup

AirGroup is a unique enterprise-class capability that leverages zero configuration networking to allow mobile
device technologies, like the AirPrint wireless printer service or the AirPlay mirroring service, to communicate
over a complex access network topology.

Starting from ArubaOS 8.0, AirGroup runs only on Mobility Master or stand-alone controllers. AirGroup does not run
on managed devices.

This section describes the following AirGroup topics:

l Zero Configuration Networking on page 919

l AirGroup Solution on page 920

l AirGroup in ArubaOS 8.0 on page 920

l AirGroup Value Additions in Mobility Master on page 921

l AirGroup Services on page 921

l AirGroup Deployment Models on page 922

l AirGroup Changes from ArubaOS 6.x on page 922

l AirGroup Features Deprecated in ArubaOS 8.0 on page 922

l AirGroup Features on page 922

l Prerequisites to Enable AirGroup on page 930

l Defining ClearPass Policy Manager Server on page 944

l Best Practices and Limitations on page 960

l Troubleshooting and Log Messages on page 962

Zero Configuration Networking
Zero configuration networking is a technology that enables service discovery, address assignment, and name
resolution for desktop computers, mobile devices, and network services. It is designed for flat, single-subnet IP
networks such as the home network of a user.

The suite of protocols introduced by Apple® for zero configuration networking over IP is referred to as
Bonjour®. Bonjour is supported by most of the Apple product lines including the Mac OS X® operating
system, iPhone®, iPod®, iPad®, Apple TV® and AirPort Express®. Bonjour is also included within popular
software programs such as Apple iTunes®, Safari, and iPhoto®. Bonjour® can be installed on computers
running Microsoft Windows® and is supported by most new network-capable printers.

Bonjour locates devices such as printers, other computers, and the services offered by these devices by using
multicast Domain Name System (mDNS) service records. Bonjour uses the link-scope multicast addresses, so
each query or advertisement is limited to a specific VLAN. In large universities and enterprise networks,
Bonjour capable devices connect to the network using different VLANs. As a result, an iPad on one enterprise
VLAN will not be able to discover the Apple TV that resides on another VLAN. Broadcast and multicast traffic is
filtered out of a wireless LAN network in an effort to reduce network traffic. This inhibits Bonjour (mDNS)
services, which rely on multicast traffic.

ArubaOS supports Digital Living Network Alliance (DLNA); a network standard that is derived from UPnP
(Universal Plug and Play) in addition to the mDNS protocol. DLNA uses the Simple Service Discovery Protocol
(SSDP) for service discovery on the network. DLNA provides the ability to share digital media between
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multimedia devices, like Windows and Android, similar to how mDNS supports Zero Configuration Networking
to Apple devices and services. ArubaOS ensures that DLNA seamlessly works with the current mDNS
implementation. All the features and policies that are applicable to mDNS are extended to DLNA. This ensures
full interoperability between compliant devices.

AirGroup Solution
AirGroup leverages key elements of Aruba’s solution portfolio including the ArubaOS and Aruba ClearPass
Policy Manager.

AirGroup performs the following functions:

l Enables users to discover network services across IP subnet boundaries in enterprise wireless and wired
networks.

l Enables users to access the available AirGroup services such as AirPrint and AirPlay.

l Permits users to access conference room Apple TV during presentations, based on group-based access
privileges.

l Provides and maintains seamless connectivity of clients and services across VLANs and SSIDs. It minimizes
the mDNS traffic across the wired and wireless network, thereby preserving wired network bandwidth and
WLAN airtime.

With AirGroup:

l An AirGroup operator—an end user such as a student can register personal devices. The devices registered
by the operator can then automatically be shared with each other.

l Each user can create a user group, such as friends and roommates with whom the user can share the
registered devices.

l AirGroup administrators can register and manage an organization’s shared devices such as printers or
conference room Apple TV. The administrator can grant global access to each device, or limit access based
on user name, role, or location.

This chapter provides configuration information for network administrators to enable AirGroup and ClearPass
Policy Manager and to register devices with ClearPass Guest.

AirGroup also enables context awareness for services across the network:

l AirGroup is aware of personal devices. An Apple TV in a dorm room, for example, can be associated with the
student who owns it.

l AirGroup is aware of shared resources, such as an Apple TV in a meeting room, a printer available to multiple
users, or AirPlay in a classroom where a laptop screen is projected on HDTV monitor.

l AirGroup is location aware. For example, an iPad is presented with the closest printer instead of all the
printers in a building. If a user in a conference room wants to use an Apple TV to project a MacBook screen
on an HDTV monitor, the location-aware AirGroup shows the Apple TV that is closest to that user.

AirGroup in ArubaOS 8.0
Starting from ArubaOS 8.0, AirGroup runs as a Loadable Service Module (LSM) on Mobility Master.

The AirGroup application uses the OpenFlow infrastructure to receive the signaling messages from the
managed devices and also installs/deletes flows on the managed devices for the calls.



AirGroup Value Additions in Mobility Master
AirGroup provides the following value additions in Mobility Master:

l Enables AirGroup to run as a service on Mobility Master and managed devices do not run the same. This
results in better scalability.

l AirGroup devices are maintained on Mobility Master in a centralized manner. The AirGroup domain feature
is not required for visibility across managed devices.

l AirGroup supports LSM infrastructure for upgrading to a newer version independent of ArubaOS version.

l AirGroup provides aggregation of statistical information at a centralized entity.

AirGroup Services
An administrator may enable or disable individual AirGroup services by using the WebUI or CLI. The following
AirGroup services are pre-configured and are available as part of the factory default configuration:

l AirPlay

l AirPrint

l Amazon TV

l Chat or Messages

l DIAL

l DLNA Media

l DLNA Print

l GoogleCast

l iTunes

l RemoteMgmt

l Sharing

l Static

The following AirGroup services are enabled by default:

l AirPlay — The AirPlay service allows wireless streaming of music, video, and slide shows from iOS device to
Apple TV and other devices that support the AirPlay feature.

l AirPrint — The AirPrint service allows to print from an iPad, iPhone, or iPod Touch directly to any AirPrint
compatible printers.

l DIAL — Wi-Fi-enabled streaming devices like Google Chromecast, Roku, Amazon FireTV, and more advertise
the Discovery and Launch (DIAL) protocol for clients to search for an available device on a wireless network.
Once a device is discovered, the protocol synchronizes information on how to connect to the device. The
streaming device connects to a television through an HDMI port to wirelessly streams video and music
content to the TV from a smart phone (both Android and iOS), tablet, laptop, or desktop computer devices.

The following AirGroup services are disabled by default:

l Chat or Messages — The Chat or Messages service provides messaging on Apple devices uses this service.

l DLNA Media — Applications such as Windows Media Player use this service to browse and play media
content on a remote device.

l DLNA Print — This service is used by printers which support DLNA.

l GoogleCast — Google Chromecast uses this service to stream video and music content from a smart phone
to a TV screen using a wireless network.

l iTunes — iTunes service is used by iTunes Wi-Fi sync and iTunes home-sharing applications across all Apple
devices. For best practices, see the Apple iTunes Wi-Fi Synchronization and File Sharing on page 960.
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l RemoteMgmt — Use this service for remote login, remote management, and FTP utilities on Apple devices.

l Sharing — Applications such as disk sharing and file sharing, use the service ID that are part of this service
on one or more Apple devices. For best practices, see the Apple iTunes Wi-Fi Synchronization and File
Sharing on page 960.

AirGroup also supports custom and allowall services. For more information, see Defining ClearPass Policy Manager
Server on page 944.

AirGroup Deployment Models
AirGroup supports following deployment models:

l Mobility Master-Managed Device

l Stand-alone Controller

Mobility Master-Managed Device
Mobility Master is the root of a network hierarchy. A single Mobility Master oversees a number of managed
devices that can be co-located or off-campus.

Stand-alone Controller
AirGroup supports domains for stand-alone controllers. This feature, for example, allows iPad users on one
stand-alone controller to discover Apple TV available on another stand-alone controller if both stand-alone
controllers are part of the same domain.

AirGroup Changes from ArubaOS 6.x
The following is a list of AirGroup changes from ArubaOS 6.x to ArubaOS 8.0:

l Ability to define more than one hop for ap-name based location policy.

l Support for disallowed named VLAN policy for users and servers.

l Extension of support for disallowed VLAN policy for users in addition to servers.

l Extension of support for disallowed role policy for servers in addition to users.

l Enhanced visibility of servers, users, traffic trend, and bandwidth utilization in Dashboard.

l Support for wired users.

AirGroup Features Deprecated in ArubaOS 8.0
The following AirGroup features are deprecated in ArubaOS 8.0:

l Domain is no longer supported in Mobility Master-Managed Device topology. Domain is supported in
stand-alone controller topology.

l Global credits mechanism is removed.

l Active wireless discovery mechanism is removed.

l Location discovery parameter is deprecated.

AirGroup Features
This section describes the following AirGroup features:

l Number of Hops on page 923



l Named VLANs on page 923

l Dashboard on page 924

l Auto-Association and AirGroup Policy on page 924

l ClearPass Policy Manager and ClearPass Guest on page 924

l Group-Based Device Sharing on page 925

l IPv6 Support on page 925

l Bluetooth-Based Discovery and AirGroup on page 925

l DLNA UPnP Support on page 925

l Domain for Stand-alone Controller on page 926

l mDNS AP VLAN Aggregation on page 926

l mDNS Multicast Response Propagation on page 927

l mDNS Static Records on page 927

l Scalability on page 928

Number of Hops
To support location based sharing, AirGroup allows an administrator to define the number of hops or the
neighborhood of access points an AirGroup server is shared with. This allows an administrator to deploy and
administer AirGroup in large physical places with many access points and clients. An administrator can define
the hop count as 1, 2, 3, or no neighborhood.

The hop count policy is available for per server AirGroup policy. Service based auto-associate policy considers
single hop RF neighbor APs for visibility of server. The hop count policy is allowed for a maximum of 10 servers
when the hop count is 2 or 3. The hop count policy is not available in ClearPass Policy Manager. The multi-hop
neighbor table for a server is refreshed every 30 minutes. If an access point is connected or removed in 2 or 3
hop neighborhood of the server, it takes up to 30 minutes for the policy to apply this change. To configure
number of hops, see Configuring Number of Hops on page 941

Named VLANs
Use a named VLAN (which can have a VLAN or a VLAN pool) to define and share relationships in a Mobility
Master. For example, a named VLAN "faculty" can have access to AirPlay and AirPrint services whereas another
named VLAN "students" can have access to only the AirPrint service. Only 100 VLAN IDs can be configured per
named VLAN.

Named VLANs can be disallowed. The disallowed VLANs can be configured at AirGroup service level or AirGroup
global level.

VLAN IDs can be disallowed. The disallowed VLAN IDs can be configured at AirGroup service level and AirGroup
global level. The disallow VLAN takes only a single VLAN ID. Any value beyond the range of 1 to 4093 is
considered as a named VLAN value.

When global disallow server is configured for a VLAN, then records from any server on this VLAN are not
cached.

When global disallow user is configured for a VLAN, then response is not sent from a stand-alone controller for
any query from this VLAN.

Roles can be disallowed for users and servers. The disallowed role for users and servers can be configured only
at AirGroup service level.

To configure named VLANs, see Configuring per-VLAN AirGroup Control on page 950
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Dashboard
The AirGroup dashboard provides enhanced visibility into AirGroup. The combined view of all AirGroup devices
and usage in the network is available under the AirGroup dashboard of every node in the hierarchy, regardless
of deployment type. For additional information, see AirGroup on page 724.

Auto-Association and AirGroup Policy
Auto-association allows AirGroup users to discover nearby AirGroup servers. Auto-association ensures that all
the AirGroup users associated to an AP-group, AP-FQLN, or AP and its neighbors discover the AirGroup servers.
By default, auto-association is disabled on all AirGroup servers. An administrator can enable auto-association
for each AirGroup server separately and configure AP-name, AP-group, or AP-FQLN for auto-association. Auto-
association can be enabled for a complete service, which allows all the AirGroup servers who advertise that
service to be auto-associated with the configured parameter. If auto-association is enabled, other location-
based policy configuration for the AirGroup server on ClearPass Policy Manager or CLI is not honored. Auto-
association is applicable only for wireless AirGroup servers.

By default, all AirGroup servers are visible to every AirGroup user. AirGroup allows an administrator to
configure managed device-based policies for AirGroup servers to limit the visibility of AirGroup servers to
destined AirGroup users. To limit the AirGroup server’s visibility to intended AirGroup users, administrator can
configure shared user-list, shared role-list, and shared group-list for each AirGroup server.

Administrator can also configure location-based policies for AirGroup devices. For example, administrator can
configure if an AirGroup server is visible over a broader area than auto-association configuration. In location-
based configuration, administrator can configure AP names, AP groups, and AP FQLNs. Location-based policy
configuration limits the AirGroup server’s visibility to AirGroup users who are associated to configured APs, its
neighbors, AP-groups, or AP-FQLNs. Administrator can choose whether to consider the neighborhood of the
configured AP names.

If an AirGroup policy is configured on ClearPass Policy Manager and CLI, the CLI configuration takes
precedence over the ClearPass Policy Manager configuration. The stand-alone controller-based policy
configuration is persistent for AirGroup. To configure auto association, see Configuring Auto Association on
page 942

ClearPass Policy Manager and ClearPass Guest
ClearPass Policy Manager delivers identity and device-based network access control across any wired, wireless,
and VPN infrastructure. AirGroup can be deployed with ClearPass Policy Manager (recommended for large
WLANs) or without ClearPass Policy Manager in smaller networks. AirGroup enables context awareness for
services across the network and supports a typical customer environment with shared, local, and personal
services available to mobile devices. AirGroup and ClearPass Policy Manager work together to allow users to
share personal devices.

l An AirGroup administrator uses ClearPass Policy Manager to authorize end users to register their personal
devices.

l An AirGroup operator registers their personal devices (such as an Apple TV) in the ClearPass Guest portal.

l AirGroup enabled Mobility Master sends AirGroup queries to ClearPass Policy Manager for information on
the registered devices and associates the access privileges of each device to its allowed services.

l ClearPass Policy Manager sends the Change of Authorization (CoA) to notify the Mobility Master about the
registered devices.

To configure AirGroup-ClearPass Policy Manager interface, see Configuring AirGroup-ClearPass Policy Manager
Interface on page 943

For more information on ClearPass Policy Manager, see the ClearPass Policy Manager User Guide and
ClearPass Guest Deployment Guide.



Group-Based Device Sharing
AirGroup supports sharing AirGroup devices such as Apple TV, Printer, and so on to a User Group using
ClearPass Policy Manager. This is an add-on to the existing device sharing mechanisms such as username, user-
role, and location based device sharing using ClearPass Policy Manager. A User Group is a logical association of
users.

A user can be a part of groups that are defined in an active directory. User group attribute for each user is
identified when a user is associated to a wireless network. This is initially identified in authentication module
(authentication process). Authentication module sends RADIUS request to RADIUS server as a part of 802.1X
authentication and the RADIUS server fetches the user group attribute in the form of vendor specific attribute
(VSA) from the Active Directory. Subsequently, AirGroup obtains this information from authentication module.
This is similar to user’s role, however, a user can be a part of more than one groups.

When AirGroup learns about a new device, it interacts with ClearPass Guest to obtain the shared attributes.
The shared group(s) attribute is also obtained along with the following attributes:

l Device owner

l Shared location(s)

l Shared user(s)

l Shared role(s)

The group based device sharing feature is supported in ClearPass Policy Manager 6.3 and higher versions.

A user can be a part of maximum 32 user groups. This needs to be defined as comma separated string in Active
directory. Each group name can contain a maximum of 63 characters and the entire group name strings cannot
exceed 320 characters.

The AirGroup policy engine is enhanced to compare the user’s group membership and shared groups to
determine if a user can discover the specific AirGroup server or not.

IPv6 Support
AirGroup supports IPv6 enabled users (for example, iPad) and servers (Apple TV, AirPrint printers). All the
AirGroup features are available for both IPv4 and IPv6 clients. On any dual stack client, you must restart the
client if the IPv4 interface is disabled.

Bluetooth-Based Discovery and AirGroup
Apple devices support Bluetooth-based device discovery mechanism, which allows an Apple device to discover
an Apple TV that is within the Bluetooth range.

AirGroup supports only mDNS-based device discovery and does not support Bluetooth-based device discovery
mechanism.

DLNA UPnP Support
AirGroup supports DLNA (Digital Living Network Alliance); a network standard that is derived from UPnP
(Universal Plug and Play) in addition to the mDNS protocol.

Cache refresh mechanism is not required for DLNA, as the DLNA devices advertise their service periodically.
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Domain for Stand-alone Controller
ArubaOS supports domains for stand-alone controllers. This feature allows, for example, iPad users on one
stand-alone controller to discover an Apple TV available on another stand-alone controller if both stand-alone
controllers are part of the same domain. All stand-alone controllers in a domain communicate with each other.

AirGroup domain is not supported on Mobility Master or managed devices. AirGroup domain is supported only on
stand-alone controllers.

Configure and use up to 100 AirGroup domains where each AirGroup domain can support up to 100 IP addresses.

AirGroup allows one or more domains to be part of an AirGroup active-domain.

IPv6 is supported in Mobility Master-Managed Device topology but the IPv6 address of Mobility Master is not
supported in AirGroup domain. The IPv4 address is supported only in the following scenarios:

l When forming an AirGroup cluster, only IPv4 addresses are supported.

l AirGroup supports IPv4 RADIUS clients only.

The managed device can identify any IPv6 AirGroup servers, only when they proactively advertise their services.

To configure domain for stand-alone controller, Configuring Domain for Stand-alone Controller on page 956

mDNS AP VLAN Aggregation
All mDNS/SSDP packets are terminated on a Mobility Master or a stand-alone controller. The AirGroup works
as a unicast querier and responder on behalf of mDNS/SSDP devices and eliminates the propagation of
multicast mDNS/SSDP traffic in the WLAN.

The mDNS AP VLAN aggregation allows the discovery of wired mDNS/SSDP devices which do not have L2
connectivity with the Mobility Master or a stand-alone controller or which do not trunk on the Mobility Master
or a stand-alone controller. An AP, which is in the same VLAN as the wired mDNS/SSDP device which does not
trunk on Mobility Master or a stand-alone controller receives and forwards the mDNS/SSDP packets from the
wired mDNS/SSDP devices to the Mobility Master or a stand-alone controller. The AP forms a separate split
tunnel (0x8000) and aggregates all mDNS/SSDP traffic.

l The split tunnel is formed only when both AP Multicast Aggregation (under AP System Profile) and
AirGroup parameters are enabled. If either AP Multicast Aggregation or AirGroup parameter is
disabled, the split tunnel is not formed.

l The AP Multicast Aggregation parameter is disabled by default.

l When AP Multicast Aggregation parameter is enabled from disabled state, an mDNS/SSDP device
discovery packet is sent to the VLAN in which the split tunnel is created if the AirGroup parameter is also
enabled.

l If an AP is provisioned with an uplink VLAN, then the split tunnel between the AP and the managed device is
formed with the uplink VLAN, otherwise the native VLAN is used.

l When the native VLAN is changed, the tunnel is recreated.

l Irrespective of which VLAN (uplink VLAN or native VLAN) is used, the split tunnel is in the same VLAN as the
wired mDNS/SSDP devices.

l Configure the VLAN in which the wired mDNS/SSDP device terminates in the managed device. Do not create
an SVI or attach a port to the VLAN.

To configure mDNS AP VLAN aggregation, see Configuring mDNS AP VLAN Aggregation on page 953



mDNS Multicast Response Propagation
In the AirGroup solution, all mDNS packets are terminated on the Mobility Master. The AirGroup solution
works as a unicast querier and responder on behalf of mDNS capable devices and eliminates the propagation
of multicast mDNS traffic in the WLAN.

For some services, terminating the mDNS packets at the Mobility Master does not allow the initial
advertisement to reach other devices. For example, the iChat or Messages Application uses mDNS response
packet to announce the arrival of a new user. The new user entry does not reach the existing users if the
announcement or response packet is not multicast. The exiting users get to know about the new user only
after they send a periodic query.

mDNS multicast response propagation allows services to multicast the response packet. This allows the
existing users to instantly see a new user when a new user logs in.

The mDNS response packet for iChat or Messages Application is multicast across all VLANs that are trunked in
the Mobility Master except:

l If the VLAN is globally disallowed.

l If the iChat service is disallowed for a VLAN.

In both scenarios, the mDNS response message is not propagated and:

l mDNS queries for iChat records from a disallowed VLAN are dropped.

l mDNS responses are not propagated to a disallowed VLAN.

l When an allowed VLAN is disallowed, users disappear from the buddy list of other users when they query
for the service next time. This may take a maximum of one hour.

l When a disallowed VLAN is allowed, wildcard queries are sent to all users for discovery.

The AirGroup cache is updated with iChat records thus ensuring that the cache of the existing users is also
updated. ClearPass Policy Manager/CLI policies are not applied to iChat records because the mDNS response is
multicast. The mDNS response messages are multicast whenever the status of a user changes and similar
messages are also multicast.

The response for mDNS iChat queries is L2 unicast back to the sender from the AirGroup cache while the
mDNS response packets are L3 multicast.

When the iChat service is disabled from enabled state, new messages are neither propagated nor responded
until they query for the service again. After an hour, the existing users disappear because query and responses
are not honored. When the iChat service is enabled, discovery packets are sent to determine all iChat users.

The performance of an iChat server is not the same as the performance of an AirGroup server. The number of iChat
servers supported is less than the number of AirGroup servers supported.

mDNS Static Records
AirGroup processes mDNS packets advertised by servers. When a query arrives from a user, AirGroup
responds with the appropriate cache entries and the relevant policies. AirGroup allows an administrator to
create mDNS static records as group or individual records and add them to cache, when a server is:

l not mDNS compliant.

l connected to a VLAN that is not trunked to the AirGroup supported managed device.

The administrator can add these records manually to the cache using CLI commands for the servers that
adhere to the above conditions.

Remember the following points when you create mDNS static records and add them to the cache:
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l The mDNS static records do not expire as there is no cache refresh for static records. These static records
can be deleted by an administrator.

l The Administrator needs to ensure that the relevant records are updated manually, when the IP address of
a server is changed.

l The Disallow role policy configured on the CLI is accepted for static records. The Disable service policy is
accepted while responding to a query. Administrator has the privilege to configure static records of a
disabled service. Disallow vlan is not applicable for static records.

l ClearPass Policy Manager policies work with static servers.

To configure mDNS static records, see Creating mDNS Static Records on page 955

Scalability
AirGroup can scale to support up to 100,000 devices in which up to 17,000 servers can exist.

Scalability Limit in Stand-alone Controller
Table 221 lists the total number of AirGroup servers and users supported by different stand-alone controller
models:

Stand-alone Controller Model
Number of
AirGroup
Servers

Number of
AirGroup Users

7240 10000 20000

7220 7000 15000

7210 5000 10000

7205 2000 6000

7030 1000 3000

7024 600 1400

7010 500 1500

7005 300 700

Table 221: AirGroup Server and User Limits in Stand-alone Controller

In stand-alone deployment, there is a scaling limit of 2,000 AirGroup servers and 16,000 AirGroup users for all stand-
alone controllers. If you require more servers and users than the prescribed limit, configure multiple stand-alone
controllers.

The scalability limits are based on:

l Memory Utilization

l CPU Utilization



Memory Utilization

The memory utilization is affected by the number of AirGroup servers and users in an AirGroup cluster. In an
AirGroup cluster, the total number of AirGroup servers and users cannot exceed the limit defined by the top-
end stand-alone controller. For example, in an AirGroup cluster of one 7005 stand-alone controller and two
7210 stand-alone controllers, the cluster limit is determined as per the scaling limit of the top-end stand-alone
controller which is the 7210 stand-alone controller. For the 7005 stand-alone controller in the cluster, the
platform limit of the 7005 stand-alone controller is applied.

CPU Utilization

The CPU utilization is measured by the rate at which a stand-alone controller receives mDNS packets. The rate
of mDNS packets in the cluster depends on the number of AirGroup servers, users, and number of applications
installed on these devices. The rate of mDNS packets handled by the supported stand-alone controller varies.
Table 222 displays the total number of mDNS packets received per second by supported the stand-alone
controller:

Stand-alone Controller Model
mDNS packets per
second (pps)

7240 100

7220 60

7210 60

7205 40

7030 50

7024 50

7010 30

7005 30

Table 222: mDNS Packet Limits in Stand-alone Controller

Use the following command to determine the number of mDNS packets received per second by a managed
device:
show airgroup internal-state statistics

Issue this command multiple times to measure the time difference and the mDNS packet count.

Maximum Number of iChat Users
The maximum number of iChat users is limited to 2000. Each iChat user is an mDNS server and their
announcement messages are L2 multicast.

In an AirGroup domain with multiple stand-alone controllers:
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l A stand-alone controller sends the response from an mDNS device for iChat service to other stand-alone
controllers in the domain. This is in addition to a stand-alone controller performing L2 multicast of the
message to all VLANs.

l The corresponding stand-alone controller multicasts the message to all the VLANs that are trunked in it.

l When a user moves from one stand-alone controller to another, two user entries exist in the user cache for
the same user until the user entry is deleted from the first stand-alone controller. The two user entries exist
because the IP address, which is part of the mDNS payload, changes when a user moves from one stand-
alone controller to another. If IP mobility is enabled, only one user entry exists because the user retains the
same IP address in the domain.

Prerequisites to Enable AirGroup
Before enabling AirGroup, complete the following prerequisites:

l Enable OpenFlow on page 930

l Bind User VLANs on page 930

l Enable OpenFlow in User Role and Virtual AP on page 931

l Configure Management Server Profile on page 932

l Enable Deep Packet Inspection on page 932

l Enable Firewall Visibility on page 933

Enable OpenFlow
Enable OpenFlow on Mobility Master and managed devices. Enable OpenFlow on the /mm node hierarchy.

In the WebUI
The following procedure configures OpenFlow on the Mobility Master using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile.

3. Select openflow-controller.

4. In openflow-controller, select the ofc-state check box.

5. Click Save.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following commands configure OpenFlow on the Mobility Master using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #openflow-controller

(host) [mm] (openflow-controller) #openflow-controller-enable

(host) [mm] (openflow-controller) #write memory

Bind User VLANs
Bind the user VLANs to the OpenFlow profile on the managed devices. Bind the user VLANs on the /md node
hierarchy.



In the WebUI
The following procedure binds the user VLANs to the OpenFlow profile on the managed devices using the
WebUI:

1. In the Managed Device hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile.

3. Select Openflow-profile.

4. In Openflow-profile, select the State check box.

5. In controller-ip, enter the IP address and port number of the Mobility Master.

6. In bind-vlan, enter the OpenFlow VLAN to the current list.

7. Click Save.

8. Click Pending Changes.

9. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following commands bind the user VLANs to the OpenFlow profile on the managed devices using the CLI:
(host) [mynode] #cd /md

(host) [md] #configure terminal

(host) [md] (config) #openflow-profile

(host) [md] (Openflow-profile) #openflow-enable

(host) [md] (Openflow-profile) #controller-ip <MM-ip> <port>

(host) [md] (Openflow-profile) #bind-vlan <list of user vlans>

(host) [md] (Openflow-profile) #write memory

Enable OpenFlow in User Role and Virtual AP
Enable OpenFlow in the user-role and the virtual AP profile. Enable OpenFlow in the user-role and virtual AP in
the /md node hierarchy.

In the WebUI
The following procedure enables OpenFlow in the user-role and virtual AP on the managed devices using the
WebUI:

1. In the Managed Device node hierarchy, navigate to Configuration > Roles & Policies.

2. In the Roles tab, select an existing role.

3. In the Roles > <custom-role> section, click Show Advanced View.

4. Under More, expand Network.

5. In the Open flow drop-down list, select Enabled.

6. Click Submit.

7. In the Managed Device node hierarchy, navigate to Configuration > System > Profiles.

8. In All Profiles, expand Wireless LAN > Virtual AP.

9. Select default profile.

This example uses the default profile.

10.In the default Virtual AP profile, expand Advanced.

11.Select the Openflow Enable check box.

12.Click Save.

13.Click Pending Changes.
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14.In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following commands enable OpenFlow in the user-role and virtual AP on the managed devices using the
CLI:
(host) [mynode] #cd /md

(host) [mynode] #configure terminal

(host) [md] (config) #user-role <user-role>

(host) [md] (config-submode) #openflow-enable

(host) [md] (config-submode) #!

(host) [md] (config) #wlan virtual-ap <virtual-ap>

(host) [md] (Virtual AP profile "<virtual-ap>") #openflow-enable

(host) [md] (Virtual AP profile "<virtual-ap>") #write memory

Configure Management Server Profile
Configure the management server profile to send AMON feeds to the Mobility Master for various statistics.
Configure the management server profile in the /mm node hierarchy.

In the WebUI
The following procedure configures management server profile on the Mobility Master using the WebUI:

1. In the Mobility Master node hierarchy, navigate to Configuration > System > Profiles.

2. In All Profiles, expand Controller Profile.

3. Select Mgmt Config.

4. In Mgmt Config profile, click the + icon.

5. In the Profile name field, enter the name of the management server profile.

6. Select the AirGroup Info check box.

7. Click Save.

8. In the Mobility Master node hierarchy, navigate to Configuration > System > More.

9. In MON Receivers, click the + icon.

10.In New MON Receivers, enter the following details:

a. In the Server field, enter the IP address of the Mobility Master

b. In the Profile list drop-down list, select the newly created management server profile.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following commands configure management server profile on the Mobility Master using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #mgmt-server profile <profile-name>

(host) [mm] (Mgmt Config profile "<profile-name>") #airgroup-info enable

(host) [mm] (Mgmt Config profile "<profile-name>") #!

(host) [mm] (config) #mgmt-server primary-server <MM-IP> profile <profile-name>

(host) [mm] (config) #write memory

Enable Deep Packet Inspection
Enable Deep Packet Inspection (DPI) on the managed devices. Enable DPI on the /md node hierarchy.



In the WebUI
The following procedure enables DPI on the managed devices using the WebUI:

1. In the Managed Network node hierarchy, navigate to Configuration > Services > Firewall.
2. Expand Global Settings.

3. In the Enable deep packet inspection drop-down list, select Enabled.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following commands enable DPI on the managed devices using the CLI:
(host) [mynode] #cd /md

(host) [md] #configure terminal

(host) [md] (config) #firewall

(host) [md] (config-submode) #dpi

(host) [md] (config) #write memory

Enable Firewall Visibility
Enable firewall visibility on the managed devices to view the traffic analysis on the Mobility Master dashboard.
This is an optional configuration. Enable firewall visibility on the /md node hierarchy.

In the WebUI
The following procedure enables firewall visibility on the managed devices using the WebUI:

1. In the Managed Device node hierarchy, navigate to Configuration > Services > Firewall.
2. Expand Global Settings.

3. In the Enable firewall visibility drop-down list, select Enabled.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
The following command enables firewall visibility on the managed devices using the CLI:
(host) [mynode] #cd /md

(host) [md] #configure terminal

(host) [md] (config) #firewall-visibility

(host) [md] (config) #write memory

Configuring AirGroup
AirGroup features are integrated with the WLAN Mobility Master. The Mobility Master also supports optional
integration with ClearPass Policy Manager. Trunk all VLANs with wired devices (like printers) on the managed
devices.

If your deployment requires ClearPass Policy Manager integration, complete the procedures described in ClearPass
Policy Manager User Guide and ClearPass Guest Deployment Guide before performing the steps described in this
section.

Use the following links to configure AirGroup:

l Configuring Global AirGroup Parameters on page 934
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l Viewing Status of Global AirGroup Parameters on page 935

l Defining Service on page 935

l Configuring Service-Based Policy on page 936

l Enabling Service on page 937

l Disabling Service on page 938

l Enabling Allowall Service on page 938

l Deleting Service on page 938

l Viewing List of Services on page 939

l Viewing List of Blocked Services on page 940

l Configuring Server-Based Policy on page 940

l Configuring Number of Hops on page 941

l Configuring Auto Association on page 942

l Viewing List of Servers on page 942

l Configuring AirGroup-ClearPass Policy Manager Interface on page 943

l Defining ClearPass Policy Manager Server on page 944

l Configuring ClearPass Policy Manager Server Options on page 945

l Assigning ClearPass Policy Manager Server to ClearPass Policy Manager Server Group on page 947

l Viewing ClearPass Policy Manager Configuration on page 947

l Assigning ClearPass Policy Manager Server or RFC 3576 Server to AirGroup on page 949

l Defining ClearPass Policy Manager Server Group on page 948

l Defining RFC 3576 Server on page 948

l Assigning ClearPass Policy Manager Server or RFC 3576 Server to AirGroup on page 949

l Viewing ClearPass Policy Manager Device Registration on page 950

l Configuring per-VLAN AirGroup Control on page 950

l Configuring per-VLAN AirGroup Control on page 950

l Viewing VLAN Table on page 953

l Configuring mDNS AP VLAN Aggregation on page 953

l Enabling mDNS AP VLAN Aggregation on page 954

l Disabling mDNS AP VLAN aggregation on page 954

l Creating mDNS Static Records on page 955

l Configuring Domain for Stand-alone Controller on page 956

l Deleting Domain for Stand-alone Controller on page 956

l Viewing Domain for Stand-alone Controller on page 957

l Configuring AirGroup Active-Domain on page 957

l Removing AirGroup Active-Domain on page 958

l Deleting AirGroup Active-Domain on page 959

l Viewing AirGroup Active-Domain on page 959

Configuring Global AirGroup Parameters
Configure the global AirGroup parameters using the WebUI or the CLI.

In the WebUI
To configure the global AirGroup parameters using the WebUI:



Before configuring AirGroup parameters by using the WebUI, choose Mobility Master in the configuration hierarchy.

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click General.
3. In the MDNS drop-down, select Enabled.

4. In the DLNA drop-down, select Enabled.

5. In the IPv6 drop-down , select, Enabled.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure global AirGroup parameters using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup dlna

(host) [mm] (config) #airgroup ipv6

(host) [mm] (config) #airgroup mdns

Viewing Status of Global AirGroup Parameters
View the status of the following global AirGroup parameters:

l DLNA

l IPv6

l mDNS

In the WebUI
To view the status of global AirGroup parameters using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click General.

In the CLI
To view the status of global AirGroup parameters using the CLI:
(host) [mynode] #show airgroup status

AirGroup Information

--------------------

Feature Status

------- ------

MDNS Disabled

DLNA Enabled

Enforce Registration Disabled

IPV6 Enabled

Defining Service
The DLNA service IDs are colon separated and the service ID should have the following format to discover
DLNA server or devices with the maximum label size of 128 characters:
urn:domain-name:device:deviceType:ver

urn:domain-name:service:serviceType:ver
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For example, you can use the following service ID to support DLNA media server under AirGroup:
urn:schemas-upnp-org:device:MediaServer:1

An mDNS service ID is the name of a Bonjour service offered by a Bonjour-enabled device or application.
Bonjour defines mDNS service ID strings using the
<underscore>servicename<period><underscore>protocol.local format.

Example: _airplay._tcp.local

The mDNS service ID string is case sensitive and must be entered as is without any modification, with the
exception of the .local portion of the service ID which is optional.

When you add an existing mDNS service ID to a new service, AirGroup automatically deletes the mDNS service
ID from the old service and displays a warning message. A sample warning message is as follows:

service id <_ssh._tcp> removed from <remotemgmt> and added to <remotelogin>

Configuring Service-Based Policy
AirGroup defines the concept of configurable services. One or more DLAN or mDNS services can be configured
on the Mobility Master. When you define a DLNA or an mDNS service as an AirGroup service, you can
implement policies to restrict its availability to a specific role or VLAN.

In the WebUI
To configure service-based policy using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Service-Based Policy.

3. Click +.

4. Enter a name of the service-based policy against Name.

5. Enter a description of the service-based policy against Description.

6. Select Enabled against Status to enable the service-based policy.

7. To restrict VLANs, click + against Disallow VLAN's and:

l To restrict VLANs by ID:

n Select ID against Disallowed VLAN's.

n Enter the VLAN ID against VLAN ID.

n Select the VLAN type as Servers or Users against Type.

n Click OK.

l To restrict VLANs by name:

n Select Name against Disallowed VLAN's.

n Enter the VLAN name against VLAN name
n Select the VLAN type as Servers or Users against Type.

n Click OK.

8. To restrict roles, click + against Disallow roles. and:

l Enter the role against Disallowed roles.

l Select the disallowed role type as Servers or Users against Type.

l Click OK.

9. To add a service ID, click + against Service IDs and:

l Enter the service ID against Disallowed roles.

l Click OK.



10.Enter the service ID against Service ID and click OK.

11.To auto associate the service-based policy, select AP-FQLN, AP-Group, or AP-Name against Auto
associate.

12.Click Submit.

13.Click Pending Changes.

14.In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure service-based policy using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice <string>

(host) [mm] (config-submode) #autoassociate

(host) [mm] (config-submode) #description

(host) [mm] (config-submode) #disallow-role

(host) [mm] (config-submode) #disallow-vlan

(host) [mm] (config-submode) #enable

(host) [mm] (config-submode) #id

Sample Configuration

The following example configures the iPhoto service with access to the _dpap._tcp service ID to share photos
across MacBooks:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice iPhoto

(host) [mm] (config-submode) #autoassociate apfqln

(host) [mm] (config-submode) #description Share Photos

(host) [mm] (config-submode) #enable

(host) [mm] (config-submode) #id _dpap._tcp

(host) [mm] (config-submode) #write memory

Enabling Service
Enable a service using the WebUI or the CLI.

In the WebUI
To enable a service using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Service-Based Policy.

3. Click on the required service that is disabled.

4. Select Enabled against Status.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To enable a service using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice <string>

(host) [mm] (config) #enable

(host) [mm] (config) #write memory

ArubaOS 8.0.0.0 | User Guide AirGroup |  937



938 | AirGroup ArubaOS 8.0.0.0  | User Guide

Disabling Service
Disable a service using the WebUI or the CLI.

In the WebUI
To disable a service using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Service-Based Policy.

3. Click on the required service that is enabled.

4. Select Disabled against Status.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To disable a service using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice <string>

(host) [mm] (config) #no enable

(host) [mm] (config) #write memory

Enabling Allowall Service
The allowall service is a preconfigured AirGroup service that enables the Mobility Master to permit all AirGroup
services by default, without requiring an administrator to configure an AirGroup service.

In the WebUI
To enable the allowall service using the WebUI:

1. Navigate to Configuration > Services > AirGroup.

2. In the Service-Based Policy, select the allowall service.

3. Select Enabled against Status.

4. Click Apply.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To enable the allowall service using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice allowall enable

(host) [mm] (config) #write memory

Deleting Service
Delete a service using the WebUI or the CLI.

In the WebUI
To delete a service using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.



2. Click Service-Based Policy.

3. Click on the required service.

4. Click Delete icon against the service.

5. Click Delete in the confirmation window.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To delete a service using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #no airgroupservice <string>

(host) [mm] (config) #write memory

Viewing List of Services

In the WebUI
To view the list of services using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Service-Based Policy.

In the CLI
To view the list of services using the CLI:
(host) [mynode] #show airgroupservice verbose

Sample List of Services

The following is a sample list of services:
(host) [mynode] #show airgroupservice verbose

********************************************************************************

Service Name : remotemgmt

Description : Remote management

Service Status : Disabled

service id info

---------------

service ID #query-hits #servers

---------- ----------- --------

_ssh._tcp 0 0

_sftp-ssh._tcp 0 0

_ftp._tcp 0 0

_telnet._tcp 0 0

_rfb._tcp 0 0

_net-assistant._tcp 0 0

********************************************************************************

Service Name : DIAL

Description : DIAL supported by Chromecast, FireTV, Roku etc

Service Status : Enabled

service id info

---------------

service ID #query-hits #servers

---------- ----------- --------
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urn:dial-multiscreen-org:service:dial:1 0 1

urn:dial-multiscreen-org:device:dial:1 0 1

********************************************************************************

Service Name : AmazonTV

Description : Amazon fire tv

Service Status : Enabled

service id info

---------------

service ID #query-hits #servers

---------- ----------- --------

_amzn-wplay._tcp 0 0

Viewing List of Blocked Services

In the CLI
To view the list of blocked services using the CLI:
(host) [mynode] #show airgroup blocked-service-id

Sample List of Blocked Services

The following is a sample list of blocked services:
(host) [mynode] #show airgroup blocked-service-id

AirGroup Blocked Service IDs

----------------------------

Origin Service ID #response-hits

------ ---------- --------------

fe80::6203:8ff:fe94:74a6 _sftp-ssh._tcp 82

fe80::6203:8ff:fe94:74a6 _ssh._tcp 82

10.16.124.236 _uscan._tcp 40

10.16.126.248 _keepalive._dns-sd._udp 20

Num Blocked Service-ID:4

Configuring Server-Based Policy
To configure the server-based policy:

In the WebUI
To configure server-based policy using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Server-Based Policy.
3. Click +.

4. Enter a MAC address against MAC address in the Add New Device window.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure server-based policy using the CLI:

Configuring Mac Address-Based Policy
(host) [mynode] #cd /mm

(host) [mm] #configure terminal



(host) [mm] (config) #airgroup policy <mac>

Configuring Shared Group-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-group

Adding Shared Group-Name to Shared Group-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-group device-mac <mac> add

Removing Shared Group-name from Shared Group-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-group device-mac <mac> remove

Configuring Shared Role-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-role

Adding Shared Role-Name to Shared Role-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-role device-mac <mac> add

Removing Shared Role-Name from Shared Role-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-role device-mac <mac> remove

Configuring Shared User-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-user

Adding Shared User-Name to Shared User-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-user device-mac <mac> add

Removing Shared User-Name from Shared User-List
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy shared-user device-mac <mac> remove

Configuring Service-Based Auto-association
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroupservice <string>

(host) [mm] (config-submode) #autoassociate

Configuring Number of Hops
Configure the number of hops using the WebUI or the CLI.
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In the WebUI
To define the number of hops using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Server-Based Policy.

3. Click on the required server-based policy.

4. Select the number of hops as 1, 2, or 3 against Neighborhood hop(s).
5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To define the number of hops using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy ap-neighborhood device-mac <mac> <number>

Configuring Auto Association
Configure auto association using the WebUI or the CLI.

In the WebUI
To configure auto association using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Server-Based Policy.

3. Click on the required server-based policy.

4. Select auto association as AP FQLN, AP Group, or AP Name against Auto associate.

5. Click Submit.

In the CLI
To configure auto association using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup policy autoassociate device mac <mac> {ap-fqln|ap-group|ap-

name}

Viewing List of Servers

In the WebUI
To view list of servers using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Server-Based Policy.

In the CLI
To view list of servers using the CLI:
(host) [mynode] #show airgroup servers

Sample List of Servers

The following is a sample list of servers:



(host) [mynode] #show airgroup servers

AirGroup Servers

----------------

MAC IP Type Host Name Service VLAN

--- -- ---- --------- ------- ----

5c:aa:fd:52:5a:f8 10.16.124.224 DLNA allowall 124

DLNA Media

5c:aa:fd:52:5a:fa 10.16.124.226 DLNA DLNA Media 124

allowall

f0:4d:a2:83:74:a5 10.16.126.16 DLNA DLNA Media 126

allowall

11:11:11:11:11:11 0.0.0.0 mDNS world_cricket static 0

a0:02:dc:85:c2:98 10.16.124.181 DLNA 10-16-124-181 DIAL 124

Wired/Wireless Role Group Username AP-Name

-------------- ---- ----- -------- -------

wireless ipad 7010AP

wireless ipad 7010AP

N/A

N/A

wireless x86-role arr

Num Servers: 5.

Configuring AirGroup-ClearPass Policy Manager Interface
Configure the AirGroup and ClearPass Policy Manager interface so that AirGroup and ClearPass Policy Manager
exchange information about the owner, visibility, and status for each device in the network.

The AirGroup solution allows the users to view all mDNS devices by default. AirGroup provides a set of policy
definitions to allow or disallow one of more AirGroup servers from being visible to specific AirGroup users.

If an AirGroup server is not registered on a ClearPass Policy Manager server, by default, the server will be visible
to all AirGroup users. The administrator must register an AirGroup server to allow or disallow this server from
being visible to specific AirGroup users.

The ClearPass Policy Manager query interval refreshes the ClearPass Policy Manager entries at periodic
intervals. The minimum value is 1 hour and the maximum value is 24 hours. The default value is 10 hours.

In the WebUI
To configure AirGroup-ClearPass Policy Manager Interface using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click ClearPass Policy Manager.

3. Select Enabled against Enforce registration.

4. Enter a value against CPPM query interval.
5. Enter a value against Dead time for down server.

6. Enter a value against UDP port for RFC 3576 request.

7. Select a server group against Server group.

8. Click + against RFC 3576 servers and:

a. Enter an IP address against IP address in the Add RFC 3576 Server window.

b. Click Submit.

9. Click Submit.
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10.Click Pending Changes.

11.In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To enforce registration using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup server enforce registration

(host) [mm] (config) #write memory

To configure ClearPass Policy Manager query interval using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server query-interval <value>

(host) [mm] (config) #write memory

To configure dead time for down server using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) [mm] (AirGroup AAA profile) #server-dead-time <server-dead-time>

(host) [mm] (AirGroup AAA profile) #write memory

To configure UDP port for RFC 3576 request using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) [mm] (AirGroup AAA profile) #rfc3576_udp_port <rfc3576_udp_port>

(host) [mm] (AirGroup AAA profile) #write memory

To configure server group using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) [mm] (AirGroup AAA profile) #server-group <server-group>

(host) [mm] (AirGroup AAA profile) #write memory

To configure RFC 3576 server using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) [mm] (AirGroup AAA profile) #rfc-3576-server <rfc3576_server>

(host) [mm] (AirGroup AAA profile) #write memory

Defining ClearPass Policy Manager Server
Define one or more ClearPass Policy Manager servers to be used by AirGroup. If multiple ClearPass Policy
Manager servers are defined, AirGroup uses the first available server on this list.

You can define ClearPass Policy Manager server for AirGroup using the WebUI or CLI.

Server-derived user roles or VLANs configured in this server group are not applicable to AirGroup.

In the WebUI
To define a ClearPass Policy Manager and RFC 3576 server using the WebUI:

1. On the Mobility Master, navigate to Configuration > Authentication > Auth Servers page.



2. Click + under All Servers and:

a. Enter a name against Name in New Server window.

b. Enter an IP address or hostname against IP address / hostname in New Server window.

c. Select the type as Radius against Type.

d. Click Submit.

3. Click Pending Changes.

4. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To define a ClearPass Policy Manager server using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #aaa authentication-server radius <rad_server_name>

Sample Definition
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa authentication-server radius emp_accounts

Configuring ClearPass Policy Manager Server Options
Configure the ClearPass Policy Manager Server options using the WebUI or the CLI.

In the WebUI
To configure the ClearPass Policy Manager server options using the WebUI:

1. On the Mobility Master, navigate to Configuration > Authentication > Auth Servers page.

2. Select the required server under All Servers.

3. Configure the server options under Server Options using the following table.

4. Click Submit.

5. In the Pending Changes window, select the required check box and click Deploy changes.

Parameter Description

Name Name of ClearPass Policy Manager server

IP address / hostname IP address or host name of ClearPass Policy Manager server

Auth port Authentication port on the server.

Default: 1812

Acct port Accounting port on the server.

Default: 1813

Shared key Shared secret between ClearPass Policy Manager Server and AirGroup.
The maximum length of key is 128 characters.

Table 223: ClearPass Policy Manager Server Options
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Parameter Description

Retype key Repeat shared secret between ClearPass Policy Manager Server and
AirGroup. The maximum length of key is 128 characters.

Timeout Maximum time, in seconds, that the ClearPass Policy Manager server
waits before timing out a request.

Default: 5

Retransmits Maximum number of retries that ClearPass Policy Manager server sends
before marking AirGroup as down.

Default: 3

NAS ID Network Access Server (NAS) identifier to use in RADIUS packets.

NAS IP NAS IP address to send in RADIUS packets.

Enable IPv6 Enable/Disable IPv6 support on ClearPass Policy Manager server.

NAS IPv6 NAS IPv6 address to send in RADIUS packets.

Use MD5 Enable/Disable use of a MD5 hash in the cleartext password.

Mode Enable/Disable the server.

Lowercase MAC address Enable/Disable use of lower case MAC address.

Use IP address for calling sta-
tion ID

Enable/Disable use of IP address instead of MAC address for the calling
station ID.

MAC address delimiter Type (colon, dash, OUI-NIC, none) of MAC address delimiter

Service-type of FRAMED-USER: Enable/Disable service-type of framed-user.

In the CLI
To configure the ClearPass Policy Manager server options using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa authentication-server radius <rad_server_name>

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa authentication-server radius emp_accounts

(host) [mm] (RADIUS Server "emp_accounts") #acctport 1813

(host) [mm] (RADIUS Server "emp_accounts") #authport 1812

(host) [mm] (RADIUS Server "emp_accounts") #called-station-id type ipaddr

(host) [mm] (RADIUS Server "emp_accounts") #cppm username admin password admins

(host) [mm] (RADIUS Server "emp_accounts") #enable

(host) [mm] (RADIUS Server "emp_accounts") #host 10.11.12.13

(host) [mm] (RADIUS Server "emp_accounts") #key admin123

(host) [mm] (RADIUS Server "emp_accounts") #mac-delimiter colon



(host) [mm] (RADIUS Server "emp_accounts") #mac-lowercase

(host) [mm] (RADIUS Server "emp_accounts") #nas-identifier 123

(host) [mm] (RADIUS Server "emp_accounts") #nas-ip 11.12.13.14

(host) [mm] (RADIUS Server "emp_accounts") #timeout 5

Assigning ClearPass Policy Manager Server to ClearPass Policy Manager Server
Group
Assign a ClearPass Policy Manager Server to a ClearPass Policy Manager Server Group using the WebUI or the
CLI.

In the WebUI
To assign a ClearPass Policy Manager Server to a ClearPass Policy Manager Server Group using the WebUI:

1. On the Mobility Master, navigate to Configuration > Authentication > Auth Servers page.

2. Select the required server group in Server Groups list.

3. Click + in the Server Group > Server Group Name list.

4. Select Add existing server in New server for Server Group Name window.

5. Select the required server name from the list.

6. Click Submit.

7. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To assign a ClearPass Policy Manager Server to a ClearPass Policy Manager Server Group using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa server-group <name>

(host) [mm] (Server Group "<name>") #auth-server <name>

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa server-group employee

(host) (Server Group "employee") #auth-server emp_accounts

Viewing ClearPass Policy Manager Configuration
View the ClearPass Policy Manager configuration in the WebUI or the CLI.

In the WebUI
To view the ClearPass Policy Manager configuration using the WebUI:

1. On the Mobility Master, navigate to the Configuration > Services > AirGroup page.

2. Click ClearPass Policy Manager.

In the CLI
To view the ClearPass Policy Manager configuration using the CLI:
(host) [mynode] #show airgroup cppm-server aaa

(host) [mynode] #show airgroup cppm-server query-interval

Sample Configuration
(host) [mynode] #show airgroup cppm-server aaa

Airgroup AAA profile

ArubaOS 8.0.0.0 | User Guide AirGroup |  947



948 | AirGroup ArubaOS 8.0.0.0  | User Guide

--------------------

Parameter Value Set

--------- ----- ---

Server Group san-dot1x

RFC 3576 server 10.15.16.39

Configure dead time for a down Server 5

Configure UDP port to receive RFC 3576 server requests. 5999

(host) [mynode] #show airgroup cppm-server query-interval

CPPM Server Query Interval

--------------------------

Timer Value Unit

----------- ----

9 hours

Defining ClearPass Policy Manager Server Group
Define a ClearPass Policy Manager server group using the WebUI or the CLI.

In the WebUI
To define a ClearPass Policy Manager server group using the WebUI:

1. On the Mobility Master, navigate to Configuration > Authentication > Auth Servers page.

2. Click + under Server Groups and:

a. Enter a name against Name in Add Server Group window.

b. Click Submit.

3. Click Pending Changes.

4. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To define a ClearPass Policy Manager server group using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa server-group <name>

(host) [mm] (Server Group "<name>") #write memory

Defining RFC 3576 Server
Define an RFC 3576 server using the WebUI or the CLI.

In the WebUI
To define an RFC 3576 server using the WebUI:

1. On the Mobility Master, navigate to Configuration > Authentication > Auth Servers page.

2. Click + under All Servers and:

a. Select the type as RFC against Type in New Server window.

b. Enter an IP address against IP address in New Server window.

c. Click Submit.

3. Click Pending Changes.

4. In the Pending Changes window, select the required check box and click Deploy changes

In the CLI
To define an RFC 3576 server using the CLI:



(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa rfc-3576-server <server_ip>

Sample Definition
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #aaa rfc-3576-server 10.11.12.14

Assigning ClearPass Policy Manager Server or RFC 3576 Server to AirGroup
Assign a ClearPass Policy Manager server or an RFC 3576 server to AirGroup using the WebUI or the CLI:

An AirGroup RFC 3576 server cannot use the same port as an authentication module RFC 3576 server. To avoid
conflicts, use a non-standard port for the AirGroup RFC 3576 server.

In the WebUI
To assign a ClearPass Policy Manager server or an RFC 3576 server to AirGroup using the WebUI:

1. Navigate to Configuration > Advanced Services > All Profiles.

2. Expand the Other Profiles menu and select AirGroup AAA Profile.

3. In the Configure dead time for a down Server text box in the Profile Details window, enter a
maximum period in minutes, so that a client that does not send user traffic for the given period is
considered idle.

4. Enter the UDP port number in the Configure UDP port to receive RFC 3576 server requests field. If
your network uses an RFC 3576 server for authentication, select a different port for the AirGroup 3576
server. The default in ClearPass Guest is 5999.

The user-defined UDP port number for RFC3576 server is automatically permitted by the firewall. The administrator
does not have to explicitly define a firewall policy to permit this port.

5. Identify the AirGroup ClearPass Policy Manager server group. In the Profiles list, select the Server Group
under the AirGroup AAA Profile menu.

6. In the Profile Details window, click the Server Group drop-down list to select the desired ClearPass Policy
Manager server group.

7. Click Apply.

8. Identify the RFC 3576 server. In the Profiles list, select RFC 3576 Server under the AirGroup AAA Profile
menu.

9. Enter the IP address of the RFC 3576 server in the Add a profile text box.

10.Click Add and Apply.

In the CLI
To assign a ClearPass Policy Manager server or an RFC 3576 server to AirGroup using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) (Airgroup AAA profile) #rfc-3576-server <ip-address>

(host) (Airgroup AAA profile) #rfc-3576_udp_port <port number>

(host) (Airgroup AAA profile) #server-dead-time <time>

(host) (Airgroup AAA profile) #server-group <server group name>

If your network uses an RFC 3576 server for authentication, select a different port for the AirGroup 3576 server. The
default port in ClearPass Guest is 5999.
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Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup cppm-server aaa

(host) (Airgroup AAA profile) #rfc-3576-server 10.15.16.25

(host) (Airgroup AAA profile) #rfc3576_udp_port 21334

(host) (Airgroup AAA profile) #server-dead-time 10

(host) (Airgroup AAA profile) #server-group employee

Viewing ClearPass Policy Manager Device Registration
To view ClearPass Policy Manager device registration using the CLI:
(host) [mynode] #show airgroup cppm entries

Configuring per-VLAN AirGroup Control
Configure per-VLAN AirGroup control using the WebUI or the CLI.

In the WebUI
To configure per-VLAN AirGroup control using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Per-VLAN AirGroup Control.
3. Click + and:

l To restrict VLANs by ID:

n Select ID against Disallowed VLAN's.

n Enter the VLAN ID against VLAN ID.

n Select the VLAN type as Servers or Users against Type.

n Click OK.

l To restrict VLANs by name:

n Select Name against Disallowed VLAN's.

n Enter the VLAN name against VLAN name
n Select the VLAN type as Servers or Users against Type.

n Click OK.

4. Click Pending Changes.

5. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure per-VLAN AirGroup control using the CLI:

Configure Named VLAN

To configure a named VLAN:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #vlan-name <name> assignment {hash|even}

Assign VLAN ID to Named VLAN

To assign a VLAN ID to a named VLAN:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #vlan <name> 30,20



Disallow Named VLAN

To disallow a named VLAN for servers at AirGroup service level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-vlan <name> servers

To disallow a named VLAN for users at AirGroup service level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-vlan <name> users

To verify the named VLAN configuration at the AirGroup service level:
(host) [mynode] #show airgroupservice verbose

To disallow a named VLAN for servers at AirGroup global level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup disallow-vlan <name> servers

To disallow named VLAN for users at AirGroup global level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup disallow-vlan <name> users

To verify the named VLAN configuration at the AirGroup global level using the CLI:
(host) [mynode] #show airgroup vlan

Disallow VLAN ID

To disallow a VLAN ID for servers at AirGroup service level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-vlan <id> servers

Example:
(host) [mm] (config) #airgroupservice airplay disallow-vlan 10 servers

With the above configuration, when a server connected on VLAN 10 advertises AirPlay service, the mDNS
process does not cache the records for AirPlay service. With the above configuration, when a server connected
on VLAN 10 advertises any service other than AirPlay, the mDNS process caches the records. When a user
belonging to VLAN 10 begins to advertise AirPlay service, the mDNS process does not cache the records for
AirPlay service and continues to exist in the user table.

When a user belonging to vlan 10 begins to advertise any service other than airplay service, mDNS process will
cache the records for non airplay service and move the user entry from user table to server table.

To disallow a VLAN ID for users at AirGroup service level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-vlan <id> users

Example:
(host) [mm] (config) #airgroupservice airplay disallow-vlan 10 users

With the above configuration, when a user connected on VLAN 10 queries for AirPlay service, the mDNS
process does not send any response for AirPlay service even if AirPlay servers are cached. With the above
configuration, if a user connected on VLAN 10 queries for AirPrint or any service other than the AirPlay service,
the mDNS process sends response with the cached records related to that service. When a server belonging to
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VLAN 10 queries for AirPlay service, no response is sent for AirPlay queries because the user query on VLAN 10
is disallowed for AirPlay service.

To verify the configuration:
(host) [mynode] #show airgroupservice verbose

To disallow VLAN for servers at AirGroup global level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup disallow-vlan <id> servers

To disallow VLAN for users at AirGroup global level:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup disallow-vlan <id> users

To verify the configuration using the CLI:
(host) [mynode] #show airgroup vlan

Disallow Role

To disallow a role for servers:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-role <role_name> servers

With the above configuration, when a server connected with role <role_name> advertises AirPlay service, the
mDNS process does not cache the records for AirPlay service. With the above configuration, when a server
connected with role <role_name> advertises any service other than the AirPlay service, the mDNS process
caches the records. When a user with role <role_name> begins to advertise AirPlay service, the mDNS process
does not cache the records for AirPlay service and exists in the user table. When a user with role <role_name>
begins to advertise any service other the AirPlay service, the mDNS process caches the records for non-AirPlay
service and moves the user entry from user table to the server table.

To disallow role for users:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroupservice <name> disallow-role <role_name> users

With the above configuration, when a client with role <role_name> queries for AirPlay service, the mDNS
process does not send any response for AirPlay service even if AirPlay servers cached. With the above
configuration, if a client connected with role <role_name> queries for AirPrint service or any service other than
the Airplay service, the mDNS process sends response with the cached records related to that service. When a
server belonging to role <role_name> queries for AirPlay service, response is not sent for AirPlay queries
because the user query from role <role_name> is disallowed for AirPlay service.

To verify the configuration:
(host) [mm] #show airgroupservice verbose

Deleting per-VLAN AirGroup Control
Delete per-VLAN AirGroup control using the WebUI.

In the WebUI
To delete per-VLAN AirGroup control using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Per-VLAN AirGroup Control.



3. Click on the required VLAN.

4. Click Delete icon against the VLAN.

5. Click Delete in the confirmation window.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

Viewing VLAN Table
View the VLAN table using the WebUI. Additionally, the VLAN table shows the disallowed AirGroup VLANs.

In the WebUI
To view the VLAN table using the WebUI:

1. Navigate to Configuration > Services > AirGroup.

2. Select the AirGroup Settings tab. The list of disallowed AirGroup VLANs are displayed under the VLAN
Table section.

Configuring mDNS AP VLAN Aggregation
Following different network topologies are possible to configure AP multicast aggregation for allowed VLANs:

1. If AP uplink is an access port with access VLAN x, the AP performs mDNS aggregation for VLAN x. Perform
following configuration:

n Create VLAN using command vlan x.

n Configure native VLAN ID in system profile as vlan x.

n Enable parameter AP Multicast Aggregation in ap-system profile.

2. If AP uplink is a trunk port with native VLAN as x (that is, uplink-VLAN is not configured for AP), the AP
performs mDNS aggregation for VLAN x. Perform following configuration:

n Create VLAN using command vlan x.

n Configure native VLAN ID in system profile as vlan x.

n Enable parameter AP Multicast Aggregation in ap-system profile.

3. If AP uplink is a trunk port with native VLAN as x, allowed VLANs as x, y, and z, and if the uplink-VLAN is
configured as VLAN y for AP, the AP performs mDNS aggregation for VLAN y. Perform following
configuration:

n Configure uplink-VLAN as VLAN y in the provisioning parameters of the AP and reboot the AP.

n Create VLAN using command vlan y.

n Configure native VLAN in system profile as VLAN x.

n Enable parameter AP Multicast Aggregation in ap-system profile.

In the CLI
1. Create VLAN for AP:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #vlan <id>

If an AP is connected on the trunk port, then configure the native VLAN of the trunk port using this command. If
uplink-VLAN is configured for the AP, then use this VLAN.

2. Configure the native VLAN ID for AP:
(host) [mynode] #cd /mm
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(host) [mm] # configure terminal

(host) [mm] (config) #ap system-profile <profile-name> native-vlan-id <id>

If an AP is connected on the trunk port, then configure the native VLAN of the trunk port using this command.

3. Enable mDNS aggregation:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #ap system-profile <profile-name> mcast-aggr

4. Map the AP system-profile to AP name:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #ap-name <ap-name> ap-system-profile <profile-name>

Enabling mDNS AP VLAN Aggregation
Enable the mDNS AP VLAN aggregation using the WebUI or the CLI.

In the WebUI
To enable mDNS AP VLAN aggregation using the WebUI:

1. Navigate to Configuration > System > Profiles.

2. Under All Profiles list, select AP > AP system > Profile-Name.

3. Under AP system profile: Profile-Name > General list, select the check box against AP multicast
aggregation.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To enable mDNS AP VLAN aggregation using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #ap system-profile <profile-name> mcast-aggr

Disabling mDNS AP VLAN aggregation
Disable the mDNS AP VLAN aggregation using the WebUI or the CLI.

In the WebUI
To disable mDNS AP VLAN aggregation using the WebUI:

1. Navigate to Configuration > System > Profiles.

2. Under All Profiles list, select AP > AP system > Profile-Name.

3. Under AP system profile: Profile-Name > General list, un-select the check box against AP multicast
aggregation.

4. Click Save.

5. Click Pending Changes.

6. In the Pending Changes window, select the required check box and click Deploy changes.



In the CLI
To disable mDNS AP VLAN aggregation using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #ap system-profile <profile-name> no mcast-aggr

Creating mDNS Static Records
Create mDNS static records independently for each record type.

After creating a PTR, SRV, TXT, A, and AAAA static record, you can use the show airgroup cache entries command
to view and verify the records created. You can view only the static records in the output of the show airgroup cache
entries static command.

Creating A Record
To create an A record using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup static mdns-record a <mac_addr> <host_name> <ipv4addr> [server_

ipaddr]

Creating AAAA Record
To create an AAAA record using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup static mdns-record aaaa <mac_addr> < host_name> <ipv6addr>

[server_ipaddr]

Creating PTR Record
To create a PTR record using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup static mdns-record ptr <mac_addr> <mdns_id> <domain_name>

[server_ipaddr]

Creating SRV Record
To create an SRV record using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup static mdns-record srv <mac_addr> <domain_name> <port>

<priority> <weight> <host_name> [ server_ipaddr]

Creating TXT Record
To create a TXT record using the CLI:
(host) [mynode] #cd /mm

(host) [mm] # configure terminal

(host) [mm] (config) #airgroup static mdns-record txt <mac_addr> <domain_name> <text> [server_

ipaddr]

You can delete the mDNS records by appending no at the beginning of the command. Ensure that the [server_
ipaddr] parameter is not added while deleting mDNS records.
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Configuring Domain for Stand-alone Controller
Configure domain for stand-alone controllers using WebUI or CLI.

A domain can be configured only on a Mobility Master. An Active domain can be added/removed on any managed
device

In the WebUI
To configure domain for stand-alone controller using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click + under Domains.

3. Enter a name against Name in New Domain.

4. Enter a description against Description in New Domain.

5. Click + under IP address and:

a. Enter an IP address against IP address in Add IP.

If the stand-alone controller deployment includes redundancy, use the VRRP IP address. Otherwise, use the IP
address of the Mobility Master.

b. Click OK in Add IP.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure domain for stand-alone controller using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup domain <name> description <description> ip-address <ip-address>

(host) [mm] (config) #write memory

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup domain college description library ip-address 10.11.12.13

(host) [mm] (config) #write memory

Deleting Domain for Stand-alone Controller
Delete domain for stand-alone controllers using WebUI or CLI.

In the WebUI
To delete domain for stand-alone controller using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Domains.

3. Click on the required domain.

4. Click Delete icon against the domain.

5. Click Delete in the confirmation window.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.



In the CLI
To delete domain for stand-alone controller using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #no airgroup domain <name>

(host) [mm] (config) #write memory

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #no airgroup domain college

(host) [mm] (config) #write memory

Viewing Domain for Stand-alone Controller
View the domain for stand-alone controller using the WebUI or the CLI.

In the WebUI
To view the domain for stand-alone controller using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Domains.

In the CLI
To view the domain for stand-alone controller using the CLI:
(host) [mynode] #show airgroup domain

Sample Configuration
(host) [mynode] #show airgroup domain

AirGroup Domains

----------------

Name Description IP-Address

---- ----------- ----------

test test 10.15.52.2

10.15.52.16

ag 10.15.52.2

10.15.52.16

Num domains:2

To view the IP addresses of all stand-alone controllers that are part of a domain using the CLI:
(host) [mynode] #show airgroup multi-controller-table

Sample Configuration
(host) [mynode] #show airgroup multi-controller-table

AirGroup Multi-Controller-Table

-------------------------------

IP-Address

----------

10.15.52.16

Num IP-Address:1

Configuring AirGroup Active-Domain
Configure AirGroup active-domain using the WebUI or the CLI.
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In the WebUI
To configure AirGroup active-domain using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click + under Domains.

3. Enter a name against Name in New Domain.

4. Enter a description against Description in New Domain.

5. Click + under IP address and:

a. Enter an IP address against IP address in Add IP.

If the stand-alone controller deployment includes redundancy, use the VRRP IP address. Otherwise, use the IP
address of the Mobility Master.

b. Click OK in Add IP.

6. Select in Enabled against Active to configure the domain as an active-domain.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the required check box and click Deploy changes.

In the CLI
To configure AirGroup active-domain using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup domain <name> description <description> ip-address <ip-address>

(host) [mm] (config) #airgroup active-domain <name>

(host) [mm] (config) #write memory

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #airgroup domain library description students ip-address 10.11.12.13

(host) [mm] (config) #airgroup domain cafeteria description students ip-address 10.11.12.13

(host) [mm] (config) #airgroup active-domain library

(host) [mm] (config) #airgroup active-domain cafeteria

(host) [mm] (config) #write memory

Removing AirGroup Active-Domain
Remove AirGroup active-domain using the WebUI or the CLI.

In the WebUI
To remove AirGroup active-domain using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Domains.

3. Click on the required active-domain.

4. Select Disabled against Active.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.



In the CLI
To remove AirGroup active-domain using the CLI:
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #no airgroup active-domain <name>

(host) [mm] (config) #write memory

Sample Configuration
(host) [mynode] #cd /mm

(host) [mm] #configure terminal

(host) [mm] (config) #no airgroup active-domain library

(host) [mm] (config) #write memory

Deleting AirGroup Active-Domain
Delete AirGroup active-domain using the WebUI.

In the WebUI
To delete AirGroup active-domain using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Click Domains.

3. Click on the required active-domain.

4. Click Delete icon against the service.

5. Click Delete in the confirmation window.

6. Click Pending Changes.

7. In the Pending Changes window, select the required check box and click Deploy changes.

Viewing AirGroup Active-Domain
View AirGroup active-domain using the WebUI or the CLI

In the WebUI
To view AirGroup active-domain using the WebUI:

1. On the Mobility Master, navigate to Configuration > Services > AirGroup.

2. Select the Domain.

In the CLI
To view AirGroup active-domain using the CLI:
(host) [mynode] #show airgroup active-domains

Sample Configuration
(host) [mynode] #show airgroup active-domains

AirGroup Active-Domains

-----------------------

Domain Name Status

----------- ------

ag Included

test Included

tmp1 Excluded

Num active-domains:3
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Best Practices and Limitations
Consider the best practices and limitations listed in this section before deploying AirGroup. The
recommendations that are not specific to a deployment model, apply to both Mobility Master-Managed Device
and stand-alone controller deployment model.

l Apple iTunes Wi-Fi Synchronization and File Sharing on page 960

l Firewall Configuration on page 960

l Recommended Ports on page 961

l AirGroup Services for Large Deployments on page 961

l General AirGroup Limitations on page 962

Apple iTunes Wi-Fi Synchronization and File Sharing
When a managed device receives mDNS response for a service, it caches such records and does not propagate
to other users. But for services like iTunes Wi-Fi synchronization and File Sharing to work seamlessly, such
mDNS responses must be propagated to other users on the managed device even if they do not query for it.

To ensure that applications such as iTunes Wi-Fi synchronization and File Sharing work seamlessly, ArubaOS
selectively forwards these mDNS responses to AirGroup users, based on the user-name ClearPass Policy
Manager policy of the AirGroup server. Hence, for a customer to use these services, it is necessary to configure
user-name based ClearPass Policy Manager policies for the AirGroup devices.

Firewall Configuration
The following firewall configuration settings are recommended:

l Disable Inter-User Firewall Settings on page 960

l ValidUser ACL Configuration on page 960

l Allow GRE and UDP 5353 on page 960

Disable Inter-User Firewall Settings
Some firewall settings can prevent the untrusted clients from communicating with each other. When these
settings are enabled, an untrusted client such as an iPad may not be able to send its image to an Apple TV on
the same managed device.

Use the following commands to disable the virtual AP global firewall options and allow Bonjour services to use
AirGroup.

l no firewall deny-inter-user-bridging
l no firewall deny-inter-user-traffic
l no ipv6 firewall deny-inter-user-bridging

ValidUser ACL Configuration
The ValidUser Access Control list (ACL) must allow mDNS packets with the source IP as a link local address. Do
not use a ValidUser ACL if the user VLAN interfaces of the AirGroup managed device are not configured with
an IP address.

Allow GRE and UDP 5353
mDNS discovery uses the predefined port UDP 5353. If there is a firewall between AirGroup and WLAN, ensure
that your firewall policies allow GRE and UDP 5353. DLNA uses the predefined port UDP 1900.



Recommended Ports
The ArubaOS role-based access controls for wireless clients use ACLs to allow or deny user traffic on specific
ports. Even though mDNS discovery uses the predefined port UDP 5353, application-specific traffic for
services like AirPlay may use dynamically selected port numbers. As a best practice, add or modify ACLs to allow
traffic on the ports as described in Table 224 and Table 225.

AirPlay operates using dynamic ports, however, printing protocols like AirPrint use fixed ports.

Ports for AirPlay Service
Enable the following ports for the AirPlay services.

Protocol Ports

TCP l 5000

l 7000

l 7100

l 8612

l 49152-65535

UDP l 7010

l 7011

l 8612

l 49152-65535

Table 224: Ports for AirPlay Service

Ports for AirPrint Service
Enable the following ports for AirPrint services.

Protocol Print Service Port

TCP Datastream 9100

TCP IPP 631

TCP HTTP 80

TCP Scanner 9500

TCP HTTP-ALT 8080

Table 225: Ports for AirPrint Service

AirGroup Services for Large Deployments
Large deployments with many wireless and wired users often support a large number of advertised Bonjour
services, which can consume a significant amount of system resources. For large scale deployments, enable the
AirPlay and AirPrint services, disable the allowall service, and then block all other Bonjour services.
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General AirGroup Limitations
The AirGroup feature has the following limitations:

l AirGroup is supported only in tunnel and decrypt-tunnel forwarding modes.

l If you use ClearPass Policy Manager to define AirGroup users, the shared user and role lists, and location
attributes cannot exceed 1000 characters.

l The RTSP protocol does not support AirPlay on an Apple TV receiver if you enable NAT on the user VLAN
interface.

l The location-based access feature only supports AP FQLNs (Fully Qualified Location Names) configured in
the format <ap name>.floor <number>.<building>.<campus>. The AP names cannot contain periods.

l AirGroup’s DLNA discovery works across VLANs, however, media streaming from Windows Media Server
does not work across VLANs. This limitation is because of Digital Rights Management (DRM) support in
Windows Media Server, which restricts media sharing across VLANs. Media streaming works only when both
client and server are connected to the same VLAN.

l Android devices cannot discover media server while using the native music and video player applications
and when they are connected across VLANs. For example, Samsung Tab 3 cannot discover the media server
on Samsung Galaxy S4 while using the native music and video player applications. Android devices can
discover media server when they are connected in the same VLAN. This restriction is forced by Samsung
devices.

l Xbox cannot be added as an extender to the Windows clients using the Windows Media Center application
with the AirGroup feature enabled. You need to disable the AirGroup feature to add Xbox as an extender.

l Wireless Clients such as iPad and iPhone running the Sonos application cannot discover Sonos music system
with the AirGroup is enabled.

Troubleshooting and Log Messages
Use the following procedure to prevent potential AirGroup errors:

1. Execute the show airgroup internal-state statistics command and ensure that the Sibyte Messages
Sent/Recv counters increment over a period of time.

2. Enable mDNS logs using the logging level debugging system process mdns command, and capture the
output of show log system all when the issue occurs. Review any obvious error print statements.

3. Save the output of show airgroup cache entries and show airgroup cppm entries and look for any
discrepancies.

ClearPass Guest Troubleshooting Steps
ClearPass Guest includes AirGroup-related events in the application log files. You can configure logging levels to
provide debugging information.

To show debugging information in event logs:

1. In ClearPass Guest, go to Administration > AirGroup Services and click the Configure AirGroup
Services command link. The Configure AirGroup Services form opens.

2. In the AirGroup Logging drop-down list, select either Debug—log debug information or Trace—log all
debug information. When one of these options is selected, debugging information is provided in the
events log.

3. Click Save Configuration.

For up-to-date information, see the ClearPass Guest Deployment Guide.



ClearPass Policy Manager Troubleshooting Steps
Monitoring and reporting services in ClearPass Policy Manager provide insight into system events and
performance.

To show incoming AirGroup requests from the managed device:

1. In ClearPass Policy Manager, navigate to Monitoring > Live Monitoring > Access Tracker. The Access
Tracker list view opens.

2. Click an event’s row to view details. The Summary tab of the Request Details view opens. Additional
details may be viewed on the Input, Output, or Alerts tabs, or you can click Show Logs to view logging
details.

For up-to-date information, see the ClearPass Policy Manager User Guide.

Log Messages
Display AirGroup logs by issuing the following CLI commands:

l show log all
l show log system all
l show log user all
l show log user-debug all

The log debug messages for the mDNS process are not enabled by default. To enable specific logging levels, use
the following CLI commands in configuration mode:

To enable high level mDNS debug messages:
(host)(config) #logging level debugging system process mdns

To enable mDNS packet processing messages:
(host)(config) #logging level debugging system process mdns subcat messages

To enable mDNS CLI configuration messages:
(host)(config) #logging level debugging system process mdns subcat configuration

To enable mDNS Auth and ClearPass Policy Manager user messages:
(host)(config) #logging level debugging user process mdns

Show Commands
Use the following show commands to view AirGroup configuration data and statistics in the managed device:

Viewing AirGroup Flow Table
show airgroup flow-table

Viewing AirGroup mDNS and DLAN Cache
show airgroup cache entries [mdns|dlna|static]

Viewing AirGroup mDNS and DLNA Statistics
show airgroup internal-state statistics [mdns|dlna]

Viewing AirGroup VLANs
(host) #show airgroup vlan
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Viewing AirGroup Servers
Use the following command to view the AirGroup server (Apple TV, AirPrint Printer, Google ChromeCast, and so
on) status in the managed device:
show airgroup servers [dlna|mdns] [verbose]

Viewing AirGroup Users
show airgroup users [mdns|dlna] [verbose]

Viewing Service Queries Blocked by AirGroup
This command displays the service ID that was queried but not available in the AirGroup service table.
show airgroup blocked-queries [mdns|dlna]

Viewing Blocked Services
The airgroup service <servicename> disable command disables an AirGroup service by blocking the
service IDs for that service. When you enable an AirGroup service, service IDs of that service are enabled
automatically. To view the list of blocked services, use the following command:
show airgroup blocked-service-id [mdns|dlna]
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Chapter 43
Instant AP VPN Support

ArubaOS is the companion controller release for the Aruba Instant release. This release provides an ability to
terminate VPN and GRE tunnels from Instant AP (IAP) and provide corporate connectivity to the branch IAP
network. For more details, see the Aruba Instant User Guide .

IAP VPN feature is applicable only for hardware platforms that are running ArubaOS 8.0 as a stand-alone controller.

VPN features are ideal for:

l enterprises with many branches that do not have a dedicated VPN connection to the Head Quarter.

l branch offices that require multiple APs.

l individuals working from home, connecting to the VPN.

This new architecture and form factor seamlessly adds the survivability feature of Instant APs with the VPN
connectivity of RAPs — providing corporate connectivity to branches.

This section includes the following topics:

l Overview on page 965

l VPN Configuration on page 969

l Viewing Branch Status on page 971

Overview
This section provides a brief summary of the new features included in ArubaOS to support VPN termination
from IAP.

Improved DHCP Pool Management
IAP allows you to configure the DHCP address assignment for the branches connected to the corporate
network through VPN. In distributed DHCP mode, ArubaOS 8.0 allows designated blocks of IP addresses for
static IP users by excluding them from the DHCP scope. In addition, it allows creation of scope of any required
size, thereby enabling more efficient utilization of IP address across branches. For detailed information on
Distributed DHCP for IAP-VPN, see Aruba Instant User Guide.

Termination of Instant AP VPN Tunnels
You can configure IAPs to terminate VPN tunnels on controllers. When configured, the IAP cluster creates a
tunnel from the Virtual Controller (VC) to an Aruba controller. However, the controller only acts as a VPN end-
point and does not configure the IAP. For more information on how to create a VPN tunnel from a VC to an
Aruba controller, see Aruba Instant User Guide.

Termination of IAP GRE Tunnels
IAPs have the ability to terminate GRE tunnels on controllers. The IAP cluster creates a tunnel from the VC to
the controller in your corporate office. The controller only acts as a GRE end-point and does not configure the
IAP. For more information on how to create a GRE tunnel from VC to the controller, see the Aruba Instant
Guide.
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L2/L3 Network Mode Support
The IAP functioning as a VC enables different DHCP pools (various deployment models) in addition to
allocating IP subnets to each branch.

IAPs support the following DHCP configuration modes:

l L2 Switching Mode: In this mode, IAP supports distributed L2 and centralized L2 switching modes of
connection to the corporate network. When an IAP registers with the controller and has a L2 mode DHCP
pool configured, the controller automatically adds the GRE or VPN tunnel associated to this IAP into the
VLAN multicast table. This allows the clients connecting to this L2 mode VLAN to be part of the same L2
domain on controller.

l L3 Routing Mode: In this mode, IAP supports L3 routing mode of connection to the corporate network. The
VC assigns an IP addresses from the configured subnet and forwards traffic to both corporate and non-
corporate destinations. The IAP handles the routing on the subnet and also adds a route on the controller
after the VPN tunnel is set up during the registration of the subnet. When the IAP registers with a L3 mode
DHCP pool, the controller automatically adds a route to this DHCP subnet enabling routing of traffic from
the corporate network to clients on this VLAN in the branch.

Instant AP VPN Scalability Limits
ArubaOS provides enhancements to the scalability limits for the IAP VPN branches terminating on the
controller. The following table provides the IAP VPN scalability information for various controller platforms:

Platforms Branches Routes L3 Mode Users NAT Users

7005 64 6*128

N/A N/A
7010 128 6*256

7024 128 6*128

7030 256 6*512

7205 1024 6*1024

7210 2048 32K

7220 4096 64K

7240 8192 128K

Table 226: Instant AP VPN Scalability Limits

l Branches—The number of IAP VPN branches that can be terminated on a given controller platform.

l Routes—The number of L3 routes supported on the controller.

l L3 mode and NAT mode users—The number of trusted users supported on the controller. There is no
scale impact on the controller. They are limited only by the number of clients supported per Instant AP.

Instant AP VPN OSPF Scaling
ArubaOS allows each IAP VPN to define a separate subnet derived from a corporate intranet pool to allow IAP
VPN devices to work independently. For information on sample topology and configuration, see OSPFv2.



To redistribute IAP VPN routes into the OSPF process, use the following command :
(host) [mynode] (config) #router ospf redistribute rapng-vpn

To verify if the redistribution of the IAP VPN is enabled, use following command:
(host) [mynode] #show ip ospf redistribute

Redistribute RAPNG

To configure aggregate route for IAP VPN routes, use the following command:
(host) [mynode] (config) # router ospf aggregate-route rapng-vpn

To view the aggregated routes for IAP VPN routes, use the following command:
(host) [mynode]#show ip ospf rapng-vpn aggregate-routes

RAPNG VPN aggregate routes

--------------------------

Prefix Mask Contributing routes Cost

------ ---- ------------------- ----

201.201.200.0 255.255.252.0 5 268779624

100.100.2.0 255.255.255.0 1 10

To verify the details of configured aggregated route, use the following command:
(host) [mynode]# show ip ospf rapng-vpn aggregated-routes <net> <mask>

(host) [mynode]#show ip ospf rapng-vpn aggregate-routes 100.100.2.0 255.255.255.0

Contributing routes of RAPNG VPN aggregate route

------------------------------------------------

Prefix Mask Next-Hop Cost

------ ---- -------- ----

100.100.2.64 255.255.255.224 5.5.0.10 10

To view all the redistributed routes:
(host) [mynode]#show ip ospf database

OSPF Database Table

-------------------

Area ID LSA Type Link ID Adv Router Age Seq# Checksum

------- -------- ------- ---------- --- ---- --------

0.0.0.15 ROUTER 9.9.9.9 9.9.9.9 159 0x80000016 0xee92

0.0.0.15 ROUTER 10.15.148.12 10.15.148.12 166 0x80000016 0x4c0d

0.0.0.15 NETWORK 10.15.148.12 10.15.148.12 167 0x80000001 0x9674

0.0.0.15 NSSA 12.12.2.0 9.9.9.9 29 0x80000003 0x7b54

0.0.0.15 NSSA 12.12.12.0 9.9.9.9 164 0x80000008 0x63a

0.0.0.15 NSSA 12.12.12.32 9.9.9.9 164 0x80000008 0x7b8

0.0.0.15 NSSA 50.40.40.0 9.9.9.9 164 0x80000007 0x8ed4

0.0.0.15 NSSA 51.41.41.128 9.9.9.9 164 0x80000007 0x68f6

0.0.0.15 NSSA 53.43.43.32 9.9.9.9 164 0x80000007 0x2633

0.0.0.15 NSSA 54.44.44.16 9.9.9.9 164 0x80000007 0x353

N/A AS_EXTERNAL 12.12.2.0 9.9.9.9 29 0x80000003 0x8c06

N/A AS_EXTERNAL 12.12.12.0 9.9.9.9 169 0x80000001 0x25e4

N/A AS_EXTERNAL 12.12.12.32 9.9.9.9 169 0x80000001 0x2663

N/A AS_EXTERNAL 50.40.40.0 9.9.9.9 169 0x80000001 0xab80

N/A AS_EXTERNAL 51.41.41.128 9.9.9.9 169 0x80000001 0x85a2

N/A AS_EXTERNAL 53.43.43.32 9.9.9.9 169 0x80000001 0x43de

N/A AS_EXTERNAL 54.44.44.16 9.9.9.9 169 0x80000001 0x20fe

To verify if the redistributed routes are installed or not.
(host) [mynode]#show ip route

Codes: C - connected, O - OSPF, R - RIP, S - static

M - mgmt, U - route usable, * - candidate default, V - RAPNG VPN

Gateway of last resort is Imported from DHCP to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from CELL to network 0.0.0.0 at cost 10

Gateway of last resort is Imported from PPPOE to network 0.0.0.0 at cost 10

Gateway of last resort is 10.15.148.254 to network 0.0.0.0 at cost 1

S* 0.0.0.0/0 [1/0] via 10.15.148.254*

V 12.12.2.0/24 [10/0] ipsec map

V 12.12.12.0/25 [10/0] ipsec map
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V 12.12.12.32/27 [10/0] ipsec map

V 50.40.40.0/24 [10/0] ipsec map

V 51.41.41.128/25 [10/0] ipsec map

V 53.43.43.32/27 [10/0] ipsec map

V 54.44.44.16/28 [10/0] ipsec map

C 9.9.9.0/24 is directly connected, VLAN9

C 10.15.148.0/24 is directly connected, VLAN1

C 43.43.43.0/24 is directly connected, VLAN132

C 42.42.42.0/24 is directly connected, VLAN123

C 44.44.44.0/24 is directly connected, VLAN125

C 182.82.82.12/32 is an ipsec map 10.15.149.69-182.82.82.12

C 182.82.82.14/32 is an ipsec map 10.17.87.126-182.82.82.14

Branch-ID Allocation
For branches deployed in distributed L3 and distributed L2 modes, the master AP in the branch and the
controller must agree upon a subnet and IP addresses to be use for DHCP services in the branch. The process
or protocol used by the master AP and the controller to determine the subnet and IP addresses used in a
branch is called BID allocation. If the branches are deployed in local only or centralized l2 only modes, the BID
allocation process is not required.

The BID allocation process performs the following functions:

l Determines the IP addresses used in a branch for distributed L2 mode

l Determines the subnet used in a branch for distributed L3 mode

l Avoids IP address or subnet overlap (that is, avoids IP conflict)

l Ensures that a branch is allocated the same subnet or range of IP addresses irrespective of which AP in the
branch assumes the role of the master in an IAP cluster

Trusted Branch Validation
The branch registration requests sent by the IAP indicates whether the IAP is managed by AirWave or Central,
and provides information about the IAP configuration modes on AirWave (managed or monitored modes).
Based on the information received in the registration request and the status of trusted branch configuration,
controller allows the IAP to register the branch.

Table 227 maps the IAP configuration scenario to the branch registration and trusted branch validation
process.

IAP Configuration Mode on
AirWave or Central

Trusted Branch DB
validation Enabled on
Controller

Branch Registration
Allowed?

Monitor mode Yes No

Monitor mode No Yes

Managed mode Yes Yes

Table 227: Branch Registration and Trusted Branch Validation



IAP Configuration Mode on
AirWave or Central

Trusted Branch DB
validation Enabled on
Controller

Branch Registration
Allowed?

Managed mode No Yes

Not managed by AirWave or
Central

Yes No

Not managed by AirWave or
Central

No Yes

Table 227: Branch Registration and Trusted Branch Validation

To enable trusted branch DB validation:

l Ensure that the IAPs are running Instant 4.0 or later.

l Ensure that the controller is upgraded to ArubaOS 8.0 or later.

If you have a master-local setup, upgrade the master controller first, and then the Local controller.

l Ensure that the IAP-VPN branches are configured through the AirWave or Central management interfaces. If
the IAP VPN branches are not managed by AirWave or Central, or if your network has IAPs running Instant
3.4 or lower release versions, execute the following command to ensure that all branches are in the trusted
list:
(host) [mynode] (config) #iap trusted-branch-db allow-all

or
(host) [mynode] (config) #iap trusted-branch-db add mac-address <mac-address>

VPN Configuration
The following VPN configuration steps on the controller enable IAPs to terminate their VPN connection on the
controller:

Whitelist DB Configuration

Controller Whitelist DB
You can use the following CLI command to configure the whitelist DB if the controller is acting as the whitelist
entry:
(host) [mynode] #whitelist-db rap add mac-address 00:11:22:33:44:55 ap-group test

The ap-group parameter is not used for any configuration, but needs to be configured. The parameter can be
any valid string. If an external whitelist is being used, the MAC address of the AP needs to be saved in the
Radius server as a lower case entry without any delimiter.

External Whitelist DB
The external whitelist functionality enables you to configure the RADIUS server to use an external whitelist for
authentication of MAC addresses of RAPs.

If you are using Windows 2003 server, perform the following steps to configure external whitelist on it. There
are equivalent steps available for Windows Server 2008 and other RADIUS servers.

1. Add the MAC addresses for all the RAPs in the Active Directory of the Radius server:

ArubaOS 8.0.0.0 | User Guide Instant AP VPN Support |  969



970 | Instant AP VPN Support ArubaOS 8.0.0.0  | User Guide

a. Open the Active Directory and Computers window, add a new user and specify the MAC address
(without the colon delimiter) of the RAP for the user name and password.

b. Right-click the user that you have just created and click Properties.

c. In the Dial-in tab, select Allow access in the Remote Access Permission section and click OK.

d. Repeat Step a through Step b for all RAPs.

2. Define the remote access policy in the Internet Authentication Service:

a. In the Internet Authentication Service window, select Remote Access Policies.

b. Launch the wizard to configure a new remote access policy.

c. Define filters and select select grant remote access permission in the Permissions window.

d. Right-click the policy that you have just created and select Properties.

e. In the Settings tab, select the policy condition, and Edit Profile....
f. In the Advanced tab, select Vendor Specific, and click Add to add new vendor specific attributes.

g. Add new vendor specific attributes and click OK.

h. In the IP tab, provide the IP address of the RAP and click OK.

VPN Local Pool Configuration
The VPN local pool is used to assign an IP Address to the IAP after successful XAUTH VPN.
(host) [mynode] # ip local pool "rapngpool" <startip> <endip>

Role Assignment for the Authenticated IAPs
Define a role that includes a source NAT rule to allow connections to the RADIUS server and for the Dynamic
Radius Proxy in the IAP to work. This role is assigned to IAPs after successful authentication.
(host) [mynode] (config) #ip access-list session iaprole

(host) [mynode] (config-sess-iaprole) #any host <radius-server-ip> any src-nat

(host) [mynode] (config-sess-iaprole) #any any any permit

(host) [mynode] (config-sess-iaprole) #!

(host) [mynode] (config) #user-role iaprole

(host) [mynode] (config-role) #session-acl iaprole

VPN Profile Configuration
The VPN profile configuration defines the server used to authenticate the IAP (internal or an external server)
and the role assigned to the IAP after successful authentication.
(host) [mynode] (config) #aaa authentication vpn default-iap

(host) [mynode] (VPN Authentication Profile "default-iap") #server-group default

(host) [mynode] (VPN Authentication Profile "default-iap") #default-role iaprole

The default role parameter of the aaa authentication vpn  command requires Policy Enforcement Firewall for
VPN users (PEFV) license.

By default, the controller uses the default IAP role. If the administrator changes the IAP role name when the IAP's
status is UP, then the controller or the IAP must be rebooted.

For more information on VPN profile configuration, see the VPN Configuration chapter of the Aruba Instant
User Guide.



Viewing Branch Status
To view the details of the branch information connected to the controller, execute the show iap table
command.

Sample Configuration

This example shows the details of the branches connected to the controller:
(host) [mynode] #show iap table long

IAP Branch Table

----------------

Name VC MAC Address Status Inner IP Assigned Subnet Assigned Vlan

---- -------------- ------ -------- --------------- -------------

Tokyo-CB:D3:16 6c:f3:7f:cc:42:f8 DOWN 0.0.0.0

Paris-CB:D3:16 6c:f3:7f:cc:3d:04 UP 10.15.207.140 10.15.206.99/29 2

LA 6c:f3:7f:cc:42:25 UP 10.15.207.111 10.15.206.24/29 2

Munich d8:c7:c8:cb:d3:16 DOWN 0.0.0.0

London-c0:e1 6c:f3:7f:c0:e1:b1 UP 10.15.207.120 10.15.206.64/29 2

Instant-CB:D3 6c:f3:7f:cc:42:1e DOWN 0.0.0.0

Delhi 6c:f3:7f:cc:42:ca DOWN 0.0.0.0

Singapore 6c:f3:7f:cc:42:cb UP 10.15.207.122 10.15.206.120/29 2

Key Bid(Subnet Name)

--- ----------------

b3c65c...

b3c65c...

b3c65c... 2(10.15.205.0-10.15.205.250,5),1(10.15.206.1-10.15.206.252,5)

a2a65c... 0

b3c65c... 7(10.15.205.0-10.15.205.250,5),8(10.15.206.1-10.15.206.252,5)

b3c65c...

b3c65c... 1(10.15.205.0-10.15.205.250,5),2(10.15.206.1-10.15.206.252,5)

b3c65c... 14(10.15.205.0-10.15.205.250,5),15(10.15.206.1-10.15.206.252,5)

The output of this command includes the following parameters:

Parameter Description

Name Displays the name of the branch.

VC MAC Address Displays the MAC address of the Virtual Controller of the branch.

Status Displays the current status of the branch (UP/DOWN).

Inner IP Displays the internal VPN IP of the branch.

Assigned Subnet Displays the subnet mask assigned to the branch.

Table 228: IAP Table Parameters
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Parameter Description

Assigned Vlan Displays the VLAN ID assigned to the branch.

Key Displays the key for the branch, which is unique to each branch.

Bid(Subnet Name) Displays the Branch ID (BID) of the subnet.

l In the example above, the controller displays bid-per-subnet-per-branch i.e., for
"LA" branch, BID "2" for the ip-range "10.15.205.0-10.15.205.250" with client
count per branch "5"). If a branch has multiple subnets, it can have multiple BIDs.

l Branches that are in UP state and do not have a Bid(Subnet Name) means that
the IAP is connected to a controller which did not assign any bid for any subnet. In
the above example, "Paris-CB:D3:16" branch is UP and does not have a Bid
(Subnet Name) information. This means that either the IAP is connected to a
backup controller or connected to a primary controller without any distributed L2
or L3 subnets.

For more information on bid-per-subnet-per-branch and distributed L2 and L3
subnets, see the DHCP Configuration chapter of the Aruba Instant Access Point
6.2.1.0-3.3 User Guide.

Executing the show iap table command does not display the Key and Bid(Subnet Name) parameters.
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Chapter 44
External Services Interface

The External Services Interface (ESI) provides an open interface that is used to integrate security solutions that
solve interior network problems such as viruses, worms, spyware, and corporate compliance. ESI allows
selective redirection of traffic to external service appliances such as anti-virus gateways, content filters, and
intrusion detection systems. When “interesting” traffic is detected by these external devices, it can be dropped,
logged, modified, or transformed according to the rules of the device. ESI also permits configuration of
different server groups—with each group potentially performing a different action on the traffic.

You can configure ESI to do one or more of the following for each group:

l Redirect specified types of traffic to the server

l Perform health checks on each of the servers in the group

l Perform per-session load balancing between the servers in each group

l Provide an interface for the server to return information about the client that can place the client in special
roles such as “quarantine"

ESI cannot function or send information across an IPsec tunnel.

ESI also provides the ESI syslog parser, which is a mechanism for interpreting syslog messages from third-party
appliances such as anti-virus gateways, content filters, and intrusion detection systems. The ESI syslog parser is
a generic syslog parser that accepts syslog messages from external devices, processes them according to user-
defined rules, and then takes configurable actions on system users.

Topics in this chapter include:

l Sample ESI Topology on page 973

l Understanding the ESI Syslog Parser on page 975

l Configuring ESI on page 978

l Sample Route-Mode ESI Topology on page 985

l Sample NAT-mode ESI Topology on page 991

l Understanding Basic Regular Expression (BRE) Syntax on page 996

The ESI feature requires that the Policy Enforcement Firewall Next Generation (PEFNG) license is installed on the
managed device.

Sample ESI Topology
In the example shown in this section, ESI is used to provide an interface to the AntiVirusFirewall (AVF) server
device for providing virus inspection services. An AVF server device is one of many different types of services
supported in the ESI.



974 | External Services Interface ArubaOS 8.0.0.0  | User Guide

Figure 119 ESI-Fortinet Topology

In the ESI–Fortnet topology, the clients connect to access points (both wireless and wired). The wired access
points tunnel all traffic back to the managed device over the existing network.

The managed device receives the traffic and redirects relevant traffic (including but not limited to all
HTTP/HTTPS and email protocols such as SMTP and POP3) to the AVF server device to provide services such as
anti-virus scanning, email scanning, web content inspection, etc. This traffic is redirected on the “untrusted”
interface between the managed device and the AVF server device. The managed device also redirects the traffic
intended for the clients coming from either the Internet or the internal network. This traffic is redirected on the
“trusted” interface between the managed device and the AVF server device. The managed device forwards all
other traffic (for which the AVF server does not perform any of the required operations such as AV scanning).
An example of such traffic would be database traffic running from a client to an internal server.

The managed device can also be configured to redirect traffic only from clients in a particular role such as
“guest” or “non-remediated client” to the AVF server device. This might be done to reduce the load on the AVF
server device if there is a different mechanism such as the Aruba-Sygate integrated solution to enforce client
policies on the clients that are under the control of the IT department. These policies can be used to ensure
that an anti-virus agent runs on the clients and the client can get access to the network only if this agent
reports a “healthy” status for the client. Refer to the paper (available from Sygate) on Sygate integrated
solutions for more details on this solution.

The managed device is also capable of load balancing between multiple external server appliances. This
provides more scalability as well as redundancy by using multiple external server appliances. Also, the managed
device can be configured to have multiple groups of external server devices and different kinds of traffic can be
redirected to different groups of devices with load balancing occurring within each group (see Figure 120 for an
example).



Figure 120 Load Balancing Groups

Understanding the ESI Syslog Parser
The ESI syslog parser adds a UNIX-style regular expression engine for parsing relevant fields in messages from
third-party appliances such as anti-virus gateways, content filters, and intrusion detection systems.

The user creates a list of rules that identify the type of message, the username to which this message pertains,
and the action to be taken when there is a match on the condition.

ESI Parser Domains
The ESI servers are configured into ESI parser domains (see Figure 121) to which the rules will be applied. This
condition ensures that only messages coming from configured ESI parser domains are accepted, and reduces
the number of rules that must be examined before a match is detected (Syslog Parser Rules on page 977).
messages.When a syslog message is received, it is checked against the list of defined ESI servers. If a server
match is found, the message is then tested against the list of predefined rules.
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Figure 121 ESI Parser Domains

The ESI syslog parser begins with a list of configured IP interfaces which listen for ESI messages. When a syslog
message is received, it is checked against the list of defined ESI servers. If a server match is found, the message
is then tested against the list of predefined rules.

Within the rule-checking process, the incoming message is checked against the list of rules to search first for a
condition match (see Syslog Parser Rules on page 977). If a condition match is made, and the user name can be
extracted from the syslog message, the resulting user action is processed by first attempting to look up the
user in the local user table. If the user is found, the appropriate action is taken on the user. The default
behavior is to look for users only on the local managed device. If the user is not found, the event is
meaningless and is ignored. This is the typical situation when a single managed device is connected to a
dedicated ESI server.

Peer Managed Devices
As an alternative, consider a topology where multiple managed device share one or more ESI servers.

Figure 122 ESI Peer managed device



In this scenario, several managed device (master and local) are defined in the same syslog parser domain to act
as peers. From the standpoint of the ESI servers, because there is no accurate way of determining from which
managed device a given user came. Thus, the event is flooded out to all managed device defined as peers
within this ESI parser domain. The corresponding managed device holding the user entry acts on the event,
while other managed device ignore the event.

Syslog Parser Rules
The user creates an ESI rule by using characters and special operators to specify a pattern (regular expression)
that uniquely identifies a certain amount of text within a syslog message. (Regular expression syntax is
described in Understanding Basic Regular Expression (BRE) Syntax on page 996.) This “condition” defines the
type of message and the ESI domain to which this message pertains. The rule contains three major fields:

l Condition: The pattern that uniquely identifies the syslog message type.

l User: The username identifier. It can be in the form of a name, MAC address, or IP address.

l Action: The action to take when a rule match occurs.

Once a condition match has been made, no further rule-matching will be made. For the rule that matched, only
one action can be defined.

After a condition match has been made, the message is parsed for the user information. This is done by
specifying the target region with the regular expression (REGEX) regex() block syntax. This syntax generates
two blocks: The first block is the matched expression; the second block contains the value inside the
parentheses. For username matching, the focus is on the second block, as it contains the username.

Condition Pattern Matching
The following description uses the Fortigate virus syslog message format as an example to describe condition
pattern matching. The Fortigate virus syslog message takes the form:
Sep 26 18:30:02 log_id=0100030101 type=virus subtype=infected src=1.2.3.4

This message example contains the Fortigate virus log ID number 0100030101 (“log_id=0100030101”), which
can be used as the condition—the pattern that uniquely identifies this syslog message.

The parser expression that matches this condition is “log_id=0100030101”. This is a narrow match on the
specific log ID number shown in the message, or “log_id=[0–9]{10}[ ]” ,which is a regular expression that
matches any Fortigate log entry with a ten-digit log ID followed by a space.

User Pattern Matching
To extract the user identifier in the example Fortigate virus message shown above (“src=1.2.3.4”), use the
following expression, “src=(.*)[ ]” to parse the user information contained between the parentheses. The ()
block specifies where the username will be extracted. Only the first block will be processed.

More examples:

Given a message wherein the username is a MAC address:
Sep 26 18:30:02 log_id=0100030101 type=virus subtype=infected mac 00:aa:bb:cc:dd:00

The expression “mac[ ](.{17})” will match “mac 00:aa:bb:cc:dd:00” in the example message.

Given a message wherein the username is a user name:
Sep 26 18:30:02 log_id=0100030101 type=virus subtype=infected user<johndoe>

The expression “user<(.*)>” will match “user<johndoe>” in the example message.
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Configuring ESI
You can use the following interfaces to configure and manage ESI and ESI syslog parser behavior:

l The Web user interface (WebUI), which is accessible through a standard Web browser from a remote
management console or workstation.

l The command line interface (CLI), which is accessible from a local console device connected to the serial port
on the managed device or through a Telnet or Secure Shell (SSH) connection from a remote management
console or workstation.

By default, you can access the CLI only from the serial port or from an SSH session. To use the CLI in a Telnet
session, you must explicitly enable Telnet on the managed device. The general configuration descriptions in the
following sections include both the WebUI pages and the CLI configuration commands. The configuration overview
section is followed by several examples that show specific configuration procedures.

l The Aruba Management System, which is a suite of applications for monitoring Mobility Master and their
relatedmanaged devices and APs. Each application provides a Web-based user interface. The Aruba
Management System is available as an integrated appliance and as a software application that runs on a
dedicated system. See the ArubaOS User Guide for more information.

In general, there are three ESI configuration “phases” on the managed device as a part of the solution:

l The first phase configures the ESI ping health-check method, servers, and server groups.The term server here
refers to external server devices, for example, an AVF.

l The second phase configures the redirection policies instructing the managed device how to redirect the
different types of traffic to different server groups.

l The final phase configures the ESI syslog parser domains and the rules that interpret and act on syslog
message contents.

The procedures shown in the following sections are general descriptions. Your application might be broader or
narrower than this example, but the same general operations apply.

Configuring Health-Check Method, Groups, and Servers
To configure the ESI health-check method, servers, and server groups, navigate to the Configuration >
Services > External Services view on the WebUI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services page and select the

External Services tab.

2. Click General accordion.

3. Click + in the Health-Check Configuration table. The Create Health Check table is displayed.

(To change an existing profile, click the health check profile name.)

4. Provide the following details in the Create Health Check table:

a. Enter a Profile Name.

b. Frequency (secs)—Indicates how often the managed device checks to see if the server is up and
running. Default: 5 seconds.

c. Timeout (secs)—Indicates the number of seconds the managed device waits for a response to its
health check query before marking the health check as failed. Default: 2 seconds.

d. Retry count—Is the number of failed health checks after which the managed device marks the server
as being down. Default: 2.

5. Click Submit to add a new health check profile.



6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi ping profile_name

frequency seconds

retry-count count

timeout seconds

Defining the ESI Server
The following sections describe how to configure an ESI server using the WebUI and CLI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services and select the

External Services tab.

2. Click General accordion.

3. Click + in the External Servers table. The Create Server table is displayed.

4. Provide the following details in the Create Server table:

a. Server Name.

b. Server Group. Use the drop-down list to assign this server to a group from the existing configured
groups.

c. Server Mode. Use the drop-down list to choose the mode (bridge, nat, or route) your topology requires.
Refer to the description above to understand the differences between these modes.

For routed mode, enter the Trusted IP Address (the IP address of the trusted interface on the external
server device) and the Untrusted IP Address (the IP address of the untrusted interface on the external
server device). (You can also choose to enable a health check on either or both of these interfaces.)

For bridged mode, enter the Trusted Port number (the port connected to the trusted side of the ESI
server) and the Untrusted Port number (the port connected to the untrusted side of the ESI server).

For NAT mode, enter the Trusted IP Address (the trusted interface on the external server) and the
NAT Destination Port number (the port a packet is redirected to rather than the original destination
port in the packet). You can also choose to enable a health check on the trusted IP address interface.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi server server_identity

dport destination_tcp/udp_port

mode {bridge | nat | route}

trusted-ip-addr ip-addr [health-check]

trusted-port <slot/module/port>

untrusted-ip-addr ip-addr [health-check]

untrusted-port <slot/module/port>

Defining the ESI Server Group
The following sections describe how to configure an ESI server group using the WebUI and CLI.
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In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services and select the

External Services tab.

2. Click General accordion.

3. Click + in the Server Groups table. The Create Server Group table is displayed.

(To change an existing group, click the name of the server group you want to edit.)

4. Provide the following details in the Create Server Group table:

a. Enter a Group Name.

b. In the drop-down list, select a health check profile.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi group name

ping profile_name

server server_identity

Policies and User Role
The following sections describe how to configure the redirection policies and user role using the WebUI and
CLI.

In the WebUI
1. To configure user roles to redirect the required traffic to the server(s), in the Managed Network node

hierarchy, navigate to Configuration > Roles & Policies.

2. Click + to create a new user role.

3. To add a new role, click +. The New Role section is displayed.

To change an existing role, click on the role name for the rules to be changed.

4. Enter the Name for the role and click Apply.

5. To add a policy for the new role, select the name of the role. The roles > <name of the role> table is
displayed.

6. Click Show Advanced View on the table head. The Policies tab is now visible.

7. Click + in the Policies table. The Add Policy section is displayed.

Choose from existing configured policies, create a new policy based on existing policies, or create a new
policy.

a. If you elect to create a new policy, click on the Create New Policy option.

b. Enter the Policy Name and click Submit.

8. To add a rule to a policy, click the Policy name. The Role > Policy table is displayed.

9. Click + to add a new rule. The New rule for <policy name> is displayed.

c. Select the Rule Type as Access Control. The New rules for the rule type table is displayed.

d. Select IPV4 for the IP Version from the drop-down list.

e. Select Source, Destination, Service/app from their respective drop-down lists.

f. In the Action drop-down list, select the redirect option.

g. In the Redirected to drop-down list, select the ESI group.



h. Select ESI Direction. Forward refers to the direction of traffic from the (untrusted) client or user to the
(trusted) server (such as the HTTP server or email server).

10.Click Submit.

11.Click Pending Changes.

12.In the Pending Changes window, select the check box and click Deploy changes.

13.Refer to Roles and Policies on page 363, for directions on how to apply a policy to a user role.

In the CLI
ip access-list session policy

any any any redirect esi-group group direction both blacklist

//For any incoming traffic, going to any destination,

//redirect the traffic to servers in the specified ESI group.

any any any permit

//For everything else, allow the traffic to flow normally.

user-role role

access-list {eth | mac | session}

bandwidth-contract name

captive-portal name

dialer name

pool {l2tp | pptp}

reauthentication-interval minutes

session-acl name

vlan vlan_id

ESI Syslog Parser Domains and Rules
The following sections describe how to manage syslog parser domains using the WebUI and CLI.

In the WebUI
To configure the ESI syslog parser, in the Managed Network node hierarchy, navigate to the Configuration
> Services > External Services view on the WebUI.

Click on the Syslog Parser Domains accordion to display the Syslog Parser Domains table.

This view lists all the domains by domain name and server IP address, and includes a list of peer managed
device (when peer managed device have been configured—as described in Understanding the ESI Syslog Parser
on page 975).

Adding a new syslog parser domain

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > External
Services

2. Click on the Syslog Parser Domains accordion

3. Click + in the Syslog Parser Domains table. The New Syslog Parser Domain is displayed.

4. In the Domain text box, type the name of the domain to be added.

5. In the Server field, click + in the IP ADDRESS table and the Add Server IP Address is displayed.

6. In the Add server IP address box, enter a valid IP address and click OK.

You must ensure that you type a valid IP address, because the IP address you type is not automatically validated
against the list of external servers that has been configured.

7. In the Peer Controller field, click + in the IP ADDRESS table and the Add Peer IP Address is displayed.

8. In the Add Peer IP address box, enter a valid IP address and click OK.

9. Click Submit.
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10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

Deleting an existing syslog parser domain

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > External
Services

2. Click on the Syslog Parser Domains accordion

3. Identify the target parser domain in the list shown in the Domain section of the Syslog Parser Domains
view.

4. Click Delete icon on the same row.

5. Click Submit.

6. Click Pending Changes.

7. In the Pending Changes window, select the check box and click Deploy changes.

Editing an existing syslog parser domain

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > External
Services

2. Click on the Syslog Parser Domains accordion

3. Identify the target parser domain in the list shown in the Syslog Parser Domains view .(see In the WebUI
on page 981)

4. Click on domain name you want to edit and the system displays the edit domain view.

You cannot modify the domain name when editing a parser domain.

5. To delete a server from the selected domain, highlight the server IP address and click Delete icon and then
click Submit.

6. To delete a Peer controller server from the selected domain, highlight the Peer controller IP address and
click Delete icon.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

When you make a change in the domain, you can click the View Commands link in the lower right corner of
the window to see the CLI command that corresponds to the edit action you performed.

In the CLI
Use these CLI commands to manage syslog parser domains.

Adding a new syslog parser domain
esi parser domain name

peer peer-ip

server ipaddr

Showing ESI syslog parser domain information
show esi parser domains

Deleting an existing syslog parser domain
no esi parser domain name



Editing an existing syslog parser domain
esi parser domain name

no

peer peer-ip

server ipaddr

Managing Syslog Parser Rules
The following sections describe how to manage syslog parser rules using the WebUI and CLI.

In the WebUI
Click on the Syslog Parser Rules accordion to display the Syslog Parser Rules view. This view displays a table
of rules with the following columns:

l Name— rule name

l Ena—where “y” indicates the rule is enabled and “n” indicates the rule is disabled (not enabled)

l Condition—Match condition (a regular expression)

l Match—Match type (IP address, MAC address, or user)

l User—Match pattern (a regular expression)

l Set—Set type (blacklist or role)

l Value—Set value (role name)

l Domain—Parser domain to which this rule is to be applied

l + —The actions that can be performed on each rule.

Adding a new parser rule

To add a new syslog parser rule:

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > External
Services

2. Click on the Syslog Parser Rules accordion.

3. Click + in the Syslog Parser Rules table. The New Syslog Parser Rules table is displayed.

4. In the Rule Name text box, type the name of the rule you want to add.

5. Click the Enable check box to enable the rule.

6. In the Condition Pattern text box, type the regular expression to be used as the condition pattern.

For example, “log_id=[0–9]{10}[ ]” to search for and match a 10-digit string preceded by “log_id=” and
followed by one space.

7. In the drop-down Match list, use the drop-down list to select the match type (ipaddr, mac, or user).

8. In the Match Pattern text box, type the regular expression to be used as the match pattern.

For example, if you selected “mac” as the match type, type the regular expression to be used as the match
pattern. You could use “mac[ ](.{17})” to search for and match a 17-character MAC address preceded by the
word “mac” plus one space.

9. In the drop-down Set list, select the set type (blacklist or role).

When you select role as the Set type, the system displays a second drop-down list. Click the list to display
the possible choices and select the appropriate role value. Validation on the entered value will be based on
the Set selection.

10.In the drop-down Parser Group list, select one of the configured parser domain names.

11.Click Submit.

12.Click Pending Changes.

13.In the Pending Changes window, select the check box and click Deploy changes.
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Deleting a syslog parser rule

To delete an existing syslog parser rule:

1. Identify the target parser rule in the list shown in the Syslog Parser Rules view.

2. Click Delete icon on the same row.

3. Click Submit.

4. Click Pending Changes.

5. In the Pending Changes window, select the check box and click Deploy changes.

Editing an existing syslog parser rule

To change an existing syslog parser rule:

1. In the Managed Network node hierarchy, navigate to the Configuration > Services > External
Services

2. Click on the Syslog Parser Rules accordion.

3. Identify the target parser rule in the list shown in the Syslog Parser Rules view.

4. Click on the syslog parser rule name and edit the fields.

You cannot modify the rule name when editing a parser rule.

5. Change the other rule attributes as required:

a. Click the Enable check box to enable the rule.

b. In the Condition Pattern text box, type the regular expression to be used as the condition pattern.

c. In the drop-down Match list, select the match type (ipaddr, mac, or user).

d. In the Match Pattern text box, type the regular expression to be used as the match pattern.

e. In the drop-down Set list, select the set type (blacklist or role).

f. When you select role as the Set type, the system displays a second drop-down list. Click the list to
display the possible choices and select the appropriate role value. Validation on the entered value will be
based on the Set selection.

g. In the drop-down Parser Group list, select one of the configured parser domain names.

At this point, you can test the rule you just edited by using the System Parser Test accordion (accessed from the
External Services tab by clicking the Syslog Parser Test accordion, described in Testing a Parser Rule on page 984.

6. Click Submit.

7. Click Pending Changes.

8. In the Pending Changes window, select the check box and click Deploy changes.

Testing a Parser Rule

You can test or validate enabled Syslog Parser rules against a sample syslog message, or against a syslog
message file containing multiple syslog messages. Access the parser rules test from the External Services tab
by clicking the Syslog Parser Test tab, which displays the Syslog Parser Rule Test view.

To test against a sample syslog message:

a. In the drop-down Test Type list, select Syslog message as the test source type.

b. In the Filename text box, type the syslog message text.

c. Click Test to start the test.



The test results are displayed in a box in the area below the Test button. The test results contain
information about the matching rule and match pattern.

l To test against a syslog message file:

a. In the drop-down Test Type list, select Syslog file as the test type.

b. In the Filename text box, type the syslog file name.

c. Click Test to start the test.

The test results are displayed in a box in the area below the Test button. The test results contain
information about the matching rule and match pattern.

In the CLI
Use these CLI commands to manage syslog parser rules.

Adding a new parser rule
esi parser rule rule-name

condition expression

domain name

enable

match {ipaddr expression | mac expression | user expression}

position position

set {blacklist | role role}

Showing ESI syslog parser rule information
show esi parser rules

Deleting a syslog parser rule
no esi parser rule rule-name

Editing an existing syslog parser rule
esi parser rule rule-name

condition expression

domain name

enable

match {ipaddr expression | mac expression | user expression}

no

position position

set {blacklist | role role}

Testing a parser rule
esi parser rule rule-name

test {file filename | msg message}

Monitoring Syslog Parser Statistics
The following sections describe how to monitor syslog parser statistics using the CLI.

In the CLI
show esi parser stats

Sample Route-Mode ESI Topology
This section introduces the configuration for a sample route-mode topology using the managed device and
Fortinet Anti-Virus gateways. In route mode, the trusted and untrusted interfaces between the managed
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device and the Fortinet gateways are on different subnets. The following figure shows an example route-mode
topology.

ESI with Fortinet Anti-Virus gateways is supported only in route mode.

Figure 123 Example Route-Mode Topology

In the topology shown, the following configurations are entered on the managed device and Fortinet gateway:

ESI server configuration on the managed device
l Trusted IP address = 10.168.172.3 (syslog source)

l Untrusted IP address = 10.168.171.3

l Mode = route

IP routing configuration on the Fortinet gateway
l Default gateway (core router) = 10.168.172.1

l Static route for wireless user subnet (10.168.173.0/24) through the managed device (10.168.171.2)

Configuring the Example Routed ESI Topology
This section describes how to implement the example routed ESI topology. The description includes the
relevant configuration—both the WebUI and the CLI configuration processes are described—required on the
managed device to integrate with a AVF server appliance.

The ESI configuration process will redirect all HTTP user traffic to the Fortinet server for examination, and any
infected user will be blacklisted. The configuration process consists of these general tasks:

l Defining the ESI server.

l Defining the default ping health check method.

l Defining the ESI group.

l Defining the HTTP redirect filter for sending HTTP traffic to the ESI server.

l Applying the firewall policy to the guest role.

l Defining ESI parser domains and rules.

There are three configuration “phases” on the managed device as a part of the solution.



l The first phase configures the ESI ping health-check method, servers, and server groups.The term server here
refers to external AVF server devices.

l In the second phase of the configuration task, the user roles are configured with the redirection policies
(session ACL definition) instructing the managed device to redirect the different types of traffic to different
server groups.

l In the final phase, the ESI parser domains and rules are configured.

The procedures shown in the following sections are based on the requirements in the example routed ESI topology.
Your application might be broader or narrower than this example, but the same general operations apply.

Health-Check Method, Groups, and Servers
To configure the ESI health-check method, servers, and server groups, navigate to the Configuration >
Advanced Services > External Services view on the WebUI.

Defining the Ping Health-Check Method

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services and click on the

External Services tab on the WebUI.

2. Click + in the Health-Check Configuration table under the General accordion on the WebUI. The Create
Health Check table is displayed.

3. Provide the following details in the Create Health Check table:

a. Enter enter the name default for the Profile Name.
b. Frequency (secs)—Enter 5.)

c. Timeout (secs)—Indicates the number of seconds the managed device waits for a response to its
health check query before marking the health check as failed. Default: 2 seconds. (In this example, enter
3.)

d. Retry count—Is the number of failed health checks after which the managed device marks the server
as being down. Default: 2. (In this example, enter 3.)

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi ping profile_name

frequency seconds

retry-count count

timeout seconds

Defining the ESI Server Group
The following sections describe how to configure an ESI server group using the WebUI and CLI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services and click on the

External Services tab on the WebUI

2. Click + in the Server Groups table. The Create Server Group table is displayed.

3. Provide the following details in the Create Server Group table:

a. Enter a Group Name. Enter fortinet.
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b. In the drop-down list, select default as the health check profile.

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi group name

ping profile_name

server server_identity

Defining the ESI Server
The following sections describe how to configure an ESI server using the WebUI and CLI.

In the WebUI
1. In the Managed Network node hierarchy, navigate to the Configuration > Services and click on the

External Services tab on the WebUI

2. Click + in the External Servers table. The Create Server table is displayed.

3. Provide the following details in the Create Server table:

a. Server Name. (This example uses the name forti_1.)

b. Server Group. Use the drop-down list to assign this server to a group from the existing configured
groups. (This example uses fortinet.)

c. Server Mode. Use the drop-down list to choose the mode (bridge, nat, or route) your topology requires.
Refer to the description above to understand the differences between the modes. (This example uses
route mode.)

d. Trusted IP Address. Enter 10.168.172.3.)

e. Untrusted IP Address. Enter 10.168.171.3.)

4. Click Submit.

5. Click Pending Changes.

6. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
esi server server_identity

dport destination_tcp/udp_port

mode {bridge | nat | route}

trusted-ip-addr ip-addr [health-check]

trusted-port <slot/module/port>

untrusted-ip-addr ip-addr [health-check]

untrusted-port <slot/module/port>

Redirection Policies and Role
The following sections describe how to configure the redirection policies and user role using the WebUI and
CLI.

In the WebUI
1. To configure user roles to redirect the required traffic to the server(s), in the Managed Network node

hierarchy, navigate to Configuration > Roles & Policies > Roles tab.

2. Click + to create a new user role.

3. Enter guest for Role Name.



4. Click Submit.

5. Select guest role.

6. Click Show Advanced View.

7. Click + in Roles >guest table.

8. Click Policies tab. Click + to create a new policy.

9. In the Add Policy popup, select the Create a new policy option. Enter the Policy Name as fortinet and
select Policy type as Session from the drop-down list.

10.Click Submit.

11.Select the fortinet policy under the Roles > guest table.

12.Click + in the guest Policies > fortinet table.

13.Select Access Control as the Rule Type in New Rule for guest popup.

14.Enter the following information in the Roles > fortinet > New forwarding Rule table.

l IP version as IPv4.
l Source as Any.

l Destination as Any.

l Service/app as Protocol and the Protocol as svc-http (tcp 80).
l Action as Redirect.

l Enter Redirect to as ESI Group.

l Enter Esi group as fortinet.

l Select Esi direction as Both. Forward refers to the direction of traffic from the untrusted client or
user to the trusted server, such as the HTTP server or email server.

15.Click Submit.

16.Repeat the steps to configure additional rules. This example adds a rule that specifies
any, any, any, permit.

17.Click Submit.

18.Click Pending Changes.

19.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use these commands to define the redirection filter for sending traffic to the ESI server and apply the firewall
policy to a user role in the route-mode ESI topology example.
ip access-list session policy

any any any redirect esi-group group direction both blacklist

//For any incoming traffic, going to any destination,

//redirect the traffic to servers in the specified ESI group.

any any any permit

//For everything else, allow the traffic to flow normally.

user-role role

access-list {eth | mac | session}

bandwidth-contract name

captive-portal name

dialer name

pool {l2tp | pptp}

reauthentication-interval minutes

session-acl name

vlan vlan_id
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Syslog Parser Domain and Rules
The following sections describe how to configure the syslog parser domain and rules for the route-mode
example using the WebUI and CLI.

In the WebUI

Adding a New Syslog Parser Domain

To add a new syslog parser domain for the routed example:

1. Click + in the Syslog Parser Domains table. The New Syslog Parser Domain is displayed.

2. In the Domain text box, type the name of the domain to be added.

3. In the Server field, click + in the IP ADDRESS table and the Add Server IP Address is displayed.

4. In the Add server IP address box, enter a valid IP address and click OK.

You must ensure that you type a valid IP address, because the IP address you type is not automatically validated
against the list of external servers that has been configured.

5. In the Peer Controller field, click + in the IP ADDRESS table and the Add Peer IP Address is displayed.

6. In the Add Peer IP address box, enter a valid IP address and click OK.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

Adding a New Parser Rule

To add a new syslog parser rule for the route-mode example:

1. Click + in the Syslog Parser Rules table. The New Syslog Parser Rules table is displayed.

2. In the Rule Name text box, type the name of the rule to be added (in this example, “forti_virus”).

3. Click the Enable check box to enable the rule.

4. In the Condition Pattern text box, type the regular expression to be used as the condition pattern. (In this
example, the expression “log_id=[0–9]{10}[ ]” searches for and matches a 10-digit string preceded by “log_
id=” and followed by one space.)

5. In the drop-down Match list, use the drop-down list to select the match type (in this example, ipaddr).

6. In the Match Pattern text box, type the regular expression to be used as the match pattern (in this
example, “src=(.*)[ ]”).

7. In the drop-down Set list, select the set type (in this example, blacklist).

8. In the drop-down Parser Group list, select one of the configured parser domain names (in this example,
“forti_domain”).

9. Click Submit.

10.Click Pending Changes.

11.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use these CLI commands to define a syslog parser domain and the rule to be applied in the route-mode
example shown in Figure 123.
esi parser domain name

peer peer-ip

server ipaddr



esi parser rule rule-name

condition expression

domain name

enable

match {ipaddr expression | mac expression | user expression }

position position

set {blacklist | role role}

Sample NAT-mode ESI Topology
This section describes the configuration for a sample NAT-mode topology using the managed device and three
external captive-portal servers. NAT mode uses a trusted interface for each external captive-portal server and a
different destination port to redirect a packet to a port other than the original destination port in the packet.
An example topology is shown below in Figure 125.

Figure 124 Example NAT-Mode Topology
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Figure 125

In this example, all HTTP traffic received by the managed device is redirected to the external captive portal
server group and load-balanced across the captive portal servers. All wireless client traffic with destination port
80 is redirected to the captive portal server group, with the new destination port 8080.

The external servers do not necessarily have to be on the subnet as the managed device. The policy that redirects
traffic to the external servers for load balancing is routed to the external servers if they are on a different subnet.

In the topology shown, the following configurations are entered on the managed device and external captive-
portal servers:

ESI server configuration on the managed device
l External captive-portal server 1:

n Name = external_cp1

n Mode = NAT

n Trusted IP address = 10.1.1.1

n Alternate destination port = 8080

l External captive-portal server 2:

n Name = external_cp2

n Mode = NAT

n Trusted IP address = 10.1.1.2

l External captive-portal server 3:

n Name = external_cp3

n Mode = NAT

n Trusted IP address = 10.1.1.3

l Health-check ping:

n Name = externalcp_ping

n Frequency = 30 seconds

n Retry-count = 2 attempts



n Timeout = 2 seconds (2 seconds is the default)

l ESI group = external_cps

l Session access control list (ACL)

n Name = cp_redirect_acl

n Session policy = user any svc-http redirect esi-group external_cps direction both

Configuring the Example NAT-mode ESI Topology
This section describes how to implement the example NAT-mode ESI topology shown in using both the WebUI,
then the CLI.

The configuration process consists of these general tasks:

l Configuring captive portal (see the “Configuring Captive Portal” chapter).

l Configuring the health-check ping method.

l Configuring the ESI servers.

l Configuring the ESI group.

l Defining the redirect filter for sending traffic to the ESI server.

Configuring the NAT-mode ESI Example in the WebUI
on the WebUI.

In the WebUI

Configuring a Health-Check Ping

1. In the Managed Network node hierarchy, navigate to the Configuration > Services and click on the
External Services tab

2. Click + in the Health-Check Configuration table under the General accordion on the WebUI. The Create
Health Check table is displayed.

3. Provide the following details in the Create Health Check table:

a. Profile Name. This example uses externalcp_ping.

b. Frequency seconds. This example uses 30.

c. Retry Count. This example uses 3.

If you do not specify a value for a parameter, the WebUI assumes the default value. In this example, the desired
timeout value is two seconds; therefore, not specifying the timeout causes the WebUI to use the default value of two
seconds.

4. Click Submit.

Configuring the ESI Group

1. In the Managed Network node hierarchy, navigate to the Configuration > Services and click on the
External Services tab on the WebUI.

2. Click + in the Server Groups table. The Create Server Group table is displayed.

3. Provide the following details in the Create Server Group table :

a. Group Name. This example uses external_cps.

b. Health-Check Profile. Select the health-check ping from the drop-down list. This example uses
externalcp_ping.

4. Click Submit when you are finished.
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Configuring the ESI Servers

1. Click + in the External Servers table. The Create Server table is displayed.

2. Provide the following details in the Create Server table:

a. Server Name.

b. Server Group. Use the drop-down list to assign this server to a group from the existing configured
groups.

c. Server Mode. Use the drop-down list to choose NAT mode.)

d. Trusted IP Address. For nat mode, enter the IP address of the trusted interface on the external captive
portal server.

e. NAT Destination Port. Enter the port number (to redirect a packet to a port other than the original
destination port in the packet).

3. Click Submit when you are finished.

4. Repeat Step 1 through Step 3 for the remaining external captive portal servers.

5. Click Submit to apply the configuration changes.

Configuring the Redirection Filter

To redirect the required traffic to the server(s) using the WebUI, navigate to the Configuration > Roles and
Policies.

In the WebUI
1. To configure user roles to redirect the required traffic to the server(s), in the Managed Network node

hierarchy, navigate to Configuration > Roles & Policies > Roles tab.

2. Click + to create a new user role.

3. Enter guest for Role Name.

4. Click Submit.

5. Select guest role.

6. Click Show Advanced View.

7. Click + in Roles >guest table.

8. Click Policies tab. Click + to create a new policy.

9. In the Add Policy popup, select the Create a new policy option. Enter the Policy Name as fortinet and
select Policy type as Session from the drop-down list.

10.Click Submit.

11.Select the cp_redirect_acl policy under the Roles > guest table.

12.Click + in the guest Policies > cp_redirect_acl table.

13.Select Access Control as the Rule Type in New Rule for guest popup.

14.Enter the following information in the Roles > fortinet > New forwarding Rule table.

l IP version as IPv4.
l Source as User.

l Destination as Any.

l Service/app as Service and the Protocol as svc-http (tcp 80).
l Action as Redirect.

l Enter Redirect to as ESI Group.

l Enter Esi group as fortinet.



l Select Esi direction as Both. Forward refers to the direction of traffic from the untrusted client or
user to the trusted server, such as the HTTP server or email server.

15.Click Submit.

16.Click Pending Changes.

17.In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
The CLI configuration process consists of these general tasks:

l Configuring captive portal (see Captive Portal Authentication on page 286).

l Configuring the health-check ping method.

l Configuring the ESI servers.

l Configuring the ESI group.

l Defining the redirect filter for sending traffic to the ESI server.

Configuring a Health-Check Ping

The health-check ping will be associated with an ESI group, along with servers, so that managed device will send
ICMP echo requests to each server in the group and mark the server down if the managed device does not hear
from the server. The health-check parameters used in this example are:

l Frequency—30 seconds. (The default is 5 seconds.)

l Retry-count—3. (The default is 2.)

l Timeout—2 seconds. (The default is 2 seconds.)

Use these CLI commands to configure a health-check ping method:
esi ping profile_name

frequency seconds

retry-count count

timeout seconds

Configuring ESI Servers

Here are the ESI server CLI configuration tasks:

l Configure server mode to be NAT.

l Configure the trusted IP address (the server IP address to which packets should be redirected).

l To redirect to a different port than the original destination port in the packet, configure an alternate
destination port.

Use these CLI commands to configure an ESI server and identify its associated attributes:
esi server server_identity

dport destination_tcp/udp_port

mode {bridge | nat | route}

trusted-ip-addr ip-addr [health-check]

Configuring an ESI Group, Add the Health-Check Ping and ESI Servers

Use these CLI commands to configure an ESI server group, identify its associated ping health-check method,
and associate a server with this group:
esi group name

ping profile_name

server server_identity

Using the ESI Group in a Session Access Control List

Use these CLI commands to define the redirection filter for sending traffic to the ESI server.
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ip access-list session policy

user any svc-http redirect esi-group group direction both

Understanding Basic Regular Expression (BRE) Syntax
The ESI syslog parser supports regular expressions created using the Basic Regular Expression (BRE) syntax
described in this section. BRE syntax consists of instructions—character-matching operators (described in
Table 229), repetition operators (described in Table 230), or expression anchors (described in Table 231)—used
to defined the search or match target.

This section contains the following topics:

l “Character-Matching Operators” on page 512

l “Regular Expression Repetition Operators” on page 513

l “Regular Expression Anchors” on page 513

l “References” on page 514

Character-Matching Operators
Character-matching operators define what the search will match.

Operator Description Sample Result

. Match any one character. grep .ord sample.txt Matches ford, lord, 2ord, etc.
in the file sample.txt.

[ ] Match any one character
listed between the brackets

grep [cng]ord sample.txt Matches only cord, nord, and
gord

[^] Match any one character not
listed between the brackets

grep [^cn]ord sample.txt Matches lord, 2ord, etc., but
not cord or nord

grep [a-zA-Z]ord
sample.txt

Matches aord, bord, Aord,
Bord, etc.

grep [^0-9]ord
sample.txt

Matches Aord, aord, etc., but
not 2ord, etc.

Table 229: Character-matching operators in regular expressions

Regular Expression Repetition Operators
Repetition operators are quantifiers that describe how many times to search for a specified string. Use them
in conjunction with the character-matching operators in Table 230 to search for multiple characters.



Operator Description Sample Result

? Match any character one
time if it exists

egrep “?erd” sample text Matches berd, herd, etc., erd

* Match declared element
multiple times if it exists

egrep “n.*rd” sample.txt Matches nerd, nrd, neard, etc.

+ Match declared element
one or more times

egrep “[n]+erd” sample.txt Matches nerd, nnerd, etc., but
not erd

{n} Match declared element
exactly n times

egrep “[a-z]{2}erd”
sample.txt

Matches cherd, blerd, etc., but
not nerd, erd, buzzerd, etc.

{n,} Match declared element at
least n times

egrep “.{2,}erd” sample.txt Matches cherd and buzzerd,
but not nerd

{n,N} Match declared element at
least n times, but not more
than N times

egrep “n[e]{1,2}rd”
sample.txt

Matches nerd and neerd

Table 230: Regular expression repetition operators

Regular Expression Anchors
Anchors describe where to match the pattern, and are a handy tool for searching for common string
combinations. Some of the anchor examples use the vi line editor command :s, which stands for substitute.
That command uses the syntax: s/pattern_to_match/pattern_to_substitute.

Operator Description Sample Result

^ Match at the beginning of a
line

s/^/blah / Inserts “blah” at the beginning
of the line

$ Match at the end of a line s/$/ blah/ Inserts “ blah” at the end of
the line

\< Match at the beginning of a
word

s/\</blah/ Inserts “blah” at the beginning
of the word

egrep “\<blah”
sample.txt

Matches blahfield, etc.

\> Match at the end of a word s/\>/blah/ Inserts “blah” at the end of
the word

Table 231: Regular expression anchors
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Operator Description Sample Result

egrep “\>blah”
sample.txt

Matches soupblah, etc.

\b Match at the beginning or
end of a word

egrep “\bblah”
sample.txt

Matches blahcake and
countblah

\B Match in the middle of a
word

egrep “\Bblah”
sample.txt

Matches sublahper, etc.

References
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l Regex syntax summary: http://www.greenend.org.uk/rjk/2002/06/regexp.html

l Basic regular expression (BRE) syntax: http://builder.com.com/5100-6372-1050915.html



ArubaOS 8.0.0.0 | User Guide External User Management | 999

Chapter 45
External User Management

This chapter introduces the ArubaOS XML API interface and briefly discusses how you can use simple API calls
to perform external user management tasks. Sample scripts are listed at the end of the chapter to help you get
started with using the XML API.

Topics in this chapter include:

l Overview on page 999

l How the ArubaOS XML API Works on page 999

l Creating an XML Request on page 999

l XML Response on page 1002

l Sample Scripts on page 1012

Overview
ArubaOS allows you to set up customized external captive portal user management using its native XML API
interface. The XML API interface allows you to create and execute user management operations on behalf of
the clients or users. You can use the XML API interface to add, delete, authenticate, blacklist, query, or log out a
user.

Before you Begin
l XML API requires the PEFNG license.

l Ensure that you have connectivity between your XML API server and the Mobility Master via HTTPS.

How the ArubaOS XML API Works
Typical interaction between your XML API server and Mobility Master happens using an HTTPS POST
command. A typical communication process using the XML API interface happens as follows:

1. An API command is issued from your server in XML format to Mobility Master. The XML request can be
composed using a language of your choice using the format described in the Creating an XML Request on
page 999. Sample scripts are available in Python or Bourne Shell, using cURL to generate the HTTPS POST
command. See the Sample Scripts on page 1012.

2. The XML request is sent using an HTTPS POST command. The common format of the HTTPS POST is
https://<Mobility Master-ip>/auth/command.xml. See Creating an XML Request on page 999 for
more information.

3. Mobility Master processes the XML API request and sends the response to the XML API server. You can use
the response and take appropriate action that suits your requirement. The response from Mobility Master
is returned using predefined formats. See the XML Response on page 1002 for more information.

Creating an XML Request
You can create XML request to add, delete, authenticate, blacklist, query, or logout a user. This section provides
XML request formats that you can use for each task.
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The XML API functions such as addition, deletion, authentication, blacklisting, querying, and logout have been
extended to support IPv6 users in addition to IPv4 users. However, the XML API server must be configured with an
IPv4 address for communication with Mobility Master.

Adding a User
This XML request uses the user_add command to create a new user entry in the Mobility Master user table. If
the user entry is already present in the user table, the command will modify the entry with the values defined
in the XML request, with an exception of IP and MAC address. Session time-out is only applicable to captive
portal users.
xml=<aruba command="user_add">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<role>Role_Name<role>

<session_timeout>Session_timeout</session_timeout>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_add command:

l IP Address

l MAC Address (a valid wireless or wired client on the managed device)

l Key

l Authentication

l Version

Deleting a User
Do not use the user_delete command if the intention is to clear the association from the Mobility Master user table.
If the client is dual-stack, it re-inherits the authentication state from the IPv6 address. If not dual-stack, the client
reverts to the initial role.

This XML request uses the user_delete command to delete an existing user from the Mobility Master user
table.
xml=<aruba command="user_delete">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_delete command:

l IP Address

l Key

l Authentication

l Version



Passing the MAC address or username serves only to perform additional validation against the mandatory IP
address. For example, if the IP address is 1.2.3.4 and the MAC address passed is 00:11:22:33:44:55 but the real MAC
address is 66:77:88:99:aa:bb then the XML request will fail with response code 1, "unknown user" message.

Authenticating a User
This XML request uses the user_authenticate command to authenticate against the server group defined in
the captive portal profile. This is only applicable to captive portal users.
xml=<aruba command="user_authenticate">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<password>Password_for_the_user</password>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_authenticate command:

l IP Address

l Name

l Password

l Key

l Authentication

l Version

Passing the MAC address serves only to perform additional validation against the mandatory IP address. For
example, if the IP address is 1.2.3.4 and the MAC address passed is 00:11:22:33:44:55 but the real MAC address is
66:77:88:99:aa:bb then the XML request will fail with response code 1, "unknown user" message.

Blacklisting a User
This XML request uses the user_blacklist command to blacklist a user from connecting to your network. This
command uses the default blacklist timeout of 3600 seconds. There is no corresponding clear command. You
can use the Mobility Master CLI to clear the blacklisted clients. Refer the show ap blacklist-clients, stm
remove-blacklist-client, and stm purge-blacklist-clients commands in the ArubaOS CLI Reference Guide
to clear the blacklisted clients.
xml=<aruba command="user_blacklist">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_blacklist command:

l IP Address

l Key

l Authentication

l Version
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Passing the MAC address or username serves only to perform additional validation against the mandatory IP
address. For example, if the IP address is 1.2.3.4 and the MAC address passed is 00:11:22:33:44:55 but the real MAC
address is 66:77:88:99:aa:bb then the XML request will fail with response code 1, "unknown user" message.

Querying for User Status
This XML request uses the user_query command to get the status and details of a user connected to your
network. A dual-stack client can be queried by any of its IPv4 or IPv6 addresses, but only the queried IP
address and corresponding values are displayed in the output.
xml=<aruba command="user_query">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_query command:

l IP Address

l Key

l Authentication

l Version

Passing the MAC address or username serves only to perform additional validation against the mandatory IP
address. For example, if the IP address is 1.2.3.4 and the MAC address passed is 00:11:22:33:44:55 but the real MAC
address is 66:77:88:99:aa:bb then the XML request will fail with response code 1, "unknown user" message.

Logging Out a User
This XML request uses the user_logout command to revert the user to the initial role. This is only applicable to
captive portal users. For dual-stack clients, all user-table entries will be reverted to the initial role.
xml=<aruba command="user_logout">

<ipaddr>IP-address_of_the_user</ipaddr>

<macaddr>MAC-address_of_the_user</macaddr>

<name>User_Name</name>

<key>Shared_Key</key>

<authentication>MD5|SHA-1|cleartext</authentication>

<version>1.0</version>

</aruba>

The following options are mandatory when you execute the user_logout command:

l IP Address

l Key

l Authentication

l Version

XML Response
For every successful XML request, Mobility Master will return the processed information as an XML response.
There are two types of responses: Default response and Query response.



Default Response Format
The format of a default XML response from Mobility Master is:
<aruba>

<status>Ok | Error</status>

<code>response_code</code>

<reason>response_message</reason>

</aruba>

In which,

l the status specifies if the XML response succeeds or fails. If the request succeeds, the status tag will contain
the Ok string. If the request fails, the status tag will contain the Error string.

l the code is an integer number that represents the error in the request. This tag is populated only if there is
an error in the request.

l the reason is a message that contains descriptive information about the error.

Response Codes
The following response codes are returned if the XML request returns an Error string.

Code Reason message Description

1 unknown user
The user specified in the XML request does not exist or is
incorrect.
If the MAC address or username is specified in the query, Mobility
Master restricts the supplied IP address, i.e., the requested user IP
address together with any MAC address and username will not be
found.

Returned by the user_
authenticate, user_delete, user_
blacklist, user_logout, and user_
query commands.

2 unknown role
The specified role in the XML request does not exist in Mobility
Master.

Returned by the user_add
command.

3 unknown external agent
This error string is returned due
to an unknown source IP (i.e. not
configured as an XML server).
Or,
In case of an user_add command,
it is likely to be due to the
default-xml-api AAA profile
missing from the AAA
authentication wired profile.

4 authentication failed Indicates an authentication failure
during user_authenticate.
This is only applicable to captive
portal users.

5 invalid command
The XML request contains a command not supported by ArubaOS
XML API interface.

—

Table 232: XML Response Codes
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Code Reason message Description

6 invalid message authentication method
The authentication method specified in the XML request is not
supported by the ArubaOS XML API interface.

Returned by commands that
contain the authentication
method in the XML request.

7 invalid message digest
This is due to a mismatch in
secret between the XML server
and Mobility Master XML API
profile.
If using non cleartext, this could
be an error in the calculation of
the hashed secret.

8 missing message authentication
The authentication method is not specified in the XML request.

Returned by all commands that
require the authentication
method in the XML request.

9 missing or invalid version number
The XML request does not contain the version number or the
version number is incorrect.

Returned by all commands.

10 internal error —

12 can't use vlan ip Indicates the supplied IP matches
a VLAN IP on Mobility Master.

13 invalid ip
The XML request contains invalid IP address of the user or client.

Returned by all commands that
required IP address to be
specified in the XML request.

14 can't use switch ip
The XML request contains the Mobility Master IP address instead
of the client IP address.

Returned by all commands that
required IP address to be
specified in the XML request.

15 missing MAC address
The XML request does not contain the MAC address of the user or
client.

Returned by all commands that
required MAC address to be
specified in the XML request.

16 unsupported command for this user Returned when the requested oper-
ation is invalid for the specified
user.

17 socket failed or timed out waiting for operation to complete Returned when the status of the
requested operation is unavailable;
usually signifies a socket com-
munication failure or timeout.

Query Command Response Format
The response of the XML request with the user_query command contains detailed information about the
status of the user or client.



The status, code and reason values are similar to the default response. The following responses are returned
only if the status code returns the Ok string.

Response
Code Description

status Displays the status of the XML response.

code Displays the code as an integer number that represents the error in the request. This
tag is populated only if there is an error in the request.

macaddr Displays the MAC address of the client.

ipaddr Displays the IPv4 or IPv6 address of the client.

name Displays the hostname of the user or client.

role Displays the current role of the authenticated client.

type Displays if the client is wired or wireless.

vlan Displays the VLAN ID of the client.

location Displays the name of the AP to which the client is associated.

age Displays the age of the client in Mobility Master. The age is displayed in DD:HH:MM
format (Day:Hours:Minutes).

auth_status Displays the authentication status of the client. Available values are: authenticated or
unauthenticated.

auth_server Displays the name of the authentication server used for authenticating the client. This
information is available only if the client is authenticated by Mobility Master.

auth_method Displays the authentication mechanism used to authenticate the client. This
information is available only if the client is authenticated by Mobility Master.

essid Displays the ESSID to which the client is associated.

bssid Displays the BSSID of the AP to which the client is associated.

phy_type Displays the physical connection type. Available values are: a, b, g, a-HT, g-HT, and a-
VHT.

mobility_state Displays the roaming state of the client. Available values are: Wired (Visitor), Visitor,
Wired (Away), Away, Wired (Foreign VLAN), Foreign VLAN, Wired (Remote), Asso-
ciated (Remote), Wired, and Wireless.

in_packets Displays the total number of incoming packets received by the client.

Table 233: Query Response Code

ArubaOS 8.0.0.0 | User Guide External User Management |  1005



1006 | External User Management ArubaOS 8.0.0.0  | User Guide

Response
Code Description

in_octets Displays the incoming packets (in bytes) received by the client.

out_packets Displays the total number of outgoing packets received by the client.

out_octets Displays the outgoing packets (in bytes) received by the client.

Using the XML API Server
Follow the steps below to use the XML API:

1. Configure an XML API server.

2. Associate the XML API server to an appropriate AAA profile.

3. Configure a user role to direct non-authenticated users to the external captive portal server.

4. Configure captive portal profile and associate that to an initial role (example logon).

5. Create an XML request with the appropriate API call.

6. Process XML response appropriately.

The default logon role of a client or user must have captive-portal enabled.

Configuring the XML API Server
Configure an external XML API server in your AAA infrastructure. In this example, 10.11.12.13 is your server.
The XML API interface on Mobility Master will receive requests from this server.

Define the XML API server and specify the key for verifying requests from your server:
(host) [mynode] (config) #aaa xml-api server 10.11.12.13

(host) ^[mynode] (XML API Server "10.11.12.13") #key aruba123

(host) ^[mynode] (XML API Server "10.11.12.13") #write memory

Verify the XML API server configuration:
(host) [mynode] #show aaa xml-api server

XML API Server List

-------------------

Name References Profile Status

---- ---------- --------------

10.11.12.13 0

Total:1

Associating the XML API Server to a AAA profile
After you define the XML API server profile associate it to the appropriate AAA profile. If the XML API server is
not correctly configured in the appropriate profile, Mobility Master will respond with the client not
authorized error message. You can add XML API server references to the following AAA profile depending on
your requirement:

Create a AAA profile for the wireless users and associate the XML API server:
(host) [mynode] (config) #aaa profile wirelessusers

(host) ^[mynode] (AAA Profile "wirelessusers") #xml-api-server 10.11.12.13

(host) ^[mynode] (AAA Profile "wirelessusers") #write memory



Verify the association of the XML API server to the AAA profile:
(host) [mynode] #show aaa profile wirelessusers

AAA Profile "wirelessusers"

---------------------------

Parameter Value Set

--------- ----- ---

Initial role logon

MAC Authentication Profile N/A

MAC Authentication Default Role guest

MAC Authentication Server Group default

802.1X Authentication Profile N/A

802.1X Authentication Default Role guest

802.1X Authentication Server Group N/A

Download Role from CPPM Disabled

Set username from dhcp option 12 Disabled

L2 Authentication Fail Through Disabled

Multiple Server Accounting Disabled

User idle timeout N/A

Max IPv4 for wireless user 2

RADIUS Accounting Server Group N/A

RADIUS Interim Accounting Disabled

XML API server 10.11.12.13

RFC 3576 server N/A

User derivation rules N/A

Wired to Wireless Roaming Enabled

Device Type Classification Enabled

Enforce DHCP Disabled

PAN Firewall Integration Disabled

Open SSID radius accounting Disabled

For wireless users, associate the AAA profile to the virtual AP profile:
(host) [mynode] (config) #wlan virtual-ap wireless-vap

(host) ^[mynode] (Virtual AP profile "wireless-vap") #aaa-profile wirelessusers

(host) ^[mynode] (Virtual AP profile "wireless-vap") #write memory

Verify the association of the AAA profile to the virtual AP profile:
(host) [mynode] #show wlan virtual-ap wireless-vap

Virtual AP profile "wireless-vap"

---------------------------------

Parameter Value Set

--------- ----- ---

AAA Profile wirelessusers

802.11K Profile default

Hotspot 2.0 Profile N/A

Virtual AP enable Enabled

VLAN N/A

Forward mode tunnel

SSID Profile default

Allowed band all

Band Steering Disabled

Cellular handoff assist Disabled

Openflow Enable Disabled

Steering Mode prefer-5ghz

Dynamic Multicast Optimization (DMO) Disabled

Dynamic Multicast Optimization (DMO) Threshold 6

Drop Broadcast and Multicast Disabled

Convert Broadcast ARP requests to unicast Enabled

Authentication Failure Blacklist Time 3600 sec

Blacklist Time 3600 sec

Deny inter user traffic Disabled

Deny time range N/A
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DoS Prevention Disabled

HA Discovery on-association Enabled

Mobile IP Enabled

Preserve Client VLAN Disabled

Remote-AP Operation standard

Station Blacklisting Enabled

Strict Compliance Disabled

VLAN Mobility Disabled

WAN Operation mode always

FDB Update on Assoc Disabled

WMM Traffic Management Profile N/A

Anyspot profile N/A

Create a AAA profile for the wired users and associate the XML API server:
(host) [mynode] (config) #aaa profile wiredusers

(host) ^[mynode] (AAA Profile "wiredusers") #xml-api-server 10.11.12.13

(host) ^[mynode] (AAA Profile "wiredusers") #write memory

Associate the wired AAA profile to the wired authentication profile:
(host) [mynode] (config) #aaa authentication wired

(host) ^[mynode] (Wired Authentication Profile) #profile wiredusers

(host) ^[mynode] (Wired Authentication Profile) #write memory

Verify the association of the wired AAA profile to the wired authentication profile:
(host) [mynode] #show aaa authentication wired

Wired Authentication Profile

----------------------------

Parameter Value

--------- -----

AAA Profile wiredusers

For unknown wired users, associate the XML API server to the default-xml-api AAA profile.

The default-xml-api AAA profile is used only to add or authenticate new users.

Associate the XML API server to the default-xml-api AAA profile:
(host) [mynode] (config) #aaa profile default-xml-api

(host) ^[mynode] (AAA Profile "default-xml-api") #xml-api-server 10.11.12.13

(host) ^[mynode] (AAA Profile "default-xml-api") #write memory

Verify the association of the XML API server to the default-xml-api AAA profile:
(host) [mynode] #show aaa profile default-xml-api

AAA Profile "default-xml-api" (Predefined (changed))

----------------------------------------------------

Parameter Value Set

--------- ----- ---

Initial role logon

MAC Authentication Profile N/A

MAC Authentication Default Role guest

MAC Authentication Server Group default

802.1X Authentication Profile N/A

802.1X Authentication Default Role guest

802.1X Authentication Server Group N/A

Download Role from CPPM Disabled

Set username from dhcp option 12 Disabled

L2 Authentication Fail Through Disabled

Multiple Server Accounting Disabled

User idle timeout N/A



Max IPv4 for wireless user 2

RADIUS Accounting Server Group N/A

RADIUS Interim Accounting Disabled

XML API server 10.11.12.13

RFC 3576 server N/A

User derivation rules N/A

Wired to Wireless Roaming Enabled

Device Type Classification Enabled

Enforce DHCP Disabled

PAN Firewall Integration Disabled

Open SSID radius accounting Disabled

Your Mobility Master is now ready to receive API calls from the XML API server.

Setting up the Captive Portal Profile
Set up a Captive Portal profile with a login page that will redirect users to the external Captive Portal server:
(host) [mynode] (config) #aaa authentication captive-portal captive-portal-auth

(host) ^[mynode] (Captive Portal Authentication Profile "captive-portal-auth") #default-role

authenticated

(host) (Captive Portal Authentication Profile "captive-portal-auth") #login-page

https://10.11.12.13/cgi-bin/login.pl

(host) (Captive Portal Authentication Profile "captive-portal-auth") #switch-in-redirection-

url

(host) (Captive Portal Authentication Profile "captive-portal-auth") #write memory

The login-page https://10.11.12.13/cgin-bin/login.pl is for illustration purposes where the login.pl is a Perl script on the
external server that handles the external captive portal.

Associating the Captive Portal Profile to an Initial Role
Associate the Captive Portal profile to the logon role:
(host) [mynode] (config) #user-role logon

(host) ^[mynode] (config-submode)#captive-portal captive-portal-auth

(host) ^[mynode] (config-submode)#session-acl captiveportal

(host) ^[mynode] (config-submode)#write memory

Create an alias for the external Captive Portal server:
(host) [mynode] (config) #netdestination xCP

(host) ^[mynode] (config-submode)#host 10.11.12.13

(host) ^[mynode] (config-submode)#write memory

You can either create a new ACL or append specific rules to an existing ACLs. Create session ACL for the logon
role:
(host) [mynode] (config) #ip access-list session captiveportal

(host) ^[mynode] (config-submode)#user alias xCP svc-https permit

(host) ^[mynode] (config-submode)#user alias xCP svc-http permit

(host) ^[mynode] (config-submode)#write memory

Creating an XML API Request
You can now create an XML request with an XML API command and send it to Mobility Master via HTTPS POST.
The format of the URL to send the XML request is:

https://<Mobility Master-ip/auth/command.xml

l Mobility Master-ip: The IP address of Mobility Master that will receive the XML API request

l command.xml: The XML request that contains the XML API command.

The format of the XML API request is:
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xml=<aruba command="<XML API command>">

<options>Value</options>

...

<options>Value</options>

</aruba>

You can specify any of the following commands in the XML request:

XML API Command Description

user_add This command creates a new user entry in the Mobility Master user
table. If the user entry is already present in the user table, the command
will modify the entry with the values defined in the XML request. For an
existing user, this command will update any value that is supplied, with
an exception of IP and MAC address. Session time-out is only applicable
to captive portal users.

user_delete This command deletes an existing user from the Mobility Master user
table.

NOTE: Do not use the user_delete command if the intention is to clear
the association from the Mobility Master user table. If the client is dual-
stack, it re-inherits the authentication state from the IPv6 address. If not
dual-stack, the client reverts to the initial role.

user_authenticate This command authenticates against the server group defined in the
captive portal profile. This is only applicable to captive portal users.

user_blacklist This command blacklists a user from connecting to your network. This
command uses the default blacklist timeout of 3600 seconds. There is no
corresponding clear command. You can use the Mobility Master CLI to
clear the blacklisted clients. Refer the show ap blacklist-clients, stm
remove-blacklist-client, and stm purge-blacklist-clients commands
in the ArubaOS CLI Reference Guide to clear the blacklisted clients.

user_query This command fetches the status and details of a user connected to your
network. A dual-stack client can be queried by any of its IPv4 or IPv6
addresses, but only the queried IP address is displayed in the output.

user_logout This command reverts the user to the initial role. This is only applicable
to captive portal users. For dual-stack clients, all user-table entries will
be reverted to the initial role.

Table 234: XML API Command

Each XML API command requires certain mandatory options to successfully execute the task. The list of all
available options are:



Options Description Range / Defaults

ipaddr IP address of the user in IPv4 or IPv6 format. —

macaddr MAC address of the user in aa:bb:cc:dd:ee:ff
format.

Enter MAC address with
colon.

user Name of the user. 64 character string

role The role to apply to a newly created user, or
change of role for an existing user. This option
applies to user_add and user_delete commands
only.

64 character string

password The password of the user for authentication. —

session_timeout Session time-out in seconds. User will be
disconnected after this time.

—

authentication Authentication method used to authenticate the
message and the sender. You can use any of
MD5, SHA-1 or clear text methods of
authentication. This option is ignored if shared
secret is not configured. It is, however, mandatory
if it is configured.

—

key This is the encoded SHA1/MD5 hash of shared
secret or plaintext shared secret.

This option is ignored if shared secret is not
configured on the switch.

The actual MD5/SHA-1 hash is 16/20 bytes and
consists of binary data. It must be encoded as an
ASCII based HEX string before sending. It must be
present when the Mobility Master is configured
with an xml-api key for the server. Encoded hash
length is 32/40 bytes for MD5/SHA-1.

version The version of the XML API interface available in
Mobility Master. This field is mandatory in all XML
API requests.

Current version 1.0

Table 235: XML API Command Options

Monitoring External Captive Portal Usage Statistics
To check the external captive portal authentication statistics, execute the show aaa xml-api statistics
command. This command displays the number of times an authentication command was executed per client.
The command also displays the number of times an authentication event occurred and the number of new
authentication events that occurred since the last status check.
(host) [mynode] #show aaa xml-api statistics
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Sample Scripts
You can download the sample scripts from support.arubanetworks.com. Before downloading the scripts, you
must read the following disclaimer.

The sample scripts are examples and provided for illustration purposes only. If you plan to use this script in your
environment, ensure that the script meets your IT guidelines. By running this script, you acknowledge that Aruba
Networks, Inc. is in no way liable for any loss, damage, problems arising from running this script.

The following scripts are available for download:

Python 2.7 Script

l ArubaXMLDemo.py: This is a Python 2.7 script. This script demonstrates the basic functionality of the XML
API. Using this script, you can send XML requests to add, delete, authenticate, blacklist, query, or log out a
user.

Bourne Shell Scripts

l xml_user_add.sh: This script adds a user using the user_add command.

l xml_user_del_or_logout.sh: The user_delete part of the script deletes an existing user from the Mobility
Master user table. The user_logout part of the script reverts an existing user to the initial role in the AAA
profile.

l xml_user_query.sh: This script fetches the status and details of a user connected in the network using the
user_query command.

The Bourne Shell scripts work on most Unix, Linux, and Mac operating systems. To run on Windows, you can install
Cygwin.

All scripts require cURL to be installed on the XML API server. cURL is an open source command line tool and library
for transferring data with URL syntax. You can download cURL from http://curl.haxx.se/download.html.

XML API using Python 2.7
The information covered in the following section is based on running the ArubaXMLDemo.py script on a
Windows 8.1 64-bit and Python 2.7.

Understanding Request and Response
Mobility Master processes the XML API request and sends the response to the XML API server. The XML
response contains the status of the request and a code in case of an error.

Request format: <script_name> <Mobility Master-ip> <secret_key> <command> [options]

Understanding XML API Request Parameters
The Table 236 lists all parameters that you can use in a request.

https://support.arubanetworks.com/ToolsResources/tabid/76/DMXModule/514/Default.aspx?EntryId=19024
http://curl.haxx.se/download.html


Parameter Description

script_name The name of the script executable.

Mobility
Master-ip

The IP address of Mobility Master that will receive the XML requests.

secret_key The password used to validate the authentication request from your authentication
server. See Configuring the XML API Server on page 1006 for more information.

Table 236: XML API Request Parameters and Descriptions
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Parameter Description

command The XML API command sent to the Mobility Master. You can send one of the following
commands per request:

l use_add: Creates a new user entry in the Mobility Master user table. If the user
entry is already present in the user table, the command will modify the entry with the
values defined in the XML request. For an existing user, this command will update
any value that is supplied, with an exception of IP and MAC address. Session time-
out is only applicable to captive portal users.

l user_delete: Deletes an existing user from the Mobility Master user table.

NOTE: Do not use the user_delete command if the intention is to clear the association
from the Mobility Master user table. If the client is dual-stack, it re-inherits the
authentication state from the IPv6 address. If not dual-stack, the client reverts to the
initial role.

l user_authenticate: Authenticates against the server group defined in the captive
portal profile. This is only applicable to captive portal users.

l user_blacklist: Blacklists a user from connecting to your network. This command
uses the default blacklist timeout of 3600 seconds. There is no corresponding clear
command. You can use the Mobility Master CLI to clear the blacklisted clients. Refer
the show ap blacklist-clients, stm remove-blacklist-client, and stm purge-
blacklist-clients commands in the ArubaOS CLI Reference Guide to clear the
blacklisted clients.

l user_query: Fetches the status and details of a user connected to your network. A
dual-stack client can be queried by any of its IPv4 or IPv6 addresses, but only the
queried IP address is displayed in the output.

l user_logout: Reverts the user to the initial role. This is only applicable to captive
portal users. For dual-stack clients, all user-table entries will be reverted to the initial
role.

Options l -i <ip_addr>: Specify the IP address of the user in IPv4 or IPv6 format.

l -m <mac_addr>: Specify the MAC address of the user in aa:bb:cc:dd:ee:ff format.

l -n <name>: Specify the name of the user.

l -p <password>: Specify the password of the user for authentication.

l -r role: Specify the role to apply to a newly created user, or change of role for an
existing user. This option applies to user_add and user_delete commands only.

l -t timeout: Specifies the session time-out in seconds. User will be disconnected
after this time.

l -v version: Specifies the version of the XML API interface available in Mobility
Master. This field is mandatory is all requests. Default version is 1.0.

l -a method: Specifies the encryption method to send the secret key. You can specify
MD5 or SHA-1 or cleartext as the encryption method. By default, cleartext method is
used to send the key.

l -s sessid: Specifies the active session ID.

Understanding an XML API Response
The response message from Mobility Master is sent in an XML format. The default format of the response is:
[Message header]

Displays the request parameters and other standard header details.

...

...

...

<response>



<status>Status Message</status>

<code>Code in case of an error</code>

</response>

The following section describes few of the XML API requests and responses from Mobility Master.

Adding a User
This XML request uses the user_add command to create a new user entry in the Mobility Master user table.
C:\Python27>python ArubaXMLDemo.py --switch-ip=192.0.2.1 --secret=aruba123 --command=user_add

--ip=192.0.2.2 --mac=a4:e:60:c3:10:59 --role=logon

The command sends the following information in the XML request to Mobility Master:

l --switch-ip: IP address of Mobility Master

l --secret: Shared secret key (sent as plain text)

l --command: XML API command

l --ip: IP address of the user

l --mac: MAC address of the user

l --role: User role

Mobility Master Response

Mobility Master processes using an XML format and sends the following response to the XML API server.
Warning: The specified mac address *must* match the user specified by --ip or the command will

fail.

Prepared XML buf

---------------------------------

xml=<aruba command="user_add">

<ipaddr>192.0.2.2</ipaddr>

<macaddr>a4:5e:60:c3:10:59</macaddr>

<role>logon</role>

<authentication>cleartext</authentication>

<key>aruba123</key>

<version>1.0</version>

</aruba>

---------------------------------

Sending XML request to https://192.0.2.1/auth/command.xml

Controller response status: 200

Response XML

-----------------------------------

<aruba>

<status>Ok</status>

<code>0</code>

</aruba>

-----------------------------------

Mobility Master CLI

You can view the updated details of the user in the Mobility Master CLI.
(host) [mynode] #show user-table

Users

-----

IP MAC Name Role Age(d:h:m) Auth VPN link AP name

---------- ------------ ------ ---- ---------- ---- -------- -------

192.0.2.2 a4:5e:60:c3:10:59 logon 00:00:00

Roaming Essid/Bssid/Phy Profile Forward mode Type Host Name

--- ---- --------------- ------- ------------ ---- ---------
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User Entries: 1/1

Querying a User
This XML request uses the user_query command to get the status and details of a user connected to your
network.
C:\Python27>python ArubaXMLDemo.py --switch-ip=192.0.2.1 --secret=aruba123 --command=user_

query --ip=192.0.2.2

The command sends the following information in the XML request to Mobility Master:

l --switch-ip: IP address of Mobility Master

l --secret: Shared secret key (sent as plain text)

l --command: XML API command

l --ip: IP address of the user

Mobility Master Response

Mobility Master processes using an XML format and sends the following response to the XML API server.
Prepared XML buf

---------------------------------

xml=<aruba command="user_query">

<ipaddr>192.0.2.2</ipaddr>

<authentication>cleartext</authentication>

<key>aruba123</key>

<version>1.0</version>

</aruba>

---------------------------------

Sending XML request to https://192.0.2.1/auth/command.xml

Controller response status: 200

Response XML

-----------------------------------

<aruba>

<status>Ok</status>

<code>0</code>

<macaddr>a4:5e:60:c3:10:59</macaddr>

<ipaddr>192.0.2.2</ipaddr>

<name>John</name>

<role>authenticated</role>

<type>Wireless</type>

<vlan>1034</vlan>

<location>ap225-sales</location>

<age>00:03:51</age>

<auth_status>Authenticated</auth_status>

<auth_server>clearpass-hq1</auth_server>

<auth_method>802.1X</auth_method>

<essid>ethersphere-wpa2</essid>

<bssid>9c:1c:12:92:2e:f1</bssid>

<phy_type>a-VHT-80</phy_type>

<mobility_state>Wireless</mobility_state>

<in_packets>93400</in_packets>

<in_octets>24947332</in_octets>

<out_packets>89042</out_packets>

<out_octets>79397284</out_octets>

</aruba>

Mobility Master CLI

The output of the show user command displays the client information.



(host) #show user

Users

-----

IP MAC Name Role Age(d:h:m) Auth VPN link

---------- ------------ ------ ---- ---------- ---- --------

192.0.2.2 a4:5e:60:c3:10:59 John authenticate 00:03:51 Authenticated

AP name Roaming Essid/Bssid/Phy Profile Forward mode

------- -------- --------------- ------- ------------

ap225-sales Wireless ethersphere-wpa2/9c:1c:12:92:2e:f1/a-VHT-80

Type Host Name

---- ---------

User Entries: 1/1

Logging Out a User
This XML request uses the user_logout command to revert the user to the initial role. This is only applicable to
captive portal users.
C:\Python27>python ArubaXMLDemo.py --switch-ip=192.0.2.1 --secret=aruba123 --command=user_

logout --ip=192.0.2.2

The command sends the following information in the XML request to Mobility Master:

l --switch-ip: IP address of Mobility Master

l --secret: Shared secret key (sent as plain text)

l --command: XML API command

l --ip: IP address of the user

Mobility Master Response

Mobility Master processes using an XML format and sends the following response to the XML API server.
Prepared XML buf

---------------------------------

xml=<aruba command="user_logout">

<ipaddr>192.0.2.2</ipaddr>

<authentication>cleartext</authentication>

<key>aruba123</key>

<version>1.0</version>

</aruba>

---------------------------------

Sending XML request to https://192.0.2.1/auth/command.xml

Controller response status: 200

Response XML

-----------------------------------

<aruba>

<status>Ok</status>

<code>0</code>

</aruba>

Mobility Master CLI

The output of the show user command displays the client information.
(host) #show user

Users

-----

IP MAC Name Role Age(d:h:m) Auth VPN link

---------- ------------ ------ ---- ---------- ---- --------
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192.0.2.2 a4:5e:60:c3:10:59 John initial 00:00:06 Unauthenticated

AP name Roaming Essid/Bssid/Phy Profile Forward mode

------- -------- --------------- ------- ------------

ap225-sales Wireless ethersphere-wpa2/9c:1c:12:92:2e:f1/a-VHT-80

Type Host Name

---- ---------

User Entries: 1/1
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Chapter 46
Behavior and Defaults

Topics in this chapter include:

l Understanding Mode Support on page 1019

l Understanding Basic System Defaults on page 1021

l Understanding Default Management User Roles on page 1028

l Understanding Default Open Ports on page 1032

Understanding Mode Support
Most ArubaOS features are supported in all forwarding modes. However, there are a some features that are
not supported in one or more forwarding modes. Campus APs do not support split-tunnel forwarding mode
and the decrypt-tunnel forwarding mode does not support TKIP Counter measure management on campus
APs or remote APs.

Table 237 describes the features that are not supported in each forwarding mode.
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Forwarding Mode Feature Not Supported

Split Tunnel Mode on Remote APs VLAN Pooling

Named VLAN

Voice over Mesh

Video over Mesh

Layer-2 Mobility

Layer-3 Mobility

IGMP Proxy Mobility

Mobile IP

TKIP countermeasure mgmt

Bandwidth based CAC

Dynamic Multicast Optimization

Bridge Mode on Campus APs or Remote APs Firewall – SIP/SCCP/RTP/RTSP Voice Support

Firewall – Alcatel NOE Support

Voice over Mesh

Video over Mesh

Named VLAN

Captive portal

Rate Limiting for broadcast/multicast

Power save: Wireless battery boost

Power save: Drop wireless multicast traffic

Power save: Proxy ARP (global)

Power save: Proxy ARP (per-SSID)

Automatic Voice Flow Classification

Bridge Mode on Campus APs or Remote APs
(continued)

SIP ALG

SIP: SIP authentication tracking

SIP: CAC enforcement enhancements

SIP: Phone number awareness

SIP: R-Value computation

SIP: Delay measurement

Management: Voice-specific views

Management: Voice client statistics

Management: Voice client troubleshooting

Voice protocol monitoring/reporting

SVP ALG

Table 237: Features not Supported in Each Forwarding Mode



Forwarding Mode Feature Not Supported

H.323 ALG

Vocera ALG

SCCP ALG

NOE ALG

Layer 3 Mobility

IGMP Proxy Mobility

Mobile IP

TKIP countermeasure mgmt

Bandwidth based CAC

Dynamic Multicast Optimization

Understanding Basic System Defaults
The default administrator user name is admin, and the password should be set up during the initial setup
dialog. The ArubaOS software includes several predefined network services, firewall policies, and roles.

Network Services
The following table lists the predefined network services and their protocols and ports.

Name Protocol Port(s)

svc-dhcp udp 67 68

svc-snmp-trap udp 162

svc-smb-tcp tcp 445

svc-https tcp 443

svc-ike udp 500

svc-l2tp udp 1701

svc-syslog udp 514

svc-pptp tcp 1723

svc-telnet tcp 23

svc-sccp tcp 2000

Table 238: Predefined Network Services

ArubaOS 8.0.0.0 | User Guide Behavior and Defaults |  1021



1022 | Behavior and Defaults ArubaOS 8.0.0.0  | User Guide

Name Protocol Port(s)

svc-tftp udp 69

svc-sip-tcp tcp 5060

svc-kerberos udp 88

svc-pop3 tcp 110

svc-adp udp 8200

svc-noe udp 32512

svc-noe-oxo udp 5000

svc-dns udp 53

svc-msrpc-tcp tcp 135 139

svc-rtsp tcp 554

svc-http tcp 80

svc-vocera udp 5002

svc-nterm tcp 1026 1028

svc-sip-udp udp 5060

svc-papi udp 8211

svc-ftp tcp 21

svc-natt udp 4500

svc-svp 119 0

svc-gre gre 0

svc-smtp tcp 25

svc-smb-udp udp 445

svc-esp esp 0



Name Protocol Port(s)

svc-bootp udp 67 69

svc-snmp udp 161

svc-icmp icmp 0

svc-ntp udp 123

svc-msrpc-udp udp 135 139

svc-ssh tcp 22

svc-h323-tcp tcp 1720

svc-h323-udp udp 1718 1719

svc-http-proxy1 tcp 3128

svc-http-proxy2 tcp 8080

svc-http-proxy3 tcp 8888

svc-sips tcp 5061

svc-v6-dhcp udp 546 547

svc-v6-icmp icmp 0

any any 0

Policies
The following table lists predefined policies.

Predefined Policy Description

ip access-list session allowall

any any any permit
An "allow all" firewall rule that permits all traffic.

ip access-list session control

user any udp 68 deny

  any any svc-icmp permit

  any any svc-dns permit

  any any svc-papi permit

  any any svc-cfgm-tcp permit

  any any svc-adp permit

  any any svc-tftp permit

Controls traffic - Apply to untrusted wired ports in
order to allow Aruba APs to boot up.

NOTE: In most cases wired ports should be made
"trusted" when attached to an internal network.

Table 239: Predefined Policies
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Predefined Policy Description

  any any svc-dhcp permit

  any any svc-natt permit

ip access-list session captiveportal

user alias mswitch svc-https dst-nat 8081

user any svc-http dst-nat 8080

user any svc-https dst-nat 8081

user any svc-http-proxy1 dst-nat 8088

user any svc-proxy2 dst-nat 8088

user any svc-http-proxy3 dst-nat 8088

Enables captive portal authentication.
1. Any HTTPS traffic destined for the managed

device will be NATed to port 8081, where the
captive portal server will answer.

2. All HTTP traffic to any destination will be NATed to
the managed device on port 8080, where an HTTP
redirect will be issued.

3. All HTTPS traffic to any destination will be NATed
to the managed device on port 8081, where an
HTTP redirect will be issued.

4. All HTTP proxy traffic will be NATed to the
managed device on port 8088.

NOTE: In order for captive portal to work properly,
DNS must also be permitted. This is normally done
in the "logon-control" firewall rule.

ip access-list session cplogout

user alias mswitch svc-https dst-nat 8081
Used to enable the captive portal "logout" window. If
the user attempts to connect to the managed device
on the standard HTTPS port (443) the client will be
NATed to port 8081, where the captive portal server
will answer. If this rule is not present, a wireless
client may be able to access the managed device's
administrative interface.

ip access-list session vpnlogon

any any svc-ike permit

any any svc-esp permit

any any svc-l2tp permit

any any svc-pptp permit

any any svc-gre permit

This policy permits VPN sessions to be established to
any destination. IPsec (IKE, ESP, and L2TP) and PPTP
(PPTP and GRE) are supported.

ip access-list session ap-acl

any any udp 5000 5555

any any svc-gre permit

any any svc-syslog permit

any user svc-snmp permit

user any svc-snmp-trap permit

user any svc-ntp permit

This is a policy for internal use and should not be
modified. It permits APs to boot up and
communicate with the managed device.

ip access-list session validuser

any any any permit
This firewall rule controls which users will be added
to the user table of the managed device through
untrusted interfaces. Only IP addresses permitted by
this ACL will be admitted to the system for further
processing. If a client device attempts to use an IP
address that is denied by this rule, the client device
will be ignored by the managed device and given no
network access. You can use this rule to restrict
foreign IP addresses from being added to the user-
table.

This policy should not be applied to any user role, it
is an internal system policy.



Predefined Policy Description

ip access-list session vocera-acl

any any svc-vocera permit queue high
Use for Vocera VoIP devices to automatically permit
and prioritize Vocera traffic.

ip access-list session icmp-acl

any any svc-icmp permit
Permits all ICMP traffic.

ip access-list session sip-acl

any any svc-sip-udp permit queue high

any any svc-sip-tcp permit queue high

Use for SIP VoIP devices to automatically permit and
prioritize all SIP control and data traffic.

ip access-list session https-acl

any any svc-https permit
Permits all HTTPS traffic.

ip access-list session dns-acl

any any svc-dns permit
Permits all DNS traffic.

ip access-list session logon-control

user any udp 68 deny

any any svc-icmp permit

any any svc-dns permit

any any svc-dhcp permit

any any svc-natt permit

The default pre-authentication role that should be
used by all wireless clients. Prohibits the client from
acting as a DHCP server. Permits all ICMP, DNS, and
DHCP. Also permits IPsec NAT-T (UDP 4500).
Remove NAT-T if not needed.

ip access-list session srcnat

user any any src-nat
This policy can be used to source-NAT all traffic.
Because no NAT pool is specified, traffic that
matches this policy will be source NATed to the IP
address of the managed device.

ip access-list session skinny-acl

any any svc-sccp permit queue high
Use for Cisco Skinny VoIP devices to automatically
permit and prioritize VoIP traffic.

ip access-list session tftp-acl

any any svc-tftp permit
Permits all TFTP traffic.

ip access-list session guest This policy is not used.

ip access-list session dhcp-acl

any any svc-dhcp permit
Permits all DHCP traffic. If DHCP is not allowed,
clients will not be able to request or renew IP
addresses.

ip access-list session http-acl

any any svc-http permit
Permits all HTTP traffic.

ip access-list session svp-acl

any any svc-svp permit queue high

user host 224.0.1.116 any permit

Use for Spectralink VoIP devices to automatically
permit and prioritize Spectralink Voice Protocol
(SVP).

ip access-list session noe-acl

any any svc-noe permit queue high
Use for Alcatel NOE VoIP devices to automatically
permit and prioritize NOE traffic.

ip access-list session h323-acl

any any svc-h323-tcp permit queue high

any any svc-h323-udp permit queue high

Use for H.323 VoIP devices to automatically permit
and prioritize H.323 traffic.
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Predefined Policy Description

ipv6 access-list session v6-control

user any udp 68 deny

any any svc-v6-icmp permit

any any svc-v6-dhcp permit

any any svc-dns permit

any any svc-tftp permit

Provides equivalent functionality to the "control"
policy, but for IPv6 clients.

ipv6 access-list session v6-icmp-acl

any any svc-v6-icmp permit
Permits all ICMPv6 traffic.

ipv6 access-list session v6-https-acl

any any svc-https permit
Permits all IPv6 HTTPS traffic.

ipv6 access-list session v6-dhcp-acl

any any svc-v6-dhcp permit
Permits all IPv6 DHCP traffic.

ipv6 access-list session v6-dns-acl

any any svc-dns permit
Permits all IPv6 DNS traffic.

ipv6 access-list session v6-allowall

any any any permit
Permits all IPv6 traffic.

ipv6 access-list session v6-http-acl

any any svc-http permit
Permits all IPv6 HTTP traffic.

ipv6 access-list session v6-tftp-acl

any any svc-tftp permit
Permits all IPv6 TFTP traffic.

ipv6 access-list session v6-logon-control

user any udp 68 deny

any any svc-v6-icmp permit

any any svc-v6-dhcp permit

any any svc-dns permit

Provides equivalent functionality to the "logon-
control" policy, but for IPv6 clients.

Validuser and Logon-control ACLs
Default firewall rules for both the validuser and logon-control ACLs prevent malicious users by blocking self-
assigned IPs.

A client with the correct source address can send traffic to the below networks as a destination IP address. The
default firewall rules deny traffic FROM the reserved addresses.

The following networks can be blocked by the default firewall rules in both the validuser and logon-control
ACLs:

l Network packets where the source address of the network packet is defined as being on a broadcast
network (source address == 255.255.255.255)

l Network packets where the source address of the network packet is defined as being on a multicast
network (source address = 224.0.0.0 – 239.255.255.255)

l Network packets where the source address of the network packet is defined as being a loopback address
(127.0.0.1 through 127.255.255.254)

l Network packets where the source or destination address of the network packet is a link-local address
(169.254.0.0/16)

l Network packets where the source or destination address of the network packet is defined as being an
address “reserved for future use” as specified in RFC 5735 for IPv4; (240.0.0.0/4)



l Network packets where the source or destination address of the network packet is defined as an
“unspecified address”(::/128) or an address “reserved for future definition and use”(addresses other than
2000::/3) as specified in RFC 3513 for IPv6. The IPv6 “an unspecified address”(::/128) is currently being
checked in datapath and the packet is dropped. This is the default behavior and you can view the logs by
enabling firewall enable-per-packet-logging configuration.

Roles
The following table lists predefined roles.

If you upgrade from a previous ArubaOS release, your existing configuration may have additional or different
predefined roles. The information in this section only describes the predefined roles for this release.

Predefined Role Description

user-role ap-role

 session-acl control

 session-acl ap-acl

This is an internal role and should not be edited.

user-role default-vpn-role

 session-acl allowall

 ipv6 session-acl v6-allowall

This is the default role used for VPN-connected clients. It is
referenced in the default "aaa authentication vpn" profile.

user-role voice

 session-acl sip-acl

 session-acl noe-acl

 session-acl svp-acl

 session-acl vocera-acl

 session-acl skinny-acl

 session-acl h323-acl

 session-acl dhcp-acl

 session-acl tftp-acl

 session-acl dns-acl

 session-acl icmp-acl

This role can be applied to voice devices in order to
automatically permit and prioritize all VoIP protocols.

user-role guest

 session-acl http-acl

 session-acl https-acl

 session-acl dhcp-acl

 session-acl icmp-acl

 session-acl dns-acl

 ipv6 session-acl v6-http-acl

 ipv6 session-acl v6-https-acl

 ipv6 session-acl v6-dhcp-acl

 ipv6 session-acl v6-icmp-acl

 ipv6 session-acl v6-dns-acl

This is a default role for guest users. It permits only HTTP,
HTTPS, DHCP, ICMP, and DNS for the guest user. To
increase security, a "deny" rule for internal network
destinations could be added at the beginning.

user-role guest-logon

captive-portal default

session-acl logon-control

session-acl captiveportal

This role is used as the pre-authentication role for guest
SSIDs. It allows control traffic such as DNS, DHCP, and
ICMP, and also enables captive portal.

Table 240: Predefined Roles
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Predefined Role Description

user-role <ssid>-guest-logon

captive-portal default

session-acl logon-control

session-acl captiveportal

This role is only generated when creating a new WLAN
using the WLAN Wizard. The WLAN Wizard creates this
role when captive portal is enabled. This is the initial role
that a guest will be placed in prior to captive portal
authentication. By using a different guest logon role for
each SSID, it is possible to enable multiple captive portal
profiles with different customization.

user-role stateful-dot1x This is an internal role used for Stateful 802.1X. It should
not be edited.

user-role authenticated

 session-acl allowall

 ipv6 session-acl v6-allowall

This is a default role that can be used for authenticated
users. It permits all IPv4 and IPv6 traffic for users who are
part of this role.

user-role logon

session-acl logon-control

session-acl captiveportal

session-acl vpnlogon

 ipv6 session-acl v6-logon-control

This is a system role that is normally applied to a user
prior to authentication. This applies to wired users and
non-802.1X wireless users.

The role allows certain control protocols such as DNS,
DHCP, and ICMP, and also enables captive portal and VPN
termination/pass through. The logon role should be edited
to provide only the required services to a pre-
authenticated user. For example, VPN pass through should
be disabled if it is not needed.

user-role <ssid>-logon

session-acl control

session-acl captiveportal

session-acl vpnlogon

This role is only generated when creating a new WLAN
using the WLAN wizard. The WLAN wizard creates this role
when captive portal is enabled and a PEFNG license is
installed. This is the initial role that a client will be placed in
prior to captive portal authentication. By using a different
logon role for each SSID, it is possible to enable multiple
captive portal profiles with different customization.

user-role <ssid>-captiveportal-profile When utilizing the WLAN Wizard and you do not have a PEF
NG installed and you are configuring an Internal or Guest
WLAN with captive portal enabled, the managed device
creates an implicit user role with the same name as the
captive portal profile, <ssid>-captiveportal-profile.

This implicit user role allows only DNS and DHCP traffic
between the client and network and directs all HTTP or
HTTPS requests to the captive portal. You cannot directly
modify the implicit user role or its rules. Upon
authentication, captive portal clients are allowed full
access to their assigned VLAN. Once the WLAN
configuration is pushed to the managed device, the WLAN
wizard will associate the new role with the initial user role
that you specify in the AAA profile. This role will not be
visible to the user in the WLAN wizard.

Understanding Default Management User Roles
The ArubaOS software includes predefined management user roles.

If you upgrade from a previous ArubaOS release, your existing configuration may have different management roles.
The information in this section only describes the predefined management roles for this release.



Predefined Role Permissions

ap-provisioning This role permits access only to AP provisioning commands and no access to
other configuration commands on the Mobility Master.

guest-provisioning This role permits access to configuring guest users in the managed device’s
internal database only. This user only has access via the WebUI to create guest
accounts; there is no CLI access.

Guest-provisioning tasks include creating or generating the user name and
password for a guest account as well as configuring when the account expires.

location-api-mgmt This role permits access to location API information and the CLI; however, you
cannot use any CLI commands. This role does not permit access to the WebUI.

Using a third-party location appliance, you can gather information about the
location of 802.11 stations.

To log in to the managed device using a third-party location appliance, enter:

http[s]://<ipaddress>[:port]/screens/wms/wms.login.

You are prompted to enter your username and password (for example, the
username and password associated with the location API management role).
Once authenticated, you can use an API call to request location information from
the managed device, for example:

http[s]://<ipaddress>[:port]/screens/wms/wms.cgi?opcode=wlm-get-
spot&campus-name=<campus id>&building-name<building
id>&mac=<client1>,<client2>....

nbapi-mgmt This role permits configuring a NBAPI management role.

network-operations Monitoring > Network > All Access PointsMonitoring
> Network > All Wired Access Points

You can view the reports created by the following CLI commands:

l DB:opcode=monitor-summary

l DB:opcode=cr-load

l DB:opcode=wlm-search&class=probes&start

l DB:opcode=wlm-search&class=amii

l DB:opcode=monitor-get-all-gps&status=any

l show ap-group

l show vlan status

Monitoring > Controller > Controller Summary

You can view the reports created by the following CLI commands:

l show switches

l show switches summary

Monitoring > Controller > Air Monitors

Table 241: Predefined Management Roles
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Predefined Role Permissions

You can view the reports created by the following CLI commands:

l show wlan-ap start*

Monitoring > Controller > Clients

You can view the reports created by the following CLI commands:

l show ip mobile host

l show ip mobile trail {<ipaddr> | <macaddr>}

l <span class="CLI">show ap essid</span>

l show esi servers

l show esi ping

l show esi parser stats

l show private port status*

l show vlan

l show port stats

l show spanning-tree interface fastethernet <slot/module/port>

l show interface fastethernet <slot/module/port> counters

l clear counters fastethernet <slot/module/port>

l show snmp trap-queue <page>

Monitoring > Controller > Clients > Packet CaptureMonitoring
>Controller > Clients > LocateMonitoring
> Controller > Clients > Debug

You can view the reports created by the following CLI commands:

l aaa user debug mac

Monitoring > Controller> Clients > Disconnect

You can view the reports created by the following CLI commands:

l stm kick-off-sta <macaddr>

l aaa user logout <ipaddr>

network-operations
(continued)

Monitoring > Controller> Clients > Blacklist

You can view the reports created by the following CLI commands:

l stm add-blacklist-client <macaddr>

l aaa user delete {<ipaddr> | all | mac <macaddr> | name

<username> | role <role>}

Monitoring > Controller > Blacklist Clients

You can view the reports created by the following CLI commands:

l stm remove-blacklist-client <macaddr>

Monitoring > Controller > External Services Interface



Predefined Role Permissions

You can view the reports created by the following CLI commands:

l show esi groups

l show esi servers

l show esi ping

l show esi parser stats

Monitoring > Controller > Ports

You can view the reports created by the following CLI commands:

l show model-switch-internal*

l show slots

l show private port status*

l show vlan

Monitoring > Controller> Inventory

You can view the reports created by executing the following command:

l show keys

Monitoring > WLAN

You can view the reports created by the following CLI commands:

l DB:opcode=get-permissions

l DB:opcode=cr-load

l show switches

l show switches summary

Monitoring > Voice

You can view the reports created by the following CLI commands:

l show ap association voip-only

l show ap active voip-only

l show voice call-counters

l show voice client status

l show voice call-quality

l show voice call-density

l show voice call-cdrs

l show voice call-perf

root This role permits access to all management functions (commands and
operations) on the managed device.

read-only This role permits access to CLI show commands or WebUI monitoring pages
only.
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Understanding Default Open Ports
By default, Aruba managed devices and access points treat ports as untrusted. However, certain ports are
open by default only on the trusted side of the network. These open ports are listed in Table 242.

Port Number Protocol Where Used Description

17 TCP managed device This is used for certain
types of VPN clients
that accept a banner
(QOTD). During
normal operation, this
port will only accept a
connection and
immediately close it.

21 TCP managed device

22 TCP managed device SSH

23 TCP AP and managed
device

Telnet is disabled by
default but the port is
still open.

53 UDP managed device Internal domain.

67 UDP AP (and
managed device
if DHCP server is
configured)

DHCP server.

68 UDP AP (and
managed device
if DHCP server is
configured)

DHCP client.

69 UDP managed device TFTP

80 TCP AP and managed
device

Used for remote
packet capture where
the capture is saved
on the access point.
Provides access to the
WebUI on the
managed device.

123 UDP managed device NTP

161 UDP AP and managed
device

SNMP. Disabled by
default.

Table 242: Default (Trusted) Open Ports



Port Number Protocol Where Used Description

443 TCP managed device Used internally for
captive portal
authentication
(HTTPS) and is
exposed to wireless
users. A default self-
signed certificate is
installed in the
managed device.
Users in a production
environment are
urged to install a
certificate from a well
known CA such as
Verisign. Self-signed
certs are open to
man-in-the-middle
attacks and should
only be used for
testing.

Required for VIA:
During the initializing
phase, VIA uses
HTTPS connections to
perform trusted
network and captive
portal checks against
the managed device. It
is mandatory that you
enable port 443 on
your network to allow
VIA to perform these
checks.

500 UDP managed device ISAKMP

514 UDP managed device Syslog

1701 UDP managed device L2TP

1723 TCP managed device PPTP

2300 TCP managed device Internal terminal
server opened by
telnet soe

command.

3306 TCP managed device Remote wired MAC
lookup.
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Port Number Protocol Where Used Description

4343, 443 TCP managed device HTTPS. Both port 4343
and 443 are
supported. If port
4343 is used it
redirects to port 443.
If port 443 is used it
continues to connect
using this port. A
default self-signed
certificate is installed
in the managed
device. Users in a
production
environment are
urged to install a
certificate from a well
known CA such as
Verisign. Self-signed
certs are open to
man-in-the-middle
attacks and should
only be used for
testing.

4500 UDP managed device sae-urn

Required for VIA:
During the initializing
phase, VIA uses
HTTPS connections to
perform trusted
network and captive
portal checks against
the managed device. It
is mandatory that you
enable port 4500 on
your network to allow
VIA to perform these
checks.

8080 TCP managed device Used internally for
captive portal
authentication (HTTP-
proxy). This port is not
exposed to wireless
users.



Port Number Protocol Where Used Description

8081 TCP managed device Used internally for
captive portal
authentication
(HTTPS). Not exposed
to wireless users. A
default self-signed
certificate is installed
in the managed
device. Users in a
production
environment are
urged to install a
certificate from a well
known CA such as
Verisign. Self-signed
certs are open to
man-in-the-middle
attacks and should
only be used for
testing.

8082 TCP managed device Used internally for
single sign-on
authentication (HTTP).
Not exposed to
wireless users.

8083 TCP managed device Used internally for
single sign-on
authentication
(HTTPS). Not exposed
to wireless users.

8088 TCP managed device For internal use.

8200 UDP managed device The Aruba Discovery
Protocol (ADP)

8211 UDP managed device For internal use.

8888 TCP managed device Used for HTTP access.
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Chapter 47
DHCP with Vendor-Specific Options

This chapter describes how to configure several DHCP vendor-specific options.

Topics in this chapter include:

l Configuring a Windows-Based DHCP Server on page 1036

l Enabling DHCP Relay Agent Information Option (Option 82) on page 1037

l Enabling Linux DHCP Servers on page 1038

Configuring a Windows-Based DHCP Server
Configuring a Microsoft Windows-based DHCP server to send option 43 to the DHCP client on an Aruba AP
consists of the following two tasks:

l Configuring Option 60

l Configuring Option 43

DHCP servers are a popular way of configuring clients with basic networking information such as an IP address,
a default gateway, network mask, DNS server, and so on. Most DHCP servers have the ability to also send a
variety of optional information, including the Vendor-Specific Option Code, also called option 43.

When a client or an AP requests for option 43 (Vendor Specific Information), the managed device responds
with the value configured by administrator in the DHCP pool.

Configuring Option 60
This section describes how to configure the Vendor Class Identifier Code (option 60) on a Microsoft Windows-
based-DHCP server.

Option 60 identifies and associates a DHCP client with a particular vendor. Any DHCP server configured to take
action based on a client’s vendor ID should also have this option configured.

Since option 60 is not a predefined option on a Windows DHCP server, you must add it to the option list for
the server.

Configuring Option 60 using the Windows DHCP Server
1. On the DHCP server, open the DHCP server administration tool by clicking Start > AdministrativeTools >

DHCP.

2. Find your server and right-click on the scope to be configured under the server name. Select Set
Predefined Options.

3. In the Predefined Options and Values dialog box, click Add.
4. In the Option Type dialog box, enter the following information:
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Field Information

Name Aruba access point

Data Type String

Code 60

Description Aruba AP vendor class
identifier

Table 243: Configuring Option 60 Using Windows DHCP Server

5. Click OK to save this information.

6. In the Predefined Options and Values dialog box, ensure 060 Aruba Access Point is selected from the
Option Name drop-down list.

7. In the Value field, enter the following information:

String: ArubaAP

8. Click OK to save this information.

9. Under server, select the scope you want to configure and expand it. Select Scope Options, then select
Configure Options.

10.In the Scope Options dialog box, scroll down and select 060 Aruba Access Point. Confirm the value is set
to ArubaAP and click OK.

Confirm that the option 060 Aruba Access Point is listed in the right pane.

Configuring Option 43
Configuring Option 43 returns the IP address of the Aruba Mobility Master to an Aruba DHCP client. This
information allows Aruba APs to auto-discover the Mobility Master and obtain their configuration.

Configuring Option 43 Using the Windows DHCP Server:
1. On the DHCP server, navigate to Start > Administration Tools > DHCP to open the DHCP server

administration tool.

2. Find your server and right-click on the scope to be configured under the server name. Click on the Scope
Options entry and select Configure Options.

3. In the Scope Options dialog box, scroll down and select 043 Vendor Specific Info.

4. In the Data Entry field, click anywhere in the area under the ASCII heading and enter ASCII : Loopback
address of the Mobility Master.

5. Click OK to save the configuration.

Option 43 is configured for this DHCP scope. Though you entered the IP address in ASCII text, the IP address is
displayed in binary form.

Enabling DHCP Relay Agent Information Option (Option 82)
The DHCP Relay Agent Information option (Option 82) allows the DHCP Relay Agent to insert circuit-specific
information into a request that is being forwarded to a DHCP server.



The managed device, when acting as a DHCP relay agent, inserts information about the AP and SSID through
which a client is connecting into the DHCP request. Many service providers use this mechanism to make access
control decisions.

Configuring Option 82
You can configure Option 82 using the WebUI or the CLI. You can include:

l AP name or AP name and ESSID.

l MAC address or MAC address and ESSID.

In the WebUI
1. In the Managed Network node hierarchy, navigate to Configuration > Interfaces > VLANs.

2. Select the VLAN ID for which you want to configure Option 82. The VLANs table is displayed.

3. From the VLANs > table select the VLAN ID again.

4. Select IPv4 from the table that is displayed.

5. Select IP Address Assignment.

6. Select AP Name Essid, Mac, or Mac Essid from the Option-82 drop-down list.

7. Click Submit.

8. Click Pending Changes.

9. In the Pending Changes window, select the check box and click Deploy changes.

In the CLI
Use the interface vlan option-82 option to enable Option 82 for a VLAN using ESSID. You can include:

l AP name or AP name and ESSID.

l MAC address or MAC address and ESSID.

Enabling Linux DHCP Servers
The following is an example configuration for the Linux dhcpd.conf file. After you enter the configuration, you
must restart the DHCP service.
option serverip code 43 = ip-address;

class "vendor-class" { 

      match option vendor-class-identifier;

}

.

.

.

subnet 10.200.10.0 netmask 255.255.255.0 { 

   default-lease-time 200;

   max-lease-time 200;

   option subnet-mask 255.255.255.0;

   option routers 10.200.10.1;

   option domain-name-servers 10.4.0.12;

   option domain-name "vlan10.aa.mycorpnetworks.com";

   subclass "vendor-class" "ArubaAP" { 

      option vendor-class-identifier "ArubaAP";

#

# option serverip <loopback-IP-address-of-master-controller>

#

      option serverip 10.200.10.10;

   }

   range 10.200.10.200 10.200.10.252;
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Chapter 48
802.1X Configuration for IAS and Windows Clients

This chapter provides examples of how to configure a Microsoft Internet Authentication Server, and a Windows
XP wireless client for 802.1X authentication with the Mobility Master. For more information on 802.1X
Authentication, see 802.1X Authentication on page 233.

For more information about configuring computers in a Windows environment for PEAP-MS-CHAPv2 and EAP-
TLS authentication, see the Microsoft document Step-by-Step Guide for Setting Up Secure Wireless Access in a
Test Lab, available from Microsoft’s Download Center at www.microsoft.com/downloads. Additional
information on client configuration is available at
http://www.microsoft.com/technet/prodtechnol/winxppro/maintain/wificomp.mspx#EQGAC.

This chapter describes the following topics:

l Configuring Microsoft IAS on page 1040

l Configuring Management Authentication Using IAS on page 1042

l Window XP Wireless Client Sample Configuration on page 1044

Configuring Microsoft IAS
Microsoft Internet Authentication Server (IAS) provides authentication functions for wireless networks. IAS
implements the RADIUS protocol, which is used between the Aruba Mobility Master and the server. IAS uses
Active Directory as the database for looking up computers, users, passwords, and group information.

RADIUS Client Configuration
Each device in the network that needs to authenticate to a RADIUS server must be configured as a RADIUS
client. You must configure the Aruba Mobility Master as a RADIUS client.

The steps to perform this task may very depending on the version of Windows currently running on your server. For
complete details on configuring Windows IAS, refer to the Windows documentation available at
www.microsoft.com/downloads.

To configure a RADIUS client:

1. From your Windows server, navigate to Start > Settings > Control Panel > Administrative Tools >
Internet Authentication Service.

2. In the Internet Authentication Service window, select RADIUS Clients.

3. To configure a RADIUS client, select Action > New RADIUS Client from the menu at the top of the
window.

4. In the New RADIUS Client dialog window, enter the name and IP address for the Mobility Master. Click
Next.

5. Enter and confirm a shared secret.

The shared secret is configured on both the RADIUS server and client, and ensures that an unauthorized
client cannot perform authentication against the server.

6. Click Finish.

http://www.microsoft.com/downloads
http://www.microsoft.com/downloads
http://www.microsoft.com/downloads
http://www.microsoft.com/downloads
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Remote Access Policies
The IAS policy configuration defines all policies related to wireless access, including time of day restrictions,
session length, authentication type, and group-related policies. See Microsoft product documentation for
detailed descriptions and explanations of IAS policy settings.

Active Directory Database
The Active Directory database serves as the master authentication database for both the wired and wireless
networks. The IAS authentication server bases all authentication decisions on information in the Active
Directory database. IAS is normally used as an authentication server for remote access and thus looks to the
Active Directory “Remote Access” property to determine whether authentication requests should be allowed or
denied. This property is set on a per-user or per-computer basis. For a user or computer to be allowed access to
the wireless network, the remote access property must be set to “Allow access”.

The authentication policy configured in IAS depends on the group membership of the computer or user in the
Active Directory. These policies are responsible for passing group information back to the Mobility Master for
use in assigning computers or users to the correct role, which determines their network access privileges. When
the IAS server receives a request for authentication, it compares the request with the list of remote access
policies. The first policy to match the request is executed; additional policies are not searched.

Configuring Policies
The policies in this 802.1X authentication example are designed to work by examining the username portion of
the authentication request, searching the Active Directory database for a matching name, and then examining
the group membership for a computer or user entry that matches. For example, the following policies would
operate with the Mobility Master configuration shown in Configuring Authentication with an 802.1X RADIUS
Server on page 246:

l The Wireless-Computers policy matches the "Domain Computers" group. This group contains the list of all
computers that are members of the domain. This group is used for all computers to authenticate to the
network.

l The Wireless-Student policy matches the “Student” group. This group is used for all student users.

l The Wireless-Faculty policy matches the “Faculty” group. This group is used for all faculty users.

l The Wireless-Sysadmin policy matches the “Sysadmin” group. This group is used for system administrators.

In addition to matching the respective group, the policy also specifies that the request must be from an 802.11
wireless device. The policy instructs IAS to grant remote access permission if all the conditions specified in the
policy match, a valid username/password is supplied, the user’s or computer’s remote access permission is set
to “Allow”.

To configure a policy:

1. In the Internet Authentication Service window, select Remote Access Policies.

2. Navigate to Action > New Remote Access Policy to add a new policy.

3. Click Next on the initial wizard window to proceed.

4. Enter a name for the policy, for example, “Wireless Computers” and click Next.

5. In the Access Method window, select the Wireless option, then click Next.

6. In the User or Group Access window, select Group and click Add to add the group of users to which this
policy applies (for example, “Domain Computers”). Click Next.

7. For Authentication Methods, select either Protected EAP (PEAP) or Smart Card or Other Certificate.

8. Click Configure to select additional properties.

9. Select a server certificate.



The list of available certificates is taken from the computer certificate store on which IAS is running. In this
case, a self-signed certificate was generated by the local certificate authority and installed on the IAS system.
On each wireless client device, the local certificate authority is added as a trusted certificate authority, thus
allowing this certificate to be trusted.

10.For PEAP, select the inner authentication method.

The authentication method shown is MS-CHAPv2. This should be the only EAP authentication type that
should be selected as password authentication is being used on this network.

You can also enable fast reconnect in this screen. If you enable fast reconnect here and also on client
devices, additional time can be saved when multiple authentications take place (such as when clients are
roaming between APs frequently) because the server will keep the PEAP encrypted tunnel alive.

11.Click OK.

Configuring RADIUS Attributes
In the configuration example for 802.1X, the Mobility Master restricts network access privileges based on the
group membership of the computer or user. In order for this to work, the Mobility Master must be told to
which group the user belongs. This is accomplished using RADIUS attributes returned by the authentication
server.

To configure RADIUS attributes:

1. In the Internet Authentication Service window, select Remote Access Policies.

1. Open the remote access policy you want to configure, and select the Advanced tab.

2. Click Add to configure an attribute.

3. Select the Class attribute.

4. Enter the value for this attribute. For example, for the Wireless-Computers policy, the Class attribute
returned to the Mobility Master should contain the value “computer”.

5. Click OK.

Another example of a Class attribute configuration is shown below for the “Wireless-Student” policy. This
policy returns the RADIUS attribute Class with the value “student” after successful completion.

Configuring Management Authentication Using IAS
Before you can configure the Mobility Master for management authentication using Windows IAS, you must
perform the following steps to configure a Windows IAS RADIUS server on your Windows client.

The steps to perform this task may very depending on the version of Windows currently running on your server. For
complete details on configuring Windows IAS, refer to the Windows documentation available at
www.microsoft.com/downloads.

1. From your Windows server, navigate to Start > Settings > Control Panel > Administrative Tools >
Internet Authentication Service. The Internet Authentication Service window is displayed.

2. Verify if IAS is running.

If IAS is running, a green arrow icon is displayed at the top of this window. If it has stopped, a red stop icon
will appear. If the service is not active, click the green arrow icon to restart the service.

3. From the Internet Authentication Service window, right click the Radius Clients folder and select New
Radius Client. The New RADIUS Client window is displayed.

4. Enter a name for the RADIUS client and enter the Mobility Master’s IP address or DNS name. Click Next.

5. Enter and confirm the shared secret key for the Mobility Master. Click Finish.
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Creating a Remote Policy
1. From the Internet Authentication Service window, right click the Remote Access Policies folder and

select New Remote Access Policy.

2. The New Remote Access Policy wizard is displayed. Click Next on the first window to start the wizard.

3. Select Use the wizard to set up a typical Policy for a common scenario and enter a name for the
policy. Click Next.

4. In the Access Method window of the wizard, select the method you will use to gain management access to
the network. Click Next.

5. In the User or Group Access window of the wizard, select either user or group, depending upon how
your user permissions are defined. Click Next.

6. In the Authentication Method window, click the Type drop-down list and select Protected EAP (PEAP).
Click Next.

7. Click Finish.

Defining Properties for Remote Policy
1. In the Internet Authentication Service window, click the Remote Access Policy icon. All configured

remote access policies are displayed in the right window pane.

2. Right-click the policy you just created, and select Properties. The Properties window is displayed.

3. Select the Grant remote access permission option, and click Edit Profile. The Edit Profile window is
displayed.

4. Click the Authentication tab and select the authentication methods that include MS-CHAP, MS-CHAP V2,
and PAP.

5. Click Apply.

6. Click the Advanced tab.

7. Click Add. The Add Attribute window is displayed.

8. Scroll down the list of attributes and select Vendor-Specific, then click Add. The MultiValued Attribute
Information window is displayed.

9. Click Add.

10.Enter the vendor code 14823 and select the option Yes, it conforms.

11.Click Configure Attribute. The Configure VSA window is displayed.

12.In the Vendor-assigned attribute number field, enter 3.

13.In the Attribute value field, enter 7.

14.Click OK to save the settings.

15.Click Apply.

16.Click Apply.

Now that you have defined your remote policy properties, you must create a user entry in the Windows active
directory. The steps to complete this process will vary, depending on the version of Windows currently running
on your server. The procedure below should be used only as a guideline.

Creating a User Entry in Windows Active Directory
1. Open the Active Directory Users and Computers tool on your Windows server.

2. Create a new user entry on the Windows Active directory.

3. Once you have created the new user, right-click the user name and select Properties.

4. Click the Dial-in tab and select “Allow access” for the user.



5. Click Ok to save your settings.

Configure the Mobility Master to Use IAS Management Authentication
The following procedure describes the steps to configure the Mobility Master to user IAS management
authentication.

1. In the Mobility Master node hierarchy, navigate to Configuration > Authentication > Auth Servers.

2. Click + in All Servers table. The New Server dialog box is displayed.

3. Enter a value for following:

a. Name

b. IP address

c. From the Type drop-down list, select Radius.

4. Click Submit.

5. Select the Radius server that you created.

6. Enter and then retype the shared key for the server. (The UI is already populated with a shared key, does
the user have to enter a new one).

7. Click Apply.

8. Click + in Server Groups table. The Add Server Group dialog box is displayed.

9. Enter a name for the server group.

10.Click Submit.

11.Select the server group that you created.

12.Click + in Server table. A dialog box is displayed that prompts you to select a Radius server.

13.Ensure that the Add existing server option is selected.

14.Select the Radius server you created. Click Submit.
15.Click Pending Changes.

16.In the Pending Changes window, select the check box and click Deploy changes.

Verify Communication Between the Mobility Master and RADIUS Server
After you have configured your Windows Server and the Mobility Master for Windows IAS Management
Authentication, you can verify that the Mobility Master and server are communicating.

1. In the Mobility Master node hierarchy, navigate to Diagnostics > Tools > AAA Server Test.

2. Click the Server Name drop-down list and select the RADIUS server.

3. Select either MSCHAP-V2 or PAP as the authentication method.

4. Enter the user name and password in the Username and Password fields.

5. Click Begin Test.

If the Mobility Master displays Authentication Successful, then the Mobility Master is able to
communicate with the RADIUS server.

Window XP Wireless Client Sample Configuration
This section shows an example of how to configure a Windows XP wireless client using Windows XP’s Wireless
Zero Configuration service.

The following steps apply to a computer running Windows XP Professional Version 2002 with Service Pack 2. To
configure a wireless client on other Windows platforms, see your Microsoft Windows documentation.
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1. On the desktop, right-click My Network Places and select Properties.

2. In the Network Connections window, right-click on Wireless Network Connection and select
Properties.

3. Select the Wireless Networks tab. This screen displays the available wireless networks and the list of
preferred networks. Windows connects to the preferred networks in the order in which they appear in the
list.

4. Click the Advanced button to display the Networks to access window.

This window determines what types of wireless networks the client can access. By default, Windows
connects to any type of wireless network. Make sure that the option Computer-to-computer (ad hoc)
networks only is not selected. Click Close.

5. In the Wireless Networks tab, click Add to add a wireless network.

6. Click the Association tab to enter the network properties for the SSID.

This tab configures the authentication and encryption used between the wireless client and the Aruba user-centric
network. Therefore, the settings for the SSID that you configure on the client must match the configuration for the
SSID on the Mobility Master.

l For an SSID using dynamic WEP, enter the following:

n Network Authentication: Open

n Data Encryption: WEP

n Select the option “The key is provided for me automatically”. Each client will use a dynamically-
generated WEP key that is automatically derived during the 802.1X process.

l For an SSID using WPA, enter the following:

n Network Authentication: WPA

n Data Encryption: TKIP

l For an SSID using WPA-PSK, enter the following:

n Network Authentication: WPA-PSK

n Data Encryption: TKIP

n Enter the pre-shared key.

l For an SSID using WPA2, enter the following:

n Network Authentication: WPA2

n Data Encryption: AES

l For an SSID using WPA2-PSK, enter the following:

n Network Authentication: WPA2-PSK

n Data Encryption: AES

n Enter the pre-shared key

Do not select the option “This is a computer-to-computer (ad hoc) network; wireless access points are not used”.

7. Click the Authentication tab to enter the 802.1X authentication parameters for the SSID. This tab
configures the EAP type used between the wireless client and the authentication server.

l Select Enable IEEE 802.1X authentication for this network.

l Select Protected EAP (PEAP) for the EAP type.



l Select Authenticate as computer when computer information is available. The client will perform
computer authentication when a user is not logged in.

l Do not select Authenticate as guest when user or computer information is unavailable. The client will not
attempt to authenticate as a guest.

l Select Validate server certificate. This instructs the client to check the validity of the server certificate
from an expiration, identity, and trust perspective.

l Select the trusted Certification Authority (CA) that can issue server certificates for the network.

l Select Secured password (EAP-MSCHAP v2) — the PEAP “inner authentication” mechanism will be an MS-
CHAPv2 password.

l Select Enable Fast Reconnect to speed up authentication in some cases.

8. Under Select Authentication Method, click Configure to display the EAP-MSCHAPv2 Properties
window. Select the option Automatically use my Windows logon name and password (and domain if any).
This option specifies that the user’s Windows logon information is used for authentication to the wireless
network. This option allows the same logon credentials to be used for access to the Windows domain as well
as the wireless network.
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Acronyms and Terms

Acronyms
The following table lists the acronyms and their definitions used in this guide.

Acronym Definition

ABR area border router

AC access category

ACI adjacent channel interference

ACL access control list

ADP Aruba Discovery Protocol (ADP)

AES advanced encryption standard

AIFSN arbitrary inter-frame space number

ALG application level gateway

AM air monitor

AP access point

APM AP air monitor

ARM adaptive radio management

AVF AntiVirus Firewall

A-MSDU aggregate MAC service data unit

BCMC broadcast and multicast

BRAS broadband remote access server

BRE basic regular expression

BPDU bridge protocol data unit

Table 244: List of acronyms
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Acronym Definition

BSSID basic service set identifier

CA certification authority

CAC call admission control

CAP campus AP

CCA clear channel assessment

CDP Cisco Discovery Protocol

CDR call detail records

CHAP Challenge Handshake Authentication Protocol

CRL certificate revocation list

CSA channel switch announcement

CSMA/CA carrier sense multiple access with collision avoidance

CSR certificate signing request

CSS content security service

CTS clear to send

CW contention window

DAS distributed antenna systems

DCF distributed coordination function

DES data encryption standard

DHCP Dynamic Host Configuration Protocol

DS differentiated services

DSCP differentiated services codepoint

DSSS direct sequence spread spectrum



Acronym Definition

DNS domain name system

DoS denial of service

DPD dead peer detection

DR designated router

DU data unit

DMO dynamic multicast optimization

EAP Extensible Authentication Protocol

EAP-TLS EAP-transport layer security

EDCA enhanced distributed channel access

EIRP effective isotropic radiated power

ESI external service interfaces

ESS extended service set

ESSID extended service set identifier

FE fast ethernet

FFT fast fourier transform

FHSS frequency-hopping spread spectrum

FIB forwarding information base

FRER frame receive error rate

FRR frame retry rate

FSPL free space path loss

FTP File Transfer Protocol

FQLN fully qualified location name
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Acronym Definition

GRE generic routing encapsulation

GIS generic interface specification

GMT Greenwich Mean Time

GPP guest provisioning page

HMD high mobility device

HSPA high-speed packet access

HT high throughput

IAS internet authentication server

IDS intrusion detection system

IE information element

IEEE Institute of Electrical and Electronics Engineer

IGMP Internet Group Management Protocol

IGP Interior Gateway Routing Protocol

IKE PSK internet key exchange pre-shared key

ISAKMP Internet Security Association and Key Management Protocol

LACP Link Aggregation Control Protocol

LAG link aggregation group

LD local debug

LDAP Lightweight Directory Access Protocol

LEAP Lightweight Extensible Authentication Protocol

LI listening interval

L2TP Layer-2 Tunneling Protocol



Acronym Definition

MAC media access control

MCS modulation and coding scheme

MDPU MAC protocol data unit

MIB management information base

MIMO multiple input, multiple output

MMS mobility management system

MP mesh point

MPP mesh portal

MPV mesh private VLAN

MSCHAP Microsoft Challenge Handshake Authentication Protocol

MSCHAPv2 MSCHAP version 2

MSSID mesh service set identifier

MPPE Microsoft point-to-point encryption

MTU maximum transmission unit

NAS network access server

NAT network address translation

NIC network interface card

NOE new office environment

NTP Network Time Protocol

OCSP Online Certificate Status Protocol

OFDM orthogonal frequency division multiplexing

OKC opportunistic key caching
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Acronym Definition

OSPF open shortest path first

OUI organizationally unique identifier

PAC protected access credential

PAP Password Authentication Protocol

PAPI proprietary access protocol interface

PFS perfect forward secrecy

PHB per hop behavior

PIN personal identification number

PKI public key infrastructure

PMK pairwise master key

PoE power over ethernet

PSK pre-shared key

PPPoE point-to-point protocol over ethernet

PPTP Point-to-Point Tunneling Protocol

PVST per VLAN spanning tree

QoS quality of service

RADIUS remote authentication dial-in user service

RAP remote AP

REGEX region with the regular expression

RF radio frequency

RFID radio frequency identification

RoW rest of world



Acronym Definition

RSSI received signal strength indication

RSTP Rapid Spanning Tree Protocol

RTLS real-time locating systems

RTS request to send

SA security association

SDR software-defined radio

SIM subscriber identity module

SIP Session Initiation Protocol

SNIR signal-to-noise-and-interference ratio

SNMP Simple Network Management Protocol

SSID service set identifier

STP Spanning Tree Protocol

STRAP secure thin remote access point

SVP spectralink voice priority

TFTP Trivial File Transfer Protocol

TIM traffic indication map

TLS transport layer security

TOS type of service

TPM trusted platform module

TSPEC traffic specification

TXOP opportunity to transmit

UDP User Datagram Protocol
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UTMS universal mobile telecommunication systems

U-APSD unscheduled automatic power save delivery

VBA virtual branch networking

VIA virtual intranet access

VoFI voice over Wi-Fi

VoIP voice over IP

VPN virtual private network

VRD validated reference design

VRRP Virtual Router Redundancy Protocol

VSA vendor specific attributes

VTP Virtual Trunking Protocol

WIDS wireless intrusion detection system

WINS windows internet naming service

WIPS wireless intrusion prevention system

WISPr wireless internet service provider roaming

WLAN wireless local area network

WMM wireless multimedia

WMS WLAN management system

WSIRT wireless security incident response team

WZC wireless zero config

XAuth extended authentication

Terms
The following table lists the terms and their definitions used in this guide.



Term Definition

802.11 An evolving family of specifications for wireless LANs developed by a
working group of the Institute of Electrical and Electronics Engineers
(IEEE). 802.11 standards use the Ethernet protocol and CSMA/CA
(carrier sense multiple access with collision avoidance) for path
sharing.

802.11a Provides specifications for wireless systems. Networks using 802.11a
operate at radio frequencies in the 5GHz band. The specification uses
a modulation scheme known as orthogonal frequency-division
multiplexing (OFDM) that is especially well suited to use in office
settings.

802.11b WLAN standard often called Wi-Fi; backward compatible with 802.11.
Instead of the phase-shift keying (PSK) modulation method historically
used in 802.11 standards, 802.11b uses complementary code keying
(CCK), which allows higher data speeds and is less susceptible to
multipath-propagation interference.

802.11d A wireless network communications specification for use in countries
where systems using other standards in the 802.11 family are not
allowed to operate. Configuration can be fine-tuned at the Media
Access Control layer (MAC layer) level to comply with the rules of the
country or district in which the network is to be used. Rules subject to
variation include allowed frequencies, allowed power levels, and
allowed signal bandwidth. 802.11d facilitates global roaming.

802.11e A proposed adaptation to the 802.11a and 802.11b specifications that
enhances the 802.11 Media Access Control layer (MAC layer) with a
coordinated time division multiple access (TDMA) construct, and adds
error-correcting mechanisms for delay-sensitive applications such as
voice and video. The 802.11e specification provides seamless
interoperability between business, home, and public environments
such as airports and hotels and offers all subscribers high-speed
Internet access with full-motion video, high-fidelity audio, and Voice
over IP (VoIP).

802.11g Offers transmission over relatively short distances at up to 54
megabits per second (Mbps), compared with the 11 Mbps theoretical
maximum of 802.11b. 802.11g employs orthogonal frequency division
multiplexing (OFDM), the modulation scheme used in 802.11a, to
obtain higher data speed. Computers or terminals set up for 802.11g
can fall back to speeds of 11 Mbps, so that 802.11b and 802.11g
devices can be compatible within a single network.

802.11h Intended to resolve interference issues introduced by the use of
802.11a in some locations, particularly with military radar systems and
medical devices. Dynamic frequency selection (DFS) detects the
presence of other devices on a channel and automatically switches the
network to another channel if and when such signals are detected.
Transmit power control (TPC) reduces the radio-frequency (RF) output
power of each network transmitter to a level that minimizes the risk of
interference.

Table 245: List of terms

ArubaOS 8.0.0.0 | User Guide Acronyms and Terms |  1055



1056 | Acronyms and Terms ArubaOS 8.0.0.0  | User Guide

Term Definition

802.11i Provides improved encryption for networks that use 802.11a, 802.11b,
and 802.11g standards. Requires new encryption key protocols, known
as Temporal Key Integrity Protocol (TKIP) and Advanced Encryption
Standard (AES). Other features include key caching, which facilitates
fast reconnection to the server for users who have temporarily gone
offline, and pre-authentication, which allows fast roaming and is ideal
for use with advanced applications such as Voice over Internet
Protocol (VoIP).

802.11j Proposed addition to the 802.11 family of standards that incorporates
Japanese regulatory extensions to 802.11a; the main intent is to add
channels in the radio-frequency (RF) band of 4.9 GHz to 5.0 GHz.
WLANs using 802.11j will provide for speeds of up to 54 Mbps, and will
employ orthogonal frequency division multiplexing (OFDM). The
specification will define how Japanese 802.11 family WLANs and other
wireless systems, particularly HiperLAN2 networks, can operate in
geographic proximity without mutual interference.

802.11k Proposed standard for how a WLAN should perform channel selection,
roaming, and transmit power control (TPC) to optimize network
performance. In a network conforming to 802.11k, if the access point
(AP) having the strongest signal is loaded to capacity, a wireless
device is connected to one of the under used APs. Even though the
signal may be weaker, the overall throughput is greater because more
efficient use is made of the network resources.

802.11n Wireless networking standard to improve network throughput over the
two previous standards 802.11a and 802.11g with a significant
increase in the maximum raw data rate from 54 Mbit/s to 600 Mbit/s
with the use of four spatial streams at a channel width of 40 MHz.

802.11m An initiative to perform editorial maintenance, corrections,
improvements, clarifications, and interpretations relevant to
documentation for 802.11 family specifications. 802.11m also refers to
the set of maintenance releases itself.

802.11 bSec The bSec protocol is a pre-standard protocol that has been proposed to
the IEEE 802.11 committee as an alternative to 802.11i. The difference
between bSec and standard 802.11i is that bSec implements Suite B
algorithms whenever possible. Notably, AES-CCM is replaced by AES-
CGM, and the Key Derivation Function (KDF) of 802.11i is upgraded to
support SHA-256 and SHA-384.

To provide interoperability with standard Wi-Fi software drivers, bSec is
implemented as a shim layer between standard 802.11 Wi-Fi and a
Layer 3 protocol such as IP. A controller configured to advertise a bSec
SSID will advertise an open network, however only bSec frames will be
permitted on the network.

802.1X Standard designed to enhance 802.11 WLAN security. 802.1X provides
an authentication framework, allowing a user to be authenticated by a
central authority. The actual algorithm that is used to determine
whether a user is authentic is left open and multiple algorithms are
possible.



Term Definition

access point (AP) An access point connects users to other users within the network and
also can serve as the point of interconnection between the WLAN and
a fixed wire network. The number of access points a WLAN needs is
determined by the number of users and the size of the network.

access point mapping The act of locating and possibly exploiting connections to WLANs while
driving around a city or elsewhere. To do war driving, you need a
vehicle, a computer (which can be a laptop), a wireless Ethernet card
set to work in promiscuous mode, and some kind of an antenna which
can be mounted on top of or positioned inside the car. Because a
WLAN may have a range that extends beyond an office building, an
outside user may be able to intrude into the network, obtain a free
Internet connection, and possibly gain access to company records and
other resources.

adhoc network A LAN or other small network, especially one with wireless or
temporary plug-in connections, in which some of the network devices
are part of the network only for the duration of a communications
session or, in the case of mobile or portable devices, while in some
close proximity to the rest of the network.

A-MSDU A structure containing multiple MSDUs , transported within a single
(unfragmented) data medium access control (MAC) protocol data unit
(MPDU).

band A specified range of frequencies of electromagnetic radiation.

digital wireless pulse Wireless technology for transmitting large amounts of digital data
over a wide spectrum of frequency bands with very low power for a
short distance. Ultra wideband radio can carry a huge amount of data
over a distance up to 230 feet at very low power (less than 0.5
milliwatts), and has the ability to carry signals through doors and other
obstacles that tend to reflect signals at more limited bandwidths and a
higher power.

evil twin A home-made wireless access point that masquerades as a legitimate
one to gather personal or corporate information without the end-
user's knowledge. It's fairly easy for an attacker to create an evil twin
by simply using a laptop, a wireless card and some readily-available
software. The attacker positions himself in the vicinity of a legitimate
Wi-Fi access point and lets his computer discover what name and
radio frequency the legitimate access point uses. He then sends out
his own radio signal, using the same name.

extensible authentication
protocol (EAP)

Authentication protocol for wireless networks that expands on
methods used by the point-to-point protocol (PPP), a protocol often
used when connecting a computer to the Internet. EAP can support
multiple authentication mechanisms, such as token cards, smart
cards, certificates, one-time passwords, and public key encryption
authentication.
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fixed wireless Wireless devices or systems in fixed locations such as homes and
offices. Fixed wireless devices usually derive their electrical power
from the utility mains, unlike mobile wireless or portable wireless
which tend to be battery-powered. Although mobile and portable
systems can be used in fixed locations, efficiency and bandwidth are
compromised compared with fixed systems.

frequency allocation Use of radio frequency spectrum regulated by governments.

frequency spectrum Part of the electromagnetic spectrum.

goodput Goodput is the ratio of the total bytes transmitted or received in the
network to the total air time required for transmitting or receiving the
bytes. The air time includes the retransmission time taken for both
successful and dropped frames.Suppose 1000 frames of 1500 bytes
each are transmitted in the network as follows:

l 50% of frames are transmitted successfully at MCS index 11 at 108
Mbps.

l 25% of the frames were dropped in the 1st attempt at 108 Mbps
but were successfully transmitted using MCS index 3 at 54 Mbps in
the second attempt.

l The remaining 25% are dropped in both the attempts.

Then the effective rate is calculated as: The total bits transmitted / the
total air time. In this example: (500 * 1500 + 250 * 1500) * 8 / (total air
time for 50% frames + total air time for 25 % frames retransmitted +
total air time for 25% dropped frames) = 40.5 Mbps.

hot spot A WLAN node that provides Internet connection and virtual private
network (VPN) access from a given location. A business traveller, for
example, with a laptop equipped for Wi-Fi can look up a local hot spot,
contact it, and get connected through its network to reach the Internet
and their own company remotely with a secure connection.
Increasingly, public places, such as airports, hotels, and coffee shops
are providing free wireless access for customers.

hot zone A wireless access area created by multiple hot spots located in close
proximity to each other. Hot zones usually combine public safety
access points with public hot spots. Each hot spot typically provides
network access for distances between 100 and 300 feet; various
technologies, such as mesh network topologies and fiber optic
backbones, are used in conjunction with the hot spots to create areas
of coverage.

Infrared Data Association
(IrDA)

An industry-sponsored organization set up in 1993 to create
international standards for the hardware and software used in
infrared communication links. In this special form of radio
transmission, a focused ray of light in the infrared frequency
spectrum, measured in terahertz, or trillions of hertz (cycles per
second), is modulated with information and sent from a transmitter to
a receiver over a relatively short distance



Term Definition

IR wireless The use of wireless technology in devices or systems that convey data
through infrared (IR) radiation. Infrared is electromagnetic energy at a
wavelength or wavelengths somewhat longer than those of red light.
The shortest-wavelength IR borders visible red in the electromagnetic
radiation spectrum; the longest-wavelength IR borders radio waves.

microwave Electromagnetic energy having a frequency higher than 1 gigahertz
(billions of cycles per second), corresponding to wavelength shorter
than 30 centimeters. Microwave signals propagate in straight lines
and are affected very little by the troposphere. They are not refracted
or reflected by ionized regions in the upper atmosphere. Microwave
beams do not readily diffract around barriers such as hills, mountains,
and large human-made structures.

MIMO An antenna technology for wireless communications in which multiple
antennas are used at both the source (transmitter) and the destination
(receiver). The antennas at each end of the communications circuit
are combined to minimize errors and optimize data speed. MIMO is
one of several forms of smart antenna technology, the others being
MISO (multiple input, single output) and SIMO (single input, multiple
output).

MISO An antenna technology for wireless communications in which multiple
antennas are used at the source (transmitter). The antennas are
combined to minimize errors and optimize data speed. The
destination (receiver) has only one antenna. MISO is one of several
forms of smart antenna technology, the others being MIMO (multiple
input, multiple output) and SIMO (single input, multiple output).

near field communication
(NFC)

A short-range wireless connectivity standard (Ecma-340, ISO/IEC
18092) that uses magnetic field induction to enable communication
between devices when they're touched together, or brought within a
few centimeters of each other. The standard specifies a way for the
devices to establish a peer-to-peer (P2P) network to exchange data.

optical wireless The combined use of conventional radio-frequency (RF) wireless and
optical fiber for telecommunication. Long-range links are provided by
optical fiber and links from the long-range end-points to end users are
accomplished by RF wireless or laser systems. RF wireless at ultra-high
frequencies (UHF) and microwave frequencies can carry broadband
signals to individual computers at substantial data speeds.

OCSP Client The ArubaOScontroller can act as an OCSP client and issues OCSP
queries to remote OCSP responders located on the intranet or
Internet.

OCSP Responder The OCSP client retrieves certificate revocation status from an OCSP
responder. The responder may be the certificate authority (CA) that
has issued the certificate in question or it may be some other
designated entity which provides the service on behalf of the CA.

radio frequency (RF) Portion of electromagnetic spectrum in which electromagnetic waves
are generated by feeding alternating current to an antenna.
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structured wireless-aware
network (SWAN)

A technology that incorporates a WLAN into a wired wide-area
network (WAN). SWAN technology can enable an existing wired
network to serve hundreds of users, organizations, corporations, or
agencies over a large geographic area. A SWAN is said to be scalable,
secure, and reliable.

secure copy (SCP) Secured encrypted command to copy files across an ssh connection,
Files can be copied from or to a remote server, and also from one
remote server to another.

transponder A wireless communications, monitoring, or control device that picks up
and automatically responds to an incoming signal. The term is a
contraction of the words transmitter and responder. Transponders
can be either passive or active.

ultra high frequency (UHF) International Telecommunication Union (ITU) band 9, 300-3000 MHz,
1m - 100 mm frequency wavelength.

ultra wideband (UVB) Is a wireless technology for transmitting large amounts of digital data
over a wide spectrum of frequency bands with very low power for a
short distance. Ultra wideband broadcasts very precisely timed digital
pulses on a carrier signal across a very wide spectrum (number of
frequency channels) at the same time. UWB can carry a huge amount
of data over a distance up to 230 feet at very low power (less than 0.5
milliwatts), and has the ability to carry signals through doors and other
obstacles that tend to reflect signals at more limited bandwidths and a
higher power.

virtual private network (VPN) A network that uses a public telecommunication infrastructure, such
as the Internet, to provide remote offices or individual users with
secure access to their organization's network. A VPN ensures privacy
through security procedures and tunneling protocols such as the Layer
Two Tunneling Protocol ( L2TP ). Data is encrypted at the sending end
and decrypted at the receiving end.

voice over WLAN (VoWLAN) A method of routing telephone calls for mobile users over the Internet
using the technology specified in IEEE 802.11b. Routing mobile calls
over the Internet makes them free, or at least much less expensive
than they would be otherwise.

wideband code-division
multiple access (W-CDMA)

Officially known as IMT-2000 direct spread; ITU standard derived from
Code-Division Multiple Access (CDMA). W-CDMA is a third-generation
(3G) mobile wireless technology that promises much higher data
speeds to mobile and portable wireless devices than commonly
offered in today's market.

Wi-Fi A term for certain types of WLANs. Wi-Fi can apply to products that use
any 802.11 standard. Wi-Fi has gained acceptance in many
businesses, agencies, schools, and homes as an alternative to a wired
LAN. Many airports, hotels, and fast-food facilities offer public access
to Wi-Fi networks.
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WiMAX A wireless industry coalition whose members organized to advance
IEEE 802.16 standards for broadband wireless access (BWA) networks.
WiMAX 802.16 technology is expected to enable multimedia
applications with wireless connection and, with a range of up to 30
miles, enable networks to have a wireless last mile solution. According
to the WiMAX forum, the group's aim is to promote and certify
compatibility and interoperability of devices based on the 802.16
specification, and to develop such devices for the marketplace.

wired equivalent privacy
(WEP)

A security protocol specified in 802.11b, designed to provide a WLAN
with a level of security and privacy comparable to what is usually
expected of a wired LAN. Data encryption protects the vulnerable
wireless link between clients and access points; once this measure has
been taken, other typical LAN security mechanisms such as password
protection, end-to-end encryption, virtual private networks (VPNs), and
authentication can be put in place to ensure privacy.

wireless Describes telecommunications in which electromagnetic waves
(rather than some form of wire) carry the signal over part or all of the
communication path.

wireless abstract XML (WAX) Describes telecommunications in which electromagnetic waves
(rather than some form of wire) carry the signal over part or all of the
communication path.

wireless application service
provider (WASP)

Provides Web-based access to applications and services that would
otherwise have to be stored locally and makes it possible for
customers to access the service from a variety of wireless devices,
such as a smartphone or personal digital assistant (PDA).

wireless ISP (WISP) An internet service provider (ISP) that allows subscribers to connect to
a server at designated hot spots (access points) using a wireless
connection such as Wi-Fi. This type of ISP offers broadband service
and allows subscriber computers, called stations, to access the
Internet and the Web from anywhere within the zone of coverage
provided by the server antenna, usually a region with a radius of
several kilometers.

wireless service provider A company that offers transmission services to users of wireless
devices through radio frequency (RF) signals rather than through end-
to-end wire communication.

wireless local area network
(WLAN)

A local area network (LAN) that users access through a wireless
connection. 802.11 standards specify WLAN technologies. WLANs are
frequently some portion of a wired LAN.

yagi antenna A unidirectional antenna commonly used in communications when a
frequency is above 10 MHz.
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